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Oracle Demantra products.

Oracle Enterprise Asset Management User's Guide
This guide describes the information you need to understand and use Oracle Enterprise 
Asset Management to plan, schedule, and track the costs of asset maintenance.

Oracle Flow Manufacturing User's Guide
This guide describes how to use Oracle's Flow Manufacturing functionality to support 
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Oracle Global Order Promising Implementation and User's Guide
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Oracle Inventory Optimization User's Guide
This guide describes the comprehensive Internet-based inventory planning solution that
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Oracle Order Management User's Guide
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This guide describes the information you need to understand and use Oracle Process 
Manufacturing.

Oracle Process Manufacturing Planning User's Guide
This guide describes the information you need to understand and use to integrate 
Oracle Process Manufacturing with the Oracle Advanced Planning suite.

Oracle Production Scheduling Implementation Guide
This guide describes how to use Production Scheduling to create detailed finite capacity
and materially constrained optimized production schedules to drive shop floor 
operations and material planning.

Oracle Project Manufacturing User's Guide
This guide describes the unique set of features that Oracle Project Manufacturing 
provides for a project-based manufacturing environment. Oracle Project Manufacturing
can be tightly integrated with Oracle Projects. However, in addition to Oracle Projects 
functionality, Oracle Project Manufacturing provides a comprehensive set of new 
features to support project sales management, project manufacturing costing, project 
manufacturing planning, project manufacturing performance, and project quality 
management.

Oracle Projects Fundamentals
This guide describes the foundation information you need to understand and use 
Oracle Projects.

Oracle Rapid Planning Implementation and User's Guide
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Oracle Service Parts Planning Implementation and User Guide
Oracle Service Parts Planning is used by repair service operations to ensure that the 
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most efficient manner possible. 
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Oracle Shipping Execution User's Guide
This guide describes the information you need to understand and use Oracle Shipping 
Execution.

Oracle Strategic Network Optimization Implementation Guide
This guide describes how to use Strategic Network Optimization to model and optimize
your supply chain network, from obtaining raw materials through delivering end 
products.

Oracle Value Chain Planning Installation Guide
This explains what you need to do to install Oracle Value Chain Planning

Do Not Use Database Tools to Modify Oracle E-Business Suite Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle E-Business Suite data 
unless otherwise instructed. 

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data. 

Because Oracle E-Business Suite tables are interrelated, any change you make using an 
Oracle E-Business Suite form can update many tables at once. But when you modify 
Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you 
may change a row in one table without making corresponding changes in related tables.
If your tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle E-Business Suite. 

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite 
automatically checks that your changes are valid. Oracle E-Business Suite also keeps 
track of who changes information. If you enter information into database tables using 
database tools, you may store invalid information. You also lose the ability to track who
has changed your information because SQL*Plus and other database tools do not keep a
record of changes. 
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1
Overview

This chapter covers the following topics:

• Oracle Advanced Planning Suite

• Oracle Advanced Supply Chain Planning

• Distribution Planning

• Simulating Plans in Oracle Rapid Planning

Oracle Advanced Planning Suite
The Oracle Advanced Planning suite includes the following products:

• Oracle Advanced Supply Chain Planning (ASCP)

• Oracle Collaborative Planning

• Oracle Demand Planning

• Oracle Global Order Promising

• Oracle Inventory Optimization

• Oracle Manufacturing Scheduling

• Oracle Production Scheduling

• Oracle Strategic Network Optimization

This document covers Oracle Advanced Supply Chain Planning.

Oracle Advanced Supply Chain Planning
Oracle Advanced Supply Chain Planning (ASCP) is a comprehensive, Internet-based 
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planning solution that decides when and where supplies (for example, inventory, 
purchase orders and work orders) should be deployed within an extended supply 
chain. This is the supply planning function. Oracle ASCP addresses the following key 
supply planning issues: 

• How do I plan my supply chain in the least amount of time possible?

• How do I minimize the number of plans and iterations?

• How do I plan my entire supply chain?

• How do I involve my trading partners?

• How can I access my plan from anywhere?

• How do I keep improving my plans?

• How can I plan all manufacturing methods?

The key capabilities of Oracle ASCP are:

• Holistic Optimization, Planning, and Scheduling. Oracle ASCP can plan all supply 
chain facilities simultaneously. Short-term detailed scheduling and long-term 
aggregate planning are supported within a single plan. This single plan also 
supports multiple manufacturing methods, including discrete, flow, project, and 
process manufacturing.

• Finite Capacity Planning and Scheduling. Oracle ASCP generates feasible supply 
chain plans that consider both resource and material constraints.

• Optimization. Users can easily configure Oracle ASCP to optimize specific business 
criteria. No programming is necessary to access Oracle ASCP's powerful 
mathematical optimization capabilities.

• Backward Compatibility. Oracle ASCP's component architecture allow it to be 
deployed against any version of Oracle transaction systems.

• Workflow-Driven Exception Messaging. Oracle ASCP's exception messages alert 
planners to critical issues across the extended supply chain. Workflows that drive 
these exceptions route data to and feedback from trading partners as required, thus 
effectively involving them in the supply chain planning process.

• Global Accessibility. Oracle ASCP's database-centric architecture stores plan data in
a central planning server database. These data are accessible from anywhere via a 
simple browser. It is possible for multiple planners to simultaneously access data 
from a single plan. 

• Integrated Planning and Execution. Oracle ASCP's Advanced Planner Workbench 
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user interface not only displays plan results, but also allows planners to execute 
planning recommendations. Planners do not have to move to the transaction system
to perform plan execution.

• Simulation Capability. Oracle ASCP allows many types of changes to supply, 
demand, plan options, and resource profiles to simulate changing business 
conditions. You can generate a plan considering all the changes that have been 
entered via the Planner's Workbench. Unlimited numbers of scenarios can be 
simulated and compared using online planning, copy plans, and exceptions. 
Examples of the types of changes are firming, changing sources, modifying 
quantities and dates, modifying priorities, modifying resource availability, 
modifying supplier capacity, and modifying objective weights. 

Distribution Planning
Businesses with multi-level supply chains need to fulfill demands from downstream 
distribution locations and customers from supply plans for their manufacturing and 
stocking locations. The rules that govern this distribution are different depending on 
whether the supply is unconstrained or constrained. The distribution planning process 
is independent of the supply planning process at each source locations. 

This process includes generating a:

• Detailed short term (daily) plan: A movement plan for each lane of the distribution 
network

• Longer term, higher level material distribution plan

The constraints impacting these two plans are the same but the level of detail modeled 
is quite different.

• In both the short and long term, you must have global visibility to inventory 
positions in each location in your distribution network (external and internal), fulfill
demand requirements arising at these locations, and be able to react to specific 
consumption patterns

• In the short term, you must maintain target and maximum inventory levels at each 
destination location and safety stock levels at each source location to react to 
demand uncertainties. In all cases, make sure that target and safety stock levels 
respect maximum levels.

Distribution planning answers the question about where you should deploy inventory 
when there is excess at your central locations. As needed, the excess inventory is 
pushed outwards to locations closer to the customer.

In addition, you need fair share rules for supply-constrained items. These fair share 
rules specify how to cover part of the needs at each of the receiving locations when all 
of the needs cannot be covered. This process can also be tightly integrated with 
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customers via business agreements such as vendor managed inventory and customer 
managed inventory and you may model customers and supplier organizations

Some of the key constraints that influence distribution planning decisions are :

• Distribution rules and fair share allocation rules

• Supplier capacity constraints

• Inventory investments

• Maximum and target inventory levels

• Safety stock levels and service level requirements 

• Intransit lead times

• Shipment limits

• Shipping, receiving, and transportation calendars

Distribution planning meets these constraints by:

• Providing fair share allocation of scarce supplies to competing demands 

• Modeling multiple inventory levels including maximum, target and safety stock 
inventory levels 

• Rebalancing inventories at regional distribution centers before transferring supplies
from a central distribution center

• Consolidating shipments between organizations to improve the utilization of 
shipment capacities 

• Accepting global forecasts and selecting the best facility to meet each demand

• Creating the documents for inter-organization transfers

• Integrating with Oracle Transportation Management to provide detailed 
transportation planning

Key benefits from using distribution planning can be:

• Increased ability to react to tight supply situations, for example, delay of supply 
arrival from a supplier or production shortfalls in manufacturing plants with 
allocation strategies

• Improved customer service levels and reduced overall cost of inventory through 
proactive inventory rebalancing
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• Reduced cost of material movement (shipping cost) through load balancing

• Replenishments that dynamically follow consumption patterns

• Minimized inventory write off (wastage and spoilage)

• Improved service levels through fair share allocation 

• Improved global visibility and enforcement of inventory and distribution policies 

• Improved distribution planner productivity by using the Distribution Planner 
Workbench and by simultaneous release and reschedule of internal sales orders and
internal requisitions

Distribution planning focuses on the end items in distribution environments. As such, it
does not suggest production of more supply nor consider manufacturing capacity and 
components. It does consider additional purchased supplies and supplier capacity 
models. While it considers kits (light assembly) using Oracle Bills of Material for the 
component list, it does not consider assemble-to-order, pick-to-order, and 
configure-to-order.

Distribution planning works with other Oracle Advanced Planning suite products that 
can be used upstream and downstream of it:

• Oracle Demand Planning drives independent demands into distribution plans.

• Oracle Advanced Supply Chain Planning manufacturing plans drive supplies into 
distribution plans

• Oracle Inventory Optimization plans drive time-phased safety-stock information 
into distribution plans.

• Distribution plans drive Oracle Transportation Management through the release of 
internal purchase requisitions and internal sales orders.

• Distribution plans provide a statement of product availability to Oracle Global 
Order Promising.

• Distribution planning interacts with the Oracle Collaborative Planning flows 
Publish order forecast (both for external suppliers and for suppliers modeled as 
organizations), Publish supply commits, Receive supplier capacity, and Publish 
safety stock levels

Distribution and Manufacturing Plan Relationships
If you are a distribution company, you can plan your business using distribution 
planning only.

If you are a manufacturing and distribution company, you can combine manufacturing 
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plans and distribution plans to plan your enterprise. The manufacturing and 
distribution plan types are:

• Master Production Plans (MPP): They typically include your distribution facilities 
and not your manufacturing facilities. Use the master production plan to 
summarize all of the demands for production in your manufacturing plants. 
Typically, independent demand drives this plan and this plan drives the 
manufacturing planning and scheduling process.

• Master Production Schedules (MPS) and Material Requirements Plans (MRP): They 
typically include your manufacturing facilities and not your distribution facilities. 
Use the master production schedule and material requirements plan to plan the full 
production schedule. Typically, the master production plan drives this plan and 
this plan drives the manufacturing execution and the distribution planning. For 
manufacturing planning, you can use either a two-level or a single plan planning 
approach. The two-level approach uses both the master production schedule and 
material requirements plan; the single plan approach uses the material 
requirements plan only

• Distribution Plans (DRP): They typically include your distribution facilities and not 
your manufacturing facilities. Use the distribution plan to schedule transfers with 
carrier recommendations that move finished goods across the warehouse network, 
outwards from the manufacturing plants through the supply chain. Typically, a 
supply schedule drives this plan and this plan drives the distribution execution. A 
supply schedule is a master production plan, a master production schedule, or a 
material requirements plan.

Planning Process Flows for Business Types
Different businesses use different distribution and manufacturing process flows. Here 
are some sample process flows for different business types.

Distributor and Retailer

Buys product for resale through a distribution network. No manufacturing capabilities, 
although light kitting may be done. Vendor managed inventories may be located at 
customer sites. Oracle recommends a single distribution plan.
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Manufacturer

Manufacturer owning a network of distribution centers. The network may also include 
vendor managed inventories located at customer sites. Oracle recommends: 

• A constrained master production plan that includes all manufacturing facilities and 
all planned items. Drive this plan with global and local forecasts. If you need to 
capture both sales orders and forecasts, you may need to include distribution 
facilities; however, the master production plan does not plan these facilities. At 
your option, you could use a material requirements plan for C-level items

• A distribution plan that includes all distribution facilities and that uses the master 
production plan as a demand schedule. The supplies in the master production plan 
constrain the distribution plan. The distribution plan does not create new supplies 
in the organizations planned by the master production plan. Only list the master 
production plan as a supply schedule for organizations that have incoming 
supplies.

• Use the distribution plan to provide a statement of unconstrained demand to the 
constrained master production plan.

Multi-Plant or Complex Product Manufacturer: Manufacturer owning a network of 
distribution centers. The network may also include vendor managed inventories located
at customer sites. Manufacturer using two-level scheduling planning approach. This 
diagram shows a planning business flow for this business type.
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Simulating Plans in Oracle Rapid Planning

Overview
You use Oracle Advanced Supply Chain Planning and Oracle Rapid Planning together 
to respond to unanticipated events between Advanced Supply Chain Planning runs. 
Use Rapid Planning to simulate prospective changes that address these unanticipated 
issues. Choose a solution, then release it to the execution system and feed it back to 
Advanced Supply Chain Planning. 

Process
This table describes the simulation process.

Oracle Advanced Supply Chain Planning Oracle Rapid Planning

Run plan -

Edit and firm order dates --

Release orders to execution --

There are unanticipated events that cause 
production issues before the next plan run. . .

--
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Oracle Advanced Supply Chain Planning Oracle Rapid Planning

Copy Advanced Supply Chain Planning plan 
as Rapid Planning baseline plan (once, either 
from Advanced Supply Chain Planning or 
Rapid Planning) 

Copy Advanced Supply Chain Planning plan 
as Rapid Planning baseline plan (once, either 
from Advanced Supply Chain Planning or 
Rapid Planning) 

-- Do this as many times as you need to simulate
potential solutions and select a solution: 

-- - Copy the baseline plan to a simulation plan

-- - Make potential changes to the simulation 
plan 

-- - Firm a portion of the simulation plan

-- - Run the simulation plan

-- - Compare the baseline and the simulation 
results

-- Release orders to execution

-- In the simulation plan that you use to solve 
the issue, firm the planned orders that you 
released. These become firm planned orders 
when you pass them to the next Advanced 
Supply Chain Planning run.

Run the plan and specify the Rapid Planning 
simulation plan that you used to solve the 
issue and released orders from.

--

Enable Simulations
Navigate to window Preferences, tab Other. Select Enable Rapid Planning Simulations.

Create Baseline Plan
You can create the baseline Rapid Planning plan from an Advanced Supply Chain 
Planning plan using these methods:

• In Advanced Supply Chain Planning: Menu, Open Simulation
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• In Rapid Planning: Process, Copy Plan

For a description of the process, see Oracle Rapid Planning Implementation and User's 
Guide.

Open Simulation
Navigate (M) Plan > Open Simulation. 

If you want to create a Rapid Planning baseline plan, click Create New Rapid Planning 
Simulation Plan and enter Plan Name, Description and Simulation Horizon (Days). 

If you want to open a Rapid Planning baseline plan, click Open Existing Rapid Planning
Simulation Plan and select a plan. 

The Open Simulation – Status window shows the status of the process. If you click 
Close, the window closes but the process still runs. You see an error message if the 
process fails. 

Rapid Planning opens to the plan. 

Copy Plan
See Oracle Rapid Planning Implementation and User's Guide.

Feeding Back from Rapid Planning 
Feed back the results of your Rapid Planning simulation decision to the next Advanced 
Supply Chain Planning plan run. 

Set plan option Main tab > Rapid Planning Simulation Set. This brings the changes that 
you made in the Rapid Planning plan's simulation set to the plan.

Navigate to Concurrent Processes, select Launch Supply Chain Planning Process 
Request Set, and navigate to window Parameters. 

Navigate to field Launch Snapshot, select Full Snapshot. 

Navigate to field Snapshot Source for Firm Planned Orders. Its list of values has itself 
and the Rapid Planning baseline and simulation plans. Select the Rapid Planning plan 
that you decided to use to solve the unanticipated event and release orders from. 

Everything else snapshots from the usual sources, only the firm planned orders come 
from the Rapid Planning plan. In these situations, firm planned orders do not snapshot:

• Partially released firm planned orders snapshot their unreleased quantity

• If the plan has other Advanced Supply Chain Planning plans driving it as supply or
demand schedules. The process does not snapshot Rapid Planning firm planned 
orders for item-org's that are in those supply and demand schedules
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2
Setting Up Advanced Supply Chain Planning

This chapter covers the following topics:

• Setup Overview

• Hardware Configuration

• Setup Flowchart

• Setup Steps for the Source

• Setup Steps for the Destination

Setup Overview
This section describes setup steps for Oracle Advanced Supply Chain Planning.

Set up for Oracle Demand Planning and Oracle Global Order Promising is briefly 
covered for the sake of completeness, but is described fully in their respective 
installation instructions.

The online help keys for Oracle Advanced Supply Chain Planning are:

• Node Application: MSC

• Node Key: GATPTOP_ASCP

• Parent Application: SUPPLY

• Parent Key: SUPPLY

Hardware Configuration
The first step in the setup process is to decide on the overall hardware configuration.

Oracle Advanced Planning Suite has a component architecture that separates the 
transaction data and associated processing (for example, inventory receipts and order 
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entry) in a source instance from the planning calculations done in a destination 
instance. This allows planning calculations to be done on a different physical machine 
than the machine that performs transactions and results in better system response. It 
also allows planning calculations (demand planning, inventory planning, supply 
planning and order promising) to be applied simultaneously to information from across
multiple source instances, which is useful when transaction information for a global 
supply chain is spread across multiple instances. Oracle Demand Planning also uses a 
third instance, an OLAP Analytic Workspace (AW) database, to hold data while 
multidimensional manipulation of demand data occurs.

The source can be any ERP system, but out-of-the-box integration to the Oracle 
Advanced Planning Suite destination instance (planning server) exists in some cases but
not in all cases.

Both source and destination database instances must be on the same major release of the
Oracle database; see Setup Flowchart, page 2-4.

One-Machine Implementation
For small implementations, source, destination, and Express can reside on the same 
machine and be in the same instance. The following figure illustrates this configuration.

Note: ASCP means Advanced Supply Chain Planning and DP means 
Demand Planning.

Two-Machine Implementation
For larger implementations where system throughput is more important, the various 
instances can be deployed on separate machines. A two-machine deployment 
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configuration is appropriate when the size of the demand planning data is relatively 
small. The following figure illustrates this configuration.

Three-Machine Implementation
A three-machine deployment allows for the manipulation of high-dimensionality, 
large-scale demand planning data to occur on a machine separate from the planning 
calculations done on the planning server. The following figure illustrates this 
configuration.

Four-Machine Implementation
The Advanced Supply Chain Planning concurrent manager may also be deployed on a 
separate machine. This creates even greater system performance. The following figure 
illustrates the four-machine implementation.



2-4    Oracle Advanced Supply Chain Planning Implementation and User's Guide

In all deployment configurations, a collection process brings data from the EBS Source 
tables to the APS Destination tables. A build process brings data form the APS 
Destination tables to the OLAP Analytic Workspace (AW) for Demand Planning. 
Finally, a publish process moves data from the AW to the APS Destination tables to be 
used for planning and can also publish data back to the EBS Source instance.

Global Order Promising and Inventory Optimization planning calculations are also 
performed on the planning server.

Setup Flowchart
Set up for Oracle Advanced Planning Suite consists of steps for the EBS Source instance,
steps for the APS Destination instance, and steps for Express.

In Oracle Advanced Planning where you have a distributed installation with separate 
EBS Source and Planning Server (APS Destination), we support disparate database 
releases in all supported Oracle RDBMS releases. For instance, you could have an 
11.5.10 EBS Source instance on 10gR2 and your 12.1 APS destination is on 11gR2.s 

The following figure is a flowchart illustrating the source and destination setup steps.
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Source and Destination Instance Setup

Setup Steps for the Source
The setup steps are as follows:

1. For a Distributed installation, you may have to apply patches on the EBS Source 
Instance.

See My Oracle Support Note 1361221.1. It describes:

• Supported configurations and limitations.

• Latest Patches to be applied for Centralized single instance.

• Latest available patch to apply to both APS Destination on 12.2 with EBS Source
also on 12.2 or with EBS source on an earlier release. 

2. Create a database link pointing to the planning server.

A database link must be established on the EBS Source instance that points to the 
APS Destination (planning) instances, MRP: ATP Database Link. This database link 
will also be used, along with a database link established on the destination instance,
in setting up the instances on the planning server.

3. Create Advanced Supply Chain Planner responsibilities in the source instance 
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related to the collections process.

The data collection process is discussed in Running Collections, page 4-1.

Source Instance Prior to Release 12.1

You must assign this Advanced Supply Chain Planner Responsibility with the 
specifications listed below to the User who will launch Collections and Release 
from the workbench:

• Responsibility Name: Advanced Supply Chain Planner

• Application: Advanced Supply Chain Planning

• Description: Used for running Refresh Collection Snapshots

• Menu: MSC_TOP_4.0

• Data Group Name: Standard

• Application: Advanced Supply Chain Planning

• Request Group: All MSC Reports

• Application: Advanced Supply Chain Planning

• Oracle Advanced Supply Chain Planning uses this responsibility to run the 
concurrent program Refresh Snapshot during all data collection runs.

Warning: If you create custom responsibilities for your users on the
APS Destination to launch Data Collection or Release planned 
orders from the Planner Workbench, then you must also define 
those responsibilities on the EBS Source instance. When creating 
those responsibilities, the following fields must match exactly or 
the Release process will fail: Responsibility Name, Application, 
Responsibility Key, and Description.

For other fields, you should use the same fields used for Advanced 
Supply Chain Planner. The user will not use this responsibility for 
any data processing. It must exist only for processes launched on 
the APS destination which must have this information on the EBS 
Source to complete processing successfully.

Source Instance At Release 12.1 or Later

You must assign this Advanced Supply Chain Planner Responsibility, with the 
specifications listed below, to the User who will launch Collections and Release 
from the workbench:
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• First Responsibility Name: APS Collections

• Application: Advanced Supply Chain Planning

• Description: APS Collections Responsibility

• Menu: MSC_COLL_REL_MENU

• Data Group Name: Standard

• Application: Advanced Supply Chain Planning

• Request Group: All MSC Reports

• Application: Advanced Supply Chain Planning

• Assign the responsibility to user names in the source instance that are 
authorized to run the APS collection processes.

• Second Responsibility Name: APS Release

• Application: Advanced Supply Chain Planning

• Description: APS Collections & Release

• Menu: MSC_COLL_REL_MENU

• Data Group Name: Standard

• Application: Advanced Supply Chain Planning

• Request Group: All MSC Reports

• Application: Advanced Supply Chain Planning

• Assign the responsibility to user names in the source instance that are 
authorized to run the APS release processes.

4. The Create Planning Flexfields concurrent program creates new segment definitions
in existing descriptive flexfields to hold data that may be required for constrained 
and/or optimized planning. The program also populates profile values with the 
value corresponding to the descriptive flexfield attribute number for each attribute 
(planning parameter) created. The collections process uses the profile values for the 
flexfield attribute to collect any values for entities, for example, items and bills of 
material, when you populates them in the source instance.

The table below shows the descriptive flexfield attributes that are required, the 
name of the attributes that are created, the tables in which the data resides, and the 
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profile options that correspond to each attribute.

Descriptive 
Flexfield Names

Parameter Name

(In flexfield form 
and report 
parameter)

Base Table Name Profile Option 
Name

Items Late Demands 
Penalty (Item)

MTL_SYSTEM_ITE
MS

MSO: Penalty Cost 
Factor for Late Item 
Demands Flexfield 
Attribute

Items Material 
Over-Capacity 
Penalty (Item)

MTL_SYSTEM_ITE
MS

MSO: Penalty Cost 
Factor for Exceeding
Item Material 
Capacity Flexfield 
Attribute

Organization 
Parameters

Late Demands 
Penalty (Org)

MTL_PARAMETER
S

MSO: Penalty Cost 
Factor for Late 
Demands 
(Organization) 
flexfield attribute

Organization 
Parameters

Material 
Over-Capacity 
Penalty (Org)

MTL_PARAMETER
S

MSO: Penalty cost 
factor for exceeding 
material capacity 
(Organization) 
flexfield

Organization 
Parameters

Resource 
Over-Capacity 
Penalty (Org)

MTL_PARAMETER
S

MSO: Penalty cost 
factor for exceeding 
resource capacity 
(Organization) 
flexfield

Organization 
Parameters

Transport 
Over-Capacity 
Penalty (Org)

MTL_PARAMETER
S

MSO: Penalty cost 
factor for exceeding 
transportation 
capacity 
(Organization)

Department 
Resource 
Information

Aggregate 
Resources

BOM_DEPARTMEN
T _RESOURCES

MSC: Aggregate 
Resource Name 
Flexfield Attribute
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Descriptive 
Flexfield Names

Parameter Name

(In flexfield form 
and report 
parameter)

Base Table Name Profile Option 
Name

Department 
Resource 
Information

Resource 
Over-Capacity 
Penalty (Resource)

BOM_DEPARTMEN
T _RESOURCES

MSO: Penalty cost 
factor for exceeding 
resource capacity 
(Resource) flexfield

Attribute 

(Purchasing)

Material 
Over-Capacity 
Penalty (Supplier)

PO_ASL_ATTRIBUT
ES

MSO: Penalty Cost 
Factor for Exceeding
Material Capacity 
Flexfield Attribute

Substitute 
Component 
Information

Substitute Items 
Priority

BOM_SUBSTITUTE
_ COMPONENT

MSC: Priority for 
Substitute Items 
Flexfield Attribute

MTL Interorg ship 
methods

Transport 
Over-Capacity 
Penalty (Ship 
Method)

MTL_INTERORG_S
HIP _METHOD

MSO: Penalty cost 
factor for exceeding 
transportation 
capacity flexfield 
attribute

Bill of Material 
Information

BOM/Routing Cost BOM_BILL_OF_MA
TERIALS

MSC: Cost of Using 
a BOM/ Routing 
Flexfield Attribute

MRP Forecast Dates Late Forecasts MRP_FORECAST_D
ATES

MSO: Penalty cost 
factor for late 
forecasts

Additional Line 
Information

Late Sales Order 
Penalty

SO_LINES MSO: Penalty cost 
factor for late sales 
orders

Production Line Resource Group 
(Line)

WIP_LINES MSC: Resource 
Group for a Line 
Flexfield Attribute

Launch the Create Planning Flexfields report from the newly created Advanced 
Supply Chain Planner responsibility. The parameters that must be set for the report 
are the attributes that you wish to utilize for the new flexfield definitions. The list of
values for each parameter lists only the available attributes in the subject 
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descriptive flexfield. 

Note: Keep track of the attribute number that you select for each 
flexfield segment. You will need to verify that each corresponding 
profile option was populated with the correct attribute number 
when the process completes.

After submitting the program, eleven additional processes should be spawned. 
These jobs are compiling the descriptive flexfield views.

Check that the profile values corresponding to each flexfield attribute were 
populated with the correct attribute number. Some profile values may retain the 
value of unassigned after the Create Planning Flexfield program completed. You 
must change any unassigned profiles to the attribute number corresponding to the 
flexfield attribute where the new segment was defined.

Set up source data with BOMs, resources, routings, supplier data, flexfields, 
purchasing information, item masters, Oracle BIS targets, and any other data 
required by your plans.

5. Set profile values.

If Global Order Promising is going to be utilized, the following two additional 
profile options must be set. 

The MRP: ATP Database Link profile option must be set with the database link. The
profile value is the name of the database link that resides on the source and points 
to the destination. There is no validation on this profile value. If Global Order 
Promising is not utilized, this need not be set.

6. Execute the Refresh Snapshot concurrent program.

The Refresh Snapshot process must be run on the source. This concurrent program 
is available in the Advanced Supply Chain Planner responsibility created earlier. 
The process has no parameters to be set at run time. Verify that the process 
completes without error. 

Setup Steps for the Destination
The setup steps are as follows:

1. Install the destination instance patches.

The patches can be found on My Oracle Support in Note 1361221.1.

2. For a distributed installation, create a database link pointing to each source.

These links will be needed when defining instances later on in this setup procedure.
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3. Define the source instances to be collected from.

The define instances setup establishes the means of communication between the 
source and destination instances. It also specifies the organizations in the source 
database for which data will be pulled.

In a distributed installation where EBS Source instance is release 12.1, you must 
have the responsibility APS COLLECTIONS on the source instance to run 
collections and APS RELEASE on the source instance to release planned orders. 
These responsibilities are seeded on the source instances. For all collection profiles 
on source instances at the responsibility level, set them to responsibility APS 
COLLECTIONS. For all release profiles on source instances at the responsibility 
level, set them to responsibility APS RELEASE.

4. In Advanced Planning Administrator, choose Setup > Instances. Do not access this 
form while the collections process is running; it locks a table that the collections 
process needs to complete successfully.

The Application Instances window appears.

5. Enter each of the Application instances for which you would like the Planning 
Server to plan. 

6. Complete the fields and flags in the Application Instances window as shown in the 
table below.

Note: You are only required to set up Applications Instances before
the first time you perform data collection.

Field/Flag Description

Instance Code This is a user-defined three character short 
form for the instance to be planned. It 
appears in front organization names and 
other designators. For example, if two 
transaction instances TA1 and TA2 are to be
planned, and both instances have an 
internal organization named M1, ASCP will 
display TA1's organization as TA1:M1 and 
TA2's organization and TA2:M1.
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Field/Flag Description

Instance Type The valid values here are Discrete, Process, 
Discrete and Process. This controls whether 
discrete manufacturing data or process 
manufacturing data (or both) are collected 
from the transaction instance to the planner 
server for planning. Legacy is used when 
collecting from the applications other than 
E-Business Suite (EBS) application.

Version The Oracle Application version of the 
transaction instance.

Application Database Link Only used where in a Distributed 
Installation where EBS Source Instance on a 
separate server, then define a link to 
connect the EBS Source instance to the APS 
Destination instance. This link is 
determined by the database administrator. 
This database link is defined on the EBS 
Source transaction instance and points to 
the APD Destination planning server. This 
link is used to publish releases from the 
ASCP back to the transaction instance as 
purchase orders or work orders.

A link to connect the Applications 
database(s) to Oracle ASCP. This link is 
determined by the database administrator. 
This database link is defined on the 
transaction instance and points to the 
planning server. This link is used to publish 
releases from the ASCP back to the 
transaction instance as purchase orders or 
work orders.
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Field/Flag Description

Planning Database Link Only used where in a Distributed 
Installation where EBS Source Instance on a 
separate server, then define a link to 
connect the APS Destination instance to the 
EBS Source instance. This link is determined
by the database administrator. This 
database link is defined on the APS 
Destination server and points to the EBS 
Source transaction server. This link is used 
to find and collect the EBS Source 
transaction data to be collected for 
planning.

A link to connect Oracle ASCP to the 
Applications database(s). This link is 
determined by the database administrator. 
This link is defined on the planning server 
and points to the transaction instance. This 
link is used to positively locate the source of
the transaction data to be planned.

Enable Flag Select this option to enable the collection 
process.

GMT Difference The difference between planning server 
time zone and GMT.

Assignment Set Optionally, enter the default assignment set 
for this instance. The assignment is used to 
resolve sourcing for order promising 
inquiries.

7. Enter the organizations on each of the instances from which to collect the Planning 
data and plan for on the Planning Server by clicking Organizations.

The Organizations window appears.

8. Select the organizations for a particular instance. Be sure to select the master 
organization.

9. Close the Organization window.

10. Save the Instance Definition setup.
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3
Advanced Supply Chain Planning Business 

Flows

This chapter covers the following topics:

• Business Flows

• Planning Cycle

• Specify Sources of Demand

• Run Collections

• Create a Plan

• Launch the Plan

• Review Key Performance Indicators (KPIs)

• Review Exceptions 

• Review Workflow Notifications

• View Pegged Supply and Demand

• Modify the Plan Environment

• Run Net Change

• Release or Firm Orders

Business Flows
This section describes the flows of information between the components of the Oracle 
Advanced Planning Suite and provides an overview of how these components are to be 
used together in order to accomplish several key business flows.

Topics covered in this section include the following:

• APS Information Flows
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• The Demand-to-Make / Demand-to-Buy Business Flow

• The Inquiry-to-Order Business Flow

APS Information Flows
The major information flows between the components of the Oracle Advanced Planning
Suite and the rest of Oracle Applications are shown in the figure below.

APS Information Flow

The Demand-to-Make / Demand-to-Buy Business Flow
The demand-to-make /demand-to-buy business flow begins with the establishment of 
independent demands that will drive the activities of the supply chain.

On the basis of sales history from Oracle Order Management, Oracle Demand Planning 
generates statistical demand forecasts. After adjustment by planners, these forecasts and
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their variability as estimated by Oracle Demand Planning are then input into Oracle 
Inventory Optimization.

Using user-supplied information about the variability of this forecast demand and the 
variability of supplier lead-times, Oracle Inventory Optimization generates an optimal 
time-phased safety stock plan.

Oracle Advanced Supply Chain Planning (hereafter, Oracle ASCP) considers three 
streams of independent demand: the safety stock planned demand from Oracle 
Inventory Optimization, forecasts from Oracle Demand Planning, and sales order 
demand from Oracle Order Management. Oracle ASCP outputs a time-phased supply 
plan (planned orders) that can then be released directly to the appropriate execution 
systems: Oracle Purchasing, Oracle Work in Process (for discrete manufacturing), 
Oracle Process Manufacturing, Oracle Flow Manufacturing, Oracle Project 
Manufacturing, or Oracle Shop Floor Management (for semiconductor manufacturing).

The Inquiry-to-Order Business Flow
The demand/supply picture output by Oracle ASCP serves as the basis for the order 
promising results calculated by Oracle Global Order Promising. Oracle Global Order 
Promising can be called either from a customer-facing order capture application such as
a web store or from Oracle Order Management.

In the inquiry-to-order business flow, an inquiry for a potential order is sent from 
Oracle Order Management to Oracle Global Order Promising. The fulfillment date 
returned by Global Order Promising, if later than the original request date, is populated
as the new request date of the order. This request date validation process is called 
scheduling. Once an order is successfully scheduled, then it can be booked and made 
visible to Oracle ASCP for supply planning purposes.

Planning Cycle
This section describes an end-to-end planning flow that a planner might perform 
during the course of a planning cycle. The flow demonstrates the key features of Oracle 
ASCP that a typical planner would use in the course of their work.

The general flow that occurs during a planning cycle is shown in the figure below.
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A Day in the Life of a Planner

Specify Sources of Demand
You can drive the plan with:

• Sales order demand

• Forecast demand

• A combination: In this case, the sales order demand reduces (consumes) the forecast
demand to avoid over-demanding.

The forecast demand comes from:

• Oracle MRP on the source instances.

• Oracle Demand Planning

• Oracle Demantra

• Your own system

Demand from Oracle MRP

Create a new or use an existing master demand schedule

Use the master demand schedule source list to associate individual forecasts with your 
MDS

Load the adjusted (unconstrained) forecasts into a master demand schedule. You can 
load individual forecasts, for example, for customers and sales regions, into a single 
master demand schedule and plan them all at once.

See Oracle MRP User's Guide .

Run collections.

Demand from Oracle Demand Planning

You do not have to run collections.
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See Oracle Demand Planning Implementation and User's Guide

Forecast Demand from Oracle Demantra

You use an interface process to move the forecasts to Oracle Advanced Supply Chain 
Planning

See Oracle Demantra Demand Management User's Guide.

Demand from Your Own System

See Overview of Running Collections, page 4-1. You may use the legacy collections 
process

Run Collections
Run collections to bring planning data from the source instance to the planning server, 
where the data will be accessible to Oracle ASCP. See 'Running Collections, page 4-1 
for more information.

Create a Plan
After an MDS has been defined, a Production, Manufacturing, or Distribution 
plan/schedule can be created.

To create a plan
1. Choose Supply Chain Plan > Names to create a new plan/schedule or modify an 

existing plan/schedule.

2. Select Plan Options to specify plan options.

3. Save your work.

See 'Defining Plans, page 5-1 for more information. 

Launch the Plan
After you have created your MRP, MPS, or MPP plan/schedule and saved it, choose the 
plan from [Production, Manufacturing, or Distribution Plan] > Names and select 
Launch Plan.

You can view the run status of your plan by choosing Other > Requests.

Review Key Performance Indicators (KPIs)
Once your new plan has completed running, you can evaluate the performance of the 
plan by comparing it to Key Performance Indicators (KPIs). Evaluating a plan based on 
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its impact to KPIs is a good way to see the high level impact of the plan without doing 
offline analysis and looking at plan details to see which demand is fulfilled on time and 
which is not.

The Key Indicators compare actual plan values to target values defined in the Target 
Repository. Evaluating plans against KPIs lets you select the plan which best meets 
organizational objectives that you have defined.

You can drill down to the trend over time using the right-mouse menu.

To review KPIs for a plan
1. Navigate to the Planner Workbench.

2. Choose either the Organizations tab or the Items tab in the left pane. 

3. Select the Key Performance Indicators tab in the right pane.

4. In the left panel, select the plan to evaluate or the plans to compare.

5. View the results on the graphs in the right panel.

SeePlanner Workbench , page 18-1 and Key Performance Indicators , page 12-69 
for more information.

Review Exceptions 
After you have evaluated your plan(s) based on KPIs, you can evaluate a plan based on 
the number and types of exceptions it generates. Reviewing the exceptions generated by
a plan lets you evaluate a plan's performance in more detail than a KPI comparison 
provides. For each exception type displayed in the Planner Workbench, you can click 
and drill down on an exception to get more detailed information about the nature of the
exception.

Oracle ASCP provides a range of exception messages for all plans. You can easily 
manage your plan by displaying only those items and orders that require your 
attention, and you can further narrow your search using other criteria such as by buyer 
or by line. By saving the exception messages each time you replan simulations, you can 
compare different versions of the same plan or analyze the strengths and weaknesses of 
a single plan.

For guidelines on evaluating and interpreting the exceptions generated by your plan, 
see 'Exception Messages., page 17-1

To review exceptions for a plan
1. Navigate to the Planner Workbench.
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2. Choose the Organizations or Items tab in the Navigator and select the plan(s) for 
which you want to view exceptions.

3. Select [right-click] > Exceptions > Details. Exceptions are displayed by exception 
type on the top portion of the window. Exception counts can be viewed graphically 
at the bottom of the window.

4. Double click on an exception to drill down to detail. 

Refer to 'Exception Messages, page 17-1 for more information. 

Review Workflow Notifications
Oracle ASCP's powerful collaboration features enable you to automate and streamline 
your interactions with customers and suppliers.

You can automate the processing of exceptions which lets you take corrective action 
more quickly and efficiently, driving overhead costs out of your process.

You can define the process that a Workflow Notification should follow which includes 
the routing for the exception notifications, actions available to the recipient of the 
notifications, and the approval steps. The messages can be viewed either in 
Applications (see Review Exceptions, page 3-6) or via E-mail. Certain response actions 
may be required.

This table shows the standard workflow processes which generate various types of 
exceptions.

Process Exception Types

Item Workflow • Item is over committed

• Item has a shortage

• Item has excess inventory

• Items with expired lots

• Past due forecast

• Late supply pegged to a forecast

• Items below safety stock
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Process Exception Types

Rescheduling Workflow • Item has orders to be rescheduled in

• Item has orders to be rescheduled out

• Item has orders to be cancelled

• Item has orders with compression days

• Item has past due orders

Sales Order Workflow • Past due sales orders

• Late supply pegged to a sales order

Project Workflow • Items with shortage in a project

• Items with excess in a project

• Items allocated across projects

Material Workflow • Material constraint (supplier capacity 
constraint)

See the Oracle Workflow Guide for more information on creating notifications and 
building new workflows. 

View Pegged Supply and Demand
You can easily analyze the impact of changing a supply or demand order at any level of
your bill of material using the powerful graphical pegging feature. Full pegging traces 
supply information for an item to its corresponding end demand details. Full pegging 
can also link a demand order to all corresponding supply. You can trace a purchased 
item or subassembly shortage to the sales order that would be affected. You can use this
information to prioritize critical material and capacity resources.

To use graphical pegging you must select Pegging in the Plan Options window. You 
must also have the Pegging item attribute (in Oracle Inventory) set to one of the 
pegging options.

For more information on pegging, see 'Supply/Demand Window, page 18-64. Also, 
please refer to Item Attribute Controls in the Oracle Inventory User's Guide for more 
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information. 

Modify the Plan Environment

Modify Objectives
If you are unsatisfied with the results of your plan, you may wish to change your 
optimization objectives to improve the plan's performance against KPIs or reduce the 
number of exceptions.

Available Supply Chain Optimization objectives are:

• Maximize Inventory Turns

• Maximize Plan Profit

• Maximize On-time Delivery

To run an optimized plan
Choose Supply Chain Plan > Options > Optimization tab to check the Optimization 
check box and adjust optimization objectives or associated penalty costs.

Once you have changed objectives, you can run a new, separate plan, or you can run a 
simulation in net change mode to view only the differences between the baseline plan 
and the simulated plan.

See Overview of Optimization, page 8-1 and Overview of Simulations, page 7-1 for 
additional information. 

Alternatively, you may evaluate your plan or check feasibility based on available 
material and resources by running an unconstrained plan.

To run an unconstrained plan
1. Choose Supply Chain Plan > Options.

2. Choose the Constraints tab and check Constrained Plan and Enforce Demand Due 
Dates.

3. Select No for the material and resource constraint settings.

4. In the Optimization tab, uncheck Optimize.

Once you have made the change you can run a new, separate plan, or you can run a
simulation in net change model to view only the differences between the baseline 
plan and the simulated plan.
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See 'Overview of Optimization, page 8-1 and 'Overview of Simulations, page 7-1
for additional information. 

Modify Supply/Demand
After you have run additional plans or simulations based on changes to your 
optimization objectives, you may still be unsatisfied with the results of your plans.

At this point, you may wish to consider the impact to changing demand and supply 
levels. You can quickly and easily simulate the impact of changes in inventory, 
purchase order schedules, and product demand. Changes to demand can be performed 
directly in your MDS or to individual forecasts associated with your MDS. Changes to 
supply may consist of changes to material availability (for example, supplier capacity) 
or to resource availability. You can make changes to either capacity or materials and see
the effects of these changes on your plan.

To modify demand/supply
1. Navigate to the Planner Workbench. 

2. Choose Tools > Supply/Demand.

3. Select the Supply/Demand you want to change from the list of values. 

4. Make the desired changes and close the window. 

Modify Resources
To increase available supply, you may wish to modify resource availability. 

There are a number of ways in which to modify resources:

• Add additional production resources (for example, add shifts).

• Define alternate resources available for producing particular items.

• Change the resource consumption for an item (for example, change the amount of 
an item that can be produced in a given amount of time).

To modify resources
1. Navigate to the Planner Workbench. 

2. Choose Tools > Resources.

3. Make the desired changes and close the window.
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Modify Supplier Parameters
At this point you might choose to modify supply parameters such as Supplier Capacity,
Supplier Order Modifier, and Supplier Tolerance Fence. For more information see 
Supply Chain Modeling., page 6-1

Run Net Change
After you have changed optimization objectives, demand, supply or resources, you can 
run simulated plans in net change mode to view only the differences of the simulated 
plan compared to a baseline plan.

Net change is used for changes to:

• Item supply and demand, resource availability

• Your objectives

• Demand priority rules

• Sourcing

• BOM/Routing effectivity

See Running Net Change Replan Simulations , page 7-4for more information.

Review a Constrained Forecast that Results from Net Change Planning
The forecast or MDS that is loaded into a Supply Chain Plan is generally a prediction of 
total customer demand, regardless of your company's ability to produce the demand.

After a Supply Chain Plan has been run based on an unconstrained forecast/MDS as an 
input, the resulting plan that has been constrained by material and resource availability 
is a demand plan constrained by production capabilities.

The easiest way to view the differences between an unconstrained demand plan and a 
constrained demand plan is to view the exceptions that occur after the Supply Chain 
Plan is run with material and resource constraints set to Yes in plan options.

The exception message Late forecast for customer demand will show all demand that 
could not be met due to material and resource limitations.

An alternate way to compare an unconstrained demand plan to a constrained plan is to 
run your Supply Chain Plan once with material and resource constraints set to No in 
plan options and run a second plan with material and resource constraints set to Yes. 
The two plans can then be compared side by side via KPI comparisons or exception 
comparisons.
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Release or Firm Orders

To release or firm orders
1. From the Planner Workbench, choose Tools > Supply/Demand. 

2. In the Order tab, choose an organization and an item then choose to release or firm 
orders for that organization or item. 

You can also redefine release properties for the organization or item. 

.
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4
Running Collections

This chapter covers the following topics:

• Overview of Running Collections

• Definitions

• Collection Strategy

• Architecture

• Collection Methods

• Running Standard Collections

• Data Changes That Can Be Collected in Net Change Mode

• Continuous Collections

• Legacy Collection

• Organization Specific Collections

Overview of Running Collections
Oracle ASCP has a component architecture that allows a single instance of Oracle ASCP
to plan one or more transaction instances. The transaction instances can be a mixture of 
releases. The Oracle ASCP planning instance (referred to as the planning server) can sit 
on the same instance as one of the transaction instances, or be a separate instance 
altogether. In either case (even if the planning server shares an instance with the 
transaction instance to be planned), data to be planned is brought from the transaction 
instance(s) to the planning server via a process called Collection. 

This section describes the architecture used in the collection of planning data from 
multiple operational sources into Oracle ASCP. These sources could be different 
versions/instances of Oracle Applications or other legacy systems. Oracle ASCP uses a 
data store based on the planning data model that is exposed through interface tables. 
The data is pulled from the designated data sources into its data store; Oracle ASCP 
Collections are responsible for synchronization as changes are made to the data sources.
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The configurability of the collections is enabled through a pull program based on AOL 
concurrent program architecture. Thus, for example, different business objects can be 
collected at different frequencies. Supplies and demands, which change frequently, can 
be collected frequently. Routings and resources, which change relatively less often, can 
be collected less frequently.

The data collection process consists of the Data Pull and the Operational Data Store 
(ODS) Load. The collection process lets you collect across several Oracle Application 
versions. It supports several configurations. The two types of collections process are 
standard and continuous.

• Standard collections process: Using the standard collections process, you can 
manually run three types of collection methods including a complete refresh, a net 
change refresh, or a targeted refresh on specific business entities.

• Continuous collections process: The continuous collections process is an automated 
process of data collection that efficiently synchronizes the data on the planning 
server by looking up the sources. If you opt for continuous collections, the system 
automatically determine the type of collection that needs to be run on entities 
selected by you. The continuous collections process collects data from the sources 
with the least user intervention. The Continuous Collections concurrent program 
performs continuous collections.

Collections Data Notes
Calendar: Oracle recommends that you load calendars separate from all other entities 
and before all other entities. When you collect all other entities, set Calendar selection to
No..

Currency: Currencies collected from Oracle Order Management and Oracle Purchasing 
are posted in functional currency even if their source is in transactional currency.

Currency Conversion Rates: Collect currency and currency conversion rates for a past, 
current and future period from the source in order to support displaying the cost in 
reporting currency. The default value is No. Currency conversion rates are collected 
only: 

• If profile option MSC: Planning Hub Currency Code is Yes

• For standard collections

See profile options:

• MSC: Currency Conversion Type

• MSC: Planning Hub Currency Code

• MSC: History Days for Currency Conversion
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• MSC: Future Days for Currency Conversion

Discrete Jobs: A discrete job that is complete and not closed appears in the collected 
data with quantity zero. A discrete job that is complete and closed does not appear in 
the collected data. You can control this with profile option MSC: Collect Completed Jobs

Drop ship purchase orders: The collections process does not collect supplies against 
drop ship purchase orders because the planning engine does not plan drop ship sales 
orders.

End-Item Substitutes: You can see end-item substitutes in Collections Workbench as 
long as you have not defined a substitute set. If you have defined a substitute set, use 
Planner Workbench Items window to see the substitute set and end-item substitute.

Global Forecasts: You can review global forecast entries in Collections Workbench 
horizontal plan using rows Original and Cumulative Original.

Inactive forecasts: The collections process does not collect the demands of inactive 
forecasts if run in Full Refresh or Targeted Refresh collections mode

Intransit, Purchase Order, and Requisition: Oracle recommends that you always collect 
purchase order, requisition and intransit together. To do so, set Planning Data Pull 
parameter Purchase Orders/Purchase Requisitions to Yes.

Routings: The collections process does not collect routing operation resources with 
Schedule = No and does not display them in their routings. It also does not collect 
alternate resources of primary resources that are Schedule = No, even if the alternate 
resources themselves are Schedule = Yes.

Trading Partners: When loading trading partners, access file Parameters.txt and set 
Calendar_Overwrite_Flag to N.

Definitions
You should be familiar with the following terms before examining the data collections 
architecture:

Oracle Applications Data Store (ADS): The set of source data tables in each transaction 
instance that contain data relevant to planning.

Operational Data Store (ODS): The planning data tables in the planning server that act 
as destination for the collected data from each of the data sources (both ADS and 
Legacy). 

Planning Data Store (PDS): The outputs of the planning process. The PDS resides in the 
same data tables as the ODS. However, PDS data are marked with plan IDs that show 
which plans they correspond to, while ODS data are marked with plan ID = -1.

Standard Data Collection: The standard data collection process enables you to select the 
mode of data collection. You can use a complete refresh, a net change (increamental) 
refresh, or a targeted refresh Standard data collection consists of the following 
processes:
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• Planning Data Pull: Collects the data from the ADS and stores the data into the 
staging tables. This pull program is a registered AOL concurrent program that 
could be scheduled and launched by a system administrator. If you are using a 
legacy program, you must write your own pull program.

• ODS Load: A PL/SQL program which performs the data transform and moves the 
data from the staging tables to the ODS. This collection program is a registered 
AOL concurrent program that could be scheduled and launched by the system 
administrator.

Continuous Data Collection: The continuous data collection process automates the 
process of looking up the sources to populate the tables on the planning server. With 
the least user intervention, the continuous data collection process determines the type 
of collection to perform on each type of entity. The Continuous Collections concurrent 
process performs continuous collections.

Collection Workbench: The Collection Workbench is a user interface for viewing data 
collected over to the planning server from the transaction instances. The functionality 
here is similar to Planner Workbench functionality. For more information on the 
Planner Workbench, see 'Overview of Planner Workbench, page 18-1.

Collection Strategy
Major features of the collection process include:

• Multiple Source Instances

• Pull Architecture

• Detect Net Changes to Synchronize Oracle Applications and Oracle ASCP

• Multi-Process Collection Architecture

• Data Consolidation

• Projects/Tasks, and Seiban Numbers

• Support for several Oracle Applications Versions and RDBMS Versions

• Support for Several Configurations

Multiple Source Instances
You can register any number of source data instances and non-Oracle data sources on 
each Oracle ASCP installation.
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Pull Architecture
You can collect new source data instances into Oracle ASCP with minimal impact. The 
data is pulled from the source data instance by Oracle ASCP. Each instance can have its 
own refresh interval. A failure in one instance will not affect data collections from other 
instances. 

Detect Net Change to Synchronize Oracle Applications and Oracle ASCP
You can synchronize the data in Oracle Applications transaction instances and the 
Oracle ASCP planning server in a net change mode. Thus, only the changed source data
is collected each time, reducing the computational burden on the collection process.

Multi-Process Collection Architecture
You can enhance the performance of the pull program by distributing the tasks to 
multiple collection workers. 

Data Consolidation
The collection program can consolidate the entities shown in the following table across 
instances based on the corresponding user-defined keys.

Entity User Key

MTL_SYSTEM_ITEMS Concatenated Item Segments

MTL_CATEGORIES Concatenated Category Name

MTL_CATEGORY_SETS Category Set Name

PO_VENDORS Vendor Name

PO_VENDOR_SITES Vendor Site Code

RA_CUSTOMERS Customer Name

RA_SITE_USES_ALL Customer Name, Site Use Code, Location 
Operating Unit

Unit Of Measure UOM Code

For all the entities not described in the table, the instance ID together with the entity key
in each instance uniquely identifies each row.
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Projects/Tasks and Seiban Numbers
You can consider Projects, Tasks, and Seiban Numbers to be unique within the context 
of an Oracle Applications instance; no consolidation is required.

Support for Several Configurations
You can perform centralized and decentralized configurations based on the scale of the 
enterprise and specific business needs. Source data applications and Oracle ASCP can 
reside on one server or on separate servers. 

Architecture
Oracle ASCP's data collection architecture, shown in the figure below, depicts the data 
objects, procedures, and data flow between source data and Oracle ASCP. The major 
repositories are ADS, ODS, and PDS. Procedures enable data cleansing, data collecting, 
data communication, and net-change handling between data repositories. 

When Oracle ASCP and its source data reside on the same instance, communication 
between them is enabled by PL/SQL based public API procedures or interface tables. In 
a distributed environment, procedure calls are made using database links.
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Data Collections Architecture

Supported Configurations
Oracle ASCP supports the following planning configurations for installation and 
deployment:

• Centralized

• Decentralized

These configurations offer you enough flexibility to design a mode of planning that 
suits your business objectives. Both configurations are supported using a consistent 
architecture as outlined in the previous section. The sole distinction is that centralized 
planning uses database links to pull data into the Oracle ASCP data store. 

Decentralized Planning
The following figure shows the decentralized planning configuration: 



4-8    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Oracle ASCP works as a central Planning Server across several source data instances. 
The collection program is installed on the planning server and the data stripped by 
instance is moved into staging tables within Oracle ASCP during the data collection 
process.

After the planning process, results can be pushed back to each instance.

Centralized Planning
This figure shows the centralized planning configuration.

Oracle ASCP and its source data reside in the same database. No database link is 
required in this case. Two components can communicate through the planning object 



Running Collections    4-9

APIs and the interface tables defined in Oracle Applications.

In this configuration, shown in the following figure, a simplified architecture is used, 
and the data transformation is not required.

Simplified Data Collections Architecture

Collection Methods
Collecting data can take a significant amount of time compared to the time for the 
overall planning cycle. Oracle Advanced Supply Chain Planning (ASCP) provides a 
collection method that allows the collections duration to be reduced in cases where 
information about some - but not all - planning-related business entities on the planning
server needs to be updated.

There are three collection methods:

• The Complete Refresh method clears all transaction data for all business entities 
from the planning server (for the source instance being collected), then copies over 
information about the user-selected entities. This method can be time consuming.

• The Targeted Refresh method clears transaction data for only the user-selected 



4-10    Oracle Advanced Supply Chain Planning Implementation and User's Guide

business entities from the planning server, and then copies the entity information 
over from the transaction instance. Information about unselected entities remains 
intact on the planning server. All planning business entities are supported by 
Targeted Refresh collections. When running targeted refresh for entity Trading 
partners, also collect entity Calendars. This ensures that the Oracle Project 
Manufacturing organizations are set up as organization type process so that the 
release process from Oracle Advanced Supply Chain Planning to Oracle Project 
Manufacturing succeeds.

• The Net Change Refresh method copies only incremental changes to business 
entities to the planning server (and is thus faster), but is supported mainly for 
demand and supply business entities only.

Running Standard Collections

To collect data from an Oracle Applications transaction instance
1. Sign on using the Advanced Supply Chain Planner responsibility or the Advanced 

Planning Administrator responsibility.

2. Navigate to the Planning Data Collection window by selecting Collections > Oracle 
Systems > Standard Collection.

The Planning Data Collection window appears.

This window shows you that the collections process consists of two sequentially 
executed concurrent programs. The first program, Planning Data Pull, copies 
information from the source instance into the APS staging tables on the planning 
server. Here, against the data held in the staging tables, ASCP performs some basic 
cleansing. For example, it ensures that items with the same names that are collected 
from different source instances will be assigned the same internal IDs (recognized 
as the same item). Further cleansing operations on the staging tables (if desired) 
may be done at this point via any custom concurrent program. This custom 
concurrent program would need to be inserted into the Planning Data Collection 
request set, in between Planning Data Pull and Planning ODS Load. The second 
program, Planning ODS Load, copies information from the APS staging tables into 
the operation data store on the planning server, where it becomes available for use 
during planning.

3. Select the Parameters field for the Planning Data Pull program. 

The Planning Data Pull Parameters window appears.

4. Use the information in the following table to set up parameters in the Planning Data
Pull Parameters window.
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Parameter Values

Instance Source instance code from list of values.

Number of Workers One or greater. Increase this number to 
increase the amount of computational 
resources to devoted to the Planning Data 
Pull process. This allows you to specify the 
number of workers for the Data Pull, which 
can now be different from the number of 
workers specified for the ODS load process.

Timeout (Minutes) The maximum amount of time you would 
like to allocate to the Planning Data Pull 
process. If the Planning Data Pull process 
has not completed within this amount of 
time, it will be terminated with an error.

Purge Previously Collected Data Yes (default) or No. Setting this to Yes 
wipes out all data in the APS planning 
server operational data store associated 
with the selected source instance as the first 
step in the collections process. If you set this
to Yes, the only allowable collection method
is Complete Refresh. If you set this to No, 
the allowable collection methods are 
Targeted Replacement and Net Change.

Collection Method Complete Refresh/Targeted Refresh/Net 
Change Refresh. 

Analyze Staging Tables Yes or No (default). Set this to Yes 
periodically to recompute database access 
statistics on the APS staging tables. This 
speeds up the subsequent Planning ODS 
Load process.
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Parameter Values

User Company Association The possible values are:

• No: During data collections, the 
destination instance does not accept the
following: New users' company 
association and existing users with 
changes to their company association.

• Create users and enable user company 
association: A user created on one of 
the source instances can be 
automatically created on the planning 
server or destination instance. You can 
use this option when you need to work 
with multiple source instances or 
systems.

Create a new user, specify the user's 
contact information during setup, and 
initiate a data collection. The user is 
created on the destination instance or 
planning server and is assigned the 
Supply Chain Collaboration Planner 
responsibility. The new user can log 
onto Oracle Collaborative Planning and
view data that is visible to the 
associated company.

• Create a new user, specify the user's 
contact information during setup, and 
initiate a data collection. The user is 
created on the destination instance or 
planning server and is assigned the 
Supply Chain Collaboration Planner 
responsibility. The new user can log 
onto Oracle Collaborative Planning and
view data that is visible to the 
associated company.

Create a new user on the source 
instance and specify the user's contact 
information during the setup. Create 
the user on the destination instance or 
planning system and assign the user 
responsibilities. Start a data collection 
to complete the user's company 
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Parameter Values

association. This ensures that the user 
has all the assigned responsibilities.

The remaining parameters in the Planning Data Pull Parameters are a list of 
business entities. Selecting Yes for an entity means collect the information for that 
entity over from the source instance. Selecting No for an entity means don't collect 
the information for that entity over from the source instance.

Note: The default value for these entities is set to Yes. Collecting 
information for Resource Availability and Sourcing History takes a 
significant amount of time. Collect this information only when 
necessary.

5. Select OK. 

6. Select the Parameters field for the Planning ODS Load program. 

The Parameters window appears.

7. Use the information in the following table to specify the fields and options in this 
window. 

Parameter Values

Instance Source instance code from list of values.

Timeout (Minutes) Number of minutes before the concurrent 
program will end.

Number of Workers One or greater. Increase this number to 
increase the amount of computational 
resources to devoted to the Planning ODS 
Load process.
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Parameter Values

Recalculate Resource Availability This defaults to the value (Yes or No) that 
you set for the Resources Availability 
business entity in the Planning Data Pull 
Parameters window. The value that you set 
here is the one that actually determines 
whether resources availability is collected or
not.

Recalculate Sourcing History This defaults to the value (Yes or No) that 
you set for the Sourcing History business 
entity in the Planning Data Pull Parameters 
window. The value that you set here is the 
one that actually determines whether 
sourcing history is collected or not. If you 
select Yes, then ASCP will collect all new 
sourcing history not already on the 
planning server in the time range [(today - x
months) through (today)] from the source 
transaction system. The number x is given 
by the value that you set for the profile 
option MSC: Sourcing History Start Date 
Offset (in months). During planning, ASCP 
will use the total cumulative sourcing 
history on the planning server in addition to
the planned sourcing in the plan to 
determine whether sourcing percentages in 
sourcing rules are being respected or not.

Purge Sourcing History Valid values are Yes and No (default). If 
you select Yes, then all sourcing history 
present on the planning server will be 
deleted before the collection process 
commences.

8. Select OK. 

9. Select Submit in the Planning Data Collection window to run collections 
immediately, or select Schedule to schedule collections for some later time. 

If you select Schedule, the Schedule window appears.

Note: If you want to perform an incremental refresh frequently, use
this feature. 
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You have complete control over the timing and frequency of the 
collection of data from the transaction systems, and the timing and 
frequency of planning. You can manage the balance between 
network traffic and the need to monitor current status in your 
plans.

10. Select a frequency for running the job in the left pane. Complete any additional 
fields that appear based on your selection. 

11. Click OK.

12. Choose Submit in the Planning Data Collection window.

13. From the toolbar, choose View > Requests to view the status of the collection 
process.

The Find Requests window appears. 

14. Select a type of requests to view then select Find. 

The Requests Window displays data collection progress. 

15. After the collection process completes, view your results. 

If concurrent process Refresh Snapshot ends in a warning and you have 
configure-to-order items, there may be a setup issue with those items. Concurrent 
process Refresh Snapshot calls the configure-to-order applications programming 
interface to explode the configured bills of material and create demand in the 
proper manufacturing organizations. Check the log file of the configure-to-order 
applications programming interface for details of the setup issues and take 
corrective action.

If your collections process runs on an Oracle 8i database and the collections process 
fails, attend to the following troubleshooting information:

• If it fails with an Autonomous Transaction within Distributed Databases error 
either at any point in the Data Pull /Pull Workers run or when launching 
Refresh Snapshots, set profile option FND:Log Enabled to No.

• If it fails in Planning Data Pull Worker when collecting sales orders or hard 
reservations, either set profile option OM:Debug Level to null value or set it to a
value lower than 5

16. From the Navigator window, choose Collection > Workbench.

Notice that data is brought over from selected instances.
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Note: Users can collect forecasts into the planning server. If you 
want the collections program to collect a forecast set, select the 
Advanced Planning Collections checkbox while defining the 
forecast set.

Data Changes That Can Be Collected in Net Change Mode
When the net change mode for collections is selected (by setting the collections 
parameter Complete Refresh to No), the data changes shown in the following table can 
be collected. If you set the collections parameter Complete Refresh to yes, the collections
program collects the entire data for the entity.

All other data changes must be collected by running full collections (by setting the 
collections parameter Complete Refresh to Yes). Net change collections run more 
quickly than full collections.

You can run data collections in net change mode for these transactions:

Data Element Comments

Sales orders Cancellations of or modifications to sales 
orders and sales order reservations are 
captured. Net change collections always 
collects sales orders; it is not dependent on 
any parameters or settings, including 
collection parameter Pull Sales Orders.

Reservations against demands Reservations against both external and 
internal sales order demands are captured. Set
the Planning Data Pull parameter 
Reservations to Yes.

Master production schedule demands MPS demands that are added, modified or 
relieved in the source instance are captured. 
Set the Planning Data Pull parameter Master 
Production Schedules to Yes.

Master demand schedule Set the Planning Data Pull parameter Master 
Demand Schedules to Yes.
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Data Element Comments

WIP component demands Demand changes due to cancellation of WIP 
jobs, changes in the state of WIP jobs (for 
example, operations within a job have been 
performed or cancelled), and changes to WIP 
jobs because of changes in item information 
are captured. Set the Planning Data Pull 
parameter Work in Process to Yes.

WIP repetitive item demands Demand changes due to cancellation of WIP 
repetitive schedules, changes in the state of 
WIP repetitive schedules, and changes to WIP 
repetitive schedules because of changes in 
item information are captured. Set the 
Planning Data Pull parameter Work in Process
to Yes.

Forecast demands Changes and deletions in forecasts are 
captured. Set the Planning Data Pull 
parameter Forecasts to Yes.

User demands Changes to user demands because of changes 
to item information are captured. Set the 
Planning Data Pull parameter User Supplies 
and Demands to Yes.

Master production schedule supplies Changes in supply schedules or item 
information are captured. Set the Planning 
Data Pull parameter Master Production 
Schedules to Yes

User supplies Changes to user supplies because of changes 
to item information are captured. Set the 
Planning Data Pull parameter User Supplies 
and Demands to Yes.

Purchase order supplies Changes to PO supplies because of rejections, 
returns, or cancellations or changes to item 
information are captured. Set the Planning 
Data Pull parameter Purchase 
Orders/Purchase Requisitions to Yes.

On-hand supplies Set the Planning Data Pull parameter On 
Hand to Yes.
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Data Element Comments

Work orders in Oracle Work in Process Changes in WIP Jobs are captured. Set the 
Planning Data Pull parameter Work in Process
to Yes.

Resource availability You can use net change mode in discrete 
manufacturing organizations. Set the Planning
Data Pull parameter Resource Availability to 
Collect and Regenerate Data.

If you are a process manufacturing 
organization, use complete refresh.

Supplier capacity Set the Planning Data Pull parameter 
Approved Supplier Lists to Yes.

Bills of material All BOM changes are captured: new 
components, disabled components, 
component quantities, effectivity dates, BOM 
revisions, and component substitutes. Set the 
Planning Data Pull parameter Bills of 
Materials / Routings / Resources to Yes.

Routing operations Changes to and deletions of routing 
operations as a result of changes to operation 
sequences (for example, the addition of new 
operations, the disabling of operations, or the 
changing of operation dates), the disabling of 
a routing, the changing of routing dates, or 
changes to item information (for example, the 
disabling of an item, the creation of a new 
item) are captured. Set the Planning Data Pull 
parameter Bills of Materials / Routings / 
Resources to Yes.

Components needed for a routing operation Changes to and deletions of components 
needed for a routing operation are captured. 
Set the Planning Data Pull parameter Bills of 
Materials / Routings / Resources to Yes.

Resources attached to a routing operation Changes to and deletions of operation 
resources or operation resource sequences 
within a routing are captured. Set the 
Planning Data Pull parameter Bills of 
Materials / Routings / Resources to Yes.
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Data Element Comments

Resource requirements for WIP jobs Changes in resource requirements of WIP jobs
because of completion of the WIP jobs, 
completion of operations within the WIP jobs, 
or changes in item information are captured. 
Set the Planning Data Pull parameter Work in 
Process to Yes.

Items or Item categories Changes in items and items categories are 
captured. Set the Planning Data Pull 
parameter Items to Yes.

Transactions (supply and demand) change more frequently than setup entities. After 
data collections, the collections program maintains snapshots of transaction entities. 
Each time you run data collections, the collections program looks at the snapshot to 
determine if the transaction entity has changed since the previous collections. If it has, 
the collections program collects the incremental data changes and updates the snapshot.
As setup entities change less frequently, the collections process does not keep snapshots
for these and cannot perform net change collections on them. Schedule either a targeted 
or a complete refresh for setup.

You cannot run data collections in net change mode for the following setup entities:

• Simulation sets

• Resource shift setup

• Projects or project tasks

• Units of measure (class conversion, conversions)

• Sourcing information

• Bills of resources

• Calendar information (start dates calendar dates, calendar week, calendar shifts, 
shift Dates, shift exceptions, shift times, period start dates)

• Interorganization ship methods

• Planning parameters

• Planners

• Business intelligence systems periods
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• Resource groups

• Demand classes

• Available to promise (ATP) rules

• Trading partners (customer or customer sites, suppliers, supplier sites, 
organization, organization sites, location associations, customer, vendor, buyer, 
contacts)

Continuous Collections
Continuous collection is an automated process that synchronizes snapshot-enabled data
entities (supply and demand) and snapshot-disabled setup entities (suppliers, 
customers and supplier rules) between the sources and the planning server. You can 
schedule separate collection programs for collecting data entities and setup entities.

The Continuous Collections concurrent program performs the process of continuous 
collections. You have to select only those business entities for which the collections 
process needs to run automatically. The Continuous Collections concurrent program 
determines the appropriate mode of performing collections for the selected business 
entities. You can run continuous collections on the following entities:

• For entities that have snapshots associated with the source, you need to specify a 
threshold value (as a percent). Based on this value, the Continuous Collections 
concurrent program determines whether the collections should run in the Targeted 
mode or the Net Change refresh mode. If continuous collections are run frequently, 
then for most entities, the data collections are performed in the Net Change Refresh 
mode.

• If the changed records percent is below the threshold percent, the concurrent 
process collects only the changed records (Net Change Refresh) from the snapshot 
log.

• If the changed records percent is higher than the threshold percent, the concurrent 
process collects all of the rows (Targeted Change Refresh) from the snapshot.

• If there are no changed records, the concurrent process does not collect any data.

The following table details whether or not snapshots are associated for the entities 
supported by continuous collections:

Entities Snapshot Associated

Approved supplier lists (Supplier capacity) Yes
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Entities Snapshot Associated

Bills of material Yes

Routings Yes

Resources Yes

Bills of resources Yes

Forecasts Yes

Items Yes

Master demand schedule Yes

Master production schedule Yes

On hand quantity Yes

Purchase orders Yes

Purchase requisitions Yes

Sales orders Yes

User supplies and demands Yes

Work in process Yes

Available to promise rules No

Calendars No

Demand classes No

End item substitution No

Key performance indicator targets No

Planning parameters No
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Entities Snapshot Associated

Planners No

Projects and tasks No

Reservations No

Resource availability No

Safety stock No

Sourcing history No

Sourcing rules No

Subinventories No

Trading partners (customers and suppliers) No

Unit numbers No

Units of measure No

User company association No

For entities without snapshots, the concurrent program always initiates targeted 
refresh.

You can plan to use continuous collections when extensive transactions are involved. 
For example, a manufacturing company with extensive work in process transactions 
might setup continuous collections to run every 20 minutes to collect on hand balance. 
Similarly, Oracle Collaborative Planning users might schedule continuous collections 
every 2 minutes if they want to view the current supplies status.

Running Continuous Collections

To collect data from an Oracle Applications transaction instance
1. Sign on using the Advanced Supply Chain Planner responsibility or the Advanced 

Planning Administrator responsibility.

2. From the Navigator, select Collections > Oracle Systems > Continuous Collection.
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The Continuous Collections window appears.

This window enables you to schedule the process of data collection, set parameters 
that are required for running Continuous collections, select language preferences, 
and specify the notification tasks that need to be triggered on completion of 
Continuous collections.

3. Click in the Parameters field to set values that the concurrent program would 
require to perform Continuous collections.

The Parameters window appears.

Specify Yes for the entities that you want the Continuous Collections concurrent 
program to consider for collection. Most of the fields in this window are similar to 
the parameter fields for the Standard collections process. The parameter that 
distinguishes the Continuous collections process from the Standard collections 
process is Snapshot Threshold (%). By default, the threshold value is set to 40%. 
You can change this value.

4. Select OK.

5. Select Schedule in the Continuous Collections window to schedule collections.

The Schedule window appears.

6. Select the frequency for running collections in the left pane. Complete any 
additional fields that appear based on your selection.

7. Click OK.

8. Select Submit in the Continuous Collections window.

9. From the toolbar, choose View > Requests to view the status of the collections 
process.

The Find Requests window appears.

10. Specify the type of request you want to view.

11. Select Find.

The Requests window displays the status of the data collection process.

After the collection process completes, view the result in the Collection Workbench.

Legacy Collection
Legacy Collection provides an open framework for consulting and system integrators to
bring data from legacy systems into Oracle APS / CP. You can upload data by batch 
upload of flat files. This is achieved in part by extending the interface table capabilities. 
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A preprocessing engine validates the incoming data from legacy application and 
ensures that referential integrity is maintained. All business objects can be imported 
into APS using flat files.

In addition to collecting data from your ERP instance to your planning instance, you 
can collect data to the Planning instance from:

• Your non-Oracle (legacy) systems

• Your trading partners' non-Oracle systems

To collect data from your non-Oracle ERP systems or your trading partners' systems, 
you model each non-Oracle ERP system or trading partner as an Oracle Applications 
organization and store their setup and transaction data there. Setup information 
includes organization setup, items, bills of material, resources, routings, and sourcing 
information. Transaction data is of the following types:

• On-hand balance

• Purchase orders

• Purchase requisition

• Work orders 

• Work Order component demand

• Intransit shipment and receipt

• Planned orders

• Local forecasts

• Demand schedules

• Sales orders

• Item suppliers

• Supplier capacities

• Supplier flex fences

You can perform the following steps to collect data from your trading partners' 
non-Oracle systems to your planning instance:

• Load setup data (such as items, BOMs, Trading Partners) from the trading partner's 
system to flat files. Load the flat files to the source (Oracle ERP) instance using the 
standard interfaces and use standard collections to move it to the destination 
(planning) server.
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• Load transaction data from flat files to the ERP instance (representation of Oracle 
ERP system's data) of your planning server. Use legacy collections to move data 
from the legacy instance to the planning server.

The following diagram illustrates the flow of data from non-Oracle ERP (legacy) 
systems to an Oracle ERP application and the planning server.

Data Flow

Setup for Collection of Transaction Data into the Planning Server
• Define two types of organizations in the source instance. The first organization is 

for OEM and the second is for supplier and customer. You also need to define 
sourcing rules between the OEM organization and the supplier and customer 
organization.

• Import the setup data from your non-Oracle ERP system into the supplier and 
customer organization using the Oracle ERP open interfaces such as Items open 
interface, BOM open Interface.

To load the organizations for trading partners, you must first define the trading 
partners in previous loads .

• Collect all data from the OEM and supplier and customer organizations into your 
destination instance (planning server).

• Load transaction data into the each supplier and customer organizations flat files. 
Using either an Oracle Applications form or the self-service application, you can 
load data from the non-Oracle ERP system into the organizations. If you are using 
the self-service method, you can upload a zip file containing all the data.

Legacy Collections Data Notes

OWNING_PARTNER_SITE_CODE: Organization code
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OWNING_TP_TYPE: Valid values are:

• 1: Supplier

• 2: Inventory Organization

PLANNING_PARTNER_SITE_CODE: Organization code

PLANNING_TP_TYPE: Valid values are:

• 1: Supplier

• 2: Inventory Organization

Resource Balance Flag: Indicates whether a resource is load balanced. Valid values are:

• 1: Yes

• 2: No

This flag is only for Oracle Process Manufacturing. Since you cannot use legacy 
collections with Oracle Process Manufacturing, always leave this field null.

Unit of Measure: Load all base unit of measure comversions without an item name This
creates rows in MSC_UOM_CONVERSIONS with inventory_item_id = 0, for example: 

• Base UOM: LB

• Standard conversions: KG - LB, Gram - LB, Kiloton - LB, mg - LB, Oz - LB, Ton - LB,

For specific conversions across UOM Class or specific intra-class unit of measure 
conversions for some items, load them using the item name

Process
You push legacy data, such as items, bills of materials, routings, etc. into Oracle APS 
interface tables using batch upload. Batch upload is done using Oracle SQL*Loader. 
SQL*Loader requires that data is brought over in a format described in a control file. 
Oracle has provided control files for all the interface tables. The list of control files is 
available in Oracle iSupport.

The following diagram shows the movement of data from legacy systems into the 
Oracle APS server via interface tables using the batch upload process.
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Legacy Application

Setting up Batch Uploads
The System Integrator must do the following to set up the batch uploads:

1. Map the Oracle APS interface tables' control files (a control file is a template that 
specifies the input data format) to the legacy system's tables. The list of control files 
is available in Oracle iSupport. 

2. Create scripts to extract data from the legacy system in the format prescribed by the
control files.

When loading for trading partner sites, provide values for the location for 
organizations (Partner Type = 3); do not provide values for the location for 
customer and supplier sites (Partner Type = 1 or 2).

For example, the following is the control file for Purchase Order Supplies 
(MSC_ST_SUPPLIES_PO.ctl)

OPTIONS (BINDSIZE=1000000, ROWS=1000, SILENT=(FEEDBACK,DISCARDS))

LOAD DATA

INFILE 'MSC_ST_SUPPLIES_PO.DAT'

APPEND

INTO TABLE MSC.MSC_ST_SUPPLIES

FIELDS TERMINATED BY '~'
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(

ITEM_NAME,

ORGANIZATION_CODE,

NEW_SCHEDULE_DATE,

SUPPLIER_NAME,

FIRM_PLANNED_TYPE" NVL(:FIRM_PLANNED_TYPE,1)",

SUPPLIER_SITE_CODE,

PURCH_LINE_NUM,

ORDER_NUMBER,

SR_INSTANCE_CODE,

REVISION "NVL(:REVISION,1)",

UNIT_NUMBER,

NEW_ORDER_QUANTITY,

NEW_DOCK_DATE,

PROJECT_NUMBER,

TASK_NUMBER,

PLANNING_GROUP,

DELIVERY_PRICE,

QTY_SCRAPPED,

FROM_ORGANIZATION_CODE,

ORDER_TYPE CONSTANT '1', 

DELETED_FLAG "DECODE(:DELETED_FLAG,1,1,2,2,2)",

COMPANY_NAME "NVL(:COMPANY_NAME,-1)",

END_ORDER_NUMBER,

END_ORDER_RELEASE_NUMBER,

END_ORDER_LINE_NUMBER,

ORDER_RELEASE_NUMBER,

COMMENTS,

SHIP_TO_PARTY_NAME,

SHIP_TO_SITE_CODE,

SR_INSTANCE_ID CONSTANT '0',

PROCESS_FLAG CONSTANT '1',
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DATA_SOURCE_TYPE CONSTANT 'BATCH',

LAST_UPDATE_LOGIN CONSTANT '-1',

LAST_UPDATE_DATE SYSDATE,

CREATION_DATE SYSDATE

)

The script to extract Purchase Order data for this format from a legacy system hosted on
an Oracle database could look like the following:

SET HEAD OFF';

SET LINESIZE 200;

SET PAGESIZE 50000;

SPOOL ON;

SPOOL MSC_ST_SUPPLIES_PO.dat;

SELECT

DISTINCT

ITEM_TAB.ITEM_NAME||'~'||

ITEM_TAB.ORGANIZATION_CODE||'~'||

PO_TAB.EXPECTED_DELIVERY_DATE||'~'||

SITES_TAB.TP_NAME||'~'||

1||'~'|| /* All orders are treated as Firmed */

SITES_TAB.TP_SITE_CODE||'~'||

PO_TAB.LINE_NUM||'~'||

PO_TAB.PO_NUMBER||'~'||

&&SR_INSTANCE_CODE||'~'||

NVL(ITEM_TAB.ITEM_REVISION,1)||'~'||

YES||'~'||

PO_TAB.MRP_PRIMARY_QUANTITY||'~'||

PO_TAB.EXPECTED_DOCK_DATE||'~'||

PO_TAB.PROJECT_ID||'~'||

PO_TAB.TASK_ID||'~'||

YES||'~'||

PO_TAB.UNIT_PRICE||'~'||

0||'~'||
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YES||'~'||

1 ||'~'|| /* All records are either for Insert/Change. No deletions are being uploaded */

-1||'~'||

YES||'~'||

YES||'~'||

YES||'~'||

YES||'~'||

YES||'~'||

YES||'~'||

YES||'~'||

0||'~'||

1||'~'||

'BATCH'||'~'||

-1||'~'||

SYSDATE||'~'||

SYSDATE

FROM <LEGACY_SUPPLY_TABLE> PO_TAB,

<LEGACY_ITEMS> ITEM_TAB,

<LEGACY_PARTNER_SITES> SITES_TAB

WHERE PO_TAB.ORGANIZATION_ID = ITEM_TAB.ORGANIZATION_ID

AND PO_TAB.ITEM_ID = ITEM_TAB.INVENTORY_ITEM_ID

AND PO_TAB.VENDOR_ID = SITES_TAB.SR_TP_ID

AND PO_TAB.VENDOR_SITE_ID = SITES_TAB.SR_TP_SITE_ID;

1. Run the scripts to get the Data files and ftp these to the APS concurrent manager 
node. The steps to upload these files into Oracle APS are described below under 
Running Legacy Collections.

Sequence of Data Uploads
Load all this information either together or in the following order:

1. Upload calendar data information. All the calendar data files corresponding to 
calendar's control files (MSC_ST_CALENDARS.ctl, 
MSC_ST_WORKDAY_PATTERNS.ctl, MSC_ST_SHIFT_TIMES.ctl, 
MSC_ST_CALENDAR_EXCEPTIONS.ctl, MSC_ST_SHIFT_EXCEPTIONS.ctl) need 
to be uploaded in one single run. Based on the information provided, the calendar 
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is built in the planning system. If calendar already exists in ODS tables (Planning 
System) and you want to rebuild the calendar again, then the entire information (all
the above mentioned files) must be sent again. Also, in this case for 
MSC_ST_CALENDARS.ctl the OVERWRITE_FLAG should be sent as Y.

2. Upload the UOM information. The control file for this is 
MSC_ST_UNITS_OF_MEASURE.ctl.

3. Upload the Demand Class information.

4. Upload the Trading Partner information. The control files for setting up trading 
partners are MSC_ST_TRADING_PARTNERS.ctl, 
MSC_ST_TRADING_PARTNER_SITES.ctl, 
MSC_ST_LOCATION_ASSOCIATIONS.ctl, MSC_ST_SUB_INVENTORIES.ctl and 
MSC_ST_PARTNER_CONTACTS. 

The trading partner sites, location associations, sub inventories and contacts can be 
uploaded along with the trading partner information and also in subsequent runs. 
Only MSC_ST_TRADING_PARTNERS.ctl can be uploaded in the first run. 

MSC_ST_TRADING_PARTNERS.ctl has CALENDAR_CODE field. This should 
refer to a valid calendar code existing in the planning system or to a calendar code 
that you are uploading in this run of collections. If calendar does not exist in the 
planning system and has not been uploaded either, then the trading partner record 
is not accepted and is marked as error.

5. Upload the category sets information. The control file for setting up category sets is 
MSC_ST_CATEGORY_SETS.ctl

6. Upload the designators information for forecast, MDS and MPS. The control files 
required are: MSC_ST_DESIGNATORS_MDS.ctl, 
MSC_ST_DESIGNATORS_FORECAST.ctl and 
MSC_ST_DESIGNATORS_PLAN_ORDERS.ctl. The forecast, MDS and MPS records
can be uploaded now or in subsequent runs.

7. Upload the projects and tasks information. The control file name is 
MSC_ST_PROJECT_TASKS.ctl

8. Upload the items information as per the MSC_ST_SYSTEM_ITEMS.ctl file. If the 
UOM_CODE of the data file has an invalid value (that is, a value that does not exist 
in the planning system and is also not being uploaded along with items as per the 
MSC_ST_UNITS_OF_MEASURE.ctl in this upload) the item records are errored 
out.

9. Upload the item related information; for example, supplier capacity, supplies and 
demands, categories, UOM conversions, and sourcing rules. Upload the data as per 
the preprocessing diagram shown below and make sure that the items are valid; 
that is, the items exist in the planning system or are being uploaded in this run of 
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legacy collections.

10. Upload categories using control file MSC_ST_ITEM_CATEGORIES.ctl. 

11. Upload sourcing rules using control file MSC_ST_ITEM_SOURCING.ctl.

12. Upload UOM conversions using MSC_ST_UOM_CONVERSIONS.ctl, 
MSC_ST_UOM_CLASS_CONVERSIONS.ctl. 

13. Upload resources using control file MSC_ST_DEPARTMENT_RESOURCEs.ctl.

14. Upload bill of materials using the following control files: MSC_ST_BOMS.ctl, 
MSC_ST_BOM_COMPONENTS.ctl, and 
MSC_ST_COMPONENT_SUBSTITUTES.ctl. You can upload BOM components and
substitutes to BOM at the same time or upload these in later runs.

15. Upload routings using the following control files: MSC_ST_ROUTINGS.ctl, 
MSC_ST_ROUTING_OPERATIONS.ctl, and 
MSC_ST_OPERATION_RESOURCES.ctl. You can upload resources to operations at
the same time or upload these in later runs.

16. Upload supplier capacity using the following control files: 
MSC_ST_ITEM_SUPPLIERS.ctl, MSC_ST_SUPPLIER_CAPACITIES.ctl, and 
MSC_ST_SUPPLIER_FLEX_FENCES.ctl. You can upload 
MSC_ST_SUPPLIER_CAPACITIES.ctl with MSC_ST_ITEM_SUPPLIERS.ctl or in 
subsequent runs. You can also upload MSC_ST_SUPPLIER_FLEX_FENCES.ctl with
MSC_ST_ITEM_SUPPLIERS.ctl or in subsequent runs.

17. Load material supply for work order after routings are loaded because there is a 
field ROUTING_NAME in MSC_ST_SUPPLIES_WO.ctl.

18. Upload resource demand using the control file 
MSC_ST_RESOURCE_REQUIREMENTS.ctl. If WIP_ENTITY_NAME is not valid (it
was not previously loaded using the MSC_ST_SUPPLIES_WO.ctl and also is not 
loaded in this run using this control file) the record is errored out.

Preprocessing
After data from legacy application has been loaded into the planning system, it 
undergoes preprocessing before it can be used by the planning engine. 

Preprocessing generates IDs for the entities coming into the planning system based on a
set of user-defined keys (UDKs). For example, to identify an item record in the planning
system, the UDK is Instance Code, Organization code, Item Name and Company Name 
(Company Name is required only if SCE is installed. For standalone APS, this is 
defaulted to -1). A UDK uniquely identifies an existing record in the planning system. 
UDKs are used as reference to update existing records in the planning system.
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The preprocessing program is a concurrent program that runs independently from the 
planning engine and global ATP engine. 

After the data files have been brought over to the concurrent manager node, as 
described in the Running Legacy Collections section below, the legacy collection's 
request set program can be configured to read and load the data files into interface 
tables. Following which, this program can preprocess the data and finally load the data 
into the main planning tables, all in a single run.

The preprocessing engine has the intelligence to handle scenarios wherein transaction 
data and any prerequisite setup data needed to perform this transaction co-exist in a 
single data load.

The figure below shows the sequence in which the uploaded data is processed by the 
preprocessing engine. The preprocessing engine possesses parallel processing 
capabilities. Parallel processing is enabled for processing Items and Item-related entities
as shown in the diagram. Items, supplies and demand records can further be broken 
into sub-batches and processed in parallel. 
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Preprocessing

The above architecture also makes it necessary to ensure that all the setup related data 
is sent to the planning system to avoid errors while processing the transactions. For 
example, a purchase order line coming into the planning system referring to an item 
that has not been sent to the system is flagged as an error. Also, the supplier for the item
should have been defined on the system as a valid one.

Records in the staging tables are checked for multiple occurrences of the same UDK 
combination. For instance, in the case of data coming in via XML, if two or more item 
records are found in the interface table having the same combination of instance code, 
organization code, item name and company name, preprocessing picks the latest record
for further processing and the older records are flagged as errors. For instance, for data 
coming in via batch upload, if two or more item records are found in the interface table 
having same combination of instance code, organization code, item name and company 
name, preprocessing flags those records as errors because preprocessing is not able to 
determine which is the correct record to be picked up.
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To set up Legacy Instance
The system default installation creates one instance partition and five plan partitions. 
Use this process if you need to create an instance partition.

1. From the Navigator, select Requests > Run.

The Submit a New Request screen appears.

2. Select Single Request and select the OK button.

The Submit Request form appears.

3. In the Name field, select Create APS Partitions and select the OK button.

The Parameters screen appears.

4. Enter the number of plan partitions and instance partitions and select the OK 
button.

The partitions are created.

5. Change to the Advanced Planning Administrator responsibility. From the 
Navigator, select Admin > Instances. 

The Application Instances screen appears.

6. Specify the Instance Code for the Legacy Instance and set the Instance Type as 
Other. Leave the fields From Source to APS and From APS To Source blank. Fill the 
other fields for the instance as specified in the online help.

You are now set to use the Batch Load solution. Using the Running Legacy 
Collections process described below, upload the Workday Calendar data and 
Planning Organizations for this instance. This data can be uploaded along with the 
other entities' data. Preprocessing has the intelligence to consider the new 
organizations that have come in the same batch upload. After Legacy Collection is 
completed, you can view these organizations using the Organizations button at the 
bottom of the Instance Setup form.

Note: Setting up batch uploads and setting up legacy instance steps
can occur in parallel up to creation of scripts for data uploads. 
However, for getting the data files from the scripts, the instance 
code is required.

Running Legacy Collections
Using either an Oracle Applications form or the self-service application page, you can 
upload data from flat files to the legacy instance and finally to the planning engine. 
Using the form, you upload each data file separately. 
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Using the self-service method, you can upload a zip file containing all data files. Each 
type of data file, such as work order supply or BOM header, is identified using a tag in 
the file name. Ensure that you do not zip the entire directory but add individual files to 
the zip file.

To collect into a legacy instance using the form-based application
1. Copy all the data files conforming to the control files in the 

$MSC_TOP/patch/<version>/import in a directory on the concurrent manager node.
If there are more than one concurrent manager nodes and if these are not NFS 
mounted, then the data files need to be copied to all the nodes in same directory 
structure. This directory (or all the directories in case of multiple non-NFS mounted
concurrent manager nodes) should have read/write privileges to all users, because 
SQL*Loader discards files for the data that could not be uploaded due to errors. 

2. Choose the Advanced Planning Administrator responsibility.

3. In the Navigator, choose Collections > Legacy Systems > Collect Flat File Data. 

The Planning Data Collection screen appears showing three programs: Flat File 
Loader, Pre-Process Monitor, and Planning ODS Load. Planning ODS Load moves 
the data from the interface tables to the planning system's main tables.

4. Choose the Parameters field for Flat File Loader. 

The Parameters screen appears.

5. Enter the required information and the File Names for all the data files that you 
want to upload. You can either enter the directory path in the Data File's Directory 
field and then enter the file names for each entity to be uploaded in the File Name 
fields, or you can leave the Data File's Directory field blank and enter the complete 
path and file name of each entity in the File Name fields. The second option is 
useful if all the data files are not kept in the same directory. 

The Total Number of Workers field specifies the number of maximum number of 
loader workers that should be running in parallel at any given point in time. A 
loader worker is launched for each File Name specified.

6. When finished entering information for this screen, choose the OK button.

7. Choose the Parameters field for Pre-Process Monitor.

The Parameters screen appears.

8. Specify the entities that you want to be preprocessed for the legacy instance.

The Processing Batch Size field determines the size of batches while processing the 
records in the interface tables. A larger batch size is faster but requires more system 
resources. The current default batch size is 1000. 
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The Total Number of Workers field specifies the number of concurrent processes to 
be launched to process the data in parallel. 

9. When finished entering information for this screen, choose the OK button.

10. Choose the Parameters field for Planning ODS Load. 

The Parameters screen appears.

11. Specify whether you want Resource Availability and Sourcing History to be 
recalculated after the data has been moved.

12. When finished entering information for this screen, choose the OK button.

The Planning Data Collection screen appears.

13. Press the Submit button to allow the concurrent manager to schedule the request as 
per the schedule options that you specify in the At these Times... section.

14. Use the View Requests Form to monitor the progress of the different programs.

15. Use the View Collected Data menu option under Collections in the Navigator to 
view the data coming into the planning system.

To collect into a legacy instance using the self-service application
1. Double-click Collections > Legacy Systems Collect Flat File Data - Self Service. 

The Oracle Collaborative Planning suite page appears.

2. Click the Download link to download the Oracle Applications (OA) template.

All zipped .dat files, for example, bills of material and calendar appear. 

You can read the OATemplateReadme.html file for information on how to load 
various entities into Oracle Advanced Planning and Scheduling suite of products 
using flat files. You can open the ExcelLoad.xlt file and import your data files to 
view and modify.

3. In the Collaborative Planning suite page, click Browse to navigate to the data files 
location. 

4. Select the zip file containing data files to be uploaded.

5. Click Start Load Now.

The concurrent request starts. You can note down the request id for your reference.

After the completion of this request, navigate to Collections Workbench to view the 
collected data.
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Purge Program
The Purge program deletes the data from the ODS table as well as the local id table 
(MSC_LOCAL_ID_XXX). Depending upon the option selected while submitting the 
concurrent program, it behaves differently as explained below.

To access purge UI
1. Choose the Advanced Supply Chain Planner responsibility.

2. From the Navigator, choose Collections > Legacy System > Purge Collected Data.

If you selected Yes for Complete Refresh when you submitted the concurrent 
program, the following screen appears.

The following table shows the values for this screen.

Field Value

Instance Legacy instance against which the purge 
program is to be run.

Complete Refresh Yes

Delete records up to date User-entered date (defaults to the current 
date)

Delete supplies Yes (will always be Yes if complete refresh 
is Yes)

Delete demands Yes (will always be Yes if complete refresh 
is Yes)

In this case, the following tables get purged from ODS:

MSC_SYSTEM_ITEMS

MSC_BOMS

MSC_BOM_COMPONENTS

MSC_COMPONENT_SUBSTITUTES

MSC_ROUTINGS

MSC_ROUTING_OPERATIONS

MSC_OPERATION_RESOURCES
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MSC_OPERATION_COMPONENTS

MSC_OPERATION_RESOURCE_SEQS

MSC_PROCESS_EFFECTIVITY

MSC_DEPARTMENT_RESOURCES

MSC_RESOURCE_SHIFTS

MSC_RESOURCE_CHANGES

MSC_SIMULATION_SETS

MSC_PROJECTS

MSC_PROJECT_TASKS

MSC_ITEM_CATEGORIES

MSC_DESIGNATORS (Here program updates disable date as current date instead 
of deleting)

MSC_DEMANDS

MSC_SALES_ORDERS

MSC_SUPPLIES

MSC_INTERORG_SHIP_METHODS

MSC_ABC_CLASSES

MSC_ST_RESOURCE_GROUPS

MSC_ST_DEMAND_CLASSES

MSC_ST_RESERVATIONS MSC_ST_SAFETY_STOCKS

In addition, the entities listed in the following table, which are stored in the LID 
table will be deleted.

Entity Name LID Table Name Business Object

SR_INVENTORY_ITEM_ID MSC_LOCAL_ID_ITEM Item

ABC_CLASS_ID MSC_LOCAL_ID_MISC Item

BILL_SEQUENCE_ID MSC_LOCAL_ID_SETUP BOM 

COMPONENT_SEQUENCE
_ID

MSC_LOCAL_ID_SETUP BOM

ROUTING_SEQUENCE_ID MSC_LOCAL_ID_SETUP Routing
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Entity Name LID Table Name Business Object

OPERATION_SEQUENCE_
ID

MSC_LOCAL_ID_SETUP Routing

RESOURCE_SEQ_NUM MSC_LOCAL_ID_SETUP Routing

DEPARTMENT_ID MSC_LOCAL_ID_SETUP Department/Resources

LINE_ID MSC_LOCAL_ID_SETUP Department/Resources

RESOURCE_ID MSC_LOCAL_ID_SETUP Department/Resources

PROJECT_ID MSC_LOCAL_ID_MISC Project/Tasks

TASK_ID MSC_LOCAL_ID_MISC Project/Tasks

COSTING_GROUP_ID MSC_LOCAL_ID_MISC Project/Tasks

SR_CATEGORY_ID MSC_LOCAL_ID_MISC Categories

DISPOSITION_ID_FCT MSC_LOCAL_ID_DEMAN
D

Demand (Forecast)

DISPOSITION_ID_MDS MSC_LOCAL_ID_DEMAN
D

Demand (MDS)

SALES_ORDER_ID MSC_LOCAL_ID_DEMAN
D

Demand (Sales Order)

DEMAND_ID MSC_LOCAL_ID_DEMAN
D

Demand (Sales Order)

DISPOSITION_ID MSC_LOCAL_ID_SUPPLY Supplies

PO_LINE_ID MSC_LOCAL_ID_SUPPLY Supplies (PO/Req)

SCHEDULE_GROUP_ID MSC_LOCAL_ID_SUPPLY Supplies (MPS)

DISPOSTION_ID_MPS MSC_LOCAL_ID_SUPPLY Supplies (MPS)

SR_MTL_SUPPLY_ID MSC_LOCAL_ID_SUPPLY Supplies (On Hand)
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Entity Name LID Table Name Business Object

WIP_ENTITY_ID MSC_LOCAL_ID_SUPPLY Supplies (WIP)

The Purge program does not delete records related to following business objects 
from ODS or LID tables.

• Trading partners (organization, supplier, customer) 

• Calendars

• Category sets

• Sourcing rules

• UOM

If you selected No for Complete Refresh when you submitted the concurrent 
program, the following screen appears.

The following table shows the values for this screen.

Field Value

Instance Legacy instance against which the purge 
program is to be run.

Complete Refresh No

Delete records up to date User-entered date (defaults to the current 
date)

Delete supplies Yes/No (defaults to Yes)

Delete demands Yes/No (defaults to Yes)

In this case, only supply/demand business object records and those records whose 
creation date is less than user-entered date get deleted from the ODS and LID 
tables.

Loading Transaction Data Using Flat Files Into ERP Instance
Using either an Oracle Applications form or the self-service application, you can upload
transaction data (supply and demand) from flat files to the ERP instance. 



4-42    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Ensure that the transaction data is uploaded to the planning server using either legacy 
systems directly or an Oracle ERP application. To avoid double counting, do not upload
the same transaction data to both Legacy and ERP instances. For example, a sales order 
should not be uploaded using both ERP and Legacy instances.

Loading Transaction Data Notes
If you are importing the .dat file for the first time, then Excel prompts you to enter these
values. Once you enter them, you do not need to enter them again:

• Date format: The format of all the dates in the dat files

• Delimiter: Used internally to separate different columns in the dat file; make sure 
that it matches the value of profile option MSC: Self Service Loads Delimiter. 
Change these values in APS Menu > User Options. It opens a window to modify the
values and select an action: 

• Apply: Applies the changes to the open sheet

• Apply & Save: Applies the changes to the open sheet and saves the settings

Before uploading CSData.dat, set the date format in ExcelLoader to YYYY/MM/DD.

To collect into an ERP instance using the form-based application
1. Navigate to the Planning Data Collection form (Collections > Oracle Systems > Load

Transaction Data using Flat Files).

The Planning Data Collection form appears showing three programs: Load 
Transaction Data, Pre-Process Transaction Data, and Planning ODS Load. The Load
Transaction Data program loads the transaction data through flat files into interface
tables. Load Transaction Data accepts parameter values including the path for 
control and data files. 

The Pre-Process Transaction Data program preprocesses the transaction data and 
generates ids. Pre-Process Transaction Data enables you to specify the instance in 
which you want to load the transaction data. 

Planning ODS Load program moves the data from the interface tables to the main 
tables of the planning server.

2. Click in the Parameters field for Load Transaction Data.

The Parameters window appears.

3. Enter the required information and the file names for all the data files that you want
to upload. Specify the maximum amount of time you would like to allocate to the 
concurrent program in the Time Out Duration field. You can either enter the 
directory path in the Data File's Directory field and then enter the file names for 
each entity to be uploaded in the File Name fields, or you can leave the Data File's 
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Directory field blank and enter the complete path and file name of each entity in the
File Name fields. The second option is useful if all the data files are not kept in the 
same directory.

4. When you finish entering information in the fields, click OK.

5. Click in the Parameters field for Pre-Process Transaction Data.

The Parameters window appears.

6. Select the instance from a list of values.

7. After specifying the instance in which you want to load the transaction data, specify
the maximum time allowed for the process in the Time Out Duration field (in 
minutes).

The Processing Batch Size field determines the size of batches while preprocessing 
the records in the interface tables. A larger batch size is faster but requires more 
system resources. The current default batch size is 1000.

The Total Number of Workers field specifies the number of concurrent processes to 
be launched to process the data in parallel.

8. Specify the entities that you want to be preprocessed for the ERP instance. Yes 
indicates the entities that need to be preprocessed.

9. When you finish entering information in the fields, click OK.

10. Click in the Parameters field for Planning ODS Load.

The Parameters window appears.

The Planning ODS Load parameters required for data collection in the ERP instance
is similar to the parameters required for legacy collections. 

11. Specify the values for the parameters and click OK.

12. Click Submit in the Planning Data Collection window.

13. From the toolbar, choose View > Requests to view the status of the collections 
process.

When the request is complete, you can view the data in Collection Workbench.

To collect into an ERP instance using the self-service application
1. Double-click Collections > Oracle Systems > Load Transaction Data using Self 

Service Loads. 

The Oracle Collaborative Planning suite page appears.
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2. Click the Download link to download the Oracle Applications (OA) template.

All zipped .dat files, for example, bills of material and Calendar appear. A readme 
providing information on how to use the templates is also provided in this zip file.

3. Open the ExcelLoad.xlt file and import your data files to view and modify. After 
making the changes, export the data file. Finally, zip all data files that need to be 
uploaded.

4. Click Browse to navigate to the data files location. 

5. Select the zip file containing data files to be uploaded.

6. Click Start Load Now.

A concurrent request is triggered.

After the completion of this request, navigate to Collections Workbench to view the 
collected data.

Customization
System integrators may want to add custom validations for enabling preprocessing to 
filter out unwanted incoming data. The preprocessing engine provides hooks for each 
entity, which can be used to plug-in custom validations.

Organization Specific Collections
Oracle Advanced Supply Chain Planning supports organization-specific collections, 
which helps you in maintaining independent planning processes in independent 
business units of a company that is running a single instance of the Oracle e-Business 
Suite. 

You can run collections for collecting data from only specified organizations of a source 
instance. This helps you in elimination of unnecessary data collection from 
organizations that are not planned in your planning process and reduce the processing 
time.

Oracle Advanced Supply Chain Planning allows organization-specific collection for:

• Standard collections:

• Complete refresh method

• Net change refresh method

• Targeted refresh method

• Continuous collections
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Note: Organization-specific collection is not available for legacy 
collections.

To setup organization specific collections
1. Select Advanced Planning Administrator responsibility.

2. Navigate to Admin > Instances.

The Application Instances form appears.

3. Define the instance.

4. Click Organizations.

The Organizations form appears.

5. Select the Enable check box for the organizations of the defined instance.

6. Specify Collection Group for the organizations.

Assign all related organizations to the same collection group to ensure that group 
organizations are collected together.

To perform organization specific collections
1. Select the Advanced Supply Chain Planner responsibility.

2. Navigate to Collections > Oracle Systems > Standard Collections.

3. The Planning Data Collection form appears.

4. Click the Parameters field for the Planning Data Pull program.

5. The Parameters window appears.

6. Select the Collection Group.

Regardless of the Collection Group value, Oracle Advanced Supply Chain Planning 
always collects the following:

• ATP Rules

• Demand Classes

• Trading Partners (Customers)

• Trading Partners (Suppliers)
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• Units of Measure

• User Company Association

• Sourcing Rules and Assignment Sets 

• Shipping Networks and Shipping Methods

In addition, the collection programs collects all calendars to accommodate all trading 
partner shipping and receiving calendars. 

Collection from a Single Source to Multiple Destinations
Oracle Advanced Supply Chain Planning allows you to collect a single source instance 
to multiple destination instances. This is useful when you need to perform volume 
testing, where you need to collect from a source production instance to a test 
destination instance while still generating production plans out of a production 
planning server instance. Both of the planning server instances can share the same 
production source transaction instance. 

Collection from a single source to multiple destinations allows you to leverage the setup
and transaction data in the production source instance to do volume testing on the test 
planning server instance. You can avoid duplicating the source instance and reduce 
substantial amount of storage and maintenance costs.

Note: The source and destination (planning server) instances do not 
need to be on the samerelease.

For example, you can have a test R12.1 destination instance and R11i 
other destination instance. Both can collect from the same R11i 
e-Business Suite Source instance. 

The critical factor in such a design is the patching management.. If you 
have to apply patch to one instance, you may have to apply the same 
patch to all three instances. For example, you may patch the R12.1 
destination instance and it requires a patch on your R11i e-Business 
Suite Source instance. Then, you may need to apply the same patch the 
same patch may need to be applied to your R11i other destination 
instance.

To setup collection from a single source to multiple destinations
Perform these steps in each In each of your multiple destination instances.

1. Select Advanced Planning Administrator responsibility.

2. Navigate to Admin > Instances.

The Application Instances form appears.



Running Collections    4-47

3. Associate destination instances to source instance in each destination instance 
separately.

4. Select the Allow ATP check box for the destination instance that you want to 
consider in the ATP process from the source instance.

You can select the Allow ATP check box for only one of the destinations that are 
associated to a single source.

The planning engine displays an error message if you attempt to select more than 
one destination for ATP.

5. Select the Allow Release ATP check box for the destination instances that are 
allowed to release to the source instance.

The Allow Release Flag check box is used for both auto release and manual release 
processes.

You can select the Allow Release check box for multiple destinations that are 
associated to a single source. 

To trigger the Auto Release process for a plan:
1. Select the Allow Release check box for the instance where the plan is defined in the 

Application Instances form.

2. Select the Production check box for the plan in the Plan Names form.

Example: Using the Allow ATP option
Consider:

• A single source instance S that is associated to two destination instances D1 and D2.

• The Allow ATP check box is selected for destination instance D1 related to source S.

The ATP request from source S points to D1. The planning engine performs the ATP 
process in D1 taking into consideration the plans that have ATP check box selected in 
the Plan Names form. 

In destination instance D2, there could be plans with the ATP check boxes selected in 
the Plan Names form. The ATP process from D2 uses these plans. There are no 
restrictions in checking the ATP check boxes in the Plan Names form in destinations. 

Conclusion: You can select the Allow ATP check box in the Application Instances form 
for only one of the destinations associated to a single source

Example: Using the Allow Release option
Consider:

• A single source instance S that is associated to two destination instances D1 and D2.

• The Allow Release check box is selected for D2 and not for D1.
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The plans in D2 with the Production check boxes selected in the Plan Options form 
trigger the Auto Release process to source. 

You can select the Production check boxes for plans in D1 but they will not trigger any 
Auto Release process to source. This is because the Allow Release check box is not 
checked for D1 in the Application Instances form. 

Conclusion: You can select the Allow Release check box for multiple destinations that 
are associated to a single source.
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5
Defining Supply Chain Plans

This chapter covers the following topics:

• Overview of Defining Plans

• Global Supply Chain Planning

• Subset Plans

• Master Scheduling

• Choosing a Plan Type

• Choosing Plan Classes

• Choosing Planning Modes

• Setting Plan Options

• Forecasts

• Choosing Aggregation Levels

• Choosing an Objective Function

• Controlling Planned Items

Overview of Defining Plans
This section describes features that help you select a plan type that best satisfies your 
business requirements. You can choose to run a global supply chain plan or a subset 
plan to suit your supply chain environment or single organization environment, 
respectively. You can also select constrained, unconstrained, or optimized plan class 
based on business objectives such as maximizing inventory turns, on time delivery, and 
plan profit. Lastly, you can specify aggregation levels to view plans at varying levels of 
detail.
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Global Supply Chain Planning
Oracle ASCP can generate planned orders for an entire supply chain within a single 
multi-organization supply chain plan. This is illustrated below with a sample supply 
chain; see alsoSample Supply Chain, page 5-2) andSample Bill of Material, page 5-2:

Sample Bill of Material

In this sample supply chain, SF1 and SF2 are subassembly facilities, AF1 is a final 
assembly facility, DC1 and DC2 are distribution centers, C1, C2, C3 and C4 are 
customers and S1, S2, S3 and S4 are suppliers. 

A single plan of the entire supply chain has the following inputs:

• Demand quantity (forecast + actual sales orders) for A01 at DC1 for each of the time
buckets in the planning horizon. This is captured in a Master Demand Schedule 
(MDS) for DC1.

• Demand quantity for A01 at DC2 for each of the time buckets in the planning 
horizon. This is captured in an MDS for DC2.

The plan output contains planned order quantities, start dates, and completion dates for
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A01 and all of its components and subcomponents. 

Prerequisites for Running a Global Supply Chain Plan
To run a global supply chain plan, the following prerequisites are required:

• Each planned organization must be set up on the source instance. 

• Collection programs must be directed to collect data from the transactional instance
of each planned organization. 

• Items to be planned must be enabled in each organization that can produce (or 
distribute) the item. During item setup, items can be enabled in all organizations or 
only in specific organizations.

• Routings and/or Bills of Resource for each planned item must exist or be enabled in 
each organization that is planned centrally.

• Suppliers and sourcing rules must be enabled in all relevant organizations. 

Advantages of the Single Plan
The single-plan approach is advantageous for the following reasons:

• Least planning effort. Fewer plans need to be generated; fewer planning servers 
need to be deployed and maintained.

• Data consistency. Without the single-plan ability, requirements must be repeatedly 
transferred upstream within the supply chain to each successive supplier facility. 
Each transfer presents an opportunity for miscommunication or data loss.

• Global optimization. Intelligent trade-offs between the performance of individual 
facilities (as measured by, for example, plan profit) can be made because Oracle 
ASCP optimizes the supply chain planned orders as a whole.

• Minimum communication lag:

The effects of decisions made at the highest level of the supply chain are 
immediately visible at the lowest level of the supply chain. If individual facility 
plans are used, there is at least a one planning-run duration lag between the receipt 
of requirements at a facility and the passing of the dependent requirements to the 
facility's suppliers. Moreover, this lag is often much greater due to differences in 
working hours between upstream and downstream facilities (for example, if the 
facilities are in different time zones). Also, the planning cycles of upstream and 
downstream facilities may not be synchronized (for example, customer facility AF1 
runs its plan on Monday, while supplier facility SF1 runs its plan on Sunday). This 
results in even longer communication lags.
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The overall effect of plan communication lag is to make the supply chain less 
responsive to meeting changes in customer demand.

Creating Supply Chain Plans
You can have multiple supply chain plans. Before you launch a plan for the first time 
you must name it.

In addition to creating a plans by creation, you can create a new plan by copying 
information from one plan to it. Do this if you want to:

• Save the results of a particular plan run before you re-run the plan

• Begin using a new plan name with the results of the latest run of another plan.

• Create a new plan with the same plan options as an existing plan

To create a global supply chain plan 
1. From the Navigator, choose Supply Chain Plan > Names. 

The Supply Chain Names window appears.

This table describes the fields and options.

Object Description

Name Define a plan name.

Description Define a plan description.

ATP If this is selected, this plan will be used for 
availability check. If the plan is used as a 24 
x 7 ATP plan, the planning process may 
never switch to a new version of the plan 
from the copied plan after the original plan 
has completed successfully ; consider 
setting profile options MSC: Action 
Allowed on ATP 24 x 7 Plan While Running
and MSC: ATP Synchronization Downtime 
(minutes).

Production If this is selected, this is a product plan. 
Planned orders will be automatically 
released within their release time fence.
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Object Description

Notifications If this is selected, exception message 
notifications for the plan are enabled.

Plan Type Valid values are Manufacturing Plan, 
Production Plan, and Master Plan. This 
setting interacts with the Planning Method 
item attribute to determine which subset of 
the items that pass the condition imposed 
by the Planned Items parameter are 
planned. Please see Choosing a Plan Type, 
page 5-27 for further details.

2. Save your work.

3. Select Plan Options for the Plan Options window.

Continue setting plan options and parameters.

Copying Supply Chain Plans
Use the copy plan function to make a copy of an existing plan.

If memory bases planner flat files do not exist, Copy Plan process completes with the 
warning - WARNING: The copy plan operation completed successfully. However, 
some auxiliary data files could not be copied. Therefore, you will not be able to run 
online planner. You can re-launch the plan from the Navigator.

To copy a plan
1. From the Supply Chain Names window, select a plan, then click Copy Plan for the 

Copy Plan window.

2. In Plan Name and Plan Description, enter information for the new plan.

3. Select or clear ATP, Production, and Notification as you would if you are creating a 
new plan om the Plan Names form.

4. Plan Type defaults to the plan type of the source plan and you cannot change it if 
you want to copy all plan information.

You can copy only the plan options from one plan to another of a different plan 
type. To do so, select Copy Plan Options Only and select Plan Type for the new 
plan.
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5. Enter an Inactive Date for the new plan. 

6. Click OK.

7. Save your work.

Subset Plans
There are some situations in which it makes sense to plan a portion of the supply chain 
separately, outside of the overall supply chain MPP plan.

Scenario 1: Unique Local Objectives Must be Respected Along with Global Objectives
Suppose that subassembly plant SF1 (Figure: Sample Supply Chain, page 5-2), which 
makes M12 (Figure: Sample Bill of Material, page 5-2), contains very expensive capital 
equipment. SF1 is the overall supply chain constraint, so every minute that its resources
are utilized brings extra profits to the enterprise. Resource utilization is the most 
important objective for SF1. For the supply chain as a whole, however, due to rapid 
product life cycles and a fickle market, inventory turns might be the most important 
objective. In this situation you could run a two-stage planning process.

• An MRP for organization SF1 with resource utilization as the objective to generate 
planned orders for M11, M22, B31, and B21 (the portion required at SF1).

• A MPP for organizations DC1, DC2, AF1, SF1, and SF2 with the above MRP as a 
supply schedule with inventory turns as the objective to generate planned orders 
for A01, M12, B13, B23, and B21 (the portion required at SF2).

Scenario 2: Local Restrictions Not Captured in Global Planning Inputs
Suppose that item B21, a subcomponent of item M11 (Figure: Sample Bill of Material, 
page 5-2), has volatile pricing. In lieu of implementing the default planned orders in 
facility SF1 that a global MPP would generate for M11 and its subcomponents (B21), one
could plan the supply chain as follows:

1. MPP plan for organizations DC1, DC2, AF1, and SF2 to generate planned orders for
A01, M12, B13, M22, and M11.

2. Load the MPP as a demand schedule into a Master Production Schedule (MPS) for 
organization SF1. Dependent demand for M11 is derived from the planned orders 
for A01.

3. Run the MPS.

4. Manually adjust the planned orders for M11 in the MPS (for example, to pull ahead 
the orders for M11 in order to take advantage of a time-sensitive special promotion 
on B21).
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5. Run an MRP for organization SF1 with the adjusted MPS as input to create planned 
orders for M11 components and subcomponents (B21 in this case).

Situation 3: Single Global Data Model Not Available
The one-step supply chain planning capability of Oracle ASCP presumes either the 
installation of ASCP as part of an enterprise-wide implementation of Oracle 
Applications, or the existence of collection programs to pull cross-supply chain 
transaction data from various Oracle Applications instances or from legacy systems. 
Cross-supply chain data must be accessible to build the net change snapshot used by 
Oracle ASCP to generate planned orders.

This may not be the case. For example, one or more facilities in the supply chain 
perform planning and/or transaction processing on legacy systems not yet integrated to 
Oracle ASCP via some sort of collection program. In this situation, the renegade 
facilities must be scheduled outside the global MPP plan according to the same steps as 
used in Scenario 2 above.

Pitfalls of Subset Planning
The two principal pitfalls of subset planning (as opposed to global, single-plan supply 
chain planning) are:

• Local optimization as opposed to global optimization

• Plan infeasibility due to supply chain interdependencies

The first pitfall is the fact that plans that optimize individual facilities may not be 
compatible with the optimum global supply chain plan. Take the case of the two 
distribution centers DC1 and DC2 in Figure 5-1: Sample Supply Chain The way to 
maximize on-time delivery for DC1 is to allocate all production from AF1 to DC1. The 
same logic holds for DC2. The global optimum solution, which would be missed via 
subset planning, comes from some allocation of AF1 output to both DC1 and DC2.

A simple example of supply chain interdependency is Supplier S3 in Figure 5-1: Sample 
Supply Chain. This supplier supplies item B21 to both subassembly facilities SF1 and 
SF2. Individual plans run for SF1 and SF2 could not recognize the shared capacity at 
supplier S3 and could not evaluate, if the combined SF1 and SF2 demands for B21 are 
too high, how best to allocate the B21 to SF1 and SF2. In such a situation the SF1 and 
SF2 individual plans would be infeasible, but would not even generate any exception 
notices to alert the planners.

Choosing Between Global Supply Chain and Subset Plans
In general, resource and material capacity are most efficiently utilized in a global 
supply chain planning environment where planning distributes production 
requirements across multiple organizations. However, the choice of global supply chain
versus subset planning should depend on a number of factors including:
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• Physical proximity of the organizations being planned: If planned organizations 
are geographically dispersed, it is generally more difficult to fulfill demand in one 
region from a plant or distribution center far away because of transportation costs 
and longer lead-times. Note, however, that the costs associated with fulfilling 
demand from remote plants can be modeled in planning. Planning can then 
optimize production allocation across plants to meet the objectives that have been 
set. For example, if balancing resource loads is the primary objective of a 
multi-organization plan, planning will distribute production across plants to meet 
that objective. 

• Commonality of the items produced: If you have multiple organizations that 
produce similar products, global supply chain planning is beneficial because 
planning can consider factors like material and resource availability, material costs, 
and resource costs to create an optimal supply chain plan. 

• Commonality of the supply base: Similar to producing common items, 
organizations sharing suppliers are good candidates for global supply chain 
planning because supply can be optimally distributed across plants depending on 
each plan's production requirements. Global supply chain planning will ensure that
supplier capacity is most effectively used to meet end customer demand and to 
minimize inventory.

• Linkage among plants: If production at one plant must be coordinated with 
production at other plants, global supply chain planning should be used. For 
example, if Plant A provides subassemblies to Plant B (Plant A is a feeder plant), 
both plants should be planned together.

• Corporate structure:The internal organizational structure of a corporation is also a 
major determinate of the planning method used. If there are clear organizational 
boundaries between divisions, global supply chain planning is difficult to 
implement. 

The table below summarizes the factors to consider when deciding whether to run a 
global supply chain or subset plan.

Factor Global Supply Chain 
Planning

Subset Planning

Physical proximity Close Physical Proximity Distant Physical Proximity

Commonality of items 
produced

High Commonality Low Commonality

Commonality of supply base High Commonality Low Commonality
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Factor Global Supply Chain 
Planning

Subset Planning

Linkage among plants Tight Linkage Among Plants Loose Linkage Among Plants

Corporate structure Centralized Corporate 
Structure

Decentralized Corporate 
Structure

Hub and Spoke Planning
Oracle Advanced Supply Chain Planning provides you with the option of using 
demands from all planned orders during hub and spoke planning. When you use your 
plans as demand schedules to other plans, the planning engine considers all planned 
orders in the source plan as demands and explodes down the bills of material creating 
demands for the lower level components.

Hub and spoke planning uses a multi-plan approach where you can plan across the 
supply chain at the top level and then release planned orders to a lower level 
manufacturing plan for all MRP planned items. The top level plan includes only end 
items or end items with critical sub-assemblies, and typically only the final assembly 
plants. The lower level plan (MRP) is at the component level and includes the final 
assembly plants and the component manufacturing plants. Hub and spoke planning is a
commonly used term for this type of subset planning.

Hub and spoke planning allows you to plan and release the top level plans for a small 
subset of items. It also provides easier recognition of critical components based on 
bottleneck resources.

Using the two plan process with MPS/MPP and MRP
In a multi-planning setup with a two plan process, the top level plans are always either 
MPS or MPP, and the lower level plan is the MRP.

MRP is the best choice for the lower level plan, as the MRP plans all items for any 
planning method except Not Planned. This reduces the risk of missing an item due to 
an incorrect planning method selection.

Note: Avoid setting item attributes to one of the joint planning methods
(MRP/MPP Planned or MPS/MPP Planned) as this can lead to 
unintended results. For example, if an item is marked MRP/MPP and 
the item is in the MPP, then the MRP does not replan it. If you use the 
joint planning method settings, you need to take extra care during 
testing to insure that you get the intended results.

You can use the two plan process when you need to segment the planned items into 
two groups to support multiple planning groups. For example, the production planners
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of your company want to plan the top level items and sub-assemblies. The buyers and 
MRP planners want to see the demands for their MRP planned items based on an 
approved production schedule from the production planners. In addition, there is a 
difference in frequency that each plan is run. The production is run once or twice a 
week while the MRP is run every night. In such a scenario, you can employ a two plan 
process.

The top level plan, an MPP for example:

• Has independent demands including MDS, forecasts, and sales orders.

• Plans all MPP, MPS/MPP, MRP/MPP planned items.

• Plans critical components that are MRP planned items marked as critical 
components

• Releases orders as required, either manually or auto-release, for MPP, MPS/MPP or 
MRP/MPP items.

• Planners manually review, adjust, and release orders as needed by the shop floor.

• The planned orders and reschedules are visible to the MRP after the MRP is 
launched. Therefore, the planners do not have to release them until needed by the 
shop floor.

The lower level plan, the MRP:

• Has independent demands for MRP planned items, including MDS's, forecasts and 
sales orders.

Note: Avoid adding independent demands for MPP or MPS 
planned items to the MRP. MRP does not re-plan these demands.

• Has the MPP or MPS as a demand schedule and the Interplant check box is not 
selected.

• This brings into the MRP, the independent demands and supplies for all MPP 
or MPS planned items with components that are MRP planned items.

• The MRP explodes downwards from the MPP or MPS supplies including 
planned orders, creating demands for MRP planned items.

• Plans all MRP items and any other planned items that are not planned by the MPP 
or MPS plans.

Items that are sandwiched between two MPP or two MPS items are designated as 
MRP planned by MRP and are re-planned by MRP.

You may encounter a number of inconsistencies with sandwich items. It is 
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recommended that you avoid sandwiched items as this condition can lead to 
unintended results. For example, if a sandwiched item has a primary and alternate 
bills of material, the MPP might select the alternate bills of material and the MRP 
might select the primary bill of material. The two plans may then plan different 
components of the sandwiched item. You can face a similar situation with respect to
primary and substitute components of the sandwich item.

If you add demands for the sandwich item to the MRP, some planned orders in the 
MRP are pushed out of the planning horizon because of insufficient supply for the 
MPS part in the MRP. Therefore, if an item is sandwiched, you need to include all 
demands in the MPS.

For MRP constraint options, if you select:

• Enforce Capacity Constraints (ECC), the planned orders in the MRP can be late for 
the demands from the MPP or MPS.

• Enforce Demand Due Dates (EDD), the planned orders in the MRP are not late for 
demands from the MPP or MPS.

If the MPP arrives at planned supplies and reschedules based on objectives, constraints, 
pegging, and demand priorities visible in the MPP, the MRP does not change these 
planned supplies and reschedules. The MRP has different objectives, constraints, 
pegging and priorities and does not have adequate data to accurately replan MPP 
planned supplies. 

The MRP considers resource capacity consumed by planned orders in the MPP or MPS. 
If resources are shared by items in both the MPP and MRP or in the MPS and the MRP, 
then the resource capacity consumed by the MPP or MPS items is considered by the 
MRP and only the remaining resource capacity is available to the MRP planned items. 
The MPP or MPS resource usages are not rescheduled by the MRP.

Note: Oracle Advanced Supply Chain Planning uses the date of the 
resource requirements. Therefore, orders that come in the middle of a 
weekly or period bucket in the demand or supply schedule are 
available in the destination plan on the actual schedule date and not at 
the beginning of the bucket.

Hub and spoke planning using critical components
When you run an MPS plan with the critical components option selected, the planning 
engine plans for: 

• MPS and MPS/MPP planned items

• MRP and MPP planned Items that are critical components of MPS and MPS/MPP 
Planned items.
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• The plan is constrained by resource requirements for critical components if resource
requirements are selected as a constraint.

• The plan is also constrained by the supplier capacities for critical components if 
supplier capacity is selected as a constraint.

• The plan may also be constrained by the purchasing lead-times of the critical 
components if you select the Enforce Purchasing Lead-times option.

• If the plan options items selection is set to Demand Schedule items, then the MRP 
planned items that are not a critical component of an item in the Demand Schedule 
are not included. For example, item C is MRP planned and is only a critical 
component of Item X. If Item X is not a planned item for the MPS, then neither is 
Item C.

• All components in the paths of critical components or between the critical 
components and end items.

This means that other MPS or MPP items are pulled into the MPS and planned 
because they have common critical components with the MPS planned items 
selected.

For example, item C is MRP planned and is a critical component of item X and item 
Y. Item X is on the demand schedule of the MPS. The planning engine plans item Y 
in the MPS because it is on the path of the critical component Item C.

In this case, item Y is treated as a critical component and not as an MPS planned 
item. For example, work orders for Item Y cannot be released from the MPS.

Critical components and bottleneck resource group
In case of a MPP or MPS plan with Include critical components option selected and 
bottleneck resource group:

• Any item with a bottleneck resource on the routing is planned as a critical 
component

• All MRP planned items that use any resource in the bottleneck resource group are 
planned as critical components

If you select the plan options Include critical components and bottleneck resources, then
the plan itself determines what the critical components are based on the resources in the
bottleneck resource group. You do not need to individually mark items as critical 
components.

The planning engine calculates the requirements in the following manner:

• The plan is constrained only by the capacity of bottleneck resources when planning 
resource requirements.
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• The resource durations for non-constraining resources are calculated for the proper 
offsetting of requirements. The resource loads for non-constraining resources are 
calculated and resource overloads exceptions are generated.

• MPP or MPS item supplies planned in a production or master plan with respect to 
bottleneck resources can be released.

To define critical components
1. Select the Inventory responsibility.

2. Navigate to Items > Organization Items > MPS/MRP Planning tab.

3. Select the Critical Component check box.

Set the critical component item attribute at the organization level or globally for all 
organizations depending on whether the item attribute is set to the organization 
level or the global level.

The planning engine can also infer from the bottleneck resource group whether or 
not an item is a critical component. You can opt to not mark any item as a critical 
component as critical components are selected based on the resources in your 
bottleneck resource group.

4. Navigate to Plan Options > Main tab.

5. Select the Include Critical Components check box.

MPS/MPP planning with critical components used as a demand schedule for an MRP
When a MPP or MPS plan with critical components is used as a demand schedule for an
MRP:

• The critical components are planned in the MRP.

• The supply due dates for critical components in the MRP plan can be different from 
the ones in the MPP plan because:

• The MRP plan constraint options are different

• Additional constraints at the lower levels cause the critical components to be 
late or early.

• Changes in delivery dates of the critical components do not change dates on 
planned orders from the MPS for all MPS items. The planning engine always treats 
these orders as firm.

• The planned orders for critical components in the MPS are ignored by the MRP.
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• The planned orders for critical components in the MRP can be released.

To perform hub and spoke planning
1. Set up the following profile options:

• MSC: Allow Release of Planned Orders from Demand Schedule Plan

• MSO: Use Collections Start Time

For more details, see Appendix A: Profile Options.

2. Define critical components.

For more details, see: To define critical components, page 5-13.

3. Define a MPP or MPS as the top level plan.

4. Launch the MPP or MPS plan.

5. If you make any changes to the results of the hub plan that impact resources, run 
online or batch replan against the hub plan before feeding it to the spoke plan. 

6. In the spoke plan, navigate to Plan Options > Organizations tab.

7. Select the top level plan as a demand schedule for the lower level plan, the MRP.

8. Clear the Interplant check box.

9. Launch the MRP plan.

10. Navigate to Workbench > Supply/Demand window.

11. View the supply or demand that is fed from the MPP/MPS plan demand schedule.

The Item From Source Plan check box is selected for all supplies or demands that arrive 
from an MPS or MPP.

Examples
This section provides a few examples to illustrate the relation between the Interplant 
plan option and hub and spoke planning:

• Single organization MPP as a demand schedule to an MRP with Interplant not 
Checked, page 5-15

• Single organization MPP with critical components as a demand schedule to an 
MRP, page 5-16

• 'Multi organization MPP with critical components as a demand schedule to an 
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MRP, page 5-20

In all the examples provided in this section, you can change MPP to MPS everywhere to
receive identical results.

Example 1: Single organization MPP as a demand schedule to an MRP with Interplant not 
Checked
Assume that a single organization uses a MPP and an MRP. The MPP is a demand 
schedule to the MRP and the Interplant option is not selected. The MRP does not plan 
the MPP or MPS planned supplies: 

Figure 'Single organization MPP, page 5-15 illustrates the following:

• Sandwiched items: Item F is sandwiched between items D and J.

• Item E is MRP/MPP planned or uses a joint planning method.

Single organization MPP

The MPP constrained planning rules are:

• Items A, B, E, D, F, and J are planned by the MPP

• Items C, H, I, G and K are not planned by the MPP and are not visible in the MPP.

When the MPP is a demand schedule to the MRP, the MRP constrained planning rules 
are:

• Items A, B, E, D, and J are not planned again by the MRP but the planned orders for
items A, E, D, J are visible in the MRP.

• Item F, which is the sandwiched MRP planned item, is re-planned by the MRP.

• The planned order demand for items C, F, H, I G, and K is visible in the MRP. These
items are planned in the MRP.
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Explanation:

• Item E, which is MRP/MPP planned, is treated like MPP planned items. If Item B is 
MRP/MPP and Item E is MPP, there is no difference in the plan results as both are 
still planned like any other MPP planned item.

• If independent demands are fed to the MRP for any MPP planned item, then these 
are displayed in the MRP as Unmet Demand. The MRP does not create new 
supplies for any items planned by the MPP.

• If new demands are fed to the MRP for the sandwiched item F, the total demand for
item F in the MRP will exceed the total demand for item F in the MPP. Therefore, 
the supply of its component item J will be insufficient for the total demand found in
the MRP. The MRP cannot plan additional supplies of Item J. Therefore, some item 
F supplies will be pushed to the end of the planning horizon.

Example 2: Single organization MPP with critical components as a demand schedule to an 
MRP
Assume that a single organization uses a MPP and an MRP. The MPP is fed as a 
demand schedule to the MRP and the Interplant option is not selected.

Single organization MPP with critical components

Figure 'Single organization MPP with critical components, page 5-16 illustrates the 
following:

• MPP planned items include 1, A, D, K, and M.

• Item G is MRP planned but it is treated as MPP planned by the MPP because it is 
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sandwiched between MPP planned Items. It is re-planned by the MRP.

• MRP planned items include B, C, E, F, G, H, I, J, L, N, O, P, Q, and R.

• Three MRP planned items C, F, and R are marked as critical components. These are 
constraints to the MPP plan. Planned orders from the MPP are not passed to the 
MRP for these three items.

• Item B is MRP planned and not a critical component but is treated as a critical 
component because it is above another critical component. Planned orders from the 
MPP are not passed to the MRP for Item B.

The MPP has both released supplies and planned order supplies for all MPP 
planned items. These are passed to the MRP as independent demands and supplies 
whenever they have an MRP planned item below them.

In the MRP Supply Demand view, the following information is displayed:

Plan 
Meth
od

Ite
m

Fi
r
m

From
Sour
ce 
Plan

Order 
Type

Days 
Late

Qty
/ 
Rat
e

Sugg 
Start 
Date

Sugg
Due 
Date

Dema
nd 
Satisfi
ed 
Date

Need
By 
Date

Action

MPP 1   Yes Sales 
Order

1 -1   3-Jan-
03

4-Jan-0
3

   

MPP 1 Fir
m

Yes MPP 
Planned 
Order

    4-Jan-
03

4-Jan-
03

  3-Jan
-03

Alway
s None

MPP A   Yes Planned 
Order 
Demand

-1 -1   3-Jan-
03

4-Jan-0
3

  None

MPP A Fir
m

Yes MPP 
Planned 
Order

-3 1 2-Jan-
03

4-Jan-
03

  3-Jan
-03

Alway
s None

MRP E     Planned 
Order 
Demand

-3 -1   2-Jan-
03

5-Jan-0
3

  None

MRP E     Planned 
Order

  1 4-Jan-
03

5-Jan-
03

  2-Jan
-03

Releas
e
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Plan 
Meth
od

Ite
m

Fi
r
m

From
Sour
ce 
Plan

Order 
Type

Days 
Late

Qty
/ 
Rat
e

Sugg 
Start 
Date

Sugg
Due 
Date

Dema
nd 
Satisfi
ed 
Date

Need
By 
Date

Action

MRP C     Planned 
Order 
Demand

1 -1   2-Jan-
03

1-Jan-0
3

  None

MRP C     Planned 
Order

  1 1-Jan-
03

1-Jan-
03

  2-Jan
-03

Releas
e

MPP D   Yes Planned 
Order 
Demand

-1 -1   1-Jan-
03

2-Jan-0
3

  None

MPP D Fir
m

Yes MPP 
Planned 
Order

0 1 1-Jan-
03

2-Jan-
03

  1-Jan
-03

Alway
s None

MRP H     Planned 
Order 
Demand

0 -1   1-Jan-
03

1-Jan-0
3

  None

  H     Planned 
Order

  1 1-Jan-
03

1-Jan-
03

  1-Jan
-03

Releas
e

MPP K Fir
m

Yes Planned 
Order 
Demand

0 -1   20-De
c-02

20-Dec
-02

  None

MPP K Fir
m

Yes Discrete 
Job

-36 1 15-De
c-02

20-De
c-02

  20-D
ec-02

Alway
s None

MRP L     Discrete 
Job 
Demand

-36 -1   15-De
c-02

21-Jan-
03

  None

MRP L     Planned 
Order

  1 21-Jan
-03

21-Ja
n-03

  15-D
ec-02

Releas
e

MRP N     Discrete 
Job 
Demand

-1 -1   18-De
c-02

19-Dec
-02

  None
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Plan 
Meth
od

Ite
m

Fi
r
m

From
Sour
ce 
Plan

Order 
Type

Days 
Late

Qty
/ 
Rat
e

Sugg 
Start 
Date

Sugg
Due 
Date

Dema
nd 
Satisfi
ed 
Date

Need
By 
Date

Action

MRP N     Planned 
Order

  1 19-De
c-02

19-De
c-02

  18-D
ec-02

Releas
e

MPP M   Yes Planned 
Order 
Demand

0 -1   17-De
c-02

17-Dec
-02

  None

MPP M Fir
m

Yes Planned 
Order

0 1 15-De
c-02

17-De
c-02

  17-D
ec-02

Alway
s None

MRP Q     Planned 
Order 
Demand

0 -1   15-De
c-02

15-Dec
-02

  None

MRP Q     Planned 
Order

  1 10-De
c-02

15-De
c-02

  15-D
ec-02

Releas
e

Explanation:

• MPP planned orders can or cannot be released from the MRP, depending on the 
value of the profile option MSC: Allow MRP Release of Planned Orders from 
Demand Schedule Plan.

• Item 1 also appears in the MRP Supply/Demand form but the pegging ends with 
the Item A supply.

• Days Late information is brought over from the MPP. This is the calculated value 
found in the MPP for the demand.

• Order number is either the MPP Plan Name or, if this is the end item demand in the
MPP, the planning engine displays the order number found in the MPP for the end 
item demand. If the customer and customer site for the end item demand is 
available in the MPP, this is also passed to the MRP for the end item demand.

• The planning engine provides the order start date and all operation start dates from
the MPP to MRP. This drives the due date for MRP components if the Operation 
Start Date scheduling method is selected.

• The Need By Date for a planned order from the MPP is always the suggested due 
date of the MPP Schedule Demand.
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• Item C is MRP planned and is a critical component. The MRP creates the planned 
orders and these can be released from the MRP. The planned orders created for 
item C in the MPP are not visible in the MRP.

• The example displays a planned order scheduled early because of capacity 
constraints.

• A supply for item K is 36 days late. From the supply chain bills of material, it is 
clear that the item A supply will also late. However, the MPP Planned Order 
Demand for item A is not changed to reflect this. In the MRP, the days late is noted 
for the next higher level MPP planned items but the days late is not pushed up the 
supply chain bills of material to higher levels of MPP Planned Items.

• The MPP planned order dates for item M are not changed even though item M is 
not needed at these dates because the supplies for Item K are 36 days late.

• The days late information for the MPP supply are based on the lower level supplies 
that are pegged to it.

• The rows marked as Yes in the From Source Plan column indicate that the demand 
and supply rows are from the demand schedule plan, either an MPS or a MPP.

Multi organization MPP with critical components as a demand schedule to an MRP
Assume that the MPP plans for four organizations D2, M2, S1, and M1.
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Multi organization MPP

Figure Multi organization MPP, page 5-21 illustrates that the interorganization 
transfers, which are possible between the four organizations are:

• Org D2 item A is transferred from M2

• Org M2 item L is transferred from M1

• Org M2 item E is transferred from M2

The MPP has a demand schedule for item 1. The MPP is fed to an MRP as a demand 
schedule four times, once for each org D2, M1, M2, and S2.

The MPP plans the following items:

• Org D2: Items 1 and A

• Org M2: Items A,B, E. B is only planned as a critical component.

• Org M1: No items

• Org S1: Items E, F, G and I. I is only planned as a critical component.
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MPP supply pegs to all lower levels of supply for all MRP planned items.

The MPP is fed as a demand schedule to the MRP. You can arrive at two results based 
on the Interplant check box selection:

• Interplant option is not selected, page 5-22

• Interplant option is selected, page 5-22

Interplant option is not selected
The MRP shows MPP planned supplies for all MPP planned items. In the MRP, you can
see:

• Org D2: Nothing

• Org M2: 

• MPP planned make orders for item A

• MPP planned transfer orders for item E from S1

• MRP planned orders for Items B, C, and D

• MRP planned transfer orders for item L from M1

• Org M1:

• Nothing from the MPP

• MRP planned orders for items L, M, and N

• Org S1: 

• MPP planned orders items E, F, and G

• MRP planned orders for items H and I

Interplant option is selected
In the MRP, the interplant check box is selected for the MPS or MPP demand schedule. 
The only planned orders from the MPP or MPS that appear in the MRP are interplant 
transfers. The purpose of feeding the demand schedule with Interplant option selected 
is to pick up the interplant demands and then let the MRP plan all supplies within an 
organization. The supplies are all pegged to the interplant transfer demands, which are 
again seen as firm with respect to the MRP. No dates and times are changed for the 
interplant transfer demands.

Master Scheduling
Oracle Advanced Supply Chain Planning provides you with master scheduling 
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capabilities to perform aggregate production planning using product family items.

Forecasting and planning at the product family level allows you to anticipate and 
resolve resource loading issues and subsequently helps you to recommend appropriate 
levels of procurement at the right times.

You can also perform aggregate production planning using product family items if you 
want to segregate production planning (for level loading against resource constraints) 
and materials planning (for driving procurement) into separate job functions.

Oracle does not recommend placing an assemble-to-order model as a member of a 
product family.

Oracle Advanced Supply Chain Planning provides you the following features for 
master scheduling:

• 'Reduce MPS, page 5-23

• 'Production Forecast, page 5-24

• 'Product Family Item Sourcing, page 5-25

• 'Constrained Master Scheduling, page 5-26

• 'Product Family and Member Item Drill Down, page 5-27

• 'Forecast and Production Forecast Pegging, page 5-27

Reduce MPS
Planned orders for product family items in an MPS plan are usually firm due to the 
following reasons:

• The orders are firmed during level loading

• The profile option MSC: MPS Auto-Firm Planned Orders is set to Yes 

Oracle Advanced Supply Chain Planning allows you to eliminate the firmed planned 
orders within a defined time fence from subsequent batch replans. When you set the 
Reduce MPS option, firm planned orders that fall within the Reduce MPS time fence are
automatically dropped at the time of the next plan run. This helps you in avoiding 
overstatement of material and resource requirements.

Note: In case of standard items, the demand time fence, the process of 
releasing a planned order, and collecting the Work In Process job 
reduces and relieves the planned orders. However, product family 
items are only reference items with respect to execution and are never 
released. Therefore, these items do not follow the mechanism used by 
standard items.
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To set the Reduce MPS option
1. Define the product family item.

2. For more details, see section: Creating a Product Family in Oracle Bills of Material 
User's Guide.

3. Select the Inventory responsibility.

4. Navigate to Items > Organization Items > MPS/MRP Planning tab.

5. Set the Reduce MPS option to one of the following:

• None - The order quantities of the MPS item supply are not reduced.

• Past Due - When the supply due date is past due, the order quantities on the 
MPS supply entries are reduced to zero

• Demand Time Fence - When the supply is within the demand time fence, the 
order quantities on the MPS supply entries are reduced to zero

• Planning Time Fence - When the supply is within the planning time fence, the 
order quantities on the MPS supply entries are reduced to zero

It is recommended that you use the Past Due option for reducing MPS and 
enable Demand Time Fence for items that are exploded and derived in 
planning.

To use the Reduce MPS option
1. Set the Reduce MPS option.

2. Run a production plan for the MPS item.

3. Level load and firm the planned orders.

4. Re-run production plan at a later date.

5. Verify that firmed planned orders are dropped based on the Reduce MPS time 
fence.

Production Forecast
During planning, Oracle Advanced Supply Chain Planning considers the following 
derived dependent demands as production forecasts:

• Member items that are part of a product family item

• Option class and option items that are part of a model item
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The planning engine applies demand time fence control to the production forecast. This 
ensures a correct demand picture for the member items, option class and option items.

To set dependant demands as production forecast
1. Select the Inventory responsibility.

2. Navigate to Items > Organization Items > MPS/MRP Planning tab.

3. Set the Forecast Control as None for the member items, option class, or option 
items. 

The planning engine explodes the requirements for these items based on the parent 
forecast or demand.

4. Optionally, define the Demand Time Fence for member items to enable demand 
time fence control.

For more details, see section: MPS/MRP Planning Attribute Group in Oracle 
Inventory User's Guide.

5. Verify that the derived demand is available as production forecast.

If Demand Time Fence is enabled, the planning engine uses the member item 
demand time fence.

6. Navigate to the Horizontal Plan window to view the dependent demand.

Product Family Item Sourcing
When you need to ship product family member items from multiple shipping locations,
Oracle Advanced Supply Chain Planning generates recommendations for shipping 
locations based on capacity and current supply conditions and allows you to distribute 
forecasts to the specific shipping locations. Using this option, you can decide, which 
internal organizations to source from at the product family level in the production plan.

To set up product family items sourcing
1. Select Advanced Supply Chain Planner responsibility.

2. Navigate to Sourcing > Assignment set.

The Sourcing Rule / Bill of Distribution Assignments window appears.

3. Assign sourcing rules to product family items.

For more details on assigning sourcing rules, see Setting Up the Supply Chain, page
6-2,

Oracle Advanced Supply Chain Planning uses the global sourcing rules from the 
assignment set defined in Step 3 to distribute forecast using global forecasting rules.
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For more details on global forecasting, see Chapter 6: Supply Chain Modeling, section: 
Global Forecasting.

Constrained Master Scheduling
It is often desirable to master schedule only end items, taking into consideration 
material availability of critical components and the capacity of key bottleneck resources.
You can specify certain components as critical components, and resources as bottleneck 
resources to constrain an MPS or MPP plan even though the components are actually 
planned in MRP.

To define critical components:
1. Select the Inventory responsibility.

2. Navigate to Items > Organization Items > MPS/MRP Planning tab.

3. Select the critical component check box.

The planning engine can infer from the bottleneck resource group whether or not an 
item is a critical component.

For more details, see section: MPS/MRP Planning Attribute Group in Oracle Inventory 
User's Guide.

To define bottleneck resources:
1. Select the Inventory responsibility.

2. Define the Bottleneck Resource Group in the Resource Groups Lookups form.

3. Assign the Bottleneck Resource Group to the appropriate department resources in 
the Department Resources form.

For more details, see Oracle Bills of Material User's Guide.

4. Specify the Bottleneck Resource Group in Plan Options > Constraint tab.

Bottleneck Resource Group Scheduling
If you plan using a bottleneck resource group, the planning engine schedules all 
resources but schedules resources in the bottleneck resource group differently than it 
schedules resources not in the bottleneck resource group.

For resources in the bottleneck resource group, it performs the usual detailed 
scheduling referring to the constraint planning options that you selected. 

For resources not in the bottleneck resource group, it schedules activities and 
operations:

• When needed
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• Based on the required duration (Resource usage / Assigned units)

• Without regard to resource capacity. If its actions overload resource capacity, it 
issues Resource overloaded exception messages.

• Without regard to the plan option Resource Constraints.

If the plan is:

• Enforce capacity constraints, the planning engine may schedule the supply late 
because of the duration and issue Resource constraint exception messages.

• Enforce demand due dates, the planning engine may compress the duration so that 
the supply completes on time, when it reaches the planning horizon start time, and 
when it reaches the planning time fence. As it compresses duration, it increases 
assigned units.

Product Family and Member Item Drill Down
Oracle Advanced Supply Chain Planning allows you to view the product family item 
details that include member item rolled up information in the Horizontal Plan window.

For more details, see Chapter 10: Planner Workbench, section: Product Family and 
Member Item Drill Down.

Forecast and Production Forecast Pegging
Pegging traces supply information for an item to its corresponding end demand details.

For more details, see Chapter 10: Planner Workbench, section: Forecast and Production 
Forecast Pegging.

Choosing a Plan Type
In Oracle ASCP you can launch three type of plans:

• Production Plan

• Manufacturing Plan

• Master Plan

Each creates time-phased planned orders that satisfy independent and dependent 
demand while seeking to respect material and resource constraints.

A choice of plan types lets you tailor the degree of subset planning that is performed for
the supply chain: from a single, global supply chain plan down to manually adjusted 
plans for each item in each organization of the supply chain.

MPS plans support the following functionality:
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• You can select routings for a production plan while scheduling resources. 

• For production plans that have routings, you can view the Gantt chart in the 
Planner Workbench.

To do this, the three types of plans need to be used in conjunction with the MRP 
Planning Type item attribute that is set for each item. Possible values for this attribute 
are:

• MRP Planning

• MPS Planning

• MRP/MPP Planned

• MPS/MPP Planned

• MPP Planned

In addition, plan option Main tab, Planned Items specifies the types of items that the 
planning engine should plan in a particular plan run. Choices are:

• All Planned Items 

• Demand Schedule Items and all sales orders: Plan all items that have demands as 
well as all items that have sales orders against them.

• Supply Schedule Items only 

• Demand and supply schedule Items 

• Demand Schedule and WIP components 

• Demand Schedule items only: Only plan items that have demands If plan option 
Include Sales Orders is selected (Organizations tab), include only sales orders 
against those items.

• Demand Schedule Items, WIP components and all sales orders

To set the MRP Planning Type item attribute at the item level
1. Sign on with the Manufacturing and Distribution Manager responsibility. 

2. From the Navigator window, choose Inventory > Items > Master Items.
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To set the MRP Planning Type item attribute at the more detailed item-organization level
1. Sign on with the Manufacturing and Distribution Manager responsibility.

2. From the Navigator window, choose Inventory > Items > Organization Items.

Each type of plan includes or ignores an item for planning depending on the setting of 
its MRP Planning Type attribute. The discussion below focuses on the principal ways in
which plan type (Master, Production, or Manufacturing) can be used in conjunction 
with MRP Planning Type item attribute values (MRP Planning, MPS Planning, MPP 
Planned, MRP/MPP Planned, MPS/MPP Planned).

There is a logical equivalence between the different planning types as shown by the fact
that the following plans, applied to the sample supply chain (Sample Supply Chain, 
page 5-2) and BOM (Sample Bill of Material, page 5-2), yield identical planned orders 
across the supply chain. In the BOMs illustrated in these figures, the values in 
parentheses indicate the setting of the MRP Planning Type item attribute.

The usefulness of the different types of plans comes in when subset planning is used. 
Suppose, for example, that subset plan M12 and all its components and subcomponents 
are used. Some reasons for needing to do so are discussed above.

1. Run a Master plan to generate planned orders for all items except for the 
components and subcomponents of M12 (Sample Bill of Material, page 5-2):

This combination of plan type and MRP Planning Type item attribute values creates
cross-supply chain planned orders for A01, M11, B13, B21, and M12 and omits M22,
B23, B31.

2. Use the Master plan as a demand schedule for a Production plan run. This 
generates planned orders M12.
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3. Manually modify the MPS for M12 as necessary.

Note: With Oracle ASCP, this step is less frequently necessary than 
before. This is because the finite-capacity planning performed by 
Oracle ASCP takes resource and material availability into account, 
and therefore eliminates much of the need to manually smooth 
production via an MPS.

4. Run a Manufacturing plan, using the Production plan as an input demand 
schedule. This generates planned orders for M12, M22, B23 and B31 (Sample Bill of 
Material, page 5-2).
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Choosing Plan Classes
Oracle ASCP allows for the following options for generating plans. 

• Unconstrained

• Resource Constrained

• Material Constrained

• Material and Resource Constrained

• Optimized

Before discussing these options in the table below, please take note of the following key 
concepts.

Constraints
Oracle ASCP lets you prioritize how you enforce Capacity Constraints or Demand Due 
Dates. Whichever constraint takes precedence over the other is the hard constraint; the 
other is the soft constraint. You must choose one and only one type of constraint.

Enforce Demand Due Dates
If you choose to enforce Demand Due Dates (setting Demand Due Dates as a hard 
constraint), then primary resources are used and loaded to capacity to satisfy demand 
due dates. The system also evaluates alternate resources if additional capacity is 
required. If there is insufficient capacity to meet demand due dates, the primary 
resource is overloaded. The choice of whether to use an alternate resource or overload 
capacity depends on cost considerations if optimization is selected. Oracle ASCP 
returns exception messages if capacity is overloaded.

Enforce Capacity Constraints
If you choose to enforce Capacity Constraints (setting Capacity Constraints as a hard 
constraint), then resources are loaded to their limit to satisfy demand (if required). 
Unsatisfied demand is pushed into the future. In this case, Oracle ASCP returns late 
replenishment exception messages.

Optimization
Oracle ASCP allows for multiple levels of optimization in generating plans. These are 
described in the table below along with the situations under which each would be most 
useful.



5-32    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Optimization Level Planning Horizon Question/Goals Scenario

Unconstrained Plan Long Term Future How much resource 
capacity and material 
availability do I need 
to arrange in order to 
satisfy all anticipated 
demand in a timely 
manner?

Decisions can be 
made on resource 
acquisition/dispositio
n and supplier 
sourcing to address 
the exceptions.

Resource Constrained
Plan 

Long Term Future How much material 
availability do I need 
to arrange in order to 
satisfy all anticipated 
demand in a timely 
manner?

Difficult to change 
resource capacity, but
increased outsourcing
is an option. 

Decisions can be 
made on supplier 
sourcing to address 
the exceptions.

Material Constrained 
Plan 

Long Term Future How much resource 
capacity do I need to 
arrange in order to 
satisfy all anticipated 
demand in a timely 
manner?

Difficult to change 
material availability 
but internal resource 
acquisition/dispositio
n is an option.

Decisions can be 
made on resource 
acquisition/dispositio
n to address the 
exceptions.

Material and 
Resource Constrained
Plan

Near Term Future Generate a feasible 
plan that respects 
material, resource, 
distribution, and 
transportation 
constraints.

Impossible to 
overcome material 
and resource 
constraints and 
therefore must 
respect them in order 
to generate a feasible 
supply chain plan.
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Optimization Level Planning Horizon Question/Goals Scenario

Optimized Plan Near Term Future Generate an 
optimized and 
executable plan based
on plan objectives 
and material, 
resource, and 
transportation 
constraints.

Impossible to 
overcome material 
and resource 
constraints and 
therefore must 
respect them in order 
to generate a feasible 
supply chain plan.

The scope of optimization levels is summarized in the table below:

Optimization Level Scope

Non-optimized (unconstrained, resource 
constrained, material constrained, material 
and resource constrained) 

(Optimized option unchecked which applies 
to the entire planning horizon) 

Local settings that can be applied to temporal 
subsets of an overall supply chain plan. These 
simply dictate which types of constraints 
(material and resource) are obeyed in which 
portions of the plan. 

The planned orders for the Resource 
Constrained, Material Constrained and 
Material and Resource Constrained time 
portions of the plan are generated via a fast 
heuristic.

The planned orders for the Unconstrained 
time portion of the supply chain plan are 
always generated using traditional MRP type 
logic.

Optimized 

(Optimized option checked which applies to 
the entire planning horizon)

Global setting that applies to the entire supply
chain plan. 

The planned orders for the resource 
constrained, material constrained and material
and resource constrained time portions of the 
plan are generated via a linear programming 
planning algorithm which explicitly optimizes
objectives that are important to the user.

Choosing Planning Modes
The planning engine operates in phases. Each phase performs different planning tasks.
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You can choose a planning mode to guide the planning engine in the planning process. 
Each planning mode executes a different set of planning phases.

Planning Engine Phases

This table explains the planning engine phases.

Planning Engine Phase Description

Optimization phase - Linear-programming based

- Selects alternate sources, processes bills of 
material and routings, substitute items and 
components, and alternate resources

Order modifier phase - Modifies output of optimization phase so 
that order modifiers are respected

- Calculates pegging

Planning phase - Nets available supply and scheduled receipts
against demand to calculate planned orders

- Applies order modifiers

- Calculates pegging

- Enforces date effectivities: Bills of material 
and routings, sourcing rules, process validity 
rules, and end item substitution rules)

Scheduling phase - Reschedules supplies to respect material, 
resource, lead-time, and calendar constraints

- Refines alternate resource selection if 
necessary

- Schedules supplies to the minute

Planning Modes

You select the planning mode for a plan as you specify the instructions for the planning 
engine (plan options). This table explains the planning phases that the planning engine 
performs each planning mode.

Planning Mode Planning Engine Phases

Unconstrained: Planning phase Planning phase
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Planning Mode Planning Engine Phases

Constrained (Classic): - Planning phase

- Scheduling phase

Constrained (Classic) with Decision Rules: - Optimization phase

- Planning phase

- Scheduling phase 

Constrained (Without Detailed Scheduling): - Optimization phase

- Order modifier phase

Constrained (With Detailed Scheduling): - Planning phase

- Optimization phase

- Order modifier phase

- Scheduling phase

Optimized: - Optimization phase

- Planning phase

- Scheduling phase

The planning modes Constrained (Without Detailed Scheduling) and Constrained 
(With Detailed Scheduling) are available only when the value of profile option MSC: 
Enable Advanced Constraints is Yes

Evaluation of Planning Modes

If you want to plan to infinite capacity, choose Unconstrained planning mode.

If you want to constrain the plan according to capacity constraints or due dates, choose 
from:

• A constrained planning mode—Constrained (Classic), Constrained (Classic) with 
Decision Rules, Constrained (Without Detailed Scheduling), and Constrained (With
Detailed Scheduling) planning mode

• Optimized planning mode 

If you want the planning process automatically to select alternates considering full 
relative cost data, choose Optimized planning mode.

If you want the planning process automatically to select alternates considering only the 
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rankings of alternates (sources, bills of material/routings, resources, substitute 
components, end item substitutes) and not relative cost data for alternates, choose from

• Constrained (Classic) with Decision Rules planning mode

• Constrained (Without Detailed Scheduling) planning mode

• Constrained (With Detailed Scheduling) planning mode

Before you use these alternate options, set profile options:

• MSC: Enable Advanced Constraints

• MSO: Order Modifier Maximum Searching Depth

Oracle suggests that the Constrained (Without Detailed Scheduling) and Constrained 
(With Detailed Scheduling) planning modes provide superior solution quality to the 
Constrained (Classic) with Decision Rules planning mode. The superior quality results 
from planned order generation with respect to order modifiers, capacity, and lead-time 
constraints at the same time. This results in more accurate offloading from primary to:

• Alternate resources when order modifiers are present

• Alternate sources to minimize demand lateness

• Substitute components to minimize demand lateness

These diagrams show some solution differences between the Constrained (Classic) 
mode and the Constrained (With/Without Detailed Scheduling) modes.
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If day-level planning information is acceptable and you prefer to have the planning 
results as quickly as possible, choose Constrained (Without Detailed Scheduling) 
planning mode. Oracle suggests that this planning mode generally takes less time to 
process than the detailed scheduling planning modes—Constrained (Classic) with 
Decision Rules and Constrained (With Detailed Scheduling).

If you need detailed scheduling to the minute and can wait for longer processing times 
than Constrained (Without Detailed Scheduling) planning mode, choose from:

• Constrained (Classic) with Decision Rules planning mode: Oracle suggests that this 
planning mode generally takes less time to process than the Constrained (With 
Detailed Scheduling) planning mode.

• Constrained (With Detailed Scheduling) planning mode: Oracle suggests that this 
planning mode takes longer to process than the Constrained (Classic) with Decision
Rules planning mode but provides superior solution quality.

Setting Plan Options
This section describes how to set plan options. The plan options appear in the following
tabbed regions:
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• Main

• Aggregation

• Organizations

• Constraints

• Optimization

• Decision Rules

• Reporting

To access the plan options do either of the following:

• Go directly from the Navigator

• Access the Plan Names form, select a plan, and click Plan Options.

The Main Tabbed Region
This table describes the fields and options.

Object Description

Planned Items This parameter and the Plan Type field in the 
Supply Chain Names window, control the 
items that are planned in the supply chain 
plan. An item must satisfy conditions imposed
by both parameters before being included in 
the supply chain plan. Please see Choosing a 
Plan Type, page 5-27 for further details.

Assignment Set The assignment set that holds the sourcing 
rules and bills of distribution that define the 
rules for material flow within your supply 
chain. 



Defining Supply Chain Plans    5-39

Object Description

Material Scheduling Method Choose from Operation Start Date or Order 
Start Date scheduling methods. If you choose 
Operation Start Date, material is scheduled to 
arrive at the start of the operation for which it 
is required. If you choose Order Start Date, 
material is scheduled to arrive at the start of 
the order for which it is required. Order State 
Date is usually an earlier date than the 
Operation Start Date and therefore this 
selection represents the more conservative 
planning logic of the two options. 

Rapid Planning Simulation Set Set this if you are using an Oracle Rapid 
Planning simulation plan to feed back changes
to this plan. Enter the name of the simulation 
set from the Oracle Rapid Planning plan.

Demand Priority Rule When ASCP does detailed scheduling, it 
schedules demands one by one. The rule 
specified here dictates the order in which 
demands will be considered during detailed 
scheduling, and thus which demands will get 
the first opportunities to take up available 
materials and resource capacities. Please see 
the section Demand Priority Rules, page 5-66.

End Item Substitution Set If Decision Rules tabbed region > Use End 
Item Substitution is selected, select a 
substitution set. These are defined in the 
Planning Details - Substitute window 
discussed End-Item-Level Substitution, page 
12-1. You can use a set of substitution 
relationships to be effective for a given plan 
by selecting the substitution set as an option 
for the plan. This allows you to run 
simulations of possible substitutions and 
evaluate performance indicators given 
possible future substitutions. 

Exception Group If you want to filter exception messages using 
an exception group that you have created, 
select it. The planning engine issues only the 
exception messages that you want and only 
issue them for the organizations, item 
categories, and time periods that you want.
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Object Description

Overwrite Overwrite planned orders. For further details, 
please see Overwrite Options, page 5-61.
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Object Description

Schedule By Set this option to instruct the planning engine 
to:

- Plan supplies based on sales order line 
request, promise, or schedule dates for either 
ship or arrival

- Consume forecasts based on sales order line 
request, promise, or schedule dates. You must 
provide forecast dates that match your choice 
of this plan option; for example, if you select 
Promise Ship date for this plan option, make 
sure your forecast dates are in terms of 
promise ship dates.

Select one of the following sales order line 
dates:

- Schedule Ship Date

- Schedule Arrival Date

- Request Ship Date

- Request Arrival Date

- Promise Ship Date

- Promise Arrival Date

The default is Schedule Ship Date.

For forecast consumption, the planning engine
uses:

• Schedule Date: If you select Schedule 
Ship Date or Schedule Arrival Date

• Request Date: If you select Request Ship 
Date or Request Arrival Date

• Promise Date: If you select Promise Ship 
Date or Promise Arrival Date

If you do not specify plan option Demand 
Priority Rule and have not specified a default 
demand priority rule (in the Define Priority 
Ruled form), the planning engine uses the 
value of this plan option as the demand 
priority rule.
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Object Description

Demand Class If you want to limit a production plan to a 
demand class, enter it. This field is active only 
for a Production Plan/MPS schedule.

Planning Time Fence Control Check this option to enforce item attribute 
planning time fence control. 

Maintenance Work Orders For asset intensive planning, select the 
collected entities that you want to drive the 
plan

- EAM forecasts

- cMRO simulation sets

Demand Time Fence Control Check this option to enforce demand time 
fence control. 

Append Planned Orders Appends new planned orders to current plan. 
For further details, please see Overwrite 
Options, page 5-61.

Move Work Orders to PIP Check this option if you want to generate 
planned order supply even in the absence of 
demand in order to ensure that inventory is 
held on the manufacturing floor only for items
designated as Planned Inventory Points.

Display Key Performance Indicators Check this option to calculate key 
performance indicators for the plan.

Lot for Lot Check this option to force the creation of a 
separate supply for each demand. This 
prevents creation of aggregate supplies that 
satisfy multiple demands.
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Object Description

Include Critical Components Select this plan option to instruct the planning
engine to plan considering critical 
components.

Depending on the plan type and the planning 
item types, the planning engine may plan 
critical components and not plan other 
components or components of those 
components.

To mark an item as a critical component, select
its item attribute Critical Component.

Derive Returns Forecast from Work Orders In asset intensive planning, select this plan 
option to instruct the planning engine to use 
cMRO defective component requirements as a 
removals forecast.

Do Not Spread Forecast The planning engine should use forecast 
entries as they exist for planning.

Spread Forecast Evenly The planning engine should spread aggregate 
forecast demand evenly across the daily 
buckets from the workday calendar.

Consume by Forecast Bucket The forecast consumption process does not 
search outside of the consumption bucket for 
forecasts and sales orders except in daily 
buckets.

Explode Forecast Select this plan option to instruct the planning
engine to explode forecasts as follows during 
the consumption process:

- Product family forecasts to product family 
member item forecasts

- Model forecasts to other model, option class, 
and item forecasts.

This option applies to forecasts with forecast 
control Consume and derive.

If you clear this plan option, you have 
arranged for this explosion to occur in the 
source instance or in Oracle Demand Planning
before the planning run.
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Object Description

Backward Days This parameter allows a sales order demand 
to consume forecast demand even if the 
forecast demand is up to the specified number
of days earlier than the sales order demand. It 
applies only to the supply chain planning 
forecast and not to Oracle Demand Planning 
forecast scenarios. Please see the section 
Forecast Consumption Days, page 5-74 for 
more details.

Forward Days This parameter allows a sales order demand 
to consume forecast demand even if the 
forecast demand is up to the specified number
of days later than the sales order demand. It 
applies only to the supply chain planning 
forecast and not to Oracle Demand Planning 
forecast scenarios Please see the section 
Forecast Consumption Days, page 5-74 for 
more details.

Enable Pegging Select this option (the default) to calculate 
pegging information. Oracle ASCP traces 
supply information for an item to its 
corresponding end demand details, which you
can then view in a graphical display. This field
is checked by default.

Peg Supplies by Demand Priority If Enable Pegging is selected, select to instruct 
the planning engine to peg in demand priority
order from Demand Priority Rule.

Reservation Level If Enable Pegging is selected, choose a 
reservation level: Planning Group, Project, 
Project-Task, or None. 

Hard Pegging Level If Enable Pegging is selected, choose a hard 
pegging level: Project, Project-Task, or None. 

The Aggregation Tabbed Region
This table describes the fields and options.
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Object Description

Plan Start Date If you have never run the plan, this field 
displays today's date. If you have run the 
plan, this field displays the planning horizon 
start date of the last run.

Plan End Date Calculated planning horizon end date based 
on your entries in Buckets and the owning 
organization calendar. 

Start Date Calculated start date for each bucket based on 
your entries in Buckets and the owning 
organization calendar. The value for the Days 
column is the Plan Start Date.

Buckets Number of buckets of this bucket type. 

Weekly buckets can only start on the week 
beginning day from the manufacturing 
calendar. If the daily horizon does not end on 
the day before a week beginning day, the 
planning engine extends it to the next day 
before a week beginning day. It plans the 
extended days in daily buckets, never minute 
or hourly buckets, regardless of any other 
settings.

Items Choose to plan at either the Item level or 
Product Family level. If you select Items in the
first bucket, the other buckets can be set to 
either Items or Product Family. However, if 
you select Product Family in the first bucket, 
the remaining buckets are set to Product 
Family by default.

Resources Choose to plan at either the Individual level or
Aggregate level. If you select Individual in the
first bucket, the other buckets can be set to 
either Individual or Aggregate. If you select 
Aggregate in the first bucket, the remaining 
buckets are set to Aggregate by default.

Routings Choose to plan at either the routings or bill of 
resources level. Whatever level you select in 
any of the buckets, all the rest of the buckets 
are assigned that level by default. 
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Resource Utilization Calculation
The planning run generates planned orders, recommendations, and resource 
requirements. 

The planning horizon is synchronized with time of the plan run. As a result, planned 
orders, recommendations, and resource requirements are generated starting at the time 
of plan run.

This diagram shows how resource utilization is calculated. The resource requirements 
are calculated as of Time t2 and the resource availability as of Time t1. There is a 
disparity between the times of resource requirement calculation (t2) and resource 
availability calculation (t1).

The Organizations Tabbed Region
This table describes the fields and options.

Object Description

Global Demand Schedules Select the names of Oracle Demand Planning 
scenarios that drive this plan. You can select 
demand planning scenarios that do not 
reference an organization (organization 
dimension set to All Organization).

Ship To Consumption Level Select a forecast consumption level for the 
Oracle Demand Planning scenario. The global 
forecasting process consumes forecast entries 
that have Ship To value the same as this plan 
option.

You can select:

- Customer

- Customer Site

- Zone

- Customer Zone

- Demand Class

- Item

The choices in the list of values changes 
depending on the published level of the 
scenario.
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Object Description

Org An organization which this plan should plan. 

Description The name of the organization. 

Net WIP Select to consider discrete jobs and other 
production orders as supply in the planning 
demand/supply netting process.

Net Reservations If checked, ASCP generates pegging of 
on-hand supply to sales orders that matches 
the reservations recorded in the source 
transaction system.

Net Purchases Select to consider purchase orders, purchase 
requisitions, in-transit shipments and other 
nonproduction order scheduled receipts as 
supply in the planning demand/supply 
netting process. This option covers all 
scheduled receipts not covered by the Net 
WIP option.

Plan Safety Stock Select to consider plan safety stock demand 
and supply in the planning demand/supply 
netting process. See Safety Stock, page 6-133.

Include Sales Order Select to invoke forecast consumption within 
ASCP for the selected organization. Check this
if the demand schedules for the organization 
are unconsumed forecasts. Uncheck this if the 
demand schedules for the organization are 
consumed forecasts plus sales orders in the 
form of master demand schedules.

Firm Planned Orders From Production 
Schedule

Select this check box to indicate that the 
organization can receive data from Production
Scheduling to the schedule specified in the 
Schedule Name field.

See Feeding a Production Schedule Back into 
ASCP.
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Object Description

Schedule Name Enter the name of the production schedule. 
Note that this production schedule should be 
referencing this ASCP plan within its schedule
options. In other words, the schedule name 
that is entered should reference the ASCP plan
on the Schedule Options page, Scope tab.

See Feeding a Production Schedule Back into 
ASCP.

Firm Horizon (Days) Enter the number of days for which the 
planned orders from the feeding production 
schedule are considered by the ASCP plan.

See Feeding a Production Schedule Back into 
ASCP.

Bill of Resource Select Bill of Resources from the list of values. 
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Object Description

Simulation Set Select a Simulation Set from the list of values. 
A simulation set is a set of adjustments to the 
base availability calendar of a resource, and is 
defined via the Oracle Bills of Material 
Department Resources form. You can define 
different simulation sets to model different 
availability scenarios (for example, the base 
availability calendar reflects 5 day operations; 
simulation set 1 reflects working 6 day 
operations; simulation set 2 reflects 7 day 
operations). The planning engine applies the 
simulation set to all resources in the 
organization. 

Oracle Enterprise Asset Management plans 
maintenance activity and creates maintenance 
work orders which may specify shutdown of 
equipment resources. If you are using Oracle 
Enterprise Asset Management, you can pass 
your maintenance downtimes to the planning 
engine. To plan for these shutdowns in Oracle 
Advanced Supply Chain Planning, run the 
Oracle Enterprise Asset Management Load 
Equipment Maintenance Downtime 
concurrent process.

The process creates a simulation set with the 
downtimes recorded as capacity changes for 
reduced hours. You can specify the simulation
set in the Organizations tabbed region of the 
Plan Options window. When the plan is run, 
the planning engine uses this simulation set to
calculate the reduction in the available 
capacity of resources due to maintenance 
downtime. The planning engine plans 
production activities for these resources after 
considering the reduction in available 
capacity. You can view the impact of this 
change on the resource availability and usage 
profiles in the Planner Workbench.

Demand Schedules Select the names of demand schedules, 
forecasts, and plans that drive this plan. 
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Object Description

Include Targets You can select this option for a distribution 
plan that you are using as a demand schedule.
Distribution plans may use target inventory 
levels and attempt to plan to meet the target 
inventory demands. However, when 
smoothing their production schedules and 
resolving constraints, they may choose to 
produce some amount less than required by 
the target inventory levels. In this case, 
distribution planning distributes according to 
safety stock inventory levels first and then 
allocates the remainder using the target 
inventory levels. 

Ship To Consumption Level Select a forecast consumption level for the 
local forecasts in the demand schedule. The 
forecast consumption process consumes 
forecast entries that have Ship To value the 
same as this plan option.

You can select:

- Customer

- Customer Site

- Demand Class

- Item-org

Interplant If selected, the planning engine uses only 
interorganization orders and demands from 
interorganization planned orders. If cleared, 
the planning engine uses demands from all 
planned orders.

Supply Schedules Select the name of supply schedules that 
participate in this plan. 

Subinventory Netting Opens the Subinventory Netting window. 
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Object Description

Forecast Spreading Calendar The calendar that the planning engine uses to 
spread this organization's forecasts. If you 
don't specify a calendar here, the planning 
engine spreads this organization's forecasts 
according to the calendar in profile option 
MSC: Forecast Spreading Calendar.

The Constraints Tabbed Region
This table describes the fields and options.

Object Description

Constraints Mode Specify the constrained planning mode for 
this plan; see Choosing Planning Modes. Valid
values are:

Unconstrained: This is the default value. The 
options in the Scheduling region are grayed 
out. 

Constrained (Classic): The options in the 
Scheduling region are enabled.

Constrained (Without Detailed Scheduling): 
The options in the Scheduling region are 
grayed out. You cannot use lot-for-lot 
planning in this planning mode.

Constrained (With Detailed Scheduling): The 
options in the Scheduling region are enabled.

You cannot set all Resource Constraints and 
Material Constraints to No. If you set any 
Resource Constraints to Yes, you cannot clear 
Calculate Resource Requirements.

To enable pegging, select plan option Enable 
Pegging.
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Object Description

Enforce Demand Due Dates Select if you want demand due dates to be 
your hard constraint (that is, respected in lieu 
of material and resource capacity constraints if
there is conflict). For more information, see 
Setting Constraints for Different Plan Types, 
page 9-28.

Enforce Capacity Constraints Select if you want material and resource 
capacity constraints to be respected in lieu of 
demand due date constraints if there is a 
conflict. For more information, see Setting 
Constraints for Different Plan Types, page 9-
28.

Start Date Displays the start date for each bucket type.

Buckets Displays the number of buckets of this bucket 
type.

Resource Constraints Select Yes to consider resource constraints. If 
you select No, the planning engine assumes 
that resource capacity is infinite regardless of 
any simulation sets.

Supplier Capacity Constraints Select Yes to consider supplier capacity 
constraints. 

Enforce Purchasing Lead-time Constraints Select this plan option to instruct the planning
engine to constrain the plan by purchased 
item lead-times (item attributes or approved 
supplier list).

Clear it to instruct the planning engine never 
to miss a demand due date because of a 
purchased item lead-time.

For more details, see Enforce Purchasing 
Lead-time, page 9-30.
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Object Description

Minutes Bucket Size (in Days) Specify the number of minute buckets in the 
Days bucket type. If the plan start time is not 
00:00, the planning engine schedules the 
remainder of the first day in minutes even if 
the value for plan option Minutes is 0. For 
example if you start the plan on 01-Jan 14:00, 
the planning engine schedules in minutes 
from 01-Jan 14:00 to 02-Jan 00:00.

Hours Bucket Size (in Days) Specify the number of hours buckets in the 
Days bucket type. 

Days Bucket Size (in Days) Specify the number of days buckets in the 
Days bucket type. 

Calculate Resource Requirements If selected, the program will calculate resource
capacity utilization. Select in unconstrained 
plans to enable release of lot-based planned 
orders.

Planned Resources Select All Resources or Bottleneck Resources. 
If you have defined bottleneck resource 
groups in Oracle Bills of Material and you 
want to detail schedule only the bottleneck 
resources, select Bottleneck Resources and 
enter a Bottleneck Resource Group.

Bottleneck Resource Group If you have defined bottleneck resource 
groups in Oracle Bills of Material and you 
want to detail schedule only the bottleneck 
resources, select its name. 

Bottleneck Resource Group Scheduling
If you plan using a bottleneck resource group, the planning engine schedules all 
resources but schedules resources in the bottleneck resource group differently than it 
schedules resources not in the bottleneck resource group.

For resources in the bottleneck resource group, it performs the usual detailed 
scheduling referring to the constraint planning options that you selected. 

For resources not in the bottleneck resource group, it schedules activities and 
operations:

• When needed
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• Based on the required duration (Resource usage / Assigned units)

• Without regard to resource capacity. If its actions overload resource capacity, it 
issues Resource overloaded exception messages.

• Without regard to the plan option Resource Constraints.

If the plan is:

• Enforce capacity constraints, the planning engine may schedule the supply late 
because of the duration and issue Resource constraint exception messages.

• Enforce demand due dates, the planning engine may compress the duration so that 
the supply completes on time, when it reaches the planning horizon start time, and 
when it reaches the planning time fence. As it compresses duration, it increases 
assigned units.

The Optimization Tabbed Region
This table describes the fields and options.

Penalty factors are plan level values that:

• You can override by setting values for organizations and items in the source 
instance

• Override those set in profile options

Object Description

Optimize Select if you are running an optimized plan.
Before selecting, verify that you selected 
Constraints tabbed region, Constrained Plan
field. If you clear, you cannot enter any 
other information in this tabbed region.

Enforce Sourcing Constraints Select if you want to enforce the sourcing 
splits in the item sourcing rules. For an 
optimized plan, the planning engine may 
override these sourcing splits if it results in 
less cost. For unconstrained and constrained
plans, the planning engine respects these 
sourcing splits without regard to this 
option.

Maximize inventory turns Specify a weighting percentage from 0 to 1. 
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Object Description

Maximize plan profit Specify a weighting percentage from 0 to 1.

Maximize on-time delivery Specify a weighting percentage from 0 to 1.

Exceeding material capacity % Enter a numerical value to quantify the 
impact of exceeding material capacity. For 
example, if you enter 50, the penalty factor 
is 50%.

Exceeding resource capacity % Enter a numerical value to quantify the 
impact of exceeding resource capacity. For 
example, if you enter 50, the penalty factor 
is 50%. 

Exceeding transportation capacity % Enter a numerical value to quantify the 
impact of exceeding transportation capacity.
For example, if you enter 50, the penalty 
factor is 50%.

Demand lateness % Enter a numerical value to quantify the 
impact of late demand. For example, if you 
enter 50, the penalty factor is 50%.

The Decision Rules Tabbed Region
This tabbed region is available as follows:

• Unconstrained plans: It is never available. 

• Constrained plans: It is available only if profile option MSO: Enable Decision Rules 
is Yes. 

• Optimized plans (Optimization tabbed region, Optimize is selected): It is always 
available.

This table describes the fields and options.
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Object Description

Use End Item Substitution If selected, use end item substitute prior to 
creating new planned orders. If cleared, use 
only the demanded item. Enter the End Item 
Substitution Set in the Main tabbed region.

Use Alternate Resources If selected, use primary resource and use 
alternate resource only if necessary. If cleared, 
use only primary resources.

Use Substitute Components If selected, use primary components and use 
substitute components only if necessary. If 
cleared, use only primary components only.

Use Alternate BOM/Routing If selected, use primary routings and use 
alternates only if necessary. If cleared, use 
only primary bills of material and routings.

Use Alternate Sources If selected, use primary sources and use 
alternate sources only if necessary. If cleared, 
use primary sources only. The planning 
engine does not use alternate sources (rank 2 
or higher) as a sources of supply.

The Reporting Tabbed Region
This table describes the fields and options.

Object Description

Available Worksheets Worksheet definitions available for this plan.

<arrows> Move worksheet definitions between 
Available Worksheets and Selected 
Worksheets.

Selected Worksheets Worksheet definitions that the planning 
engine completes if you select launch 
parameter Build Worksheets; you can export 
them when the planning engine finishes.
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Using an Existing Plan as a Demand Schedule For New Plan
The plan for one organization can be used as a demand (or demand schedule) for the 
plan of another organization. 

Note: Users can collect forecasts into the APS planning server. 
Optionally, they can choose to consume forecasts by sales orders when 
they run ASCP plans. Forecasts are consumed if the Include Sales 
Order check box in the Organizations tab of the Plan Options window 
is checked. For multilevel assemble-to-order items, forecasts are 
consumed at all levels if the forecast explosion has occurred in the 
source instance prior to the collection.

To use an existing plan as a demand schedule for new plan
1. Choose Supply Chain Plan > Names to create a new plan for the organization that 

will use an existing plan as a source. 

The Supply Chain Plan Names window appears.

2. Select Plan Options.

The Plan Options window appears.

3. Choose the Organizations tab. 

4. Specify the plan name to be used as a source for the new plan in the Demand 
Schedule portion of the window.

5. Click Subinventory Netting. 

The Subinventory Netting window appears. 

This table describes the fields and options.

Object Description

Name Shows all active subinventories for your 
organization.

Description Subinventory description. 

Net Select to net the subinventory in the 
planning run. 
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Up-Sell Cross-Sell Substitution Item Relationships
Oracle Advanced Supply Chain Planning collects the following information on a 
demand that represents a sales order line:

• Original ordered item: The item that the customer asked for

• Ordered item: The item that the customer ordered (the booked item)

The relationship between the ordered item and original ordered item is classified as:

• Up-sell: The process of offering customers products superior in capability to the 
ones that they intend to buy

• Cross-sell: The process of offering customers related products or accessories in 
addition to the ones that they intend to buy

• Substitution: The process of offering customers similar products to the ones that 
they intend to buy. This is usually when the requested product is not available to 
ship.

During forecast consumption, Oracle Advanced Supply Chain Planning checks to see if 
the booked item in the sales order is one that has been offered to the customer as a 
substitute to what the customer originally requested. If so, Oracle Advanced Supply 
Chain Planning consumes the forecast of the original item. If the booked item in the 
sales order is an up-sell or a cross-sell item, Oracle Advanced Supply Chain Planning 
consumes the forecast of the booked item.

This feature helps you in offering equivalent substitute products when requested 
product is in short supply. It also makes the forecast consumption process sensitive to 
the relationship type between the original and the ordered items as recorded on the 
sales order. This provides you with accurate records of order booking history, which 
improves forecast accuracy.

The following table shows the relationship type on the sales order line. The planning 
engine considers this for identifying the forecast against which this sales order line 
should be consumed.

Relationship type on the 
sales order

Forecast consumption 
performed on forecast of 
ordered item?

Forecast consumption 
performed on forecast of 
original ordered item?

Up-Sell Yes No

Cross-Sell Yes No

Substitution No Yes
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To setup up-sell cross-sell substitution item relationships
1. Select the Manufacturing and Distribution Manager responsibility.

2. Navigate to Order Management > Orders, Returns > Sales Orders.

3. Highlight any sales order line, and select Related Items to see all the potential 
up-sell, cross-sell, and substitution possibilities. You can select one of the displayed 
options.

4. Once you select a related item, Oracle Order Management copies the item that the 
customer had originally requested for, into the original item column on the sales 
order line.

To use up-sell cross-sell substitution item relationships
1. Enter related items in the sales order lines.

2. Collect data into the planning instance.

3. Change to the Demand Planner responsibility.

4. Select the data stream inputs for demand planning.

For more details, see Creating Data Streams for Demand Plans, page 5-60.

5. Create a demand plan.

For more details, see Oracle Demand Planning Implementation and User's Guide.

Oracle Demand Planning has options of recording history against either the original
item or the ordered item through the choice of input data stream. This will 
influence the forecasting process for these items.

6. Change to the Advanced Supply Chain Planner responsibility.

7. Navigate to Plan Options > Organization tab.

8. In the Global Demand Schedules region or the Organization specific Demand 
Scheduled Region, select the demand planning scenarios that drive the plan.

9. Run the plan.

10. Navigate to the Supply/Demand window to view the information on the original 
item and the ordered item.

7

11. The forecast consumption process of Oracle Advanced Supply Chain Planning is 
sensitive to the presence of orders that have undergone item substitution.
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12. Right-click on a sales order line and select Consumption Details.

Both the Original Item and the End Item are displayed in the Consumption Details 
window.

You can also view the forecast consumption details in the Horizontal Plan window if 
the forecast is a global forecast.

Creating Data Streams for Demand Plans
When creating demand plans, you can specify any one of the following data streams:

• Booking History

• Booking History - Booked Items

• Shipment History

• Shipment History - Shipped Items

The following table shows whether the planning engine records the history on the 
original item or the ordered item based on the relationship on the sales order.

Input data stream Relationship type 
on the sales order

History recorded on 
ordered item?

History recorded on 
original item?

Booking History or 
Shipment History

Up-Sell Yes No

Cross-Sell Yes No

Substitution No Yes

Booking History - 
Booked Item or 
Shipment History - 
Shipped Item

Up-Sell Yes No

Cross-Sell Yes No

Substitution Yes No

If the relationship type on the sales order is other than up-sell, cross-sell, or, 
substitution, the planning engine records the history against the ordered item in all the 
four input data streams.

If the relationship type is blank and the original item is specified, these are orders that 
have undergone item substitution in the planning process. The planning engine treats 
such orders as the substitution relationship type.



Defining Supply Chain Plans    5-61

Note: In case of model items, the Calculate Planning Percentages 
feature works only with two input data streams: Booking History - 
Booked Items and Shipment History - Shipped Items. Using this feature
in conjunction with the other two data streams may produce 
inconsistent results.

Overwrite Options
When you launch the planning process, you generate new planned orders and 
suggested repetitive schedules to meet your net requirements. Since you can firm a 
MPP, MPS, or MRP planned order, you may not want the planning process to overwrite
any firm planned orders. You can use the Overwrite and Append plan level options to 
limit how the planning process reacts to firm planned orders and to stabilize the short 
term material plan.

Overwrite
When you enter All in the Overwrite field in the Main tab of the Plan Options form, the 
planning process overwrites all entries, planned and firm planned, from the current 
material plan. When you enter None in the Overwrite field, the planning process does 
not overwrite any firm planned orders. It does, however, overwrite any suggested 
planned orders that are not firm. When you enter Outside planning time fence in the 
Overwrite field, the planning process overwrites all entries from the current plan, 
planned and firm planned, outside the planning time fence, and overwrites only 
planned orders inside the planning time fence. It does not overwrite any firm planned 
orders within the planning time fence. The planning time fence can be different for each
item, so the planning process looks at the planning time fence for each item when 
choosing what to delete.

Append Planned Orders
When you uncheck the Append Planned Orders field in the Main tab of the Plan 
Options window, the planning process does not append any planned orders to the 
current plan. Additional demand does not cause planned order recommendations. 
Instead, the projected quantity on hand may go negative in response to demand that 
was not met by a suggested planned order.

When you check the Append Planned Orders field, the planning process appends 
additional planned orders after the last entry on the current material plan to meet any 
additional demand. The overwrite and append options work in combinations, as 
described below.

Overwrite All, Append Planned Orders
This option allows you to create a new material requirements plan for the plan name 
you specify, deleting all previous planned and firm planned entries while regenerating 
new planned orders. You can use this combination the first time you run your plan or if 
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you want your plan to reflect all sources of new demand. For example, if an existing 
material plan has the following orders for an item:

Schedule Date Quantity Order Status

01-FEB 100 Planned

08-FEB 200 MRP firm planned

15-FEB 300 Planned

And the following MDS is used to plan the material plan using All in the Overwrite 
field and Yes in the Append Planned Orders field:

Schedule Date Quantity

02-FEB 110

09-FEB 220

16-FEB 330

Then the resulting material plan would have the following suggestions for planned 
orders:

Schedule Date Quantity Order Status

02-FEB 110 Planned

09-FEB 220 Planned

16-FEB 330 Planned

The planning process always suggests planned orders. You can change planned orders 
to a firm status using the Items window in the Planner Workbench.

Overwrite Outside Planning Time Fence, Append Planned Orders
This option allows you to create an extension to the material requirements plan for the 
plan name you specify, deleting planned and firm planned orders outside the planning 
time fence and deleting all planned entries inside the planning time fence for each item. 
The planning process creates (appends) new planned orders after the planning time 
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fence date. In this case, since you are overwriting after the planning time fence, you are 
also appending new planned orders after that date. You can use this combination to 
stabilize the short-term plan and allow the long-term plan to react to new sources of 
demand. 

Note: If an item has no time fence specified and this option is chosen, 
all planned and firm planned orders are overwritten.

For example, if an existing MRP has the following orders for an item:

Schedule Date Quantity Order Status

01-FEB 100 Planned

08-FEB 200 MRP firm planned

15-FEB 300 Planned

And the following MDS is used to plan the MRP using Outside Planning Time Fence in 
the Overwrite field and Yes in the Append Planned Orders field

:

Schedule Date Quantity

02-FEB 110

09-FEB 220

16-FEB 330

Then the resulting material plan would have the following suggestions for planned 
orders, assuming the planning time fence is 05-FEB.

Schedule Date Quantity Order Status

05-FEB 110 Planned

09-FEB 220 Planned

16-FEB 330 Planned
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Since the entry on 01-FEB is not firmed, the MRP planning process overwrites this 
entry. If it was firmed, the process would not overwrite the entry. The additional 
demand from the MDS of 110 on 02-FEB was appended on the planning time fence date
of 05-FEB. The MRP firm planned order on 08-FEB was deleted because it falls outside 
the planning time fence of 05-FEB. The planning process always suggests planned 
orders. You can change planned orders to a MRP firm status using the Items window in
the Planner Workbench.

Overwrite None, Append Planned Orders
When you choose not to overwrite an existing plan, the planning process does not 
overwrite existing firm planned orders, but deletes any suggested planned orders. The 
planning process then creates (appends) new planned orders after the planning time 
fence date. This is analogous to firming sections of your short-term material 
requirements plan. You can extend the plan horizon without altering existing firm 
planned orders. For example, if an existing MRP has the following suggested planned 
orders for an item:

Schedule Date Quantity Order Status

01-FEB 100 Planned

08-FEB 200 MRP firm planned

15-FEB 300 Planned

And the following MDS is used to plan the MRP using None in the Overwrite field and 
Yes in the Append Planned Orders field:

Schedule Date Quantity

02-FEB 110

09-FEB 220

16-FEB 330

The resulting material plan would have the following suggestions for planned orders 
assuming the planning time fence is 05-FEB:
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Schedule Date Quantity Order Status

05-FEB 110 Planned

08-FEB 200 MRP firm planned

09-FEB 20 Planned

16-FEB 330 Planned

The firm order on 08-FEB remains on the MRP since the overwrite is None. However, 
the planned entries are deleted. Although additional demand exists on the MDS, no 
planned orders are suggested until the planning time fence (on 05-FEB). The MDS 
demand of 110 on 02-FEB was satisfied by a new planned order for 110 on 05-FEB. The 
demand for 220 on 09-FEB was partially met by the firm MRP planned order on 08-FEB.
Thus an additional planned order was suggested on 09-FEB for 20 to meet the MDS 
demand of 220. A suggested planned order was created on 16-FEB for 330 to meet the 
demand from the MDS on 16-FEB.

Overwrite None, Do Not Append Planned Orders
In this case, the planning process does not overwrite existing firm planned entries, but 
deletes any suggested planned orders. In addition, it does not append additional 
demand to the end of the plan. Instead, it reports the instances where the material 
requirements plan is out of balance with the master demand schedule, and allows you 
to solve these problems by manipulating the plan manually. This gives maximum 
control to the material planner. For example, if an existing material plan has the 
following orders:

Schedule Date Quantity Order Status

01-FEB 100 Planned

08-FEB 200 MRP firm planned

15-FEB 300 Planned

And the following MDS is used to plan the MRP using None in the Overwrite field and 
No in the Append Planned Orders field:
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Schedule Date Quantity

02-FEB 110

09-FEB 220

16-FEB 330

The resulting MRP would have the following suggestions for planned orders:

Schedule Date Quantity Order Status

08-FEB 200 MRP firm planned

The reason the additional demand from 02-FEB, 09-FEB, and 16-FEB was not planned 
for is because with the Overwrite None and Do Not Append Planned Orders, you 
choose not to overwrite firm planned orders nor create new planned orders to meet 
additional demand. In this case, the projected quantity on hand would go negative since
no planned orders were suggested to meet the additional demand. The material planner
can use online inquiries and reports with exception messages to identify material 
shortages.

Demand Priority Rules
In ASCP, planning decision-making occurs sequentially in the following phases:

• Selection of alternates (routings, substitute components, internal source 
organizations, suppliers).

Note: Intelligent selection of alternates occurs in constrained plans 
with decision rules enabled or in optimized plans only. 
Constrained without decision rules enabled and unconstrained 
plans choose only the primary alternative (for example, the 
primary routing) and always respect the sourcing rank and 
percentages specified in sourcing rules.

• Pegging of supplies (on-hands, scheduled receipts, and planned order supplies) to 
demands

• Detailed scheduling of individual operation steps on resources
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Note: This phase is enabled only if the Constrained Plan checkbox 
in the Constraints tab of the Plan Options form is checked

In the detailed scheduling phase, demand quantities that are pegged to planned order 
supplies are considered in internal priority order. Demands with higher internal 
priority get the first opportunities to take up available resource and material capacities; 
demands with lower internal priorities can only use remaining resource and material 
capacities and are therefore more likely to be satisfied late.

Oracle does not recommend driving a plan using both a master demand schedule and 
forecasts and sales orders directly. In such plans, the planning engine does not maintain
demand priorities across these entities.

The internal priorities described above are different than the external priorities that can 
be attached to sales orders and master demand schedule entries. Internal priorities are 
generated for a plan on the basis of a priority rule that you attach to the plan in the 
Main tab of the Plan Options form.

To define a priority rule
1. Sign on using the Advanced Supply Chain Planner responsibility.

2. From the Navigator, select Setup > Priority Rules. 

The Define Priority Rules window appears.

Use the information in the following table to fill in the fields in this form.

Field Description

Name Enter a name for your priority rule. You will
refer to this name when defining plan 
options for a supply chain plan.

Description Enter a description for your priority rule. 
The description is for your personal 
reference only, and is not used elsewhere in 
ASCP.

Enabled Check this box to allow this priority rule to 
be attached to an ASCP plan.

Default Check this box to make this priority rule the
default priority rule on the ASCP planning 
server.
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Field Description

Criteria Name Valid values are: Gross Margin, Promise 
Date, Request Date, Sales Orders and MDS 
Entries Priority, and Schedule Date. Select 
the criteria that you wish to evaluate each 
demand by when ASCP generates the 
internal priority for the demand. For 
example, if you select Sales Orders and 
MDS Entries Priority, then the demand 
entry that has the most urgent external 
priority (as specified on the sales order line 
or on the MDS entry) will receive an 
internal priority of 1, the demand with the 
next most urgent external priority will 
receive an internal priority of 2, and so 
forth. If you choose multiple criteria, each 
criterion will be used to break ties in the 
criteria that preceded it. In the screenshot 
example, if two sales order demands both 
have a priority of 1, the most urgent internal
priority will be assigned to the sales order 
with the earliest Schedule Date (due date). If
multiple demands tie on all criteria 
specified in the priority rule, then the tie is 
broken arbitrarily and the demands are 
assigned consecutive internal priority 
values.

Criteria Order This field is populated automatically. It 
numbers the criteria that you choose above 
sequentially, starting with 1, 2, ...

To attach a priority rule to a supply chain plan
Enter the priority rule name in the Demand Priority Rule field in the Main tab of the 
Plan Options form. Please see the section The Main Tabbed Region, page 5-38 for 
further details.

By using the priority rule shown in the screenshot above, you ensure that the demands 
with the most urgent external priority will have the best chance of being satisfied on 
time, since they will have the first opportunity to utilize available resource and material
capacities.

The planning engine uses this hierarchy to determine the priority rule:

• Plan priority rule: Plan options form > Main tabbed region
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• Default priority rule: Priority rules form

• Schedule Date: Prioritizes the demands in due date order

Peg Supplies by Demand Priority
The planning engine allocates firm and nonfirm supplies to demands during the 
pegging process.

The planning engine pegs in different ways depending on settings that you choose, see 
the Pegging Overview section in 'Supply/Demand Window, page 18-64.

Plan to Request, Promise, or Schedule Dates
Oracle Advanced Supply Chain Planning allows you to plan supplies or consume 
forecasts based on the sales order line request dates, promise dates, or schedule dates. 
This helps you to honor as well as improve your delivery commitments.

Depending on the condition that your organization needs to meet, you can plan based 
on one of the following dates:

• Plan to request date - If you want to meet a more aggressive set of dates compared 
to the ones initially scheduled by Oracle Global Order Promising. You can use this 
option when you have many alternate bills of materials (BOMs) / routings or 
alternate facilities. Since, Oracle Global Order Promising does not take into account 
these alternates, it often provides conservative schedule dates in these situations. In 
this scenario, you can use Oracle Advanced Supply Chain Planning's constrained, 
decision rule-based, or cost-optimized plans to arrive at better schedule dates. 

• Plan to promise date - If you want to meet dates communicated to customers and 
ignore any schedule date overrides. By comparing the resulting demand satisfied 
dates with the demand schedule dates, you can validate manual schedule date 
overrides made since the previous customer communication.

• Plan to schedule date - If you want to meet demand dates as suggested by Oracle 
Global Order Promising and adhere to manually overridden dates.

To Set the Plan Option to Request, Promise, or Schedule dates
1. From the Navigator, choose Supply Chain Plans > Plan Options.

The Plan Options window appears. The Main tab is displayed by default.

2. In the Schedule By box, select the type of sales order line date that you want to 
consider for your planning:

• Schedule Ship Date (default)
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• Schedule Arrival Date

• Request Ship Date

• Request Arrival Date

• Promise Ship Date

• Promise Arrival Date

For more details on the Plan Options window, see Setting Plan Options.

Note: If no priority rule is specified in the Define Priority Rules form, 
then the planning engine considers a demand priority rule based on the
option specified (or defaulted) in the Schedule By box of the Plan 
Options window.

Calculation of Ship and Arrival Dates
You can consider either the arrival or the ship date of the demand to be the due date. 
The planning engine calculates the ship and arrival dates as following:

For Schedule Dates
The planning engine calculates the schedule ship date or arrival date based on the date 
specified on the sales order line. If the schedule arrival date is specified on the sales 
order line, then the planning engine calculates the schedule ship date by offsetting the 
schedule arrival date by the intransit time.

For example:

If the Schedule Arrival Date is specified as Day 11 and the intransit time is 2 days, then 
the planning engine calculates the Schedule Ship Date as Day 9.

For Request or Promise Dates
The planning engine calculates the corresponding ship dates or the arrival dates for the 
order request dates or the order promise dates with respect to the customer level 
attribute Request Date Type specified in Customers > Order Management tab.

If the Request Date Type is:

• Arrival - The ship dates are calculated by offsetting the arrival dates by the intransit
time

For example:

If the Request Arrival Date is Day 12 and the intransit time is 2 days, then the 
planning engine calculates the Request Ship date as Day 10.

• Ship - The arrival dates are calculated by adding the intransit time to the ship dates

For example:
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If the Request Ship Date is Day 12 and the intransit time is 2 days, the planning 
engine calculates the Request Arrival Date as Day 14.

Note: The planing engine also takes into account the shipping, 
receiving and, carrier calendar for calculating the ship and arrival 
dates. For more details on calendars, see Setting Shipping, Receiving, 
Carrier, and Supplier Capacity Calendars

Exporting Plan Results
You can export the supply, demand, and item information that you want, and in the 
format you want, from a supply chain plan to Microsoft Excel. The planning engine:

• Collects the data that you want during the planning run

• Saves it as a worksheet with the other plan information for you to export

To accomplish the export, do this:

• Define worksheets, Plan Worksheets window

• Tell the planning process which worksheets to complete for this plan: Plan Options 
window > tab Reporting

• Tell the planning process to complete the worksheets for this plan that you select: 
Concurrent Processes > Launch Supply Chain Planning Process Request Set

• Export the completed worksheets: Planner Workbench, (M) Tools > Export Plan 
Worksheets to Excel

Plan Worksheets Window

Use this window to define worksheets to export to Microsoft Excel.

In the header, name and describe your worksheet, and select if it is public or private.

Plan Worksheets Window – Filters Tab

Select the information that you want to see in each column. Criteria is the field name 
from the supply chain plan.

Enable the criteria for the plan to use.

The planning engine selects data for the worksheet.

Plan Worksheets Window – Results Layout Tab

Lay out the Excel spreadsheet.

Select a value for Entity and you can see its attributes in Available Attributes. The 
entities are:
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• Item

• Order

• End Item

• End Demand

There are some derived attributes in entity Order, see Derived Attributes

Move the attributes that you want to see on the spreadsheet from Available Attributes 
to Selected Attributes

Derived Attributes

Find these attributes in entity Order.

Where Used Category 1, Where Used Category 2, and Where Used Category 3: The item
category of up to three next level where-used items.

Inter-Org: This reduces duplicate information in the spreadsheet about transfers. If you 
select organizations with destination (transfer supplies) / source (transfer dependent 
demands) pairs, the spreadsheet shows information for the transfer supplies only.

Plan Worksheets Window – Other Tab, Item Category Sets

Select up to three item category sets. If you do, the spreadsheet shows the order 
quantities of each item for all valid combinations of the item categories. 

These are example bills of materials.

These are example category sets.

This is how the example spreadsheet looks if you select:
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• Item Category Set 1: Category Set A 

• Item Category Set 2: Category Set B

• Item Category Set 3: <blank>

Plan Worksheets Window – Other Tab, Where Used Item Category Sets

Select up to three where used item category sets. If you do, the spreadsheet shows the 
order quantities of each item for all valid combinations of the where-used item 
categories. 

These are example category sets.

Tablets transfer to distribution center FIN1.

Gelcaps transfer to distribution center FIN2.

This is how the example spreadsheet looks if you select:

• Where Used Item Category Set 1: Package Type 

• Where Used Item Category Set 2: Country

• Where Used Item Category Set 3: <blank>
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Forecasts

Forecasts Overview
Use forecasts to estimate future demand for items using historical, statistical, and 
intuitive techniques.

Including Past Due Forecasts in a Plan

• Clear plan option Demand Time Fence Control.

• Set the value of profile option MSC: Consume Forecast Inside Demand Time Fence 
to Yes.

• Navigate Setup > Parameters and set the number of days of past due forecast to 
include in the plan.

Multi-organization Forecasts
The types of multi-organization forecasts are:

• Local: Forecasts with a ship from organization associated to them. You create and 
manage them in an organization in the source instance and that organization is their
ship from organization or in Oracle Demand Planning where you specify an 
organization. 

• Global: Forecasts with no pre-specified ship from organization associated to them. 
You create and manage them in Oracle Demand Planning or in Oracle Demantra. 
See Global Forecasting, page 5-107.

Forecast Consumption

Overview of Forecast Consumption
Forecast consumption replaces forecasted demand with actual sales order demand. 
Each time you create a sales order line, you create actual demand. If the actual demand 
is already forecasted, the forecast demand must be decremented by the sales order 
quantity to avoid counting the same demand twice. 

For example, this table shows the forecast and sales orders for item 1.

Order Type Quantity Date

Forecast 50 June 1
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Order Type Quantity Date

SO1 (sales order 1) 10 June 1

SO2 25 June 1

This table shows the forecast and sales orders for item 1 after forecast consumption.

Order Type Quantity Date

Forecast 15 (50 - (10 + 25)) June 1

SO1 10 June 1

SO 2 25 June 1

Forecast consumption relieves forecast items based on the sales order line schedule 
date. When an exact date match is found, consumption decrements the forecast entry by
the sales order quantity. Other factors that may affect the forecast consumption process 
are backward and forward consumption days and forecast bucket type. 

When you create a new forecast, especially from an external source, you can also apply 
consumption that has already occurred for other forecasts to the new one.

Forecast Control
You control forecast consumption against each component by setting its organization 
item attribute Forecast control:

• Consume: Sales orders for this item consume forecasts for this item in the same 
organization.

• Consume and derive: Sales orders for this item consume forecasts for this item in 
the same organization. Select this option if you will also do forecast explosion 
against the item; see Forecast Explosion, page 5-103.

• None: Sales orders for this item do not consume forecasts for this item.

Consumption within a Forecast Set 
Consumption for an item and its corresponding sales order demand only occurs once 
within a forecast set. For example:
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Forecast Set #1 contains Forecast #1 and Forecast #2. The same item, Item A, belongs to 
both forecasts within the set. Some possible scenarios and how consumption would 
work are: 

• If the sales order quantity is less than the forecast quantity of each forecast, only one
of the forecasts for Item A is consumed. 

• If one of the two forecasts for Item A were on the same day as the sales order line 
schedule date, that forecast would be consumed first. 

• If the forecast for Item A is for the same day in both forecasts, the forecasts are 
consumed in alphanumeric order by forecast name. 

For example, if each forecast for Item A is for a quantity of 100 and you place sales 
order demand for 20, the consumption process would decrement only Forecast #1 to 80. 
However, if the sales order quantity is for 120, Forecast #1 is decremented from 

100 to zero and Forecast #2 is decremented from 100 to 80. 

Consumption for a Product Family 
Forecasts can be created and maintained at the product family level, and exploded 
down to the members of the family based on the planning percentages and effectivity 
dates in the bill of materials. Forecast consumption depends on the Forecast Control 
item attribute: if Forecast Control for the product family item is set to Consume and at all
levels below that to Consume and Derive, a sales order added for member items 
consumes its own forecast and the forecast for the product family. For example: 
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Suppose that the planning percentages for the member items are: 

• 60% for B 

• 40% for C 

Also assume a product-family forecast for A of 100.

After forecast explosion, a sales order of 20 for item B consumes the forecast, leaving the
following forecast:

• 100 - 20 = 80 for A 

• 60 - 20 = 40 for B 

• 40 - 0 = 40 for C 

Similarly, if item B is a model and if Forecast Control for both D and E is set to Consume 
and Derive, then the forecast for item D gets consumed by 20 and the forecast for item E 
gets consumed by 20. The forecasts for items F and G remain the same. 

Consumption Across Forecast Sets 
Consumption can occur multiple times if an item appears in more than one forecast set. 
For example: 



5-78    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Forecast Set #1 contains Forecast #1 and Forecast Set #2 contains Forecast #2. The same 
item, Item A, belongs to both forecasts within each set. 

When you create a sales order, both forecasts for Item A in Forecast Set #1 and Forecast 
Set #2 are consumed. This is because consumption occurs against each forecast set, and 
Item A exists in both forecast sets. 

For example, if each forecast for Item A is quantity 100 and you place sales order 
demand for 20, the consumption process would decrement each forecast in each set 
from 100 to 80. 

Note: In this example, Forecast Set #1 and Forecast Set #2 are most 
likely alternative scenarios two different sets for comparison purposes, 
so that consumption occurs for the same item in both sets. If you want 
to consume an item only once, define all forecasts for an item within a 
single set.

Consumption Level
You can specify consumption levels in the forecast set:

• Item level: Consumption occurs when item numbers match between the forecast 
entry and the sales order line.

• Customer Level: Consumption occurs when item numbers and customer numbers 
match between the forecast entry and the sales order line.

• Ship-to level: Consumption occurs when item numbers, customer numbers, and 
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customer ship-to addresses match between the forecast entry and the sales order 
line

• Bill-to level: Consumption occurs when item numbers, customer numbers, and 
customer bill-to addresses match between the forecast entry and the sales order line

Backward and Forward Consumption Days 
Use consumption days if:

• You do not always have an exact match between the sales order line schedule dates 
and forecast entry dates.

• Your forecast entry quantity is not always sufficient to cover the sales order 
quantities.

Forecast consumption works as follows:

• It searches backward from the sales order line schedule date, workday by workday, 
for forecast quantities to consume.

• If that search is not successful in consuming the entire sales order line quantity, it 
searches forward from the sales order line schedule date, workday by workday, for 
forecast quantities to consume.

• If that search is not successful in consuming the entire sales order line quantity, it 
creates an overconsumption (negative demand) entry on the sales order line 
schedule date.

Consumption and Demand Classes 
You can assign a demand class to a forecast. When you create a sales order with a 
demand class, consumption searches for forecasts that have the same demand class. 
Consumption attempts to consume these forecasts first. If it does not find matching 
entries, it tries to consume forecasts that do not have a demand class. 

For sales orders without an associated demand class, consumption attempts to consume
forecasts that match the default demand class for the organization first, and then 
consumes forecast entries that have no demand class defined.

Overconsumption
When consumption cannot find an appropriate forecast entry to consume, it creates, for 
information purposes only, a new forecast entry at the forecast set level. This entry has 
a zero original quantity and a negative current quantity equal to the unconsumed 
demand. 

The entry is marked with an origination of overconsumption.
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Outlier Update Percent
This controls the effects of abnormal demand with a maximum percent of the original 
quantity forecast that a single sales order can consume. 

Example 

You have several customers. Each typically orders 100 units in a given period. One of 
the customers is having a special promotion that could increase demand significantly. 
Use the outlier update percentage to ensure that these "one time" sales orders do not 
overconsume the forecast.

In the above example, daily forecast exists for 20 on the 2nd and the 9th with an outlier 
update percent of 50 on each forecast. When you place sales order demand for 50 on the
9th, the forecast consumption process attempts to consume on the sales order line 
schedule date only, since the forecast is stated in daily buckets and no backward 
consumption days exist. Because an outlier update percent of 50 exists on the forecast, 
the consumption process consumes only 50% of the forecast. The outlier update percent 
applies to how much of the original forecast quantity, not the sales order, the 
consumption process can consume. In this example, the consumption process consumes
50% of the forecast (10) and the rest of the sales order quantity (40) is overconsumed. If 
there were a backward consumption days of 5, 50% of the forecast on the 2nd would 
also be consumed, and the overconsumed quantity would be 30. 

Using the same example, if another sales order for 50 is placed on the 9th, it consumes 
50% of the original forecast quantity (10) and the current forecast quantity on the 9th 
becomes zero. Overconsumption is increased by an additional 40 to a new total on the 
9th (80). 
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Time Buckets in Forecast Consumption

Consumption with Daily Buckets

The process tries to consume a forecast entry on the 12th (the sales order date) because 
the forecast is stated in daily buckets and no backward consumption days exist. Since 
there are no forecasts on the 12th, an overconsumption entry is created on the 12th and 
the forecasts remain the same.

Here, the process tries to consume a forecast entry between the 12th (the sales order 
date) and the 9th (backward 3 days). The forecast entry of 20 each on the 9th is 
consumed. The remaining sales order quantity of 5 creates an overconsumption entry.
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In this example, the process tries to consume a forecast entry between the 2nd (back 3 
days from the sales order date of the 5th) and the 10th (forward 3 workdays, skipping 
the weekend). Going backward, the forecast entry of 20 each on the 2nd is consumed. 
Going forward, the forecast entry of 20 on the 9th is reduced to 15 each. 

Consumption with Weekly Buckets 

In the above example, weekly forecasts exists for 20 on the 2nd and the 9th. When you 
place sales order demand for 25 on the 12th, the forecast consumption process attempts 
to consume in the week of the sales order only, since the forecast is stated in weekly 
buckets and no backward consumption days exist. Since there is a forecast in the week 
of the 12th, the entire forecast of 20 is consumed by the sales order for 

25 and the remainder of the sales order becomes an overconsumption of 5 on the sales 
order line schedule date.
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In the above example, weekly forecasts exists for 20 on the 2nd and the 9th. When you 
place sales order demand for 25 on the 12th, the forecast consumption process attempts 
to consume in the week of the sales order first and then backwards for the number of 
backward consumption days. 

In this example, the backward consumption days of 5 causes the consumption process 
to go into another weekly bucket where it also consumes anything from that week. 
Since there is a forecast in the week of the 12th, the sales order for 25 consumes the 
entire forecast of 20 and then consumes the remainder of the sales order quantity (5) 
from the forecast on the 2nd. 

Note: When you use weekly or periodic buckets and the consumption 
days carry the consumption process into a different week or period, the
consumption process consumes from anywhere in the week or period, 
regardless of whether the consumption days span the entire week or 
period.

In this example, the process subtracts the backward consumption days from the 12th 
(excluding non-workdays) to day 5. Since day 5 is in the previous week, it consumes 
forecasts anywhere within the bucket; in this case, on the 2nd. 

The consumption process consumes any forecasts that are included in the time fence 
created by the backward or forward consumption days, and then any other forecasts 
that are in the week or period. However, it does not consume a daily forecast that exists 
in the week or period if it is not covered by the time fence. In the above example, a daily
forecast for the same item on the 4th would not have been consumed by the sales order; 
however, a daily forecast on the 5th would have since it is in the period included in the 
backward consumption days. 
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Consumption with Periodic Buckets 

In the above example, a periodic forecast exists for 20 on the 2nd, the first day of the 
period. When you place sales order demand for 25 on the 12th (assuming it is in the 
same period), the forecast consumption process attempts to consume in the period of 
the sales order only, since the forecast is stated in periodic buckets and no backward 
consumption days exist. Since there is a forecast in the period starting on the 2nd, the 
entire forecast of 20 is consumed by the sales order for 25 and the remainder of the sales
order becomes an overconsumption of 5. 

In the above example, a periodic forecast exists for 20 on the 2nd, the first day of the 
period. When you place sales order demand for 25 on the 12th (assuming it is in the 
same period), the forecast consumption process attempts to consume in the period of 
the sales order line schedule date first and then backwards for the number of backward 
consumption days. 

In this example, the backward consumption days does not cause the consumption 
process to go into another periodic bucket. It behaves the same as if there were no 
backward consumption days. Since there is a forecast in the period of the 2nd, the sales 
order for 25 consumes, and the remainder of the sales order becomes an 
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overconsumption of 5 on the 12th. However, if the backward consumption days are 
large enough to carry forecast consumption into the previous period, forecast 
consumption can consume any forecasts in that period also. 

Note: When you have a mix of daily, weekly, and periodic forecast 
entries, forecast consumption first consumes the daily entries, then the 
weekly entries, and lastly the periodic forecast entries that are included 
in the time fence created by the backward and/or forward consumption
days. 

Multi-organization Forecast Consumption

Consumption Options
Consume forecasts either:

• In the source instance (local only): Use this option if you want to view the forecast 
consumption results in the source instance independent of their use in a plan run.

You consume the forecasts during the MDS Load concurrent process. To use the 
consumed forecasts in an Oracle Advanced Planning and Scheduling plan, collect 
them.

• During the Oracle Advanced Supply Chain Planning plan run (local and global): 
Use this option if you want to view the forecast consumption results in the 
destination instance as an output of the planning run.

Collect unconsumed forecasts and use them to drive a plan.

In both cases, the method of forecast consumption is the same.

The planning engine can perform inline forecast consumption for source instance 
forecasts, Oracle Demand Planning forecasts and Oracle Demantra forecasts in the same
plan run.

If you drive a supply chain plan by an Oracle Demand Planning or Oracle Demantra, or
a source instance forecast instead of a source instance master demand schedule, the 
planning process consumes the forecast. 

Among the forecast modification methods, the planning engine performs them in this 
order:

• Forecast spreading

• Demand time fence control if profile option MSC: Consume Forecast Inside 
Demand Time Fence is No. The planning engine neither considers forecast entries 
within the demand time fence as demand nor uses them for forecast consumption

• Forecast consumption
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• Demand time fence control if profile option MSC: Consume Forecast Inside 
Demand Time Fence is Yes. The planning engine does not consider forecast entries 
within the demand time fence as demand but it uses them for forecast consumption

• Forecast bucket consumption

Forecast Consumption Features
Since you cannot specify these features in Oracle Demand Planning, you cannot use 
them if you collect forecast sets and forecasts from Oracle Demand Planning to the 
destination instance. However, you can use a variation of forecast consumption days.

To use these features with forecast sets and forecasts from Oracle Demand Planning:

• Specify these features in the source instance forecast sets and forecasts

• Publish the Oracle Demand Planning scenario to the source as a forecast set/forecast

• Collect the source instance forecast sets and forecasts to the destination instance and
run the plan

Forward Consumption Days
If all the forecast sets that you want to use in an Oracle Advanced Supply Chain 
Planning plan run have the same backward and forward consumption days, you can 
collect forecast sets and forecasts from Oracle Demand Planning to the destination 
instance and apply this feature when you run the Oracle Advanced Supply Chain 
Planning plan.

If the forecast sets that you want to use in an Oracle Advanced Supply Chain Planning 
plan run need different backward and forward consumption days, set them in the 
source instance forecast sets.

Demand Class
You can specify demand class in the forecast entry; if there is no forecast entry demand 
class the forecast consumption process uses the forecast entry's organization demand 
class.

You can specify demand class in the sales order line; if there is no sales order line 
demand class the forecast consumption process uses the sales order line's organization 
warehouse demand class.

If you consume by demand class and have forecasts without demand classes, set profile 
option MSC: Consume forecast with No demand class.

Collection Processing
Since the sales orders that you collect affect the results of inline forecast consumption, 
consider the sales orders that you collect.

To collect past due sales order demand, set the profile option MSC: Sales Orders Offset 
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Days. It specifies the number of days before the day that you run the collection engine 
that it is to collect shipped sales order lines. For example, if you set this option to 5 and 
collect today, the collection engine collects shipped sales order lines starting from 5 
days before today. The default for this option is 99999.

The collection engine collects partially- or non-shipped sales orders regardless of this 
profile option.

Plan Options Setup
You control forecast consumption against each component by setting its organization 
item attribute Forecast control:

• Consume: Sales orders for this item consume forecasts for this item in the same 
organization.

• Consume and derive: Sales orders for this item consume forecasts for this item in 
the same organization. Select this option if you will also do forecast explosion 
against the item; see Forecast Explosion, page 5-103.

• None: Sales orders for this item do not consume forecasts for this item.

Set up the following in the Plan Options window:

• In the Demand Schedule region of the Organization tab, specify the appropriate 
forecast sets.

• In the Organizations region of the Organization tab, select Include Sales Order.

• If you are using forecasts collected directly from Oracle Demand Planning, specify 
Forecast Consumption Backward Days and Forecast Consumption Forward Days. 
The planning engine applies this window to all Oracle Demand Planning forecasts 
driving the plan

If you want to specify this window for each Oracle Demand Planning forecast set, 
use the process in Forecast Consumption Features, page 5-86.

The forecast consumption process occurs in the snapshot phase. When you launch a 
plan, select Launch Snapshot (the default).

Plan Processing
If an item does not have a demand time fence, the planning engine performs 
consumption across the planning horizon and uses the consumed forecast entries across
the planning horizon in the gross-to net-explosion.

If an item has a demand time fence, the planning engine checks the profile option MSC: 
Consume forecast within demand time fence and does the following depending on its 
value:

• If the value is No, the planning engine applies the demand time fence to the item, 
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drops forecast entries within the demand time fence, and performs consumption 
outside the demand time fence if the forward consumption days value represents 
more days than the demand time fence. It uses the consumed forecast entries 
outside the demand time fence in the gross-to net explosion.

• If the value is Yes, the planning engine performs consumption across the planning 
horizon and then applies the demand time fence to the item. It drops the forecast 
entries inside the demand time fence and uses the forecast entries outside the 
demand time fence in the gross-to net explosion.

Per the above process, the planning engine attends to the actual past-due forecast 
entries. However, to view their consumption, check the Day 0 forecast bucket.

The following diagram shows a consumption scenario for item A which has a demand 
time fence:

• There is a sales order line for 100 units due between the anchor date and the 
demand time fence date.

• There is a forecast entry for 40 units past due, two forecast entries for 60 units 
between the anchor date and the demand time fence date, and a forecast entry for 
100 outside the demand time fence. The forward consumption days represents 
more days than the demand time fence.
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Consumption scenario

The planning engine checks the profile option MSC: Consume forecast within demand 
time fence and does the following depending on its value:

• If the value is No, the planning engine drops the past due forecast and the two 
forecast entries between the anchor date and the demand time fence date and uses 
the sales order for 100 to consume the forecast entry for 100 which is outside the 
demand time fence.

It uses that consumed forecast entry in the gross-to-net explosion.

This diagram shows the results of the No profile option using the previous 
example:
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Profile option setting

• If the value is Yes, the planning engine uses the sales order for 100 to consume the 
forecast entry for 40 which is past due and to consume one forecast entry for 60 
between the anchor date and the demand time fence date.

It does not use the two consumed forecast entries in the gross-to-net explosion. The 
other forecast between the anchor date and the demand time fence date is not 
consumed and not used in the gross-to-net explosion. The forecast entry outside the
demand time fence is not consumed but used in the gross-to-net explosion.

This diagram shows the results of the Yes profile option using the previous 
example:
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Profile Option setting

Viewing Forecast Consumption 
View forecast consumption in the Planner Workbench.

To view consumption results
1. Navigate to the Planner Workbench.

2. Select the plan name, organization, and item.

3. Right click on the item and select either Demand or Supply/Demand.

4. If you want to see which sales order lines consumed a forecast entry, select any 
entry with Forecast order type, right click the forecast name, and select 
Consumption Details.

5. If you want to see which forecast entries a sales order line consumed, select any 
entry with order type Sales Order, right click the sales order name, and select 
Consumption Details.

For example, to see the consumption details for the forecast from a previous 
example, select the forecast and right-click. Choose Consumption Details from the 
list that appears. This table illustrates the information that displays:
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Forecast Qty Forecast Date Consumed Qty Sales Order 
Date

Sales Order 
Number

50 June 1 10 June 1 SO1

50 June 1 25 June 1 SO2

To see how sales order 1 (SO1) from the previous example is consuming forecasts, 
select sales order 1 and right-click. Choose Consumption Details from the list that 
appears. This table illustrates the information that displays:

Forecast Qty Forecast Date Consumed Qty Sales Order 
Date

Sales Order 
Number

50 June 1 10 June 1 SO1

Setting Timestamps and Tolerance for Sales Orders and Forecasts Due Dates
Use the following profile options to instruct the planning engine how to use shipment 
date, timestamp, and forecast due date to plan supplies:

• You can set the profile option MSO: Use Default for Sales Orders to specify the 
timestamp for sales orders. For example, if you specify the value Beginning of Day, 
all sales orders have the timestamp 00:00. If you specify End of Day, the planning 
engine considers all sales orders due by 23:59. For more information about the 
profile option, see MSO Profile Options, page A-83.

• Set the profile option MSO: Default Timestamp Forecasts to specify the time when 
the planning engine should consider a forecast due. For more information about the
profile option, see MSO Profile Options, page A-83.

• You can set the profile option MSO: Late Demands Exceptions Tolerance Minutes to
specify the tolerance limit for late replenishments. The planning engine raises 
exceptions only after the tolerance limit is overstepped. For example, if you specify 
1440 minutes as the tolerance for a demand due at 12:00 on Tuesday, the planning 
engine does not raise an exception until 12:00 on Wednesday. For more information
about the profile option, see MSO Profile Options, page A-83.

This timestamp behavior is not applicable to Availability to Promise (ATP) or Global 
Order Processing (GOP). As unconstrained plans use the smallest planning bucket 
(daily bucket), this profile option does not affect the scheduling behavior for supplies 
that are scheduled at 00:00.
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Forecast Bucket Consumption
You can instruct the planning engine to consume forecasts with sales orders only within
the same time bucket (within the consumption bucket).

For each forecast, the consumption bucket is the same length as the forecast bucket. The 
consumption process consumes inside the consumption buckets going backward and 
then forward. It ends when either there are no more:

• Unconsumed forecasts in the consumption bucket

• Sales orders within the consumption bucket to consume forecasts

The consumption process does not search outside of the consumption bucket for 
forecasts and sales orders except in daily buckets. If you do not want the planning 
engine to use backward and forward consumption in daily buckets:

• For Oracle Demand Planning forecasts, navigate to the Plan Options form, Main 
tabbed region; set Backward Days and Forward Days to zero.

• For Oracle Advanced Supply Chain Planning and Oracle Demantra forecasts, 
navigate to the Forecasts form; set Backward Days and Forward Days to zero.

To use this feature, navigate to the Plan Options form, Main tabbed region; select 
Consume by Forecast Bucket. If you do not want to use this feature, select Consume 
Using Backward/Forward Days.

For example, you: 

• Enter forecast 1 with five forecast entries of quantity 100 to cover weeks 25 May - 31
May, 1 June - 7 June, 8 June - 14 June, 15 June - 21 June, and 22 June - 28 June

• Enter forecast 2 with one forecast entry for quantity 200 to cover week 25 May - 31 
May and one forecast for quantity 1500 to cover 1 June - 28 June. 

• Receive a sales order for quantity 150 due on 10 June.

• Select plan option Consume by Forecast Bucket.

This table shows the results of the forecast consumption against forecast 1. The sales 
order consumes only the forecast entry in week 8 June - 14 June and does not consume 
from any other weekly entries. Since the planning engine cannot consume the entire 
sales order quantity from forecast 1, it looks for other forecasts with entries that cover 
10 June.
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Data or 
Calculation

25 May - 31 
May

1 June - 7 
June

8 June - 14 
June

15 June - 21 
June

22 June - 28 
June

Forecast 1 
original 
quantity

100 100 100 100 100

Sales order 
quantity

0 0 150 0 0

Forecast 1 
consumed 
quantity

0 0 100 0 0

The planning engine finds forecast 2 with entries that cover 10 June. This table shows 
the results of the forecast consumption against forecast 2. The sales order consumes 
only the forecast entry in period 1 June - 28 June. If it could not consume the entire 
quantity fro the period, it would not consume from the forecast entry in week 25 May - 
31 May. 

Data or Calculation 25 May - 31 May 1 June - 28 June

Forecast 2 original quantity 200 1500

Sales order remaining 
quantity

0 50

Forecast 1 quantity 0 50

You can see the backward and forward consumption days that apply to a forecast in the
Planner Workbench, Demand window. See fields Consumption Backward Days and 
Consumption Forward Days.

Among the forecast modification methods, the planning engine performs them in this 
order:

• Forecast spreading

• Demand time fence control if profile option MSC: Consume Forecast Inside 
Demand Time Fence is No. The planning engine neither considers forecast entries 
within the demand time fence as demand nor uses them for forecast consumption

• Forecast consumption
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• Demand time fence control if profile option MSC: Consume Forecast Inside 
Demand Time Fence is Yes. The planning engine does not consider forecast entries 
within the demand time fence as demand but it uses them for forecast consumption

• Forecast bucket consumption

Forecast Spreading
If you develop and maintain your Oracle Demand Planning forecasts in aggregate 
(week, month, or quarter), you can:

• Use those forecasts in Oracle Advanced Supply Chain Planning

• struct the planning engine to spread this aggregate forecast demand evenly across 
the daily buckets. It spreads according to the calendar in plan option Forecast 
Spreading Calendar for an organization. If there is no value for the plan option, it 
spreads according to the calendar in profile option MSC: Forecast Spreading 
Calendar.MSC: Forecast Spreading Calendar.

Planning forecast demand in daily buckets may provide a more realistic estimate of the 
future supply but forecasting in aggregate may lead to more accurate forecasts.

Bucketing behaves as follows:

• If you select plan option Spread Forecasts Evenly , the planning engine first 
allocates forecasts from the forecasting buckets down to the planning buckets

• The consumption of these forecasts is dependent on the setting of flag Consume by 
Forecast Bucket 

• If you select Consume by Forecast Bucket, sales orders that fall within a forecast 
bucket can only consume the forecasts in that bucket. They cannot consume 
forecasts in the previous or the next forecast buckets

• If you clear Consume by Forecast Bucket, sales orders consume forecasts based on 
the setting of plan options Backward Days and Forward Days. Sales orders within a
forecast bucket can consume forecasts in the previous or the next forecast buckets

Among the forecast modification methods, the planning engine performs them in this 
order:

• Forecast spreading

• Demand time fence control if profile option MSC: Consume Forecast Inside 
Demand Time Fence is No. The planning engine neither considers forecast entries 
within the demand time fence as demand nor uses them for forecast consumption

• Forecast consumption
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• Demand time fence control if profile option MSC: Consume Forecast Inside 
Demand Time Fence is Yes. The planning engine does not consider forecast entries 
within the demand time fence as demand but it uses them for forecast consumption.

• Forecast bucketing consumption: Aggregates consumed forecasts and sales orders 
to planning buckets.

The forecast spreading process interacts with profile option MSC: Consume Forecast 
Inside Demand Time Fence as follows:

• If it is No, the planning engine neither considers forecast entries within the demand 
time fence as demand nor uses them for forecast consumption. It drops them as 
demand before forecast consumption

• If it is Yes, the planning engine does forecast consumption before it does demand 
time fence control. It does not consider forecast entries within the demand time 
fence as demand but it uses them for forecast consumption.

• For a periodic forecast entry that falls in weekly planning buckets within the 
demand time fence, the process spreads the entries into daily entries.

• If a daily entry is within the demand time fence, the process ignores the actual 
profile option value and proceeds as if the value is Yes.

• If the daily entry is outside the demand time fence, the process ignores the profile 
option and consumes against the entry

Forecast Spreading Setup
To use this feature, set the following information:

• Use only week or period forecast buckets in Oracle Demantra or Oracle Demand 
Planning.

• Set planning parameter Include Past Due Forecast. Enter the number of days of past
due forecasts to include in plans. No value indicates include all past due forecasts; 
zero indicates include no past due forecasts. This value does not apply to 
independent demands derived from assemble-to-order models. Use navigation 
Setup > Parameters.

• If you are publishing master demand schedules and sales orders from Oracle 
Demantra or Oracle Demand Planning, set Oracle Advanced Supply Chain 
Planning profile option Include MDS Days.

• Navigate to the Plan Options form, Main tabbed region; select Spread Forecast 
Evenly.

Oracle Inventory Optimization always spreads forecasts into planning buckets.
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Forecast Spreading Example
This diagram shows a forecast spreading example:

• You entered forecasts of quantity 100 for the weeks of 13 March, 20 March, 27 
March, 3 April, 10 April, and 17 April. Each week begins on Thursday.

• The planning buckets are five days, two weeks, and one period.

• The workdays are Monday through Friday and there is a holiday on Tuesday 1 
April.

• You set plan parameter Include Past Due Forecast to 0 and selected plan option 
Spread Forecast Evenly.

• The planning engine spreads each weekly forecast of quantity 100 for the weeks 
beginning 13 March and 20 March to five daily forecasts of quantity 20.

• The planning engine spreads the weekly forecast of quantity 100 for the week 
beginning 27 March to four daily forecasts of quantity 25.

• The planning engine does not spread forecasts that map to planning horizon 
periods.

• The planning engine plans to no forecast demand on planning daily buckets 10 
March, 11 March, and 12 March. It plans to forecast demand of 20 on daily buckets 
13 March and 14 March.

• The planning engine plans for forecast demand of 100 on planning weekly bucket 
17 March to 23 March (20 + 20 + 20 + 20 + 20).

• The planning engine plans for forecast demand of 110 on planning weekly bucket 
24 March to 30 March (20 + 20 + 20 + 25 + 25).

• The planning engine plans for forecast demand of 350 on planning monthly bucket 
31 March to 4 May (25 + 25 +100 + 100 + 100).
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Forecast Spreading Example

Forecast Spreading Considerations
If you set outlier percentage for a forecast set, the planning engine applies it to the 
forecasts after it spreads them.

If a forecast entry from Oracle Demand Planning falls on a non-workday in Oracle 
Advanced Supply Chain Planning, the planning engine places the forecast entry on the 
previous working day.

This table shows an example of workday forecast recalculation. . Oracle Advanced 
Supply Planning manufacturing calendar workdays are Monday to Friday, the 
planning horizon is ten workdays in daily buckets, and the plan run date is 10 June.

• The shipping calendar that Oracle Demand Planning uses has all working days.

• It has daily forecasts for seven days beginning on Monday 10 June.

• The manufacturing calendar that the production organization uses has 
non-workdays on Saturday and Sunday.
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• The forecast spreading process places the forecasts for Saturday and Sunday on 
Friday

Date Oracle Demand Planning 
Forecast Quantity

Oracle Advanced Supply 
Chain Planning Forecast 
Quantity

Monday 10 June 9 9

Tuesday 11 June 13 13

Wednesday 12 June 10 10

Thursday 13 June 7 7

Friday 14 June 10 30 (10 + 10 + 10)

Saturday 15 June 
(non-workday in 
manufacturing calendar)

10 -

Sunday 16 June 
(non-workday in 
manufacturing calendar)

10 -

For items under rounding control, the planning engine rounds a spread forecast 
quantity up and applies its cumulative remainder to the next bucket. It uses the 
item-organization item attribute. This table shows how the planning engine spreads a 
weekly forecast of quantity 36 for an item with item attribute Rounding Control 
selected.

This table shows an example of forecast spreading with rounding control:

• The planning engine rounds the Monday forecast of 7.2 up to 8.

• It calculates the Monday cumulative remainder as the difference between the two 
quantities which is - 0.8 (7.2 - 8).

• It applies the cumulative remainder of the Monday forecast to the Tuesday daily 
forecast quantity to adjust it to 6.4. (7.2 - 0.8).

• It rounds the Tuesday Forecast of 6.4 up to 7.
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Data or 
Calculation

Monday Tuesday Wednesday Thursday Friday

Daily 
forecast 
before 
rounding 

7.2 (36 / 5) 7.2 (36 / 5) 7.2 (36 / 5) 7.2 (36 / 5) 7.2 (36 / 5)

Daily 
forecast 
before 
rounding + 
Cumulative 
remainder

7.2 (7.2 + 0) 6.4 (7.2 - 0.8) 6.6 (7.2 - 0.6) 6.8 (7.2 - 0.4) 7 (7.2 - 0.2)

Daily 
forecast after
rounding

8 7 7 7 7

Cumulative 
remainder

-0.8 (7.2 - 8) -0.6 (6.4 - 7) -0.4 (6.6 - 7) -0.2 (6.8 - 7) 0

If the Oracle Demand Planning Forecast has decimal quantities, the rounded Oracle 
Advanced Supply Chain Planning forecasts may have decimal quantities.

Advanced Forecast Spreading Examples
This diagram shows an example of forecast spreading with backward and forward 
consumption days. In this example:

• The forecast for this item is in weekly buckets.

• The planning buckets are ten days and two weeks.

• Both Backward Days and Forward Days are 3.

The forecast spreading process spreads the weekly forecast quantities for weeks 1 and 2 
in to daily buckets to match the planning buckets.

The forecast consumption consumes these forecast quantities with these sales orders:

• D1 and D2 with S1

• D3 and D4 with S2

• D5, D6, D7, D8 with S3

• D8 and D9 with S4
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• D8, D9, and D10 with S5

• Week 2 with S6

• Week 2 with S7

Total Demand (after bucketing) for D5 is zero for consumption method using the 
Consume Using Backward/Forward Days method and 20 using the Consume by 
Forecast Bucket method.

Forecast Spreading with Backward and Forward Consumption Days

This diagram shows forecast spreading demand calculations in the order of their 
processing:

• Forecast spreading

• Forecast consumption

• Forecast bucketing
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• Demand time fence

The parameters are:

• Forecast Allocation: Spread Forecast Evenly

• Forecast Consumption: Consume by Forecast Bucket

• Demand Time Fence: 2 days

• Include Past Due Forecast Days: 6 days 

• Planning Buckets: 5 days, 2 weeks

The process buckets past due:

• Sales orders on days D -5, D -4, and D -1 into bucket D0

• Forecasts on days D -3 and D -5 into bucket D0
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Forecast Spreading Demand Calculations

Forecast Explosion
You can define and maintain forecasts for any item, at any level on your bills of 
material. Forecast explosion is a process that creates forecasts for components from the 
forecasts of their parents. It occurs in the following situations:

• Product family forecasts to product family member item forecasts. The planning 
engine considers these exploded forecasts as independent demand and uses 
pegging to link then to their product family forecast.

• Model forecasts to other model, option class, option item, and included item 
forecasts. See Configure to Order Forecast Explosion, page 10-9.

Forecasting Planning Bills of Material

In Oracle Bills of Material, you can define multilevel planning bills, with multiple levels 
of planning items, to represent groups of related products that you want to forecast by 
family. 

Typically, you can order components of a planning bill, but not the planning item itself. 
The planning item is an artificial grouping of products that helps you to improve the 
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accuracy of your forecasting since, generally, the higher the level of aggregation, the 
more accurate the forecast. 

Before you can perform forecast explosion, set up planning percentages in the product 
family and model bills of material. Planning percentage is the percent of the parent 
forecast that is attributable to the component. For example:

• In a product family bill of material, product family member item A has planning 
percentage 30%, product family member item B has planning percentage 50%, and 
5-56 product family member item C has planning percentage 20%.

• A product family forecast entry has quantity 1000

• After forecast explosion, the forecast quantity for product family member item A is 
300, for product family member item B is 500, and for product family member item 
C is 200.

See Creating a Bill of Material, Oracle Bills of Material User's Guide and attend to tab 
Component Details, field Planning %.

The following table illustrates a planning bill for Training Computer, a planning item 
that represents a planning bill for three types of computers: laptop, desktop, and server.
The planning percent assigned to each member of the planning bill represents 
anticipated future demand for each product.

Level Item BOM Item Type Planning % 

1 Training Computer Planning -

. 2 . Laptop Computer Model 60% 

. 2 . Desktop Computer Model 20% 

. 2 . Server Computer Model 20% 

The following table illustrates forecast explosion, via the planning bill described in the 
previous table, for a forecast of 100 Training Computers. The table also illustrates 
forecast consumption after you place sales order demand for 20 Laptop Computers. 
Original forecast shows forecast quantities before forecast consumption. Current 
forecast shows forecast quantities after consumption by sales order demand.

Level Item Original Forecast Current Forecast 

1 Training Computer 100 100 
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Level Item Original Forecast Current Forecast 

. 2 . Laptop Computer 60 40 

. 2 . Desktop Computer 20 20 

. 2 . Server Computer 20 20 

The planning percentages of all of the components of a parent can add to more than 
100%.

You control forecast explosion to each component by setting its organization item 
attribute Forecast control:

• Consume: There is no planning engine forecast explosion to this component.

• Consume and derive: There can be planning engine forecast explosion for models 
depending on plan option Explode Forecast. The planning engine does not explode 
multi-organization models.

• None: There can be planning engine forecast explosion for product families 
depending on plan option Explode Forecast.

For information about forecast explosion for model forecasts, see Configure to Order 
Forecast Explosion, page 10-7.

Multi-organization Forecast Explosion
The forecast explosion process can round the member item forecasts after explosion of 
the product family forecast. Use this rounding if you find that, because of fractional 
member item forecasts, you:

• Are creating excess inventory

• Experience an increase in pegging records

To use this rounding, set item attribute Round Order Quantity for each member item of 
a product family.

To perform this rounding, the forecast explosion process:

• Selects any member item

• Rounds its forecast down to the nearest integer and saves the remainder

• Applies (adds to or subtracts from) the remainder to the forecast of the next 
member item that it selects
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• Rounds its forecast to the nearest integer and saves the remainder

• Continues until it has rounded all member item forecasts

You can explode forecasts in:

• The source instance (local only): Then collect the exploded forecasts to the planning 
server. See Forecast Explosion in Oracle MRP User's Guide.

• Oracle Demand Planning (local and global): Then use the forecasts as demand 
schedules to a plan run.

• Oracle Advanced Supply Chain Planning (local only): During the plan run.

If you have exploded forecasts in the source instance or in Oracle Demand Planning, do 
not explode them in Oracle Advanced Supply Chain Planning.

To use Oracle Demand Planning for Forecast Explosion
Select the Demand Planning System Administrator responsibility.

1. Navigate to Demand Plans.

2. Select Calculate dependent demand to explode the forecast at a plan level.

3. Select the Scenarios tab.

4. Select Consume in Supply Plan to specify the Demand Planning scenario that needs
to be consumed in by Oracle Advanced Supply Chain Planning.

5. Set Explode Demand Using to:

• Global Bill of Material: To select a generic bills of material specified in item 
validation organization for forecast explosion purposes

• Organization specific Bill of Materials: To use the bills of material of a specific 
organization for forecast explosion purposes

6. Select Scenarios > Output Levels.

7. Publish demand plans with organization dimension set to All Organizations

To use Oracle Advanced Supply Chain Planning for Forecast Explosion
You can pre-explode the forecast using plan option Explode Forecast. This process 
occurs both for configure to order items and for product family items when the 
members have item attribute Forecast Control Consume and derive.

If you are using Oracle Demand Planning to explode the forecast, it publishes product 
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family forecasts to Oracle Advanced Supply Chain Panning for the product family and 
the product family member items. Do not instruct the planning engine to explode 
forecasts; it will double count the demand for the product family member items.

If Forecast Control is None, Oracle Demand Planning publishes the product family 
forecast to Oracle Advanced Supply Chain Panning for the product family only. The 
planning engine disregards plan option Explode Forecast and always performs inline 
forecast explosion to the product family items based on planning percentages and 
forecast consumption.

Select the Advanced Supply Chain Planner responsibility.

• Navigate to Supply Chain Plan > Plan Options > Main tab.

• Select the Explode Forecast check box.

To use Oracle Demantra for Forecast Explosion
See Oracle Demantra Demand Management User's Guide.

Global Forecasting
Global forecasts a re forecasts with no pre-specified ship from Organization associated 
to forecasts. Oracle Advanced Supply Chain Planning supports global forecasting by 
using Oracle Demand Planning scenarios as global forecasts. The forecasts from Oracle 
Demand Planning are fed into the planning engine as demand schedules, which can be 
consumed without any reference to a ship from organization. You can then use sourcing
rules to distribute the consumed forecasts and sales orders to appropriate shipping 
facilities.

Use global forecasting if your business has multiple shipping facilities and you would 
like to use multiple sources for end items without pre-determining the shipping 
organizations as you prepare and analyze your forecasts. Local forecasts apply to a 
shipping facility (inventory organization) while global forecasts apply to your entire 
business. Since, demand fulfillment is a dynamic process, you should be able to 
evaluate the current availability of supplies/resources and then come up with a 
fulfillment organization for the demand.

You can therefore select the demand fulfillment organization to take advantage of 
current supply conditions and constraints. This helps you in using existing supplies 
across multiple shipping organizations effectively and making more accurate forecast 
consumption.

Refer the following figure to understand the global forecasting process supported by 
Oracle Advanced Supply Chain Planning:
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You can consume global forecasts at any of the Ship To entities displayed in the above 
figure. If you do not specify the consumption level, Oracle Advanced Supply Chain 
Planning consumes forecasts at the item level. You can then distribute the consumed 
forecast to multiple organizations using the forecast distribution process.

Global Forecast Demand Schedules
You can maintain global forecasts with Oracle Demand Planning.

An Oracle Demand Planning scenario is available to Oracle Advanced Supply Chain 
Planning only if output levels are set as follows:

• Mandatory Dimensions

• Time: Day, Manufacturing Week, or Manufacturing Period

• Organization: Organization

• Product: Item or Product Family

• Optional Dimension Geography: Ship-to-location or Customer

Note: You cannot create global forecasts in Oracle MRP or Oracle 
Advanced Supply Chain Planning.

Global Forecast Explosion
You can explode global forecasts either in Oracle Demand Planning or in Oracle 
Advanced Supply Chain Planning. You cannot explode them in the source instance.

See Forecast Explosion, page 5-103.
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Global Forecast Consumption
Consumption of local forecasts always occurs within a shipping facility.

Consumption of global forecasts occurs without any reference to a shipping facility. In 
global forecast consumption, sales orders in inventory organizations consume global 
forecasts with reference to a ship to entity like zone, customer site, demand class. It 
ignores the source organization on the sales order line and redetermines the source. 

The planning engine can consume a global forecast with sales orders having the same 
ship to entities.

Note: If you have a scenario where a part of the forecast must be met by
a specific source, then you need to remove such a source from the 
sourcing rule of the global forecast distribution. For such items, the 
planning engine assumes that you will provide an organization specific
forecast or a local forecast. Global forecasts are then distributed to the 
sources that do not include the specific source and the local forecasts 
are distributed to the specific source.

If you provide a local forecast and global forecasts for the same item, 
Oracle Advanced Supply Chain Planning consumes both the forecasts.

To set up global forecast consumption
You need to complete setup steps in the following Oracle products to use global 
forecasting:

• Oracle Inventory

• Oracle Bills of Material 

• Oracle Flow Manufacturing

• Oracle Order Management

• Oracle Shipping

• Oracle Demand Planning

• Oracle Advanced Supply Chain Planning

Setup Steps in Oracle Inventory
Select the Manufacturing and Distribution Manager responsibility.

1. Navigate to Inventory > Items > Organization Items > MPS/MRP Planning tab.

2. Set the Forecast Control item attribute to decide the method for consuming and 
exploding forecasts:
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• Consume or None: If you select this option, the planning engine:

• Aggregates sales orders based on consumption level

• Consumes the top level assembly

• Distributes the remaining forecast

• Explodes the remaining forecast as part of the bills of material explosion

• Consume and Derive - If you select this option, the planning engine:

• Aggregates sales orders based on consumption level

• Explodes the forecast using Oracle Demand Planning or Oracle Advanced 
Supply Chain Planning

• Consumes the model, option class, and optional items

• Distributes the remaining forecast

3. If you have multi-level/multi-organization assemble-to-order assemblies, identify 
an organization where you intend to set up generic bills of material for forecast 
explosion purposes.

4. Set the profile option MSC: Organization containing generic BOM for forecast 
explosion based on your selection in step 4.

5. Specify a generic bills of material for forecast explosion in this organization.

Setup Steps in Oracle Bills of Material
1. Navigate to Bills of Materials > Bill > Bill.

2. If you have multi-level/multi-organization assemble-to-order assemblies, define a 
generic bills of material in the organization, which is specified by the profile 
MSC:Organization containing generic BOM for forecast explosion.

Setup Steps in Oracle Flow Manufacturing
1. Navigate to Flow Manufacturing > Products and Parts > Product Family Members.

2. Define the product family member relationship in the item validation organization.

Setup Steps in Oracle Order Management
1. Navigate to Order Management > Customers > Trading Community > Trading 

Community > Customers > Standard.

2. Define Customer site addresses.
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Setup Steps in Oracle Shipping
1. Navigate to Shipping > Setup > Regions and Zones > Regions and Zones.

2. Define Region, Zone or, Customer Zone to cover selected customer site addresses.

3. Navigate to Shipping > Setup > Regions and Zones > Transit Times.

4. Set up intransit lead-times between the zone and the shipping organizations.

5. Navigate to Regions and Zones > Zone tab.

6. Use the Zone Usage flex field to set the zone usage as Forecast Analysis.

When a sales order maps to multiple zones, then irrespective of the type of zone 
usage, Oracle Advanced Supply Chain Planning:

• Figures out which region within the zone it maps to (if applicable)

• Compares the levels of the regions within each of the zones and selects the 
more specific of the region and the corresponding zone

• Checks if the levels of the regions are the same across zones, and retains only 1, 
which is selected at random

Oracle Advanced Supply Chain Planning applies the methods mentioned above to 
forecasts as well. When you define a Zone in Oracle Shipping, you have the choice of 
specifying how the zone will be used in Oracle Advanced Supply Chain Planning. You 
can specify that either the zone will be used for forecast analysis or for deriving 
intransit lead-time. There are two possible values for usage: Null and forecast analysis. 

When the planning engine tries to distribute the forecasts to internal orgs, it uses Zones 
with usage set to forecast analysis. 

In the process of distributing sales orders to different internal orgs, the distribution 
process can use Zones with usages set to forecast analysis or, Zones with no usage set or
set to Null.

When a sales order maps to a region and a zone, the planning engine selects the 
intransit lead-time between the region and the customer or global organization.

Setup Steps in Oracle Demand Planning
1. Change to Demand Planning System Administrator responsibility.

2. Navigate to Demand plans > Scenarios > Output levels.

3. Define a demand plan and set the Organization dimension as All Organizations.

4. Enable the Consume in Supply Plan option.

5. Select Customer or, Demand Class as the hierarchy in the Geography dimension. 
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6. If you want to explode forecasts, select Calculate Dependent Demand.

7. If you have multi-level/multi-organization assemble-to-order assemblies, select 
Global Bills of Material to explode forecasts.

8. Set profile option MSD: Master organization. Set it either to:

• The same organization as that in profile option MSC: Organization containing 
generic BOM for forecast explosion 

• An organization whose items are a subset of the items in the organization in profile 
option MSC: Organization containing generic BOM for forecast explosion

Setup Steps in Oracle Advanced Supply Chain Planning
1. Update your sourcing assignment set to include transfer from rules that specify the 

organization where you want each forecast distributed.

. You also need a sourcing assignment that specifies where the item should be 
sourced within the organization. For example: 

• An item-instance rule that specifies all forecasts should be transferred from 
organizations M1 and M2 with a given planning percentage.

• You also need to have make, buy, or transfer rules at the organization-item 
level that specify where to source these items.

2. You need to assign sourcing rules at zone level for global forecasting. For more 
details, see section Sourcing Rules at Region or Zone Level in Oracle Global Order 
Promising Implementation and User's Guide.

Oracle Advanced Supply Chain Planning supports global forecasting based at zone 
level and not at customer site level. This also implies that when you use global 
forecasting at the zone level for example, zone A, it also covers all the customer 
sites that fall under zone A.

3. Navigate to Supply Chain Plan > Plan Options > Organizations tab.

4. In the Global Demand Schedules region, select the names of either global or local 
(organization specific) demand planning scenarios to drive the plan.

5. Select one of the following forecast consumption level for the Oracle Demand 
Planning scenario in Ship to Consumption Level:

• Zone: To represent demand from a number of customers who belong to a zone, 
which is a user specified definition of geography. Zone can be defined using 
city, postal code, state, and country. You do not get customer specific forecasts 
when you select this entity.
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• Customer Zone: To represent user specified definition of geography where 
multiple customers can be grouped. You can use this option if forecast for a few
customers from a zone are known. You can choose to provide forecast at 
customer zone in addition to zone level forecast.

• Customer

• Customer Site

• Demand Class - To group a demand segment. For example: internet sales, 
catalog sales

• Global (Item)

Your selection depends on the dimension on which the demand planning 
scenario is published.

Note: The list of values displayed for Ship to Consumption 
Level changes depending on the published level of the demand
planning scenario.

The global forecasting process consumes forecast entries that match the Ship To
plan option value.

To consume global forecasts
Publish demand plans with the organization dimension set to All Organizations.

• Oracle Demand Planning allows you to publish the forecasts without the context of 
a ship from location. Oracle Advanced Supply Chain Planning picks up these 
forecasts without the context of an organization and uses these forecasts for forecast
consumption and planning purposes.

• Set the Schedule By plan option to determine the date by which Oracle Advanced 
Supply Chain Planning needs to consume the forecasts.

• If you ship early, run Oracle Order Management concurrent process Re-schedule 
Ship Sets. Shipped sales orders consume forecasts only by schedule date. This 
concurrent process updates the schedule date of shipped sales orders to the ship 
date.

• Run a supply chain plan with the appropriate explosion and consumption controls.

The forecast consumption occurs on forecast entries that have references to both 
Ship From (a generic reference) and Ship To (specific references) entities.
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Internal Sales Order Forecast Consumption
Forecasts in general are consumed by regular sales orders. Internal sales orders do not 
consume forecasts. The assumption here is that the forecast maintained at an org level 
or even globally is meant for demands that is destined to a specific customer. If you 
consume forecasts using internal sales orders, you may be consuming forecasts that was
from a customer using a sales order that originated from an internal source (from 
another org) and therefore, understate the demand.

You can control how internal sales orders should consume forecasts by setting profile 
option MSC: Consume forecasts using Internal Sales Orders as follows:

• Yes: The planning engine consumes forecasts with internal sales orders

• No: The planning engine does not consume forecasts with internal sales orders

• Only if Destination Organization on ISO is not part of Plan: The planning engine 
consumes forecasts with internal sales order that meet either of these conditions:

• Its destination organization is not planned in this plan

• Its destination organization is planned in a source plan (MRP/MPS/MPP). This 
applies only one level down from the internal sales order source organization.

Lower Level Pre-configuration Consumption
You can forecast and stock a lower level configured item and then consume its forecast 
with sales orders for the parent assembly. Any remaining demand then consumes the 
forecast for the associated assemble-to-order model. 

If you need to stock at the end item level or at lower level subassemblies to reduce 
delivery time, you can forecast a demand for the configuration item directly, release a 
planned order for that item, and build and stock that item.

The planning engine consumes the forecast for this specific configuration first, within 
the backward and forward consumption days. If there is remaining sales order demand 
after consuming the configuration's forecast, the planning engine then consumes 
forecasts for the base assemble-to-order model. For the part of the forecast that 
consumed the assemble-to-order model's forecast, the planning engine explodes the 
bills of material to consume any forecast for the lower level configured item. After 
consuming the forecast for the lower level configured item, the planning engine then 
consumes the base model forecast in the same manner. When demand consumes a 
model, the consumption process also consumes its option classes and option forecasts at
that level.

To avoid double counting the forecast, reduce your exploded forecast or planning 
percentages to account for the separate forecast for the configured item.
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Global Forecast Planning
Option Dependent Resources

For forecasted demands of assemble-to-order models, the planning engine reduces 
planned order resource requirements for optional resources. These planned orders are 
only generated for forecasted demands. Certain operations are utilized only when 
specific optional components are utilized.

When the planning engine reduces the resource usage for optional resources, it uses the 
component planned percentage for the optional component used at that operation to 
estimate the amount of time that resources are required.

If several options require the same operation, the planning engine sums the planned 
percentage for these options up to a total of 100% and then applies the formula 
Operation schedule quantity = Planned order quantity * planning percentage

To set up an option dependent resource, select Option Dependent for the operation on 
the routing, then assign the optional components to the operation on the bill of material.

The Auto-create Configuration concurrent process creates the configured item's bills of 
material with only the specified options. In the same way, it creates the configured 
item's routing with only those operations that are mandatory and the option dependent 
operations linked to the options that you select.

Common Routings for Option Classes

You can reference an assemble-to-order model routing as a common routing for option 
class items. The model routing includes the steps that all configurations require. The 
planning engine recognizes the common routing between the assemble-to-order model 
and its option class and ignores the repeated resources in the option class routing. 

This only applies to an option class that shares a common routing with its immediate 
parent. If the option class shares a common routing with any other item, the option 
class's routing is planned as a separate routing. The planning engine does not ignore 
common routings for lower level assemble-to-order models that are tied directly to an 
assemble-to-order parent model.

Global Forecasts Distribution
The planning engine distributes forecasts in the following manner:

• Unconstrained - Distributes based on ranks and planning percentage.

• Constrained - Distributes based on ranks and planning percentage.

• Constrained with decision rules - Distributes forecasts based on capacity and 
resource availability. The planning engine considers rank as well as material, 
resource, and transportation constraints.

• Cost based optimized plans - In addition to supplies and constraints, the planning 
engine also considers the cost of production and transportation for distributing 
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forecasts.

Note: Select the Round Order Quantity item attribute in Inventory 
> Items > Organization Items > MPS/MRP Planning tab to avoid the
planning engine from sourcing forecast entries with fractional 
demand.

Sales Order Distribution
The planning engine only sources sales order lines that:

• Have global forecasts against their item

• Are present in constrained plans with decision rules and optimized plans

• Are scheduled

• Are not firmed

• Are not marked ship model complete

You can manually select a shipping facility on a sales order line at the order entry time. 
However, the facility that you select may not be the best one at the shipment time due 
to the evolving global supply and demand picture. The planning engine selects a facility
for sourcing the sales order based on the global supply availability, supply chain 
constraints, procurement costs, and production costs.

You can opt to enforce the global sourcing rule split. If the organization with the higher 
sourcing percentage has enough capacity, the planning engine places the entire sales 
order line there. If it does not find any capacity in any of the sources, it distributes based
on the highest planned split percentage of the highest rank in the source. It uses the 
entire capacity of the organization with the higher sourcing percentage and sources the 
remaining supplies from other organizations.

The planning engine may distribute components of a configured item to multiple 
inventory organizations. In other words, it may source one line from one inventory 
organization and another line from another inventory organization regardless of 
whether you prefer to source all supplies for a sales order from a single source, the sales
order has ship sets, or the sales order has arrival sets.

During demand allocation, the planning engine splits a sales order:

• If capacity constraints are present

• To use existing supplies

The planning engine does not split the sales order if:

• You have partial demand quantity reserved. In this case, the planning engine does 
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not change the source. The entire sales order will be sourced to the Org where you 
have partial reservation.

• There are sourcing constraints because the planning engine does not include sales 
orders into enforce sourcing constraints calculations.

The planning engine evaluates alternate ship methods specified in the sourcing 
rules/BOD form and recommends the appropriate option. It can also release a ship 
method to the sales order, which is different from the one specified in the Transit Times 
form.

If a sales order is already firmed in Oracle Order Management, the planning engine 
provides recommendations only for ship method and schedule ship date and does not 
provide any suggestions for changing the shipping facility.

To view Global Forecasting Results
To review the forecast distribution from the global forecast to individual organizations' 
forecasts

• Navigate to Supply Chain Plan > Workbench

• Select View by Organization. 

• Select a plan name

• Select an organization

• Select an item

• Select Horizontal Plan

• The Horizontal Plan window presents the forecast consumption and distribution 
details in two parts. 

The first part displays the global forecast plan with following rows:

• Original forecast quantity

• Consumed quantity

• Current quantity

• Cumulative original quantity

• Cumulative original quantity

• Expired forecast: The amount of unmet forecasts

The second part is the horizontal material plan, which is specific to the 
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organization from where you navigated to the horizontal plan. The forecast row
in this part of the horizontal plan displays the amount of forecasts distributed 
to the organization.

If you select View by Item, Planner Workbench displays the same global 
organization information with the supply and demand aggregated for all 
organizations instead of for a specific organization.

• Right-click on the Horizontal Plan window and select Global Forecasting and select 
the level values available to analyze the consumption plan with respect to specific 
consumption levels. 

• You can use this option to bring up the forecast and consumption information 
specific to different zones. For example: you can right-click and select Global 
Forecasting > Zone 1 to display information that is specific to Zone 1.

• In the Horizontal Plan window, double-click on the Current field to open the 
Supply/Demand window with all the distributed forecasts for a global forecast.

• In the Horizontal Plan window, double-click on the Consumed field to open the 
Supply/Demand window with sales orders that consumed the forecast.

Note: Oracle Advanced Supply Chain Planning retains shipped 
sales orders for consumption purposes but the sales order is not 
shown in the demand picture as it has already been shipped. When 
you drill down from the Consumed field in the Horizontal Plan 
window to the Supply/Demand window, the planning engine does 
not show shipped sales orders while the consumption still happens 
using shipped sales orders. This may cause a mismatch between 
the numbers in the Consumed field and the numbers in 
Supply/Demand window (drill down from the Consumed field) .

You can set the Include Sales Order plan option to control whether 
the planning engine picks up sales orders behind a specific number 
of days or not. For details, see Chapter 5: Plan Options. 

You can use the profile MSC: Sales Order offset days to filter out 
the sales orders that are not supposed to consume the forecast.

• Right click from a specific sales order.

The Consumption Details window appears.

• Navigate to Exception Details window to review overconsumption exceptions. 

Oracle Advanced Supply Chain Planning generates the following exception for 
each occurrence of forecast over consumption:
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• Items with forecast overconsumptions

Examples
This section lists a few examples to further explain the global consumption and 
explosion process based on different scenarios:

• Example 1: Standard item, page 5-119

• Example 2: Product family Items in multiple organizations, page 5-120

• Example 3: Single level single org ATO assembly, page 5-123

• Example 4: Multi level single org ATO assembly, page 5-126

• Example 5: Single level multi org ATO assembly, page 5-129

• Example 6: Multi level multi org ATO assembly, page 5-133

Example 1: Standard item
Consider a standard item A for which:

• The forecast consumption is at the item or global level.

• The forecast is distributed to two manufacturing organizations M1 and M2:

• The sourcing rules for M1 and M2 are set as 40% and 60% respectively.

Global Forecasting for a standard item

Refer the table below to see the amount of forecast consumed and distributed by the 
planning engine:

Forecast 1/10 1/17 1/24 D2/1 2/8 2/15

Consumed 
forecast

40 80 60 50 50 50
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Forecast 1/10 1/17 1/24 D2/1 2/8 2/15

Forecast 
distributed 
to M1

20 10 15 11 10 20

Forecast 
distributed 
to M2

20 70 45 39 40 30

Result:

• The distributed forecast is not according to settings in the sourcing rules/BOD. The 
forecast distribution amount can vary depending on the type of plan you run and 
the options you choose. Oracle Advanced Supply Chain Planning also supports 
enforcing a sourcing percentage. This option allows you to enforce the amount of 
forecasts on a percentage basis to specific organizations 

• Lead-times used during forecast distribution: If the forecast is specific to a customer
site, and you have customer specific sourcing rule, Oracle Advanced Supply Chain 
Planning uses the intransit lead-time between shipment organization and customer 
site (via zones) if you have set up intransit lead-time between the two.

Example 2: Product family Items in multiple organizations 
Consider: 

• A product family item PF1 with two member items M1 and M2 is present in 
Organization 1. The member percentages are 40 and 60 for M1 and M2 respectively.

• The product family item PF1 with two member items M1 and M2 is also present in 
Organization 2. The member percentages are 50 for both M1 and M2.

• Forecast explosion cannot go across multiple organizations and it needs a single bill
of material (product family relationship) to explode the forecast. Therefore, you 
need to define a representative product family relationship in the item validation 
organization. 

• The representative bill of material is used for forecast explosion purposes only. The 
planning percentage for M1 versus M2 is adjusted in the item validation 
organization to get a single definition of the product family. 
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Global forecasting for product family items

Oracle Demand Planning and Oracle Advanced Supply Chain Planning use the product
family relationship that you specify in the item validation organization to explode the 
forecasts to member levels.

Scenario 1: 
Forecast control is set to Consume and Derive

Assume that the following sales orders are present for members M1 and M2 of product 
family PF1 in Organization 1:

Sales Order 
No

Item Date Qty Customer Customer 
Site

1001 M1 1/15 20 C1 S1

1002 M1 2/1 50 C1 S2

1003 M2 2/8 40 C2 S1

1004 M2 3/1 80 C3 -

Before forecast consumption and explosion and no organization context, the planning 
engine gives the following result:

Item 1/10 1/17 1/24 D2/1 2/8 2/15

PF1 80 50 50 100 50 100

After forecast explosion, the planning engine gives the following result:
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Item 1/10 1/17 1/24 D2/1 2/8 2/15

PF1 80 50 50 100 50 100

M1 40 25 25 50 25 50

M2 40 25 25 50 25 50

Assume that backward consumption = 30 days.

After forecast explosion and consumption, the planning engine gives the following 
result:

Item 1/10 1/17 1/24 D2/1 2/8 2/15

PF1 60 50 50 5 25 50

M1 20 25 25 0 25 50

Sales Order
No

1001 - - 1002 - -

M2 40 25 25 5 0 0

Sales Order
No

- - - 1003

1004

1003 1004

Result: 

• The forecasts are consumed against the product family.

• No shipment organization has been referenced in the forecast consumption.

• Forecast explosion can either happen in Oracle Demand Planning or Oracle 
Advanced Supply Chain Planning. If you bring forecasts at a global level, you can 
explode the forecast within Oracle Advanced Supply Chain Planning.

• You have forecasts that need to be placed into specific organizations for materials 
and resources planning. Specify sourcing rules for product family items so that the 
planning engine can place the item in a specific organization and plan the item and 
its members.

• When the forecast gets distributed to a specific Ship From organization, the order 
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type for the demand is Production Forecast.

• You need to assign the sourcing rules at the same level as the forecast consumption 
level. For example, if the forecasts are consumed at item level, then you need to 
provide the sourcing rule also at item level.

Scenario 2:
Forecast control is set to None or Consume

Consider:

• Forecast control is set to None or Consume

• Specify the sourcing rules for the product family item as mentioned in Scenario 1. 
This enables Oracle Advanced Supply Chain Planning to distribute the forecasts 
from generic Ship From organizations to specific organizations.

Result:

• The forecast consumption happens before the forecast explosion at the product 
family level and the member item level.

• The product family bill of material is exploded during bill of material explosion in 
Oracle Advanced Supply Chain Planning.

• Oracle Advanced Supply Chain Planning explodes the demand to member items 
during the bill of material explosion as it does for standard items during regular 
planning process. When Oracle Advanced Supply Chain Planning explodes the bill 
of material in this case, it picks up the bill of material in the true organization and 
not the one in the item validation organization.

Example 3: Single level single org ATO assembly
Consider:

• A single level single org ATO assembly in Organization 1.

• The assembly for Model 1 contains Option Class OC1 and Mandatory Components 
MC1. 

• Option Class OC1 contains Option 1 and Option 2.

• The bill of material is maintained in the item validation organization.

• The fixed and variable lead-times are also maintained in the item validation 
organization.
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Single level single org ATO assembly

Scenario 1: 
Forecast control is set to Consume and Derive

Assume that:

• Forecast control is set to Consume and Derive

• The forecast for the Model item is maintained without any organization context.

• The forecasts for optional items and mandatory components are maintained 
independently to service independent demands such as spares or safety stock 
requirements.

Refer the table below for the forecasts maintained for Model 1 in Organization 1:

Item 1/10 1/17 1/24 D2/1 2/8 2/15

Model 1 40 20 10 20 50 40

Option 1 5 0 5 4 10 10

Option 2 0 0 0 5 6 10

Mandatory 
Components 
MC 1

2 2 2 2 2 2

The forecasts for Option 1, Option 2, and Mandatory components MC1, which belong to
Models 1, account for the lead-time of its assembly item. 

If you have independent forecasts, the planning engine derives the forecast date for the 
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independent demand as the ship date for the options and mandatory components. 
However, the dependent demands Option 1, Option 2, and Mandatory components 
MC1 for Model 1 are offset for lead-time.

Assume that:

• The sourcing rule for Model 1 is defined at Organization 1. This is the level at which
you consumed the forecasts.

• The fixed and variable lead-time for Model 1 = 5 days

After forecast explosion, the planning engine gives the following result:

Item 1/5 1/10 1/12 1/17 1/19 1/24 1/25 2/1 2/3 2/
8

2/1
0

2/15

Model 1 0 40 0 20 0 10 0 20 0 50 0 40

Option Class 
OC1

40 0 20 0 10 0 20 0 50 0 40 0

Option 1 20 5 10 0 5 5 10 4 25 10 20 10

Option 2 20 0 10 0 5 0 10 5 25 6 20 0

Mandatory 
Components 
MC 1

40 2 20 2 10 2 20 2 50 2 40 2

Assume that:

• You receive a sales order for 25 units of Model with Option 1 on 1/17.

• Backward consumption = 30 days

After forecast consumption, the planning engine gives the following result:

Item 1/5 1/10 1/12 1/17 1/19 1/24 1/25 2/1 2/3 2/8 2/10 2/15

Model 1 0 35 0 0 0 10 0 20 0 50 0 40

Option 
Class OC1

5 0 0 0 10 0 20 0 50 0 40 0

Option 1 0 5 10 0 5 5 10 4 25 10 20 10
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Item 1/5 1/10 1/12 1/17 1/19 1/24 1/25 2/1 2/3 2/8 2/10 2/15

Option 2 20 0 10 0 5 0 10 5 25 6 20 10

Mandatory 
Components
MC 1

15 2 20 2 10 2 20 2 50 2 40 2

Result: The above forecast is sourced to Organization 1.

Scenario 2: 
Forecast control set to None or Consume

If the forecast control is set to None or Consume, you do not need to maintain the bill of
material in the item validation organization. In this case, planning engine explodes the 
forecasts as part of regular planning explosion process. 

It is enough to maintain the sourcing rules for Model 1. If the top level item's forecast 
control is set to Consume, Oracle Advanced Supply Chain Planning consumes only the 
top level model.

Example 4: Multi level single org ATO assembly
Consider:

• A multi level single org ATO assembly where the entire assembly is produced in 
Organization 1 but has multiple ATO assemblies.

• The bill of material is maintained in the item validation organization.

• The fixed and variable lead-times are also maintained in the item validation 
organization.

Scenario 1:
Forecast control set to consume for assembly and none or consume to components

Assume that:

• Forecast control is set to consume for assembly and none or consume to 
components

• The forecast for the Model item is maintained without any organization context.

• The forecasts for optional items and mandatory components are maintained 
independently to service independent demands such as spares or safety stock 
requirements.

Refer the table below for the forecasts maintained for Model 1 in Organization 1:
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Item 1/24 D2/1 2/8 2/15

Model 1 10 20 50 40

Option 1 5 4 10 10

Option 2 0 5 6 10

Option 3 2 2 2 2

Mandatory 
Components MC 3

4 4 4 4

Assume that:

• The forecast is maintained at the global level.

• The sourcing is maintained for the top level model, which is Model 1.

• The fixed and variable lead-time for Model 1 = 3 days

• The fixed and variable lead-time for = 2 days

You receive a sales order for 25 units of Model with Option 1 on 2/8 for Customer 1 and 
Site 1.

After forecast consumption, the planning engine gives the following result:

Item 1/24 D2/1 2/8 2/15

Model 1 10 20 25 40

Option 1 5 4 10 10

Option 2 0 5 6 10

Option 3 2 2 2 2

Mandatory 
Components MC 3

4 4 4 4

After forecast explosion, the planning engine gives the following result:
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Item 1/19 1/21 1/2
4

1/25 1/27 2/1 2/2 2/5 2/8 2/10 2/12 2/1
5

Model 1 - - 10 - - 20 - - 25 - - 40

Option Class 
OC1

- - 10 - - 20 - - 25 - - 40

Mandatory 
Components 
MC 1

- - 10 - - - - - 25 - - 40

Model 2 - 10 - - 20 - - 25 - - 40 -

Option 1 - 5 5 - 10 4 - 13 10 - 20 10

Mandatory 
Components 
MC 2

- 10 - - 20 - - 25 - - 40 -

Option Class 
OC2

10 - - 20 - - 25 - - 40 - -

Option 2 5 - 0 10 - 5 13 - 6 20 - 10

Option 3 5 - 2 10 - 2 12 - 2 20 - 2

Mandatory 
Components 
MC 3

10 - 4 20 - 4 25 - 4 40 - 4

Result:

• The above forecast is sourced to Organization 1 for material and resource planning.

• It is assumed that there are no constraints. If you run a constrained plan, the timing 
of the supplies and the demand satisfied dates for these forecasts may be away from
the due dates.

Scenario 2:
Forecast control is set to Consume and Derive 

If the forecast control is set to Consume and Derive, you need to maintain the bills of 
material in the item validation organization. In this case, Oracle Demand Planning 
performs the forecast explosion and provides forecasts to Oracle Advanced Supply 
Chain Planning.
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Oracle Advanced Supply Chain Planning consumes the forecasts at the chosen level 
and distributes the forecasts based on the sourcing rules provided for Model 1, which is 
the top level model.

Example 5: Single level multi org ATO assembly
Consider:

• A single level multi org ATO assembly where Model 1 can be sourced from two 
different organizations

• The forecast is set globally without the context of an organization. 

• Lead-time for Model 1 in Organization 1 = 2 days

• Lead-time Model 1 in Organization 2 = 3 days.

Single level multi org ATO assembly

Scenario 1:
Forecast control is set to None or Consume

Assume that:

• You need to consume forecast at the top assembly level and distribute the forecasts 
across sources. You can set the forecast control to None or Consume for the 
components. 

• The sourcing rules for Model 1 is maintained to source the items.

• You need to maintain an independent forecast for the model and some optional 
items as follows:
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Item 1/10 1/17 1/24 2/1 2/8 2/15

Model 1 20 20 16 20 30 20

Option 1 5 0 5 4 10 10

Option 2 0 0 0 5 6 10

• The sourcing rule for Model 1 is maintained to source the items. The level at which 
you specify the sourcing rule must match the level at which you consume the 
forecast.

• 25% of the forecast needs to be sourced from Organization 1 and 75% of the forecast
needs to be sourced from Organization 2.

• Model 2 is needed for Model 1 assembly 100% of the time.

You get a demand of 25 units of sales order demand for Model 1 on 1/24 with Option 2.

After forecast consumption and explosion, the planning engine gives the following 
result:

Result for Organization 1:

Item 1/7 1/10 1/14 1/17 1/21 1/24 1/27 2/1 2/5 2/8 2/12 2/15

Model 1 - 5 - 8 - 0 - 15 - 23 - 15

Option 1 8 5 4 0 0 5 8 4 12 10 8 10

Option 2 7 0 4 0 0 0 7 5 11 6 7 10

Result for Organization 2:

Item 1/8 1/10 1/14 1/17 1/22 1/24 1/27 2/1 2/6 2/8 2/13 2/15

Model 1 - 5 - 3 - 0 - 5 - 8 - 5

Option 1 3 5 2 0 0 5 3 4 4 10 3 10

Option 2 2 0 1 0 0 0 2 5 4 6 2 10
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The intransit lead-times and the organization specific lead-times are considered when 
distributing the demand and sourcing the items. Option 1 and Option 2 forecasts are 
offset using the lead-time in the Organization 1 and Organization 2 respectively. 

Scenario 2:
Forecast control is set to Consume and Derive

Consider:

• The forecast is maintained at the global level.

• The sourcing is maintained for Model 1 to source the items. The level at which you 
specify the sourcing rule must match the level at which you consumed the forecast.

• A generic bill of material is maintained in the item validation organization with all 
the options and mandatory components as shown below: 

Bill of Material

• Adjust the planning percentage on option class items and optional items to arrive at
a figure that represent the figure in both organizations. 

• In this method the organization specific lead-times are not be applied. The 
lead-times specified in the item validation organization is used. Therefore, it is 
important to specify the lead-times that closely represents your set up.

• The forecast control for mandatory components is generally set to None. Therefore, 
the demand on the mandatory components is placed when the bills of material 
explosion happens in Oracle Advanced Supply Chain Planning. If you put in 
mandatory components in the generic bill of material, the forecast is derived to the 
mandatory components. Therefore, it is not recommended that you add the 
mandatory components to the generic bill of material. 
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The forecast explosion occurs using the above bills of material in the item validation 
organization. After the forecast explosion, Oracle Advanced Supply Chain Planning 
consumes the forecast at the level you choose. 

After forecast explosion, the planning engine gives the following result:

Item 1/7 1/10 1/14 1/17 1/21 1/2
4

1/27 2/1 2/5 2/8 2/12 2/15

Model 1 - 20 - 20 - 16 - - - 30 - 20

Option 
Class OC1

20 - 20 - 16 - - - 30 - 20 -

Option 1 10 5 10 0 8 5 10 4 15 10 10 10

Option 2 10 0 10 0 8 0 10 5 15 6 10 10

You get a demand of 25 units of sales order demand for the model on 1/24 with Option 
2. 

After forecast consumption, the planning engine gives the following result:

Item 1/8 1/10 1/14 1/17 1/22 1/24 1/27 2/1 2/6 2/
8

2/13 2/15

Model 1 - 20 - 11 - 0 - 20 - 30 - 20

Option 
Class OC1

20 - 11 - 0 - 20 - 30 - 20 -

Option 1 10 5 10 0 8 5 10 4 15 10 10 10

Option 2 3 0 0 0 0 0 10 5 15 6 10 10

Result:

• After forecast explosion, the forecast is consumed at the level that you choose.

• The planning engine distributes the forecast for optional items between 
Organization 1 and Organization 2 based on the sourcing rules established for these
models. If your optional items follow different sources than the model, you should 
define the different sources in the sourcing rule for the optional items.

• If you want to maintain the sourcing splits between organizations, set Enforce 
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sourcing constraints to No in the Plan Options form. The planning engine 
recommends the forecast quantities to be placed in each organization based on the 
constraints you might have in the lower levels of the bills of material in each of the 
organizations.

Example 6: Multi level multi org ATO assembly
Consider:

• A multi level multi org ATO assembly where a lower level Model is sourced from 
two different organizations. 

• Forecasts are specified globally without the context of an organization. 

• The lead-time for Model 2 in Organization 2 = 2 days.

• The lead-time for Model 2 in Organization 3 = 3 days.

• The intransit lead-time for Organization 2 = 2 days.

• The intransit lead-time for Organization 3 = 3 days.

Multi level multi org ATO assembly

Scenario 1:
Forecast control is set to None or Consume

Assume that:

• You need to consume forecast at the top assembly level and distribute the forecasts 
across sources. You can set the forecast control to None or Consume for the 
components. 

• The sourcing rules for Model 1 and Model 2 are maintained to source the items. The
level at which you specify the sourcing rules must match the level at which you 
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consume the forecast.

• You need to maintain an independent forecast for Model 1 and some optional items
as follows:

Item 1/24 D2/1 2/8 2/15

Model 1 16 20 30 20

Option 1 5 4 10 10

Option 2 0 5 6 10

Assume that:

• 25% of the forecast needs to be sourced from Organization 2 and 75% of the forecast
needs to be sourced from Organization 3.

• Model 2 is needed for Model 1 assembly 100% of the time.

You get a demand of 25 units of sales order demand for the model on 2/8 with Option 2.

After forecast consumption and explosion, the planning engine gives the following 
result:

Result for Organization 2:

Item 1/20 1/24 1/26 2/1 2/4 2/8 2/11 2/15

Model 1 - 4 - 5 - 1 - 5

Option 
1

2 5 3 4 1 10 3 10

Option 
2

2 0 2 5 0 6 2 10

Result for Organization 3:

Item 1/18 1/24 1/24 2/1 2/2 2/8 2/9 2/15

Model 1 - 12 - 15 - 4 - 15
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Item 1/18 1/24 1/24 2/1 2/2 2/8 2/9 2/15

Option 
1

6 5 8 4 2 10 8 10

Option 
2

6 0 7 5 2 6 7 10

The intransit lead-times and the organization specific lead-times are considered when 
distributing the demand and sourcing the items.

Scenario 2:
Forecast control is set to Consume and Derive

Consider:

• The forecast is maintained at the global level.

• The sourcing is maintained for Model 1 and Model 2 to source the items. The level 
at which you specify the sourcing rules must match the level at which you 
consumed the forecast.

• A generic bills of material is maintained in the item validation organization with all 
the options and mandatory components as shown below: 

Bills of Material

Assume that:

• Lead-time for Model 1 = 1 day.
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• Lead-time for Model 2 = 2 days.

• Model 2 is needed for Model 1 assembly 100% of the time.

After forecast explosion, the planning engine gives the following result:

Item 1/22 1/23 1/24 1/29 1/31 2/1 2/5 2/7 2/8 2/1
2

2/14 2/15

Model 1 - - 16 - - 20 - - 30 - - 20

Model 2 - 16 - - 20 - - 30 - - 20 -

Option 
Class OC1

16 - - 20 - - 30 - - 30 - -

Option 1 8 - 5 10 - 4 15 - 10 10 - 10

Option 2 8 - 0 10 - 5 15 - 6 10 - 10

You get a demand of 25 units of sales order demand for the model on 2/8 with Option 2.

After forecast consumption, the planning engine gives the following result:

Item 1/22 1/23 1/24 1/29 1/31 2/1 2/5 2/7 2/
8

2/12 2/14 2/1
5

Model 1 - - 16 - - 20 - - 5 - - 20

Model 2 - 16 - - 20 - - 5 - - 20 -

Option 
Class OC1

16 - - 20 - - 5 - - 30 - -

Option 1 8 - 5 10 - 4 15 - 10 10 - 10

Option 2 8 - 0 5 - 0 0 - 6 10 - 10

Result:

• After forecast explosion, the forecast is consumed at the level that you choose.

• The planning engine distributes the forecast for optional items between 
Organization 2 and Organization 3 based on the sourcing rules established for these
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models. If your optional items follow different sources than the model, you should 
define the different sources in the sourcing rule for the optional items.

• If you want to maintain the sourcing splits between organizations, set Enforce 
sourcing constraints to No in the Plan Options form. The planning engine 
recommends the forecast quantities to be placed in each organization based on the 
constraints you might have in the lower levels of the bills of material in each of the 
organizations.

Choosing Aggregation Levels
Oracle ASCP allows planning to occur at different levels of aggregation within the same
plan. This allows detailed scheduling and long-range planning to take place within a 
single integrated plan. Flexible aggregation levels exist along several planning 
dimensions:

• Time

• Product

• Resource/routing

Aggregation level options for each dimension is described below.

Time Aggregation Levels
In ASCP, the available time aggregation levels are:

• Minutes

• Hours

• Days

• Weeks

• Periods

In order to reduce the computational effort to calculate a plan and to reduce the volume
of plan output (for clarity), time bucket sizes should be set only as small as is necessary 
to capture the necessary detail.

Time bucket size must increase or stay level over the planning horizon; it cannot 
decrease.

The following sequences of time aggregation levels are examples of those (but not all) 
that are valid within a single plan:
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• Minutes-hours-days-weeks-periods (check Constrained Plan in the Constraints tab)

• Days (Aggregation tab)

• Days-weeks (Aggregation tab)

• Hours-days-periods (check Constrained Plan in the Constraints tab. Note: weeks 
time aggregation level is skipped.)

• Planning at the minute and hour aggregation levels is referred to as scheduling, and
is enabled only when the Constrained Plan check box in the Constraints tab of the 
Plan Options window is checked.

• Periods default to months.

• All lower level demand that occurs within a higher level time bucket (for example, 
a daily demand occurring in the middle of a weekly time bucket) is moved to the 
last day of the higher level bucket for planning purposes. This is the information 
lost through aggregation.

• Supplies are always scheduled to arrive at the last day of periods.

If you use order modifier Fixed Days of Supply, the planning engine creates a single 
supply to cover multiple days of demand. During constraint-based scheduling, the 
planning engine may move the demand and supply dates such that you cannot 
reconcile the supply quantity to the demand dates and quantities. To attempt a 
reconciliation, Oracle recommends using the old due date on the planned order 
demands.

Product Aggregation Levels
In Oracle ASCP, the available product aggregation levels are:

• Item

• Product family

Planning at the item level explodes material and resource requirements down to each 
bottom-level component (provided that the component's MRP Planning Type item 
attribute matches the type of Manufacturing, Production, or Master Plan being run).

When planning at the product family level, no explosion of material or resource 
requirements occurs. Information concerning the resources required to make a product 
family are taken from the routing for the product family. Therefore, if planning is to be 
done at a product family level, there needs to be a routing defined for each product 
family. No material requirements are considered when planning at a product family 
level.
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Resource Aggregation Levels
There are two ways in which the aggregation level of resource information may be 
specified in Oracle ASCP:

• Resource aggregation level of Individual aggregate

• Routing aggregation level of Routing bill of resource (BOR)

Note: Resource aggregation levels do not have any effect unless the 
Constrained Plan check box in the Constraint tab of the Plan Options 
window is checked.

Resource aggregation levels can either be individual or aggregate.

• Individual: All resources listed in all item routings (if the item aggregation level is 
set to Item) or all product family routings (if the item aggregation level is set to 
Product Family) are considered in planning.

• Aggregate: Only resources specified as aggregate resources are considered in 
planning. Aggregate resources are specified in the window accessed by the 
Operations Resources button during routing definition (Use the Manufacturing and
Distribution Manager responsibility. From the Navigator window, choose Bills of 
Material > Routings > Routings). Each operation resource can have a designated 
aggregate resource (which may be itself or another resource). If you designate a 
resource as an aggregate resource, do not use it as an individual resource; the 
planning engine does not plan it. 

Routing aggregation levels serve a similar function.

• Routing: all resources listed in all item routings (if the item aggregation level is set 
to Item) or all product family routings (if the item aggregation level is set to Product
Family) are considered in planning. This is identical in meaning to the individual 
resource aggregation level described above.

• Bill of resource (BOR): only resources listed in bills of resources for items (if the 
item aggregation level is set to Item) or product families (if the item aggregation 
level is set to Product Family) are considered in planning. Bills of resource are lists 
which associate items or product families with individual resources and the 
processing times (usages) incurred on those resources for each item/product family.
(To define a bill of resource, use the Manufacturing and Distribution Manager 
responsibility. From the Navigator window, choose Capacity Planning > Bill of 
Resources > Bill of Resource.) The usages in a bill of resource may be automatically 
generated by summing the resource usages from the routings for an item and its 
components and subcomponents. A bill of resource may also be manually defined, 
allowing you to include only certain key resources and to manually adjust the 
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usage quantity for each key resource as necessary.

• When using the routing aggregation level bill of resources, Oracle ASCP generates 
resource requirements during planning only for those items or product families that
have defined bills of resources.

• When using the routing aggregation level bill of resources, operation sequencing 
information from the routings that are used to generate the bill of resources is lost. 
The bill of resources aggregation level is for use with the weekly and period buckets
for an approximate rough-cut capacity planning. When using bills of resources, 
constraint-based planning is not recommended because the resource sequencing 
and interdependence is not considered. Bill of resources aggregation is not 
compatible with routing aggregation in the same plan, and bill of resources 
aggregation is not available when scheduling in minutes and hours. 

The higher levels of resource aggregation (aggregate) and routing aggregation (BOR) 
both have the effect of limiting the number of resources considered in planning.

Resource and routing aggregation level have overlapping effects.

• If either the resource aggregation level is set to individual or the routing 
aggregation level is set to routing, all individual resources for items (if the item 
aggregation level is set to Item) or product families (if the item aggregation level is 
set to Product Family) are considered in planning.

To set the resource aggregation levels for a time horizon
1. From the Navigator, select Supply Chain Plan > Options.

The Plan Options window appears.

2. Choose the Constraints tab.

3. Enter the time horizon in days, weeks, or periods. 

You can specify different levels of aggregation in different time buckets so that 
detailed information is considered more frequently and less detailed information is 
considered less frequently. 

Resources can be scheduled either individually or in aggregate. Selecting individual 
resource scheduling generates schedules down to the individual resource level and 
considers the available capacity of each resource in the schedule recommendations. 

Selecting aggregate resource scheduling considers the overall capacity of all resources 
in a resource group required for an item. For example, the overall capacity of a 
department to which the individual resources are assigned are used. 

For more information, see Defining a Resource in Oracle Bills of Material User's Guide.
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Material Aggregation Levels
You can specify material aggregation levels for each of the three planning time 
horizons.

To set the material aggregation level for a time horizon
1. From the Navigator, select Supply Chain Plan > Options.

2. Choose the Constraints tab.

3. Enter the time horizon in days, weeks, or periods. 

You can specify different levels of aggregation in different time buckets so that 
detailed information is considered more frequently and less detailed information is 
considered less frequently. 

You can schedule the product at either the item level or the product family level.

Ensure items are correctly assigned to a product family and that a planning percent 
is specified when setting up your BOMs.

Routing Aggregation Levels
You can specify routing aggregation levels for each of the three planning time horizons.

To set the routing aggregation level for a time horizon
1. From the Navigator, select Supply Chain Plan > Options.

The Plan Options window appears.

2. Choose the Constraints tab.

3. Enter the time horizon in days, weeks, or periods. 

You can specify different levels of aggregation in different time buckets so that 
detailed information is considered more frequently and less detailed information is 
considered less frequently. 

Either routings or bills of resources can be selected for plans. For detailed 
scheduling in the minute, hour and daily buckets, routings are used. For long-range
simulations in the weekly and monthly buckets, routings or bills of resources can be
used. Note that routings and bills of resources cannot be used in the same plan. 

Selecting routing level aggregation will result in schedules that consider the 
capacity of each resource as well as the sequencing of the resources during the 
production of an item. Selecting bill of resource level aggregation will only consider
the resource requirements needed to produce an item without considering the 
sequencing and interdependence among the resources required for an item. 
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The bill of resources aggregation level is for use with the weekly and period buckets
for an approximate rough-cut capacity planning. When using bills of resources, 
constraint-based planning is not recommended because the resource sequencing 
and interdependence is not considered. Bill of resource aggregation is not 
compatible with routing aggregation in the same plan, and bill of resource 
aggregation is not available when scheduling in minutes and hours. 

Choosing an Objective Function
When generating plans via the Optimized option, Oracle ASCP lets you specify the 
objectives to be considered in generating planned orders across the supply chain.

All objectives are expressed in units of dollars.

This section describes each of the available objectives and how multiple objectives can 
be combined into a single objective function which captures trade-offs between 
competing objectives.

You can optimize your plans to the objectives shown in the following table.

Objective Function How is the Objective Achieved?

Maximize Inventory Turns Minimize inventory carrying cost

Maximize Plan Profit Maximize plan revenue minus plan cost

Maximize On-Time Delivery Minimize penalty cost for late demand

Inventory Turns
The inventory turns are maximized by minimizing inventory carrying cost. Inventory 
carrying cost is summed up for all items in all time buckets. Inventory carrying cost is 
calculated as follows:

Inventory carrying cost = (Average inventory per bucket) * (Carrying cost percent) * 
(Item cost)

Plan Profit Objective
Profit optimization occurs if you set profile option MSO: Cost Rollup for Optimization 
is No. Profit optimization should not use the internal cost rollup for optimization. That 
is used for making sure that costs of assemblies are more than the costs of components. 
It does not capture the true standard costs that profit optimization needs.

The planning engine optimizes subject to the plan constraints. The penalty factors, for 
example, demand lateness penalty, are the crucial part of this optimization. Based on 
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the size of the demand lateness penalty factor, the planning engine may decide to 
satisfy a demand late in order to increase the profit. 

Generally, the remainder of the planning process retains the optimized decisions. 
However, 

• If there are order modifiers, the planning engine may increase the size of some 
planned orders to satisfy the order modifier and eliminate planned orders no longer
needed

• If there are constraints, for example, resource capacity, the planning engine may 
reschedule some orders

Even if two supplies use the same resources and ingredients, the profit optimization 
process always schedules a supply pegged to a more profitable demand before a supply
pegged to a less profitable demand

If there are several main products in a formula, the profit optimization rollup uses the 
bill of material usage to calculate and allocate costs. For example, item C is component 
or ingredient of item A and item B. The rollup determines how many or how much item
C is required to make one item A and how many or how much item C is required to 
make one item B (or how much of ingredient C is used to produce one unit of A @ and 
one unit of B). The process translates percentages to bill of material usages to calculate 
the costs.

The profit optimization rollup calculates the cost of by-products using bill of material 
usage also.

To see the internal cost calculations, view file SCO_COST_<plan id>

The planning engine performs pegging by demand priority even in the case of profit 
optimization. It may override the profit optimization decision, for example:

• There are two demands: D1 for quantity 100 on Day 5 has higher priority and is less
profitable; D2 for quantity 100 on Day 5 has lower priority but is more profitable

• There are two supplies: S1 for quantity 100 on Day 6; S2 for quantity 100 on Day 7

• The profit optimization process recommends S1 > D2 and S2 > D1

• The pegging process overrides the profit optimization recommendations pegs S1 > 
D1 with higher priority and S2 > D2 with lower priority

The calculation for margin percentage objective is in Margin Percentage, page 12-70

On-time Delivery Objective
The on-time delivery objective is modeled as minimization of the penalty cost for late 
demand.

Penalty cost is calculated and summed up for all items with independent demand in all 
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time buckets.

• Penalty cost for late demand = (Penalty cost factor for late demand in $/unit/day * 
Days late * Quantity of late demand) + (Penalty cost factor for unmet demand in 
$/unit/day * Days late * Quantity of unmet demand)

Penalty cost sums two types of costs: late demand cost and unmet demand cost. An 
unmet demand is simply a very late demand. Specifically, it is a demand for which the 
plan generates supply that exceeds the demand due date by more than allowable days 
early/late. Allowable days early/late is a profile option.

Penalty cost factor for late demand is a plan option. Penalty cost factor for unmet 
demand is a system plan option, obtained by multiplying the penalty cost factor for late 
demand by a constant that is greater than 1. This makes unmet (very late) demands cost
more than late demands.

Implicit Objectives
In addition to the above objectives, which you can select/weight or deselect, Oracle 
ASCP maintains a set of implicit (hidden) objectives that it takes into consideration no 
matter what you select. These objectives are defined to be the negative of various 
penalty costs, as follows:

Implicit objectives =

• -(Penalty cost for late demand)

-(Penalty cost for resource capacity violation)

-(Penalty cost for transport capacity violation)

-(Penalty cost for material capacity violation)

-(Penalty cost for safety stock violation) 

-(Penalty cost for using alternate sources)

-(Penalty cost for using alternate routings)

-(Penalty cost for using alternate resources)

-(Penalty cost for using substitute items) 

-(Percentage of carrying cost)

Maximizing implicit objectives results in minimization of the penalty costs.

Penalty costs are the product of the penalty factor and some other parameter such as list
price, item cost, resource cost, or transportation cost. For example:

Penalty cost for late demand [$/unit/day] = (Penalty factor) * (List price)

You can set penalty factors at different levels using flexfields, plan options, or profile 
options. Flexfields let you set penalty factors at the most discrete level. For example, 
you can set the Penalty Factor for Late Demand at the Demand, Item, or Org level using
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flexfields. Plan options and profile options let you set the same penalty factor at the 
plan level and site level, respectively.

Combining Objectives
The planning engine combines the above objectives into the following objective 
function:

Overall objective = Maximize w1 * (Plan profit) + w2 * On-time delivery) + w3 * 
(Inventory turns) + 1.0 * (Implicit objectives)

Objective weights w1-w3 are restricted to the range 0 to 1. Setting an objective's weight 
to 0 directs Oracle ASCP not to consider that particular objective. Setting an objective's 
weight to 1 places the maximum possible emphasis on that objective. Objective weights 
w1-w3 may be set independently.

Objective weights w1-w3 in general do not precisely show the relative importance of 
each objective in planning decisions. As can be seen from the above definition of the 
overall objective, the percentage of the overall objective value occupied by a particular 
objective depends also on the dollar magnitude of the objective, and it is the product of 
the weight and the dollar magnitude of the objective which reflects the relative 
importance of each objective in planning decisions.

Take special note of interdependent objectives. Some costs are contained in more than 
one objective. For example, inventory carrying cost is a part of both the Plan Profit and 
Inventory Turns objectives. Therefore, only use these two objectives together if it is 
desired to artificially weight inventory carrying cost higher than the other costs (item 
cost, transportation cost) contained within plan profit.

A more subtle case is penalty cost for late demand, which appears both in the On-time 
Delivery objective and in the implicit objectives not seen by the user. Thus, no matter 
what the weight on-time delivery, the planning engine considers late demand cost in its
planning decision-making.

Factors Affecting Objectives
Implicit and explicit objectives are affected by several factors and rules. These tables 
show:

• The relationship of these objectives to costs, prices, priority rules, and sourcing 
ranks

• The minimum data requirements for optimized plans based on different objectives

Yes means the cost/factor affects the objective.
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Cost-Price/Objective
s

Inventory Turns On-time Delivery Plan Profit

Resource Cost No No Yes

Item Standard Cost Yes No Yes

Carrying Cost 
Percentage

Yes No Yes

Late Demand Penalty 
Factor

No Yes No

List Price and Selling 
Price

No Yes No

Transportation Cost No No Yes

Factor Penalty Cost
for Late 
Demand

Penalty Cost
for Resource
Capacity 
Violation

Penalty Cost
for 
Transport 
Capacity 
Violation

Penalty Cost
for Material 
Capacity 
Violation

Penalty Cost
for Safety 
Stock 
Violation

Resource 
Cost

No Yes No No No

Item 
Standard 
Cost

No No No Yes Yes

Carrying 
Cost 
Percentage

No No No No No

Exceeding 
Item Capacity
Penalty 
Factor

No No No Yes No
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Factor Penalty Cost
for Late 
Demand

Penalty Cost
for Resource
Capacity 
Violation

Penalty Cost
for 
Transport 
Capacity 
Violation

Penalty Cost
for Material 
Capacity 
Violation

Penalty Cost
for Safety 
Stock 
Violation

Exceeding 
Resource 
Capacity 
Penalty 
Factor

No Yes No No No

Exceeding 
Transport 
Capacity 
Penalty 
Factor

No No Yes No No

Late Demand
Penalty 
Factor

Yes No No No No

List Price and
Selling Price

Yes No No No No

Transportatio
n Cost

No No Yes No No

Factor Penalty Cost
for Using 
Alternate 
Sources

Penalty Cost
for Using 
Alternate 
Routings

Penalty Cost
for Using 
Alternate 
Resources

Penalty Cost
for Using 
Substitute 
Items

Implicit 
Carrying 
Cost

Resource 
Cost

Yes No Yes No No

Item 
Standard 
Cost

Yes Yes No Yes Yes

Carrying 
Cost 
Percentage

No No No No Yes
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Factor Penalty Cost
for Using 
Alternate 
Sources

Penalty Cost
for Using 
Alternate 
Routings

Penalty Cost
for Using 
Alternate 
Resources

Penalty Cost
for Using 
Substitute 
Items

Implicit 
Carrying 
Cost

Sourcing 
Rank

Yes No No No No

Substitute 
Item Priority

No No No Yes No

BOM/Routin
g Priority

No Yes No No No

Alternate 
Resource 
Priority

No No Yes No No

Computational Burden Considerations
At all levels of optimization except for unconstrained plan (see Choosing Plan Classes, 
page 5-31), Oracle ASCP performs some type of finite-capacity scheduling. This is 
computationally much more complex than the infinite-capacity planning performed in 
older versions. Therefore, formulating the planning problem so that it is less 
computationally intensive is worthwhile.

The computational burden of a planning problem increases with the number of 
scheduled resources, the number of items, and the number of demands.

Ways to decrease the number of resources include:

• Leave non-critical (non-constraint) resources out of routings. For example, an entire 
cell in a cellular manufacturing system might be modeled as a single resource 
instead of as a group of resources.

• Set planned resources to bottleneck resources and include only key constraint 
resources in the bottleneck resource group.

• Maximize the use of resource and routing aggregation (see Choosing Resource , 
page 5-139Aggregation Levels).

Ways to decrease the number of items include:

• Enable each item in as few organizations as possible because each combination of 
item-organization counts as a separate item.

• Maximize the use of item aggregation (to the product family level) in the plan 
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options.

• Set the Planned Items option in the Main tab of the Plan Options window to 
something other than All Planned Items. For example, set it to Demand Schedule 
Items Only.

Ways to decrease the number of demands include:

• Maximize the use of time aggregation (larger time buckets) in plan options. This 
collapses multiple demands occurring within a larger time bucket to a single 
demand at the end of the time bucket.

• Maintain long-term forecasts in larger time buckets (for example, weeks or periods) 
instead of shorter time buckets such as days. This reduces the number of MDS 
demands once the forecast is loaded into an MDS for input to the planning process.

Optimized Plans Data Requirements
The majority of the data required for optimized plans for different objectives are 
available in ERP systems. These data include:

• Item Standard Cost, List Price, Selling Price, Discount

• Carrying Cost Percent

• Resource Cost

• Transportation Cost

• Sourcing Rank

• Substitute Item Priority

• BOM/Routing Priority

• Alternate Resource Priority

The remaining data can be set up at the profile option level or plan level to expedite the 
implementation of optimized plans. These data include:

• Exceeding Item Capacity Penalty Factor

• Exceeding Resource Capacity Penalty Factor

• Exceeding Transport Capacity Penalty Factor

• Late Demand Penalty Factor

Oracle ASCP considers some default values for these fields, such as 0.01 for the 
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Standard Cost. The Optimization process cannot produce very valuable results based 
on these default values alone. It is recommended that you specify starting values for 
these fields at the profile option level at the start of implementation.

Optimization Effects on Sourcing
Oracle ASCP optimization does not consider allocation percentages specified in the 
sourcing rules and/or bills of distributions. Sourcing decisions are made based on 
capacity, item standard cost, and rank with respect to penalty costs and constraints.

Example 1: Enforce Capacity Constraints Scenario
Item A is sourced from organizations O1 and O2 with ranks equal to 1 and 2 
respectively. If the total costs (item plus penalty costs) are equal in both organizations, 
and capacity is available only in O2; then this organization is used as the source for item
A and ranking is overridden.

Example 2: Enforce Demand Due Dates Scenario
Item A is sourced from organizations O1 and O2 with ranks equal to 1 and 2 
respectively. If the total costs (item plus penalty costs) are equal for both organizations, 
Organization O1 with rank 1 is loaded (or overloaded) to source item A.

Example 3: Enforce Demand Due Dates Scenario 
Item A is sourced from organizations O1 and O2 with ranks equal to 1 and 2 
respectively. If the total cost (item plus penalty costs) in organization O1 is greater than 
organization O2, Organization O2 with rank 2 is loaded (or overloaded) to source item 
A and ranking is overridden.

Nervousness
Nervousness is the condition in which small changes in demand cause large changes in 
supply (planned order releases). In traditional MRP, plan nervousness causes lost time 
due to extra setups (and confusion and frustration) on the plant floor. With Oracle 
ASCP's ability to generate a single global supply chain plan, the effects of nervousness 
are magnified because they extend to trading partners (who may not have the same 
urgency to constantly replan manufacturing to accommodate rapidly changing 
requirements).

Consider the following example. End-item A has lead-time 1 day and order modifier of 
Fixed Order Period = 3 days. End-item A contains one component B, which has a 
lead-time of 3 days and order modifier Lot for Lot. Initial planned orders for A and B 
are shown in the next two tables.

Item A Current 1 2 3 4 5

Gross 
Requireme
nts

0 10 10 10 10 50
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Item A Current 1 2 3 4 5

Scheduled 
Receipts

0 0 0 0 0 0

Project 
On-Hand

15 5 -5 0 0 0

Net 
Requireme
nts

0 0 5 10 10 50

Planned 
Order Due 
Date

0 0 25 0 0 50

Planned 
Order Start
Date

0 25 0 0 50 0

Item B Current 1 2 3 4 5

Gross 
Requireme
nts

0 25 0 0 50 0

Scheduled 
Receipts

0 0 0 0 0 0

Project 
On-Hand

25 0 0 0 -50 0

Net 
Requireme
nts

0 0 0 0 50 0

Planned 
Order Due 
Date

0 0 0 0 50 0

Planned 
Order Start
Date

0 50 0 0 0 0
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Now suppose that the demand for A on day 2 decreases by 5 units. Revised planned 
orders are shown in the two tables below.

Item A Current 1 2 3 4 5

Gross 
Requireme
nts

0 0 70 0 0 0

Scheduled 
Receipts

0 0 0 0 0 0

Project 
On-Hand

25 25 -50 0 0 0

Net 
Requireme
nts

0 0 50 0 0 0

Planned 
Order Due 
Date

0 0 50 0 0 0

Planned 
Order Start
Date

0 50* 0 0 0 0

Item B Current 1 2 3 4 5

Gross 
Requireme
nts

0 10 5 10 10 50

Scheduled 
Receipts

0 0 0 0 0 0

Project 
On-Hand

15 5 0 -10 0 0

Net 
Requireme
nts

0 0 0 10 10 50
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Item B Current 1 2 3 4 5

Planned 
Order Due 
Date

0 0 0 70 0 0

Planned 
Order Start
Date

0 0 70 0 0 0

* Late Start

• Note that the decrease in demand caused the planned orders for A to change from 
25 on Day 1 and 50 on Day 4 to 70 on Day 3. This is an example of nervousness at 
work.

• Note further that the resulting change in dependent demand for B causes the 
planned orders for B to become infeasible, resulting in a late start - this after the 
demand for A decreased.

Several steps may be taken to reduce planning nervousness of the sort illustrated above.

• Eliminate the use of the order modifier Fixed Order Period for end items. Instead, 
use Fixed Lot Multiple or Fixed Order Quantity. Reserve Fixed Order Period for 
lowest-level items only.

• Make use of a planning time fence. A planning time fence of x days freezes planned 
orders in the interval [plan start date, plan start date + x]. This eliminates near-term 
disruptions to the manufacturing schedule.

• Make use of a release time fence. A release time fence of x days automatically firms 
and releases to the execution system planned orders in the time interval [plan start 
date, plan start date + x]. Subsequent planning runs then treat these planned orders 
as scheduled receipts, not subject to manipulation via order modifiers. This reduces 
planning nervousness.

Time fences can be used to freeze near-term plans and reduce nervousness. However, 
they also reduce the ability of the planning process to accommodate changes in 
demand. They should be set to the lowest values possible. 

Controlling Planned Items
There are three interdependent ways of controlling which items are planned in and 
which are excluded from an ASCP plan:

1. Setting the Planning Method item attribute in conjunction with selecting the Plan 
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Type in the Supply Chain Plan Names form

• The Planning Method item attribute can be set to:

• Not planned

• MPS planning

• MRP planning

• MRP/MPP Planned

• MPS/MPP Planned

• MPP Planned

• Plan Type can be set to:

• Manufacturing Plan

• Production Plan

• Master Plan

2. Setting critical items in conjunction with setting the Include Critical Components 
flag in ASCP plan options

An item can be set to be critical in two ways:

• Explicitly, by checking its Critical Component item attribute

• Implicitly, by having a routing (primary or alternate) that includes a resource in
the ASCP plan's bottleneck resource group

3. Setting the value for the Planned Items plan option, along with setting the 
organization-level Include Sales Order flag in the Organizations tab of the Plan 
Options form. Valid values for the Planned Items plan option are:

• All planned items

• Demand schedule items only

• Supply schedule items only

• Demand & Supply schedule items

• Demand schedule and WIP components

• Demand schedule items and all sales orders
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• Demand schedule items/WIP components/all sales orders

The following tables shows the items planned based on the Planned Items Plan Option, 
Plan Type, Planning Method Item Attribute, Include Critical Component Plan Option, 
Critical Component Item Attribute, and Include Sales Order Plan Option:

Planned Items 
Plan Option

Plan Type Include 
Critical 
Component
s Plan 
Option

Planned Items

All Planned 
Items

Manufactu
ring Plan

Unchecked All items in the planned organizations except 
ones having MRP planning code of Not 
Planned.

All Planned 
Items

Manufactu
ring Plan

Checked 1. All critical items.

2. Any assembly that has a critical item 
anywhere in its supply chain bill.

3. All items sandwiched between 1 and 2.

Note: If the primary component is critical 
then ASCP also selects the non-critical 
substitute components. 

If the primary component is not critical then 
ASCP does not select the substitute 
components even if these substitutes are 
critical. 

This behavior is applicable for all variations 
of Plan Type and Planned Items plan option.

All Planned 
Items

Production 
Plan

Unchecked 1. Items with Planning Method of MPS 
Planning or MPS/MPP Planned.

2. Any assembly that has an item with 
Planning Method of MPS Planning or 
MPS/MPP Planned anywhere in its 
supply chain bill.

3. All items sandwiched between 1 and 2.
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All Planned 
Items

Production 
Plan

Checked 1. Items with Planning Method of MPS 
Planning or MPS/MPP Planned.

2. Any assembly that has an item with 
Planning Method of MPS Planning or 
MPS/MPP Planned anywhere in its 
supply chain bill

3. All items sandwiched between 1 and 2.

4. All critical items.

5. Any assembly that has a critical item 
anywhere in its supply chain bill.

6. All items sandwiched between 4 and 5.

All Planned 
Items

Master 
Plan

Unchecked 1. Items with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned.

2. Any assembly that has an item with 
Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned anywhere in its supply chain bill.

3. All items sandwiched between 1 and 2.
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All Planned 
Items

Master 
Plan

Checked 1. Items with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned.

2. Any assembly that has an item with 
Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned anywhere in its supply chain bill.

3. All items sandwiched between 1 and 2.

4. All critical items.

5. Any assembly that has a critical item 
anywhere in its supply chain bill.

6. All items sandwiched between 4 and 5.

Demand 
schedule items 
only

Manufactu
ring Plan

Unchecked 1. All items contained within demand 
schedules that are specified as input to 
the plan (Forecast, MDS, DP Scenario).

2. All components and subcomponents of 1.

Note: In this option (Demand schedule 
items only) ASCP does not include sales 
orders for those item/organizations that are
not in the demand schedule even if the 
Include Sales Order checkbox is checked 
for the related organizations.

Demand 
schedule items 
only

Manufactu
ring Plan

Checked 1. All items contained within demand 
schedules that are specified as input to 
the plan (Forecast, MDS, DP Scenario).

2. Only critical components and 
subcomponents of 1.

3. All items sandwiched between 1 and 2.
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Demand 
schedule items 
only

Production 
Plan

Unchecked 1. Items with Planning Method of MPS 
Planning or MPS/MPP Planned contained
within demand schedules that are 
specified as input to the plan (Forecast, 
MDS, DP Scenario).

2. All components and subcomponents of 1 
with Planning Method of MPS Planning 
or MPS/MPP Planned.

3. Any assembly that has an item with 
Planning Method of MPS Planning or 
MPS/MPP Planned anywhere in its 
supply chain bill and contained within 
demand schedules.

4. All items sandwiched between 1 and 3.

Demand 
schedule items 
only

Production 
Plan

Checked 1. Items with Planning Method of MPS 
Planning or MPS/MPP Planned contained
within demand schedules that are 
specified as input to the plan (Forecast, 
MDS, DP Scenario).

2. All components and subcomponents of 1 
with Planning Method of MPS Planning 
or MPS/MPP Planned.

3. Any assembly that has an item with 
Planning Method of MPS Planning or 
MPS/MPP Planned anywhere in its 
supply chain bill and contained within 
demand schedules.

4. All items sandwiched between 1 and 3.

5. All critical components of 1.

6. All items sandwiched between 1 and 5
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Demand 
schedule items 
only

Master 
Plan

Unchecked 1. Items with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned contained within 
demand schedules that are specified as 
input to the plan (Forecast, MDS, DP 
Scenario).

2. All components and subcomponents of 1 
with Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned.

3. Any assembly that has an item with 
Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned anywhere in its supply chain bill 
and contained within demand schedules.

4. All items sandwiched between 1 and 3.

Demand 
schedule items 
only

Master 
Plan

Checked 1. Items with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned contained within 
demand schedules that are specified as 
input to the plan (Forecast, MDS, DP 
Scenario).

2. All components and subcomponents of 1 
with Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned.

3. Any assembly that has an item with 
Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned anywhere in its supply chain bill 
and contained within demand schedules.

4. All items sandwiched between 1 and 3. 

5. All critical components of 1.

6. All items sandwiched between 1 and 5.



5-160    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Supply schedule 
items only

Manufactu
ring Plan

Unchecked 1. All items contained within supply 
schedules that are specified as input to 
the plan.

2. All components and subcomponents of 1.

Note: In this option (Supply schedule 
items only) ASCP does not include sales 
orders for those item/organizations that are
not in the supply schedule even if the 
Include Sales Order checkbox is checked 
for the related organizations.

Supply schedule 
items only

Manufactu
ring Plan

Checked 1. All items contained within supply 
schedules that are specified as input to 
the plan.

2. Only critical components and 
subcomponents of 1.

3. All items sandwiched between 1 and 2.

Supply schedule 
items only

Production 
Plan

Unchecked 1. Items with Planning Method of MPS 
Planning or MPS/MPP Planned contained
within supply schedules that are specified
as input to the plan.

2. All components and subcomponents of 1 
with Planning Method of MPS Planning 
or MPS/MPP Planned.

3. Any assembly that has an item with 
Planning Method of MPS Planning or 
MPS/MPP Planned anywhere in its 
supply chain bill and contained within 
supply schedules.

4. All items sandwiched between 1 and 3.
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Supply schedule 
items only

Production 
Plan

Checked 1. Items with Planning Method of MPS 
Planning or MPS/MPP Planned contained
within supply schedules that are specified
as input to the plan.

2. All components and subcomponents of 1 
with Planning Method of MPS Planning 
or MPS/MPP Planned.

3. Any assembly that has an item with 
Planning Method of MPS Planning or 
MPS/MPP Planned anywhere in its 
supply chain bill and contained within 
supply schedules.

4. All items sandwiched between 1 and 3.

5. All critical components of 1.

6. All items sandwiched between 1 and 5.

Supply schedule 
items only

Master 
Plan

Unchecked 1. Items with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned contained within 
supply schedules that are specified as 
input to the plan.

2. All components and subcomponents of 1 
with Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned.

3. Any assembly that has an item with 
Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned anywhere in its supply chain bill 
and contained within supply schedules. 

4. All items sandwiched between 1 and 3.
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Supply schedule 
items only

Master 
Plan

Checked 1. Items with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned contained within 
supply schedules that are specified as 
input to the plan.

2. All components and subcomponents of 1 
with Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned.

3. Any assembly that has an item with 
Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned anywhere in its supply chain bill 
and contained within supply schedules. 

4. All items sandwiched between 1 and 3.

5. All critical components of 1.

6. All items sandwiched between 1 and 5.

Demand & 
Supply schedule 
items

Manufactu
ring Plan

Unchecked 1. All items contained within demand or 
supply schedules that are specified as 
input to the plan.

2. All components and subcomponents of 1.

Note: In this option (Demand & Supply 
schedule items) ASCP does not include 
sales orders for those item/organizations 
that are not in the demand or supply 
schedules even if the Include Sales Order 
checkbox is checked for the related 
organizations.
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Demand & 
Supply schedule 
items

Manufactu
ring Plan

Checked 1. All items contained within demand or 
supply schedules that are specified as 
input to the plan.

2. Only critical components and 
subcomponents of 1.

3. All items sandwiched between 1 and 2.

Demand & 
Supply schedule 
items

Production 
Plan

Unchecked 1. Items with Planning Method of MPS 
Planning or MPS/MPP Planned contained
within demand or supply schedules that 
are specified as input to the plan.

2. All components and subcomponents of 1 
with Planning Method of MPS Planning 
or MPS/MPP Planned.

3. Any assembly that has an item with 
Planning Method of MPS Planning or 
MPS/MPP Planned anywhere in its 
supply chain bill and contained within 
demand or supply schedules.

4. All items sandwiched between 1 and 3.
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Demand & 
Supply schedule 
items

Production 
Plan

Checked 1. Items with Planning Method of MPS 
Planning or MPS/MPP Planned contained
within demand or supply schedules that 
are specified as input to the plan.

2. All components and subcomponents of 1 
with Planning Method of MPS Planning 
or MPS/MPP Planned.

3. Any assembly that has an item with 
Planning Method of MPS Planning or 
MPS/MPP Planned anywhere in its 
supply chain bill and contained within 
demand or supply schedules.

4. All items sandwiched between 1 and 3.

5. All critical components of 1.

6. All items sandwiched between 1 and 5.

Demand & 
Supply schedule 
items

Master 
Plan

Unchecked 1. Items with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned contained within 
demand or supply schedules that are 
specified as input to the plan.

2. All components and subcomponents of 1 
with Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned.

3. Any assembly that has an item with 
Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned anywhere in its supply chain bill 
and contained within demand or supply 
schedules.

4. All items sandwiched between 1 and 3.
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Demand & 
Supply schedule 
items

Master 
Plan

Checked 1. Items with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned contained within 
demand or supply schedules that are 
specified as input to the plan.

2. All components and subcomponents of 1 
with Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned.

3. Any assembly that has an item with 
Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned anywhere in its supply chain bill 
and contained within demand or supply 
schedules.

4. All items sandwiched between 1 and 3.

5. All critical components of 1.

6. All items sandwiched between 1 and 3.

Demand 
schedule and 
WIP Components

Manufactu
ring Plan

Unchecked 1. All items contained within demand 
schedules that are specified as input to 
the plan (Forecast, MDS, DP Scenario).

2. All components and subcomponents of 1.

3. All WIP components used in existing 
work orders (discrete job, lot-based job, 
process batch).

Note: In this option (Demand schedule 
and WIP Components) ASCP does not 
include sales orders for those 
item/organizations that are not in the 
demand schedule even if the Include Sales 
Order checkbox is checked for the related 
organizations.
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Demand 
schedule and 
WIP Components

Manufactu
ring Plan

Checked 1. All items contained within demand 
schedules that are specified as input to 
the plan (Forecast, MDS, DP Scenario).

2. Only critical components and 
subcomponents of 1.

3. All items sandwiched between 1 and 2.

4. All critical WIP components used in 
existing work orders (discrete job, 
lot-based job, process batch) .

Demand 
schedule and 
WIP Components

Production 
Plan

Unchecked 1. Items with Planning Method of MPS 
Planning or MPS/MPP Planned contained
within demand schedules that are 
specified as input to the plan (Forecast, 
MDS, DP Scenario).

2. All components and subcomponents of 1 
with Planning Method of MPS Planning 
or MPS/MPP Planned.

3. Any assembly that has an item with 
Planning Method of MPS Planning or 
MPS/MPP Planned anywhere in its 
supply chain bill and contained within 
demand schedules.

4. All items sandwiched between 1 and 3.

5. All WIP components with Planning 
Method of MPS Planning or MPS/MPP 
Planned used in existing work orders 
(discrete job, lot-based job, process batch).
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Demand 
schedule and 
WIP Components

Production 
Plan

Checked 1. Items with Planning Method of MPS 
Planning or MPS/MPP Planned contained
within demand schedules that are 
specified as input to the plan (Forecast, 
MDS, DP Scenario).

2. All components and subcomponents of 1 
with Planning Method of MPS Planning 
or MPS/MPP Planned.

3. Any assembly that has an item with 
Planning Method of MPS Planning or 
MPS/MPP Planned anywhere in its 
supply chain bill and contained within 
demand schedules.

4. All items sandwiched between 1 and 3.

5. All critical components of 1.

6. All items sandwiched between 1 and 5.

7. All critical WIP components with 
Planning Method of MPS Planning or 
MPS/MPP Planned used in existing work 
orders (discrete job, lot-based job, process
batch).
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Demand 
schedule and 
WIP Components

Master 
Plan

Unchecked 1. Items with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned contained within 
demand schedules that are specified as 
input to the plan (Forecast, MDS, DP 
Scenario).

2. All components and subcomponents of 1 
with Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned.

3. Any assembly that has an item with 
Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned anywhere in its supply chain bill 
and contained within demand schedules.

4. All items sandwiched between 1 and 3.

5. All WIP components with Planning 
Method of MPP Planned, MPS/MPP 
Planned, or MRP/MPP Planned used in 
existing work orders (discrete job, 
lot-based job, process batch).
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Demand 
schedule and 
WIP Components

Master 
Plan

Checked 1. Items with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned contained within 
demand schedules that are specified as 
input to the plan (Forecast, MDS, DP 
Scenario).

2. All components and subcomponents of 1 
with Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned.

3. Any assembly that has an item with 
Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned anywhere in its supply chain bill 
and contained within demand schedules.

4. All items sandwiched between 1 and 3.

5. All critical components of 1.

6. All items sandwiched between 1 and 5.

7. All critical WIP components with 
Planning Method of MPP Planned, 
MPS/MPP Planned, or MRP/MPP 
Planned used in existing work orders 
(discrete job, lot-based job, process batch).

Planned Items 
Plan Option

Plan Type Include 
Critical 
Compon
ents 
Plan 
Option

Include 
Sales 
Order 
Plan 
Option 
(organiz
ation 
specific)

Planned Items



5-170    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Demand 
schedule items 
and all sales 
orders

Manufactu
ring Plan

Uncheck
ed

Uncheck
ed

1. All items contained within 
demand schedules that are 
specified as input to the plan 
(Forecast, MDS, DP Scenario).

2. All items with sales orders.

3. All components and 
subcomponents of 1 and 2.

Note: Sales order demands are 
ignored and not seen in the plan.

Demand 
schedule items 
and all sales 
orders

Manufactu
ring Plan

Uncheck
ed

Checked 1. All items contained within 
demand schedules that are 
specified as input to the plan 
(Forecast, MDS, DP Scenario).

2. All items with sales orders.

3. All components and 
subcomponents of 1 and 2.

Note: Sales order demands are 
planned.

Demand 
schedule items 
and all sales 
orders

Manufactu
ring Plan

Checked Uncheck
ed

1. All items contained within 
demand schedules that are 
specified as input to the plan 
(Forecast, MDS, DP Scenario).

2. All items with sales orders.

3. Only critical components and 
subcomponents of 1 and 2.

4. All items sandwiched between 1 
and 3 as well as 2 and 3.

Note: Sales order demands are 
ignored and not seen in the plan.
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Demand 
schedule items 
and all sales 
orders

Manufactu
ring Plan

Checked Checked 1. All items contained within 
demand schedules that are 
specified as input to the plan 
(Forecast, MDS, DP Scenario).

2. All items with sales orders.

3. Only critical components and 
subcomponents of 1 and 2.

4. All items sandwiched between 1 
and 3 as well as 2 and 3.

Note: Sales order demands are 
planned.

Demand 
schedule items 
and all sales 
orders

Production
Plan

Uncheck
ed

Uncheck
ed

1. Items with Planning Method of 
MPS Planning or MPS/MPP 
Planned contained within 
demand schedules that are 
specified as input to the plan 
(Forecast, MDS, DP Scenario).

2. All components and 
subcomponents of 1 with 
Planning Method of MPS 
Planning or MPS/MPP Planned.

3. Any assembly that has an item 
with Planning Method of MPS 
Planning or MPS/MPP Planned 
anywhere in its supply chain bill 
and contained within demand 
schedules.

4. All items sandwiched between 1 
and 3.

Note: Sales order demands are 
ignored and not seen in the plan.
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Demand 
schedule items 
and all sales 
orders

Production
Plan

Uncheck
ed

Checked 1. Items with Planning Method of 
MPS Planning or MPS/MPP 
Planned contained within 
demand schedules that are 
specified as input to the plan 
(Forecast, MDS, DP Scenario).

2. All components and 
subcomponents of 1 with 
Planning Method of MPS 
Planning or MPS/MPP Planned.

3. Any assembly that has an item 
with Planning Method of MPS 
Planning or MPS/MPP Planned 
anywhere in its supply chain bill 
and contained within demand 
schedules.

4. All items sandwiched between 1 
and 3.

Note: Sales order demands are 
planned.
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Demand 
schedule items 
and all sales 
orders

Production
Plan

Checked Uncheck
ed

1. Items with Planning Method of 
MPS Planning or MPS/MPP 
Planned contained within 
demand schedules that are 
specified as input to the plan 
(Forecast, MDS, DP Scenario).

2. All components and 
subcomponents of 1 with 
Planning Method of MPS 
Planning or MPS/MPP Planned.

3. Any assembly that has an item 
with Planning Method of MPS 
Planning or MPS/MPP Planned 
anywhere in its supply chain bill 
and contained within demand 
schedules. 

4. All items sandwiched between 1 
and 3.

5. All critical components of 1.

6. All items sandwiched between 1 
and 5.

Note: Sales order demands are 
ignored and not seen in the plan.
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Demand 
schedule items 
and all sales 
orders

Production
Plan

Checked Checked 1. Items with Planning Method of 
MPS Planning or MPS/MPP 
Planned contained within 
demand schedules that are 
specified as input to the plan 
(Forecast, MDS, DP Scenario).

2. All components and 
subcomponents of 1 with 
Planning Method of MPS 
Planning or MPS/MPP Planned.

3. Any assembly that has an item 
with Planning Method of MPS 
Planning or MPS/MPP Planned 
anywhere in its supply chain bill 
and contained within demand 
schedules. 

4. All items sandwiched between 1 
and 3.

5. All critical components of 1.

6. All items sandwiched between 1 
and 5.

Note: Sales order demands are 
planned.
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Demand 
schedule items 
and all sales 
orders

Master 
Plan

Uncheck
ed

Uncheck
ed

1. Items with Planning Method of 
MPP Planned, MPS/MPP 
Planned, or MRP/MPP Planned 
contained within demand 
schedules that are specified as 
input to the plan (Forecast, MDS,
DP Scenario).

2. All components and 
subcomponents of 1 with 
Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned.

3. Any assembly that has an item 
with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned anywhere in 
its supply chain bill and 
contained within demand 
schedules.

4. All items sandwiched between 1 
and 3.

Note: Sales order demands are 
ignored and not seen in the plan. 
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Demand 
schedule items 
and all sales 
orders

Master 
Plan

Uncheck
ed

Checked 1. Items with Planning Method of 
MPP Planned, MPS/MPP 
Planned, or MRP/MPP Planned 
contained within demand 
schedules that are specified as 
input to the plan (Forecast, MDS,
DP Scenario).

2. All components and 
subcomponents of 1 with 
Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned.

3. Any assembly that has an item 
with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned anywhere in 
its supply chain bill and 
contained within demand 
schedules.

4. All items sandwiched between 1 
and 3.

Note: Sales order demands are 
planned. 
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Demand 
schedule items 
and all sales 
orders

Master 
Plan

Checked Uncheck
ed

1. Items with Planning Method of 
MPP Planned, MPS/MPP 
Planned, or MRP/MPP Planned 
contained within demand 
schedules that are specified as 
input to the plan (Forecast, MDS,
DP Scenario).

2. All components and 
subcomponents of 1 with 
Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned.

3. Any assembly that has an item 
with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned anywhere in 
its supply chain bill and 
contained within demand 
schedules.

4. All items sandwiched between 1 
and 3.

5. All critical components of 1.

6. All items sandwiched between 1 
and 5.

Note: Sales order demands are 
ignored and not seen in the plan.
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Demand 
schedule items 
and all sales 
orders

Master 
Plan

Checked Checked 1. Items with Planning Method of 
MPP Planned, MPS/MPP 
Planned, or MRP/MPP Planned 
contained within demand 
schedules that are specified as 
input to the plan (Forecast, MDS,
DP Scenario).

2. All components and 
subcomponents of 1 with 
Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned.

3. Any assembly that has an item 
with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned anywhere in 
its supply chain bill and 
contained within demand 
schedules.

4. All items sandwiched between 1 
and 3. 

5. All critical components of 1.

6. All items sandwiched between 1 
and 5.

Note: Sales order demands are 
planned.
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Demand 
schedule items / 
WIP components 
/ all sales orders

Manufactu
ring Plan

Uncheck
ed

Uncheck
ed

1. All items contained within 
demand schedules that are 
specified as input to the plan 
(Forecast, MDS, DP Scenario).

2. All items with sales orders.

3. All components and 
subcomponents of 1 and 2.

4. All WIP components used in 
existing work orders (discrete 
job, lot-based job, process batch).

Note: Sales order demands are 
ignored and not seen in the plan.

Demand 
schedule items / 
WIP components 
/ all sales orders

Manufactu
ring Plan

Uncheck
ed

Checked 1. All items contained within 
demand schedules that are 
specified as input to the plan 
(Forecast, MDS, DP Scenario).

2. All items with sales orders.

3. All components and 
subcomponents of 1 and 2.

4. All WIP components used in 
existing work orders (discrete 
job, lot-based job, process batch).

Note: Sales order demands are 
planned.
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Demand 
schedule items / 
WIP components 
/ all sales orders

Manufactu
ring Plan

Checked Uncheck
ed

1. All items contained within 
demand schedules that are 
specified as input to the plan 
(Forecast, MDS, DP Scenario).

2. All items with sales orders.

3. Only critical components and 
subcomponents of 1 and 2.

4. All items sandwiched between 1 
and 3 as well as 2 and 3.

5. All critical WIP components used
in existing work orders (discrete 
job, lot-based job, process batch).

Note: Sales order demands are 
ignored and not seen in the plan.

Demand 
schedule items / 
WIP components 
/ all sales orders

Manufactu
ring Plan

Checked Checked 1. All items contained within 
demand schedules that are 
specified as input to the plan 
(Forecast, MDS, DP Scenario).

2. All items with sales orders.

3. Only critical components and 
subcomponents of 1 and 2.

4. All items sandwiched between 1 
and 3 as well as 2 and 3.

5. All critical WIP components used
in existing work orders (discrete 
job, lot-based job, process batch).

Note: Sales order demands are 
planned.
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Demand 
schedule items / 
WIP components 
/ all sales orders

Production
Plan

Uncheck
ed

Uncheck
ed

1. Items with Planning Method of 
MPS Planning or MPS/MPP 
Planned contained within 
demand schedules that are 
specified as input to the plan 
(Forecast, MDS, DP Scenario).

2. All items with Planning Method 
of MPS Planning or MPS/MPP 
Planned and with sales orders.

3. All components and 
subcomponents of 1 and 2 with 
Planning Method of MPS 
Planning or MPS/MPP Planned.

4. Any assembly that has an item 
with Planning Method of MPS 
Planning or MPS/MPP Planned 
anywhere in its supply chain bill 
and contained within demand 
schedules.

5. All items sandwiched between 1 
and 3 as well as 2 and 3.

6. All items sandwiched between 1 
and 4 as well as 2 and 4.

7. All WIP components with 
Planning Method of MPS 
Planning or MPS/MPP Planned 
used in existing work orders 
(discrete job, lot-based job, 
process batch)

Note: Sales order demands are 
ignored and not seen in the plan.
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Demand 
schedule items / 
WIP components 
/ all sales orders

Production
Plan

Uncheck
ed

Checked 1. Items with Planning Method of 
MPS Planning or MPS/MPP 
Planned contained within 
demand schedules that are 
specified as input to the plan 
(Forecast, MDS, DP Scenario).

2. All items with Planning Method 
of MPS Planning or MPS/MPP 
Planned and with sales orders.

3. All components and 
subcomponents of 1 and 2 with 
Planning Method of MPS 
Planning or MPS/MPP Planned.

4. Any assembly that has an item 
with Planning Method of MPS 
Planning or MPS/MPP Planned 
anywhere in its supply chain bill 
and contained within demand 
schedules.

5. All items sandwiched between 1 
and 3 as well as 2 and 3.

6. All items sandwiched between 1 
and 4 as well as 2 and 4.

7. All WIP components with 
Planning Method of MPS 
Planning or MPS/MPP Planned 
used in existing work orders 
(discrete job, lot-based job, 
process batch).

Note: Sales order demands are 
planned.
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Demand 
schedule items / 
WIP components 
/ all sales orders

Production
Plan

Checked Uncheck
ed

1. Items with Planning Method of 
MPS Planning or MPS/MPP 
Planned contained within 
demand schedules that are 
specified as input to the plan 
(Forecast, MDS, DP Scenario).

2. All items with Planning Method 
of MPS Planning or MPS/MPP 
Planned and with sales orders.

3. All components and 
subcomponents of and 2 with 
Planning Method of MPS 
Planning or MPS/MPP Planned.

4. Any assembly that has an item 
with Planning Method of MPS 
Planning or MPS/MPP Planned 
anywhere in its supply chain bill 
and contained within demand 
schedules.

5. All items sandwiched between 1 
and 3 as well as 2 and 3.

6. All items sandwiched between 1 
and 4 as well as 2 and 4.

7. All critical components of 1.

8. All items sandwiched between 1 
and 7.

9. All critical WIP components with
Planning Method of MPS 
Planning or MPS/MPP Planned 
used in existing work orders 
(discrete job, lot-based job, 
process batch).

Note: Sales order demands are 
ignored and not seen in the plan.
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Demand 
schedule items / 
WIP components 
/ all sales orders

Production
Plan

Checked Checked 1. Items with Planning Method of 
MPS Planning or MPS/MPP 
Planned contained within 
demand schedules that are 
specified as input to the plan 
(Forecast, MDS, DP Scenario).

2. All items with Planning Method 
of MPS Planning or MPS/MPP 
Planned and with sales orders.

3. All components and 
subcomponents of and 2 with 
Planning Method of MPS 
Planning or MPS/MPP Planned.

4. Any assembly that has an item 
with Planning Method of MPS 
Planning or MPS/MPP Planned 
anywhere in its supply chain bill 
and contained within demand 
schedules.

5. All items sandwiched between 1 
and 3 as well as 2 and 3.

6. All items sandwiched between 1 
and 4 as well as 2 and 4.

7. All critical components of 1.

8. All items sandwiched between 1 
and 7.

9. All critical WIP components with
Planning Method of MPS 
Planning or MPS/MPP Planned 
used in existing work orders 
(discrete job, lot-based job, 
process batch).

Note: Sales order demands are 
planned.
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Demand 
schedule items / 
WIP components 
/ all sales orders

Master 
Plan

Uncheck
ed

Uncheck
ed

1. Items with Planning Method of 
MPP Planned, MPS/MPP 
Planned, or MRP/MPP Planned 
contained within demand 
schedules that are specified as 
input to the plan (Forecast, MDS,
DP Scenario).

2. All items with Planning Method 
of MPP Planned, MPS/MPP 
Planned, or MRP/MPP Planned 
and with sales orders.

3. All components and 
subcomponents of 1 and 2 with 
Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned.

4. Any assembly that has an item 
with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned anywhere in 
its supply chain bill and 
contained within demand 
schedules.

5. All items sandwiched between 1 
and 3 as well as 2 and 3.

6. All items sandwiched between 1 
and 4 as well as 2 and 4.

7. All WIP components with 
Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned used in 
existing work orders (discrete 
job, lot-based job, process batch).

Note: Sales order demands are 
ignored and not seen in the plan.
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Demand 
schedule items / 
WIP components 
/ all sales orders

Master 
Plan

Uncheck
ed

Checked 1. Items with Planning Method of 
MPP Planned, MPS/MPP 
Planned, or MRP/MPP Planned 
contained within demand 
schedules that are specified as 
input to the plan (Forecast, MDS,
DP Scenario).

2. All items with Planning Method 
of MPP Planned, MPS/MPP 
Planned, or MRP/MPP Planned 
and with sales orders.

3. All components and 
subcomponents of 1 and 2 with 
Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned.

4. Any assembly that has an item 
with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned anywhere in 
its supply chain bill and 
contained within demand 
schedules.

5. All items sandwiched between 1 
and 3 as well as 2 and 3.

6. All items sandwiched between a 
and d as well as 2 and 4.

7. All WIP components with 
Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned used in 
existing work orders (discrete 
job, lot-based job, process batch).

Note: Sales order demands are 
planned.
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Demand 
schedule items / 
WIP components 
/ all sales orders

Master 
Plan

Checked Uncheck
ed

1. Items with Planning Method of 
MPP Planned, MPS/MPP 
Planned, or MRP/MPP Planned 
contained within demand 
schedules that are specified as 
input to the plan (Forecast, MDS,
DP Scenario).

2. All items with Planning Method 
of MPP Planned, MPS/MPP 
Planned, or MRP/MPP Planned 
and with sales orders.

3. All components and 
subcomponents of 1 and 2 with 
Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned.

4. Any assembly that has an item 
with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned anywhere in 
its supply chain bill and 
contained within demand 
schedules.

5. All items sandwiched between 1 
and 3 as well as 2 and 3.

6. All items sandwiched between 1 
and 4 as well as 2 and 4.

7. All critical components of 1.

8. All items sandwiched between 1 
and 7.

9. All critical WIP components with
Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned used in 
existing work orders (discrete 
job, lot-based job, process batch) .
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Note: Sales order demands are 
ignored and not seen in the plan.
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Demand 
schedule items / 
WIP components 
/ all sales orders

Master 
Plan

Checked Checked 1. Items with Planning Method of 
MPP Planned, MPS/MPP 
Planned, or MRP/MPP Planned 
contained within demand 
schedules that are specified as 
input to the plan (Forecast, MDS,
DP Scenario).

2. All items with Planning Method 
of MPP Planned, MPS/MPP 
Planned, or MRP/MPP Planned 
and with sales orders.

3. All components and 
subcomponents of 1 and 2 with 
Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned.

4. Any assembly that has an item 
with Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned anywhere in 
its supply chain bill and 
contained within demand 
schedules.

5. All items sandwiched between 1 
and 3 as well as 2 and 3.

6. All items sandwiched between 1 
and 4 as well as 2 and 4.

7. All critical components of 1.

8. All items sandwiched between 1 
and 7.

9. All critical WIP components with
Planning Method of MPP 
Planned, MPS/MPP Planned, or 
MRP/MPP Planned used in 
existing work orders (discrete 
job, lot-based job, process batch).
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Note: Sales order demands are 
planned.

Example
Consider items A and B with the following bills of materials and demands at 
organizations M1 and M2:

In the Organizations tab of the Plan Options form, the Include Sales Order flag is set as 
follows for M1 and M2:

Organization Include Sales Order

M1 Yes

M2 No

Item A has demand schedules and sales orders for both organizations M1 and M2. Item 
B has only sales orders in organizations M1 and M2.

The following table shows what items are planned in a Manufacturing Plan. It 
references some scenarios.

Scenario 1 - Demand schedule items only and Include Critical Component is not 
checked

In this case ASCP plans item A with demand schedules in organizations M1 and M2. 
All components of item A (A1, A2, A3, A4) are also planned in both organizations. Item 
B with only sales orders in organizations M1 and M2 is not planned.

Sales order demands of item A for organization M1 are planned. Sales order demands 
of item A for organization M2 are ignored because the Include Sales Order flag for 
organization M2 is unchecked.

Scenario 2 - Demand schedule items only and Include Critical Component is checked

In this case ASCP plans item A with demand schedules in organizations M1 and M2. 
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Only critical components of item A (A1, A3) and sandwiched item A2 are planned in 
both organizations. Item B with only sales orders in organizations M1 and M2 is not 
planned.

Sales order demands of item A for organization M1 are planned. Sales order demands 
of item A for organization M2 are ignored because the Include Sales Order flag for 
organization M2 is unchecked.

Scenario 3 - Demand schedule items and all sales orders and Include Critical 
Component is not checked

In this case ASCP plans item A with demand schedules in organizations M1 and M2. 
All components of item A (A1, A2, A3, A4) are also planned in both organizations. In 
addition item B with sales orders in organizations M1 and M2 is planned. All 
components of item B (A1, A2, A3, A4) are also planned in both organizations.

Sales order demands of items A and B for organization M1 are planned. Sales order 
demands of items A and B for organization M2 are ignored because the Include Sales 
Order flag for organization M2 is unchecked.

Scenario 4 - Demand schedule items and all sales orders and Include Critical 
Component is checked

In this case ASCP plans item A with demand schedules in organizations M1 and M2. 
Only critical components of item A (A1, A3) and sandwiched item A2 are planned in 
both organizations. In addition item B with sales orders in organizations M1 and M2 is 
planned. Only critical component of item B (B3) and sandwiched item B2 are planned in
both organizations.

Sales order demands of items A and B for organization M1 are planned. Sales order 
demands of items A and B for organization M2 are ignored because the Include Sales 
Order flag for organization M2 is unchecked.

Ite
m

Organi
zation

Planned Items 
with Demand 
schedule items 
only and Include
Critical 
Component 
Option Set to No
(Scenario 1)

Planned Items 
with Demand 
schedule items 
only and Include 
Critical 
Component Set 
to Yes (Scenario 
2)

Planned Items 
with Demand 
schedule items 
and all sales 
orders and 
Include Critical 
Component Set 
to No (Scenario 
3)

Planned Items 
with Demand 
schedule items 
and all sales 
orders and 
Include Critical 
Component Set 
to Yes (Scenario 
4)

A M1 Yes Yes Yes Yes

A1 M1 Yes Yes Yes Yes

A2 M1 Yes Yes Yes Yes
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A3 M1 Yes Yes Yes Yes

A4 M1 Yes No Yes No

B M1 No No Yes Yes

B1 M1 No No Yes No

B2 M1 No No Yes Yes

B3 M1 No No Yes Yes

B4 M1 No No Yes No

A M2 Yes Yes Yes Yes

A1 M2 Yes Yes Yes Yes

A2 M2 Yes Yes Yes Yes

A3 M2 Yes Yes Yes Yes

A4 M2 Yes No Yes No

B M2 No No Yes Yes

B1 M2 No No Yes No

B2 M2 No No Yes Yes

B3 M2 No No Yes Yes

B4 M2 No No Yes No

This table shows what items are planned in a Production Plan assuming items A and B 
are MPS Planning (or MPS/MPP Planned) items and their components are not MPS 
Planning (or MPS/MPP Planned) items. It references some scenarios.

Scenario 1 - Demand schedule items only and Include Critical Component is not 
checked

In this case ASCP plans item A with demand schedules in organizations M1 and M2. 
Item B with only sales orders in organizations M1 and M2 is not planned.
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Sales order demands of item A for organization M1 are planned. Sales order demands 
of item A for organization M2 are ignored because the Include Sales Order flag for 
organization M2 is unchecked.

Scenario 2 - Demand schedule items only and Include Critical Component is checked

In this case ASCP plans item A with demand schedules in organizations M1 and M2. In 
addition all critical components of item A (A1, A3) and sandwiched item A2 are 
planned in both organizations. Item B with only sales orders in organizations M1 and 
M2 is not planned.

Sales order demands of item A for organization M1 are planned. Sales order demands 
of item A for organization M2 are ignored because the Include Sales Order flag for 
organization M2 is unchecked.

Scenario 3 - Demand schedule items and all sales orders and Include Critical 
Component is not checked

In this case ASCP plans item A with demand schedules in organizations M1 and M2. In 
addition item B with sales orders in organizations M1 and M2 is planned.

Sales order demands of items A and B for organization M1 are planned. Sales order 
demands of items A and B for organization M2 are ignored because the Include Sales 
Order flag for organization M2 is unchecked.

Scenario 4 - Demand schedule items and all sales orders and Include Critical 
Component is checked 

In this case ASCP plans item A with demand schedules in organizations M1 and M2. In 
addition all critical components of item A (A1, A3) and sandwiched item A2 are 
planned in both organizations. Item B with sales orders in organizations M1 and M2 is 
also planned. In addition critical component of item B (B3) and sandwiched item B2 are 
planned in both organizations.

Sales order demands of items A and B for organization M1 are planned. Sales order 
demands of items A and B for organization M2 are ignored because the Include Sales 
Order flag for organization M2 is unchecked.

Ite
m

Organi
zation

Planned Items 
with Demand 
schedule items 
only and Include
Critical 
Component 
Option Set to No
(Scenario 1)

Planned Items 
with Demand 
schedule items 
only and 
Include Critical 
Component Set 
to Yes (Scenario
2)

Planned Items 
with Demand 
schedule items 
and all sales 
orders and 
Include Critical 
Component Set 
to No (Scenario 
3)

Planned Items 
with Demand 
schedule items 
and all sales 
orders and 
Include Critical 
Component Set to 
Yes (Scenario 4)

A M1 Yes Yes Yes Yes
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A1 M1 No Yes No Yes

A2 M1 No Yes No Yes

A3 M1 No Yes No Yes

A4 M1 No No No No

B M1 No No Yes Yes

B1 M1 No No No No

B2 M1 No No No Yes

B3 M1 No No No Yes

B4 M1 No No No No

A M2 Yes Yes Yes Yes

A1 M2 No Yes No Yes

A2 M2 No Yes No Yes

A3 M2 No Yes No Yes

A4 M2 No No No No

B M2 No No Yes Yes

B1 M2 No No No No

B2 M2 No No No Yes

B3 M2 No No No Yes

B4 M2 No No No No
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6
Supply Chain Plan Modeling

This chapter covers the following topics:

• Overview of Supply Chain Modeling

• Setting Up the Supply Chain

• Setting Outbound Ship Method

• Setting Supplier Capacity 

• Allocating Demand to Suppliers

• Setting Up Routings

• Lead-time and the Planning Time Fence

• Safety Stock

• Setting Shipping, Receiving, Carrier, and Supplier Capacity Calendars

• Scheduled Receipts

• Setting Up Batch Resources

• Performing Tasks on the Planning Server

Overview of Supply Chain Modeling
Oracle ASCP is a tool that integrates manufacturing and distribution into a single 
planning process. With Oracle ASCP, you can generate plans that include the entire 
supply chain. In a single step you can schedule and plan material and distribution 
requirements for multiple organizations, or centrally plan the entire enterprise. You can 
also include customer and supplier inventories in the supply chain planning process.

Oracle ASCP lets you plan finished products, intermediate assemblies, and purchased 
items for all facilities in your supply chain. Material plans for feeder plants and 
distribution centers automatically consider requirements originating from any number 
of other facilities. You can load planned order demand from multiple user 
organizations into the master schedule of supplying organizations.
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In addition to planning the material requirements of your supply chain, you can plan 
the requirements for your distribution network. This includes all warehouses, 
distribution centers, and any location that ships products. You can use these master 
production plans (MPPs) as input for your material plans.

You can combine centralized distribution and material planning for items with 
significant interorganization supply or demand. You can perform subset planning 
where you prefer autonomous local planning. Output from the central plan can go into 
plant-level material plans and vice versa.

Oracle ASCP gives you a transparent view of the virtual enterprise, where all inventory 
locations participate in the planning process.

Setting Up the Supply Chain
Sourcing rules and bills of distribution determine the movement of materials 
throughout your supply chain; these include items that you buy from your suppliers 
and make at your manufacturing organizations.

Sourcing rules and bills of distribution both specify date-effective sourcing strategies, 
combining replenishment sources with split allocation percentages and rankings. A 
replenishment source is:

• An inter-organization transfer (Transfer From)

• The replenished organization manufactures the item (Make At)

• An external supplier (Buy From)

• An organization repairs the item (Repair at)

Sourcing rules and BODs both describe sourcing supply; in other words, for any 
organization, they answer the question Where do I get part A? (They never ask Where 
do I send part A?) Sourcing rules apply the answer to one organization or all the 
organizations in your enterprise. BODs define this behavior across multiple 
organizations (not just one or all). 

In a sourcing rule, time-phasing applies only to the shipping organizations; the 
receiving organization remains static for the life of the sourcing rule. In a bill of 
distribution, time-phasing applies both to shipping and receiving organizations.

For each item in a rule or bill, you can define effectivity dates to switch sourcing 
between make and buy, and set intransit lead times. If an item does not appear in a rule 
or bill, the item attribute determines the status; when these attributes conflict with a 
sourcing rule or bill of distribution, the rule or bill takes precedence. (See: Item and Bill 
of Material Attributes, and Defining Items, Oracle Inventory User's Guide.)

The following features are provided in Oracle Supply Chain Planning sourcing logic:

• Alternate source search if allocation exceeds supplier capacity
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• Control over Make/Buy attributes

• Delivery frequency calendars

• Historical information used in allocations

• Ranking sources and defining allocation percentages

• Splitting demand according to sourcing percentages

• Supplier capacity constraints

• Supplier specific lead times

• Supplier specific order modifiers

• Tolerance fences

Sourcing Rules 

Sourcing rules define inventory replenishment methods for either a single organization 
or all organizations in your enterprise. Time-phasing in a sourcing rule determines 
when each group of shipping method - ship org combinations is in effect, as in this 
example: 

In the first phase of SR-C01, SAC is replenished equally by AUS and NYC. From 
01-JUL-1997, AUS no longer supplies SAC, which receives all transfers from NYC: 
(mrp_suprulex.if)

This sourcing rule can apply to one org (SAC, in this example), or to all your 
organizations. However, you cannot choose a single organization in one phase and all 
organizations in another phase. That would require two sourcing rules, with 
consecutive effectivity dates. If you assign the sourcing rule to one receiving 
organization (SAC in this example), it is a local sourcing rule; if you assign it to multiple
organizations, it is a global sourcing rule.

You cannot apply sourcing rules and bills of distribution (make them Planning Active) 
until the sum of the allocation percentages equals 100. Secondly, sourcing rules and bills
of distribution do not take effect until they are assigned to a part or a range of parts. 
(See: Assigning Sourcing Rules and Bills of Distribution.)

Bills of Distribution 

Bills of distribution define the sourcing strategies of several organizations. In other 
words, a bill of distribution is library of sourcing strategies. For instance, the sourcing 
strategy described in SR–C01 could apply to different organizations at different periods.
You cannot do this with sourcing rules because you have to apply the strategy to one 
organization or all organizations.

In another example, an item is made in a manufacturing center and supplied to a 
distribution center, which in turn supplies three sales offices. Instead of using five 
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different local sourcing rules, you could set up a three-level replenishment hierarchy 
with a bill of distribution for the item. This bill would specify how the item is sourced at
each level.

Both sourcing rules and bills of distribution have effective dates, periods during which 
the scheme is valid. For each period, you can specify a list of sources, type, allocation 
percentage, rank, shipping method, and intransit time.

You cannot apply sourcing rules and bills of distribution (make them Planning Active) 
until the sum of the allocation percentages equals 100. Secondly, sourcing rules and bills
of distribution do not take effect until they are assigned to a part or a range of parts. 
(See: Assigning Sourcing Rules and Bills of Distribution.)

Example - Sourcing Rule/Bills of Distribution 

In the following scenario, distribution centers SFD and NYD receive finished goods 
from manufacturing plan SAC: 
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Sourcing rule SR-C02 describes the replenishment of SFD by SAC. Since no other plants 
supply the part (which is assigned to this rule separately), the allocation is 100%. 
SR-C02 is a local sourcing rule because it applies to SFD only. Similarly, SR-C03 
describes the replenishment of NYD by SAC.

The bill of distribution (BR–E01 in this example) can define a specific set of receiving 
organizations, and for each organization it can define any number of shipping 
organizations - each with its own allocation percentage, ranking, and shipping method. 
Bills of distribution are more flexible than sourcing rules because, for each organization 
you list in the bill, you define a range of dates and a sourcing strategy to apply within 
those dates. Sourcing rules can only define the dates and strategy for one organization 
or all the organizations in your enterprise. 

The following scenario illustrates this flexibility: 
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As the demand from NYD expands and exceeds SAC's capacity to meet the demand, 
the enterprise decides to build a new plant, called NYC. While NYC is brought online, 
SAC continues to meet 100% of demand from NYD. From 1-JUL, however, NYC begins 
to supply a small percentage of this demand, taking some of the burden away from 
SAC. The planning process can quickly and easily support this transition. Sourcing rule 
SR-C04 can define the dates during which the transition will occur, include NYC, and 
split the demand replenishment between it and SAC. Bill of distribution BR-E01 can 
accomplish this as well, but the bill can incorporate it into an enterprise–wide sourcing 
strategy.

Defining Sourcing Rules
You can define sourcing rules that specify how to replenish items in an organization, 
such as purchased items in plants. Sourcing rules can also specify how to replenish all 
organizations, as when the entire enterprise gets a subassembly from a particular 
organization.

If there are conflicts in Sourcing, a predetermined hierarchy will resolve the sourcing 
conflict. For instance, if you assign a bill of distribution to an organization AUS that tells
it to source the part from another organization NYC, you can still define a local 
sourcing rule at organization AUS to source the part from yet another organization 
SAC. In this case, the local sourcing rule overrides the bill of distribution.

The planning assignment set holds information for:
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• Sales order global distribution

• Organization-to-organization sourcing

Watch for conflicts between sourcing rules for external demands and sourcing rules for 
internal demands. For example:

• External demand for an item is sourced globally from either organizations M1 or 
M2. The sourcing rule is Transfer from with M1, M2. assigned at the item level

• Internal demand at organization M1 is sourced from organization M3. The sourcing
rule is Transfer from with M3 assigned at the item/org level. The item/org 
assignment tells the planning engine that this sourcing rule applies to the sourcing 
for internal demand and not for the external demand.

• If you assign a sourcing rule for external demand at the item level, then you cannot 
assign a sourcing rule for internal demand at that level.

Ship methods apply to Buy from and Transfer from sourcing rules. To create the ship 
methods:

• Navigate to Oracle Inventory > Shipping Networks 

• Navigate to the detail region

• Navigate (M) Tools> Shipping Methods

To define a sourcing rule

1. Navigate to the Sourcing Rule window.

2. Enter a unique sourcing rule name.

3. Indicate whether this sourcing rule is used for all organizations (global) or a single 
organization (local). If the sourcing rule is local, you must enter an organization 
name; otherwise, your current organization will be the receiving organization.

4. Choose Copy From to copy the effectivity dates and shipping organization from 
another sourcing rule into this one.

5. Enter effectivity dates. You must enter a start date, but entering an end date is 
optional.

6. For each range of effectivity dates, you can include multiple shipping organizations.
For each shipping organization you want to include, select a sourcing type to 
specify whether you make, buy, or internally transfer the item. You can also copy a 
list of shipping organizations from an existing sourcing rule. If you enter a 
customer organization as the receiving organization, then you cannot select a 
supplier organization as the shipping organization.
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7. Enter an allocation percentage for each shipping organization. Allocation 
percentage includes the number of planned orders issued to the part for the entire 
the planning horizon. Your total allocation may not exceed 100. If the allocation 
percentage for all the shipping organizations included within a range of effectivity 
dates equals 100, Planning Active is checked. If the sourcing rule is not planning 
active, the planning process will not use the rule to assign planned orders.

8. Enter a numeric rank value to prioritize each sourcing type. If you have two sources
with the same allocation percentage, planned orders are sourced from the highest 
rank first.

9. Select a shipping method, such as FEDEX, UPS, or rail. (See: Defining Shipping 
Methods, Oracle Inventory User's Guide.

10. Save your work.

To copy shipping organizations from an existing sourcing rule

This feature allows you to include long, previously defined lists of shipping 
organizations without manual entry.

1. Select a sourcing type to specify whether you make, buy, or internally transfer the 
item.

2. Choose Copy Shipping Orgs From.

3. In the Find window, select a sourcing rule that includes the shipping organizations 
you want to duplicate in this new sourcing rule.

4. Choose OK.

To purge a sourcing rule

1. Select a sourcing rule name.

2. Choose Purge.

Defining Bills of Distribution
You can define bills of distribution that specify a multilevel replenishment network of 
warehouses, distribution centers, manufacturing centers (plants), and trading partners.

To define a bill of distribution

1. Navigate to the Bill of Distribution window.

2. Enter a unique bill of distribution name.

3. If the allocation percentage for this bill of distribution equals 100, Planning Active is
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checked. (See Step 7.)

Note: You cannot set the allocation percentage to less than or 
greater than 100 for sourcing rules that are already assigned in 
assignment sets

4. Choose Copy From to copy the receiving and shipping organization information 
from another bill of distribution into this one.

5. Enter the effectivity dates for each receiving organization in this bill of distribution.

6. For each receiving organization, you can enter a number of shipping organizations. 
For each shipping organization, select a sourcing type to specify whether you make,
buy, or internally transfer the item. You can also copy a list of shipping 
organizations from an existing bill of distribution.

Note: Suppliers and supplier sites must be predefined in Oracle 
Payables. See: About Suppliers, Oracle Payables User's Guide

7. Enter an allocation percentage for each shipping organization. Allocation 
percentage includes the number of planned orders issued to the part for the entire 
the planning horizon. Your total allocation may not exceed 100. If the allocation 
percentage for all the shipping organizations included within a range of effectivity 
dates equals 100, Planning Active is checked. If the sourcing rule is not planning 
active, the planning process will use the rule to assign planned orders.

Note: For bills of distribution that are already named in assignment
sets, you cannot set the allocation percentage to less than or greater 
than 10

8. Enter a numeric rank value to prioritize each sourcing type. If you have two sources
with the same allocation percentage, planned orders are sourced in rank order.

9. Select a shipping method, such as FEDEX, UPS, or rail. See: Defining Shipping 
Methods, Oracle Inventory User's Guide.

10. Save your work.

To copy shipping organizations from an existing bill of distribution

This feature allows you to include long, previously defined lists of shipping 
organizations without manual entry.

1. Select a sourcing type to specify whether you make, buy, or internally transfer the 
item.
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2. Choose Copy Shipping Orgs From.

3. In the Find window, select a bill of distribution that includes the shipping 
organizations you want to duplicate in this new bill of distribution.

4. Choose OK.

To purge a bill of distribution

1. Select a bill of distribution name.

2. Choose Purge.

Assigning Sourcing Rules and Bills of Distribution
Once you have defined your sourcing rules and bills of distribution, you must assign 
them to particular items and/or organizations. These assignments are grouped together 
in assignment sets. This is where your various sourcing strategies define a particular 
supply chain network.

Each assignment set to represents selection of organizations and/or items you want 
planned. To influence the planning process, you must include an assignment set in your
plan options. 

In an assignment set can assign your sourcing rules and bills of distribution at different 
levels, as follows:

• Item-Instance: An item across all organizations. If the Item field is empty, use the 
Reduce Criteria Window to restrict the selection.

• Item-Instance-Organization: A single item in an inventory organization

• Instance-Organization: All items in an inventory organization

• Category-Instance: Categories of items

• Category-Instance-Organization: Categories of items in an inventory organization

• Instance: All organizations

These levels allow you to assign a replenishment rule to as many or as few items as 
possible. For example, a category of items could be defined as packaging material, and a
sourcing rule that identifies the suppliers could be assigned.

When you specify a customer in an assignment:

• You cannot specify an organization in the same row

• The planning engine does not split planned orders by customer. If you want the 
planning engine to split planned orders by customer, use project manufacturing. 
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Create one project per customer so all of the sales orders for each customer peg to 
one project.

To assign a sourcing rule or bill of distribution

1. Navigate to the Sourcing Rule/Bill of Distribution Assignments window. 

2. Enter an assignment set name and description.

Note: The assignment specified in profile option MRP: Default 
Sourcing Assignment Set is the only one used by Oracle Purchasing
for its processing

3. Select an Assigned To type.

Note: You can assign a sourcing rule or bill of distribution to a 
category only if you have updated the profile option MRP:Sourcing
Rule Category Set. See: MRP:Sourcing Rule Category Set

4. Enter an organization name, if the Assigned To type requires one.

Note: You cannot assign customers modelled as organizations to a 
global sourcing rule

5. Enter the name of the customer to which you want to assign a sourcing rule or bill 
of distribution.

6. Enter the specific site to which you want to assign a sourcing rule or bill of 
distribution.

7. Enter an Item/Category if you selected Item or Item-Org as the Assign To type.

8. Enter the sourcing rule or bill of distribution as the Type.

9. Enter the name of the sourcing rule or bill of distribution.

10. Enter Condition if the source is Repair at or Transfer fromfective and usable items 
in asset intensive planning. It is the condition of the repairable at he end of the 
process.

11. Save your work.

To purge a sourcing rule or bill of distribution

1. Select an assignment set name.
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2. Choose Purge.

Assignments Hierarchy
In the following table, rows below override rows above them. Columns on the right 
override columns on the left.

A global sourcing rule has an unspecified receiving organization.

Sourcing Rules vs. Bill of Distribution Assignments 

Assignment Scope Global Sourcing 
Rule*

Local Sourcing 
Rule

Bill of 
Distribution

Global Yes No Yes 

Organization No Yes No 

Category of Item Yes No Yes 

Category of Items in an 
Organization 

No Yes No 

Item Yes No Yes 

Items in an Organization No Yes No 

Since not all assignment types are valid for both sourcing rules and bills of distribution, 
the effect of the Sourcing Rules vs. Bill of Distribution Assignments table is illustrated in
a linear hierarchy in the following table. The rows below override rows above them.

Assignment to Levels

Assignment Scope Sourcing Mechanism

Global Global Sourcing Rule 

Global Bill of Distribution 

Organization Local Sourcing Rule 

Category of Item Global Sourcing Rule 
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Assignment Scope Sourcing Mechanism

Category of Item Bill of Distribution 

Category of Items Local Sourcing Rule 

in an Organization  

Item Local Sourcing Rule 

Item Bill of Distribution

Items in an Organization Local Sourcing Rule

Viewing Sourcing Rules
You can quickly and easily retrieve sourcing rules for reference. After retrieving a 
sourcing rule, you can display it in a convenient, hierarchical representation, or you can
locate the assignment sets in which it is assigned.

To view sourcing rules

1. Navigate to the View Sourcing Rule or Sourcing Rule window. 

2. Place your cursor in the Name or Description field and select Find or Find All from 
the query menu.

3. Choose View to launch the Object Navigator and display the graphical view of your
sourcing rule.

With the Object Navigator, you can display your sourcing rule in a visual hierarchy.
Each element in the sourcing rule is displayed in a rectangular node, with 
connecting lines that depict the nodes' relationships to each another (known as the 
data flow). The nodes are also color-coded for easy identification, and other aspects 
of the data flow can be changed to meet specific requirements.

To view assignments for your sourcing rules

Sourcing rules govern replenishment of specific items in your enterprise based on the 
rule's assignment. Sourcing rules can be assigned to an item, and item in an 
organization, an organization, a category of items, a category of items in an 
organization, or to all items.

When modifying or viewing a sourcing rule, you can quickly refer to all the assignment 
sets in which the rule participates. You can also refer to the assignment level assigned to
the rule. For more information about assignment sets, see: Assigning Sourcing Rules 
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and Bills of Distribution.

1. Navigate to the View Sourcing Rule or Sourcing Rule window.

2. Place your cursor in the Name or Description field and select Find or Find All from 
the Query menu.

3. Choose Assignment Set. The list that appears includes all sets in which the current 
rule participates. 

For each Sourcing Rule and Bill of Distribution in the Assignment Set, you can review 
the following information: 

• Assigned to: Each Sourcing and Bill of Distribution can be assigned:

• A single item (across all organizations)

• An item in a specific organization

• All items in a specific organization

• A category of items

• A category of items in an organization

• All items in all organizations (globally)

Note: You can assign a sourcing rule to a category only if you have 
updated the profile option MRP:Sourcing Rule Category Set. See: 
MRP:Sourcing Rule Category Set

• Organization: Rules or bills assigned to an organization, a category of items in an 
organization, or an item in an organization will also display the name of that 
organization.

• Customer and Customer Site: Rules or bills associated with a customer will also 
display this information.

• Item/Category: Rules or bills assigned to an item or an item in an organization will 
display with the associated item or category of items (if the profile option has been 
updated to include categories).

Viewing Bills of Distribution
You can quickly and easily retrieve bills of distribution for reference. After retrieving a 
bill of distribution, you can display it in a convenient, hierarchical representation, or 
you can locate the assignment sets in which it is assigned. 
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To view bills of distribution

1. Navigate to the View Bill of Distribution or Bill of Distribution window 

2. Place your cursor in the Name or Description field and select Find or Find All from 
the Query menu.

3. Choose View to launch the Object Navigator and display the graphical view of your
bill of distribution.

With the Object Navigator, you can display your bill of distribution in a visual 
hierarchy. Each element in the bill is displayed in a rectangular node, with 
connecting lines that depict the nodes' relationships to each another (known as the 
data flow). The nodes are also color–coded for easy identification, and other aspects 
of the data flow can be changed to meet specific requirements.

To view assignments for your bills of distribution

Bills of distribution govern replenishment of specific items in your enterprise based on 
the bill's assignment. Bills of distribution can be assigned to an item, and item in an 
organization, an organization, a category of items, a category of items in an 
organization, or to all items.

When modifying or viewing a bill of distribution, you can quickly refer to all the 
assignment sets in which the bill participates. You can also refer to the assignment level 
assigned to the rule. For more information about assignment sets, see: Assigning 
Sourcing Rules and Bills of Distribution.

1. Navigate to the View Bills of Distribution or Bill of Distribution window

2. Place your cursor in the Name or Description field and select Find or Find All from 
the Query menu.

3. Choose Assignment Set. The list that appears includes all sets in which the current 
bill participates.

For each Sourcing Rule and Bill of Distribution in the Assignment Set, you can review 
the following information:

• Assigned to: Each Sourcing and Bill of Distribution can be assigned:

• A single item (across all organizations)

• An item in a specific organization

• All items in a specific organization

• A category of items

• A category of items in an organization
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• All items in all organizations (globally)

Note: You can assign a sourcing rule to a category only if you 
have updated the profile option MRP:Sourcing Rule Category 
Set. See: MRP:Sourcing Rule Category Set

• Organization: Rules or bills assigned to an organization, a category of items in an 
organization, or an item in an organization will also display the name of that 
organization.

• Customer and Customer Site: Rules or bills associated with a customer will also 
display this information.

• Item/Category: Rules or bills assigned to an item or an item in an organization will 
display with the associated item or category of items (if the profile option has been 
updated to include categories).

Viewing Sourcing Rule and Bill of Distribution Assignments
Once you have defined your sourcing rules and bills of distribution, you must assign 
them to particular items and/or organizations. These assignments are grouped together 
in assignment sets. This is where your various sourcing strategies define a particular 
supply chain network. 

You can quickly view your assignment sets to review particular sourcing schemes, 
locate particular assignments of sourcing rules or bills of distribution, or view the 
supply chain bill for a particular assignment set.

To view sourcing rule and bill of distribution assignments

1. Navigate to the Sourcing Rule/Bill of Distribution Assignments window.

2. Place your cursor in the Assignment Set or Description field and select Find or Find 
All from the Query menu.

3. Select an assignment set from the list.

For each Sourcing Rule and Bill of Distribution in the Assignment Set, you can review 
the following information:

• Assigned to: Each Sourcing and Bill of Distribution can be assigned:

• A single item (across all organizations)

• An item in a specific organization

• All items in a specific organization
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• A category of items

• A category of items in an organization

• All items in all organizations (globally)

Note: You can assign a sourcing rule to a category only if you 
have updated the profile option MRP:Sourcing Rule Category 
Set. See: MRP:Sourcing Rule Category Set.

• Organization: Rules or bills assigned to an organization, a category of items in an 
organization, or an item in an organization will also display the name of that 
organization.

• Item/Category: Rules or bills assigned to an item or an item in an organization will 
display with the associated item or category of items (if the profile option has been 
updated to include categories).

To view details of a particular rule or bill

When viewing an assignment set, you can quickly retrieve full details on any sourcing 
rule or bill of distribution named in the set.

1. In the Assignments region, place your cursor in any field on the row containing the 
rule or bill you want.

2. Choose View Sourcing Rule/BOD

Setting Outbound Ship Method
When there are multiple ship methods possible between a customer site and an internal 
organization, Oracle Advanced Supply Chain Planning evaluates the delivery time and 
selects the ship method that is most appropriate. Each ship method has a specific 
intransit lead-time. If the default ship method or the current ship method on the sales 
order does not meet the demand on time, you can evaluate multiple ship methods and 
select an alternate ship method that meets the demand on time.

For example, you may want to use a cost effective ship method such as ocean shipment 
or ground shipment for most part and switch to airfreight for certain orders to avoid 
late orders. With the automatic selection of ship methods, Oracle Advanced Supply 
Chain Planning suggests change in ship methods to meet orders on time by using ship 
methods that have shorter lead-times. Therefore, you can use the most cost effective 
ship methods for normal operations, but decide to use alternate ship methods if the 
orders are going to be late.

If you use cost based optimization, Oracle Advanced Supply Chain Planning selects the 
ship method based on costs associated with the specific ship method and the 
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optimization objectives. You can send the selected ship method to Oracle Order 
Management along with the recommendation for the ship from organization. These 
planning decisions are communicated to Oracle Order Management using the Release 
process. 

Note: Intransit lead-time depends on the ship method used to transport
goods.

You can model alternate ship methods for:

• Sales orders bound to a customer 

• Planned order between two organizations

• Planned orders sourced at a supplier or planned orders with buy source

To Setup Alternate Ship Methods
You need to complete setup steps in the following Oracle products to setup selection of 
outbound ship method:

• Oracle Shipping

• Oracle Inventory

• Oracle Advanced Supply Chain Planning

Perform the following setup steps in both the execution as well as planning server.

Setup Steps in Oracle Shipping
1. Select the Manufacturing and Distribution Manager responsibility.

2. Navigate to Order Management > Shipping > Setup > Regions and Zones.

3. Set up ship methods.

4. Optionally set up zones to group customer sites and supplier sites.

For more details, see Oracle Shipping Execution User's Guide.

Setup Steps in Oracle Inventory
1. Navigate to Inventory > Set up > Organizations > Inter-Location Transit Times.

2. Set up ship methods and intransit lead-times between the following entities:

• Organization and Customer sites
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• Between Organizations

• From supplier site to Organizations

To model transit lead-time between customers and organizations, include it in 
supplier processing lead time

For more details, see Oracle Inventory User's Guide.

Setup Steps in Oracle Advanced Supply Chain Planning
1. Navigate to Advanced Supply Chain Planner > Sourcing > Sourcing Rules.

2. Define sourcing rules or bills of distribution. Create multiple entries for the same 
source and select different ship methods and intransit lead-times in each entry.

3. Navigate to Sourcing > Assignment set

4. Assign sourcing rules at customer site level or one of the following levels:

• Item-Instance-Region

• Category-Instance-Region

• Instance-Region

5. Assign sourcing rules to items.

6. Select the assignment set in the plan option.

Note: If destination is an Org, the level assignment can be at 
Item-Instance-Org, Category-Org etc.

To use Alternate Ship Methods
1. Run a plan with the assignment set that contains sources and alternate ship 

methods.

2. Review the alternate ship method used/ ship method changed exceptions.

3. Drill down to Exception Details and review old and new ship methods and intransit
lead-times.

4. Navigate to the Supply/Demand window and select the sales orders for release.

5. Release the sales orders with the selected ship method from the Planner 
Workbench.
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6. Review the results in Oracle Order Management.

Note: The ship method is automatically changed on the sales order 
line.

7. Work with your suppliers to use the suggested ship method.

You can also evaluate and select ship methods between two internal organizations each 
time you run the plan.

Setting Supplier Capacity 
This section explains supplier capacity:

• Constraints

• Set up

• Setting by time periods

Constraints
Oracle ASCP considers the following supplier capacity constraints. 

Allocation of Demand Based on Historical Allocations 
You can allocate planned orders to sources taking historical allocations into account. 
Planning uses history to determine the allocations necessary to achieve your targeted 
allocations. 

Allocate Planned Orders With Capacity Constraints
You can specify the capacity of individual suppliers to supply specific items. You can 
allocate planned orders taking capacity constraints of the suppliers into account. 
Planning uses the ranking information you specify and first attempts to source the 
planned orders with the primary sources. If the primary source does not have the 
capacity to fulfill the demand, planning suggests sourcing with the alternative sources 
you have specified, in the priority you have specified.

Supplier-Specific Order Modifiers 
You can specify supplier-specific order modifiers at an item/supplier site level. Planning
respects the order modifier quantities defined for the sources of the item. This enables 
you to specify more precisely the conditions related to each source.

Supplier-Specific Lead-times
You can specify supplier-specific lead-times for items. This ensures orders are placed 
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early enough to provide the supplier time to react to your needs.

Delivery/Reception Frequency Calendars
Use receiving calendars to specify the available delivery dates to:

• An organization

• An organization from a specific carrier

The reception schedule contains the dates that organizations can receive inbound 
shipments from carriers. The planning engine adjusts planned orders so that they are 
due on available dates in the reception schedule.

Flexible Tolerance Fences
You can define capacity tolerance percentages that vary over time for each source. This 
allows the allocation of demand over capacity by a variable amount depending on the 
time in the future.

Supplier Capacity Accumulation
The planning engine accumulates supplier capacity on all workdays in the owning 
organization's manufacturing calendar. Capacity that accumulates on a given day is 
available for use the next day.

To specify unavailable supplier capacity for a certain supplier (for example, a 
shutdown), specify zero capacity for that period in the approved supplier list.

You can configure accumulation of supplier capacity depending on when your supplier 
starts production.

If the supplier has ongoing production, you might assume that material is always in 
process. Since the supplier can ship almost immediately, you might want to accumulate 
supplier capacity from the plan start date. Set profile option MSC: Supplier Capacity 
Accumulation (multiplier) to 0. This table shows an example of this scenario with 
Approved Supplier List Supplier Capacity at 10 each per day.

Schedule 
Entity

Th F
r

S
a

Su Mo Tu We Th Fr Sa Su Mo Tu We

Daily 
supplier 
capacity in 
source 
instance

- 1
0

- - 10 10 10 10 10 - - 10 10 10
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Schedule 
Entity

Th F
r

S
a

Su Mo Tu We Th Fr Sa Su Mo Tu We

Daily 
supplier 
capacity in 
planning 
instance

- 1
0

- - 10 10 10 10 10 - - 10 10 10

Cumulative 
supplier 
capacity in 
planning 
instance

- 1
0

- - 20 30 40 50 60 - - 70 80 90

If the supplier starts making new material when it receives your order, it can ship after 
their lead-time. You might want to accumulate supplier capacity at the Approved 
Supplier List Processing Lead-time or a multiple of it. Set profile option MSC: Supplier 
Capacity Accumulation (multiplier) to 1 (for the Approved Supplier List Processing 
Lead-time) or another whole number (for a multiple of the Approved Supplier List 
Processing Lead-time.

This table shows an example of this scenario with quantity of 10 each per day and 
Approved Supplier List Processing Lead-time of 6 days. If there is no Approved 
Supplier List Processing Lead-time, the planning engine uses item attribute Processing 
Lead-time.

Schedule 
Entity

Th F
r

Sa Su Mo Tu We T
h

Fr Sa Su M
o

T
u

We

Daily 
supplier 
capacity in 
source 
instance

- 1
0

- - 10 10 10 10 10 - - 10 10 10

Daily 
supplier 
capacity in 
planning 
instance

- - - - - - - 10 10 - - 10 10 10
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Schedule 
Entity

Th F
r

Sa Su Mo Tu We T
h

Fr Sa Su M
o

T
u

We

Cumulative 
supplier 
capacity in 
planning 
instance

- - - - - - - - 10 - - 20 30 40

Purchase Order Consumption of Supplier Capacity
The planning engine does not consume supplier capacity with purchase orders unless 
you specify. In general, purchase order deliveries that consume supplier capacity can 
result in unnecessary reschedule out exception messages. They have consumed supplier
capacity in the past; since the planning engine does not track past supplier capacity, it 
sees not enough supplier capacity between the plan start date and the purchase order 
delivery dock date.

You can configure purchase order consumption of supplier capacity in several ways 
depending on the amount of feedback that you receive from your suppliers:

• Constrain new orders only

• Constrain new orders only, purchase order placed early

• Integrate with Oracle Collaborative Planning

Profile Options
To configure purchase order consumption of supplier capacity, set the following profile 
options:

• MSC: Supplier Capacity Consumption by Purchase Orders

• MSC: Supplier Capacity Accumulation (multiplier)

Constrain New Orders Only Scheme
Use this scheme with the following business situation and assumptions:

• The planning engine consumes supplier capacity and lead-time for planned orders 
after the supplier lead-time.

• You typically place purchase orders just outside the supplier lead-time. The 
supplier starts to build supplies when you place the purchase order and they need 
the entire lead-time. If you typically place purchase orders early, consider using the 
Constrain new orders only, purchase order placed early scheme.
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• The supplier will deliver purchase orders on time.

• The planning engine does not consume supplier capacity for purchase orders. 

To implement this supplier capacity accumulation scheme, set profile option:

• MSC: Purchase Order Dock Date Calculation Preference to Need By Date

• MSC: Supplier Capacity Accumulation (multiplier) to 1

For example, this table shows the planning engine behavior for this scheme:

• Approved Supplier List Supplier Capacity of 10 each per day and Approved 
Supplier List Processing Lead-time of 1 day.

• The planning engine begins to accumulate supplier capacity on Friday which is 
available for receipt of new planned orders or requisitions on Monday.

• The planning engine does not consume supplier capacity against the purchase 
order for 50. It does not issue an Orders to be rescheduled out exception message 
because of lead-time.

Schedule 
Entity

Th Fr S
a

Su Mo Tu W
e

Th Fr Sa Su Mo T
u

We

Purchase 
orders

- - - - - 50 - - - - - - - -

Purchase 
requisition
s

- - - - - - - 30 - - - - - -

Planned 
orders

- - - - - - - - - - - 20 - -

Daily 
supplier 
capacity in
planning 
instance

- 10 - - 10 10 10 10 - - - 10 10 10

Cumulativ
e supplier 
capacity in
planning 
instance

- - - - 10 20 30 10 10 - - 0 10 20
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Constrain New Orders Only, Purchase Order Placed Early Scheme
Use this scheme with the following business situation and assumptions:

• The planning engine consumes supplier capacity and lead-time for planned orders 
after the supplier lead-time.

• You typically place purchase orders earlier than just outside the supplier lead-time. 
The supplier starts to build supplies when you place the purchase order and they 
need the entire lead-time. If you typically do not place purchase orders early, 
consider using the Constrain new orders only scheme.

• You maintain the purchase order delivery promise date within the supplier 
lead-time. Purchase order deliveries with no promise date have not been accepted 
by the supplier.

• The supplier will deliver purchase orders on time.

• The planning engine does not consume supplier capacity for purchase orders that 
have been acknowledged by the supplier.

To implement this supplier capacity accumulation scheme, set profile option:

• MSC: Purchase Order Dock Date Calculation Preference to Promise Date

• MSC: Supplier Capacity Accumulation (multiplier) to 1

The planning engine behaves as follows for this scheme:

• For example, the supplier lead-time for an item is 5 days and the supplier capacity 
is 100 per day.

• The planning engine begins to accumulate supplier capacity on day 5 which is 
available for receipt of new planned orders or requisitions on day 6.

• The planning engine does not consume supplier capacity against purchase order 
deliveries with a promise date. It uses the promise date as the dock date.

• The planning engine does not consumes supplier capacity against purchase order 
deliveries without a promise date. However, it may issue an Orders to be 
rescheduled out exception message because of lead-time and a Supplier capacity 
overloaded exception message because of supplier capacity. 

Integrate with Oracle Collaborative Planning Scheme
Oracle Advanced Supply Chain Planning and Oracle Collaborative Planning
You use Oracle Collaborative Planning to produce and send (publish) order forecasts 
from material plans to suppliers, either:
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• Unconsumed: Purchase orders, purchase requisitions, and planned orders

• Consumed: Purchase requisitions and planned orders

The supplier responds to each statement of demand with:

• Acknowledgements: Quantity and date tied to individual purchase order deliveries.

If the supplier uses iSupplier portal to accept purchase orders, the Oracle Advanced
Supply Chain Planning collections process sets the promise date to the need by date
for accepted purchase order deliveries.

Otherwise, use this information to manually update the promise date for each 
purchase order delivery. If the supplier acknowledges several partial quantity 
deliveries on different dates, manually split the deliveries and enter promise dates 
for each one.

• Supply commit: Tied to the unconsumed portion of your forecast.

If the supplier uses Oracle Advanced Supply Chain Planning, they publish a supply
commit that represents existing supplies and planned orders for the top level item 
that are pegged to forecasts and sales orders for a customer. To receive the supplier 
commit, run concurrent process Receive Supplier Capacity before running 
collections. 

Otherwise, they provide aggregated time phased supply values into Oracle Supply 
Chain Collaboration using a flat file, an XML transaction, or manual entry. 

You uses the supplier responses to constrain your material plan. The planning engine 
uses them as the supplier's commitment of capacity instead of the capacity statements 
in the approved supplier list.

Scheme Details
Use this scheme with the following business situation and assumptions:

• You use Oracle Collaborative Planning 

• You issue relatively few purchase order deliveries outside of the dates and 
quantities that Oracle Advanced Supply Chain Planning recommends.

To implement this supplier capacity accumulation scheme, set profile option:

• MSC: Purchase Order Dock Date Calculation Preference to Promise Date

• MSC: Supplier Capacity Accumulation (multiplier) to 0

For example, you run an unconstrained plan. This table shows the supplies for supplier 
1, supplier site 1, item A. Although you have issued purchase orders 2 and 3, the 
supplier has not yet acknowledged them.
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Order 
Type

Order 
Number

Order Line Quantity Need by 
Date

Promise 
Date

Dock Date

Purchase 
order

1 1 20 29 April 29 April 29 April

Purchase 
order

1 2 100 1 May 3 May 3 May

Purchase 
order

2 1 10 6 May - 6 May

Purchase 
order

3 1 100 29 April - 29 April

Purchase 
requisition

100 1 200 13 May - 13 May

Purchase 
requisition

101 1 200 10 May - 10 May

Purchase 
requisition

102 1 300 14 May - 14 May

Planned 
order

301 - 100 20 May - 20 May

Planned 
order

302 - 100 27 May - 27 May

Planned 
order

303 - 100 3 June - 3 June

You use Oracle Collaborative Planning to publish a forecast to Supplier 1 for item A of 
purchase orders, purchase requisitions, and planned orders based on dock date. This 
table shows the forecast.

Quantity Date

20 29 April

100 1 May
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Quantity Date

10 6 May

100 29 April

200 13 May

200 10 May

300 14 May

100 20 May

100 27 May

100 3 June

Supplier 1 runs a constrained plan that results in the supply and demand situation for 
supplier site 1, Item A. This table shows the details of supplier 1 supplies that are 
pegged to your demands.

Supplier 1:

• Has received sales orders for purchase order 1, lines 1 and 2; they consume your 
forecast for the demands on 29 April and 03 May. 

• Has not received sales orders against the demand that resulted in purchase orders 2
and 3; they do not consume your forecast.

Order Type Order Number Order Line Quantity Date

Sales order 1 1 20 29 April

Forecast - - 100 29 April

On hand - - 20 29 April

On hand - - 100 29 April

Sales order 1 2 100 3 May
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Order Type Order Number Order Line Quantity Date

On hand - - 100 29 April

Forecast - - 10 6 May

Oh hand - - 20 29 April

Forecast - - 200 10 May

WIP job 1114 - 200 10 May

Forecast - - 200 13 May

WIP job 1113 - 200 13 May

Forecast - - 300 14 May

Planned order 3330 - 300 14 May

Forecast - - 100 20 May

Planned order 3331 - 100 20 May

Forecast - - 100 27 May

Planned order 3332 - 100 27 May

Forecast - - 100 3 June

Planned order 3333 - 100 3 June

Supplier 1 uses Oracle Collaborative Planning to publish a supply commit with only 
supplies that are pegged to your forecast. This table shows the supplies that are pegged 
to your forecast.

Order Type Order Number Quantity Date

On hand - 100 29 April
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Order Type Order Number Quantity Date

On hand - 10 29 April

WIP job 1114 200 10 May

WIP job 1113 200 13 May

Planned order 3330 300 14 May

Planned order 3331 100 20 May

Planned order 3332 100 27 May

Planned order 3333 100 3 June

This table shows the supply commit which is the statement of supplier capacity through
its last entry date of 3 June. If an item-supplier site does not appear in the supply 
commit, the planning engine uses the Approved Supplier List Supplier Capacity.

The sales orders in the supplier's system that represent your purchase orders should be 
consumed during the supplier's forecast consumption process. The supplies pegged to 
these sales orders should not be in the supply commit. 

Quantity Due Date

100 29 April

10 29 April

200 10 May

200 13 May

300 14 May

100 20 May

100 27 May

100 3 June
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You run a constrained plan based on the supply commit. The planning engine must 
schedule the items in this table. 

Order 
Type

Order 
Number

Order Line Quantity Need by 
Date

Promise 
Date

Dock Date

Purchase 
order

1 1 20 29 April 29 April 29 April

Purchase 
order

1 2 100 1 May 3 May 3 May

Purchase 
order

2 1 10 6 May - 6 May

Purchase 
order

3 1 100 29 April - 29 April

This table shows how planning engine consumes supplier capacity in your constrained 
plan:

• Since the supplier has acknowledged both purchase order deliveries in purchase 
order 1 (they have Promise Date), the planning engine does not consume supplier 
capacity against them.

• Since the supplier has not yet acknowledged purchase order 2 and purchase order 3
(they do not have Promise Date), the planning engine consumes supplier capacity 
against them.

• The planning engine consumes supplier capacity against the purchase requisitions 
and planned orders.

Date Available Capacity Required Capacity Consuming Entity

29 April 110 110 Purchase orders 2 
and 3 (no Promise 
Date)

10 May 200 200 Purchase requisition 
100

13 May 200 200 Purchase requisition 
200
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Date Available Capacity Required Capacity Consuming Entity

14 May 300 300 Purchase requisition 
300

20 May 100 100 Planned order 3331

27 May 100 100 Planned order 3332

3 June 100 100 Planned order 3333

Setting Supplier Capacity by Time Periods
Please note the following when setting up supplier capacity:

• It is important to select Global in the Supplier Capacity window.

• Processing lead-time can be selected in number of days. This is a lead-time at the 
supplier end before the order is processed

• The delivery calendar should be entered to reflect the days the supplier can deliver 
the order. Examples: M, W or M, W, F 

• Minimum order quantity can be entered if the supplier has to deliver some 
minimum quantity if an order is placed. For example, if you have set the minimum 
order quantity to 25, and if 20 is ordered, 25 will be delivered

• Fixed lot multiple value needs to be entered if the supplier delivers only in certain 
multiples. For example, if you have set the fixed lot multiple to 5, if quantity 103 is 
ordered, 105 will be delivered

• The capacity area of the Supplier Capacity window is used to specify supplier's 
capacity for a specific time period. The supplier could have different capacity on 
different days. For examples, from 10/11/00 to 10/22/00, the supplier could have 50 
units/day, and from 10/23/00 to 10/31/00, the supplier could have 70 units/day

• Tolerance fence values can be determined to reflect how much capacity a supplier 
can adjust if given enough advanced notice. For example, on 10/24/00, if tolerance 
percentage is 10, this means that on 10/24/00, the capacity will be 77 units (in the 
above example)

Supplier capacity can vary by time period. You can specify one daily capacity for period
1 and a different capacity for period 2. Time periods are specified from a start date to an
end date.
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Note: The methods you use to set capacity by time period vary 
depending on which version of Oracle Applications you are using.

The planning engine considers supplier capacity as infinite after the end date of the last 
item-supplier-supplier site capacity entry. If there are no item-supplier-supplier site 
capacity entries, it considers supplier capacity as infinite for the entire planning horizon

To set capacity by time period
1. Navigate to the Purchasing module (you must use the Manufacturing and 

Distribution Manager responsibility).

2. Choose Purchasing > Supply Base > Approved Suppliers List. 

3. Choose the searchlight icon in the toolbar to search for an item. 

The Find ASL Item/Commodity window appears.

4. Choose an item or commodity.

Supplier information appears.

5. Choose a supplier by clicking in the Supplier field.

6. Select Attributes.

7. Choose the Planning Constraints tab. 

8. Enter the numbers of days in advance and the tolerance percentage. 

For example, entering 15 days and 5% means that within 15 days, the supplier can 
increase the capacity by 5%.

Allocating Demand to Suppliers
For more information on the following topics, see . Setting Up the Supply Chain, page 
6-2.

Setting Rank and Allocation
You can define a rank for each source of supply named in the sourcing rules and BODs. 
You can then define a sourcing percentage for each source within a rank, allowing you 
to allocate a portion of the total orders to each source.

Splitting Demand According To Sourcing Percentages
The data in these tables demonstrate how allocation percentages for planned orders are 
divided according to ranking information.
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The demand for Item A is shown in the following table. 

Demand Due Date Quantity

1 07/15 300

Sourcing for Item A is shown in the following table.

Item Source Rank Percentage Effective 
From

Effective To

A S1 1 40 05/15 12/31

A S2 1 30 05/15 12/31

A S3 1 30 05/15 12/31

Demand is assigned using the ranking information and calculating the percentages 
assigned to each source to calculate the planned orders.

• S1: 300 x 0.40 = 120

• S2: 300 x 0.30 = 90

• S3: 300 x 0.30 = 90

Three planned orders are created for the quantities of 120, 90, and 90 respectively. 

Note: All planned orders generated in this process are subject to item 
order modifiers. 

If you run a constrained plan and did not use optimization, the supplies calculated 
above will be scheduled based on the supplier capacity established for the item. If 
optimization is used, Oracle ASCP will not split the orders per the sourcing splits in 
sourcing rules; it will evaluate the suppliers by rank and considers supplier capacities to
come up with allocations to suppliers. The rank, lead-time and capacity of 3 suppliers is
shown in the following table.

Supplier Rank Lead Time Capacity

Supplier 1 3 2 100
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Supplier Rank Lead Time Capacity

Supplier 2 2 2 100

Supplier 3 1 2 100

Allocating Demand to Suppliers Based on Historical Demand
You can allocate planned orders taking into account historical allocations in 
unconstrained plans. The enhanced sourcing logic considers historical allocations and 
allows the splitting of demand to achieve target sourcing percentages. 

Sourcing Example
The next eight tables contain the set up data required to explain the example. The ninth 
table has historical allocation data, which results from previous allocations.

This table shows demand for item A.

Demand for Item A Due Date Quantity

1 7/15/98 310

2 7/16/98 280

This table shows sourcing rules data for item A.

Item Source Rank Percentage Effective 
From

Effective To

A S1 1 50 5/15/97 12/31/97

A S2 1 50 5/15/97 12/31/97

A S1 1 100 1/1/98 7/14/99

A S2 2 60 1/1/98 7/14/99

A S3 2 40 1/1/98 7/14/99

This table shows supplier capacity profile for item A.
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Source 7/10/98 (Thu) 7/11/98 (Fri) 7/14/98 
(Mon)

7/15/98 (Tue) 7/16/98 
(Wed)

S1 60 60 60 60 60

S2 80 80 80 80 80

S3 20 20 20 20 20

This table shows supplier capacity tolerance percentages for item A. The numbers in 
this table are from applying tolerance percentages to the supplier capacity profile; refer 
to those tables. For example, for supplier S1 on 7/16/98, total supplier capacity is 60 + 
10%(60) = 66.

Source 7/10/98 (Thu) 7/11/98 (Fri) 7/14/98 
(Mon)

7/15/98 (Tue) 7/16/98 
(Wed)

S1 0 0 0 0 10

S2 0 0 0 5 10

S3 0 0 0 5 10

S1 60 60 60 60 66

S2 80 80 80 84 88

S3 20 20 20 21 22

This table shows supplier delivery patterns for item A.

Source Reception Pattern

S1 Mondays and Wednesdays

S2 Mondays

S3 All days except Fridays

This table shows supplier processing information for item A.
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Source Processing (days)

S1 3

S2 2

S3 2

This table shows order modifiers at each source for item A.

Source Min. Order Quantity Fixed Lot Multiple

S1 50 5

S2 25 25

S3 21 7

Order Modifiers for Item A:

• Minimum Order Quantity: 17

• Fixed Lot Multiple: 88

Lead Times for Item A:

• Preprocessing: 0

• Postprocessing: 1

This table shows historical allocation totals.

Source Quantity

S2 1400

S3 1000

This table shows the horizontal plan.
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Item A 7/10/98 7/11/98 7/14/98 7/15/98 7/16/98

Demand 0 0 0 310 280

Excess 
Schedule 
Receipts

0 0 0 16 0

Planned 
Orders - Org 
S1

0 0 288 0 0

Planned 
Orders - Org 
S2

0 0 125 100 0

Planned 
Orders - Org 
S3

0 0 21 56 0

Allocations for Demand #1

Allocation Calculation Using Historical Allocation Information and Target Percentages 
for Demand #1:

Quantity = 310

Due Date = 7/15/98 (Tuesday)

Note: The first date of planning horizon is 7/9/98. Only the last three 
rows in the source rules data table apply due to effectivity dates. S1 has 
rank 1 with allocation percentage = 100 (sourcing rules data table). This 
indicates that the system should allocate as much as possible to S1 
before allocating the excess to other sources.

Based on the input demand data, we can now calculate how the demand for Item A will
be satisfied.

Step 1: Allocation to S1
Monday 7/14/98 is the latest reception date (supplier delivery patterns table) before due 
date (7/15/98). This respects the processing and postprocessing lead-times (supplier 
processing information table).

Cumulative capacity = 180 from supplier capacity profile with tolerance percentages 
table (tolerance percentage = 0)

Unsatisfied demand = 310 - 180 = 130
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Allocation to S1 = 180

This table shows you the resource availability after the allocation of 180 items consumes
capacity. The values in are derived from subtracting demand satisfied from supplier 
capacity tolerance percentages.

Source 7/10/98 (Thu) 7/11/98 (Fri) 7/14/98 
(Mon)

7/15/98 (Tu) 7/16/98 
(Wed)

S1 0 0 0 60 66

S2 80 80 80 84 88

S3 20 20 20 21 22

Step 2: Calculation of Historical Allocations for Alternate Sources.
Consider S2 and S3 from historical allocation totals with rank 2. Historical allocations 
beginning 1/1/98. 

• S2 = 1400

• S3 = 1000

Total allocations for S2 and S3 = 2400

Step 3: Calculate Allocations to S2 Based on Historical Allocations and Target Sourcing Percentages.
Note: Because S2 has a higher sourcing percentage, we will begin with 
allocations to S2.

Target source percentages: S2 = 60% (see sourcing rules data table)

Total target allocation = historical allocation + unsatisfied demand = 2400 + 130 = 2530

Using the S2 target allocation percentage, calculate the allocation to S2.

Allocation to S2 + 1400 (historical allocation) / 2530 (total target allocation) = 0.6 (source 
percent)

S2 allocation = 118

Step 4: Respect Order Modifiers If They Exist
S2 Allocation: 118 becomes 125 because S2 has a fixed lot multiple of 25 (see order 
modifiers at each source table). To respect that, 125 needs to be allocated.



6-40    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Step 5: Allocation to S2 with Following Constraints: Capacity, Lead Times, and Reception Calendars.
S2: Allocation = 125, Date = 7/15/98

Monday, 7/14/98, is the latest reception date before the due date. This respects the 
processing and postprocessing lead-times. 

Cumulative Available Capacity = 240 (tolerance percentage = 0); see supplier capacity 
profile after S1 allocation table.

This table shows you the resource availability after all allocations so far have consumed 
capacity.

Source 7/10/98 (Thu) 7/11/98 (Fri) 7/14/98 
(Mon)

7/16/98 (Tue) 7/16/98 
(Wed)

S1 0 0 0 60 66

S2 80 35 0 84 88

S3 20 20 20 21 22

Step 6: Calculate Allocations to S3 Based on Allocation to S2.
Remaining quantity to allocate = 130 - 125 = 5

Step 7: Respect Order Modifiers If They Exist
S3 allocation: 5 becomes 21 because the minimum order quantity for S3 is 21 (see order 
modifiers at each source table).

Step 8: Allocation to S3 with Following Constraints: Capacity, Lead Times, and Reception Calendars.
Tuesday is a valid reception date. The reception date must be moved to Monday 7/14 
due to postprocessing lead-time. This respects all lead-times (see supplier delivery 
patterns table and supplier processing information table).

Cumulative Available Capacity = 60

This table shows you the resource availability after all allocations so far have consumed 
capacity. 

Source 7/10/98 (Thu) 7/11/98 (Fri) 7/14/98 
(Mon)

7/15/98 (Tue) 7/16/98 
(Wed)

S1 0 0 0 60 66
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Source 7/10/98 (Thu) 7/11/98 (Fri) 7/14/98 
(Mon)

7/15/98 (Tue) 7/16/98 
(Wed)

S2 80 35 0 84 88

S3 20 19 0 21 22

Note: Scheduled receipt excess = 16 (for netting gross requirements for 
the next planning period) (see horizontal plan table).

This table shows summary of planned order allocations for demand #1.

Source Allocation Date

S1 180 7/14/98

S2 125 7/14/98

S3 21 7/14/98

The values for S1 come from Step 1: Allocation to S1, page 6-38, the values for S2 come 
from Step 4: Respect Order Modifiers If They Exist, page 6-39, and the values for S3 
come from Step 7: Respect Order Modifiers If They Exist, page 6-40.

Input Data for Demand #2
See demand table.

Quantity = 280

Due Date = 7/16/98 (Wednesday)

Unsatisfied Demand = 280 - 16 (scheduled receipt excess) = 264

Allocations for Demand #2
Step 1: Allocation to S1
Wednesday is delivery date. The receiving date must be moved to Tuesday, 7/15, due to
postprocessing lead-time.

Tuesday is not a reception date. The allocation date is moved to Monday, 7/14/98.

Cumulative available capacity = 0 (tolerance percentage = 0) (see supplier capacity 
profile after S3 allocation table), hence allocation to S1 = 0.

Unsatisfied demand = 280 - 16 (excess supply due to order modifiers from previous 
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bucket(s) = 264.

Step 2: Calculation of Historical Allocations for Alternate Sources
Consider S2 and S3 with rank 2 from the historical allocation totals table and the 
summary of planned order allocations for demand #1 table.

Historical Allocations beginning 1/1/98.

S2: 1400 + 125 = 1525

S3: 1000 + 21 = 1021

Total Allocations for S2 and S3 = 2546

Step 3: Calculate Allocations to S2 Based on Historical Allocations and Target Sourcing 
Percentages.

Note: Because S2 has a higher sourcing percentage, we will begin with 
allocations to S2.

Target Sourcing Percentages: S2 = 60%

Total Target Allocation = Historical allocation + New allocation = 2546 + 264 = 2810

Using the S2 target allocation percentage, calculate the allocation to S2.

(S2 + 1525)/2810 = 0.6

S2 Allocation = 161 

Step 4: Respect Order Modifiers If They Exist. 
S2 Allocation: 161 becomes 175 because S2 has a fixed lot multiple of 25 (see order 
modifiers at each source table), and to respect that 7*25 = 175 needs to be allocated.

Step 5. Allocation to S2 With Following Constraints: Capacity, Lead Times, and Reception 
Calendars.
S2: Allocation = 175.

Date = 7/16/98 (Wednesday)

Reception date must be moved to Tuesday 7/15 due to postprocessing lead-time of one 
day (see order modifiers at each source table). Tuesday is not a reception date. 
Allocation date moved to Monday 7/14/98. This respects the processing and 
postprocessing lead-times.

Cumulative Available Capacity = 115 (see supplier capacity profile after S3 allocation 
table)

Respecting order modifiers: allocation of 115 becomes 125 because S2 has a fixed lot 
multiple of 25. To respect that, 5 x 25 = 125 needs to be allocated. However, accumulated
capacity for S2 by 7/14/98 is 115, which is not a multiple of 25. Therefore, 100 units, 
which is the next lower value respecting order modifier and capacity will be scheduled.

This table shows you the resource availability after all allocations so far have consumed 
capacity.
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Source 7/10/98 (Thu) 7/11/98 (Fri) 7/14/98 
(Mon)

7/15/98 (Tue) 7/16/98 
(Wed)

S1 0 0 0 60 66

S2 15 0 0 84 88

S3 20 19 0 21 22

Step 6: Calculate Allocations to S3 Based on Allocation to S2.
Remaining quantity to allocate = 264 - 100 = 164

Step 7: Respect Order Modifiers If They Exist.
S3 Allocation: 164 becomes 168 because S3 has a fixed lot multiple of 7, so 24*7 = 168 
needs to be ordered.

Step 8. Allocation to S3 With Following Constraints: Capacity, Lead Times, and Reception 
Calendars.
Allocation date moved to Tuesday 7/15/98 due to postprocessing lead-time. Tuesday is 
a valid reception date. This respects all lead-times.

Cumulative Available Capacity = 60

Respecting order modifiers: allocation of 60 becomes 63 because S3 has an order 
modifier of 7. To respect that, 9*7 = 63 needs to be allocated. However, accumulated 
capacity at S3 by 7/14/98 is 60, which is not a multiple of 7. Therefore, 56 units, which is 
the next lower value respecting order modifiers and capacity will be scheduled.

Unsatisfied quantity = 164 - 56 = 108

This table shows you the capacity available after all allocations so far have consumed 
capacity.

Source 7/10/98 (Thu) 7/11/98 (Fri) 7/14/98 
(Mon)

7/15/98 (Tue) 7/16/98 
(Wed)

S1 0 0 0 60 66

S2 15 0 0 84 88

S3 4 0 0 0 22

Search for Alternative Sources:

• S1: Not possible due to postprocessing lead-time and reception date constraints.

• S2: Wednesday is not a delivery date. Tuesday is not a delivery date.
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Allocation of Excess Demand:

• Excess Demand = 108

• Allocate excess demand to primary source S1. 

• Postprocessing = 1 day becomes Tuesday, 7/15/98 (7/16 minus 1 day of 
postprocessing = Tuesday, 7/15).

• Because Tuesday 7/15 is not a delivery date, the load excess is moved to Monday 
7/14/98.

This table 6-17 shows you the capacity availability after all allocations so far have 
consumed capacity.

Source 7/10/98 (Thu) 7/11/98 (Fri) 7/14/98 
(Mon)

7/15/98 (Tue) 7/16/98 
(Wed)

S1 0 0 0 60 66

S2 15 0 0 9 88

S3 4 0 0 0 22

This table shows the summary of allocations for planned order #2.

Source Allocation Date

S1 108 7/14/98

S2 100 7/14/98

S3 56 7/16/98

This table shows the planned order allocations summary.

Source 7/10/98 (Thu) 7/11/98 (Fri) 7/14/98 
(Mon)

7/15/98 (Tue) 7/16/98 
(Wed)

S1 0 0 288 (180 + 
108)

0 0
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Source 7/10/98 (Thu) 7/11/98 (Fri) 7/14/98 
(Mon)

7/15/98 (Tue) 7/16/98 
(Wed)

S2 0 0 125 100 0

S3 0 0 21 56 0

Enforce Sourcing Splits
Supplier contracts require that a company source its materials from suppliers based on 
specified allocation percentages. Similarly, requirements such as labor agreements 
necessitate adherence to allocation percentages from internal organizations.

You can control whether the planning process treats contractual sourcing allocation 
percentages as constraints, or is free to flex the allocation percentages to achieve plan 
objectives. 

Oracle ASCP and Inventory Optimization impose the sourcing allocation percentages 
during optimization.

To invoke enforce sourcing splits functionality
1. Specify Allocation Percentages.

1. Sign on using the Advanced Supply Chain Planner responsibility.

2. From the Navigator, choose Sourcing > Sourcing Rules.

The Sourcing Rule screen appears.

3. Specify the sourcing Allocation Percentages in the Sourcing Rule form using the
Allocation % field. 

2. Specify Sourcing Allocation Window.

1. Sign on using the System Administrator responsibility.

2. From the Navigator, choose Profile > System.

The Find System Profile Values screen appears.

3. Enter the profile option name, or use the search feature to search for a 
component of the profile option name (for example, you could search on the 
word Sourcing). 

4. Select the Find button.

The System Profile Values screen appears. 
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You can specify the new profile option called MSO: Sourcing Allocation 
Window in the System Profile Values form. The default value is 7 days. 

You can specify a length of time (in days) used to satisfy the allocation 
percentages. This time period during which the allocation percentages are 
enforced is called Sourcing Allocation Window. The sourcing constraints are 
enforced in a rolling horizon manner, in multiples of the Sourcing Allocation 
Window, with the finest granularity being the specific time bucket.

3. Specify Sourcing Percentage Variance.

In the System Profile Values screen, you can specify the new profile option called 
MSC: Sourcing Variance Tolerance in the System Profile Values form. The default 
value is 0.05 (5%). 

The system allows you to specify a tolerance band for the difference between the 
user-specified allocation percentages and the plan-derived allocation percentages. If
the difference is greater than the tolerance, then an exception is triggered.

4. Specify Allocation History Start Date.

In the System Profile Values screen, you can specify the new profile option called 
MSC: Start Date Offset for Sourcing History (Months) in the System Profile Values 
form. The default value is Null (system collects all history if the collection 
parameter Recalculate History is set to Yes). 

The system allows you to specify a global allocation percentages start date from 
which the sourcing history is collected and accumulated for making sourcing 
decisions. The allocation history is ignored if the sourcing rule effectivity date is 
after the plan date.

5. Enforce Sourcing Constraints.

At the plan level, the system allows you to enable sourcing constraints for all 
sourcing rules. You can enable sourcing constraints by selecting the Enforce 
Sourcing Constraints checkbox in the Options tab of the Plan Options form. 

1. Sign on using the Advanced Supply Chain Planner responsibility.

2. From the Navigator, choose Supply Chain Plan > Options.

The Plan Options screen appears.

3. Select the Enforce Sourcing Constraints checkbox.

Enforce Sourcing Splits Example
The following example shows how to use the enforce sourcing splits feature. 

Suppliers S1 and S2 have the following contractual allocations:

• Supplier S1: 50%
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• Supplier S2: 50%

The table below summarizes supply and demand and sourcing allocation 
percentages for suppliers S1 and S2.

Demand/Suppl
y/Sourcing 
Allocation

Day 1 Day 2 Day 3 Day 4

Dependent 
Demand

0 3 0 3

Planned Order 
Supply, S1

0 2 0 1

Planned Order 
Supply, S2

0 1 0 2

Cumulative 
Allocation, %, 
S1

0% 67% 67% 50%

Cumulative 
Allocation %, S2

0% 33% 33% 50%

On Day 2, it is not possible to exactly achieve the contractual 50%/50% split, so 
planned order supplies that achieve the closest possible split (67%/33%) are 
generated.

On Day 4, S2 is given a higher allocation in order to bring the cumulative allocation 
to the desired 50%/50%.

In this example, the sourcing allocation window is assumed to be equal to one day. 

Constraints Precedence
If you select the Enforce Sourcing Constraints at the plan option level, the precedence 
among the above constraints are established as follows:

Case 1 - Enforce Demand Due Dates 
You have selected the Enforce Demand Due Dates or the Enforce Service Levels plan 
option. In this case, the order of priority among the constraints is as follows:

1. Enforce Demand Due Dates/Enforce Service Levels (highest priority)

2. Enforce Capacity Constraints
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3. Enforce Sourcing Constraints (lowest priority)

Case 2 - Enforce Capacity Constraints 
You have selected the Enforce Capacity Constraints plan option. In this case, the order 
of priority among the constraints is as follows:

1. Enforce Capacity Constraints (highest priority)

2. Enforce Demand Due Dates/ Enforce Service Levels

3. Enforce Sourcing Constraints (lowest priority)

Note that in either case, the sourcing constraints have the lowest priority; that is, 
these constraints may be violated, if required, to satisfy the capacity constraints or 
to meet demands.

Consideration of Rank 1 Sources 
Only Rank 1 sources are considered for enforcing sourcing allocation percentages. The 
allocation percentages are ignored for sources of ranks 2 and higher. 

The system considers sources of ranks 2 and higher only if there is insufficient capacity 
among rank 1 sources to meet the required supply. If one or more rank 1 sources fall 
short of capacity, the sourcing allocation percentages are ignored, and the system 
allocates supply quantities among the sources of ranks 1 and higher based on cost and 
capacity considerations. The enforcement of ranking priority functionality is unchanged
and it is accomplished by means of internal penalty factors.

Interorganization Allocations
The allocation percentages are enforced for all sourcing types:

• External supplies from suppliers

• Transfer supplies from internal organizations 

• Make supplies made within an organization

Penalty Cost for Violation of Sourcing Allocation Percentages
The system automatically uses internal penalty factors (i.e., not exposed to user) to 
minimize deviations from the desired allocation percentages. The system chooses 
penalty factors such that the sourcing constraints violations are penalized less than the 
unmet demands and capacity violations.

Setting Up Routings
The manufacturing process or routing to make a product includes the operations that 
are required to be performed in a predetermined sequence. 
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Operation Resource Schedule Flag

Some resources are also required to carry out these operations and these resources need
to be scheduled. The schedule flag determines whether a resource is scheduled.

When the schedule flag has been set to No, the corresponding operation resource is not 
brought over to the planning server as a part of the routings and is not scheduled. 
When the schedule flag has been set to Yes, Prior, or Next, the corresponding operation 
resources are brought over to the planning server as a part of the routings collection. 

Within an operation, the planning engine assumes that there is at most one PRIOR 
activity and at most one NEXT activity. Also if you need to specify an activity as 
PRIOR, it should be the first activity within the operation; if you need to specify an 
activity as NEXT, it should be the last activity in the operation.

If a PRIOR activity is not the first activity, the planning engine sets all preceding 
activities to PRIOR also, regardless of the routing definition. If a NEXT activity is not 
the last activity, the planning engine sets all succeeding activities to NEXT also, 
regardless of the routing definition.

If you need a NEXT activity as an intraoperation step, break the routing into two 
operation steps so that the NEXT is at the end of the first of two operations rather than 
in the middle of one operation.

To model the resource schedule
1. Sign on using the Manufacturing and Distribution Manager responsibility.

2. From the Navigator, select Bill of Material > Routings > Routings.

The Routings screen appears.

3. Select Operation Resources.

Operation Resources screen appears. 

4. Set up resource schedule from the Scheduling tab. The possible values for the 
schedule flag are: Yes, No, Prior, Next. 

For details on other columns and functionality, refer to the Routings chapter in the 
Oracle Bills of Material User's Guide.

Modeling Minimum Transfer Quantity (MTQ)
When planning for long-running jobs or batches, Oracle Advanced Supply Chain 
Planning can plan for the arrival of the necessary raw materials or ingredients from 
external suppliers as well as from other internal organizations to occur incrementally 
throughout the duration of the job or batch instead of the raw materials to arrive prior 
to the start of the job. This reduces the total manufacturing lead-time significantly.

Oracle Advanced Supply Chain Planning also allows you to model overlaps of 
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manufacturing operations in different organizations. An operation of a routing in the 
downstream organization can start after completion of a Minimum Transfer Quantity 
(MTQ) at the operation of another routing in the upstream organization.

Note: Theoretically, it is possible to combine Minimum Transfer 
Quantity with incremental supplies.

Understanding Minimum Transfer Quantity
Oracle Advanced Supply Chain Planning allows you to specify a Minimum Transfer 
Quantity, which is the minimum amount that an operation must be completed in order 
to trigger the start of the next operation.

Minimum Transfer Quantity is used to model production operations in which materials
are transferred in lots smaller than the processing lots, resulting in subsequent 
operations that start before the current operation is completely finished. You can specify
Minimum Transfer Quantities between routings as well as between operations of a 
routing. Oracle Advanced Supply Chain Planning respects Minimum Transfer Quantity
while scheduling operations.

In the process of scheduling an operation, Oracle Advanced Supply Chain Planning 
dynamically uses the production rate of the selected alternative resource to determine 
when to begin the material transfer to the subsequent operation. Production breaks are 
honored.

Oracle Advanced Supply Chain Planning allows you to model Minimum Transfer 
Quantity between operations across routings, in a single organization as well as 
between multiple organizations. This implies that a downstream operation of a routing 
in one organization can start after completion of Minimum Transfer Quantity at the 
upstream operation of another routing in a different organization.

The following diagram shows how the planning engine uses the Minimum Transfer 
Quantity:

Minimum Transfer Quantity

You can specify the Minimum Transfer Quantity between routings and between 
operations. Oracle Advanced Supply Chain Planning schedules operations with respect 
to Minimum Transfer Quantity.

Specifying Minimum Transfer Batch Size
You can specify the Minimum Transfer Quantity in the following manner:
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• Interrouting (between routings): The Minimum Transfer Quantity is specified for 
the last operation of the upstream routing.

• Intrarouting (between operations of one routing): The Minimum Transfer Quantity 
is specified for the current operation.

MTQ Between Processes With Different Run Rates
Oracle Advanced Supply Chain Planning models MTQ with respect to the resource run 
rates of the upstream and downstream processes. These processes can have the same 
run rates or different run rates. The scheduling results can be different due to these 
rates. 

Example - Downstream process is slower than the upstream process or it has the same 
rate
Consider a routing with two operations, Operation 10 using resource R1 and Operation 
20 using resource R2. There is an MTQ between Operations 10 and 20. The following 
equation presents the relationship between the resources run rates:

• R1 Run Rate >= R2 Run Rate

Operation 20 can start after the completion of MTQ at Operation 10 with respect to 
resource availability.

Downstream process is slower than the upstream process or it has the same rate 

Example - Downstream process is faster than the upstream process 
Consider a routing with two operations, Operation 10 using resource R1 and Operation 
20 using resource R2. There is an MTQ between Operations 10 and 20. The following 
equation presents the relationship between the resources run rates:

• R1 Run Rate < R2 Run Rate

The planning engine schedules Operation 20 such that the end of Operation 20 is 
beyond the end of Operation 10 with minimum of MTQ.

• Operations Finish Times Constraint: Operation 20 Finish Time - Operation 10 Finish
Time >= MTQ
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Downstream process is faster than the upstream process

A similar constraint holds for activities with respect to MTQ. Consider an operation 
with two activities, Activity 1 using resource R1 and Activity 2 using resource R2. The 
MTQ between Activity 1 and Activity 2 is inferred for the operation MTQ. The 
following equation presents the relationship between the resources run rates:

R1 Run Rate < R2 Run Rate

The planning engine schedules Activity 2 such that the end of Activity 2 is beyond the 
end of Activity 1 with minimum of MTQ.

• Activities Finish Times Constraint: Activity 2 Finish Time - Activity 1 Finish Time 
>= MTQ

Downstream process is faster than the upstream process

Consideration of Resource Breaks
When resource breaks are present, Oracle Advanced Supply Chain Planning adjusts the
start time of the next operation with respect to the start time of the current operation. 
This ensures that the planning engine respects the Minimum Transfer Quantity 
constraints and also avoids starvation of the next operation. For more details, see the 
following examples:

• Resource Break: Scenario 1, page 6-52

• 'Resource Break: Scenario 2, page 6-53

• 'Resource Break: Scenario 3, page 6-55

• 'Resource Break: Scenario 4, page 6-56

Resource Break: Scenario 1
Consider:
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• The upstream activity has a break within MTQ (MTQ is available after the break) 

• The break delays the start of the downstream activity by delaying the time at which 
MTQ units are completed by the upstream operation.

• MTQ = 100 units = 3 hours

• Break 1 = 15 minutes starting at 10:00 am

• Runtime activity of Operation 10 starts at 9:45 am.

• A = 15 minutes

• B = 2 hours and 45 minutes

• MTQ Production Time = A + B = 3 hours 

• Runtime activity of Operation 20 can start any time after 1:00 pm (9:45 am + 3 hours 
+ 15 min = 1:00 pm) with respect to the Activities Finish Times Constraint.

Resource Break: Scenario 1

Result:

• Runtime Activity OP 20 Start Time >= (Runtime Activity OP 10 Start Time) + MTQ +
Break 1

Resource Break: Scenario 2
Consider:

• The upstream activity has a break after the completion of MTQ (MTQ is available 
before the break) 

• MTQ = 100 units = 3 hours

• Break 2 = 15 minutes starting at 2:00 pm
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• Runtime activity of Operation 10 starts at 9:45 am.

Case 1
• If the downstream activity is faster than the upstream activity or it has the same run

rate as the upstream activity, the downstream activity can start after MTQ 
Production Time plus break. The break postpones the start of the downstream 
activity.

• Runtime activity of Operation 20 can start any time after 1:00 pm (9:45 am + 3 hours 
+ 15 min = 1:00 pm) with respect to the Activities Finish Times Constraint.

Resource Break: Scenario 2: Case 1

Result:

• T >= MTQ + Break 2

• Runtime Activity OP 20 Start Time >= (Runtime Activity OP 10 Start Time) + MTQ +
Break 2 

Case 2
• If the downstream activity is slower than the upstream activity, then the 

downstream activity can start any time after MTQ.

• Runtime activity of Operation 20 can start any time after 12:45 pm (9:45 am + 3 
hours = 12:45 pm) with respect to the Activities Finish Times Constraint.
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Resource Break: Scenario 2: Case 2

Result:

• Runtime Activity OP 20 Start Time >= (Runtime Activity OP 10 Start Time) + MTQ

• In case 1, if the downstream activity cannot start after MTQ plus break time (for 
example the activity start time has been firmed after MTQ but before MTQ plus 
break time), then there is a potential for starvation at the downstream activity.

Resource Break: Scenario 2: Continuation of Case 2

This implies that the above constraint can be violated with respect to firm requirements.

Resource Break: Scenario 3
Consider:

• Both the upstream and downstream activities have equal breaks at the same time 
after the completion of MTQ 
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• MTQ = 100 units = 3 hours

• Break 2 = 15 minutes starting at 2:00 pm

• Break 3 = 15 minutes starting at 2:00 pm

• Runtime activity of Operation 10 starts at 9:45 am.

• The downstream activity starts after MTQ with respect to the equal breaks. 

• Runtime activity of Operation 20 can start any time after 12:45 pm (9:45 am + 3 
hours = 12:45 pm) with respect to the Activities Finish Times Constraint. 

Resource Break: Scenario 3

Result:

• Runtime Activity OP 20 Start Time >= (Runtime Activity OP 10 Start Time) + MTQ 

• This scenario is also valid if the downstream activity break is greater than the 
upstream activity break. 

Resource Break: Scenario 4
Consider:

• Both the upstream and downstream activities have unequal breaks at the same time
after the completion of MTQ 

• MTQ = 100 units = 3 hours

• Break 2 = 30 minutes starting at 2:00 pm

• Break 3 = 15 minutes starting at 2:15 pm

• Break 2 (upstream activity) > Break 3 (downstream activity) 
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• Runtime activity of Operation 10 starts at 9:45 am.

• Considering the larger break of the upstream activity, the downstream activity can 
start any time after MTQ plus the difference of the breaks. 

• Runtime activity of Operation 20 can start any time after 1:00 p.m. [9:45 a.m. + (3 
hours) + (30 min -15 min) = 1:00 p.m.] with respect to the Activities Finish Times 
Constraint.

Result:

• Runtime Activity OP 20 Start Time >= (Runtime Activity OP 10 Start Time) + MTQ +
(Break 2 - Break 3)

• If the downstream activity cannot start after MTQ plus the difference of the breaks 
(for example the activity start time has been firmed after MTQ but before MTQ plus
the difference of the breaks), then there is a potential for starvation at the 
downstream activity.

Modeling Material Transfers
When raw materials are replenished by external suppliers, Oracle Advanced Supply 
Chain Planning respects order quantity-limiting modifiers such as fixed order quantity, 
issues multiple raw material replenishment orders for each long-running production 
job, then staggers the due dates of the replenishment orders across the duration of the 
job.

When raw materials are replenished by internal organizations, Oracle Advanced 
Supply Chain Planning can model the replenishment as either of the following:

• Continuous transfer- The production order in the destination organization is 
permitted to start after a suitable time offset from the raw material production 
order in the source organization.

The downstream process receives material in lot sizes of 1 from the upstream 
process. The transfer starts on or after the completion of Minimum Transfer 
Quantity at the upstream process.

• Discrete incremental or non-continuous transfer - Multiple transfer orders that 
respect quantity limitations imposed by order modifiers are created, and their due 
dates are staggered across the duration of the production order in the destination 
organization.

The downstream process receives material in discrete increments (more than 1 at a 
time) from the upstream process.

When you use incremental planned orders, downstream supply can be split into 
multiple planned orders. In this case, the planned order demand driving these planned 
orders has a demand date of the later of the planned orders. By referring to the planned 
order demand, it could appear that the planned order supply occurs after the start of a 
scheduled activity. For example:



6-58    Oracle Advanced Supply Chain Planning Implementation and User's Guide

• An assembly supply order calls for making quantity 30 

• An activity is scheduled 13-JAN 22:41:00 to 13-JAN 22:59:00

• The planning engine creates incremental planned orders quantity 5 for 13-JAN 
22:41:00 and quantity 25 for 13-JAN 22:44:00

• The planned order demand becomes quantity 30 on 13-JAN 22:44:00

You can also model material transfers with respect to convergence and divergence of 
supplies. In case of divergence, supply from one upstream process splits into two or 
more downstream processes of the same item. In case of convergence, supplies from 
two or more upstream processes of the same item are sent to (consumed by) one 
downstream process.

You can adopt the following supply chain models for material transfer from suppliers 
and internal organizations:

• 'To model continuous transfer inside one organization, page 6-58

• 'To model continuous transfer across organization, page 6-60

• 'To model non-continuous transfers inside one organization with incremental 
supplies, page 6-62

• 'To model non-continuous transfers inside one organization with incremental 
consumption, page 6-63

• 'To model non-continuous transfers across organizations with incremental supplies,
page 6-64

• 'To model non-continuous transfers across organizations with incremental 
consumption, page 6-65

• 'To model non-continuous transfers across organizations with both incremental 
supplies and incremental consumption, page 6-66

• 'To model non-continuous transfers between suppliers and internal organizations, 
page 6-67

To model continuous transfer inside one organization
1. Select the Manufacturing and Distribution Manager responsibility.

2. Navigate to Bill of Materials > Routings > Routings.

3. Define Routing.

4. Define Routing Operations.
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5. Select the WIP tab.

6. Specify Min Transfer Qty for the feeding operation.

The Minimum Transfer Quantity is applied between the last scheduled activity of 
the upstream producing operation and the first scheduled activity of the 
downstream consuming operation.

In regular routings the last operation of the routing is considered as the producing 
operation. In case of network and complex routings, the upstream feeding 
operation can be any one of the operations in the upstream routing. 

In case of process manufacturing, you can define Min Transfer Qty in the Operation
Details Activities form.

7. Navigate to Operation Resources > Scheduling tab.

8. Set the Basis field to:

1. Item for value added activities (runtime).

2. Lot for setup (preparation) and teardown (clean up) activities.

9. Set the Schedule field to:

• Yes for value added activities (runtime)

• Prior for setup activities (preparation)

• Next for teardown activities (clean up)

Note: The planning engine models Minimum Transfer 
Quantity only if both upstream and downstream operations 
have at least one activity.

10. Navigate to Items > Organization Items > General Planning tab:

11. Set the following item order modifiers:

• Maximum Order Quantity

• Fixed Order Quantity

• Fixed Days Supply

Example: Continuous transfer inside one organization
Consider:

• Items A and X are produced in Organization 1.
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• Item A routing consists of 2 operations - OP 10 and OP 20 - and each operation 
consists of 3 activities: Preparation, Runtime, and Clean Up.

• Item X routing also consists of 2 operations - OP 10 and OP 20 - and each operation 
consists of 3 activities: Preparation, Runtime, and Clean Up.

• The Runtime activity of operation 20 can start after completion of MTQ at the 
Runtime activity of operation 10.

Refer the figure below to view the continuous transfer modeling in Organization 1:

Continuous transfer inside one organization with MTQ

Result: The downstream process starts after a minimum quantity from the upstream 
process has been completed. The material transfer is continuous after the Minimum 
Transfer Quantity is completed.

To model continuous transfer across organization
This type of transfer is modeled for processes with continuous flow.

1. Complete from Step 1-9 listed in the section 'To model continuous transfer inside 
one organization, page 6-58.

2. Navigate to Item > Organization Items > MPS/MRP Planning tab.

3. Set the Continuous Inter-Org Transfers item attribute to Yes.

Alternatively, you can also set the profile option MSO: Continuous transfer across 
organizations to Yes in the Personal Profile Values form.
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4. Navigate to Items > Organization Items > General Planning tab:

5. Set the following item order modifiers:

• Maximum Order Quantity

• Fixed Order Quantity

• Fixed Days Supply

Example: Continuous transfer across organizations
Consider:

• Items A is produced in Organization 1.

• Item A routing consists of 2 operations - OP 10 and OP 20 - and each operation 
consists of 3 activities: Preparation, Runtime, and Clean Up.

• The Runtime activity of operation 20 can start after completion of MTQ at the 
Runtime activity of operation 10.

• Item X is produced in Organization 2.

• Item X routing consists of 2 operations - OP 10 and OP 20 - and each operation 
consists of 3 activities: Preparation, Runtime, and Clean Up.

• The Runtime activity of operation 20 can start after completion of Minimum 
Transfer Quantity at the Runtime activity of operation 10.

Refer the figure below to view the continuous transfer modeling between Organization 
1 and Organization 2:



6-62    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Continuous transfer across organizations

Result: 

• Downstream operation of the routing in Organization 2 starts after completion of 
Minimum Transfer Quantity at the upstream operation of the routing in 
Organization 1. 

• The planning engine adds the in-transit time between organizations and the item 
postprocessing lead-time to the specified Minimum Transfer Quantity to trigger the
start of the downstream process.

To model non-continuous transfers inside one organization with incremental supplies
1. Navigate to Item > Organization Items > MPS/MRP Planning tab.

2. Set the Divergence Pattern item attribute to Series.

Alternatively, you can set the profile option MSO: Divergent Supply Feeding 
Pattern for Intra-Org Sourced orders to Series in the Personal Profile Values form.

3. Navigate to Items > Organization Items > General Planning tab:

4. Set the following item order modifiers:

• Maximum Order Quantity 

• Fixed Order Quantity
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• Fixed Days Supply

Example: Non-continuous transfers inside one organization with incremental supplies
Refer the following figure to understand how Oracle Advanced Supply Chain Planning 
allows you to model incremental transfer of supplies within an organization. The 
downstream process is incrementally fed with the supply segments of the upstream 
process.

Non-continuous transfers inside one organization with incremental supplies

Result: Order 1 of Item B can start after the completion of the first supply segment of 
Item A.

To model non-continuous transfers inside one organization with incremental consumption
1. Navigate to Item > Organization Items > MPS/MRP Planning tab.

2. Set the Convergence Pattern item attribute to Series.

Alternatively, you can set the profile option MSO: Convergent Supplies 
Consumption Pattern for Intra-Org Sourced orders to Series in the Personal Profile 
Values form

3. Navigate to Items > Organization Items > General Planning tab:

4. Set the following item order modifiers:

• Maximum Order Quantity 

• Fixed Order Quantity

• Fixed Days Supply

Example: Non-continuous transfers inside one organization with incremental consumption
Refer the following figure to understand how Oracle Advanced Supply Chain Planning 
allows you to model incremental consumption of supplies within an organization. The 
downstream process incrementally consumes supply orders of the upstream process.
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Non-continuous transfers inside one organization with incremental consumption

Result: The supply orders of Item A are consumed in two increments by the 
downstream process of Item B. In this case, the overlap between the upstream process 
and the downstream process reduces the cycle time.

To model non-continuous transfers across organizations with incremental supplies
1. Navigate to Item > Organization Items > MPS/MRP Planning tab.

2. Set the Divergence Pattern item attribute to Series.

Alternatively, you can set the profile option MSO: Divergent Supply Feeding 
Pattern for Inter-Org and Supplier Sourced orders to Series in the Personal Profile 
Values form.

3. Navigate to Items > Organization Items > General Planning tab:

4. Set the following item order modifiers:

• Maximum Order Quantity

• Fixed Order Quantity

• Fixed Days Supply

Non-continuous transfers with incremental supplies in case of within an organization as
well across organizations use the same item attribute:

• Set the Divergence Pattern item attribute to Series

However, non-continuous transfers with incremental supplies in case of within an 
organization use the profiles options:

• MSO: Divergent Supply Feeding Pattern for Intra-Org Sourced orders to Series

Whereas, non-continuous transfers with incremental supplies in case of across 
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organizations use the profiles options:

• MSO: Divergent Supply Feeding Pattern for Inter-Org and Supplier Sourced orders 
to Series

Example: Non-continuous transfers across organizations with incremental supplies
Refer the following figure to understand how Oracle Advanced Supply Chain Planning 
allows you to model incremental transfer of supplies between organizations. The 
downstream process is incrementally fed with the supply segments of the upstream 
process.

Non-continuous transfers across organizations with incremental supplies

Results:

• Transfer Order 1 and Transfer Order 2 of Item A can start after the completion of 
the corresponding supply segments of Item A at organization 1.

• Order 1 and Order 2 of Item B can start after the arrival of shipments of Item A 
supply segments (transfer orders) at organization 2. In other words, the production 
process for Item B Order 1 can start earlier when compared to non-incremental case.

• The two supply segments are generated based on the two transfer orders.

To model non-continuous transfers across organizations with incremental consumption
1. Navigate to Item > Organization Items > MPS/MRP Planning tab.

2. Set the Convergence Pattern item attribute to Series.

Alternatively, you can set the profile option MSO: Convergent Supplies 
Consumption Pattern for Inter-Org and Supplier Sourced orders to Series in the 
Personal Profile Values form.

3. Navigate to Items > Organization Items > General Planning tab:
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4. Set the following item order modifiers:

• Maximum Order Quantity

• Fixed Order Quantity

• Fixed Days Supply

Example: Non-continuous transfers across organizations with incremental consumption
Refer the following figure to understand how Oracle Advanced Supply Chain Planning 
allows you to model incremental consumption of supplies between organizations. The 
downstream process incrementally consumes the supply orders of the upstream 
process.

Non-continuous transfers across organizations with incremental consumption

Result: The transfer orders of Item A are consumed in two increments by the 
downstream process of Item B. In this case, the overlap between the transfer orders and 
the downstream process reduces the cycle time.

To model non-continuous transfers across organizations with both incremental supplies 
and incremental consumption
1. Navigate to Item > Organization Items > MPS/MRP Planning tab.

2. Set the Divergence Pattern item attribute to Series.

Alternatively, you can set the profile option MSO: Divergent Supply Feeding 
Pattern for Inter-Org and Supplier Sourced orders to Series in the Personal Profile 
Values form.

3. Set the Convergence Pattern item attribute to Series.

Alternatively, you can set the profile option MSO: Convergent Supplies 
Consumption Pattern for Inter-Org and Supplier Sourced orders to Series in the 
Personal Profile Values form.
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4. Navigate to Items > Organization Items > General Planning tab:

5. Set the following item order modifiers:

• Maximum Order Quantity

• Fixed Order Quantity

• Fixed Days Supply

Example: Non-continuous transfers across organizations with both incremental supplies 
and incremental consumption
Refer the following figure to understand how Oracle Advanced Supply Chain Planning 
allows you to model incremental supplies and incremental consumption of supplies 
between organizations.

Non-continuous transfers across organizations with incremental supplies and incremental 
consumption

Result: 

• The supply orders of Item A are consumed in two increments by the downstream 
process of Item B. 

• The overlap between the upstream process and the downstream process reduces 
the cycle time.

• Transfer Order 1 and Transfer Order 2 of Item A can start after the completion of 
the corresponding supply segments of Item A at Organization 1.

• The transfer orders of Item A are consumed in two increments by the downstream 
process of Item B. In this case, the overlap between the transfer orders and the 
downstream process reduces the cycle time.
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To model non-continuous transfers between suppliers and internal organizations 
1. Navigate to Items > Organization Items > General Planning tab.

2. Set the item order modifiers in the Organization Item form

3. Set the Convergence Pattern item attribute to Series.

Alternatively, you can set the profile option MSO: Convergent Supplies 
Consumption Pattern for Inter-Org and Supplier Sourced orders to Series in the 
Personal Profile Values form.

Example: Non-continuous transfers between suppliers and internal organizations
Refer the following figure to understand Oracle Advanced Supply Chain Planning 
allows you to model incremental consumption of supplies (Convergent Supplies 
Consumption Pattern) between suppliers and internal organizations. The downstream 
process incrementally consumes supply orders of the upstream process. 

Incremental supplies do not always start at the start of the downstream operation and 
after that. These can also start before the start of the downstream operation. 

Non-continuous transfers between suppliers and internal organizations

Result:

• The supply orders of Item A are consumed in two increments by the downstream 
process of Item B.

• The overlap between the supply orders and the downstream process reduces the 
cycle time.
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Alternate and Simultaneous Resources
This section discusses the business benefits from setting up alternate and simultaneous 
resources and discusses how to:

• Set up alternate resources.

• Set up simultaneous resources.

Business Benefits to Setting up Alternate and Simultaneous Resources
• You can schedule two or more resources (simultaneous resources) to be used at the 

same time within the job operation. For example: you can schedule a person 
resource operating a machine resource.

• You can define resource groups within the operation. This lets you give your 
primary resource a group number. This group can then be replaced by other 
resources. For example: a group of lathes can be replaced by a group of computer 
numerical control (CNC) machines.

• You have the ability to define substitute resources for each primary resource group 
defined. This enables you to specify resource sequences that can replace the 
primary resource group. For example: a group of lathes can be replaced by a group 
of CNC machines.

• You can assign a priority to the substitute resource groups, and specify the 
circumstances the substitute groups are to be considered. For example: you can 
assign a less expensive resources as priority 1, and a more expensive resources as 
priority 2. This means that resources with priority 1 (less expensive) will be used 
first.

• You have control over the relative end times of principal and simultaneous 
resources. Principal and simultaneous resources can start and end at the same time. 
Or, principal and simultaneous resources can start and the same time and end at 
different times, which avoids over consumption of capacity and improves resource 
utilization.

• A simultaneous resource is available as soon as processing is complete. If the 
simultaneous resource finishes early, it can be reassigned to other activities.

• You can control the scheduling of simultaneous resources across breaks, which 
avoids cases where the principal resource completes before the simultaneous 
resource.

• You can improve scheduling accuracy and quality because you can model your 
requirements precisely, which minimizes manual intervention and reduces cycle 
times.
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To set up alternate resources
1. From the Navigator, choose Bills of Materials > Routings > Routings. 

The Routings window appears.

2. From the menu bar, select View > Find. 

The Find Routings window appears.

3. Find your routing, by entering search criteria and selecting the Find button. 

The Routings window appears with your routing.

4. From the Main tab, select the operation sequence with which you want to set up 
and select the Operation Resources button.

The Operation Resources window appears with the first resource already entered. 
This resource is considered as a primary resource.

5. Select the Scheduling tab.

6. Enter the Substitute Group Number.

If you have a machine and a labor resource modeled as primary and simultaneous 
resources, enter the same substitute group number for both of them. This indicates 
that when replacing them with alternate resources, they are both replaces as a 
group.

Select the Principal Flag for the resource or one of the resources if there are multiple
present in the primary group.

7. Select the Alternate button.

The Operation Alternate Resources window appears.

8. Enter alternate resources and choose Replacement Group.

Replacement Group number establishes relative priority. Enter a value of 1 or 
higher. If you have multiple alternates, enter them as multiple rows with 
appropriate Replacement Group numbers to indicate priorities.

You can specify multiple resource sequences with the same replacement group 
number. This indicates that a set of primary resources are replaced by a set of 
alternate resources with the resource sequence number, and schedule sequence 
number, within each replacement group, indicating the order or simultaneity of 
scheduling within that replacement group.

9. Check the Principal Flag for your alternate resource as appropriate.



Supply Chain Plan Modeling    6-71

To set up simultaneous resources
1. From the Navigator, choose Bill of Materials > Routings > Routings. The Routings 

window appears.

2. From the menu bar, select View > Find. The Find Routings window appears.

3. Find your routing by entering search criteria and selecting the Find button. the 
Routings window appears with your routing.

4. From the Main tab, select the operation sequence within which you want to set up 
and select the Operation Resources button. the Operation Resources window 
appears with the first resource already entered. This resource is considered a 
primary resource.

5. Select the Scheduling tab.

6. On the Operation Resources - Scheduling page, enter simultaneous resources in the 
rows below the initial resource.

7. In the Schedule Seq. (schedule sequence) field, enter the same number for both 
principal and simultaneous resources.

This indicates to planning that the resources are simultaneous resources.

8. Select the Principal Flag check box to indicate that one of the resources is the 
principal resource.

Multiresource Scheduling
For some types of manufacturing operations, the duration can be shortened by applying
greater numbers of processing resources. For example, the duration of a visual 
inspection operation can be approximately halved by increasing the number of 
inspectors from one to two. For these types of divisible manufacturing operations, it is 
important to accurately plan for the shrinking of the operation duration as greater 
numbers of processing resources are deployed. It is also important to be able to 
designate certain operations as divisible and others as indivisible (one resource per 
operation). The multiresource scheduling feature of Oracle ASCP accomplishes these 
aims. 

Unconstrained planning mode does not use resources for scheduling. It uses fixed and 
variable lead times to backward schedule

Using Multiresource Scheduling
Shown below are examples of how this feature can be used in various manufacturing 
scenarios.
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Note: In the following scenarios, the notation Res 1, Res 2, etc., refers to 
multiple identical units of a single resource defined in Oracle Bills of 
Material, not to multiple distinct resources.

Scenario 1
In this scenario, multiple resource units work together on an operation (divisible).

A manufacturing house is assembling telephone handsets. The handset assembly job 
consists of one assembly operation that takes one hour. The manufacturing house has 
one resource called RES. The resource RES has 4 resource units which are 4 assemblers 
(Res 1, Res 2, Res 3, Res 4). Please note that within ASCP, a resource can be either a 
single or a multiple resource unit of the same type.

The job parameters are:

• Job: Handset assembly

• Job Qty: 6

• Resource RES units: Res 1, Res 2, Res 3, Res 4

• Usage rate: 1 hour per operation

The following figure shows how the resource unit allocation should be done.
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Scenario 1

Total processing time for the Job = 1.5 hours (when multiple resources can work 
together on a job)

Scenario 2 
This scenario shows a single unit per operation (indivisible).

In printed circuit board assembly, one resource unit is required to finish the entire 
operation. This is because the item is so small, only one person can handle it. Sometimes
even from the process perspective it is not possible to use two units on one job at one 
time. After soldering, cleaning is done by a machine in which the board goes inside the 
cleaning machine. In this case, two cleaners cannot work together on a single board.

The job parameters are:

• Job: PCB assembly

• Job Qty: 6

• Resource RES units: Res 1, Res 2, Res 3, Res 4

• Usage rate: 1 hour per operation

The following figure shows how resource unit allocation should be performed in this 
situation.

Note: In the following figure, Oracle ASCP assumes that during the 
second hour, Res 3 and Res 4 remain consumed for the purpose of 
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calculating resource utilization, and are not available for any other job. 
To overcome this approximation, you can define Res 1, Res 2, Res 3, 
and Res 4 as individual resources (instead of multiple units of the same 
resource).

Scenario 2

To assign resource units on a one-to-one basis
You select a rounding control attribute in the item master. When the Round Order 
Quantities flag is checked, it means only one resource unit can work on one assembly at
a time. 

1. From the Manufacturing and Distribution manager responsibility 

2. Select Inventory > Items > Master Items.

3. Use the scroll arrow so that the MPS/MRP Planning tab appears.

4. Check or uncheck Round Order Quantities.

Following are the few examples of behavior when rounding control attribute is 
checked.

Example 1
The job parameters are:

• Job quantity: 4

• Number of assigned resource units: 5
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• Job duration: 1 hour

Here, four resource units are assigned 4 jobs and the fifth resource unit is idle. The job 
takes one hour to complete.

Example 2
The job parameters are:

• Job quantity: 4

• Number of assigned resource units: 3

• Job duration: 2 hours

Here, all 3 resource units are occupied for first two hours (job duration). For the next 
two hours, only one resource unit is occupied. The job takes four hours to complete.

Example 3
The job parameters are:

• Job quantity: 8

• Number of assigned resource units: 3

• Job duration: 1 hour

Here, all 3 resource units are occupied for first two hours. For the next hour, two 
resource units are occupied. The job takes 3 hours to complete.

The following table also explains Example 3.

Example 3

Note: In ASCP, the number of resource units per operation/activity is 
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controlled by the Assigned Units field in the Routing form.

Example 4
Since Oracle ASCP treats the capacity of multiple units of a single resource as a large 
bucket (instead of as independent buckets for each resource unit), certain detailed 
scheduling decisions will be approximate and may not be locally optimal. For example, 
in the situation below:

The job parameters are:

• Assigned units: 2

• Job 1 quantity: 2

• Job 2 quantity: 4

• Job duration: 1 hour

• Max/available resource units: 3

In the figure below, the table to the left shows what happens when Job 2 is scheduled 
first and the table to the right shows what happens when Job 1 is scheduled first. Both 
of the outcomes shown in the figure below are possible, depending on the order in 
which the jobs are assigned to the resource units.

Example 4

Lead-time and the Planning Time Fence
Lead-times are portions of the span of time from recognizing the need for an order to 
receiving the goods to inventory.

The planning time fence defines a time period within which the planning engine may 
not create planned orders. Use planning time fence control for schedule stability during 
the initial periods of a plan.

The more realistic that your lead-times are, the more accurate the plan matches what 
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will actually occur during execution. Use planning time fence control for schedule 
stability during the initial periods of a plan.

Lead-time

Lead-time Introduction
Lead-times are portions of the span of time from recognizing the need for an order to 
receiving the goods to inventory.

This topic reviews the lead-times that Oracle Advanced Supply Chain Planning uses to 
plan and schedule. It also explains concurrent processes, profile options, plan options, 
and planning parameters that affect lead-time calculations.

Setting Lead-times
Set lead-time values for the planning engine to use in the following source system 
forms:

• Oracle Inventory > Organization items form > Item attributes > Lead-time tabbed 
region

• Oracle Purchasing > Approved Supplier List form

The planning engine does not use subinventory lead-times from Oracle Inventory. 
These values are for the Oracle Inventory Min-Max planning process.

Lead-time Item Attributes
This topic describes the lead-time item attributes. You define them:

• For each organization and not for the master organization

• In work days from the manufacturing calendar

For more information, see Oracle Inventory User's Guide.

Lead-time Item Attributes Definition
You can enter the following lead-time item attributes: 

• Preprocessing: The time required to place a purchase order or create a discrete job 
or schedule. This is also known as the paperwork or planning time.

• Fixed: The time required to complete the tasks to make an assembly that are 
independent of order quantity, for example, setup, fixed run time, or teardown 
times.

• Variable: The time required to complete the tasks to make an assembly that depend 
on order quantity, for example, run time. Oracle Bills of Material concurrent 
processes calculate this time.
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• Lead Time Lot Size: The typical quantity of the item that you buy, make or transfer. 
The default value is item attribute Standard Lot Size (set by Oracle Cost 
Management). 

Oracle Bills of Material concurrent process Calculate Manufacturing Lead Time 
uses this value to compute Processing.

• Processing: The time required for a supplier or your transfer from facility to deliver 
an item to your receiving dock or for you to manufacture an item. For make items, 
this is also known as manufacturing lead-time. For buy and transfer items, it 
includes in-transit time to your facility.

For transfer items, the planning engine only takes this lead time into account if the 
item is not planned at your source organization, If the item is planned at the source 
organization, the planning engine uses the lead times from the source organization.

• Postprocessing: The time required to receive a buy or transfer item from the 
receiving dock to inventory or for a make item from production to inventory.

For make items, post-production activities that you don't model in the item routing,
for example, quality control analysis and shipping preparation activities. The 
planning process adds this time to work orders that you have collected. Set it in the 
Item Attributes Mass Maintenance window, do not set it in the source using the 
Item Attributes window.

• Cumulative Manufacturing: For make items, the time required to make the item if 
you have all of the buy items in inventory and have to make all subassemblies and 
the item itself. 

• Cumulative Total: For make items, the time required to make the item if you have 
to purchase all of the buy items, make all subassemblies, and make the item itself. 

Lead-times and Order Dates
The lead-times define dates that are associated with planned orders and scheduled 
receipts for these items:

• Order date: The beginning of Preprocessing the date you should begin the 
processing to release the order.

• Start date: The end of Preprocessing and beginning of Processing; the date you, 
your supplier, or your ship from facility should begin work on the order.

• Dock date: The end of Processing and the beginning of Postprocessing; the date that
the material should be on your receiving dock.

• Due date: The end of Postprocessing and the date that the material should be in 
your inventory. For make orders, put the on-hand on hold to account for the post 
processing lead time.
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Lead-time Item Attributes and Lead Time Calculation Concurrent Processes
If you run the following Oracle Bills of Material concurrent processes, they can update 
lead-time values that you may have manually set: 

• Calculate Manufacturing Lead Time

• Calculate Cumulative Lead Time

• Rollup Cumulative Lead Time

These concurrent processes update the following lead-time item attribute fields:

• Fixed: Oracle Bills of Material concurrent process Calculate Manufacturing Lead 
Time calculates this time and update your manual entry for make items. It sums the
values in field Usage for lot-based, scheduled resources. 

• Variable: Oracle Bills of Material concurrent process Calculate Manufacturing Lead 
Times calculates this time and update your manual entry for make items. It sums 
the values in field Usage for item-based, scheduled resources. 

• Processing: The Oracle Bills of Material lead-time concurrent process Calculate 
Manufacturing Lead Time calculates this time and replaces your manual entry for 
make items. It uses calculation Fixed + (Variable * Lead Time Lot Size); if Lead Time
Lot Size does not have a value, it uses 1.

• Cumulative Manufacturing: The Oracle Bills of Material lead-time concurrent 
processes Calculate Cumulative Lead Time and Rollup Cumulative Lead Time 
calculates this time and replace your manual entry. For an assembly, they take each 
component's cumulative lead-time and subtract its operation lead-time offset in the 
assembly's routing. Then, they take the manufacturing lead-time of the assembly 
and add the largest adjusted cumulative manufacturing lead-time of its 
components.

• Cumulative Total: The Oracle Bills of Material lead-time concurrent processes 
Calculate Cumulative Lead Time and Rollup Cumulative Lead Time calculate this 
time and replace your manual entry. For an assembly, they take each component's 
cumulative lead-time and subtract its operation lead-time offset in the assembly's 
routing. Then, they take the manufacturing lead-time of the assembly, add the 
largest adjusted cumulative manufacturing lead-time of its components, and add 
the longest buy part lead-time of its components.

Decimal lead-time quantities denote times less then one day and are the result of the 
lead-time divided by 24 hours.

For more information, see Oracle Bills of Material User's Guide.

Safety Lead Time
Safety lead-time is a lead-time that you add to the normal lead-time of make and buy 
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items. You use it to instruct the planning engine to schedule supplies in advance of the 
demand due dates that peg to them for the purposes of:

• Having an inventory buffer to protecting against fluctuations in lead-time, demand 
(for example, forecast error), and supply (for example, variable supplier lead times 
and irregular operation yields)

• Providing a time buffer to recover from fluctuations by taking longer to 
manufacture the original units or by manufacturing more units either to handle 
increased demand or to replace unsuitable parts from the original supply run

Safety lead-time is sometimes referred to as protection time or safety time

You can also complete supplies earlier than the demands that peg to them using 
transient safety stock levels. See Safety Stock, page 6-133. Use safety stock lead-time 
instead of transient safety stock if you want to have: 

• Lower average inventory level: Safety lead-time creates less excess supply because 
it creates safety stock from supplies pegged to actual demands rather than to 
additional safety stock level demands

• Less late-satisfied demands: There are no supplies pegged to additional safety stock
level demands that compete against actual demands for manufacturing and 
supplier capacity

Safety stock lead-time is:

• Used in constraint-based planning and is not available for unconstrained planning

• A soft constraint. If hard constraints prevent moving the supply due date to honor 
the safety lead-time, the planning engine will not honor the safety lead-time

To set safety lead time:

• Set profile option MSO: Use Safety Lead Time to Yes

• For each item-organization, set item attribute Safety Stock Method to MRP Planned 
% then, in item attribute Safety Stock Percent, enter safety lead-time in days.

When the planning engine schedules a supply subject to safety lead-time, it:

• Creates planned orders based on demands

• Pegs demands to these supplies and uses them to cover transient safety stock 
requirements

• Ignores safety lead-time in forward scheduling so as to meet demand due date

• Inflates the lead-time by the safety lead-time in backward scheduling to plan for 
receipt to stock.
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This example shows how to analyze plan information for items subject to safety 
lead-time:

• In the diagram, SS means safety stock and PAB means projected available balance.

• Profile option MSO: Use Safety Lead Time = Yes

• Item attribute Safety Stock Method = MRP Planned %

• Item attribute Safety Stock Bucket Days = 5

• Item attribute Safety Stock Percent = 200% = 2 days

• The planning engine ignored transient safety stock, pegged supplies to actual 
demands, and scheduled supplies two days earlier than the demand due dates of 
the demands that peg to them.

• Planned orders on day 4 are for quantities 400, 400, and 200.

• The first planned order of quantity 400 on day 4 is against the transient safety stock 
of quantity 400 on day 1.

• The second planned order of quantity 400 is against the increase in the transient 
safety stock to quantity 800 on day 3.

• A third planned order of quantity 400 is against the increase in the transient safety 
stock to quantity 1200 on day 5. The planning engine splits the planned order of 
quantity 400 into two planned orders of quantity 200 (according to profile option 
MSO: Demand Size Tolerance Before Splitting Planned Orders). The demand on 
day 6 pegs to one planned order of quantity 200; the demand on day 8 pegs to the 
other planned order of quantity 200. 

This example shows the plan information for the same demand position but using 
non-transient/transient safety stock planning. In the diagram, SS means safety stock and
PAB means projected available balance.
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If you use safety lead-time:

• You might accumulate too much material too early. However, resource constraints 
reduce the possibility. By using safety lead-time planning, the risk of accumulation 
should be lower than by using non-transient/transient safety stock planning.

• The planning engine might suggest that you delay lower priority demands in order 
to meet safety lead-time

Lead-time Item Attribute Notes
You can also view Preprocessing, Processing, Postprocessing, Fixed, and Variable in the
Collections Workbench Items window and the Planner Workbench Items window.

The planning engine does not use Cumulative Manufacturing and Cumulative Total 
values. You may see them in lists of values when you are entering lead-times, for 
example, item attribute Planning Time Fence.

Total lead-time is not an item attribute. The planning engine calculates it in 
unconstrained plans to determine an order's Order Date. It:

• Begins with the order's Due Date

• Calculates total lead-time for the order as item Fixed + (Variable * Order quantity)

• Adds Preprocessing to calculate the order's Order Date 

The Calculate Manufacturing Lead-time concurrent process uses the same general 
calculation for Processing as the planning engine uses for Total Lead-time. The 
Calculate Manufacturing Lead-time concurrent process uses item attribute Lead-time 
Lot Size to calculate item attribute Processing. The planning engine uses actual order 
quantity to calculate the processing time for a specific planned order or scheduled 
receipt.

This diagram shows the relative use of Total Lead-time, Cumulative Manufacturing, 
and Cumulative Total.



Supply Chain Plan Modeling    6-83

Calculations of Cumulative Lead-time Attributes

Calculated Supply Dates
For all plan types, the planning engine schedules planned orders and scheduled 
receipts based on Demand Due Date of the demand that the supply is pegged to. It 
calculates these dates:

• Need By Date: The earliest demand due date of all demands pegged to a supply. 

• Suggested Due Date: The date by which the supply is available for use by its 
demand. In an Unconstrained or Constrained - Enforce demand due dates plan this 
is the same as Need By Date. In a Constrained - Enforce capacity constraints plan 
this is the scheduled availability date of the supply.

• Suggested Dock Date: For buy or transfer orders, the date the order arrives on your 
receiving dock.

• Suggested Ship Date: For transfer orders, the date of departure from the source 
organization of the last transport used for the transfer.

• Suggested Start Date: The date that you, your supplier, or your ship from facility 
should begin work on the order 
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• Suggested Order Date: The date by which you need to place the order. For a 
scheduled receipt, this field displays the date the date that it was created.

Old Due Date, Old Dock Date, and Original Need By Date are the original dates from 
the source system for scheduled receipts.

You can view these dates in the Planner Workbench from among the Supply/Demand, 
Supply, and Demand windows.

Calculating Planned Order Demand Due Date
Oracle Advanced Supply Chain Planning takes into account the actual requirement date
and the lead-times for calculating the planned order demand due dates. This provides 
more accurate lead-time offsets in aggregate planning time buckets.

The planning engine allows you to plan at aggregate time bucket levels like periods and
weeks. It provides you easy identification of aggregate supply/demand mismatches and
helps you make strategic decisions related to equipment and labor acquisition, sourcing
etc. without generating needless details.

The planning engine's Memory Based Planner calculates the planned order demand due
dates for dependent demands based on the actual requirement date with respect to 
lead-time. It saves the calculated requirement date based on the lead-time value for 
subsequent calculation.

The planning engine aligns all dates to the ends of time buckets. You can get more 
accurate dates by first performing dependent demand explosion followed by alignment.

Example
Consider an organization with an assembly A, which has components B and C.
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Assembly

The quantity per assembly for components B and C is 1.

The lead-time for assembly A = 4

The lead-time for sub-assembly B = 3

The lead-time for component C = 4

The organization follows a weekly planning bucket and working days are Monday 
through Friday.

An order quantity of 1 is placed for item A on Friday February 28.

The planning engine generates the following planned order demands:
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Planned Order Demand Due Date Calculation

Explanation:

• Calculated requirement date for B

= Demand Due Date for A - LT 

= February 28 - 4 days 

= February 24 (Monday)

• Demand Due Date for B

= Calculated requirement date for B after bucketing into planning bucket

= February 28 (weekly demands are bucketed into Friday)

• Calculated requirement date for C

= Calculated requirement for B - LT

= February 24 - 4 days

= February 18 (Monday)

• Demand Due Date for C

= Calculated requirement date for C after bucketing into planning bucket

= February 21 (weekly demands are bucketed into Friday)

Date Calculations for Manufactured Supplies
The planning engine uses work days from the manufacturing calendar to calculate 
dates for manufactured supplies, unless otherwise indicated.

Need By Date: The date that the material should ship or be in inventory for a 
next-higher level assembly. The earliest demand due date that the supply is pegged to.

Suggested Due Date: In an Unconstrained or Constrained - Enforce demand due dates 
plan this is the same as Need By Date. In a Constrained - Enforce capacity constraints 
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plan this is the scheduled availability date of the supply. If the supply is constrained, 
the planning engine forward schedules from the constraint.

Suggested Dock Date: Demand Due Date. Dock Date is the day by which all shop floor 
operations are complete. 

Suggested Ship Date: Blank

Suggested Start Date: Suggested Due Date - Production duration. The day that you 
should begin shop floor operations.

lead-time offsetting begins only on a workday of the workday calendar. For example:

• The workday calendar shows the week of 15 January as 5 workdays (Monday 15 
January to Friday 19 January) followed by 2 non-workdays (Saturday 20 January to 
Sunday 21 January).

• The planning engine creates a planned order against item A for quantity 45 with 
suggested ship date 20 January. Processing lead-time for item A is 5 days.

• Since 20 January is a non-workday, the planning engine moves to 19 January to 
begin lead-time offsetting and calculates Suggested Start Date 12 January.

Sunday 21 January (non-workday)

Monday 20 January (non-workday) > Suggested Ship Date 

Friday 19 January > Beginning of lead-time offsetting

Thursday 18 January > -1 

Wednesday 17 January > -2 

Tuesday 16 January > -3 

Monday 15-January > -4

Sunday 14 January (non-workday)

Saturday 13 January (non-workday)

Friday 12 January > -5 and Suggested Start Date

Thursday 11 January

Production Duration:

• Unconstrained plans: Fixed + (Variable * Order quantity)

• Constrained plans: Calculated resource and material duration. If the item does not 
have a routing, the planning engine uses the unconstrained calculation.

Suggested Order Date: Planned order Start Date - Preprocessing. The date on which you
should place the order. For a scheduled receipt, this field displays the date the date that 
it was created.

This diagram shows dates calculated for manufacturing supplies.
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Dates Calculated for Manufacturing Supplies

Date Calculations for Manufactured Supply Components
The planning engine calculates the component due dates of a manufacturing supply 
order according to your setting of the plan option Material Scheduling Method. 

For value Order Start Date, the component due date is the supply Start Date.

For value Operation Start Date:

• Unconstrained plans: The planning engine determines the operation that uses the 
component. It begins with the supply Start Date and increases it by lead-time % of 
that operation.

• Constrained plans: Operation Start Date for the operation which uses it

Purchased Supply Lead-times and Approved Supplier Lists
If the item of the purchased supply has an Approved Supplier List, the planning engine:

• Uses its Processing Lead-time value instead of the item attribute Processing 
lead-time

• Adjusts Dock Date to conform to its Delivery Calendar value

You can view Approved Supplier List planning attributes in the Collections Workbench
and the Planner Workbench, Items window, Sources tabbed region, and select Supplier 
Capacity. 

Date Calculations for Purchased Supplies
The planning engine uses work days from the receiving organization calendar to 
calculate dates for purchased supplies, unless otherwise indicated.

Need by Date: Date that the material is required to satisfy demand.

Suggested Due Date:

• Unconstrained plans: Need by Date

• Constrained plans: The available date of the supply by forward scheduling

Suggested Dock Date:

• Unconstrained plans: Due Date - Postprocessing
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• Constrained plans: The latest delivery day for which the capacity is available and 
the material is needed

• If the purchased supply item has an Approved Supplier List delivery calendar: The 
planning engine verifies that the Suggested Dock Date is a work day on the delivery
calendar. If it is not, the planning engine changes Suggested Due Date to the next 
earliest working day of the delivery calendar.

Suggested Ship Date: Dock Date - Production duration

Production Duration:

• If the purchased supply item has an Approved Supplier List Supplier Processing 
lead-time: Approved Supplier List Supplier Processing lead-time

• If the purchased supply item does not have an Approved Supplier List Supplier 
Processing lead-time: Item attribute Processing

Suggested Start Date: Ship Date

Suggested Order Date: Start Date - Preprocessing. For a scheduled receipt, this field 
displays the date the date that it was created. In Collections Workbench, purchase order
create date. The planning engine calculates this date using the organization 
manufacturing calendar.

This diagram shows the calculations for purchased supplies.

Calculated Dates for Purchased Supplies

Date Calculations for Transfer Supplies
The planning engine uses work days from the receiving organization calendar and 
shipping organization calendar to calculate dates for transfer supplies.

Need By Date (receiving organization calendar): Date material is required to satisfy 
demand. 

Demand Due Date (receiving organization calendar):

• Unconstrained plans: Need By Date

• Constrained plans: Forward scheduling from the constraint.

Suggested Dock Date (receiving organization calendar): Due Date - Postprocessing

Suggested Ship Date (shipping organization calendar): 
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• Unconstrained plans: Dock Date - Intransit Time 

• Constrained plans: Dock Date - Intransit Time, considering constrained 
transportation duration. The planning engine considers transportation constraint 
maximum transfer quantity per day

Intransit Time is calendar days.

Suggested Start Date (shipping organization calendar): 

• Unconstrained plans: Ship Date - Processing

• Constrained plans: Ship Date. The planning engine does not consider a build time 
because the supply may be on-hand.

Suggested Order Date (receiving organization calendar):

• Unconstrained plans: Planned order Start Date - Preprocessing

• Constrained plans: Ship date in the receiving organization, if the shipping 
organization is a planned organization. The constrained plan uses material and 
resource constraints in the shipping organization.

For a scheduled receipt, this field displays the date the date that it was created.

This diagram shows calculated dates for transfer supplies in an unconstrained plan. The
planning engine calculates production duration differently for the source organization 
and the destination organizations; therefore, the dates in your plan may not line up as 
accurately as they appear in this diagram. If material is scheduled inside of these 
lead-times, planners can determine what action to take on the compression messages.

Calculated Dates for Transfer Supplies, Unconstrained Plan

This diagram shows that, in constrained plans, Need By Date and Demand Due Date in 
the shipping organization should be the same as planned order Ship Date in the 
shipping organization.
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Calculated Dates for Transfer Supplies, Constrained Plan

Planning Time Fence Control

Planning Time Fence Control Introduction
The planning time fence defines a time period within which the planning engine may 
not create planned orders. Use planning time fence control for schedule stability during 
the initial periods of a plan 

Setting Planning Time Fence
Specify a planning time fence time for an item in an organization using the item 
attributes Planning Time Fence and Planning Time Fence Days.

To enable planning time fence control in a plan, select plan option Planning Time Fence 
Control.

The planning engine calculates Planning Time Fence Date for each item in each 
organization as Plan Run Date + item attributes Planning Time Fence and Planning 
Time Fence Days, considering working days in the organization manufacturing 
calendar. 

You can also instruct the planning engine to create a natural time fence when it first 
finds a firm scheduled receipt for an item. See Related Profile Options in this topic. If 
the natural time fence is later than Planning Time Fence Date, the planning engine 
changes Planning Time Fence Date to the date of the natural time fence. 

You can view item attribute Planning Time Fence Days and Planning Time Fence Date 
on the Planner Workbench Items window. They may be hidden fields.

You can instruct the planning engine whether to remove firm planned orders from the 
last plan run. Use plan option Overwrite and select one of the values:

• None: Do not remove any firm planned orders

• All: Remove all firm planned orders
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• Outside Planning Time Fence: Do not remove firm planned orders due earlier than 
Planning Time Fence Date and remove firm planned orders due later then Planning
Time Fence Date

Planning Time Fence Date and Plan Type
The planning engine uses Planning Time Fence Date as follows:

• In unconstrained plans, it does not set any planned order due dates earlier than 
Planning Time Fence Date

• In constrained plans, it does not set any planned order due dates earlier then 
Planning Time Fence Date if, for

• A make order, the start date of the first resource sequence within the first 
operation is earlier than or on Planning Time Fence Date

• A buy order, purchase requisition, and purchase order, Dock Date is earlier 
than or on Planning Time Fence Date

• A transfer order, internal requisition and flow schedule, Start Date is earlier 
than or on Planning Time Fence Date

Related Profile Options
For more information on profile options, see Profile Options Introduction, page A-1.

These following profile options relate to planning time fence control and firming of 
supplies:

• MRP: Create Time Fence

• MRP: Firm Internal Req Transferred to OE

• MRP: Firm Planned Order Time Fence

• MRP: Recommend Action within PTF

• MSC: Firm Internal Requisition Time Fence

• MSC: Firm In-transit and PO in Receiving Supplies

• MSC: MPS Auto-Firm All Planned Orders

• MSO: Delay Fulfillment of Small Demands

• MSO: Firm Operations/Orders Within Time Fence

• MSO: Firm Purchase Orders Within Time Fence
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• MSO: Firm Requisitions Within Time Fence

• MSO: Maximum Inventory Level % of Safety Stock

• MSO: Net All Firm Supplies Before Creating Planned Orders

• MSO: Target Inventory Level % of Safety Stock

The planning engine decides whether to calculate Planning Time Fence Date based on 
plan option Planning Time Fence Control. These profile options instruct the planning 
engine to create natural time fences and to change Planning Time Fence Date to the 
natural time fence date if the natural time fence date is later than the calculated 
Planning Time Fence Date:

• MRP: Create Time Fence: Instructs the planning engine to create a natural time 
fence for an item at the completion date of the latest firm discrete job, purchase 
order, flow schedule, or shipment. 

• MRP: Firm Planned Order Time Fence: Instructs the planning engine to create a 
natural time fence for an item at the completion date of the latest firm planned 
order.

• MSC: Firm Internal Requisition Time Fence: Instructs the planning engine to create 
a natural time fence for an item at the completion date of the latest firm internal 
requisition.

These profile options affect the firming of specific supply types:

• MRP: Firm Internal Req Transferred to OE: Instructs the planning engine to 
consider internal requisitions that have transferred to Oracle Order Management as 
firm.

You cannot reschedule transferred internal requisitions from Oracle Advanced 
Supply Chain Planning. To reschedule it, cancel the internal requisition and the 
internal sales order line in the source instance and create them again.

Since the planning engine coordinates the dates between internal requisitions and 
their internal sales orders, it never reschedules the internal sales order of a firm 
internal requisition. 

• MSC: Firm Intransit and PO in Receiving Supplies: Instructs the planning engine, in
unconstrained plans, to consider intransit purchase orders and purchase orders in 
receiving as firm. It issues reschedule recommendations but you cannot release 
them from Planner Workbench.

• MSC: MPS Auto-Firm All Planned Orders: Instructs the planning engine, for master
production schedule plans, to firm all planned orders.

When a master production schedule is a demand schedule for another plan, the 
planning engine considers all master production schedule planned orders as firm, 
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regardless of this profile option.

• MSO: Firm Orders/Operations within Time Fence: Instructs the planning engine 
how to use planning time fence control on purchase orders, purchase requisitions, 
internal requisitions, discrete jobs, and flow schedules. The effect depends on order 
type; see Planning Time Fence Logic for Supply Types in this topic.

• MSO: Net All Firm Supplies Before Creating Planned Orders: Instructs the planning
engine to net firmed supplies available in any future period before creating new 
planned orders.

Profile option MRP: Recommend action within Planning Time Fence affects exceptions 
and recommendations. It instructs the planning engine, in unconstrained plans, to 
generate recommendations for scheduled receipts earlier than Planning Time Fence 
Date.

Planning Time Fence Logic for Order Types and Supply Types
In unconstrained plans, the planning engine uses Due Date to determine if the supply is
earlier than, later than, or on Planning Time Fence Date. In constrained plans, the 
planning engine uses different methods depending on order type and supply type. 

Planned Orders
Firm planned orders: The planning engine does not reschedule the completion date of a 
firm planned order but may reschedule its manufacturing resources. If profile option 
MRP: Firm Planned Order Time Fence is Yes, the planning engine creates a natural time
fence.

Planned Orders: The planning engine does not create planned orders earlier than 
Planning Time Fence date. It schedules planned orders as follows depending on supply 
type:

• Make supplies: Start Date of the first operation's first resource on or after Planning 
Time Fence Date. 

• Purchased supplies: Dock Date on or after Planning Time Fence Date 

• Transfer supplies: Start Date at the receiving organization on or after Planning Time
Fence Date.

Purchase Orders and Requisitions
Firm purchase orders: Generally, the planning engine does not recommend reschedule 
or cancel.

Non-firm purchase orders, purchase requisitions, and internal requisitions: Generally, 
the planning engine recommends reschedule or cancel. However, it does not 
recommend reschedule in for jobs and schedules in the following circumstances in 
Unconstrained plans and Constrained - Enforce Capacity Constraints plans:
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• The due date is earlier or on the Planning Time Fence Date

• It wants to reschedule the due date from later than Planning Time Fence Date to 
earlier or on Planning Time Fence Date. 

If profile options MSO: Firm Purchase Orders Within Time Fence and MSO: Firm 
Requisitions Within Time Fence are Yes, the planning engine:

• Considers non-firm purchase orders and purchase requisitions with Dock Date 
earlier than or on Planning Time Fence Date as firm and does not issue reschedule 
recommendations.

• Considers internal requisitions with Start Date earlier than or on Planning Time 
Fence Date in the receiving organization as firm and does not issue reschedule 
recommendations.

If profile option MSO: Firm Operations/Orders Within Time Fence is No, the planning 
engine:

• For non-firm purchase orders, purchase requisitions and internal requisitions, 
recommends reschedule out as needed, limited by the demand dates. It can 
recommend a reschedule out date that is earlier or on Planning Time Fence Date. 

• For purchase requisitions and internal requisitions, recommends cancel as needed

Standard Discrete Jobs and Repetitive Schedules
Firm standard discrete jobs and firm repetitive schedules: Generally, the planning 
engine does not recommend reschedule or cancel.

Non-firm standard discrete jobs and non-firm repetitive schedules: Generally, the 
planning engine recommends reschedule or cancel. However, it does not recommend 
reschedule in for jobs and schedules in the following circumstances in Unconstrained 
plans and Constrained - Enforce Capacity Constraints plans:

• The due date is earlier or on the Planning Time Fence Date

• It wants to reschedule the due date from later than Planning Time Fence Date to 
earlier or on Planning Time Fence Date.

If profile option MSO: Firm Operations/Orders Within Time Fence is Yes, the planning 
engine:

• Considers operations with start dates earlier or on Planning Time Fence Date as 
firm

• Considers operations with start dates later than Planning Time Fence Date as 
non-firm and subject to reschedule recommendations

• Does not recommend reschedule against orders and schedules entirely earlier than 
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or on Planning Time Fence Date

If profile option MSO: Firm Operations/Orders Within Time Fence is No, the planning 
engine, for non-firm orders:

• Recommends reschedule out as needed, limited by the demand dates. It can 
recommend a reschedule out date that is earlier or on Planning Time Fence Date. 

• Does not cancel orders no longer pegged to a demand but issues excess exception 
messages

Non-standard Discrete Jobs and Flow Schedules
The planning engine considers non-standard discrete jobs and flow schedules as firm 
and not subject to reschedule recommendations. It does not recommend cancel for 
non-standard discrete jobs.

Planner Workbench Supply and Demand Dates
The planning engine's calculation of dates that you see in Planner Workbench can differ
for:

• Demand dates, depending on whether the demand is independent or dependent

• Supply dates, depending on whether the supply is pegged to an independent or 
dependent demand

Planner Workbench Demand Dates
This table shows Planner Workbench demand dates.

Set the profile option MSC: Use Shipping Receiving Calendar at the site level. Do not set
it at the user level or set in the same as at the site level. For example:

• The site level value is Yes. The collection process collects the calendars and the 
planning engine uses them.

• The user level value is No. Planner Workbench for that user does not display the 
collected calendars but displays all calendars as 24x7.

It appears to this user that the planning engine does not follow the calendars.

Demand Satisfied Date is the latest due date of the supplies pegged directly to an end 
demand. In unconstrained plans, it is the same as Demand Date. All supplies pegged to 
a end demand that have an end date on or before the suggested due date are included 
in the Demand Satisfied Date, even if that demand is late by a few hours. 
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Demand Date Independent Demand 
Meaning

Dependent Demand 
Meaning

Requested Ship Date For sales order demand, see 
note after the table. For other 
demand, blank.

Blank

Requested Arrival Date For sales order demand, see 
note after table. For other 
demand, blank.

Blank

Scheduled Ship Date For sales order demand, see 
note after table. For other 
demand, blank.

Blank

Scheduled Arrival Date For sales order demand, see 
note after table. For other 
demand, blank.

Blank

Promised Ship Date For sales order demand, see 
note after table. For other 
demand, blank.

Blank

Promised Arrival Date For sales order demand, see 
note after table. For other 
demand, blank.

Blank

Suggested Due Date The date by which you need 
to ship with the planning 
engine considering alternate 
ship methods, for example, 
arrival date of and duration 
for a new ship method.

Suggested due date may be 
for one of the following based
on the Schedule By plan 
option:

- Requested Ship Date

- Scheduled Ship Date

- Promise Ship Date

The planning engine does not 
change the suggested due 
date.

The due date of the 
dependent demand. 

Determined by the final 
scheduling phase of the 
planning engine.
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Demand Date Independent Demand 
Meaning

Dependent Demand 
Meaning

Material Available Date Date when the total 
demanded quantity is 
available. If there are multiple
supplies pegging to the 
demand, it is the due date of 
the latest supply pegging to 
the demand.

This date may be different 
from the date that the 
material will ship. For 
example, a customer wants an
item on Thursday. Due to 
shop floor constraints, the 
material cannot be ready until
Saturday. Since the shipping 
dock does not work on 
weekends, the material 
cannot ship until Monday. 
The dates are:

• Suggested Due Date of 
Demand = Day 1 15:00 
(Thursday)

• Material Available Date 
for Demand = Day 3 12:00
(Saturday)

• Suggested Ship Date of 
Demand = Day 5 8:00 
(Monday) 

The planning engine issues 
exception messages Late 
Replenishment for Forecast or
Sales Order based on the 
difference between Suggested
Ship Date and Suggested Due 
Date. 

Blank
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Demand Date Independent Demand 
Meaning

Dependent Demand 
Meaning

Suggested Ship Date The date by which you can 
ship, with reference to the 
shipping calendar. For 
demands, suggested ship date
is used only for external and 
internal sales orders.

Blank

Planned Arrival Date For sales order demand, the 
calculated arrival date 
considering the suggested 
ship date, carrier calendar, 
intransit lead-time, and the 
receiving calendar.

Blank

Order Date Type For sales orders only, the 
customer order date type 
from the customer or the 
customer site definition. Valid
values are:

- Ship Date 

- Arrival Date

Blank

Days Late For an end demand, the 
planning engine calculates the
days late based on the 
difference between suggested 
sue date and the demand 
satisfied date.

If positive, the demand is 
satisfied late; if negative, the 
demand is satisfied early

Blank

Old Due Date Suggested demand due date. For a dependent demand that 
is pegged to a rescheduled 
supply, need by date of the 
dependent demand before the
reschedule.

Note: Customer date type is defined as the order date type (ship date or
arrival date). When you specify a date in the sales order line in the 
request date column, the planning engine interprets the date as either a 
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ship date or an arrival date depending on the customer's order date 
type. During the ATP calculation process, the planning engine 
calculates the schedule ship date and schedule arrival date based on the
request date, the customer date type, and the transit lead-time from the 
shipping organization to the customer site using the selected ship 
method on the sales order.

Note: In the Supply Demand window, if the customer date type is ship 
date, the requested ship date is from the sales order line field Request 
Date. If the customer date type is arrival date, the requested arrival date
is from the sales order line field Request Date. In both cases, the 
planning engine calculates the other field using the transit lead-time 
from the shipping organization to the customer site using the selected 
ship method on the sales order.

Note: The scheduled ship date and the scheduled arrival date are from 
the sales order fields with the same name.

Note: The promised arrival date and the promised ship date are from 
the sales order field promise date, with one of the two calculated using 
the order date type and the transit lead-time from the sales order. The 
calculation is the same as the requested arrival date or the requested 
ship date based on the order date type.

Planner Workbench Supply Dates
This table shows Planner Workbench supply dates:

• Need by Date represents the Suggested Due Date of a supply as calculated by an 
unconstrained plan. For constrained but not optimized plans, Need By Date is the 
date that the planning engine uses to determine the effectivity date for the bill of 
material explosion. 

• Updated Need by Date represents the Suggested Due Date of a supply as calculated
by the optimization planning phase for both cost-based or rule-based optimization. 
This approximation may not match the results of the detailed scheduling phase. If 
Updated Need By Date has an entry, the planning engine uses it, instead of Need 
by Date, to determine the effectivity date for the bill of material explosion.
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Supply Date Pegged to Independent 
Demand Meaning

Pegged to Dependent 
Demand Meaning

Need By Date For planned orders and 
open make orders, the date 
the supply is due, the Sugg 
Due Date of end item 
demand.

For purchase orders, the 
need by date from the 
purchase order line. If the 
purchase order is 
rescheduled, the same as if 
the supply is a planned 
order.

For planned orders and 
open make orders, 
calculated using 
unconstrained planning 
lead-time formulas and 
considering the plan 
material scheduling method 
option (order start date or 
operation start date).

If the component is due at 
the beginning of the first 
operation of a discrete job, 
Due Date - [Fixed + 
(Variable * Quantity)]. If the 
supply is due at the 
beginning of another 
operation of a discrete job, 
Due Date - [Fixed + 
(Variable * Quantity)] + 
Lead-time % from 
assembly's routing.

For purchase orders, same 
as the pegged to 
independent demand 
meaning.

Updated Need by Date The supply due date 
calculated and used by the 
optimization engine with 
material scheduling method 
order start date. This applies
only to planned orders.

The optimization process 
may schedule the supply 
either early or late. 

Same as the pegged to 
independent demand 
meaning.

Suggested Order Date Order Date for the supply. If
different from the start date, 
the difference is 
Preprocessing lead-time.

Same as the pegged to 
independent demand 
meaning.
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Supply Date Pegged to Independent 
Demand Meaning

Pegged to Dependent 
Demand Meaning

Suggested Start Date For make supplies, the job 
start date.

For buy supplies, the date 
the vendor receives the 
order.

Determined by the final 
scheduling phase of the 
planning engine.

Same as the pegged to 
independent demand 
meaning.

Suggested Dock Date The arrival date on the 
receiving dock, offset from 
Sugg Due Date by the post 
processing lead-time.

Determined by the final 
scheduling phase of the 
planning engine.

Same as the pegged to 
independent demand 
meaning.

Suggested Due Date The date the supply is in 
stock and available.

Determined by the final 
scheduling phase of the 
planning engine.

Same as the pegged to 
independent demand 
meaning.

Old Due Date Only applies to rescheduled 
supplies.

Sugg Due Date of the supply
before the reschedule. 

Only applies if the 
dependent supply itself is 
rescheduled. 

Sugg Due Date of the supply
before the reschedule.

Old Dock Date Only applies to buy items 
with rescheduled supplies. 

Sugg Dock Date of the 
supply before the 
reschedule.

Only applies to buy items if 
the dependent supply itself 
is rescheduled.

Sugg Dock Date of the 
supply before the 
reschedule.
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Supply Date Pegged to Independent 
Demand Meaning

Pegged to Dependent 
Demand Meaning

Sugg Ship Date For suppliers, this is used 
only for transfer orders. It is 
determined by the final 
scheduling phase of the 
planning engine.

The Ship Date is offset from 
the Sugg Due Date by the 
intransit lead-time and 
respects the shipping 
calendars.

For transfer planned orders, 
this is the same as the 
pegged to independent 
demand Suggested Ship 
Date meaning.

Same as the pegged to 
independent demand 
Suggested Ship Date 
meaning.

Arrival Time Updates 
If you use Oracle Transportation Management, you can update your production plans 
with the current status of estimated arrival times of purchase and transfer orders in 
transit. These changes occur either because of a change in the transportation plan or 
because of carries updates.

When Oracle Transportation Management detects a change in an estimated arrival time,
it:

• Notes the estimated arrival time in your production plans for purchase requisitions,
internal requisitions, and internal sales orders

• Compares its estimated arrival time to the corresponding plan dock date or 
scheduled arrival date

• Issues exception messages if the dates differ--Order will be delivered later than 
scheduled or Order will be delivered earlier than scheduled

• Sends a notification to the planner with a link to drill down to Oracle 
Transportation Management for details

• Updates the arrival date in Oracle Collaborative Planning

• Arranges for the Oracle Collaborative Planning exception process to evaluate the 
updates and issue exceptions as necessary
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When the next production plan runs, it:

• Updates the dock date with the estimated arrival time

• Firms the order

• Issues exception messages as necessary when the new arrival time has an effect on 
demand satisfaction—late replenishment, early replenishment, order at risk

You can view transportation updates in form View Transportation Updates

Examples of Lead-time Calculations 

Introduction
This topic shows examples of lead-time calculations for unconstrained and constrained 
plans. Some examples show the effect of planning time fence control on lead-time 
calculations. 

Constrained - Enforce demand due dates plans violate the planning time fence to meet 
the demand due date. Since the lead-time calculations are similar between these and 
Constrained - Enforce capacity constraints plans, there are no examples specifically for 
no specific examples are provided for Constrained - Enforce demand due dates plans 
with planning time fence control.

Calendars
The lead-time examples use these three calendars. They refer to dates as days, for 
example, Day 1 and Day 2, rather than as specific dates such as September 1. 

Each calendar covers multiple weeks, each row has seven days. Non-work days have 
the letters NW after their day number; non-delivery days have the letters ND after their 
day number.

This is the organization calendar that organization ORG1, the receiving organization, 
uses. It follows a 5 on - 2 off pattern.

Monday Tuesday Wednesda
y

Thursday Friday Saturday Sunday

1 2 3 4 5 6NW 7NW

8 9 10 11 12 13NW 14NW

15 16 17 18 19 20NW 21NW

22 23 24 25 26 27NW 28NW
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Monday Tuesday Wednesda
y

Thursday Friday Saturday Sunday

29 30 31 32 33 34NW 35NW

36 37 38 39 40 41NW 42NW

This is the organization calendar that organization ORG2, the shipping organization, 
uses. It follows a 6 on - 1 off pattern.

Monday Tuesday Wednesda
y

Thursday Friday Saturday Sunday

1 2 3 4 5 6 7NW

8 9 10 11 12 13 14NW

15 16 17 18 19 20 21NW

22 23 24 25 26 27 28NW

29 30 31 32 33 34 35NW

36 37 38 39 40 41 42NW

This is the delivery calendar from the approved supplier list for the supplier that 
supplies the purchased component.

Monday Tuesday Wednesda
y

Thursday Friday Saturday Sunday

1 2ND 3 4ND 5 6 7ND

8 9ND 10 11ND 12 13 14ND

15 16ND 17 18ND 19 20 21ND

22 23ND 24 25ND 26 27 28ND

29 30ND 31 32ND 33 34 35ND
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Monday Tuesday Wednesda
y

Thursday Friday Saturday Sunday

36 37ND 38 39ND 40 41 42ND

Example 1: Manufactured Supply with Purchased Component
This example shows lead-time calculations for Item A manufactured supply using Item 
B purchased component both in organization ORG1. Item B is used at the first operation
of Item A and its usage in Item A is 1.

lead-times:

• Item A: Fixed, 3 days; Variable, 0.5 days, Preprocessing, 1 day

• Item B: Processing, 2 days, Preprocessing, 1 day; Postprocessing, 1 day 

Sourcing rules:

• Item A in ORG1: Type, Make at; Allocation, 100; Rank, 1

• Item B in ORG1: Type, Buy from; Allocation, 100; Rank, 1

There is a demand for 8 units of Item A due on day 19.

Scenario 1: Unconstrained Plan, No Planning Time Fence Control
These calculations are for an unconstrained plan. The calculations for a constrained plan
are similar, except that they consider detailed resource and material constraints.

See Example 1: Manufactured Supply with Purchased Component in this topic for setup
information.

Scenario 1: Calculations for Item A Supply
Need By Date: Day 19 (Demand Due Date)

Suggested Due Date: Day 19 (Need By Date)

Suggested Start Date: Day 10

• Use ORG1 organization calendar 

• Suggested Due Date - ((Fixed + (Variable * Supply quantity)) = Day 19 - (3 days (0.5 
days * 8) = Day 19 - 7 days 

• Two non-work days: Days 13 and 14 

Suggested Order Date: Day 9

• Use ORG1 organization calendar 

• Suggested Start Date - Preprocessing = Day 10 - 1 day
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Scenario 1: Calculation for Item B Demand
You use purchased component Item B to manufacture Item A. If you use Item B at Item 
A's first operation (Material Scheduling Method of Order Start Date), Demand Due 
Date: Day 10 (Item A Suggested Start Date).

Scenario 1: Calculations for Item B Supply
Need By Date: Day 10 (Demand Due Date)

Suggested Due Date: Day 10 (Need By Date)

Suggested Dock Date: Day 8

• Use ORG1 organization calendar

• Suggested Due Date - Postprocessing Time = Day 10 - 1 day = Day 9

• Use ASL delivery calendar for supplier of Item B

• Day 9 is not a delivery work day. Move dock date to next earlier delivery work day.

Suggested Ship Date: Day 4

• Use ORG1 organization calendar

• Dock Date - Processing = Day 8 - 2 days 

• Two non-workdays: Days 6 and 7

Suggested Start Date: Day 4 (Suggested Ship Date)

Suggested Order Date: Day 3

• Use ORG1 organization calendar

• Start Date - Preprocessing = Day 4 - 1 day 

Scenario 1: Summary
This table summarizes the lead-times for Scenario 1: Unconstrained Plan, No Planning 
Time Fence Control.

Organizati
on

Item Order 
Type

Suggested
Due Date

Suggested
Dock Date

Suggested
Start Date

Suggested
Order Date

ORG1 A Demand Day 19 n/a n/a n/a

ORG1 A Planned 
order

Day 19 n/a Day 10 Day 9
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Organizati
on

Item Order 
Type

Suggested
Due Date

Suggested
Dock Date

Suggested
Start Date

Suggested
Order Date

ORG1 B Planned 
order 
demand

Day 10 n/a n/a n/a

ORG1 B Planned 
order

Day 10 Day 8 Day 4 Day 3

Scenario 2: Unconstrained Plan, Assembly Planning Time Fence Control
See Example 1: Manufactured Supply with Purchased Component in this topic for setup
information.

Item A, organization ORG1 Planning Time Fence Days: 15

Item A, organization ORG Planning Time Fence Date: Day 19

• Use ORG1 organization calendar

• Day 1 + Planning Time Fence Days = Day 1 + 15 days

• Four non-work days: Days 6, 7, 13, and 14

The planning engine cannot schedule a planned order until the day after Planning Time
Fence Date.

Scenario 2: Calculations for Item A Supply
Need By Date: Day 19 (Demand Due Date)

Suggested Due Date: Day 22

• Need By Date is Day 19

• Planning Time Fence Date is Day 19

• The planning engine cannot schedule planned order until Day 22 (Planning Time 
Fence Date + 1) = Day 19 + 1 day

• Two non-work days: Days 20 and 21

• Supply is due after Demand Due Date; issue shortage and late replenishment 
exception messages

Suggested Start Date: Day 11

• Use ORG1 organization calendar 
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• Suggested Due Date - ((Fixed + (Variable * Supply quantity)) = Day 22 - (3 days (0.5 
days * 8) = Day 22 - 7 days 

• Four non-work days: Days 13, 14, 20, and 21 

Suggested Order Date: Day 10

• Use ORG1 organization calendar 

• Suggested Start Date - Preprocessing = Day 11 - 1 day

Scenario 2: Calculation for Item B Demand
You use purchased component Item B to manufacture Item A. If you use Item B at Item 
A's first operation (Material Scheduling Method of Order Start Date), Demand Due 
Date: Day 11 (Item A Suggested Start Date).

Scenario 2: Calculations for Item B Supply
Need By Date: Day 11 (Demand Due Date)

Suggested Due Date: Day 11 (Need By Date)

Suggested Dock Date: Day 10

• Use ORG1 organization calendar

• Suggested Due Date - Postprocessing Time = Day 11 - 1 day = Day 10

• Use ASL delivery calendar for supplier of Item B

• Day 10 is delivery work day

Suggested Ship Date: Day 8

• Use ORG1 organization calendar

• Dock Date - Processing = Day 10 - 2 days 

Suggested Start Date: Day 8 (Suggested Ship Date)

Suggested Order Date: Day 5

• Use ORG1 organization calendar

• Start Date - Preprocessing = Day 8 - 1 day 

• Two non-work days: Days 6 and 7

Scenario 2: Summary
This table summarizes the lead-times for Scenario 2: Unconstrained Plan, Assembly 
Planning Time Fence Control.
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Organizati
on

Item Order 
Type

Suggested
Due Date

Suggested
Dock Date

Suggested
Start Date

Suggested
Order Date

ORG1 A Demand Day 19 n/a n/a n/a

ORG1 A Planned 
order

Day 22 n/a Day 11 Day 10

ORG1 B Planned 
order 
demand

Day 11 n/a n/a n/a

ORG1 B Planned 
order

Day 11 Day 10 Day 8 Day 5

Scenario 3: Constrained - Enforce Capacity Constraints Plan, Assembly Planning Time Fence Control
Constrained plans perform detailed scheduling which considers resource and material 
constraints. These examples assume no constraints and use lead-time offsets; the 
planning engine would only do this if Item A has no routing.

See Example 1: Manufactured Supply with Purchased Component in this topic for setup
information.

Scenario 3: Calculations for Item A Supply
Need By Date: Day 19 (Demand Due Date)

Suggested Due Date: Day 19 (Need By Date)

Suggested Start Date: Day 22

• Use ORG1 organization calendar 

• Suggested Due Date - ((Fixed + (Variable * Supply quantity)) = Day 19 - (3 days (0.5 
days * 8) = Day 19 - 7 days = Day 10

• Two non-work days: Days 13 and 14 

• Planning Time Fence Date is Day 19

• The planning engine cannot schedule planned order until Day 22 (Planning Time 
Fence Date + 1) = Day 19 + 1 day

• Two non-work days: Days 20 and 21

Suggested Order Date: Day 19

• Use ORG1 organization calendar 
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• Suggested Start Date - Preprocessing = Day 22 - 1 day 

• Two non-work days: Days 20 and 21

Recalculate Suggested Due Date by forward scheduling from Suggested Dock Date

Suggested Due Date: Day 23

• Use ORG1 organization calendar 

• Suggested Dock Date + Postprocessing = Day 22 + 1 = Day 23

• Supply is due after Demand Due Date; issue shortage exception message

Scenario 3: Calculation for Item B Demand
You use purchased component Item B to manufacture Item A. If you use Item B at Item 
A's first operation (Material Scheduling Method of Order Start Date), Demand Due 
Date: Day 22 (Item A Suggested Start Date).

Scenario 3: Calculations for Item B Supply
Need By Date: Day 22 (Demand Due Date)

Suggested Due Date: Day 2 (Need By Date)

Suggested Dock Date: Day 19

• Use ORG1 organization calendar

• Suggested Due Date - Postprocessing Time = Day 22 - 1 day = Day 19

• Two non-work days: Days 20 and 21

• Use ASL delivery calendar for supplier of Item B

• Day 19 is delivery work day

Suggested Ship Date: Day 17

• Use ORG1 organization calendar

• Dock Date - Processing = Day 19 - 2 days 

Suggested Start Date: Day 17 (Suggested Ship Date)

Suggested Order Date: Day 16

• Use ORG1 organization calendar

• Start Date - Preprocessing = Day 17 - 1 day 

Scenario 3: Summary
This table summarizes the lead-times for Scenario 3: Constrained - Enforce Capacity 
Constraints Plan, Assembly Planning Time Fence Control.
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Organizati
on

Item Order 
Type

Suggested
Due Date

Suggested
Dock Date

Suggested
Start Date

Suggested
Order Date

ORG1 A Demand Day 19 n/a n/a n/a

ORG1 A Planned 
order

Day 31 n/a Day 22 Day 19

ORG1 B Planned 
order 
demand

Day 22 n/a n/a n/a

ORG1 B Planned 
order

Day 22 Day 19 Day 17 Day 16

Example 2: Purchased Component
These examples are the same as the scenarios in Example 1 but purchased component 
Item B has a planning time fence.

The scenarios in this example are similar to Scenario 1. In Scenario 1, neither assembly 
Item A or purchased component Item B has a planning time fence. In this scenario, 
assembly Item A does not have a planning time fence but purchased component Item B 
has a planning time fence.

Item B, organization ORG1 Planning Time Fence Days: 15

Item B, organization ORG Planning Time Fence Date: Day 19

• Use ORG1 organization calendar

• Day 1 + Planning Time Fence Days = Day 1 + 15 days

• Four non-work days: Days 6, 7, 13, and 14

The planning engine cannot schedule a planned order until the day after Planning Time
Fence Date.

Scenario 4: Unconstrained Plan, Purchased Component Planning Time Fence Control
See Example 2: Purchased Component in this topic for setup information.

See Scenario 1: Unconstrained Plan, No Planning Time Fence Control in this topic for 
the calculations of supply for Item A and demand for Item B. Item B has dependent 
demand due on Day 10.

Scenario 4: Calculations for Item B Supply
Need By Date: Day 10 (Demand Due Date)

Suggested Due Date: Day 22 
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• Need By Date is Day 10

• Use ORG1 organization calendar

• Planning Time Fence Date is Day 19

• The planning engine cannot schedule planned order until Day 22 (Planning Time 
Fence Date + 1) = Day 19 + 1 day

• Two non-work days: Days 20 and 21

• Supply is due after Demand Due Date; issue shortage exception message. Do not 
reschedule supply for Item A.

Suggested Dock Date: Day 19

• Use ORG1 organization calendar

• Suggested Due Date - Postprocessing Time = Day 22 - 1 day = Day 19

• Two non-work days: Days 20 and 21

• Use ASL delivery calendar for supplier of Item B

• Day 9 is a delivery work day

Suggested Ship Date: Day 17

• Use ORG1 organization calendar

• Dock Date - Processing = Day 19 - 2 days 

Suggested Start Date: Day 17 (Suggested Ship Date)

Suggested Order Date: Day 16

• Use ORG1 organization calendar

• Start Date - Preprocessing = Day 17 - 1 day 

Scenario 4: Summary
This table summarizes the lead-times for Scenario 4: Unconstrained Plan, Purchased 
Component Planning Time Fence Control.

Organizati
on

Item Order 
Type

Suggested
Due Date

Suggested
Dock Date

Suggested
Start Date

Suggested
Order Date

ORG1 A Demand Day 19 n/a n/a n/a
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Organizati
on

Item Order 
Type

Suggested
Due Date

Suggested
Dock Date

Suggested
Start Date

Suggested
Order Date

ORG1 A Planned 
order

Day 31 n/a Day 10 Day 9

ORG1 B Planned 
order 
demand

Day 10 n/a n/a n/a

ORG1 B Planned 
order

Day 22 Day 19 Day 17 Day 16

Scenario 5: Constrained - Enforce Capacity Constraints Plan, Purchased Component Planning Time Fence Control
See Example 2: Purchased Component in this topic for setup information.

See Scenario 1: Unconstrained Plan, No Planning Time Fence Control in this topic for 
the calculations of supply for Item A and demand for Item B. Item B has dependent 
demand due on Day 10.

Scenario 5: Calculations for Item B Supply
Need By Date: Day 10 (Demand Due Date)

Suggested Due Date: Day 10 (Need By Date) 

Suggested Dock Date: Day 22

• Use ORG1 organization calendar

• Suggested Due Date - Postprocessing Time = Day 10 - 1 day = Day 9

• Planning Time Fence Date is Day 19

• The planning engine cannot schedule planned order until Day 22 (Planning Time 
Fence Date + 1) = Day 19 + 1 day

• Two non-work days: Days 20 and 21

• Use ASL delivery calendar for supplier of Item B

• Day 22 is a delivery work day

Suggested Ship Date: Day 18

• Use ORG1 organization calendar

• Dock Date - Processing = Day 22 - 2 days 
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• Two non-work days: Days 21 and 21

Suggested Start Date: Day 18 (Suggested Ship Date)

Suggested Order Date: Day 17

• Use ORG1 organization calendar

• Start Date - Preprocessing = Day 18 - 1 day 

Recalculate Suggested Due Date by forward scheduling from Suggested Dock Date

Suggested Due Date: Day 23

• Use ORG1 organization calendar 

• Suggested Dock Date + Postprocessing = Day 22 + 1= Day 23 + 7 days = Day 10

• Supply is due after Demand Due Date; issue shortage exception message. 
Reschedule supply for Item A.

Scenario 5: Recalculations for Item A Supply
Suggested Start Date: Day 23 (Item B Suggested Due Date)

Suggested Due Date: Day 32

• Use ORG1 organization calendar 

• Suggested Start Date + ((Fixed + (Variable * Supply quantity)) = Day 23 - (3 days + 
(0.5 days * 8) = Day 23 + 7 days = Day 32

• Two non-work days: Days 27 and 28

• Supply is due after Demand Due Date; issue shortage exception message.

Suggested Order Date: Day 22

• Use ORG1 organization calendar

• Suggested Start Date - Preprocessing = Day 23 - 1 day

Scenario 5: Summary
This table summarizes the lead-times for Scenario 5: Constrained - Enforce Capacity 
Constraints Plan, Purchased Component Planning Time Fence Control.

Organizati
on

Item Order 
Type

Suggested
Due Date

Suggested
Dock Date

Suggested
Start Date

Suggested
Order Date

ORG1 A Demand Day 19 n/a n/a n/a
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Organizati
on

Item Order 
Type

Suggested
Due Date

Suggested
Dock Date

Suggested
Start Date

Suggested
Order Date

ORG1 A Planned 
order

Day 32 n/a Day 23 Day 22

ORG1 B Planned 
order 
demand

Day 23 n/a n/a n/a

ORG1 B Planned 
order

Day 23 Day 22 Day 18 Day 17

Example 3: Transfer Component
This example shows lead-time calculations for Item A manufactured supply using Item 
C transfer component both in organization ORG1. ORG2 supplies Item C to 
organization ORG1. Item C is used at the first operation of Item A and its usage in Item 
A is 1.

Lead-times:

• Item A in ORG1: Fixed, 3 days; Variable, 0.5 days, Preprocessing, 1 day

• Item C in ORG1: Processing, 2 days, Preprocessing, 1 day; Postprocessing, 1 day

• Item C in ORG2: Fixed, 4 days; Variable, 0.25 days, Preprocessing, 3 days

Sourcing rules:

• Item A in ORG1: Type, Make at; Allocation, 100; Rank, 1

• Item C in ORG1: Type, Transfer from; Allocation, 100; Rank, 1; Intransit Time, 2 
days

• Item C in ORG2: Type, Make at; Allocation, 100; Rank, 1

There is a demand for 8 units of Item A due on day 33.

Scenario 6: Unconstrained Plan, No Planning Time Fence Control
These calculations are for an unconstrained plan. The calculations for a constrained plan
are similar, except that they consider detailed resource and material constraints.

See Example 3: Transfer Component in this topic for setup information.

Scenario 6: Calculations for Item A Supply (Make At, Receiving Organization)
Need By Date: Day 33 (Demand Due Date)

Suggested Due Date: Day 33 (Need By Date)
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Suggested Start Date: Day 24

• Use ORG1 receiving organization calendar 

• Suggested Due Date - ((Fixed + (Variable * Supply quantity)) = Day 33 - (3 days (0.5 
days * 8) = Day 33 - 7 days 

• Two non-work days: Days 27 and 28

Suggested Order Date: Day 23

• Use ORG1 receiving organization calendar 

• Suggested Start Date - Preprocessing = Day 24 - 1 day

Scenario 6: Calculation for Item C Demand (Transfer From, Receiving Organization)
You use purchased component Item C to manufacture Item A. If you use Item C at Item 
A's first operation (Material Scheduling Method of Order Start Date), Demand Due 
Date: Day 24 (Item A Suggested Start Date).

Scenario 6: Calculations for Item C Supply (Transfer From, Receiving Organization)
Need By Date: Day 24 (Demand Due Date)

Suggested Due Date: Day 24 (Need By Date)

Suggested Dock Date: Day 23

• Use ORG1 receiving organization calendar

• Suggested Due Date - Postprocessing = Day 24 - 1 day = Day 23

Suggested Ship Date: Day 20

• Use ORG1 receiving organization calendar

• Suggested Dock Date - Intransit Time [include non-workdays] = Day 23 - 2 days = 
Day 21

• Use ORG2 shipping organization calendar

• Day 21 is not a work day. Move suggested ship date to next earlier work day.

Suggested Start Date: Day 13

• Use ORG2 shipping organization calendar

• Suggested Ship Date - ((Fixed + (Variable * Supply quantity)) [Fixed and Variable 
from ORG2]= Day 20 - (4 days (0.25 days * 8) = Day 20 - 6 days 

• One non-workday: Day 14

Suggested Order Date: Day 12
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• Use ORG1 receiving organization calendar

• Start Date - Preprocessing = Day 13 - 1 day

Scenario 6: Calculation for Item C Demand (Make At, Shipping Organization)
You transfer component Item C from ORG2 to ORG1. Demand Due Date: Day 20 (Item 
A at ORG1 Suggested Ship Date).

Scenario 6: Calculations for Item C Supply (Make At, Shipping Organization)
Need By Date: Day 20 (Demand Due Date)

Suggested Due Date: Day 20 (Need By Date)

Suggested Start Date: Day 13

• Use ORG2 shipping organization calendar

• Suggested Due Date - ((Fixed + (Variable * Supply quantity)) = Day 20 - (4 days - 
(0.25 days * 8) = Day 20 - 6 days 

• One non-work day: Day 14

Suggested Order Date: Day 10

• Use ORG2 shipping organization calendar 

• Suggested Start Date - Preprocessing = Day 13 - 3 day

Scenario 6: Summary
This table summarizes the lead-times for Scenario 6: Unconstrained Plan, No Planning 
Time Fence Control.

Organiza
tion

Item Order 
Type

Suggest
ed Due 
Date

Suggest
ed Dock 
Date

Suggest
ed Ship 
Date

Suggest
ed Start 
Date

Suggest
ed Order
Date

ORG1 A Demand Day 33 n/a n/a n/a n/a

ORG1 A Planned 
order

Day 33 n/a n/a Day 24 Day 23

ORG1 C Planned 
order 
demand

Day 24 n/a n/a n/a n/a

ORG1 C Planned 
order

Day 24 Day 23 Day 20 Day 13 Day 12
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Organiza
tion

Item Order 
Type

Suggest
ed Due 
Date

Suggest
ed Dock 
Date

Suggest
ed Ship 
Date

Suggest
ed Start 
Date

Suggest
ed Order
Date

ORG2 C Planned 
order 
demand

Day 20 n/a n/a n/a n/a

ORG2 C Planned 
order

Day 20 n/a n/a Day 13 Day 10

Scenario 6: Calculations for Item C Supply (Make At, Shipping Organization) for 
Constrained Plan
In constrained plans, the planning engine does not schedule Start Date to include the 
estimated processing time in the shipping org. This avoids pushing out a receiving 
order when the item may be on-hand or in process.

Compare this table with the table for unconstrained plans in Scenario 6: Calculations for
Item C Supply (Make At, Shipping Organization) in this topic. Note the differences in 
the Suggested Start Date and Suggested Order Date in the receiving organization 
ORG1.

This table summarizes the lead-times for Scenario 6: Unconstrained Plan, No Planning 
Time Fence Control if you used a constrained plan.

Organiza
tion

Item Order 
Type

Suggest
ed Due 
Date

Suggest
ed Dock 
Date

Suggest
ed Ship 
Date

Suggest
ed Start 
Date

Suggest
ed Order
Date

ORG1 A Demand Day 33 n/a n/a n/a n/a

ORG1 A Planned 
order

Day 33 n/a n/a Day 24 Day 23

ORG1 C Planned 
order 
demand

Day 24 n/a n/a n/a n/a

ORG1 C Planned 
order

Day 24 Day 23 Day 20 Day 20 Day 19

ORG2 C Planned 
order 
demand

Day 20 n/a n/a n/a n/a
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Organiza
tion

Item Order 
Type

Suggest
ed Due 
Date

Suggest
ed Dock 
Date

Suggest
ed Ship 
Date

Suggest
ed Start 
Date

Suggest
ed Order
Date

ORG2 C Planned 
order

Day 20 n/a n/a Day 13 Day 10

Scenario 7: Unconstrained Plan, Purchased Component Planning Time Fence Control
This scenario is the same as Scenario 6 but transfer component Item C has a planning 
time fence in receiving organization ORG1.

See Example 3: Transfer Component in this topic for setup information.

In Scenario 6, neither assembly Item A or transfer component Item C has a planning 
time fence. In this scenario, assembly Item A does not have a planning time fence but 
transfer component Item C has a planning time fence.

Item C, organization ORG1 Planning Time Fence Days: 20

Item C, organization ORG1 Planning Time Fence Date: Day 26

• Use ORG1 receiving organization calendar

• Day 1 + Planning Time Fence Days = Day 1 + 20 days

• Six non-work days: Days 6, 7, 13, 14, 20, and 21

The planning engine cannot schedule a planned order until the day after Planning Time
Fence Date.

See Scenario 6: Unconstrained Plan, No Planning Time Fence Control in this topic for 
the calculations of supply for Item A and demand for Item C at the receiving 
organization ORG1. Item C in the receiving organization has dependent demand due 
on Day 24.

Scenario 7: Calculations for Item C Supply (Transfer From, Receiving Organization)
Need By Date: Day 24 (Demand Due Date)

Suggested Due Date: Day 29

• Use ORG1 receiving organization calendar

• Need By Date: Day 24

• Planning Time Fence Date is Day 26

• The planning engine cannot schedule planned order until Day 29 (Planning Time 
Fence Date + 1) = Day 26 + 1 day
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• Two non-work days: Days 27 and 28

• Supply is due after Demand Due Date; issue shortage exception message. Do not 
reschedule any other supply order that requires this supply. However, supplies 
below this one in the supply chain bill are delayed as the planning engine plans 
them. 

Suggested Dock Date: Day 26

• Use ORG1 receiving organization calendar

• Suggested Due Date - Postprocessing = Day 29 - 1 day

• Two non-work days: Days 27 and 28

Suggested Ship Date: Day 24

• Use ORG1 receiving organization calendar

• Suggested Dock Date - Intransit Time [include non-workdays] = Day 26 - 2 days = 
Day 24 

• Use ORG2 shipping organization calendar

• Day 24 is a work day

Suggested Start Date: Day 17

• Use ORG2 shipping organization calendar

• Suggested Ship Date - ((Fixed + (Variable * Supply quantity)) [Fixed and Variable 
from ORG2] = Day 24 - (4 days + (0.25 days * 8) = Day 24 - 6 days 

• One non-workday: Day 21

Suggested Order Date: Day 16

• Use ORG1 receiving organization calendar

• Start Date - Preprocessing = Day 17 - 1 day

Scenario 7: Calculation for Item C Demand (Make At, Shipping Organization)
You transfer component Item C from ORG2 to ORG1. Demand Due Date: Day 24 (Item 
A at ORG1 Suggested Ship Date).

Scenario 7: Calculations for Item C Supply (Make At, Shipping Organization)
Need By Date: Day 24 (Demand Due Date)

Suggested Due Date: Day 24 (Need By Date)

Suggested Start Date: Day 17
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• Use ORG2 shipping organization calendar

• Suggested Due Date - ((Fixed + (Variable * Supply quantity)) = Day 24 - (4 days - 
(0.25 days * 8) = Day 24 - 6 days 

• One non-work day: Day 21

Suggested Order Date: Day 13

• Use ORG2 shipping organization calendar 

• Suggested Start Date - Preprocessing = Day 17 - 3 day

• One non-work day: Day 14 

Scenario 7: Summary
This table summarizes the lead-times for Scenario 7: Unconstrained Plan, Purchased 
Component Planning Time Fence Control

Organiza
tion

Item Order 
Type

Suggest
ed Due 
Date

Suggest
ed Dock 
Date

Suggest
ed Ship 
Date

Suggest
ed Start 
Date

Suggest
ed Order
Date

ORG1 A Demand Day 33 n/a n/a n/a n/a

ORG1 A Planned 
order

Day 33 n/a n/a Day 24 Day 23

ORG1 C Planned 
order 
demand

Day 24 n/a n/a n/a n/a

ORG1 C Planned 
order

Day 29 Day 26 Day 24 Day 17 Day 16

ORG2 C Planned 
order 
demand

Day 24 n/a n/a n/a n/a

ORG2 C Planned 
order

Day 24 n/a n/a Day 17 Day 13

Scenario 8: Constrained - Enforce Capacity Constraints Plan, Transfer Component Planning Time Fence Control
Constrained plans perform detailed scheduling which considers resource and material 
constraints. These examples assume no constraints and use lead-time offsets; the 



Supply Chain Plan Modeling    6-123

planning engine would only do this if Item A has no routing.

See Example 3: Transfer Component in this topic for setup information.

See Scenario 7: Unconstrained Plan, Purchased Component Planning Time Fence 
Control in this topic for the calculation of Planning Time Fence Date for Item C in 
organization ORG1. Item C organization ORG1 Planning Time Fence Date: Day 26. The 
planning engine cannot schedule a planned order until the day after Planning Time 
Fence Date.

See Scenario 6: Unconstrained Plan, No Planning Time Fence Control in this topic for 
the calculations of supply for Item A and demand for Item C at the receiving 
organization ORG1. Item C in the receiving organization has dependent demand due 
on Day 24.

Scenario 8: Calculations for Item C Supply (Transfer From, Receiving Organization)
Need By Date: Day 24 (Demand Due Date)

Suggested Due Date: Day 24 (Need by Date)

Suggested Dock Date: Day 23

• Use ORG1 receiving organization calendar

• Suggested Due Date - Postprocessing = Day 24 - 1 day

Suggested Ship Date: Day 20

• Use ORG1 receiving organization calendar

• Suggested Dock Date - Intransit Time [include non-workdays] = Day 23 - 2 days = 
Day 21 

• Use ORG2 shipping organization calendar

• Day 21 is not a work day. Move suggested ship date to next earlier work day.

Suggested Start Date: Day 27

• Use ORG2 shipping organization calendar

• Suggested Ship Date - ((Fixed + (Variable * Supply quantity)) [Fixed and Variable 
from ORG2] = Day 24 - (4 days + (0.25 days * 8) = Day 20 - 6 days = Day 13

• One non-workday: Day 14

• Planning Time Fence Date is Day 26

• The planning engine cannot schedule planned order until Day 29 (Planning Time 
Fence Date + 1) = Day 26 + 1 day = Day 27

• Day 27 is a workday in ORG2 shipping organization. It is a non-workday in ORG1 
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receiving organization.

Suggested Order Date: Day 26

• Use ORG1 receiving organization calendar

• Start Date - Preprocessing = Day 27 - 1 day

Scenario 8: Recalculations for Item C Supply (Transfer From, Receiving Organization)
Recalculate Suggested Ship Date, Suggested Dock Date, and Suggested Due Date by 
forward scheduling from Suggested Start Date.

Suggested Ship Date: Day 31

• Use ORG2 shipping organization calendar

• Suggested Start Date + (Fixed + (Variable * Supply quantity)) [Fixed and Variable 
from ORG2] = Day 27 + (4 days + (0.25 days * 8) = Day 27 + 6 days

• One non-workday: Day 28

Suggested Dock Date: Day 33

• Use ORG1 receiving organization calendar

• Suggested Ship Date + Intransit Time [include non-workdays] = Day 31 + 2 days = 
Day 33

• Use ORG2 shipping organization calendar

• Day 33 is a work day.

Suggested Due Date: Day 36

• Use ORG1 receiving organization calendar

• Suggested Dock Date + Postprocessing = Day 33 + 1 day

• Two non-workdays: Days 34 and 35

Scenario 8: Recalculation for Item A Supply (Make At, Receiving Organization)
Reschedule Item A supply Suggested Start Date and Suggested Due Date by forward 
scheduling from Day 36 (Item C Suggested Due Date in ORG1 receiving organization)

Suggested Start Date: Day 36 (Item C Suggested Due Date)

Suggested Due Date: Day 45

• Use ORG1 organization calendar 

• Suggested Start Date + ((Fixed + (Variable * Supply quantity)) = Day 36 + (3 days - 
(0.5 days * 8) = Day 36 + 7 days
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• Two non-work days: Days 41 and 42

Reschedule Item A supply Suggested Order Date by backward scheduling from Day 36 
(Item C Suggested Due Date in ORG1 receiving organization)

Suggested Order Date: Day 33

• Use ORG1 organization calendar

• Suggested Start Date - Preprocessing = Day 36 - 1 day

• Two non-workdays: Days 34 and 35

Scenario 8: Calculation for Item C Demand (Make At, Shipping Organization)
You transfer component Item C from ORG2 to ORG1. Demand Due Date: Day 31 (Item 
C Suggested Ship Date at ORG1 receiving organization).

Scenario 8: Calculations for Item C Supply (Make At, Shipping Organization)
Need By Date: Day 31 (Demand Due Date)

Suggested Due Date: Day 31 (Need By Date)

Suggested Start Date: Day 24

• Use ORG2 shipping organization calendar

• Suggested Due Date - ((Fixed + (Variable * Supply quantity)) = Day 31 - (4 days - 
(0.25 days * 8) = Day 31 - 6 days 

• One non-work day: Day 28

Suggested Order Date: Day 20

• Use ORG2 shipping organization calendar 

• Suggested Start Date - Preprocessing = Day 24 - 3 day

• One non-work day: Day 21 

Scenario 8: Summary
This table summarizes the lead-times for Scenario 8: Constrained - Enforce Capacity 
Constraints Plan, Transfer Component Planning Time Fence Control.

Organiza
tion

Item Order 
Type

Suggest
ed Due 
Date

Suggest
ed Dock 
Date

Suggest
ed Ship 
Date

Suggest
ed Start 
Date

Suggest
ed Order
Date

ORG1 A Demand Day 33 n/a n/a n/a n/a
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Organiza
tion

Item Order 
Type

Suggest
ed Due 
Date

Suggest
ed Dock 
Date

Suggest
ed Ship 
Date

Suggest
ed Start 
Date

Suggest
ed Order
Date

ORG1 A Planned 
order

Day 45 n/a n/a Day 36 Day 33

ORG1 C Planned 
order 
demand

Day 36 n/a n/a n/a n/a

ORG1 C Planned 
order

Day 36 Day 33 Day 31 Day 27 Day 26

ORG2 C Planned 
order 
demand

Day 31 n/a n/a n/a n/a

ORG2 C Planned 
order

Day 31 n/a n/a Day 24 Day 26

Examples of Planning Time Fence Control

Manufacturing Work Order Scheduling
This topic explains the scheduling of manufacturing work orders. Although the 
examples use Oracle Work in Process discrete jobs, they also apply to the scheduling of 
the primary path of Oracle Shop Floor Manufacturing lot based jobs and Oracle Process 
Manufacturing work orders.

This diagram shows a plan with the following features:

• Run on May 5

• Planning time fence control enabled

• The profile options that create a natural time fence based on existing firmed 
supplies are disabled.

• Planning Time Fence Date is based on the item attribute (User defined, 4 days) as 
May 9 and considers working days in the organization. The calendar for this 
organization has no non-work days in the organization calendar.

This diagram shows the supplies for this item after the plan run. The supplies have the 
following characteristics:
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• Job 1: Completely scheduled in the past.

• Job 2: Operations scheduled in the past and completion date of May 6 is earlier than
Planning Time Fence Date.

• Job 3: Three operations scheduled to start prior to Planning Time Fence Date.

• Job 4 and 5: All operations scheduled to start after Planning Time Fence Date.

• Job 6: This job is firmed to complete on May 10. 

This diagram shows the state of the collected discrete jobs.

State of Collected Discrete Jobs

Manufacturing Work Order Scheduling in Unconstrained Plans
In unconstrained plans, the planning engine schedules manufacturing work order 
completion dates earlier than Planning Time Fence Date, as follows:

• Planned manufacturing orders and non-firm manufacturing work orders: Order 
Due Date never scheduled earlier than the item's Planning Time Fence Date.

• Firm manufacturing work orders: Never cancel, reschedule, or change the Order 
Due Date. 

• Firm planned manufacturing orders: Retained based on the value of plan option 
Overwrite. If None or Overwrite Outside Planning Time Fence, retain the order and
consider Order Due Date firm.

This diagram shows the same manufacturing work orders from topic Manufacturing 
Work Order Scheduling scheduled in an unconstrained plan. The planning engine 
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schedules Order Due Date then offsets operations from Order Due Date according to 
Lead Time % on the manufacturing work order routing. For operations scheduled prior 
to the plan run date, the planning engine compresses them to start and complete on the 
plan run date:

• Job 1: is rescheduled out to meet its demand on time. Operation 10 would have 
been scheduled to start and complete in the past. These dates are both updated to 
Start on Plan Run Date. Operation 20 would have been scheduled to start in the past
and is now updated to Start of Plan Run Date

• Job 2: Order Due Date rescheduled out to meet its demand on time. Operation start 
and completion dates offset with no compression.

• Job 3: Order Due Date rescheduled out to meet its demand on time. Operation start 
and completion dates offset with no compression

• Job 4: Rescheduled in to meet demand on time because Order Due Date is later than
the Planning Tine Fence Date. All operations offset from this date.

• Job 5: Canceled because it has no pegged demand

• Job 6: A firm job, not rescheduled.

This diagram shows the effect of Planning Time Fence Date and firming on discrete job 
scheduling in Unconstrained plans.
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Discrete Job Scheduling with Planning Time Fence and Firming, Unconstrained Plan

Manufacturing Work Order Scheduling in Constrained - Enforce Capacity Constraints Plans
For a Constrained - Enforce capacity constraints plan, the planning engine applies the 
following planning time fence control rules based on the item's Planning Time Fence 
Date:

• Planned orders: Do not schedule the first operation to start earlier than Planning 
Time Fence Date.

• Non-firm manufacturing work orders: If an order, operation, or resource has a start 
date inside the planning time fence, do not rescheduled in. If the job a start date 
outside of the planning time fence, only reschedule in up to Planning Time Fence 
Date.

• Firm manufacturing work orders: Never cancel or reschedule. Do not change the 
completion date or reschedule the operations. Calculate firm work order resource 
requirements and reduce resource availability by these requirements. Consider the 
resource loads for firmed jobs prior to scheduling all other supplies. 

• Firm planned manufacturing orders: Retained based on the value of plan option 
Overwrite. If None or Overwrite Outside Planning Time Fence, retain the order and
consider Order Due Date firm. Consider the completion date firm; reschedule 
operations as required. The operation rescheduling may cause compression or 
violate Planning Time Fence Date because the supply is firmed.

In the operation detailed scheduling, the planning engine calculates Earliest Possible 
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Start Date for each operation. This is never earlier than Planning Time Fence Date, but it
may be later.

This diagram shows the same manufacturing work orders from topic Manufacturing 
Work Order Scheduling scheduled in an unconstrained plan:

• Jobs 1, 2, and 3: Rescheduled out based on the required demand dates. All of these 
jobs had job and operation start dates earlier than Planning Time Fence Date, so 
their operations would never be rescheduled in. Job 1 cannot be scheduled in time 
to meet its required demand; the planning engine schedules the operations 
respecting their minimum lead-time and the first operation cannot start prior to the 
plan run date. The planning engine reschedules Jobs 2 and 3 to meet their demands 
on time. It schedules all operations to minimize slack between resources except 
Operation 10 which is scheduled earlier due to a capacity constraint

• Job 4: Rescheduled in based on its demand due date. Since the planning engine 
cannot reschedule Start Date of the first operation earlier than Planning Time Fence 
Date, it forward schedules from Planning Time Fence Date.

• Job 5: Canceled because it has no pegged demand and its start date is outside the 
planning time fence.

• Job 6: Since the work order is firm, the planning engine never cancels it or 
reschedules its completion date. It does not reschedule the operation start and end 
dates and loads the resources are based on their requirements on the existing 
schedule dates.

This diagram shows the effect of Planning Time Fence Date and firming on discrete job 
scheduling in Constrained - Enforce capacity constraints plans.
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Discrete Job Scheduling with Planning Time Fence and Firming, Constrained - Enforce 
Capacity Constraints Plan

Manufacturing Work Order Scheduling in Constrained - Enforce Demand Due Dates Plans
Constrained - Enforce demand due dates plans generally follow the same rules as 
Constrained - Enforce capacity constraints plans. However, the planning engine may 
schedule supplies earlier than Planning Time Fence Date to meet the demand. It may 
also compress operations.

This diagram shows the same manufacturing work orders from topic Manufacturing 
Work Order Scheduling in Constrained - Enforce Capacity Constraints Plans scheduled 
in a Constrained - Enforce demand due dates plan. The planning engine schedules all 
the supplies to meet the due dates of their pegged demands even if it violates the 
planning time fence:

• Job 1: Rescheduled out to meet its demand on time. May overload or compress 
resources.

• Jobs 2 and 3: Rescheduled out to meet their demands on time with no resource 
overload or compression

• Job 4: Rescheduled in to meet its demand on time. Operation 10 rescheduled in 
earlier than Planning Time Fence Date.

• Job 5: Canceled because it has no pegged demand

• Job 6: Firm, not rescheduled

This diagram shows the effect of Planning Time Fence Date and firming on discrete job 
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scheduling in Constrained - Enforce capacity constraints plans.

Discrete Job Scheduling with Planning Time Fence and Firming, Constrained - Enforce 
Demand Due Dates Plan

Manufacturing Work Order Scheduling with Firm Operations and Orders
If you want to maintain the detailed schedule dates from a previous plan or that you 
have set, you can direct the planning engine to consider operations within the planning 
time fence as firm. 

In constrained plans only, set profile option MSO: Firm Operations/Orders Within Time
Fence to Yes at the site level. The planning engine:

• Consider operations with Start Date earlier than Planning Time Fence Date as firm

• Does not change their schedule dates and loads resources on these schedule dates

• Considers work orders with completion dates earlier then Planning Time Fence 
Date as firmed

• Does not reschedule their the job completion dates or cancel them

This diagram shows the same manufacturing work orders from topic Manufacturing 
Work Order Scheduling scheduled in a Constrained - Enforce capacity constraints plan. 
The scheduling in Constrained - Enforce demand due dates plans is similar:

• Jobs 1 and 2: All operations are earlier than Planning Time Fence Date; do not 
reschedule. Do not change Order Due Date. Compress the first two operations of 
Job 1 ad the first three operations of Job 2 to occur on the plan run date because 
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their schedule dates occurred prior to the plan run date.

• Job 3: Operations 10, 20, and 30 have Start Date earlier than Planning Time Fence 
Date (May 9); do not reschedule. Operation 40 starts after Planning Time Fence 
Date; schedule out based on the required demand date. Reschedule out completion 
date.

• Job 4: All operations have Start Date after Planning Time Fence Date; reschedule 
them. Reschedule the first operation up to Planning Time Fence Date. In a 
Constrained - Enforce capacity constraints plan, do not violate the operation start 
date and forward schedule the job; the job is late for its demand. In a Constrained - 
Enforce demand due dates plan, schedule the operation prior to Planning Time 
Fence Date to meet the demand on time.

• Job 5: Cancel because all operations scheduled to start after Planning Time Fence 
Date

• Job 6: Firm; do not reschedule job completion date and operation schedule dates

This diagram shows the effect of firm operations and orders on discrete job scheduling 
in Constrained plans.

Discrete Job Scheduling with Firm Operations and Orders, Constrained Plans

Safety Stock
Safety stock is a quantity of stock you plan to remain in inventory to protect against 
fluctuations in demand (for example, forecast error) and supply (for example, variable 
supplier lead times and irregular operation yields). Safety stock is sometimes referred to
as overplanning, a market hedge, buffer stock, or reserve stock.
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Safety stock is an inventory level that needs to be maintained. You satisfy demand, for 
example, sales orders and forecasts, by consuming inventory. Safety stock is an 
inventory level that you must maintain; it remains in projected available balance.

Safety stock level can be made up of different types of safety stock levels:

• Non-transient safety stock levels are levels that you hold from their point of 
origination to the end of the planning horizon. They are safety stock levels without 
ending effectivity dates.

• Transient safety stock levels are levels that you hold for only a certain time during 
the planning horizon. They are safety stock levels with ending effectivity dates. 
Transient safety stock levels plan for supplies to be completed earlier than the 
demands that peg to them and plan for the inventory to be held as safety stock. You
can also complete supplies earlier than the demands that peg to them using safety 
lead-time; see Safety Lead-time , page 6-77

This diagram shows a safety stock level and its components for a 15-day planning 
horizon (PH). It details:

• SSL: Safety stock level

• T1, T2: Transient safety stock levels

• NT1, NT2: Non-transient safety stock levels

D1 D2 D3 D4 D5 D6 D7 D8 D9 D1
0

D1
1

D1
2

D1
3

D1
4

D1
5

SSL 10 10 10 10 10 10 25 25 25 18 18 18 15 15 15

T1 
(D7
> 
D9)

- - - - - - 10 10 10 - - - -- - -

T2 
(D1
0 < 
D1
2)

- - - - - - - - - 3 3 3 - - -
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2 
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Specifying Safety Stock Levels
You can use several ways to specify safety stock levels to the planning engine:

• You specify

• Oracle Inventory calculates

• The planning engine calculates

• Oracle Inventory Optimization calculates

If you run optimized plans, see also Implicit Objectives, page 5-144.

You Specify Safety Stock Levels

Navigate to the item attributes (Inventory > Items > Master Items or Inventory > Items > 
Organization Items > tab General Planning > region Safety Stock > field Method.

Set Method to Non MRP Planned

Navigate to form Enter Item Safety Stocks (Inventory > Planning > Safety Stocks).

Enter Item, Quantity, and Effective Date.

If you specify only one safety stock level for an item, the planning engine considers the 
safety stock level as non-transient. If you enter more than one safety stock level for an 
item, the planning engine generally considers the safety stock level as transient. 
However, if the levels are always increasing, the planning engine considers the safety 
stock levels as non-transient. If there is no safety stock level for an item, the planning 
engine considers the safety stock level as zero.

See Entering and Reloading Safety Stocks, Oracle Inventory User's Guide.
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Oracle Inventory Calculates Safety Stock Levels

Navigate to the item attributes (Inventory > Items > Master Items or Inventory > Items > 
Organization Items > tab General Planning > region Safety Stock > field Method.

Set Method to Non MRP Planned

Use one of these Oracle Inventory methods for calculating safety stock:

• Mean absolute deviation (MAD): The formula is safety stock = Z * 1.25 * MAD, 
where Z is a function of the desired service level, which you enter.

• User-defined percentage 

User-defined percentage: The formula is the percentage you enter times the average
monthly demand. 

See Entering and Reloading Safety Stocks, Oracle Inventory User's Guide.

The Planning Engine Calculates Safety Stock Levels

Navigate to the item attributes (Inventory > Items > Master Items or Inventory > Items > 
Organization Items) > tab General Planning > region Safety Stock.

Set field Method to MRP Planned %

Specify Bucket Days as the number of days to be used for aggregating demand

Specify Percent as the percentage of aggregated demand to be used for safety stock.

If either Bucket Days or Percent are zero, the planning engine calculates the safety stock 
as zero.

The planning engine calculates safety stock level for all for working days in the 
planning horizon during the planning process. The level is a target to be satisfied by the
end of the day. You can control it with profile option MSO: Default Timestamp Safety 
Stocks.

For each day, the planning engine multiplies the safety stock percentage you define by 
the sum of gross requirements for the safety stock days. For repetitively manufactured 
items in unconstrained plans only, the planning process multiplies the percentage you 
define by the average daily demand during each repetitive planning period.

The formula for discrete safety stock is (Sum of gross requirements for Bucket Days 
working days * Percent) / (100 * Bucket Days).

The organization manufacturing calender determines the working days.

The gross requirements includes both independent and dependent demands. For 
independent demands, the planning engine uses the demand date. For dependent 
demands, it uses the unconstrained demand date. In constrained and optimized plans, 
the scheduling process occurs after the safety stock calculation; the planning engine 
does not recalculate safety stock even if the scheduling process changes dates.

If the demand is in weekly buckets, the planning evenly divides the weekly demand 
over the days.
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For example, an item has these item attributes:

• Safety stock method: MRP Planned %

• Bucket Days: 5

• Percent: 500% = 5

Days D6 & D7 are non-workdays.

This table shows the demands for days D1 through D9 and the safety stock level for
days D1 and D2. The planning engine does calculate safety stock levels for the other
work days.

  D1 D2 D3 D4 D5 D6 D7 D8 D9

Demand (independent 
and dependent)

10 20 15 35 25 - - 5 35

Safety stock level 105 
[(10+20+15
+35+25) * 
500] / (100 
*5)]

100 
[(20+15+35
+25+5) * 
500] / (100
*5)]

- - - - - - -

Oracle Inventory Optimization Calculates Safety Stock Levels

Navigate to the item attributes (Inventory > Items > Master Items or Inventory > Items > 
Organization Items > tab General Planning > region Safety Stock.

Set field Method to MRP Planned %. You may leave Bucket Days and Percent blank. 
Oracle Inventory Optimization calculates safety stock level only for items with item 
attribute Method set to MRP Planned %.

Use Oracle Inventory Optimization to calculate safety stock levels that account for 
variability in demand and lead times. See Oracle Inventory Optimization 
Implementation and User's Guide.

The planning engine receives information for each item-organization combination. The 
levels are timed with the inventory optimization plan's time buckets. 

If there is a planned item that is not in the inventory optimization plan and item 
attribute Method is set to:

• MRP Planned %: The planning engine calculates safety stock level for the item

• Non MRP Planned: The planning engine receives safety stock level for the item 
from Oracle Inventory.

When receiving safety stock information from Oracle Inventory Optimization, the 
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planning engine:

• Does not process safety stock demands that occur after the plan horizon date

• Sets safety stock demand for the last bucket to be the same as the safety stock 
demand in the second to the last bucket

• In weekly and period buckets, moves safety stock demands that occur on a 
non-workday to the previous workday

Safety Stock Planning
Enabling Safety Stock Planning

Navigate to form Plan Options (Supply Chain Planning > Supply Chain Plan > Options).
In tab Organizations: 

• In region Organizations, select field Plan Safety Stock for the organizations that you
want. You can default this setting in the Plan Parameters form (Supply Chain 
Planning > Setup > Parameters > Execution Defaults).

• Only if you set safety stock levels by an Oracle Inventory Optimization plan, in 
region Demand Schedules > field Name, select the inventory optimization plan with
the safety stock levels that you want the planning engine to use.

Planning Phases for Safety Stock

The planning engine plans to meet safety stock levels through a process of sequential 
phases:

• Safety stock smoothing: Smooths out fluctuations in safety stock. This phase is 
optional. The planning engine only performs safety stock pegging if profile option 
MSC: Use FIFO Pegging is No.

• Inventory netting: Creates planned orders and recommendations to meet safety 
stock levels

• Pegging: Associates supplies and demands

• Scheduling: Detailed schedules supplies

This topic explains phases Safety stock smoothing, Inventory netting, and Scheduling. 
To understand the Pegging phase, see Safety Stock Pegging, page 18-83.

Safety Stock Smoothing Planning Phase

Consider this phase especially if you have the planning engine calculate safety stock 
levels. The planning engine bases safety stock levels on demand levels; as demand 
levels fluctuate, safety stock levels fluctuate. This phase help smooth out nervous safety 
stock levels.
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There are the types of safety stock smoothing:

• Within time intervals:

• Across time intervals:

Safety Stock Smoothing Planning Phase: Within Time Intervals

You can instruct the planing engine to keep safety stock levels relatively constant within
a time interval.

You specify:

• The number of days in the time interval: Set profile option MSC: Safety stock 
change interval (Days)

• The method that the planning engine should use to calculate the constant value: Set 
profile option MSC: Smoothing method to calculate Safety stock within Change 
interval

The planning engine begins at the plan start date and:

• Groups the days in to the time interval based on the number of days you specify

• Finds the value among the days that corresponds to the method--minimum, 
maximum, or average

• Sets the safety stock level for all the days in the time interval to that value

This table shows the daily safety stock levels. It then shows the smoothed safety stock 
levels that the planning engine calculates for the value of profile option MSC: 
Smoothing method to calculate Safety stock within Change interval with profile option 
MSC: Safety stock change interval (Days) set to 3. Levels are rounded to integers.

D1 D2 D3 D4 D5 D6 D7 D8 D9 D1
0

D1
1

D1
2

D1
3

D1
4

D1
5

Dai
ly

11 14 25 5 5 15 35 45 25 12 45 23 5 10 15

Mi
n

11 11 11 5 5 5 25 25 25 12 12 12 5 5 5

Av
g

17 17 17 8 8 8 35 35 35 27 27 27 10 10 10

Ma
x

25 25 25 15 15 15 45 45 45 45 45 45 15 15 15
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Safety Stock Smoothing Planning Phase: Across Time Intervals

You can instruct the planning engine to minimize safety stock levels across the 
smoothed time intervals.

You specify:

• Whether you want the planning engine to do this smoothing only for MRP Planned 
% items or for all items. Set profile option MSC: Apply Safety Stock Change interval
to non MRP Planned Safety Stock.

• The maximum change in safety stock values that you will allow between time 
intervals. Set profile option MSC: Maximum Percentage variation in safety stock 
values.

• The minimum change in safety stock values that you consider significant enough to 
trigger a change in the safety stock level from one bucket to the next. Set profile 
option MSC: Minimum Percentage variation in safety stock values.

The planning engine finds the highest safety stock level within the planning horizon 
and begins the smoothing process from that time interval. It proceeds backwards to the 
plan start date and smooths each time interval, then proceeds forward to the end of the 
planning horizon and smooths each time interval.

The planning engine calculates the change between time intervals as [100 * (Safety stock
level in the next interval - Safety stock level in this interval)] / Safety stock level in this 
interval.

If the deviation between the two time intervals is:

• Between the minimum and maximum changes in safety stock levels that you will 
allow, the planning engine leaves the original safety stock level

• Higher than the maximum changes in safety stock levels that you will allow, the 
planning engine adjusts the original safety stock level to be at the maximum 
percent.

• Lower than the minimum changes in safety stock levels that you consider 
significant, the planning engine retains the safety stock level for the two buckets.

In this table: 

• The value you enter for profile option MSC: Smoothing method to calculate Safety 
stock within Change interval is Minimum.

• You set profile option MSC: Maximum Percentage variation in safety stock values 
to 55. This is the maximum deviation that is considered significant to trigger a 
change in safety stock between two periods.

• You set profile option MSC: Minimum Percentage variation in safety stock values to
10. This is the minimum allowed deviation between any two periods.
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• The planning engine finds the highest smoothed safety stock level in the planing 
horizon to be D7-9. It begins from there and smooths across time intervals by 
calculating deviations in the order D7-9 to D4-6, then D4-6 to D1-3, then D7-9 to 
D10-12, and then D10-12 to D13-15.

D1-3 D4-6 D7-9 D10-12 D13-15

Smoothed 
Minimum 
safety stock 
level within 
time intervals

11 5 25 12 5

Maximum 
allowed 
deviation

+/- 55% +/- 55% Base +/- 55% +/- 55%

Minimum 
allowed 
deviation

+/- 10% +/- 10% Base +/- 10% +/- 10%

Order of 
smoothing 
calculations

2 1 Base 3 4

Actual 
deviation

+46.6%

[100*(16.13-11
)/11]

+400%

[100*(25- 5)/5]

Base -52%

[100*(12-25)/2
5]

-58%

[100*(5-12)/12
]

Decision Actual 
deviation 
within 
minimum / 
maximum 
range; retain 
value

Actual 
deviation 
outside of 
maximum 
allowed; cap 
safety stock 
level at 55% 
of base level

Base Actual 
deviation 
within 
minimum / 
maximum 
range; retain 
value

Actual 
deviation 
outside of 
maximum 
allowed; cap 
safety stock 
level at 55% 
of previous 
level

Smoothed 
safety stock 
level across 
time intervals

11 16

[25 / (1+0.55) 
= 16.13]

25 12 5

[12*(1 - 0.55)] 
= 5.4]

Inventory Netting Planning Phase for Safety Stock
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When there is a safety stock level for an item, the netting process checks for a shortage 
using this formula: Projected available balance from last period + Supplies in this period
- Independent and dependent demand in this period - Safety stock level in this period.

After the planning engine resolves the shortage through planned orders, future firm 
planned orders, and recommendations, the projected available balance should be the 
safety stock level. However, the projected available balance may be affected by order 
modifiers and constraints.

Pegging Planning Phase for Safety Stock

To understand the Pegging phase, see Safety Stock Pegging, page 18-83.

Scheduling Planning Phase for Safety Stock

The planning engine uses the safety stock pegging information to schedule supplies. It 
schedules supplies so that they meet both demands and safety stock levels as 
appropriate.

Other Safety Stock Planning Principles

The planning engine uses unconstrained demand dates in the inventory netting and 
pegging phases. The scheduling phase may move supplies in and out and that could 
result in your holding too much or too little safety stock.

The planning engine uses unconstrained demand dates when it calculates safety stock 
level. Therefore, it could sometimes be difficult to tie safety stock level to the MRP 
Planned % values. The dependent demands used in the initial calculation of safety stock
level may have moved by the scheduling process.

These profile options also relate to safety stock:

• MSC: Excess and Safety Stock by Demand Class, see MSC Profile Options, page A-
13

• MSO: Default Timestamp Safety Stock, see MSD Profile Options, page A-76

Viewing Safety Stock Results

To see the results of safety stock planning, see Horizontal Plan, page 18-52, 
Supply/Demand Window, page 18-64, and Pegging, page 18-83.

Setting Shipping, Receiving, Carrier, and Supplier Capacity Calendars
Oracle Advanced Supply Chain Planning plans a variety of supply chain activities like 
manufacturing, inter facility shipments, purchases, and shipment to customers. Each of 
these activities is controlled by a set of calendars. Manufacturing, supplier, and 
customer facilities may be able to ship or receive goods on specific days. Oracle 
Advanced Supply Chain Planning plans each type of supply or demand considering the
working and non working days in the appropriate set of calendars. 

The planning engine considers the following calendars while planning and scheduling:
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• Org/Supplier shipping calendar

• Org/Customer receiving calendar

• Carrier calendar

• Supplier capacity calendar

• Manufacturing Calendar

It does not consider account-level customer calendars.

The planning engine generates specific exceptions when the dates in the calendar cause 
a delay in meeting a customer order or, when the dates are violated.

Shipping Calendar
The shipping calendar indicates the valid working days for shipment activities 
originating from suppliers and organizations. The planning engine does not 
recommend a shipment out from those facilities if the date is a non-working day. The 
planning engine adjusts the shipment date if the current shipment date is a 
non-working day. For example, an inter organization shipment that originates at a 
certain organization may be able to start only between 9 a.m. and 5 p.m. on Monday 
through Friday. The planning engine considers the working days and times when 
generating recommended transfers as part of the planning process.

Shipping calendars also need to be variable by the combination of carrier and the 
service level. For example, a carrier company may only pick up parcels between 
Monday and Friday. However, another carrier company may also have a Saturday 
pickup. In addition, any carrier or service level shipping calendars override the default 
shipping calendar for the organization or a supplier.

The planning engine uses:

• Processing lead time to calculate the dock date during the planning and scheduling 
process

• Shipping calendars to calculate valid ship date (dock date - intransit lead time) after
the planning and scheduling process completes

In some cases, the planning engine may not find a valid ship date for a buy order, for 
example, if:

• You have an item with processing lead time that is less than the intransit time from 
supplier to organization

• Your shipping calendar has many non-workdays

In these cases, the planning engine uses today's date (the plan run date) as the ship date.
If today is a non-workday on the shipping calendar, the planning engine issues 
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exception message Order violates a business calendar.

Receiving Calendar
The receiving calendar governs the receiving activities at the organizations or customer 
sites that receive goods. The planning engine allows organizations to receive shipments 
only on a working day. If the current shipment arrival date is a non-working day 
according to the receiving calendar, the planning engine defers the receipt of the 
shipment until the next (or previous) working day. For example, the dock doors of a 
distribution center that receives truckload shipments from a manufacturing facility may
be open between 12 noon and 5 p.m. on a daily basis. When generating planned 
transfers between these two facilities, the planning engine assigns dock dates on these 
planned transfers based on the receiving calendar of the organization.

Receiving calendars can also vary by combination of carrier and service level. You need 
to specify valid receiving calendars for organizations and customers at the carrier and 
service levels.

Carrier Calendar
The carrier calendar indicates the working and non-working days and times for 
material that is intransit using different means of transport. For example, certain 
methods of shipment such as parcel carriers may not work on weekends. This may 
cause the transit time to be stretched over the weekends. The planning engine needs to 
consider these non-working times of various transportation modes that are modeled in 
the supply chain. Consider a carrier that has a regular transit time of 3 days. However, 
this carrier does not pick, deliver or operate during weekends. This implies that while a 
shipment that starts on a Monday morning can arrive on a Thursday morning, a 
shipment that starts on a Friday morning cannot arrive on a Monday morning. It can 
only arrive on a Wednesday morning because the carrier does not operate on Saturday 
and Sunday.

Note: The carrier calendar indicates the operating calendar of the 
carrier or the service. It does not indicate the pickup or delivery dates 
of the carrier.

Supplier Capacity Calendar
The supplier capacity calendar governs how supplier capacity is accumulated over a 
period of time. Supplier capacity is only accumulated on the working days according to 
the supplier capacity calendar. The supplier capacity calendar also governs how the 
supplier processing time is calculated.

Default Hierarchy for Calendars
You may or may not define all the calendars available. Therefore, depending on the 
calendars that you define, the valid calendar for scheduling dates could change. Refer 
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the following table for the hierarchy that the planning engine uses for determining valid
calendars:

Calendar 
Name

Option 1 Option 2 Option 3 Option 4 Option 5

Supplier 
capacity 
calendar

Supplier/sup
plier site 
capacity 
calendar

24x7 calendar - - -

Supplier 
shipping 
calendar

Carrier/suppl
ier/supplier 
site calendar

Supplier/Sup
plier Site 
Shipping 
Calendar

Carrier/Suppl
ier Calendar

Supplier 
Shipping 
Calendar

24x7 calendar

Organization 
Receiving 
Calendar 

Carrier/Org 
Calendar

Organization 
Receiving 
Calendar

Organization 
Manufacturin
g Calendar

- -

Organization 
Manufacturin
g Calendar

Organization 
Manufacturin
g Calendar

- - - -

Organization 
Shipping 
Calendar

Carrier / Org 
Calendar

Organization 
Shipping 
Calendar

Org 
Manufacturin
g Calendar

- -

Customer 
Receiving 
Calendar

Carrier/Custo
mer/Custome
r Site 
Calendar

Customer/Cu
stomer Site 
Receiving 
Calendar

Carrier/Custo
mer Calendar

Customer 
Receiving 
Calendar

24x7 calendar

Intransit 
Calendar 

Carrier 
Intransit 
Calendar

24x7 calendar - - -

Note: An organization manufacturing calendar always exists for an 
organization.

The planning engine first checks option 1 for each calendar. In case, option 1 is not 
defined in your setup, then it checks the next option available. For example, when the 
planning engine needs to take into account a supplier shipping calendar, it checks for a 
supplier / supplier site / carrier shipping calendar. If not specified, the planning engine 
looks for a supplier / supplier site shipping calendar. If not specified, it looks for a 
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supplier / carrier calendar. If not specified, then it looks for a supplier shipping calendar
and if that does not exist, it then defaults to a 24x7 calendar.

If you want any organization shipping and receiving calendars to be 24x7, then you 
need to define the specific calendar as 24x7 if the organization manufacturing calendar 
is not 24x7.

In case of receiving calendars, the planning engine checks customer receiving calendars 
set up at the customer level. Customer receiving calendars set up at the account level 
are not supported.

If you do not want to use any shipping, receiving, or, carrier calendar for 
planning/scheduling, set the profile MSC: Use Shipping/Receiving Calendars to No. 
When you set this profile to No, the planning engine uses only the organization 
manufacturing calendar while generating a plan. Irrespective of the setting of this 
profile, the planning engine takes into account the supplier capacity calendar to 
accumulate supplier capacity. If the supplier capacity calendar is not specified, the 
planning engine uses the 24x7 calendar. If you want to accumulate supplier capacity 
based on the organization manufacturing calendar, you need to set your supplier 
capacity calendar to be the same as the organization manufacturing calendar.

Lead-time Calculation
Oracle Advanced Supply Chain Planning plans orders depending on the type of order 
as well as the type of date on the order. The planning engine checks the working and 
non working days on specific calendars after taking into consideration the lead-time for 
each type of order.

Lead-time offsetting begins only on a workday of the workday calendar.

For Make Orders
Refer the following figure for the calendars and lead-times that the planning engine 
takes into account while processing make orders.

The processing time for make orders is calculated as follows:

• Routing specified: Manufacturing duration based on resource usages in the routing
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• Routings not specified: Fixed + variable lead-time

In unconstrained plans, the value of fixed + variable lead-time is used regardless of 
whether routings are specified or not.

For Buy Order
Refer the following figure for the calendars and lead-times that the planning engine 
takes into account while processing buy orders.

The processing time for buy orders is calculated as follows:

• Supplier defined: Supplier processing lead-time (assumed to include transit 
lead-time)

• Supplier not defined: Item processing lead-time

The planning engine calculates the transit lead-time as follows:

• Planned order: The ship method on the sourcing rule that the planning engine 
selects

• Purchase order: The default ship method between the supplier and the receiving 
organization

For Transfer Orders
Refer to the following figure for the calendars and lead-times that the planning engine 
takes into account while processing transfer orders.
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In case of transfer orders for constrained plans:

• Ship Date = Start Date

The intransit lead-time between the organizations is specific to the carrier used.

For Sales Orders and Forecast
Refer to the following figure for the calendars and lead-times that the planning engine 
takes into account while processing sales orders and forecasts.

The intransit lead-time is specific to the carrier used and the location of the customer 
site.

Shift Times
Oracle Advances Supply Chain Planning optionally uses the specified shift timings on 
the shipping, receiving, and carrier calendars for calculating lead-times. When the 
profile MSO: Use Shift Definitions When Scheduling Lead Times is set to Yes, the 
planning engine counts only the working time within the shifts. This is applicable only 
to constrained plans. 

This means that if each working day defined in a calendar has only one active shift with
8 hours of working time, a lead-time of 1 day (24 working hours) takes 3 working days, 
since each working day only offers 8 hours of working time. Also, with this profile 
option set to Yes, each date on the order lies within a valid shift timing defined as part 
of the calendar. For example, if the shift timing is from 8 a.m. to 4 p.m., then any date on
the order will have a time stamp between 8 a.m. and 4 p.m.
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To setup and collect the calendar data from an ERP source
1. Select Order Management > Shipping > Setup > Calendars > Enter.

The Workday Calendar window appears.

2. Select Order Management > Shipping > Setup > Calendars > Assign.

The Assign Calendars window appears.

3. Define the calendar that you need to use.

For more details on setting up the calendars, see Oracle Shipping User Guide.

4. Run collections.

For more details on collections, see Running Collections.

The planning engine collects the following data: 

5. The shipping, receiving, and carrier calendar association with their respective 
trading partners (including the carrier or the shipment method) into the destination 
tables.

6. The supplier calendar associated with the Approved Suppliers List (ASL).

7. Manufacturing calendars associated to the organizations.

8. Run a plan. 

The start date, ship date, arrival dates, order date etc. are associated with the 
respective shipping, receiving, and carrier calendars instead of the organization's 
manufacturing calendar.

9. View the calendar from the Planner Workbench.

To collect the calendar data from a legacy source
1. Collect the calendar data using the following control files

• msc_st_calendars.ctl

• msc_st_workday_patterns.ctl

• msc_st_calendar_exceptions.ctl

• msc_st_shift_exceptions

• msc_st_shift_times
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2. Collect the calendar associations using the following control files:

• msc_st_item_suppliers.ctl

• msc_st_trading_partners.ctl

• msc_st_calendar_assignments.ctl

3. Run the Legacy Collections concurrent program.

For more details on Legacy Collections, see Legacy Collection.

4. Run a plan.

The start date, ship date, arrival dates, order date etc. are associated with the 
respective shipping, receiving, and intransit calendars rather than with the 
organization's manufacturing calendar.

5. View the calendar from the Planner Workbench.

To view calendar data from the Tools Menu
You can use the Calendar window to view the valid working days and shift timings on 
the various calendars used by the planning engine.

1. Open the Planner Workbench or Collections Workbench.

2. Select Tools > Work Dates.

The Calendar window appears.

You can also view calendar data from the following windows:

• Supply/Demand window: For more details, see Supply/Demand Window.

• Pegging region of the Supply/Demand window: For more details see Right-click 
Menu Options in the Pegging Region of the Supply/Demand Window.

• Exceptions Details window: For more details, see Exception Details Window.

Viewing Calendar from Exceptions
You can view the calendar data for the following exceptions:

• Late Replenishment for Sales Order

• Late Replenishment for Forecast

• Early Replenishment for Sales Order
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• Early Replenishment for Forecast

• Overcommitment for Sales Order

• Order Violates a Business Calendar

For more details about the exceptions listed above, see Exception Messages. Only those 
calendars that are relevant to the exception message are enabled in the popup menu.

To view calendar data from exceptions:

1. In the Exceptions Details window, select one of the exceptions listed above.

2. Right-click and select the Calendar option from the pop-up menu.

Scheduled Receipts
Scheduled receipts are open orders with assigned due dates. This topic explains 
scheduled receipts as they relate to planning.

Non-standard Discrete Jobs
When you use non-standard discrete jobs to model rework, the item is both the 
assembly and a component of the discrete job. Use one of the following processes to 
create and process the discrete job:

• Store and record the item in a nettable subinventory. In the non-standard discrete 
job, set MRP Net Qty to the expected yield of the non-standard job. Immediately 
issue the component material from the nettable subinventory to the to the discrete 
job. Complete the finished assemblies to a nettable subinventory.

• Store and record the item in a non-nettable subinventory. In the non-standard 
discrete job, set MRP Net Qty to the expected yield of the non-standard job and 
clear the component Net MRP. Complete the finished assemblies to a nettable 
subinventory.

For successful planning when you have non-standard discrete jobs for rework, if you 
provide a value for the job MRP Net Qty, then clear the component Net MRP.

Consume Supplies from Substitution Chain
You can instruct the planning engine to use all non-firm purchase orders of components
in the substitution chain before creating a planned order for a primary component. It 
uses the purchase orders in first-in, first-out sequence.

The planning engine:

• Generally fulfills all possible demands in a day with a purchase order before 
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moving to the demands on the next day.

• Uses purchase orders in order of purchase order availability. It uses component 
substitution priority to prioritize multiple purchase orders for the same item on the 
same day

• Does not reserve supply to meet demands

• May create a planned order on one item and cancel purchase orders on another 
item in order to follow purchase order availability sequence. 

This method:

• Only applies to purchased items

• Only applies in Constrained – Enforce capacity constraint plans

• Does not pay attention to order modifiers for scheduled receipts. Oracle 
recommends no order modifiers on these items.

• Does not pay attention to safety stock. Oracle recommends no safety stock on these 
items.

• Works only with single-level bills of material

• Does not source across organizations

• Bases demand priorities on demand date

This diagram shows an example of the processing.

There are two assemblies, A and AA.

The primary component of:

• Assembly A is component B

• Assembly AA is component BB 

The substitution chain for:

• Component B is B1 - B2 - B3

• Component BB is B1

In this example:

• The supply of item B1 on day 1 for quantity 600 satisfies demands for items B and 
BB on days 1 and 2.

• The supplies of items B2 and B3 on days 2 and 3 satisfy demands for item B on days
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3 and 4. These items are not in the substitution chain for item BB.

• The supply for item B1 on day 4 partially satisfies the demand for item BB on day 3.

• The planning engine uses the purchase order for item BB quantity 400 to satisfy its 
remaining demand quantity on day 3 and its demand on day 4. It does not use 
quantity 100 of this purchase order.

• The planning engine recommends that you cancel both purchase orders for item B 
on day 15 and the purchase order for item BB quantity 100 on day 15. In the 
diagram, they have asterisks after their quantities.
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To enable this processing, set these profile options:

• MSO: Component offset logic for optimization to 2 

• MSC: Use Optimization Phase Supply Due Dates for Pegging to Yes

• MSO: Schedule PO in FIFO to Yes 

• MSO: Additional Demand Slices for Shared Supply Rescheduling to -1

• MSO: Net All Firm Supplies Before Creating Planned Order to All Supply Types

Maximize Use of Substitute Supplies
You can instruct the planning engine to use the on-hand and on order supply of 
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substitute components before using the on-hand, on order, and planned supply of 
primary components. Use this method if you prefer to buy or produce less of primary 
components by first using the supply of their substitute components

This method uses supplies in this order to satisfy its demands:

• Use on-hand and scheduled receipts of substitute components

• Use on-hand and scheduled receipts the of primary component

• Recommend planned orders for primary components

• Recommend planned orders for substitute components

This method:

• Only applies in Constrained (Without Scheduling) planning mode

• Only uses on-hand of a substitute component if it is higher than order modifiers 
Minimum Order Quantity, Fixed Order Quantity, and Fixed Lot Multiplier

• May only use part of the on-hand of a substitute component if it is higher than 
order modifiers but not a multiple of them

It uses substitute priority to decide the substitute component supply to use first. 
However, the highest priority substitute component supply may not always satisfy the 
earliest demand. These tables show an example:

This table shows demand for assembly A.

Entity Day 10 Day 20 Day 30

Item A Demand 5 5 5

This table shows the substitute components for assembly A, their substitute priority, 
and their on-hand.

Substitute Component Substitute Priority On-hand

B1 1 10

B2 2 5

B3 3 5

In this example, the planning engine does not use the on-hand for substitute component
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B3; the quantities of substitute components with higher substitute priorities (B1 and B2) 
are enough to satisfy the demands for assembly A. The planning engine can do any of 
the following

• Use on-hand of substitute component B1 quantity 10 to satisfy the demands for 
assembly A on day 10 quantity 5 and day 20 quantity 5. Use on-hand of substitute 
component B2 quantity 5 to satisfy the demand for assembly A on day 30 quantity 
5.

• Use on-hand of substitute component B2 quantity 5 to satisfy the demand for 
assembly A on day 10 quantity 5. Use on-hand of substitute component B1 quantity 
10 to satisfy the demands for assembly A on day 20 quantity 5 and day 30 quantity 
5.

• Use on-hand of substitute component B1 quantity 10 to satisfy the demands for 
assembly A on day 10 quantity 5 and day 30 quantity 5. Use on-hand of substitute 
component B2 quantity 5 to satisfy the demand for assembly A on day 20 quantity 
5.

This diagram shows an example of the processing if you use this method.

There is an assembly A with order modifier Minimum Order Quantity of 500.

The primary component of assembly A is component B

The substitution chain for component B is C.

In this example:

• Assembly A has demands of quantity 500, quantity 250 on day 5 and quantity 250 
on day 10.

• The planning engine recommends a planned order against assembly A of quantity 
500 on day 5 to satisfy both demands.

• Because of the planned order for assembly A on day 5, the planning engine creates 
planned order demand for quantity 500 against substitute component C. 

• The on-hand for component C of quantity 500 satisfies the planned order demand 
for substitute component C on day 5.
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To enable this processing, set these profile options:

• MSO: Use up existing supply of primary components before substitute to No; This 
setting states your preference to use substitute supplies before primary supplies. 
However, if there is no on hand or scheduled receipts for the substitute components
or the primary component, the planning engine creates planned orders for the 
primary component first, then the substitute components

• MSO: Use Existing Supplies in Alternate BOM/Subs. Comp to 0 or 1 (do not use 2 or
3): This setting states your preference for whether or not the planning engine uses 
alternate bill of material component supplies.

• MSO: Postpone Use of Alternates to Latest Possible Time to No: This setting states 
your preference that the planning engine should not delay planning alternate 
supplies until the last possible moment.

• MSO: Cost Roll-up incremental factor to 1

This diagram shows an example of the processing if you do not use this method.

In this example
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• Because of the planned order for assembly A on day 5, the planning engine creates 
planned order demand for quantity 250 on primary component B and creates 
planned order demand for quantity 250 on substitute component C. 

• The on-hand for primary component B of quantity 250 satisfies the planned order 
demand for primary component B on day 5.

• Quantity 250 of the on-hand for substitute component C of quantity 500 satisfies the
planned order demand for substitute component C on day 5.

Setting Up Batch Resources
Batch operations can process multiple items simultaneously. Typical examples of batch 
operations are heat treatment, sand blasting, electroplating, specialized drying, and 
gamma ray treatment to kill bacteria. 

Work scheduled via batch processing is characterized by the same work performed on 
multiple items simultaneously for a preset amount of time. Some of the other 
characteristics of batch processing are similarities in processing, capacity available to 
hold the items, and minimum batch size considerations.
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The critical issues for scheduling batch operations are:

• Grouping items for scheduling 

• Constraining resources along multiple dimensions 

• Honoring minimum and maximum batch sizes

• Delaying or prebuilding to make up a batch

The following steps show the basic business process flow for scheduling batch 
operations:

1. Group orders for an item or across items for batch operations.

2. Evaluate batch resources availability along multiple dimensions.

3. Determine minimum and maximum batch sizes.

4. Determine delaying and/or prebuilding criteria for batching.

You cannot use resource batching with Oracle Process Manufacturing.

Capability
Oracle ASCP allows you to specify a resource as a batch type resource at the 
department resource level. A batch type resource is consumed only on a Lot basis. 
Oracle ASCP batches several orders for an item or across items when scheduling batch 
resources. Oracle ASCP batches operation sequences that carry the same batchable 
resource and schedules them as a batch. The criteria for batching depends on the 
following factors:

• Sharing same standard operation code

• Same usage on the routing

If you do not assign a standard operation code to an operation sequence that uses a 
batchable resource, Oracle ASCP only batches orders with matching durations.

If the maximum capacity is exceeded, the planning engine pushes out batchable 
resources to the first unconstrained bucket.

To set up Resource Batching
1. Sign on using the Manufacturing and Distribution Manager responsibility.

2. From the Navigator, select Bills of Materials > Routings > Resources. 

The Resources form appears.
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3. To specify a resource as a batch type resource at the department resource level, 
select Batchable.

You cannot use some batchable alternate resources and some non-batchable 
alternate resources in the same make order. To model this, use alternate routings 
instead of alternate resources.

4. Enter Minimum Batch Capacity and Maximum Batch Capacity quantities and their 
Batch Capacity UOM.

• The minimum batch size is implemented as a non-enforced constraint. The 
maximum batch size is an enforced constraint; the planning engine continues to
batch orders until it meets the maximum batch size or exceeds the batching 
window.

• Verify that there is a unit of measure conversion factor between the routing 
assembly primary unit of measure and the resource Batch Capacity UOM.

5. Enter Batching Window and its UOM

Specify the window size in days. If the planning engine does not find enough order 
quantity within the batching window to at least meet Minimum Batch Capacity, it:

• Starts a batch with less than the minimum quantity

• Issues an exception message

6. Enter Batching Penalty.

Batchable Resources and Planned Orders
Oracle Advanced Supply Chain Planning calculates the capacity of the batchable 
resource as

(Specified Batch Capacity in Resource Screen) * (Number of Resource Units specified in 
Department/Resources Screen)

When releasing a planned order, Oracle Advanced Supply Chain Planning always sets 
the assigned units on a batchable resource requirement to 1. To prevent data 
inconsistencies, make sure that the planned order quantities do not require more than 
one assigned unit's worth of capacity. Use order modifier Maximum Order Quantity 
against the routing assembly.

Batching Window
You can specify a window to batch orders and specify the window size at the 
department resource level. If the system does not find orders in the batching window 
which is equal to or more than the minimum batch quantity, it starts a batch with less 
than minimum quantity. In this case, an exception message is generated. 
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Specify the batching window value on the source system in days to match the way that 
the collections process considers it.

If the planning engine appears to schedule large gaps between resources and you want 
to reduce them, Oracle recommends that you lower the batching window size. 

Minimum / Maximum Batch Capacity 
You can specify minimum and maximum batch quantities for batch type resources. The 
minimum batch size is implemented as a soft constraint. The maximum batch size is a 
hard constraint. Oracle ASCP continues to batch orders until the maximum batch size is
met or until the Batching window is exceeded. 

Batchable Unit of Measure
You can specify a unit of measure (volume or weight) at the resource level that is 
appropriate to your resource. In addition to the resource availability (time dimension), 
Oracle ASCP allows you to constrain a resource in one other dimension (batching 
dimensions are time, volume, and weight). 

The batching activity is constrained by the maximum capacity set for a resource.

In order to define routings including batchable resources, you must have a unit of 
measure conversion factor between the item's primary unit of measure and its batchable
unit of measure.

Example: Batching orders for 2 items
The following table presents order quantities for two items, A and B, sharing the same 
batchable resource:

Item Day 1
Qty.

Day 2
Qty.

Day 3
Qty.

Day 4
Qty.

Day 5
Qty.

Day 6
Qty.

Day 7
Qty.

Day 8
Qty.

Day 9
Qty.

Day 
10 
Qty.

Item 
A

0 0 0 2 0 0 0 3 0 4

Item B 0 2 0 0 3 0 0 0 2 0

Batching Window = 3

Maximum Capacity = 6

Considering the batching window and the maximum capacity of the resource, the first 
batch is processed on day 2 for the total quantity of 4: 

First Batch on Day 2 = 2 + 2 = 4

Because there is a maximum capacity of 6, the 3 units on day 5 is not included in the 
first batch.



6-162    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Second Batch on Day 5 = 3 + 3 = 6

Example: Required Hours and Required Capacity
Order Qty: 2500

Weight requirement: 15 pounds/item

Batch process time: 14 hours

Routing assigned units: 2

If the order is firm order, if it pegs to a firm order, or if the plan is Constrained - Enforce
demand due dates, the resources are overloaded.

The resources consume 8 assigned units instead of 2 units (max), then:

• Required hours: 112

• Required capacity: 525,000 resource hours per batch (2500 units * 15 pounds/unit * 
14 hours)

Performing Tasks on the Planning Server
You can perform the following tasks only on the Planning Server: 

• Create instances

• Define plan names and its options

• Create priority rules

You can perform the following tasks on the source or Planning Server: 

• Add new sourcing rules

• Add new assignment sets

• Add new bill of distribution

• Change the order priority for any independent demand

• Add/change supplier capacity and flex fences

• Change plan parameters
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7
Supply Chain Plan Simulations

This chapter covers the following topics:

• Overview of Simulations

• Simulation Scenarios

• Simulation Modes

• Running Net Change Replan Simulations

• Using Undo to Reverse Actions or Make Changes

• Comparing Scenarios Quantitatively

Overview of Simulations
Oracle ASCP provides simulation planning so you can simulate changes and respond to
changing conditions. Simulations can be run by changing plan inputs and parameters 
and rerunning the new, simulated plan. The new simulated plan can be saved as a new 
plan and compared to the original (baseline) plan. You can copy and version your plan, 
save and compare exceptions, and visually highlight changes. 

Simulation Scenarios
You can simulate changes to material and resource capacity simultaneously. In 
addition, you can simulate the effects of changing planned orders.

Supplier Capacity
To simulate item supply changes, you can add new supplier capacity and adjust a 
supplier's capacity (for example, change daily capacity from 100 units to 200 units) over 
a specified time frame. 
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Resource Availability
You can add new resource availability and modify how many resources are available 
over user defined time frame. Resource constraints include available machine hours, 
available worker hours, and adding or removing shifts.

Shutdown Planning
Oracle Enterprise Asset Management plans maintenance activity and creates 
maintenance work orders which may specify shutdown of equipment resources. To 
plan for those shutdowns in Oracle Advanced Supply Chain Planning, run the Oracle 
Enterprise Asset Management Load Equipment Maintenance Downtime concurrent 
process. 

The process creates a simulation set with the downtimes recorded as capacity changes 
for reduced hours. You can limit the organizations, departments, and resources that 
appear in the simulation set.

It does not create capacity changes for resources with Available 24 Hours selected.

You cannot edit the capacity change entries but you can make additional simulation set 
entries.

For more information, see Oracle Enterprise Asset Management User's Guide.

Supplies
To simulate supply changes, you can:

• Add new planned orders

• Firm planned orders, discrete jobs, and purchase orders

• Modify quantities, dates, sources, and alternates

Demands
You can alter the demand priority of any demand. Oracle ASCP then modifies the 
existing schedule to accommodate changes to demand priority. To simulate demand 
changes, you can modify quantities and due dates for independent demand (MDS 
entries). You can also add new Manual MDS.

Simulation Modes
You can use the Planner Workbench to simulate and evaluate changes to specific 
orders, supplier capacity, and resource capacity. Additions to demand and supplies can 
also be simulated. Net change replan simulation is a powerful What If analysis feature 
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that lets you update a material plan by planning only the items you have changed in the
Planner Workbench. Replanning is based on the snapshot data gathered during the 
original planning run and the changes you have made with the Planner Workbench. No
other transactions, such as receipts in Oracle Inventory, are considered in the 
replanning process. You can also implement the changes recommended by net change 
replan.

Net Change Replan
Net change replan generates only those plan outputs that have changed compared to a 
baseline plan. When you make minor changes to a plan, it evaluates it in a time that 
depends on the plan size and complexity.

Batch Mode Planner

Batch mode lets you communicate directly with the database while making and 
replanning your changes. While frequent replanning can place an excessive load on 
system resources, batch mode gives other users access to the plan while you are 
performing simulations. 

Batch mode is particularly useful when you want to complete a single replanning cycle.

Online Planner

The online planner lets you simulate and replan manual changes to supply and demand
records without increasing database traffic. Starting an online session loads all planning
data into memory. Afterwards, you can make changes to that data, then replan the 
changes to see their effect on the rest of the plan. You can implement and release your 
changes from within the session, or you can make changes and replan as many times as 
necessary before the release.

As a simulation tool, the online planner lets you see the effect of the changes you make 
in the Planner Workbench. As an implementation tool, it reduces unnecessary database 
transactions and offers rapid plan revision and execution. As a monitoring tool, it 
generates the full set of exception messages following a replan. It also lets you save the 
exceptions generated by previous sessions, offering you feedback on successive 
planning decisions.

The online planner is particularly useful when performing frequent simulation on a 
single plan. In online mode, you can do this without suffering a significant loss in 
performance.

The following are some of the rules of operation for the Online Planner:

• You can view any plan even if another user is running online simulation.

• You are not allowed to start another Online Planner session nor are you allowed to 
make changes to the plan when Online Replan is progressing.

• You are allowed to enter changes before and after, but not during Online Replan 
session.
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• The changes you have made prior to Online Replan are incorporated into the 
replan.

• You can view all of the changes that have been made since the last batch rerun of 
the plan.

• You can see the user and timestamp of all changes.

• The changes you made during an online session can be undone.

Running Net Change Replan Simulations
You have two options for running net change replan simulations:

• Batch plan

• Online replan

Run the online planner or batch replan process after making changes to supplies and 
demands in Planner Workbench, for example, adding new supplies and demands, 
changing supply dates and quantities. If you do not run these, your next complete 
regeneration may fail, especially if you set plan option Overwrite to None or Outside 
Planning Time Fence.

If the plan has end item substitutions, the original exception messages about that 
subject remain in the plan output even though they do not apply after the replan.

Running Batch Replan
Note: Save and make a copy of your baseline plan before running batch
replan (make modifications to the copy). Otherwise, you will lose 
visibility to your baseline plan. SeeUsing Undo to Reverse Actions or 
Changes, page 7-6

To run a batch replan
1. Select a plan in the Planner Workbench. 

2. Make the desired changes to the plan.

3. Run your plan again by choosing Plan > Batch Replan.

4. Make a note of the concurrent request ID and choose OK.

5. Verify that the replanning process is complete. 
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6. Re-query the plan to review your changes. 

7. If you are not satisfied with the replan results, repeat steps 2 through 6 as needed. 

Running Online Replan
Note: Save and make a copy of your baseline plan before running batch
replan (make modifications to the copy). Otherwise, you will lose 
visibility to your baseline plan.

To run online replan
1. Select a plan in the Planner Workbench Window.

2. Choose Plan > Start Online Planner.

3. Make a note of the concurrent request ID and choose OK.

While the online planner loads the data into memory, you will see the Online 
Planner Status window. This window displays the progress of the loading and 
signals you when the session is ready for planning

4. When the status window informs you that the session is ready for planning, close 
the window to return to the Planner Workbench. Your online planner session is 
now active.

5. Make the desired changes to your plan.

6. Save the plan.

7. Choose Plan > Online Replan.

To check the status of an online planner session
Choose Plan > Online Planner Status.

The Online Planner Status window appears.

Note: Though you can view a plan while another user is running an 
online simulation for that plan, you can neither make changes to the 
plan nor start another simulation until the current run completes. An 
icon denoting that online planner is running accompanies the plan in 
the left pane tree.
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Note: It is recommended that the online planner be stopped as soon as 
a series of simulations is complete. Multiple active online planners 
could consume a lot of system resources (CPU/memory) in a 
production environment.

To stop an online planner session
1. Choose Plan > Stop Online Planner

2. Click OK to confirm your choice.

Note: Do not stop the online planner until all simulations are complete.

To save your actions 
1. Choose Plan > Save actions. 

A pop-up window indicates the version number of your saved actions. Note this 
version number if you wish to view your actions later. 

To view your actions
1. Select the Actions tab (left pane) then scroll down to the desired version.

Using Undo to Reverse Actions or Make Changes
The Undo feature enables you to reverse changes for online planning. The following list
details how this feature functions:

• You can undo your changes in any order, as long as the record you are undoing has
not had subsequent changes made to it.

• You can undo changes until the plan is rerun in batch mode.

• You can view online planning changes using Undo Summary.

• You can view all of the changes that have been made since the last batch rerun of 
the plan. You can see the user and timestamp of all changes.

• You can tell immediately upon entering the Planner Workbench that the online 
planner is running or that it has been run.

• You can create a savepoint/bookmark and undo all of your changes to that 
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savepoint. Bookmark names are not required to be unique.

• You cannot undo a release.

• You cannot undo changes made to the implement properties.

To view the Undo Summary for a plan
1. Select Plan > Undo Summary.

The Undo Summary window appears. This window lists the user and timestamp 
for every action/change made to the plan since the last batch replan. It includes 
online planning changes, sorted by user.

To view details on an action
1. Select an action in the Undo Summary window.

2. Click Detail.

The Undo Detail window appears.

To undo your actions
You can undo actions you make in the online planner in any order so long as no one 
else has made subsequent changes to the record you are undoing.

Note: You can only undo changes made between batch replan runs.

1. Select Plan > Undo Summary.

The Undo Summary window appears.

2. Select a change you initiated in the online planner.

3. Click Undo.

Note: You cannot undo another user's changes. If you attempt to do so, 
you will receive an error message.

To create a bookmark
You can create save points for undoing online planner actions. Subsequently, you can 
undo only those online planner actions made after the bookmark.
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1. Select Plan > Add Undo Bookmark.

2. In the pop-up window, enter a name for the bookmark.

Comparing Scenarios Quantitatively
Simulation lets you compare Key Performance Indicators (KPIs) of multiple plans and 
make necessary changes to reach your goals. Standard KPIs available in Oracle ASCP 
are:

• Inventory Turns

• On-time Delivery 

• Planned Utilization

• Margin Percentage 

• Margin

• Cost Breakdown

You can quantify the results of simulation scenarios and graphically compare the results
of multiple scenarios to help you choose the plan that best meets your performance 
objectives.

You can also compare the differences in exception messages between two plans in the 
Plan Comparison Report; see Identifying Differences Between Plans, page 17-139.

To compare scenarios quantitatively 
1. Navigate to the Planner Workbench. 

2. Select the baseline plan.

3. While holding the shift key, select the simulated plan. 

KPIs for both plans show side by side. 
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8
Supply Chain Plan Optimization

This chapter covers the following topics:

• Overview of Optimization

• Optimization Objectives

• Setting Penalty Factors

• Comparing Different Optimization Runs

Overview of Optimization
In optimized supply chain plans, Oracle ASCP uses a combination of traditional linear 
programming and constraint programming techniques.

You can choose to optimize your plans to meet one or more of the following objectives:

• Maximize inventory turns

• Maximize plan profit

• Maximize on-time delivery

The plan objective is derived by combining and weighting chosen objectives. 
Optimization determines the best possible sources of supply, considering all your 
material, resource, and transportation constraints.

Optimized plans automatically choose (on the basis of minimizing plan objective cost) 
the following:

• Alternate bills of material

• Alternate routings

• Alternate resources

• Substitute components
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Constrained plans with decision rules also select alternate bills of material, routings, 
and resources; however, they do not do so on the basis of maximizing plan objectives.

If the planning engine selects an alternate bill of material that does not have a 
corresponding routing, it uses the primary routing. If the planning engine selects an 
alternate routing that does not have a corresponding alternate bill of material, the 
planning engine uses the primary bill of material.

Optimized plans will override the rankings and sourcing percentages provided in 
sourcing rules and bills of distribution as necessary in order to minimize the plan 
objective cost.

You cannot plan repetitive items in optimized plans.

Optimization Objectives
Multiple optimization objectives can be met by assigning weights to each. This is done 
using the Optimization tab. 

For more information on the Optimization tab, see Defining Plans., page 5-1

Following are descriptions of the various optimization objectives:

Maximize Inventory Turns

This objective is achieved by minimizing the total inventory for the plan duration. 

Maximize Plan Profit

• The following are considered:

• Item cost

• Resource cost

• Inventory carrying cost

• Transportation cost

Other penalty costs are considered, such as demand lateness, resource over 
utilization, etc.

Maximize On-time Delivery

This maximizes on-time delivery by trying to ensure that all demand is met on time. 
Penalty factors specify the relative importance of demands when maximizing on-time 
delivery. 

Setting Penalty Factors
Oracle ASCP depends a great deal on data related to costs, penalties, and priorities 
above and beyond what is available from the ERP system. You can set penalty factors at
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different levels using flexfields, plan options, or profile options. Flexfields let you set 
penalty factors at the most discrete level. For example, you can set the Penalty Factor for
Late Demand at the Demand, Item, or Org level using flexfields. Plan options and 
profile options let you set the same penalty factor at the Plan level and Site level, 
respectively. 

Warning: Penalty costs are different from penalty factors. Penalty costs 
are the product of the penalty factor and some other parameter such as 
list price, item cost, resource cost, or transportation cost. 

For all of the steps related to setting penalty factors, please log in as Manufacturing and 
Distribution Manager, unless otherwise noted. You must run the Create Planning 
Flexfields program beforehand for the flexfields used for setting penalty factors to be 
operational. Please see Oracle ASCP Flexfields, page B-1 for additional details. Finally,
please refer to Choosing an Objective Function for help with setting actual penalty 
costs.

For more information on setting penalty factors, see 'Profile Options, page A-1 and 
'Oracle ASCP Flexfields., page B-1

Setting Late Demand Penalty Costs
The following figure shows the hierarchy for Setting Penalty Factor for Late Demand.
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Hierarchy for Setting Penalty Factor for Late Demand 

Hierarchy for Setting Penalty Factor for Late Demand 

If the data is not available at a given level, Oracle ASCP will check for available data at 
the next level in the hierarchy and so on.

To set late demand penalty cost at the demand level
1. From the Navigator, choose Supply Chain Planning > Forecast > Entries.

The Item Forecast Entries window appears.

2. Select a forecast.

3. Select the flexfield.

The MRP Forecast Dates window appears.
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4. Enter the Late Forecasts Penalty factor.

To set late demand penalty cost at the item level
For more information on these steps, please refer to the Oracle Inventory User's Guide.

1. From the Navigator, choose Inventory > Items > Master Items.

The Master Item window appears.

2. Click the Item field.

3. Select View menu > Find.

The Find Master Items window appears.

4. Enter a search string for the item in the Item field and click the Find button.

The Master Item window appears.

5. Select the flexfield.

The Items window appears.

6. Enter the Late Demands Penalty factor.

To set late demand penalty cost at the organization level
1. From the Navigator, choose Inventory > Setup > Organizations > Parameters.

The Organization Parameters window appears.

2. Select the flexfield.

A second Organization parameters window appears.

3. Enter the Late Demands Penalty factor.

To set late demand penalty cost at the plan level
1. Select the Advanced Supply Chain Planner responsibility.

2. From the Navigator, choose Supply Chain Plan > Options.

3. Select a plan.

The Plan Options window appears.

4. Select the Optimization tab.

5. Enter the penalty factor in the Demand Lateness field.
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To set late demand penalty cost through a profile option
1. Log in as the System Administrator.

2. From the Navigator, choose Profile > System.

The Find System Profile Values window appears.

3. Enter the profile name MSO: Penalty Cost Factor for Late Demands in the Profile 
field and click Find.

The System Profile Values window appears.

4. Enter the penalty factor in the Site column.

Setting Penalty Factors for Exceeding Material Capacity
The following figure shows the hierarchy for Setting Penalty Factor for Exceeding 
Material Capacity.
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Hierarchy for Setting Penalty Factor for Exceeding Material Capacity

Hierarchy for Setting Penalty Factor for Exceeding Material Capacity

If the data is not available at a given level, Oracle ASCP will check for available data at 
the next level in the hierarchy. 

To set penalty factors for exceeding material capacity at the item/supplier level
For more information on these steps, please refer to the Oracle Purchasing User Guide.

1. From the Navigator, choose Purchasing > Supply Base > Approved Supplier List.

2. Click Attributes.

The Supplier-Item Attributes window appears.

3. Select the flexfield.
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The Attributes window appears.

4. Enter the Material Over-Capacity Penalty factor.

To set penalty factors for exceeding material capacity at the item level
For more information on these steps, please refer to the Oracle Inventory User's Guide.

1. From the Navigator, choose Inventory > Items > Master Items.

The Master Item window appears.

2. Click the Item field.

3. Select View menu > Find.

The Find Master Items window appears.

4. Enter a search string for the item in the Item field and click Find.

The Master Item window appears.

5. Select the flexfield.

The Items window appears.

6. Enter the Material Over-Capacity Penalty factor.

To set penalty factors for exceeding material capacity at the organization level
1. From the Navigator, choose Inventory > Setup > Organizations > Parameters.

The Organization Parameters window appears.

2. Select the flexfield.

A second Organization Parameters window appears.

3. Enter the Material Over-Capacity Penalty factor.

To set penalty factors for exceeding material capacity at the plan level
1. Select the Advanced Supply Chain Planner responsibility.

2. From the Navigator, choose Supply Chain Plan > Options.

3. Select a plan.

The Plan Options window appears.

4. Select the Optimization tab.
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5. Enter the penalty factor in the Exceeding material capacity field.

To set penalty factors for exceeding material capacity through a profile option
1. Log in as the System Administrator.

2. From the Navigator, choose Profile > System.

The Find System Profile Values window appears.

3. Enter the profile name MSO: Penalty Cost Factor for Exceeding Material Capacity in
the Profile field and click Find.

The System Profile Values window appears.

4. Enter the penalty factor in the Site column.

Setting Penalty Factors for Exceeding Resource Capacity
The following figure shows the hierarchy for Setting Penalty Factor for Exceeding 
Resource Capacity.
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Hierarchy for Setting Penalty Factor for Exceeding Resource Capacity

Hierarchy for Setting Penalty Factor for Exceeding Resource Capacity

If the data is not available at a given level, Oracle ASCP will check for available data at 
the next level in the hierarchy.

To set penalty factors for exceeding resource capacity at the resource level
1. From the Navigator, choose Bills of Material > Routings > Departments.

The Departments window appears.

2. Find a department.

3. Click Resources.

The Resources window appears.

4. Select the flexfield

The Department Resource Information window appears.

5. Enter the Resource Over-Capacity Penalty factor.
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To set penalty factors for exceeding resource capacity at the organization level
1. From the Navigator, choose Inventory > Setup > Organizations > Parameters.

The Organization Parameters window appears.

2. Select the flexfield.

The Organization Parameters window appears.

3. Enter the Resource Over-Capacity Penalty factor.

To set penalty factors for exceeding resource capacity at the plan level
1. Select the Advanced Supply Chain Planner responsibility.

2. From the Navigator, choose Supply Chain Plan > Options.

3. Select a plan.

The Plan Options window appears.

4. Select the Optimization tab.

5. Enter the penalty factor in the Exceeding resource capacity field.

To set penalty factors for exceeding resource capacity through a profile option
1. Log in as the System Administrator.

2. From the Navigator, choose Profile > System.

The Find System Profile Values window appears.

3. Enter the profile name MSO: Penalty Cost Factor for Exceeding Resource Capacity 
in the Profile field and click Find.

The System Profile Values window appears.

4. Enter the penalty factor in the Site column.

Setting Penalty Factors Using Plan Options
There are four penalty factors that can be set in the Optimization tab. For more 
information on the Optimization tab, see Defining Plans., page 5-1

• Penalty Factor for Late Demand

• Penalty Factor for Exceeding Material Capacity
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• Penalty Factor for Exceeding Transportation Capacity

• Penalty Factor for Exceeding Resource Capacity

Penalty Cost for Late Demand
The penalty cost for late demand (forecasts and sales orders) is equal to:

• (Penalty factor) x (List price)

Penalty Cost for Exceeding Material Capacity
The penalty cost for exceeding material capacity is equal to:

• (Penalty factor for exceeding material capacity) x (Item cost)

Penalty Cost for Exceeding Transportation Capacity
The penalty cost for exceeding transportation capacity is equal to:

• (Penalty factor for exceeding transportation capacity) x (Transportation cost)

Penalty Cost for Exceeding Resource Capacity
The penalty cost for exceeding resource capacity is equal to:

• (Penalty factor for exceeding resource capacity) x (Resource cost) 

Note: Unit costs (list price, item cost, and so on) play an important 
role in determining penalty costs. 

Setting Penalty Factors Using Optimization Profile Options
These profile options can be used to specify default values necessary for optimization. 

Note: For detailed information on setting these and other profile 
options, see 'Profile Options, page A-1.

Penalty Factor for Late Demand
Use this profile option to define a penalty factor common to all demands. The demands 
include sales orders and forecasts.

Penalty Factor for Exceeding Material Capacity
Use this profile option to define a global penalty factor for exceeding material capacity. 
This value will be common to all items in the plan.
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Penalty Factor for Exceeding Resource Capacity
Use this profile option to define a global penalty factor for exceeding resource capacity. 
This value will be common to all manufacturing and transportation resources in the 
plan.

Inventory Carrying Costs Percentage
Use this profile option to specify the inventory carrying costs percentage for all items in 
the plan. The value is specified as a number between 0 and 1.

Maximum Allowable Days Late
Use this profile option to limit the number of days by which a demand or non-firm 
scheduled receipt can be moved out. This value is used to improve performance during 
optimization. The value is specified as an integer greater than 0.

Comparing Different Optimization Runs
You can generate an optimized and executable plan based on your plan objectives as 
well as material, resource, and transportation constraints. For example, you could 
compare two optimized plans with different objective weights and compare the results 
based on performance indicators.

Results of optimized plans are stored for use by future planning runs. 

For more information on simulations see Simulations, page 7-1. For more information 
on evaluating plan performance and comparing multiple plans, see 'Exception 
Messages , page 17-139.
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9
Supply Chain Constraint-Based Planning

This chapter covers the following topics:

• Overview of Constraint-Based Planning

• Constraint Types 

• Enabling and Disabling Constraints

• Setting Constraints for Different Plan Types

• Enforce Purchasing Lead-time

• Rules Used in Constrained Plans

• Enforce Capacity Constraints Scheduling

• Enforce Demand Due Date Scheduling

• Engineering Change Orders Use-Up Effectivity

• Forecast Expiration

• Sequence Dependent Setups

• Planned Inventory Points

Overview of Constraint-Based Planning
Constraint-based planning and scheduling is an approach for balancing material and 
plant resources while meeting customer demand. It takes into account constraints at the
enterprise and plant levels. Material and capacity constraints are considered 
simultaneously. Capacity constraints include factory, distribution, and transportation 
resources. This complete picture of the problem provides instant and global visibility to 
the effects of planning and scheduling decisions throughout the supply chain. 

There are two types of constraint-based planning--with and without optimization. This 
section first describes constraint types that are applicable to both types, and then 
describes constraint-based planning without optimization. Constraint-based planning 
with optimization is described in 'Optimization, page 8-1.
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You cannot plan repetitive items in constrained plans.

Constraint Types 
You can define constraints for materials and resources in your plan. You will also be 
able to specify the level of importance of these constraints depending on your business 
needs and the planning horizon. You can generate plans using the following scenarios 
for each planning bucket type (days, weeks, periods): 

• Plan considering material constraints only

• Plan considering resource constraints only

• Plan with respect to both material and resource constraints

See Defining Plans, page 5-1 for information on defining the relative importance of 
constraints.

The following table gives you the information you need to run a constraint-based plan: 

Constraint Type Includes

Items BOM effectivities (process effectivity), ECOs, 
alternate BOMs, substitute components, 
by-products, safety stocks, order modifiers, 
supplier-specific order modifiers, 
supplier-specific lead-times, pegging 
restrictions

Manufacturing Resources Routing effectivities, alternate routings, 
alternate resources, resource capacities, line 
rates, workday calendar

Transportation Resources Carrier capacities, shipment and delivery 
calendars

Sourcng Constraints Sourcing effectivities, sourcing ranks, 
allocation percentages, supplier capacity 

Suppliers Supplier capacity, supplier rank, supplier 
calendar, flex fences, supplier order modifier

DemDands Sales orders/forecasts, demand priority, 
demand priority rules
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Items

Item Definition
General Planning tab, Source Organization field: Do not set the value of this field to the 
same organization in which you are setting the item attributes. 

You set item attributes for process manufacturing supply tolerances as item attributes. 
These tolerances instruct the planning engine not to exactly match supply to demand at 
all times through the planning horizon. See Supply Tolerances, page 19-62.

The item attribute Create Supply only applies to end item substitution. It specifies 
whether to create supply at the current revision of the item or at a higher revision of the 
item. It does not control whether or not the planning engine creates planned orders for 
the item; for this, use item attribute MRP Planning Type.

Use the Item Attributes Mass Maintenance form to update the same item attributes for 
multiple items..

Bills of Material
You can set effective dates for BOMs. Similarly, you can set effective dates for process 
effectivity (this is for Oracle OPM only). You can specify effectivities in the form of 
effective dates, use ups, model/unit numbers. For more information, see Effective Date 
Fields, Oracle Bill of Materials User's Guide and Primary and Alternate Bills of Material, 
Oracle Bills of material User's Guide

Note: Effectivity can be set not only at the date level, but also at the unit
number level. 

The planning engine uses the yield percentage that is effective on the pegging demand 
date. Because of constraints, the planning engine could later schedule the component to 
be used on a date that has different yield percentage in the bill of material; however, the
planning engine continues to use the yield from the pegging demand date.

Engineering Changes (ECOs)
Oracle ASCP evaluates the engineering change orders as of their scheduled effective 
date. You can order material and plan resources that you need for new revisions ahead 
of time. 

Note: The planning process only suggests implementing engineering 
change orders when the unconstrained start date of the planned order 
is later than the effective date. Oracle ASCP does not suggest a planned 
order using an ECO if the planned order needs to start before the 
effective date of the ECO.

For a pending ECO, you can specify whether to include the engineering changes during
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the planning process. Set the MRP Active Flag to Yes in the Engineering Change Order 
window if you want the planning process to consider the engineering changes on the 
ECO.

Oracle ASCP considers engineering changes when generating component requirements 
for planned orders and suggested repetitive schedules. The quantity specified by an 
engineering change order is considered if the scheduled effective date of the ECO is 
before the suggested start date of the order. For additional information, see 
'Engineering Change Orders Use-Up , page 9-56Effectivity.

Substitute Components
Substitute components are modeled similarly to alternate resources. Each primary BOM
component is assumed to have a set of possible substitutes. The primary item will be 
used instead of the substitute when it is available. 

For more information, seeAssigning Substitute Components, Oracle Bills of Material 
User's Guide.

By-products
You can define negative usages for component items on a bill of material in Oracle Bills 
of Material. You can add by-products to discrete jobs using Oracle Work in Process. 

Oracle ASCP includes by-products on standard and non-standard discrete jobs and 
components with a negative usage on a bill of material when netting supply and 
demand. Oracle ASCP considers this type of component requirement as supply 
available on the job completion date. 

Note: You can manually add a negative requirement to a non-standard 
job in Oracle Work in Process to manage components that result in 
disassembly. You could use this option for repairing assembly units. It 
lets you track the item that is issued to the job as available supply on 
completion of the repair job.

Planned Orders
You can turn off planned order creation for an item.

Consider turning off planned order creation if your business has these or similar 
situations

• You have a by-product in a bill of material that can be a downstream component. 
You want to consume the available stock of the by-product, but you do not want to 
buy any of it. In addition, you want to take sales orders for the by-product, to ship 
against them as supplies are available, but not to make any of the by-product to 
meet sales order demand.

• You want to phase out item components and their replacement with newer 
ingredients. You cannot have any orders or builds for the phased out item, but you 
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want to use up the available stock that you have.

• You do not want to make more of an item, but you do want to distribute and sell 
the available stock.

To turn off planned order creation for an item, use Item Mass Maintenance and set item 
attribute New Planned Order Creation. Valid values are:

• Create New Planned Orders (default)

• Do Not Create New Planned Orders

This item attribute applies only to plans that do not have a planning phase. These are 
plan types:

• Constrained (Without Detailed Scheduling)

• Distribution Planning

Product Families
Product families improve plan performance, letting you plan further down the plan 
horizon. You can do the following at the product family level: 

• Specify demands 

• Run planning and scheduling

• Create supplies 

For more information, see Forecast Explosion, page 5-103..

Safety Stock
See Safety Stock, page 6-133.

Order Modifiers
Order sizing is a set of item attributes that allow you to control the recommended order 
quantities for planned orders. The planning process creates planned orders using basic 
lot-for-lot sizing logic.

You can set order modifiers in the following forms:

• Master Items and Organization Items

• Supplier-Item Attributes: These values supersede values in Master Items and 
Organization Items

• Recipe Validity Rule Details: For process manufacturing
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Note: The planning process ignores order modifiers for items that have 
a phantom supply type. 

Note: Order modifiers for supplied items may be defined by their 
suppliers.

For additional information, please refer to Items, General Planning Attribute Group and
MPS/MRP Planning Attribute Group in the Oracle Inventory User's Guide.

Fixed Days Supply

The planning process places single orders for the quantity that covers the requirements 
for the user-defined number of days. When suggesting planned orders, the planning 
process looks forward this many days and accumulates all of the demand in that time 
period. It then suggests a planned order to satisfy the total quantity required for that 
time period.

If you use order modifier Fixed Days of Supply, the planning engine creates a single 
supply to cover multiple days of demand. During constraint-based scheduling, the 
planning engine may move the demand and supply dates such that you cannot 
reconcile the supply quantity to the demand dates and quantities. To attempt a 
reconciliation, Oracle recommends using the old due date on the planned order 
demands.

Fixed Order Quantity

The planning process places one or more orders for the user-defined quantity or 
repetitive rate. 

• For discretely planned items, when the requirement for a given date exceeds the 
fixed order quantity, place multiple orders. 

• For repetitively planned items, either recommend a rate equal to the fixed order 
quantity or a rate of zero.

Fixed Lot Multiple

The planning process places single orders in quantities that are multiples of the 
user-defined quantity or rate. 

For example, when the fixed lot multiple quantity is 100 and the requirement equals 110
units, place a single order for 200 units.

Minimum and Maximum Order Quantity

The planning process places one or more orders for at least the minimum quantity, but 
no greater than the maximum quantity. 

For discretely planned items, when the requirement for a given date exceeds the 
maximum order quantity, the planning process places multiple orders.
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Rounding Order Quantities

You can define, for each inventory item, whether the planning process should round 
order quantities when the actual order quantity is calculated as a fraction. If you choose 
to round, order quantities are rounded to the next highest whole number. 

Note: By rounding up, the planning process may suggest a planned 
order for more than what is actually needed. This extra quantity is 
carried over into the next period as supply; therefore, the planning 
engine rounds other orders down to account for the excess supply from
the last period..

This diagram shows the order in which the planning engine applies order modifiers to 
planned orders (precedence of order modifiers).
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Requirement Integer Quantities
Use requirement integer quantities to instruct the planning engine only to pass 
dependent demand requirement quantities that are whole numbers. You set the 
instruction for each component of each assembly in each organization.

The order modifier item attribute Round Order Quantities instructs the planning engine
that when it calculates a fractional quantity for an assembly supply order, it should 
round the assembly supply order quantity up to the next highest whole number. 
Fractional supply order quantities occur because of: 

• Fractional bill of material quantities
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• Process yield

• Shrinkage

• Co-product relationship percentages

• MRP-planned safety stock 

• Component yield 

From the extra supply order quantities, the planning engine creates fractional 
dependent demands on the components to match those extra supply order quantities 
and carries pegging in fractional quantities through the lower bills of material levels. 
Pegging to fractional demand quantities is both inaccurate and difficult to understand 
when you actually make the components and subcomponents in whole number 
quantities.

To instruct the planning engine to round dependent demand quantities for components:

• On the Organization Items form, MPS/MRP planning tabbed region, select the item 
attribute Round Order Quantities for the component.

• On the Bills of Material form, Component Details tabbed region, select a value for 
the field Enforce Integer Req for the component.

• Select Up to instruct the planning engine to round fractional dependent 
demand requirements up to the next highest whole number.

• Select Down to instruct the planning engine to round fractional dependent 
demand requirements down to the next lowest whole number.

• If you use Oracle Process Manufacturing and want requirement integer quantities 
processing, select attribute Integer Multiple Scaled Items. This duplicates the Up 
selection of Enforce Integer Reqs.

• If you use substitute items, you can select Enforce Integer Reqs in the Substitute 
window.

• If you use engineering change orders, you can select Enforce Integer Reqs as you 
add and change the component list.

You can view the setting for each component in the Planner Workbench Components 
window, Item Details tabbed region.

The planning engine does not issue any new exceptions as a result of the rounding.

In the following situations, the planning engine honors your instruction: 

• Material requirement plan, master production schedule, and distribution 
requirement plan
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• Unconstrained, constrained, and optimized plan

• Netting with reservation levels of Projects/Seiban and Planning Groups

In the following situations, the planning engine does not honor your instruction: 

• Inventory optimization plans 

• Order promising

• Product family bills of material

This diagram shows a multilevel bill of material with all of the components Enforce 
Integer Reqs set to Up.

Multi Level Bills of Material

Lead-times
Enter intransit lead-time based on calendar days.
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Manufacturing Resources

Routings
You can:

• Set effective dates for routings

• Specify alternate routings and alternate resources for the planning engine to use 
when the primary routing resources are not available

• Define different routings with varying priorities

• Associate a bill of material with routings

• Define the costs of using routings

• Specify the number of resources (resource units) that are available to work on an 
operation at a given time; the planning engine uses this number for resource 
availability instead of the resource unit numbers that you specified for each 
resource and its shifts.

• Specify operation yield: Do not enter cumulative yields; the planning engine 
calculates it from the operation yield. 

• Set the profile option MSO: Use of Assigned Units in Scheduling to control the 
number of resource units to be used when scheduling a resource activity. For more 
information, see 'MSO Profile Options, page A-83.

When you define operation effectivity dates, always make the effective time 00:00:00. If 
this is not the effective time, the planning engine assumes 00:00:00 but the release 
process for planned orders using the operation may not complete correctly.

For more information, see Routings in Oracle Bills of Material User's Guide. 

You specify process yields in the routings. The planning engine inflates material 
requirements and calculates resource requirements based on the amount of expected 
material at each operation sequence. The following process yield information is 
available in the standard, flow, and network routing types:

• Yield

• Cumulative yield

• Reverse cumulative yield

• Process yield
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Resources
You can define alternate resources for an operation, but not for a routing. A resource for
an operation can have different alternates, each with its own priority. You can specify if 
two resources must be used simultaneously. 

For more information, see Defining a Resource in Oracle Bills of Material User's Guide.

If you attempt to fix a late replenishment exception message by adding resource 
capacity and running the plan again, you may expose additional resource and material 
constraints and need to fix their exception messages. Constraint resolution can be an 
iterative process.

The planning engine rounds resource consumption to an integer value for each 
assigned unit. For example:

• A resource works eight hours per day and has five assigned units

• The routing for an item uses that resource for one hour

• A supply order for quantity 40 is scheduled on that resource for three assigned 
units

• The expected resource consumption is 40 hours [40 pieces * 1 hour per piece]

• The planning engine calculates resource consumption as 42 hours [((40 pieces * 1 
hour per piece) / 3 assigned units) * 3 assigned units = (40 / 3) * 3 = 13.3 * 4 = 14 
rounded * 3]

Consider an example that illustrates the use of the profile option MSO: Use of Assigned 
Units in Scheduling and the related impact on backward and forward scheduling. Three
items (A, B and C) are being manufactured.

Make A 

• Operation Sequence 10

• Resource R1 

• Assigned Units = 1

• 200 units/day

• Maximum Availability of Resource = 2

Make B

• Operation Sequence 10

• Resource R2 
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• Assigned Units = 2

• 80 units/day

• Maximum Availability of Resource = 2

Make C

• Operation Sequence 10

• Resource R3 

• Assigned Units = 4

• 100 units/day

• Maximum Availability of Resource = 4

Case 1: Backward Scheduling With Value Set to Variable
If you set the profile option MSO: Use of Assigned Units in Scheduling to Variable, 
backward scheduling succeeds as depicted by the illustration. In the illustration, A, B 
and C represent three items. R1, R2 and R3 represent the three resources who have 
specific units assigned. The demand is due on the 21st day.
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Impact on Backward Scheduling With Value Variable

Backward schedule succeeds as the item C is scheduled in the available planning 
horizon.

Case 2: Backward Scheduling With Value Set to Fixed at Routing Value
The following illustration depicts the case when the profile option is set to Fixed at 
Routing Value.
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Impact on Backward Scheduling With Value Fixed at Routing Value

Backward scheduling fails when the profile option MSO: Use of Assigned Units in 
Scheduling is set to Fixed at Routing Value. There is no date available in the planning 
horizon to schedule 4 units for resource 3.

Case 3: Forward Scheduling With Value Set to Fixed at Routing Value
Using the same example, consider the following illustration that depicts the late 
demand scenario when you perform forward scheduling with the profile option MSO: 
Use of Assigned Units in Scheduling to Fixed at Routing Value.
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Impact on Forward Scheduling With Value Fixed at Routing Value

Shifts
A shift is a period of time over which a resource works. You either specify the shifts that
each resource is available for work or specify that the resource is available 24 hours.

You also specify the number of units of the resource that are available (assigned units) 
when the resource is available on a shift. If resource M--a machine resource--has 3 
resource units and is available on shifts 1 and 2, the planning engine schedules work for
3 machines during shift 1 and 3 machines during shift 2. 

The planning engine determines the number of units of the resource that are available 
on any given shift (maximum available units). While the maximum available units are 
never more than the assigned units, they may be less, for example, a resource is down. 
If this situation occurs in a Constrained - Enforce capacity constraints plan, the planning
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engine may schedule planned orders to finish later than if all of the assigned units were 
available.

For person and miscellaneous type resources, you can specify different resource units 
for each resource shift in addition to the resource units for the resource. For example, 
resource P, a person resource, has 12 resource units for the resource and is available on 
shift 1 with 12 resource units, on shift 2 with 10 resource units, and on shift 3 with 2 
resource units. Each shift is 8 hours. 

For more information, see Defining a Resource in Oracle Bills of Material User's Guide.

The data collection process calculates resource availability as follows:

• Resource availability (shift) = Capacity units (shift) * Hours available (shift)

• Resource availability (resource) = Sum of resource availability for all shifts

For example, resource P has 192 available hours per day:

• Shift 1: 96 hours per day (12 Capacity units (shift) * 8 Hours available (shift))

• Shift 2: 80 hours per day (10 Capacity units (shift) * 8 Hours available (shift))

• Shift 3: 16 hours per day (2 Capacity units (shift) * 8 Hours available (shift))

The planning engine uses the resource units for the resource if the shift resource units is
blank or 0. It does not use instance-specific capacity information that you specify for 
Oracle Manufacturing Scheduling; it uses only the total available resource units. If you 
neither specify a resource as available 24 hours nor assign shifts, the collection process 
does not calculate available capacity and the planning engine schedules the resource as 
available 24 hours. 

View the resource unit information both on the collections workbench and on the 
planner workbench.

You can also record capacity changes to specific shifts with simulation sets, for example,
add or delete resource units and add or delete workdays. For example, resource P has 
10 resource units per day on shift 2 and you make the following capacity changes:

• For 11 February to 11 March, you add 20 resource units per day. The planning 
engine uses 30 resource units available from 11 February to 11 March and calculates
resource availability for shift 2 as 240 hours per day (30 Capacity units (shift) * 8 
Hours available (shift))

• For 12 March to 14 March, you reduce 1 resource unit per day. The planning engine 
uses 9 resource units available from 12 March to 14 March and calculates resource 
availability for shift 2 as 72 hours per day (9 Capacity units (shift) * 8 Hours 
available (shift)).

• You change 24 February from a non-workday to a workday. The planning engine 
uses 30 resource units available on 24 February and calculates resource availability 
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for shift 2 on 24 February as 240 hours (30 Capacity units (shift) * 8 Hours available 
(shift))

You change 25 February from a workday to a non-workday. The planning engine uses 
30 resource units available on 24 February and calculates resource availability for shift 2
on 25 February as 0 hours (30 Capacity units (shift) * 0 Hours available (shift))

Workday Calendar
You define a workday calendar for one or more organizations, and assign an exception 
set to each calendar. For each workday calendar and exception set, you assign a list of 
holidays or workday exceptions. You then define shifts for your workday calendar, and 
assign any shift workday exceptions.

Oracle Advanced Supply Chain Planning supports 4-4-5-type periods.

For more information, see Defining a Workday Calendar in Oracle Bills of Material User's
Guide.

Resource Efficiency and Utilization
Oracle Advanced Planning includes support for shop floor scheduling. It considers 
resource efficiency and utilization that you specify at the resource level while 
scheduling.

Resource efficiency is a measure (expressed as a percent) of the actual output to the 
standard output expected. Resource efficiency determines the time a resource takes to 
complete a task. For example, if you expect a resource having an efficiency of 100% to 
complete a task in 12 hours, the resource having an efficiency of 50% would take 24 
hours to complete the task. Effective usage of a resource is the ratio of resource hours as
specified in routing (theoretical usage) to efficiency.

Resource utilization is a measure (expressed as a percent) of how intensively a resource 
is utilized. For example, a resource might take frequent breaks or you might assign 
maintenance tasks to the resource. As such, a percent of the resource time is not 
available for the task. The actual usage is the ratio of the resource hours as specified in 
routing to the product of efficiency and utilization.

For example, if a routing has a resource requirement for 2 hours. The efficiency and 
utilization of the resource is expected to be 90% and 75%, respectively. Therefore, the 
actual resource usage is calculated as 2.96 hours.

Considering the actual resource efficiency and utilization, the planning engine 
generates a plan. In case additional resource usage is required to satisfy a demand, the 
planning engine recommends inflating the resource usage. This might lead to stretched 
plans where a longer time is required for completing a task.

Releasing and Collecting Plans Considering Resource Efficiency and Utilization
Perform the following steps to define, release and collect discrete jobs:

1. Define resource efficiency and utilization for the resources.
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2. Run a plan. The planned order for a discrete Work in Process job includes inflated 
resource usage based on the resource efficiency and utilization that you specified.

3. Release a planned order for a discrete Work in Process job. When you release the 
planned order, the planning engine releases the start and end times according to the
resource usage. However, the planning engine does not include the inflated 
resource usage value while releasing the planned order. When the planning engine 
releases Work in Process jobs, it deflates the resource usage by readjusting the 
resource efficiency and utilization value. This helps avoid costing issues. However, 
the start and end times for the resource requirement remains inflated as Oracle 
Costing does not consider these.

4. Using Oracle Work in Process, you can update the Work in Process discrete job and 
even transact against the discrete job. In addition, you can use Oracle 
Manufacturing Scheduling to reschedule the discrete job. Oracle Manufacturing 
Scheduling does not change the resource usage for open discrete jobs

5. When you collect the rescheduled Work in Process discrete jobs (firm, unfirm, and 
non-standard) back to the planning engine, it inflates the resource usage by 
considering the resource efficiency and utilization. You can control this behavior of 
the planning engine during collection by setting the profile option MSC: Inflate WIP
Resource Requirements to No. However, the planning engine does not change the 
start and end times during collection.

6. Run a plan.

7. The planning engine reschedules the Work in Process discrete job based on the 
inflated resource usage. However, the planning engine does not reschedule firm, 
non-standard discrete jobs, individual operations, and resources. Based on the 
value you specify for the profile option MSO: Firm Operations/Orders Within Time 
Fence, the planning engine determines whether or not to reschedule discrete jobs 
that are within the planning time fence.

You can view the resource efficiency and utilization values in the Planner 
Workbench.

The Planner Workbench displays fields such as Resource Hours, Touchtime, and 
Adjusted Resource Hours. Resource hours are calculated as the product of adjusted 
resource hours, efficiency (in percent) and utilization (in percent). The adjusted 
resource hours indicate the actual collected resource hours (based on routing or 
discrete job). Touchtime is the product of adjusted resource hours and utilization (in
percent).

Example: 

Planned Order in Planning Engine

Consider a routing with 1 operation and 2 resources (R1 and R2). 

Efficiency of R1 = 50%
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Utilization of R1 = 80%

Efficiency of R2 = 100%

Utilization of R2 = 100%

When the planning engine schedules resources for a planned order, the resource 
usage for R1 is inflated owing to the efficiency and utilization. The following table 
depicts the inflated resource usage.

Resource 
Sequence

Resource Usage Units Start Time End Time

Total Job - - - 9:00 AM 1:30 PM

10 R1 2.5 1 9:00 AM 11:30 AM

20 R2 2 1 11:30 AM 1:30 PM

The following table depicts how the resource usage is deflated when the Work in 
Process job is released by the planning engine.

Resource 
Sequence

Resource Usage Units Start Time End Time

Total Job - - - 9:00 AM 1:30 PM

10 R1 1 1 9:00 AM 11:30 AM

20 R2 2 1 11:30 AM 1:30 PM

If you set the profile option MSC: Inflate WIP Resource Requirements to Yes, the 
planning engine inflates the resource usage for R1 during the collection process. 
The following table shows the re-inflated value for the resource usage.

Resource 
Sequence

Resource Usage Units Start Time End Time

Total Job - - - 9:00 AM 1:30 PM

10 R1 2.5 1 9:00 AM 11:30 AM

20 R2 2 1 11:30 AM 1:30 PM
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Data Consistency While Rescheduling Discrete Jobs
The planning engine determines rescheduling resource duration, start and end dates 
based on the nature of the job.

• If the planning engine collects a non-firm discrete job from Oracle Manufacturing 
Scheduling, it reschedules the resource start and end times based on the resource 
usage.

• If the planning engine collects firm discrete jobs from Oracle Manufacturing 
Scheduling, it calculates resource capacity consumption based on the resource start 
and end times.

However, the planning engine treats a non-firm open job as firm in the following cases:

• If you set a planning time fence by using the system-level profile options MRP: 
Create Time Fence and MRP: Firm Planned Order Time Fence. For more 
information on the profile options, see MRP Profile Options.

• If you set the profile option MSO: Firm Operations/Orders Within Time Fence to 
Yes. If you set this profile option to No, the planning engine can reschedule the start
dates within the planning time fence out.

Sequence Dependent Steps
Sequence dependent steps represent the times to set up machine resources when the 
setup depends on the sequence of jobs running on the machine. They are lot-based 
resource requirements of discrete jobs that Oracle Manufacturing Scheduling schedules.

Oracle Advanced Supply Chain Planning:

• Simulates sequence dependent setups when creating planned orders by using the 
resource utilization factor

• In some cases, schedules with sequence dependent setup resources from discrete 
jobs. 

The planning time fence determines the Oracle Application that schedules discrete 
job operations. Oracle Manufacturing Scheduling schedules discrete job operations 
inside the planning time fence and Oracle Advanced Supply Chain Planning 
schedules discrete job operations outside the planning time fence.

To set the information that the planning engine needs to plan sequence dependent 
setups:

• Define resource utilization factors for resources. For example, on average, 5% of the 
time that a resource is in an operation, it needs setup. Set resource utilization to 
95%.

• Define sequence dependent setups and associate them to resources.
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• Set profile option MSC: Inflate WIP Resource Requirements to Yes. If you have a 
shop floor scheduling system that adjusts resource requirements, you might not 
want to use this feature. In that case, set profile option MSC: Inflate WIP Resource 
Requirements to No.

• Set Oracle Manufacturing Scheduling to ignore resource utilization. The planning 
engine inflates resource times as a simulation; if Oracle Manufacturing Scheduling 
inflates the resource times and then also schedules sequence dependent setup 
requirements, it overstates the resource requirements.

• Review item planning time fences.

The sequence dependent setup processing works as follows:

• During a planning run, the planning engine does not consider resource sequence 
dependent setup factors for new planned orders. As it schedules, it uses the 
resource utilization factor to inflate resource usages to simulate sequence 
dependent setup time. Then, it schedules the order resources based on those 
resource usages.

• You release the planned orders as discrete jobs. Their resource requirements are not
inflated by resource efficiency or utilization.

• You reschedule the discrete jobs using Oracle Manufacturing Scheduling. Based on 
the job sequence, Oracle Manufacturing Scheduling may add a sequence dependent
setup to the discrete job.

• When the collections process collects discrete jobs, it collects sequence dependent 
setups of discrete job operations within the item planning time fence and deletes 
those outside the item planning time fence. For those outside the planning time 
fence, it inflates resource usages to simulate sequence dependent setup time.

• The next time that you run a plan, the planning engine processes the operations 
with sequence dependent setups. The processing depends on whether the planning 
engine considers the operation with the sequence dependent setup as firm.

If the planning engine considers the operation firm, it consumes resource capacity 
both for its sequence dependent setup and for the run time. It does not inflate the 
resource usage by utilization and does not reschedule the operation.

If the planning engine does not consider the operation firm, it deletes sequence 
dependent setup requirements, consumes resource capacity for its runtime only. It 
inflates the resource usage by utilization to duplicate sequence dependence setup 
and may reschedule the operation.

The planning engine considers an operation firm if:

• It is in a firm discrete job, in a non-standard discrete job, inside the planning 
time fence item attribute, or inside the natural time fence
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• Profile option MSO: Firm Operations/Orders within the Planning Time Fence is 
Yes

For example, this table shows a routing with one operation and two resources.

Op Seq Res Seq Resource Usage Assigned 
Units

Efficiency Utilization

10 - - - - - -

- 10 R1 1 1 0.50 0.80

- 20 R2 2 1 1 1

This table shows a planned order to make one unit of the item.

The planning engine inflates R1 resource usage by efficiency and utilization. R1 
efficiency is 50% and utilization is 80%. The usage is 2.5 hours (1 Hour / (50% * 80%).

Op Seq Res Seq Resource Adjusted 
Usage (hour)

Assigned 
Units

Start 
Time

End 
Time

10 - - - - 0900 
hours

1330 
hours

- 10 R1 2.5 (inflated) 1 0900 
hours

1130 
hours

- 20 R2 2 1 1130 
hours

1330 
hours

This table shows the discrete job released from the planned order.

The resource usages are deflated but Oracle Advanced Supply Chain Planning does not 
change the resource start and end times. These times remain in the discrete job until you
change them in Oracle Work in Process or Oracle Manufacturing Scheduling. 

Op Seq Res Seq Resource Usage 
(hour)

Assigned 
Units

Start 
Time

End 
Time

10 - - - - 0900 
hours

1330 
hours
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Op Seq Res Seq Resource Usage 
(hour)

Assigned 
Units

Start 
Time

End 
Time

- 10 R1 1 
(deflated)

1 0900 
hours

1130 
hours

- 20 R2 2 1 1130 
hours

1330 
hours

This table shows the discrete job that you released from Oracle Advanced Supply Chain
Planning after the next collections process to the planning server.

Since you released this job from Oracle Advanced Supply Chain Planning, the start and 
end times reflect the inflated resource usages. You do not need to change the end times. 
However, the planning engine may change the start and end times during the next 
planning run but it continues to base them on the inflated resource usages.

Op Seq Res Seq Resource Advanced 
Supply Chain 
Planning 
Usage (hour)

Assigned 
Units

Start 
Time

End 
Time

10 - - - - 0900 
hours

1330 
hours

- 10 R1 2.5 (inflated)

Work in Process
usage: 1

1 0900 
hours

1130 
hours

- 20 R2 2

Work in Process
usage: 2

1 1130 
hours

1330 
hours

10 - - - - 0900 
hours

1330 
hours

This table shows a discrete job for one unit that you manually created in Oracle Work in
Process.

R1 in this job finishes 1.5 hours earlier then the job released from Oracle Advanced 
Supply Chain Planning because this job does not consider the resource efficiency and 
utilization.
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Op Seq Res Seq Resource Usage 
(hour)

Assigned 
Units

Start 
Time

End 
Time

10 - - - - 0900 
hours

1200 
hours

- 10 R1 1 1 0900 
hours

1000 
hours

- 20 R2 2 1 1000 
hours

1200 
hours

This table shows the discrete job that you created in Oracle Work in Process after the 
next collections process to the planning server.

The collections process does not change the start and end times during collections but 
does inflate the resource usages. During the next planning run, the planning engine 
correctly calculates the start and end times using the inflated resource usages. 

Op Seq Res Seq Resource Advanced 
Supply 
Chain 
Planning 
Usage 
(hour)

Assigned 
Units

Start 
Time

End 
Time

10 - - - - 0900 
hours

1200 
hours

- 10 R1 2.5 (inflated)

Work in 
Process 
usage: 1

1 0900 
hours

1000 
hours

- 20 R2 2

Work in 
Process 
usage: 2

1 1000 
hours

1200 
hours

In some cases, you create a discrete job in Oracle Work in Process and firmed it. This 
table shows it after the next collections process to the planning server.

The collections process does not change the start and end times during collections but 
does inflate the resource usages.
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Op Seq Res Seq Resource Advanced 
Supply 
Chain 
Planning 
Usage 
(hour)

Assigned 
Units

Start 
Time

End 
Time

10 - - - - 0900 
hours

1200 
hours

- 10 R1 1 (based on 
resource 
usage)

Work in 
Process 
usage: 1

1 0900 
hours

1000 
hours

- 20 R2 2

Work in 
Process 
usage: 2

1 1000 
hours

1200 
hours

Transportation Resources
Oracle APS considers Transportation and Storage Capacity constraints to plan 
accurately while providing a strong Available/Capable to Deliver (ATD/CTD). 

You will be able to define transportation capacity for a lane of a ship method. In 
addition, you will be able to define aggregate capacity for an intransit/destination 
warehouse or a storage location. 

Sourcing Constraints/Suppliers
You can specify the time-phased capacity of individual suppliers to specific items in 
Oracle Purchasing. You can allocate planned orders using the constraints of the 
suppliers--planned orders are assigned supplier sources in respect to their capacity. 
Planning uses the ranking information you specify and first attempts to source the 
planned orders with the primary sources. If the capacity to fulfill the demand is not 
available, alternative sources are used. 

Source Rank Percentage Effective From Effective To

Supplier 1 1 40 05/15 12/31
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Source Rank Percentage Effective From Effective To

Supplier 2 1 60 05/15 12/31

Supplier 3 2 100 05/15 12/31

Supplier capacity is specified in units per day over a designated time period. Supplier 
capacity accumulates if not used on a particular day. For example, if a supplier's 
capacity is 100 units per day from 1/1/99 to 1/10/99 and no units are ordered from the 
supplier from 1/1/99 to 1/3/99, then planning considers a total of 1000 units to be 
available from 1/4/99 to 1/10/99. No capacity is assumed available on nonworking days 
based on the owning organization calendar.

Supplier capacity can vary by time period. You can specify one daily capacity for Period
1 and a different capacity for Period 2. Time periods are specified from a start date to an
end date.

See 'Supply Chain Modeling, page 6-1 for more information about setting supplier 
capacity constraints.

Tolerance Fences
You can define capacity tolerance percentages that can vary for each of your items. The 
tolerance fence data in Oracle Purchasing is used to adjust production according to 
capacity changes for item/supplier combinations when the order is placed. Tolerance 
fence values can be specified for the capacity fluctuation allowed for available to 
promise; and used to determine demand based on the amount of advanced notice given
to the supplier.

See 'Supply Chain Modeling, page 6-1 for more information about setting tolerance 
fences.

Enabling and Disabling Constraints

To enable and disable constraints
1. From the Navigator, select Supply Chain Plan > Options.

The Plan Options window appears.

2. Select the Constraints tab.

3. Using the drop-down menus, set Resource or Material Constraints to Yes or No 
based on your business requirements. 
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Note: To generate exception messages related to material resource 
capacity, you must select the Constrained Plan checkbox. 

For more information on setting constraints prior to launching plans, see Defining 
Plans, page 5-1.

Note: You cannot update the Start Date and End Date. The End 
Date is calculated based on your time bucket settings.

Setting Hard and Soft Constraints
Oracle ASCP lets you prioritize how you enforce Capacity Constraints or Demand Due 
Dates. Whichever constraint takes precedence over the other is the hard constraint; the 
other is the soft constraint. If you choose to enforce Demand Due Dates (setting 
Demand Due Dates as a hard constraint), then resources are used and possibly 
overloaded to satisfy demand due dates. In this case, Oracle ASCP returns overloaded 
exception messages. 

If you choose to enforce Capacity Constraints (setting Capacity Constraints as a hard 
constraint), then resource are loaded to their limit to satisfy demand (if required). 
Unsatisfied demand are pushed to future. In this case, Oracle ASCP returns late 
replenishment exception messages. 

Note: You must choose one and only one type of constraint. 

To set hard and soft constraints
1. From the Navigator, select Supply Chain Plan > Options. 

The Plan options window appears.

2. Select the Constraints tab.

3. Check either the Enforce Demand Due Dates or the Enforce Capacity Constraints 
check box. The selected check box represents a hard constraint while the cleared 
check box represents a soft constraint. 

Setting Constraints for Different Plan Types
The following table describes the requirements for setting constraints for various types 
of plans: 
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Plan Type Constraints Tab Optimization Tab

Unconstrained Constrained Plan checkbox is 
unchecked. Enforce Demand 
Due Dates checkbox is 
checked. Resource Constraint 
and Material Constraint fields
are set to No. Calculate 
Resource Requirements can 
be checked to calculate 
capacity even for 
unconstrained plans.

Optimize checkbox is 
unchecked. 

Material Constrained Constrained Plan checkbox is 
checked. Check either Enforce
Demand Due Dates or 
Enforce Capacity Constraints 
checkbox.You can check only 
one checkbox. Resource 
Constraint fields are set to 
No; Material Constraint fields
are set to Yes. 

Optimize checkbox is 
unchecked. 

Resource Constrained Constrained Plan checkbox is 
checked. Check either Enforce
Demand Due Dates or 
Enforce Capacity Constraints 
checkbox.You can check only 
one checkbox. Resource 
Constraint field set to Yes; 
Material Constraint fields are 
set to No. 

Optimize checkbox is 
unchecked. 

Material and Resource 
Constrained

Constrained Plan checkbox is 
checked. Check either Enforce
Demand Due Dates or 
Enforce Capacity Constraints 
checkbox.You can check only 
one checkbox. Resource 
Constraint and Material 
Constraint fields are set to 
Yes. 

Optimize checkbox is 
unchecked. 
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Plan Type Constraints Tab Optimization Tab

Optimized Constrained Plan check box is
checked. Depending on your 
hard and soft constraint 
requirements, check either 
Enforce Demand Due Dates 
or Enforce Capacity 
Constraints check box.You 
can check only one check box.
Either or both Resource 
Constraint Material 
Constraint fields are set to 
Yes. 

Optimize check box is 
checked. 

For additional information on setting constraints, see 'Defining Plans, page 5-1 and 
'Supply Chain Modeling., page 6-1

Enforce Purchasing Lead-time
Oracle Advanced Supply Chain Planning allows you to distinguish between supplier 
capacity constraints and purchasing lead-time constraints for constrained plans. 

The supplier capacity constraints considers that the supplier capacity and the receiving 
calendar that are defined on the ASL planning tab.

The Enforce Purchasing Lead-times Constraint considers:

• Purchasing lead-times that are defined as lead-time item attributes or processing, 
pre processing and post processing lead-times

• Supplier specific processing lead-time that is defined on the ASL planning tab

The Enforce Purchasing Lead-times Constrain plan option governs the purchasing lead 
items of items that are procured from suppliers as shown in the table below:

Enforce Purchasing Lead-time Constraints 
Plan Option =

The planning engine:

Yes Enforces purchasing lead-times.

No If necessary, compresses purchasing 
lead-times, then generates exception.

The plan option does not affect the items sourced from an internal organization or make
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items. It applies to supply frim planned orders, purchase requisitions, and purchase 
orders.

However, the MSO: Lead Time Control profile option governs the lead-times for make, 
buy and transfer items as shown in the table below:

Enforce Purchasing 
Lead-time Constraints Pan 
Option =

Profile MSO: Lead Time 
Control =

The planning engine:

Yes Do not violate min processing
times

Enforces purchasing 
lead-times.

No Do not violate min processing
times

Does not enforce purchasing 
lead-times.

Yes Violate min processing times 
to meet demand due date

Does not enforce purchasing 
lead-times.

No Violate min processing times 
to meet demand due date

If necessary, compresses 
purchasing lead-times, then 
generates exception.

When the Enforce Purchasing Lead-time Constraints is set to No and lead-time 
violation occurs, the planning engine generates the following exception message:

• Order with Insufficient Lead-time

For more details, see Chapter 9: Exception Messages.

Irrespective of whether the Enforce Purchasing lead-time Constraints plan option is set 
to Yes or No, the planning time fence is enforced depending on the plan option 
Planning Time Fence control. If Enforce Purchasing lead-time Constraints is set to No 
and the planning time fence control option is selected, then the planning engine forces 
the suggested due date to be after the planning time fence. This means that all other 
purchase order dates can be inside the planning time fence, but the suggested due date 
cannot be inside the planning time fence.

In Constrained - Enforce demand due dates plans, when MSO: Lead Time Control is Do
Not Violate Min Processing Times and Enforce Purchasing Lead Time is:

• Yes: The planning engine treats all lead times as enforced constraints and moves 
demands to a later date if necessary to enforce the constraints. 

• No: The planning engine treats all lead times except purchasing lead times as 
enforced constraints and moves demands to a later date if necessary to enforce 
make at and transfer from constraints. It may compress supplier lead times to meet 
the demand due date.
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These settings have no effect in Constrained - Enforce capacity constraints plans.

Rules Used in Constrained Plans
There are two types of constrained plans; one that uses the User Defined Decision Rules
and one that does not. This is determined by the setting for the profile option MSO: 
Enable Decision Rules. If it is set to No (the default), then when running a constrained 
but not optimized plan, the following rules are used: 

• Demand Priorities are respected 

Note: When Demand Priorities are not specified, the default 
priorities of the various demand types are (in order): sales order, 
forecast, and safety stock. 

• Alternate BOMs will not be considered

• Alternate routings will not be considered

• Substitute items will not be considered

If MSO: Enable Decision Rules is set to Yes, then when running a constrained but not 
optimized plan, the following rules are used:

• Demand Priorities are respected 

Note: When Demand Priorities are not specified, the default 
priorities of the various demand types are sales order, then 
forecast, and then safety stock. 

• Alternate BOMs are considered

• Alternate routings are considered

• Substitute items are considered

For additional information, please refer to User-Defined Alternate Decision Rules, page 
12-39.

Look-Ahead Heuristic
Using the look-ahead heuristic, the planning engine:

• Schedules supplies so that, as much as possible, you work on supplies pegged to 
higher priority demands ahead of supplies pegged to lower priority demands.
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• Looks ahead at a certain group of demands and schedules supplies to meet these 
demands in a single pass.

• May schedule supplies ahead of their due dates. This can result in higher priority 
demands completing earlier than their actual due dates and benefitting from 
additional protection of their delivery dates.

To enable the heuristic:

• Set the value of profile option MSO: Heuristic type to Look Ahead

• Specify the number of demands to group by setting profile option MSO: Maximum 
Demands per Slice.

When using the look-ahead heuristic, the planning engine:

• Orders demands by demand priority

• Groups demands into slices; each slice has no more than the number of demands in 
profile option MSO: Maximum Demands per Slice

• Plans each slice in the plan

When the planning engine plans each slice, it schedules as follows:

• Backward schedules the demands in the slice.

It starts with the demand with the latest completion date in the slice and resolves 
demands due on the same day by scheduling the lowest priority demand first. It 
results in resources for higher priority demands scheduled earlier then resources for
lower priority demands.

It tries to schedule activities to take as little time as possible and use as much 
capacity as possible, even if the activity ends earlier than needed.

• Determines if the schedule is feasible, that is, that you have enough resources to 
schedule supplies for all of the demands. In a feasible schedule, no supplies are 
scheduled to start in the past and no demands are complete in the past.

• If the schedule is not feasible, the planning engine forward schedules the demands 
in the slice.

It starts with the highest priority demand and schedules each demand respecting 
material and capacity constraints. It starts on the calculated schedule date from the 
backward pass for each demand; however, if the calculated schedule date for the 
demand is in the past, it schedule it to start it today.

If it schedules a demand complete earlier than its actual due date, the planning engine 
right justifies it if possible.
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V-Shaped Schedules
The planning engine tries to avoid V-shaped schedules by scheduling all of the 
operations of a supply before scheduling any other supplies. This reduces the chance of 
scheduled gaps between operations of any supply.

A V-shaped schedule is a schedule with a consistent pattern of gaps between operations
in the same routings. For example, a routing has operation sequences 10 and 20 which 
use the same resource. The planning engine needs to schedule three supplies (S1, S2, 
and S3) for that item that are pegged to different demands. This diagram shows the 
resource scheduling which results in and with avoiding V-shaped schedules.

Resource Scheduling

The planning engine may not always avoid gaps and V-shaped schedules, especially in 
cases of:

• Resource constraints in Constrained - Enforce due dates plans

• Components assigned to operations in the middle of the routing

• Co-products assigned to operations in the middle of the routing

The easiest way to see the pattern of the supplies for a demand is in the Planner 
Workbench, Gantt Chart, Order View.

Flexible Shift Times
This feature enables planners to plan resource shift start and end times at any minute 
within the hour. This feature enables ASCP to handle aggregate planning and detailed 
scheduling concurrently and to accurately schedule resources down to the minute time 
level.

For the portion of the planning horizon that is planned at greater than minute-level 
granularity (the portion that is planned at the hour, day, week or period levels), ASCP 
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factors in break periods by extending operation times to reflect the proportion of breaks 
within each planning time bucket. For example, a 2-hour operation that occurs during a 
day-level planning bucket that has breaks at 4:00-5:00, 12:00-13:00 and 20:00-21:00 
would be stretched into a 2 / (21/24) = 2.29-hour operation. The exact timing of breaks 
within this day-level planning bucket is ignored. This solution maintains as much 
scheduling accuracy as possible when more aggregate (time-bucketed) planning is 
being done.

Example 1: Planning Time Bucket Size = 1 Hour
Consider a one-hour portion of the planning horizon (1:00 - 2:00). Within this period 
there is a resource break of 15 minutes (1:30-1:45). The size of the planning time bucket 
is 1 hour.

ASCP calculates an elongation factor for this period that is equal to the ratio of working 
time within the period to the total duration of the period.

• Elongation factor = (60 - 15) / 60 = 0.75

If there is a resource requirement of 18 minutes, due at 2:00, by using the elongation 
factor, the requirement duration is calculated to be:

• Requirement duration = 18 / 0.75 = 24 minutes

The requirement start time is therefore set to requirement end time (2:00) minus 24 
minutes:

• Requirement start time = 1:36

The following figure is an example of how a resource break is scheduled for when the 
planning time bucket size is one hour:

One Hour Planning Time Bucket Size

Note that the requirement is scheduled to start in the middle of the resource break; the 
exact timing of the resource break is ignored. This is an approximation that ASCP 
makes in any time bucket of size 1 hour or more. It allows for as much scheduling 
accuracy as possible while planning at more aggregate time levels.
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Example 2: Planning Time Bucket Size = 1 Minute
Consider the same one-hour portion of the planning horizon (1:00 - 2:00), with the same 
resource break of 15 minutes (1:30-1:45). In this example, the size of the planning time 
bucket is 1 minute (the smallest permitted by ASCP).

Once again there is a resource requirement of 18 minutes, due at 2:00.

Since this is the minute-by-minute detailed scheduling portion of the plan horizon, 
break start and end times are accounted for down to the nearest minute. An elongation 
factor is not used.

The requirement start time is calculated to be:

• Requirement start time = 1:27

The following figure is an example of how a resource break is scheduled for when the 
planning time bucket size is one minute:

One Minute Planning Time Bucket Size

This allows for 3 of the 18 minutes of work to be done before the break (1:27 to 1:30), 
then the remaining 15 minutes of work to be done after the break (1:45 to 2:00). No work
is scheduled during the break.

The above two examples demonstrate the contrast in the level of detail of scheduling 
that occurs in aggregate (greater than one minute duration) time buckets versus 
detailed (one minute duration) time buckets.

Example 3: Efficiency Factor Rounding
Use profile option MSO: Floating Point Precision for Planning Bucket Efficiency specify 
the efficiency factor precision. The default value is 1000 which instructs the planning 
engine to truncate the efficiency factor to three decimal places. See also MSO Profile 
Options, page A-83.

For example, you set:

• Plan Options form, Aggregation tabbed region, Days Bucket: 30
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• Plan Options form, Constraints tabbed region, Constrained Plan: Selected, Enforce 
Demand Due Dates: Selected, Resource Constraints: Yes, Material Constraints: Yes

You have a resource shift for 8 May for 5.25 hours (from 1300 hours to 1710 hours and 
1755 hours to 1900 hours = 6 hours - 45 minutes = 6 hours - 0.75 hours)

Your resource can produce 10 pieces per hour or one every six minutes (60 minutes / 10 
pieces)

The master demand schedule has quantity 12 on 8 May. You need 72 minutes to meet 
the demand (12 pieces * 6 minutes per piece).

The planning engine should calculate Efficiency factor = Working time / Total time 
available. The efficiency factor in this example is 0.21875 (5.25 hours in the shift / 24 
hours in the day)

The planning engine should calculate Requirement duration = Time needed for 
operation / Efficiency factor. The requirement duration in this example is 5.48 hours (72 
minutes / 0.21875 = 329 minutes).

However, Planner Workbench schedules the operation for 5.63 hours (343 minutes) 
which is 0.14 hours/8.4 minutes discrepancy:

• Suggested Start Date: 8 May 18:16:00

• Suggested Due Date: 8 May 23:59:00

The difference is due to your setting profile option MSO: Floating Point Precision for 
Planning Bucket Efficiency to 100:

• The planning engine calculates efficiency factor as 0.21 (5.25 hours in the shift / 24 
hours in the day = 0.21875, truncate to two decimal places)

The planning engine calculates requirement duration as 5.63 hours (72 minutes / 0.21 = 
342.85 minutes, round to 343 minutes).

Planned Order Suggested Dates
You may notice a difference between planned order suggested dates from the planning 
engine and the theoretical offset calculation due to rounding. This example illustrates 
the reason.

Offset formulas: 

• Efficiency Factor = Working Time / Total Time Available 

• Requirement Duration = Operation Time/Efficiency Factor

Shifts for operation resource: 

• 1300h - 1710h 

• 1755h - 1900h
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Resource qty/rate: 6 minutes or 10 per hour

Demand: 08-MAY, quantity 12

Constrained - Enforce demand due date plan. Plan options are:

• Aggregation tab, Days buckets = 30 

• Constraints tab, Days Resource Constraints = Yes

• Constraints tab, Supplier Capacity Constraints = Yes 

Supply, planned order in Planner Workbench:

• Sugg Start Date: 08-MAY 18:16:00 

• Sugg Due Date: 08-MAY 23:59:00

• Requirement Duration = 5.62 hours or 343 min

Planned order offset calculations:

• Efficiency Factor = 0.21875 [5.25 hours / 24 hours] 

• Requirement Duration = 5.48 hours [72 minutes/0.21875 = 329 minutes] 

The difference between the Planner Workbench suggestion and the planned order offset
calculation is 8.4 minutes or 0.14 hours [(5.62 hours - 5.48 hours]. The explanation is:

• Profile option MSO: Floating Point Precision for Planning Bucket Efficiency = 100

• Efficiency Factor = 0.21 [5.25 hours / 24 hours = 0.21875] 

• Requirement Duration = 5.62 hours or 343 minutes [72 minutes/0.21 = 342.85 
minutes]

Elongation Factor
The scheduling process calculates an elongation factor to express resource availability 
in terms of daily buckets - (Resource Availability / Total Hours in Planning Bucket) * 
100. For example:

• There is a resource available daily for 8 hours [0800 hours to 1600 hours

• The total hours in a day is 24 [0000 hours to 2400 hours]

• The daily elongation factor is 33% [8/24 = 0.3333]

• When the planning engine schedules this resource for 12 hours in a daily planning 
bucket, the resource usage is 4 hours [12 * 0.3333] 

In the first planning bucket, the calculation depends on the plan start time. For example:
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• The plan start time is 1400 hours

• The resource is available for 2 hours in day 1 [1400 hours to 1600 hours]

• The total hours in day 1 is 10 [1400 hours to 2400 hours]

• The elongation factor for day 1 is 20% [(2/10) * 100 = 0.2]

• Resource usage for day 1 is 2 hours [10 * 0.2]

Partial Demand Satisfaction
When multiple planned order supplies are required to satisfy a demand, ASCP 
schedules all supplies that can be completed by the due date for the due date, and the 
remaining supplies for the demand satisfied date. 

This allows the supplies that can be completed on time to be released, executed, and 
shipped as a partial order shipment to the customer.

The Partial Demand Satisfaction capability applies only to the end demand 
(independent demand). For the dependent demand, it is not cost effective and beneficial
to complete part of the order quantity and then carry this inventory up to the time when
it is needed.

To establish Partial Demand Satisfaction functionality
1. Set Partial Demand Completion Profile Option.

1. Sign in as System Administrator.

2. From the Navigator, choose Profile > System.

The Find System Profile Values screen appears.

3. Enter your search criteria and select the Find button.

The System Profile Values screen appears.

Set the MSO: Allow Partial Demand Completion profile option to any of the 
following values:

• All End Demands 

• Sales Orders Only

• None 

The default value for this profile option is All End Demands.

Example
In this example, there is a sales order SO1 for 150 with a due date on day 10. There 
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are two planned orders P1 and P2 satisfying this sales order demand. This is shown 
in the following diagram:

Partial Demand Satisfaction

The planned order P2 can be completed on time; however, the planned order S1 can
be completed only by day 12.

Without the Partial Demand Satisfaction enhancement, ASCP would have 
scheduled both P and P2 to complete on day 12.

Using the Partial Demand Satisfaction feature, P2 is scheduled to complete on time 
(on day 10), while P1 remains scheduled for day 12. This permits P2 to be released, 
executed and shipped in time to partially satisfy customer demand on time.

In the Exception Details form (Supply Chain Plan > Workbench > Actions tab > drill 
down on an Action Type), the column named Quantity Satisfied By Due Date is 
used to present the portion of a demand that can be satisfied by the due date.

Phantom Routings
In order to run constrained plans in ASCP, you must set the BOM parameter Use 
Phantom Routings to No.

To set the BOM parameter Use Phantom Routings to No
1. Sign in using the Manufacturing and Distribution Manager responsibility.

2. Select Bills of Materials > Setup > Parameters. 

The Parameters screen opens.

3. Uncheck the Use Phantom Routings checkbox.
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Split Planned Orders
Smaller planned orders typically give the planning engine more flexibility and result in 
a schedule in which supplies are more likely to be made just in time to meet their 
demands. This feature instructs the planning engine to split planned orders to more 
closely match the quantities of the demands to which they are pegged. Use it if:

• You do not typically use order modifiers

• Your plan results in planned orders which peg to demands with widely separated 
due dates

• Your plan results in product made near-term when most of it is needed to satisfy 
demands that are due farther out

Split planned orders defaults such that if a planned order with quantity more than 10% 
higher than the quantity of the demand to which it is pegged, the planning engine splits
it. To change the default percentage or disable the feature, set profile option MSO: 
Demands Size Tolerance PCT Before Splitting Planned Orders with the percentage in 
decimal format (for example, for 10%, enter 0.1, not 10).

During pegging, the planning engine:

• Pegs a planned order to a demand.

• Checks to see if the planned order item has order modifiers. If so, it does not split 
the planned order.

• Checks to see if the planned order quantity is significantly larger than the demand 
quantity. The check is (Planned order quantity - Demand quantity) / Demand 
quantity >MSO: Demands Size Tolerance PCT before Splitting Planned Orders.

If the calculation shows not significantly larger, the planning engine does not split 
the planned order.

If the calculation shows significantly larger, the planning engine splits the planned 
order, assigns the demand quantity to the new planned order, and pegs the new 
planned order to the demand.

For example, MSO: Demands Size Tolerance PCT before Splitting Planned Orders is 0.1.
The planning engine:

• Pegs planned order 1 for item S with quantity 100 to demand A with quantity 20. 

• Verifies that item S has no order modifiers set.

• Calculates ((100 - 20) / 20 = 4.

• Verifies 4 > 0.1.
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• Splits planned order 1. Planned order 1 has quantity 80 and new planned order 1-a 
has quantity 20.

• Removes the peg of planned order 1 to demand A and pegs planned order 1a to 
demand A.

Split Planned Order: Sizing and Timing
Use the profile option MSC: Split Planned Orders for Scheduling Flexibility to specify 
whether or not you want the planning engine to split a planned order into multiple 
planned orders. For more information about this profile option, see Profile Options. The
planning engine considers and applies the profile option MSC: Split Planned Orders for 
Scheduling Flexibility before the profile option MSO: Demands Size Tolerance PCT 
before Splitting Planned Orders. The profile option MSC: Split Planned Orders for 
Scheduling Flexibility applies to:

• Constrained plans for which decision rules are enabled 

• Cost-optimized plans

Firm Work Orders
Firm work orders are work orders that are:

• Under the control of a shop floor manufacturing application

• Marked as do not change by shop-floor or planning personnel

The planning engine does not change firm work order operation start and end times 
and resource usages. However, it calculates firm work order resource requirements and
reduces resource availability by these requirements (processes firm work orders).

The planning engine processes firm work orders before it schedules non-firm work 
orders and planned orders. It does this without regard to the demand priorities. After it 
processes firm work orders, it schedules non-firm work orders and planned orders in 
the manner prescribed by the plan options and profile options.

Firm work orders can overconsume resource capacity; when that occurs, the planning 
engine issues Resource overloaded exception messages.

Plan Shared Supplies
Shared supplies are scheduled receipts, firm planned orders, and planned orders that 
peg to more than one end item demand.

The planning engine schedules a shared supply based on the due date of one of the 
demands and that shared supply may be late with respect to the other demands that are
also pegged to it.
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Multiple Demands in Same Slice 
If multiple demands that are pegged to one shared supply are in the same demand slice 
(see Pegging), the planning engine always reschedules the shared supply.

The rescheduling:

• Attempts to meet all demands on time

• Attempts to meet higher priority demands early or just in time

• Selects lower priority demands to be late, if necessary

• Occurs only if the reschedule can fit within available supplier capacity and within 
lead-times, depending on constraints

For example, the last process to produce light posts is to have a welder attach a 
purchased bracket to a light post subassembly. The welder can attach 100 brackets a 
day.

Two demands peg to a shared supply for attaching the brackets. Both demands are in 
the same demand slice:

• Demand 1: End Item: Light post, Quantity: 100, Demand Due Date: Day 7, Priority: 
1

• Demand 2: End Item: Light post, Quantity: 200, Demand Due Date: Day 4, Priority: 
200

The planning engine:

• Processes demand 1, the higher priority demand which is due on day 7.

• Schedules the brackets to arrive on day 6. The welder is to produce 100 light posts 
on day 6 and meet demand 1 on time.

• Processes demand 2, the lower priority demand which is due on day 4, earlier than 
demand 1.

• Reschedules the brackets to arrive on day 2. The welder is to produce 200 light 
posts on days 2 and 3 and meet demand 2 on time, then is to produce 100 brackets 
on day 4 and meet demand 1 early.
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Figure Title

Multiple Demands in Different Slices
If multiple demands that are pegged to one shared supply are in different demand 
slices, the planning engine does not typically reschedule the shared supply.

For example, the last process to produce light posts is to have a welder attach a 
purchased bracket to a light post subassembly. The welder can attach 100 brackets a 
day.

Two demands peg to a shared supply for attaching the brackets. Each demand is in a 
different demand slice:

• Demand 1: End Item: Light post, Quantity: 100, Demand Due Date: Day 7, Priority: 
1

• Demand 2: End Item: Light post, Quantity: 200, Demand Due Date: Day 4, Priority: 
200

The planning engine:

• Processes demand 1, the higher priority demand which is due on day 7.
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• Schedules the brackets to arrive on day 6. The welder is to produce 100 light posts 
on day 6 and meet demand 1 on time.

• Processes demand 2, the lower priority demand which is due on day 4, earlier than 
demand 1 and is in a different slice than demand 1.

• The welder is to produce 100 light posts on day 6 and meet demand 1 on time, then 
is to produce 200 brackets on days 7 and 8 and meet demand 2 late.

Figure Title

Use the plan shared supplies feature to instruct the planning engine to attempt to 
reschedule shared supplies that it scheduled in previous demand slices. The goal is the 
same as when the multiple demands are in the same slice--to make the shared supply 
on time or early for all demands which peg to it.

To enable the feature, set profile option, MSO: Additional Demand Slices for Shared 
Supply Rescheduling which defaults to 0. Specify either:

• A positive integer: The planning engine attempts to reschedule shared supplies 
across this many previous demand slices. After that, it does not reschedule a shared
supply even if that results in a demand being late.
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• -1: The planning engine reschedules shared supplies across all slices.

The higher the integer, the more impact there is on plan performance. The value -1 has 
the most impact.

Enforce Capacity Constraints Scheduling
Supplies and resource requirements within supplies that are pegged to on time 
demands have their Earliest Allowable Completion Time (EACT) as the Plan Start Date.

Enforce Demand Due Date Scheduling
Enforce demand due date plans require the planning engine to meet demand due dates.
If it cannot meet the demand on time using existing capacity, it must overload resources
and suppliers.

The planning engine backward schedules the activities from the demand due date. If 
there is not enough time to complete the supply order by the demand due date, the 
planning engine reaches the plan start date before it is finished scheduling the order. It 
then follows a certain process to reschedule the operations, see Identifying Root Causes 
of Late Demand, page 17-121.

The planning engine manage the slacks (overloads) as it schedules, so that it can 
overload the activities that are constraining the schedule the most and reasonably 
schedule the other activities. As planners can easily identify the actual constraining 
activities, they can work to improve the overall schedule.

To manage the slacks, it assigns each activity of a supply order a time window and only
schedules the activity within that window. This allocates to each activity in a supply 
order its proportion of the slack. Otherwise, the full scheduling of beginning or ending 
activities in the routing can use up most of the time. Then, other activities appear 
compressed against the plan start date or demand due date with high slack even 
thought they are not necessarily the most constraining activities.

When faced with a need to overload, the planning engine: 

• Does not compress operations beyond their minimum durations unless the demand
is due very close to the plan start date

• Tends to overload resources at times when they are unavailable rather then 
compressing operations into small gaps of available time

• Attempts to create resource overloads evenly distributed in time rather than 
creating higher resource overloads closer to the plan start date

This diagram shows an example of scheduling a four operation (operation numbers 10, 
20, 30, 40) supply order without using scheduling windows and with using scheduling 
windows. The filled in boxes represent times when a resource is unavailable.
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• When not using scheduling windows, the planning engine schedules operations 40 
and 30 for their complete times and during times when their resources are available
and then severely compresses operations 20 and 10 to avoid their being past due.

• When using scheduling windows, the planning engine schedules all operations for 
their complete times; however, it schedules operations 20 and 40 during times when
their resources are not available.

Activity Scheduling and Scheduling Windows

Scheduling Requirements
The planning engine schedules every material and resource requirement in an enforce 
demand due date plan:

• Within an unconstrained scheduling window

• Within an actual scheduling time window

• According to the nature of the time window

Unconstrained Scheduling Window
To schedule a supply order, the planning engine first finds the unconstrained 
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scheduling window for each operation.

The unconstrained scheduling window of an operation occurs between these points:

• Unconstrained Earliest Possible Start Time (UEPST): The planning engine never 
schedules an operation to start earlier than this time. If it did so, it would compress 
upstream operations beyond their minimum durations.

The Unconstrained Earliest Possible Completion Time (UEPCT) = UEPST + 
Minimum duration of operation

• Unconstrained Latest Possible Completion Time (ULPCT) : The planning engine 
never schedules an operation to end later than this time. If it did so, it would 
compress downstream operations beyond their minimum durations.

Unconstrained Latest Possible Start Time (ULPST) = ULPCT - Minimum duration of
operation

This diagram shows the unconstrained scheduling window for an operation.

The planning engine finds the UEPST and ULPCT by backward and forward 
scheduling all activities, considering resource availability and breaks (according to the 
setting of the profile option MSO: Use Breaks in Calculation of Unconstrained 
Scheduling Windows), maximum assigned units, precedence constraints, firming, 
minimum transfer quantity operations, and Next and Prior scheduled resources, but not
minimum batch size constraints, resource batching, or organization receiving calendars 
. It backward schedules from the demand due date and forward schedules from the 
minimum start time for each operation. The minimum start time of each operation 
accounts for the plan start date, planning time fence, and preprocessing lead-time.

This diagram shows a number of operations with their unconstrained scheduling 
windows and the UEPSTs and ULPSTs highlighted.
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Routing Unconstrained Scheduling Windows

If there is are firm activities, the planning engine first backward schedules the activities 
upstream of the earliest firmed activity and between them and then first forward 
schedules activities downstream of the latest firmed activity.

Actual Scheduling Window
The planning engine uses the information from the unconstrained scheduling windows 
to find the total slack of a supply order and to distribute it among the activities in 
proportion their contribution to it. For each operation that uses a resource, the planning 
engine calculates a constrained window, the actual scheduling window, and schedules 
the operation within that window.

The slack of each operation is the maximum amount of "wiggle room" that each 
operation has. It assumes that each operation above it in the pegging tree is scheduled 
as late as possible with minimum processing time and that each operation below it in 
the pegging tree is scheduled as early as possible with minimum processing time. 
Slacks among the operations are interrelated. For example, if an operation higher in the 
pegging tree gets scheduled towards the earlier side of its unconstrained scheduling 
window, the planning engine is more likely to compress the windows of its operations 
lower in the pegging tree. 
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The actual scheduling window of an operation occurs between these points:

• Earliest Allowable Completion Time (EACT): The planning engine never schedules 
an operation to end earlier than this time. An earlier completion would take time 
from other activities and possibly cause them to have less slack than is proportional 
for them.

The planning engine calculates it from information gathered while performing 
unconstrained scheduling. It is the ratio of the minimum processing time needed by
the operation to the total minimum processing time along the path of minimum 
slack upstream from the operation. This ratio indicates how much of the slack we 
can allow the operation to use. You can influence the calculation of EACT and the 
length of the actual scheduling window by setting profile option MSO: EDD 
Scheduling Window Control.

Earliest Allowable Start Time (EAST) = EACT - (UEPCT - UEPST)

• Unconstrained Latest Possible Completion Time (ULPCT) of the unconstrained 
scheduling window.

This diagram shows the unconstrained scheduling window and the actual scheduling 
window for an operation.
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Unconstrained and Actual Operation Scheduling Windows

Scheduling Window Nature
The action that the planning engine takes to schedule an operation depends on the 
nature of the scheduling window. The nature of scheduling window depends on:

• The time between the plan start date and the demand due date

• The cumulative duration of all supplies and operations that need scheduling to 
satisfy the demand on time

If the size of the actual scheduling window is the same as or longer then the operation 
minimum duration, the planning engine schedules it at its minimum duration within 
the actual scheduling window.

If the size of the actual scheduling window is shorter than the operation minimum 
duration, the planning engine may compress it and schedules it for the duration of the 
actual scheduling window. This usually occurs when the demand due date is close to 
the plan start date and depends on the profile option MSO: Lead Time Control.

If the operation would start or end in the past, the unconstrained scheduling window is 
nonexistent. The planning engine schedules the operations according to the setting of 
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profile option MSO: Lead Time Control.

Scheduling Controls
You can control some functions of the planning engine operation scheduling in enforce 
demand due date plans.

Operation Compression
To instruct the planning engine how to proceed when it finds an operation would start 
or end in the past, set profile operation MSO: Lead Time Control. With either setting, 
there may be supplier and resource overloads.

If you select Violate minimum processing times to meet demand due date (the default), 
the planning engine compresses operations into less time than the maximum assigned 
units processing time to meet the demand due date. In addition, it issues an Order with 
insufficient lead time exception message and a Requirement with insufficient lead time 
exception message. It retains the schedules of the future operations within their actual 
scheduling windows.

This diagram shows a series of operations to be scheduled. Operations A4 and A5 are 
wholly or partially in the past. With option Violate minimum processing times to meet 
demand due date set, the planning engine compresses operations A4 and A5 to retain 
the demand due date.
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Violate Minimum Processing Times Example

If you select Do not violate minimum processing times, the planning engine does not 
compress operations, calculates a new demand due date (the demand satisfied date), 
and reschedules the operations according to the new demand due date. The time 
between the original demand due date and the new demand due date is the minimum 
possible days late.

This diagram shows a series of operations to be scheduled. Operations A4 and A5 are 
wholly or partially in the past. With option Do not violate minimum processing times 
set, the planning engine calculates new demand due date and reschedules the 
operations for that date.
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Do Not Violate Minimum Processing Times Example

Capacity Breaks
To instruct the planning engine to make use of capacity breaks (non-work times), set 
profile option MSO: Use Breaks in Calculation of Unconstrained Scheduling Windows.

If you select Yes (the default), the planning engine calculates UEPST, UEPCT, ULPST 
and ULPCT taking capacity breaks into account. It does not include resource or supplier
non-work time when laying out activity time and never sets any of these time points to 
a non-work time. 

If you select No, the planning engine calculates UEPST, UEPCT, ULPST and ULPCT 
ignoring capacity breaks. It does include resource or supplier non-work time when 
laying out activity time and may set any of these time points to a non-work time.

Select No to encourage the planning engine to schedule work during resource breaks to 
meet demand due dates; select Yes to discourage it from this effort.

If set to Yes, the planning engine may schedule a downstream operation during a 
resource's non-working time. This results in more available time available for upstream 
operation scheduling; the planning engine could schedule upstream operations beyond 
their ULPCT.
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Earliest Allowable Completion Time
To control the planning engine calculation of Earliest Allowable Completion Time 
(EACT), set profile option MSO: EDD Scheduling Window Control. The planning 
engine calculates the optimal size for each operation's actual scheduling window as 
proportional to its minimum duration and whether or not it is in the critical path. You 
control the actual size of the actual scheduling window by entering a number between 0
and 1.

If you enter 0.5 (the default), the planning engine sets the actual scheduling window 
duration to the optimal size.

If you enter an number lower than 0.5, the actual scheduling window becomes larger 
than the optimal size. This could cause more resource overloads on upstream resources 
as compared to downstream resources.

If you enter an number higher than 0.5, the actual scheduling window becomes smaller 
than the optimal size. This could cause more resource overloads on downstream 
resources as compared to upstream resources.

This diagram shows the effect of different actual scheduling window sizes.

Actual Scheduling Window Sizes

Analyzing the Plan
To see the results of the enforce due date planning, refer to the Planner Workbench.

• In the Supply window, view the UEPST and UEPCT for each supply calculated 
forward from the plan start date and the ULPST and ULPCT calculated backwards 
from the demand due date.

• In the Resource Requirements window, view the start and completion times and the
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UEPST, UEPCT, ULPST, ULPCT, and EACT for each resource requirement. No 
resource requirement should show a completion time that is earlier than its EACT.

• In the Gantt Chart, right lower pane, the constrained resources should show as 
scheduled with an overload within its scheduling window.

• Resources that are overloaded may not show a corresponding exception message if 
the overload is within the exception set Over-utilization %.

Since scheduling method is not exact, you may see available capacity which appears not
used. The planning engine does not reschedule firm activities and, once it begins 
scheduling, does not usually return to already scheduled operations and resources to 
look for further opportunities.

If profile option MSO: Use Breaks in Calculation of Unconstrained Scheduling 
Windows is Yes, the planning engine, in these cases, does not issue exception message 
Order lead time constraint:

• Operations and supplies that have negative unconstrained scheduling windows 
(unconstrained latest possible completion time is earlier than unconstrained earliest
possible completion time)

• Compressed unconstrained scheduling windows (Unconstrained latest possible 
completion time - Unconstrained earliest possible completion time < Minimum 
processing time)

Safety Stock
Safety stock requirements are hard requirements. The planning engine schedules 
supplies that peg to them to meet their due dates and overloads resources as necessary.

Engineering Change Orders Use-Up Effectivity
Engineering changes to an item or modifications to bills of material are implemented 
through Engineering Change Orders (ECO). These planned changes affect the 
dependent demand calculations and the orders rescheduled or created by the planning 
process. The use-up date is the date when the on-hand quantity for an item will be 
exhausted based on projected gross requirements and receipts. You can plan to use up 
your current item before introducing engineering changes by accepting the use-up 
effectivity date recommended by ASCP.

When you define a revised item using an ECO, you can specify whether the planning 
process should recommend a suggested effective date for the revised item. If you do so, 
Oracle ASCP recommends a use-up date for the current item. The use-up date is 
calculated by applying on-hand quantity in inventory (supply) against gross 
requirements (demand). It is the date on which all supplies for the current item will be 
used up (on hand will be zero).
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The ECO use-up effectivity date is calculated by adding one working day to this, as 
shown in the following figure.

ECO Use-up Effectivity Date

Oracle ASCP considers scheduled receipts in the use-up date calculation if the following
profile option: Include Schd Rcpts in Use-up, is set to Yes.

If you typically have many engineering change orders with close dates, you can instruct
the planning engine to align discrete jobs and engineering change orders but at the 
expense of finite capacity scheduling for the jobs suppliers and resources. To enable 
this, set profile option MSC: Release WIP Dtls if Order Date different then BOM 
Revision Date. As a result of this setting:

• The planning engine updates engineering change order revision date to the start 
date of the earliest affected discrete job.

• Oracle Work in Process ignores the job BOM Revision Date and explodes for the bill
of material and routing details effective on the planning-recommended new order 
(start) date (instead of the existing order (start) date); this eliminates revision 
conflicts among multiple engineering change orders.

To use the ECO Use-up effectivity date recommended by ASCP
1. Define your Engineering Change Orders. For information on how to do this, please 

refer to Oracle Engineering User's Guide.

When you create an ECO, by default the MRP Active Flag is already checked. If you
do not want this ECO to be subject to a use-up date calculation, you can uncheck 
this flag. 

2. Bring the ECO to your planning system by running Collections. 
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3. Run an ASCP plan for the items to which ECOs apply. 

4. After running your plan, you can verify that the ECO has been accounted for in the 
planning process by selecting the item in the left pane of the Planner Workbench, 
then right-clicking with the mouse and selecting Items from the menu that drops 
down. 

The Items window appears.

5. Select the Components button.

The Components window appears. 

Effectivity dates for the components appear in this window.

6. Push the plan output to the source system by running the Push Plan Information 
concurrent program. (Navigation: Setup > Run Requests > Single Request. Select 
Push Plan Information from the list of values.)

7. You can find the system recommended use-up date for the item and components by
navigating to Oracle Engineering and querying up the ECO. You can see the ECO 
details by selecting the Revised Items button in the Engineering Change Orders 
window.

The Revised Items window appears.

8. You can override the recommended use-up date by manually changing the 
Effective Date field. You can also see use-up dates for all components, if the item is 
part of an assembly, and choose the use-up date of any component to be use-up 
date for the whole assembly.

The following table illustrates how the use-up effectivity date is established. 

Day Day 1 Day 2 Day 3 Day 4 Day 5 Day 6

Gross 
Requirements

0 200 200 300 300 0

Projected 
On-Hand

700 500 300 0 0 0

Oracle Advanced Supply Chain Planning calculates the use up date based on 
projected gross requirements for the item. In this example, the current on-hand 
quantity is exhausted on Day 4. Therefore, the planning process sets the use-up 
effectivity date for this item to be Day 5.
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Forecast Expiration
Forecast expiration instructs the planning engine not to plan supply to satisfy some 
types of unmet, past due demands (expire the demands). Use it to avoid build-up of 
these demands that consume current and future production capacity and make it more 
difficult to meet the current demands.

Forecast expiration applies to forecast lines and master demand schedule entries. It does
not apply to sales order lines, safety stock demand, and dependent demand.

It works only for Optimized - Enforce capacity constraints plans with either:

• User-defined decision rules enabled (profile option MSC: Enable User Defined 
Decision Rules is Yes)

• Cost-based optimization enabled

The planning engine calculates late demands based on the capacity constraint options 
you select (Material, Resource, or Material and resource). For example, if you select 
Resource, material capacity constraints (other than the hard constraint material 
lead-time) does not cause late demands and therefore does not cause forecast 
expirations.

Forecast Expiration Setup
To use it, specify the number of days that the planning engine should plan supply for 
these types of past due demand in the profile option MSO: Maximum Allowable Days 
Late before Forecast Expiration. The planning engine expires any of these types of 
demands that are unmet and past due for longer than the profile option value. If you 
want the planning engine to expire all of these types of demands that are unmet and 
past due, set the profile option to 0. Note that the profile option MSO: Maximum 
Allowable Days Late is different from this one.

For example:

• Profile option MSO: Maximum Allowable Days Late before Forecast Expiration is 4

• Original forecast: 1000 units

• Sales order: 100 units

• Unconsumed forecast: 900 units (1000 - 100). The consumption is the forecast 
consumption within the plan; it does not reflect forecast consumption that occurs 
on the source instance during the master demand schedule load.

• Forecast expiration (planning engine cannot meet demand within four days late): 
200 units
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• Net forecast: 700 units (900 - 200)

• Supply: 800 (100 sales order + 700 net forecast). If the item is lot controlled, you see 
one supply for 100 units pegged to the sales order and one supply for 700 units 
pegged to the forecast.

The planning engine calculates the actual cutoff date from the MSO: Maximum 
Allowable Days Late before Forecast Expiration value using the manufacturing 
organization calendar. If that date is within a weekly or period bucket, the planning 
engine uses the date at the end of the weekly or period bucket as the actual cutoff date. 
Therefore, all completed supplies within that weekly or period bucket are within the 
allowed window.

Viewing Forecast Expiration Results
You can see the results of forecast expiration in these Planner Workbench fields in the 
Supply/Demand window:

• Original Order Quantity: The demand quantity before any forecast consumption or 
expired demand.

• Expired Demand: The quantity of the demand that has expired.

• Quantity/Rate: Original order quantity - Consumed quantity - Expired demand.

• Consumption Details: To see the Consumption Details window, right-click on the 
forecast line and select Consumption Details.

This table shows an example of plan results when the planning engine applies forecast 
expiration in this situation:

• There are forecast entries on 4 November for quantity 700 and on 11 November for 
quantity 1000.

• There are no sales orders.

• Profile option MSO: Maximum Allowable Days Late before Forecast Expiration: 4.

• Order modifier Maximum Order Size: 300.

• Both forecast entries are eligible for forecast expiration against their unmet 
quantities. The planning engine estimates that it cannot successfully schedule 100 
units of the 4 November forecast by 8 November and 200 units of the 11 November 
forecast by 15 November. 

The planned order for quantity 200 due on 17 November is six days late despite the 
profile option value of four days. The detailed scheduling process for the planned 
orders may move supplies outside the allowable days late window.
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Entity Due Date Days Late Original 
Forecast

Expired 
Demand

Qty/Rate

Forecast 4 November - 700 100 - 600

Planned 
Order

4 November 0 - - 300

Planned 
Order

4 November 0 - - 300

Forecast 11 
November

- 1000 200 - 800

Planned 
Order

1 November -10 - - 300

Planned 
Order

11 
November

0 - - 300

Planned 
Order

17 
November

6 - - 200

Forecast Expiration Exception Messages
Forecast expiration does not stop the planning engine from issuing Late replenishment 
for forecast exception messages. If you want to suppress those messages, set profile 
option MSO: Late Demands Exceptions Tolerance Minutes to the same length of time as
you set profile option MSO: Maximum Allowable Days Late before Forecast Expiration. 
However, you can set it for any length of time; use quantity 1440 for each whole day. 

Whether or not you suppress the exception message, you can sort on Days Late in the 
Late replenishments for forecast exception details. Sort on Days Late in descending 
order to review the exception messages outside of the MSO: Maximum Allowable Days 
Late before Forecast Expiration value.

Implementing Forecast Expiration
Use this information to adjust profile options and settings for best forecast expiration 
performance.

MSO: Maximum Allowable Days Late
This profile option interacts with MSO: Maximum Allowable Days Late before Forecast 
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Expiration. It limits the number of days that the planning engine can move out a 
demand or unfirmed scheduled receipt in an Optimized plan. You use it only to 
improve the performance of the optimization component of the memory based planner. 
Scheduling moves out demands and unfirmed scheduled receipts as long as necessary 
in the final plan output.

MSO: Maximum Allowable Days Late only applies to sales orders if MSO: Maximum 
Allowable Days Late before Forecast Expiration has a value. If MSO: Maximum 
Allowable Days Late before Forecast Expiration does not have a value, MSO: Maximum
Allowable Days Late applies to all demands. For production planning purposes, MSO: 
Maximum Allowable Days Late limits how many days in the future that the planning 
engine considers alternate sources, end item substitutes, substitute components, 
alternate bills of material, and alternate routings when the primary method would 
result in a late supply. Typically, you should set the MSO: Maximum Allowable Days 
Late to the plan horizon for production plans to make alternate methods available for 
the entire plan duration. If it has a small value, for example 30, and the planning engine 
does not select an alternate method within the first 30 days, it selects the primary 
method. That typically moves the final supply date is pushed out beyond 30 days.

MSO: Maximum Allowable Days Late also impacts forecast expiration when MSO: 
Maximum Allowable Days Late before Forecast Expiration has a value. MSO: 
Maximum Allowable Days Late limits the number of days from the demand date that 
the planning engine reduces capacity for the supply if it is scheduled late. If MSO: 
Maximum Allowable Days Late has a small value, for example 30, and optimization 
cannot find capacity for the sales order within 30 days, then it stops looking at later 
dates. As a result, optimization may not expire forecasts when it should because it has 
not reduced capacity for sales orders. To avoid this, Oracle recommends that you set 
MSO: Maximum Allowable Days Late higher than the number of days in the plan 
horizon.

MSO: Queue Time Factor
The optimization engine uses it to increase lead-time when calculating capacity and 
scheduling supplies. This allows you to produce a more conservative estimate of when 
capacity is required and raises the amount of expired forecast quantities. Too high a 
value leaves unused capacity and expires too much of the forecast quantity. This profile
option does not affect scheduling.

Controlling Late Replenishments
To control the number of late replenishments beyond the MSO: Maximum Allowable 
Days Late before Forecast Expiration value, ensure that all of the processing lead-time 
values are good representations of your actual lead-times. If there are many forecasts 
consistently late and information points to certain resource or material constraints, 
adjust the processing lead-time and retest forecast expiration. Oracle recommends that 
you complete this tip and monitor forecast expiration performance before considering 
the next tip.
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In addition, you can tune the results by setting profile option MSO: Queue Time Factor 
to a fraction. For example, if the value is .10, then the planning engine increases all 
lead-times by 10% in all time buckets.

Forecast Expiration and Demand Priority
The planning engine uses demand priority to decide which of these types of demand to 
expire first. If several eligible demands are in the same bucket with the same demand 
priority, the planning engine randomly selects the demand to expire first. A forecast 
entry and a sales order line can be in the same bucket and have the same demand 
priority. If the planning engine considers the forecast first, it may not post sufficient 
forecast expiration because it has not considered the sales order.

If you want forecast expiration to consider a certain demand before others, set its 
priority higher (a lower number) than the priority of the other demands. For proper 
forecast expiration, Oracle suggests that you use a demand priority rule that includes a 
date criteria first and then MDS/Sales Order Priority. This insures that:

• Sales orders in a bucket have a higher priority than forecasts in the same bucket. 

• The planning engine performs forecast expiration in date sequence, properly 
balances demand and capacity in each bucket, and displays results that you can 
understand.

Forecast Expiration with Online and Batch Replan
When running online or batch replan, the planning engine may reset expired demand to
the quantity expired in that replan. When this happens, note the following:

• The Planner Workbench Qty/Rate field is not accurate. 

• During the online or batch replan, the planning engine has not unexpired any 
expired forecast quantities. Once the forecast quantities have expired, they remain 
expired in all future online and batch replans.

For example, during a regenerative plan run, 1000 units expires. A subsequent 
batch replan expires an additional 100 units. The value in the Expired Demand field
is now 100 units, not 1100 units. Original Order Quantity does not change during 
online or batch replan.

• When you relaunching the plan, the planning engine considers the original order 
quantity and recalculates any forecast expiration.

With online and batch replans when MSO: Maximum Allowable Days Late before 
Forecast Expiration has a value, the planning engine never again considers expired 
forecast quantities.

To see the impact of changes on the expired forecast quantities, either change the source
forecast quantity and launch a new plan or manually increase the forecast quantities in 
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the Planner Workbench. The next online replan expires additional forecast quantities as 
needed.

Sequence Dependent Setups
To minimize resource setup times and maximize resource setup times, you can specify 
sequence dependent setup times. Sequence dependent setup times indicate how long it 
takes to set up a resource, depending on the jobs on the resource. For example, 
changing a paint sprayer from white paint to black paint could take loner than changing
the sprayer from white paint to yellow paint.

Based on sequence dependent setup times, Oracle Advanced Supply Chain Planning 
can determine preferred activity sequences, or "setup rings," that minimize resource 
setup times. A setup ring is a sequence of changeovers that enables a resource to make 
each possible product at least once with a low amount of total changeover time. For 
example, based on sequence dependent setup times, Oracle Advanced Supply Chain 
Planning might determine that the best changeover pattern for a paint sprayer is from 
which to yellow, to blue, to black paint.

When a sequence dependent scheduling is enabled for a time bucket, Oracle Advanced 
Supply Chain Planning tries to schedule resource activities in the time bucket in 
accordance with the setup rings. The planning engine tries to minimize changeover 
times and associated penalties, while meeting demand on time.

If only some resource setup types are required in a time bucket, only the required 
activities are included and planned in accordance with the setup ring. For example, if a 
sprayer setup ring is from white to yellow to blue to black paint, and the sprayer does 
not require blue paint during a bucket, the remaining activities follow the setup ring: 
white to yellow to black.

Oracle Advanced Supply Chain Planning (ASCP) schedules sequence dependent setup 
resources to the level of the resource instance. Rather than stating that a job requires 
three units of a resource, ASCP specifies the sequence dependent setup resource 
instances where the job must run. Sequence dependent setup for batch resources are 
also scheduled to the resource instance level.

If you do not enable sequence dependent scheduling, ASCP increases activity durations 
according to the utilization percentage on each resource, without determining how to 
minimize setup times.

Sequence Dependent Setups for Discrete Manufacturing
You can set up date required for sequence dependent scheduling for discrete 
manufacturing in Oracle Bill of Materials. You can then run collections to populate the 
data in Oracle Advanced Supply Chain Planning.

To specify sequence dependent setup data for discrete manufacturing, you must:

• Define setup types.
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• Assign setup types to resources.

• Specify changeover times between setup types on resources.

• Specify setup types for routing steps.

• Enable instance-level scheduling.

• Specify initial resource state.

• Specify sequencing window sizes.

To Define Setup Types
You must create a setup type for every sequence dependent resource setup. For 
example, you could create white paint, yellow paint, and black paint setup types.

1. Select the Manufacturing and Distribution Manager responsibility.

2. Navigate to Bills of Materials > Routings > Setup Types.

3. For each sequence dependent setup type, enter a code and description.

For more information on setting up resource information for bills of materials, see 
Defining Resource Setup Information, Oracle Bills of Material User's Guide

To Assign Setup Types to Resources
After defining setup types, you must assign the setup types to resources. For example, 
you could assign the paint setups to a paint sprayer.

1. Select the Manufacturing and Distribution Manager responsibility.

2. Navigate to Bills of Materials > Routings > Resources.

3. In the Resources window, find a sequence dependent setup resource.

4. Click Setups.

5. In the Setups window, move all setup types for the resource from the Available area
to the Selected area.

For more information on setting up resource information for bills of materials, see 
Defining Resource Setup Information, Oracle Bills of Material User's Guide

To Specify Changeover Times Between Setup Types on Resources
After assigning setup types to resources, you must specify the amount of time that it 
takes to change between possible setups on a resource. For example, you could specify 
how long it takes to change a paint sprayer from:
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• White paint to yellow paint.

• White paint to black paint.

• Yellow paint to white paint.

• Yellow paint to black paint.

• Black paint to white paint.

• Black paint to yellow paint.

1. Select the Manufacturing and Distribution Manager responsibility.

2. Navigate to Bills or Materials > Routings > Resources.

3. In the Resources window, find a sequence dependent setup resource.

4. Click Setups.

5. In the Setups window, click Changeovers.

6. In the Changeover Times window, do one of the following:

• To select a set of records to perform an edit of changeover times, select a list of 
From Setup Types and a list of To Setup Types, and click Refresh Changeover 
Times. 

This populates all possible combinations on the bottom portion of the screen. 
You can then perform a mass update of changeover times for a subset of the 
records or for all of the records displayed.

• To enter information for one changeover, complete these fields for a changeover
row:

Field Description

From The setup from which the resource is 
changing. The value can be null, meaning 
a changeover from any resource.

To The setup to which the resource is 
changing.

Duration The time it takes to perform the 
changeover.
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Field Description

UOM The unit of measure for the duration.

Penalty The penalty incurred if this changeover is 
performed. The planning engine balances 
this penalty with the demand lateness 
penalty that might be incurred if the 
changeover is not performed and the 
activity is scheduled for a later date.

Standard Operation The standard operation needed for the 
changeover. The standard operation can 
specify resources used in performing the 
changeover. These resources are 
considered simultaneous resources with 
the machine where the changeover is 
performed. Simultaneous resources on 
the changeovers are not scheduled as 
constrained resources and ma have 
overloads after planning.

• To update information for multiple changeovers, select the changeover rows, 
enter information in the Perform Mass Update fields, and click Update.

To exclude changeovers from the update if the From setup is the same as the To
setup, select Unselect Records where From equals To.

To Specify Setup Types for Routing Steps
You must specify which setup types are associated with which routing operations. 

Note: You cannot mark both principal and other resources as sequence 
dependent.

1. Select the Manufacturing and Distribution Manager responsibility.

2. Navigate to Bills of Materials > Routings > Routings.

3. In the Routings window, select an operation in a routing.

4. Click Operation Resources.

5. In the Operation Resources window, on the Scheduling tab, enter the setup type in 
the Setup Type field.
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To Enable Instance-level Scheduling
If a resource has more than one unit, you must specify the resource instances and enable
instance-level scheduling for the resource.

Note: Instance level scheduling is relevant only for sequence dependent
setup resources. Instance level scheduling is not supported in 
Advanced Supply Chain Planning for non-sequence dependent setup 
resources.

1. Select the Manufacturing and Distribution Manager responsibility.

2. Navigate to Bills of Materials > Routings > Departments.

3. In the Departments window, click Resources.

4. In the Resources window, select Schedule by Instance for each sequence dependent 
setup resource.

To Specify Initial Resource State
You can specify the initial setup state of each sequence dependent setup resource. The 
initial setup state determines whether the first activity scheduled on the resource 
requires a changeover.

1. Select the Advanced Supply Chain Planner responsibility.

2. Navigate to Collections > View Collected Data > Resources.

3. In the Resources window, click Instances.

4. In the Resource Instances window, specify the initial setup for each resource 
instance.

To Specify Sequencing Window Sizes
For each sequence dependent setup resource, you must specify the time required to 
cycle through all setup types. The system uses this value to estimate setup cycle lengths.

1. Select the Manufacturing and Distribution Manager responsibility.

2. Navigate to Bill of Materials > Department > Departments.

3. In the Resources window, click the Planning tab.

4. For each resource, enter the number of days to cycle through all setup types.
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Sequence Dependent Setups for Process Manufacturing
You can specify sequence dependent setup data for process manufacturing in Oracle 
manufacturing models and run collections to populate the data in Oracle Advanced 
Supply Chain Planning. To specify sequence dependent setup data for process 
manufacturing, you must:

• Classify items as sequence dependent.

• Specify changeover times and penalties.

• Specify resources with sequence dependent setup.

• Specify sequencing window sizes.

To Classify Items as Sequence Dependent
To classify items with sequence dependent setups you must assign the item to a 
category in the Sequence Dependency Class category set. For more information on 
assigning an item to a category set, see Assigning Items to Categories, Oracle Inventory 
User's Guide.

To Specify Changeover Times and Penalties
In Oracle Process Manufacturing, you must specify changeover times and penalties 
between Operation and Item class combinations. When this data is collected into the 
planning server, it becomes Setup Types and appears in the planner workbench.

1. Select the Oracle Process Manufacturing responsibility.

2. Navigate to Process Planning > Scheduling > Setup > Sequence Dependent Setup.

3. In the Sequence Dependent Setup window, specify setup times and penalties for 
operation and item class combinations.

The item classes that are displayed are the ones defined under the category set of 
Sequence Dependency Class.

To Specify Resources with Sequence Dependent Setups
Resources used in sequence dependent setup operations are scheduled as sequence 
dependent setup resources in Oracle Advanced Supply Chain Planning. Only the 
principal resource is scheduled as a sequence dependent setup resource. Simultaneous 
resources are not considered to have sequence dependent setups. 

1. Select Oracle Process Manufacturing responsibility.

2. Navigate to Process Engineer > Process Operations.



9-70    Oracle Advanced Supply Chain Planning Implementation and User's Guide

3. In the Process Operation Details: Activities window, select the Sequence 
Dependency option for sequence dependent resources.

To Specify Sequencing Window Sizes
For each sequence dependent resource enter the value of the sequencing window in 
days. the planning engine uses this value to estimate the time required to cycle once 
through all possible setup types.

If you do not specify a sequencing window for a resource, the planning engine uses the 
number of days specified by the MSO: Default Resource Sequencing Window (Days).

1. Select the Oracle Process Manufacturing responsibility.

2. Navigate to Process Engineer > Setup > Plant Resources.

3. Enter the sequencing window (SDS window) for each sequence dependent 
resource.

Planning with Sequence Dependent Setups
After setting up data in your discrete or process manufacturing system and collecting 
the data into Oracle Advanced Supply Chain Planning, you must set plan and profile 
options that control sequence dependent scheduling.

There are two values that you must specify:

• Activity selection window: the number of days from which activities can be chosen 
for scheduling.

• Resource sequencing window: the number of days to find another activity, or set of 
activities, of the same setup type to slot this activity along with. 

This value can be specified for each resource or specified as a default value from the
profile option.

This diagram illustrates that when Oracle Advanced Supply Planning schedules 
sequence dependent activities, the planning engine first chooses an unscheduled 
activity from the activity window. From this group of activities, the planning engine 
chooses an activity that best fits with the activities that are already scheduled so that a 
new changeover can be avoided.
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Selecting Activities

After choosing the activity, the planning engine looks for another activity with the same
setup type in the resource sequencing window. The window ends at the latest possible 
time for running the activity and filling the demand. The activity is then scheduled at a 
time that best balances the objectives of minimizing changeovers and minimizing 
demand lateness.

The length of the resource sequencing window affects the length of the cycle for each 
setup type. The larger the resource sequencing window, the longer the time spent by 
the resource on each setup type before changing to another setup type. Making the 
resource sequencing window too large might result in demand priorities not being fully
respected while scheduling,

While this example refers to "backward" scheduling, the same principle applies when 
forward scheduling when demands are late.

To Plan with Sequence Dependent Setups
1. Navigate to Supply Chain Plan > Options > Constraints tab and set the following 

plan options:

• Sequence Dependent Setups: set this option to Yes for every planning bucket 
that you want to consider sequence dependent setups. 

Note: You need to set this to Yes in earlier planning buckets in 
order to be able to set this to Yes in later buckets.

• Demand Lateness Penalty: (Optional) Specify a demand lateness penalty.

2. Set the following profile options:

• MSO: Activity Selection Window (Days)

• MSO: Default Resource Sequencing Window (Days)
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• MSO: Maximum Demands per Group for Advanced Scheduling

• MSO: Use Sequencing Template

• MSO: Setup Pattern Calculation Window

• MSO: Alternate Resource Selection Method

• MSO: Penalty Basis for Changeovers

For more information on profile options, see Profile Options, page A-1

Viewing Changeover Times and Preferred Sequence
You can view the changeover times and the preferred activity sequence determined by 
Oracle Advanced Supply Chain Planning (ASCP) by using the ASCP Changeover Times
screen. Changeover times are adjusted when necessary to ensure that the planning 
engine does not recommend interim unused setups. For example, on a paint machine, 
you might specify that it takes:

• Two hours to change a machine from white paint to cream paint.

• Two hours to change from cream paint to yellow paint.

• Five hours to change from white paint to yellow paint.

In this case, it appears that the quickest way to change the machine from white paint to 
yellow paint is to change from white paint to cream paint, and then from cream paint to
yellow paint. To prevent this problem, the system calculates an adjusted changeover 
time for the white to yellow paint changeover that equals the sum of the first two 
changeover times: four hours. The value of five hours will appear in the Original 
Changeover Times column within the Changeover Times screen. To ensure that ASCP 
does not perform these types of adjustments to the changeover times, your entries 
should respect the following rule: Changeover (A to B) < Changeover (A to X) + 
Changeover (X to B) for any setup types A, B, X on the resource.

To View Changeover Times and Preferred Sequences
1. Select the Advanced Supply Chain Planner responsibility.

2. Navigate to Supply Chain Plan > Workbench.

3. Right-click a plan and choose Resources > Resources from the menu.

4. Select a resource and click Changeovers.

The Changeover Times screen shows the preferred activity sequence. The preferred 
sequence is represented by the ascending order of the Setup Ring Sequence Number. 
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Changeovers at the bottom of the screen are not part of the preferred sequence, when 
the records are sorted on setup ring sequence number, and are avoided as much as 
possible.

Viewing Plan Results
You can view results using sequence dependent setups in the horizontal plan and in the
Gantt chart.

These row types are available on the horizontal plan:

• Setup Hours

• Setup Hour Ratio = Setup Hours / Available Hours

• Run Hours

• Run Hour Ration = Run Hours / Available Hours

The setup hours include both sequence dependent hours and fixed setups. These 
resource requirements can be distinguished by the fact that the schedule flag will be 
Prior.

A changeover canspan a break even if profile option MSO: Schedule Across Breaks is 
No or rven if the Oracle Process Manufacturing activity is breakable. 

For more information on the Gantt chart, see Interactive Scheduling Using the Gantt 
Chart, page 18-159

To View Plan Results
1. Select the Advanced Supply Chain Planner responsibility.

2. Navigate to Supply Chain Plan > Workbench.

3. Right-click a resource and choose a horizontal plan from the menu.

Planned Inventory Points
One of the major functions of production control is to release work to the shop floor and
monitor its progress. Once you release the work to the shop floor, the normal path is to 
complete the work as planned. If the demand pegged to the work being performed 
disappears, you may end up with excess supply. In some manufacturing environments, 
work can be stopped right after you realize that the demand no longer exists. However, 
work cannot be always stopped after demand cancellations due to practical reasons. 
The most important reasons are the possibility of loosing materials to scrap, needing to 
reprocess some of the steps at enormous cost, and the need to control the production 
process and corresponding yields. It is not desirable to leave the discrete jobs on the 
floor for excessive amount of time as it adds to confusion, occupies precious space, and 
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increases work in process value. Therefore, the need is to continue processing until the 
product reaches a stage in the Bills of Material where it can be safely stored until the 
next demand comes along. These stages in the Bills of Material can be visualized as 
major staging or stocking points. These stages will be referred to as Planned Inventory 
Points (PIPs).

The following are some examples of work that cannot be stopped for various reasons: 

• In semiconductor manufacturing, if wafers are left alone for a long period of time 
after they are processed in the furnace, they oxidize and run the risk of being 
scrapped. 

• In certain semiconductor fabrication processes such as Ion Implantation, Diffusion, 
and Photo Lithography, acid clean activity is involved. If you leave the parts alone 
for a long time after they are acid cleaned, they have to be recleaned before they are 
passed on to the next process. 

• In semi-conductor operations, between fabrication and testing, a critical closed loop 
exists to measure performance and adjust production processes based on tests. 
There is a need to provide timely test results and act on corrective actions. If work 
orders spend too much time without generating results, it affects process control 
and yields.

• In Consumer Product Goods manufacturing, bottling fluids such as food 
supplements need to happen after certain number of hours following an extraction 
and condensation process. If you fail to bottle within a specified amount of time, 
you will have to destroy the product as it will not be suitable for consumption. 

The following list summarizes some of ways in which PIP functions: 

• Tries to allocate supplies that are not pegged to a demand to a different sales order 
or a forecast

• Recognizes an item attribute called Planned Inventory Point

• Continues to process the work until you reach a PIP even if the demand driving the 
supply in work in process does not materialize

• Works on the jobs that are not pegged to a demand at a much slower pace than the 
jobs that are satisfying other valid demands

PIP Capability
This section contains examples of how the PIP features work.

Specify Inventory Point at Item Level
You can specify if the item can be stocked by specifying it as an Inventory Point. You 
choose the PIP Attribute for an item at Item-Organization level. 
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If you designate the item as an Inventory Point item, it suggests that the material can be 
stored at this item level without the fear of loosing the materials or loosing quality 
characteristics of the materials. PIPs generally point to major stocking phases in 
manufacturing cycle. 

Move Jobs to PIP Level
If you have an existing job and it does not have any demands to peg to, you can move 
the job to the next PIP level. For example, the figure below shows a BOM, where item Z 
is a purchased item that gets processed to become item A. It goes through several stages
of manufacturing, changing the item number several items as mentioned on the BOM. 

Assume that you have demand for item A, you have purchased item Z, and are 
working on creating item D using a discrete job. If for some reason, the end demand for 
A disappears, you can continue scheduling the discrete job for D instead of 
recommending a cancellation. You can allocate the discrete job to other valid demands 
(sales orders, forecasts, order modifiers) if they exist. Please note that allocating 
unconsumed supplies to other valid demands is the standard Oracle APS behavior. 

Bill with Inventory Point

Once you start a job, your goal is to reach the next Inventory Point, that is (referring to 
the previous figure), you need to generate and schedule orders for items C and B. If you
fail to do so, you run the risk of scrapping or reworking the discrete job for item D. This 
means that you would have to introduce fictitious demand at a PIP so that the system 
would generate and schedule planned orders for item C and B.

Order Modifiers and Planned Inventory Points
If the item at the PIP has an order modifier, you can add demand at the PIP that honors 
the order modifiers. In the previous example, you have a Discrete Job for 15 units at 
item D, you do not have a committed end demand for it, and item B has an the 
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following order modifier: the Minimum Order Quantity is set to 30 units. For this 
example, Oracle APS will add a fictitious demand of 30 units for Item B, which is a PIP. 
If you have order modifiers for an item, you will have excess supplies, and therefore, 
you can expect excess supplies at lower levels in the Bills of Material. 

Addition of Fictitious Demand
Oracle APS adds the necessary amount of fictitious demand so that the jobs and 
planned orders are scheduled with their normal lead-times (cumulative lead-time). If 
orders need to be created at different levels (items), the cumulative lead-times are 
added for all such items. If the lead-times for item Z and D are 4 and 3 days 
respectively, the fictitious demand is added 7 days from the due date of the job 
assuming that the job is for item D. 

Pegged Jobs at Different Levels on the BOM
You may have jobs opened at two or more levels that peg to each other. In such cases, 
the amount of fictitious demand added is equal to the maximum quantity of the jobs 
that needs to be moved to PIPs. The fictitious demand is not just a sum total of all the 
open unpegged jobs. For example, using 'Figure Bill with Inventory Point, page 9-75 as 
a template, you could have two jobs pegged to each other: a job for item D for 10 units 
and a job for item C for 5 units. If there is a cancellation of end item demand from item 
A, the fictitious demand would be for 10 units. This means there would be extra 
supplies (planned orders) created at item C for 5 units. You can analyze item excess 
exceptions to figure out any excess.

On-Hand Quantities
On-hand quantities for items below a PIP may affect the logic of moving unpegged jobs 
to a PIP. Assume that you have 10 units on hand for Item C and you have an unpegged 
job for Item D for 5 units. The normal logic for PIP is to add 5 units of fictitious demand 
at Item B, which is the next PIP. Because 5 units of fictitious demand is smaller than the 
10 units that are on-hand at Item C, you will not be able to pass the demand to the job at
Item D. This affects the movement of the job to the next PIP.

Oracle APS assumes that you will issue any on- hand material present at levels below a 
PIP to jobs at higher levels. This is logical as you do not want to have any inventories 
sitting below a PIP.

It is possible to have multiple Inventory Points in a BOM as shown in the next diagram:
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Bill with Multiple Inventory Points

If you have a job started at item Z and loose the demand, Oracle APS generates and 
schedules orders to reach Item D including item D. If you have started a discrete job for 
item C and loose the end demand, Oracle APS generates and schedules orders to reach 
item B including item B. 

Job Properties: Firm and Status 
PIP logic schedules jobs to the next PIP even without a valid demand for it instead of 
canceling it. The idea is to reach a point in the bill of materials where materials could be 
stored without the fear of loosing them. Firm jobs are also scheduled similar to non-firm
jobs in order to aid the process of scheduling materials to reach a PIP.

Firm jobs by nature are not open to rescheduling; hence, any scheduling of higher level 
items to reach the next PIP need to work around the scheduling that is done for firm 
jobs. For example, you might have a firm job for item Z due on day 25 and the demand 
that the firm job was pegged to does not materialize. This leaves you with the task of 
moving materials being processed by the firm job to the next PIP. Because you cannot 
change the scheduling already done for firm job, you must work around the firm job 
schedule. The planned order generated for item D to help the process of moving 
materials from firm job to the next PIP is scheduled such that it starts on D25. If item D 
has a lead-time of 5 days, the planned order start for item C is scheduled on D30.

Oracle ASCP treats jobs with statuses of Released and Unreleased in the same manner. 
Jobs with both these statuses are subject to rescheduling to aid the process of scheduling
materials to reach the next PIP. 
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Generate PIP Orders Exception 
Scheduling of jobs even after cancellation of committed demand is an exception 
condition. In the application, you can see scheduling of such orders as exceptions. The 
exception Orders Moved to Next PIP Level is generated for each order moved to the 
next PIP. Please note that this exception is created only for orders that are completely 
pegged to the fictitious demand. 

Using PIP
The following procedures show how to use PIP.

To specify that an item should be treated as a PIP
1. Sign in using the Manufacturing and Distribution Manager responsibility.

2. From the Navigator, select Inventory > Items > Master Items.

The Master Item screen appears.

3. Define an item and specify the item attributes. 

4. Select the MPS/MRP Planning tab.

5. Select the Planned Inventory Point checkbox.

6. Save your work.

To choose a plan level option to enable PIP
1. Sign in using the Advanced Supply Chain Planner responsibility.

2. From the Navigator, select Supply Chain Plan > Names. 

The SCP Names screen appears.

3. Define a plan name. 

4. Select the Options button.

The Plan Options screen appears. 

5. Select the Move Jobs to PIP checkbox. 

By checking this checkbox, if you have discrete jobs, lot-based jobs or nonstandard 
jobs with no end demand, Oracle APS will create and schedule supplies for all 
items between the item which has discrete jobs and the Planned Inventory Point.

6. Save your work.



Supply Chain Constraint-Based Planning    9-79

7. After completing Steps A and B, run the plan.

To review and analyze scheduling of orders
1. Sign in using the Advanced Supply Chain Planner responsibility.

2. From the Navigator, select Supply Chain Plan > Workbench.

The Planner Workbench appears.

3. Access either the Resource Requirement window or the Gantt chart to review 
scheduling for the supply. See steps D and E below.

To access the Resource Requirement window
1. From the Planner Workbench, select a plan and an item.

2. Select the item and select Supply from the Tools menu.

The Supply window appears.

3. Select and item, then right click and select Resource Requirements.

The Resource Requirements screen appears.

4. Review scheduling for the supply.

To access the Gantt Chart
1. From the Planner Workbench, select a plan and an item.

2. Select Supply/Demand from the Tools menu.

The Supply/Demand window appears.

3. Select an item, then right click and select Gantt chart.

The Gantt chart appears.

4. Review scheduling for the supply.

To analyze exceptions
1. Sign in using the Advanced Supply Chain Planner responsibility.

2. From the Navigator, select Supply Chain Plan > Workbench.

The Planner Workbench appears.

3. Select a plan and then select the Actions tab on the right pane.

A list of action types appears.
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4. Double-click Reschedules (this is a type of exception summary). 

A list of exceptions appears.

5. Select Orders scheduled to next inventory point.

The Exception Details screen appears.

6. Review the exceptions.
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10
Supply Chain Plan Configure to Order

This chapter covers the following topics:

• Configure to Order Models

• Configure to Order Multi-organization Models

• Configure to Order Sales Orders

• Configure to Order Order Promising

• Configure to Order Forecast Control

• Configure to Order Forecast Explosion

• Configure to Order Multi-organization Forecast Explosion

• Configure to Order Forecast Consumption

• Configure to Order Multi-organization Forecast Consumption

• Configure to Order Collections

• Configure to Order Planning Process

Configure to Order Models
A model is an item with some configurable components. A configurable component is a
component that different customers may order differently, for example, a color of paint.

There are these types of models:

• Assemble-to-order: The manufacturer or distributor assembles the components and 
ships the configured item, for example, an automobile.

• Pick-to-order: The components are shipped separately and assembled by the 
recipient, for example, a childrens' outdoor play set. Oracle Advanced Supply 
Chain Planning uses the pick-to-order model item for forecast explosion; it does not
plan it.
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The components of a model are: 

• Option classes: A bill of material structure whose components are the options that 
the customer can select, for example, paint color.

• Standard items: The options from which the customer chooses, for example, red, 
green, and blue. They are components of the option classes.

• Included items (also known as mandatory components): A standard item that the 
customer receives regardless of options selected, for example, an instruction 
brochure. They are components of the model item.

• Another model: For example, a personal computer. The customer chooses the main 
components and the manufacturer assembles them into a case (assemble-to-order). 
The customer also chooses peripheral items that the manufacturer or distributor 
ships separately from the main unit and that the recipient attaches to the main unit. 
The personal computer is a pick-to-order model, the main unit is an 
assemble-to-order model component under the pick-to-order model, and the 
peripherals are option class components under the pick-to-order model.

Oracle does not recommend placing an assemble-to-order model as a member of a 
product family.

The following table illustrates a model bill for Laptop Computer, a model that includes 
two mandatory components and three option classes. The planning percent assigned to 
optional option classes represents anticipated demand for the option class. In this 
example, 90% of Laptop Computers are expected to be sold with an operating system, 
and the remaining 10% are expected to be sold without.

Level Item BOM Item Type Optional Planning % 

. 2 . Laptop Computer Model No 60% 

. . 3 . . Carrying Case Standard No 100% 

. . 3 . . Keyboard Standard No 100% 

. . 3 . . CPU Option Class No 100% 

. . 3 . . Monitor Option Class No 100% 

. . 3 . . Operating System Option Class Yes 90% 

Option Class Bills

The following example illustrates the option class bills for the Monitor, VGA, and EGA 



Supply Chain Plan Configure to Order    10-3

option classes. The planning percent assigned to each option within each option class 
represents anticipated demand for the option. In this example, 70% of all Laptop 
Computers are expected to be sold with a VGA monitor, and the remaining 30% are 
expected to be sold with an EGA monitor. Notice that the Monitor option class is not 
optional. This means that customers must always choose one of the Monitor options 
when ordering Laptop Computer. Of the 70% of Laptop Computers sold with a VGA 
monitor, 50% are expected to be sold with the VGA1 monitor and 50% are expected to 
be sold with the VGA2 monitor. The VGA option class also includes a mandatory 
component, VGA Manual, that is always shipped with Laptop Computer if the VGA 
monitor option class is chosen, regardless of the VGA option.

Level Item BOM Item Type Optional Planning %

. . 3 . . Monitor Option Class No 100%

. . . 4 . . . VGA Option Class Yes 70%

. . . . 5 . . . . VGA Manual Standard No 100%

. . . . 5 . . . . VGA1 Standard Yes 50%

. . . . 5 . . . . VGA2 Standard Yes 50%

. . . 4 . . . EGA Option Class Yes 30%

. . . . 5 . . . . EGA1 Standard No 55%

. . . . 5 . . . . EGA2 Standard Yes 45%

Forecasting Predefined Configurations

Predefined configurations are configurations that you have defined as standard items, 
with standard bills and standard routings. You might define a predefined configuration
because you often use the configuration in sales promotions, or the configuration is one 
of your most commonly ordered configurations, and you want to build it to stock to 
reduce delivery lead times and improve customer service levels. Your customers can 
order predefined configurations by item number, just as they order any other standard 
item. 

Forecast consumption, forecast explosion, master scheduling, planning, production 
relief, and shipment relief for predefined configurations behave as they do for any other
standard item. 
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Configure to Order Multi-organization Models
There are several assemble-to-order model structure types:

• Single Level Single Organization (SLSO): A single level model in which the 
components are standard items.

• Multi level Single Organization (MLSO): An assemble-to-order model with one or 
more assemble-to-order models as components.

• Multi-Level Multi-Organization (MLMO): An assemble-to-order model with one or 
more assemble-to-order models as components and some lower-level models are 
transferred from organizations. If you have multi-organization models you must 
use global forecasting for forecast consumption to be correct. To conduct global 
forecasting, you must use Oracle Demand Planning. See Global Forecasting, page 5-
107.

If a model in an organization can be sourced from another organization, the sourcing 
rule needs to be set up. Sourcing rule at the model level means that all configurations 
derived from that model will be manufactured in the sourcing organization and finally 
be shipped in the shipping organization.

Configure to Order Sales Orders
Configuring an order is the process of selecting options against a model item. You can 
configure your orders using Oracle Configurator and Oracle Order Management CTO 
Workbench. Regardless of the organization from which you want to ship the orders, 
you can source the configuration in your source organizations. 

Later in the sales order processing, concurrent process Auto-create Configuration 
creates a unique configured item for each configured model based on your selection at 
order entry. Configured items are standard items that have as their components the 
options selected for the particular order and the included items. The configured items 
replace the model item on the sales order.

Your sales order workflow must progress the order to create the configuration item at 
the point that you want this demand to be visible to planning. The order does not need 
to be booked, but the configured item must be linked to the order.

Use the assignment set specified in profile option MRP: Default Sourcing Assignment as
the assignment set in the plan options. This is because if the models are sourced, Oracle 
Order Management selects sources for configurations for ATP purposes and it uses the 
assignment set from this profile option. If the plan uses an assignment set that is 
different than the one mentioned in this profile option, you run the risk of inconsistent 
sources.

See Call CTO Workbench, Choosing Options Using the Oracle Configurator, and 
Configuration Date Effectivity in Oracle Order Management User's Guide.
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Configure to Order Order Promising
You can use Oracle Advanced Supply Chain Planning and plans with Oracle Global 
Order Promising to quote configure-to-order promise dates for your customers. Oracle 
Advanced Planning and Scheduling automatically places sales order demands for 
configurations, evaluates the best possible promise dates, and schedules supplies.

Set profile option INV: Capable to Promise to ATP/CTP Based on Planning Output to 
perform order promising.

See "Multi-Level Supply Chain ATP" and "Functional Setup for ATP Based on Planning 
Output". Also see "Global Order Promising for ATO Configurations" in Oracle Order 
Management User's Guide.

Configure to Order Forecast Control
Use item attribute Forecast Control to specify the types of demand that you place for 
models, option classes, options, and mandatory components. The configure to order 
processes uses the Forecast Control value that you assign to each assemble-to-order and
pick-to-order item to guide the behavior of those processes.

The following section discusses the four types of demand that you can place for an item,
and identifies the appropriate Forecast Control attribute value for each type of demand.

Choosing a Value for Forecast Control
There are the types of demand that you can place for your models, option classes, 
options, and mandatory components: 

• Independent forecast demand 

• Exploded forecast demand 

• Sales order demand 

• Derived sales order demand 

Independent Forecast Demand 

Independent forecast demand is demand that you place for an item by entering 
forecasts for the item directly, rather than exploding forecast to the item using forecast 
explosion. You typically define direct forecasts for items, such as a planning items or 
models, whose demand is independent of any other item. Define direct forecasts by 
entering them manually, or by loading them from other products or systems. 

If you forecast demand directly for an item, then set Forecast Control to Consume. 

Exploded Forecast Demand 
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Exploded forecast demand is demand that you generate for an item when you explode 
forecasts to the item using forecast explosion. You typically generate exploded forecast 
demand for items, such as option classes and options, whose demand is directly related 
to or derived from the bill of material structure for other items. 

If you forecast demand for an item by exploding demand from a higher level item in a 
bill of material, set Forecast Control to Consume and Derive. 

In some cases, you may have items that are subject to both types of forecast demand. 
For example, the keyboard that is forecast and sold as a mandatory component with a 
Laptop Computer may also be forecast and sold separately as a spare or service part. 

You use Forecast Control to control which models, option classes, options, and 
mandatory components in a model bill receive exploded forecasts, since forecast 
explosion only generates exploded forecast demand for items where you have set 
Forecast Control to Consume and Derive. 

Important: Set Forecast Control to None to identify items that have 
dependent demand that should be calculated by the planning process, 
using standard planning logic, rather than through forecast explosion. 
An example of this type of item is a user manual that is either 
gross-to-net or minmax planned and replenished.

If you forecast demand for an item directly, and explode forecast demand to the item, 
set Forecast Control to Consume and Derive. 

Sales Order Demand

Sales order demand is demand that you place when your customers order 
configurations. As your customers order configurations, Oracle Order Management 
automatically places sales order demand for each model, option class, and option 
selected by your customer when they place the order. 

If you place sales order demand for an item, but do not forecast the item, set Forecast 
Control to None. 

Derived Sales Order Demand 

Under normal circumstances, Oracle Order Management does not place sales order 
demand for mandatory components when your customers order configurations. If you 
are forecasting key mandatory components, however, you will usually want to 
maintain your forecasts by generating sales order demand for the mandatory 
components and consuming the forecasts as your customers place sales orders. 

You can set the Forecast Control attribute to Consume or Consume and Derive to 
automatically place demand and consume forecasts for mandatory components when 
you place sales orders demand for configurations that include the mandatory 
components. 

If you forecast demand for a mandatory component, either directly or through forecast 
explosion, set Forecast Control to Consume or Consume and Derive. 
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Summary 

The following table summarizes, for each type of item, the types of demand that 
configure to order assumes you place for different values of Forecast Control. 

Item Type Forecast 
Control

Forecast Expl
oded 
Forec
ast

Exploded
Sales 
Order

Derived Sales 
Order

Models and Option 
Classes 

Consume Yes - Yes -

Models and Option 
Classes 

Consume and
Derive 

Yes Yes Yes -

Option Consume Yes - Yes -

Option Consume and
Derive 

Yes Yes Yes -

Option None - - -

Mandatory 
Component

Consume Yes - - Yes 

Mandatory 
Component

Consume and
Derive 

Yes Yes - Yes 

Mandatory 
Component

None - -

Product Family Consume Yes - - Yes 

Product Family Consume and
Derive 

Yes - - Yes 

Configure to Order Forecast Explosion
You can use the Bills of Material window in Oracle Bills of Material to define model and
option class bills with multiple levels of option classes, options, and mandatory 
components to represent your complex configure-to-order products. You can then use 
forecast explosion to explode model and option class forecasts the same way you 
explode forecasts for planning items. 
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The logic for exploding models and option classes is the same as the logic used to 
explode planning items. You can choose to explode model and option class forecasts, 
just as you can choose to explode planning item forecasts when loading forecasts into 
other forecasts or master schedules. 

The following diagram illustrates the forecast explosion logic. 

Exploding Forecasts from Using Assemblies

The following table illustrates when forecast explosion explodes forecast from a parent 
item to its components. 'Always' means 'Always explode forecasts from this item', and 
'Never' means 'Never explode forecasts from this item.' 

Planning 
Item 

ATO 
Model 

ATO 
Option 
Class 

ATO 
Std. Item

PTO 
Model 

PTO 
Option 
Class 

PTO 
Std. 
Item 

Std. Item 

Always Always Always Never Always Always Always Never 

Exploding Forecasts to Components

The following table illustrates when forecast explosion explodes forecast to a 
component from its parent item. 'Always' means 'Always explode forecasts from this 
item', 'Check' means 'Explode forecasts to this item if Forecast Control is set to Consume 
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and Derive', and 'Never' means 'Never explode forecasts from this item.' 

Product 
Family 

Planning 
Item 

ATO 
Model 

ATO 
Option 
Class 

ATO 
Std. 
Item 

PTO 
Model 

PTO 
Option 
Class 

PTO 
Std. 
Item 

Std. 
Item 

Check Check Check Check Check Check Check Check Check 

Forecast Explosion Example 

The following table illustrates how forecast explosion explodes a forecast for 100 Laptop
Computers. The FC column shows forecast quantities. 

Level Item BOM Item 
Type 

Forecast 
Control 

Optional Plan % FC 

. 2 . Laptop 
Computer 

Model Consume No 100 

. . 3 . . Carrying 
Case 

Standard Consume 
and Derive 

No 100% 100 

. . 3 . . Keyboard Standard Consume 
and Derive 

No 100% 100 

. . 3 . . CPU Option 
Class 

Consume 
and Derive 

No 100% 100 

. . . 4 . . . 386 
Processor 

Standard Consume 
and Derive 

Yes 65% 65 

. . . 4 . . . 486 
Processor 

Standard Consume 
and Derive 

Yes 35% 35 

Configure to Order Multi-organization Forecast Explosion
See Forecast Explosion, page 5-103.

You can create and maintain forecasts for any item at any level in the model bill of 
material

For single organization models, you can maintain and explode forecasts either in the 
source instance or in Oracle Demand Planning. For multiple organization models, you 
can use Oracle Demand Planning and Oracle Demantra.
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• With Oracle Demand Planning, you maintain model forecasts and planning 
percentages and explode the model forecasts in Oracle Demand Planning. The 
exploded results pass to Oracle Advanced Supply Chain Planning. 

• With Oracle Demantra, you maintain model forecasts and time-phased planning 
percentages in Oracle Demantra and explode the model forecasts using Oracle 
Advanced Supply Chain Planning inline forecast explosion process. Set item 
attribute Forecast Control to Consume and derive and set plan option Explode 
Forecast to Yes

If you are forecasting single organization models in the source instance, Oracle 
recommends that you consider exploding your forecasts using Oracle Advanced Supply
Chain Planning inline forecast explosion process (Form Plan Option > tab Main > field 
Explode Forecast). It is more efficient and reduces the load on your source instance 
concurrent process Planning Manager load.

Multilevel ATO Example
This diagram shows a multi-level supply chain bill of materials.
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Supply Chain Bill

Please refer to the legends on the figure for an explanation of item types. Sourcing 
relationships are shown in dotted lines and the BOM relationship are shown in 
continuous lines. You can find the item names within each of the nodes. The item name 
is followed by a two-letter code to identify the organizations.

CMP mainframe has four configurable assemblies (ATO models): PCI module, Dual 
Pod Enclosure, Sub Prod 32, and Sub Prod 64. The company sells CMP mainframes 
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from shipping organizations in Boston, USA and Singapore. It has manufacturing sites 
in Hong Kong SAR, China; Mexico City, Mexico; and Boston, USA. CMP mainframes 
are assembled in Boston and Hong Kong. The PCI module is manufactured and sourced
at the Mexico City facility. Dual Pod Enclosures are manufactured and sourced at Hong 
Kong along with the components Sub prod32 and Sub prod64. Optional items CD 
ROMs, DAT Drives, and Tape Drives can be sold as spares from either Boston or Hong 
Kong.

Forecasts maintained for CMP mainframe at the Hong Kong organization can be 
exploded down to its models, sub-models, option classes, options and mandatory 
components within the Hong Kong organization as independent demand.

Console, Pdevices, PCI Module, Dual Pod Enclosure, Sub Prod OC, Sub Prod 32, Sub 
Prod 64, PTN32-1MB, etc. have exploded forecasts. Independent forecasts maintained 
for CD-ROM, DAT Drv, Tape Drv can be consolidated with the exploded forecasts from
its parents. 

Similarly, any independent forecasts maintained for Sub Prod 32 or Sub Prod 64 can be 
consolidated with the exploded forecasts from its parents and exploded to its 
component forecasts.

Configure to Order Forecast Consumption
Forecast consumption is the process that replaces forecast demand with sales order 
demand. Each time you place a sales order, you create actual demand. If the actual 
demand is forecasted, you typically want to reduce the forecast demand by the sales 
order quantity to avoid overstating demand. 

For source instance forecasts, the consumption occurs against forecasts for product 
families, configurations, models, option classes, and options when you place sales order
demand for configurations. By default, forecast consumption consumes forecasts by 
item.

If you want to consume your forecasts by distribution channel, customer type, or order 
type, use demand classes to control forecast consumption. You can also choose to 
consume your forecasts by one of the following forecast consumption levels: 

• Item 

• Customer 

• Customer bill-to address 

• Customer ship-to address 

With inline forecast consumption, toe consumption occurs at the beginning of the 
planning run, using the forecasts and sales orders that you use to drive the plan.
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Consumption of Models
Forecast consumption takes place both before and after the AutoCreate Configuration 
process creates a configuration item, bill, and routing for a configuration. The configure 
to order process ensures that forecast consumption is consistent before and after the 
creation of the configuration item. 

Note: The fact that forecast consumption takes place twice, both before 
and after the creation of the configuration item, is transparent to the 
user. The purpose of this section is only to provide detailed 
information.

Forecast Consumption: Before AutoCreate Configuration
When your customers order configurations, Oracle Order Management places sales 
order demand for all ordered models, option classes, and options. 

Note: Under normal circumstances, no sales order demand is placed for
mandatory components. You can also generate derived sales order 
demand for selected mandatory components, since forecast 
consumption generates derived sales order demand for all items where 
you have set Forecast Control to Consume or Consume and Derive. This 
lets you define and maintain forecasts for key mandatory components 
as well as models, option classes, and options.

Before you run the AutoCreate Configuration process, forecast consumption uses actual
sales order demand for models, option classes, options, and derived sales order demand
for selected mandatory components, to consume your forecasts. 

Example: Before AutoCreate Configuration

The following example illustrates how forecast consumption consumes an exploded 
forecast for 100 Laptop Computers when a customer places a sales order for 10 Laptop 
Computers with 486 processors, VGA1 monitors, and DOS operating system. The SO 
column shows sales order quantities. Notice that forecast consumption generates and 
consumes derived sales order demand for each mandatory component where you have 
set Forecast Control to Consume or Consume and Derive. 

Forecast Consumption (1 of 2)

Level Item BOM Item 
Type 

Forecast 
Control 

Optional Plan % FC/ SO 
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. 2 . Laptop 
Computer 

Model Consume     90 10 

. . 3 . . Carrying
Case 

Standard Consume 
and Derive 

No 100% 90 10 

. . 3 . . 
Keyboard 

Standard Consume 
and Derive 

No 100% 90 10 

Forecast Consumption (2 of 2)

Level Item BOM Item Forecast Optional Plan FC/ 

    Type Control   % SO 

. . 3 . . CPU Option 
Class 

Consume 
and Derive 

No 100% 90 10 

. . . 4 . . . 386 
Processor 

Standard Consume 
and Derive 

Yes 65% 65 

. . . 4 . . . 486 
Processor 

Standard Consume 
and Derive 

Yes 35% 25 10 

. . 3 . . Monitor Option 
Class 

Consume 
and Derive 

No 100% 90 10 

. . . 4 . . . VGA Option 
Class 

Consume 
and Derive 

Yes 70% 60 10 

. . . . 5 . . . . VGA 
Manual 

Standard Consume 
and Derive 

No 100% 60 10 

. . . . 5 . . . . VGA1 Standard Consume 
and Derive 

Yes 50% 25 10 

. . . . 5 . . . . VGA2 Standard Consume 
and Derive 

Yes 50% 35 

. . . 4 . . . EGA Option 
Class 

Consume 
and Derive 

Yes 30% 30 
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. . . . 5 . . . . EGA1 Standard Consume 
and Derive 

Yes 55% 16.5 

. . . . 5 . . . . EGA2 Standard Consume 
and Derive 

Yes 45% 13.5 

. . . 4 . . . Monitor
Manual 

Standard None No 100%  

. . 3 . . 
Operating 
System 

Option 
Class 

Consume 
and Derive 

Yes 90% 80 10 

. . . 4 . . DOS Standard Consume 
and Derive 

Yes 80% 62 10 

. . 4 . . UNIX Standard Consume 
and Derive 

Yes 20% 18 

Forecast Consumption: After AutoCreate Configuration 
The AutoCreate Configuration process replaces sales order demand for ordered models,
option classes, and options with sales order demand for the newly created 
configuration item. This prompts forecast consumption to unconsume forecasts for the 
models, option classes, options, and selected mandatory components, and consume 
forecasts for the new configuration item and its components. 

When creating the configuration item, the AutoCreate Configuration process also 
creates a single level bill of material for the configuration item. The single level bill 
includes all ordered options, all mandatory components of all ordered models and 
options classes, and each ordered model and option class. The models and option 
classes appear on the configuration bill as phantoms, and are only there to consume 
forecasts and relieve master schedules. They are not used by the planning process or 
Oracle Work in Process since all mandatory components from the model and option 
class bills are also included directly on the single level bill. 

The following table illustrates the single level configuration bill created by the 
AutoCreate Configuration process in response to the sales order for 10 Laptop 
Computers with 486 processors, VGA1 monitors, and DOS operating system. 

Single Level Bill for Laptop Configuration 

Level Item BOM Item Type Optional 
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1 Laptop Computer001 Standard No 

2 Laptop Computer Model No 

2 Carrying Case Standard No 

2 Keyboard Standard No 

2 CPU Option Class No 

2 486 Processor Standard No 

2 Monitor Option Class No 

2 VGA Option Class No 

2 VGA Manual Standard No 

2 VGA1 Standard No 

2 Monitor Manual Standard No 

2 Operating System Option Class No 

2 DOS Standard No 

In the post configuration stage, forecast consumption uses the sales order demand for 
the new configuration item to consume forecasts. Typically, you do not have any 
forecasts defined for unique configurations. Therefore, forecast consumption does not 
find any forecasts to consume. If forecast explosion cannot find any forecasts to 
consume, it explodes the configuration bill and consumes forecasts for each model and 
option class on the bill. It also consumes forecasts for each standard item on the 
configuration bill where Forecast Control is set to Consume or Consume and Derive. 

To ensure that forecast consumption is consistent before and after the AutoCreate 
Configuration process, forecast consumption only consumes forecasts for standard 
items on configuration bills where Forecast Control is set to Consume or Consume and 
Derive. 

Note: If you set Forecast Control to None for an option, and then define
forecasts for the option, you get inconsistent forecast consumption 
before and after the AutoCreate Configuration process. Before the 
AutoCreate Configuration process, forecast consumption uses actual 
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sales order demand to consume any existing forecasts. After the 
AutoCreate Configuration process, forecast consumption does not 
consume those same forecasts since it only consumes forecasts for 
standard items on configuration bills where Forecast Control is set to 
Consume or Consume and Derive. 

Example: After AutoCreate Configuration

The following table shows how forecast consumption consumes the exploded forecast 
for 100 Laptop Computers after the AutoCreate Configuration process replaces sales 
order demand for the model, option classes, and options with sales order demand for 
the newly created configuration item. 

Sales Order Demand for the Configuration Item

Level Item BOM Item 
Type 

Forecast 
Control 

Optional Plan % FC/ SO 

1 Laptop 
Computer0
01 

Standard Consume     10 

Forecast Consumption (1 of 2)

Level Item BOM Item 
Type 

Forecast 
Control 

Optional Plan % FC/ SO 

2 Laptop 
Computer 

Model Consume     90 

. 3 . Carrying 
Case 

Standard Consume 
and Derive 

No 100% 90 

Forecast Consumption (2 of 2)

Level Item BOM Item 
Type 

Forecast 
Control 

Optional Plan % FC/ SO 

. 3 . Keyboard Standard Consume 
and Derive 

No 100% 90 
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. 3 . CPU Option 
Class 

Consume 
and Derive 

No 100% 90 

. . 4 . . 386 
Processor 

Standard Consume 
and Derive 

Yes 65% 65 

. . 4 . . 486 
Processor 

Standard Consume 
and Derive 

Yes 35% 25 

. 3 . Monitor Option 
Class 

Consume 
and Derive 

No 100% 90 

. . 4 . . VGA Option 
Class 

Consume 
and Derive 

Yes 70% 60 

. . . . 5 . . . . VGA 
Manual 

Standard Consume 
and Derive 

No 100% 60 

. . . . 5 . . . . VGA1 Standard Consume 
and Derive 

Yes 50% 25 

. . . . 5 . . . . VGA2 Standard Consume 
and Derive 

Yes 50% 35 

. . . 4 . . . EGA Option 
Class 

Consume 
and Derive 

Yes 30% 30 

. . . . 5 . . . . EGA1 Standard Consume 
and Derive 

Yes 55% 16.5 

. . . . 5 . . . . EGA2 Standard Consume 
and Derive 

Yes 45% 13.5 

. . . 4 . . . Monitor
Manual 

Standard None No 100%  

. . 3 . . 
Operating 
System 

Option 
Class 

Consume 
and Derive 

Yes 90% 80 

. . . 4 . . . DOS Standard Consume 
and Derive 

Yes 80% 62 
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. . . 4 . . . UNIX Standard Consume 
and Derive 

Yes 20% 18 

Consumption of Predefined Configurations
Forecast consumption for predefined configurations is exactly the same as forecast 
consumption for configuration items created automatically from sales orders for ATO 
models. Typically, if you have created a predefined configuration, you have also 
defined forecasts for it. If so, forecast consumption finds and consumes forecasts for the 
predefined configuration. If you have not defined forecasts for the predefined 
configuration item, then forecast consumption explodes the configuration bill and 
consumes forecasts for each model and option class on the bill. It also consumes 
forecasts for each standard item on the configuration bill where Forecast Control is set 
to Consume or Consume and Derive. 

The following table illustrates a predefined configuration for a commonly ordered 
version of Laptop Computer called Laptop Basic. 

Predefined Configuration

Level Item BOM Item Type Optional 

1 Laptop Basic Standard No 

. 2 . Laptop Computer Model No 

. 2 . Carrying Case Standard No 

. 2 . Keyboard Standard No 

. 2 . CPU Option Class No 

. 2 . 486 Processor Standard No 

. 2 . Monitor Option Class No 

. 2 . VGA Option Class No 

. 2 . VGA Manual Standard No 

. 2 . VGA1 Standard No 
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. 2 . Monitor Manual Standard No 

. 2 . Operating System Option Class No 

. 2 . DOS Standard No 

The following table illustrates consumption of a forecast for 100 Laptop Basics after a 
customer places a sales order for 10 units. 

Forecast Consumption

Item Original Forecast Current Forecast

Laptop Basic 100 90

If you have not defined forecasts for the predefined configuration, forecast 
consumption explodes the configuration bill and consumes forecasts for each model 
and option class. Forecast consumption also consumes forecasts for each standard item 
on the configuration bill where Forecast Control is set to Consume or Consume and Derive
. 

The following table illustrates consumption of the same sales order for 10 Laptop Basics
when you have not defined a forecast for Laptop Basic. Note that the original forecast 
quantities for Laptop Basic's components have not been exploded from Laptop Basic, 
since you cannot explode forecasts from a standard item. Any forecasts that do exist for 
Laptop Basic's components must have been entered manually or exploded from a 
planning item, model, or option class forecast. This example assumes that Forecast 
Control is set to Consume or Consume and Derive for all standard components on Laptop 
Basic's configuration bill. 

Forecast Consumption

Item Original Forecast Current Forecast 

Laptop Computer 20 10 

Carrying Case 20 10 

Keyboard 20 10 

CPU 30 20 
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486 Processor 50 40 

Monitor 40 30 

VGA 40 20 

VGA Manual 50 40 

VGA1 20 10 

Monitor Manual 30 20 

Operating System 30 20 

DOS 30 20 

Configure to Order Multi-organization Forecast Consumption
If you have multi-organization models you must use global forecasting for forecast 
consumption to be correct. To conduct global forecasting, you must use Oracle Demand
Planning or Oracle Demantra.

The planning engine can perform inline forecast consumption both for Oracle Demand 
Planning forecasts, Oracle Demantra forecasts, and source instance forecasts in the same
plan run. However, you must use the same source to consume a configuration's forecast
and then consume any remaining sales order demand in the base assemble-to-order 
model.

When it consumes a forecast with a sales order for a top-level configuration, the forecast
consumption process may consume configured items at different levels. For example:

• The bill of material for model M1 contains model M2

• You create a sales order for model M1 for quantity 120

• After you create the configuration, the bill of material for configuration C*1 contains
configuration C*2 

• Configuration C*1 has a forecast of quantity 100

• Configuration C*2 has a forecast of quantity 50

• The forecast consumption process first consumes the C*1 forecast for quantity 100 
and then consumes the C*2 forecast for quantity 20
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• The C*1 forecast has current quantity 0 and the C*2 forecast has current quantity 30 

Configure to Order Collections
The data collection process collects sales order demand for configured and scheduled 
items; it does not collect sales order demand for models and option classes. The 
planning engine then schedules the configured item in the same way that it schedules 
standard items. 

Your sales order workflow must progress the order to create the unique configuration 
item at the point that you want this demand to be visible to planning. The order does 
not need to be booked, but the configured item must be linked to the order.

After the configuration item is created, you can run collections .See Overview of 
Running Collections for ASCP, page 4-1.

For example, you accept an order at the Singapore organization and select the following
options for your configuration: 

• CMP Main Frame, 

• CD-ROM,

• PTN32-2MB,

• 32TLC Add On,

• 5V Card;

After collections, you see a sales order line for the configuration item at the Singapore 
organization. You also see configuration items for each of the assemble-to-order models 
in your selection--CMP Main Frame, PCI Module, Dual Pod Enclosure, and Sub Prod 32
at Hong Kong. In addition, you see a configuration item for PCI Module at Mexico City.
You also see bills of material for each of the configuration items based on your selection.
The planning engine uses these to pass dependent demand to the components. Forecast 
consumption now reflects the configuration item instead of the model item.

This table represents the demand picture in planning after creating the Configuration 
Item. The configuration item is created for each ATO model shown as *1 appended to 
the item.

Item Org Type of Demand

CMP Main Frame*1 SG Sales Order

CMP Main Frame*1 HK Planned Order
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Item Org Type of Demand

Console HK Planned Order

CD-ROM HK Planned Order

PCI Module*1 HK Planned Order

PCI Module*1 MEX Planned Order

Cables MEX Planned Order

5V card MEX Planned Order

Compatibility Bridge MEX Planned Order

Dual Pod Enclosure*1 HK Planned Order

Power Supply HK Planned Order

Sub Prod 32*1 HK Planned Order

PTN-32 OC HK Planned Order

PTN32-2MB HK Planned Order

TLC1032 HK Planned Order

32TLC Add On HK Planned Order

Configure to Order Planning Process
After the configuration item is created, you have run collections, and you have run the 
plan, you see a sales order line for the configuration item at its shipping organization. 

For example, you accept an order at the Singapore organization and select the following
options for your configuration: 

• CMP Main Frame, 

• CD-ROM,

• PTN32-2MB,
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• 32TLC Add On,

• 5V Card;

The planning engine explodes the sub-models, option classes, optional items, and 
mandatory components as dependent demand from the Model so that it can schedule 
and reschedule their supplies as a unit. (For forecasts, it explodes this demand as 
independent demand.) The planning process further explodes the demand down from 
Standard Items and plans for components below if there are any.

The planning engine bases its material scheduling on the start of the order rather than 
on the start of the operation. When the planning engine encounters sales order delay in 
an option supply:

• In a Constrained - Enforce capacity constraints plan, it pushes the option class and 
the model demand out.

• In a Constrained - Enforce demand due dates plan, it raises exceptions as needed as 
the assumption for meeting the demand due dates changes. The sales order and 
sales order lines are demand constraints. The option item sales order lines and the 
option class item sales order lines constrain the model item sales order demand and
the model item sales order demand constrains the option item sales order lines and 
the option class item sales order lines.

After you collect your configured and scheduled order into the APS server and run a 
plan, you will get the demand picture shown in the following table in your APS plan:

Item Org Demands

CMP Main Frame SG None 

CMP Main Frame HK Sales Order

Console HK Sales Order

P devices HK Sales Order

CD-ROM HK Sales Order

PCI Module HK None 

PCI Module MEX Sales Order

Cables MEX Sales Order
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Item Org Demands

PCI Cards MEX Sales Order

5V card MEX Sales Order

Compatibility Bridge MEX Sales Order

Dual Pod Enclosure HK Sales Order

Sub Prod OC HK Sales Order

Power Supply HK Sales Order

Sub Prod 32 HK Sales Order

PTN-32 OC HK Sales Order

PTN32-2MB HK Sales Order

TLC1032 HK Sales Order

32TLC Add On HK Sales Order

The planning engine creates appropriate planned supplies that you can convert to 
actual supplies and follow standard replenishment cycle to ship the sales orders 
between internal Organizations and finally to the customer. 

Supplier Capacity for Procured Models
You can constrain procured configurations based on the aggregate capacity available 
for the base model. That is, you state the capacity for the supplier-supplier site in terms 
of how many of the base assemble-to-order model can be built. The planning engine 
constrains all planned orders, requisitions, and purchase orders for all configurations of
this base model to the aggregate capacity value. Planned orders for the 
assemble-to-order model also consume this same capacity.

The supplier capacity for the assemble-to-order model is consumed by the 
assemble-to-order items that are created based on this model. You can view this 
capacity consumption in Planner Workbench Horizontal Plan window. The planning 
engine uses only the:

• Capacity defined on the approved supplier list for the assemble-to-order model. It 
ignores any supplier capacity defined for any of its configuration items.
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• Specific order modifiers and lead times from the approved supplier list for the 
configuration items

To set up supplier capacity for procured models:

• Navigate to Purchasing > Supply Base > Approved Supplier List

• Query the assemble-to-order model item, select Global, then click Attributes to 
enter the planning attributes

• Define the supplier capacity for the assemble-to-order model. This is the total 
capacity for all configurations of the base model that the supplier can produce.

To view supplier capacity for procured models:

• Navigate to Supply Chain Plan > Workbench > View by suppliers

• Select the supplier site, then select any of the configured items or the base model 
and view the same horizontal plan information. Oracle Advanced Supply Chain 
Planning provides an aggregate view of supply and demand information for all 
configurations of this base assemble-to-order model in the horizontal plan.
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11
Supply Chain Plan Cross-Instance Planning

This chapter covers the following topics:

• Overview of Cross-Instance Planning

• Instances

• Collections

• Cross-Instance Supply Chain Modeling

• Cross-Instance Planning

• Global Available to Promise

• Cross-Instance Execution

• Cross-Instance Data Considerations

• Purchase Orders and Sales Orders Across Instances

Overview of Cross-Instance Planning
This explains cross-instance planning and available-to-promise in Oracle Advanced 
Planning. Cross-instance planning is defining, running, and executing a single plan 
across multiple source instances. It is a key feature for companies that use a 
hub-and-spoke planning model.

Instances
The Oracle Advanced Planning can plan a single instance or multiple instances. An 
instance is a database and a set of applications. 

There are several types of instances:

• Source instances hold source information, for example, items, bill of materials, 
orders. Source instances are Oracle Applications instances and legacy systems.
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• The destination instance (APS planning server) holds planning information. 
Planners use the planning server to store information collected from the source 
instances; run, analyze, and simulate plans; and implement planned orders. 

Collection from an Oracle Applications source instance are standard functionality; from 
legacy systems, develop a customized collection.

The diagram shows four source instances (S11, ABC, TR1, and S07) feeding a planning 
server.

Instance example

To set up cross-instance planning, the system administrator:

• Establishes a database link between the source instances and the APS planning 
server. 

• Registers the source instances: Use the Application Instances form (Setup > 
Instances) to set parameters about each source instance that planning should 
consider, for example, base currency and time difference.

Collections
Before running plans on the planning server, you collect the source data (planning 
related data and transactional data). In the situation depicted in the instance example, 
you run a collections concurrent process to collect from each source instances. You can 
run the collections concurrent processes in parallel. 

You can process collections in any of the following methods:

• Complete: Use this method to collect all data and overwrite the data from previous 
collections.
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• Net change: Use this method to collect only new and changed data since the 
previous collection.

• Targeted: Use this method to collect selected data in a complete refresh.

For more information, see 'Collection Methods, page 4-9.

Cross-Instance Supply Chain Modeling
Cross-instance supply chain planning involves planning organizations that are in 
different instances in one planning process. The organization are:

• Shipping organizations: Organizations that ship material

• Receiving organizations: Organizations that receive material

Sourcing rules, bills of distribution, and assignment sets specify how the planning 
engine should source across instances.

The rectangles in this diagram shows five instance-organization combinations that 
share material. The characters before the colon of each instance-organization represent 
the instance and the letters after the colon of each instance-organization represent the 
organization within the instance. For example, for instance-organization ABC:S1, the 
instance is ABC and the organization is S1. 

Sourcing rules example

To model a cross instance supply chain, model cross-instance:

• Lead-times

• Sourcing relationships

• Customers and suppliers
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Modeling Cross-Instance In-transit Lead-times
You define cross-instance intransit lead-times on the planning server in the Transit 
Times form (Setup > Transit Times).

Use this form to set up transit times between two organizations in the following cases:

• One organization is an Oracle Process Manufacturing (OPM) organization and the 
other is a discrete manufacturing organization.

• The two organizations are in different instances.

To set transit times between two discrete manufacturing organizations that are in the 
same instance, use the Oracle Inventory Shipping Networks form (Setup > 
Organizations > Shipping Networks). Populate the From Org and To Org fields there, 
then navigate Tools > Ship Methods and populate the ship method. Then, collect the 
information to the destination instance.

To view, create, and maintain cross-instance lead times
1. Navigate to the Transit Times form (Setup > Transit Times).

2. In Organization, select an instance-organization.

3. To see the existing shipping network, in Scope, select a value and click Find. View 
information in the Shipping Networks and Ship Methods regions.

In the From Org query, you can see all of your organizations. In the To Org query, 
you can see only organizations that are from another instance.

4. In the Shipping Networks region, select a From Org (shipping organization) and To 
Org (receiving organization) pair.

5. In the Ship Methods region, enter or change the shipping methods that you use 
between the two locations. Click Ship Methods Lookup to view the available 
shipping methods.

For each shipping method, enter or change Transit Time in calendar days.

For the shipping method that you use most often, click Default Method.

6. Save your work.

Defining Cross-Instance Sourcing Relationships 
To set up sourcing rules:

• Specify the sourcing for cross-instance planning on the planning server; use the 
Sourcing Rule window (Sourcing > Sourcing Rules) and the Bills of Distribution 
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window (Sourcing > Bills of Distribution)

This table shows the sourcing rules needed to set up a sourcing rules example.

Sourcing 
Rule/Bill of 
Distribution

Receiving Org Shipping Org Allocation % Intransit 
lead-times

SR100 S11:M1 TR1:M2 25% 3

SR100 S11:M1 S07:M3 75% 10

SR200 ABC:S1 TR1:M2 60% 1

SR200 ABC:S1 S07:M3 15% 5

SR200 ABC:S1 S07:S1 25% 10

• Assign sourcing rules in an assignment set; use the Sourcing Rule/Bill of 
Distribution Assignments window (Sourcing > Assign Sourcing Rules) to assign 
sourcing rules and bills of distribution to:

• Items

• Item in an organization

• Categories of items in organizations

• Organization

• Instances

For more information, see Setting Up the Supply Chain, page 6-2.

Modeling Cross-Instance Customers and Suppliers
In each shipping organization, set up each receiving organization that it ships to as a 
customer. The customer appears on sales orders between the two. For example:

• Instance-organization TR1:M2 supplies instance-organization S11:M1.

• In TR1:M2, set up a supplier CUST_S11_M1. CUST_S11_M1 represents 
instance-organization S11:M1.

In each receiving organization, set up each shipping organization that supplies it as a 
supplier and supplier site. The supplier appears on purchase orders between the two. If 
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a supplying organization supplies multiple receiving organizations, set up the same 
supplier name in all the receiving organizations. For example:

• Instance-organization S11:M1 receives from instance-organization TR1:M2.

• In S11:M1, set up supplier SUP_TR1_M2 and supplier site Hong Kong. Supplier 
SUP_TR1_M2 represents instance-organization TR1:M2.

After setting up suppliers that represent cross-instance shipping organizations:

• Collect the suppliers to the planning server. This relates the shipping organizations 
and their supplier names for all instance-organizations.

• Run concurrent process Create Instance-Org Supplier Association in each shipping 
organization.

See Create Instance-Org Supplier Association, page 22-27.

For example, in shipping organization TR1:M2, run concurrent process Create 
Instance-Org Supplier Association with parameter values:

• Instance Code: TR1

• Organization: Instance: TR1:M2

• Modeled Supplier: SUP_TR1_M2

• Modeled Supplier Site: Hong Kong

• Accept demands from Unmet PO: No

When you release planned orders in receiving organizations for items sourced from 
cross-instance shipping organization, TR1:M2, Planner Workbench creates an external 
purchase requisition against supplier SUP_TR1_M2, supplier site Hong Kong.

This diagram shows the cross-instance supplier-customer modeling process just 
described.
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Cross-Instance Customer-Supplier Modeling

To delete an instance-organization supplier association, run concurrent process Create 
Instance-Org Supplier Association with only parameters Instance Code and 
Organization: Instance.

You can also use the concurrent process with the same steps to create an instance-org 
supplier relationship for an organization that models a supplier. When you release a 
planned order for this organization, the planning engine creates an external purchase 
requisition, not an internal requisition. 

Cross-Instance Planning
To define a plan that spans multiple instances, specify the following in the plan options 
(Supply Chain Plan > Options):

• All instance-organizations. For the instance example, select the five instance-org 
combinations along with their demand and supply schedules. 

• The assignment set with the cross-instance sourcing relationships.

For more information on defining plans, see Overview of Defining Plans, page 5-1.

The combination of sourcing rules/bill of distribution, bills of material, and routings 
create a supply chain bill. The planning engine:

• Explodes independent demand through the entire cross-instance supply chain

• Creates planned supply for each component at each level of the supply chain bill, if 
needed.

For example, as the instance example plan runs, the planned orders generated in 



11-8    Oracle Advanced Supply Chain Planning Implementation and User's Guide

instance-organization S11:M1 and instance-organization ABC:S1 may have 
instance-organization sources TR1:M2, S07:M3, or S07:S1 according to the sourcing rules
and bill of distribution that you defined and assigned to the plan.

The planning engine creates planned orders and recommendations for all instances and 
organizations in the day and time scheme of the plan owning organization.

Global Available to Promise
The available-to-promise calculation uses the supplies generated in a cross-instance 
plan to evaluate availability. If there is a need for more supply, the capable-to-promise 
calculation uses the supply chain bill from cross-instance sourcing to evaluate the 
capability and returns a valid availability date. 

Cross-Instance Execution
After a cross-instance plan completes, you see planned orders and reschedule/cancel 
recommendations in the planner workbench with sources from different 
instances-organizations. If you act on these, the APS planning server passes the 
information to the source instances.

Before releasing planned orders from the plan owning organization to multiple 
instances, perform the following set up:

• Set up the same user name in both source instances

• Tie the user name in each source instance to a manufacturing responsibility

The troubleshooting indication for this setup is that planned orders for make at items in
the non-owning organization instance show in Planner Workbench with Imp Qty = 0.

This table shows the assignment set for the instances example. The:

• Receiving organization is the organization with the planned order (the ship-to 
organization)

• Shipping organization is the organization that supplies the planned order (the 
ship-from organization)

Item Receiving Organization Shipping Organization

A S11:M1 TR1:M2

B S11:M1 S07:M3

C ABC:S1 TR1:M2
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Item Receiving Organization Shipping Organization

D ABC:S1 S07:M3

As you release a cross-instance planned order or recommendations in the receiving 
organization, the Planner Workbench creates an external purchase requisition there and
references the supplier that represents the shipping organization. For example: 

• A planned order in the receiving organization S11:M1 shows supply source TR1:M2
in Planner Workbench.

• The release process creates the external purchase requisition with supplier 
SUP_TR1_M2. 

You:

• Create a purchase order in the receiving organization.

• Create an external sales order in the shipping organization and reference both the 
purchase order number in the receiving organization and the customer that 
represents the receiving organization, for example, CUST_S11_M1. If you do not 
reference the purchase order number, the purchase order and sales order do not 
peg. You can use the Order Import concurrent process to create sales orders against 
purchase requisitions that need them.

The collections process brings the sales orders into the planning server for display, 
including pegging. 

You:

• Perform shipment transactions in the shipping organization.

• Perform receiving transactions in the receiving organization.

This diagram shows the cross-instance execution process.
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Cross-Instance Execution

Oracle Applications does not convert financial data to the base currency of each 
organization. 

Cross-Instance Data Considerations
In the example of multi-instance data collection, there are four source instances. Oracle 
recommends that you pay detailed attention to data values. The collection process must
collect data entities from the four source instances, eliminate duplicate values, and 
produce a combined, consistent set of values (data cleansing or data scrubbing).

Data cleansing involves:

• Eliminating duplicate values that are common in the source instances

• Adjusting source values ensuring consistent values for the same business entities 
(such as the same item) across instances.

For more information on data cleansing techniques, see My Oracle Support.

Constraint Violations
Duplicate data values do not affect the behavior of the planning process. However, the 
collection process may issue warnings. This often occurs with data that is not instance 
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specific, such as unit of measure codes. 

For example, the collection process:

• Collects unit of measure code EA from instance S1

• Collects unit of measure code EA from instance ABC

• Issues ORA-00001: Unique Constraint Violation

Since unit of measure EA is collected, you can safely ignore this warning; it does not 
cause collections or planning to fail. To eliminate it, delete the duplicate data from the 
staging tables for the remaining instances. Data types affected by the unique constraint 
include:

• Unit of measure code

• Unit of measure class

• Unit of measure conversions

• Category set name

Text Differences with Conversions
Data with the same meaning may be in different source instances with similar codes 
and Oracle Applications provides conversions. 

For example, these source instances have these unit of measure codes that all represent 
the unit of measure each:

• S1: EA

• ABC: ea

• TR1: Ea

• S07: EA

After collections, the planning server contains unit of measure codes EA, ea, and Ea. 
The planning process considers these as different units of measure. Before launching the
planning process, you should make sure to have unit of measure conversions among 
these unit of measure codes

Text Differences without Conversions
Typically, Oracle Applications achieves unique data values in the operational data store
for data entities through data entity ID's--internally generated numeric values. 
However, there are exceptions in which Oracle Applications uses text unique indices to 
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achieve unique data values.

In these cases, data with the same meaning may be in different source instances with 
similar text and Oracle Applications does not provide conversions. 

For example, these source instances have these item codes that all represent the item 
Oak Desk:

• S1: Oak Desk

• ABC: OAK Desk

• TR1: OAK DESK

• S07: oak desk

After collections, the planning server contains item codes Oak Desk, OAK Desk, OAK 
DESK, and oak desk. The planning process considers these as different items. Before 
launching the planning process, you should make sure to develop a data cleansing 
process to eliminate the conflicts by adjusting the different values to reflect the same 
value. You can:

• Pull items from instance S1 to staging tables

• Load items from the staging tables to the operational data store

• Pull items from instance ABC to staging tables

• Run a SQL script to update OAK Desk to Oak Desk in the staging tables.

• Load items from the staging tables to the operational data store

• Repeat the pull to staging tables, SQL script, and load to operational data store for 
source instances TR1 and SO7.

These are the data entities in which Oracle Applications uses text unique indices:

• Item name

• Item category

• Customer

• Customer site

• Vendor

• Vendor site

• Bottleneck resource group
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• ABC class

• Demand class

• End item substitution set

• Global approved supplier list

• Currency

• Product family

Purchase Orders and Sales Orders Across Instances
In a multi-organization structure, the supplier in the source instance provides supplies 
to the destination instance against a purchase order. When you release a purchase order
from the destination instance to the source instance, the supplier creates a sales order 
and releases it from the destination instance to the source instance.

The planning engine treats transactions across instances as external requisitions. 
Variations in demand within the destination instance influence the sales order demand 
in the source instance. The planning engine plans to supply schedule across instances. 
When you run collections, the planning engine pegs the external purchase order to the 
external sales order.

Cross Instance Pegging Logic
In specific situations, this is how pegging works:

• If the quantity in the sales order is same as the quantity in the purchase order, the 
sales order is pegged to the purchase order.

• If the quantity in the sales order is less than the quantity in the purchase order, the 
purchase order creates a planned order demand with quantity equal to the 
difference of quantities in purchase order and sales order in the supplier's 
organization. The supplier can accept the excess demand as a planned order 
demand in the organization and later convert the planned orders to sales order 
manually. This behavior is determined by the value set for the flag Accept 
Demands from Unmet PO (set while mapping a supplier to an organization). If the 
value for this flag is set to Yes, the supplier has an option to accept demands from 
unmet purchase orders. The supplier should be modeled as the organization that is 
included in the plan. However, if the value for this flag is set to No, the excess 
demand is not pushed to the supplier's organization.

• If multiple lines in the sales order map to a single line in the purchase order, each 
line in the sales order is pegged to the same purchase order line.
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• If the quantity in the sales order exceeds the quantity specified in the purchase 
order, the sales order is pegged to the amount specified in the purchase order. The 
rest of the quantity is pegged to In-Excess.

• If inaccurate purchase order details or item details are specified in the sales order, 
the sales order is not pegged to the purchase order.

Cross Instances Pegging Criteria
Pegging works when specific conditions are fulfilled:

• Sales orders across instances can be pegged against purchase orders having a single 
shipment per line. Purchase orders having multiple shipments per line are not 
considered.

• A single sales order line cannot be pegged to multiple purchase order line numbers 
because a single purchase order number is associated with a sales order.

Cross Instances Pegging Process
Perform these steps to peg purchase orders and sales orders across instances:

1. Ensure that you have defined cross instance sourcing in the destination 
organization instance.

2. Run the Create instance-org Supplier Association concurrent program to designate 
the supplier organization as an external supplier organization. This results in 
creating sourcing rules.

3. Generate a cross instance supply chain plan.

4. Release a purchase order from the destination instance to the source instance. 

5. Supplier needs to manually create an external sales order against the purchase 
order and specify the purchase order number and the purchase order line number 
in the source organization instance. 

6. After you run data collections and launch and launch the supply chain plan, 
navigate to the Planner Workbench to view whether or not the purchase order in 
the destination instance is pegged to the sales order in the source organization 
instance.

Designating Supplier Organization As External Supplier Organization
If you want a supplier in an organization to be available to other organizations, you 
need to designate the supplier organization as external. This enables the planning 
engine to peg across instances. As part of the setup for designating a supplier 
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organization, you need to run the Create instance-org Supplier Association concurrent 
program. Perform these steps to run the concurrent program:

1. Navigate to the Submit Request window.

2. In the Name field, select Create Instance-Org Supplier Association.

The Parameters window appears.

3. In the Instance Code field, specify the user-defined 3-character short-form for the 
instance to be planned.

4. To associate the supplier with the specified instance, specify the supplier in the 
Modeled Supplier field.

5. Select a specific supplier site in the Modeled Supplier Site field and click OK.

6. Click Submit in the Submit Request window to submit the concurrent program.
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12
Supply Chain Plan Business Topics

This chapter covers the following topics:

• End-Item-Level Substitution

• User-Defined Alternate Decision Rules

• Organization Security

• Key Performance Indicators

• Supplier Acknowledgement for a Rescheduled Purchase Order

• Setting Demand to Supply Planning Automation

• Setting Supplier Collaboration Automation

End-Item-Level Substitution
Oracle ASCP supports two types of substitution: component substitution and 
end-item-level substitution. This section describes end-item-level substitution.

You cannot use end-item-level substitution in unconstrained plans.

The term end-item refers to the finished good or saleable product. End-item-level 
substitution is an acceptable business practice in many industries. It is often possible to 
fulfill customer demand on time when the requested item is not available by 
substituting a more functionally rich product. Substitution is also done to use up 
existing inventory of older, functionally equivalent items.

End-item substitution provides the following capabilities: 

• Enable substitution based on user-defined rules that can be effective either in one 
direction or in both directions; defining a chain of substitution relationships can be 
simplified by inferring existing relationships

• Consider substitution rules in the order promising process and suggest substitution 
similar to planning; this is important because promising orders based on a logic 
which does not consider substitution may lead to inaccurate promise dates and 
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over promising

• Consider the customer/customer site ordering the item; for example, some 
customers ordering a specific item might not accept substitutions; on the other hand
other customers ordering the same item will accept substitutions 

• Consider the effective dates of substitution rules prior to performing substitution

• Evaluate the effects of possible substitution rules by performing plan simulations

• Define whether orders may be fulfilled using a combination of requested and 
substitute items or only one item 

You cannot use end item substitution with project planning.

User Procedures Overview
This section lists the general procedures that are used to define and use end-item 
substitution:

Define substitution relationship between items at Oracle Inventory, optionally establish 
substitution chain, directionality and effectivity for substitution, and optionally 
establish customer and customer site for each substitution relationship

1. Set item attributes to control the generation of supplies

2. Set Item attribute to establish a window for substitution

3. Collect data

4. Run plans and analyze substitution decisions

5. Follow work flow procedure to enable execution

6. Optionally initiate ATP queries to quote promise dates based on substitution logic 

Define a Substitution Relationship
This section describes what you need to do to define a substitution rule or relationship 
at the item level. In general, you must define the following: 

• A substitute From and a substitute To item

• The direction in which substitution is effective 

• Effective dates for substitution (optional)

• Partial Order Fulfillment flag for each substitution relationship (optional)
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• Substitution Set to enable simulation of substitutions (optional)

• Customer and customer site for a substitution relationship (optional)

You can define substitution rules or relationships via item relationships in Oracle 
Inventory using the Item Relationship form. You can use the form to define all the 
characteristics mentioned above. You can infer chaining and highest-level item in a 
substitution chain. 

You can create unidirectional and bi-directional (reciprocal) relationships, for example, 
A > B (not reciprocal) or A <> B (reciprocal). However, once you create A > B (not 
reciprocal), you cannot create B > A (not reciprocal). You can simulate A <> B 
(reciprocal) by creating unidirectional relationships A > B, then B > C (item C is a 
dummy item), and then C > A.

If you define the end item-level substitution rule, it is applicable in all organizations in 
which the items are enabled. 

These substitution rules are collected in Targeted collection mode and Complete refresh
mode and not in Net change mode.

Although Item relationships are defined at the operating unit level, the planning engine
applies them at the global level to all organizations within a plan.

Substitution Chain Priorities

You can instruct the planning engine how to decide the priorities of multiple items in a 
substitution chain--either by substitution distance or by effectivity date.

If the planning engine decides by substitution distance, it looks at the distance of each 
item from the demanded item in the substitution chain. The closer a potential substitute
item is to the demanded item, the higher its priority is in the substitution chain. Set 
profile option MSO: Use Effectivity Dates to Infer End Item Substitute Priority to No.

For example, you set up this substitution chain:

From Item To Item Type

A B Reciprocal

B C Reciprocal

C D Reciprocal

Graphically, the substitution chain is A <> B <> C >< D.

For a demand on item C, the priorities are, from highest to lowest:

• C: Substitution distance from C is 0
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• B: Substitution distance from C is 1 and it is higher in the substitution chain

• D: Substitution distance from C is 1 and it is lower in the substitution chain

• A: Substitution distance from C is 2

If the planning engine decides by effectivity date, you must enter effective and disable 
dates for each relationship. The earlier a potential substitute item's effectivity date, the 
higher its priority is in the substitution chain. If more than one substitute item has the 
same effective date, those substitute items have the same priority. Set profile option 
MSO: Use Effectivity Dates to Infer End Item Substitute Priority to Yes.

Use this method if you want to use up older substitutes before newer substitutes.

For example, you set up a substitution chain as follows:

From Item To Item Type Effective Date Disable Date

A' dummy A Unidirectional December 30, 
2006

-

A B Reciprocal January 1, 2007 -

B C Reciprocal January 10, 2008 -

C D Reciprocal January 20, 2008 -

For effectivity dates, you must also include a dummy from item in the substitution 
chain, link it to your preferred substitute item, and set its effective date earlier that all of
the actual substitute items.

Graphically, the substitution chain is [A' dummy] > A <> B <> C >< D.

For a demand on item C, the priorities are, from highest to lowest:

• A: Priority 1, earliest of the effectivity dates

• B: Priority 2, second earliest of the effectivity dates 

• C: Priority 3, third earliest of the effectivity dates

• D: Priority 4, latest of the effectivity dates

Substitution Chain Inferences

The planning engine can infer additional substitution relationships if profile option 
MSO: Disable Inference of Item Substitution Relationship is No.

This diagram lists the Reciprocal substitution relationships that you might make as well
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as the Reciprocal (inferred) substitution relationships that the planning engine infers

From Item To Item Type

A B Reciprocal

B C Reciprocal

A C Reciprocal (inferred)

C D Reciprocal

A D Reciprocal (inferred)

B D Reciprocal (inferred)

To define a substitution relationship
1. From the Navigator, select Inventory > Items > Item Relationships.

The Find Item Relationships window appears.

2. Either select a previously defined item or search for an item.

The Item Relationships window appears.

3. You can use this window to create a substitute relationship between two items and 
to indicate if the relationship is reciprocal. Please note that you cannot enter 
multiple Effective Dates for a substitution relationship in this window. This is done 
in the Planning Details window.

If profile option MSO: Use Effectivity Dates to Infer End Item Substitute Priority is 
Yes, enter a value in field Effective Dates From. You can also enter a value in field 
Effective Dates To. If an entry has Effectivity Dates To and the date has passed, that 
substitute item cannot be in the substitution chain.

4. To further define details about the substitute relationship, select an item row and 
select the Planning Details button.

The Planning Details - Substitute window appears.

5. Use the information in the following table to fill out the fields in this screen.

.



12-6    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Field Description

Substitution Set You can specify one or more substitution 
sets for a substitution relations ship. You 
can use a set of substitution relationships to 
be effective for a given plan by selecting the 
substitution set as an option for the plan. 
This allows you to run simulations of 
possible substitutions and evaluate 
performance indicators given possible 
future substitutions. For additional 
information, please see Simulate Possible 
Substitutions, page 12-24. 

Partial Fulfillment If you select this check box, the entire order 
can be satisfied with supplies from both 
items. If you do not select this checkbox, 
Oracle APS must satisfy the entire order 
with supplies from one item or the other 
item, but not both. 

Effective Dates The substitution relationship can be made 
effective between a range of dates or 
multiple ranges of dates. If you specify 
range of dates in this window, the effective 
dates in the Item Relationship window will 
be ignored.

If profile option MSO: Use Effectivity Dates 
to Infer End Item Substitute Priority is Yes, 
enter a value in field Effective Dates From. 
You can also enter a value in field Effective 
Dates To.

Oracle APS will consider substitution 
relationship with different effective dates 
and will substitute only during the valid 
range of dates. 

All Customers When this box is checked, any substitution 
set or range of effective dates is made 
applicable to all customers. If you need to 
make it specific to a customer, then unselect 
this checkbox and navigate to the Customer 
field where you will have a chance to enter 
a customer or multiple customers.
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Field Description

Customer You can set up customer site-specific 
substitution rules by defining customers 
and customer sites here. This allows you to 
maintain customer-specific substitutions as 
your customers accept or decline specific 
substitution relationships. Please note that 
you can associate multiple customers to the 
same substitute relationships. 

You may have a need to enter both 
customer-specific and 
non-customer-specific substitution 
relationships for the same set of items. You 
can do so by entering one record in the Item
Relationship window, entering the effective 
dates for the first rule in the first row of the 
Planning Detail window and deselecting All
Customers, and entering multiple 
customer-specific associations in the 
Customer Reference section. Then, you 
enter effective dates for the generic rule in 
the Planning Details window and leave All 
Customers selected. One of the records can 
be applicable to all customers and the other 
record will be a customer-specific record. 

NOTE: Once you enter customer-specific 
substitution rule for any item, you will have
to specify all the relationships applicable to 
that customer explicitly because no generic 
rules will be applied to that customer.

Address Choose the address for the customer 
location.

Type View only field that shows the type of 
location (currently, only shows Ship to).

From and To You can specify effective dates for 
substitution at a customer level. If you 
specify effective dates at customer level for 
a substitution relationship, the effective 
dates you might have specified at the in the 
Planning Details window and the Item 
Relationship window will be ignored.
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Substitution Set-Up Examples
Use the following information to set up various substitution scenarios. 

To set up substitution across many dates/effectivities
1. Fill out the Item Relationships window as shown in the following table:

From Item To Item Relationship type Reciprocal 

A B Substitute <cleared>

2. Fill out the Planning Details window as shown in the following table:

Substitution 
Set

Partial 
Fulfillment 

From Date To Date All Customers

<null> <cleared> Day 1 Day 50 <selected>

<null> <cleared> Day 65 Day 80 <selected>

<null> <cleared> Day 101 <null> <selected>

To set up substitution relationships with multiple substitution sets
1. Fill out the Item Relationships window as shown in the following table:

From Item To Item Relationship type Reciprocal

A B Substitute <cleared>

2. For the item relationship A --> B, fill out the Planning Details window as shown in 
the following table:

Substitution 
Set

Partial 
Fulfillment

From Date To Date All Customers

<null> (default) <cleared> <null> <null> <selected>

SSET1 <cleared> <null> <null> <selected>
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Substitution 
Set

Partial 
Fulfillment

From Date To Date All Customers

SSET2 <cleared> <null> <null> <selected>

You may now run plans using any of the substitution sets defined in this window as a 
plan option.

To set up customer-specific and non-customer-specific substitution rules
1. Fill out the Item Relationships window as shown in the following table:

From Item To Item Relationship type Reciprocal

A B Substitute <cleared>

2. Fill out the Planning Details section of the Planning Details window as shown in the
following table:

Substitution 
Set

Partial 
Fulfillment

From Date To Date All Customers

<null> <selected> <null> <null> <cleared>

<null> <selected> <null> <null> <selected>

3. Fill out the Customer References section of the Planning Details window for the 
first row as shown in the following table:

Customer Customer Site From Date To Date

Customer 1 Site 1 <null> <null>

Customer 2 Site 2 <null> <null>

Please note that in order to enter a customer-specific rule, All Customers must be 
unselected.

To set up multiple substitution effective dates for a customer
1. Fill out the Item Relationships window as shown in the following table:
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From Item To Item Relationship Type Reciprocal

A B Substitute <cleared>

2. Fill out the Planning Details section of the Planning Details window as shown in the
following table:

Substitution 
Set

Partial 
Fulfillment

From Date To Date All Customers

<null> Selected <null> <null> <cleared>

3. Fill out the Customer References section of the Planning Details window as shown 
in the following table:

Customer Customer Site From Date To Date

Customer 1 Site 1 Day 1 Day 50

Customer 1 Site 1 Day 100 <null>

Viewing Substitution Display

To view substitution display
1. From the Navigator, select Supply Chain Plan > Workbench.

The Supply Chain Planner Workbench appears.

2. In the Navigator, select View By Items.

3. Select the item you wish to view and right-click. 

4. From the menu that appears, select Items.

The Items window appears.

5. Select an item. 

6. Select the Substitutes button. Please note that multiselects are not allowed. If you 
select several items, the Substitutes button will be greyed out.
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The Substitution Chain window appears.

7. The following list provides an explanation of the features of this window:

• The item you selected in the Items window is highlighted. 

• The color of the arrows between each item signify whether the relationship is 
predecessor, parallel, or successor.

• You can see the item and the substitution chain along with the direction, and 
the type of substitution relationship (i.e. one-way/two-way). 

• Each node in the window refers to an item and has expansion capabilities.

• Double-clicking on an item will show any existing expanded relationships.

• If you can expand the chain upwards, the item in question can use higher level 
item as a substitute. 

• If you can expand the chain lower the item in question can be substituted for 
the lower level item. 

• If you can expand the tree sideways, the item in question and the parallel item 
can be substituted for each other. 

• If you double click on a node which is a two-way substitute item, the tree will 
refresh itself and start from the node you double-clicked rather than showing 
multiple trees at the same time. 

• The highest level item is the one to which all the arrows point.

• The highest-level item is usually the item with most capabilities and it is the 
item that is in active production in certain industries. 

• If you select an item and right-click, two menu options appear: Properties and 
Horizontal Plan. If you select Properties, the Substitution Properties window 
appears. If you select Horizontal Plan, the Horizontal Plan appears.

There are three tabs: Predecessor, Successor, and Parallel. Each tab shows you the 
properties of substitution relationship and other possible substitutes as shown below. If 
you do not have a Predecessor, Successor, or a Parallel substitution, the appropriate 
tabs are disabled. The default enabled tab when you open the window is the 
Predecessor tab.

The following information appears in the Substitution Properties window: 

• From and To substitute items

• Implied Substitution - whether the item relationship is implied or directly specified
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• Highest level item in the substitution chain

• Effective date for the relationship

• Disable date for the relationship

• Customer and Customer sites which accept the substitution 

• Substitution set if specified

• Partial Fulfillment is allowed

Substitution Logic
The section contains description of how substitution logic functions. It contains 
information about:

• Searching the supply chain

• Chaining

Search the Supply Chain for Substitution
A demanded item or a substitute item could be available within the same organization 
or in a different organization within the supply chain. You can take advantage of 
availability of supply (both requested item and substitute items) across the supply chain
and use up the inventory effectively before placing orders to make or buy the item. To 
search for demanded item or substitute items, the planning engine looks for demanded 
and substitute items within the same organization before looking in other organizations
to find them.

The following figure show you this search method:

With this method, the emphasis is on use up. The availability picture of original item 
and substitutes guides the search. The emphasis of the search is to seek supplies from 
demanded item or substitute item and use it up as effectively as you can before creating
supplies for the item requested. This means Oracle APS looks for on hand and 
scheduled receipts of demanded items and substitutes within one organization before 
proceeding to the next organization to repeat the same search. 

If profile option MSC: Choice of item for which to create supplies in substitute 
relationship is Follow Item Attribute, the planning engine respects capacity on the 
demanded items. It can create planned orders for any item within the chain as long as 
flag Create Supply is Yes and there is available capacity. The planning engine does not 
consider order modifiers.

If you do not want the planning engine to recommend orders for a particular item in the
substitution chain: 
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• Set profile option MSC: Choice of item for which to create supplies in substitute 
relationship to Follow Item Attribute

• In item attributes for item-organization, set Create Supply Flag to No

Breadth-First Search

An important point to note here is the direction of search when multiple levels of 
sources are involved. If you consider the following diagram, the Atlanta facility sources 
from Dallas and Miami, Dallas sources from Dallas-1, and Miami sources from Miami-1.

Supply Chain for Substitution

If you have item A and a substitute item A1 in all the organizations in the supply chain 
and if you have demand in Atlanta, the search follows the sequence mentioned below:

• Look for on hand and scheduled receipts of item A and substitute A1 at Atlanta

• Look for on hand and scheduled receipts of item A and substitute A1 at Dallas

• Look for on hand and scheduled receipts of item A and substitute A1 at Miami

• Look for on hand and scheduled receipts of item A and substitute A1 at Dallas-1

• Look for on hand and scheduled receipts of item A and substitute A1 at Miami-1

The search across organizations is guided strictly by sourcing rules, bills of distribution,
and the corresponding ranks for the sources. Summarizing the search process, Oracle 
APS looks for the demanded item (requested item) and all its possible substitutes 
within a facility and it continues to look for demanded item (requested item) and its 
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substitutes in other facilities searching breadth first. Referring to the diagram, the 
search will follow:

Atlanta, Dallas, Miami, Dallas-1, and Miami-1 

It is very important to note that the breadth-first search method is used in constrained 
plans. In optimized plans, the search is entirely driven by costs i.e., item costs, penalty 
costs for satisfying demand late, transportation costs etc. An optimized plan suggests 
transfers and substitutes based on the overall objective of the plan and costs mentioned 
above. 

Enforce Sourcing Splits and Substitute Supply Across Supply Chain

Oracle APS supports enforcing sourcing splits in optimized plans. This means that you 
can have the system adhere to the sourcing splits (while allocating supply to various 
sources) you mention on the sourcing rules or bills of distribution even though the 
splits may not be cost effective.

Supplies that you may find for demanded or substitute items across the supply chain 
with the intention of use up may violate the enforce sourcing splits logic. If you need 
the use up functionality, sourcing splits will not be enforced at least for the sources 
where you would expect to use up the supply efficiently. Enforce sourcing splits is 
enabled at the sourcing rule or the bill of distribution level; therefore, it is easy to apply 
the sourcing splits only to the sources you may need and not for the ones that you do 
not need. 

Example 1
There may be times where enforce sourcing splits conflicts with the substitution use up 
rule. For example, the following table shows the sourcing splits and supply for Org1 
and Org2.

Org Sourcing Split Supply

Org 1 50% 100 of item A

Org 2 50% 0 of item A

If the demand for item A is 100, according to sourcing splits, 50 of item A should come 
from Org 1 and 50 of item A should come from Org 2. However, since there is no 
supply of item A at Org 2, this cannot be accomplished. In the substitution process, the 
use up will override enforce sourcing splits and will take all 100 from Org 1 to meet the 
demand for 100 of item A. 

Chaining - Multiple Levels of Substitution 
If multiple items are involved in substitution, you can establish a chain of substitutions 
that is valid. 
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Example 2
If item A can be substituted for item B and item B can be substituted for item C, you can
infer that item A can be substituted for item C, if profile option MSO: Disable Inference 
of Item Substitution Relationship is No.

Establishing and maintaining substitution relationships amongst items in a large 
substitution chain; for example, up to 80 items, can be very tedious and time 
consuming. Therefore, you might prefer to infer certain substitutions, such as in the 
above example in which A --> C is inferred given the first two relationships. 

If such a relationship is established and if item A is requested, you can satisfy it with 
supplies from A, B, or C. If item B is requested, you can satisfy it with either B or C. If C 
is requested, you can satisfy it with only C's supply. 

If you add effectivities as suggested in the Define a Substitution Relationship section 
and if profile option MSO: Disable Inference of Item Substitution Relationship is No, the
substitution inference is made effective based either on the effective dates of all 
relationships or on the intersection of all the dates. The following table shows that the 
substitution rule between item A and B is effective between Day 2 and Day 10. A second
substitution rule between item B and C is effective between Day 6 and Day 22. 
Therefore, the inferred substitution rule between item A and C is effective between Day 
6 and Day 10.

From Item To Item From Date To Date Inferred

A B Day 2 Day 10 No

B C Day 6 Day 22 No

A C Day 6 Day 10 Yes

End-Item Substitution Features
This section contains descriptions of substitution features available in Oracle ASCP. It 
contains information for the following features:

• Reciprocal - unidirectional and bidirectional substitution

• Preference for generating planned orders

• Window for substitution

• Partial order fulfillment

• Effectivity (time phasing)
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• Customer-specific substitution rules

• Simulate possible substitutions

• Transfer of demands on to substitute supplies

Reciprocal - Unidirectional and Bidirectional Substitution 
As shown in an earlier example, while you can satisfy A's demand with B's supply, you 
cannot satisfy B's demand with A's supply. This is referred to as unidirectional 
substitution. In some cases you can satisfy B's demand with A's supply. This is referred 
to as bidirectional substitution or reciprocal substitution.

Referring to the diagram below, items X, Y and Z are in a unidirectional relationship, 
and items Y and YY are in a bidirectional relationship. Because item Y has two 
relationships, Oracle APS will allocate supply from item Z or item YY if you have a 
demand for item Y. 

Figure title

Preference for Generating Planned Orders
Given a group of substitutable items, there is considerable variation in how the supplies
are to be created for the substitute items. This depends on the type of industry. 

Field Service Repair/Replacement Business

In this business, the emphasis is more on locating original item supplies or substitute 
supplies and distributing items across a defined distribution channel. The demand for 
the item may be for any one of the items in the substitution chain. If the supplies are not
found in your distribution network, you can purchase needed items, but you cannot 
buy older items as the manufacturer might no longer produce them. In such cases you 
are forced to buy the current item. This translates to creating supplies only for the 
highest level item in the substitution chain.

Example 3
In this example, there are four items in the substitution chain: items A1, A2, A3, and A4.
The highest revision in this pool is A4 (referred to as the highest level item). You may 
get demand for any of the four items mentioned. If you get demand for A2, you will 
evaluate supply availability for A2, A3, and A4 assuming chaining and direction as A1 
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--> A2 --> A3 --> A4. If you do not find any supply for the demanded item, you can 
generate supply for highest level item which is A4. 

To achieve this, set the profile option MSC: Choice of Items for which to Create Supplies
in a Substitute Relationship equal to Highest Level Item.

Semiconductor Business

In semiconductor business, substitutable items are typically co-products. Even in this 
scenario, the demand can be for any one of the items in the substitution relationship. In 
contrast to the previous scenario, here you can produce the item the customer has 
requested. Given that the products are going to be co-produced, you may need to create
co-product supplies for the rest of the items in the co-product relationship. 

Oracle APS plans for the capacity to produce all the co-products for a given order 
because you cannot produce only one item that is part of the co-product. 

Example 4 
In this example, there are four items in the substitution chain: items A1, A2, A3, and A4.
The highest revision in this pool is also A4 (referred to as the highest level item). If you 
get a demand for A2, you will evaluate supply availability for A2, A3, and A4 assuming
chaining and direction as A1 --> A2 --> A3 --> A4. If you do not find any supply, you 
can generate supply for the demanded item which is A2. 

If items A1, A2, A3, and A4 are in a co-product relationship, Oracle ASCP generates 
co-product supplies for items A1, A3, and A4.

In addition to the two modes of generating supplies as mentioned above (being forced 
to buy the current item and needing to create co-product supplies), a general 
requirement is to have an item attribute that controls whether you want to create new 
planned supplies. This may be helpful in scenarios where you have existing supplies 
that you may want to plan and potentially sell, but you do not want to produce the item
anymore. 

All of these requirements are addressed by a combination of profile options and item 
attributes. You can choose one of the following methods to generate supplies using 
profile option MSC: Choice of Items for Which to Create Supplies in Substitute 
Relationship:

• Demanded Item

• Highest Level Item

• Follow Item Attributes

If you set the profile option to Follow Item Attributes, Oracle ASCP will follow the 
Create Supply item attribute established at the item-organization level.

For more details on profile options, see Profile Options, page A-13.

Resolving Conflict Between Item Attributes and Profile Options
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If you employ a combination of profile options and item attributes, you may set up 
contradicting values.

Example 5
In this example, there are three items: A, B, and C. Item C is the highest level item in the
substitution chain. This example shows you may set up a conflict between your item 
attribute and profile option with unexpected results. 

The profile option Choice of Item for Which to Create Supplies in Substitute 
Relationship can be set to:

• Demanded Item

• Highest Level Item

• Follow Item Attribute

The item attribute Create Supply for each item can be set to either Yes or No.

If you select Demand Item or Highest Level item, Oracle APS ignores any item 
attributes. 

The following table shows you what to expect when you set the Profile Option to 
Follow Item Attribute.

Conflicts Related to Enforce Demand Due Dates Plan: 

Running your plans using the plan option Enforce Demand Due Dates means that you 
must satisfy the demand on time. However, if you set the profile option Choice of Item 
for Which to Create Supplies in Substitute Relationship to Follow Item Attribute and 
the item attribute Create Supply for all the substitute items in the substitution chain is 
set to No, no supplies will be created and Enforce Demand Due Dates will be violated.

Conflict Between Choice to Create Supplies and Enabling Item in an Organization:

If you have a substitution chain A --> B --> C and you have set the profile option Choice 
of Item for Which to Create Supplies in Substitute Relationship to Highest Level Item, 
the expectation is that Oracle APS will create supply for item C. However, item C must 
be enabled in the organization in which you are trying to create a supply. If item C is 
not enabled in the organization, Oracle APS will create supply for item B (the next 
highest level item in the substitution chain) and not create supply for item C.

Window for Substitution
While substitutions are part of regular business process, substitutions done too far 
ahead of demand might not be appropriate. For example, if you find a substitute supply
four weeks away from demand, you may not want to substitute as you may have a 
good chance of producing supply for the demanded item in the next three weeks. 

A substitution window allows you to limit the time frame for the substitution. You can 
define the substitute window for an item using item attribute form in Oracle Inventory. 
The substitution window is effective in the forward direction from every demand. All 
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substitute supplies prior to demand are eligible for substitution. Please note that the 
substitution window is applicable only for substitution; if you are netting supply and 
demand from the same item, the substitution window does not apply

If you do not set substitution window, the planning engine uses default of zero days, so 
it will not do end-item substitutions.

Example 6
In the time-phased supply picture shown in the following table, item A is being 
substituted for item B. You get a demand for 30 units of item B in time bucket 1. If 
substitution must happen right away, you can use A's supply for B's demand and 
satisfy it on time. If you can wait for two more time buckets, you will find the supply 
for B in time period 3; therefore, you can avoid substitution. The assumption here is you
will get a demand for item A and you do not have to give up on the amount of money 
you could make by shipping A for A's demand.

Item Time 
Bucket 1

Time 
Bucket 2

Time 
Bucket 3

Time 
Bucket 4

Time 
Bucket 5

Time 
Bucket 6

Item A 25 2 3 4 5 6

Item B 5 0 25 0 0 25

At the same time, if supply of 25 units in time period 3 was not available, you may not 
be able to wait until time period 6 to pick up the supply for item B, as delivery 
performance might drive you to use substitution right away.

Another aspect of substitution window might be to evaluate all native demands and 
supplies within a specified amount of time, and to consider only excess supply from 
each item as possible substitution supplies. 

Continuing our example from above, you may also have demand for 20 units of item A 
in time period 1. In this case, you may not want to satisfy B's demand using A's supply. 
You may want to find out the excess after satisfying the native demand before you 
apply substitutions. Therefore, the demand for Item B can satisfied only as follows: 5 
units of its own supply in time period 1, 5 units of item A's supply in time period 1, and 
its own supply of 20 units in time period 3. 

Satisfying native demand may run contrary to prioritized demand in constrained plans.
The following table shows the supply/demand picture where demand for item B can be 
satisfied with a supply for item A. The substitute window for both items is 3 days. 
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Item Time 
Bucket 1

Time 
Bucket 2

Time 
Bucket 3

Time 
Bucket 4

Time 
Bucket 5

Time 
Bucket 6

Item A 
(Demand)

20 (Priority
10)

10 (Priority
20)

0 0 0 0

Item A 
(Supply)

0 20 5 0 0 0

Item B 
(Demand)

50 (Priority
1)

0 0 0 0 0

Item B 
(Supply)

5 10 0 0 0 25

Given the logic of constrained plans, you will try to satisfy every demand based on its 
associated demand priority. In the above scenario, satisfying native demand and 
following demand priorities are at odds. Going by priority, you will consume all the 
supplies for item B and substitute 10 units from item A to satisfy B's demand. This 
means demand from item A may not be satisfied on time because it needs to be 
manufactured or bought.

If your business scenario needs to give preference to native demand satisfaction within 
the substitute window, you can do so by setting up system level profile options. If you 
set up the profile option to give preference to native demand satisfaction, item B will 
not be able to substitute any supply from item A in the previous example. You can 
achieve native demand satisfaction by setting up system level profile options. Please see
Profile Options, page A-1 for details.

Substitution window is not applicable in optimized plans because the end item 
substitution is purely based on cost in an optimized plans 

Enforced Demand due date plans (both constrained and optimized) do not consider 
substitution window

Maximum allowable days late overrides the substitution window. Demands go unmet 
or move to the planning horizon rather being assigned a substitute.

Partial Order fulfillment In this type of substitution, the demand must be satisfied with 
only one type of item. If item A and item A1 are substitute items, you cannot, for 
example, satisfy a demand for 100 units of A with 50 units of A and 50 units of A1. You 
must either supply 100 units of A or 100 units of A1. 

This feature is available in the Planning Details window. 

Example 7
You can specify Partial Order fulfillment attribute for a substitute relationship in Oracle
Inventory using the Planning Details form (this form is accessible through the Item 
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Relationship form)

In this example, items A and A1 are substitute items. Based on the supply demand view
in the following table, you would substitute and satisfy the demand by allocating 
supply from item A1. This is enforced because the supply for item A by itself could not 
have satisfied the demand, and in addition, the entire demand must be satisfied by 
either item A or A1.

Record Type Day 2 Day 15 Day 18

Demand for A 0 50 0

Supply for A 0 40 0

Supply for A1 0 0 60

If the supply for A1 is inadequate to meet the demand, you can satisfy the demand by 
using 40 units of existing supply of item A and new supply of 10 units for A.

Effectivity (Time Phasing)
It is common to see an effective time period for substitution. This is typically used to 
model restrictions on use up of inventory, time phase product qualifications and 
engineering changes etc. You can specify substitution Effective From and To dates 
along with definition of substitution.

You can specify effective dates for substitution in the Planning Details form.

The effective dates for the substitution will be validated against the demand due date 
(Suggested Due Date) to derive the valid substitutions. Let us consider the following 
substitution table: 

From Item To Item Customer Ship-to 
Address

From Date To Date

X1 X2 Company A 75 Hill Street 3/1/2002 9/30/2002

X1 X3 Company B 219 Revere 
Blvd. 

4/1/2002 10/30/2002

X2 X3 Company B 219 Revere 
Blvd. 

6/1/2002 <null>

If you get demand from Company A/75 Hill Street on 4/1/2002 for item X1, you can 
substitute with item X2. If your demand is beyond 9/30/2002, the substitution between 
X1 and X2 is not possible. Similarly, if you get a demand from Company B/219 Revere 
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Blvd. for item X1 on 6/1/2002 you can substitute with item X3. If you get a demand for 
item X2 after 6/1/2002, you can substitute with item X3. 

Please note that if you run a constrained plan, your demand satisfied date may be 
different from suggested due date. The validity of the substitution is derived by 
comparing the suggested due date with the effective dates, not the demand satisfied 
date.

Customer-Specific Substitution Rules
Substitution rules can sometimes change depending on which customer site is ordering 
the item. Often customers qualify the plants producing the items. In a typical set up you
will issue a different item number based on the origin of the item even if it is the same 
item. Item numbers issued to represent the item origin will form a basis to specify 
customer-specific substitution. 

You will be able to set up substitutions specific to a single customer or all customers. 

Example 8
There are three customers; Customer A, B, and C. Assume that they buy Integrated 
Circuits with varying degrees of capability, namely IC200, IC300, and IC400. 
Restrictions posed by the customers are as follows: 

• Customer A can accept IC200 and IC300 but not IC400

• Customer B can accept IC200 and IC400 but not IC300

• Customer C can accept all the three items

You can set up the above substitutions in the following way:

From To Customer Address

IC200 IC400 Customer B Address B

IC200 IC300 Customer C Address C

IC200 IC400 Customer C Address C

IC200 IC300 Customer A Address A

Oracle Inventory allows you to specify customer and customer ship-to address specific 
substitutions.

Substitution Definition With and Without Customer and Customer Site

It is possible to have customer-specific and generic substitution relationships for the 
same set of items. However, if you record a customer-specific rule, then the generic 
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rules no longer apply to that customer. You will have to define an item relationship for 
each substitution that the customer will accept. 

Example 9
Given the above understanding, let us look at an example to clarify the intended 
behavior. 

Customer-Specific Substitution Relationships

From Item To Item All Customers Customer Address

X1 X2 Y <blank> <blank>

X2 X3 Y <blank> <blank>

X1 X3 Y <blank> <blank>

X1 X4 Y <blank> <blank>

X1 X2 N Company 1 Company 1 
address

X1 X3 N Company 2 Company 2 
address

X2 X3 N Company 2 Company 2 
address

X1 DUMMY N Company 3 Company 3 
address

The first four rows of the table show generic substitution relationships. That is, X1 can 
substitute for X2, etc. The next four rows show company-specific substitutions. 
Company 1 will not accept any substitutions other than X1 for X2. Company 2 will not 
accept any substitutions other than the X1 for X3 and X2 for X3. So even though there 
are generic substitution relationships, customer-specific rules overrides all other rules 
for that customer.

The last line of the table shows a customer that does not accept any substitutions. For 
this customer, you must create a dummy item that forces the system not to consider any
substitutions for any items for that customer.

All other customers will accept all the generic rules in the first 4 rows of the substitution
table. 

If you find any substitution rule tied to a customer, the only substitutions which are 
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valid for the customer are the rules that are specific to a customer. 

Example 10
In this example, effective dates are added on top of the definition in Example 8:

From Item To Item Customer Customer 
Address

From Date To Date

X1 X2 <blank> <blank> <null> <null>

X2 X3 <blank> <blank> <null> <null>

X1 X3 <blank> <blank> <null> <null>

X1 X4 <blank> <blank> <null> <null>

X1 X2 Company 1 Company 1 
address

3/1/2002 <blank>

X1 X3 Company 2 Company 2 
address

4/1/2002 4/1/2003

X2 X3 Company 2 Company 2 
address

6/1/2002 <blank>

X1 DUMMY Company 3 Company 3 
address

<null> <null>

Given the above substitution table, Company 1 will not accept any substitution prior to 
3/1/2002. Company 2 will not accept any substitution prior to 4/1/2002, and then will 
accept X1 for X3 from 4/1/2002 to 4/1/2003, and then will accept X2 to X3 from 6/1/2002. 
As before, Company 3 will accept no substitutions.

Simulate Possible Substitutions
Once you run a plan with a given set of substitution definitions, you may realize that 
more substitution definitions are possible in the near future. You will need to run the 
plan with possible substitutions and evaluate delivery performance and other key 
performance indicators.

You can associate a Substitution Set with each substitution definition in Oracle 
Inventory. A Substitution Set is an alphanumeric field value that you can establish to 
make up a set of substitutions. Substitution Set is a global entity meaning that you can 
establish the same Substitution Set across different instances. The following table gives 
examples of substitution definitions. The From and To column of the table are defined 
in the Item Relationship window. The rest of the columns are defined in the Planning 
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Details window.

From To Substitution Set Customer

X1 X2 <null> Company X

X1 X2 <null> Company Y

X1 X3 SIM1 Company X

X1 X4 SIM2 Company X

X1 X3 SIM1 Company Y

X1 X5 SIM2 Company Y

If you run your plan without a Substitution Set, item X1 can be substituted for X2 for 
both Company X and Company Y. If you want to evaluate the results of substituting 
item X1 for item X3, you can choose Substitution Set SIM1 in the plan option and run 
the plan. Similarly, you can run a plan with Substitution Set SIM2 to evaluate the 
possibility of substituting item X1 for X4 for Company X and substituting item X1 for 
X5 for Company Y.

As explained above, you can choose a Substitution Set for a plan at plan option level. 
Oracle APS will plan using the substitution definitions tied to a Substitution Set. If you 
need to simulate with other possible substitutions, you can associate a different 
Substitution Set with a plan and run the plan. If you do not choose a Substitution Set, 
only the substitution relationships without a Substitution Set defined in Oracle 
Inventory will be considered in the plan.

Note: You must run a batch plan (as opposed to an online plan) to use 
substitution sets.

Transfer of Demands on to Substitute Supplies
The ability to show pegging and supply/demand details if you have substitution supply
identified for a demand is important because the items that bear supply and demand 
are different.

One of the ways the display can be clearly shown is when you transfer the demand 
from original item to the substitute item for all substitutions. 

Example 11
The following table shows the supply and demand for items A and B. In this example, 
30 units of item B can use 25 units of item A and 5 units of its own supply to satisfy this 
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demand.

Record Type Item Day 1

Demand A 0

Demand B 30

Supply A 25

Supply B 5

Since substitution is involved between item B and item A, Oracle APS will transfer the 
demand from item B to item A for 25 units to account for substitution. If there are 
multiple items with which item B can be substituted, you will see demands on all such 
items. In other words, the original demand will be split into possibly multiple demands 
if substitutions are involved. 

Examples Illustrating Substitution Logic
Example for customer-specific substitution, partial order fulfillment, time phasing

This example uses three customers. None of these customers accept a mix of original 
items and substitute items in any one shipment (i.e., partial orders fulfillment is not 
allowed); therefore, the entire shipment needs to be made up of either original items or 
one of the substitute items allowed based on acceptance rules described below. The 
substitution direction is always from higher level to a lower level i.e., supply from A1 
can be used to satisfy A demand.

The following profile options and item relationship rules have been set in the following 
example:

Profile Options:

• MSC: Choice of item for which to create supplies in substitute relationship = 
Demanded Item. 

• MSO: Choice of supply for substitution = All supplies

Item relationship rules:

• Partial Fulfillment = No

• Reciprocal relationship = No

Company S Example

A customer-specific item relationship is defined to substitute A1 for A effective until 
Day 6. The item attribute Substitution Window = 4 days.
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As shown in the following table, the demand for product A on Day 1 can be met with 
on hand (qty = 5), supply (qty = 10) on Day 4, and a new planned order of 5 units for A. 
The supply from substitute item A1 is not enough to make up the entire order, and the 
supply on Day 6 is out of reach due to the 4-day substitution window. The demand on 
Day 7 can be met with supply of 10 units on Day 8 and a planned supply of 40 units for 
A, because substitution of item A1 is not valid after 6 days. Substitution did not occur 
because the substitute supply was not adequate to meet the order demand.

Record
Type

Ite
m

Day 
0

Day 1 Day 
2

Day 
3

Day 
4

Day 
5

Day 
6

Day 
7

Day 8 Day 9

Deman
d

A 0 20 0 0 0 0 0 50 0 0

Supply A 5 
(on-h
and)

0 0 0 10 0 0 0 10 0

Supply A1 0 2 0 10 0 0 8 50 0 0

Company R Example

A customer-specific item relationship is defined to substitute D for C, and B for A 
effective until Day 6. The item attribute Substitution Window = 1 day.

As shown in the following table, the demand on Day 1 for item A (qty = 20) cannot be 
satisfied by substitution because partial order fulfillment is not allowed. The inventory 
of item B (qty = 15) is inadequate to meet this demand and the supply of 5 units on Day 
3 is outside the substitution window of 1 day. Therefore, it will be satisfied by 5 units of 
on hand, 10 units of supply from Day 8, and 5 units of planned supply.

Demand on Day 6 for item A for 30 units can be satisfied by substitution; i.e., 15 units of
on hand, 5 units of supplies from Day 3, and 10 units out of 50 units from Day 6.

The demand for item C, qty = 10, on Day 2 can be satisfied by 8 units of on hand and a 
supply of 2 units for D scheduled on Day 2. Demand of 60 units for item C on Day 7 can
be satisfied with an existing scheduled supply of 60 units on Day 7 for item D. Note that
with a 1-day substitution window, the supply must be available on the same day as the 
demand. Future scheduled receipts will not be utilized.

Record 
Type

Item Day
0

Day 
1

Day 
2

Day 
3

Day 
4

Day 
5

Day 6 Day 7 Day 8 Day 
9

Deman
d 

A 0 20 0 0 0 0 30 0 0 0
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Record 
Type

Item Day
0

Day 
1

Day 
2

Day 
3

Day 
4

Day 
5

Day 6 Day 7 Day 8 Day 
9

Supply A 5 
(on-
han
d)

0 0 0 0 0 0 0 10 0

Supply B 15 
(on-
han
d)

0 0 5 0 0 50 0 0 0

Deman
d 

C 0 0 10 0 0 0 0 60 0 0

Supply C 0 0 0 0 0 10 0 0 0 0

Supply D 8 
(on-
han
d)

0 2 0 0 0 0 60 0 0

Company Q Example

A customer specific item relationship is defined to substitute B for A for the next 5 days 
and D for C for the next 10. The item attribute Substitution Window = 2 days.

As shown in the following table, demand for 20 units of item A on Day 1 can be 
satisfied completely by substituting the two scheduled supplies of item B, 10 units on 
Day 1 and Day 3. The demand for item A on Day 7 can be satisfied using 10 units of 
supply on Day 8 and a new planned supply of 40 units on Day 7 as the substitution rule
is not effective after Day 6. The demand for item C can be satisfied with substitution for 
both demands, because it's substitution rule is effective until Day 10.

Record 
Type

Item Day 
0

Day 1 Day 
2

Day 
3

Day 
4

Day 
5

Day 
6

Day 
7

Day 
8

Day 
9

Demand A 0 20 0 0 0 0 0 50 0 0

Supply A 8 
(on-
hand
)

0 2 0 0 0 0 0 10 0
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Record 
Type

Item Day 
0

Day 1 Day 
2

Day 
3

Day 
4

Day 
5

Day 
6

Day 
7

Day 
8

Day 
9

Supply B 0 10 0 10 0 0 0 50 0 0

Demand C 0 0 10 0 0 0 0 60 0 0

Supply C 0 0 0 0 0 0 0 0 0 0

Supply D 0 0 10 0 0 0 0 60 0 0

Example for Native Demand Fulfillment, Substitution Window, Partial Order 
fulfillment 

In the following example, A2 supply can be substituted with A1 demand. Substitution 
window is 2 days.

As shown in the following table, on Day 1, you have demand for both A1 and A2. 
Because of native demand fulfillment rule, only excess supply after fulfilling native 
demand can be used for substitution. Therefore, demand for A1 will not be satisfied by 
supply for A2 on Day 1. The situation is the same on Day 2; you do not have excess 
supply of A2 to satisfy A1's demand. The demand for A1 on Day 1 will be met with 
supply for A1 on Day 3 and a planned supply of 3 units for A1. This is due to the Partial
Order fulfillment rule. 

The demand for A1 on Day 2 will be satisfied with 3 units of A2 (which is excess supply
of A2 from Day 3) and a planned supply of A2 for 2 units. The planned supply has to be
for A2 because the rule is Partial Order fulfillment. The supply of A2 on Day 6 is not 
open because of substitution window. 

Record 
Type

Item Day 1 Day 2 Day 3 Day 4 Day 5 Day 6

Demand A1 5 5        

Demand A2 15 10 5   10 5

Supply A1     2      

Supply A2 15 10 8     20

Example for Search the Supply Chain for Substitution, Substitution Window, Use Up

In this example there are three facilities: Facility 1, 2, and 3. The transfer times between 
facilities is 2 days; the window for substitution is 2 days. The supply and demand 
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picture for 3 items A1, A2, A3 is shown in the following tables. A3 is the lowest level 
and it can accept either A1 or A2 supply. A2 can accept A1 supply, but A1 cannot accept
any substitutions. 

The search rules are to search Facility 1 first, Facility 2 second, and Facility 3 third.

Facility 1

Recor
d 
Type

Ite
m

Da
y 1

Da
y 2

Day
3

Day
4

Da
y 5

Day
6

Da
y 7

Da
y 8

Day 
9

Day 
10

Day 
11

Day 
12

Dema
nd

A3     10     3            

Suppl
y

A2           3            

Facility 2

Recor
d Type

Item Da
y 1

Da
y 2

Day
3

Day
4

Da
y 5

Da
y 6

Day 
7

Day 
8

Da
y 9

Day 
10

Day 
11

Day 
12

Deman
d 

A2     10                  

Supply A1 2             5        

Supply A2 5                      

Facility 3

Reco
rd 
Type

Ite
m

Day 
1

Day 
2

Day 
3

Day 
4

Da
y 
5

Day 
6

Da
y 7

Day
8

Day
9

Day 
10

Day 
11

Day 
12

Dem
and

A1               10        

Supp
ly

A1       10           5    
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Reco
rd 
Type

Ite
m

Day 
1

Day 
2

Day 
3

Day 
4

Da
y 
5

Day 
6

Da
y 7

Day
8

Day
9

Day 
10

Day 
11

Day 
12

Supp
ly

A3 3     3                

Demand on Day 3 for A3 in Facility 1 will be satisfied with 2 units of supply of A1 and 5
units of supply at Facility 2, and 3 units of supply of A3 at Facility 3. Facility 2 is the 
next logical facility to search based on our rules.

The 10 units of demand on Day 3 for A2 at Facility 2 will be satisfied with transferring 
10 units of A1 from Facility 3, i.e., you will get a recommendation to reschedule the 
order to Day 1 so that you can transfer it in time to make the substitution. Notice that 
the 5 units of supply for A1 is outside the substitution window.

The 3 units of demand on Day 6 for A3 can be met by transferring supply of A3 from 
Facility 3. The 10 units of demand on Day 8 for A1 can be satisfied by transferring 5 
units of A1 from Facility 2 and using the 5 units of supply available in Facility 3. In both
cases, you will get recommendations to reschedule the order so that you will satisfy 
demand on time. 

General Substitution Examples
Tie between Demanded and Substitute Item Supply

Item A and A1 are substitute items. Item A can use A1's supply to satisfy the demand. 
This is a one-way substitution. Substitution window is set to 5 days.

As shown in the following table, the demand on Day 2 has two supplies to consider: 60 
units of its own supply on Day 50 and supply of a substitute item on Day 2. The 
preference is to substitute right away, i.e., apply substitute supply of 60 units on Day 2 
to satisfy the demand for 60 units of item A. This goes contrary to regular planning 
logic of planning item by item where you would pick up supply on Day 50. 

If the supply for A1 were to be on Day 15, you would not pick up substitute supply as it
is outside the substitution window. If there is no time advantage and both demanded 
item and substitute item are available on the same day, you pick up demanded item's 
supply (i.e., A1's supply)

Record Type Item Day 2 Day 15 Between 
Day 16 and 
Day 49

Day 50

Demand A 60 0 0 0

Supply A 0 0 0 60
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Record Type Item Day 2 Day 15 Between 
Day 16 and 
Day 49

Day 50

Supply A1 60 0 0 0

Search Direction and Transferring Demands

Example 11
A supply chain is shown in the diagram below. In the diagram M1, S1, D2, M2, D2, and 
P1 are Organizations. V1 is a supplier. Organization M1 sources from S1 and D2 in a 
ranked order. Organization D2 sources from three different sources. (Make at, Transfer 
from, Buy From). Your desired search sequence is M1, S1, D2, M2, P1 and V1.
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Figure title

The following tables show supply and demand for the organizations in the diagram.

In this example, you have two items; A and A1. A can use A1 supply due to 
substitution rules. Both item A and A1 are enabled in all organizations. Assume that 
you do not have any supplies at Organization M2, P1 and supplier V1.

Org: M1

Record Type Item Day 2 Day 5 Day 10 Day 20

Demand A 100 0 0 0
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Record Type Item Day 2 Day 5 Day 10 Day 20

Supply A 0 5 0 10

Supply A1 0 0 15 0

Org:S1 

Record Type Item Day 2 Day 5 Day 10 Day 20

Demand A 0 0 0 0

Supply A 20 0 0 0

Supply A1 10 0 0 0

Org. D2

Record Type Item Day 2 Day 5 Day 10 Day 20

Demand A 0 0 0 0

Supply A 0 10 0 0

Supply A1 0 0 10 0

Starting with a demand for 100 units of Item A in Organization M1 on Day 2, you 
consume 30 units of supply from A and A1 leaving you with a net demand of 70 units. 
A planned order demand for item A is created and pushed down to Org S1, where you 
will consume 20 units of supply from Item A and 10 units of supply from item A1. 
(Notice that the demand is pushed down for A instead of A1. If you push down the 
demand on A1, you run a risk of not using supply from item A). Now you are left with 
a net demand of 40, for which you create a planned order demand for item A and push 
it down to Org D2. You consume 10 units of supply from both A and A1 leaving you a 
net deficit of 20 units.

Now that you have exhausted all original item supplies and substitute supplies in the 
supply chain, you need to still produce 20 units. The creation of 20 units of supply 
follows the normal planning logic. 
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Optimization
So far we have seen how rules-based substitution works in Oracle APS. The logic is 
driven by set of rules rather than various costs that play a role in substitution decisions 
in an optimized plan. If you want your substitution logic to be driven purely by costs, 
you can run optimized plans based on costs. Substitution definition remains the same, 
but many of the rules described above may not be followed. Standard cost of items, 
carrying costs, penalty costs for satisfying the demand late, objectives chosen at the plan
will affect the logic of substitution. 

Exception Messages
When substitution occurs in Planning, an exception message is generated. A typical 
planning process may consist of analyzing exceptions generated by the plan, drilling 
into the details of exceptions, analyzing supply demand records using the 
Supply/Demand window, vertical plan and pegging. In this process you may access 
substitution definition and characteristics several times. Users may access the horizontal
plan to get a detailed understanding of the demands placed by the substitution, 
supplies received as a part of substitution logic, and analyze possibilities of improving 
the solution based on their knowledge. 

Exception Display
When the system performs a substitution, the following exception message is 
generated: Demand satisfied using end item substitution. These exceptions are 
summarized in the Substitutes and Alternates Used exception group.

Exception Details
Oracle APS converts the demand from the original item to substitute items if substitute 
supply is found. Access the Exception Details window to view the demand that has 
been satisfied by the substitute item.

Use the information in the following table to specify the fields and options.

Field Description

Org. Organization in which the exceptions 
occurred

Item The item for which you received the demand, 
the exception is for this item. 

Quantity The quantity on the original order
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Field Description

Order number Sales Order Number or MDS/Forecast name 
for the From item 

Substitute items This is the item to which the demand was 
transferred.

Substitute Qty. The demand transferred quantity.

Substitute Org. The organization at which you found the 
supply

From the end item exception, you can select either the Items or the Supply/Demand 
window.

If you right-mouse click from the exception detail, the following menu appears: 
Demand, Sources, Destination, Horizontal plan, and Vertical plan.

To view these demands, select the exceptions message and select the Supply/Demand 
button. The Demand window shows you each demand for that record.

You can look at pegging for each record from the Demand window to analyze 
replenishment for each demand. The Original Item and the Original Quantity are fields 
that are available in the Demand window that may be helpful in understanding 
substitute exceptions. These are optional fields that can be added to the window by 
selecting Folder > Show Fields.

If substitute supply is found in another organization, you will be able to see the original
organization in the pegging details for that demand. 

You can release the substitute item to the sales order through Planner Workbench. See 
Substitutes and Alternates Used Exception Group, page 17-97, exception message 
Demand satisfied using end item substitution. 

Exception Details Example
Oracle ASCP converts the demand from the original item to substitute item/s if 
substitute supply is found. In the following example, Plug in Card 100 can be 
substituted for Plug in Card 150 and Plug in Card 200. You have 50 units of Plug in 
Cards 150 and 200 in stock and you receive 100 units of demand for Plug in Card 100. 
Oracle ASCP splits the original demand (for Plug in Card 100) of 100 units into two 
pieces; the first will be demand for 50 units of Plug in Card 150, the second demand will
be for 50 units of Plug in Cards 200. The demand has been transferred to the substitute 
item. The rest of this section explains how review the exception details. 

Once you identify that demands have been satisfied by substitute items from 
exceptions, you can navigate to the Demand window from the Exception Details 
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window. Select the record and right-click. Select Demand from the drop-down menu. 
This is available for each line of the exception message Demand Satisfied by Substitute 
End Items. The Demand window shows you all the demand splits associated with the 
original demand. 

If you navigate to the Demands screen from the exception message Demand Satisfied 
by Substituting End Items for item Plug in Card 100, you will see two records in 
Demands window; the first will be demand for 50 units of Plug in Card 150; the second 
demand will be for 50 units of Plug in Cards 200. If you happen to have 10 units of Plug 
in Card 100 in stock you will see three records as follows:

• 10 units of demand for Plug in Card 100

• 40 units of demand for Plug in Card 150

• 50 units of demand for Plug in Card 200

End Item Substitution Workflow for Planning
If you plan for substitution, it is only logical to initiate the execution of the substitution 
from Planning. A general workflow is initiated by the Planning engine to notify 
relevant people in your organization of substitution decisions.

You can also release the substitute item to the sales order through Planner Workbench. 
See Substitutes and Alternates Used Exception Group, page 17-97, exception message 
Demand satisfied using end item substitution. 

For each occurrence of the exception message: Demand Satisfied by Using End Item 
Substitution, a workflow is initiated and sent to the planner associated with the original
item. At this point you can end the workflow or notify the Sales Representative or the 
Customer Contact of the substitution.

Following is a diagram of the workflow initiated by the planning engine. You will 
notice that there is not an alternative to change the line item based on the workflow. 
Users can manually change the line items as long as the orders are in a pre-booking 
stage. 
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Workflow Initiated by the Planning Engine

The heading of the workflow is Demand Satisfied by Substituting End Items. The 
following details are shown in the workflow:

• From item: The item for which you received the demand, the exception is for this 
item.
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• Plan name: Name of the plan 

• Order Number: Optional based on the type of demand

• Line Number: Optional based on the type of demand

• Original Quantity: The requested quantity 

• Substitute item: Substitute item, this is the item to which the demand was 
transferred. These could be multiple items. 

• Organization: Organization at which the exceptions happened.

• Substituted Quantity: The demand transferred quantity. 

• Substitute Supply Organization: The organization at which you found the supply.

End Item Substitution and Oracle Global Order Promising 
Substituting supply of a higher level item (in a substitution chain) for a demand from 
lower level item (in a substitution chain) demand is a decision that needs to begin with 
Oracle Global Order Promising. Since both ASCP and Oracle Global Order Promising 
processes are analyzing the same data, the logic with which the substitutions are done 
needs to be consistent. Oracle Global Order Promising supports almost all the features 
mentioned in the End Item Substitution Features section. In some cases, the way Oracle 
Global Order Promising supports the product substitution features is slightly different 
from the planning engine.

For more information, see End Item Substitution in Oracle Global Order Promising 
Implementation and User's Guide.

User-Defined Alternate Decision Rules
This section discusses the following topics:

• User defined alternate decision rules for constrained plans

• User-defined alternate decision rules for optimized plans

• Planning search logic

User-Defined Alternate Decision Rules for Constrained Plans
This feature allows you to automatically select alternate routings, resources, bills of 
material, items, and sources.

It does this by providing decision rules giving you the ability to do the following: 
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• Intelligently select alternatives with the minimum data input prerequisites possible.
You can run a supply chain plan that automatically selects alternate routings, BOM,
resources, suppliers, internal sources, end-items and components with the 
minimum amount of input.

• Enforce a specified sequence of decision-making actions (which may mimic a 
planner's problem resolution thought process.) The sequence in which the planning 
engine looks for supply using standard Oracle Application functions is transparent 
to the user. (For example you may specify substitutes for a given component but 
not alternate sources.). You can specify a global decision rule when more than one 
supply source can satisfy the demand. (For example if you have specified both 
substitutes and alternate sources, you can choose one over the other.)

• Make easier APS planning decisions because the decision-making process is more 
transparent. You can select alternates when the primary source of supply is unable 
to satisfy the demand. In doing so, you can express your preference as business 
rules, such as: the alternate resource should be used before looking for alternate 
supply and substitute components. 

• Restrict planning to a universe of authorized decision-making actions (for example, 
permit exploration of alternate routings and substitute items but not of sourcing or 
permit substitute components but do not permit end item substitution, even though
rules are specified for the given items at the source level.

If you opt to use the User Defined Decision Rules for constrained plans, you do not 
have to setup the complete cost data and cost penalty factors for end item substitutes, 
substitute components, alternate bills of material (BOM)/routings, and alternate sources 
of supply. While optimization requires accurate costing of all entities to arrive at useful 
results, User Defined Decision Rules do not consider costs. The selections are done 
based on the priorities you enter in the source instance. For example, for substitute 
components, if the primary component that you selected is not available, then the 
planning engine considers the priority 2 substitute. If the priority 2 substitute is not 
available, then the planning engine considers the priority 3 substitute, and so on. 

User Procedures
Constrained Plans and Alternate Rules - Two Methods

Please note that there are two different methods of constrained planning and the 
method to be used is determined by the site profile option MSO: Enable Decision Rules. 
If MSO: Enable Decision Rules is set to No (this is the default), you cannot use any 
alternate rule except for alternate resources, and to some extent, alternate suppliers. If 
MSO: Enable Decision Rules is set to Yes, you can select and define alternate rules. The 
rules are used by the planning engine according to the order in which they appear in 
the Decision Rules tab of the Plan Options window. For additional details, please refer 
to 'Constraint-Based Planning, page 9-1.

The following steps and diagrams outlines the procedures used to select alternates for a 
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constrained plan. The steps provide a more in-depth explanation for the procedures 
shown in the diagrams.

To select alternates using a constrained plan
1. Perform your source data setups.

2. Define or open the Plan Options window.

3. Set up the desired plan options using all the appropriate tabs from this window.

4. If you have set the profile option MSO: Enable Decision Rules to No, none of the 
following steps apply. Go to step 7.

5. If you have set the profile option to Yes, you can select the Decision Rules tab if you
want to change the default settings, which are shown in the following table:

Decision Rule Status

Use End Item Substitution <cleared>

Use Alternate Resources <selected>

Use Substitute Components <selected>

Use Alternate BOM/Routing <selected>

Use Alternate Sources <selected>

6. Enable or disable decision rules.

You can enable and disable the decision rules for constrained plans. These decision 
rules are used to derive the constrained plan, while honoring your preferences. If 
any of the rules are disabled, then the planning engine will not have the ability to 
look for supply pertaining to these rules. 

The meanings of the decision rules are shown in the following table:

Decision Rule Status Meaning

Use alternate sources <selected> Use primary sources as far 
as possible and use alternate
sources only if necessary.
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Decision Rule Status Meaning

Use alternate sources <cleared> Use primary sources only. 
Alternate sources (sources of
rank 2 or higher) will not be 
used as a source of supply. 

Use alternate BOM/routings <selected> Use primary routing as far 
as possible and use alternate
only if necessary.

Use alternate BOM/routings <cleared> Use only primary 
BOM/Routing

Use alternate resources <selected> Use primary resource as far 
as possible and use alternate
resource only if necessary.

Use alternate resources <cleared> Use only primary resources

Use end item substitutions <selected> Use primary item and end 
item substitute, when 
enabled, prior to creating 
new planned orders.

Use end item substitutions <cleared> Use only the demanded 
item. Do not use the end 
item substitute.

Use substitute components <selected> Use primary items as far as 
possible and use substitute 
component only if 
necessary.

Use substitute components <cleared> Use primary 
items/components only.

7. If you want the planning engine to use more alternate resources, routings, and 
sources from the user-defined decision rules, set profile option MSO: Resource 
Adjustment Factor For Improved Offloading to Alternates. Use a number between 
and including 0 and 1.

The factor adds a resource constraint which reduces resource availability; for 
example, if you enter 0.8, the planning engine reduces the resource availabilities by 
20%. The planning engine offloads more work to alternate supply methods. 



Supply Chain Plan Business Topics    12-43

This factor affects how the planning engine decides to select alternates. It does not 
affect the final scheduling and resource loading process.

Features
The major features include: 

• Data setup for decision rules

• Site level profile option, MSO: Enable Decision Rules

• Constrained plans based on user-enabled decision rules 

• Support for current APS engine's logic and behavior for constrained plans.

Profile OptionMSO: Enable Decision Rules

The site level profile option MSO: Enable Decision Rules enables or disables the 
Decision Rules tab in the Plan Options window. If this profile option is set to Yes, the 
Decision Rules tab is enabled and the decision rules you set using this tab are used; if it 
is set to No, the Decision Rules tab is disabled and the APS engine uses the current 
engine logic for planning. 

The default display status of the Decision Rules tab depends on the status of the tab in 
the plan's previous run. If in the previous run, this profile option was set to No, then the
Decision Rules tab displays the default status (all decision rules checked) of the 
Decision Rules tab. If in the previous run, the profile option was set to Yes, then the 
Decision Rules tab displays the status of the tab as it was in the last plan run. 

Decision Rules Implementation for Constrained Plans

The main objective of the constrained plan is to meet demand in time. There are two 
options in the constraint planning mode: Enforce Demand Due Dates and Enforce 
Capacity. You can choose these in the Constraints tab of the Plan Options window. 
These are used to describe the objective of the constraint plan.

You can define the various constraints (material or resources or both) using the 
Constraints tab in the Plan Options window. 

To invoke this option of using the decision rules for constrained plan, you set the site 
profile option MSO: Enable Decision Rules to Yes. The default for this profile is No. 
When this profile option is set to No, constrained plans will be based on the current 
constrained planning engine. 

Criteria for Selection of Alternates

It is possible to have multiple alternates for sourcing, substitute components, resources 
and BOM/Routing. This section deals with the use of source data setup for selection of 
alternates. 

Alternate Sources:
You can define the priority of the sources in the sourcing rule. By default, the planning 
engine tries to minimize the use of alternate sources. But if it necessary to use the 
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alternate sources, then the planning engine uses the rank that you have assigned to the 
source for selecting the alternates. An example of such a situation is if you would like to
use and exhaust the supply from the sources with a higher rank before you select one 
with lower rank. When there is more than one source set at the same rank, planning 
searches for supply in the following order

1. Make

2. Transfer

3. Buy

If you have specified more than one source of supply of the same type, planning uses 
the supply at its discretion. (For example you have two make sources and both are at 
priority 1).

The above search assumes that you have not enforced sourcing splits. You can define 
ranks for Alternate Sources using the Sourcing Rules and Bill of Distribution screens. 
For additional information, see Setting Up the Supply Chain, page 6-2.

Substitute component:

You can define the priority of the substitute component. By default, planning tries to 
minimize the use of substitutes. Also, the planning engine has an built-in logic that tries
to use substitutes at a lower level in your BOM than close to product completion in the 
BOM. Planning will honor the priority that you have defined while searching for 
supply from the various substitutes. 

You can define priorities for Substitute Components in the Substitute Component 
Information screen. 

For additional information on this screen, please refer to the Oracle Bills of Material 
User's Guide.

The diagram below indicates the planning logic for a component B with B1 as the 
substitute component. As shown in the diagram, Planning will look for projected 
available supply of item B (on hand and existing supplies) and then projected available 
supply for item B1. After that, Planning will recommend creating a planned order for 
item B using primary BOM/Routing and alternate resources. Planning will then 
generate planned orders for item B1 using primary BOM/Routing and alternate 
resources. If additional supply is needed, Planning will use the alternate BOM/Routing 
for item B and then for item B1 before looking to source items B and B1 from an 
alternate source/facility.
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Planning Logic for Substitute Component

Alternate Resources:

By default, the planning engine tries to minimize the use of alternate resources. But if it 
has to use the alternates, it uses the priority you have assigned to the alternate resource 
while using the capacity from this resource to build supply. If more than one resource is
specified at the same rank, then the planning search is at its discretion for constrained 
plans. 

You can define priorities for Alternate Resources using the Operation Alternate 
Resources screen.

The rank that you specify for Replacement Group in the Operation Alternate Resources 
screen is the priority of the alternate resources.

Alternate BOM/Routing:

Planning uses the combination of Bill of Material definition and the routing of a 
particular item to define the process. If the planning engine selects an alternate bill of 
material that does not have a corresponding routing, it uses the primary routing. If the 
planning engine selects an alternate routing that does not have a corresponding 
alternate bill of material, the planning engine uses the primary bill of material. 

By default, the planning process tries to minimize the use of lower priority 
BOM/Routing. You can specify the priority in the Routing Details form.

Note: In the Routing Details form, priorities for routings are unique, so 
you cannot assign the same priority to two different routings for a 
different item. However, internally you may get the same priority for 
two different routings. How this happens is explained in the next 
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section.

You can define priorities for Alternate BOM/Routing using the Routing Details screen.

Default BOM/Routing Priority

If you do not specify any priority for the BOM/Routing in the Routing Details form, the 
following rule will apply for calculating the default priority:

• If the alternate designator is NULL, then default priority will be internally assumed 
to be 1

• If you specify an alternate designator for the BOM/Routing, then the default 
priority will be internally assumed to be 2

User-Specified BOM/Routing Priority

You have the ability to specify any priority to a particular BOM/Routing. Planning uses 
the priority to load the particular BOM/Routing for supply derivation. The ability to 
specify any priority to any BOM/Routing gives you the flexibility to assign a higher 
priority to an alternate BOM/Routing. 

For example, you can designate a BOM/Routing whose alternate designator is NULL to 
2 and specify a priority of 1 to BOM/Routing that has a valid alternate designator of 
ALT_ROUTE_2. Planning will honor the priority and suggest BOM/Routing as defined 
by alternate designator ALT_ROUTE_2 before using the BOM/Routing with the 
alternate designator as Null.

Note: When there is more than one alternate of the same rank, then planning will use 
the supply at its discretion. For example for a given item A:

• BOM/Routing1: alternate designator = NULL, priority = 1 

• BOM/Routing2: alternate designator = ALT_ROUTE_2, priority = 1 

• BOM/Routing3: alternate designator = ALT_ROUTE_3, priority = 2 

In this case, the planning engine will try to use either Routing1 or Routing2 first. Then, 
if necessary, it will try to use Routing2 or Routing1. Then, if necessary, it will move on 
to Routing3.

Note: For information on End-Item Substitutions, please refer to 
End-Item-Level Substitution, page 12-1. 

Examples of How Alternate Decision Rules are Used
This section contains three scenarios that describe how alternate decision rules are used.

The following tables provide background information for the three scenarios.

Day 0 Demand Information
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Product Demand Due Date Capacity

A 60 units 1 100 units/day

A 120 units 2 100 units/day

A 80 units 3 100 units/day

Bill of Material for Item A 

Component 
(Make/Buy)

Op sequence Quantity Substitute

B (Make) 10 1 D (Make)

C (Buy) 20 2 E (Make)

Routing for Item A

OP Sequence Operation Resource Alternate

10 Milling M10 M20 

20 Grinding G10 G20

Capacity information:

Resource Capacity

M10 60 units/day

M20 60 units/day

G10 100 units/day

G20 100 units/day

Project available on Day 2: 
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Type Units

Item A 0

Component B 90

Component C 200

Sub. Component D 30

Sub. Component E 100

Sourcing rule for Item A:

Rule Org % Priority Capacity

Make at org M M 100 1 (Primary) 100/day

Source from org 
S

S 100 2 (Alternate) 60/day 
(lead-time 1 day)

Suppliers and capacity:

Supplier Item Capacity Priority Sourcing %

Test 1 C 50 1 (Primary) 50

Test 2 C 100 2 (Primary) 50

Scenario I:
The default ranking is shown in the following table:

Rank Objective

1 Use end item substitutions

2 Use alternate resources

3 Use substitute components 
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Rank Objective

4 Use alternate BOM/Routing 

5 Use alternate sources

The planning engine plans for the 120 units of Item A on Day 2 by combining the 
following two actions: 

1. Use alternate resource (M2/G10) along with primary (M10/G10) 

2. Use component substitutions for B (B 90 + D 30) and C (C 200 + E 40)

If the demand on Day 2 is only 90, then the solution is achieved by selecting only 
alternate resources (alternate resource (M20/G10) along with primary (M10/G10).

Scenario II:
The decision rule Use Substitute Components is unchecked. This makes the default 
ranking: 

Rank Objective

1 Use end item substitutions

2 Use alternate resources

3 Use alternate BOM/Routing

4 Use alternate sources

The planning engine plans for 120 units of Item A on Day 2 by combining the following 
two actions:

1. Use alternate resource (M20/G10) along with primary (M10/G10) to make 90

2. Source 30 of Item A from Org S.

The planning engine completely ignored the opportunity of available supply from the 
component substitutes. 

Scenario III:
The information in the following table helps to illustrate the role of Enforce sourcing 
splits and Enforce capacity constraints. The net demand for Item C is 200
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Supplier Capacity Enforce 
Demand Due 
Dates and 
Enforce 
Sourcing Splits 
on

Enforce 
Capacity 
Constraints on 
and Enforce 
Sourcing Splits 
off

Enforce 
Capacity 
Constraints on 
and Enforce 
Sourcing Splits 
on

Test 1 50 units Supplies 100 Supplies 50 Supplies 50

Test 2 100 units Supplies 100 Supplies 100 Supplies 100

Assume that Supplier Test1 has a capacity of 50 units of Item C and Supplier Test2 has a
capacity of 100 units of Item C. Also, assume the net demand for item C is 200 units. If 
we enforce sourcing splits, then Test1 would have to supply 100 units and Test2 would 
also have to supply 100 units. (Assuming Enforce Demand Due Dates is enabled)

If Enforce Capacity Constraints is enabled, then Supplier Test1 would have to supply 50
units and Supplier Test2 would have to supply 100 units. Supply for 50 units would be 
on a different day. (Assuming Enforce sourcing splits is disabled.) 

If both Enforce Capacity Constraint and Enforce Sourcing Split are enabled then 
Supplier Test1 would supply 50 units, Supplier Test2 would supply 100 units and the 
remaining 50 units would be on a different day. Please note that the Enforce Demand 
Due Dates and the Enforce Capacity Constraints takes precedence over Enforce 
Sourcing Splits. The sourcing splits are valid only for rank 1 sources and are enabled by 
default for a constrained plan.

Selection of Alternates for OSFM
This section contains two scenarios that describe the selection of alternates for network 
routing based on:

• Primary Path

• Planned Percentage

(For additional information, please see'Network Routings, page 19-94). The optimize 
scheduling method is not supported for constrained plans that use user-defined 
decision rules. The following diagrams and the first table provides background 
information for the two scenarios.

The following diagram shows the BOM for Item A where B1 is the substitute for B.
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Bill of Material

The next diagram shows network routing for Item B. The capacity at Operation 20 is 80 
per day and the capacity at Operation 30 is 40 per day. The percentage split at 
Operation 10 is 50% each for Operation 20 and 30.

Network Routing for Item B

The following diagram shows network routing for Item B1. The capacity at Operation 
30 is 80 per day, and the capacity at Operation 40 is 40 per day. The percentage split at 
Operation 10 is 25% for Operation 20, 50% for Operation 30, and 25% for Operation 40.

Network Routing for Item B1
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The following table shows the demand for Item A.

Demand Date Quantity

A 1 80

A 2 120

A 3 160

Scenario I
The following table shows how supply would be affected if the scheduling method was 
Primary Path.

Item Date Supply

A 1 80

A 2 120

A 3 160

B 1 80

B 2 80

B 3 80

B1 2 40

B1 3 80

All the demand for Item A will be met on time. To meet the demand on Days 2 and 3, 
substitute item B1 is selected. On Day 2, the demand for 120 is satisfied with a supply of
80 units of item B and 40 units of items B1, whereas on Day 3 the demand for 160 units 
of item A requires 80 units of item B and 80 units of item B1, all using only the Primary 
operation sequences.

Note that there is no supply available from the alternate path when the planning 
method is based on the primary path.

Scenario II
The following table shows how supply would be affected if the scheduling method was 
Planned Percentage.
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Item Date Supply Alternate

B 1 40 10-20

B 1 40 10-30

B 2 40 10-20

B 2 40 10-30

B1 2 10 10-20

B1 2 20 10-30

B1 2 20 10-40

All the demand for item A is met on time, but since the network scheduling method is 
based on Planned Percentage, both the Primary and the Alternate nodes are used to 
meet the demand in time. For example, item B is produced on both nodes 10-20 and 
10-30 by placing a demand of 40 units per each node.

Note that the maximum capacity is constrained by the most-capacity-constraining node 
of the network routing.

Simulations and User-Defined Decision Rules
When simulating constrained ASCP plans, do not toggle the site level profile option 
MSO: Enable Decision Rules. Switching the profile option values and running online 
plans may lead to erroneous results. 

When simulating the changes in demand priorities, keep the priorities contiguous. For 
example, if the original demand priority for Demand1, Demand2 and Demand3 for a 
demanded item were 1, 2, and 3 respectively, you can change the demand priority for 
Demand1, Demand2 and Demand3 to 2, 1, and 3 but not 2, 1, and 18. 

For further details on plan simulations, please refer to Simulations, page 7-1.

User-Defined Alternate Decision Rules for Optimized Plans
This feature allows you to automatically select alternate routings, resources, bills of 
material, items, and sources. Optimized plans provide the most cost-effective planning 
solution.

It does this by providing decision rules giving you the ability to do the following: 

• Intelligently select alternatives with the minimum data input prerequisites possible.
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You can run a supply chain plan that automatically selects alternate routings, BOM,
resources, suppliers, internal sources, end-items and components with the 
minimum amount of input.

• Enforce a specified sequence of decision-making actions (which may mimic a 
planner's problem resolution thought process.) The sequence in which the planning 
engine looks for the most cost-effective supply using standard Oracle Application 
functions is transparent to the user. (For example you may specify substitutes for a 
given component but not alternate sources.). You can specify a global decision rule 
when more than one supply source can satisfy the demand. (For example if you 
have specified both substitutes and alternate sources, ASCP will select the most 
optimal solution. In case of multiple cost-effective solutions, ASCP will use the 
decision rule sequence to arrive at the solution.)

• Restrict planning to a universe of authorized decision-making actions (for example, 
permit exploration of alternate routings and substitute items but not of sourcing or 
permit substitute components but do not permit end item substitution, even though
rules are specified for the given items at the source level.)

Note: The site level profile option MSO: Enable Decision Rules has 
no bearing on an optimized plan. The Decision Rules tab in the 
Plan Options window is always available for an optimized plan.

User Procedures
The following steps and diagram outline the procedures used to select alternates for an 
optimized plan. The steps provide a more in-depth explanation for the procedures 
shown in the diagrams.

To select alternates using a constrained plan
1. Define cost and penalty factors at various levels to model required behavior.

2. Perform data setups.

3. Define or open Plan Options window.

4. Set up your plan parameters using all the appropriate tabs.

5. Choose the Constraints tab and select the Constrained Plan checkbox. 

6. Choose the Optimization tab and select the Optimize checkbox.

7. Set up the required parameters for plan objectives and penalty factors.

8. If you want to make changes to the default decision rule, choose the Decision Rules 
tab. If not, skip to step 10.
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9. Enable or disable decision rules.

You can enable and disable the decision rules. These decision rules are used to 
derive the optimized plan, while honoring your preferences. If any of the rules are 
disabled, then the planning engine will not look for supply pertaining to these 
rules. 

The meanings of the decision rules are shown in the following table:

Decision Rule Status Meaning

Use alternate sources <selected> Use primary sources as far 
as possible and use alternate
sources only if necessary.

Use alternate sources <cleared> Use primary sources only 
and alternate sources 
(sources of rank 2 or higher) 
will not be used as a source 
of supply. 

Use alternate BOM/routings <selected> Use primary routing as far 
as possible and use alternate
only if necessary.

Use alternate BOM/routings <cleared> Use only primary 
BOM/Routing

Use alternate resources <selected> Use primary resource as far 
as possible and use alternate
resource only if necessary.

Use alternate resources <cleared> Use only primary resources

Use end item substitutions <selected> Use primary item and end 
item substitute, when 
enabled, prior to creating 
new planned orders.

Use end item substitutions <cleared> Use only the demanded 
item. Do not use the end 
item substitute.
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Decision Rule Status Meaning

Use substitute components <selected> Use primary items as far as 
possible and use substitute 
component only if 
necessary.

Use substitute components <cleared> Use primary 
items/components only.

10. If you want the planning engine to use more alternate resources, routings, and 
sources from the user-defined decision rules, set profile option MSO: Resource 
Adjustment Factor For Improved Offloading to Alternates. Use a number between 
and including 0 and 1.

The factor adds a resource constraint which reduces resource availability; for 
example, if you enter 0.8, the planning engine reduces the resource availabilities by 
20%. The planning engine offloads more work to alternate supply methods. 

This factor affects how the planning engine decides to select alternates. It does not 
affect the final scheduling and resource loading process.

Features
The major features include: 

• Setup for the weighted objectives for optimization

• Data setup for decision rules

• Optimization based on user-defined weights for the objectives and user-enabled 
decision rules 

Define Plan Objectives

You can prioritize the plan objectives as weights. The list of plan objectives is provided 
in the following table. You can define and set the weight for the objectives for each 
optimized plan. 

Objective Weight

Maximize inventory turns 0 to 1

Maximize plan profit 0 to 1

Maximize On-time delivery 0 to 1
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For additional information, please refer to 'Optimization, page 8-1.

Optimization Based on User-Defined Priority for Decision Rules

You have the ability to disable any decision rules for a particular plan prior to 
launching the plan. 

The base data setup like items, bill of materials and sourcing rules are used to 
recommend the most optimized plan based on the objectives you have specified. 
User-defined decision rules and the priority of the decision rules will be honored for tie 
breaking amongst various cost-effective solution possibilities. For example, ASCP may 
suggest the use of alternate resource instead of the primary resource, if alternate 
resource is more cost effective than the primary resource. This is shown in the following
example:

First, use the examples in the section 'Examples of How Alternate Decision Rules are 
Used, page 12-46 section starting and then also assume that the cost of making item A in
Org M is $100 and the cost of buying from Supplier S is only $60. The demand for 120 
units on day 2 would be satisfied by procuring 60 units from Supplier 1 and then 60 
more from making 60 units of item A using resources M10 and G10 and using 60 units 
of item B and 120 units of item C. 

The constrained plan would recommend the use of a higher ranked source (Org M) 
before using a lower ranked source (Supplier S); however, the optimized plan would 
recommend using the most cost-effective source. 

However, if both making at Org M and buying from Supplier S were $100, the 
optimized plan would recommend the use of Org M because it is a higher ranked 
source. 

Planning Search Logic
This section describes the planning search logic for user-defined alternate decision rules
for both optimized and constrained plans. The planning logic uses a series of steps 
depending on the constraints used for the plan. The planning search logic is illustrated 
below using the supply chain for assembly item A with end-item substitute item A1. 
Item A is made of B and C with B1 and C1 as the substitute components. B and C in 
turn need items D and E respectively. To simplify the search we will not expand the 
substitute component B1 and C1 and also assume the same BOM and routing for All 
items across Manufacturing 11 and Manufacturing 21. In addition, we have made the 
following two assumptions: 

• There is high demand placed on the distribution center 

• For optimized plans, cost effectiveness at each node across the given supply-chain 
is the same
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Supply Chain for Item A

The planning engine searches on-hand quantity and schedules receipts (item A and end
item substitute A1) across each tier before creating new planned orders for the 
demanded item. (Please refer to End Item Substitution chapter). To look for on-hand 
quantity and scheduled receipts of the demanded item and the end-item substitute, 
ASCP uses the search logic as specified below. 

1. Distribution center for item A

2. Distribution center for item A1
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3. Warehouse 1 for item A

4. Warehouse 1 for item A1

5. Manufacturing 11 for item A

6. Manufacturing 11 for item A1

7. Manufacturing 21 for item A

8. Manufacturing 21 for item A1

The following diagram illustrates the tier-by-tier search logic for on-hand quantity and 
scheduled receipts for end items. 
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Figure title

If there is no on-hand/scheduled receipts for either A and A1 or on-hand quantity is not 
adequate to satisfy demand, then ASCP will create the planned orders to satisfy net 
demand for A, B, C, D and E in the following method:

When creating planned orders for A:

1. Transfer A from Warehouse 1 to Distribution Center

2. Make A at Manufacturing 11 using primary resource and primary BOM/Routing 
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and Primary components B (Refer to Planning for B at Manufacturing 11, page 12-
61), C (Refer to Planning for C at Manufacturing 11, page 12-62), D (Refer to 
Planning for D at Manufacturing 11, page 12-63), and E (Refer to Planning for E at 
Manufacturing 11, page 12-63)

3. Make A at Manufacturing 11 additionally using alternate resource 

4. Make A at Manufacturing 11 additionally using substitute components (B1, C1 if 
needed)

5. Make A at Manufacturing 11 using Alternate routings/BOM 

6. Make A at Manufacturing 21 using primary resource and primary BOM/Routing 
and Primary components (B (Refer to Planning for B at Manufacturing 21, page 12-
62), C (Refer to 'Planning for C at Manufacturing 21, page 12-63), D (Refer to 
Planning for D at Manufacturing 21, page 12-63), E (Refer to Planning for E at 
Manufacturing 21, page 12-64)

7. Make A at Manufacturing 21 using alternate resource 

8. Make A at Manufacturing 21 using substitute components (B1, C1)

9. Make A at Manufacturing 21 using Alternate routings/BOM 

Planning for B at Manufacturing 11
1. Use on-hand/scheduled receipts for B in Manufacturing 11

2. Use on-hand/scheduled receipts for B1 in Manufacturing 11 

3. Make B at Manufacturing 11 using primary Resources, BOM/Routing and 
component D (Refer to Planning for D at Manufacturing 11, page 12-63)

4. Make B at Manufacturing 11 using alternate resources 

5. Make B1 at Manufacturing 11 using primary Resources, BOM/Routing and 
components 

6. Make B1 at Manufacturing 11 using alternate resources 

7. Make B at Manufacturing 11 using alternate BOM/Routing 

8. Make B1 at Manufacturing 11 using substitute components 

9. Make B1 at Manufacturing 11 using alternate BOM/Routing
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Planning for B at Manufacturing 21
1. Use on-hand for B in Manufacturing 21

2. Use on-hand for B1 in Manufacturing 21 

3. Make B at Manufacturing 21 using primary Resources, BOM/Routing and 
component D (Refer to Planning for D at Manufacturing 21, page 12-63)

4. Make B at Manufacturing 21 using alternate resources 

5. Make B1 at Manufacturing 21 using primary Resources, BOM/Routing and 
components 

6. Make B1 at Manufacturing 21 using alternate resources 

7. Make B at Manufacturing 21 using alternate BOM/Routing 

8. Make B1 at Manufacturing 21 using substitute components 

9. Make B1 at Manufacturing 21 using alternate BOM/Routing

Planning for C at Manufacturing 11
1. Transfer from Manufacturing 21

2. Use on-hand for C in Manufacturing 11

3. Use on-hand for C1 in Manufacturing 11

4. Make C at Manufacturing 11 using primary Resources BOM/Routing and 
component E (Refer to 'Planning for E at Manufacturing 11, page 12-63)

5. Make C at Manufacturing 11 using alternate resources 

6. Make C1 at Manufacturing 11 using primary Resources BOM/Routing and 
components (E)

7. Make C1 at Manufacturing 11 using alternate resources 

8. Make C at Manufacturing 11 using alternate BOM/Routing 

9. Make C1 at Manufacturing 11 substitute component 

10. Make C1 at Manufacturing 11 using alternate BOM/Routing
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Planning for C at Manufacturing 21
1. Use on-hand for C in Manufacturing 21

2. Use on-hand for C1 in Manufacturing 21

3. Make C at Manufacturing 21 using primary Resources BOM/Routing and 
component E (Refer to 'Planning for E at Manufacturing 21, page 12-64)

4. Make C at Manufacturing 21 using alternate resources 

5. Make C1 at Manufacturing 21 using primary Resources BOM/Routing and 
components (E)

6. Make C1 at Manufacturing 21 using alternate resources 

7. Make C at Manufacturing 21 using alternate BOM/Routing 

8. Make C1 at Manufacturing 21 substitute component 

9. Make C1 at Manufacturing 21 using alternate BOM/Routing

Planning for D at Manufacturing 11
1. Use on-hand/scheduled receipts of D at Manufacturing 11

2. Buy D from supplier 1

3. Look for alternate source of supply 

Planning for D at Manufacturing 21
1. Use on-hand/scheduled receipts of D at Manufacturing 21

2. Buy D from supplier 1

3. Look for alternate source of supply 

Planning for E at Manufacturing 11
1. Use on-hand/scheduled receipts of E at Manufacturing 11

2. Buy E from supplier 2

3. Look for alternate source of supply (none defined)
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Planning for E at Manufacturing 21
1. Use on-hand/scheduled receipts of E at Manufacturing 21

2. Buy E from supplier 2

3. Look for alternate source of supply (none defined)

Lead-times and User-Defined Decision Rules
When running a constrained plan with the site level profile option MSO: Enable 
Decision Rules set to Yes, ASCP uses the following:

• Item lead-times that are defined as item attributes 

• In-transit lead-times defined between organizations 

• Resource availability and usages as defined by the resources and the assembly's 
routing

The lead-time item attribute is composed of preprocessing, processing, postprocessing, 
fixed, and variable lead-times. 

The following shows how total processing lead-time and cumulative lead-times for 
make and buy items are calculated for user-define decision rules: 

Make Item
Total processing lead-time = ((1 + Queue time factor) * Processing lead-time) --then 
rounded--

where Queue time factor is the site level profile option value for MSO: Queue Time 
Factor.

If routing for the make item is not defined, Cumulative lead-time = Fixed lead-time + 
(Scheduled quantity * Variable lead-time).

Buy Item
For a buy item, the processing lead time is based on the most specific definition. If there 
is a processing lead time assigned to the item supplier relationship, then ASCP uses that
as the processing lead time. If not, it will use the item attribute for the processing lead 
time. 

Total processing lead time = Preprocessing lead-time + Postprocessing lead time + 
Processing lead time.

Cumulative lead time = Preprocessing + Fixed lead time + (Scheduled quantity * 
Variable lead time) + Postprocessing lead times.

If the fixed and variable lead times are not set, fixed lead time assumes the value of the 
processing lead time defined at the item attribute. 
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In transit lead times are used for all transfers between the sourcing and destination 
organizations. 

For the planning engine to follow the predefined sequence of selecting alternates, the 
derived value of the total processing lead time and the cumulative lead times should be 
the same. Any discrepancies between the total value of the two lead times may result in 
ASCP not following the predefined sequence of selecting alternates. 

Pegging and User-Defined Decision Rules
Looking at pegging may not be the method you should use to determine the sequence 
of selection of alternates. This is because the sequence of selection of alternates is more 
apparent when looking at total demand and total supply across the time bucket where 
there is a constraint. 

For example, suppose there are two demands, D1 (150 units) and D2 (50 units) on day 1 
and day 2 for item B, and the only way to satisfy this demand is by making 100 units 
with primary resource/routing/BOM and 50 units using substitute component B1 and 50
units of B with alternate BOM/routing. Then, day 1 demand will peg to 100 units of item
B using primary resource/routing/BOM and 50 units of item B using alternate 
BOM/routing. Day 2 demand will peg to 50 units of substitute component B1. 

If you look at just the pegging for D1, 50 units of the substitute component is not used. 
Instead, 50 units of the alternate BOM/routing is pegged to D1. Therefore, it looks as if 
ASCP has broken the user-defined sequence. But, if the demand was for only 150 units, 
then the supply would be 100 units of item B and 150 units of substitute component B1, 
which follows the user-defined sequence.

Exception Messages
Once the planning engine runs, you may find several instances where the engine has 
recommended alternates. When this happens, an exception message is generated. 
Typical flow may consist of analyzing exceptions generated by the plan, drilling into 
the details of exceptions, analyzing supply demand records using Supply/Demand 
window, vertical plan and pegging. Users may access the horizontal plan to get a 
detailed understanding of the demands placed on the alternates, supplies received as a 
part of the user-defined decision rule, and analyze possibilities of improving the 
solution based on their knowledge. 

Exception Display
When the system suggests the use of alternates, it also generates required exception 
messages referencing the type of alternates used. These exceptions are summarized in 
the Substitutes and Alternates Used exception group.

Organization Security
This feature restricts plan information access to authorized individuals. Oracle ASCP 
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allow users to associate job responsibilities to organizations for security purposes. This 
ensures that you see/change planning data in an organization only if you have a job 
responsibility associated with the organization. 

Examples:

• User 1 is restricted to organization M2

• User 2 has global authorization to access all organizations including organizations 
M1 and M2. 

• User 2 creates a plan for organizations M1 and M2 (owning organization is M1). 
User 1 can access this plan and view and execute only the portion of this plan 
related to organization M2. 

User Procedure Flow 
The following diagram illustrates the procedure flow for assigning users and job 
responsibilities to organizations:

To assign users and job responsibilities to organizations
1. Define custom responsibility in the Planning Server. To do this, sign in using the 

System Administrator responsibility. From the Navigator, select Security > 
Responsibility > Define. Fill in the appropriate fields with the appropriate 
information.

2. Define users and assign responsibilities. To do this, from the Navigator, select 
Security > User > Define. Fill in the appropriate fields.

3. Sign on using the Advanced Planning Administrator responsibility.

Note: Only users with APS Administration responsibility can 
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access and view Organization Security.

4. From the Navigator, select Admin > Organization Security.

The Assign Organizations to Responsibilities page appears.

5. In the Responsibility field, select the responsibility that you want to associate to 
organizations. The list of values for the Responsibility field includes all 
responsibilities defined in the Responsibilities form in the Planning Server. (limited 
to Oracle ASCP responsibilities). 

6. From the Available Organizations column, select and move any organization to the 
Assigned Organizations column using the Move button. You can use the Move All 
button to select all organizations for the specified responsibility. You can use the 
Remove button to remove any selected organization from the Assigned 
Organizations column. You can also use the Remove All button to remove all 
selected organizations. 

7. Select the Save button.

Organization Validation
Oracle ASCP restricts users to their authorized inventory organizations. The 
Organizations Find form displays only the authorized organizations when users 
attempt to open a form in Oracle ASCP for the first time: 

Note: You are also restricted to the authorized organizations when you select the 
Change Instance/Organization menu item.

Supply Chain Plan Names Form
For the selected instance/organization, you can view and create plan names in the 
Supply Chain Plan Names form. The system restricts accessing and viewing plans to 
authorized users of the owning organization.

Plan Options Form
You can select organizations for planning in the Org field. The list of values for this field
is restricted to authorized organizations which can be accessed by user. This implies 
that the Plan Organizations Find form list of values is restricted to organizations 
associated to user. 

Note: In general, the Plan Options form can be viewed and updated 
only if user has access to the owning organization of the plan.
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Example
Plan1 has been created in M1 (owning organization) for planning organizations M1 and 
M2. This means the Plan Names form in M1 includes Plan1, but the Plan Names form in
M2 does not include Plan1.

The Organization Security behavior for Plan Names, Plan Options, and the Planner 
Workbench is summarized for different user authorizations in the following tables.

User Authorized To... Plan Names Plan Options Workbench

User 1 M2 User 1 cannot 
view and access 
Plan1 in the Plan
Names form

User1 cannot 
access Plan 
Options via the 
Plan Options 
menu entry in 
the Navigator.

User1 can view 
Plan1 in the left 
pane of the 
Planner 
Workbench, but 
restricted to 
Organization 
M2. However, 
User1 can view 
all planned 
Organizations 
(M1 and M2) in 
the Organization
tab of the Plan 
Options form via
the Plan menu 
entry from the 
tool bar in the 
Planner 
Workbench.

User2 M1 and M2 User2 can view 
and access Plan1 
in the Plan 
Names form 
from 
organization M1.
User2 can copy 
and launch 
Plan1.

User2 can access 
Plan Options via 
the Plan Options
menu entry in 
the Navigator 
window.

User2 can view 
Plan1 in the left 
pane of the 
Planner 
Workbench with
both 
organizations 
M1 and M2 
displayed.
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User Authorized To... Plan Names Plan Options Workbench

User3 M1 User3 can view 
and access Plan1 
in the Plan 
Names form 
from 
organization M1.
User3 can copy 
and launch 
Plan1.

User3 can view 
and access Plan1 
in the Plan 
Options form. 

User3 can delete 
planned 
organization M2 
but cannot add 
organization M2.

User3 can only 
add organization
M1 to the Plan 
Options form.

User3 can view 
Plan1 in the left 
pane of the 
Planner 
Workbench with
both 
organizations 
M1 and M2 
displayed.

Key Performance Indicators
Oracle ASCP is integrated with the Oracle Business Intelligence System (BIS) 
performance management system. BIS lets you set the organizational objectives. These 
objectives, known as Performance Measures in BIS, are referred to as Key Performance 
Indicators (KPIs) in Oracle ASCP.

KPIs are used to drive continuous improvement in your enterprise. You can set 
performance targets and exception tolerances by business units or by period and 
automatically notify the appropriate people when exceptions arise. For information on 
setting targets, see Oracle Business Intelligence System Implementation Guide. 

You can also compare the KPIs for multiple plan simulations using the Planner 
Workbench.

Oracle Advanced Supply Chain Planning displays these key performance indicators:

• Inventory turns

• Margin percentage

• Planned utilization

• On-time delivery

• Margin

• Inventory value: This key performance indicator is available only for inventory 
optimization plans. 
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• Utilization by Weight/Volume: This key performance indicator is available only for 
distribution plans.

• Cost breakdown

• Service level

Following are descriptions of various KPIs.

Key performance indicator displays for periods group their information for uniformity 
across organizations in the supply chain plan. They group according to the financial 
calendar. Many of the Planner Workbench context windows group their information 
using manufacturing calendars. If you see results that appear not to matc, it may be due
to different grouping.

Inventory Turns
Inventory turns for a given plan between time periods t1 and t2are calculated as follows:

• Annual inventory turns = {Value of MDS demand in period [t1,t2] / Value of average
inventory in period [t1,t2]} * 365 / (t2- t1)

Value of average inventory in period [t1, t2] = (Inventory at t1 + Inventory at t2)/2

where t1 and t1 are in days

Inventory at time t2 = Inventory at time t1 + Purchase orders during period [t1,t2] + 
Purchase requisitions during period [t1,t2] + Planned orders during period [t1,t2] + 
Discrete jobs during period [t1,t2] + Repetitive schedules during period [t1,t2] + 
Master schedule demand during period [t1,t2]

Note: These calculations use standard costs of items. Standard cost 
systems use a single value to cost all material and resource 
transactions in inventory and work in process systems. 

To set the value for the target, use profile option MSC: Performance target for Inventory
Turns.

Margin Percentage
Margin percentage is the net difference between planned revenues and planned 
production costs.

The calculation for margin percentage objective is

• Margin percentage = (Plan revenue) - (Plan cost)

Plan revenue = {(Sales order line price) * (Sales order quantity)} + {(Item list price)* 
Iitem discount) * (Forecast quantity)
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Plan revenue is calculated and summed up for all items with independent demand in 
all time buckets.

• Plan cost = Item cost + Transportation cost + Inventory carrying cost

Plan cost is calculated and summed up for all items, resources, and ship methods in all 
time buckets.

• Item cost = (Resource cost * Resource quantity used) + (Buy item cost * Buy item 
quantity) + (Process cost * Quantity using process)

Transportation cost = (Transfer quantity * Item weight * Shipping cost per unit 
weight) + (Buy quantity * Item weight * Shipping cost per unit weight)

Inventory carrying cost = Average inventory per bucket * Carrying cost percent * 
Item cost

Margin percentage is the most aggregate of objectives in the sense that it combines 
multiple costs.

Planned utilization
Planned utilization for a resource or supplier for a planning time bucket is calculated as 
follows:

Planned utilization = (Hours of capacity actually used / Available hours of capacity) * 
100

Note: For production lines and supplier capacities, substitute units for 
hours.

Aggregate level utilizations for all hierarchy levels are based on average utilization. For 
example, Planned utilization for a resource is calculated as follows:

Resource Planned utilization = Sum of [Planned utilization for all Planning time 
buckets] / Number of Planning time buckets

Plan level Planned utilization does not include supplier utilization.

To set the value for the target, use profile option MSC: Performance target for Resource 
Utilization Percent.

On-Time Delivery
Customer service level or delivery performance are calculated as follows: 

((Total number of orders - Number of late orders) * 100) / Total number of orders

To set the value for the target, use profile option MSC: Performance target for Ontime 
Delivery Percent.
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Margin
Margin is calculated as follows:

• Top assembly margin = (Total shipment units * Standard price) - (Total shipment 
units * Standard cost)

Aggregate level margin = Sum of margin of top assemblies

You can drill down to plan/org level KPI (revenue vs. cost vs. profit) or to KPI trend. No
target is available for Margin KPI.

Margin KPI does not consider discounts.

To set the value of the target, use profile option Performance target for Margin Percent 

Cost Breakdown
Cost breakdown KPI is composed of these costs:

• Production cost

• Inventory carrying cost

• Penalty cost

• Purchasing cost

Production cost is calculated based on the required resource time and its corresponding 
cost. Product cost is calculated as follows:

• Production cost = Sum of (Resource time needed * Resource cost) for all resources in
the organization.

Inventory carrying cost is calculated based on average inventory level in each time 
bucket. Inventory carrying is calculated as follows:

• Inventory carrying cost (period i) = Average inventory of period i * Carrying cost 
percent

Penalty cost is calculated as follows:

• Penalty cost = Demand lateness cost * (Demand satisfied date - Requirement date) * 
Demand quantity * Item list price

Standard item cost is used in the penalty cost equation in the absence of item list price.

Purchasing cost is calculated based on the standard item cost and the supply quantity. 

• Purchasing cost = Sum of [Item list price * Supply quantity] for all items

Standard item cost is used in the purchasing cost equation in the absence of item list 
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price.

You can drill down to plan/org KPI or to KPI trend. No target is available for the Cost 
Breakdown KPI.

Service Level
Aggregate service level is calculated for constrained and optimized plans. The 
calculation process groups all independent demands (except safety stock) by item and 
then by demand due date into BIS periods. It calculates service level for each item in 
each BIS period and then rolls the service level up to:

• The item

• All items in an organization

• All organizations in a plan

The calculation is (Demand quantity satisfied by due date / Demand quantity) * 100.

This table shows a calculation for item A independent demands for each BIS period and
the rollup to item A.

Item BIS period Demand Due
Date

Demand 
Quantity

Demand 
Quantity 
Satisfied by 
Demand Due
Date

Service 
Level

A - - - - 95% [(100 + 
90 + 100 +190 
+ 280) / (100 +
100 + 100 + 
200 + 300)] * 
100 = (470 / 
500) * 100

- 1 January - 31
January

- - - 97% [(100 + 
90 + 100) / 
(100 + 100 + 
100)] * 100 = 
(290 / 300) * 
100

- - 10 January 100 100 -

- - 15 January 100 90 -



12-74    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Item BIS period Demand Due
Date

Demand 
Quantity

Demand 
Quantity 
Satisfied by 
Demand Due
Date

Service 
Level

- - 20 January 100 100 -

- 1 February - 
28 February

- - - 94% [(190 + 
280) / (200 + 
300)] * 100 = 
(470 / 500) * 
100

- - 10 February 200 190 -

- - 20 February 300 280 -

You can:

• Display planned service level vs. target service level for plans, organizations, and 
items

• Drill down to a graph showing service level trend

If there is no demand, the service level is 100%; service level 0% would raise an 
unnecessary exception.

In an unconstrained plan, the service level is always 100%.

Inventory Value
A graphical representation of the least risk inventory values at the intersection of the 
levels in the hierarchies that you have selected for inventory planning (e.g., item or 
product family and organization by month) are displayed in a time-phased view. 

This key performance indicator is available only for inventory optimization plans.

Note: For more information on using KPIs, refer to Planner Workbench,
page 18-1.

KPI Setup
Currently, setting up targets for the following KPIs or performance measures are set up 
within the BIS application. You can access the BIS application to set the following KPIs 
(now known as performance measures) at the following dimensios: 
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• MRP gross margin % at the total organizations and total time dimensions

• MRP inventory turns at the total organizations and total time dimensions

• MRP on-time delivery % at the total organizations and total time dimensions

• MRP planned utilization % at the total organizations and total time dimensions

To set targets for KPIs or Performance Measures
For these key indicators, use a profile option to set the targets:

• Inventory turns: MSC: Performance target for Inventory Turns 

• Ontime delivery: MSC: Performance target for Ontime Delivery Percent 

• Margin: MSC: Performance target for Margin Percent 

• Planned utilization: MSC: Performance target for Resource Utilization Percent 

1. From the BIS Personal Home Page, click Performance Management Framework 
(Full Access).

2. Click Performance Measures.

3. In the Performance Measure drop down box, select the correct performance 
measure (for example, MRP Gross Margin %).

4. Click the View Target Levels button.

5. Click BIS_EDIT_VIEW in the row that shows the correct dimensions (e.g.; Total 
Organizations, Total Time).

6. Scroll down to the access section. Make sure the Selected Responsibilities include 
Performance Management Framework (Full Access) and Performance Management 
Framework (Targets Access).

7. Click the Save and View Targets button.

8. In the Organization drop down box, select Total Organizations.

9. Click the Find Targets button.

10. Click the Retrieve button.

11. In the Business Plan drop down box, select Standard.

12. Click the Refresh button.
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13. If there is no target set and you wish to set a target, click the New Target button.

14. If there is an existing target you wish to edit, click BIS_EDIT_VIEW for the target 
you wish to edit.

15. Enter the target.

16. Click the Save button.

17. Use the home button in the Performance Target Details bar and start over with the 
next target.

Tracking Plan Performance Using KPIs
Oracle ASCP lets you track plan performance against KPIs. For more information, see 
Planner Workbench., page 18-1

Making Improvements Based on KPIs

Increasing Inventory Turns
• Decrease the penalty factor for safety stock violation. 

• Increase weight given to the maximize inventory turns objective, decrease weight 
given to other objectives by choosing Plan Options > Optimization tab.

• Change sourcing rules used by the plan to reflect material sources (for example, 
inventory stocks) that are controlled by the planner or the organization being 
planned. For example, if a plan is run with many inventory sources specified in the 
sourcing rules, inventory turns will be lower than if only a few inventory sources 
are used.

Increasing Planned Utilization
• Decrease penalty factor for exceeding resource capacity.

• Increase weight given to the maximize resource utilization objective, decrease 
weight given to other objectives.

• Increase the demand that is being planned. Note that increasing demand can have 
adverse impact to other KPIs (for example, On-time Delivery) if material capacity is 
not sufficient to support the demand.

Increasing Margin Percentage 
• Decrease penalty factors considered in the margin percentage calculation.
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• Increase weight given to the maximize margin percentage objective, decrease 
weight given to other objectives.

• If material and/or resource capacity is constrained, demand will not be fulfilled by 
the request date and sales will either be lost of penalty costs will be incurred for late
demand. See actions described in Increasing On-time Delivery.

Increasing On-time Delivery 
• On-time Delivery will suffer if material capacity and/or resource capacity are not 

sufficient to meet requested delivery dates. By looking at the exceptions that occur 
after a plan is run, you can determine whether material or resource capacity is the 
gating factor. 

• To determine material and resource capacities required to meet all requested 
delivery dates for demand, run the plan unconstrained by material and capacity to 
determine total resource and material capacity requirements. (Choose Plan Options 
> Constraints tab to specify material and resource constraints.)

If material capacity is insufficient:

• Add capacity at the bottleneck supplier(s)

• Specify alternate components that can be used if the primary (constrained) 
component is not available

• Add capacity at feeder plants supplying sub assemblies

If resource capacity is insufficient:

• Add capacity at the bottleneck resource. For example, add shifts, add 
outsourcing providers, add labor

• Specify alternate resources that can be used

If material and resource capacities are not constrained:

• Increase penalty factor for unmet demand and late demand

Increase weight given to the maximize on-time delivery objective, decrease weight 
given to other objectives.

Supplier Acknowledgement for a Rescheduled Purchase Order
Your material requirement date might be different from the material availability date as
provided by the supplier. The planning engine can consider either of the dates while 
generating a plan. Usually, you use the promise date in the purchase order as the date 
when the supplier supplies the material. However, in absence of the promise date, the 
planning engine uses the need by date as specified in the purchase order. If a supplier 
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always meets the need by date irrespective of the promise date, you can set the MSC: 
Purchase Order Dock Date Calculation Preference profile option value to need by date.

This diagram illustrates the supplier acknowledgement cycle.

To instruct the planning engine which date to use for the arrival of a purchase order 
delivery (dock date):

• Set the MSC: Purchase Order Dock Date Calculation Preference profile option. The 
valid values for this profile option are Need by Date or Promise Date. If you set the 
profile option to Promise Date, the planning engine considers the promise date 
from the supplier as the material arrival date. If you set this profile option value to 
Need by Date, the planning engine considers the need by date specified in the 
purchase order as the date of material availability. See MSC Profile Options, page 
A-83 for more information.

• Run collections in the targeted refresh mode

• Run the plan on the collected purchase orders to view the promise date and original
need by date in the Planner Workbench.

The following steps detail the flow of information:

• If you accept the calculated dock date and release the purchase order to Oracle 
Purchasing, Oracle Purchasing uses the suggested dock date as the new need by 
date. Oracle Purchasing leaves the original promise date unchanged. It sends a PO 
change notification to the supplier to acknowledge the rescheduled purchase order.

• Using Oracle iSupplier Portal, the supplier can either accept the need by date as the 
promise date or specify a different promise date. If the supplier accepts the need by 
date, Oracle iSupplier Portal uses it as the promise date. If the supplier specifies a 
new promise date, Oracle iSupplier Portal sends a change request notification to the
buyer.

• The buyer can review and update the need by date and promise date for the 
purchase order in Oracle Purchasing. 

• After the next plan run, you can view the suggested dock date, the original need by 
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date, and the new promise date in the Planner Workbench.

• If the supplier provides a sales order number at the time of acknowledging the 
purchase order, Oracle Collaborative Planning creates a sales order that is pegged 
to the purchase order. The promise date is set as the delivery date. If the supplier 
changes the promise date or the quantity, an exception is created in Oracle 
Collaborative Planning. 

If the purchase order is not firm or within the planning time fence, Oracle Advanced 
Planning and Scheduling can recommend rescheduling of the purchase order when the 
plan is run again.

Change Requests from Suppliers Resulting in Exceptions
This table displays the exception messages that Oracle Collaborative Planning generates
in specific scenarios:

Exception Message Scenario

Late replenishment from supplier This exception is generated when the supplier 
requests a change in the need by date or splits 
lines.

Early replenishment from supplier This exception is generated when the supplier 
requests a change in the need by date, 
quantity or splits lines.

Short supply from supplier This exception is generated when the supplier 
requests a change in the quantity or splits 
lines.

Excess replenishment from supplier This exception is generated when the supplier 
requests a change in the quantity or splits 
lines.

Setting Demand to Supply Planning Automation
You can set up collaboration between Oracle Advanced Supply Chain Planning and 
Oracle Demand Planning to automatically launch an unconstrained supply chain plan 
based on forecast scenarios that you publish.

Demand to Supply Planning Automation Setup
• Set the profile option MSD: Default DP Scenario to a valid demand plan scenario.
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• Set the profile option MSC: New Forecast Auto Plan to an unconstrained supply 
chain plan. When the demand plan scenario mentioned in the profile option MSD: 
Default DP Scenario is published, the unconstrained supply chain plan specified in 
the profile option MSC: New Forecast Auto Plan starts running.

The following figure illustrates the activities that are performed after the customer 
uploads the forecast in Oracle Collaborative Planning.

Demand to Supply Planning Automation Cycle

After the customer uploads an order forecast using flat files or the user interface, you 
can review the exceptions to address the mismatch between the forecast you generated 
and the customer forecast. The Receive Forecast From Customer program automatically
runs to receive the forecast into Oracle Demand Planning. Oracle Demand Planning 
Engine publishes the new demand plan scenario to Oracle Demand Planning Engine 
Server. This action automatically launches the unconstrained supply chain plan 
specified in the profile option.

Setting Supplier Collaboration Automation
Using Oracle Advanced Planning and Scheduling, you can collaborate with suppliers, 
track exceptions arising out of supplies, issue notifications to suppliers and receive 
notifications from suppliers. 

Supplier Collaboration Setup
You and your suppliers need to perform the following list of tasks to enable the 
collaboration between Oracle Advanced Supply Chain Planning and Oracle 
Collaborative Planning:

• Set the profile option MSC: SCEM Engine Launch Events to All to automatically 
start Supply Chain Event Manager (SCEM) when a supplier loads an order forecast 
or when you publish an order forecast from the planning server. If you set the 
profile option to Publish, Supply Chain Event Manager starts only when plans are 
published from Oracle Advanced Supply Chain Planning. If you set the profile 
option to Load, Supply Chain Event Manager starts only when data is loaded using 
flat files.
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• Ensure that the value of the profile option MSC: Configuration is set to APS & CP. 
This enables collaboration between Oracle Advanced Supply Chain Planning and 
Oracle Collaborative Planning.

• Specify the name of the plan that you want to launch automatically in the profile 
option MSC: New Supply Commit Auto Plan. It is recommended that you specify a 
constrained plan.

Triggering Launch of Plan
• Publish an order forecast from the Planner Workbench to the supplier. This 

launches Supply Chain Event Manager to compute material excess and generate 
shortage exceptions.

• Suppliers need to upload supply and demand information in Oracle Collaborative 
Planning. This launches Supply Chain Event Manager to compute material excess 
and generate shortage exceptions. Supply Chain Event Manager also generates a 
notification.

• Suppliers can upload or enter forecasts into Oracle Collaborative Planning. When 
the supplier clicks the Send Supply Commit to customer link in the Admin tabbed 
region, the Receive Supplier Capacity concurrent process runs. This process 
updates the supplier capacity information on the planning server. If the profile 
option MSC: New Supply Commit Auto Plan points to a valid plan, the plan is 
automatically launched.
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13
Setting Up Distribution Planning

This chapter covers the following topics:

• Overview of Setting Up Distribution Planning

• Prerequisites for Distribution Planning

• Defining Items as Distribution Planned

• Defining Bills of Material for Kitting

• Defining Demand Priority Rules

• Daily Load Consolidation

• Defining Trip Limits for Ship Methods by Lane

• Defining Sourcing Rules

• Multiple Inventory Policies

• Inventory Rebalancing

• Setting Up Supply Allocation Rules

• Setting Up High Volume Distribution Planning 

• Order Modifiers

Overview of Setting Up Distribution Planning
This section outlines the steps required to set up Distribution Planning. You begin by 
setting up organizations, ship methods, shipping lanes, and calendars the same as in 
other Oracle Advanced Supply Chain Planning plan types. You then define the 
following:

• Distribution planned items and key attributes

• Safety stock, target, and maximum inventory levels
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• BOMs for kitting

• Demand priority rule

• Trip limits for ship methods by lane

• The assignment of sourcing and supply allocation rules to items

• Organization and customer selection lists

• Distribution plan preferences

The set up steps detailed in this section are specific for distribution plans and assume 
that the user has completed all of the usual source instance set up tasks such as enabling
Oracle Bills of Material, Oracle Work in Process, Oracle Order Management, and Oracle 
Purchasing.

Prerequisites for Distribution Planning
To run Distribution Planning, the following prerequisites are required:

• Define organizations and inter-organization relationships.

Receiving organizations must be associated as customers of shipping organizations.

• Define carriers and associate with them with ship methods.

This facilitates the release of inter-organization shipments.

• Define inter-organization shipping lanes.

Shipping networks should be defined and assigned ship methods.

• Define shipping, receiving, and carrier calendars.

Please see Setting Shipping, Receiving, Carrier, and Supplier Capacity Calendars, page 
6-142 for more details.

These steps are the same as in other Oracle Advanced Supply Chain Planning plan 
types, such as MRP, MPS, and MPP.

Defining Items as Distribution Planned
When setting up Distribution Planning, the first step you need to take is to define which
items to include in your distribution plans.

To define items as distribution planned:
1. On the MPS/MRP item attributes tab, select the Distribution Planned check box.
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Distribution Planning selects items to include in a distribution plan based on the 
following plan options for planned items.

Planned Item Description

All planned items All Distribution Planned items are included.

Demand schedule items only Only Distribution Planned items in the 
demand schedule are included in the 
distribution plan.

Supply schedule items only Only Distribution Planned items in the 
supply schedule are included in the 
distribution plan.

Demand and Supply schedule items Only Distribution Planned items in the 
demand and supply schedules are included 
in the distribution plan.

Demand schedule and WIP components Distribution Planned items in the demand 
schedule and WIP jobs, as defined by the 
MSC: DPP Discrete Job Cutoff Window 
(Days) profile option, are included in the 
distribution plan. 

Demand schedule items and all sales orders Only Distribution Planned items in the 
demand schedule and all sales orders are 
included in the distribution plan.

Demand schedule items/WIP 
components/all sales orders

Only Distribution Planned items in the 
demand schedule, all sales orders and all 
WIP jobs are included in the distribution 
plan.

In each case, an item between two included Distribution Planned items is also 
included.

Defining Bills of Material for Kitting
Oracle Bills of Material is used to define Bills of Material for kitting. Distribution 
Planning plans components of kitting planned orders the same way MPS/MRP/MPP 
explodes Bills of Materials and plans lower level components. Routings and resources 
are not considered by distribution plans and kit assembly is constrained by component 
availability.
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Lead-time
When planning a discrete job, distribution planning calculates the start and complete 
times based on the item-organization fixed lead-time attribute. 

• Variable lead-time is not considered. 

• Calculation of start date, completion date and duration consider the organization 
manufacturing calendar for valid work days and shifts.

• All components are required at the job start time.

Example
If the supply is due for 24 units at 10:00 AM on Day 5, the fixed lead-time is 1 day, and 
there is one 24 hour shift, the job start time is at 10:00 AM on Day 4. 

Order Size
For discrete jobs, the size of planned orders is the value of item attribute Fixed Lot 
Multiplier. If this attribute is null, no order size modifiers are applied and each discrete 
job is the size of the associated demand. The item attributes Fixed Lot Multiplier, 
Rounding Control and the Fixed Lead-time should be considered together during the 
data setup.

Releasing Kit Jobs to Oracle WIP
Distribution Planning can release a planned order for a discrete job to Oracle WIP. If 
substitute components are selected, these will be released and appear as component 
requirements in the WIP job. If substitute components are not selected, the planned 
order header is released. The WIP job explodes and creates the component and resource
requirements based on the BOM and routing. The planned order header includes the 
completion date and the primary or alternate BOM/routing designation. If a routing 
exists in the source instance, the start date of the released WIP job may be different from
the start date in distribution planning.

Since distribution planning treats Oracle Work in Process jobs as firm supplies, it does 
not recommend their reschedule. For these jobs, distribution planning: 

• Considers component requirements

• Does not show resource requirements

To control which of these jobs the distribution planning engine considers, set profile 
option MSC: DPP Discrete Job Cutoff Window (Days).
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Defining Demand Priority Rules
Distribution plans consider demand type priorities and you can set priorities based on 
demand class within each demand type. There are six demand types: 

• Sales orders

• Over-consumption sales orders (the sales order represents quantities in addition to 
the forecasted quantities)

• Forecasts 

• Safety stock level demands

• Target inventory level demands

• Excess demand (caused by order modifiers)

With the first three demand types, you can define additional priorities by demand class.
If a sales order or forecast has an associated demand class, it gets the priority of the 
demand class. However, this is only within the demand type. Priorities for safety stock, 
target, and excess always default to the lowest three priorities in that order.

To define demand priority rules:
1. From the Navigator, select Distribution Planning > Setup > Demand Priorities

The Define Priority Rules window appears.

2. In Name and Description, enter information for the new demand priority rule.

3. To enable the demand priority rule, click the Enabled check box. To set the demand 
priority rule as a default, click the Default check box.

A rule must be completely defined before it can be enabled.

4. Specify a demand priority by selecting a level from the Priority Specified For 
drop-down list. 

5. In the Demand Type field, enter one of the following:

• Sales Orders

• Over-Consumption Sales Orders 

• Forecasts

This priority is applied to all demands of the demand type, unless the demand class
or demand type - demand class has been specified. An entry must be made in this 
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field.

6. Enter any demand class in the Demand Class field. This priority is used to rank 
demands within each of the demand types. If no demand class is specified, it is set 
to the lowest priority within the demand type. You can also select All Other 
Demand Classes which allows you to set this priority directly. An entry must be 
made in this field.

7. Enter a numeric value in the Priority field.

8. Click the Save button.

When the form is saved, the read-only Calculated Demand Priorities area of the form is 
populated with the resulting calculated demand priorities. A row is created for each 
demand type and demand class combination and one additional row is created for the 
demand type and all other demands. 

For demands in a distribution plan that use the above demand priority rule, any sales 
order line with a specific demand class will have that priority. For example, a sales 
order line with demand class RS-B will have priority 2.

Daily Load Consolidation
Distribution planning performs load consolidation and distribution by the minute. If 
supplies are available at 10:03 AM then you can create an outbound shipment with 
shipment time at 10:03 AM. Available supplies at 3:12 PM may lead to another 
outbound shipment to the same organization then. If you prefer to consolidate transfers 
consolidated by days, use one of these daily load consolidation.

For the first approach, adjust your supply schedules so that your supplies are available 
at the same time of day. If you use an ASCP plan as a supply schedule, run it in daily 
buckets so all supplies have the same timestamp.

For the second approach, use a calendar with shift duration at least one minute as the 
shipping calendar of your source organization. For example, set the shift to start at 10:59
and to end at 11:00. Distribution planning creates outbound shipments with timestamp 
10:59. Supplies ready before 10:59 ship today and supplies ready after 11:00 ship 
tomorrow. You can change times as you manage actual shipments in your shipping and
transportation management products.

Oracle recommends not to use this calendar for any other purpose. Define your transit 
calendars and receiving calendars appropriately. 

Defining Trip Limits for Ship Methods by Lane
For the truckload (TL) ship methods, the concept of a trip limit is used in Distribution 
Planning. The trip limit is a weight maximum, a volume maximum, or both. You must 
define trip limits for TL ship methods for each shipping lane. The shipping network 
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must be defined in the source instance before the user can access the trip limits on the 
planning servers. 

You define trip limits on the Transit Times window by setting weight and volume trip 
limits for in the Shipment Limit area of this window. To access the Transit Times from 
the Navigator, the Transit Times form, select Setup > Transit Times.

When planning trips between organizations, distribution plans:

• Select a ship method to use for inter-organization trips between each from and to 
organization pair. 

• For the selected ship method, attempt to respect the trip maximum weight and 
volume constraints or report violations.

• LTL and parcel ship method should be used when a trip must be scheduled and the
trip is less than the TL ship method constraints permit based on the plan utilization 
targets. It assumes that you have defined a sourcing with rank 1 ship methods as TL
and lower rank ship methods that are not TL.

Only Maximum Trip Weight and Maximum Trip Volume can be edited and only when 
the Ship Method mode is TL Shipment limit fields cannot be edited for other Ship 
Methods. Distribution Planning uses the following rules when deciding what to ship 
and when, and how to consolidate shipments:

• Safety Stock Level: Distribution Planning will always ship available supplies on 
time to meet safety stock demands. Minimum Trip Capacity can be violated.

• Target Level: During trip consolidation, Distribution Planning will only ship 
available supplies on time to meet target inventory levels if there is a trip that the 
supply can be added to without violating the trip capacity.

• If no trip is available to move the supplies for target inventory levels during trip 
consolidation, these supplies are not shipped even if available in the source. 

• If the ship method has no limits, target supplies are not shipped during the trip 
consolidation window. Because of this approach, you might find a number of 
supplies for target inventory levels that are shipping immediately after the end of 
the trip consolidation window. You may not want to firm or release these planned 
shipments. The next distribution planning run may pull these supplies in if there 
are now trips that can move them efficiently.

Trip Limit Constraints
When a Shipping Method is used on a Sourcing Rule, Bill or Distribution or Inventory 
Distribution Rule, the Shipping Method can be a constraint on the plan output. The 
following constraints are created by Shipping Methods:

• Intransit time: if the intransit lead-time is not null,, the intransit lead-time of the 
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selected ship method is a constraint.

• If not null, Trip Size limits are based on the Maximum Trip Weight and Volume 
Constraints for the Ship Method.

Distribution Planning considers the minimum and maximum weight and volume limits
for each Ship Method. You can specify new constraint plan options for the following 
trip limits for the distribution plan:

• Maximum Trip Utilization:  This parameter is the upper limit for loading a truck. 
For example, if you set this parameter to 90%, any truck is not loaded over 90 % of 
the maximum weight and volume capacities. If null, 100% is used.

• Minimum Trip Utilization: The planning engine generates different TL trips with 
various levels of capacity utilization. Distribution Planning plans attempt to create 
trips that have capacity utilization greater than the minimum TL utilization. If null, 
0 is used.

Distribution Planning uses the plan option utilization targets combined with the ship 
method maximum trip limits. 

• Maximum Trip Weight = Maximum Trip Utilization * Maximum Trip Weight

• Maximum Trip Volume = Maximum Trip Utilization * Maximum Trip Volume

• Minimum Trip Weight = Minimum Trip Utilization * Maximum Trip Weight

• Minimum Trip Volume = Minimum Trip Utilization * Maximum Trip Volume

Both weight and volume maximum and minimum are considered if not null. If both
the weight and volume maximum are null, then the ship method is treated as 
non-TL.

Distribution Planning uses the targets and minimums as follows:

• Trips are not loaded in excess of the Maximum Trip Weight or Volume.

• Trips are loaded up to the Maximum Trip Weight or the Maximum Trip Volume.

• Trips are loaded over the Minimum Trip Weight or Minimum Trip Volume. If the 
Minimum Trip Weight or Maximum Trip Volume cannot be met, the trip is planned
for other ship methods. If the internal transfers are pegged to demands other than 
target inventory level demands, an LTL or parcel ship method is used. If there are 
no LTL ship methods, then a trip is planned on a TL ship method which can violate 
the Minimum Trip Weight and Minimum Trip Volume. Trips may be less than the 
Minimum Trip Weight and Minimum Trip Volume if the trip is a scheduled trip, 
with routing or routing and contents firm.
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Defining Sourcing Rules
Sourcing rules are defined the same as for MRP/MPS/MPP. Inter-organization sourcing 
relationships are defined and ship methods are selected. Multiple ship methods can be 
specified for the same supply source with differing percentages but the percentages are 
not necessarily respected for the same supply source with different ship methods.

If the sourcing rule is global, ship method is allowed but no transit time is specified as 
the shipping lane is not known. 

• During planning, if no ship method is specified on the global sourcing rule, the 
default ship method from the shipping methods form is used.

• If no ship method is marked as default on the shipping methods form, no ship 
method is selected and intransit lead-time is 0.

If the sourcing rule is local, you can optionally specify a shipping method for a 
particular source organization. If no shipping method is specified, the default shipping 
method is used from the inter-organization relationships form. You can specify multiple
ship methods for the same source organization on the sourcing rule or bill of 
distribution, giving each ship method a different rank. 

You can specify multiple ship methods on the sourcing rule or bill of distribution, 
giving each ship method the same rank but different percentages. The requested 
inbound shipments for Rank 1 ship methods will respect the percentages by ship 
method if decision rules are not used. However, the final plan output might not respect 
the percentages because Distribution Planning will select the best ship method from 
among the Rank 1 ship methods. This means that you can specify two ship methods 
with differing costs, lead-times or maximum trip limits, and they are considered based 
on trip dates and sizes.

Please see the section Ship Method Selection, page 15-2 for more details.

Multiple Inventory Policies
Distribution planning uses three values to create bands of inventory for items:

• Safety stock

• Target inventory level

• Maximum inventory level

The inventory level varies among these values depending on the timing of economical 
trips that are moving on or before the date that is needed to keep the inventory level at 
the safety stock level.
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Safety Stock
Distribution Planning uses the same profile options as Oracle Advanced Supply Chain 
Planning safety stock process. See Safety Stock, page 6-133

Even if safety stock smoothing is turned off, distribution planning uses the safety stock 
level of the last day of an allocation bucket as the safety level for the entire bucket. If the
allocation buckets are weekly or larger, this gives the output a smoothed appearance. 
Even if no smoothing is selected, we display a constant safety stock level across the 
entire allocation bucket, since distribution planning allocation only considers the safety 
stock on the last day of an allocation bucket. 

Smoothing occurs in two stages:

• Smoothing within allocation buckets: Controlled by profile options MSC: Safety 
Stock Change Interval and MSC: Smoothing Method

• Smoothing across Allocation Buckets: Controlled by profile options MSC: 
Maximum Percentage Variation in Safety Stock Values and MSC: Minimum 
Percentage Variation in Safety Stock Values

The planning engine uses profile option MSC: Safety stock change interval (Days) as 
follows:

• Value is Null or 0: distribution planning does not smooth within an allocation 
bucket 

• Value > 0 (without regard to the actual value): distribution planning smoothes 
within the allocation bucket 

The smoothing method within an allocation bucket considers the profile option MSC: 
Smoothing method to calculate safety stock within change interval: 

• Minimum: Set safety stock to the minimum value found within the bucket 

• Maximum: Set safety stock to the maximum value found within the bucket

• Average: Set safety stock to the average value within the bucket (based on working 
days) 

• Null: Use the Average method by default 

The other profile options control safety stock smoothing behavior across allocation 
buckets: 

• MSC: Maximum Percentage variation in safety stock values

• MSC: Minimum Percentage variation in safety stock values 

To turn smoothing off across allocation buckets, set: 
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• MSC: Maximum Percentage variation in safety stock values = Null 

• MSC: Minimum Percentage variation in safety stock values = 0 

Distribution planning does not distinguish between transient and non-transient safety 
stock levels when creating planned orders. This concept is used in Oracle Advanced 
Supply Chain Planning for pegging but does not apply to distribution planning.

Entering Target and Maximum Inventory Levels
You enter target and maximum inventory level information in these places:

• Oracle Inventory Items form, MPS/MRP Planning tab: Enter Target Inventory Days 
of Supply, Target Inventory Window, Maximum Inventory Days of Supply, 
Maximum Inventory Window

• Enter Inventory Levels form on the Distribution Planning setup menu: There are 
areas Target and Maximum. For either level, you can enter either the quantity or 
days of supply.

• Profile Options form: If you want your maximum and target inventory levels to 
default to a percentage of safety stock, on the profile options form, enter percent 
values for profile options MSO: Target Inventory Level % of Safety Stock and MSO: 
Maximum Inventory Level % of Safety Stock.

The defaulting hierarchy for target and maximum inventory levels, from first used to 
last used, is:

• Entries in the Oracle Inventory Optimization Enter Inventory levels form. If you 
enter days of supply, that becomes the value in the Oracle Inventory Items form, 
MPS/MRP Planning tab, fields Target Inventory Window and Maximum Inventory 
Window.

• Entries in the Oracle Inventory Items form, MPS/MRP Planning tab. You must enter
both Days of Supply and Window.

• For target inventory level, profile option MSO: Target Inventory Level % of Safety 
Stock. For maximum inventory level, profile option MSO: Maximum Inventory 
Level % of Safety Stock.

• For target inventory level, use safety stock inventory level. For maximum inventory
level, item-organization attribute Vendor Managed Maximum Inventory

• Do not use the inventory level as a constraint

The planning engine smooths target inventory levels and maximum inventory levels in 
the same was as it smooths safety stock levels.
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Calculating Target and Maximum Inventory Levels
For target inventory level:

• You enter Target Inventory Level Days of Supply and Target Inventory Level 
Window

• For each day, Target inventory level = Target inventory level days of supply * 
Average daily requirements

• Average daily requirements = Gross requirements for the next number of days in 
Target Inventory Level Window / Target Inventory Level Window.

For maximum inventory level:

• You enter Maximum Inventory Level Days of Supply and Maximum Inventory 
Level Window

• For each day, Maximum inventory level = Maximum inventory level days of supply
* Average daily requirements

• Average daily requirements = Gross requirements for the next number of days in 
Maximum Inventory Level Window / Maximum Inventory Level Window

Both inventory levels change on days where there is no demand since the planning 
engine calculates them for every day.

For both inventory levels, the day count starts with the current day. If the current day is
not a workday, it starts with the next workday.

For weekly planning buckets, the planning engine adds up the demands in the buckets 
until it reaches Target Inventory Level Window or Maximum Inventory Level Window.
For both levels, if it reaches the end of the window in the middle of a bucket, it prorates 
the demand in that bucket to calculate a smoother inventory level profile (that is not 
influenced by the position of the demands in the bucket).

For example:

• Target Inventory Level Days of Supply is 10

• Target Inventory Level Window is 10

• There are four weekly buckets of seven days each

• Week 22 demand = 700

• Week 23 demand = 350

• Week 24 demand = 525
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• Week 25 (last week of plan) demand = 700

• The target inventory level for week 22 is 600 [(700 / 7) + 350 + ((525 / 7) * 2)]. This is 
the demand on the final day of week 22, the demand on all seven days of week 23, 
and the demand on two days of week 24.

• The target inventory level for week 23 is 775 [(350 / 7) + 525 + ((700 /7) * 2))]

• The target inventory level for week 24 is 875 [(525 / 7) + 700 + ((1400 / 28) * 2)]

• The target inventory level for week 25 is 70 [700 / 7]

Distribution Planning Using Multiple Inventory Policies
Distribution requirements plans consider the replenishment window as decisions are 
made about when an item is to be shipped. The maximum, target, and safety stock 
inventory levels give the plan the flexibility to accelerate or delay trips for the sake of 
economical trip sizes. They are applied to projected inventory on hand without regard 
to pegging relationships or inventory reservations. 

The planning engine calculates supply and demand to the minute. While the safety 
stock and target levels are only calculated on a daily basis, the planning engine tries to 
keep the inventory balance always at the safety stock and target levels. For example, if a
sales order is due to ship at 11:00 am, the planning engine creates a planned order due 
at 1100 am to maintain the safety stock or target inventory level after the sales order 
ships.

The maximum inventory level is an enforced constraint. If demand is greater than 
maximum, the planning engine plans to satisfy the maximum rather than the actual 
demand.

The planning engine uses the following rules to decide what to ship, when to ship, and 
how to consolidate shipments:

• Safety stock level: The planning engine always recommends shipment on time to 
meet safety stock levels, even if it violates minimum trip capacity.

• Target level: During trip consolidation, the planning engine recommends shipment 
on time to meet target inventory level only if it does not violate trip capacity. Load 
consolidation uses target inventory level demands to improve overall trip 
utilization both by shipping early when space on a trip is available and by delaying 
shipments for target demands when there are no trips scheduled. If the ship 
method has no limits, target supplies are not recommended for shipment during the
trip consolidation window. Therefore, you may find a number of shipments for 
target inventory levels immediately after the end of the trip consolidation window. 
If you do not firm or release these planned shipments, the next distribution planing 
run may pull these supplies in if there are trips available earlier to move them.



13-14    Oracle Advanced Supply Chain Planning Implementation and User's Guide

• Early shipments: 

• To use available ship capacity, the planning engine can recommend shipment 
early using a truckload ship method for either safety stock or target inventory 
levels. These supplies are sequenced last on the shipment.

• The planning engine can recommend shipment early to meet any demand with 
a higher priority than target level when the shipping, transit, or receiving 
calendars prevent on-time shipment. It may violate maximum inventory level.

• Non-truckload ship methods: 

• The planning engine never recommends early shipment using a 
less-than-truckload ship method, except when the shipping, transit, or receiving
calendars prevent on-time shipment.

• The planning engine recommends less-than-truckload ship methods only when 
it predicts an organization's on-hand will drop below safety stock. It does not 
recommend less-than-truckload ship methods to meet a target inventory 
method as it assumes that it is not reasonable to use a more expensive method 
in this case. 

The planning engine uses these rules to break ties to fill an available trip:

• If one supply has to ship early: If two supplies take for the same shipping capacity, 
have the same inventory maximums, and are due on the same date, the supply 
pegged to the higher priority demand is recommended to ship early.

• If one supply has to ship late: If two supplies take the same shipping capacity, have 
the same inventory maximums, and are due on the same date, the supply pegged to
the lower priority demand is recommended to ship late.

Example 1

Safety stock levels are calculated by Oracle Inventory Optimization and the two percent
of safety stock profile option values are 300% and 200%. This table shows sample 
maximum, target, and safety stock levels and projected available balance.

Ent
ity

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

Ma
xim
um

15 15 15 15 15 21 21 21 21 21 30 30 30 30 30

Tar
get

10 10 10 10 10 14 14 14 14 14 20 20 20 20 20
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Ent
ity

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

Saf
ety 
sto
ck

5 5 5 5 5 7 7 7 7 7 10 10 10 10 10

Pro
ject
ed 
ava
ilab
le 
bal
anc
e

10 10 10 15 15 14 14 14 14 7 10 10 20 20 30

Pro
ject
ed 
ava
ilab
le 
bal
anc
e 
+/- 
Tar
get

- - - 5 5 - - - - -7 -10 -10 - - 10

Pro
ject
ed 
ava
ilab
le 
bal
anc
e 
+/- 
saf
ety 
sto
ck

5 5 5 10 10 7 7 7 7 - - - 10 10 20

If the percentage for target is 150% of safety stock, then target inventory level is 10.5 
[150% * 7]. The planning engine rounds the target and maximum inventory level values 



13-16    Oracle Advanced Supply Chain Planning Implementation and User's Guide

up if the item attribute enabling rounding control is selected.

If distribution planning does not have to consider optimum use of shipping capacity 
and there is sufficient supply, it maintains an inventory level equal to the target level. If 
there are opportunities to optimize the use of shipping capacity because of multiple 
shipment in a given time period moving into a facility, the actual on hand might 
fluctuate within the range of the maximum and safety stock and occasionally hitting the
target level. Order modifiers can also cause inventory level fluctuations between safety 
stock and maximum. In the example:

• Projected available balance is greater than target on days 4 and 5. This shows that 
five units were planned to be shipped early, possibly due to order modifiers. The 
levels shown in the table are for the destination organization. Early shipments can 
also occur if there is a maximum inventory defined in the source organization and 
the supply in the source exceeds maximum. Supplies ship early to avoid inventory 
violations in the source organization as long as they do not violate maximum 
inventory in the destination.

• Projected available balance on day 6 is at target level

• Projected available balance on days 10, 11, and 12 show that some units were 
planned to be shipped late for the target inventory level but the safety stock 
inventory level is not violated.

Example 2

In this more complex example, safety stocks are actually very low relative to demand. 
From Example 1, there might be a demand for 100 units on Day 10. The 100 unit supply 
could never arrive even one day early using the profile options as specified. The user 
would have to set the profile options maximum percentage of safety stock to a much 
higher value.

In cases like this, it may be better of you select the item attributes method and set 
maximums that allow more flexibility so the planning engine can recommend shipment
of supplies early.

In this example, the same safety stock levels are the same. You enter these values:

• Maximum Inventory Level Days of Supply: 1

• Maximum Inventory Level Window: 2

• Target Inventory Level Days of Supply and Window: <null>

• MSO: Target Inventory Level % of Safety Stock: 200%

The demand on day 16 is also 400 units. The effect of the Maximum Inventory Level 
Days of Supply and Maximum Inventory Level Window values is that demands are 
allowed to arrive at the destination one day early.
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Ent
ity

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15

De
ma
nd

70 70 80 80 100 100 100 150 100 200 200 200 200 200 400

Ma
xim
um

70 75 80 90 100 100 125 125 150 200 200 200 200 300 400

Tar
get

10 10 10 10 10 14 14 14 14 14 20 20 20 20 20

Saf
ety 
sto
ck

5 5 5 5 5 7 7 7 7 7 10 10 10 10 10

Pro
ject
ed 
ava
ilab
le 
bal
anc
e

10 10 80 50 50 7 14 14 150 200 75 10 10 400 400

+/- 
saf
ety 
sto
ck

- - 70 40 40 -7 - - 136 186 55 -10 -10 380 380

The maximum value for day 1 is 70, the average of day 1 and day 2 demands [(70 + 70) /
2].

The maximum inventory level bears little resemblance to the safety stock level. Instead, 
you have chosen to let the maximum inventory level fluctuate based on the average of 
the next two days supply. In other words, the amount of inventory that can arrive early 
in the warehouse is the average demand for two days.

Distribution Planning for Early Shipments
If there are supplies that are available early, the planing engine may decide to ship the 
supplies early. 



13-18    Oracle Advanced Supply Chain Planning Implementation and User's Guide

• Distribution planning netting logic is used. It respects allocation buckets and 
demand priorities. Supplies are rescheduled and planned orders are created based 
on demands (sales orders, forecasts, and safety stock levels) and all available 
supplies (including expected receipts).

• All supplies are pegged to demands or to excess

Maximum inventory level in the destination organization places a limit on how early 
supplies can be shipped since inventory level cannot exceed the maximum. However, 
the maximum is sometimes violated in the destination organization if this organization 
is in the middle of a distribution network. 

For Example:

• Org2 is sourced from Org1 at no lead time

• Org1 is sourced from Org0 at 1 day lead time

• Org2 has demand of quantity 100 due on day 3

• This places outbound demand on Org1 on day 3 and requests outbound shipment 
from Org0 on day 2

• Org1 can only ship once a week on, for example, day 3 and day 10, but can receive 
on any day 

• The demand in Org0 was satisfied late on day 4 and ships on day 4.

• When Org1 gets the shipment from Org0 on day 5, it must carry this inventory until
day 10 when it ships to Org2. If the Org2 maximum inventory level is less than 100, 
this planned transaction violates it.

The distribution planning engine determines how early a supply can be shipped based 
on the maximum inventory level. It then considers trip consolidation constraints and 
profile option MSC: Distribution Planning Ship Date to determine if the item should be 
shipped early.

There can be supplies available from two different sources and both are available early. 
If both cannot arrive at the destination organization early because of its maximum 
inventory level but one supply could arrive early:

• If the maximum inventory level at a source organization would be violated, the 
planning engine recommends shipment from that organization

• Otherwise, it recommends to ship the supply that has the shortest in-transit time to 
minimize the amount of material in transit.
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Distribution Planning for Min-Max Simulation
Distribution planning replenishes to the target level. You might want to prevent the 
distribution engine from ordering small quantities when the projected available balance
is close to the maximum, you can set a fixed order quantity as he minimum value for 
supply orders. For example:

• Safety Stock: 10

• Target: 15

• Maximum: 15

• Fixed Order Quantity: 4

The distribution planning engine does not create a supply order that violates the 
maximum. If projected available balance is 14, the projected available balance will be 18 
(14 projected available balance + 4 fixed order quantity). It does not recommend a 
supply order.

The distribution planning engine does violate the maximum if projected available 
balance is below safety stock. For example:

• Safety Stock: 10

• Target: 15

• Maximum: 15

• Fixed Order Quantity: 12

If projected available balance is 9, it is below safety stock. The distribution planning 
engine recommends a supply order for 12. The projected available balance becomes 17 
(9 projected available balance + 12 fixed order quantity).

Inventory Rebalancing
You use inventory rebalancing if you want distribution planning to resolve an expected 
shortage in one organization by planning to transfer inventory from a related 
organization and vice versa. For example, you have two regional distribution centers 
that are geographically close. If there is a shortage in either distribution center, the 
planning engine plans to use the other organization as a supply source. The planning 
engine does not create bidirectional transfers within the same bucket or across several 
close-in-time buckets to prevent inventory from continually circling back and forth 
between sites.

To specify your inventory balancing relationships, use the sourcing rules and bills of 
distribution of both of the organizations. To indicate an inventory balancing relation, 
you select Inventory Rebalance. You must use the sourcing rules and bills of 
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distribution from the Distribution Planner responsibility. The sourcing rules and bills of
distribution in Oracle Purchasing do not have the inventory rebalance fields.

This example shows rebalancing set up between an east organization (R1) and a central 
organization (R2). You must specify the inventory rebalance relationship between R1 
and R2 on both the R1 local sourcing rule and on the R2 local sourcing rule for the 
inventory rebalancing relationship to be established. Both distribution centers normally 
source from the central distribution center D2.

This table shows the sourcing rules for organization R1 East.

Type Org Supplie
r

Supplie
r Site 

Invento
ry 
Rebala
nce

Allocati
on %

Rank Shippin
g 
Method

Intransi
t Time

Transfer
from

D2 - - Clear 100 1 Truck 2

Transfer
from

R2 - - Selected - <blank> Acme 2

This table shows the sourcing rules for organization R2 Central.

Type Org Supplie
r

Supplie
r Site 

Invento
ry 
Rebala
nce

Allocati
on %

Rank Shippin
g 
Method

Intransi
t Time

Transfer
from

D2 - - Clear 100 1 Truck 2

Transfer
from

R1 - - Selected - <blank> Ace 2

These are the rules that apply to specifying inventory rebalancing relationships:

• Use local sourcing rules and bills of distribution, not global ones, to specify an 
inventory rebalancing relationship.

• Rank and Allocation % default to blank. You cannot change them. If either Rank or 
Allocation % contains a value, you cannot select Inventory Rebalance.

• If ship method is left blank, then the default ship method is used.

• You can specify multiple inventory rebalance sources. Use field Inventory 
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Rebalance Rank to control the order in which the planning engine sources; it 
sources from the highest rank source (lowest number rank) first.

• You can only use one ship method for each inventory rebalancing relationship on a 
sourcing rule or bill of distribution entry. You cannot have multiple sourcing rule or
bill of distribution lines with Inventory Balancing selected and the same Org.

• MPP, MPS, and MRP plans do not use inventory rebalancing relationships.

• The two-way inventory rebalancing relationship needs to be specified for both 
directions or it is not complete.

If one of the inventory rebalancing sources has a supply schedule for an item, no 
inventory rebalancing is done in any direction for that item; the planning engine 
cannot create planned orders for an organization-item with a supply schedule.

This example shows rebalancing set up among an east organization (R1), a central 
organization (R2), and a west organization (R3). You must specify the inventory 
rebalance relationship among R1, R2, and R3 on the R1 local sourcing rule, on the R2 
local sourcing rule, and on the R3 local sourcing rule for the inventory rebalancing 
relationship to be established. You need to mention each pair at least once.

This table shows the sourcing rules for organization R1 East.

Type Org Suppli
er

Suppli
er Site

Invent
ory 
Rebala
nce

Alloca
tion %

Rank Rebala
nce 
Rank

Shippi
ng 
Metho
d

Intran
sit 
Time

Transfe
r from

D2 - - Clear 100 1 <blank
>

Truck 2

Transfe
r from

R2 - - Selecte
d

- <blank
>

0 Acme 2

Transfe
r from

R3 - - Selecte
d

- <blank
>

1 Truck 2

This table shows the sourcing rules for organization R2 Central.
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Type Org Suppli
er

Suppli
er Site

Invent
ory 
Rebala
nce

Alloca
tion %

Rank Rebala
nce 
Rank

Shippi
ng 
Metho
d

Intran
sit 
Time

Transfe
r from

D2 - - Clear 100 1 <blank
>

Truck 2

Transfe
r from

R1 - - Selecte
d

- <blank
>

0 Ace 2

Transfe
r from

R3 - - Selecte
d

- <blank
>

1 Truck 2

This table shows the sourcing rules for organization R3 West.

Type Org Suppli
er

Suppli
er Site

Invent
ory 
Rebala
nce

Alloca
tion %

Rank Rebala
nce 
Rank

Shippi
ng 
Metho
d

Intran
sit 
Time

Transfe
r from

D2 - - Clear 100 1 <blank
>

Truck 2

Transfe
r from

R1 - - Selecte
d

- <blank
>

0 Truck 2

Transfe
r from

R2 - - Selecte
d

- <blank
>

1 Truck 2

Inventory rebalancing relationships create a use up first relationship. That is, the 
supplies in the inventory rebalance relationship are used first before additional supplies
are sourced from other locations. For example, distribution center DC1 has both an 
inventory rebalancing relationship with distribution center DC2 and a non-inventory 
rebalancing, transfer from relationship with manufacturing facility M1. The planning 
engine tries to resolve expected shortages at DC1 with expected inventory from DC2 
before it tries to resolve expected shortages with inventory from M1.

Inventory rebalancing logic respects demand priority. If inventory rebalancing is 
specified between organization DC1 and organization DC2, the planning engine only 
plans to transfer the part of supply from DC2 to DC1 that is not needed to allocate to 
DC2 demands that are higher priority than the demand in DC1 that needs the supply. 
The planning engine does this by only considering the notion of a surplus projected 
available balance and a number of days that the surplus must exist.
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The sources of supply that the planning engine considers for inventory rebalancing are:

• Firm supplies: On hand, firm scheduled receipts and firm planned orders)

• Surplus projected available balance: This is the quantity of projected available 
balance that is higher than target inventory level or safety stock inventory level, 
depending on the value of profile option MSC: Inventory Rebalancing Surplus 
Inventory Basis

Load consolidation is not done for inventory rebalancing relationships and trips are not 
created. The internal requisitions and internal sales orders are created and can be 
released.

Use plan option Inventory Rebalancing Surplus Days to specify the number of 
additional days that the surplus must exist before it can be used as a supply for a 
inventory rebalancing demand. This prevents the surplus from being used on one day 
when it might be needed for a demand tomorrow If it is zero, the surplus only has to 
exist at the end of each day. . For example, this table shows the inventory, supply, and 
demand position of an item, that uses inventory rebalancing:

• Plan option Inventory Rebalancing Surplus Days = 3 days and profile option MSC: 
Inventory rebalancing Surplus Inventory Basis = Safety Stock.

• There are three units of surplus supply on day 3. There is no surplus supply 
beginning on day 6 because of the demands on day 9.

Entity 1 2 3 4 5 6 7 8 9 10

Dema
nd

- - 3 5 - - - - 15 -

Suppl
y

- 1 - 4 7 - - 5 - 10

Projec
ted 
availa
ble 
balanc
e

16 17 14 13 20 20 20 25 10 20

Safety
stock

10 10 10 10 10 10 10 10 10 10

Surpl
us

3 3 3 3 10 - - - - -
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If inventory is planned to be shipped early because of trip consolidation and is firmed 
prior to the current plan run, the current plan run may create a surplus at the 
destination organization

Inventory rebalancing is designed to resolve short term inventory shortages; it is not 
intended to resolve ongoing supply shortages. Inventory rebalance sources are 
considered in the first planning bucket where there is demand. If the first demand is on 
Day 2 in organization A, inventory rebalance transfers may be recommended to meet 
the demand on Day 2. However, inventory rebalancing assumes that by day 3, the 
demands on day 2 have been met, and only considers the new demands on day 3. In 
other words, inventory rebalancing does not carry over unmet demands from one 
bucket to the next, and does not attempt to meet the total shortages over time.

Inventory rebalancing is considered in both the daily and weekly planning buckets. If 
the value of the inventory rebalancing surplus days calculated date falls on any day 
other than the end of the week in the source organization, the planning engine takes a 
conservative approach and extends it to the end of that weekly planning bucket. For 
example, 

• The destination organization does not work on Friday and Saturday

• Surplus days is five

• A demand is due in the destination organization on Wednesday.

• The inventory rebalancing surplus date is the next Wednesday (the demand due 
Wednesday + Thursday, Sunday, Monday, Tuesday, Wednesday)

• If the next Wednesday is in a bucket that ends on Friday, the planning engine 
moves the inventory rebalancing surplus date from the next Wednesday to the next 
Friday.

When evaluating inventory rebalancing results in weekly buckets, past due demands 
are not carried forward during the inventory rebalancing calculations, and so, inventory
rebalancing may not be useful in the weekly buckets which are typically later in a plan 
horizon

Supply allocation rules:

• Are not used to allocate inventory between competing inventory rebalancing 
demands

• Are used to apply order modifiers to inventory rebalancing transfers. Distribution 
plans use only item attribute order modifiers Fixed Lot Multiple and Round Order 
Quantities.

The order modifiers are used for inventory rebalancing as defined on the Supply 
Allocation Rule, and if null then the item attribute order modifier Fixed Lot Multiplier 
is used. When defining a supply allocation rule for a inventory rebalancing relationship,
only define the order modifiers as the demand priority override and fair share 
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allocation selections are ignored by the planning engine.

Inventory rebalancing rules do not consider end item substitution relationships.

Setting Up Supply Allocation Rules
The Supply Allocation Rule form is used to define allocations for multiple destinations 
from a single shipping organization and determine how supply is allocated outwards 
from more central locations. Supply allocation rules are assigned to items and 
organizations within an existing assignment set, and are only assigned to organizations,
not customer sites. They define:

• Methods to allocation supply among competing demands when supply is 
insufficient in a time bucket

• Methods to override the demand priorities for inter-organization demands

To set up Supply Allocation Rules
1. From the Navigator, select Distribution Planning > Sourcing > Supply Allocation 

Rules.

The Supply Allocation Rule form appears.

2. Enter the Name and Description for the supply allocation rule. To import this 
information from another supply allocation rule, click the Copy From button.

3. In the Org fields, enter at least one organization. Organizations listed here are 
considered for both the Demand Priority Override and fair share allocation, even if 
no values are specified in either zone for that organization.

4. Set the Fixed Lot Multiplier to be used by the supply allocation process by entering 
an integer greater than zero. The Fixed Lot Multiplier is used as the order modifier 
for assigned organization items.

This step is optional and is only used for inter-organization transfers. If the Fixed 
Lot Multiplier is not defined by the supply allocation rule, Distribution Planning 
uses the destination organization Fixed Lot Multiplier for transfer order sizing. 

5. Set the Fair Share Allocation method to one of the following:.

• Current Demand: Fair share of supplies is based on the ratio of demands in the 
allocation bucket. You can optionally enter a percent for one or more 
organizations. The percent overrides the safety stock ratio for that organization 
and the remaining organizations are apportioned the remaining percentages 
based on demand ratios.

• Safety Stock Ratio: For an organization, fair share is calculated as follows:, 
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Fair Share Percent = Organization Safety Stock / Total of All Organization 
Safety Stock Levels

You can optionally enter a percent for one or more organizations. The percent 
overrides the safety stock ratio for that organization and the remaining 
organizations are apportioned the remaining percentages based on demand 
ratios.

• Fixed Percent: Fixed percentages of supplies are allocated to each destination 
organization.

The entered percents are used during the allocation process and define the 
minimum amount of the available supplies that an organization should receive.
During allocation, the organization with the highest percent is considered first 
and is allocated up to that percent of the supply before the next organization is 
considered. After all organizations with defined percents are considered, any 
remaining supply is allocated on a first come first serve basis.

• Order Size Method: Fair share is allocated by order size.

• None: There is no fair share, supplies are allocated to demands on a first come 
first served basis.

Fair Share Allocation methods are assigned in the assignments sets form.

Please see the section Fair Share Allocation, page 16-18 for more details.

6. Enter required Percent values for the selected Fair Share Allocation method. The 
form validates Percent depending on the selected Fair Share Allocation method as 
follows:

• Fixed Percent Method: Percent can be entered for each organization.

• Safety Stock Ratio Method: Percent can be entered for each organization. 

• Current Demand Ratio Method: Percent can be entered for each organization. 

• Order Size Method: Percent is disabled.

• None: Percent is disabled.

7. Optionally, you can set the Demand Priority Override to establish priorities by 
organization by choosing Select Organization from the drop-down and specifying a 
priority for each destination organization.

8. To specify how you want to planning engine to allocate external sales orders and 
internal sales orders, see profile option MSC: DPP allocates to existing ISO's before 
other demands with the same priority
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Setting Up Assignment Sets

To set up assignment sets:
1. From the Navigator, select Distribution Planning > Sourcing > Assign Sourcing 

Rules

2. Assign sourcing rules and bills of distribution.

3. Assign supply allocation rules at the organization, organization category, or 
organization-item level.

Supply allocation rules are assigned to the shipping organization and specify how the 
shipping organization allocates when supply is short.

For supply allocation rules, the Assigned to list of values is:

• Organization

• Category - Organization 

• Item - Organization 

Supply allocation rules cannot be assigned at the item or global levels. The context is 
always specific to the shipping or source organization. You must enter the organization 
which becomes the shipping organization context for the supply allocation rule.

Setting Up High Volume Distribution Planning 
Use profile option MSC: Enable DPP Multitasking to enable high volume distribution 
planning.

System administrators set these profile options together for performance tuning 
depending on the plan structure and hardware available:

• MSC: DPP Multitasking Max Concurrent Processes

• MSC: DPP Multitasking Group ID's per Process

These profile options work together to affect performance. For example:

• There are 103 group IDs in a plan and profile option MSC: DPP Multitasking Group
ID's per Process is 4. The plan needs 26 (103 / 4) netting and allocation children 
processes for the entire model. The first 25 children processes will process 4 group 
IDs each, and the 26th child will process the remaining 3 group IDs.

After the netting and allocation phase, the load consolidation processes run. Since 
load consolidation does not use a group ID based filtering it does not use this 
profile option.
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• Profile option MSC: DPP Multitasking Max Concurrent Processes is 6. The planning
process starts six concurrent processes and does not exceed this number during the 
processing but it does process all 26

Order Modifiers
You can use these order modifiers with distribution plans:

• Fixed Lot Multiplier

• Minimum Order Quantity

• Maximum Order Quantity

• Round Order Quantity

See also Items, page 9-3 > Order Modifiers.

You can set:

• All of these as item-organization item attributes

• All except Round Order Quantity as part of the supplier allocation rules

• Minimum Order Quantity and Fixed Lot Multiplier as part of the approved 
supplier list

Order Modifiers and Transfer Orders
The planning engine does not use, approved supplier list order modifiers.

It first uses supply allocation rule order modifiers that are effective on the plan run 
date, regardless of the transfer due date

Otherwise, it uses the item-organization item attribute order modifiers from the 
destination organization.

When there are multiple order modifiers, it uses these procedures to decide on the 
order size.

Use supplier allocation rule order modifier Fixed Lot Multiplier, or item attribute order 
modifier Fixed Lot Multiplier. Set order size to the smallest multiple of the fixed lot 
multiplier that is more than the suggested order.

For example, demand quantity is 100, fixed lot multiplier is 30, order size is 120

Use supplier allocation rule order modifier Minimum Order Quantity, or item attribute 
order modifier Minimum Order Quantity. Set order size:

• Higher than the minimum order quantity
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• Higher than the demand quantity

• In a multiple of the fixed lot multiplier

For example:

• Demand quantity is 100, minimum order quantity is 200, fixed lot multiplier is 0, 
order size is 200

• Demand quantity is 100, minimum order quantity is 200, fixed lot multiplier is 30, 
order size is 210

Use supplier allocation rule order modifier Maximum Order Quantity, or item attribute 
order modifier Maximum Order Quantity. Set order size:

• At the maximum order quantity or lower

• Higher than the minimum order quantity

• At the demand quantity or higher

• In a multiple of the fixed lot multiplier

For example:

• Demand quantity is 100, maximum order quantity is 200, fixed lot multiplier is 0, 
order size is 100

• Demand quantity is 200, maximum order quantity is 200, fixed lot multiplier is 30, 
two orders with order size is 180 and 30

• Demand quantity is 200, maximum order quantity is 200, minimum order quantity 
is 50, fixed lot multiplier is 30, two orders with order size is 180 and 60

If Maximum Order Quantity is the same or lower than Minimum Order Quantity, use 
Maximum Order Quantity as the order size and ignore Minimum Order Quantity.

If Maximum Order Quantity is lower than Fixed Lot Multiplier, use Maximum Order 
Quantity as the order size and ignore Fixed Lot Multiplier.

Round order quantities.

Order Modifiers and Buy Orders
The planning engine does not pay attention to supplier allocation rule order modifiers.

It first uses approved supplier list order modifiers

Otherwise, it uses the item-organization item attribute order modifiers from the 
destination organization.

When there are multiple order modifiers, it uses these procedures to decide on the 
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order size

Use approved supplier list order modifier Fixed Lot Multiplier, or item attribute order 
modifier Fixed Lot Multiplier. Set order size to the smallest multiple of the fixed lot 
multiplier that is more than the suggested order.

For example, demand quantity is 100, fixed lot multiplier is 30, order size is 120

Use approved supplier list order modifier Minimum Order Quantity, or item attribute 
order modifier Minimum Order Quantity. Set order size:

• Higher than the minimum order quantity

• Higher than the demand quantity

• In a multiple of the fixed lot multiplier

For example:

• Demand quantity is 100, minimum order quantity is 200, fixed lot multiplier is 0, 
order size is 200

• Demand quantity is 100, minimum order quantity is 200, fixed lot multiplier is 30, 
order size is 210

Use item attribute order modifier Maximum Order Quantity. Set order size:

• At the maximum order quantity or lower

• Higher than the minimum order quantity

• At the demand quantity or higher

• In a multiple of the fixed lot multiplier

For example:

• Demand quantity is 100, maximum order quantity is 200, fixed lot multiplier is 0, 
order size is 100

• Demand quantity is 200, maximum order quantity is 200, fixed lot multiplier is 30, 
two orders with order size is 180 and 30

• Demand quantity is 200, maximum order quantity is 200, minimum order quantity 
is 50, fixed lot multiplier is 30, two orders with order size is 180 and 60

If Maximum Order Quantity is the same or lower than Minimum Order Quantity, use 
Maximum Order Quantity as the order size and ignore Minimum Order Quantity.

If Maximum Order Quantity is lower than Fixed Lot Multiplier, use Maximum Order 
Quantity as the order size and ignore Fixed Lot Multiplier.

Round order quantities.
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Order Modifiers and Make Orders
The planning engine does not pay attention to supplier allocation rule or approved 
supplier list order modifiers.

It only uses the item-organization item attribute order modifiers from the destination 
organization.

When there are multiple order modifiers, it uses these procedures to decide on the 
order size.

Use item attribute order modifier Fixed Lot Multiplier. Set order size to the smallest 
multiple of the fixed lot multiplier that is more than the suggested order.

For example, demand quantity is 100, fixed lot multiplier is 30, order size is 120

Use item attribute order modifier Minimum Order Quantity. Set order size:

• Higher than the minimum order quantity

• Higher than the demand quantity

• In a multiple of the fixed lot multiplier

For example:

• Demand quantity is 100, minimum order quantity is 200, fixed lot multiplier is 0, 
order size is 200

• Demand quantity is 100, minimum order quantity is 200, fixed lot multiplier is 30, 
order size is 210

Use item attribute order modifier Maximum Order Quantity. Set order size:

• At the maximum order quantity or lower

• Higher than the minimum order quantity

• At the demand quantity or higher

• In a multiple of the fixed lot multiplier

For example:

• Demand quantity is 100, maximum order quantity is 200, fixed lot multiplier is 0, 
order size is 100

• Demand quantity is 200, maximum order quantity is 200, fixed lot multiplier is 30, 
two orders with order size is 180 and 30

• Demand quantity is 200, maximum order quantity is 200, minimum order quantity 
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is 50, fixed lot multiplier is 30, two orders with order size is 180 and 60

• Maximum order quantity is 200, minimum order quantity is 200, fixed lot multiplier
is 30, all orders have order size is 210

If Maximum Order Quantity is the same or lower than Minimum Order Quantity, use 
Maximum Order Quantity as the order size and ignore Minimum Order Quantity.

If Maximum Order Quantity is lower than Fixed Lot Multiplier, use Maximum Order 
Quantity as the order size and ignore Fixed Lot Multiplier.

Round order quantities.

Order Modifiers and Partial Cancellations
When the planning engine recommends a quantity reduction to a scheduled receipt, it 
considers most modifiers. It does not consider order modifier Maximum Order 
Quantity; an order above the maximum order quantity can remain above the maximum 
order quantity.

It first checks for and uses the:

• Supply allocation rule modifiers for internal transfer orders

• Approved supplier list order modifiers for purchase requisitions and purchase 
orders

For example:

• There is an internal transfer order quantity 80.

• Supplier allocation rule order modifier Minimum Order Quantity is 50

• The planning solver can suggest reducing the internal transfer order as low as 
quantity 50

For example:

• There is an internal transfer order quantity 80

• Supplier allocation rule order modifier Minimum Order Quantity is 50

• Supplier allocation rule order modifier Fixed Lot Multiplier is 20

• The planning solver can suggest reducing the internal transfer order as low as 
quantity 60

Order Modifiers and Inventory Rebalance Transfers
To override item-organization item attribute order modifiers, set up one supplier 
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allocation rule for all inventory rebalance organizations and assign it to an organization.

The planning solver uses the supply allocation rule order modifiers for transfers from 
that assigned organization to any organization with an inventory rebalance 
relationship.

For example: 

• Organizations RW1, RW2, RW3, RW4, and RW5 are regional warehouses with one 
or more inventory rebalance relationships. 

• Organization DC is the central distribution center.

• You want to use the same order modifiers for all inventory rebalance transfers.

• Create one supply allocation rule, list the five organizations, and set the order 
modifiers for each destination organization. 

• In the assignment set, assign the supply allocation rule to each of the five 
organizations.
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14
Defining Distribution Plans

This chapter covers the following topics:

• Setting Distribution Plan Options

• The Main Tabbed Region

• The Aggregation Tabbed Region

• The Organizations Tabbed Region

• The Decision Rules Tabbed Region

Setting Distribution Plan Options
This section describes how to set distribution plan options. The distribution plan 
options appear in the following tabbed regions:

• Main

• Aggregation

• Organizations

• Decision Rules

To access the distribution plan options:

• If the plan name is defined: Navigate to Distribution Plans > Options

• If the plan name is not defined: Navigate to Distribution Planner > Distribution 
Plans > Names. Choose your organization if prompted, define a plan name, and 
save your work. To access the plan options, click button Plan Options.
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The Main Tabbed Region
This table describes the fields and options of the Main tabbed region:

Object Description

Demand Priority Rule Set Use this option to set the Demand Priority Rule for 
each plan. Demand priorities are set by demand class 
and demand type. Priorities are assigned to sales 
orders and forecasts. 

End demand priorities are passed down the supply 
chain network on the dependent demands. 

If you prefer, you can enter priorities for each 
demand in the source instance or load priorities for 
each demand into the ODS using SQL tools. When 
you select the demand priority rule set in the plan 
options form, one of the choices is user defined 
priorities. If user defined priorities is selected, 
Distribution Planning uses the demand priorities 
entered for each demand.

Assignment Set Use this option to select assignment set for the 
distribution plan. Assignment sets include the Supply
Allocation rule assignment tab.

• MRP/MPS/MPP plans can use the same 
assignment sets but these plans will ignore the 
supply allocation rules.

• The Supply Allocation tab is only available on 
assignment sets on the planning server.
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Object Description

Use Organization Priority Overrides The Use Organization Priority Overrides check box is 
optional. However, if Use Organization Priority 
Overrides is checked, a demand priority rule cannot 
be used.

Priorities are based on the organization override 
priorities set in the supply allocation rule for each 
organization-item. Allocation from a source 
organization to the destination organizations are 
based on the assigned destination organization 
priority.

• If no priorities are assigned for an 
organization-item, allocations are performed on 
an equal priority basis.

• Priorities assigned to end demands (forecasts 
and sales orders), safety stock and target are the 
same priority as the assigned organization 
priority.

Assign organization override priorities to the source 
organization to control the relative priority level of 
the source organization independent demands versus
the dependent demands from other organizations.

On demand priority override region, in supply 
allocation rules, you can select: 

• Use Organization Priorities: For all demands 
against this organization, the demand priorities 
are set to the values specified for each 
organization. You can set the relative priorities of
all demands from several organizations.

• None or Null: Demand priorities are not 
over-written. 

You can also include the source or shipping 
organization and specify a priority for the shipping 
organization. This allows you to specify priorities for 
the shipping organization when you specify priorities
for the receiving organizations. If Organization 
Priority is selected, all unspecified warehouses are set
at the same priority which is one less than any 
specified warehouses. 
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Object Description

For example, Organizations R1, R2 and R3 source 
from D2. A demand priority override is specified for 
R1 as 1, R2 as 2. and D2 as 2 No priority is specified 
for R3. The default demand priority override for R3 is
3. 

If no organization priority override rule is specified, 
then all destinations and source are treated as having 
the same priority. 

When organization priority override is used, then 
within an organization all demands are given the 
same priority. Supplies are fair shared within this 
priority based on the plan option customer fair share 
allocation method. 

Fair Share Allocation Method: Default For each plan, set default fair share allocation method
from any source organization to the destination 
organizations if no supply allocation rule is specified. 
The three plan option choices are:

• Current Demand Ratio

• Safety Stock Ratio

• None

Use the default method to reduce the number of user 
entered fair share allocation rules. The default 
method is applied to all item-organizations except 
where a Supply Allocation Rule has been explicitly 
defined and assigned to the item-source organization.

When the default fair share allocation method is 
applied to an item-destination organization, you 
cannot specify ranks and percents, so standard 
defaulting logic is used. 
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Object Description

Fair Share Allocation Method: Supplier For each plan, set the supplier fair share allocation 
method used for all suppliers to organizations 
allocation. The three plan option choices are:

• Current Demand Ratio: Fair share based on the 
ratio of the demands from each destination 
organization for the bucket.

• Safety Stock Ratio: Fair share based on the ratio 
of the destination organization safety stock levels
at the end of the allocation bucket

• None: First-come first-serve basis.

Fair share allocation methods are not assigned 
directly to individual suppliers.

The fair share allocation logic is called when supplier 
capacity is defined and demand exceeds available 
supplier capacity in an allocation bucket.

Supplier capacity is fair shared to multiple 
organizations based on the net capacity available at 
the end of an allocation bucket.

The total supply that is allocated is the net supply 
available by the end of the allocation bucket. This is 
based on the supplier capacity. Load consolidation 
for shipments from suppliers to organizations is not 
done. Distribution Planning uses a defaulting 
hierarchy for the order size multiplier for suppliers: 

• Approved Supply List (ASL) Fixed Lot 
Multiplier on the plan run date if defined

• If ASL Fixed Lot Multiplier is null, then use the 
destination organization item attribute Fixed Lot 
Multiplier for internal transfers from and to this 
organization. 

• If destination organization item attribute Fixed 
Lot Multiplier is Null, then use one as the fixed 
lot multiplier if item attribute Round Order 
Quantities is checked.

• Otherwise, use fractional quantities up to six 
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Object Description

decimal places.

Fair Share Allocation Method: 
Customer

For each plan, set customer fair share allocation 
method. The four plan option choices are:

• Demand Class: Fair share allocation is performed
by demand class. Below demand class, supplies 
allocated on a first come first serve basis.

• Customer: Fair share allocation is performed by 
customer. At the customer site level, supplies are 
allocated on a first come first serve basis.

• Customer Site: Fair share allocation is performed 
by customer site.

• None: Supplies are allocated on first-come 
first-serve basis. 

Highest priority demands are allocated supplies first. 
When supply runs short for a particular priority, fair 
share allocation is performed for all demands with 
that priority.
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Object Description

Enable Sales Order Split If Enable Sales Order Split is checked, and the sales 
order line quantity cannot be met on the suggested 
due date, split it into two lines as: 

• 1st line: Sales order quantity reduced to the 
quantity available on the suggested due date.

• 2nd line: New suggested ship date when 
remaining quantity is available.

Sales order line splits are not preserved from one plan
run to the next. Sales order line splits cannot be 
directly released to Oracle Order Management. You 
need to establish a process to update and split the 
sales order lines in Oracle Order Management.

• Distribution Planning issues sales order line 
allocation split exception messages. 

• Ship line complete sales order lines and internal 
sales order lines are not split.

• If no part of the sales order line can be satisfied 
on time, then the sales order line is not split. The 
only order modifier considered when 
determining line splits for sales orders is the 
Round Order Quantity item attribute for the 
shipping organization. Any sales order line that 
is marked order ship line complete cannot be 
split. Any sales order line that is part of a ship set
cannot be split. 

• Firm sales order lines can still be split, as the firm
flag only indicates that the source organization is
firm. 

• If the sales order line split and fill or kill features 
are both enabled, sales order lines are only split 
into two lines when the late quantity can be filled
before or on the latest acceptable date. 
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Object Description

Enforce Supplier Capacity Constraints If Enforce Supplier Capacity Constraints is checked, 
supplier capacity constraints are respected and 
Material Shortage exceptions are issued when 
supplier capacity constrains planned orders.

If Enforce Supplier Capacity Constraints is not 
checked, supplier capacity constraints can be violated
and supplier capacity overload exception messages 
are reported.

Minimum Trip Utilization % and 
Maximum Trip Utilization %

Use this option to set Minimum Trip Utilization % 
and Maximum Trip Utilization %. This option only 
applies to truckload ship methods.

Maximum Trip Utilization: This parameter is upper 
limit for loading a truck. For example, if the user 
specifies this parameter to be 90%, then no truck is 
loaded over 90% of the maximum weight and cube 
capacities. If null, 100% is used. 

Minimum Trip Utilization: The planning engine 
generates different truckload trips with various levels
of capacity utilization. Distribution plans attempt to 
create trips that have capacity utilization greater than 
the minimum truckload utilization. If null, 0 is used.

• Both weight and cube trip limits are considered 
by distribution planning.

• Trips are not loaded in excess of the maximum 
trip utilization %.

Under-utilized trip exceptions reported for trips 
below the minimum trip utilization %:

• Under-utilized trips are not scheduled until one 
of the supplies on the trip is required to prevent 
safety stock inventory violations or required for 
higher priority demands.

• If the trip is scheduled because of one supply, 
additional supplies may be loaded to improve 
trip utilization even though not required on the 
scheduled dock date in the destination.

Other fields on the main tab are similar to MRP and MPS plan options. Please see the 
section The Main Tabbed Region, page 5-38 for more details.
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Enable Sales Order Split
In the following example, the upper table shows the sales orders before splitting and 
the lower table shows the Distribution Planning split of the sales orders based on 
supply of 100 units on Day 1 and 100 units on Day 3. Customer fair share allocation is 
enabled.

Customer Priority Demand 
Quantity

Qty by Due 
Date

Ship Date Due Date

Customer A 1 100 Day 1

Customer B 1 100 Day 1

Customer Priority Demand 
Quantity

Qty by Due 
Date

Ship Date Due Date

Customer A 1 50 50 Day 1 Day 1

Customer B 1 50 50 Day 1 Day 1

Customer A 1 50 0 Day 3 Day 1

Customer B 1 50 0 Day 3 Day 1

In this example, each sales order line is split into two lines. The Distribution Planning 
output shows the two lines on Day 1 have a smaller quantity and the remainder of each 
original sales order demand is now a new sales order line with a ship date of day 3. 

These sales orders cannot be released back to Oracle Order Management. You should 
enable a process that allows the planner to communicate the splits to the customer 
service department, who can then notify the customer when the sales orders will be 
shipped.

The Aggregation Tabbed Region
Distribution Planning provides controls for several functional time intervals as:

• Daily and weekly planning buckets

• Load consolidation horizons

• Allocation time buckets
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• Inventory rebalancing surplus days

• Infinite time fence days

During daily planning buckets, Distribution Planning calculates supplies and demands 
down to the minute level. During the weekly planning buckets, Distribution Planning 
aggregates demands and supplies by week. Period buckets are not used in Distribution 
Planning.

This table describes the fields and options of the Aggregation tabbed region:

Object Description

Trip Consolidation Days Trip consolidation days are days from the 
plan start date that trips are created, 
scheduled and consolidated.

• Days are measured in working days 
based on the plan calendar as defined by 
owning organization or calendar profile.

• Must be less than or equal to daily 
buckets.

• Internal transfers are consolidated onto 
trips if the ship date is inside the trip 
consolidation window even though the 
dock date may be after the trip 
consolidation end date.

Trip Consolidation End Date The Trip Consolidation End Date field is 
display only. It displays the end date of the 
trip consolidation horizon. The time stamp of 
the trip consolidation end date is 23:59.

Period Allocation Bucket Check to enable period allocation based on the
plan calendar. When checked, Daily 
Allocation Buckets and Weeks per Aggregate 
Allocation Bucket are grayed out.

Daily Allocation Bucket The number of days during which the 
allocation bucket size is one day. Daily 
allocation buckets are counted against 
working days on the plan calendar.

Weekly Allocation Bucket Start Date This field is display only and shows the start 
date for a weekly allocation bucket.
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Object Description

Weeks per Weekly Allocation Bucket The number of weeks contained in each 
aggregate allocation bucket. 

Inventory Rebalancing Days The number of days that surplus inventory 
must be available before it can be used as 
supply for a demand from an inventory 
rebalancing relationship. Only firm supplies 
are considered for inventory rebalancing. 

Inventory rebalancing relationships are 
defined in the sourcing rules. 

Inventory rebalancing rules define a use up 
first relationship. Inventory is transferred 
from inventory rebalance sources first, thereby
using up the surplus at another organization 
before sourcing through the usual channels.
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Object Description

Infinite Time Fence Horizon Days Infinite time fence (infinite time fence) horizon
days is the number of days from the plan start 
date that the supply schedule is a constraint. It
is calculated based on working days in the 
planning calendar. If the infinite time fence 
start date is later than the plan horizon end 
date, the first day after the plan horizon end 
date is displayed as the infinite time fence 
date. 

After the infinite time fence start date, the 
distribution planning engine behaves as 
follows: 

• The infinite time fence applies to the 
lowest level organization in the supply 
chain where there is a supply schedule.

• Internal transfers are generated even if 
supply is not available. 

• After the infinite time fence, projected 
stockout exceptions are issued if there is a
supply and demand mismatch. 
Constraint exceptions and demand 
quantity is not satisfied exceptions are not
issued in the lowest level organization. 

• Ship Method selection is still done after 
the infinite time fence.

• Fair share allocation of supplies does not 
occur after the infinite time fence in the 
lowest-level organization. 

• The infinite time fence does not apply to 
supplier capacity.

• Load consolidation is not performed after
the infinite time fence. 

• Pegging is not calculated for supplies 
outside the infinite time fence. There is a 
placeholder in the pegging tree for the 
lowest level organization.
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Object Description

Infinite Time Fence Start Date The first date of the Infinite Time Fence.

Please see the section Inventory Rebalancing, page 13-19 for more details.

Daily Allocation Buckets
Daily allocation buckets are the number of buckets during which the allocation bucket 
size is one day. 

Null or zero value means that there are no daily allocation buckets. For example, if the 
plan start date is on a Wednesday and week ending date is Sunday, the first weekly 
allocation bucket is short two days. 

You must specify that the number of daily allocation buckets is less than or equal to the 
number of daily planning buckets. 

Weeks per aggregate allocation bucket is the number of weeks contained in each 
aggregate allocation bucket. It can be an integer only. If the weeks per aggregate 
allocation bucket is two or more, then the last allocation bucket may not contain that 
number of weeks (depending on how many weeks are left before the plan horizon end 
date). For example, if weeks per allocation bucket is two, but the plan horizon only 
allows one week in the last allocation bucket, only one week is used. 

The plan horizon is not extended because of the allocation buckets. If there are daily 
allocation buckets, the aggregate buckets start on the next week start date and 
additional daily allocation buckets may be used. For example, if the daily allocation 
buckets end on a Thursday and the week start date is Monday, one additional daily 
allocation bucket is used (assuming that Saturday and Sunday are non-working days).

Supply allocation proceeds bucket by bucket. Demands in the first bucket (daily, 
weekly or period) are sorted by priority and firm demands are given the highest 
priority. Within the bucket, for each demand of a priority: 

• Demands are allocated supplies on or before the demand date 

• Or if not available by the demand date, then by the bucket end date

• Or if a shortage occurs for a demand priority within an allocation bucket, the 
supplies are fair shared based on the supply allocation rules and plan options 

Unsatisfied demands are carried forward to the next allocation bucket

Trip Consolidation Days
Trip consolidation days sets the trip scheduling horizon. Trips consist of internal sales 
orders and internal transfers that are scheduled with the same ship date, dock date, and
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ship method. 

Distribution Planning selects ship methods by working through the list of available ship
methods. The list is sorted by rank (lowest value first), cost (lowest cost first using the 
costs specified on the inter-organization ship methods form), in transit time (shortest in 
transit time first), and then maximum trip weight (highest value first). 

After a ship method is selected for the first internal transfer, calculate the earliest the 
trip can ship based on the supply availability and the latest the trip could possibly 
arrive based on the destination inventory requirements. Continue loading the trip with 
additional supplies that fit within the trip earliest possible ship date and latest possible 
dock date.

Distribution Planning uses the following rules when consolidating trips: 

• Safety stock level: distribution planning will always ship available supplies on time 
to meet safety stock demands. Minimum Trip Capacity can be violated. 

• Target level: During trip consolidation, distribution planning will only ship 
available supplies on time to meet target inventory levels if there is a trip that the 
supply can be put on without violating the trip capacity.

• For a supply, the earliest possible ship date considers the destination maximum 
inventory level constraint. 

• For a supply, the latest possible dock date considers the source maximum inventory
level constraint.

Trip Identifiers
Trips are identified in the trips form and the supply and demand window with trip 
numbers. Trip identifiers appear in the Distribution Planning Trips form and the supply
and demand window. Internal sales orders and internal requisitions on a trip have the 
same ship and dock date and ship method. Transfers are grouped based on the load 
consolidation limits for a ship method Trips are created within the load consolidation 
horizon.

Trip identifiers are not released to the source instance, only the internal sales orders and
internal requisitions which make up the trip are released to the source instance. 

If an internal transfer is too big for the maximum trip size, then the internal transfer is 
automatically split into two or more internal transfers where each internal transfer is 
now the maximum trip size or lower. Automatic splitting of internal transfers into 
smaller sizes to meet the maximum trip size constraint occurs in one of two cases: 

• If the selected ship method maximum trip size would be violated, then the internal 
transfer can be split into multiple internal transfers so that the trips are below the 
maximum trip size. For example, if the internal transfer is for 1000 units and 200 
units fill a semi-trailer, then 5 internal transfers are created. 
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• For ship methods that do not have a maximum trip size, internal transfers are not 
split.

The Trips Form
The Trips form displays details about each trip including the from and to organizations 
and the ship and dock dates and the ship method. The weight and cube utilization are 
calculated and displayed in percents if trip limits are defined for the ship method. 

Other fields shown include trip weight and cube, available weight and cube, and 
maximum weight and cube. Also included for each trip are the in transit lead-time, the 
ship method, mode, service level and carrier name. Statuses for each trip are provided 
to show if it is an existing trip and if there are trip utilization exceptions issued for it. 

The following is calculated for each trip and displayed in the trips form: 

• Earliest supply date: The earliest possible date that a trip can ship based on the 
material available dates of all of the supplies on the trip. Tells the planner that a trip
can ship earlier than scheduled. For demands, the material available date means 
when the supplies pegged to the demand are complete and available for shipping. 

• Latest possible dock date: The latest of all of the required dock dates for the 
supplies scheduled on the trip. Tells the planner when the trip should arrive at the 
destination organization. If it is earlier than the actual scheduled dock date, it 
indicates that the trip requires expediting. 

• Cost of under utilization: The formula is Trip Upper Weight Limit * (cost/weight 
unit) - Actual Trip Weight * (cost/weight unit). Applies when the cost/unit for 
weight is provided on the inter-organization shipping form. 

Understanding Time Aggregation Options
This diagram illustrates the relationship among the trip consolidation time fence, the 
trip consolidation days, the infinite time fence, and the daily/aggregate allocation 
buckets. In this example, the planning buckets are daily.
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The Organizations Tabbed Region
You can specify a distribution plan as a supply schedule to other distribution plans. 
This enables you to subset the distribution planning problem and run multiple 
distribution plans. You can run a centralized allocation plan less frequently and run 
replenishment plans for the outlying locations more frequently. The behavior of a 
distribution plan as a supply schedule is exactly the same as the behavior of 
MPP/MPS/MRP plans as supply schedules. 

For items and organizations planned in the central plan, no new supplies are planned 
when it is used as a supply schedule. Instead, the available supplies are pushed further 
outwards in the supply chain and may be reallocated during subsequent runs of the 
distribution plan. The only difference is after the infinite time fence. 

Distribution plans can be fed as a demand schedule to a distribution plan. This allows 
distribution planning users to also subset the planning problem into multiple 
distribution plans, and close the loop between plans by feeding the main distribution 
plan as a demand schedule. When a distribution plan is listed as a demand schedule for 
an organization in a second distribution plan, the behavior is similar to checking the 
interplant check box on an Oracle Advanced Supply Chain Planning plan. The only 
demands passed are the requested outbound shipments for the organization. The 
demands from the demand schedule plan appear in the distribution plan as 
inter-organization demand.

Setting Up the Organizations Tabbed Region
1. Enter global demand schedules from Demand Planning.

2. Check or uncheck the Include Sales Order check box.

WIP, Reservations, and Purchases are always included. Safety stocks are always 
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planned.

3. Add demand and supply schedules.

Distribution plans can be used as demand schedules. Distribution plans and 
MRP/MPS/MPP plans can be supply schedules.

Distribution plans do not create any new planned orders for item-organizations that
are found in an MRP/MPS/MPP supply schedule or a Distribution Plan supply 
schedule until the infinite time fence. If there are existing non-firm supplies for that 
item-organization that are not in the supply schedule, these are canceled by default 
since the distribution plan relies on the supply schedule. If the existing supplies are 
firm, then the distribution plan does not cancel them. 

The Decision Rules Tabbed Region
When the MSO: Enable Decision Rules is set to Yes, you can select Decision Rules 
options for Distribution Planning in the Decision Rules Tab. This tab is grayed out if 
you have set MSO: Enable Decision Rules to No.

Decision rules are supported by Distribution Planning for:

• End item substitution

• Substitute components

• Alternate BOMs

• Alternate sources
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15
Running and Analyzing Distribution Plans

This chapter covers the following topics:

• Global Forecasting

• Ship Method Selection

• Distribution Planning Overview

• Distribution Plan Workbench

• Distribution Plan Exception Messages

• Defining Organization Selection Lists

Global Forecasting
You can use global forecasting with distribution plans; see Global Forecasting, page 5-
107. If you use global forecasting, you forecast across your enterprise using global 
demand schedules from Oracle Demand Planning. Distribution planning selects a 
source organization to meet each forecast and sales order demand; this results in local 
allocation of supply across your distribution network.

If global forecasts are not used, then sales order consumption occur for sales orders 
with ship from organizations that have organization forecasts. If there are multiple 
organizations in a plan and no global forecasts, then for any organization without any 
forecasts, there will not be any sales order consumption with a ship from for that 
organization.

Use the Ship Methods and Inter-Location Transit Times forms to define shipping 
methods between and organization and regions/zones for use in global forecasting.

The firm flag in global forecasting indicates that the source organization is firm, just as 
it does for sales orders. If global forecasting is enabled, sales order warehouses are 
selected before any sales order line splits occur.

For customer vendor managed inventory, Oracle recommends that you use global 
forecasts to represent projected future demand from the customer. For consigned 
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vendor managed inventory, at the external organizations, the internal requisitions and 
planned inbound shipments are allocated to the global forecast but ship method 
selection is not performed since it is not required for allocations to a forecast.

Ship Method Selection
In sourcing rules and bills of distributions, you can specify multiple supply sources 
within each rank and assign percentages to each. Distribution plans use the percentages
for different supply sources if you are not using decision rules. They do not necessarily 
use the percentages for the same supply source with different ship methods

When there is more than one available ship method for a source, distribution plans 
select ship method by this process for each organization supply source. Set profile 
option MSC: Distribution Planning Ship Date to instruct the planning engine when to 
schedule the departure of trips with truckload ship methods that is considers for load 
consolidation.

Sort the ship methods in this order:

• Rank (lowest value first)

• Cost (lowest cost first): From the Oracle Inventory Shipping Networks form

• Intransit Time (shortest intransit time first)

• Maximum trip weight (highest value first)

Select a ship method that meets that required delivery time by meeting the following 
criteria:

• Rank 1

• Lowest cost ship method

• The demand's (demand dock date - available date) is the same or more than the 
intransit time

• Trip size is between maximum and minimum utilization targets

If more than one ship method meets the required delivery time, select the ship method 
that most closely meets these criteria:

• Rank 1

• Lowest cost

• Shortest lead time

If the trip created does not match the selected ship method maximum and minimum 
trip utilization targets, select the ship method that most closely meets these criteria:
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• Rank 1

• Lowest cost

• Matches maximum and minimum trip utilization targets

If there is still no ship method that meets the rank 1 criteria, verify whether or not Plan 
Option form, Decision Rules tab, Alternate Sources is selected. If it is, evaluate the rank 
2 alternate sources and consider alternate ship methods against the criteria. If there is 
still no ship method that meets the criteria, evaluate the rank 3 alternate sources.

If no Ship Method is found that meets the criteria, the supply is likely to be late. Select 
the shortest lead-time ship method unless there is a trip sizing consideration that leads 
to the selection of another ship method.

Distribution Planning Overview
Demand Types

Distribution planning uses the following independent demand types: 

• Oracle Demand Planning forecasts: Organization specific and Global forecasts for 
all organizations

• Source instance org-specific forecasts: Oracle Inventory > Planning >Forecasts 

• Sales Orders

• Inventory optimization plans for safety stock levels 

• Distribution plans as demand schedules to distribution plans

Supply Types

Distribution planning uses the following supply types:

• On Hands 

• Expected receipts 

• Scheduled receipts from work orders, purchase orders, and requisitions: Discrete, 
process, and flow manufacturing supplies are supported

• Planned orders as supplies: From Other distribution plans: Oracle Advanced 
Supply Chain Planning MRP/MPS/MPP plans and source instance MPS plans

Oracle Project Manufacturing and Oracle Shop Floor Management are not supported 
with distribution planning. 

Internal Requisitions and Internal Sales Orders
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Users can create internal requisitions and internal sales orders with the standard 
procedures in Oracle Purchasing and Oracle Order Management. These are collected 
and used as supplies and demands for distribution plans. 

Internal requisitions and internal sales orders may not match each other in the source 
instance. This happens because of user changes to the internal sales order, partial 
shipments of the internal sales order, rescheduling by distribution planning of the 
internal sales order, and so forth. Users are not allowed to update the internal 
requisition so after changes to the internal sales orders, the two documents may not by 
aligned. To resolve this for planning, the internal sales order is used as the source of 
truth in distribution planning. 

During collections, both internal sales orders and internal requisitions are collected. In 
distribution planning, we use the correct internal requisition number and source and 
destination organizations for the internal requisition. However, the quantity, ship date 
and timestamp, arrival date and timestamp, ship method, and firm flag are the values 
found on the internal sales order. The result is that distribution planning takes a single 
view of the internal transfer, as defined by the internal sales order, and does not contain
contradictory values for the two documents. 

If internal requisitions have been created, but the corresponding internal sales orders 
have not been created, then when we have a mismatch:

• Firm internal requisitions: They remain as firm with no change to date and 
quantity. The supply and demand picture in the source organization (where the 
corresponding Internal Sales Order should be) is incorrect. 

• Not firmed internal requisitions: They may get rescheduled in or out. 

Supplier Capacity

Define supplier capacity in the Approved Supplier List in Oracle Purchasing 

Distribution planning uses the same supplier capacity model that is used in the 
MRP/MPS/MPP plan types 

MRP/MPS/MPP Supply Schedules

Distribution plans can be used as a Demand Schedules for MRP/MPS/MPP plans and 
the resulting MRP/MPS/MPP plans are used as supply schedules for the same 
distribution plan. Users should run the MRP/MPS/MPP plans to update the plans with 
the latest supply information before running the distribution plan. 

Make the distribution plans demand schedules available to MRP/MPS/MPP plans with 
the following rules: 

• Dependent demands are passed for all inter-organization demands. 

• Distribution plan demand quantities, due dates, and demand priorities passed to 
the MPP/MPS/MRP plans are the initial unconstrained quantities and demand due 
dates; these are before constraints and trip consolidation is considered in the 
distribution plan. The priorities passed are the actual priorities except in the case of 
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safety stock level, target inventory leve, and excess supply priority. 

Optionally include target inventory plan option for MRP/MPS/MPP plans using 
distribution plan as a demand schedule: 

• Yes: Users may establish target inventory levels and attempt to plan to meet the 
target inventory demands. However, when smoothing their production schedules 
and resolving constraints, they may choose to produce some amount less than 
required by the target inventory levels. In this case, distribution planning 
distributes according to safety stock inventory levels first and then allocates the 
remainder using the target inventory levels 

• No: Do not use target inventory levels. Users do not want to plan production levels 
to meet target inventory demands. Only consider target inventory levels when there
is excess inventory in the central locations. 

Inventory Optimization Plans

Inventory optimization plans can be used as a time-phased schedule of safety stock 
levels by item-organization. 

Run Oracle Inventory Optimization as needed to update time-phased safety stock levels

Oracle Inventory Optimization plans accept distribution plans as demand schedules 

In turn, Oracle Inventory Optimization plans pass time-phased safety stock levels to the
distribution plans 

Collections

Collections processes are the same collections processes used for MRP/MPS/MPP plans

Since distribution planning does not consider routings and resources, users do not need
to collect these entities unless required for MRP/MPS/MPP plans. Schedule and collect 
other entities as needed. 

If you use legacy collections to import supply for kitting as work orders, you must also 
import the kit component demand. If you want the distribution planning engine to 
create the kit component requirements, import the supply as firm planned orders.

High Volume Processing

High volume distribution plan processing is a special type of processing that you can 
use if you are a business with large numbers of:

• Locations: For example, in the thousands

• Items per location. For example, in the tens of thousands or more

It handles large volumes of processing using multi-processing, either:

• Multiple servers linked together with Oracle Real Application Clusters

• A single planning server with multiple processors
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Consider using high volume distribution planning if your business could benefit from

• Increased plan availability: Plans are available earlier in the day and release of 
planned orders occurs earlier in the cycle. Warehouses have earlier visibility into 
the daily transfer requirements. 

• More frequent regeneration of plans: Daily or intra-day depending on location and 
item sizing). Warehouses have more frequent visibility to the latest supply and 
demand picture. 

• Improved operational efficiency: Since transfers and purchases can be released later
in the business cycle, distribution planners can better account for the latest supply 
and demand picture and increase accuracy of their quantities and schedule dates.

• Reduced server hardware load: Requires less total memory on the planning server. 
Large volume plans can load to available server memory.

The planning engine uses multi-processing during the distribution planning phases of:

• Supply allocation: Calculates the independent and dependent demands at each 
distribution location and allocates supply to those demands

• Load consolidation: Shipping early or late to improve trip utilization

Launch Distribution Plans

Parameters are the same as those for MRP/MPS/MPP plans.

Distribution Plan Workbench
Distribution Plan Summary

Use Distribution Plan Summary for fast, easy analysis of the distribution planning plan 
output.

The plan summary is new for distribution planning. The plan summary can be accessed
from: 

• The navigator, by highlighting the plan name and right clicking to Plan Summary 

• (M) Plan >Plan Summary 

The user can specify the default plan and default tab as plan summary in the plan 
preferences. If the user opens the Planner Workbench, then the plan summary is 
displayed by default. If the user is not in the owning organization for the default plan 
specified in the plan preferences, the Planner Workbench opens with the usual plans 
view. 

A new region on the Other tab of the plan preferences is called Plan Summary. It holds 
the specifications for the plan summary screen including the planner name field (used 
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for the counts in the plan summary section). 

Automate opening the plan summary: 

• Set Plan Preferences >Default Tab = Plan Summary

• Set Plan Preferences >Default Plan = <plan name>

• Open Planner Workbench and the plan summary automatically opens for the 
default plan 

Plan summary data can be filtered for each planner:

• Set Plan Preferences > Plan Summary: Select a planner 

• Plan Summary only displays data for the selected planner specified in the user's 
plan preferences 

The Summary region displays pre-seeded exceptions and recommendations 

The seeded exception messages alert you to:

• Material Shortages

• Late Sales Orders 

• Under Utilized Trips 

Click Details to open the exception details.

Recommendations alert you to: 

• Trips Ready for Release 

• Purchases Ready for Release

Click Details to open the recommendation details and click Release to release all trips or
purchases.

Plan summary counts are planner specific if planner is specified in the plan preferences.

KPIs

The KPI region displays four comparison statistics. They are recalculated each time that 
the plan is run

• Inventory Turns: Calculated in the same way as Oracle Advanced Supply Chain 
Planning 

• Vehicle Utilization: Displayed as a percent. Vehicle utilization = Average (All trip 
utilizations for the plan). Each trip utilization is included if Ship Method = 
Truckload and Weight Capacity Limit is not null. Each Trip utilization = Trip 
weight / Trip weight total capacity. 
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• Fill Rate: Same as on time delivery: [(Total number of orders - Number of late 
orders) * 100) / Total number of orders]. We do not show service level which is 
computed in Oracle Advanced Supply Chain Planning as (Demand quantity 
satisfied by due date / Demand quantity) * 100. In the distribution market, the 
number of sales orders completed on time is more interesting than the quantity 
satisfied by due date. 

• Supply Chain Costs: We only support total cost in the display and do not display 
the components of the cost breakdown. It is calculated the same as Oracle 
Advanced Supply Chain Planning. 

Users can also open the key indicators window from the planner workbench tree.

Set the targets for the four key indicators in the plan preferences.

High Volume Processing

Some distribution planning workbench windows are not available for plans run with 
high volume processing. In these plans, allocation details are not updated for the final 
plan output. They are:

• From the Horizontal Plan window and the Allocation Plan, the Allocation Details 
view

• From the Trips view, the Trip Allocation Details view

There can be variances between exception messages issued by high volume and 
standard distribution plans because the supply and demand pictures may be slightly 
different. In standard distribution plans, the planning engine performs the netting and 
allocation and the load consolidation together; in high volume distribution plans, it 
performs them separately.

Distribution Plan Exception Messages
Overview

For general information about exception messages, see Overview of Exception 
Messages, page 17-1. The list of exception messages there summarizes the exception 
messages for the supply chain planning types (master production plan, master 
production schedule, and material requirements plan). Distribution planning shares 
some of these exception messages and it has some unique exception messages. The 
topics that describe the distribution planning exception groups explain the exception 
messages issued by distribution plans.

Viewing Exceptions

You view distribution planning exception messages in the same way as one views 
supply chain plan exception messages. However, for distribution plans, you use the 
Distribution Plan Workbench rather than the Planner Workbench to access them. For 
general information about how to view exception messages, see Viewing Exceptions, 
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page 17-9.

Personal Queries

Most Important Exceptions uses a personal query.

Set the personal query used in the Plan Preferences > Other > Most Important 
Exceptions Personal Query.

Right click from most important exceptions to navigate to exception details, supply, 
demand, trips, and so on.

Personal Queries enables users to: 

• Create a custom name for each exception 

• Include recommendations and reschedules, and sales order changes

• Use the same exception multiple times (for example, late sales orders for X, and late 
sales orders for Y)

• Leverage enhanced inventory level exceptions filter criteria: Percent above or below
safety stock or target or maximum 

It works as follows: 

• The custom name is displayed, not the exception name. The count is for the total 
number of exceptions and ignores any group by's defined for the personal query

• The Edit Query button opens the personal query from. 

• The Details button opens the exception details for the highlighted row. 

• Right Clicks from any row include: 

• Exception Details: Shows the exceptions for the row highlighted 

• Supply, Demand, Supply and Demand, and On Hand: Shows all supply and 
demand without regard to the custom exception parameters. 

• Items: Shows all items

• Trips: Shows the trips for a trip related exception.

• The exceptions are sequenced in the window just as they appear in the personal 
query.

Related Exceptions

This table shows related distribution planning exceptions. After you review an 
exception message, you might consult related exception messages to gather more cause 
and effect information about a situation.
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Exception Group Exception Message Related Exceptions

Late Sales Orders and 
Forecasts

Late replenishment 
exceptions for sales orders / 
forecasts

Material constraint

Order lead time constraint

Order is firmed late

Demand quantity is not satisfied

Late Sales Orders and 
Forecasts

Sales order / forecast at risk Order causes supplier capacity 
overload

Order with insufficient lead time

Material Capacity Material constraint Allocation constraint

Order lead time constraint

Item shipment consolidated to a 
later date

Supply Exceptions for 
Late Sales Orders and 
Forecasts

Allocation constraint Allocation bucket details

Shortage and Excess Items with a shortage Material constraint

Allocation constraint

Shortage and Excess Items below safety stock Material constraint

Allocation constraint

Shortage and Excess Items below target Material constraint

Allocation constraint

Item shipment consolidated to a 
later date

Late Sales Orders and Forecasts Exception Group
The following sections discuss the exceptions in this exception group and state their 
effects on distribution plans.

Sales order/forecast at risk
Explanation
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The purpose of this exception is to indicate that a certain end demand is at risk. The 
reasons for this risk are investigated by going to the various related exceptions. 

This exception is only generated when the sales order is in the same organization that 
sources from a supplier. The exception can occur when Enforce Purchasing Lead times 
or Enforce Supplier Capacity is not checked in the plan options.

Note: The planner can keep the Enforce Supplier Capacity or 
Purchasing Lead-times constraint disabled, or the planning engine can 
disable these constraints if the demand pegged to a sales order is late.

This exception will be calculated by obtaining a unique list of demands from the list of 
end demands that are pegged to:

• Supply orders that cause Supplier Capacity Overload: This exception message 
appears when the scheduled supplier capacity in a planning time bucket is 
overloaded

• Supply order with insufficient lead time: This exception message appears when the 
scheduled supply order violates purchasing lead time

The following exception messages are in the Late Sales Orders and Forecasts exception 
group that you can use for collecting further information about the sales order or 
forecast at risk:

• Sales Order / Forecast at Risk due to Material Shortage

• Order causes Supplier Capacity Overload

• Order with Insufficient Lead-time

Information Displayed

The information displayed for this exception message all refers to the demand line and 
is:

• Order Number: The Order Number for the Sales Order

• Item: The name of the end item

• Category: The category where the end item exists

• Org: The organization for the end item

• End Item Description

• Order Type 

• Demand Date
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• Planned Arrival Date

• Product Family

• Order Quantity

• Customer

• Customer Site

• Demand Class

• Planner: The planner name

• Planning Group

• Priority

Resolution Suggestions

Check for more details from related exceptions in the Supply Problems for Late Sales 
Orders and Forecasts exception group.

Past due sales orders
Explanation

This exception message appears for past due sales order lines. A past due sales order 
line is a sales order line with a schedule date earlier than the plan horizon start date.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Past due sales orders" in Late Sales Orders and 
Forecasts Exception Group, page 17-14.

Past due forecast
Explanation

This exception message appears for late forecast entries. A late forecast entry is a 
forecast entry with a date earlier than the plan horizon start date. The planning engine 
issues this message even if the forecast is totally consumed.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Past due forecast" in Late Sales Orders and Forecasts 
Exception Group, page 17-14.

Late replenishment for sales order
Explanation
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This exception message appears in a distribution plan when the planning engine detects
that the supplies for a sales order line are due later than the sales order line due date. 
This exception is generated for external sales orders and is not generated for internal 
sales orders.

The demand satisfied date is the latest due date of the supplies pegged directly to an 
end demand. The planning engine issues this exception message against a sales order 
line when its demand satisfied date is later than its schedule date.

This exception usually occurs because of a material constraint or planning time fence. It 
often occurs in Enforce Purchasing Lead Time and Enforce Supplier Capacity 
constrained plans when the planning engine needs to move supply order due dates to 
honor supplier capacity or lead-time constraints.

For example, there is a sales order line on item A due 25 January for quantity 100 in 
organization D2 The supplies pegged to this sales order line are:

• Supply 1: Quantity 50 and due date 23 January

• Supply 2: Quantity 20 and due date 25 January

• Supply 3: Quantity 30 and due date 27 January

• Demand satisfied date is 27 January (from Supply 3).

• Days late is 2.

• Quantity satisfied by sales order line schedule date is 70 (from Supply 1 and Supply
2).

For more information on this exception message, see Late Sales Orders and Forecasts 
Exception Group, page 17-14.

Late replenishment for forecast
Explanation

This exception message appears in a distribution plan when the planning engine detects
that the supplies for a forecast are due later than the forecast due date.This exception is 
generated for external sales orders and is not generated for internal sales orders.

The demand satisfied date is the latest due date of the supplies pegged directly to an 
end demand. The planning engine issues this exception message against a sales order 
line when its demand satisfied date is later than its schedule date.

This exception usually occurs because of a material constraint or planning time fence. It 
often occurs in Enforce Purchasing Lead-Time and Enforce Supplier Capacity 
constrained plans when the planning engine needs to move supply order due dates to 
honor supplier capacity or lead-time constraints.

For example, there is a forecast entry e on item A due 25 January for quantity 100 in 
organization D2 The supplies pegged to this forecast entry are:
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• Supply 1: Quantity 50 and due date 23 January

• Supply 2: Quantity 20 and due date 25 January

• Supply 3: Quantity 30 and due date 27 January

• Demand satisfied date is 27 January (from Supply 3).

• Days late is 2.

• Quantity satisfied by forecast schedule date is 70 (from Supply 1 and Supply 2).

For more information on this exception message, see Late Sales Orders and Forecasts 
Exception Group, page 17-14.

Supply Exceptions for Late Sales Orders and Forecasts Exception Group
The following sections discuss the exceptions in this exception group and state their 
effects on distribution plans.

Allocation constraint
Explanation

The allocation constraint exception message appears for each allocation bucket and item
when the destination organization is not allocated the full requested supply from the 
source organization or from the supplier. 

The exception issued for each item, destination organization, allocation bucket and 
source organization or supplier / supplier site.

The planning engine does not issue this exception message if the plan was run with 
high volume processing.

Allocation constraints can occur for one or more of the following reasons:

• Higher priority demands from other organizations acquired the supply available 
for an organization leaving a shortage for the organization's demands.

• Multiple demands from several organizations of the same priority led to the 
application of a Fair Share Allocation Rule, leaving a shortage for a demand.

• Rounding of demands from other organizations due to order modifiers led to 
additional allocations for other demands, leaving a shortage for a demand.

• An insufficient supplier capacity compelled multiple organizations to allocate 
supplies across competing demands.

Information Displayed
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• Action

• Exception

• Source Org

• Destination Org: Not populated if the allocation constraint is not for transferring 
demands.

• Customer

• Customer Site

• Supplier 

• Supplier Site 

• Item: Item Number of the item for which the exception is generated.

• Allocation bucket start date. 

• Allocation bucket end date. 

• Demand quantity: Total demand quantity from the destination organization for this
bucket. Note that demand quantity in a bucket can include carried over demands 
that were not satisfied in prior buckets.

• Allocated quantity: Total supply allocated to the destination organization for this 
bucket.

• Total Demand quantity: Total demand quantity in this bucket from all demand 
sources. Again, this can include carried over demand from prior buckets.

• Total Supply quantity: Total supply quantity from the source organization or the 
supplier in this bucket.

• % of Total Supply Allocated: Allocated quantity / total supply quantity * 100%.

• Fixed lot multiplier: The order modifier used for this item and destination 
organization. 

• Allocation Rule: Fair Share Allocation Rule Name.

• Allocation Rule Type: Fair Share Allocation Rule Type.

• Planner

• Product Family
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• Item Category

Resolution Suggestions

To resolve this exception, navigate to the horizontal plan or the allocation plan to 
review all allocations made in a bucket and determine if allocations, demands or 
supplies should be adjusted.

Also, check for more information used by the distribution plan to make the allocation 
decisions in the Allocation Bucket Details window. To navigate to Allocation Bucket 
Details window, right click on the Allocation Constraint exception message and select 
Allocation Bucket Details.

Allocation bucket details
Explanation

Allocation Bucket Details is not a true exception message, but an additional piece of 
information displayed about the allocation constraint exception. The allocation bucket 
details shows the information used by the distribution plan to make the allocation 
decisions.

You can also display the allocation bucket details information by right clicking within 
the horizontal plan or the allocation plan.

An allocation bucket results row is displayed for each demand priority, allocation 
bucket, source organization, destination organization, and Firm flag.

Note: The Firm flag indicates whether the demand is firm or is pegged 
directly to a firm supply in the destination organization. For example, if
an internal transfer from Org1 to Org2 is firmed, then the demand 
created in Org1 from the internal transfer is referred to as a firm 
demand.

During allocation, firm demands are given higher priorities over other demands. Firm 
demands from the earliest bucket are given the highest priority. If the item is a 
component, then a row appears for each of the parent items also. However, in such a 
case the destination organization is null. 

You can navigate to Supply Allocation Detail window by right clicking the Allocation 
Constraint exception message and selecting the Allocation Bucket Details option.

Information Displayed

• Action

• Exception

• Source Org

• Destination Org
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• Supplier

• Supplier Site

• Item

• Demand Priority: Inventory rebalancing demands display as priority 0. All other 
demands display their original demand priority.

• Firm Flag: Indicates that the demand is firm or is pegged to a firm supply in the 
destination organization.

• Firm Demand Carry Forward Buckets: The number of allocation buckets that the 
firm demand is carried forward. If the firm demand is in the current bucket, then 
the bucket quantity is 0.

• Allocation Bucket Start Date

• Allocation Bucket End Date

• Demand Quantity: Total demands for this priority and bucket for this destination 
organization.

• Fixed Lot Multiplier: The order modifier used for this item and destination 
organization.

• Actual Allocated Quantity: The actual quantity allocated to this destination org for 
this priority and allocation bucket.

• Total Available to Allocate Quantity: The total quantity available to allocate to all 
demands for this priority and allocation bucket.

• Total Supply: The total available supply in this bucket from this source 
organization.

• Allocated Percentage: This value is calculated by the following formula:

(Actual Allocated Quantity / Total Available to Allocate Quantity *100)

• Total Allocated Quantity to Higher Priorities: The supply quantity allocated to 
higher priority demands in this allocation bucket.

• Total Demands for All Higher Priorities: Total demands before rounding for all 
higher demand priorities in this bucket.

• Total Demands for this Priority: Total demands before rounding in this allocation 
bucket.
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• Planner

• Product Family

• Item Category

Item shipment consolidated to a later date
Explanation

An Item Shipment Consolidated to a Later Date exception message is generated when 
the supply quantity is available to ship on time but there is not a shipment available for 
the internal transfer. This can happen when supplies are pegged to target demands and 
when there is no less-than-truckload or parcel ship method. 

Information Displayed

• Action

• Exception

• Source Org

• Destination Org

• Item

• Need by date: The date when the demand is due in the destination organization.

• Available Date: The earliest date when the supply is available in the source 
organization.

• Suggested Due date: The actual date when the supply is available in the destination 
organization.

• Quantity: The allocation line quantity. Typically, this is the quantity that is required
to meet the target inventory level demand.

• Trip ID: The ID of the trip on which the allocation line is placed

• Planner

• Product Family

• Item Category

Resolution Suggestions

If the supplies are pegged to safety stock or other higher priority demands, the planning
engine consolidates the supplies to create an on-time shipment. However, in such a 
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case, the shipment quantity can be less than the minimum shipment utilization target.

You can also consolidate trips manually to resolve this exception. For more information 
on consolidating trips manually, see "Consolidating Trips" in Manage Distribution Plan 
Overview, page 16-1.

Sales order cancellation
Explanation

This exception message is generated for each sales order line that has some or all of the 
demand quantity canceled. Sales orders can be canceled if the profile option MSC: 
Cancel Outstanding Sales Order Quantities is set to Yes. 

Note that the system does not generate a Late replenishments for sales order exception 
for sales orders that are canceled.

Information Displayed

• Action

• Release

• Exception

• Org

• Customer

• Customer Site

• Requested Ship Date

• Due Date

• Latest Acceptable Date

• Order Number

• Ship Method

• Item

• Original Demand Quantity

• Expired Demand Quantity

• New Demand Quantity

• % of Demand Expired: This percentage is calculated by using the following 
formula:
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(Expired Demand/Original Demand) * 100

• Planner

• Product Family

• Item Category

Resolution Suggestions

Distribution planning engine provides this exception as an FYI to the planner. 
Resolution may not be required for this exception.

Order causes supplier capacity overload
Explanation

This exception is generated when a particular buy order causes the supplier capacity to 
be exceeded. This is detected and flagged at the time of scheduling the buy order.

When Enforce Supplier Capacity is not checked, buy orders are scheduled without 
regard to supplier capacity and this exception can occur relatively frequently. 

When Enforce Supplier Capacity is checked, firm buy orders may cause supplier 
capacity to be overloaded. These orders are not rescheduled but the exception condition
is detected and reported.

This exception is generated as a related exception to sales order/forecast at risk 
exception. 

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Order causes supplier capacity overload" in Supply 
Problems for Late Sales Orders and Forecasts Exception Group, page 17-24.

Order lead time constraint
This exception is generated when a demand gets satisfied later than the due date 
because of insufficient lead time.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Order lead time constraint" in Supply Problems for Late 
Sales Orders and Forecasts Exception Group, page 17-24.

Note: Despite the similarities, the following fields are described 
differently in this exception message for distribution plans:

• Required Start Time field is described as From Date: Required Start 
Time for make orders, the dock date for buy orders, and the ship 
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date for transfer orders.

• Required Completion Time field is described as To Date: Required 
Completion Time.

Order with insufficient lead time
This exception message is generated for any order that gets scheduled when there is 
insufficient time from the plan start date or the planning time fence for the item lead 
time.

This exception will be generated if Enforce Purchasing Lead Time is not checked.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Order with insufficient lead time" in Supply Problems 
for Late Sales Orders and Forecasts Exception Group, page 17-24.

Demand quantity is not satisfied
This exception is generated when demand satisfied dates are pushed to the end of the 
planning horizon for the supply quantity pegged to this demand is less than the 
demand quantity (at some point within the supply chain pegging tree).

This exception is generated for every demand for which the supply quantity is 
insufficient

This exception is generated as a related exception for Late Replenishments for Sales 
Order/Forecast.

Order violates a business calendar
This exception is generated for any order in which one of the dates on the order is in 
violation of a valid calendar that governs that date. As part of the exception details we 
will provide the name of the calendar that is being violated as well as the usage of that 
calendar with respect to the order, for example, Shipping and Receiving. Note that only 
a single exception will be generated for each order, even if that order violates multiple 
calendars. The calendar violation field in the exception details will indicate the specific 
calendars that have been violated.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Order violates a business calendar" in Supply Problems 
for Late Sales Orders and Forecasts Exception Group, page 17-24.

Note: For distribution plans, this exception message also displays the 
ID of the trip that the order is on.
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Material Capacity Exception Group
The following sections discuss the exceptions in this exception group and state their 
effects on distribution plans.

Supplier capacity overloaded
Explanation

This exception message appears when, in a planning time bucket, the supplier required 
capacity is more than the supplier available capacity.

These exceptions are typically issued when Enforce Supplier Capacity is not checked. 
Purchase orders are scheduled without regard to supplier capacity and overloads can 
occur.

The overload Percentage is calculated using the following formula:

(Required Quantity/Cumulative Available Quantity) * 100

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Supplier capacity overloaded" in Material and Resource 
Capacity Exception Group, page 17-45.

Important: A new field is added to this exception for distribution plans 
called Maximum Overload Percentage. This field displays the 
maximum overload percentage for the exception time period.

Organization capacity exceeded
Explanation

This exception message is generated whenever organization capacity, either weight or 
cube, is exceeded at the end of a day. The start and end dates indicate the time period 
during which either weight or cube organization capacity is overloaded. Generated 
once for every date range when the organization capacity is exceeded. The maximum 
overload quantity is calculated as the maximum amount of the overload during the date
range.

The planning engine allows organization capacity to be exceeded and reports the 
occurrences. Note that the planning engine does not recalculate the exception during 
on-line or batch replan. It is only calculated during a full plan launch. Also, shipments 
are not automatically rescheduled because organization capacity is exceeded.

Information Displayed

• Action

• Exception
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• organization

• Start Date

• End Date

• Weight Over Load %: This percentage is calculated by the following formula for the
date range between the start date and end date:

Maximum of (Actual Weight / Maximum Capacity Weight) * 100

• Cube Over Load %: This percentage is calculated by the following formula for the 
date range between the start date and end date:

Maximum of (Actual Cube / Maximum Capacity Cube) * 100

Resolution Suggestions

Consider the following steps to resolve an Organization capacity violation exception 
message:

1. Navigate to the Trips window and review the deliveries by date:

• Reschedule the Dock Dates for the trips in the plan at later dates.

• Reschedule the Ship Dates for the trips in the plan at earlier dates.

• Optionally firm the adjusted Trip.

2. Release the adjusted Trip.

Material shortage
Explanation

The exception is issued for each planning bucket when:

• The inventory calculated by [constrained supplies - unconstrained demands] at the 
end of the bucket is less than the target inventory level. The value [constrained 
supplies - unconstrained demands] is referred to as Unconstrained Projected 
Available Balance.

• If you did not define a target inventory for the organization, the system defines the 
safety stock level as the target inventory. Hence, the exception is issued when the 
Unconstrained Projected Available Balance goes below the safety stock level if the 
target inventory is not defined.

• Constrained supplies:The planned supplies output supply 
schedule, constrained by material availability, based on the 
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constraints you selected while defining the plan options, for 
example, supplier capacity or purchasing lead-time.

• Unconstrained demands: Demand calculated during an 
unconstrained planning step. This does not specify the final 
constrained demands in each bucket.

In other words, the exception is issued if there is a supply shortage in a daily or weekly 
planning bucket, and if the plan tried to meet all unconstrained or actual demands.

Important: The bucketing is either at the daily or weekly level since 
these are the only two options allowed for planning buckets. In the 
daily planning buckets, the material shortage is reported by the minute 
as distribution planning really plans in minute increments. For weekly 
buckets, distribution planning uses 00:00:00 on the first day of the week
bucket and 23:59:00 on the last day of the week.

The start of a material shortage occurs anytime the unconstrained 
projected available balance is less than the target inventory on the start 
date and the unconstrained projected available balance one minute 
prior is greater than the unconstrained projected available balance on 
the start date. That is, anytime the unconstrained projected available 
balance becomes worse a new material shortage is generated. In other 
words, for a single Material Shortage exception, the (unconstrained 
projected available balance - target inventory) on the start date is at its 
lowest value for the date range of the exception.

The end of the material shortage occurs in either of the following cases

• If you start a new material shortage

• The (unconstrained projected available balance - target inventory) 
becomes greater than zero

The quantity on the material shortage is the unconstrained projected 
available balance at the start of the material shortage.

Information Displayed

• Organization: The organization with the material shortage

• Item Planner

• Supplier: If the material is purchased, then this field displays the supplier name.

• Supplier Site
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• Target Qty: Displays the target inventory level on the start date of the exception 
(From Date). Note that this value cannot be used to compare the shortage amount if
the target stock levels have changed during the date range of the exception.

• Safety Stock Qty: Displays the Safety Stock Inventory level on the start date of the 
exception. Like target quantity, this value also cannot be used to compare the 
shortage amount if the safety stock levels have changed during the date range of 
the exception.

• Unconstrained PAB: Displays the inventory calculated by [constrained supplies - 
unconstrained demands] on the start date of the exception.

• From Date

• To Date

• Shortage: Displays the inventory calculated by [Target Inventory Level - 
Unconstrained PAB] on the start date of the exception.

• Actual Duration (Hours): Displays the hours elapsed between the start date and the 
end date. The system calculates the hours by [End Date - Start Date].

• Product Family

• Item Category

Resolution Suggestions

Check the following related exceptions to determine the underlying cause of the 
material shortage in the current bucket for a specific item-organization combination:

• Lead-time constraint: The related exception is Order Lead-time Constraint.

• Supplier capacity constraint: The related exception is another Material Shortage 
with a specific supplier name.

• Source organization constraint: The related exception is another Material Shortage 
for the same item with a different organization as the source organization. This 
indicates that the supply is constrained or short in the source organization. The 
system also issues an allocation constraint.

• Kit component constraint: The related exception is another Material shortage with a
different item, which is a component of the kitted item in the original material 
shortage. The user can now follow the related exceptions for the component to 
understand why it is in short supply.

• Allocation constraint: The related exception is an allocation constraint exception.
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• Load consolidation constraint: The related exception is an item trip consolidated to 
a later date.

To summarize, check for the following related exceptions to resolve a Material shortage 
exception:

• Material shortage for the

1. Same item in the source organization

2. Component item in the destination organization

3. Same item from a supplier

• Allocation constraint, Demand quantity not satisfied, and Order lead-time 
constraint for the

1. Same item in the source organization

2. Component item in the destination organization

• Item shipment consolidated to a later date

1. For same item in the source organization

Also consider:

• Adjusting the planned inbound shipment quantity 

• Updating supply allocation rule

• Firming the planned inbound shipments on a new date

• Modifying the sourcing rules: For example, change sourcing percentage

Transportation and Distribution Exception Group
The following sections discuss the exceptions in this exception group and state their 
effects on distribution plans.

Trip under utilized
Explanation

Generated when both weight and cube for a trip is below the minimum weight and 
cube allowed for the particular ship method.

Note: The minimum weight and cube are defined by the plan options 
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and ship method trip limits.

The planning engine generates an exception message for each trip with weight and cube
below the minimum level.

Information Displayed

• Action

• Exception

• Trip ID

• Ship Method

• Source Org

• Destination Org

• Plan Ship Date

• Plan Dock Date

• Weight Under Load %: Displays the percentage of weight by which the trip is 
under-loaded. Displays null if the trip is not under-loaded. The percentage is 
calculated by the following formula: 

(1 - Actual Weight/Minimum Weight) * 100

• Weight

• Min Weight Allowed

• Cube Under Load %: Displays the percentage of cube by which the trip is 
under-loaded. Displays null if the trip is not under-loaded. The percentage is 
calculated by the following formula:

(1 - Actual Cube/Minimum Cube) * 100

• Cube

• Min Cube Allowed

• Pieces

Resolution Suggestions

To resolve this exception, consider the following steps:

1. Right click on the exception message in the Exception Details window, and select 
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Trips.

2. In the Trips window review the trip and internal requisitions.

3. Adjust the Trip so that it respects the minimum weight and/or cube:

1. Add unassigned internal requisitions to the trip.

2. Release the updated trip.

Note: Optionally, accept the under utilization and firm and release the 
trip.

Trip over utilized
Explanation

Generated when either weight or cube for a trip is above either the maximum weight or 
cube allowed for the particular ship method.

Note: The maximum weight and cube are defined by the plan options 
and ship method trip limits.

The planning engine generates an exception message for each trip with weight and cube
above the maximum level. Currently, over utilization of a trip can happen only in the 
case of firm internal sales orders with quantities that are above the trip maximum.

Information Displayed

• Action

• Exception

• Trip ID

• Ship Method

• Source Org

• Destination Org

• Plan Ship Date

• Plan Dock Date

• Weight Over Load %: Displays the percentage of weight by which the trip is 
overloaded. Displays null if the trip is not overloaded. The percentage is calculated 
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by the following formula: 

(1 - Actual Weight/Maximum Weight) * 100

• Weight

• Max Weight Allowed

• Cube Over Load %: Displays the percentage of cube by which the trip is 
overloaded. Displays null if the trip is not overloaded. The percentage is calculated 
by the following formula: 

(1 - Actual Cube/Maximum Cube) * 100

• Cube

• Max Cube Allowed

• Pieces

Resolution Suggestions

To resolve this exception, consider the following steps:

1. Right click on the exception message in the Exception Details window, and select 
Trips.

2. In the Trips window review the trip and internal requisitions.

3. Adjust the Trip so that it respects the maximum weight and/or cube:

1. Remove internal requisitions or reduce the quantity of internal requisitions on 
the trip 

2. Release the updated trip.

Note: Optionally, accept the over utilization and firm and release the 
trip.

Item Shortage and Excess Exception Group
The following sections discuss the exceptions in this exception group and state their 
effects on distribution plans.

Item with a projected stockout
Explanation

Distribution planning shares the Items with a shortage exception message with ASCP. 
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However, to distinguish this exception from a Material Shortage, Distribution Planning 
recognizes this exception message as Item with a Projected Stockout.

This exception message appears when projected available balance for a planning bucket
is negative and is within the exception set Shortage Exceptions exception time period. 
Projected available balance is Previous bucket projected available balance + Sum of 
supply quantities with due date in this planning time bucket - Sum of demand 
quantities with due date in this planning time bucket.

The demands are most likely independent (because the planning engine pushes out 
dependent demand due dates). Due to lead time, intransit time, calendar, planning time
fence, or supplier capacity constraints, the supply due dates are later than the end 
demand due date.

The characteristics of this exception message are same as those of supply chain plans, as
Distribution Planning shares this exception message with ASCP. For more information 
on this exception message, see "Items with a shortage" in Shortages and Excess 
Exception Group, page 17-72.

Items below safety stock
Explanation

This exception message appears when projected available balance for a planning bucket
is below the specified safety stock level for the planning bucket (but not below zero). 
Projected available balance is Previous bucket projected available balance + Sum of 
supply quantities with due date in this planning time bucket - Sum of demand 
quantities with due date in this planning time bucket.

The exception is not issued when the projected available balance is negative and the 
more severe exception Item with a Projected Stockout Exception is issued.

The planning engine does not consult the exception set for the item.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Items below safety stock" in Shortages and Excess 
Exception Group, page 17-72.

The following new fields are added to this exception for distribution plans:

• Duration (Days): Displays the difference between the start date and the end date of 
the planning time bucket by [End Date - Start Date].

• Maximum Qty: Displays the maximum quantity below safety stock.

Items with excess inventory
The planning engine generates this message when projected available balance for a 
bucket is greater than the exception set Excess Quantity value for the item and within 
the exception set Excess Exceptions exception time period. Projected available balance is
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calculated by the following formula:

[Previous bucket projected available balance + Sum of supply quantities with due date in this 
planning time bucket - Sum of demand quantities with due date in this planning time bucket]

Note that items with excess inventory are not generated for items with items above 
target exceptions or maximum inventory level exceptions.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Items with excess inventory" in Shortages and Excess 
Exception Group, page 17-72.

Important: The following new fields are added to this exception for 
distribution plans: 

• Maximum Quantity: Displays the maximum excess quantity for the
exception time period.

• Maximum Cost: Displays the cost of the total quantity by [ 
Quantity * Item Cost]

Items below target inventory level
Explanation

This exception message appears when projected available balance for a planning bucket
is below the specified target inventory level for the planning bucket. Projected available 
balance is calculated by the following formula:

[Previous bucket projected available balance + Sum of supply quantities with due date in this 
planning time bucket - Sum of demand quantities with due date in this planning time bucket]

The planning engine does not consult the exception set for the item.

Note: The following exception messages are issued whenever the target
quantity for an item changes and quantity is below target. However, 
the planning engine does not generate a new exception when this 
quantity (i.e. the quantity below target) is updated.

• Supplier capacity overloaded

• Items with a projected stockout

• Items with excess inventory

• Items below safety stock 

• Items below target inventory level
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• Items above target inventory level

• Items above maximum inventory level

• Material shortage

Note that all these exception messages have both From Date and To 
Date fields. The fields carry time stamps and the exceptions are issued 
from the date/time stamp that the exception is triggered and ends at the
date/time stamp that the exception condition is resolved.

Information Displayed

• Action

• Exception

• Org

• Item

• Start Date: The start date for the first planning time bucket

• End Date: The start date for the last planning time bucket

• Duration (Days): Displays the days elapsed between the start date and the end date,
and is calculated by [End Date - Start Date].

• Actual Duration (Hours): Displays the hours elapsed between the start date and the 
end date, and is calculated by [End Date - Start Date].

• Maximum Qty: Displays the maximum quantity for the time period, and is 
calculated by the Maximum of [Target Inventory Level - Projected Available 
Balance].

• Target Qty: Target Inventory Level on the start date.

• Planner

• Product Family

• Item Category

Resolution Suggestions

Consider the following to resolve this exception:

• Expediting supply orders
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• Transferring some inventory from another organization to the organization for 
which the exception is generated

Items above target inventory level
Explanation

The planning engine generates this message when projected available balance for a 
planning bucket is greater than the target inventory level for the item. Projected 
available balance is calculated by the following formula:

[Previous bucket projected available balance + Sum of supply quantities with due date in this 
planning time bucket - Sum of demand quantities with due date in this planning time bucket]

Note that items above target are not generated for items with inventory levels above 
maximum.

Note: An exception message is issued whenever the target quantity 
changes and quantity is above target. However, a new exception is not 
issued when the quantity above target changes.

Information Displayed

• Action

• Exception

• Org

• Item

• Start Date: The start date for the first planning time bucket

• End Date: The end date for the last planning time bucket

• Duration (Days): Displays the days elapsed between the start date and the end date,
and is calculated by [End Date - Start Date].

• Actual Duration (Hours): Displays the hours elapsed between the start date and the 
end date, and is calculated by [End Date - Start Date].

• Maximum Qty: Displays the maximum quantity for the time period, and is 
calculated by the Maximum of [Projected Available Balance - Target Inventory 
Level].

• Target Qty: Target Inventory Level on the start date.

• Safety Stock Qty: Safety stock inventory level on the start date.
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• Planner

• Product Family

• Item Category

Resolution Suggestions

Consider the following to resolve this exception:

• Cancelling unnecessary supply orders

• Transferring the excess inventory to another organization

Items above maximum inventory level
The planning engine generates this message when projected available balance for a 
bucket is greater than the maximum inventory level for the item. Projected available 
balance is calculated by the following formula:

[Previous bucket projected available balance + Sum of supply quantities with due date in this 
planning time bucket - Sum of demand quantities with due date in this planning time bucket]

Information Displayed

• Action

• Exception

• Org

• Item

• Start Date: The start date for the first planning time bucket

• End Date: The end date for the last planning time bucket

• Duration (Days): Displays the days elapsed between the start date and the end date,
and is calculated by [End Date - Start Date].

• Actual Duration (Hours): Displays the hours elapsed between the start date and the 
end date, and is calculated by [End Date - Start Date].

• Maximum Qty: Displays the maximum quantity for the time period, and is 
calculated by the Maximum of [Projected Available Balance - Maximum Inventory 
Level]

• Maximum Inventory Level: Maximum Inventory Level on the start date

• Planner
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• Product Family

• Item Category

Resolution Suggestions

Consider the following to resolve this exception:

• Cancelling unnecessary supply orders

• Transferring the excess inventory to another organization

Reschedule Exception Group
The following sections discuss the exceptions in this exception group and state their 
effects on distribution plans.

Changes recommended for sales orders
Explanation

The exception is generated when ASCP recommends changes to the existing sales order 
line details. The exception will be generated each time there is a change in the following
sales order line entities in ASCP.

This exception helps integrating the planning and Order management data flow 
whenever ASCP recommends changes to the existing orders.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Changes recommended for sales orders" in Reschedules 
Exception Group, page 17-77.

Orders to be rescheduled out
Explanation

This exception message appears when the planning engine suggests that you 
reschedule an existing supply order (scheduled receipt) to a later date to avoid carrying 
excess inventory. It occurs when the planning engine detects a non-firm existing supply
order with a due date that is earlier than it suggests (suggested due date).

The planning engine does not issue this recommendation for firm existing supply 
orders.

The planning engine continues to plan lower bill of material levels as if you accept the 
suggestion.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Orders to be rescheduled out" in Reschedules Exception
Group, page 17-77
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Important: A new field is added to this exception for distribution plans 
called Demand Order Number. This field displays the order number of 
the internal sales order.

Orders to be rescheduled in
Explanation

This exception message appears when the planning engine suggests that you 
reschedule an existing supply order to an earlier date. It occurs when the planning 
engine detects a non-firm existing supply order with a due date that is later than it 
suggests (suggested order date). 

The planning engine continues to plan lower bill of material levels as if you accept the 
suggestion.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Orders to be rescheduled in" in Reschedules Exception 
Group, page 17-77.

Important: A new field is added to this exception for distribution plans 
called Demand Order Number. This field displays the order number of 
the internal sales order.

Orders to be cancelled
Explanation

This exception message appears when the planning engine suggests that you cancel an 
existing supply order.

It occurs when the planning engine detects a non-firm existing supply order that you do
not need to satisfy demand or safety stock requirements.

The planning engine continues to plan lower bill of material levels as if you accept the 
suggestion.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Orders to be cancelled" in Reschedules Exception 
Group, page 17-77.

Important: A new field is added to this exception for distribution plans 
called Demand Order Number. This field displays the order number of 
the internal sales order.
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Past due orders
Explanation

This exception message appears when the planning engine detects supply orders and 
planned orders that have order (start) dates and due dates in the past (before the 
planning horizon start date).

For non-firmed supply orders, the planning engine also issues Orders to be rescheduled
out exception message.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Past due orders" in Reschedules Exception Group, page 
17-77

Order is firmed late
Explanation

This exception is generated when the planning engine encounters a firm order because 
of which planning is unable to schedule succeeding orders in time to meet the demand 
due date. This exception is generated when the order is firmed.

There will be one exception for every Firm Supply that is encountered that causes 
demand lateness

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Order is firmed late" in Reschedules Exception Group, 
page 17-77.

Order is firmed early
Explanation

This exception is generated when the planning engine encounters a firm order because 
of which planning is unable to schedule preceding orders without causing lead time 
compressions on the upstream preceding orders.

There will be one exception for every Firm Supply that is encountered that causes 
upstream order lead time compression.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Order is firmed early" in Reschedules Exception Group, 
page 17-77.

Sales Order Line Allocation Split
Explanation
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This exception message is generated for each sales order line that is split during the 
order line allocation process. The planning engine generates this exception message 
only once for the original sales order line number. Sales order lines are only split if the 
appropriate plan option is checked.

Note:  The planning engine also generates Late Replenishment for Sales
Order exception message for the new sales order lines that are satisfied 
late.

Information Displayed

• Action

• Exception

• Org

• Item

• Sales Order Number

• Suggested Due Date: The original suggested due date of the sales order line

• Original Qty: The original sales order line quantity

• Qty on Time: The quantity that is delivered on time

• Late Qty: The quantity of the late split sales order line. Displays the total of all lines 
that are late if there is more than one split from the original line.

• Late Suggested Due Date: The date of the late split sales order line. Displays the 
latest date if more than one line is split from the original line.

• % Quantity Satisfied on Time: Displays the percentage of quantity delivered on 
time by the following formula: 

[Qty on Time / Original Qty] * 100

• Planner

• Product Family

• Item Category

Note: Distribution planning engine provides this exception as an FYI to 
the planner. Resolution may not be required for this exception.
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Order quantity change
Explanation

Generated whenever the purchase order, internal sales order, or internal requisition 
quantity is reduced but is still greater than zero. If the order quantity is reduced to 0, 
that is considered a cancellation and a different reschedule recommendation is issued.

Information Displayed

• Action

• Release

• Exception

• Trip ID

• Source Org

• Destination Org

• Ship Date

• Due Date

• Demand Order Number: Internal Sales Order Number

• Order Number: Internal Requisition Number

• Ship Method

• Item

• Old Quantity

• New Quantity

• Planner

• Product Family

• Item Category

Resolution Suggestions

Consider increasing the quantity of the purchase order, internal sales order, or the 
internal requisition.
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Note: Distribution planning engine provides this exception as an FYI to 
the planner. Resolution may not be required for this exception.

Substitutes and Alternates Exception Group
The following sections discuss the exceptions in this exception group and state their 
effects on distribution plans.

Planned order uses alternate BOM
Explanation

The exception message Planned order uses alternate BOM/routing in ASCP is renamed 
as Planned order uses alternate BOM in Distribution Planning.

This exception message appears when the planning engine:

• Under the direction of a decision rule, assigns an alternate bill of material and 
routing to a planned order

• Detects a firm a planned order with an alternate bill of material and routing

As Distribution Planning shares this exception message with ASCP, the characteristics 
of this exception message are same as those of supply chain plans. For more 
information on this exception message, see "Planned order uses alternate BOM/routing"
in Substitutes and Alternates Used Exception Group, page 17-97.

Planned order uses substitute components
Explanation

This exception message appears when the planning engine:

• Under the direction of a decision rule, assigns a substitute component to a planned 
order.

• Detects a firm a planned order with a substitute component.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Planned order uses substitute components" in 
Substitutes and Alternates Used Exception Group, page 17-97.

Order sourced from alternate facility
Explanation

This exception message appears when the planning engine:
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• Under the direction of a decision rule, assigns a planned order to an alternate 
facility

• Detects a firm planned order with an alternate facility assigned

An alternate facility is an organization in the supply chain and is not a supplier site.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Order sourced from alternate facility" in Substitutes and
Alternates Used Exception Group, page 17-97.

Order sourced from alternate supplier
Explanation

This exception message appears when the planning engine:

• In a plan with decision rules enabled, under the direction of a decision rule, assigns 
a planned order to an alternate supplier (supplier with rank other than 1) 

• In any distribution plan, detects a firm planned order with an alternate supplier 
assigned

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Order sourced from alternate supplier" in Substitutes 
and Alternates Used Exception Group, page 17-97.

Demand satisfied using end item substitution
Explanation

This exception message appears when the planning engine plans to satisfy an end item 
demand using a supply order with a substitute item. The planning engine substitutes 
items when both of these are true:

• The plan is under the direction of substitution rules

• The plan option Decision Rules, End Item Substitution is selected

If the planning engine satisfies a demand with multiple planned orders, it issues an 
exception for each supply order with the substitute item.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Demand satisfied using end item substitution" in 
Substitutes and Alternates Used Exception Group, page 17-97.
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Alternate ship method used / ship method changed
Explanation

This exception is generated when the Distribution Planning engine selects an alternate 
ship method for a planned order or changes the ship method on an existing sales order, 
external purchase order, or planned order. The distribution plan can change the ship 
method on a sales order even if the decision rules are not enabled (MPP/MPS/MRP 
plans require decision rules enabled for this feature). The planning engine evaluates 
alternate ship methods for internal transfers and uses similar logic to evaluate ship 
methods for sales orders.

This exception is not used for internal sales orders, internal requisitions, or planned 
orders for internal shipments or internal arrivals.

For released orders, you will get an exception when the originally suggested ship 
method changes to a new ship method. For planned orders you will get an exception if 
system chooses an alternate ship method

Information Displayed

• Action

• Exception

• Trip ID

• Original Ship Method

• New Ship Method

• Source Org

• Destination Org

• Due Date

• Old Intransit Time

• New Intransit Time

• Source Type: Internal Requisition

• Order: Internal Requisition Number

• Item

• Quantity

• Planner
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• Product Family

• Item Category

Note: Distribution planning engine provides this exception as an FYI to 
the planner. Resolution may not be required for this exception.

Internal transfer uses alternate ship method / ship method changed
Explanation

This exception is generated for every occurrence of the use of an alternate ship method 
or a change in ship method for internal sales orders / internal requisitions and planned 
shipments / planned arrivals. Note that decision rules do not have to be enabled for the 
distribution plan to select alternate ship methods for internal transfers.

Users can specify sourcing rules with multiple ship methods at Rank 2 and below for 
internal transfers. Distribution plans can select lower rank ship methods for 
organizations specified as Rank 1 sources. Users do not need to enable decision rules for
this feature. However, if a new source is Rank 2, distribution plans will not select the 
new source unless decision rules are enabled and alternate sources are selected.

As multiple ship methods can be listed in the sourcing rule for any rank, this exception 
is not generated unless the ship method selected is a lower rank than the source is 
originally listed.

Information Displayed

• Action

• Exception

• Trip ID

• Original Ship Method

• New Ship Method

• Source Org

• Destination Org

• Due Date

• Old Intransit Time

• New Intransit Time

• Source Type: The source type is displayed as Internal Requisition
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• Order: Internal Requisition Number

• Item

• Quantity

• Planner

• Product Family Item Category

Planned order uses inventory rebalance source
Explanation

This exception is generated if the planning engine selects a supply source that is defined
as a inventory rebalance source of supply. Users can specify inventory rebalance 
sources on the sourcing rules and the planning engine can use them under certain 
conditions.

This exception is generated only for each of the internal requisitions sourced from an 
inventory rebalance source. The name of the inventory rebalancing rule is also 
displayed in the exception message.

Note: Inventory rebalance sources are used to transfer inventory to use 
up the surplus at another organization before sourcing through the 
usual channels.

Information Displayed

• Action

• Exception

• Trip ID

• Ship Method

• Sourcing Rule

• Source Org

• Destination Org

• Due Date

• Source Type: Internal requisition

• Order: Internal requisition number
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• Item

• Quantity

• Planner

• Product Family

• Item Category

Note: Distribution planning engine provides this exception as an FYI to 
the planner. Resolution may not be required for this exception.

Item Exceptions Exception Group
The following sections discuss the exceptions in this exception group and state their 
effects on distribution plans.

Items with negative starting on hand
Explanation

This exception message appears when the planning engine detects an item with 
negative beginning on-hand balance.

It usually occurs because of an incorrect inventory balance.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Items with negative starting on hand" in Item 
Exceptions Exception Group, page 17-106.

Items with expired lot
Explanation

This exception appears when the planning engine detects a potential expired lot. A 
potential expired lot is a lot that:

• Has lot expiration date during the planning horizon

• Is not pegged to a demand that results in its use before its lot expiration date

It occurs against items under lot control of Full Control. The calculation for lot 
expiration date is Lot Receipt Date + Shelf Life Days.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Items with expired lot" inItem Exceptions Exception 
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Group, page 17-106.

Sourcing split percentage violated
Explanation

This exception message appears for days when the sourcing split percentages among 
rank 1 suppliers is violated. The planning engine issues the exception against suppliers 
whose sourcing percentage is not satisfied.

The actual sourcing percentage for a supplier is calculated as (Cumulative quantity 
sourced from supplier/Cumulative quantity sourced from rank 1 suppliers) * 100

The distribution planning can only violate the sourcing split when decision rules are 
enabled and alternate sources are selected.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Sourcing split percentage violated" in Item Exceptions 
Exception Group, page 17-106.

Items with no activity
Explanation

This exception appears when the planning engine detects an item in an organization 
with no demand and no supply throughout the planning horizon. It usually occurs for:

• Substitute components

• Components on alternate bills of material

• End item substitutes

Typically, these items do not have other sources of demand and the planning engine 
does not need to use them during the planning horizon.

If the item has no activity in multiple organizations, the planning engine issues this 
exception message for each organization.

Distribution Planning shares this exception message with ASCP. The characteristics of 
this exception message are same as those of supply chain plans. For more information 
on this exception message, see "Sourcing split percentage violated" in Item Exceptions 
Exception Group, page 17-106.

Recommendations Exception Group
The following sections discuss the exceptions in this exception group and state their 
effects on distribution plans.

Distribution Planning shares the following exception message with ASCP. The 
characteristics of these exception messages are same as those of supply chain plans: For 
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more information on this exception message, see Recommendations Exception Group, 
page 17-115.

• Discrete jobs recommendations

• Purchase requisitions recommendations

Trip recommendations
Explanation

For Trip recommendations exception message, the planning engine generates a 
summary level exception for new planned trips generated by the distribution plan with 
the complete internal requisitions information for all internal requisitions attached to 
the trip.

Defining Organization Selection Lists
When you right-click in the Planners Workbench, a Horizontal Plan menu appears and 
preference set names are no longer displayed. The preference set selections for the 
Horizontal Plan are only available from a right clicking within the Horizontal Plan 
itself. 

This table describes the right-click options:

Option Description

This Org The Horizontal Plan is displayed for the 
organization based on the organization-item 
context of the right-click.

Ship From / To Orgs The Horizontal Plan is displayed for several 
organizations based on the organization-item 
context of the right-click. 

Suppose the right-click is made from the 
context of Organization X Item A. The 
sourcing rules are checked, and for 
Organization Z Item A, every source 
organization and every destination 
organization is displayed. Organization Z is 
also displayed, as are inventory rebalance 
organizations.
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Option Description

All Orgs The Horizontal Plan is displayed for all 
organizations, based on the item context of the
right-click. 

Each individual organization is also displayed
if you select Display Each Org in All Orgs 
View on the plan preferences setting for 
material plan. 

Otherwise, only the Summary section is 
displayed. After the All Orgs Horizontal Plan 
is displayed, you can right-click to toggle 
between showing only All Orgs and Display 
Each Org.

All Orgs (internal shipments not included) The Horizontal Plan is displayed for all 
organizations, based on the item context of the
right-click. Each individual organization is 
also displayed if you select Display Each Org 
in All Orgs View on the plan preferences 
setting for material plan. 

Otherwise, only the Summary section is 
displayed. After the All Orgs Horizontal Plan 
is displayed, you can right-click to toggle 
between showing only All Orgs and Display 
Each Org.

OrgList1, OrgList2, OrgList3 OrgList1, OrgList2, OrgList3 refers to 
user-defined names for various organization 
selection lists, as defined on the Org Selection 
List form. 

When selected, the Horizontal Plan opens 
with each organization displayed in the 
sequence defined from the list. The Summary 
section at the top of the Horizontal Plan.

At the top of the Horizontal Plan, the Summary displays totals for all organizations 
shown in the Horizontal Plan, if there is more than one organization displayed in the 
Horizontal Plan. The summary section is the totals for all organizations displayed.
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16
Managing Distribution Plans

This chapter covers the following topics:

• Manage Distribution Plan Overview

• Fair Share Allocation

• Setting Up Customer Lists

Manage Distribution Plan Overview
Adjusting Allocations

The Distribution Plan Workbench provides several methods of analyzing and updating 
supply allocations from one distribution center to another or from a distribution center 
to end demands (sales orders and forecasts). The user can access either the allocation 
plan or the horizontal plan for information about how distribution planning has 
allocated scarce supplies. Users can adjust and firm internal transfers and allocate to 
sales orders and forecasts.

Users can adjust allocations by: 

• Updating the allocation plan: Adjust allocations from source to destination 
organizations 

• Analyzing the multiple organization display horizontal plan and then firming 
transfer dates and quantities in the supply demand window

• Firm and update quantities on internal sales orders and requisitions and also firm 
planned inbound and outbound shipments

• Firming actual and planned purchase orders and planned purchase requisitions 

• Adjust allocations of supplier capacity to destination organizations by updating and
firming planned orders
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• Manually allocating to sales orders and forecasts by organization

Adjust Allocations to Distribution Centers

The context of the allocation plan is derived from where the user accesses it. A 
right-click from the: 

• Horizontal Plan opens it for the same organization-item of the Horizontal Plan. 

• Items window opens it for the same source organization-item as the items row. 

• Supply and Demand Window opens it for the same source organization-item as the 
demand or supply row. 

The user has three choices for the horizontal dimension, Customer, Customer Site, and 
Demand Class. The user can change the horizontal dimension by right clicking the 
allocation plan. 

The date range across the top of the form are the first day of each allocation bucket. If 
the allocation bucket is weekly, then the date is the first day of the week. Distribution 
planning does not summarize to any other weekly or period levels; some allocation 
buckets, for example two weeks, may not aggregate correctly to the period level. 

It shows unconstrained demands by bucket, whether they are sales orders, forecasts, 
transfer demand, or kit demand. This is the original demand quantity, not the net 
demand quantity after any expiration or kill of sales orders. Sales orders reflect the 
demand date based on the plan options; this is the suggested due date and not any 
distribution planning rescheduled dates. 

Allocation plan (new for distribution planning):

• Is accessed for an item-organization from the Supply and Demand window, the 
Horizontal Plan, the Workbench Navigator tree, and the Plan Summary 

• Displays allocations from the source organization to destination organizations, 
customers and customer sites, and demand classes 

• Displays by allocation bucket 

• Displays specific customers using the customer list

• Enables double clicks to Supply/Demand window 

• Enables right click to Horizontal Plan

Reviewing Allocations to Customers

Unconstrained Demand: Total unconstrained demands with suggested due date in the 
bucket for the destination organization, customer, customer site, or demand class. 

Expired Demand: Total amount of expired demand with a suggested due date in the 
bucket (sales orders and forecasts). 
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Target and safety stock: Target and safety stock inventory levels for the organization at 
the end of the allocation bucket. 

Supply: The total available supply for this bucket from this source organization (not 
shown in the All Orgs view) 

Firm Allocations: For a destination organization, this includes any firm transfers from 
the source organization, either planned or actual. 

Suggested Allocated Qty: Of the supplies in this bucket, the quantity allocated to this 
destination organization, customer, customer site, or demand class. The allocations are 
from supply in the bucket and can be allocated to demands that have suggested due 
dates in any bucket. 

Manual Allocation Qty: User editable field when the context is a destination 
organization.

Effective Allocation Qty: The allocation total of this bucket which is the manual 
allocation quantity; if it is null, it is the greater of the firm allocations or the suggested 
allocation quantity.

Cum Unconstrained Demand: Total unconstrained demand cumulative-to-date for this 
destination organization, customer, customer site, or demand class. 

Cum Expired Demand: Total unconstrained expired demand cumulative-to-date for 
this destination organization, customer, customer site, or demand class. 

Cum Supply: Total available supply for this and all prior buckets from this source 
organization. 

Cum Suggested Allocated Qty: Suggested allocated quantity cumulative-to-date for this
destination organization, customer, customer site, or demand class. 

Cum Fill Rate: 100% * Cum unconstrained demand / Cum suggested allocated quantity.
This can be greater than 0 when quantity is allocated to target or safety stock, as target 
and safety stock are not included in the cumulative unconstrained demands. 

Manual Allocation

The user can enter a manual allocation quantity from the source organization to a 
destination organization. The user enters the quantity in Allocation Plan > Manual 
Allocation Quantity. When the form is saved, a new firm planned inbound and 
outbound shipment (planned order) is created as follows : 

• It is from the source organization to the destination organization 

• It uses the rank 1 ship method from the sourcing rule. If there is more than one rank
1 ship method, then the highest percentage ship method is used. If the top percents 
are a tie, then the fastest ship method is used.

• Ship date is set to the beginning of the allocation bucket (respecting shipping and 
in-transit calendars)
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• Dock date is set based on the ship method, in-transit calendar, and receiving 
calendar. 

• The quantity of the new planned order is the difference between the firm allocations
and the manual allocation quantity. 

• The updated display after saving shows firm allocations including the newly 
created firm planned order. The field Manual Allocation Qty is cleared since the 
allocation is made.

• A message is given in the message bar saying that " <number> new firm planned 
orders are created". 

• Entries are not allowed that reduce firm allocations. If the user needs to reduce firm 
allocations, then the user can open the supply window and cancel firm actual or 
planned shipments. 

The Manual Allocation Quantity in the Allocation Plan works as follows:

• It is a user-editable field

• The Allocation Plan Reset button clears the form 

• The Allocation Plan Recalculate button updates effective allocation quantity and 
displays warnings when allocation exceeds supply

• Saving manual allocation quantity entries creates firm planned orders as follows: 

• From the source to destination organization 

• Uses Rank 1 ship method from the sourcing rule by default 

• Ship date is the beginning of the allocation bucket

• Dock date is calculated based on ship method and calendars

Horizontal Plan

In addition to the Allocation Plan, the horizontal plan can be used to analyze allocations
across the distribution network. The user can drill down to individual supply records to
make adjustments to the planned allocations

Use the enhanced horizontal plan to review material flows across the enterprise. It 
displays multiple organizations and their specific inbound and outbound transfers. 

Right-click to allocation details to review distribution planning allocation decisions

Double-click to supply demand window to analyze and update individual supply 
demand records Review pegging data 

After making adjustments, use replan to calculate the downstream impacts
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New for distribution planning, the horizontal plan organization selection options are 
presented whenever the user calls for the horizontal plan. The user selects the initial 
organizations to display and can change the selection from within the horizontal plan. 

If the user defined organization lists in the setup, then the organization list names are 
also shown as choices in the organization selection list. 

Organization display includes: 

• Single organization 

• Ship from and to organizations 

• All organizations 

• Display for organizations in an organization list 

Fields available for display in the horizontal plan include: 

• External Demand: Includes sales orders and forecasts

• Sales Order 

• Forecast 

• Kit Demand: Kit demand is the constrained dependent demand for a component of 
a kit. For example, item A is used to make item X. The kit demand is the demand 
for Item A resulting from planned orders and discrete jobs to make item X.

• Outbound Shipments: Includes internal sales order and planned outbound 
shipments. The planner can drill down into the supply and demand window for a 
bucket on this row and view the internal sales orders and planned outbound 
shipments. 

• Other Demand: Includes hard reservations (against sales orders), inter-organization
demand from other distribution plans as demand schedules, copied schedule 
demand, demand class consumption, expired lots, scrap demand, and non-standard
demand.

• Total Demand: Includes external demand, planned outbound shipments, other 
demand, and kit demand. Kit demand consists of kit planned order demand, 
non-standard job demand, and discrete job demand.

• Requested Outbound Shipments: Includes unconstrained transfer demand which is 
the requested outbound shipments. 

• Unconstrained Kit Demand: Includes unconstrained kit planned order demand and 
discrete job demand. 
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• Unconstrained Other Demand: Includes hard reservations, distribution planning 
inter-organization demand, copied schedule demand, demand class consumption, 
expired lots, scrap demand, and non-standard demand. 

• Unconstrained Total Demand: Includes unconstrained kit demand, unconstrained 
other demand, external demand, and requested outbound shipments.

• Internal Supply: Includes beginning on-hand, work in process, material in 
receiving, and planned orders. 

• Beginning On Hand

• In Receiving: Total in receiving

• WIP

• External Supply: Includes in-transits, purchase orders, requisitions, and planned 
orders 

• Requested Inbound Shipments: The unconstrained transfer supplies. It is derived 
by the user interface as Requested outbound shipment suggested due date at source
organization + In transit lead time for the default ship method. It recalculates other 
dates by using the calendars. It is not the direct output from the planning engine. 
The requested inbound shipments may violate order size. 

• Inbound Shipments: Transfer supply. It includes in-transits, purchase requisitions, 
and planned inbound shipments. The planner can drill down into the supply 
demand window for a bucket on this row and view the supplies. 

• In Transit

• Purchase Order

• Requisition 

• All Planned Orders: Includes planned make orders, planned purchase orders, and 
planned inbound shipments. 

• Total Supply: Includes work in process, purchase orders, purchase requisitions, 
in-transits, in receiving, and planned orders.

• Current Scheduled Receipts: Includes work in process, purchase orders, purchase 
requisitions, in-transits, and in receiving.

• Projected On Hand: Same as Projected Available Balance except does not include 
any planned orders. 

• Projected Available Balance: Includes beginning on-hand, total supply, and total 
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demand. 

• Unconstrained Projected Available Balance: Includes beginning on-hand, total 
supply, and unconstrained total demand. 

• Maximum Quantity

• Target Quantity

• Safety Stock Quantity

• Inbound In Transit 

• Outbound In Transit

• Net ATP

• Expired Lots

Display Horizontal Plan Allocation Details

There is a supply allocation detail row for each demand priority, allocation bucket, 
source organization, destination organization, and firm flag. If the item is a component, 
then there is also a row for each parent item but the destination organization is null. To 
see the details for an allocation bucket, right-click a demand or a supply row and select 
Allocation Details.

The fields shown include: 

• Demand Priority: Inventory rebalancing demands display as priority 0. All other 
demands display their original demand priority. 

• Firm Flag: Indicates that the demand is firm or is pegged to a firm supply in the 
destination organization. 

• Firm Demand Carry Forward Buckets: The number of allocation buckets to which 
the firm demand is carried forward. If the firm demand is in the current bucket, 
then the bucket quantity is zero.

The allocation detail rows

• Display demands by priority and how supplies are allocated to each demand type 
and priority 

• Show demands carried forward from previous allocation buckets

• Show time period by allocation bucket

Order Types

The new order types for the supply and demand window are: 



16-8    Oracle Advanced Supply Chain Planning Implementation and User's Guide

• Requested Inbound and Outbound Shipments: Unconstrained demand for internal 
transfers from one organization to another organization. Outbounds are shown for 
the source organization and inbounds for the destination organization.

• Planned Inbound and Outbound Shipments: The constrained demand and supply 
order types for planned internal transfers.

• If there are internal sales orders and internal requisitions, they are the constrained 
demand and supply order types for existing internal transfers.

The user will find the following rows in the supply and demand window for 
planned transfers: 

• Planned Inbound Shipment

• Requested Inbound Shipment

• Planned Outbound Shipment 

• Requested Outbound Shipment 

The user will find the following rows in the supply and demand window for 
internal requisitions and internal sales orders: 

• Internal Requisition

• Requested Inbound Shipment 

• Internal Sales Order

• Requested Outbound Shipment 

• Requested inbound shipments and requested outbound shipments show the 
same order number because they are the same material movement as seen from 
either the source or the destination organization. 

• Suggested Due Date: The requested inbound shipment due date is the same date 
and time as the actual demand it is associated with. For example, if a forecast is due 
on Day 3 at 00:00:00, then there will be a requested inbound shipment with a 
suggested due date Day 3 at 00:00:00 

• Planning Time Fence: The requested inbound shipment suggested due date respects
the planning time fence and, if there is not sufficient lead-time, then the suggested 
due date is set to the planning time fence. In the case of the requested inbound 
shipments, the planning time fence is applied to the due date and not to the order 
start date or ship date.

• Suggested Dock Date: The suggested dock date is offset from the suggested due 
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date by the post-processing lead-time. If the suggested dock date falls on a 
non-working date, then it is moved earlier

• Unconstrained Kit Demand: The unconstrained demand generated for items that 
are components of kits. This is not a shipment row type.

• Constrained Kit Demand: The constrained demand that is generated for items that 
are components of kits and that is the result of a planned order to make the kit. This
is not a shipment row type.

Allocation Pegging

The quantity that each demand is allocated in each bucket is first determined based on 
the allocation rules. After this, each demand is then pegged to the supplies available for 
allocation in that bucket. Each supply is pegged to one or more supplies in the end 
demand organization. 

The supply-to-supply peg is created after load consolidation is completed. This pegging
shows the constrained supply on the destination (planned inbound shipment or internal
requisition) pegged to the constrained supplies on the source (planned inbound 
shipment, internal requisition, and on-hand). Essentially, it shows the parts of the 
supply from the source that is a part of a constrained supply on the destination. 

By order types, the pegging displayed across organizations is:

• Requested inbound shipment (unconstrained supply)

• Down to supplies: To the unconstrained demand in the source organization and
then to the supplies in the source organization 

• Up to demands: Not displayed

• Requested outbound shipment (unconstrained demand):

• Down to supplies: Displays supplies in this organization 

• Up to demands: Not displayed 

• Planned inbound shipment (constrained supply):

• Down to supplies: Displays supplies in the source organization 

• Up to demands: Displays demands in the same organization

• Planned outbound shipment (constrained demand):

• Down to supplies: Not displayed 

• Up to demands: To the supply in the destination organization, the planned 
inbound shipment, and then above that to demands 
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Distribution planning does not use any of the Oracle Advanced Supply Chain Planning 
pegging profile options.

The planning engine does not show pegging relationships to safety stock demand, 
target demand, and negative on hand demand. There are no demands for these so there 
is no demand-supply relationship.

Verifying Allocation Adjustments

On-line and batch replan can be used to check the results of user entered allocation 
adjustments. It only replans items with changed demands or supplies; it does not 
completely replan trips 

On-line and batch replan decides which items to replan based on manual changes the 
planner makes: 

• Demand changes include adding a demand and changing a demands quantity, due 
date or demand priority. 

• Supply changes include both adding new supplies and firming and also changing 
supply quantities or dates and firming

• Supplier capacity changes include adding or reducing supplier capacity. 

• Trip changes include firming a trip (which cascades the firm down to all of the 
outbound shipment lines on the trip) and changing the dates of the trip (which 
cascades the changed dates down to all of the outbound shipment lines on the trip). 

Load consolidation is not completely recalculated during on-line and batch replan. The 
load consolidation recalculations involves (for changed items):

• All shipment lines are removed from existing trips 
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• Trips are considered firm and are not rescheduled. However, new shipment lines 
are can be added to the trip 

• If the trips cannot be loaded with shipment lines for the changed items, then trips 
are created 

• The existing trips may be underutilized after the shipment line for the changed item
is removed if enough new shipment lines are not added 

Adjusting Allocations to Sales Orders

To allocate to individual sales orders and forecasts, drill down to the supply and 
demand window from allocation plan or horizontal plan You can:

• Firm the entire sales order line (or forecast) on the due date

• Firm the entire sales order line on a new date 

• Split and firm both partial sales order lines on new dates 

• Split and firm only one of the partial sales order lines 

Then, run On-line or Batch Replan. Firm demands are allocated to first and all other 
demands are reallocated the remaining supplies 

The user checks firm for a demand (forecast or sales order) and updates both the New 
Date and New Quantity fields to change the demand suggested due date (earlier or 
later) and, optionally, the demand quantity. 

Sales order and forecast demands with the firm flag checked and with new date and 
new quantity populated receive allocations first (with other firm demands) during 
distribution planning batch or on-line replan. We refer to these demands as Date/Qty 
firm to distinguish them from sales order demands subject to the usual behavior of the 
firm flag. If the sales order is simply firm without values for New Date and New 
Quantity then the behavior is unchanged. The sales order source organization cannot be
changed if the sales order firm flag is checked. 

Date/Qty firm sales orders are not retained from one full plan run to the next plan run. 
The overwrite options flag does not apply to Date/Qty firm sales orders. A full plan run 
always re-snapshots sales orders. 

For example:

• The user selects a sales order that is four days late and firms it.

• The user enters new date (which is on time) and new quantity for the sales order. .

• Replan will allocate supplies on the new date to this sales order before allocating 
supplies to other sales orders that are not firm. 

Allocation Plan
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View the distribution planning allocation decisions by customer in the allocation plan. 
To use it:

• Display allocations from the source organization to Customers and customer sites 
Demand classes 

• Display by allocation bucket 

• Select specific customers with the customer list 

• Double click sales order quantities to open the supply demand window for specific 
sales orders to firm and optionally split the demands

• If you open it from the items node with no organization context, then the allocation 
plan displays allocations by customer for the entire enterprise. You can analyze 
allocations to each customer totaled for all distribution centers. Use this method if 
many customer sites are sourced from many different distribution centers.

Consolidating Trips

In the Find Opportunities window, users can select certain transfers and consolidating. 
The action: 

• Adds the shipment lines to the target trip 

• Updates the weight and cube fields for the target trip

• Firms and updates the shipment lines to the new ship date, dock date and ship 
method

• Does not update any other dates such as order date or start date. These are updated 
when a replan or a full plan launch are run. 

The planner can find under utilized trips in various ways. The planner can add trips 
under utilized exceptions to the most important exceptions in the plan summary or 
open the trips under utilized exceptions in the exceptions summary. The planner can 
also check the utilization percents in the trips form. From any of these, the planner can 
work to improve the utilization of the trip by opening the Consolidate Trips window. 

From within the Consolidation Trips window, the planner can use the find 
opportunities algorithm. The find opportunities algorithm takes the following find 
criteria as input to limit the transfers to consider placing on the target trip: 

• Utilization % (weight and cube): Always less than the value entered. 

• Days from Ship Date: The number of days before and after the ship date of the 
targeted trip 

• Supply Available Days Early: For individual shipments (internal requisitions), this 
date is less than or equal to the trip ship date. If the user enters a negative value, 
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then individual shipments are considered with supplies that are not available until 
that many days after the actual shipment is scheduled for shipment. The 
assumption is the planner can expedite them. 

From the trip, navigate to Find Opportunities form

• It displays the under utilized trip 

• Enter parameters to search for other transfers that can be loaded on the under 
utilized trips 

• Select the transfers and change ship date, dock date, and ship method for the 
selected outbound shipments Then, click Consolidation to put them on the target 
under utilized trip 

• Optionally release now or later

The trip information at the top of the Consolidate Trip form is the target trip that the 
planner is trying to improve the utilization

The Opportunities region displays the Trips selected based on the user entered values 
in the find algorithm. 

The Shipment Lines region displays the lines for the highlighted trip in the 
opportunities region.

• Demand Days Late: Target Trip (Dock date + Post processing days) - Need by date. 
If late, it is in red. 

• Supply Days Late: Trip ship date - Supply available date. If late, it is in red. 

For both Demand Days Late and Supply Days Late fields, the trip refers to the trip that 
is in the top region; that is, the trip we are looking to add shipment lines to. Both fields 
display in red if there is a problem with its either meeting the demand due date or 
having the supply available for the new ship date.

Supply Available Date field for each shipment line is calculated from the pegging 
relationship and displayed so the user can understand how early the supply is available
in the source organization. It might be moved onto a trip that is earlier than the trip it is 
on. 

Expediting Supplies

Distribution planners use the same Workbench features to expedite supplies that are 
used by MRP/MPS/MPP plans. Use exception management and Workbench 
functionality to

• Increase supplier capacity

• Select alternate suppliers
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• Reduce transit times 

• Firm orders early based on supplier responses 

Rebalancing Inventories

Review the plan for inventory rebalance requirements 

Check the Planned order uses inventory rebalance source exception to review inventory
rebalance actions by the plan As desired, release inventory rebalance planned orders 

Use horizontal plan for multiple organizations to determine if additional inventory 
rebalancing is required 

Refer to profile option MSC: Inventory Rebalancing Surplus Inventory Basis and plan 
option Inventory Rebalancing Surplus Days for more information about the inventory 
rebalancing feature.

Updating and Releasing Trips

Update and release trips using the Trips form

• Update ship date, dock date and ship method for a trip

• Changes to the trip updates all internal transfers on the trip 

• Release all internal transfers on a trip by releasing the trip 

In the Trips form, the user can change the ship method, ship date, and dock date for a 
trip. If the user changes the dock date or the ship date and blanks out the other date, 
then the other date is calculated based on the selected ship method. If no ship method is
selected, then the user must enter both dates. 

The user can firm and release trips from the trips form. 

All changes made to a trip (for example, date changes, firm, and release) are propagated
to the internal requisitions, internal sales orders, planned inbound and outbound 
shipments for a particular trip. 

From the supply and demand window, users can remove or add internal shipments to 
trips.

Analyze Trip Loading

Analyze how a trip is loaded with the Trip Allocation Details form 

Right click from a trip to view Trip Allocation Details

Each detail line: 

• Associates unconstrained demands in the destination with constrained supplies in 
the source as shipment lines are loaded 

• Supply date: The earliest date that the supply is available in the source organization
for this demand 
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• Earliest Possible Dock Date: The earliest date that the trip can dock and not cause a 
violation of maximum inventory level at the destination organization

• Latest Possible Dock Date: The latest date that the trip can dock and not cause a 
violation of safety stock level at the destination organization 

The Trip Allocation Details form provides the user a way to determine which items and 
quantities on the trip have the earliest required ship and dock dates and highest 
priority. This allows a user to make decisions about which trip lines must go on the trip 
and which lines could be delayed. Trip allocation details are not displayed for dates 
outside of the trip consolidation window. 

Similar information is provided by item in the supply and demand window, but the 
Trip Allocation Details form provides a more granular view. Both the earliest and latest 
dock dates are calculated using the ship method for the trip. Faster or slower ship 
methods can change these dates; they were considered by the distribution planning 
engine prior to assigning the trip allocation detail Line to the particular trip. The 
information in the Trip Allocation Details form is based on that ship method. 

Use these dates to determine the supplies and trips that can be considered when 
manually consolidating shipments. 

Each trip allocation detail Line is associated with both of the following: 

• The unconstrained demand (requested outbound shipment) from the destination 
organization that triggered the requirement 

• The constrained supply (planned inbound shipment or internal requisition) to the 
destination organization 

Trip Allocation Details are related to demands as follows: 

• During the allocation and trip loading process, the distribution planning engine 
evaluates demands from the destination organization and creates trip allocation 
detail lines that are tied to each of its unconstrained demands.

• The unconstrained demands are shown in the supply and demand window as 
requested outbound shipments. 

• This relationship exists during the trip loading engine process and is not shown as 
part of the pegging tree. 

• A trip allocation detail line quantity can be larger or smaller than its associated 
demand. 

• Multiple trip allocation detail lines can be associated to a single demand row. The 
relationship and number of trip allocation detail Lines is affected by such factors as 
trip size, number of demands in the destination organization, order modifiers, and 
priorities based on internal engine logic as trips are loaded. 
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• A trip allocation detail line quantity can also be larger than the associated demand 
because of order modifiers. 

Creating Internal Requisitions and Internal Sales Orders

You can release planned orders for transfers from distribution plans 

Release either the planned outbound shipment or the planned inbound shipment 

The distribution planning release mechanism automatically creates both the internal 
requisition in the destination organization and the internal sales order in the source 
organization The internal requisition is automatically interfaced to Oracle Order 
Management as part of the release mechanism and the internal sales order is created as 
part of the release process 

Releasing trips or releasing individual shipments works the same as both documents 
are created in the source by the release mechanism 

Distribution planning completes all of the steps necessary to create both documents, 
including creating the internal requisition and marking it as interfaced to Oracle Order 
Management. The internal sales order is created, the internal requisition number is 
populated and the internal sales order is marked as booked. In addition, the Oracle 
Order Management loopback API loads both the ship date and the arrival date to the 
internal sales order; these dates then reflect the planning decisions. 

Upon creation of the internal sales order, it is in the booked status; the delivery line is 
also created which in turn can be used by Oracle Transportation Management. Oracle 
Transportation Management can select the mode, carrier, service level, and can 
schedule the load so that it is ready to be tendered. 

The dates populated in the source instance for the internal sales order and internal 
requisition relate to the dates in the distribution plan supply and demand window as 
follows: 

• Internal requisition Need By Date from Distribution Plan Workbench Implement 
Dock Date

• Earliest Acceptable Date is not populated

• Latest Acceptable Date is not populated

• Schedule Ship Date from Distribution Plan Workbench Implement Ship Date

• Schedule Arrival Date from Distribution Plan Workbench Implement Dock Date

• Request Date from Distribution Plan Workbench Implement Ship Date

• Promise Date from Distribution Plan Workbench Implement Ship Date

• Earliest Ship Date (visible on the delivery line) from Material Available Date

Earliest Ship Date on the sales order is not visible in the Sales Order form, but the user 
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will be able to see the it when viewing the sales order line's related delivery line in 
Oracle Shipping. This requires that the item be an available-to-promise item and that 
the profile option OM: Source for TP Early Ship/Deliver Date is set to Earliest 
Acceptable Date. 

• If the item is an available-to-promise item and profile option OM: Source for TP 
Early Ship/Deliver Date is set to Earliest Acceptable Date, then the Earliest Ship 
Date on the delivery line is set to the greater of the earliest acceptable date or the 
earliest ship date.

• If the item is not an available-to-promise item, then the delivery line Earliest Ship 
Date is populated with the sales order line Earliest Acceptable Date; if that date is 
null, then today's date is used. The Earliest Ship Date from the sales order only 
passes to the delivery line for available-to-promise items. 

Rescheduling Internal Sales Orders and Internal Requisitions

Planners can release reschedules and cancellations for internal transfers 

The internal sales order is updated with the new date (and new quantity or new ship 
method, if different) 

The information that tracks supply, is updated by the reschedule release so that supply 
and demand is synchronized for internal sales orders and internal requisitions even 
after the internal sales order is rescheduled 

Recollected data and distribution plans show synchronized internal sales order and 
internal requisition dates even after the internal sales order is rescheduled 

When the user releases a rescheduled internal requisition and internal sales order, the 
Oracle Order Management Process Order API is called. This updates the internal sales 
order to the new date and new quantity. 

The requisition itself is not changed, as Oracle Purchasing does not allow updates to 
requisitions that are interfaced to Oracle Order Management. Instead, the Oracle Order 
Management Process Order API also updates the information that tracks the supply 
(from internal requisitions). Distribution plans use the actual dates and quantities from 
the internal sales order and the internal requisition detail is from the material supply 
information which is kept in synch with the internal sales order by the Oracle Order 
Management Process Order API. 

There may be differences in dates between the internal requisition and the internal sales
order. However, after the data is collected and used in distribution planning, the 
internal requisition and internal sales order are synchronized.

Release Sales Order Changes

Distribution planners can release customer sales order updates to the source instance 
(publishing plan results to Oracle Order Management) including

• Source organization
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• Ship method 

• Firm flag 

• Suggested ship date

• Planned arrival date 

• In transit lead-time

• Material availability date

Distribution planning provides the same functionality as MRP/MPS/MPP plans. Global 
Forecasting is supported; it uses distribution planning to select the best source 
organization for sales orders 

Fair Share Allocation
The different fair share allocation methods (except the order sizing method), determine 
a fair share percent of the available supply that is allocated to each competing demand. 

• Current Demand Ratio

• None

• Fixed Percent

• Safety Stock Ratio

• Order Size

Fair share allocation methods are invoked when:

• Two or more competing demands have the same demand priority

• At least one of the competing demands is transfer between sales orders

• There is a supply shortage in the current allocation bucket to meet all of the 
demands at a certain priority

With the order sizing fair share allocation rule, each organization is allocated its fair 
share percent of the available supply, subject to the order size. The organization with 
the highest percent is allocated supply first, and then the order size is applied and this 
may increase the supply. The organization with the next highest percent is allocated 
supply second, again subject to its order size. If two organizations have the same 
percent, then the organization with the higher rank is allocated supply first.

The other fair share rules only differ from each other in how the fair share percentage is 
calculated. Once calculated, the fair share percentage is applied in the exactly the same 
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manner.

Fair Share Allocation Methods
For the supply allocation rules, if there is a tie in percent or order size, the organization 
rank is used to break the tie. Organization rank is inferred from the sequence that 
organizations are entered on the form. If you want to control which organization is 
considered first when two organizations are tied based on a particular supply allocation
rule, then enter the organizations with the highest priority organization at the top of the
form. Inferred rank is not used for demand priority override supply allocation methods.

Current Demand Ratio Method

Fair share percents are calculated based on the quantity of the competing demands in 
the current allocation bucket.

You can also optionally enter a percent for one or more organizations. The percent 
overrides the actual demand ratio for that organization and the remaining 
organizations are apportioned the remaining percentages based on the demand ratios.

When the percents are the same, rank is used to determine which organization is 
allocated supply first.

None (no fair share allocation)

Current first come first served logic is used when allocating supplies to competing 
demands with the same priority. The supplies are allocated based on distribution 
planning priority pegging logic that is essentially first come first served. If two 
demands have the same priority and due date, one demand is allocated completely 
before the second demand is considered. You cannot control which demand is allocated
first. This is the default method if no Fair Share Allocation Method is specified for an 
item-org.

Fixed Percent Method

The user enters the fair share percent in the percent fields. The entered percents are 
used during the allocation process and define the minimum amount of the available 
supplies that an organization should receive. During allocation, the organization with 
the highest percent is considered first and is allocated up to that percent of the supply 
before the next organization is considered. After all organizations with defined percents
are considered, any remaining supply is allocated on a first come first serve basis.

The defined fixed percent values do not have to total 100 percent and are not 
normalized to internally to 100% by the planning engine. For example, you specify that 
Org1 is 50 % and do not specify any percentages for any other organizations. During 
allocation, Org1 is always considered first and can be allocated up to 50% of the supply 
before any other organizations are considered. After this step, then all the remaining 
supplies are allocated to organizations not in the rule, one organization at a time. The 
first organization selected may use up all remaining supply. Consider defining all 
organizations in the rule.

If Org1 and Org2 are specified at 25% each, and there are no other destination 



16-20    Oracle Advanced Supply Chain Planning Implementation and User's Guide

organizations, then the results of the allocation appears as though the 25% each is 
normalized to 50% each.

Safety Stock Ratio Method

For an organization, the fair share percent is the organization safety stock level divided 
by the total of all organization safety stock levels. The safety stock average value across 
the allocation bucket is used to determine the safety stock ratio. You can also optionally 
enter a percent for one or more organizations. 

You can also optionally enter a percent for one or more organizations. The percent 
overrides the safety stock ratio for that organization and the remaining organizations 
are given the remaining percentages based on the demand ratios. When the fair share 
percents are the same, then rank is used to determine which organization is allocated 
supply first.

If the organization safety stock is 0, it is given a priority lower than any organization 
with a positive value for the safety stock. The allocation steps are:

• Allocate to organizations with a safety stock values or a percent specified.

• If there is supply left after this first allocation, allocate to organizations with safety 
stock 0. Allocate to organizations by rank and within rank, allocate equally until 
demands are filled.

When the percents are the same, rank is used to determine which organization is 
allocated supply first.

Order Size Method

This is an exception to the concept of calculating a fair share percent. When order size 
method is selected, then the user must specify the fixed lot multiple values and, 
optionally, the rank. The organization with the largest fixed lot multiple is allocated a 
fixed-lot-multiple order size quantity, then the next organization is allocated a fixed lot 
multiple order size, then the next until either all supply is used up or there is not 
enough supply to satisfy any fixed lot multiple. If two fixed lot multiple order sizes are 
the same, rank determines which organization is first allocated a fixed lot multiple 
order size quantity.

Organizations are allocated supply first. If the source organization has an order, this is 
used with the other destination organizations to determine the source organization's 
own allocations. Then, this supply is allocated to the source organizations independent 
demands such as sales orders, forecasts, target inventory level, and safety stock. 

For order sizing, distribution planning considers the supply allocation rule order size 
multiplier for internal transfers.

The supply allocation rule order sizes can be used to define fixed lot multipliers, such as
pallet quantities, that are only used for inter-organization transfers between a specific 
ship from-ship to organization pair. These might be different from the item attribute 
order fixed lot multiple which is used for all inbound shipments to an organization 
without regard to the source.
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Distribution planning uses the following defaulting hierarchy to find the order size 
multiplier for internal transfers from and to an organization pair: 

• If the fixed lot multiplier on the plan run date has a value, use it for internal 
transfers from and to this organization pair Ignore all item attribute order 
modifiers.

• If the fixed lot multiplier is null, use the destination organization item attribute 
Fixed Lot Multiplier..

• If destination organization item attribute Fixed Lot Multiplier is Null, then use one 
as the fixed lot multiplier if item attribute Round Order Quantities is checked 
(when rounding, always round up to avoid a fractional shortage).

• Use fractional quantities up to 6 digits

If you put an organization on the rule and do not define an order size, we use item 
attribute Fixed Lot Multipler for the order size method. For organizations missing from 
the fair share rule, we process them after all demands are satisfied for organizations 
that have an order size.

Default Fair Share Allocation Method
You can select a default fair share allocation method on the Plan Options form. The 
default method applies to all item-destination organizations except where a supply 
allocation rule has been explicitly defined. The choices for the plan option Default Fair 
Share Allocation Method are:

• Current Demand Ratio

• Safety Stock Ratio

When the default fair share allocation method is applied to an item-destination 
organization, you cannot specify ranks and percents. The standard defaulting logic is 
used. 

Fair Share Allocation Rules
You can specify a supply allocation rule that does not include all of the destination 
warehouses for a shipping warehouse.

If the organization priority is not selected, the planing engine uses fair share allocation 
rules. Each unspecified warehouse is considered only after all demands within a 
specific priority for the specified warehouses are met in an allocation bucket. Unmet 
demands are moved to the next time bucket. For example:

• Organizations R1, R2 and R3 source from D2. R1 and R2 have fixed percents 
specified as 50 / 50.
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• If demands for R1, R2, R3, and D2 are 100 each available for demand priority 6 and 
supply is 250 units, R1 is allocated 100 units and R2 is allocated 100 units. Only after
R1 and R2 are satisfied does the planning engine consider R3 and D2. Either R3 or 
D2 is allocated the 50 remaining units.

Fair Share Logic
Fair share rules are invoked because there is a supply shortage in an allocation bucket. 
Fair share rules are used to allocate supplies to demands that have the same demand 
priority and are within the same allocation bucket. When allocating available supplies 
to demands, the supplies may be split between demands, not necessarily completely 
satisfying any one demand.

The remaining balance of the unsatisfied demands are considered in the next allocation 
bucket that has a new quantity of available supplies. The demand priority of the 
unsatisfied demands is not changed. In the next bucket, other higher priority demands 
may be considered before the unsatisfied demands that were carried forward. In fact, it 
is possible for the unsatisfied demands to be carried forward many allocation buckets, 
even to the end of the plan horizon.

These are the rules that planning engine uses to allocate scarce supplies to demands 
with the same demand priority:

• Allocation proceeds first for firm demands by priority and then non-firm demands 
by priority. At some point, as each level is considered, supplies may run out, and 
then fair share allocation is invoked.

• Firm demands are allocated supplies first until all firm demands are satisfied. This 
allocation to form demands occurs before the allocation considers any non-firm 
demands. Firm demands are firm internal sales orders, firm planned outbound 
shipments and demands pegged to firm planned orders such as a planned 
outbound shipment that is pegged to a firm supply in the destination organizations.

Allocation is to firm demands first by original demand priority and then by earliest 
date. If all of the firm demands cannot be satisfied, they are carried forward to the 
next bucket.

• The organization with the highest fair share percentage gets the first chance at the 
available supplies and can be allocated up to its fair share percentage of the 
available supplies.

The organization with the highest fair share percentage is only allocated quantity to
meet demands. For example, organization A fair share is 50% of the supply which is
2000 units. However, in the current allocation bucket, organization A demands are 
only for 500 units so only 500 units are allocated.

The allocations consider order sizing, so there may be excess supply allocated in a 
bucket due to order sizing constraints. If the allocation does not meet the order size 
requirement, then enough additional supply is allocated to reach the next fixed lot 
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multiple to respect the order size.

• If there are ties for the fair share percentage, the inferred rank is used to break the 
tie to determine which organization is considered first.

• After all organizations with fair share percentages are allocated supply, 
organizations with no fair share percentages are allocated supply on a first come 
first served basis, one organization at a time within a priority. Your needs may be 
best served by defining all organizations in the rule and not relying on defaulting 
logic. Organizations with no fair share percentages can occur with either of the 
following:

• The organization is not included in the supply allocation rule but is a valid 
destination organization based on the sourcing rules

• The organization is included in the supply allocation rule but does not have an 
allocation value specified (in the case of fixed percent method and order size 
method). The user is not required to give each list organization a value.

• Transfers are never generated to move inventory backwards. For example, a 
transfer would never be created to move material from organization R2 back to 
organization D2 for the purpose of reallocating it to other organizations from 
organization D2.

The organization with the highest allocation percentage may not always not receive 
its fair share because there isn't enough inventory on shipping lanes flowing to or 
through that organization. If most of the available inventory is in organization R5 
and organization R1 has the highest allocation percentage then R1 will not get 
transfers according to its fair share. Defining inventory rebalance distribution rules 
between R1 and R5 resolves this issue.

• The planning engine creates transfers using standard sourcing rules and supply 
allocation rules.

• The use of fair share rules raises the number of partial demand satisfactions in the 
final plan output since supplies are split between competing demands of the same 
demand priority.

In cases where all demands can be met but safety stock levels cannot be met, the affect 
of applying the fair share allocation rules is a rebalancing of the available inventory. 
The fair share rules are applied to the remaining supplies that are distributed with 
reference to the fair share rule and the safety stock or target inventory shortages.

The example shows a case where RDC1 and RDC2 source from DC1. DC1 has sales 
orders, forecasts and transfer demand from the two RDC's.

The example is for the first allocation bucket, and shows allocations with three different 
supplies in the first allocation bucket for on hand in DC1. The current demand ratio fair 
share allocation method is used.
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DC1 
Demands

Priority Demand 
Quantity

Allocation If 
Supply Is 
100

Allocation If 
Supply Is 
300

Allocation If 
Supply Is 
700

Sales order 1 100 50 100 100

RDC1 request 1 100 50 100 100

Forecast 2 100 0 25 100

RDC1 request 2 200 0 50 200

RDC1 request 2 100 0 25 100

RDC1 request 3 100 0 0 10

RDC1 request -3 -1000 -0 0 90

Customer Fair Share Allocation Method for Sales Orders and Forecasts
A plan option is provided that allows to user to select the customer fair share allocation 
method that is applied to sales orders and forecasts. The customer fair share allocation 
method for sales orders and forecasts uses the same fair share allocation approach as 
the demand ratio supply allocation rule. There is no need for you to specify individual 
fair share allocation rules by source organization and customer.

The options are:

• No Fair Share: There is no fair share allocation and supplies are allocated to sales 
orders and forecasts on a first come first served basis. This is the same as null.

• Demand Class: Fair share is done at the demand class level. Below demand class, 
supplies are allocated on a first come first served basis.

• Customer: Fair share is done at the customer level. Below customer, supplies are 
allocated on a first come first served basis.

• Customer Site: Fair share allocation is performed at the customer site level. If there 
are multiple orders in the same allocation bucket from the same customer site, then 
supplies are allocated on a first come first served basis.

The fair share allocation is used whenever a source organization has a supply shortage 
due to competing sales order, forecast, and requested outbound shipment demands 
with the same demand priority in the same allocation bucket (as determined by the 
demand priority rule set). If there is no demand priority rule set, then the priorities used
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are the default priorities for sales orders, forecasts, and over-consumed forecasts.

The fair share allocation between sales orders and forecasts is based on the ratio of 
demands for each sales order and forecast in the supply allocation bucket. The available
supply is allocated to each demand based on the ratio of the demand to the total 
demand. For both sales orders and forecasts, the quantity allocated by the demand due 
date is retained and reported in the late replenishment exception message.

The planning engine treats forecasts demands without a customer as demands with 
dummy customer name. That is, if two forecasts (one with customer and one without 
customer) are for equal quantity, the fair share is equal between the two forecasts.

If you do not choose fair share allocation for sales and forecasts, then the first come, first
served logic is applied. The supply is used to satisfy one demand at a time until the 
supply is exhausted. When demands have the same priority, you cannot control which 
demands are considered first. For example, there are five sales order and forecasts 
demands for 10 units each and all the same priority and there is a supply of 20 units. 
Using fair share means that each of the 5 demands is allocated 4 units and using first 
come first served means that 2 demands are allocated 10 units each.

These examples show no fair share allocation and fair share allocation at the demand 
class level, the customer level, and the customer site level. This table shows demands 
against an item in organization C1 for June 30. Organization C1 uses daily supply 
allocation buckets. The June 30 on-hand balance for the item is 340.

Demand Type: 
Order Number

Priority Demand Class Demand Source Qty

Sales Order: SO1 1 DC1 Customer A 100

Sales Order: SO2 2 DC2 Customer B / 
Site 1

200

Forecast: FC3 2 DC2 Customer B / 
Site 2

100

Sales Order: SO4 2 DC3 Customer C 50

Sales Order: SO5 2 DC3 Customer D 50

Sales Order: SO6 3 DC4 Customer E 100

Total - - - 600

This is how the planning process performs first-come, first-served allocation:

• 100 units are allocated to SO1 because this is the highest priority sales order. No fair
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share allocation is required for priority 1 demands. After this step, there is 240 units
of supply left. 

• There are 400 units of priority 2 demands and only 240 units of supply left. The 
priority 2 demands are allocated supply based on a first come first server method. 
While there are several possible outcomes, depending on which demand is 
considered first, assume that Customer B, Site 1 is allocated 200 units of demand 
and Customer B, Site 2 is allocated 40 units of demand. 

• There are 100 units of priority 3 demands and no available supply so no allocation 
occurs.

This table shows the result of the first-come, first-served allocation.

Demand 
Type: Order 
Number

Priority Demand 
Class

Demand 
Source

Qty Allocated 
Qty (Qty 
Satisfied by 
Due Date)

Sales Order: 
SO1

1 DC1 Customer A 100 100

Sales Order: 
SO2

2 DC2 Customer B / 
Site 1

200 200

Forecast: FC3 2 DC2 Customer B / 
Site 2

100 40

Sales Order: 
SO4

2 DC3 Customer C 50 0

Sales Order: 
SO5

2 DC3 Customer D 50 0

Sales Order: 
SO6

3 DC4 Customer E 100 0

Total - - - 600 340

This is how the planning process performs fair share allocation by demand class:

• 100 units are allocated to SO1 because this is the highest priority sales order. No fair
share allocation is required for priority 1 demands. After this step, there is 240 units
of supply left. 

• There are 400 units of priority 2 demands and only 240 units of supply left. The 
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priority 2 demands are allocated supply based on the demand class.

• DC2 has 300 units of demand and DC 3 has 100 units of demand. The allocation is 
180 units for DC2 and 60 units for DC3

• Within DC2, the allocation proceeds on a first come first served basis. There are two
possible outcomes; SO2 is allocated 180 units and FC3 is allocated nothing, or FC 3 
is allocated 100 units and SO2 is allocated 80 units. Assume SO2 is allocated 180 
units and FC3 is allocated nothing.

• Within DC3, the allocation proceeds on a first come first served basis. There are two
possible outcomes; SO4 is allocated 50 units and SO5 is allocated 10 units, or SO5 is 
allocated 50 units and SO4 is allocated 10 units. Assume SO4 is allocated 50 units 
and SO5 is allocated 10 units.

• There are 100 units of priority 3 demands and no available supply so no allocation 
occurs.

This table shows the result of the fair share allocation by demand class.

Demand 
Type: Order 
Number

Priority Demand 
Class

Demand 
Source

Qty Allocated 
Qty (Qty 
Satisfied by 
Due Date)

Sales Order: 
SO1

1 DC1 Customer A 100 100

Sales Order: 
SO2

2 DC2 Customer B / 
Site 1

200 180

Forecast: FC3 2 DC2 Customer B / 
Site 2

100 0

Sales Order: 
SO4

2 DC3 Customer C 50 50

Sales Order: 
SO5

2 DC3 Customer D 50 10

Sales Order: 
SO6

3 DC4 Customer E 100 0

Total - - - 600 340

This is how the planning process performs fair share allocation by customer:
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• 100 units are allocated to SO1 because this is the highest priority sales order. No fair
share allocation is required for priority 1 demands. After this step, there is 240 units
of supply left. 

• There are 400 units of priority 2 demands and only 240 units of supply left. The 
priority 2 demands are allocated supply based on the customer.

• Customer B has 300 units of demand, customer C has 50 units of demand, and 
Customer D has 50 units of demand. The allocation is 180, 30 and 30 respectively.

• Within Customer B's two sites, the allocation proceeds on a first come first served 
basis. There are two possible outcomes (assume that the first is the actual result); 
Site 1 is allocated 180 units and Site 2 is allocated nothing, or Site 2 is allocated 100 
units and Site 1 is allocated 80 units. Assume Site 1 is allocated 180 units and Site 2 
is allocated nothing.

• There are 100 units of priority 3 demands and no available supply so no allocation 
occurs.

This table shows the result of the fair share allocation by customer.

Demand 
Type: Order 
Number

Priority Demand 
Class

Demand 
Source

Qty Allocated 
Qty (Qty 
Satisfied by 
Due Date)

Sales Order: 
SO1

1 DC1 Customer A 100 100

Sales Order: 
SO2

2 DC2 Customer B / 
Site 1

200 180

Forecast: FC3 2 DC2 Customer B / 
Site 2

100 0

Sales Order: 
SO4

2 DC3 Customer C 50 30

Sales Order: 
SO5

2 DC3 Customer D 50 30

Sales Order: 
SO6

3 DC4 Customer E 100 0

Total - - - 600 340
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This is how the planning process performs fair share allocation by customer site:

• 100 units are allocated to SO1 because this is the highest priority sales order. No fair
share allocation is required for priority 1 demands. After this step, there is 240 units
of supply left. 

• There are 400 units of priority 2 demands and only 240 units of supply left. The 
priority 2 demands are allocated supply based on the customer. Customer B Site 1 
has 200 units of demand, Customer B Site 2 has 100 units of demand, Customer C 
has 50 units of demand and Customer D has 50 units of demand. The allocation is 
120, 60, 30 and 30 respectively.

• There are 100 units of priority 3 demands and no available supply so no allocation 
occurs.

This table shows the result of the fair share allocation by customer site.

Demand 
Type: Order 
Number

Priority Demand 
Class

Demand 
Source

Qty Allocated 
Qty (Qty 
Satisfied by 
Due Date)

Sales Order: 
SO1

1 DC1 Customer A 100 100

Sales Order: 
SO2

2 DC2 Customer B / 
Site 1

200 120

Forecast: FC3 2 DC2 Customer B / 
Site 2

100 60

Sales Order: 
SO4

2 DC3 Customer C 50 30

Sales Order: 
SO5

2 DC3 Customer D 50 30

Sales Order: 
SO6

3 DC4 Customer E 100 0

Total - - - 600 340

Organization Priority Overrides

Assign organization override priorities to the source organization to control the relative 
priority level of the source organization independent demands versus the dependent 
demands from other organizations 
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If you select plan option Use Organization Priority Overrides, priorities are based on 
the organization override priorities set in the supply allocation rule for each 
organization-item You cannot use a demand priority rule set.

Allocation from a source organization to the destination organizations are based on the 
assigned destination organization priority 

• If no priorities are assigned for an organization-item, allocations are done on an 
equal priority basis

• Priorities assigned to forecasts, sales orders, safety stock, and target inventory are 
the same priority as the assigned organization priority 

In the demand priority override region of supply allocation rules, you can select: 

• Use Organization Priorities: For all demands against this organization, the demand 
priorities are set to the values specified for each organization. You can set the 
relative priorities of all demands from several organizations. 

• None or Null: Demand priorities are not overwritten. 

You can also optionally include the source or shipping organization and specify a 
priority for the shipping organization. This allows you to specify priorities for the 
shipping organization at the same time that you specify priorities for the receiving 
organizations. This technique allows you to control whether demands from the other 
organizations have higher or lower priorities than those from the source organization. 

If Organization Priority is selected, then all unspecified warehouses are set at the same 
priority which is one less than any specified warehouses. 

For example, Organizations R1, R2 and R3 source from D2. A demand priority override 
is specified for R1 as 1, R2 as 2, and D2 as 2 No priority is specified for R3. The default 
demand priority override for R3 is 3. 

If no organization priority override rule is specified, then all destinations and source are
treated as having the same priority. 

When organization priority override is used, then within an organization all demands 
are given the same priority. Supplies are fair shared within this priority based on the 
plan option customer fair share allocation method. 

Fair Share Allocation from Suppliers to Organizations
You cannot define and assign fair share allocation rules to items sourced from suppliers,
but a plan option is provided to set the fair share allocation method for all suppliers. 
The fair share allocation logic is called when supplier capacity is defined and demand 
exceeds available supplier capacity in an allocation bucket.

The allocation logic applied to supplies from a supplier is the same as used for 
allocation or supplies between organizations. The plan option choices are:

• None: No fair share allocation is performed and supplies are allocated based on a 
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first come first serve basis.

• Current Demand Ratio: Fair share allocation is performed using the current 
demand ratio of the organizations sourcing from the supplier

• Safety Stock Ratio: Fair share allocation is performed using the safety stock ratios of 
the organizations sourcing from the supplier.

The total supply that is allocated is the net supply available by the end of the allocation 
bucket. This is based on the supplier capacity.

For example, supplier capacity is 10 units per day, all days are work days, there are no 
demands until the second weekly bucket, and the total demand exceeds supplier 
capacity. If the third weekly bucket ends on day 18, there are a total of 180 units to 
allocate among the competing demands. 

The planning engine uses this defaulting hierarchy to find the order size multiplier for 
suppliers:

• If the approved supplier list fixed lot multiplier is blank, use the destination 
organization item attribute Fixed Lot Multiplier for internal transfers from and to 
the organization.

• If the destination organization item attribute Fixed Lot Multiplier is blank, then use 
1 as the fixed lot multiplier

• If item attribute Round Order Quantities is selected round up, otherwise use 
fractional quantities up to 6 digits.

Load consolidation is not done for shipments to customers. If load consolidation is 
needed for supplies or customers, you can model the supplier or customer as an 
external organization.

Consider both the supplier capacity and the fixed lot multiplier to achieve appropriate 
allocations. For example, A plan runs on January 7 and item X has planning time fence 
of 4 days. Organizations A and B source item X from Supplier S. The supplier capacity 
is 500 per day (24x7 calendar) and the fixed lot multiple is 750 units. The plan option 
value for the supplier fair share method is Current Demand Ratio. However, the results 
might not look like much of a fair share due to the order size relative to the supplier 
capacity. The following demands from organizations A and B illustrate the case:

• No planned orders can be due before January 10 due to the planning time fence. 
Organization B is allocated to first, since its percentage fair share is higher because 
its total demand is higher. For organization B, total demand up to January is 5830 
and rounded to 6000. For organization A, total demand up to January 10 is 4350 and
rounded to 4500. The fair share capacity from January 7 to January 10 is 2000 (500 
each day). Organization B gets 857.142 (42.8571% * 2000) and rounded to 0 since we 
only have 500 capacity left and order size is 750. Organization A gets 1142.86 
(57.1429% * 2000) and rounded to 1500. The higher percentage organization gets to 
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do rounding first and we will round up first if supply allows. We only round down 
if supplier capacity is insufficient.

• On January 11, organization A total carried over demand plus new demands is 
rounded to 6000. Organization B total carried over demand plus new demands is 
rounded to 4500. We have 500 carried over to add to the 500 on January 11, so total 
supply available is 1000. Fair share organization A gets 571.429 (57.1429% * 1000) 
and rounded up to 750; organization B gets 428.571(42.8571% * 1000) and rounded 
down to 0 again.

• So after the first five days of the plan, A is allocated 2250 units and B is allocated 
nothing. To achieve a better fair share, you either reduce the order size or consider 
changing the allocation bucket to weekly so there is more supply available relative 
to the order size.

Setting Up Customer Lists
The Customer List form is used to specify a default customer selection list in the plan 
preferences, which is used when the allocation plan for customers and customer sites 
opens. Defined customer lists are displayed in the Customer List form.

To set up customer lists
1. Navigate to Tools > Customer List or right-click on an allocation plan when the 

default horizontal dimension is Customer and select Customer List.

2. Add a Name and Owner for the customer list.

3. The Public drop-down list determines whether the customer list is accessible by 
other planners, both for definition and for display when a user right-clicks on an 
allocation plan. The default value is No. Change it to Yes if you want to make the 
customer list public.

4. Define customer selection lists by selecting customers from the list of customers. 
Use the arrows to move customers up and down in the form to set the order in 
which the customers are displayed. 

5. If you want, enter values in the Customer Site fields.
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17
Supply Chain Plan Exception Messages

This chapter covers the following topics:

• Overview of Exception Messages

• Filtering Exception Messages

• Viewing Exceptions

• Understanding Exceptions

• Exception Diagnosis and Resolution

Overview of Exception Messages
The planning engine issues exception messages (exceptions) to:

• Alert you to a situation that may need your intervention, for example, a past due 
sales order

• Recommend that you perform an action, for example, change the date of a supply 
order

The planning engine issues certain exceptions for all plan types and others for only 
certain plan types. 

The planning engine only issues exceptions against items and resources that have 
exception sets assigned to them.

You can consider exception messages and recommendations when you:

• Run plans

• Review plans

When running plans, you can:

• Set plan options that make your plans consistent with your company business 
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practices. 

• Run them for a single plant or for an entire supply chain. 

• Run them with no material and resource constraints, with some material and 
resource constraints, and with optimization objectives (for example, profit, 
inventory turns, customer service, and overloading resources). 

When reviewing plans, you can:

• Search for specific exceptions (for example, exceptions that relate to a specific buyer
or item)

• View exceptions grouped by type

• Drill down to related exceptions and detailed supply and demand information

• Run simulations to test improved plan suggestions

• Use Oracle Workflow to notify employees and trading partners of specific exception
and to create automatic resolution actions

Exception Groups and Exception Messages Summary
Oracle Advanced Planning and Scheduling displays exception messages by exception 
group. An exception group is a group of exception messages that deal with a common 
issue.

This section lists the exception groups and the exception messages in each exception 
group. 

Oracle Value Chain Planning also uses the term exception group to mean an exception 
message filter. Those exception groups are not part of these collections of exception 
messages with the same subject.

Late sales orders and forecasts 
• Sales order/forecast at risk

• Past due sales orders

• Past due forecast

• Late replenishment for sales order

• Late replenishment for forecast

• Early replenishment for sales order
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• Early replenishment for forecast

Supply problems for late sales orders and forecasts
• Sales order/forecast at risk due to resource shortage

• Sales order/forecast at risk due to material shortage

• Requirement causes resource overload

• Order causes supplier capacity overload

• Order causes transportation weight capacity overload

• Order causes transportation volume capacity overload

• Order with insufficient lead time

• Requirement with insufficient lead time

• Order lead time constraint

• Requirement lead time constraint

• Demand quantity not satisfied 

• Late supply pegged to forecast

• Late supply pegged to sales order

• Order violates a business calendar

Material and resource capacity
• Material constraint

• Resource constraint

• Resource overloaded

• Supplier capacity overloaded

• Resource underloaded

• Batch was started with less than minimum capacity

• Batch was started with more than maximum capacity
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Transportation and distribution
• Transportation resource constraint

• Transportation resource's weight overloaded

• Transportation resource's volume overloaded

Shortages and excess
• Items with a shortage

• Items below safety stock

• Items with excess inventory

Reschedules
• Past due orders

• Orders to be rescheduled out

• Orders to be cancelled

• Orders to be rescheduled in

• Orders with compression days

• Orders scheduled to next inventory point

• Order is firmed late

• Requirement is firmed late

• Order is firmed early

• Requirement is firmed early

• Shared supply scheduled late

Substitutes and alternates used
• Planned order uses alternate BOM/routing

• Planned order uses substitute components

• Planned order uses alternate resources
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• Order sourced from alternate facility

• Order sourced from alternate supplier

• Demand satisfied using end item substitution

Projects/tasks 
• Items with a shortage in a project/task

• Items allocated across projects/tasks

• Items with excess inventory in a project/task

Item exception
• Items with negative starting on hand

• Items with expired lot

• Items with no activity

• Sourcing split percentage violated

Recommendations
• Batches

• Discrete jobs

• Flow schedules

• Jobs

• Purchase requisitions

Filtering Exception Messages
Use exception message filters to reduce the number of exception messages that the 
planning engine issues. By doing so, the planning engine spends less time and effort 
because it does not create exception messages that you don't want to see.

Without any filters the planning engine issues all exception messages under all 
circumstances.

Whether or not you use filters, you can use personal and public queries to limit what 
you see to only the exception messages that you want. However, if you have used 
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filters, you cannot enquire against exception message occurrences that you have filtered
out.

The filters that you can use are:

• Exception sets

• Exception groups

When you use exception sets:

• The planning engine issues all exception messages.

• It issues exception messages for items and resources that you have assigned to an 
exception set.

• You can tell it not to issue some occurrences of some exception messages; those that 
don't meet certain quantity or date thresholds. For example, you can tell it not to 
issue Items with excess quantity exception messages if the excess quantity is below 
3000 units or not to issue Items with a shortage exception message if the shortage 
occurs outside the planning time fence.

When you use exception groups:

• You can tell the planning engine not to issue certain exception messages.

• For the exception messages that you allow it to issue, you can tell it to only issue 
occurrences for certain organizations, certain item categories, or up to a certain 
number of days from the plan date.

You assign:

• Exception sets to items and resources

• Exception groups to plans

Exception Sets
Use planning exception sets in the source instance to specify sensitivity controls and 
exception time periods for exceptions.

The fields in the exception set are not item and resource attributes but they act as if they
are. Define as many planning exception sets as you need for your different types of 
items and resources (use the Planning Exception Sets form). Then, assign exception sets 
to items and resources.

The planning engine only issues exceptions against items and resources that have 
exception sets assigned to them.

Sensitivity controls control the quantity and percent thresholds for exception messages. 
For example, setting Excess Quantity to 3000 limits reporting of excess to situations in 
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which supply exceeds demand by 3000.

For the excess quantity, use a value of 1 or higher. If you use 0, the planning engine 
does not issue exception messages.

Exception time period types control the time period for exceptions. For example, setting
shortage exceptions to Planning time fence limits reporting of shortage to those 
situations in which the shortage is within the planning time fence.

Creating and Updating Exception Sets
Before creating and updating exception sets, study the exception messages. When the 
description of an exception message indicates that it is subject to exception set values, 
consider sensitivity controls and time periods that make sense for your business.

To create and update exception sets
1. Navigate to the Planning Exception Sets window.

2. Create or select a planning exception set name.

3. Enter sensitivity controls except User-Defined Time Fence (Days).

4. Select exception time period types.

If you selected User-defined time fence in any of the fields, specify the length of the 
time fence in days in User-Defined Time Fence (Days).

5. Save your work.

Assigning Planning Exception Sets
To assign a planning exception set to an item, navigate to the Items form, MPS/MRP
Planning attribute group, Exception Set field.

To assign a planning exception set to a resource:

• Navigate to the Departments form, click Resources, and view the Resources 
form

• Navigate to the Owned region, Planning tabbed region, Exception set field

Assigning Planning Exception Sets
To assign a planning exception set to an item, navigate to the Items form, MPS/MRP 
Planning attribute group, Exception Set field.

To assign a planning exception set to a resource:

• Navigate to the Departments form, click Resources, and view the Resources form

• Navigate to the Owned region, Planning tabbed region, Exception set field
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Exception Group
Use exception to tell the planning engine which exception messages to issue for you. 
You can also specify which:

• Organizations to issue them for

• Item categories to issue them for

• Time fence to issue them within

Oracle Value Chain Planning also uses the term exception group to mean a collection of 
exception messages with the same subject, for example, Late Sales Orders and Forecasts 
Exception Group. Those exception groups are not part of this filter called Exception 
Group.

To set up an exception group, attend to the:

• Header

• Exceptions tab

• Filter tab

In the header, give the exception group a name (field Exception Group Name).

In the Exceptions tab, put the names of the exception messages that you do want the 
planning engine to issue for you in the box Selected Exceptions. Put the names of the 
exception messages that you do not want the planning engine to issue for you in the 
box Available Exceptions. The exception message names are in each box in alphabetical 
order.

In the Filter tab

• Select the instance:organizations that you want the planning engine to issue 
exceptions for. Use column Organization and the + icon to add organizations to the 
list.

• Select the item categories that you want the planning engine to issue exception 
messages for their members. Use column Category and the + icon to add item 
categories to the list

• Enter a how many days out from the plan date that you want the planning engine 
to issue exception messages. Use field Exception Time Fence (Days). This applies to 
excess and shortage exceptions for items that do not have excess and shortage time 
fences in their exception sets. 

The filters only apply to exception messages that you have told the planning engine to 
issue. 



Supply Chain Plan Exception Messages    17-9

In the Filter tab, if you don't fill up any of the information for the:

• Instance/Organization: The planning engine issues exception messages for all 
instances/organizations that the plan plans.

• Item category: The planning engine issues exception messages for all members in all
item categories in all instances/organizations that the plan plans.

• Time fence: If you have exception sets, the planning engine issues exception 
messages according to the assigned exception sets. Otherwise, it issues exception 
messages for all days in the planning horizon.

You assign an exception group to a plan, see The Main Tabbed Region, page 5-38

Exception Set and Exception Group Interaction 
You can use both exception sets and exception groups.

If you run a plan with an exception group, the planning engine plans items and 
resources that have an exception set like this. It:

• Creates exceptions according to the exception group filters.

• Filters them according to the exception sets tolerances.

• Uses exception set Exception Time Periods instead of the exception group Exception
Time Fence.

Viewing Exceptions

Overview
View exception messages in the Planner Workbench. For more information, see 
'Overview of Planner Workbench, page 18-1.

To view exceptions
1. In the Navigator pane, choose a plan for which to view exception messages. You 

can view exception messages at the item level by selecting an item in the Items or 
Organization tree. 

2. In the right pane, navigate to the Actions tabbed region to access the Exception 
Summary window.

Exception Summary Window
The Exception Summary window displays summary exception message 
information:
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• Generated by the current planning run

• Saved from previous simulation runs

It displays the following information:

• Action Type: The exception group

• Version

• Count: The exception message count by exception group

The window orders the exception groups by their typical importance to 
troubleshooting; for example, late orders are more important than 
recommendations.

Using the Find window, you can sort, group, or subtotal exceptions according to 
various criteria, for example, item, supplier, and buyer.

Exception Summary Window
The Exception Summary window displays summary exception message information:

• Generated by the current planning run

• Saved from previous simulation runs

It displays the following information:

• Action Type: The exception group

• Version

• Count: The exception message count by exception group

The window orders the exception groups by their typical importance to 
troubleshooting; for example, late orders are more important than recommendations.

Using the Find window, you can sort, group, or subtotal exceptions according to 
various criteria, for example, item, supplier, and buyer. If you group by organization, 
item, planner code, resource, category, department, customer, or supplier, the results 
window displays their column headings. For other group by criteria, the results 
window displays a generic column heading, for example, Group By 1. 

To sort exceptions 
1. Navigate to the Exception Summary and select View > Find. 

The Find Actions window displays. 
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2. Select criteria by which to sort exceptions. 

3. Select Display Message Count. 

4. Click Find.

To view exception details
1. Navigate to the Exception Summary window and place the cursor over the 

exception group or the exception message.

2. Double click on the entity to access the Exception Details window. 

Exception Details Window
The Exception Details window displays information about each exception. If you select 
one exception type, the window displays information in a folder for that exception type.
If you select multiple exception types, the window displays the generic default folder.

Days Late applies to the Late replenishment for forecast and Late replenishment for 
sales order exception messages.

Quantity Satisfied By Due Date is the portion of a demand that can be satisfied by the 
due date.

Buttons
On the Exception Details window, you can obtain additional information about certain 
exceptions by clicking buttons on the bottom. The buttons that appear are unique to the 
exception.

Right Mouse Options
From the Exception Details window, you can obtain additional information by 
right-clicking on the exception. The choices in the pop-up menu are unique to the 
exception. Some choices are:

• Supply

• Demand

• Resource Availability

• Resource Requirements

• Sources

• Destinations
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• Related Exceptions

• Gantt Chart

• Horizontal Plan

• Vertical Plan

• End Item Supplies

• End Pegged Supplies

• Critical Activities

Related Exceptions
If you are working in a constrained or optimized plan, you can use the right mouse 
option Related Exceptions to obtain further cause and effect information, for example:

• Is an order late because of a resource, material, or transportation resource 
constraint.

• Does a material, resource, or transportation resource issue cause late orders?

From a resource, material, or transportation resource constraint exception message, you 
drill down to Late replenishment for sales order and Late replenishment for forecast 
exception messages that the constraint affects.

Exception Message Filters
Use exception message filters to view only the exception messages that you want to. 
You can create and save queries that specify certain exception messages and certain 
criteria. When you execute this query, the planning engine displays the exception 
messages that meet your criteria.

For example, you may want to view the Late replenishment for sales order and Late 
replenishment for forecast exception messages if the shipment of item A from 
organization M1 is delayed by more than two days.

You can filter on exception messages issued both by Oracle Advanced Supply Chain 
Planning and Oracle Collaborative Planning.

To filter exception messages
1. In the Planner Workbench, click the Queries tabbed region.

2. In Plan, select the plan that you want to query.

3. To create a query for you to use (personal query), right-click Personal Queries and 
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select Create Query. To create a query for you and others to use (public query), 
right-click Public Queries and select Create Query.

You can also right-click Personal Queries or Public Queries and then click the 
Create Query icon.

4. In the Create Query window:

Specify the Query Name.

In Query Type, select Exceptions. You can use the other choices to create queries 
that filter item, resource, and supplier information.

If the query is personal and you want to make it public, in Public, select Yes. If the 
query is public and you want to make it personal, in Public, select No. 

5. In the Exceptions region, select the exception messages that you want to view.

You can filter on most but not all planning engine exception messages. To include 
Oracle Collaborative Planning exception messages, set profile option MSC: 
Configuration to APS + CP.

The query results display the exception messages in the order that they appear in 
this region. If you want to change the order of the exception messages, use the 
arrows on the right of the region to rearrange them.

6. For some exception messages, you can specify selection criteria. The query selects 
occurrences of the exception message that match the criteria.

If you want the query to display its results grouped by criteria, select Group By for 
those criteria. For example, you group the exception message Late replenishment 
from supplier by supplier. Your query displays the number of Late replenishment 
from supplier exception messages against each supplier.

To clear the criteria and start over, click Clear.

7. To save the query, click Save or Save as.

To delete existing saved query criteria, click Delete.

8. Click Execute. The query results appear in the right pane.

To view the results of a previously executed query, in Executed Query, select its 
name.

To re-execute a saved query, search for it in the left pane under Personal Queries 
and Public Queries.

9. To view exception details, right-click the exception message and select Exceptions 
All, Exception Action Taken, or Exception No Action Taken. The Exception Details 
window appears.

To research Oracle Collaborative Planning exception messages, click More Details. 
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To research planning engine exceptions, click the remaining buttons.

Understanding Exceptions
This section explains:

• The circumstances under which the planning engine issues each exception message

• Where appropriate, the calculation of key attributes of the exception message 

• Where appropriate, a scenario illustrating the exception message

• The information shown for each exception message 

• Resolution suggestions for the exception message

The exception message explanations for Constrained - Enforce Due Dates and 
Constrained - Enforce Capacity Constraints plans assume that both plan options 
Material Constraints and Capacity Constraints are selected. Note the behavior of 
constrained and optimized plans that have either or both options cleared:

• Resource or material capacity does not cause late orders.

• Lead time still can cause a late order.

• The planning engine still reports resource and material capacity overloads.

Late Sales Orders and Forecasts Exception Group
This table shows the exceptions in this exception group and states whether the planning
engine issues the exception for each plan type.

Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand 
Dates

Available In 
Constrained 
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimized
Plans

Available In 
Inventory 
Optimization

1: Sales 
order/forec
ast at risk

Yes Yes Yes Yes Yes

2: Past due 
sales orders

Yes Yes Yes Yes Yes
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Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand 
Dates

Available In 
Constrained 
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimized
Plans

Available In 
Inventory 
Optimization

3: Past due 
forecast

Yes Yes Yes Yes Yes

4: Late 
replenishm
ent for 
sales order

No Yes Yes Yes No

5: Late 
replenishm
ent for 
forecast

No Yes Yes Yes No

6: Early 
replenishm
ent for 
sales order

No Yes Yes Yes No

7: Early 
replenishm
ent for 
forecast

No Yes Yes Yes No

8: Late 
Replenish
ment for 
MPP/MPS 
Demands

No Yes Yes Yes No

9: Changes 
recommen
ded for 
sales orders

No Yes Yes Yes Yes

1: Sales order/forecast at risk
Explanation
This exception message appears when demands are at risk. A demand is at risk when it 
is pegged to a supply order against which the planning engine has issued certain 
exception messages. These certain exception messages are in the Supply Problems for 
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Late Sales Orders and Forecasts exception group and you can use them for further 
information about the sales order or forecast at risk:

• Sales order/forecast at risk due to resource shortage

• Sales order/forecast at risk due to material shortage

• Requirement causes resource overload

• Order causes supplier capacity overload

• Order causes transportation weight capacity overload

• Order causes transportation volume capacity overload

• Order with insufficient lead time

• Requirement with insufficient lead time

• Order lead time constraint

• Requirement lead time constraint

• Demand quantity not satisfied 

• Late supply pegged to forecast

• Late supply pegged to sales order

Information Displayed
The information displayed for this exception message all refers to the demand line and 
is:

• Order Number

• End Item

• End Item Org

• End Item Description

• Order Due Date

• Order Quantity

• Customer

• Customer Site
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• Demand Class

Resolution Suggestions
Check for more details from related exceptions in the Supply Problems for Late Sales 
Orders and Forecasts exception group.

2: Past due sales orders
Explanation
This exception message appears for past due sales order lines. A past due sales order 
line is a sales order line with a schedule date earlier than the plan horizon start date.

Information Displayed
The information displayed for this exception message is:

• Organization: The sales order line warehouse

• Item

• Order Number

• Old Date: The sales order line schedule date

• Date: The sales order line schedule date

• Quantity

Resolution Suggestions
Consider revising the sales order line schedule date.

3: Past due forecast 
Explanation
This exception message appears for late forecast entries. A late forecast entry is a 
forecast entry with a date earlier than the plan horizon start date. The planning engine 
issues this message even if the forecast is totally consumed.

Information Displayed
The information displayed for this exception message is: 

• Organization

• Item

• Order Number: The forecast entry line number

• Old Date: The forecast entry due date

• Date: The forecast entry due date

• Quantity: The forecast entry netted quantity
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Resolution Suggestions
Consider:

• Deleting the entry from the forecast

• Revising the forecast due date

4: Late replenishment for sales order
Explanation
This exception message appears in a constrained plan when the planning engine detects
that the supplies for a sales order line are due later than the sales order line.

The demand satisfied date is the latest due date of the supplies pegged directly to an 
end demand. The planning engine issues this exception message against a sales order 
line when its demand satisfied date is later than its schedule date.

This exception usually occurs because of a material constraint, resource constraint, or 
planning time fence. It often occurs in Constrained - Enforce capacity constraint plans 
when the planning engine needs to move supply order due dates to honor capacity 
constraints.

For example, there is a sales order line on item A due 25 January for quantity 100 in 
organization D2

The supplies pegged to this sales order line are:

• Supply 1: Quantity 50 and due date 23 January

• Supply 2: Quantity 20 and due date 25 January

• Supply : Quantity 30 and due date 27 January

Demand satisfied date is 27 January (from Supply 3).

Days late is 2.

Quantity satisfied by sales order line schedule date is 70 (from Supply 1 and Supply 2).

Information Displayed
The information displayed for this exception message is:

• Org: Sales order line warehouse

• End Item: For the sales order line

• Quantity: For the sales order line

• Order Number: For the sales order line

• Priority: For the sales order line

• Customer
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• Customer Site

• Demand Date: Sales order line schedule date

• Demand Satisfied Date

• Days Late: Demand Satisfied Date - Demand Date

• Quantity Satisfied by Due Date: The quantity of on time and early supply orders 
pegged directly to the sales order line. This appears if you set profile option MSO: 
Allow Partial Demand Completion to All End Demands or to Sales Orders.

Resolution Suggestions
In the Planner Workbench, Exception Details window, sort the orders by your priority, 
for example, days late or demand priority.

For each exception, right click on it, select Related Exceptions, and view the constraint.

See 'Identifying Root Causes of Late Demand, page 17-121for more information.

Consider:

• Revising demand priority rules

• Revising the sales order line demand priority

• Expediting the supply order

• Revising the sales order line schedule date or forecast entry date

5: Late replenishment for forecast
Explanation
This exception message appears in a constrained plan when the planning engine detects
that the supplies for a forecast entry are due later than the forecast entry.

The demand satisfied date is the latest due date of the supplies pegged directly to an 
end demand. The planning engine issues this exception message against a forecast entry
when its demand satisfied date is later than its schedule date.

This exception usually occurs because of a material constraint, resource constraint, or 
planning time fence. It often occurs in Constrained - Enforce capacity constraint plans 
when the planning engine needs to move supply order due dates to honor capacity 
constraints.

For example, there is a forecast entry on item A due 25 January for quantity 100 in 
organization D2.

The supplies pegged to this forecast entry are:

• Supply 1: Quantity 50 and due date 23 January
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• Supply 2: Quantity 20 and due date 25 January

• Supply : Quantity 30 and due date 27 January

Demand satisfied date is 27 January (from Supply 3).

Days late is 2.

Quantity satisfied by forecast entry due date is 70 (from Supply 1 and Supply 2).

Information Displayed
The information displayed for this exception message is:

• Org: For the forecast entry

• End Item: For the forecast entry

• Quantity: Unconsumed quantity for the forecast entry

• Order Number: Forecast entry line number

• Priority: For the forecast entry

• Customer

• Customer Site

• Demand Date: Forecast entry date

• Demand Satisfied Date

• Days Late: Demand Satisfied Date - Demand Date

• Quantity Satisfied by Due Date: The quantity of on time and early supply orders 
pegged to the forecast. This appears if you set profile option MSO: Allow Partial 
Demand Completion to All End Demands or to Sales Orders.

Resolution Suggestions
See 4: Late replenishment for sales order resolution suggestions in this topic.

6: Early replenishment for sales order
Explanation
This exception message appears in a constrained plan when the planning engine detects
that the supplies for a sales order line are due earlier than the sales order line.

The demand satisfied date is the latest due date of the supplies pegged directly to an 
end demand. The planning engine issues this exception message against a sales order 
line when its demand satisfied date is earlier than its schedule date.

The planning engine issues the message even if it plans the supply earlier due to 
constraints.
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For example, there is a sales order line on item A due 25 January for quantity 100 in 
organization D2.

The supplies pegged to this sales order line are:

• Supply 1: Quantity 50 and due date 19 January

• Supply 2: Quantity 20 and due date 21 January

• Supply 3: Quantity 30 and due date 23 January

Demand satisfied date is 23 January (from Supply 3).

Information Displayed
The information displayed for this exception message is:

• Org: Sales order line warehouse

• End Item: For the sales order line

• Quantity: For the sales order line

• Order Number: For the sales order line

• Priority: For the sales order line

• Customer

• Customer Site

• Demand Date: Sales order line schedule date

• Demand Satisfied Date

• Item Description

Resolution Suggestions
If you are implementing Just-In-Time scheduling, use this exception to help minimize 
inventory carrying cost by identifying causes of early replenishment, for example:

• Organization receiving calendar restrictions: For example, supplier delivers once a 
week.

• Resource load levelling

• Firm supplies

7: Early replenishment for forecast
Explanation
This exception message appears in a constrained plan when the planning engine detects
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that the supplies for a forecast entry are due earlier than the forecast entry.

The demand satisfied date is the latest due date of the supplies pegged directly to an 
end demand. The planning engine issues this exception message against a forecast entry
when its demand satisfied date is earlier than its schedule date.

The planning engine issues the message even if it plans the supply earlier due to 
constraints.

For example, there is a forecast entry on item A due 25 January for quantity 100 in 
organization D2.

The supplies pegged to this forecast entry are:

• Supply 1: Quantity 50 and due date 19 January

• Supply 2: Quantity 20 and due date 21 January

• Supply 3: Quantity 30 and due date 23 January

Demand satisfied date is 23 January (from Supply 3).

Information Displayed
The information displayed for this exception message is:

• Org: Forecast entry organization

• End Item: For the forecast entry

• Quantity: For the forecast entry

• Order Number: Forecast entry line number

• Priority: For the forecast entry

• Customer

• Customer Site

• Demand Date: Forecast entry date

• Demand Satisfied Date

• Item Description

• Demand Class

Resolution Suggestions
See 4: Early replenishment for sales order resolution suggestions in this topic.
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8: Late replenishment for MPP/MPS demands
Explanation
The Late Replenishment for MPP/MPS Demands exception is generated when the MRP 
detects that the supply is going to miss the required dependent demand due date.

It alerts MRP users when supplies are going to miss due dates driven by the MPS or 
MPP.

Information Displayed
The information displayed for this exception message is:

• Order Number

• Item

• Org

• Due Date

• Quantity

Resolution Suggestion
Review the Days Late on this exception. You can opt to:

• Ignore it if the Days Late is not significant

• Pull in the supply that is feeding the firmed MPP/MPS supply and resolve the 
lateness. In order to do this, you may need to add a resource or supplier capacity to 
make the pull in of this supply a feasible action.

• Push out the MPP/MPS supply to a later date in the MPP/MPS plan. In the next run 
of this plan (the MRP Plan), the demand will appear at a later date and will be 
satisfied on time.

9: Changes recommended for sales orders
Explanation
This exception message is generated each time there is a change in the following 
entities:

• Source Organization

• Material availability date

• Schedule arrival date

• Ship method

You can double click on the sales order recommendation provided in the Exception 
Summary window to open the Demand window for sales order lines with release 
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recommendations.

You can right click from the exception and select the following:

• Demand

• Supply/Demand

Information Displayed
The information displayed for this exception message is:

• Item

• Description

• Sales order number with reference to line number

• Customer/customer site

• Old source organization

• New source organization

• Old schedule date (Suggested due date)

• New schedule date (Demand satisfied date)

• Old schedule arrival date

• New schedule arrival date

• ATP override flag

• Latest acceptable days

• Request ship date

• Request arrival date

• Promise ship date

• Promise arrival date

Resolution Suggestion
Release recommendations to execution system.

Supply Problems for Late Sales Orders and Forecasts Exception Group
This table shows the exceptions in this exception group and states whether the planning
engine issues the exception for each plan type.
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Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand Dates

Available In 
Constrained
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimized 
Plans

Available In 
Inventory 
Optimization

1: Sales 
order/forec
ast at risk 
due to 
resource 
shortage

Yes No No No No

2: Sales 
order/forec
ast at risk 
due to 
material 
shortage

Yes No No No No

3: 
Requireme
nt causes 
resource 
overload

No Yes Yes Yes No

4: Order 
causes 
supplier 
capacity 
overload

No Yes Yes Yes No

5: Order 
causes 
transportat
ion weight 
capacity 
overload

No Yes Yes Yes No

6: Order 
causes 
transportat
ion volume
capacity 
overload

No Yes Yes Yes No
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Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand Dates

Available In 
Constrained
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimized 
Plans

Available In 
Inventory 
Optimization

7: Order 
with 
insufficient
lead time

No Yes Yes Yes No

8: 
Requireme
nt with 
insufficient
lead time

No Yes Yes Yes No

9: Order 
lead time 
constraint

No Yes Yes Yes No

10: 
Requireme
nt lead 
time 
constraint

No Yes Yes Yes No

11: 
Demand 
quantity 
not 
satisfied

No Yes Yes Yes No

12: Late 
supply 
pegged to 
forecast

Yes Yes Yes Yes Yes

13: Late 
supply 
pegged to 
sales order

Yes Yes Yes Yes Yes
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Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand Dates

Available In 
Constrained
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimized 
Plans

Available In 
Inventory 
Optimization

14: Order 
violates a 
business 
calendar

Yes Yes Yes Yes Yes

1: Sales order/forecast at risk due to resource shortage
Explanation
This exception message appears when the scheduled resource capacity in a planning 
time bucket is overloaded and indicates that end demands may be at risk due to a 
resource capacity shortage. The planning engine looks at all make supplies within the 
bucket (according to their operation schedules), finds their end orders and issues this 
exception message against those end orders.

For example, there is a sales order on Item A for quantity 100 due on 17 January.

An unconstrained plan creates supply to satisfy this demand using lead-times and 
applying order modifiers. The planned order is on Item B which has a resource 
requirement on resource R1 for 10 hours on 10-January.

On 10-January, the cumulative available capacity for resource R1 is 1000 hours and the 
required capacity is 1200 hours (which includes this resource requirement as well as 
resource requirements from other supplies pegged to end demands). The planning 
engine issues a Resource overloaded exception message.

The planning engine issues this Order at risk due to resource shortage for the sales 
order due on 17 January as well as each of the other end demands pegged to resource 
R1 on 10 January.

Information Displayed
The information displayed for this exception message is:

• Organization: The supply organization

• Resource

• Dept/Line

• From Date: The start date of the resource overload

• To-Date: The end date of the resource overload
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• End Order Number: For the end demand

Some of the information fields for this exception message could be blank; this is normal 
behavior.

Resolution Suggestions
Consider:

• Adjusting the top level independent demand date

• Increasing resource availability:

• Hours available

• Resource units assigned to the operation

• Work and non-work days

• Using an alternate resource: Change the resource in the supply order routing.

• Using an alternate routing for this item

• Modifying the sourcing rules

• Subcontracting

• Using substitute items: Change the supply order bill of material.

• Change shift pattern

• Add capacity: For example, additional workday.

• Levelling the resource

2: Sales order/forecast at risk due to material shortage
Explanation
This exception message appears when the scheduled supplier capacity in a planning 
time bucket is overloaded and indicates that an end demand is at risk due to a material 
shortage. The planning engine looks at all buy supplies within the bucket (according to 
their dock dates), finds their end orders and issues this exception message against those 
end orders.

For example, there is a sales order on Item A for quantity 100 due on 17 January.

An unconstrained plan creates supply to satisfy this demand using lead-times and 
applying order modifiers. The planned order is on Item C, dock date 10-January, 
quantity 150, and supplier SUPP1.

On 10 January, the cumulative available capacity for SUPP1/Item C is 1000 units and the
required capacity is 1200 units (which includes this supply as well as other supplies 
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pegged to end demands). The planning engine issues a Supplier capacity overloaded 
exception message.

The planning engine issues this Order at risk due to material shortage for the sales 
order due on 17 January as well as each of the other end demands pegged to 
SUPP1/Item C on 10 January.

Information Displayed
View this exception message from Planner Workbench tree Suppliers.

The information displayed for this exception message is:

• Organization: The supply organization

• Item: The item with the material shortage 

• Date: The end demand due date

• End Order Number: The end demand order number

• Supplier

• Supplier Site

Some of the information fields for this exception message could be blank; this is normal 
behavior.

Resolution Suggestions
Consider:

• Adjusting the sales order schedule date

• Adjusting the supplier capacity: In the Planner Workbench left pane, right-click 
Supplier and select Supplier Capacity.

• Using an alternate supplier: Change the supplier in the sourcing rule

• Using a substitute item: Change the supply order bill of material

• Increasing the supplier flexfence capacity tolerance percentage

• Changing end order quantity

• Modifying the sourcing rule: For example, sourcing percentage

• Producing the supply order yourself

3: Requirement causes resource overload
Explanation
This exception message appears when, during scheduling a make order, the planning 
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engine detects a resource requirement that causes a resource capacity overload.

This exception message also appears when the setting for the profile option MSO: 
Maximize Search of Availability Intervals is incorrect. For more details, see 'MSO Profile
Options, page A-83.

When an operation fails scheduling, the planning engine uses profile options MSO: Pull
push base and MSO: Pull push offset to determine the time by which it pulls or pushes 
the operation when attempting to reschedule. If the planning engine is scheduling:

• Backwards, it is the time backwards (pulling delay)

• Forwards, it is the time forwards (pushing delay) 

MSO: Pull push base is the numerical base by which the offset is multiplied to get each 
delay (it has no unit of measure and the default is 1)

MSO: Pull push offset is the numerical offset (it is in minutes and the default is 1440)

The delay is calculated by i * base (i-1) * offset where i is the rescheduling attempt that it
is calculating. For example, with backward scheduling and the default values, the 
pulling delays are:

• Delay for first rescheduling attempt: 24 hours earlier [1 * 1 * 1440 = 1440 / 60]

• Delay for second rescheduling attempt: 48 hours earlier [1 * 2 * 1440 = 2880 / 60]

• Delay for third rescheduling attempt: 72 hours earlier [1 * 3 * 1440= 4320 / 60]

Information Displayed
The information displayed for this exception message is:

• Supply Order Number: The order number that contains the overloading resource 
requirement.

• Order Type

• Item

• Item Description

• Start Date: The start date of the time bucket in which the overloading activity falls.

• End Date: The end date of the time bucket in which the overloading activity falls.

• Resource Requirements: The required capacity of the overloading activity within 
the time bucket.

• Resource Overload: The amount by which the resource capacity in the time bucket 
is overloaded after scheduling the overloading requirement.
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• Resource Name

• Organization

• Department

• Resource Sequence Number: In the routing.

• Operation Sequence Number: In the routing.

• Resource Capacity: The resource available capacity in the bucket before scheduling 
of the overloading requirement.

• Cause: This contains the cause of the overload. This attribute is only populated 
when this exception is generated in Enforce Capacity Constraints plans. Valid 
values are:

• Exceeded maximum number of attempts to schedule: This means that the 
planning engine tried for the specified number of attempts set in MSO: 
Maximum Number of Pushes for Operation. If all the attempts to schedule 
proved to be unsuccessful, it goes back to the time slot corresponding to the 
first attempt to schedule, and schedules the activity there with an overload on 
the resource. Each time the planning engine is required to search for a new spot 
to schedule, it looks ahead by a certain time period that is dictated by the 
settings of the profile MSO: Push Pull Base and MSO: Push Pull Offset.

Each unit or bucket in the number of attempts made is determined by using the 
following formula:

Time Window = N * a*b^N

Where:

N = A value incremented from 1 to MAX in increments of 1 where MAX is the 
value set in the profile MSO:Max Num of Pushes for Operation.

a = the value set in the profile MSO: Push Pull Offset; measured in minutesa = 
the value set in the profile MSO: Push Pull Offset; measured in minutes

b = the value set in the profile MSO: Push Pull Base; default is 1. The planning 
engine searches in intervals of time that increase in a linear fashion.

• Firm Resource Requirement: If a resource requirement's start/end are firmed, 
the planning engine is forced to schedule this requirement at the user specified 
time. This can sometimes cause an overload if this requirement has been firmed
at a time where there is no capacity available on the resource. In such cases, the 
cause column indicates this condition.

• Pegged to Firm Resource Requirement / Supply: A resource requirement is 
forced to be scheduled at a certain time because it pegs to another firm order or 
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a resource requirement. This can severely restrict the planning engine's span of 
search for available capacity to schedule this resource requirement and force an 
overload.

Resolution Suggestions
Consider:

• Checking and evaluating the end demand information 

• Collecting and evaluating available options regarding increasing available capacity 
or decreasing required capacity

• Selecting and implementing options. 

4: Order causes supplier capacity overload
Explanation
This exception message appears when, during scheduling a buy order, the planning 
engine detects an order that causes a supplier capacity overload.

Information Displayed
View this exception message from Planner Workbench tree Suppliers.

The information displayed for this exception message is:

• Bucket Start Date: The start date of the time bucket in which the overloading order 
falls.

• Item

• Item Description

• Organization

• Due Date

• Dock Date

• Required Supplier Capacity: The required capacity of the overloading order within 
the time bucket.

• Supplier Capacity Overload: The amount by which the cumulative available 
supplier capacity is overloaded after scheduling the overloading order.

• Supplier Name

• Supplier Site

• Cumulative Available Capacity: The cumulative available supplier capacity before 
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scheduling the overloading order.

Resolution Suggestions
Consider:

• Checking and evaluating the end demand information 

• Collecting and evaluating available options regarding increasing available capacity 
or decreasing required capacity

• Selecting and implementing options. 

5: Order causes transportation weight capacity overload
Explanation
This exception message appears when, during scheduling a transfer order, the planning
engine detects a transportation weight capacity overload.

Information Displayed
The information displayed for this exception message is:

• Item

• Order Number

• Bucket Start Date: The start date of the time bucket in which the overloading 
shipment falls.

• Supply Order Number

• Order Type

• Item

• Item Description

• Ship Date

• Shipment Weight

• Shipment Weight UOM

• Weight Capacity overload: The amount by which this shipment causes the available
weight capacity to be overloaded.

• Ship Method

• Source Org

• Destination Org
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• Available Weight Capacity/Day: The available weight capacity on Ship Date before 
scheduling of the overloading shipment.

Resolution Suggestions
Consider:

• Checking and evaluating the end demand information 

• Collecting and evaluating available options regarding increasing available capacity 
or decreasing required capacity

• Selecting and implementing options. 

6: Order causes transportation volume capacity overload
Explanation
This exception message appears when, during scheduling a transfer order, the planning
engine detects a transportation volume capacity overload.

Information Displayed
The information displayed for this exception message is:

• Bucket Start Date: The start date of the time bucket in which the overloading 
shipment falls.

• Supply Order Number

• Order Type

• Item

• Item Description

• Ship Date

• Shipment Weight

• Shipment Weight UOM

• Weight Capacity overload The amount by which this shipment causes the available 
volume capacity to be overloaded

• Ship Method

• Source Org

• Destination Org

• Available Weight Capacity/Day: The available volume capacity on Ship Date before
scheduling of the overloading shipment.



Supply Chain Plan Exception Messages    17-35

Resolution Suggestions
Consider:

• Checking and evaluating the end demand information 

• Collecting and evaluating available options regarding increasing available capacity 
or decreasing required capacity

• Selecting and implementing options. 

7: Order with insufficient lead time
Explanation
This exception message appears when the planning engine schedules a supply order 
within a window whose size is less than the minimum duration of the supply order.

The planning engine issues this message if either of the following situations exist:

• Constrained Plan - Enforce Due Date and Optimized Plan - Enforce Due Date: 
Profile option MSO: Lead Time Control is to Violate minimum processing time to 
meet demand due date and there is not enough lead-time to meet the demand.

• Constrained Plan - Enforce Due Date, Optimized Plan - Enforce Due Date, 
Constrained Plan - Enforce Capacity Constraints, and Optimized Plan - Enforce 
Capacity Constraints: A supply is firmed early and the upstream orders need to be 
compressed.

Information Displayed
The information displayed for this exception message is:

• Supply Order Number: The order number of the order with insufficient lead-time

• Item

• Organization

• Order Type

• Supplier: For buy orders.

• Supplier Site: For buy orders.

• Source Org: For transfer orders.

• Ship Method: For transfer orders.

• Order Start Time: For make orders, the start time; for buy orders, the dock date; and
for transfer orders, the ship date.

• Order Completion Time: The due date.
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• Minimum Lead Time: The minimum lead-time Required to avoid the compression.

• Actual Lead Time: Order Completion Time - Order Start Time. This represents the 
compressed duration as seen in the plan output.

• Minimum Start Time: The minimum start time of this supply order.

Resolution Suggestions
Consider:

• That the supply may be behind schedule

• Checking and evaluating the end demand information 

• Either expediting work on the supply or adjusting the demand due date

8: Requirement with insufficient lead time
Explanation
This exception message appears when the planning engine schedules a resource 
requirement in either of these ways: 

• Within a window whose size is less than the minimum duration of the resource 
requirement.

• To start earlier than the earliest start time of its operation according to the planning 
time fence and other upstream precedence constraints

The planning engine issues this message if either of the following situations exist:

• Constrained Plan - Enforce Due Date and Optimized Plan - Enforce Due Date: 
Profile option MSO: Lead Time Control is to Violate minimum processing time to 
meet demand due date and there is not enough lead-time to meet the demand.

• Constrained Plan - Enforce Due Date, Optimized Plan - Enforce Due Date, 
Constrained Plan - Enforce Capacity Constraints, and Optimized Plan - Enforce 
Capacity Constraints: A supply is firmed early and the upstream requirements need
to be compressed.

Information Displayed
The information displayed for this exception message is:

• Supply Order Number: The order number of the supply order that contains this 
resource requirement with insufficient lead-time.

• Item

• Organization

• Order Type
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• Op-Seq: Operation sequence in the routing.

• Res-Seq: Resource sequence in the routing.

• Department: The department of the resource that contains this resource 
requirement

• Resource: The resource that contains this resource requirement.

• Start Time: Of the resource requirement.

• Completion Time: Of the resource requirement.

• Minimum Lead Time: Based on the maximum assigned units in the routing.

• Actual Lead Time: Completion Time - Start Time. Represents the compressed 
duration of this resource requirement

• Minimum Start Time: Of the Resource Requirement.

Resolution Suggestions
Consider:

• That the supply may be behind schedule

• Checking and evaluating the end demand information 

• Either expediting work on the supply or adjusting the demand due date

9: Order lead time constraint
Explanation
This exception is generated in Enforce Capacity Constraints plans. It is generated when 
the lead-time of an order is the cause for a demand being satisfied late. The exception 
specifies the minimum lead-time required for the order as well as the actual lead-time 
that is available if the demand is to be satisfied on time. The actual lead-time will be less
than the minimum lead-time indicating that a lead-time compression is required to 
meet the demand on time. Since, this is an Enforce Capacity Constraints plan, Oracle 
Advanced Supply Chain Planning will not actually compress the lead-time. Instead, it 
will satisfy the demand late and issue the Order Lead Time Constraint exception. This 
exception is generated for make orders without a routing, buy orders and transfer 
orders.

The planning engine:

• Issues this exception if profile option MSO: Calculate Constraint Exceptions is Yes

• Does not issue this exception message if the plan planning mode is Constrained 
(Without Detailed Scheduling)
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Information Displayed
The information displayed for this exception message is: 

• Supply Order Number: This is the order number of the supply that has the 
lead-time constraint.

• Item

• Organization

• Order Type

• Due Date

• Supplier: For buy supplies.

• Supplier Site: For buy supplies.

• Source Org: For transfer supplies.

• Ship Method: For transfer supplies.

• Required Start Time: For make orders, the start time; for buy orders, the dock date; 
and for transfer orders, the ship date.

• Required Completion Time: The due date.

• Minimum Lead Time: The minimum lead-time for this order.

• Actual Lead Time: Required Completion Time - Required Start Time.

• Minimum Start Time: The earliest time that this order can start.

Resolution Suggestions
Consider:

• That the supply may be behind schedule

• Checking and evaluating the end demand information 

• Either expediting work on the supply or adjusting the demand due date

10: Requirement lead time constraint
Explanation
This exception is generated in Enforce Capacity Constraints plans. It is generated when 
the lead-time of a resource requirement is the cause for a demand being satisfied late. 
The exception specifies the minimum lead-time required for the resource requirement 
as well as the actual lead-time that is available if the demand is to be satisfied on time. 
The actual lead-time represents the processing time as dictated by the usage specified in



Supply Chain Plan Exception Messages    17-39

the routing definition. The actual lead-time will be less than the minimum lead-time 
indicating that a lead-time compression is required to meet the demand on time. Since, 
this is an Enforce Capacity Constraints plan, Oracle Advanced Supply Chain Planning 
will not actually compress the lead-time. Instead, it will satisfy the demand late and 
issue the Requirement Lead Time Constraint exception. This exception is generated for 
Resource Requirements for Make Orders with Routings specified.

The planning engine issues this exception if profile option MSO: Calculate Constraint 
Exceptions is Yes.

Information Displayed
The information displayed for this exception message is:

• Supply Order Number: The supply order that contains this resource requirement.

• Item

• Organization

• Order Type

• Op-Seq: Operation sequence in the routing.

• Res-Seq: Resource sequence in the routing.

• Department: The Department of the resource that is on the resource requirement.

• Resource: The resource that contains this resource requirement.

• Required Start Time: Of the resource requirement so as to meet the demand on 
time.

• Required Completion Time: Of the resource requirement so as to meet the demand 
on time.

• Minimum Lead Time: Based on the maximum assigned units in the routing.

• Actual Lead Time: Required Completion Time - Required Start Time

• Minimum Start Time: Of the resource requirement.

• Start Date: The planned start date of the resource requirement.

• End Date: The planned completion date of the resource requirement.

Resolution Suggestions
Consider:

• That the supply may be behind schedule
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• Checking and evaluating the end demand information 

• Either expediting work on the supply or adjusting the demand due date

11: Demand quantity not satisfied
Explanation
This exception message appears when the planning engine finds any demand pegged to
supplies and the supply quantities are less than the demand quantity. The planning 
engine issues this exception message for demands at all levels of the supply chain bill of
materials.

Information Displayed
The information displayed for this exception message is:

• Item: On the supply.

• Item Description

• Order Number

• Organization

• Demand Quantity

• Demand Order Type

• Due Date

• Demand Class

• Customer

• Customer site

• Quantity Mismatch: Demand quantity - Total pegged supply quantity

Resolution Suggestions
Consider:

• Checking and evaluating the end demand information 

• Finding other sources of supply for the demand or adjusting the demand due date

12: Late supply pegged to forecast
Explanation
This message appears when a supply due date is later than the demand due date to 
which it is pegged; the demand can be independent demand or dependent demand 
(which will eventually peg to a forecast). This usually occurs because of lead-times and 
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time fences.

Refer to the example for the Late supply pegged to sales order exception message, the 
planning engine issues this Late supply pegged to forecast exception message in bucket 
15 against the planned order pegged to the dependent demand and forecast in bucket 
12.

Information Displayed
The information displayed for this exception message is:

• Organization: For the supply order

• End Item: Forecast entry item

• Quantity: For the supply order

• Order Number: The forecast entry line number

• Priority

• Customer

• Customer Site

• Due Date: For the supply order

• Demand Date: The demand due date

• End Demand Date: The forecast entry due date

• Days Late: Due Date - Demand Date. This calculation uses calendar days rather 
than manufacturing calendar working days. 

Resolution Suggestions
Consider:

• Expediting the late supply 

• Adjusting the forecast entry date

13: Late supply pegged to sales order
Explanation
This message appears when a supply due date is later than the demand due date to 
which it is pegged; the demand can be independent demand or dependent demand 
(which will eventually peg to a sales order). This usually occurs because of time fences.

For example, there are forecasts at organization D1 on item A for quantity 50 on day 7 
and quantity 30 on day 12.

Organizations D1 and M1 have two days transit time between them.
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The planning engine creates dependent demand at organization M1 on item A for 
quantity 50 on day 7 and quantity 30 on day 12.

There are sales orders at organization M1 on Item A for quantity 50 on day 9 and 
quantity 30 on day 14.

Total demand at organization M1 on Item A is 160.

There is a discrete job at organization M1 on Item A for quantity 100 on day 5.

Because of lead-times and time fences, the first day available to create a planned order 
at organization M1 on Item A is day 15.

The planning engine creates a planned order at organization M1 on Item A for quantity 
60 on day 15 and pegs it to the:

• Dependent demand on day 12

• Sales order on day 12

The planning engine issues a Late supply pegged to sales order exception message 
with:

• Due date of Day 15 (supply order)

• Demand date of Day 12 (sales order)

• End demand date of Day 12 (sales order)

• Days late of 3 (Day 15 - Day 12)

The planning engine issues a Late supply pegged to forecast exception message with:

• Due date of Day 15 (supply order)

• Demand date of Day 12 (dependent demand)

• End demand date of Day 14 (forecast)

• Days late of 3 (Day 15 - Day 12)

Schedule 
Entity

1 ... 5 6 7 8 9 10 11 12 13 14 15

Org D1: 
Forecasts

- - - - - - 50 - - - - 30 -

Org M1: 
Dependent 
demand

- - - - 50 - - - - 30 - - -
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Schedule 
Entity

1 ... 5 6 7 8 9 10 11 12 13 14 15

Org M1: 
Sales orders

- - - - 50 - - - - 30 - - -

Org M1: 
Supply 
orders

-   100 - - - - - - - - - -

Org M1: 
Planned 
orders

- - - - - - - - - - - - 60

Information Displayed 
The information displayed for this exception message is:

• Organization: For the supply order

• End Item: Sales order line item

• Quantity: For the supply order

• Order Number: For the sales order

• Priority

• Customer

• Customer Site

• Due Date: For the supply order

• Demand Date: The demand due date

• End Demand Date: The sales order line due date

• Days Late: Due Date - Demand Date. This calculation uses calendar days rather 
than manufacturing calendar working days.

Resolution Suggestions
Consider:

• Expediting the late supply 

• Adjusting the sales order line schedule date
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14: Order violates a business calendar
Explanation
The planning engine issues this exception message against buy orders, make orders, 
transfer orders, sales orders, and forecasts (entities) that have dates that are 
non-workdays of the following calendars (violates the calendar). For make orders with 
routings, the planning engine does not issue this exception message for resource 
requirements that violate calendars:

• Shipping calendar: The dates that a shipments can start from a supplier or source 
organization

• Receiving calendar: The dates that a customer or destination organization can 
receive shipments

• Intransit calendar: The dates that a carrier or other shipment service operates

• Supplier capacity calendar: The dates that a supplier operates and has processing 
time and capacity available. Start dates and processing times of buy orders must 
respect this calendar

• Organization manufacturing calendar: The dates that a work center operates and 
has capacity available. The order and due dates of make orders must respect this 
calendar.

Each entity can have only one exception message. If the entity violates multiple 
calendars, the exception message lists all of the calendars that it violates. 

For example, 1 January for organization M is a non-workday on the receiving calendar. 
There is a purchase order shipment due to organization M on 1 January. When the plan 
runs, the planning engine issues this exception message against the purchase order 
shipment.

This exception message is related to exception message Sales order/forecast at risk.

Information Displayed
• Item

• Item Description

• Source Organization: For transfer orders.

• Order Type: For buy orders and transfer orders, Planned Order, Purchase 
Requisition, or Purchase Order. For make orders, Planned Order or Discrete Job. 
For sales orders, Sales Order. For forecasts, Forecast.

• Order Number: For buy orders and transfer orders, planned order, purchase 
requisition, or purchase order number. For make orders, planned order or discrete 
job number. For sales orders, sales order number. For forecasts, forecast name.
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• Supplier: For buy orders.

• Supplier Site: For buy orders.

• Customer: For sales orders and forecasts.

• Customer Site: For sales orders and forecasts.

• Organization: For buy orders, the receiving organization. For transfer orders, the 
destination organization. For make orders without a routing, the make at 
organization. For sales orders and forecasts, the shipping organization.

• Order Date

• Order Start Date

• Order Due Date

• Order Dock Date: For buy orders and transfer orders.

• Order Ship Date; For forecasts, the forecast date. For sales orders, the suggested 
ship date. For buy orders, the ship date from the supplier. For transfer orders, the 
ship date from the source organization.

• Calendar: All calendars that the entity violates.

• Order Quantity

• Ship Method: For sales orders, forecasts, buy orders, and transfer orders.

Resolution Suggestion
Change the date of the entity.

Arrange for work on the non-workday.

Material and Resource Capacity Exception Group 
This table shows the exceptions in this exception group and states whether the planning
engine issues the exception for each plan type.

For cells that contain (1), note that orders with compression days and overloaded 
exceptions (resource overloaded, supplier capacity overloaded, and transportation 
resource overloaded) are generated for constrained and optimized plans only when 
there are firm supplies in the plans or if you select the Enforce Demand Due Dates plan 
option. 
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Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand 
Dates

Available In 
Constrained 
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimized 
Plans

Available In 
Inventory 
Optimization

1: Material 
constraint

No No Yes Yes Yes

2: Resource 
constraint

No No Yes Yes Yes

3: Resource 
overloaded 
(1)

Yes Yes Yes Yes Yes

4: Supplier 
capacity 
overloaded 
(1)

Yes Yes Yes Yes Yes

5: Resource 
underloade
d

Yes Yes Yes Yes Yes

6: Batch 
was started 
with less 
then 
minimum 
capacity

No Yes Yes Yes No

7: Batch 
was started 
with more 
than 
maximum 
capacity

No Yes Yes Yes No

8: 
Operation 
Hard Link 
Violation

No Yes Yes Yes No



Supply Chain Plan Exception Messages    17-47

Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand 
Dates

Available In 
Constrained 
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimized 
Plans

Available In 
Inventory 
Optimization

9: Late 
replenishm
ent to 
maintenanc
e work 
order 
demand

No Yes Yes No No

10: 
Maintenanc
e work 
order 
resource 
overload

No Yes Yes No No

1: Material constraint
Explanation
This exception message appears when a demand due date needs to be pushed out due 
to either:

• Lead time violation

• Supplier capacity constraint

If there are also Resource constraint exception messages for this end demand, you may 
also need to provide adequate resource capacity.

The planning engine:

• Issues this exception if profile option MSO: Calculate Constraint Exceptions is Yes

• Does not issue this exception message if the plan planning mode is Constrained 
(Without Detailed Scheduling)

Lead time violation
It occurs for lead-time violation when there is not enough time to obtain the material. 
For buy items with lead-times and for make items with no routings and lead-times, the 
planning engine uses total lead-time. The overload is the quantity.

For example, today is 12-December, there is a demand for 5 on 20-December, and the 
total lead-time is 10 days.
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Supplier capacity constraint
It occurs for supplier capacity constraint when there is not enough supplier capacity to 
purchase the buy item by a certain date. The certain date is the Latest possible 
completion time (LPCT) - the item post-processing lead-time, including breaks and 
delivery calendars.

You can see the amount of supplier capacity that you need to add at different suppliers 
during different time periods in order to satisfy a demand on time. If there are Resource
constraint exception messages for an end demand, you may also need to provide 
adequate resource capacity.

Supplier capacity is available at 0000 hours each work day according to the owning 
organization manufacturing calendar. The planning engine accumulates supplier 
capacity for a plan:

• From the launch date, if you launch the plan on a work day at 0000 hours 

• From the next working day after the launch date, if you launch the plan on a 
non-work day or on a work day after 0000 hours

While the horizontal plan accumulates the available and required capacities from the 
beginning, the exception process begins accumulating them again on the day after it 
issues an exception message.

Since supplier capacity is global, the planning engine issues these exceptions to the 
owning organization. 

The calculation of overload is Required Quantity - Cumulative Available Quantity.

The calculation for Cumulative Available Quantity is Cumulative supplier capacity - 
Cumulative quantity already used by other supplies. The amount already used depends
on previously scheduled supplies.

For example, supplier capacity is 25 units per day.

The plan start date is 3 January.

The planning engine needs to purchase 100 units on 5 January.

The cumulative available supplier capacity on 5 January is 75 units.

If the planning engine suggested a supply order to meet the demand, it would overload 
supplier capacity by 25 units (100 required - 75 available). However, an Enforce 
Capacity Constraints plan with Material selected cannot overload supplier capacity. The
planning engine:

• Moves the supply and dependent demand to a later date where supplier capacity is 
available

• Issues this Material constraint exception message with overload of 25 units

Information Displayed
The information displayed for this exception is:
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• Organization

• Item

• Item Description

• Supplier

• Supplier Site

• Supply Order Number

• Order Type

• Quantity

• Due Date

• Dock Date

• Bucket Start Date: The date of the overload. (For this exception, there is no end 
date.)

• Required Capacity

• Cumulative Available Capacity: At Bucket Start Date before scheduling.

• Overload

Resolution Suggestions
Check to see if these exceptions cause Late replenishment for sales order or Late 
replenishment for forecast exception messages; right click the exception message and 
select Related Exceptions.

In the Planner Workbench, Exception Details window, sort the Late replenishment for 
sales order and Late replenishment for forecast exception messages by your priority, for
example, days late or demand priority. 

Check to see if a resource capacity issue caused early processing of the supply order 
resulted in the material constraint.

Consider:

• Adjusting sales order line schedule date

• Adjusting forecast entry date

• Adjusting supplier capacity

• Using an alternate supplier
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• Using a substitute component: In unconstrained plans, make a manual substitution.

• Arranging and recording new substitute items

• Increasing supplier flexfences

• Changing the sales order or forecast quantity

• Modifying the sourcing rule: For example, change sourcing percentage

• Changing lead-time

2: Resource constraint
Explanation
This exception appears when the planning engine detects unavailability of resource 
capacity for a specific time period because of the capacity requirements of an end 
demand. The overload is the amount of resource capacity needed.

The planning engine:

• Issues this exception if profile option MSO: Calculate Constraint Exceptions is Yes

• Does not issue this exception message if the plan planning mode is Constrained 
(Without Detailed Scheduling)

When the planning engine performs resource/task allocation for an order, it first tries to 
schedule demands backward from the demand due dates. If there is not enough 
resource availability in a planning time bucket for it to schedule an activity to meet the 
demand due date, it generates this Resource constraint exception for the planning time 
bucket.

Since the order failed backward scheduling, the planning engine forward schedules the 
order from the plan start date to realistically allocate the resources/tasks. Therefore, the 
actual resource requirements may be later than the dates on the exception.

There are differences among the plan types:

• Constrained - Enforce due dates and Optimized - Enforce due dates: When the 
planning engine determines the window in which it wants to schedule the 
operation, it schedules the operation in that window with an overload if necessary.

• Constrained - Enforce capacity constraints and Optimized - Enforce capacity 
constraints: When the planning engine determines the window in which it wants to 
schedule the operation, it determines if there would be an overload if it schedules 
the operation.

If there would not be any resource overload, the planning engine does not issue the 
exception.

If there would be a resource overload, the planning engine issues the exception and 
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reports the quantity of the resource constraint as the quantity reported in the exception 
message. For example, an end demand may have the following resource constraints 
associated with it:

• Resource 1: Constraint dates 5 January to 6 January, overload 4 hours

• Resource 2: Constraint dates 7 January to 8 January, overload 2 hours

• Resource 1: Constraint dates 21 January to 27 January, overload 22 hours

You can see the amount of capacity that you need to add at different resources during 
different time periods in order to satisfy the demand on time. If there are also Material 
constraint exception messages for this end demand, you may also need to provide 
adequate supplier capacity.

Information Displayed
• Resource

• Organization

• Department

• Supply Order Number: Of the operation and resource.

• Order Type

• Item

• Item Description

• Op-seq. number

• Res-Seq number

• From Date: The start date of the planning time bucket in which the resource is 
overloaded.

• To Date: The end date of the planning time bucket in which the resource is 
overloaded.

• Resource Requirement

• Resource Capacity: The available capacity of the resource before scheduling the 
resource.

• Overload: Resource Capacity - Resource Requirement after scheduling the resource.

Resolution Suggestions
Consider:
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• Adjusting sales order line schedule date

• Increasing your resource availability:

• Increase hours available per unit (overtime)

• Increase the resource assigned units

• Increase work days (overtime)

• Changing shift pattern

• Using an alternate resource

• Using an alternate routing

• Modifying the sourcing rules

• Subcontracting

• Using substitute items (with different resources)

3: Resource overloaded
Explanation
This exception message appears when, in a planning time bucket, both:

• The resource required capacity is more than the resource available capacity

• The load ratio is more than the exception set Over-utilization

The amount of overload is the minimum duration of the operation for the 
maximum assigned units of the routing. Load ratio is a percent and its calculation is
(Required Capacity/Available Capacity) * 100. 

There are differences among the plan types:

• Constrained - Enforce due dates and Optimized - Enforce due dates: Since the 
planning engine holds the due dates, the material and resources that support them 
can contribute to resource overload.

• Constrained - Enforce capacity constraints and Optimized - Enforce capacity 
constraints, the message typically appears only if there are firm supplies or firm 
operation start or end dates. Typically, these plans change due dates to avoid 
overloading resources but since the supplies and operation dates are firm, they can 
contribute to resource overload.

For example, resource R1 has available capacity of 24 hours day (one resource unit for 
three shifts) on the three daily planning buckets 3 January, 4 January, and 5 January.
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The supplies that use resource R1 are: 

• S1: Operation sequence 10, resource sequence 10

Start 3 January 12:00, end 4 January 12:00

Requirements 24 hours

• S2: Operation sequence 10, resource sequence 10

Start 4 January 0:00, end 4 January 10:00

Requirements 10 hours

• S3: Operation sequence 10, resource sequence 10

Start 4 January 12:00, end 5 January 12:00

Requirements 24 hours

The exception set Over-utilization for resource R1 is 0 (report load ratios over 100).

Based on the task start and due dates, the planning engine schedules the resource 
requirements as follows:

• S1: 12 hours on 3 January and 12 hours on 4 January

• S2: 10 hours on 4 January

• S3: 12 hours on 4 January and 12 hours on 5 January

The daily resource requirements are:

• 3 January: 12 hours

4 January: 34 hours

5 January: 12 hours

Required capacity exceeds available capacity on 4 January. The planning engine issues 
this Resource overloaded exception on 4 January with load ratio 142 ((34 / 24) * 100).

Information Displayed
The information displayed for this exception message is:

• Organization

• Resource

• Dept/Line

• Start Constraint Date: The start date of the planning time bucket in which the 
resource is overloaded

• End Constraint Date: The start date of the last planning time bucket in which the 
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resource is overloaded. As long as Load Ratio remains the same in successive 
planning time buckets, the planning engine uses the same exception and extends 
the End Constraint Date.

• Load Ratio

Resolution Suggestions
Consider:

• Using resolution suggestions for the Resource constraint exception message

• Adjusting the exception set Over-utilization

4: Supplier capacity overloaded
Explanation
This exception message appears when, in a planning time bucket, the supplier required 
capacity is more than the supplier available capacity.

The amount of overload is Required capacity - Cumulative available capacity of that 
bucket. Load ratio is a percent and its calculation is (Required Quantity/Cumulative 
Available Quantity) * 100.

Since supplier capacity is global, the planning engine issues these exceptions to the 
owning organization. You can only view this exception in the plan's owning 
organization.

There are differences among the plan types:

• Unconstrained: Since unconstrained plans assume infinite capacity, the planning 
engine may issue many instances of this exception.

• Constrained - Enforce due dates and Optimized - Enforce due dates: The planning 
engine issues this exception if overloading the supplier capacity is the only way to 
meet the demand date.

• Constrained - Enforce capacity constraints and Optimized - Enforce capacity 
constraints: The planning engine issues this exception when firm supply orders and
their lower-level component firm supply orders overload the supplier capacity.

For example, supplier A available capacity on days 2 through 10 is 1 per day.

Days 6 and 7 are non-work days.

There are planned orders for buy item B which the planning engine sources from 
supplier A:

• Dock date day 1, quantity 5

• Dock date day 3, quantity 12
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• Dock date day 9, quantity 23

The planning engine issues the following Supplier capacity overloaded exception 
messages:

• On day 1, the load ratio is 500 (5 * 100) Since there is no available quantity on day 1, 
this calculation does not include it.

• On day 3, the load ratio is 200 (12/(1*2) * 100). There are two days of suppler 
capacity available since the previous Supplier capacity overloaded exception 
message on day 1 (days 2 and 3).

• On day 9, the load ratio is 575 (23/(1*4) *100). There are four days of suppler 
capacity available since the previous Supplier capacity overloaded exception 
message on day 3 (days 4, 5, 8, and 9).

Information Displayed
The information displayed for this exception message is:

• Organization: The owning organization

• Item

• From Date: The start date of the planning time bucket in which the supplier 
capacity is overloaded

• To Date: The start date of the last planning time bucket in which the supplier 
capacity is overloaded. As long as Load Ratio remains the same in successive 
planning time buckets, the planning engine uses the same exception and extends 
the To Date.

• Supplier

• Supplier Site

• Load Ratio: The planning engine does not carry supplier capacity overloads from 
one planning time bucket to the next.

Resolution Suggestions
Consider:

• Using resolution suggestions for the Material constraint exception message

• Adjusting the exception set Over-utilization

5: Resource underloaded
Explanation
This exception message appears when, in a planning time bucket, both:



17-56    Oracle Advanced Supply Chain Planning Implementation and User's Guide

• The resource required capacity is less than the resource available capacity

• The load ratio is the same as or lower then than the exception set Over-utilization.

Load ratio is a percent and its calculation is (Required Quantity/Cumulative Available 
Quantity) * 100.

For example, resource R1 has available capacity of 24 hours day (one resource unit for 
three shifts) on the three daily planning buckets 3 January, 4 January, and 5 January.

The supplies that use resource R1 are: 

• S1: Operation sequence 10, resource sequence 10

Start 3 January 12:00, end 4 January 12:00

Requirements 24 hours

• S2: Operation sequence 10, resource sequence 10

Start 4 January 0:00, end 4 January 10:00

Requirements 10 hours

• S3: Operation sequence 10, resource sequence 10

Start 4 January 12:00, end 5 January 12:00

Requirements 24 hours

The exception set Under-utilization for resource R1 is 60 (report load ratios of 60 or 
less).

Based on the task start and due dates, the planning engine schedules the resource 
requirements as follows:

• S1: 12 hours on 3 January and 12 hours on 4 January

• S2: 10 hours on 4 January

• S3: 12 hours on 4 January and 12 hours on 5 January

The daily resource requirements are:

• 3 January: 12 hours

• 4 January: 34 hours

• 5 January: 12 hours

The planning engine detects that on both 3 January and 5 January the load ratio is 50 
((12 / 24) * 100) which is lower than the exception set Under-utilization. It issues this 
Resource underloaded exception for each of those days.
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Information Displayed
The information displayed for this exception message is:

• Organization

• Resource

• Dept/Line

• Start Constraint Date: The start date of the planning time bucket in which the 
resource is underloaded.

• End Constraint Date: The start date of the last planning time bucket in which the 
resource is underloaded. As long as Load Ratio remains the same in successive 
planning time buckets, the planning engine uses the same exception and extends 
the End Constraint Date.

• Load Ratio

Resolution Suggestions
Consider:

• Adjusting the exception set Under-utilization

• Increasing the workload

• Decreasing available capacity

• Shifting resources to other work centers

• Processing rework

• Executing special projects

• Balancing the loads across planning time buckets

6: Batch was started with less than minimum capacity
Explanation
This exception message appears when the resource has batching parameters.

The planning engine creates batches that meet the resource minimum batch quantity 
within the batching window. It converts the quantities of all orders into the unit of 
measure of the batching resource. 

If it cannot find enough orders within the batching window whose quantities make up 
the minimum batch quantity, it creates the batch with less than the minimum quantity 
and issues this exception.

For example, batching resource R1 has characteristics:
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• Minimum batch capacity: 30

• Maximum batch capacity: 100

• Batch capacity unit of measure: M3 (cubic meters)

• Batching window size: 3 days

The physical attributes of item A are:

• Weight: 15 KG

• Volume: 4 F3 (cubic feet)

The planning engine schedules supply orders for item A and its resource R1:

• S1: Operation sequence 10, resource sequence 10

Quantity 100

Volume = 11.34 M3

Needs to be scheduled on 3 January

• S2: Operation sequence 10, resource sequence 10

Quantity 80

Volume 9.07 M3

Needs to be scheduled on 5 January

• S3: Operation sequence 10, resource sequence 10

Quantity 250

Volume 28.35 M3

Needs to be scheduled on 7 January

The planning engine schedules a batch on 3 January with S1.

The batch size is now 11.34 M3.

It schedules S2 as follows:

• Sets S2's batching window relative to its scheduling date: S2's scheduling date is 5 
January so the batching window is from 2 January to 8 January.

• Searches within the batching window for an existing batch that still has room: The 
batch with S1 (started on 3 January) is within S2's batching window.

• Moves in S2 to 3 January and combines it with S1 in the same batch.

The batch size is now 20.41 M3 (11.34 M3 + 9.07 M3).
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It schedules S3 as follows:

• Sets S3's batching window relative to its scheduling date: S3's scheduling date is 7 
January so the batching window is from 4 January to 10 January.

• Searches within the batching window for an existing batch that still has room. There
are no existing batches within S3's batching window.

• Creates a separate batch containing only S3 then continues scheduling other 
supplies.

There are no other supplies for the planning engine to schedule. 

The batch size for the batch started on 3 January is 20.41 and the minimum batch 
capacity is 30. The planning engine issues this Batch was started with less than 
minimum capacity exception message against the batch started on 3 January.

Information Displayed
The information displayed for this exception message is:

• Batch Number

• Resource

• Dept/Line

• Min Capacity: The minimum batch capacity in the unit of measure of the item's 
volume

• Max Capacity: The maximum batch capacity in the unit of measure of the item's 
volume

• From Date: The batch start date

• To Date: The batch finish date.

• Load Ratio: Required Capacity/Maximum Batch Capacity

• Required Capacity: For all activities in the batch in the unit of measure of the item's 
volume

Resolution Suggestions
Consider:

• Reducing the number of days in the planning time fence: Rather than creating new 
batches, the planning engine adds orders to batches and moves in later orders to 
meet the minimum batch capacity.

• Increasing the size of the batching window: The planning engine has more 
candidates from which to select for the batches.
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• Unfirming firm orders: The planning engine does not pre-process them into 
batches.

7: Batch was started with more than maximum capacity
Explanation
This exception message appears when the resource has batching parameters and the 
planning engine creates a batch with more than the maximum quantity. It occurs when:

• There are firm orders

• The only way to meet a demand due date in a Constrained - Enforce due dates plan 
is to violate the maximum batch capacity

• The only way to meet a demand due date in a Constrained - Enforce capacity 
constraints plan with Resource Constraint selected and Material Constraint cleared 
is to violate the maximum batch capacity

The planning engine converts the quantities of all orders into the unit of measure of the 
batching resource.

For example, batching resource R1 has characteristics:

• Minimum batch capacity: 30

• Maximum batch capacity: 100

• Batch capacity unit of measure: M3 (cubic meters)

• Batching window size: 3 days

The physical attributes of item A are:

• Weight: 15 KG

• Volume: 4 F3 (cubic feet)

The planning engine converts item A volume from 4 F3 to 0.1134 M3.

The planning engine schedules supply orders for item A and its resource R1:

• S1 - firm: Operation sequence 10, resource sequence 10

Quantity 600

Volume = 68.04 M3

Needs to be scheduled on 5 January

• S2 - firm: Operation sequence 10, resource sequence 10

Quantity 600
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Volume 68.04 M3

Needs to be scheduled on 5 January

The planning engine schedules a batch on 5 January with S1. It cannot change the date 
of a firm supply order to move it into another batch.

The batch size is now 68.04 M3. 

The planning engine schedules adds S2 to the batch started on 5 January. It cannot 
change the date of a firm supply order to move it into another batch and cannot start 
another batch.

The batch size is now 136.08 M3 (68.04 M3 + 68.04 M3). 

There are no other supplies for the planning engine to schedule. 

The batch size for the batch started on 5 January is 136.08 and the maximum batch 
capacity is 100. The planning engine issues this Batch was started with more than 
maximum capacity exception message against the batch started on 5 January.

Information Displayed
The information displayed for this exception message is:

• Batch Number

• Resource

• Dept/Line

• Min Capacity: The minimum batch capacity in the unit of measure of the item's 
volume

• Max Capacity: The maximum batch capacity in the unit of measure of the item's 
volume

• From Date: The batch start date

• To Date: The batch finish date

• Load Ratio: Required Capacity/Maximum Batch Capacity

• Required Capacity: For all activities in the batch in the unit of measure of the item's 
volume

Resolution Suggestions
Consider unfirming some firm orders. Rather than violating the maximum batch 
capacity, the planning engine will move unfirm orders to another date.

8: Operation Hard Link Violation 
Explanation
This exception message appears when a user-defined operation minimum time offset, 
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maximum time offset, or item shelf life days cannot be respected due to firming of 
requirements or orders. It can also appear when a negative minimum time offset or a 
negative maximum time offset is violated because of the upstream operation start time 
boundary.

Information Displayed
The information displayed for this exception message is: .....

• From

• Item

• Organization

• Supply order number

• Operation sequence number

• Resource sequence number

• To

• Item

• Organization

• Supply order number

• Operation sequence number

• Resource sequence number

• Minimum time offset

• Maximum time offset

• Shelf life days

• Actual offset

Resolution Suggestions
Navigate to the Supply/Demand window or the Resource Requirements window to 
identify causes and possible solutions.

9: Late replenishment to maintenance work order demand
Explanation
The format of this exception message is WO-1 Requires Item A on Day 1 and pegged supply 
will not be available until Day 9. 

This exception message appears in a constrained plan when the planning engine detects



Supply Chain Plan Exception Messages    17-63

that the supplies for a maintenance work order demand are due later than the 
maintenance work order demand. The demand satisfied date is the latest due date of 
the supplies pegged directly to an end demand. The planning engine issues this 
exception message against a maintenance work order demand when its demand 
satisfied date is later than its schedule date. 

Information Displayed
The information displayed for this exception message is:

• Organization: For the supply order

• End Item: Work Order item

• Quantity: For the supply order

• Work Order Number 

• Priority

• Due Date: For the supply order

• Demand Date: The demand due date

• Days Late: Due Date - Demand Date.

You can search the occurrences of this exception message on Visit. 

Resolution Suggestions
See Late Sales Orders and Forecasts Exception Group > exception message 4: Late 
replenishment for sales order resolution suggestions.

10: Maintenance work order resource overload
Explanation
The format of this exception message is WO-1 would cause Resource B to be overloaded for 
Days 5,6 and 7. 

This exception message appears when, in a planning time bucket, both occur: 

• The resource required capacity is more than the resource available capacity

• The load ratio is more than the exception set Over-utilization

Load ratio is a percent and its calculation is (Required Capacity/Available Capacity) * 
100. 

This exception appears when the planning engine detects an overload condition of 
resource capacity for a specific time period and maintenance work order because of the 
capacity requirements the maintenance work order. This exception is only triggered for 
the set or maintenance work orders that have not been allocated their required 
resources. 
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Information Displayed
The information displayed for this exception message is:

• Work Order Number 

• Resource

• Organization: Of the resource

• Dept/Line

• Start Constraint Date: The start date of the planning time bucket in which the 
resource is overloaded. This field does not show the start date of the activity.

• End Constraint Date: The start date of the last planning time bucket in which the 
resource is overloaded. As long as Overload remains the same in successive 
planning time buckets, the planning engine uses the same exception and extends 
the End Constraint Date. This field does not show the end date of the activity.

• Overload: Required Capacity - Available Capacity

You can search the occurrences of this exception message on Visit.

Resolution Suggestions
See exception message 3: Resource overloaded resolution suggestions.

Transportation and Distribution Exception Group
This table shows the exceptions in this exception group and states whether the planning
engine issues the exception for each plan type.

For cells that contain (1), note that orders with compression days and overloaded 
exceptions (resource overloaded, supplier capacity overloaded, and transportation 
resource overloaded) are generated for constrained and optimized plans only when 
there are firm supplies in the plans or if you select the Enforce Demand Due Dates plan 
option. 

Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand 
Dates

Available In 
Constrained 
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimized 
Plans

Available In 
Inventory 
Optimization

1: 
Transportat
ion weight 
constraint

No No Yes Yes Yes
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Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand 
Dates

Available In 
Constrained 
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimized 
Plans

Available In 
Inventory 
Optimization

2: 
Transportat
ion volume 
constraint

No No Yes Yes Yes

3: 
Transportat
ion 
resource's 
weight 
overloaded 
(1)

Yes Yes Yes Yes Yes

4: 
Transportat
ion 
resource's 
volume 
overloaded 
(1)

Yes Yes Yes Yes Yes

1: Transportation weight constraint
Explanation
This exception appears when the planning engine detects unavailability of 
transportation weight capacity for a specific time period because of the capacity 
requirements of supplies pegged to an end demand. The overload is the amount of 
extra resource capacity needed.

The planning engine issues this exception if profile option MSO: Calculate Constraint 
Exceptions is Yes.

The plan parameter Resource Capacity includes the transportation resources. In an 
enforce capacity constraints plan with Resource Constraints cleared and Material 
Constraints selected, the planning engine may calculate transportation weight load and 
issue exception messages.

If you do not want to use transportation weight capacity as a constraint, either leave its 
definitions blank (the planning engine assumes infinite capacity) or enter a large 
amount. Since a large amount affects plan performance, we recommend leaving its 
definitions blank. 
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The calculation for overload is Required Capacity - Available Capacity.

For example, transportation resource TR1 has characteristics:

• Weight capacity: 100 LB per day

• Volume capacity = 100 F3 (cubic feet)/day

The physical attributes of item A are:

• Weight: 1 LB

• Volume: 1 F3 (cubic feet)

There is a shipment of item A1 for quantity 1000 on 3 January from organization M1 to 
organization M2.

The planning engine detects not enough transportation weight capacity on 3 January. In
an enforce capacity constraint plan, the planning engine moves the shipment to dates 
on which there is enough transportation capacity.

The planning engine:

• Accumulates available transportation weight capacity

• Schedules the shipment on 13 January

• Issues this Transportation weight constraint exception message for 3 January with 
overload 900 (1000 required - 100 available)

Information Displayed
The information displayed for this exception message is:

• To Organization: Destination organization

• From Organization: Source organization

• Ship Method

• Constraint Date

• Overload

Resolution Suggestions
Consider:

• Adjusting your transportation resource capacity

• Using a different ship method

• Using a different shipping calendar
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2: Transportation volume constraint
Explanation
This exception appears when the planning engine detects unavailability of 
transportation volume capacity for a specific time period because of the capacity 
requirements of supplies pegged to an end demand. The overload is the amount of 
extra resource capacity needed.

The planning engine issues this exception if profile option MSO: Calculate Constraint 
Exceptions is Yes.

The plan parameter Resource Capacity includes the transportation resources. In an 
enforce capacity constraints plan with Resource Constraints cleared and Material 
Constraints selected, the planning engine may calculate transportation volume load and
issue exception messages.

If you do not want to use transportation volume capacity as a constraint, either leave its 
definitions blank (the planning engine assumes infinite capacity) or enter a large 
amount. Since a large amount affects plan performance, we recommend leaving its 
definitions blank. 

The calculation for overload is Required Capacity - Available Capacity.

For example, transportation resource TR1 has characteristics:

• Weight capacity: 100 LB per day

• Volume capacity = 100 F3 (cubic feet)/day

The physical attributes of item A are:

• Weight: 1 LB

• Volume: 1 F3 (cubic feet)

There is a shipment of item A1 for quantity 1000 on 3 January from organization M1 to 
organization M2.

The planning engine detects not enough transportation volume capacity on 3 January. 
In an enforce capacity constraint plan, the planning engine moves the shipment to dates
on which there is enough transportation capacity.

The planning engine:

• Accumulates available transportation capacity

• Schedules the shipment on 13 January

• Issues this Transportation volume constraint exception message for 3 January with 
overload 900 (1000 required - 100 available)

Information Displayed
The information displayed for this exception message is:
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• To Organization: Destination organization

• From Organization: Source organization

• Ship Method

• Constraint Date

• Overload

Resolution Suggestions
Consider:

• Adjusting your transportation resource capacity

• Using a different ship method

• Using a different shipping calendar

3: Transportation resource's weight overloaded
Explanation
This exception message appears when, in a planning time bucket, the transportation 
resource required weight capacity is more than the transportation resource available 
weight capacity.

The plan parameter Resource Capacity includes the transportation resources. In an 
enforce capacity constraints plan with Resource Constraints cleared and Material 
Constraints selected, the planning engine may calculate transportation resource load 
and issue exception messages.

If you do not want to use transportation capacity as a constraint, either leave its 
definitions blank (the planning engine assumes infinite capacity) or enter a large 
amount. Since a large amount affects plan performance, we recommend leaving its 
definitions blank. 

There are differences among the plan types:

• Unconstrained: The planning engine issues this exception frequently because 
unconstrained plans do not consider transportation capacity. 

• Constrained - Enforce due dates and Optimized - Enforce due dates: The planning 
engine issues this exception if overloading the transportation resource capacity is 
the only way to meet the demand date.

• Constrained - Enforce capacity constraints and Optimized - Enforce capacity 
constraints: The planning engine issues this exception when firm jobs overload the 
transportation capacity. 

The calculation for:



Supply Chain Plan Exception Messages    17-69

• Transportation resource required weight capacity is Shipment quantity * Item 
weight

• Utilization percent is (Required Capacity/Available Capacity) * 100

For example, transportation resource TR1 has available weight capacity of 100 LB per 
day.

The physical attributes of item A are:

• Weight: 1 LB

• Volume: 1 F3 (cubic feet)

There is a shipment of item A1 for quantity 1000 of Item A1 on 3 January from 
organization M1 to organization M2.

In an unconstrained plan, the planning engine:

• Schedules this shipment on 3 January to satisfy the demand on time

• Issues this Transportation resource's weight overloaded exception message with 
overload is 900 (1000 required - 100 available)

Information Displayed
The information displayed for this exception message is:

• Constraint Start Date: The start date of the planning time bucket in which the 
transportation resource weight constraint occurs.

• Constraint End Date: The end date of the planning time bucket in which the 
transportation resource weight constraint occurs.

• Supply Order Number: Of the transfer supply.

• Order Type

• Item

• Item Description

• Ship Date

• Shipment Weight

• Shipment Weight UOM

• Weight Capacity overload

• Ship Method
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• Source Org

• Destination Org

• Available Weight Capacity/Day: The available weight capacity on Ship Date before 
scheduling of the overloading shipment.

Resolution Suggestions
Consider:

• Adjusting your transportation resource capacity

• Using a different ship method

• Using a different shipping calendar

4: Transportation resource's volume overloaded
Explanation
This exception message appears when, in a planning time bucket, the transportation 
resource required volume capacity is more than the transportation resource available 
volume capacity.

The plan parameter Resource Capacity includes the transportation resources. In an 
enforce capacity constraints plan with Resource Constraints cleared and Material 
Constraints selected, the planning engine may calculate transportation resource load 
and issue exception messages.

If you do not want to use transportation capacity as a constraint, either leave its 
definitions blank (the planning engine assumes infinite capacity) or enter a large 
amount. Since a large amount affects plan performance, we recommend leaving its 
definitions blank. 

There are differences among the plan types:

• Unconstrained: The planning engine issues this exception frequently because 
unconstrained plans do not consider transportation capacity. 

• Constrained - Enforce due dates and Optimized - Enforce due dates: The planning 
engine issues this exception if overloading the transportation resource capacity is 
the only way to meet the demand date.

• Constrained - Enforce capacity constraints and Optimized - Enforce capacity 
constraints: The planning engine issues this exception when firm jobs overload the 
transportation capacity. 

The calculation for:

• Transportation resource required volume capacity is Shipment quantity * Item 
volume
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• Utilization percent is (Required Capacity/Available Capacity) * 100

For example, transportation resource TR1 has available volume capacity of 100 F3 per 
day.

The physical attributes of item A are:

• Weight: 1 LB

• Volume: 1 F3 (cubic feet)

There is a shipment of item A1 for quantity 1000 of Item A1 on 3 January from 
organization M1 to organization M2.

In an unconstrained plan, the planning engine:

• Schedules this shipment on 3 January to satisfy the demand on time

• Issues this Transportation resource's volume overloaded exception message with 
overload is 900 (1000 required - 100 available)

Information Displayed
The information displayed for this exception message is:

• Constraint Start Date: The start date of the planning time bucket in which the 
transportation resource volume constraint occurs.

• Constraint End Date: The end date of the planning time bucket in which the 
transportation resource volume constraint occurs.

• Supply Order Number: Of the transfer supply.

• Order Type

• Item

• Item Description

• Ship Date

• Shipment Volume

• Shipment Volume UOM

• Volume Capacity overload

• Ship Method

• Source Org
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• Destination Org

• Available Volume Capacity/Day: The available volume capacity on Ship Date 
before scheduling of the overloading shipment.

Resolution Suggestions
Consider:

• Adjusting your transportation resource capacity

• Using a different ship method

• Using a different shipping calendar

Shortages and Excess Exception Group
This table shows the exceptions in this exception group and states whether the planning
engine issues the exception for each plan type.

Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained
Plans with 
Enforce 
Demand 
Dates

Available In 
Constrained 
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimized 
Plans

Available In 
Inventory 
Optimization

1: Items 
with a 
shortage

Yes Yes Yes Yes Yes

2: Items 
below 
safety stock

Yes Yes Yes Yes Yes

3: Items 
with excess 
inventory

Yes Yes Yes Yes Yes

Asset Intensive Planning

These exception messages also occur against items with part condition Defective.

When you release a planned repair order, you have to scrap the defective components. 
This creates a shortage of the defective part.

These exception messages also show the part condition.

Resolution suggestions: 
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• Include other repairable defective parts that are not included in the plan

• Cancel the repair order and purchase the part instead

To see this exception message, in exception set, set Shortage Exceptions exception time 
period.

1: Items with a shortage
Explanation
This exception message appears when projected available balance for a planning bucket
is negative and is within the exception set Shortage Exceptions exception time period. 
Projected available balance is Previous bucket projected available balance + Sum of 
supply quantities with due date in this planning time bucket - Sum of demand 
quantities with due date (excluding safety stock demand) in this planning time bucket.

There are differences among the plan types:

• Unconstrained: The planning engine can peg late supplies to demands at any level 
in the supply chain. Therefore, you can see item shortages in several levels of the 
supply chain bill of material.

• Unconstrained, Constrained - Enforce due dates, Optimized - Enforce due dates: 
The planning engine can compress lead-times and violate planning time fences to 
meet demands. Item shortages typically occur when there are firm orders whose 
due dates are too late to meet the demand.

• Constrained - Enforce capacity constraints and Optimized - Enforce capacity 
constraints: The demands are most likely independent (because the planning engine
pushes out dependent demand due dates). Due to lead-time, planning time fence, 
resource capacity constraints, or supplier capacity constraints, the supply due dates 
are later than the end demand due date.

For example, item A1 in organization M1 has the following demands and supplies in 
daily buckets:

• 3 January

Beginning available (on hand) balance 0.

Planned order 1: Quantity 100

Planned order 3: Quantity 200

Discrete job 1: Quantity 300

Planned order demand 1 (dependent demand): Quantity 250

Forecast demand 1: Quantity 200

• 4 January

Planned order 4: Quantity 100
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Planned order demand 2 (dependent demand): Quantity 250

Forecast demand 2 = 200

• 5 January

No demands or supplies

• 6 January

Planned order 5: Quantity 200

This table shows the horizontal view of this scenario.

Schedule 
Entity

Beg 3 January 4 January 5 January 6 January

Requirements - 450 450 0 0

Supply 
orders

- 300 0 0 0

Planned 
orders

- 300 100 0 200

Projected 
available 
balance

0 150 (200) (200) 0

The planning engine issues this Item with a Shortage exception message for quantity 
-200 from 4 January to 5 January.

Information Displayed
The information displayed for this exception message is:

• Organization

• Item

• Item Description

• Quantity: Projected available balance

• From Date: The start date of the planning time bucket in which the negative 
projected available balance occurs.

• To Date: The start date of the last planning time bucket in which the negative 
projected available balance occurs. As long as Quantity remains the same in 
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successive planning time buckets, the planning engine uses the same exception and 
extends the To Date.

Resolution Suggestions
Consider:

• Expediting the late supply

• Adjusting the sales order schedule date

2: Items below safety stock
Explanation
This exception message appears when projected available balance for a planning bucket
is below the specified safety stock level for the planning bucket. Projected available 
balance is Previous bucket projected available balance + Sum of supply quantities with 
due date in this planning time bucket - Sum of demand quantities with due date in this 
planning time bucket. See 'Safety Stock, page 6-133.

The planning engine does not consult the exception set for the item.

For example, there are sales orders at organization M1 on item A for quantity 200 past 
due and quantity 150 in bucket 4.

Item A has safety stock level 73 for buckets 1 to 3 and 45 for bucket 4.

There is a planned order for item A for 395 in bucket 4.

The planning engine creates an Items below safety stock exception for buckets 1 to 3. 
The planned order in bucket 4 meets the sales order demands and the safety stock.

Schedule 
Entity

Past 1 2 3 4

Org M1: Sales
orders

200 - - - 150

Org M1: 
Safety stock 
level

- 73 73 73 45

Org M1: 
Planned 
orders

- - - - 395

Information Displayed
The information displayed for the exception message is:

• Organization
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• Item

• Item Description

• From Date: The start date of the planning time bucket with projected available 
balance below safety stock.

• To Date: The start date of the last planning time bucket with projected available 
balance below safety stock. As long as Quantity remains the same in successive 
planning time buckets, the planning engine uses the same exception and extends 
the To Date.

• Quantity: Projected Available Balance - Specified Safety Stock

Resolution Suggestions
Consider expediting supply orders.

3: Items with excess inventory
Explanation
The planning generates this message when projected available balance for a bucket is 
greater than the exception set Excess Quantity value for the item and within the 
exception set Excess Exceptions exception time period. Projected available balance is 
Previous bucket projected available balance + Sum of supply quantities with due date in
this planning time bucket - Sum of demand quantities with due date in this planning 
time bucket.

For example, item A1 in organization M1 has exception set information:

• Excess Quantity: 1

• Excess Exceptions Time Period: 5 days

This table shows a horizontal view of item A1.

Schedule 
Entity

Beg 3 January 4 January 5 January 6 January

Requirements - 450 450 0 0

Supply 
orders

- 300 0 0 0

Planned 
orders

- 300 100 0 200
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Schedule 
Entity

Beg 3 January 4 January 5 January 6 January

Projected 
available 
balance

0 150 (200) (200) 0

The planning engine issues this Item with excess inventory exception message for 
quantity 150 on 3 January.

Information Displayed
The information displayed for this exception message is:

• Organization

• Item

• Item Description

• Quantity: Projected Available Balance - Exception set Excess Quantity

• From Date: The start date of the planning time bucket with excess projected 
available balance

• To Date: The start date of the last planning time bucket with excess projected 
available balance. As long as Quantity remains the same in successive planning 
time buckets, the planning engine uses the same exception and extends the To Date.

Resolution Suggestions
Consider:

• Canceling unneeded supply orders

• Transferring the material to another facility

Reschedules Exception Group
This table shows the exceptions in this exception group and states whether the planning
engine issues the exception for each plan type.

For cells that contain (1), note that orders with compression days and overloaded 
exceptions (resource overloaded, supplier capacity overloaded, and transportation 
resource overloaded) are generated for constrained and optimized plans only when 
there are firm supplies in the plans or if you select the Enforce Demand Due Dates plan 
option. 
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Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand 
Dates

Available In 
Constrained 
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimized 
Plans

Available In 
Inventory 
Optimization

1: Past due 
orders

Yes Yes Yes Yes No

2: Orders to
be 
reschedule
d out

Yes Yes Yes Yes No

3: Orders to
be 
cancelled

Yes Yes Yes Yes No

4: Orders to
be 
reschedule
d in

Yes Yes Yes Yes No

5: Orders 
with 
compressio
n days (1)

Yes Yes Yes Yes No

6: Orders 
scheduled 
to next 
inventory 
point

Yes Yes Yes Yes No

7: Order is 
firmed late

No Yes Yes Yes Yes

8: 
Requireme
nt is firmed
late

No Yes Yes Yes Yes

9: Order is 
firmed 
early

No Yes Yes Yes Yes
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Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand 
Dates

Available In 
Constrained 
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimized 
Plans

Available In 
Inventory 
Optimization

10: 
Requireme
nt is firmed
early

No Yes Yes Yes Yes

11: Shared 
supply 
scheduled 
late

No Yes Yes Yes Yes

The planning engine follows these rules when it recommends rescheduling purchase 
orders and purchase requisitions:

• Purchase orders, reschedule out: The planning engine may not reschedule out 
purchase orders because of lead-time constraints, of insufficient capacity between 
plan start date and the dock date, or the order date or start date is past due. It may 
reschedule out purchase orders that are pegged to demands whose due dates have 
moved out.

• Purchase orders, reschedule in: The planning engine may not reschedule in 
purchase orders within supplier lead-time or that are past due. It may reschedule in
purchase orders outside supplier lead-time but the new order date must not be past
due. The planning engine does not consider capacity.

• Purchase requisitions, reschedule out: The planning engine may reschedule out 
purchase requisitions because of lead-time constraints, of insufficient capacity 
between plan start date and the dock date, the order date or start date is past due, 
or pegging to demands whose due dates have moved out.

• Purchase requisitions, reschedule in: The planning engine may not reschedule in 
purchase requisition within supplier lead-time or are past due. It may reschedule in
purchase orders outside supplier lead-time but the new order date must not be past
due and the requisition must have sufficient accumulated capacity. 

The planning engine must compress the lead-time for subsequent supplies and may 
recommend rescheduling in Constrained - Enforce demand due date plans or when a 
requirement for this item results from a firmed supply.
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1: Past due orders
Explanation
This exception message appears when the planning engine detects supply orders and 
planned orders which have order (start) dates and due dates in the past (before the 
planning horizon start date).

For non-firmed supply orders, the planning engine also issues an Orders to be 
rescheduled out exception message.

The planning engine schedules all operations of a past due order beyond the planning 
horizon start date. If the order is firm, the planning engine retains the order's firmed 
duration as it schedules all its operations beyond the planning horizon start date.

There may be dependent demand resulting from past due orders. If you clear plan 
option Lot for Lot, the planning engine groups the demand which results by item and 
creates one planned order per item (or more depending on the plan options) to meet it. 
If you select it, the planning engine creates one planned order for each dependent 
demand.

Information Displayed
The information displayed for this exception message is:

• Organization

• Item

• Order Number

• Old Date: The current due date

• Date: The suggested due date. It is usually the planning horizon start date but it can
be later if the schedules receipt is not firm and is not needed until a later planning 
time bucket.

• Quantity

• Schedule Ship Date

• Schedule Arrival Date

• Request Ship Date 

• Request Arrival Date

• Promise Ship Date

• Promise Arrival Date

Resolution Suggestions
Check the end item demand which causes the supply order.



Supply Chain Plan Exception Messages    17-81

Consider:

• Changing the demand due date

• For supply orders, expediting

• For supply orders, cancelling

2: Orders to be rescheduled out
Explanation
This exception message appears when the planning engine suggests that you 
reschedule an existing supply order (scheduled receipt) to a later date to avoid carrying 
excess inventory. It occurs when the planning engine detects a non-firm existing supply
order with a due date that is earlier than it suggests (suggested due date).

The planning engine does not issue this recommendation for firm existing supply 
orders.

The planning engine continues to plan lower bill of material levels as if you accept the 
suggestion.

For example, item A1 at organization M1 has the following demand and supply:

• A non-firm discrete job for quantity 100 due on 5 January

• A sales order line for quantity 100 due on 8 January

The planning engine issues this Orders to be rescheduled out exception against the 
discrete job and suggests a new date of 8 January.

Item attribute Acceptable Early Days has no effect on this exception message. For:

• An unconstrained plan: The planning engine keeps the due date date and does not 
issue this exception message.

• A constrained plan: The planning engine ignores it and uses its scheduling logic.

Information Displayed
The information displayed for this exception message is:

• Organization

• Item

• Order Number

• From Date: The current due date

• To Date: The suggested due date

• Quantity
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• Schedule Ship Date

• Schedule Arrival Date

• Request Ship Date

• Request Arrival Date

• Promise Ship Date

• Promise Arrival Date

Resolution Suggestions
Consider reviewing the recommendations for the item and then rescheduling the order 
out. The planning engine continues to plan lower level bills of material as if you accept 
the suggestion.

3: Orders to be cancelled
Explanation
This exception message appears when the planning engine suggests that you cancel an 
existing supply order.

It occurs when the planning engine detects a non-firm existing supply order that you do
not need to satisfy demand or safety stock requirements.

The planning engine continues to plan lower bill of material levels as if you accept the 
suggestion.

The following diagram shows a scenario in organization M1:

• There is a sales order at organization M1 on Item A for quantity 100 in bucket 3.

• There is a forecast at organization M1 on item A for quantity 100 in bucket 4.

• There are discrete jobs at organization M1 for item A for quantity 150 in bucket 1, 50
in bucket 5, and 100 in bucket 8.

• The planning engine pegs 100 of the supply of 150 in bucket 1 to the sales order for 
100 in bucket 3. It creates an Early replenishment for sales order exception message 
against the supply of 150 in bucket 1.

• The planning engine pegs 50 of the supply of 150 in bucket 1 to the forecast for 100 
in bucket 4.

• The planning engine pegs the entire supply of 50 in bucket 5 to the forecast for 100 
in bucket 4. It creates an Order to be rescheduled in exception message against the 
supply of 50 in bucket 5 from bucket 5 to bucket 4.

• The planning engine cannot find any demand to which to peg the supply of 100 in 
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bucket 8. It creates an Orders to be cancelled exception message against the supply 
of 100 in bucket 8. 

Schedule 
Entity

1 2 3 4 5 6 7 8

Org M1: Sales 
orders

- - 100 - - - - -

Org M1: 
Forecasts

- - - 100 - - - -

Org M1: 
Supply orders

150 - - - 50 - - 100

Information Displayed
The information displayed for this exception message is:

• Org

• Item

• Order Number

• Date: The due date

• Quantity

• Schedule Ship Date

• Schedule Arrival Date

• Request Ship Date

• Request Arrival Date

• Promise Ship Date

• Promise Arrival Date

Resolution Suggestions
Consider reviewing the recommendations for the item and then cancelling the order. 
The planning engine continues to plan lower level bills of material as if you accept the 
suggestion.



17-84    Oracle Advanced Supply Chain Planning Implementation and User's Guide

4: Orders to be rescheduled in
Explanation
This exception message appears when the planning engine suggests that you 
reschedule an existing supply order to an earlier date. It occurs when the planning 
engine detects a non-firm existing supply order with a due date that is later than it 
suggests (suggested order date). 

The planning engine continues to plan lower bill of material levels as if you accept the 
suggestion.

For example, there is a sales order at organization M1 on Item A for quantity 100 in 
bucket 3.

There is a forecast at organization M1 on item A for quantity 100 in bucket 4.

There are discrete jobs at organization M1 for item A for 150 in bucket 1, 50 in bucket 5, 
and 100 in bucket 8.

The planning engine pegs 100 of the supply of 150 in bucket 1 to the sales order for 100 
in bucket 3. It creates an Early replenishment for sales order exception message against 
the supply of 150 in bucket 1.

The planning engine pegs 50 of the supply of 150 in bucket 1 to the forecast for 100 in 
bucket 4.

The planning engine pegs the entire supply of 50 in bucket 5 to the forecast for 100 in 
bucket 4. It creates an Order to be rescheduled in exception message against the supply 
of 50 in bucket 5 from bucket 5 to bucket 4.

The planning engine cannot find any demand to which to peg the supply of 100 in 
bucket 8. It creates an Orders to be cancelled exception message against the supply of 
100 in bucket 8. 

Schedule 
Entity

1 2 3 4 5 6 7 8

Org M1: Sales 
orders

- - 100 - - - - -

Org M1: 
Forecasts

- - - 100 - - - -

Org M1: 
Supply orders

150 - - - 50 - - 100

Information Displayed
The information displayed for this exception message is:

• Organization
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• Item

• Order Number

• From Date: The current due date

• To Date: The suggested due date

• Quantity

• Schedule Ship Date

• Schedule Arrival Date

• Request Ship Date

• Request Arrival Date

• Promise Ship Date

• Promise Arrival Date

Resolution Suggestions
Consider reviewing the recommendations for the item and then rescheduling the order 
in. The planning engine continues to plan lower level bills of material as if you accept 
the suggestion.

5: Orders with compression days
Explanation
This exception message appears when the planning engine detects that a supply order 
needs to be completed in less time that its minimum processing time in order for it to 
meet a demand. If the planning engine plans the order according to its lead-time, it 
would start in the past (before the planning horizon start date). The compression days 
represents all of the following:

• The number of days of work that you need to make up on the order to respect its 
due date.

• The number of days that the order would be scheduled in the past (before the 
planning horizon start date).

• The number of days that the order needs to be compressed if its start date is the 
planning horizon start date.

To calculate compression days, the planning engine:

• Backward schedules orders using item lead-time offset (for unconstrained plans) or 
routing level processing times (for constrained plans) ; it uses the 24x7 calendar.
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• Finds the number of days between the order (start) date and the planning horizon 
start date; it uses the manufacturing calendar.

A supply order with compression days at a higher level of the supply chain bill of 
material leads to supply orders with compression days at lower levels of the supply 
chain bill of material. The planning engine calculates the lower level compression days 
as follows:

• For unconstrained plans: It sets each lower level dependent demand due on the 
planning horizon start date and backward schedules its supply order from that 
date. The compression days for each supply order represents the amount of 
compression time needed for that order alone.

• For constrained plans: It sets each lower level dependent demand due on the start 
date of the supply which caused it (which is prior to the planning horizon start 
date) and backward schedules its supply order from that date. The compression 
days for each supply order represents the time difference between the order start 
date and the planning horizon start date. This method calculates compression for an
order in relation to its higher level supply orders.

• For example, C pegs to B which pegs to A which pegs to end demand. Lead time 
offset is 3 for A, B, and C. The supply order for A has 1 compression day. 

In an unconstrained plan, the supply order for B has 3 (day 0 - 3 days lead-time) 
compression days and the supply order for C has 3 (day 0 - 3 days lead-time) 
compression days. 

In a constrained plan, the supply order for B has 4 (day -1 - 3 days lead-time) 
compression days and the supply order for C has 7 (day -4 - 3 days lead-time) 
compression days. 

There are differences among the plan types:

• Unconstrained: The planning engine may compress existing supplies that need to 
be rescheduled in and planned orders if there is not enough time between the 
planning horizon start date and the demand date.

• Constrained - Enforce capacity constraints and Optimized - Enforce capacity 
constraints: The planning engine moves out demands (other than those from firm 
supplies) to avoid compression the supplies pegged to the demands. It creates Late 
replenishment for sales orders and Late replenishment for forecast exception 
messages.

• Constrained - Enforce due dates and Optimized - Enforce due dates: The planning 
engine may compress existing supplies and planned orders during the scheduling 
process while trying to meet the demand due date. In some cases, it may schedule 
supplies within the planning time fence.

For example, launch an unconstrained plan with plan start date of Wednesday.
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The planning engine detects an unsatisfied demand for Friday and creates a planned 
order due on Friday.

It calculates lead-time offset for the item as three days and calculates the order date for 
Tuesday.

It sets the order date to Wednesday and issues this exception with one compression 
day. 

Information Displayed
The information displayed for this exception message is:

• Organization

• Item

• Order number

• Date: The due date

• Quantity

• Compression days

• Schedule Ship Date

• Schedule Arrival Date

• Request Ship Date

• Request Arrival Date

• Promise Ship Date

• Promise Arrival Date

Resolution Suggestions
Consider changing the demand due date to a later date. The planning engine continues 
to plan as if you accept the suggestion.

If the exception occurs on a transfer order, use the Supply/Demand window for 
visibility into the destination organization. You can take action either at the source or 
destination organization.

6: Orders scheduled to next inventory point
Explanation
This exception message appears for plans:

• With items that have item attribute Planned Inventory Point selected
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• With plan option Move Jobs to PIP selected

• In which orders are created to move inventory to the next planned inventory point

When the planning engine finds excess supply that needs to be cancelled at an 
upstream point that is not a planned inventory point, it:

• Creates an order to move this supply to the downstream planned inventory point

• Issues this Orders scheduled to next inventory point exception message

If the excess supply does not meet the criteria for this exception message, the planning 
engine issues an Orders to be cancelled exception.

For example, item A uses one component (C).

There are three discrete jobs on item C for quantity 50 due in bucket 10.

There are two MDS entries on item A for quantity 50 in buckets 12 and 13.

The planning engine pegs two of the discrete jobs to the MDS entries.

Since item A is a planned inventory point, the planning engine schedules the third job 
to item A rather than cancelling it.

Schedule 
Entity

10 11 12 13 14

Org M1, Item 
C: Discrete 
jobs

50

50

50 

- - - -

Org M1, Item 
A: MDS

- - 50 50 -

Information Displayed
The information displayed for this exception message is:

• Org

• Item: In the created order

• Planned Inventory Point: The item marked as a PIP item at the point to which the 
order is scheduled

• Date: The order due date

• Quantity
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• Department/Line

• Order Number

• Resource: The resource on which the supply order is scheduled

• Schedule Ship Date

• Schedule Arrival Date

• Request Ship Date

• Request Arrival Date

• Promise Ship Date

• Promise Arrival Date

Resolution Suggestions
This exception message is for information.

7: Order is firmed late
Explanation
This exception appears when the planning engine is scheduling activity Unconstrained 
Latest Possible Completion Times (ULPCTs) for a supply order and finds a firm supply 
that does not fit in with the scheduling of the non-firm operations to that point.

This diagram shows an example of the situation.
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Order/requirement firmed late example

In Enforce demand date plans with profile option MSO: Lead Time Control set to 
Violate minimum processing times to meet demand due date, the planning engine 
violates precedence constraints between the firm supply and its next downstream 
supply.

Information Displayed
The information displayed for this exception message is:

• Firm Supply Item

• Firm Supply Item Description

• Firm Supply Order Number

• Firm Supply Organization

• Source Organization: For transfer supplies.

• Supplier: For buy supplies.

• Supplier Site: For buy supplies.

• Firming Type: Firm Start Date, Firm End Date, Firm Start Date and End Date, or 
Firm All.

• Days Late: The number of days by which the firm supply is late according to the 
ULPCT calculation.
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• Schedule Ship Date 

• Schedule Arrival Date

• Request Ship Date 

• Request Arrival Date 

• Promise Ship Date 

• Promise Arrival Date

Resolution Suggestions
Consider:

• Researching the situation that resulted in the original firming

• Evaluating the supply schedule and the end demand information

• Collecting and evaluating available options regarding changing the firmness of the 
activity, changing the firm date of the activity, or dealing with other activities that 
fall outside of minimum start time and of demand due date.

• Selecting and implementing options.

8: Requirement is firmed late
Explanation
This exception message appears in the same circumstances as exception message Order 
is firmed late.

Information Displayed
The information displayed for this exception message is:

• Firm Supply Item

• Firm Supply Item Description

• Firm Supply Order Number

• Firm Supply Organization

• Source Organization: For transfer supplies.

• Firm Supply Operation Sequence Number: If operation firming leads to the 
exception message.

• Firm Supply Resource Sequence number: If resource firming leads to the exception 
message.
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• Firming Type: Firm Start Date, Firm End Date, Firm Start Date and End Date, or 
Firm All.

• Days Late: The number of days by which the firm supply is late according to the 
ULPCT calculation.

• Schedule Ship Date

• Schedule Arrival Date

• Request Ship Date

• Request Arrival Date

• Promise Ship Date

• Promise Arrival Date

Resolution Suggestions
Consider:

• Researching the situation that resulted in the original firming

• Evaluating the supply schedule and the end demand information

• Collecting and evaluating available options regarding changing the firmness of the 
activity, changing the firm date of the activity, or dealing with other activities that 
fall outside of minimum start time and of demand due date.

• Selecting and implementing options.

9: Order is firmed early
Explanation
This exception appears when the planning engine is scheduling activity Unconstrained 
Earliest Possible Start Time (UEPSTs) for a supply order and finds a firm supply that 
does not fit in with the scheduling of the non-firm operations to that point.

This diagram shows an example of the situation.
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Order/requirement firmed early example

In Enforce demand date plans with profile option MSO: Lead Time Control set to 
Violate minimum processing times to meet demand due date, the planning engine 
violates precedence constraints between the firm supply and its next downstream 
supply.

Information Displayed
The information displayed for this exception message is:

• Firm Supply Item

• Firm Supply Item Description

• Firm Supply Order Number

• Firm Supply Organization

• Source Organization: For transfer supplies.

• Supplier: For buy supplies.

• Supplier Site: For buy supplies.

• Firming Type: Firm Start Date, Firm End Date, Firm Start Date and End Date, or 
Firm All.

• Days Late: The number of days by which the firm supply is late according to the 
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UEPST calculation.

• Schedule Ship Date

• Schedule Arrival Date

• Request Ship Date

• Request Arrival Date

• Promise Ship Date

• Promise Arrival Date

Resolution Suggestions
Consider:

• Researching the situation that resulted in the original firming

• Evaluating the supply schedule and the end demand information

• Collecting and evaluating available options regarding changing the firmness of the 
activity, changing the firm date of the activity, or dealing with other activities that 
fall outside of minimum start time and of demand due date.

• Selecting and implementing options.

10: Requirement is firmed early
Explanation
This exception message appears in the same circumstances as exception message Order 
is firmed early.

Information Displayed
The information displayed for this exception message is:

• Firm Supply Item

• Firm Supply Item Description

• Firm Supply Order Number

• Firm Supply Organization

• Source Organization: For transfer supplies.

• Firm Supply Operation Sequence Number: If operation firming leads to the 
exception message.

• Firm Supply Resource Sequence number: If resource firming leads to the exception 
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message.

• Department

• Resource

• Firming Type: Firm Start Date, Firm End Date, Firm Start Date and End Date, or 
Firm All.

• Days Late: The number of days by which the firm supply is late according to the 
UEPST calculation.

• Schedule Ship Date

• Schedule Arrival Date

• Request Ship Date

• Request Arrival Date

• Promise Ship Date

• Promise Arrival Date

Resolution Suggestions
Consider:

• Researching the situation that resulted in the original firming

• Evaluating the supply schedule and the end demand information

• Collecting and evaluating available options regarding changing the firmness of the 
activity, changing the firm date of the activity, or dealing with other activities that 
fall outside of minimum start time and of demand due date.

• Selecting and implementing options.

11: Shared supply scheduled late
Explanation
This exception appears when shared supplies get fixed at the beginning of the current 
slice and need to be treated as firm when scheduling demands within the current slice.

The planning engine calculates it only if profile options:

• MSO: Generate Shared Supply Exceptions is Yes

• MSO: Additional Demand Slices for Shared Supply Rescheduling is not -1

A shared supply is similar to a firm supply because, at the beginning of scheduling a 
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slice, the planning engine treats shared supplies from previous slices as firm. A shared 
supply is different from a firm supply because the planning engine considers all lower 
level supplies of a shared supply as shared. Therefore, a shared supply can cause 
lateness but cannot cause compression.

For more information, see 'Plan Shared Supplies, page 9-42.

Information Displayed
The information displayed for this exception message is:

• Shared Supply Item

• Shared Supply Organization

• Shared Supply Item Description

• Shared Supply Order Number

• Shared Supply Order Type

• Supply Quantity

• Due Date 

• Source Organization 

• Ship Method

• Supplier

• Supplier Site

• Days Late: The number of days by which the shared supply is late according to the 
ULPCT calculation.

• Schedule Ship Date

• Schedule Arrival Date

• Request Ship Date

• Request Arrival Date

• Promise Ship Date 

• Promise Arrival Date

Resolution Suggestions
Consider 
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• Evaluating the supply schedule and the end demand information

• Collecting and evaluating available options regarding firming the activity or 
splitting and rearranging supply orders to avoid a shared supply.

• Selecting and implementing options.

Substitutes and Alternates Used Exception Group
This table shows the exceptions in this exception group and states whether the planning
engine issues the exception for each plan type.

For cells that contains (2), note that these exceptions are not a result of decisions made 
by the planning engine. They are only visible in an unconstrained plan if a planner 
manually chosen this alternative, for example, by firming a planned order or selecting 
an alternate routing.

Exception 
Message

Available In 
Unconstrained
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand 
Dates

Available In 
Constrained 
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimized 
Plans

Available In 
Inventory 
Optimization

1: Planned 
order uses 
alternate 
BOM/routi
ng

Yes (2) Yes Yes Yes Yes

2: Planned 
order uses 
substitute 
component
s

No Yes Yes Yes Yes

3: Planned 
order uses 
alternate 
resources

No Yes Yes Yes Yes

4: Order 
sourced 
from 
alternate 
facility

No Yes Yes Yes Yes
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Exception 
Message

Available In 
Unconstrained
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand 
Dates

Available In 
Constrained 
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimized 
Plans

Available In 
Inventory 
Optimization

5: Order 
sourced 
from 
alternate 
supplier

Yes Yes Yes Yes Yes

6: Demand 
satisfied 
using end 
item 
substitutio
n

No Yes Yes Yes No

7: Work 
order uses 
substitute 
component

No Yes Yes No No

1: Planned order uses alternate BOM/routing
Explanation
This exception message appears when the planning engine, in a constrained or 
cost-based optimized plan:

• Under the direction of a decision rule, assigns an alternate bill of material and 
routing to a planned order

• Detects a firm a planned order with an alternate bill of material and routing

Information Displayed
The information displayed for this exception message is:

• Org

• Item

• Date: The due date

• Quantity

• Alternate BOM
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• Alternate Routing

Resolution Suggestions
Monitor the volume and frequency of occurrences. Many occurrences bear investigation
as alternates and substitutes are often more expensive or more difficult to obtain.

2: Planned order uses substitute components
Explanation
This exception message appears when the planning engine, in a constrained or 
cost-based optimized plan:

• Under the direction of a decision rule, assigns a substitute component to a planned 
order.

• Detects a firm a planned order with a substitute component.

Information Displayed
The information displayed for this exception message is:

• Org

• Item

• Date: The due date

• Substitute Component

• Quantity: Of the substitute component

• Order Number

Resolution Suggestions
Monitor the volume and frequency of occurrences. Many occurrences bear investigation
as alternates and substitutes are often more expensive or more difficult to obtain.

3: Planned order uses alternate resources
Explanation
This exception message appears when the planning engine, in a constrained or 
cost-based optimized plan:

• Assigns an alternate resource to an operation of a planned order in a constrained or 
cost-based optimized plan

• Detects a firm planned order that uses an alternate resource

The situation usually occurs when the primary resource becomes overloaded. The 
resource can exist either in the primary routing or in an alternate routing.
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Information Displayed
The information displayed for this exception message is:

• Org

• Dept./Line

• Resource: The alternate

• Date: The due date

• Quantity

• Order Number

Resolution Suggestions
Monitor the volume and frequency of occurrences. Many occurrences bear investigation
as alternates and substitutes are often more expensive or more difficult to obtain.

4: Order sourced from alternate facility
Explanation
This exception message appears when the planning engine, in a constrained or 
cost-based optimized plan:

• Under the direction of a decision rule, assigns a planned order to an alternate 
facility

• Detects a firm planned order with an alternate facility assigned

An alternate facility is an organization and is not a supplier site.

Information Displayed
The information displayed for this exception message is:

• Org: The destination organization

• Item

• Date: The due date

• Quantity

• Source Org: The alternate facility

• Supplier

• Supplier Site

Resolution Suggestions
Monitor the volume and frequency of occurrences. Many occurrences bear investigation
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as alternates and substitutes are often more expensive or more difficult to obtain.

5: Order sourced from alternate supplier
Explanation
This exception message appears when the planning engine:

• In a constrained or cost-based optimized plan, under the direction of a decision 
rule, assigns a planned order to an alternate supplier (supplier with rank other than
1) 

• In a constrained or cost-based optimized plan, detects a firm planned order with an 
alternate supplier assigned

Information Displayed
The information displayed for this exception message is:

• Org: The owning organization

• Item

• Date: The due date

• Quantity

• Source Org

• Supplier: The alternate

• Supplier Site: The alternate

Resolution Suggestions
Monitor the volume and frequency of occurrences. Many occurrences bear investigation
as alternates and substitutes are often more expensive or more difficult to obtain.

6: Demand satisfied using end item substitution
Explanation
This exception message appears when the planning engine plans to satisfy an end item 
demand using a supply order with a substitute item. The planning engine substitutes 
items:

• For cost-based optimized plans

• For any plans under the direction of substitution rules

• If the plan option Decision Rules, End Item Substitution is selected

If the planning engine satisfies a demand with multiple planned orders, it issues an 
exception for each supply order with the substitute item.
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For example, the substitution chain is PSS7001 > PSS7002 > PSS7003 > PSS7004. The 
planning engine can satisfy demand for:

• PSS7001 using PSS7002, PSS7003, or PSS7004

• PSS7002 using PSS7003 or PSS7004

• PSS7003 using PSS7004

For more information, see End-Item-Level Substitution, page 12-1.

The planning engine calculates the quantity of the substitute using the information in 
the Item Relationships, Oracle Inventory User's Guide form.

For example, there is demand for PSS7002 in organization M1 for 100.

The planning engine satisfies this demand with inventory of item PSS7004 in 
organization M2.

The demand organization is M1 and the substitute organization is M2. The demand 
item is PSS7002 and the substitute item is PSS7004.

The substitute organization is the most upstream organization in the supply pegging 
tree of the substitute item. For example, the planning engine can:

• Peg on hand at organization M2 to a planned order demand arising from a transfer 
from organization M2 to organization M1

• Peg the transfer order to sales order demand at organization M1

Since the on hand supply is the most upstream supply, its organization is the substitute 
organization.

Information Displayed
The information displayed for this exception message is:

• Org: The demand organization

• Item: The demand item

• Quantity: The demand quantity

• Order Number: If the end demand is a sales order, the sales order number; if the 
end demand is a forecast, blank

• Substitute Org

• Substitute Item

• Substitute Qty: As specified in the item relationship.

• Date: The due date
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• Demand class

• Customer 

• Customer site

Resolution Suggestions
Release the substitute item to the sales order through Planner Workbench.

To enable release of substitute items, navigate to Planner Workbench Preferences 
window, Other tab and select Include Sales Orders.

To release substitute items:

• Navigate to the Supply/Demand window.

• The field Action is Release.

• The status of the sales order does not matter for the release to happen.

• After you release the substitution, concurrent process Release sales order 
recommendations runs in the source instance to make the change to the sales order.

Monitor the volume and frequency of occurrences. Many occurrences bear investigation
as alternates and substitutes are often more expensive or more difficult to obtain.

7: Work order uses substitute component
For asset intensive planning, this exception message occurs in the same situation and 
shows the same information as exception message Planned order uses substitute 
components. It occurs for maintenance work orders and also shows Visit.

Projects/Tasks Exception Group
This table shows the exceptions in this exception group and states whether the planning
engine issues the exception for each plan type.

Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand 
Dates

Available In 
Constrained 
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimized 
Plans

Available In 
Inventory 
Optimization

1: Items 
with a 
shortage in 
a 
project/task

Yes Yes Yes Yes No
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Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand 
Dates

Available In 
Constrained 
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimized 
Plans

Available In 
Inventory 
Optimization

2: Items 
allocated 
across 
projects/tas
ks

Yes Yes Yes Yes No

3: Items 
with excess 
inventory in
a 
project/task

Yes Yes Yes Yes No

1: Items with a shortage in a project/task
Explanation
This exception message appears in the same circumstances as the Items with a shortage 
except that the planning engine only uses the supplies and demands belonging to a 
project and task.

If there is both a project manager and a task manager, the planning engine sends the 
exception message to the task manager through the exception workflow.

Information Displayed
The information displayed for this exception message is:

• Org

• Item

• Date: The start date of the planning time bucket with negative project projected 
available balance

• Quantity: The projected available balance

• Planning Group

• Project

• Task

Resolution Suggestions
Consider reviewing and correcting supply and demand imbalances with the project and
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task mangers.

2: Items allocated across projects/tasks
Explanation
This exception appears when the planning engine detects a supply belonging to one 
project/task which is pegged to a demand belonging to another project/task. It occurs 
when the two projects are in the same planning group.

If there is both a project manager and a task manager, the planning engine sends the 
exception message to the task manager through the exception workflow.

Information Displayed
The information displayed for this exception message is:

• Org

• Item

• Date: The due date

• Quantity

• Planning Group

• Project: The supply project

• Task: The supply task

• To Project: The demand project

• To Task: The demand task

Resolution Suggestions
This exception message is for information.

3: Items with excess inventory in a project/task 
Explanation
This exception message appears in the same circumstances as the Items with excess 
inventory except that the planning engine only uses the supplies and demands 
belonging to a project and task.

If there is both a project manager and a task manager, the planning engine sends the 
exception message to the task manager through the exception workflow.

Information Displayed
The information displayed for this exception message is:

• Org

• Item
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• Date: The start date of the planning time bucket in which there is an excess

• Quantity: Projected Available Balance - Exception set Excess Quantity

• Planning Group

• Project

• Task

Resolution Suggestions
Consider:

• Cancelling unneeded supply orders

• Transferring the material to another project

Item Exceptions Exception Group
This table shows the exceptions in this exception group and states whether the planning
engine issues the exception for each plan type.

Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand 
Dates

Available In 
Constrained 
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimize
d Plans

Available In 
Inventory 
Optimization

1: Items 
with 
negative 
starting on 
hand

Yes Yes Yes Yes Yes

2: Items 
with 
expired lot

Yes Yes Yes Yes No

3: Items 
with no 
activity

Yes Yes Yes Yes Yes

4: Sourcing
split 
percentage 
violated

Yes Yes Yes Yes No



Supply Chain Plan Exception Messages    17-107

Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand 
Dates

Available In 
Constrained 
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimize
d Plans

Available In 
Inventory 
Optimization

5: Items 
with 
forecast 
over 
consumpti
ons

Yes Yes Yes Yes No

6: End item
minimum 
remaining 
shelf life 
violation

No Yes Yes Yes No

1: Items with negative starting on hand
Explanation
This exception message appears when the planning engine detects an item with 
negative beginning on-hand balance.

It usually occurs because of a recent inventory backflushing transaction or an incorrect 
inventory balance.

Information Displayed
The information displayed for this exception message is:

• Org

• Item

• Quantity: The beginning on-hand balance

• Date

• Item Description

• Lot Number

Resolution Suggestions
Consider:

• Releasing the planned order
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• Investigating the item to rule out incorrect inventory balance or to correct an 
incorrect inventory balance

2: Items with expired lots
Explanation
This exception appears when the planning engine detects a potential expired lot. A 
potential expired lot is a lot that:

• Has lot expiration date during the planning horizon

• Is not pegged to a demand that results in its use before its lot expiration date

It occurs against items under lot control Full Control. The calculation for lot expiration 
date is Lot Receipt Date + Shelf Life Days.

In addition to issuing this exception message, the planning engine plans for you to flush
the inventory on its lot expiration date so that you cannot use it after its lot expiration 
date to satisfy demands.

Information Displayed
The information displayed for this exception message is:

• To Organization: The organization holding the inventory

• Item

• Quantity

• Item Description

Resolution Suggestions
Consider creating or modifying an actual demand to use the material. 

3: Items with no activity
Explanation
This exception appears when the planning engine detects an item in an organization 
with no demand and no supply throughout the planning horizon. It usually occurs for:

• Substitute components

• Components on alternate bills of material

• End item substitutes

Typically, these items do not have other sources of demand and the planning engine 
does not need to use them during the planning horizon.

If the item has no activity in multiple organizations, the planning engine issues this 
exception message for each organization.
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Information Displayed
The information displayed for this exception message is:

• Org

• Item

• Item Description

Resolution Suggestions
Consider changing the item planning method to Not planned.

4: Sourcing split percentage violated
Explanation
This exception message appears for days when the percentages of the actual sourcing 
among rank 1 suppliers is different from the percentages in the sourcing rule for rank 1 
suppliers. The planning engine issues the exception:

• Against suppliers whose percentage is not satisfied

• Only if the deviation of split percentages between the planned values and the 
values defined in the sourcing rule is greater than the value specified in MSC: 
Sourcing Variance Tolerance

The planning engine uses profile option MSO: Sourcing Allocation Window to 
determine the reference period of time for the variance. 

The formula for calculating the actual sourcing percentage for a supplier is (Cumulative
quantity sourced from supplier/Cumulative quantity sourced from rank 1 suppliers) * 
100.

For example, a sourcing rule for item A1 lists two suppliers, both rank 1 with a 
50%-50% split.

One supplier has a capacity of 60 units per day and the other supplier has a capacity of 
40 units per day. A demand for the item is 200.

This table shows a horizontal view of item A1.

Schedule 
Entity

3 January 4 January 5 January 6 January 7 January

Supplier 1 
capacity

60 60 0 0 0

Supplier 2 
capacity

40 40 0 0 0
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Schedule 
Entity

3 January 4 January 5 January 6 January 7 January

Planned 
orders using 
supplier 1

60 60 0 0 0

Planned 
orders using 
supplier 2

40 40 0 0 0

Demand 0 0 0 0 200

Total supply 100 100 0 0 0

Projected 
available 
balance

100 200 200 200 0

The planning engine issues this Sourcing split percentage violated exception message 
from 3 January to 4 January with a percent variation of 10%. 

Information Displayed
The information displayed for this exception message is:

• Item

• Supplier: The supplier name

• Supplier Site

• From Date: The start date of the planning time bucket in which the which the actual
sourcing percentage does not satisfy the sourcing rule split percentage

• To Date: The start date of the last planning time bucket in which the which the 
actual sourcing percentage does not satisfy the sourcing rule split percentage. As 
long as Percent Variation remains the same in successive planning time buckets, the
planning engine uses the same exception and extends the To Date.

• Allocated Percentage: The sourcing rule split percentage

• Actual Percentage: The actual split percentage

• Percent Variation: Actual Percentage - Allocated Percentage

Resolution Suggestions
Consider:
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• Changing the suggested suppliers on the purchase requisitions and purchase orders

• Reviewing supplier agreements, splitting, history, and capacity to detect a capacity 
constraint or optimization issue

5: Items with forecast over consumptions
Explanation
This exception message appears for each occurrence of forecast overconsumption and 
belongs to the Item Exceptions group.

You can right click from the exception and select the following:

• Demand

• Sources

• Destination 

• Horizontal plan 

Information Displayed
The information displayed for this exception message is:

• Item

• Forecast name or Demand Planning scenario name

• Forecast date (schedule ship or request date)

• Original quantity

• Current quantity

• Over consumed quantity

Resolution Suggestion
You can take corrective action to increase the forecast or talk to the person responsible 
for forecasting.

6: End item minimum remaining shelf life violation
Explanation
This exception message appears when a product is going to violate the required shelf 
life criteria when it arrives at a customer site.

The system uses this formula: (Material Available Date + Shelf Life Days - Planned 
Arrival Date) < Minimum Remaining Shelf Life.

Example
Consider a prescription that must be stocked on drugstore shelves with at least three 
months (90 days) of remaining shelf life until expiration.The shelf life of this product is 
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120 days. Based on a plan run the Material Available Date for a supply of this product is
February 1, 2007 and the Planned Arrival Date is March 6, 2007. 

Therefore, Material Available Date + Shelf Life Days - Planned Arrival Date is: February
1, 2007 + 120 - March 6, 2006 = 120 - 33 = 87.

Because 87 < 90 the exception is generated.

Information Displayed
The information displayed for this exception message is: 

• Item

• Organization

• Demand order number

• Customer

• Customer site

• Material available date

• Planned arrival date

• Shelf life days

• Minimum remaining shelf life

This is the requirement specified by the user in the destination side in the Item-Org 
Mass Maintenance screen.

• Minimum remaining shelf life planned

This is the left-hand side of the inequality calculated by the plan. In the example 
above, this is equal to 87 days.

• Minimum remaining shelf life shortfall

This is equal to (minimum remaining shelf life - minimum remaining shelf life 
planned). In the example above, minimum remaining shelf life shortfall = 90 - 87 = 3 
days.

These hidden fields can be displayed through folder functionality:

• Category

• Planner

• Priority

• Demand Class
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• Demand Quantity

• Demand Due Date

• Old Due Date

• Suggested Ship Date

Resolution Suggestion
This exception enables planner to identify products that will violate the required shelf 
life criteria when it arrives at the customer site.

Transportation Management Exceptions Exception Group 
This table shows the exceptions in this exception group and states whether the planning
engine issues the exception for each plan type.

Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand 
Dates

Available In 
Constrained 
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimize
d Plans

Available In 
Inventory 
Optimization

1: Order 
will be 
delivered 
later than 
scheduled

No Yes Yes Yes No

2: Order 
will be 
delivered 
earlier than
scheduled

No Yes Yes Yes No

1: Order will be delivered later than scheduled
Explanation
The planning engine issues this exception when Updated Arrival Date is later than:

• For purchase requisitions and internal requisitions, Dock Date

• For internal sales orders, Scheduled Arrival Date

Information Displayed
The information displayed for this exception message is: 
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• Organization

• Item

• Order Number

• Current Date

• Updated Arrival Date

• Quantity

• Planner

• Product Family

• Item Category

• Supplier (for purchase order and internal requisition only)

• Supplier Site (for purchase order and internal requisition only)

• Source Organization (for internal sales order only)

Resolution Suggestion
Run either an online replan or a batch replan. The planning engine issues related 
exceptions when the new arrival time has an effect on demand satisfaction—late 
replenishment, early replenishment, order at risk

2: Order will be delivered earlier than scheduled
Explanation
The planning engine issues this exception when Updated Arrival Date is earlier than:

• For purchase requisitions and internal requisitions, Dock Date

• For internal sales orders, Scheduled Arrival Date

Information Displayed
The information displayed for this exception message is: 

• Organization

• Item

• Order Number

• Current Date

• Updated Arrival Date
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• Quantity

• Planner

• Product Family

• Item Category

• Supplier (for purchase order and internal requisition only)

• Supplier Site (for purchase order and internal requisition only)

• Source Organization (for internal sales order only)

Resolution Suggestion
Run either an online replan or a batch replan. The planning engine issues related 
exceptions when the new arrival time has an effect on demand satisfaction—late 
replenishment, early replenishment, order at risk

Recommendations Exception Group
This table shows the exceptions in this exception group and states whether the planning
engine issues the exception for each plan type.

Exception 
Message

Available In 
Unconstrained 
Plans

Available In 
Constrained 
Plans with 
Enforce 
Demand 
Dates

Available In 
Constrained 
Plans with 
Enforce 
Capacity 
Constraints

Available 
In 
Optimized
Plans

Available In 
Inventory 
Optimization

Batches Yes Yes Yes Yes Yes

Discrete 
Jobs

Yes Yes Yes Yes Yes

Flow 
Schedules

Yes Yes Yes Yes Yes

Jobs Yes Yes Yes Yes Yes

Purchase 
Requisition
s

Yes Yes Yes Yes Yes
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Explanation
Recommendations are suggestions to the planner to release planned orders. The 
planned orders become:

• Batches: Oracle Process Manufacturing

• Discrete jobs: Oracle Work in Process

• Flow schedules: Oracle Flow Manufacturing

• Jobs: Oracle Project Manufacturing, Oracle Shopfloor Management (OSFM)

• Purchase requisitions: Oracle Purchasing

Information Displayed
The information displayed in the Supply/Demand window is:

• Org

• Item

• For Release: Checkbox for releasing the planned order

• Firm: Checkbox for firming the planned order

• Order Type

• Sugg Due Date

• Orig Qty

• Order Number

• Action: The recommendation

• New Date: New firm date specified by planner

• New Qty: New firm quantity specified by planner

If you right click the exception, you can view other key information; calculations for 
some key terms are:

• Suggested Due Date = Date material is needed in inventory

• Suggested Dock Date = Due date - Postprocessing lead Time

• Suggested Start Date = Dock date - Processing Lead Time
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• Suggested Order date = Start date - Preprocessing Lead time. The earliest Suggested
Order Date allowed is the current day and no compression days are allowed.

Resolution Suggestions
Consider firming or releasing the planned order. For more information, see 
'Implementing , page 18-151Planning Recommendation

Exception Diagnosis and Resolution

Overview
This section explains how to diagnose and resolve exception messages. It includes:

• Workflow notifications and activities

• Exception information

• Identifying the root causes of late demand (enhanced exceptions) 

• Resolution suggestions

• Online simulation

• Identifying differences between plans

• Implementing plan changes

You typically resolve the:

• Most constrained (bottleneck) resource before the least constrained resource

• High priority demands before low priority demands

Workflow Notifications and Activities
You can automatically forward exceptions (using Oracle Workflow) to your trading 
partners. They can research and respond to exceptions through self-service web 
applications including forecast maintenance, supplier capacity update, ATP, and a 
secured version of the Planner Workbench. Trading partner responses can trigger other 
workflow activities such as a notification or an automatic reschedule of a purchase 
order or sales order. For more information, see 'Review Workflow Notifications, page 3-
7.

Exception Information
The section 'Understanding Exceptions, page 17-14 describes the circumstances under 
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which the planning engine issues the exceptions and the information that it displays.

The section 'Viewing Exceptions, page 17-9 describes how to obtain additional 
information about exceptions by using buttons, right mouse options, and related 
exceptions. 

Using Constraint Exceptions
Use the constraint exceptions to find situations in which the planning engine is not able 
to plan within your constraints.

Overload Related Exceptions
The overload-related constraint exception messages are:

• Requirement causes resource overload

• Order causes supplier capacity overload

• Order causes transportation weight capacity overload

• Order causes transportation volume capacity overload

The planning engine issues these exception messages when a specific resource 
requirement or a supply order causes overload on a production resource (for make 
items), a supplier capacity (for buy items), or a transportation resource (for transfer 
items).

Lead Time Related Exceptions
The lead-time-related constraint exception messages are:

• Requirement with insufficient lead time

• Order with insufficient lead time

The planning engine issues these exception messages when it schedules a resource 
requirement or supply order for less than its minimum duration. Minimum duration 
depends on order type; for example, a resource requirement minimum duration is the 
processing time required when using the resource maximum assigned units and usage 
quantity. 

Enforce Capacity Constraints Related Exceptions
The constrained plan-related constraint exception messages are:

• Resource constraint

• Material constraint

• Transportation weight constraint
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• Transportation volume constraint

• Order lead time constraint

• Requirement lead time constraint

The planning engine issues these exceptions in:

• Constrained plans

• Plan option Enforce Capacity Constraint

• Either or both Material Constraints and Resource Constraints is Yes

• Profile option MSO: Calculate Constraint Exceptions is Yes

It issues them whenever it must satisfy a sales order line or a forecast entry late. They 
help show the resource overloads, supplier capacity overloads, and lead-time violations
that need to occur for you to satisfy the order on time. 

These exception messages from Constrained plans-Enforce capacity constraints mirror 
overload and lead-time exceptions from Constrained plans-Enforce demand due dates: 

• Resource constraint mirrors Requirement causes resource overload

• Material constraint mirrors Order causes supplier capacity overload

• Transportation weight constraint mirrors Order causes transportation weight 
capacity overload

• Transportation volume constraint mirrors Order causes transportation volume 
capacity overload

• Order lead time constraint mirrors Order with insufficient lead time

• Requirement lead time constraint mirrors Requirement with insufficient lead time

Firming Related Exceptions
The firming-related constraint exception messages are:

• Order is firmed early

• Order is firmed late

• Requirement is firmed early

• Requirement is firmed late

The planning engine issues these exceptions against firmed resource requirements and 
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supply orders when it thinks they are firmed with either of the following effects:

• Too early: It cannot properly schedule upstream tasks--using minimum 
duration--to start after the plan start date.

• Too late: It cannot properly schedule downstream tasks--using minimum 
duration--to finish before the demand due date.

Other Exceptions
The other constraint exception messages are:

• Shared supply scheduled late: A shared supply is scheduled too late to satisfy one 
of its end demands. The planning engine issues this exception if profile option 
MSO: Generate Shared Supply Exceptions is Yes.

• Demand quantity is not satisfied: There is no supply for this demand; the demand 
is satisfied at the end of the planning horizon.

• Sales order/forecast at risk: The sales order line or forecast entry is likely to be late. 
The reasons for the lateness are in the exception group Supply Problems for Late 
Sales Orders/Forecasts.

Related Exceptions
The following exception messages relate to the exception message Sales order/forecast 
at risk:

• Requirement causes resource overload

• Order causes supplier capacity overload

• Order is firmed late

• Order is firmed early

• Requirement is firmed late

• Requirement is firmed early

• Order causes transportation weight capacity overload

• Order causes transportation volume capacity overload

• Order with insufficient lead time

• Requirement with insufficient lead time

The following exception messages relate to the exception message Late replenishments 
for sales orders/forecasts:
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• Resource constraint

• Material constraint

• Order is firmed late

• Order is firmed early

• Requirement is firmed late

• Requirement is firmed early

• Transportation weight constraint

• Transportation volume constraint

• Order lead time constraint

• Requirement lead time constraint

• Demand quantity not satisfied

• Shared supply scheduled late

Identifying Root Causes of Late Demand
This section explains:

• Late demands: The planning engine process for identifying and scheduling late 
demands

• Late demand root cause information: Information you need to know to research the 
causes of late demands

• Viewing late demand information: The windows that you can use to see late 
demand information

Late Demands
The exception messages that are critical relative to late demands in constrained and 
optimized plans with enforce capacity constraints are:

• Late replenishment for sales order

• Late replenishment for forecasts

The process that the planning engine uses that can result in these exception messages is:

• Start from the demand due date, backward schedule the operations for the demand 
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to determine the latest time that activities should start to meet the demand on time. 
This is the latest possible start time (LPST).

• If the LPST is in the past, find the earliest possible start time (EPST) for the first 
operation and forward schedule the operations for the demand to determine the 
earliest possible completion time (EPCT) for the demand. 

The LPST and EPCT depend on resource availability, resource precedence 
constraints, planning time fence restrictions, and item lead-times.

• Start from the EPCT, backward schedule the operations for the demand to minimize
work in process and inventory.

Critical Path

The critical path is the branch of the supply chain bill of materials with the longest 
cumulative lead time.

The planning engine calculates critical path for Constrained - Enforce capacity 
constraints plans and Constrained - Enforce due dates plans.

Late Demand Root Cause Information
This section describes:

• Terms and types of information that you may encounter in researching the root 
cause of late demands

• Potential causes of late demands

In general, the regular behavior of the planning engine can highlight late demands 
caused by:

• Environmental circumstances: For example, a downstream resource suffering from 
capacity overutilization or from supplier capacity overload on one of its supplies.

• Data circumstances: For example, an item with inaccurate lead-times or a resource 
with inaccurate available hours.

The descriptions in this section use a manufactured table as an example. The table 
consists of four legs and a top, each of which have operations.

Latest Possible Start Time
The latest possible start time (LPST) is the time that the activities need to start to meet 
the demand on time. If the latest possible start time is in the past, the planning engine 
cannot schedule to meet the demand on time.

This diagram shows the table assembly and its subassemblies backward scheduled from
an independent demand due date. The schedule shows each job finishing just in time 
for its next use; therefore, the beginning of each job is its latest possible start time. The 
latest possible start time for the tabletop is in the past.
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Latest Possible Start Date Example

Earliest Dates
The earliest possible start time (EPST) is the earliest time that the planning engine can 
schedule the operations to start.

The earliest possible completion time (EPCT) is the earliest date that the operations are 
complete if they start at the earliest possible start time.

This diagram shows the table assembly and its subassemblies backward scheduled from
the demand due date. Since the tabletop latest possible start time is in the past, the 
planning engine forward schedules each subassembly from the current date (as material
and resources are available). The result is the demand satisfied by date for the table 
assembly which is later then the demand due date. Since the legs subassembly has a 
shorter lead-time than the tabletop assembly, it is finished sooner than the tabletop 
assembly. The completed legs subassembly remains in work in process or moves to 
inventory until the table assembly needs it.
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Earliest Demand Satisfied Date Example

Earliest Order Date
The earliest order date is the earliest possible date that you can start the order, given 
plan constraints. It is the earliest possible date that can appear as the suggested order 
date and usually corresponds to the following dates:

• Make order: Suggested start date

• Buy order: Suggested dock date

• Transfer order: Suggested ship date

Even for supplies on the critical path, the suggested order date is usually after the 
earlier order date because the planning engine right-justifies it to the next order which 
has its own set of constraints. 

If the suggested order date is later than earliest order date, it is usually because there 
are more constraining supplies at the same level. If this supply started on earliest order 
date, it would wait on the other constrained supplies (buy items or subassemblies). The 
planning engine sets the suggested order date later (delays the order start) to avoid 
work in process and inventory build-up.

This diagram shows three supplies (S1, S2, and S3) pegged to supply S4. The planning 
engine forward scheduled the supplies and set the suggested order date for each one to 
be the same as the earliest order date 
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Earliest Order Date Example

In this diagram, the planning engine has backward scheduled all of the supplies from 
the due date of S4 to minimize work in process and inventory. This aligns the due date 
of the subassemblies with the start date of S4. The suggested order dates for S2 and S3 
are later than their earliest order dates.
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Suggested Order Date Shifted Example

Earliest Completion Date
The earliest completion date is the date that the order can finish if you start it on earliest
order date. It is the earliest possible date that can appear as the suggested due date.

If suggested order date is the same as earliest order date, then the field suggested due 
date is the same as earliest completion date.

If suggested order date is different from earliest order date, the time between earliest 
order date and suggested start date may not be the same as the time between earliest 
completion date and suggested due date. Breaks in the capacity profile (for example, 
holidays) may create capacity availability breaks that result in the operations stretching 
as they fit in around these breaks.

This diagram shows a supply that has two operations; operation 10 lasts three days and 
operation 20 lasts two days. The planning engine can schedule the operations with no 
breaks. Since there is no difference between suggested order date and earliest order 
date, there is no difference between suggested due date and earliest completion date.
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Earliest Possible Times Example

This diagram shows the supply when the planning engine must schedule the operations
with breaks. Since there is a difference between suggested order date and earliest order 
date, there difference between suggested due date and earliest completion date. 
However, the differences are not the same:

• The difference between suggested order date and earliest order date is one day

• The difference between suggested due date and earliest completion date is three 
days

Actual Times Example

Earliest Possible Demand Satisfied Date
The earliest demand satisfied date is the same as the earliest possible completion time of
its supply order. The planning engine reschedules the operations backwards from the 
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earliest possible completion date to minimize work in process and inventory.

This diagram shows the table assembly and its subassemblies backward scheduled from
the demand satisfied by date. This aligns the due date of the subassemblies with the 
start date of the table assembly. The planning engine has scheduled the legs 
subassembly to start later than the forward scheduling suggested. The completed legs 
subassembly does not need to remain as long in work in process or in inventory before 
the table assembly needs it.

Earliest Demand Satisfied Date with Minimum Work in Process Example

Actual Times
The actual start date and end dates are:

• Buy orders (planned orders, purchase orders, purchase requisitions): Actual start 
date = Dock Date, Actual end date = Due Date

• Make orders (planned orders, discrete jobs, batches, jobs, flow schedules): Actual 
start date = Start Date, Actual end date = Due Date

• Transfer orders (planned orders, internal sales orders, internal requisitions): Actual 
start date = Ship Date, Actual end date = Due Date

Critical Activities
A critical activity is an entity that is:

• Pegged to a late demand.
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• One of several activities which are at the same bill of material or pegging level.

• The most constraining at its level. The most constraining activity is the one that 
most restricts the lower (earliest) bound of the earliest order date of the next highest
level supply. 

It can be a:

• Specific activity of a resource

• Buy supply

• Transfer supply

This diagram shows three supplies (S1, S2, and S3) pegged to supply S4. The planning 
engine forward scheduled the supplies. Among the subassemblies, S1 is the critical 
supply since it determines the earliest order date of supply S4 (the next highest level 
supply).

Critical Activity Example

The critical supply does not always have to have its suggested order date and earliest 
order date the same. In this diagram, the first resource that supply S4 needs is not 
available until 30 June. Therefore, this resource, rather than supply S1 is the critical 
activity that determines the earliest order date for supply S4. 
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Resource Constraint on Assembly Example

This diagram shows the final schedule after the planning engine has backward 
scheduled from the demand satisfied date of supply S4 to minimize work in process 
and inventory. The planning engine still considers supply S1 as the critical activity. 
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Final Schedule for Assembly Example

Resource Utilization Profile
The resource utilization profile information includes:

• All the resources required to complete the operation

• Required hours and available hours

• Overload or underload conditions

• Firmed indications

• Percent resource utilization

• Precedence constraints

• All the tasks being worked on by the resource grouped into orders with the same, 
higher, and lower priority than the one you are researching

Constrained Times
Constrained Earliest and Actual Times represent the earliest that an activity can start 
considering resource capacity constraints, supplier capacity constraints, and resource 
precedence constraints (the earliest that an activity can start is dependent of the earliest 
time that the previous activity can complete).
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Resource Precedence Constraints
Resource precedent constraints are constraints that cause an activity associated with the
late demand to wait for a resource when it is otherwise ready to be worked on. They 
cause the earliest possible completion time to be later and delay satisfaction of the late 
demand.

Use the resource utilization profile information to identify resource precedent 
constraints on the late demand:

• All the levels of resources and operations that satisfy the late demand and their 
precedence relationships

• Availability of the upstream resources; if one upstream resource has low 
availability, it will tend to make all downstream operations later

• Availability of the downstream resource; since the planning engine backward 
schedules late demand operations to be just-in-time, a downstream activity that is 
late because of resource unavailability results in late scheduled upstream 
operations. 

Demands constrained by resources also receive a Resource constraint exception 
message and you use that exception message to find addition information about the 
resources.

This diagram shows the operations and resource schedule for a tabletop. Operation 10 
Sawing takes 400 minutes and uses resources Chipper for 250 minutes and Lathe for 150
minutes. Operation 20 Painting takes 200 minutes and uses resource Spray painter. The 
capacity consumption profiles for the resources show that the resources are not always 
available. Therefore, the:

• Schedule for this supply is delayed while waiting for the resource Spray painter 

• Due date of the supply is later than it would be if the resource was available when 
the tabletop assembly was ready for it
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Precedence Constraints and Resource Availability

Min Possible Days Late
For supplies, this indicates how late the end demand would be if this supply was the 
only late supply.

The calculation for Min Possible Days Late is Earliest Completion Date - Need by Date.

The supply Need by Date is the demand Due Sate. Since the planning engine calculates 
Need By Date from the item fixed and variable lead-times, the Need By Date may be 
different than the Suggested Due Date from detailed scheduling.
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Planning Level
For operations, this indicates its level on the supply chain routing. The higher the 
number, the lower the operation is on the routing. 

For example, if the end item assembly has operations 10, 20, and 30, the level of:

• Operation 10 is 3

• Operation 20 is 2

• Operation 30 is 1

Item Lead Time Constraints
Item lead times can cause delays in demand satisfaction.

For example:

• Tabletops are buy items with the item lead-time of 60 days. For buy items, the order
date is offset from the dock date by the pre-processing lead-time plus either the 
default supplier lead-time or by the default the item lead-time.

• If there is no supplier assigned with a specific lead-time, the forward scheduling 
process on the late demand supply order schedules the dock date for the tabletop 60
days from the plan start date.

If checking determines that this is the reason for the delay of the order, the planner 
should correct and firm the scheduled dock date for the planned order and consider 
adjusting the item and default supplier information for the future.

You can run Constrained - enforce demand due date plans so that they might satisfy 
demands late. You set profile option MSO: Lead Time Control to Do Not Violate 
Minimum Processing Time. The planning engine schedules a demand late if it:

• Starts from the demand due date

• Backward schedules the supply orders

• Needs to schedule supply orders before the planning time fence date or the plan 
start date

For these late demands, Unconstrained Earliest Possible Start Time is the same as 
Unconstrained Latest Possible Start Time and Unconstrained Earliest Possible 
Completion Time is the same as Unconstrained Latest Possible Completion Time.

The critical path is the branch of the supply chain bill of materials with the longest 
cumulative lead time.

Dependent Demand Material and Resource Constraints
Late demands can be due to material and resource constraints on dependent demand 
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items. Look for the following situations:

• Supplier capacity for buy dependent demand items: For example, if there is no 
supplier capacity for purchased tabletops before day 100, then all the planned 
orders for tabletops are scheduled from day 100 and all other orders downstream 
and upstream are realigned with them.

• The downstream operations for the dependent demand need resource capacity: For 
example, a downstream resource is available from day 0 to day 100. Since there is 
no available capacity from day 101 to the plan horizon, the planning engine must 
schedule the operation after the plan horizon date (where it assumes infinite 
capacity). This pushes out the downstream operation, its work order, and the 
corresponding dependent demand.

Planning Time Fence Constraints
The planning time fence also imposes certain constraints on the scheduling. Planning 
time fence is the point in time in the scheduling process that marks a boundary inside of
which changes to the schedule may adversely affect component schedules, capacity 
plans, customer deliveries and cost. Therefore, planned orders outside the planning 
time fence can be changed by the system planning logic, but changes within the 
planning time fence must be manually changed by the master scheduler or planner. 
Therefore, if the planning time fence is too large, then the demands cannot be 
rescheduled within the time fence and may be delayed. The planner should be able to 
see a 'Reasons for Lateness' report, which details the effect of the planning time fence on
the lateness of the order. 

Other Late Demand Causes 
When researching late demands, also look for the following situations:

• Item fixed and variable lead-times that do not accurately reflect the length of the 
routing process. This can result in less optimal pegging which can indirectly cause 
lateness. It is especially a problem for buy orders with no supplier lead-time and for
transfer orders whose source organization is not planned. 

• Transportation resource availability inaccurate

• In-transit duration setup between organizations inaccurate

• Many units of a resource are available but the resource assigned units specified on a
routing is a lower number. The planning engine uses the routing assigned units as 
an upper limit on the number of resource units it schedules.

• Preprocessing lead-time inaccurate

• For buy orders, supplier lead-time and postprocessing lead-times

• For transfer orders, the intransit and postprocessing lead-times
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Researching Late Demands Example
A sales order line for item A has due date 7 September. The item receives a Late 
replenishment for sales order exception message for the 7 September demand with 
demand satisfied date 30 September. 

Check the critical path for completion of the demand. The gaps between levels on the 
critical path are the best indicator of the constraints, even more than the difference 
between actual times.

A gap is usually caused by a combination of several constraints, for example, the 
precedence with the previous level and resource constraints on the current level. 

Determine that the reason for the late demand is a precedence constraint on a 
subassembly; the EPST of the subassembly is 20 September.

Determine the cause of EPST of subassembly is resource availability of RES1.

Check earliest possible start time (EPST) and earliest possible completion date (EPCT) 
for one of the tasks scheduled on RES1 on 18 September.

Check resource utilization profile for RES1 to determine tasks on RES1 for 18 
September. 

Identify tasks of the same priority, higher priority, and lower priority.

Check material constraints that might cause a bottleneck to the operation.

Check other late demand causes, for example, item lead-times and planning time fence 
constraints.

Viewing Late Demand Information
To obtain more information about the root causes of a late demand, use the following 
Planner Workbench windows:

• Gantt Chart Orders View: A graphical interface of the late demand with all the 
supplies pegged to it, start and end times, and critical activities contending for 
capacity.

• End Pegged Supplies: Supplies pegged to the late demand including the supplies 
for the independent demand and for all the dependent demands.

• Critical Activities: The activities that lie in the critical path of meeting the end 
demand. If you focus on expediting these, you should see the most improvement in 
the demand satisfied date.

Days Late (Unconstrained) is (Due Date / End Date) – Unconstrained Latest 
Possible Completion Time.

For Constrained - Enforce due date plans with profile option MSO: Lead Time 
Control set to Do Not Violate Minimum Processing Time, Due Date/End Date is the 
same as Unconstrained Earliest Possible Completion Time.

If the critical path encounters a firm discrete job, firm planned order, or firm operation),
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it displays information until the last activity of the firmed supply. It does not consider 
the following as critical: 

• All operations of the firmed supply

• Components pegging to the firmed supply

To access root cause information
1. Access any of the following windows:

• Exception Details window for Late replenishment for sales order or Late 
replenishment for forecasts.

• Exception Details window for Material constraint or Resource constraint. 
Right-click and exception and select Related Exceptions. View Late 
replenishment for sales orders and Late replenishment for forecasts.

• Supply/Demand window or Demand window for an item. Select a late demand.

2. Right-click on a late demand.

For the Gantt Chart, Order view, select Gantt Chart, then select Order view. 

For more information on the Gantt chart, see The Order - Centric View, page 18-159

Information in the Planner Workbench Critical Activities Window
The Planner Workbench Critical Activities window shows the activities that lie in the 
critical path of meeting the end demand. If you focus on expediting these, you should 
see the most improvement in the demand satisfied date.

Earliest Order Date

Earliest Completion Date

Min Feasible Start Time: For

• Planned orders, the planning time fence

• Scheduled receipts outside the planning time fence, the planning time fence

• Buy scheduled receipts inside the planning time fence, Old Dock Date

• Make scheduled receipts inside the planning time fence, Old Start Date

Min Possible Days Late

Critical Path Number: The planning engine assigns this number when there is more 
than one critical path. It has no meaning for the planner.

Critical Path Level: The level in the supply chain bill of an item. The higher the number,
the lower the item is on the bill. For example, you have a supply chain bill of material A
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> B > C. The planning engine assigns these critical path levels:

• 1: Item A

• 2: Item B

• 3: Item C

Gap: The time between an operation and its previous operation. The planning engine 
calculates it as the Earliest Possible Start Time of this operation - the Latest Possible 
Completion Time of the previous operation.

Planning Level: The level in the supply chain routing of an item-operation. The higher 
the number, the lower the item-operation combination is on the routing. For example, 
you have a supply chain bill of material A (operations 10, 20, and 30) > B (operations 10, 
20, and 30) > C (operation 10). The planning engine assigns these planning levels:

• 1: Item C, operation 10

• 2: Item B, operation 30

• 3: Item B, operation 20

• 4: Item B, operation 10

• 5: Item A, operation 30

• 6: Item A, operation 20

• 7: Item A, operation 10

Scheduled Demand: The demand that the supply's critical path satisfies

Online Simulation
You can simulate different ways to resolve exceptions before you make permanent 
changes by modifying information.

Supplier capacity:

• Add supplier capacity

• Modify dates and quantities

Resource availability:

• Add resource availability

• Modify dates and quantities

• Add new shifts
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Supplies:

• Add planned orders

• Firm planned orders, discrete jobs, and purchase orders

• Modify quantities, dates, sources, and alternates

Demands:

• Add Manual MDS

• Modify order priority

Plan Options: Modify objectives

In this process, you may eliminate one exception but create another. For example, if you
decide to offload some operations to a different resource, you may overload it.

Identifying Differences Between Plans
If you rerun a plan or run a new plan after making changes or simulated changes, you 
can compare two plans to find out why the two plans differ. This is useful for 
determining if:

• Actions taken by a planner to solve a specific problem have the desired overall 
effect

For example, a planner may choose to address a late sales order by increasing the 
priority of the sales order, and then replanning (generating a new plan in the 
process). By comparing the new plan to the original plan, the planner can see 
whether the problem sales order is now on time, and whether any other sales orders
may have been pushed out as a result of pulling in the problem sales order. 

• Plan setup changes led to changes in key indicator performance. You can compare 
the plan option settings for two plans.

To compare plans, use the Plan Comparison Report. See Plan Comparison Report, page 
22-3.

Implementing Plan Changes
Based on the results of your analysis, online simulations, and plan comparisons, you 
can implement changes in the execution system:

• Make most changes in the source instance, including changes to sourcing rules 
defined in the source.

• Make cross-instance planning sourcing rule changes in the destination instance. 
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18
Planner Workbench

This chapter covers the following topics:

• Overview of Planner Workbench

• Tailoring the User Interface

• Using the Context Windows

• Implementing Planning Recommendations

• Interactive Scheduling Using the Gantt Chart

• Accessing Planner Workbench From Oracle Collaborative Planning

• Displaying Suppliers Modeled as Organizations

Overview of Planner Workbench
The Planner Workbench is a powerful graphical tool that lets you perform advanced 
simulation, review plan performance, and take actions based on system 
recommendations.

You can use:

• Planner Workbench to view the output of a plan run. Navigate to Supply Chain 
Plan > Workbench

• Collections Workbench to view collected data from the source instance. Navigate to 
Collections > View Collected Data

Both have the same structures and navigation styles.

Planning Detail Report
The Planning Detail Report provides a simple and consolidated report that shows the 
output of the advanced supply chain planning process. The report gives detailed 
information to help you understand and analyze the supply chain planning results by 
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presenting the data selectively and coherently. For a given Supply Chain Plan, the 
report includes the relevant details about items, resources, gross requirements, 
scheduled receipts, planned orders, plan constraints, and exceptions in separate 
worksheets. 

See Planning Detail Report, page 22-7.

General Navigation
The Planner Workbench consists of two main tabs, Plan and Queries. The Plan tabbed 
pane appears by default. However, you can change the default pane settings in the 
Preferences window. You can specify Queries as the default tab in the Others tabbed 
pane of the Preferences window.

The Plan tabbed pane displays a list of plans in a tree structure. You can drill down to 
the elements in the tree and view corresponding information such as exception 
messages, supply and demand. The detailed information related to the selected item 
appears in separate context windows. You can use the following to navigate to various 
context windows for the selected item:

• Icons

• Tools menu

• Right-click pop-up menu

The Plan tabbed pane displays all available plans for your organization whereas the 
Queries tabbed pane displays filtered information. You can create specific queries to 
filter items, resources, supply, demand, exception messages, and suppliers according to 
your criteria in the Queries tabbed pane. For more information on the Queries tabbed 
pane, refer to Queries Tabbed Pane.

Plan Tabbed Pane
The Plan tabbed pane displays a list of plans for an organization. These plans are 
arranged in a hierarchical tree format. You can expand a plan to view its elements or 
nodes.

View By
You can view a plan by:

• Actions

• Items

• Organizations

• Projects
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• Resources

• Suppliers

You can select your view by preference from the View By drop-down menu that is 
available at the top in the Navigator. The following sections show the drill down 
information for each view.

Actions
Plans > Versions >Exception Groups ...

For exception sets other than Recommendations,

... > Exceptions > Organizations > Items

For Recommendations exception set,

... > Scheduled Receipt Type > Organizations > Items

Items
Plans > Product Families/Models/Option Classes or Categories > Items ... 

... > Organizations > Components/Departments/Lines/Transportation Resources

... > Approved Suppliers

Organizations
Plans > Organizations ...

... > Product Families/Models/Option Classes or Categories > Items > 
Components/Approved Suppliers

... > Departments > Resources (owned) > Items > Components/Approved Suppliers

... > Transportation Resources

Projects
Plans > Organizations ...

... > Planning Groups > Common > Items

... > Items > Planning Groups > Common

Resources
Plans > Organizations > Department Classes, Resource Groups, Lines, or Transportation
Resources > Departments > Resources > Items

Suppliers
Plans > Approved Suppliers > Categories > Items Organizations
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Drill Down 
In any window with summary information like actions summary or horizontal plan, 
you can drill down to more detailed information by double-clicking on an element. This
feature lets you do the following:

• Drill down on action messages to view details of a particular action.

• Drill down to different levels in the Items, Organizations, and Resources categories 
to view details. 

• Drill either down or up from a supply or demand order in the Pegging tree. 

• When working in the Items or Organizations category, drill down from the 
Horizontal Plan to view supply/demand details. When working in the Resources 
category, drill down from the Horizontal Plan to view resource availability.

• When working in the Items or Organizations category, drill down from the Vertical 
Plan to view supply/demand details. 

Multi-selecting in the Navigator
You can multi-select items or nodes in the Navigator:

• Expand the tree and select a node.

• Hold the Shift key down and select another node.

You can right-click and select an option to view information about the multiple nodes 
you selected.

Note: You cannot use multi-select to select two nodes that do not 
belong to the same folder, nor can you multi-select an item and a 
product family.

Navigating Using Icons
You can use the icons in the Navigator to view detailed information about the element 
you select.

You can use these icons to:

• Create, save and execute queries for filtering items, exception messages, resources, 
suppliers, supply and demand based on specific criteria. The first icon is for 
creating a query while the second and third are for saving and executing queries, 
respectively.

• View the horizontal plan.
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• View the supply and demand details.

• View the exception messages related to the plan or the element.

• View the items related to the plan or the element.

• View the Gantt chart.

• View additional details such as key indicators, process effectivity, and resources.

Based on your selection of plans or elements, icons that are not relevant may get 
disabled. You can select multiple items using Control-Click.

Pull-Down Menus
Pull-down menus take context from the Planner Workbench tree. For example, if an 
item node is selected, the pull-down menus will be related to that item. If a resource is 
selected, the pull-down menu will be related to that resource.

Right-click Menu Options
Right-click menu take context from the Planner Workbench tree. For example, if you 
select an item node, the right-click menu options related to that item appear. The 
right-click menu options available for various node types (elements) when you view by 
Actions, Items, Organizations, Projects, Resources, and Suppliers are listed.

Refer the following table for right-click menu options for various node types in view by 
Actions:

Node Type Right-click Menu Options

Plan Exceptions > submenu: 

  Summary

  Details

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand
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Node Type Right-click Menu Options

  Items > submenu:

  Items

  Resources > submenu:

  Resources

  Key Indicators

  Options

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help

Versions / Exceptions Group / Exceptions Exceptions > submenu: 

  Summary

  Details

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand
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Node Type Right-click Menu Options

  Items > submenu:

  Items

  Resources > submenu:

  Resources

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help

Organization Exceptions > submenu: 

  Summary

  Details

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items
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Node Type Right-click Menu Options

  Resources > submenu:

  Resources

  Key Indicators

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help

Items Exceptions > submenu:

  Summary

  Details

  Horizontal Plan > submenu:

  Default

  Vertical Plan

  Supply/Demand > submenu:

  Supply

  - Demand

  Supply/Demand

  Onhand
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Node Type Right-click Menu Options

  Items > submenu:

  Items

  Substitutes

  Resources > submenu:

  Resources

  Supply Chain > submenu:

  Sources

  Supply Chain Bill

  Destinations

  BOM/Routings > submenu:

  Components

  Routing Operations

  Where Used

  Process Effectivity

  Co-Products

  Key Indicators

  Refresh >submenu includes All and Only 
Selected

  Properties

  Delete

  Help
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Refer the following table for right-click menu options for various node types in view by 
Items.

Node Type Right-click Menu Options

Plan Exceptions > submenu:

  Summary

  Details

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Resources > submenu:

  Resources

  Key Indicators

  Options

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete
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Node Type Right-click Menu Options

  Help

Categories Exceptions > submenu:

  Summary

  Details

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Resources > submenu:

  Resources

  Key Indicators

  Expand Partial

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete
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Node Type Right-click Menu Options

  Help

Items / Organizations / Components / Where 
Used

Exceptions > submenu:

  Summary

  Details

  Horizontal Plan > submenu:

  Default

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Resources > submenu:

  Resources

  Supply Chain > submenu:

  Sources

  Supply Chain Bill

  Destinations

  BOM/Routings > submenu:
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Node Type Right-click Menu Options

  Components

  Routing Operations

  Where Used

  Process Effectivity

  Co-Products

  Key Indicators

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help

Refer the following table for right-click menu options for various node types in view by 
Organizations.

Node Type Right-click Menu Options

Plans Exceptions > submenu:

  Summary

  Details

  Supply/Demand > submenu:

  Supply
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Node Type Right-click Menu Options

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Resources > submenu:

  Resources

  Key Indicators

  Options

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help

Organizations Exceptions > submenu:

  Summary

  Details

  Supply/Demand > submenu:

  Supply
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Node Type Right-click Menu Options

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Resources > submenu:

  Resources

  Key Indicators

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help

Categories Exceptions > submenu:

  Summary

  Details

  Supply/Demand > submenu:

  Supply

  Demand
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Node Type Right-click Menu Options

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Resources > submenu:

  Resources

  Key Indicators

  Expand Partial

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help

Items Exceptions > submenu:

  Summary

  Details

  Horizontal Plan > submenu:

  Default

  Vertical Plan
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Node Type Right-click Menu Options

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Substitutes

  Resources > submenu includes Resources

  Supply Chain > submenu:

  Sources

  Supply Chain Bill

  Destinations

  BOM/Routings > submenu:

  Components

  Routing Operations

  Where Used

  Process Effectivity

  Co-Products

  Key Indicators
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Node Type Right-click Menu Options

  Refresh > submenu includes All and Only 
Selected

  Properties

  Delete

  Help

Departments / Resources / Transportation 
Resources

Exceptions > submenu:

  Summary

  Details

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Resources > submenu:

  Resources

  Resource Availability

  Resource Requirements

  Gantt Chart
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Node Type Right-click Menu Options

  Key Indicators

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help

Refer the following table for right-click menu options for various node types in view by 
Projects.

Node Type Right-click Menu Options

Plans Exceptions > submenu:

  Summary

  Details

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items
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Node Type Right-click Menu Options

  Resources > submenu:

  Resources

  Key Indicators

  Options

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help

Organizations Exceptions > submenu:

  Summary

  Details

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items
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Node Type Right-click Menu Options

  Resources > submenu:

  Resources

  Key Indicators

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help

Planning Groups / Projects / Tasks Exceptions > submenu:

  Summary

  Details

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Key Indicators
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Node Type Right-click Menu Options

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help

Items Exceptions > submenu:

  Summary

  Details

  Horizontal Plan > submenu:

  Default

  Vertical Plan

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Substitutes
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Node Type Right-click Menu Options

  Supply Chain > submenu:

  Sources

  Supply Chain Bill

  Destinations

  BOM/Routings > submenu:

  Components

  Routing Operations

  Where Used

  Process Effectivity

  Co-Products

  Key Indicators

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help

Refer the following table for right-click menu options for various node types in view by 
Resources.
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Node Type Right-click Menu Options

Plans Exceptions > submenu:

  Summary

  Details

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Resources > submenu:

  Resources

  Key Indicators

  Options

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help
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Node Type Right-click Menu Options

Organizations Exceptions > submenu:

  Summary

  Details

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Resources > submenu:

  Resources

  Key Indicators

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help

Department Classes / Departments Exceptions > submenu:
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Node Type Right-click Menu Options

  Summary

  Details

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Resources > submenu:

  Resources

  Resource Availability

  Resource Requirements

  Gantt Chart

  Key Indicators

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete
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Node Type Right-click Menu Options

  Help

Resources / Resource Groups / Transportation 
Groups

Exceptions > submenu:

  Summary

  Details

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Resources > submenu:

  Resources

  Resource Availability

  Resource Requirements

  Gantt Chart

  Key Indicators

  Refresh > submenu:

  All

  Only Selected
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Node Type Right-click Menu Options

  Properties

  Delete

  Help

Items Exceptions > submenu:

  Summary

  Details

  Horizontal Plan > submenu:

  Default

  Vertical Plan

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Substitutes

  Supply Chain > submenu:

  Sources

  Supply Chain Bill



Planner Workbench    18-29

Node Type Right-click Menu Options

  Destinations

  BOM/Routings > submenu:

  Components

  Routing Operations

  Where Used

  Process Effectivity

  Co-Products

  Key Indicators

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help

Refer the following table for right-click menu options for various node types in view by 
Suppliers.

Node Type Right-click Menu Options

Plans / Organizations Exceptions > submenu:

  Summary

  Details
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Node Type Right-click Menu Options

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Resources > submenu:

  Resources

  Key Indicators

  Options

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help

Approved Suppliers Exceptions > submenu:

  Summary

  Details
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Node Type Right-click Menu Options

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Key Indicators

  Refresh > submenu:

  Only Selected

  Properties

  Delete

  Help

Categories Exceptions > submenu:

  Summary

  Details

  Supply/Demand > submenu:

  Supply

  Demand

  Supply/Demand
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Node Type Right-click Menu Options

  Onhand

  Items > submenu:

  Items

  Resources > submenu:

  Resources

  Key Indicators

  Expand Partial

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help

Items Exceptions > submenu:

  Summary

  Details

  Horizontal Plan > submenu:

  Default

  Supply/Demand > submenu:

  Supply
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Node Type Right-click Menu Options

  Demand

  Supply/Demand

  Onhand

  Items > submenu:

  Items

  Resources > submenu:

  Resources

  Key Indicators

  Supplier Information

  Refresh > submenu:

  All

  Only Selected

  Properties

  Delete

  Help

Oracle Advanced Planning Command Center Editable Material Plan

Use the Oracle Advanced Planning Command Center Editable Material Plan to mass 
edit planned orders.

You can navigate to it from:

• Navigator pane from category and item levels

• Personal query results for item

Right click and select New Material Plan. 
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See Oracle Advanced Planning Command Center User's Guide.

Oracle Advanced Planning Command Center Editable Resource Plan

Use the Oracle Advanced Planning Command Center Editable Resource Plan to mass 
edit resource requirements.

You can navigate to it from:

• Navigator pane from department and resource levels

• Personal query results for resource

Right-click and select New Resource Plan.

See Oracle Advanced Planning Command Center User's Guide.

Properties Window
You can view properties for any node in the Navigator or pegging tree by selecting the 
node, then choosing [right-click] > Properties.

For an MRP plan with an MPS plan as a demand schedule, the MRP item may peg to a 
demand in the MPS plan. In this case, the Properties window displays pegging 
information about the end demand from the MPS.

The Properties window displays different views depending on whether you navigate 
from a demand or a supply. The following displays the properties for a supply in the 
pegging tree.

Navigating Through a Find Window 
The Find windows enables you to control the volume of data displayed. You can set 
find criteria for all trees and detail windows. 

The Find window enables you to display basic information for the items in the current 
plan, plus pegging and supply/demand information.

To display the Find window
1. Select a plan in the Planner Workbench.

2. Choose Tools > [Exception Details, Supply/Demand, Supply, Demand, On Hand, 
Items, or Resources].

The Find window appears. You can search for the following item details: 

• ABC Class (Items only)

• BOM Item Type

• Buyer

• Category
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• Effectivity Control

• Exception Set

• Forecast Control

• Item

• MRP Planning Method

• Make or Buy

• Nettable Quantity

• Non Nettable quantity

• Organization

• Planner

• Primary Supplier

• Repetitive

• Standard Cost 

• WIP Supply Type

3. To retrieve all records, leave all fields blank and choose Find.

4. To retrieve a subset of records, enter a search string. You can use just one string in 
your search (containing a criterion, an operator, and a value), or you can enter 
several strings to refine your search.

5. Once you have entered at least one string containing a field name, a condition, and 
(optionally) a value, choose Find to start your search.

6. Optionally, choose a folder to import a previously defined search strings and start 
the search.

Wildcard Search Condition

If you want to perform a wildcard search, set the condition as Starts With. For 
example, if you want to retrieve all items that start with X, set the condition as 
Starts With and specify X in the From field.

Rolling Dates Search Condition

If you want to filter based on rolling dates, select Days From Today as the 
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condition. For example, if you want to retrieve all late replenishments for sales 
order exception messages where the due date is less than five days from today, 
select Days From Today condition and specify 5 in the From field.

Expand Partial
Use Expand Partial to search for item(s) in the tree in the Planner Workbench and 
Collection Workbench. You can enter either the complete item name or a partial name 
with a wildcard.

To use Expand Partial
1. From Planner Workbench, select a plan name from the Navigator.

2. Select a category node, such as Organizations or Items.

3. Right-click on an item in the Navigator.

A menu appears.

4. Select Expand Partial.

The Enter Reduction Criteria for Long List form appears.

5. Enter either a complete item name or a partial item name with a wildcard and select
OK. This search is not case sensitive. 

Matching results (up to 500 in number at a time) are displayed in the left pane. If 
there are no matching items, a message appears in the status bar.

6. Select Cancel to close the window.

Queries Tabbed Pane
The Planner Workbench enables you to filter specific information in a plan. You can 
create queries to filter items, suppliers, resources, and exception messages based on 
specific criteria. You can also save the query and execute it whenever you require.

Navigating the Queries Tabbed Pane
Icons

You can click the icons provided in the bottom of the Navigator to create, save and 
execute queries.

Icon Description

Create Query First icon in the Navigator.
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Icon Description

Save Query Second icon in the Navigator.

Execute Query Third icon in the Navigator.

Right-click Menu Options

You can right-click in the Queries tabbed pane and select the following options 
pertaining to queries:

• Create Query

• Save Query

• View Query

• Execute Query

• Delete Query

• Rename Query 

Navigating Nodes in the Queries Tabbed Pane

The Queries tabbed pane consists of the following nodes:

• Query Result: You can expand the Query Result node to view the results of your 
unsaved queries.

• Personal Queries: You can save your query either as a Personal query or a Public 
query. In case you want to share the query with others planners, save the query as 
Public query. You can create and save various types of queries such as items, 
resources, exception messages, and suppliers within the Personal Queries node. For
example, if you want to create a personal query to filter items in a plan, navigate to 
the Item type in the Personal Queries node, right-click and select Create Query.

• Public Queries: If you want to have exclusive ownership rights to view, execute, 
and modify a query, save it as a Personal query. The Public Queries node comprises
of Item, Resource, Exception, and Supplier. You can create and save various types 
of queries such as items, resources, exception messages, and suppliers within the 
Public Queries node. For example, if you want to create a public query to filter 
exception messages associated with a plan, navigate to the Exception type in the 
Public Queries node, right-click and select Create Query.
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Create a Query
To create a query
You can create queries for filtering items, resources, suppliers, and exception messages 
associated with a plan in the Planner Workbench.

1. Click the Queries tab in the Planner Workbench. The Queries tabbed pane appears.

2. Specify the name of the plan on which you want you run the query.

3. Right-click in the Queries tabbed pane to display the pop-up menu.

4. In the pop-up menu, select Create Query.

Alternatively, you can click the Create Query icon at the bottom of the Queries 
tabbed pane to create queries.

The Create Query window appears.

5. Specify a name for the query in the Query Name field.

6. Select a type of query from the Query Type drop-down menu to specify the 
information you want to filter.

The various types of queries are Item, Resources, Exceptions, and Suppliers. You 
can select Item to create queries that filter information related to items. Similarly, 
you can select Resources and Suppliers to create queries that filter information 
related to resources and suppliers, respectively. For information about how to filter 
exception messages, see Exception Messages, page 17-1.

7. Click Yes in the Public drop-down menu in case you want the query to be visible to 
other planners as a public query.

8. Specify the criteria in the Criteria box. For example, you may want to filter those 
items that need to be purchased. In this case, specify Make or Buy, Equals, and Buy 
in the Criteria, Condition, and From fields, respectively.

The following table lists the criteria for querying items, resources, and suppliers.
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Query Type Criteria

Item ABC Class

BOM Item Type Buyer

Category

Effectivity Control

Exception Set

Forecast Control

Item

MRP Planning Method

Make or Buy

Nettable Quantity

Non Nettable Quantity

Organization

Planner

Repetitive

Standard Cost

WIP Supply Type

Carrying Cost

ATP Flag

ATP Components Flag

Create Supply Flag

PIP Flag

Orders Planning Group

Project

Task
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Query Type Criteria

Resources Department Class

Department Line

Maximum Rate

Minimum Rate

Organization

Owning Department

Resource

Resource Group

Resource Type

Suppliers Approved Supplier

Supplier Site

Buyer

Category

Item

Organization

Planner

Standard Cost

9. To retrieve all the records that meet any one of the criteria that you specify, select 
Match Any. However, if you want to retrieve only those records that meet all 
criteria, select Match All.

10. Select the check box preceding the criteria specifications for those criteria 
specifications that you want to include as active. When you execute a query, the 
planning engine considers only the active criteria as the basis for the search.

11. Click Save to save the query. Based on your selection, the planning engine saves the
query either as a Personal Query or a Public Query.

12. Click Execute to run the query. The planning engine filters and displays the result 
based on the criteria you specified in the query.

View Results of a Query
When you execute a query, the planning engine displays the result to the right of 
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the Queries tabbed pane.

If you want to view the details of a specific filtered row, click the row. When you 
right-click the selected row, the available options appear. You can select the 
required option from the drop-down menu to navigate to context windows such as 
Exceptions window and Horizontal Plan window.

If you want to the view the Results window without the Navigator, you can click 
the Collapse window sliding bar, which is the vertical slider between the Navigator 
and the Results window.

Note: To execute a query for a particular plan, you can specify the 
name of the plan in the Plan field.

Multi-select Items in Query Results Window

You can multi-select specific records or items in the Query Results window. 

For example, you may want to view the demand information for two specific 
records in the Query Results window. Use Ctrl-click to highlight the specific 
records. Select [right-click] > Supply > Demand to view the demand information for 
the items you selected.

Tailoring the User Interface
The following table shows the menu options for the Planner Workbench and what 
happens when a particular menu option is selected.

Menu Menu Option Description

File Export Export the plan information 
to Microsoft Excel.

Edit Duplicate Duplicate a record. 

Edit Clear Edit the current field. 

Edit Delete Delete the current field. 

Edit Preferences Set a user profile.

View Show Navigator Display Navigator window.

View Find Find a record.
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Menu Menu Option Description

View Find All Find all records.

View Query by Example Run queries for certain 
information. 

View Record View a record. 

View Requests Review requests. 

Tools Exception Details View exception details for 
your plan. 

Tools Supply/Demand View supply and demand 
information. 

Tools Supply View supply information. 

Tools Demand View demand information. 

Tools On-Hand View on-hand quantities. 

Tools Items View items information. 

Tools Resources View resources information.

Tools Notifications View notifications. 

Tools Launch Notifications Launch notifications.

Tools Work Dates View work dates for your 
plan. 

Tools Preferences Set preferences. For more 
information, see 'Defining 
Display Preferences, page 18-
44.

Tools Close All Detail Windows Close all context windows 
that are open in the Planner 
Workbench.
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Menu Menu Option Description

Plan Start Online Planner Start online planner.

Plan Online Replan Run replan. 

Plan Stop Online Planner Stop online planner

Plan Online Planner Status View online plan status. 

Plan Batch Replan Run replan in batch mode. 

Plan Save Actions Save actions related to your 
plan. 

Plan Launch New Plan Launch new plan

Plan Copy Plan Copy your baseline plan 
before running a new plan. 

Plan Purge Plan Delete the plan. 

Plan Plan Options View plan options. 

Plan Select All for Release Release all planned orders for 
items with your planner code.

Plan Release Release selected orders only. 

Plan Undo Summary View summary of changes in 
the Planner's Workbench for 
online planning purposes.

Plan Add Undo Bookmark Add bookmark to the Undo 
Summary.

Plan Compare Plans Compare plan exceptions and
options

Plan Firm All Firm all orders that meet the 
requirements you specify in a 
search criteria within the 
planning time fence.
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You can tailor the user interface in the following ways:

Resize Windows
You can resize windows as with any windows-based application. In the Planner 
Workbench you can adjust slide bars to change the relative widths of the Navigator and
the context windows, such as Exception Summary, that you open.

Customize Columns
You can add, hide columns, resize, and move columns on the horizontal plan and folder
windows.

Adjustable Item Field
If you have large item numbers, you can add the Item field to the scrollable region of 
these Planner Workbench windows and adjust its size using folder technology:

• Supply/Demand

• Supply

• Demand

• On Hand

• Items

• Process effectivity

The Item field in the fixed region remains whether or not you also add the field to the 
scrollable region.

Defining Display Preferences
Display preferences control what horizontal material planning data, horizontal capacity
planning data, supplier planning information, transportation planning information, and
supply/demand detail are displayed for each item.

To define your display preferences
1. Navigate to the Planner Workbench.

2. Choose Tools > Preferences.

The Material Plan tab appears as the default tab.

3. Type the name for your preference set.
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A preference set is applicable to all types of horizontal plans. You can create and 
save up to three personal preference sets for viewing a horizontal plan based on 
your requirements. You may want to create multiple preference sets to view 
different levels of information for a horizontal plan. For example, you may want to 
view summary-level information with rows displaying gross requirements, total 
supply, safety stock, and on-hand quantity to validate whether or not supply 
matches demand at a period level. You may also want to view detailed information 
for each supply type on a daily-level.

Preference sets are unique to the individuals creating it. If you create and apply a 
specific preference set, it is available only to you.

4. Enter Display Buckets, Display Factor, Decimal Places, Show Graph and check each 
type of plan information you want to display in your material plan.

Display Factor is a multiplier.

5. Choose the Capacity Plan tab.

6. Check each type of plan information you want displayed in your resource capacity 
plan.

7. Choose the Supplier Plan tab.

8. Check each type of plan information you want displayed in your supplier capacity 
plan.

9. Choose the Transportation tab.

10. Check each type of plan information you want displayed in your capacity plan.

11. Choose the Allocated ATP tab.

Oracle Global Order Promising supports two allocation methods for different 
business needs: 

• Allocated ATP based on User-Defined Allocation Percentage 

• Allocated ATP based on Demand Priority

For more details on Allocated ATP, see Oracle Global Order Promising.

12. Check each type of information you want displayed in your allocated ATP.

13. Choose the Other tab.

Supply/Demand details appear. You can select the following based on your 
requirements:

• Release Phantoms: Enables the release of planned orders for the phantoms.
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• Release Configurations: Enables the release of planned orders for ATO 
items.

• Firm Jobs: Enables the release of the Firm status when you release the work 
in process jobs.

• Include Sales Orders: Enables the release of sales orders (loopback) from 
the Planner Workbench.

• Release VMI Items: Enables the release of those items from the Planner 
Workbench that have the item attribute set to VMI items. This check box is 
selected by default. 

• Job Status: When Planner Workbench creates discrete jobs from planned 
orders, it assigns this status to the discrete jobs. 

14. Enter a Job Status. 

When the Planner Workbench creates discrete jobs from implemented planned 
orders, it assigns the job status you enter in the Preferences window.

15. Select a Job Class. 

When the Planner Workbench creates discrete jobs from implemented planned 
orders, it assigns the job class you enter in the Preferences window.

16. Select a Req Group By default. 

When the Planner Workbench creates purchase requisitions from implemented 
planned orders, it assigns the requisition load group you enter in the Preferences 
window.

If you do not have a value for this preference, Planner Workbench uses the value of 
profile option MRP: Requisition Load Group Option.

Valid values are:

• All on One: Creates one purchase requisition for all recommended orders

• Buyer: Creates one purchase requisition for each buyer; within each requisition,
creates one line for each planned order

• Planner: Creates one purchase requisition for each planner; within each 
requisition, creates one line for each planned order 

• Vendor: Creates one purchase requisition for each vendor; within each 
requisition, creates one line for each planned order

• Category: Creates one purchase requisition for each item category; within each 
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requisition, creates one line for each planned order

• Item: Creates one purchase requisition for each item; within each requisition, 
creates one line for each planned order

• One each: Creates a purchase requisition for each planned order

17. Enter a category set.

This category set is used throughout Planner Workbench. Items that you have not 
assigned to a category in this category set do not appear in Planner Workbench. 

Oracle recommends that you typically select the default planning category set 
specified in Oracle Inventory. Do not select a category set with flag Allow multiple 
item category assignments selected. Planner Workbench does not support item 
assignment to multiple categories and you may experience unexpected results.

18. Under General, select either Plans or Queries in the Default Tab.

You may consider having the Queries tabbed pane as default if you want a query to
be executed automatically each time you open the Planner Workbench. You can 
specify the query name in the Auto Execute Query field. In addition, you can 
specify a default plan that needs to open when you access the Planner Workbench.

View Recommendations for (Days from Today) specifies how many days of 
recommendations you want to see. Planner Workbench calculates Days from Today
using the supply Suggested Order Date.

If you want to view all actions in the expanded form, select Expand All Actions.

19. Choose Save to use your preference selections.

20. Choose Reset to use your previously saved selections.

Note: The parameter Cutoff Date is not supported in Oracle 
Advanced Planning and Scheduling.

Using the Context Windows
You can invoke context windows for a selected plan or element in the Navigator to 
view summary information in tables and graphs, including: 

• Exceptions

• Horizontal Plan

• Vertical Plan 
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• Supply/Demand

• Items

• Resources

• Supply Chain

• BOM/Routing

• Key Indicators

You can highlight one or more nodes on the Navigator to include the result in a single 
context window. You can also use the Find window to further limit the context.

Context Synchronization Between the Context Windows and the Navigator
The planning engine refreshes the context window to synchronize with the node that 
you select in the Navigator. The planning engine refreshes the context in an open 
context window when you: 

• Select a context window from the right-click pop-up menu

• Click the available short cut icons

• Drill down in an open context window

Exception Summary Window
The Exception context window segregates all of the exception messages that require 
immediate attention.

To view exceptions 
1. Choose a plan for which to view exception messages. You can view exception 

messages at the item level by selecting an item.

2. Drill-down to the item level and right-click the item.

3. To view the Exceptions Summary window, click Exceptions > Summary.

The Exceptions Summary window appears.

The Exception Summary window lists exception groups and exception messages for
the selected plan in order of their usefulness in troubleshooting. For instance, 
exceptions due to late sales orders appear before exceptions due to resource 
constraints.

Using the Find window, you can sort, group, or sub-total exceptions according to 
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various criteria including item, supplier, or buyer, for example.

To expand all actions
If you want to expand all actions in the Exceptions Summary window, perform the 
following steps within the Exception Summary window:

1. In the Exceptions Summary window, click in any row that has data.

2. Select [right-click] > Expand All.

The expanded actions appear.

If you want to specify your preference of viewing the expanded actions each time 
you access the Exception Summary window, perform the following steps:

3. Click Tools > Preferences to open the Preferences window.

4. Click the Other tab.

5. In the General box, select Expand All Actions.

6. To save your preference, click Save.

7. Close the Preferences window. When you view the Exception Summary window, 
the expanded actions appear.

To sort exceptions
1. From the Exception Summary window, select View > Find. 

The Find Actions window displays. 

2. Select criteria by which to sort exceptions. 

3. Check Display Message Count check box. 

4. Select Find button.

Exception messages appear in the Exception Summary window sorted accordingly. 

Exception Details Window

To view exception details
Choose [right-click] > Exceptions > Details on an item. The Exception Details window 
appears.

Exception details display pre-seeded default folders (combination of various key 
columns) based on exception type. For example, Late Replenishment for Forecast 
exception detail has a different exception default folder than Material Constraint 
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exception.

Note: If you select several different exceptions, the generic default 
folder appears. You can customize exception folders based on your 
preferences and save it as the default. This is explained in the next 
section.

Please note that the Days Late column is available and filled in for the following 
exceptions: Late Replenishment for Forecast and Late Replenishment for Sales Order.

The column named Quantity Satisfied By Due Date in the Exception Details form is 
used to present the portion of a demand that can be satisfied by the due date.

Drill Down to Related Exceptions
If you are working in a constrained or optimized plan, you can drill down from an 
exception to Related Exceptions (Right Mouse Options) to analyze questions like:

• Why is the order late? Is it because of a resource, material, or transportation 
resource constraint?

• A material/resource/transportation resource issue is detected. Will it cause any late 
orders?

The objective is to explain the cause and effect of the problems. The related exceptions 
that each exception drills down to are indicated by an arrow.

On the other hand, from the constraint exception (resource, material, or transportation 
resource), you can also drill down to Late replenishment for sales order/forecast if the 
constraint causes the late replenishment.

This feature only applies to the following:

• Late replenishment for sales orders

• Late replenishment for forecast

• Material constraint

• Resource constraint

• Transportation resource constraints

To view related exceptions for the Late Replenishment for Sales Order
1. Select a row in the Late Replenishment for Sales Order Exception Details window. 

2. Choose [right-click] > Related Exceptions.

Related exceptions appear in the Exception Details window.
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Relevant Information Buttons
On the Exception Details window, additional information about the exception can be 
obtained through clicking the buttons on the bottom of the window. The type of 
exception determines what buttons are available. For example, the Items and 
Supply/Demand buttons are available for the Late replenishment for sales order 
exception. 

The following buttons are available:

• Suppliers: For details on the Suppliers window, see 'Supplier Capacity Window, 
page 18-124.

• Resources: For details on the Resources window, see 'Resources Window, page 18-
129.

• Items: For details on the Items window, see 'Items Window, page 18-114.

• More Details

• Supply/Demand: For details on the Supply/Demand window, see 'Supply/Demand ,
page 18-64.

Right-click Menu Options
From the Exception Details window, planners can obtain more information through a 
right mouse click on the exception. The type of right mouse options users have is 
determined by the exception that is selected. Options included are:

• Supply

• Demand

• Resource Availability

• Resource Requirements

• Sources

• Destinations

• Related Exceptions

• Gantt Chart

• Horizontal Plan

• Vertical Plan
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• End Pegged Supplies

• Critical Supplies

• Calendar

Horizontal Plan
You can display your plan information horizontally or vertically.

The horizontal plan information is displayed in a pivot table enabling you to drill down
from years, to periods, to weeks, to days. The following table shows the default display 
for the horizontal plan for each plan type: 

Plan Type Default Display

Material Plan Projected Available Balance

Capacity Plan Required Hours vs. Hours Available

Supplier Plan Required Capacity vs. Available Capacity

Transportation Plan Weight Capacity Available vs. Weight 
Capacity Required

The horizontal plan does not show fictitious demand created at the planned inventory 
point level.

For long-running processes, you can segment the material completions from a supply 
over the time of the process (supply segments). However, the horizontal plan displays 
its supply information, including information relating to available-to-promise, as if all 
of the supply is only available as of the supply due date. 

Viewing the Horizontal Plan
To display your horizontal plan
1. Select one or more items, resources, lines, transportation resources, or suppliers 

from the Navigator.

2. Select [right-click] > Horizontal Plan > Default. If you create multiple preference sets
for the horizontal plan, the preference set names appear in the Horizontal Plan 
right-click pop-up menu. You can select the preference set based on your 
requirement. For more information on preference sets, see 'Setting Preferences for 
Viewing Horizontal Plan, page 18-60.
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Viewing Item Demand/Supply Across All Organizations 
The horizontal plan in the Planner's workbench supports an aggregate view of 
supply-demand for items across all organizations in the supply chain plan.

To view an item's horizontal plan across all organizations
1. Navigate to the Planner Workbench.

2. There are two ways of viewing the horizontal material plan across all organizations:

• View by items and highlight an item. This option provides you with an 
aggregate view across all organizations. The planning engine displays the 
numbers in the horizontal plan as an aggregate of all organizations.

• Alternatively, you can expand the item node and multi-select all organizations 
that the item is planned for. This option provides you the horizontal plan for 
each organization that you select.

3. Select [right-click] > Horizontal Plan > Default (or any preference set you may have 
created). 

The horizontal plan information is displayed in a pivot table that enables you to 
drill down from aggregate to periods to weeks to days.

Information in the Horizontal Plan View
This table describes the fields displayed in the Horizontal Plan window, Material Plan:

Field Description

Sales orders Sales orders, including internal sales orders.

Forecast Forecasts from Oracle Inventory and Oracle 
Demand Planning.

Production forecast Demand generated by the forecast explosion 
process based on product families, models, 
and option classes. This helps differentiate 
between dependent demands and derived 
dependent demands.

Dependant demand The planning engine calculates the dependent 
demand.

Expected scrap Demand resulting from the application of the 
Shrinkage Rate item attribute to existing 
supplies and planned orders.
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Field Description

Payback demand Demand resulting from a borrow or a payback
transaction in Oracle Project Manufacturing.

Other independent demand This includes the following: 

- Hard reservation (against sales order in 
Oracle Order Management)

- Copied Schedule Demand

- Demand Class Consumption (used by 
allocated ATP)

- Expired Lots

- Non-standard Demand

Gross requirements The planning engine calculates the total 
demand in the following way:

Sales Orders + Forecasts + Production Forecast
+ Dependent Demand + Expected Scrap + 
Payback Demand + Independent Demand

The total demand from sales orders, forecasts, 
dependent demands, payback demand, scrap 
demands, expired lots, and other demands.

Work Orders Existing make orders from Oracle Discrete 
Manufacturing, Oracle Process 
Manufacturing, Oracle Flow Manufacturing, 
and Oracle Project Manufacturing.

Purchase orders Existing purchase orders.

Requisitions Existing requisitions without corresponding 
purchase orders, including internal 
requisitions.

In Transit Interorganization transfer quantities or 
quantities shipped from suppliers (after the 
customer receives the advanced ship notice).

In Receiving Quantities that are received at the receiving 
dock but are not yet received into the 
inventory.
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Field Description

Planned orders Make and buy planned orders

Payback supply Supply resulting from a borrow or a payback 
transaction in Oracle Project Manufacturing.

Total supply The planning engine calculates total supply as
an aggregate of work in process, purchase 
orders, purchase requisitions, in transit, in 
receiving, planned orders, and payback 
supply.

Beginning on hand The amount of stock in inventory at the 
beginning of a plan on hand. The value is 0 for
all subsequent periods.

Projected available balance The planning engine calculates this as:

Beginning On hand + Total Supply - Total 
Demand

Current scheduled receipts The planning engine calculates this as the sum
of work in process, purchase orders, purchase 
requisitions, in transit, in receiving, and 
payback supply.

Projected on hand The planning engine calculates this as:

On hand + Beginning Total Supply - Total 
Demand

The planning engine does not include planned
orders to calculate the projected on hand.

Safety Stock Safety stock level at the end of the bucket.

Net ATP This indicates the difference between the net 
supply and demand after ATP performs all 
forward and backward consumption.

Expired lots This indicates the quantity of expired lots.
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Field Description

ATP+ The available to promise quantity available 
based on the plan without considering capable
to promise or capable to deliver, The quantity 
available is as of the plan run and does not 
account for any supply/demand changes since
the plan run.

Planned Repair Work Orders, Maintenance 
Work Orders, Defective Part Demand, Returns
Forecast, Defective On-Hand, Defectives 
In-Transit, Projected Available Balance 
(Defective) 

For asset intensive planning

- The defective item supply quantities for 
repair--on hand, in process, and in transit.

- The item demand quantity of forecasted 
returns

- The predicted balance of defective items

This table describes the fields displayed in the Horizontal Plan window, Capacity Plan:

Before you collect resource availability, attend to source system profile option MRP: 
Cutoff Date Offset Months. It tells the planning engine how many months of resource 
availability to calculate for resources and simulation sets. The planning engine does not 
calculate this information beyond this horizon. For constrained plans beyond this 
horizon, resource capacity is infinite. Set this value to your plan horizon. A large 
setting, for example, 12 months, could impact your planning engine performance.

Field Description

Hours available Calculated based on setups of resources. 
Collect this information during the collections 
process using Resource Availability set to 
either:

- Collect Existing Data

- Regenerate and Collect Data

In the operational data store load parameters, 
set Recalculate Resource Availability to Yes.

Setup hours Required hours of setup time, including 
changeover setups

Setup hour ratio Ratio of Setup Hours to Total Hours Available
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Field Description

Run hours Required hours of run time (does not include 
setup time)

Run hour ratio Ratio of Run Hours to Hours Available

Required hours Total Required hours

Net hours available Hours Available - Required Hours

Cum hours available Net available across the plan horizon

Capacity load ratio Load ratio of Required Hours to Hours 
Available for the bucket

Cum capacity load ratio Load ratio of Cum Required Hours to Cum 
Hours Available across the plan horizon

Hours required per day Daily hours required

Hours available per day Daily hours available

Net ATP Available to promise availability

Maintenance Work Order and Planned Repair 
Work Order

For asset intensive planning, the required 
hours for these order types.

Custom Rows
If information that you want to see that is not available on the Horizontal Plan, you can:

• Make your own custom row

• Choose a label for it

• Select the information to display in it

• Enable it selectively, for example, by user or by preference

For example, you want to see projected available balance shown in value instead of in 
quantity.

If the Horizontal Plan contains information that you want to see in a different way, you 
can modify it. For example, you might want so see information a Horizontal Plan row 
in an alternate unit of measure.
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To use a custom row:

• Specify the information to display: Provide a PL/SQL program unit with no 
parameters that. Enter the name of the program unit in profile option MSC: 
Horizontal Plan Extension Program. You can choose the level—site, responsibility, 
or user.

• Set its title: Navigate to the Manufacturing Lookups form and select lookup type 
MRP_HORIZONTAL_PLAN_TYPE_SC. Find the row for Code 500, Meaning User 
Defined, move to the Description field, and enter the title.

• Enable it: Navigate to the Preferences form, Material Plan tab. Select Demands and 
select User Defined.

To modify the data in other rows:

• Specify the modified information: Provide a PL/SQL program unit with no 
parameters that. Enter the name of the program unit in profile option MSC: 
Horizontal Plan Extension Program. You can choose the level—site, responsibility, 
or user. If you are also using a custom row, specify the information in the same 
PL/SQL program unit as you did for the custom row.

• Enable them: Navigate to the Preferences form, Material Plan tab. Select Demands 
and select User Defined.

Exporting the Horizontal Plan
To export a horizontal plan to Microsoft Excel
You can copy or export an entire expanded horizontal plan to various other document 
formats such as Microsoft Word, Microsoft Excel, and Microsoft Notepad. If your 
operating system does not support clipboards, you cannot copy the plan.

1. In the horizontal plan tabbed region, right-click in the Items or Organization area in
the right pane.

2. Click Copy horizontal plan to copy the horizontal plan to the clipboard. 

3. Open an application such as Microsoft Word, Excel, or Notepad to paste the copied 
content.

4. Paste the horizontal plan using the Paste feature of the opened application.

Dynamically Define Graphs
Define graphs by selecting which pieces of information to graph.

To define information to be graphed
1. Navigate to the Horizontal Plan window.

2. Select the plan parameters you want to graph. 

To graph two or more parameters together, hold the shift key as you select 
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additional parameters. For example, you can graph either planned orders, gross 
requirements, or both. You can also choose to graph multiple items. 

3. [Right-click] to show and hide graph or save preference in the Tools > Preferences 
menu. 

4. [Right-click] on the Items or Organization area to display more options. Left click 
on Hide/Show Graph to hide the graph. 

5. To change the number of periods being displayed in the horizontal graph, 
[right-click] anywhere in the graph and select Viewable Groups. Your choices are 5, 
7, or 10. Five is the default.

Dynamically Choose Types of Graphs 
After you have graphed parameters or items, you can change the chart type using the 
[right-click] menu. For example, if you have displayed a bar chart and you wish to 
display a line graph, select [right-click] > Line Chart.

To change the number of periods being displayed in the graph
Right-click on the graph and select Viewable Groups. The choices are 5, 7, and 10, with 
5 as the default.

Save Settings for a Horizontal Plan
You can specify and save your preferences for various option settings while viewing a 
horizontal plan. When you login again, your preference settings would be in effect for 
the plan. You can save settings for Item, Resource, Transportation, and Supplier types 
of horizontal plan. The following table lists the option settings that you can specify and 
save:

Setting Description

Hide or Show options for a row You can specify the options that should be 
hidden or shown for a row. These settings are 
updated in the Preferences window.

Hide/Show graph You can specify whether or not you want the 
graph to be shown. These settings are updated
in the Preferences window.

Column width and row height of data cells You can adjust the width and height of the 
data cells as per your requirement in the 
Planner Workbench. When you save your 
settings, these settings are updated and 
maintained by the system internally.

To save your preferences for a horizontal plan
After specifying your preferences for a horizontal plan, perform the following steps to 
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save your preferences.

1. [Right-click] on the Items or Organization area to display more options.

The menu appears.

2. Click Save Settings.

When you login again and return to the Planner Workbench, the settings that you 
saved are retained.

Setting Preferences for Viewing Horizontal Plan
For information on defining display preferences, see 'Defining Display Preferences, 
page 18-44.

Change Preferences
You may have multiple preference sets for a horizontal plan. If you want to switch 
between the preference sets, select [right-click] > Change Preferences. In the right-click 
pop-up menu, click the title of the preference set that you want to view.

Set Number Formatting for Horizontal Plan
As the number of order quantity increases, you may want to specify your preference for
a number format to ease viewing numbers that run into millions. You can format and 
view numbers based on your preference for a horizontal plan.

To set the format preference for horizontal plans
1. To set the format preference for horizontal plans, navigate to the General 

Preferences window in the Oracle Self-service Web Applications.

2. Select your preference from the Number Format drop-down menu.

3. Click Apply.

Product Family and Member Item Drill Down
Aggregate Production Plan
You can view aggregate production plans in the Planner Workbench. The supply and 
release of planned orders related to member items are reflected in the aggregate 
planned order at the product family level. The summation of the actual quantities for 
member items provides the quantity and type of supply for the product family item. 
You can use this for demand leveling and plan analysis.

You can specify whether or not you want to view details of member items that belong 
to a plan in a horizontal plan. If you want to view the product family details in the 
horizontal plan, select the Display Product Family Details check box in the Material 
Plan tabbed pane of the Preferences window.

The planning engine displays two sections in the horizontal plan view. The first section 
includes the following information about the product family items:

• Forecast

• Gross requirements
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• Planned orders

• Total supply

• Projected available balance

The order types associated with the product family appear against the product family 
node in the first section.

The second section includes member total (all items belonging to the product family) for
the plan. The member total includes all order types. You can use the Show and Hide 
right-click menu options to view specific order types. Calculations related to member 
item totals are based on only those member items that are part of the same plan.

You can double-click a row related to firm supplies such as work in process and 
on-hand, the planning engine displays details of the individual items. However, for 
detailed information, you can use the Planning Detail report.

Comparing Multiple Items
You can view and compare items that belong to two different categories in the 
horizontal plan. To select more than one items in different categories, highlight an item 
in the Navigator, hold the Shift key down and select another item.

Global Forecasting
There is a possibility that you may not know the exact demand fulfilling facility at the 
time of preparing and analyzing forecasts in case you have you have multiple shipping,
distribution, and manufacturing facilities. You can use global forecasting for consuming
forecast without any reference to a shipping organization. You can distribute a forecast 
to multiple shipping locations.

You need to choose a demand planning scenario published without a context of an 
organization. In addition you need to choose a Ship to consumption level. Following are
the consumption levels supported:

• Configure a forecast and define the Ship To entity. Specify any one of the following 
values for the Ship To:

• Item

• Zone

• Customer

• Customer Zone

• Customer Site

• Demand Class

• Select the Global Forecasting check box in the Preferences window (Material tabbed
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pane).

• In the View by Items mode, select an item and navigate to the Horizontal Plan 
window.

The global forecast section appears in the Horizontal Plan window. If this section does 
not appear, use the Show option from the right-click menu to display it. The following 
information appears in the global forecast section:

• Item name

• Original: This refers to the time phased global forecasts that Oracle Demand 
Planning publishes.

• Cumulative Original: This indicates the cumulative value of the original time 
phased global forecasts.

• Consumed: This indicates the number of sales orders that are consuming the 
forecasts. You can drill down from here to view the set of sales order in the 
Supply/Demand window.

• Cumulative Consumed: This indicates the total number of sales orders based on the
Consumed field.

• Current: This refers to the original sales order. A negative value indicates over 
consumption. You can drill down from this field to the individual distributed 
forecasts. When you double-click in this field, the Supply/Demand window 
appears. You can view details regarding the distribution of the consumed amount 
across organizations.

• Cumulative Current: This refers to the total number of original sales order based on
the values from the Current field.

• Expired Forecast: This refers to the amount of unmet forecasts. You can specify the 
number of days a forecast can remain unmet. If a forecast cannot be met until the 
specified number of days, the planning engine displays the forecast as an unmet 
forecast.

Drill-down from Forecast Row in Horizontal Plan
You can double-click the forecast row in the Horizontal Plan window to drill-down to 
the Supply/Demand window. However, in the case of global forecasting, you can drill 
down only from the consumed numbers field.

If you want to view consumption details, you can select [right-click] > Consumption 
Details option.

Information in the Consumption Details window is detailed in the following table:
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Field Description

Sales Order This indicates the sales order number.

Sales Order Sched Date This indicates the scheduled ship date for the 
sales order.

Consumed Qty This refers to the quantity consumed.

Consumption Date This refers to the quantity consumption date.

Promise Date For more information, see Lead Time and the 
Planning Time fence, page 6-76.

Request Date For more information, see Lead Time and the 
Planning Time Fence, page 6-76.

End Item This refers to the end item that consumed the 
forecast. An end item is applicable for option 
class and optional items.

Original Item This indicates the original item for which you 
received the demand. This information is 
applicable only if the original item is 
substituted.

Drill-down from Global Forecasting Section in Horizontal Plan
The following drill-downs are supported from the global forecasting section in the 
horizontal plan:

• You can drill-down from the current quantity field to the Supply/Demand window 
to view distributed forecasts.

• You can drill-down from the consumed quantity field to the Supply/Demand 
window to view the sales orders that consumed the forecasts.

Safety Stock Level
To see if your plan satisfies safety stock levels, verify that the projected available 
balance is the safety stock level. If it is not so exactly, it may be because of:

• The planning engine could not schedule all supplies on time because of resource, 
material, and transportation constraints

• The reasons in Other Safety Stock Planning Principles in Safety Stock, page 6-133.
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Vertical Plan
The Vertical Plan view is enabled for an Item-Org context and it displays the activity by 
item over time in a vertical format (non-bucketized).

View Vertical Plan
To display your plan vertically
1. Select one or more items from the tree in the Navigator.

2. Select [right-click] > Vertical Plan.

Right-click Menu Options in a Vertical Plan
Based on the context of the selected field, the planning engine displays right-click menu
options. If you right-click in an information field (non-fixed field) within a vertical plan,
you can:

• Choose to view additional fields associated with the vertical plan.

• Hide fields that you do not want.

• Move selected fields either to the right or the left.

• Increase or decrease the field size.

• Change the prompt or the heading of the field.

• Drill down to the Supply/Demand and Item windows.

When you right-click the graph shown for a vertical plan, the planning engine displays 
three options: Days, Weeks, and Periods. You can choose the time frame for which you 
want to view the graph.

Supply Demand Window
The Supply/Demand window displays information about supplies and demands and 
shows pegging information.

View the Supply/Demand Window
You can navigate to the Supply/Demand window from various node types such as 
items, organizations, plans, departments, and planning groups in the Navigator. In 
addition to the Navigator, you can also drill down to the Supply/Demand window from
other windows such as the Vertical Plan window.

If you request this window from the Exception Details window, it displays supply 
information, demand information, or both types of information based on the exception 
type. For example, if the exception message is Demand satisfied using end item 
substitution, the Supply/Demand window displays demand information only.
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To display the Supply/Demand window 
1. Select one or more nodes (using Ctrl-click) in the Navigator.

2. Select [right-click] > Supply/Demand.

The Supply/Demand pop-up menu displays the following options:

• Supply

• Demand

• Supply/Demand

• Onhand

3. To display the Supply/Demand window, click Supply/Demand.

Supply/Demand window has five tabbed regions:

• Order

• Release Properties

• Sourcing

• Line

• Project

Each tabbed region displays fixed fields:

• Org

• Item

• For Release

• Firm

While each tabbed region shows different variable fields, you can access all of the 
Supply/Demand window variable fields using the Orders tab folder function.

Supply/Demand Window Notes
Internal Requisitions and Sales Orders

If you cancel an internal requisition and do not cancel the corresponding internal sales 
order, Planner Workbench:

• Displays the internal requisition with a cancel reschedule recommendation since the
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planning engine can only issue a cancel recommendation for a supply

• Does not display the internal sales order. The planning engine does not plan to 
satisfy the demand.

Safety Stock

To analyze how the planning engine has planned to meet safety stock levels, select the 
supply and analyze the pegging details. The pegs between a transient safety stock level 
and supplies peg with supply quantity zero. This is because the supply pegs to a 
demand after the safety stock level expires; the peg to the demand has the quantity. The
pegs between a non-transient safety stock level and supplies peg with quantities that 
meet the safety stock level. To understand safety stock pegging, see Safety Stock 
Pegging in Pegging, page 18-83.

Order Tabbed Pane
The following table provides a description of the fields displayed in the Order tabbed 
pane:

Fields Description

Order Type This refers to the supply or the demand type. 
For example, purchase order, sales order, 
planned order.

Part Condition For asset intensive planning, the condition of 
the item in inventory or the condition of the 
item after you perform work.

Sugg Due Date The planning engine populates this for 
demands and supplies. For more information, 
seeLead Time and the Planning Time Fence, 
page 6-76.

Qty/Rate Supply, demand quantity, or rate.

Visit, Produce to Stock, Maintenance 
Requirement, Operating Fleet, and 
Maintenance Plan 

For asset intensive planning, production order
attributes for order types Maintenance Work 
Order and Maintenance Work Order Demand.

Order Number Identifies the supply or the demand record. 
For purchase orders, displays purchase order 
number, line number, release number, 
shipment number.
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Fields Description

Action This refers to the action recommended by the 
planning engine. The possible values are:

- None

- Release

- Cancel

New Date After you firm a supply, you can specify a 
new date to change an existing planned order,
a forecast, an MDS demand, a manual MDS 
demand, or a sales order.

New Qty After you firm a supply, you can specify the 
quantity to change an existing planned order, 
a forecast, an MDS demand, a manual MDS 
demand, or a sales order.

Order Priority Indicates the priority of a demand. The 
planning engine generates this number based 
on the priority rule used in the plan.

ABC Class Inventory ABC classification of the item.

Alternate BOM BOM Alternate bill of material name

Alternate Routing BOM Alternate routing name

Arrival Set Name On the sales order, the arrival set name 
designates lines that should arrive together at 
the customer site. Oracle Advanced Supply 
Chain Planning does not consider arrival sets 
but displays the field for information.

Bucket Type This refers to the bucket type that a demand 
falls under, such as Forecasts. The valid values
includes day, week, and period.

Build Sequence This number indicates the order in which the 
work orders are sequenced.

Category Category of an item
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Fields Description

Company Name Name of the company

Company Site Name of the company site 

Component Yield Bills of material component yield for a 
component

Compression Days The planning engine calculates the number of 
days that the order needs to be scheduled in 
the past (earlier than the planning horizon 
start date). For more information on Orders 
with Compression Days, see Exception 
Messages, page 17-1.

Consumed Forecast For a forecast demand, this field indicates the 
quantity of the forecast that is consumed by 
sales orders.

Consumption Backward Days This indicates the number of days (backward) 
when a forecast can be consumed by sales 
orders.

Consumption Forward Days This indicates the number of days (forward) 
when a forecast can be consumed by sales 
orders.

Cube Total cube of the supply row

Cumulative Probability Not used in Oracle Advanced Supply Chain 
Planning.

Customer Customer name as it appears on the sales 
order or forecast.

Customer Site Customer ship to location

Days From Today The planning engine calculates the difference 
between the suggested due date and the plan 
launch date to populate this field.

Days Late For more information, seeLead Time and the 
Planning Time Fence, page 6-76.
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Fields Description

Demand Class An attribute of a demand that is used to 
categorize demand. 

Demand Lateness Cost Penalty cost for a demand

Description Item description

Destination Org The destination organization for an internal 
sales order.

Earliest Allowable Completion Time The planning engine calculates this to indicate
the end of the scheduling window for the 
supply that allows sufficient time for the 
upstream activities to be scheduled.

Earliest Possible Completion Time The planning engine calculates this based on 
the constrained schedule for upstream 
supplies. It is the earliest time in which the 
supply can be completed.

Earliest Possible Start Time The planning engine calculates the difference 
between the earliest possible completion time 
and supply duration to populate this field.

End Date The end date of a bucketed forecast. This is 
used only in the Collections workbench. The 
planning engine does not populate the end 
date for Oracle Advanced Supply Chain 
Planning plans. 

Expiration Date This indicates the expiration date for an 
existing lot.

Expired Demand The planning engine marks the demand 
quantity as expired if the demand is not met 
within specific number of days.

First Unit Completion Date Indicates the first unit completion date of the 
repetitive job.

First Unit Start Date Indicates the first unit start date of the 
repetitive job.
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Fields Description

Fixed Leadtime For buy items, the processing lead time

Imp Qty/Rate Corresponds to the new quantity that you 
specify for an order when you release the 
order.

Implement Alternate BOM Alternate BOM is an alternate list of 
component items that you can use to produce 
an assembly.

Implement Alternate Routing An alternate manufacturing process that you 
can use to produce an assembly.

Implement As If you select an organization in the Order 
tabbed pane, you can release the order as a 
discrete job. If you select a supplier, you can 
release the order as a purchase order.

Implement Date Corresponds to the new date that you specify 
for an order when you release the order.

Implement Demand Class Demand Class of released order

Implement FUCD Implement first unit completion date for a 
repetitive job (editable)

Implement Firm Implement firm flag status (editable)

Implement Job Implement job number (not editable)

Implement Line Implement line for a repetitive job (not 
editable)

Implement Project Implement project name (editable)

Implement Source Org Implement source organization (editable)

Implement Status Implement work in process status (editable)

Implement Supplier Implement supplier (editable)
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Fields Description

Implement Supplier Site Implement supplier site (editable)

Implement Task Implement task identifier (editable)

Implement Unit Number Implement starting unit number for unit 
effectivity (not editable)

Implement WIP Class Implement work in process class (not editable)

Implemented Quantity Previously implemented order quantities (not 
editable)

Internal Sales Order Internal sales order number

Intransit Lead Time This indicates the transit lead-time associated 
with a transfer order.

Item Item name

Item From Source Plan A flag that indicates whether the item is 
planned in some other plan. For example, 
when you feed an MPS supply plan to another
plan such as MRP, the planning engine sets 
the flag for the item in the MRP plan.

Last Unit Completion Date Indicates the last unit completion date of the 
repetitive job.

Last Unit Start Date Indicates the last unit start date of the 
repetitive job.

Latest Acceptable Date Indicates the latest acceptable date for a sales 
order.

Line Line refers to the flow line.

Location Location refers to the supplier site or 
organization location.

Lot Lot refers to the lot number.
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Fields Description

MRP Planning Method Planning method defined for the item

Material Available Date For more information, seeLead Time and the 
Planning Time Fence, page 6-76.

Min Possible Days Late This planning engine calculates the minimum 
number of days that the end demand is late 
because of a particular supply. Other supplies 
may also cause additional delay.

Min Possible Start Time This field is obsolete.

Model/Option Class This refers to the model or the option class to 
which the item belongs.

Need By Date For more information, seeLead Time and the 
Planning Time Fence, page 6-76.

Old Dock Date For more information, seeLead Time and the 
Planning Time Fence, page 6-76.

Old Due Date For more information, seeLead Time and the 
Planning Time Fence, page 6-76.

Order Date Type For more information, seeLead Time and the 
Planning Time Fence, page 6-76.

Order Margin Profit margin of an order

Original Item If the planning engine recommends end item 
substitution for a demand, the item field refers
to the substituted item. This field stores the 
original demanded item.

Original Item Qty This indicates the demand quantity of the 
original item.

Original Need By Date Original need by date of the purchase order or
the requisition. For more information, see 
Lead Time and the Planning Time Fence, page
6-76.
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Fields Description

Original Order Quantity For forecasts, this is the original order 
quantity of the forecast before consumption or
before the forecast expiration. For all other 
order types, this is the same as the demand 
quantity.

Original Quantity Original forecast quantity for a global forecast.

Origination This field indicates the source where the 
planned supply is created. The origin is either 
the planning engine or ATP. 

Override Transit Times Not used in Oracle Advanced Supply Chain 
Planning. This is reserved for future use.

PO Line No Purchase order line number

Planned Arrival Date For more information, see Lead Time and the 
Planning Time Fence, page 6-76.

Planner Planner code

Planning Group The name of the planning group for which the
material is being planned.

Planning Level The identifier assigned to a project in the 
planning group.

Probability This is not used in Oracle Advanced Supply 
Chain Planning.

Process Days This field indicates the number of days a 
planned order is scheduled for a repetitive 
schedule.

Product Family The product family to which the item belongs.

Project Number Project number. For more information, see 
Planning in Mixed Mode Environments, page 
19-1.
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Fields Description

Promise Arrival Date The date when you promise that the customer 
can receive the products.

Promised Ship Date The date when you promise to ship the 
products to the customer.

For more information, see Lead Time and the 
Planning Time Fence, page 6-76.

Qty by Due Date This indicates the supply quantity that is 
available by the demand due date.

Quantity in Process This field indicates the quantity of a supply 
that is released.

Recommended Oracle Shop Flow Manufacturing job 
information on collection workbench.

Release Errors This field displays the release validation 
errors.

Repetitive Repetitive schedule

Requested Arrival Date The date when the customer wants to receive 
the products.

For more information, see Lead Time and the 
Planning Time Fence, page 6-76.

Requested Ship Date The date when the customer wants the 
products to be shipped.

For more information, see Lead Time and the 
Planning Time Fence, page 6-76.

Reschedule Days This indicates the number of days in or out 
that a supply order is rescheduled. A negative 
value indicates that the order is rescheduled 
to an earlier date.

Rescheduled This flag indicates that the order is 
rescheduled.
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Fields Description

Schedule Designator This is the supply schedule name for those 
supplies that you feed to a plan by using a 
supply schedule.

Schedule Group This refers to work in process schedule group.

Schedule Arrival Date The date on which the customer can receive 
the product.

For more information, see Lead Time and the 
Planning Time Fence, page 6-76.

Schedule Ship Date The date when the product needs to be 
shipped to the customer.

For more information, see Lead Time and the 
Planning Time Fence, page 6-76.

Service Level Not used in Oracle Advanced Supply Chain 
Planning.

Shared Supply A flag to indicate that this supply is shared 
among multiple demands.

Ship Method Ship method used for transfers and buy 
orders. 

Ship Set Name On the sales order, the ship set name 
designates lines that should ship together. 
Oracle Advanced Supply Chain Planning does
not consider ship sets. However, the field is 
provided for information.

Ship To Customer ship to location

Shipment Not used in Oracle Advanced Supply Chain 
Planning.

Source Order Priority This indicates the priority number on the 
actual demand record. This is different from 
the priority number calculated by the 
planning engine.
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Fields Description

Source Org Name of the source organization

Source Supplier Name of the source supplier

Source Supplier Site Name of the source supplier site

Start Quantity This indicates the start quantity of a supply 
that can be different from the finished 
quantity owing to yield.

Subinventory Subinventory identifier on the supply 
document, demand document, or location of 
an on-hand.

Substitute Component Rank BOM substitute component rank

Sugg Dock Date For more information, see Lead Time and the 
Planning Time Fence, page 6-76.

Suggested Due Date The timestamp for the suggested due date in 
case of: 

• Past demand lines is 23:59:00 on a day 
before the plan date

• On hand supply due date is 00:00:00 on 
the plan date

Suggested Due Date Before Bucketing The due date for Planned Order Demand and 
Model, Option Class or, Product Family 
Demand order types.

Sugg Order Date For more information, see Lead Time and the 
Planning Time Fence, page 6-76.

Sugg Ship Date For more information, see Lead Time and the 
Planning Time Fence, page 6-76.

Sugg Start Date For more information, see Lead Time and the 
Planning Time Fence, page 6-76.

Source Supplier The supplier company name.
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Fields Description

Source Supplier Site The supplier company site name.

Task Number The identifier assigned to the task in a project.

UOM This is an item attribute (unit of measurement)

Unconstrained Earliest Possible Completion 
Time

The planning engine calculates this based on 
the unconstrained schedule for those 
upstream supplies that allow minimum 
durations.

Unconstrained Earliest Possible Start Time The planning engine calculates the difference 
between the unconstrained earliest possible 
completion time and supply duration.

Unconstrained Latest Possible Completion 
Time

The planning engine calculates this based on 
the unconstrained schedule for those 
downstream supplies that allow minimum 
durations.

Unconstrained Latest Possible Start Time The planning engine calculates the difference 
between the unconstrained latest possible 
completion time and the supply duration.

Unit Number This refers to the starting unit effectivity 
number.

Update Need By Date For more information, see Lead Time and the 
Planning Time Fence, page 6-76.

Using Assembly For planned order associated with demands, 
this field refers to the assembly with this item 
as a component.

VMI Yes indicates that the supply is for a 
VMI-enabled item.
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Fields Description

WIP Status Status of the work in process. Some of the 
values are:

- Onhold

- Released

- Unreleased

Weight Weight of the order

WIP Start Qty Start quantity used for planning

Release Properties Tabbed Pane
The following table provides a description of the fields displayed in the Release 
Properties tabbed pane:

Fields Description

Implement Date Implement date (editable)

Imp Qty/Rate Implement quantity or rate (editable). The 
planning engine initially derives this value by 
dividing quantity by rate.

Implement As Implement as a work order or a purchase 
requisition (editable).

Implement Alternate BOM Implement alternate bills of material name 
(editable)

Implement Alternate Routing Implement alternate routing name (editable)

Implement Arrival Date Implement arrival date (not editable)

Implement Demand Class Implement demand class (not editable)

Implement Dock Date Implement dock date (not editable)
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Fields Description

Implement FUCD Implement first unit completion date for a 
repetitive job (editable)

Implement Firm Implement firm flag status (editable)

Implement Job Implement job number (not editable)

Implement Line Implement line for a repetitive job (not 
editable)

Implement Project Implement project name (editable)

Implement Ship Date Implement ship date (non editable)

Implement Source Org Implement source organization (editable)

Implement Status Implement work in process status (editable)

Implement Supplier Implement supplier (editable)

Implement Supplier Site Implement supplier site (editable)

Implement Task Implement task identifier (editable)

Implement Unit Number Implement starting unit number for unit 
effectivity (not editable)

Implement WIP Class Implement work in process class (not editable)

Implemented Quantity Previously implemented order quantities (not 
editable)

Location Implement location for the source 
organization or the supplier site (not editable)

Order Type Type of order such as planned order, sales 
order, manual master demand schedule (not 
editable).

Quantity in Process Implement Quantity or Rate (editable for 
planned orders only)
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Fields Description

Quantity/Rate Original order quantity (not editable)

Release Errors Alerts you to any problem that might have 
occurred during the process of release.

Suggested Due Date For more information, see Lead Time and the 
Planning Time Fence, page 6-76.

Sourcing Tabbed Pane
The following table provides a description of the fields displayed in the Source tabbed 
pane:

Fields Description

Source Org Name of the source organization

Source Supplier Name of the supplier

Source Supplier Site Name of the supplier's site

Company Name Name of the company

Company Site Name of the company site

Order Type Type of order

Quantity/Rate Quantity supplied by the source org

Suggested Due Date For more information, see Lead Time and the 
Planning Time Fence, page 6-76.

Line Tabbed Pane
The following table provides a description of the fields displayed in the Line tabbed 
pane:
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Fields Description

Line A group of resources

Schedule Group This refers to work in process schedule group.

Build Sequence The sequence number indicating the order in 
which work orders are sequenced

First Unit Start Date The date on which the first unit belonging to a
line is scheduled.

Last Unit Completion Date The date on which the last unit belonging to a 
line is completed

Last Unit Start Date The date on which the last unit belonging to a 
line is started

Order Type Type of order. For example, planned order, 
sales order.

Process Days This field indicates the number of days a 
planned order is scheduled for a repetitive 
schedule.

Quantity/Rate This indicates the rate per day for a repetitive 
schedule.

Repetitive Repetitive schedule

Suggested Due Date For more information, see Lead Time and the 
Planning Time Fence, page 6-76.

Using Assembly Name of the assembly. An assembly is an item
that has a bill of material.

Project Tabbed Pane
The following table provides a description of the fields displayed in the Project tabbed 
pane:
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Fields Description

Planning Group The name of the planning group for which the
material is being planned.

Project Number The identifier assigned to a project in the 
planning group.

Task Number The identifier assigned to the task in a project 
belonging to a planning group.

Order Type Type of order. For example, planned order, 
sales order.

Quantity/Rate The quantity of the order.

Suggested Due Date For more information, see Lead Time and the 
Planning Time Fence, page 6-76.

Unit Number Unit number

Right-click Menu Options in the Supply/Demand Window
In addition to the folder options, the right-click pop-up menu displays the following 
options to navigate to other windows:

• Exception Details

• Onhand

• Items

• Resource Requirements

• Order Exceptions

• Release

• Gantt Chart

• Horizontal Plan

• Co Product Supplies

• Calendar (based on the context, the following options may be available)
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• Calendar > Organization Manufacturing Calendar

• Calendar > Supplier Capacity Calendar

• Calendar > Organization Shipping Calendar

• Calendar > Supplier Shipping Calendar

• Calendar > Organization Receiving Calendar

• Calendar > Customer Receiving Calendar

• Calendar > Carrier Transit Calendar

• More

• More > Vertical Plan

Pegging
Pegging is a process that the planning engine uses to link:

• Supplies to demands: All the way up to the top-level independent demand. 

• Demands to supplies: All the way down to the bottom-level purchased component 
supply.

Use pegging to:

• Trace a purchased component or subassembly shortage to the sales orders and 
forecasts that are affected.

• Prioritize critical material and capacity resources.

• Analyze the impact of changing a supply or demand

Pegging plays a major role in determining the sequence in which demands are satisfied.
For some pegging modes, the planning engine:

• Groups supplies and demands into time windows

• Sorts supplies by type

• Pegs by demand priority or randomly within time windows

This section discusses:

• Standard pegging: Standard pegging groups demands into windows and supplies 
by type, then pegs by priority within window. It provides a limited amount of 
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prioritization at the day level (the window size is always one day).

• Priority pegging: Priority pegging pegs high priority demands first to on-hand and 
firm supplies then continues with other existing and non-firm supplies. It controls 
the trade-off between holding inventory or satisfying lower priority demands.

• FIFO pegging: FIFO pegging pegs demands to supplies on a day-by-day basis. It is 
the pegging process with the least load on the system.

• Priority/FIFO pegging: The planning engine uses a combination of priority pegging 
and FIFO pegging methods where it does not prioritize beyond the firm supplies. 
The load on the system is less than the load from priority pegging.

• Enabling pegging checklist

• Viewing pegging information

The actual date that a demand is satisfied is a function of the detailed scheduling 
process. There is no guarantee that high priority orders are satisfied on time.

In performing the pegging process, the planning engine selects demands and locates 
supplies to peg those demands to. Therefore, we say that the pegging process pegs 
demands to supplies.

When some people think of pegging, they think of supplies pegged to demands. For 
example, if you are using hard pegging with Oracle Project Manufacturing, it reserves 
the supply for the demand.

When discussing the results of the pegging process, you can correctly say either that 
demands peg to supplies or that supplies peg to demands. The diagrams in this section 
use arrows which indicate the supplies that peg to particular demands.

To use pegging you must enable it for the items and for the plan. The planning engine 
pegs in several ways (pegging modes). For certain modes, you specify information to 
instruct the planning engine.

The planning engine pegs each item after the netting process. It begins with all of the 
items in the highest bill of material level and proceeds level by level to the lowest bill of 
material level.

The planning engine attempts to minimize substitution at the expense of crossing 
organizations and uses substituted on-hand or scheduled receipts before creating 
planned orders. For example:

• Item A is a saleable item

• Item B is a substitute for item A

• In organization M1, there is:

• Demand for item A, due on day 10, quantity 100, priority 1
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• Demand for item A, due on day 20, quantity 70, priority 2

• On-hand supply for item A, quantity 40

• On-hand supply for item B, quantity 70

• In organization M2, there is:

• On-hand supply for item A, quantity 60

• On-hand supply for item B, quantity 40

• The planning engine pegs the demand in organization M1, for item A, due on day 
10, quantity 100, priority 1 to:

• Organization M1, on-hand supply for item A, quantity 40 

• Organization M2, on-hand supply for item A, quantity 60

• Demand satisfied date is day 10

• It crosses organizations to avoid substituting

• The planning engine pegs the demand in organization M1 for item A, due on day 
20, quantity 70, priority 2 to:

• Organization M1, on-hand supply for item B, quantity 70

• Demand satisfied date is today

• There is no supply for the requested item in any organization; it substitutes to 
use on-hand before creating planned orders 

The planning engine passes independent demand priorities to discrete job and planned 
order dependent demands to which they peg. Planned order dependent demands have 
lower priority than discrete job dependent demands at the same bill of material level.

The planning engine performs pegging for product family items regardless of the 
setting of their item attribute Pegging

Pegging Modes
This table shows the pegging modes and the settings that you use to enable them.
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Pegging Mode Plan Option - Priority 
Pegging

Profile Option - MSC: Use 
FIFO Pegging

Standard Cleared No

Priority Selected No

FIFO Cleared Yes

Priority/FIFO Selected Yes

When the pegging process is processing an end-item product substitution, it does not 
attend to the following profile options, regardless of the pegging mode. The process 
performs the pegging for these demands immediately following the item substitution:

• MSC: Demand Window Size

• MSC: Peg by Product Supplies

• MSC: Supply Window Size 

• MSO: Firm Supply Allocation Window (Forwards Days)

• MSO: Firm Supply Allocation Window (Backwards Days)

• MSO: Use Firm Supplies Before Creating Planned Orders

Standard Pegging
The standard pegging process makes two passes through the demands and supplies. 

First Pass
The planning engine groups demands into daily windows. It does not use profile option
MSO: Demand Window Size. The first window starts at the first demand date and the 
last window ends at the end of the planning horizon. 

For example, the demand window size is 1 day, the first demand is due on day 5. The 
first demand window is from day 5 to day 5, the second demand window is from day 6 
to day 6, and the third demand window is from day 7 to day 7. 

Demands in each window are sorted by demand priority in ascending order. 

The planning engine groups supplies into daily windows. It does not use profile option 
MSO: Supply Window Size. The first window starts at the first supply availability date 
and the last window ends at the end of the planning horizon.

For example, the supply window size is 1 day, the first supply is available on day 7. The
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first supply window is from day 7 to day 7, the second supply window is from day 8 to 
day 8, and the third supply window is from day 9 to day 9. 

Supplies in each window are sorted by type using the following order: 

1. Firm supplies

1. On-hand

2. Receipt shipment, intransit shipment, payback supply (Oracle Project 
Scheduling)

3. Work order (firm), job by-product supply (firm), purchase order (firm), 
non-standard jobs, non-standard job by-product supply (always considered 
firm)

4. Purchase requisition (firm)

2. 2. Existing supplies

1. Work order (non-firm), job by-product Supply (non-firm), repetitive schedule, 
repetitive schedule by-product supply, flow schedule, flow schedule 
by-product supply, purchase order (non-firm)

2. Purchase requisition (non-firm)

3. Planned supplies

1. Planned order (firm), planned order by-product supply (firm). You can raise the
pegging priority of firm planned orders by releasing them.

2. Planned order (non-firm), planned order by-product supply (non-firm)

The supplies in each type are sorted as follows:

• On-hand: Lot expiration date and then quantity in ascending order to use expiring 
lots first. A demand pegging to an expiring lot must have its demand date earlier 
than the lot expiration date; therefore, some expiring lots may not peg.

• Firm: By date in ascending order within each type. 

• Non-firm: By quantity in ascending order within each type.

Second Pass
The planning engine begins from the first demand window and pegs demands by 
demand priority to supplies of the first supply window. If necessary, it continues the 
pegging process with the next supply window.

As all demands in the each demand window are pegged, it moves to the next demand 
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window and pegs as it did in the first demand window

Unpegged supplies are posted to excess.

In this example, demands D1 and D2 are sorted by priority in ascending order and 
supplies S5 and S6 are sorted by type. Pegged entities are connected by arrows.

Pegged Entities

Standard Pegging Example
This example shows standard pegging for two items. It begins with various settings and
then shows the pegging for each item.

Profile option MSC: Use FIFO Pegging is No.

Plan option Peg Supplies by Demand Priority: Cleared.

In standard pegging, the planning engine uses 1 as the value for MSO: Demand 
Window Size and MSO: Supply Window Size and ignores the entered values.

Item A101 Pegging
This diagram shows the demands, supplies, and pegging information for item A101. 
Demand priorities are in parentheses, pegged entities are connected by arrows, and 
split supply quantities are in brackets.

The first demand window starts on day 3 at the first demand date. 

Supplies in the first supply window [day 1] are pegged in the following order:

• On-hand of quantity 25 on day 1 and demand quantity of 100 on day 3 

• Firm planned order of quantity 10 on day 1 and demand of quantity 100 on day 3
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• Non-firm planned order of quantity 50 on day 1 and demand of quantity 100 on 
day 3

Supplies in the second supply window [day 2] are pegged in the following order:

• Firm planned order of quantity 5 on day 2 and demand of quantity 100 on day 3

• Non-firm planned order of quantity 35 on day 2 (for partial quantity 10) and 
demand of quantity 100 on day 3

• Non-firm planned order of quantity 35 on day 2 (for partial quantity 25) and 
demand of quantity 100 on day 4

Supply in the third supply window [day 3] is pegged as non-firm planned order of 
quantity 75 on day 3 and demand of quantity 100 on day 4 

Pegged Entities

Item A102 Pegging
This table shows the demands, supplies, and pegging information for item A102. 
Demand priorities are in parentheses and pegged entities are connected by arrows.

Supplies in the first supply window [day 1] are pegged in the following order:

• On-hand of quantity 10 on day 1 and demand of quantity 200 on day 1 
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• Non-firm planned order of quantity 40 on day 1 and demand of quantity 200 on 
day 1

Supplies in the second supply window [day 2] are pegged in the following order:

• Firm work order of quantity 20 on day 2 and demand of quantity 200 on day 1

• Non-firm planned order of quantity 100 on day 2 and demand of quantity 200 on 
day 1

Supply in the third supply window [day 3] is pegged as firm purchase requisition of 
quantity 30 on day 3 and demand of quantity 200 on day 1 

Supply in the forth supply window [day 4] is pegged as non-firm work order of 
quantity 40 on day 4 and demand of quantity 100 on day 6

Supply in the sixth supply window [day 6] is pegged as non-firm planned order of 
quantity 60 on day 6 and demand of quantity 100 on day 6 
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Pegged Entities

Priority Pegging
The priority pegging process makes three passes through the demands and supplies. 

First Pass
The planning engine starts with the demand of highest priority as specified by the 
plan's demand priority rule. It scans backwards the number of days in the site or 
item-specific firm supply allocation window (profile option MSO: Firm Supply 
Allocation Window (Backward days) and finds the first firm supply quantity to peg the 
demand to. 

The planning engine scans backward and finds supplies. It organizes and pegs them as 
follows:
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• Sorts on-hand by the lot expiration date and then quantity in ascending order. Pegs 
demand to on-hand before other firm supplies of day 1 when the firm supply 
allocation window includes day 1.

• Firm supplies are not sorted on any given date. 

• If you want firm planned orders included in the firm supply allocation window, set 
profile option MSC: Include Firm Planned Orders In Firm Allocation Window to 
Yes.

If it cannot find enough firm supply quantity to satisfy the entire demand quantity, it 
scans forwards the number of days in the site or item-specific firm supply allocation 
window (profile option MSO: Firm Supply Allocation Window (Forward days)) to find 
supplies to peg the demand to.

The pass ends when the demand is completely pegged to firm supplies or all firm 
supplies in the firm supply allocation windows are exhausted.

This diagram shows an example of the first pass:

• Demand D1 on day 4 is the highest priority demand

• MSO: Firm Supply Allocation Window (Backward days) is 3

• MSO: Firm Supply Allocation Window (Forward days) is 2

• Supplies S2 and S3 on day 3 are not sorted

• OH (on-hand) is sorted before supply S4 on day 1

• The order of supplies for pegging to demand D1 is:

• Backward: S1, S2 and S3 randomly; OH; and S4

• Forward: S5; D1 cannot peg to S6
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Priority Pegging First Pass Example

Second Pass
For the remaining demands and supplies, the planning engine groups all demands into 
windows by using profile option MSO: Demand Window Size. The first window starts 
at the first demand date and ends after the number of days in the window size. The 
second window starts at the end of the first window and ends after the number of days 
in the window size. The last window ends at the end of the planning horizon.

For example, the demand window size is 50 days and the first demand date is due on 
day 1. The first demand window is from day 1 to day 49 and the second demand 
window is from day 50 to day 99.

Demands in each window are sorted by demand priority in ascending order. 

The planning engine groups all supplies into windows by using profile option MSO: 
Supply Window Size. The first window starts at the first available supply date and ends
after the number of days in the window size. The second window starts at the end of 
the first window and ends after the number of days in the window size. The last 
window ends at the end of the planning horizon. 

For example, the supply window size is 50 days and the first supply is available on day 
1. The first supply window is from day 1 to day 49 and the second supply window is 
from day 50 to day 99.

It sorts supplies in each window by type in the same manner as the standard pegging 
first pass.

Third Pass
The planning engine uses the standard pegging second pass.

Third Pass Example
This diagram shows an example of the third pass:

• MSO: Demand Window Size = 3
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• MSO: Supply Window Size = 2

• Demands are sorted by priority in each demand window and supplies are sorted by
type and date or quantity in each supply window

Note that:

• Demand D1 is pegged to multiple supplies S1 and S2

• Demands D3 and D4 both peg to supply S3

• Pegged entities are connected by arrows

Priority Pegging Third Pass Example

Firm Supply Allocation Window
Setting
You can set the firm supply allocation window in these ways:

• Site level: Use profile options MSO: Firm Supply Allocation Window (Backward 
days) and MSO: Firm Supply Allocation Window (Forward days) for all items.

• Item level: Use Cumulative Manufacturing Lead Time (make items) or Processing 
Lead Time (buy items) and the profile option MSO: Multiplier to Derive Supply 
Allocation Window to calculate an item specific value for backward calculations 
only.
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If you specify a positive number for the value of profile option MSO: Multiplier to 
Derive Supply Allocation Window, then the planning engine ignores the profile option 
MSO: Firm Supply Allocation Window (Backward days). If you specify a zero, negative,
or null number for the value of profile option MSO: Multiplier to Derive Supply 
Allocation Window, then the planning engine uses the profile option MSO: Firm Supply
Allocation Window (Backward days). 

Calculating
Oracle Advanced Supply Chain Planning derives a firm supply allocation window for 
each item based on its item attributes as follows:

• Make: Cumulative manufacturing lead-time. Either automatically calculate it or 
enter it. To automatically calculate it use either the Oracle Bills of Material Compute
Lead Time calculation or the Lead Time Rollup concurrent processes.

• Buy: Processing lead-time

These are the formulas for the item-specific firm supply allocation window:

• Make item: Cumulative manufacturing lead-time * MSO: Multiplier to derive 
supply allocation window

• Buy item: Processing lead-time * MSO: Multiplier to derive supply allocation 
window

The value is rounded up to the integer. If the cumulative manufacturing lead-time or 
the processing lead-time is null or 0 and the multiplier is positive, the planning engine 
uses the item-specific firm supply allocation window which is 0.

For example:

• MSC: Multiplier to Derive Supply Allocation Window: 1.2

• Cumulative manufacturing lead-times for item A101: 12 days

• Cumulative manufacturing lead-times for item A102: 20 days

• Firm supply allocation window for item A101: 15 days (12 * 1.2 = 14.4)

• Firm supply allocation window for item A102: 24 days (20 * 1.2)

Sizing Demand and Supply Windows
Very small or very large window sizes bring advantages and disadvantages to the 
results of the pegging process.

Some benefits of small demand window size are:

• Lower inventory and inventory carrying cost: Earlier demands are pegged to 
on-hand instead of higher priority later demands pegging to on-hand.
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• Decrease in total demand lateness: It is more likely that early demands are satisfied 
before later demands.

A disadvantage of small demand window size is more late higher priority demands. 
Lower priority demands are satisfied before higher priority demands and low priority 
demands for safety stock peg to on-hand. 

A benefit of large demand window size is higher priority demands having a higher 
probability of being satisfied earlier.

Some disadvantages of large demand window size are:

• Increased overall demand lateness.

• Increased inventory carrying cost as more inventory is held.

When you are sizing the supply window, note that selecting a large window size can 
result in the planning engine's pegging early demands to firm supplies or non-firm 
supplies at the end of the window (firm supplies sort by type and date, non-firm 
supplies sort by type and quantity). This results in increased lateness for the early 
demands.

Priority Pegging Examples
This example shows priority pegging for two items. It begins with various settings and 
then shows the pegging for each item.

Profile option settings:

• MSO: Firm Supply Allocation Window (Backward days): 5

• MSO: Firm Supply Allocation Window (Forward days): 1

• MSO: Multiplier To Derive Supply Allocation Window: 2

• MSO: Demand Window Size: 2

• MSO: Supply Window Size: 2

• MSC: Use FIFO Pegging: No

Plan option Peg Supplies by Demand Priority: Selected.

Item cumulative lead-times:

• A101: 2

• A102: 1

Item specific firm supply allocation window:

A101: 4 (2 * 2)
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A102: 2 (2 * 1)

Item A101 Pegging:
First Pass
This diagram shows the demands, supplies, and pegging information for item A101 on 
the first pass. Demand priorities are in parentheses and pegged entities are connected 
by arrows. The order of the schedule entities is:

• Demand

• Pegging to on-hand and firm supplies within the firm supply allocation window. 
The planning engine starts with the highest priority demand on day 4 going 
backward and then forward.

Pegging to On-hand and firmed supplies

Second Pass
This diagram shows the demands, supplies, and pegging information for item A101 on 
the second pass. Demand priorities are in parentheses, pegged entities are connected by
arrows, and split supply quantities are in brackets. The order of the schedule entities is:

• Demand position after of on-hand and firm supplies within the firm supply 
allocation window

• Pegging to supply outside the firm supply allocation window, firm supplies first

Note that non-firm planned orders are sorted by quantity in ascending order and firm 
planned orders are sorted by date in ascending order. Therefore, the planning engine:

• Pegs the non-firm planned order in bucket 2 for quantity 35 and the higher priority 
demand in bucket 4. Pegs the non-firm planned order for quantity 35 on day 2 and 
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the higher priority demand on day 4. Pegs the non-firm planned order for quantity 
50 on day 1 and both the demand on day 4 (for quantity 25) and the demand on day
3 (for quantity 25). 

• Pegs the firm planned order for quantity 10 on day 1 and the higher priority 
demand of day 4.

Pegging of firmed planned order

Item A102 Pegging
First Pass
This table shows the demands, supplies, and pegging information for item A102 on the 
first pass. Demand priorities are in parentheses and pegged entities are connected by 
arrows. The order of the schedule entities is:

• Demand

• Pegging to on-hand and firm supplies within the firm supply allocation window. 
The planning engine starts with the highest priority demand on day 6 going 
backward and then forward.

Note that the planning engine pegs to firm jobs and on-hand balances with respect to 
the firm supply allocation windows. No demand in the first pass pegs to the firm job on
day 3 but the demand in bucket 1 for quantity 170 in the second pass does peg to it.
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Pegging Entities

Second Pass
This table shows the demands, supplies, and pegging information for item A102 on the 
second pass. Demand priorities are in parentheses and pegged entities are connected by
arrows. The order of the schedule entities is:

• Demand position after of on-hand and firm supplies within the firm supply 
allocation window

• Pegging to supply outside the firm supply allocation window, firm supplies first
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Pegging to supply outside firm supply

FIFO Pegging
For all demands and supplies, the planning engine:

• Pegs demands to supplies day by day. It does not sort each day's supplies and 
demands.

• When there are no more supplies or demands on one day, uses supplies or 
demands from the next day

• At the end of the planning horizon, posts unpegged supplies to excess.

FIFO Pegging Example
This example shows FIFO pegging. It begins with various settings and then shows the 
pegging for each item. Daily supplies and demands are not sorted. Pegged entities are 
connected by arrows and split supply quantities are in brackets.

Profile option MSC: Use FIFO Pegging: Yes

Plan option Peg Supplies by Demand Priority: Cleared

The pegging includes:

• The supply of quantity 500 on day 1 and the demand on day 3 for quantity 300 and 
the demand on day 7 for quantity 200.

• The supply of quantity 100 on day 7 and the demand on day 7 for quantity 100.
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• The supply of quantity 400 on day 10 and the demand on day 10 for quantity 400.

• The supply of quantity 200 on day 20 and the demand on day 10 for quantity 100 
and the demand on day 20 for quantity 100.

• The supply of quantity 300 on day 30 and the demand on day 30 for quantity 300.

Pegging

Priority/FIFO Pegging
The priority/FIFO pegging process makes two passes through the demands and 
supplies. 

First Pass
The planning engine uses the priority pegging first pass.

Second Pass
The planning engine uses the FIFO pegging pass.

Priority/FIFO Pegging Example
This example shows priority/FIFO pegging. It begins with various settings and then 
shows the pegging for each item. Pegged entities are connected by arrows and split 
supply and combined demand quantities are in brackets.

Profile options:

• MSO: Firm Supply Allocation Window (Backward days): 5

• MSO: Firm Supply Allocation Window (Forward days): 1

• MSO: Multiplier To Derive Supply Allocation Window: 2

• MSC: Use FIFO Pegging: Yes

Plan option Peg Supplies by Demand Priority: Selected.
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Item cumulative lead-time: 1

Item specific firm supply allocation window: 2 (2 * 1)

First Pass
The planning engine pegs firm jobs and on-hand with respect to the firm supply 
allocation windows. It does not peg the firm work order for quantity 30 on day 3 to any 
demand in the first pass but to the demand on day 1 for 100 in the second pass.

Second Pass
The planning engine pegs:

• The demand for quantity 70 on day 1 to the planned order for quantity 70 on day 1.

• The demand for quantity 100 on day 1 to the purchase requisition for quantity 20 on
day 2, then to the planned order for quantity 50 on day 2, and then to the work 
order for quantity 30 on day 3.
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Second Pass

Priority and FIFO/Priority Comparison
This diagram shows the second pass as priority pegging schedules it. The planning 
engine pegs:

• The demand for quantity 70 on day 1 to the purchase requisition for quantity 20 on 
day 2 and then to the planned order for quantity 50 on day 2.

• The demand for quantity 100 on day 1 to the planned order for quantity 70 on day 1
and then to the work order for quantity 30 on day 3.
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Third Pass

Enabling Pegging Checklist
1. Enable pegged items: In the Items form, MPS/MRP Planning tabbed region, 

Pegging field, select any value other than None. For more information, see Oracle 
Inventory User's Guide.

2. Enable plan pegging: In the Profile Options form, Main tabbed region, set Enable 
Pegging. This action enables standard pegging.

Perform this checklist item if you want to use FIFO pegging or priority/FIFO 
pegging.

3. Enable plan FIFO pegging: In the Profile Options form, set MSC: Use FIFO Pegging 
to Yes.
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Perform the next three checklist items if you want to use priority pegging or 
priority/FIFO pegging.

4. Enable priority pegging: In the Plan Options form, Main tabbed region, select Peg 
Supplies by Demand Priorities.

5. Set firm supply allocation windows: In the Profile Options form, attend to the 
following: 

• MSO: Firm Supply Allocation Window (Backward days): Number of days for 
searching backward from the demand date. The default value for this profile 
option is zero (do not search backwards). If you do not enter a value or enter a 
negative value, the planning engine also does not search backwards.

• MSO: Firm Supply Allocation Window (Forward days): Number of days for
searching forward from the demand date. The default value for this profile 
option is zero (do not search forwards). If you do not enter a value or enter 
a negative value, the planning engine also does not search forwards.

6. Set multiplier To Derive Supply Allocation Window: In the Profile Options form, 
set MSO: Multiplier To Derive Supply Allocation Window. You can use a decimal 
quantity.

This profile option defaults to not entered, which instructs the planning engine to 
ignore it and base the backward search of pegging is on profile option MSO: Firm 
Supply Allocation Window (Backward days). If you enter a negative value or zero, 
the planning engine also ignores this profile option.

Perform this checklist item if you want to use priority pegging.

7. Set demand and supply window sizes. In the Profile Options form, attend to the 
following:

• MSO: Demand Window Size: Number of days for grouping demands into 
windows; it defaults to 1. If you do not enter a value, enter 0, or enter a negative
value, the planning engine uses value 1. 

• MSO: Supply Window Size: Number of days for grouping supplies into 
windows; it defaults to 1. If you do not enter a value, enter 0, or enter a 
negative value, the planning engine uses value 1. 

8. Set the profile MSC: Minimize Workorder crossovers during reschedules to Yes to 
avoid pushing any supply forward to complete a work order even if there is some 
excess. This ensures that the supply is not pegged to a safety stock and therefore, 
the safety stock date will be closer to the real demand date.

For more details on the profile option, see 'MSC Profile Options, page A-13
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Safety Stock Pegging
To set up safety stock planning and to understand the safety stock planning process, see
Safety Stock, page 6-133.

Overview of Safety Stock Pegging

The planning engine plans to meet safety stock levels through a process of sequential 
phases:

• Safety stock smoothing: Smooths out fluctuations in safety stock. This phase is 
optional. The planning engine only performs safety stock pegging if profile option 
MSC: Use FIFO Pegging is No.

Oracle recommends that you use priority pegging if your business uses safety stock.

• Inventory netting: Creates planned orders and recommendations to meet safety 
stock levels

• Pegging: Associates supplies and demands

• Scheduling: Detailed schedules safety stock supplies

This topic explains the Pegging phase. To understand the other planning phases, see 
Safety Stock, page 6-133.

To view the results of safety stock pegging, use theSupply/Demand Window, page 18-
64.

Safety Stock Pegging Phases

The planning engine plans to peg safety stock through a process of sequential phases:

• Peg to non-transient safety stock levels.

• Peg to demands

• Peg to transient safety stock levels

Non-transient safety stock levels are levels that you must hold throughout the planning 
horizon. They are safety stock levels without ending effectivity dates.

Transient safety stock levels are levels that you must hold for only a certain time during
the planning horizon. They are safety stock levels with ending effectivity dates

The safety stock level for a day can be a combination of non-transient and transient 
safety stock levels for that day.

The planning engine pegs non-transient and transient safety stocks differently. For:

• Transient safety stock levels: It may dual-peg them to both satisfy a safety stock 
level and also to satisfy a future demand after the safety stock level has expired and 
safety stock level goes down
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• Non-transient safety stock levels: It only pegs them to safety stock level, never to 
demand

In all examples, please assume:

• Profile option MSO: Demand Window Size is 1

• Profile option MSO: Supply Window Size is 1

• Demand dates are unconstrained demand dates. Unconstrained demand dates are 
demand dates calculated before scheduling. Scheduling of supplies occurs after 
pegging.

Safety Stock Pegging Phase 1: Peg to Non-transient Safety Stock Levels

You can choose to exclude non-transient safety stock demands from the pegging logic; 
set profile option MSC: Include Safety Stocks in Priority based Pegging to No. The 
pegging process:

• First pegs all non-transient safety stock levels to non-firm planned orders

• Then pegs other demands to supplies

If you set profile option MSC: Include Safety Stocks in Priority based Pegging to Yes, 
the pegging process does not give preferential treatment to the non-transient safety 
stock levels and pegs them at the same time as the demands.

Safety Stock Pegging Phase 2: Peg to Demands

The planning engine performs priority pegging logic using demands and supplies 
within each supply and demand window. It does not consider transient safety stocks. It 
does consider non-transient safety stocks if it has not pegged them in the previous 
optional phase.

Safety Stock Pegging Phase 3: Peg to Transient Safety Stock Levels

The planning engine performs priority pegging logic using transient safety stock levels 
and supplies. It pegs the supplies at quantity 0 because these supplies will eventually 
satisfy demands. It pegs the transient safety stock levels to the lowest priority supplies 
in the supply window. 

This table shows pegging to a transient safety stock level. It details:

• D: Demand

• SSL(T): Transient safety stock level

• S1: Supply 1

The transient safety stock level pegs to Supply 1 from D1 to D9 at quantity 0. The 
demand on D10 for quantity 10 pegs to Supply 1 on D10 at quantity 10.
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Other Safety Stock Pegging Principles

Other safety stock pegging principles are:

• The planning engine can peg a safety stock level to more than one supply

• The planning engine can split planned orders to peg to different transient safety 
stock levels. To enable this, set profile option MSC: Split Planned Order to perform 
safety stock pegging to Yes or Yes But Do Not Violate Order Modifiers.

• The peg to a transient safety stock level expires either when the transient safety 
stock level expires or when the supply is consumed by demands.

• A supply that pegs to a transient safety stock level and also to multiple demands 
may contribute less to its pegged safety stock level over time. As time progresses, 
the demands consume a part of its quantity at different times; the remaining 
quantity remains pegged to the transient safety stock level.

• The planning engine can push out dependent demands of supplies that peg to 
safety stock levels: Use this method when your constraints tend to cause the 
scheduling phase of planning to push resource requirements out and result in 
unneeded safety stock at lower bill of material levels. To enable this, set a value for 
profile option MSO: Supply Reschedule Window Size for Safety Stock Pegging. The 
value is the number of reschedule that the pegging process estimates when it makes
decisions against transient safety stocks.

This diagram shows an inventory netting scenario with pegging indicated. It chiefly 
shows the pegging of safety stock levels. The planning engine does peg other demands 
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and supplies that do not appear pegged here or do not appear completely pegged here.

It details:

• D: Demands

• OH: On-hand balance

• SR: Scheduled receipts

• PO: Planned orders

• SS(NT): Non transient safety stock levels

• SS(T): Transient safety stock level

• SSL: Safety stock level

• PAB: Projected Available Balance

In this diagram, the non-transient safety stock levels (quantity 10 beginning on day 1 
and an additional quantity 5 beginning on day 7) peg to supplies due on day 3.

For transient safety stock:

• The quantity 10 on day 7 pegs to the planned order quantity 10 consumed on day 8.

• The quantity 10 on days 8 and 9 and the quantity 3 on days 10 and 11 peg to the 
planned order quantity 10 consumed on day 12

• The quantity 3 on day 12 pegs to the planned order quantity 3 consumed on day 14.
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Forecast and Production Forecast Pegging
When you create a production plan during constrained master scheduling or, an 
unconstrained plan with pegging enabled, Oracle Advanced Supply Chain Planning 
allows you to see product family planned orders that are pegged to existing sources of 
supply including, On-hand, Work In Process jobs and firm planned orders if any. You 
can do this if:

• The planning method for product family item and the member items are the same

• You are performing constrained master scheduling in which the member items or 
some of their components are critical items. This ensures that both the product 
family and the member items reside in the same plan. 

The planning engine does not generate pegging:

• Across different plans

For example, if product family PF-1 is in production plan and you use that to drive 
manufacturing plan for member items M-A and M-B, the planning engine does not 
derive pegging in this scenario. 

• For sales orders

Note: Only demand that is pushed down from the aggregate 
demand statement is pegged.

Product family push down demand = Total supply (Planned orders) - Sales order 
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demand (Rolled up sales orders at the product family level)

You can view the Pegging region of the Supply/Demand window to analyze the impact 
of changing a supply or demand order at any level of your bill of material.

To generate pegging information
1. Navigate to Plan Options > Main tab.

2. Select the Enable Pegging check box for an unconstrained plan.

Alternatively, you can choose to generate a constrained/optimized plan. In this case, the
planning engine always generates pegging.

Viewing Pegging Information
Using the pegging tree, you can trace demand and supply up or down from any bill of 
material level.

If you have any item in a supply chain bill marked for pegging, the planning engine 
pegs for the top level assembly.

For the planning engine to peg a component, you must mark its assembly for pegging.

To display the pegging tree
1. Select the desired item in the Navigator.

2. Navigate Tools > Supply/Demand. 

3. In the Supply/Demand window, the pegging tree appears in the bottom half of the 
window.

The default display for viewing pegging from demand to supply is supply order 
details and end item demand order information. The default display for viewing 
pegging from supply to demand is supply order details, immediate parent demand 
information, and end item demand information.

4. To expand the entire pegging tree, select (highlight) the top pegging node (root), 
right-click, and select Expand All.

You can explode each node to higher level or lower level nodes by clicking on the 
plus and minus signs. You can also jump to other detail windows by right-clicking 
the pegging node. 

To see a node's properties, highlight it, right-click it, and select Properties.

Right-click Menu Options in the Pegging Region of the Supply/Demand Window
The following right-click menu options are available from the pegging region:
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Right-click Menu Option Available For Demand Line 
or Supply Line

Description

Exception Details Both Use to navigate to the 
Exception Details window.

Horizontal Plan Both Use this to navigate to the 
Horizontal Plan window.

Vertical Plan Both Use this to navigate to the 
Vertical Plan window.

Items Both Use this to navigate to the 
Items window.

Resource Requirements Supply Line Use this to navigate to the 
Resource Requirements 
window.

Expand Both Use this to expand all the 
pegging lines below the line 
you highlight in the pegging 
tree.

Refresh Supply/Demand Both Use this option to refresh the 
information in the 
Supply/Demand region. The 
planning engine does not 
change the information in the 
pegging region.

Calendar Both Various Calendar options 
(such as Organization 
Shipping and receiving) are 
available.

Refresh Demand Line The planning engine refreshes
the information in the 
pegging region.

Pegging Icons in the Supply/Demand Window
Pegging information is available in the pegging region of the Supply/Demand window. 
You can use the icons provided in this window to perform the following:

• Supply Pegging icon and Demand Pegging icon: View upstream (demand pegging) 
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and downstream pegging (supply pegging) for a particular supply or demand 
record in the same window. By default, a supply line has upstream pegging while a
demand line has downstream pegging. You can change the pegging direction by 
clicking on these icons.

• Backward Navigation icon and Forward Navigation icon: Navigate forward or 
backward to multiple Supply/Demand windows to view pegging information for 
different items.

• For example, while navigating a pegging tree, you may want to view the 
demand pegging for a different item in the pegging tree. To do this, highlight 
the pegging line of the item and click the Demand Pegging icon. The planning 
engine refreshes only the pegging region and creates the highlighted line in the 
pegging region as the root pegging line. You can use the Backward Navigation 
to return to the previous context in the pegging region. The state of the pegging 
region is maintained so that you return to the pegging region as you left it.

• The history of your forward and backward navigation is cleared when you 
select a different node from the Navigator or the Query result window. In 
addition, the history of the navigation is cleared when you select a different 
supply or demand line from the supply and demand region of the 
Supply/Demand window.

• After you select an item from a plan or from a query result window and open 
the Supply/Demand window, you may have subsequent different context in the
Supply/Demand window as you drill through pegging and view 
supply/demand for a different item. 

• The planning engine saves a copy of the contents in the entire Supply Demand 
window when a different root node (different item) appears in the pegging 
region. However, the planning engine does not save a copy of the Supply 
Demand window if you change the context in the supply/demand region of the 
window by firming a supply, querying a subset of records, or refreshing 
supply/demand.

• Hide Dependant Demands and Show Dependant Demands toggle icon: This is a 
toggle icon and can be used to switch between hide and show of dependent 
demand pegging lines.

• Hide Operation/Resource and Show Operation/Resource toggle icon: This is a 
toggle icon and can be used to switch between hide and show operation and 
resource pegging lines. By default, the planning engine displays the operation and 
resource lines in the pegging tree.

Vendor Managed Inventory (VMI) Supplies
You can perform the following tasks to manage VMI supplies using the Planner 
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Workbench:

• Search for VMI supplies using the VMI Flag criterion in the Find Supply/Demand 
window. After you specify the condition for the VMI flag, the records that meet 
your criteria appear in the Supply/Demand window. You can view all supplies 
(planned orders, requisitions, purchase orders, in transit shipments) that are 
managed by a VMI-enabled supplier.

• Prevent the release of those planned orders that are sourced from VMI-enabled 
suppliers. You need not create a requisition for items managed by suppliers. To 
prevent the release of VMI items, clear the Release VMI Items check box in the 
Other tabbed pane of the Preferences window.

• Create forecasts for VMI items and publish them to your suppliers.

Items Window

View the Items Window
You can navigate to the Items window from various node types such as items an plans 
in the Navigator. In addition to the Navigator, you can also drill down to the Items 
window from other windows such as Vertical Plan.

To display the Items window 
1. Select one or more nodes (using Ctrl- click) in the Navigator.

2. Select [right-click] > Items > Items.

Information Displayed in the Items Window
The Items window provides detailed information pertaining to items such as:

Fields Description

BOM Item Type BOM item attribute

Pegging MPS/MRP planning item attribute

Preprocessing LT Lead times item attribute

Processing LT Lead times item attribute

Postprocessing LT Lead times item attribute

Fixed LT Lead times item attribute. For buy items, this 
field displays item attribute Processing LT.
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Fields Description

Fixed Order Qty General planning item attribute

Fixed Lot Mult General planning item attribute

Min Order Qty General planning item attribute

Max Ord Qty General planning item attribute

ABC Class ABC class code assigned to the item 

ATP Components Flag Oracle Order Management item attribute

ATP Flag Oracle Order Management item attribute

Base Model Bills of material item attribute 

Buyer Purchasing item attribute

Carrying Cost General planning item attribute

Category Planning category assigned to the item 

Category Desc Planning category description

Continuous Inter-Org Transfers MPS/MRP planning item attribute

Convergent Supply Consumption MPS/MRP planning item attribute

Create Supply Flag MPS/MRP planning item attribute
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Fields Description

Critical Component MPS/MRP planning item attribute

The planning engine can infer from the 
bottleneck resource group whether or not an 
item is a critical component. The Critical 
Component fields displays one of the 
following values:

- Null

- Item attribute

- Inferred

For example, sub-assembly B is created using 
an item A. You may not specify the item A as 
a critical component. However, if the resource 
for creating the sub-assembly B is a bottleneck,
the planning engine considers the 
sub-assembly as a critical component at the 
time of planning for Item A in a production 
plan.

Demand Time Fence Date The planning engine calculates this based on 
the sum of plan run date and demand time 
fence days.

Demand Time Fence Days MPS/MRP planning item attribute

Description Main item attribute

Discount MRP: Plan Revenue Discount Percent profile 
option value

Divergent Supply Feed MPS/MRP planning item attribute

Effectivity Control Bills of material item attribute 

Exception Set MPS/MRP planning item attribute

Fixed Days Supp MPS/MRP planning item attribute

Forecast Control MPS/MRP planning item attribute
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Fields Description

Inventory Use Up Date The planning engine calculates this based on 
the engineering change order for the item.

Make/Buy General planning item attribute 

Margin The planning engine uses the following 
formula to calculate this:

(1 - Standard Cost/ Net Selling Price) * 100

Net Selling Price The planning engine uses the following 
formula to calculate this: 

Selling Price * (1 - Discount) 

Nettable Qty Nettable inventory quantity

Non Nettable Qty Non-nettable inventory quantity

PIP Flag MPS/MRP planning item attribute

Planner General Planning item attribute

Planning Method MPS/MRP planning item attribute

Planning Time Fence Date The planning engine compares the sum of the 
plan run date and planning time fence days 
with the natural time fence. The greater value 
of the two is used for calculating the planning 
time fence date.

If plan option Planning Time Fence is clear 
and the item has no firm discrete jobs, this 
field is blank.

For more information, see Lead Time and the 
Planning Time Fence, page 6-76 .

Planning Time Fence Days MPS/MRP planning item attribute

Product Family Item Product family item name (applicable to 
member items only)



18-118    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Fields Description

Product Family Item Desc Product family item description (applicable to 
member items only)

Repetitive MPS/MRP planning item attribute

Round MPS/MRP planning item attribute

Safety Stock Days General planning item attribute 

Safety Stock Method General planning item attribute 

Safety Stock Percent General planning item attribute 

Selling Price The planning engine considers the selling 
price based on the default price list associated 
with the profile option MRP: Plan Revenue 
Price List.

Service Level Target service level for an item

Shrinkage Rate MPS/MRP planning item attribute

Standard Cost Item cost

Substitution Window MPS/MRP planning item attribute

UOM Main item attribute

Unit Volume Physical attributes item attribute

Unit Weight Physical attributes item attribute

Volume UOM Unit of measure for quantity (volume)

WIP Supply Type Work in process item attribute

Weight UOM Item weight (unit of measurement)

Buttons in the Items Window
Various buttons are provided in the Items window. You can use these buttons to 
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navigate to various other windows:

• Destinations

• Sources

• Where Used

• Components

• Co-Product

• Routing Operations

• Safety Stock

• Substitutes

Right-click Menu Options in the Items Window
In addition to the folder options, the right-click pop-up menu displays the following 
options to navigate to other windows:

• Supply/Demand

• Supply

• Supplier Information

• Process Effectivity

• Exception Details

• Gantt Chart

• Horizontal Plan

• Vertical Plan

Destinations Window
The Destinations window details information such as destination organization, 
sourcing, and assignment associated with items. You can access the Destinations 
window from the Items window and Supply Chain Bill.

The Destinations window consists of three tabs: Sourcing, Effectivity Dates, Assignment
Information.
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Sourcing Tabbed Pane
The following table provides a description of the fields displayed in the Sourcing 
tabbed pane:

Field Description

Item Item

Source Type Sourcing rule, bill of distribution or item 
attribute

Destination Org The receiving organization.

Supplier Supplier name (not used in the Destinations 
window)

Supplier Site Supplier site name (not used in the 
Destinations window)

Allocation % Allocation % from the sourcing rule or bill of 
distribution

Rank Rank from the sourcing rule or bill of 
distribution

Shipping Method Shipping method from the sourcing rule or 
bill of distribution

Intransit Time Indicates the intransit time from the sourcing 
rule or the bill of distribution.

Effectivity Dates Tabbed Pane
The following table provides a description of the fields displayed in the Effectivity 
Dates tabbed pane:

Field Description

From Date Effectivity dates from the sourcing rule or bill 
of distribution
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Field Description

To Date Effectivity dates from the sourcing rule or bill 
of distribution

Quantity Indicates the conversion factor used during 
sourcing

Assignment Information Tabbed Pane
The following table provides a description of the fields displayed in the Assignment 
Information tabbed pane:

Field Description

Sourcing Rule Type Sourcing rule or bill of distribution or item 
attribute

Sourcing Rule Name Sourcing rule or bill of distribution name

Assignment Name Buy from, make at or transfer from

Sources Window
The Sources window details information about sourcing and assignment associated 
with items. You can access the Sources window in one of the following ways:

• Click the Sources button in the Items window 

• Right-click an item in the Navigator, select Supply Chain > Sources.

The Sources window consists of three tabs: Sourcing, Effectivity Dates, Assignment 
Information.

Sourcing Tabbed Pane
The following table provides a description of the fields displayed in the Source tabbed 
pane:
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Field Description

Assignment Use Type of assignment set that uses this rule. For 
example, Sourcing Assignment or Global 
Forecast Distribution.

Source Type Sourcing rule or bill of distribution

Source Org Source organization from the sourcing rule

Supplier Supplier from the sourcing rule or bill of 
distribution

Supplier Site Supplier site from the sourcing rule or bill of 
distribution

Allocation % Allocation % from the sourcing rule or bill of 
distribution

Rank Rank from the Sourcing Rule or bill of 
distribution

Shipping Method Ship Method from the sourcing rule or bill of 
distribution

Intransit Time Indicates the intransit time from the sourcing 
rule or the bill of distribution.
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Field Description

Allocated Qty The planning engine calculates the allocated 
quantity in the following manner 

For each rank, the planning engine aggregates 
all historical allocations for the sources in that 
rank to calculate the total historical allocation.

The planning engine uses the rank quantity 
and the allocated quantity to calculate the 
quantity that is to be allocated to the source. 
The rank quantity is the planned order 
quantity that needs to be planned for each 
rank.

The allocated quantity is the quantity that is 
allocated to any source (allocated quantity). 
The planning engine also considers the 
allocation percent for the source at this rank. 

The quantity that is to be allocated to the 
source = ((allocation percent /100) * (total 
historical allocation + rank quantity)) - 
quantity allocated from this source. 

If the calculated quantity exceed the quantity 
required for this rank, the planning engine 
sets this value to the ceiling.

Effectivity Dates Tabbed Pane
The Effectivity Dates tabbed pane displays the following information:

• From Date

• To Date

• Quantity

For more information about these fields, see 'Destinations Window, page 18-119.

Assignment Information Tabbed Pane
The Assignment Information tabbed pane displays the following information:

• Sourcing Rule Type

• Sourcing Rule Name
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• Assignment Type

For more information about these fields, see Destinations Window, page 18-119.

Buttons in the Sources Window
You can use the buttons provided in the Sources window to navigate to the following 
windows:

• Supplier Flexfences window

• Supplier Capacity window

• Supplier Variability window

• Items window

• Supply/Demand window 

Supplier Capacity Window
You can view the capacity details associated with a supplier in the Supplier Capacity 
window.

View Supplier Capacity Window
To display your supplier capacity
1. In the Navigator, view by supplier.

2. Drill down to highlight an item associated with a supplier or a supplier site.

3. Select [right-click] > Supplier Information.

Alternatively, you can view by any other category and perform the following steps 
to navigate to the Supplier Capacity window.

Highlight a supplier or a supplier site.

4. Navigate to the Items window.

5. In the Items window, click Sources.

6. In the Sources window, click Supplier Capacity.

Information Displayed in the Supplier Capacity Window
The Supplier Capacity window displays the following information:
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Fields Description

Supplier Supplier name

Supplier Site Supplier site name

Item Item name

Org Organization

Processing Lead Time Approved Supplier List processing lead-time

Minimum Order Quantity Approved Supplier List minimum order 
quantity

Fixed Lot Multiplier Approved Supplier List fixed lot multiplier

Penalty Cost Factor Supplier capacity penalty cost factor

Supplier Price Purchasing item attribute

Supplier Capacity Calendar Approved Supplier List supplier capacity 
calendar

Capacity Accumulation Date The planning engine calculates the capacity 
accumulation date based on the Supplier 
Capacity profile option. For more information,
see 'Supply Chain Modeling, page 6-1 .

Category Planning item category

Buyer Purchasing item category

Planner General planning item attribute

Standard Cost Item cost from the Oracle Cost module

The Supplier Capacity window has two tabs:

• Supplier Capacity

• Supplier Flexfences
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Supplier Capacity Tabbed Pane
A supplier may have different capacity on different dates. You can specify the supplier's
capacity for specific time periods in this tabbed pane The planning engine assumes 
infinite capacity on:

• All days from the plan start date to the first day of defined capacity

• All days after the last day of defined capacity to the planing horizon

The following table provides a description of the fields displayed in the Supplier 
Capacity tabbed pane:

Fields Description

From Specify the start date.

To Specify the end date.

Capacity Specify the capacity of the supplier (units per 
day) for the duration. A blank value indicates 
no capacity for all dates before any date with 
defined capacity. A blank value means infinite
capacity for all dates that there is no future 
dates with defined capacity.

For more information on setting supplier capacity, see Supply Chain Modeling, page 6-
1.

Supplier Flexfences Tabbed Pane
On certain days, the supplier may have additional capacity. You can specify the 
tolerance (in percent) to an increase in capacity that the supplier may indicate. The 
fields in the Supplier Flexfences Tabbed pane include:

• Days: Approved Supplier List days in advance

• Tolerance (%): Approved Supplier List tolerance (in %) for days in advance 

For more information on setting supplier flexfences, see Supply Chain Modeling, page 
6-1.

Supplier Variability Window
For information on setting supplier lead-time variability, see Oracle Inventory 
Optimization Implementation and User's Guide.
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Safety Stock Window
The Safety Stock window shows time phased safety stock levels that the planning 
engine used to plan. To access the Safety Stock window for an item, navigate to the 
Items window, select items, and click Safety Stocks.

The information displays by item, then by effective date. You can also update safety 
stock levels. To see safety stock levels calculated but Oracle Advanced Supply Chain 
Planning or Oracle Inventory Optimizaion, see Horizontal Plan, page 18-52

To see more detailed results of safety stock planning, see Supply/Demand Window, 
page 18-64, and Pegging, page 18-83.

The following table lists the information displayed in the Safety Stock window.

Field Description

Item Item

Org Organization

Effective Date Effective dates of the safety stock quantity

UOM Unit of measure

Description Item description

Quantity Safety stock quantity

User Defined Quantity The planning engine populates this field with 
the value from the Inventory Safety Stock 
definition form.

User Defined Days of Supply This is a user-defined quantity that indicates 
days of supply.

Days of Supply The planning engine populates this field with 
the value from the General Planning Item 
attribute.

Safety Stock Methods The planning engine populates this field with 
the value from the General Planning Item 
attribute.
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Field Description

Project The planning engine populates this field with 
the value from the Inventory Safety Stock 
definition form.

Task The planning engine populates this field with 
the value from the Inventory Safety Stock 
definition form.

Substitution Chain Window
You can navigate to the Substitution Chain window from:

• Items window > Substitutes.

• From the Navigator, right-click an item and select Items > Substitutes.

You can specify a customer and site to view the substitution chain for the item. 

Substitition information is only available in Collections Workbench if the substitution 
set name is DEFAULT. 

If you have more than one substitution set, you must running the plan with your 
substitution set specified in the plan options before you can see the substitution 
relationships here. 

Right-click Menu Options
When you right-click an item in the Substitution Chain window, the following options 
appear:

• Properties

• Horizontal Plan

The Properties window does not display the following information for the default 
substitution chain:

• Highest revision item

• Implied predecessor

For more information about the Substitution Chain window, see Business Topics, page 
12-1.
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Resources Window
The Resources window displays resource-related information such as ship method, 
location, and resource cost.

Viewing the Resources Window
To navigate to the Resources window
1. Select a resource in the Navigator.

2. Choose [right-click] > Resources.

3. The Resources right-click menu displays four options: Resources, Resource 
Availability, Resource Requirements, Gantt Chart.

4. Select Resources to view the Resources window.

The Resources window appears.

The Resources window provides detailed information such as:

Fields Description

Dept/Line Department or line designation 

Resource Resource name

Org Organization

Owning Dept Owning department of the resource

Dept Class Department class to which the resource is 
assigned

Resource Type Person, machine or miscellaneous

Resource Group Bottleneck resource group assignment

Min Rate Line rate

Max Rate Line rate

Resource Cost Resource cost per resource UOM



18-130    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Fields Description

24 Hours Resource Yes or No

Aggregate Resource Yes or No

Base UOM Resource UOM

Batchable Resource batchable flag

Batchable UOM Resource batchable UOM

Batching Window Resource batching window

Bottleneck Flag The planning engine calculates this based on 
the plan options for bottleneck resource 
groups.

Dept/Line Desc Description

Efficiency % Resource efficiency %

Exception Set Resource exception set

Group Number Activity group number

Inactive Date Resource inactive date

Max Capacity Resource batching maximum capacity 

Min Capacity Resource batching minimum capacity

Offset (%) Resource offset percent

Resource Desc Resource description
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Fields Description

Schedule The valid values for this schedule flag are:

- Yes

- No

- Prior

- Next

Sequence Resource sequence number

Utilization Resource utilization %

Right-click Menu Options
If you select a resource in the Resources window and right-click, the following options 
appear:

• Folder options (such as Show Field or Hide Field)

• Horizontal Plan

Buttons in the Resources Window
Based on the context, specific buttons are available in the Routing Operations window. 
You can use these buttons to navigate to other windows such as:

• Gantt Chart

• Items window

• Resource Availability Summary window

• Resource Requirements window

Resource Availability Summary Window
You can navigate to the Resource Availability Summary window either from the 
Resources window or by using the Resources right-click popup menu in the Navigator.

To view the Resource Availability window
To view the available capacity, choose Resources > Resource Availability. 

The Resource Availability Summary window appears.
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Information in the Resource Availability Summary Window
The following table lists the information displayed in the Resource Availability 
Summary window.

Field Description

Org Organization 

Dept/Line Resource Owning Department or Line

Resource Resource Name

From Date Start Date for the Total Available

To Date End Date for the Total Available

Total Available Quantity based on the Resource UOM

UOM Resource UOM

Buttons in the Resource Availability Summary Window
The following buttons are available in the Resources Availability Summary window:

• Requirements: You can navigate to the Resource Requirements window by clicking 
the Requirements button.

• Details: You can navigate to the Resource Availability window to view the details.

Resource Availability (Details) Window 
When you click the Details button in the Resource Availability Summary window, the 
Resource Availability window appears. You can view the details of the available 
capacity in the Resource Availability window.

Information in the Resource Availability (Details) Window
The following table lists the information displayed in the Resource Availability 
window:
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Field Description

Org Organization

Dept/Line Owning department or line

Resource Resource name

Shift date Shift date

Shift Num Shift id

From Time Shift start time

To Time Shift end time

Capacity Units Number of resources for this shift

Max Rate Repetitive line max rate

Update Resource Availability
To update resource availability
You can make changes to the resource availability in the Update Resource section.

1. Click the Update Mode drop-down menu to specify the mode in which you want to
update the resource availability. 

The following options appear:

• Add Capacity: Specify the number of units by which the current capacity needs 
to be increased with effect from a specific date.

• Reduce Capacity: Specify the units by which the current capacity needs to 
be reduced with effect from a specific date.

• Set Capacity: Specify the exact capacity units and the date from which the 
capacity change is effective.

• Add Day: Add resource capacity for a non-working day.

• Delete Day: Delete resource capacity for a workday.

Based on your choice, the planning engine prompts you to specify the information.

2. After making changes, click Apply.
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Resource Requirements Window
You can navigate to the Resource Requirements window in one of the following ways: 

• From the Resources window, click the Requirements button.

• From the Navigator, select a resource and choose Resource Requirements from the 
Resources right-click popup menu.

Oracle Advanced Supply Chain Planning does not: 

• Plan and schedule repetitive items

• Detect duplicate resource requirements and decide to drop one. If you change a 
released discrete job bill of material, there may be requirements in two places. 
Change released discrete jobs to reflect bill of material and routing changes; Oracle 
recommends implementing engineering change orders to reflect changes on 
released jobs.

Information in the Resource Requirements Window
The following table lists the information displayed in the Resource Requirements 
window.

Field Description

Dept/Line Owning department or line

Resource Resource name

Org Organization

Firm Type Firm status of the resource requirement. If the 
resource is from a job from Oracle Shop Floor 
Management if profile option WSM: Create 
Job Level BOM and Routing Copies is Yes, it is
the Firm Type collected from that job.

Start Date Requirement start date

End Date Requirement end date

Resource Hours Required resource hours based on the routing 
requirement
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Field Description

Schedule Quantity Assembly quantity of the actual or planned 
make order

Using Assembly Assembly with the resource requirement

Op Seq Actual or planned operation sequence number
for the requirement

Res Seq Actual or planned operation resource 
sequence number for the requirement

Daily Rate Daily rate for repetitive schedule.

Daily Hours The planning engine divides the adjusted 
resource requirement by the number of days 
that the job is scheduled on the resource to 
derive an approximate average.

Touch Time The planning engine calculates this as follows:

Resource Hours / Resource Efficiency %

Adjustable Resource Hours The planning engine calculates this as follows:

Resource Hours / (Resource Efficient % * 
Resource Utilization %)

Assigned Units Number of assigned resource units

Batch Number Batch number

Earliest Allowable Completion Time The planning engine calculates this to indicate
the end of the scheduling window for those 
resource requirements that allow sufficient 
time for the upstream activities to be 
scheduled.

Earliest Possible Completion Time The planning engine calculates this based on 
the constrained schedule for upstream 
activities. It is the earliest time in which the 
resource requirement can be completed.
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Field Description

Earliest Possible Start Time The planning engine calculates this based on 
the difference between the earliest possible 
completion time and supply duration.

Hours Expended This indicates the resource hours already 
expended for existing make orders.

Load Rate This is used for lines only to indicate the load 
rate of the line.

Order Number Order number

Order Type Order type

Overloaded Capacity This indicates the number of overloaded 
resource units.

Quantity Completed This indicates the quantity of the make order 
that is completed.

Quantity in Queue This refers to the quantity of the make order 
that is in queue for resource requirement.

Quantity Running This indicates the quantity of the make order 
that is running on this resource.

Quantity Waiting To Move This refers to the quantity of the make order 
that is complete and is ready to be moved.

Rate End Date Line rate end date

Recalculated Reverse Cumulative Yield For more information, see Network Routing 
Window, page 18-143.

Recommended Yes or No

Required Capacity The planning engine calculates this as follows:

Resource hours * Order quantity in 
weight/volume)
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Field Description

Schedule The valid values for this schedule flag are:

- Yes

- No

- Prior

- Next

Schedule Date This indicates the suggested due date for the 
supply.

Scheduling Sequence Number This refers to the sequence dependent setup 
number.

Source Item This is used for bills of resources to identity 
the source item for the resource requirement.

Unconstrained Earliest Possible Completion 
Time

The planning engine calculates this based on 
the unconstrained schedule for the upstream 
activities that allow minimum durations.

Unconstrained Earliest Possible Start Time The planning engine calculates this based on 
the difference between the unconstrained 
earliest possible completion time and supply 
duration (Unconstrained Earliest Possible 
Completion Time - Supply Duration).

Unconstrained Latest Possible Completion 
Time

The planning engine calculates this based on 
the unconstrained schedule for the 
downstream activities that allow minimum 
durations.

Unconstrained Latest Possible Start Time The planning engine calculates this based on 
the difference between the unconstrained 
latest possible completion time and supply 
duration.

Usage Rate Indicates the usage rate for discrete and 
lot-based jobs.

Yield This indicates the operation yield.



18-138    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Buttons in the Resource Requirements Window
The following button is available in this window:

• Supply: Click this if you want to view the pegging information for supplies (Supply
window).

Supply Chain
The tree structure makes it easy to go down levels on a bill of material. When viewing 
by Organization, you can drill down to go down a level from a department, resource, or
item level to the next level down.

The supply chain map also offers the Item/Location View. This view is available only at 
the item nodes and is the default for these nodes. This view displays a diagrammed 
flow view of all the sourcing rules and bills of distribution associated with the selected 
item. This view also serves as the indented bill of materials.

When you right-click an item in the Navigator, the pop-up menu displays the following
options:

• Sources: Navigate to the Sources window. For more information, see Sources 
Window, page 18-121.

• Supply Chain Bill: View the Supply Chain Bill for an item. For more information, 
see Supply Chain Bill, page 18-138.

• Destinations: Navigate to the Destinations window. For more information, see 
Destinations Window, page 18-119.

Supply Chain Bill
You can view contextual supply chain and where used information for an item 
graphically.

It shows items in the plan options assignment set.

You use this primarily to see bills of material that cross organizations. For example:

• If you have an item that you make 100% in one organization, you may not have 
assigned a sourcing rule in the assignment set. You don't see the item and its 
components in this context window.

• If the make item has components that you source from another organization, you 
most likely have a sourcing rule. You do see the item and its component in this 
context window.
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To view Supply Chain Bill 
1. Drill down to an end item in the Navigator. 

2. Right-click the end item and select Supply Chain > Supply Chain Bill.

A graphical representation of the item's supply chain bill appears.

3. To expand the entire Supply Chain Bill tree, select [right-click] > Expand.

You can use the Expand menu option at all nodes of the Supply Chain Bill tree. 
When you click this menu option after selecting a particular node, the nodes in the 
selected node expand.

BOM/Routing
The planning engine provides detailed BOM and routing information associated with 
an item. Right-click an item in the Navigator, select BOM/Routing. The right-click 
pop-up menu displays the following options to navigate to windows that display 
specific information:

• Components

• Routing Operations

• Where Used

• Process Effectivity

• Co-Products

Components Window
You can navigate to the Components window from the Items window. It consists of 
three tabs: Effectivity and Quantity, Use Up Information, and Item Details.

Effectivity and Quantity Tabbed Pane
The following table provides a description of the fields displayed in the Effectivity and 
Quantity tabbed pane:

Field Description

Org Organization

Item Parent item name
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Field Description

Component Component name

Effectivity Date BOM effectivity date

Usage BOM component usage

Alternate BOM Alternate BOM name

Change Notice Engineering change order name

Revision Engineering change order revision number

Use Up Information Tabbed Pane
The following table provides a description of the fields displayed in the Use Up 
Information tabbed pane:

Field Description

Org Organization

Item Item name

Component Component name

Use Up Item Engineering change order use up item

Use Up This indicates that it is a use up Engineering 
change order item.

Suggested Effectivity Date This is the suggested effectivity date for a use 
up item.

Item Details Tabbed Pane
The following table provides a description of the fields displayed in the Item Details 
tabbed pane:
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Field Description

Org Organization

Item Item name

Component Component name

Op Sq BOM Operation Sequence number

Supply Type BOM supply type

Offset Percent BOM offset percent

Planning Factor BOM planning factor

Item Desc Parent item description

Component Desc Component item description

UOM BOM UOM for the component

Enforce Int Req BOM enforce Integer Requirements Parameter

Optional BOM optional flag

Buttons in the Components Window
Based on the context, specific buttons may be available in the Components window. 
You can use these to navigate to other windows such as:

• Routing Operations window

• Substitution Chain window

• Items window

• Supply/Demand window

Routing Operations Window
In addition to using the BOM/Routing right-click pop-up menu in the Navigator, you 
can navigate to the Routing Operations window from the Items window. The Routing 
window displays the following information, but it does not display information for 
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flow routings:

Field Description

Org Organization

Item Components required at the operation 
sequence

Assembly Routing assembly item

Line Routing line name

Alternate Routing Alternate routing name

Alternate BOM Alternate BOM name

Operation Seq Routing operation sequence number

Operation Description Routing operation description

Effectivity Date Routing operation effectivity date

Disable Date Routing effectivity disable date

From Unit Number BOM unit effectivity start number

To Unit Number BOM unit effectivity end number

Option Dependent Routing operation dependent flag

Operation Type Routing operation type

Minimum Transfer Qty Routing minimum transfer quantity

Yield Routing operation yield

Department Routing department

Operation Lead Time Routing operation lead-time

Cumulative Yield Routing cumulative yield
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Field Description

Reverse Cumulative Yield Routing reverse cumulative yield

Net Planning (%) Routing net planning (%)

Setup Duration Setup duration

Tear Down Duration Tear down duration

UOM Routing resource requirement UOM

Operation Code Routing standard operation code

Effective Routing effective date

Buttons in Routing Operations Window
Based on the context, specific buttons may be available in the Routing Operations 
window. You can use these buttons to navigate to other windows such as:

• Network Routing window

• Resources window

Network Routing Window
You can navigate to the Network Routing window from the Routing Operations 
window. The Network Routing window displays the following information:

Field Description

From Seq + Network routing from sequence number

Code Network routing standard operation code

To Seq + Network routing to sequence number

Code Network routing standard operation code

Link Type Network routing primary or alternate path
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Field Description

Planning % Network routing planning (%)

Where Used Window
The Where Used window provides information about the items usage. In addition to 
using the BOM/Routing right-click pop-up menu in the Navigator, you can also 
navigate to the Where Used window from the Items window to find out where the item 
is used.

The Where Used window has three tabs: Effectivity and Quantity, Use Up Information, 
and Item Details.

Effectivity and Quantity Tabbed Pane
The following table provides a description of the fields displayed in the Effectivity and 
Quantity tabbed pane:

Field Description

Org Organization

Item Component item name

Assembly Parent item name

Effectivity Date BOM effectivity date

From Unit Number BOM unit effectivity start number

To Unit Number BOM unit number end number

Usage BOM usage

Alternate BOM Alternate BOM name

Change Notice ECO Name

Revision ECO revision number

Disable Date BOM component disable date
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Use Up Information Tabbed Pane
For more information, see Use Up Information Tabbed Pane, page 18-139 (for 
Components window).

Item Details Tabbed Pane
For more information, see Item Details Tabbed Pane, page 18-139 (for Components 
window).

You can navigate to the Items window and the Supply/Demand window from the 
Where Used window.

Co-Product Window
In addition to using the BOM/Routing right-click pop-up menu in the Navigator, you 
can navigate to the Co-Product window from the Items window. The Co-Product 
window displays the following information:

Field Description

Co-Product Network routing co-product name

Split (%) Network routing split (%)

Process Effectivity
The Process Effectivity window provides information about the bills of material and 
routing header. It also provides easy access to detailed information associated with bills
of material and routing.

View the Process Effectivity Window
You can right-click an item in the Navigator, select BOM/Routing > Process Effectivity 
to navigate to the Process Effectivity window.

Information Displayed in the Process Effectivity Window
The Process Effectivity window displays the following information:

Field Description

Org Organization
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Field Description

Item Item name

Effectivity Date Routing effectivity date

Disable Date Routing disable date

Minimum Quantity Process manufacturing batch minimum 
quantity

Maximum Quantity Process manufacturing batch maximum 
quantity

Priority Process batch priority

Alternate Routing Alternate routing name

Alternate BOM Alternate BOM name

Total Product Cycle Time Process Manufacturing product cycle time

Item Processing Cost Process Manufacturing item processing cost

Line Process Manufacturing line name

Primary Line Process Manufacturing primary line flag

Line Rate Process Manufacturing line rate

Buttons in the Process Effectivity Window
The following buttons in the Process Effectivity window enables you to navigate to 
other context windows:

• Routing Operations

• Components

Key Indicators
The Key Indicators window is a summary chart that provides a graphical display of a 
plan's Key Performance Indicators (KPIs). At a glance, you can see how the plan 
performs relative to the following measures:



Planner Workbench    18-147

• Inventory Turns

• On-time Delivery 

• Margin Percentage

• Planned Utilization

• Margin

• Cost Breakdown

• Service Level

• Inventory value

• Utilization by Weight/Volume

You can choose to see any four of these measures together. The availability of the KPIs 
depends on the type of plan chosen. For information on how these measures are 
calculated, please refer to, Key Performance Indicators., page 12-69

Viewing KPIs
To view key performance indicators, select plan option, Main tab, Display Key 
Performance Indicators.

To view KPIs
1. Select a Plan, an Item, an Org, or a Product Family from the Navigator. 

2. Select Key Indicators in the pop-up menu.

The Key Indicators window displays the KPIs for the selected Plan, Item, Org, or 
Product Family.

To view an enlarged version of a KPI graph
Double-click on a sub-window to see an enlarged version of a KPI graph. Double-click 
again to return to the normal view. 

Additional display options for each sub-window in the summary chart are available 
using the [right-click] menu. For instance, you can display KPI information in a trend 
chart.

Inventory Turns
This graph compares the actual inventory turn values to the target values collected from
the source. You can view overall inventory turns for a plan or select a node on the tree 
to see the node's inventory turns. You can view the inventory turns value over time to 
evaluate the plan throughout the planning period.

The Inventory Turns graph is displayed at the following nodes:
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• Plans

• Organizations

• Product families

• Categories

• Individual items

• Components 

• Planning groups

• Projects

• Tasks

On-time Delivery
The On-time Delivery Percentage graph is displayed at the following nodes:

• Plans

• Organizations

• Product families

• Categories

• Individual items

• Components 

• Planning groups

• Projects

• Tasks

Planned Utilization
The Planned Utilization percentage is available at the following nodes:

• Plans

• Organizations

• Departments

• Resource groups
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• Resources

• Production lines

• Transportation resources

• Approved suppliers

Margin Percentage
This graph compares the actual margin to the target values collected from the source. 
You can evaluate alternate plans based on the net difference between plan revenues and
costs. Plan revenues are derived from forecasts and booked sales orders while costs 
account for planned production schedule expenses.

Margin percentage is available at the following nodes: 

• Plan

• Organization

• Product family

Reviewing Item Planning Information
In the View by drop-down menu, select either Item or Organization, then drill down to 
an Item to view KPIs at the Item level.

Comparing KPIs for Multiple Plans
KPIs of multiple plans can be compared in the summary chart by selecting two or more 
plans in the Navigator (using Ctrl-Click).

Select Worksheet (Export to Excel)
Use this window to export worksheets to Microsoft Excel. Before you do this, see Export
to Excel.

Navigate (M) Tools > Export Plan Worksheets to Excel.

Select a worksheet and click OK. Microsoft Excel opens and displays the information.

Web Tools Pages
Web tools pages are browser pages. You can use them to perform analysis and release 
functions like some of the context windows

To see the web tool pages:

• Install WebLogic 11gR1

• Install Oracle Application Development Framework

• Set profile option MSC: ASCP Planning URL
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Item Simulation Set Page

Use this view to make proposed adjustments to item attributes to simulate their effect 
on a plan results (run a simulation plan)

You can access this page from:

• Navigator > Web Tools

• The right-click menu of Planner Workbench context windows, for example, Items, 
Supply/Demand, and Sources, Orders

• Web tools page Orders

Run and analyze a supply chain plan, record your proposed changes, and launch the 
simulation plan using web tools Supply Chain Launch View.

If you have not made a simulation set for the plan you want to simulate, this page 
opens in create mode. You can name and start making entries to it.

If you have made a simulation set for the plan you want to simulate, this page opens in 
edit mode. You can change entries in it.

When you save the simulation set, it removes item/organization entries where you have
not changed any item sttributes

Orders Page

Use this view to view and edit order attributes and release orders.

You can access this page from the right-click menu of Planner Workbench context 
windows, for example, Supply/Demand Pegging Tree, Items, and Sources.

Organization Security Page

Use this view to assign organizations to responsibilities.

You can access this page from Navigator > Web Tools.

Its functionality is similar to the Advanced Planning Administrator form Assign 
Organizations to Responsibilities.

Supply Chain Launch Page

Use this view to launch a supply chain plan online.

You can access this page from:

• Navigator > Web Tools

• The right-click menu of Planner Workbench context windows, for example, 

Its functionality is similar to the concurrent process Launch Supply Chain Planning 
Process Request Set, Parameters window.
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Implementing Planning Recommendations
The Actions Summary view displays both recommendations and exceptions. The 
recommendations are divided into orders that must be released and future orders. In 
the Preferences window (Tools > Preferences), you can specify the time frame in days 
for which to show recommendations. 

To implement planning recommendations, choose Tools > Preferences. 

Creating and Implementing Firm Planned Orders

Accessing Planned Orders
You can access a subset of planned orders for a specified time period or other user 
defined sort criteria using the Supply/Demand window. You can release all planned 
orders using a Release All feature or you can individually select planned orders for 
release.

To access planned orders
1. In the View By Actions mode, drill down to the Recommendations node.

2. Drill down to items in Purchase Requisitions or Discrete Jobs.

3. Right-click an item, select Supply/Demand > Supply/Demand. 

4. To firm a planned order, drill down to detail, then select the Firm check box. 

For detailed information about the fields in the Supply/Demand window, see 
Supply/Demand Window, page 18-64.

Receiving Firm Planned Orders from Production Schedules
Production schedule planners can publish Oracle Production Scheduling work orders 
and planned orders to Oracle Advanced Supply Chain Planning. The orders in Oracle 
Advanced Supply Chain Planning are firm planned orders.

See Feeding a Production Schedule Back into ASCP, page 20-39.

Releasing Recommendations
You use the Supply/Demand context window to release recommendations to the 
execution systems. 

If you are releasing recommendations to multiple operating units, set profile option 
MO: Operating Unit at the responsibility level.

To release recommendations
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1. In the View By Actions mode (on the left pane), select the Recommendations node.

2. Drill down to the node that you want, for example, a plan, a planner, or an item.

3. Right-click an item, select Supply/Demand > Supply/Demand.

4. If you want to make changes to recommendations, navigate to the Release 
Properties tab, make them, and save your work. See Release for Buy and Make 
Orders and Release for Transfer Orders.

5. If you want to release a recommendation, select For Release. If you want to release 
all recommendations, select Edit > Select All.

If you select For Release in the Orders tab before you make changes in the Release 
Properties tab, clear For Release, make your changes, and select For Release again.

6. From either the Orders tab or the Release Properties tab, press [right-click] > and 
select Release.

Release for Buy and Make Orders

To change the supply Suggested Due Date, select a new date in Implement Date. You 
can select a non-workday. If you select a date in the past, the scheduled receipt or 
transfer order will have today's date. 

To change the supply Qty/Rate, enter a new quantity or rate in Imp Qty/Rate.

If you want to firm a recommendation, select Firm. It becomes a firm planned order. See
Creating and Implementing Firm Planned Orders, page 18-151.

When you release a planned order as buy from and do not change the recommended 
dates, the release process sets Need-by Date to the planned order Suggested Dock Date.

When you release a planned order as buy from and change the recommended dates, the
release process calculates Need-by Date as follows:

• If Implement Date is a non-workday in the manufacturing calendar, moves it to the 
previous working day.

• Calculates Dock Date = Implement Date - Postprocessing lead time

• If Dock Date is a non-workday in the manufacturing calendar, moves it to the 
previous working day.

• If the organization has a receiving calendar and Dock Date is a non-workday in the 
receiving calendar, moves it to the previous working day on this calendar.

• Sets Need-by Date to Dock Date

When you release recommendations for make items using substitute components, the 
substitute components only appear on the discrete jobs if the discrete jobs are in daily 
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buckets.

Release for Transfer Orders

You transfer material by using internal sales orders and internal requisitions in pairs.

For release for transfer orders, your source instance must be at least release 12.1.1.

If your plan includes both the source and destination organizations, you can:

• Change the date and quantity on the internal requisition

• Change the date and quantity on the internal sales order

• Cancel the internal requisition

• Cancel the internal sales order

If your plan includes only the destination organization and not the source organization, 
you can:

• Cancel the internal requisition

• Cancel the internal sales order

Changes to the:

• Internal requisition pass automatically to the internal sales order

• Internal sales order pass automatically to the internal requisition

To change the internal requisition Suggested Due Date and the internal sales order 
Suggested Ship Date, select a new date in New Date. You can select a non-workday. If 
you select a date in the past, the scheduled receipt or transfer order will have today's 
date

To change the supply Qty/Rate, enter a new quantity in New Quantity. To cancel an 
internal requisition and internal sales order, set New Quantity to zero.

The information in fields Implement Date and Imp Qty/Rate come from:

• If you have not firmed the recommendation, Suggested Due Date and Suggested 
Quantity

• If you have firmed the recommendation, New Date and New Quantity

If you mark a recommendation For Release and want to make further changes to New 
Date and New Quantity, clear For Release before you make the changes. Otherwise, 
make the changes directly.

When you execute the release, the fields that change the internal requisition and 
internal sales order are Implement Date and Imp Qty/Rate. Also, the process:

• Updates Ship Method on the internal sales order if the internal sales order is in the 
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plan

• Performs an available to promise check on the internal sales order, if profile option 
MSC: Perform ATP check for Internal Sales Orders is Yes 

This table shows the other Planner Workbench fields that pas to the transfer orders.

Planner Workbench Field 
(from)

Transfer Order (to) Transfer Order Field (to)

Implement Dock Date > Internal requisition Need-By Date

Implement Ship Date > Internal sales order - Schedule Ship Date

- Request Date

- Promise Date

Implement Dock Date > Internal sales order Schedule Arrive Date

Material Available Date > Internal sales order Earliest Ship Date

Once you have released either the internal requisition or internal sales order, you 
cannot release the other one

If the passing of changes to the other order of the transfer pair fails, you receive a 
message in a concurrent process log file from:

• If your plan includes both the source and destination organizations, Oracle Order 
Management concurrent process Update Scheduling Results

• If your plan includes only the destination organization and not the source 
organization, Oracle Purchasing concurrent processes Reschedule Requisitions or 
Check ATP

Publishing Plan Results to Oracle Order Management
One of the many decisions Oracle Advanced Supply Chain Planning can make is the 
selection of a facility to source the materials based on current conditions of supply and 
demand. The planning engine selects the sources based on global supply availability, 
constraints that you may have in the supply chain, costs involved in producing and 
procuring items etc. This information can be communicated to Order Management for 
effective execution.

As sales orders are accepted into the system, users may put in a fulfillment facility 
based on order promising or a preferred facility by default, but the facility chosen by 
the users may not be the correct facility given the ever evolving supply and demand 
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picture through out the supply chain. As a result of plan run, you can determine the 
correct sources, and along with changed source you might have to change ship dates, 
ship methods etc. These change recommendations are published to Order Management

Oracle Advanced Supply Chain Planning checks for several conditions before releasing 
the updated sales orders to Oracle Order Management:

• A single sales order line cannot have multiple source organizations. Global 
forecasting can result in split recommendations for a sales order.

• Sales order lines in a ship set must have the same source organization. The 
implement date for all the lines in a ship set or an arrival set is the maximum date 
across all the lines in a ship set or an arrival set respectively.

• Sales order lines set to Ship Model Complete do not receive any release 
recommendations.

• Sales order lines for components of PTO models and kits do not receive any release 
recommendations.

The planning engine displays a release error for each incorrect selection of an order.

Note: You cannot auto-release these recommendations to Oracle Order 
Management.

To setup plan results publishing to Oracle Order Management
1. Select the Advanced Supply Chain Planner responsibility.

2. Navigate to Supply Chain Plan > Names.

3. Select the Notifications check box for the plan that you want to publish result for.

4. Navigate to Supply Chain Plan > Plan Options > Organizations tab:

5. Verify that global forecasts are defined as Demand Schedules in the Global Demand
Schedules region.

To firm sales orders in Oracle Order Management
Oracle Order Management provides a Firm option at the order line level. You can set 
the Firm option on a sales order line in three ways:

1. Firm based on the event

Oracle Order Management provides different event values, which are set at 
organization level, to firm the demand lines:

• Schedule: The sales order line is firmed the moment it is scheduled
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• Shipping Interfaced: The sales order line is firmed after it is interfaced to 
shipping.

• None or Null: The sales order line is not firmed

2. Firm using a workflow

Oracle Order Management provides a sub process to hold and firm sales order 
lines. You can customize their line flow and place this sub process anywhere in the 
flow based on your need. Shipped, closed, fulfilled, and cancelled sales order lines 
are firmed irrespective of the sub process position. Lines that reach the sub process 
wait until they are progressed further.

You can manually progress the lines to continue their progress. Oracle Order 
Management provides a concurrent program to progress the sales order lines that 
are waiting at the sub process. You can schedule to run this concurrent program 
periodically to progress lines that are waiting at the sub process.

Oracle Order Management firms the sales order lines and progresses the lines to the
next activity.

3. Firm by manually setting the Firm option on the sales order.

You can manually firm the sales order lines based on your need. However, you 
cannot update the firm option on closed, shipped, cancelled and fulfilled sales order
lines.

To publish plan results to Oracle Order Management
1. Navigate to Supply Chain Plan > Workbench > Tools > Preferences > Other tab.

2. Select the Include Sales Orders check box.

3. Run a supply chain plan with global forecasts defined as demand schedules.

4. Review exception messages. The planning engine can generate the following 
exception message:

• Changes recommended for sales order exception

5. Optionally, firm the sales order line:

1. Navigate to Supply/Demand window > order tab.

2. Select the Firm check box for the order line that you wish to firm.

6. Select the Release check box for each order or the Select all for release menu option 
to release the recommendations to update the sales orders.

This initiates the Release sales order recommendations concurrent process to save 
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the release selection and release the updated sales order information to Oracle 
Order Management.

Note: You can manually change the Implement Date in the Release 
Properties window to override the plan recommendations. When 
the sales order is released, the Implement Date is populated to the 
Schedule Ship Date on the sales order line in Oracle Order 
Management.

When you release recommendations, the Release window appears as a confirmation
with the following information:

• Concurrent request number

• Number of sales orders released

• Number of sales orders affected

7. Click OK to complete the release process

The planning engine publishes the following information to the sales order line in 
Oracle Order Management:

Fields from the Supply/Demand window in 
Oracle Advanced Supply Chain Planning

Fields that are updated on the Sales Order 
Line in Oracle Order Management

Source Organization Warehouse

Suggested Ship Date Scheduled Ship Date

Planned Arrival Date Scheduled Arrival Date

Ship method Shipping Method

Intransit lead-time Deliver lead-time

Firm flag Firm flag

Material availability date Earliest ship date (Shipping)

If the sales orders update in Oracle Order Management fails after the release by the 
planning engine, Oracle Advanced Supply Chain Planning initiates the following 
workflow notification:

• Sales order changes from Oracle ASCP not committed
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Oracle Advanced Supply Chain Planning derives the CSR or sales representative details
from the Created By field on the sales order header and sends the following details:

• Item - The item on the sales order line

• Order number: Sales order number 

• Line Number: Sales order line number

• Customer: Customer on the sales order

• Override flag (from Oracle Order Management)

• Old ship method and deliver lead-time

• New ship method and deliver lead-time

• Old schedule arrival date

• New schedule arrival date

• New schedule ship date

• Old schedule ship date

• Old source organization

• New source organization

• Request ID 

Note: You need to define the person named in the Created By 
field as a valid user in Oracle ERP to receive the workflow 
notifications.

You can use the request ID displayed on the workflow notification to bring up 
the reason codes for failure to update the sales order in Oracle Order 
Management.

For more details, see Oracle Order Management User Guide.

Example
This section provides an example of sales order update by Oracle Advanced Supply 
Chain Planning to Oracle Order Management.

Assume that a sales order line has:

• Request Date = D10
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• Schedule Ship Date = D20 

If the planning engine determines that the material availability date is:

• D22, then both the earliest ship date and schedule ship date are updated to D22. 

• D8, the schedule ship date is updated to the request date, which is D10. The 
planning engine uses the earliest ship date to update the schedule ship date.

The updated schedule ship date can be vied in Oracle Order Management after the sales
order is released by the Planning engine.

If you have firmed a sales order in Oracle Order Management, the planning engine does
not provide any recommendation for source change. Oracle Advanced Supply Chain 
Planning sources the supplies only from the source provided on the sales order. If the 
sourcing causes resource overload at the source organization, the resources are still 
overloaded to honor the source mentioned on the sales order. 

Interactive Scheduling Using the Gantt Chart
Interactive scheduling provides a time-phased graphical interface to your plan's 
scheduled activities and resources to help resolve inevitable shop floor problems. It lets 
you troubleshoot exceptions arising from resource or material constraints; overloaded 
or underloaded resources; absenteeism, or machine downtime. Use interactive 
scheduling to pinpoint affected jobs and operations and simulate changes towards 
effective, timely resolution. 

You can use the Gantt Chart for plan type Constrained.

To access the Gantt Chart 
Follow the appropriate navigation path as shown in the table:

Current Window Navigation

Exception Details window [Select any field] > [right-click] > Gantt Chart

Supply window [Select any field] > [right-click] > Gantt Chart

Resources window Click the Gantt Chart button

Navigator Select a resource>[right-click]>Gantt Chart

Select a resource and click the Gantt chart 
button and the bottom of the navigator 
window.
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The title in the Gantt Chart window reflects the view selection that you make-- Orders 
View, Resource Activities View, or Supplier Capacity View.

When the Gantt Chart opens, there are two group boxes.

• The first group box displays "Gantt Chart" and the instance and organization 
selected.

The icons provide options for various Gantt chart views.

The Preference set determines the user preferences for Gantt chart display options.

The Go To option enables you to go to a specific date when the Gantt chart is 
displayed, and the Today option enables you to view the current date.

• The next group box displays the view that is selected, with a left and a right pane.

The folder icon enables you to save selected settings.

The View field enables you to select a view.

The left pane displays a tree structure with multiple columns. The columns are 
dependant on the view that is selected.

Depending on the view selected, the left pane displays a list of resources, orders, or 
item suppliers.

To select a view, use the drop down menu in the left pane.

The right pane panels begin at the plan start date. To go to another date, you can:

• Scroll horizontally

• Enter a date and time in Go to: and press Enter. To go to today, click Today.

The right panel header also shows the planning granularity that was used for a certain 
portion of the planning horizon. This is different from the display granularity. For 
example, you may be viewing the Gantt chart in weekly buckets, but the portion of the 
planning horizon you are viewing may have been scheduled at the day level of 
granularity.

The Order-Centric View
The order centric view displays the selected supplies. This view can be invoked from 
the Supply or Supply/Demand block of the Planner Workbench. For the selected supply
(or supplies), if pegging actions are invoked, the Gantt Chart displays all the supplies 
that peg to the selected supply. This includes supplies at various levels in the bill of 
material. This is provided as a tool to view the impact on supplies across supply chain 
levels on a planner's scheduling changes.

From the end assembly, the Gantt chart first displays the operations and the 
requirements on the resources selected to perform the operations. Because material 
availability is just as important as resource availability, it is shown within the Gantt to 
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make rescheduling more accurate. The dates when materials become available are 
displayed as milestones. Material is shown at the beginning of the operation where it is 
needed.

When accessed from the Resource Centric View, the Order-Centric view shows the 
orders that were originally in the Resource Centric View.

The Orders view also functions as the view where late demand diagnosis can be 
performed in the Gantt chart. When you enter the Orders view from a late demand, the 
Gantt chart displays the late demand and all the supplies that peg up to that late 
demand. You can choose display options to highlight the critical path or show just the 
critical path. You can view the unconstrained earliest and latest start and completion 
times to identify the effects of resource and supplier capacity constraints on demand 
lateness. Comparison of the constrained earliest and planned start and completions 
times along the various activities on the critical path, which enables you to identify the 
key bottlenecks on the critical path.

The Resource-Centric View
This view can be accessed from the resource block of the Planner Workbench or by right
clicking on a selected resource(s) in the left pane of Planner Workbench.

This view displays all the activities that are being worked on by the selected resource(s).
The right pane shows resource availability as a backdrop. Resource activities that are 
scheduled on the resource are shown in the foreground. A color scheme can be applied 
to distinguish activities with characteristics such as: late order, early orders, firm orders,
or orders causing overloads.

Changeover times between activities are displayed in a separate color. Activities on 
batchable resources can be shown either as individual activities or as consolidated 
batches. Users can select activities and view the alternate or simultaneous resources 
used in those activities. Activities can be moved to those alternate resources. Within the 
same resource, users can drag and drop activities to earlier or later points in time. The 
Resource Activities view only displays the portion of the planning horizon that is 
scheduled to the minute level of granularity.

The Resource Hours view displays hours that are available compared with hours that 
are used. The detail displays hours spent on late orders, hours spent on early orders, 
hours spent on firm orders, and hours that overloaded and exceed available capacity. 
The most granular display possible in this view is daily buckets. When viewing in daily 
buckets you can only view the portion of the planning horizon that was planned in 
days. When viewing in weekly buckets you can see both the portion that was planned 
in days and weeks. When viewing in period buckets you can see the entire planning 
horizon.

The Resource Units view displays continuous time varying profile of the resource units 
that are available compared with units that are used. This view is useful if there are a 
large number of available units per resource and if the units available vary with time.
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Note: In both the order-centric and the resource-centric views, an 
activity that appears on the right pane and is not seen on the left pane 
can be brought in to the right pane by right clicking on that activity in 
the left pane and selecting Jump from the right-click option. This makes
it easy to navigate to an activity.

Rescheduling is not available within the Resource Hours and the 
Resource Units views.

The Supplier Capacity View
This view displays the supplier capacity that is available and the supplier capacity that 
is used. It also tracks the cumulative capacity that is available. You can select a bucket 
and drill down into the supply details by selecting Supply from the right-click option. If
the supplier capacity is infinite, or undefined, a dark background color is displayed.

A slider Scale option is available in the upper right portion of the chart, which controls 
the maximum value of the vertical dimension. This is useful when wanting to use 
different scales to identify the buld up of cumulative capacity versus the capacity 
available or used in any one bucket.

Defining User Preferences - Gantt
The Preferences - Gantt page enables you to define display options for these view types:

• Orders

• Resource Activities

• Resource Hours

• Resource Units

• Supplier Capacity

To access the Preferences - Gantt page
To access the Preference - Gantt page:

1. Navigate to the Planner Workbench.

2. Choose Tools > Preferences.

3. Select the Gantt tab.

4. Select a View Type.
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The Orders View Type
These fields are available on the Preferences - Gantt - Orders view type page:

• Row Height: Select the desired height for each row in the view. One is the smallest 
and five is the largest.

• Show Pegging with Material Flow Details: Select to display pegging arrows to and 
from each supply segment.

Important: Select this option only if you have enables segment level
pegging for the plan. To see regular pegging between supplies and 
demands, you should not select this option.

• Timescale Display: Select the timescale that will appear by default when the Gantt 
Chart is displayed.

• Text Format: Select the text that displays within each type of bar.

• Color Settings: Select the color that displays for each type of bar.

The Resource Activities View Type
The fields on the Resource Activities view type are similar to the Orders view type with 
the exception of the Display Tolerances field. In the Display Tolerances field, enter the 
tolerance for the number of days late that an order needs to be for it to be color coded as
late when displayed in the Gantt chart. Also enter the tolerance of the number of days 
early that an order needs to be for it to be color coded as early. An order displays with 
the late color setting if it is late by more than this tolerance. The same applies to early 
orders.

Find Window
The Find window can be used to view subsets of data by selected criteria, such as by 
time, by items, by organizations within the Gantt chart. The Find window can be used 
with all views, but the fields that are available are dependant on the specific view. A 
Find condition can be saved as part of a folder. 

Tip: The only way to save the find condition as a folder in the Gantt 
chart view is when the find window is open. Once you close the find 
window, you are not allowed to save as a folder.

To display the Find window, select View>Find.
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Right-Click Menu Options
The Gantt Chart provides easy access to important information and tasks related to 
operations. The following options are available if you right-click with your cursor over 
an operation:

[Right-Click] Menu Options Description

View Alternate/Primary Resource View Alternate/Primary Resource for this 
operation

Load Alternate/Primary Resource Load Alternate/Primary Resource for this 
operation

View Simultaneous Resources View Simultaneous Resources for this 
operation. If in the Resource Activities view, 
the selected simultaneous resource, and all of 
its associated instances is added to the list of 
displayed resources.

Firm/Unfirm Operation Firm/Unfirm Operation for this operation

Reschedule Reschedule

Supply/Demand Open the Supply/Demand window

Exception Details Open the Exception Details window

Items Open the Items window

Resource Capacity Open the Resource Capacity window

Resource Requirements Open the Resource Requirements window

Resources Open the Resources window

Batches Open the Batches window

Charges Open the Charge Details window

Material Flow Details Open the Material Flow Details window

Horizontal Plan Open the Horizontal Plan window
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[Right-Click] Menu Options Description

Hide/Show Resource Temporarily hide or display a resource.

End Pegged Demands Open the End Pegged Demands window

Save Layout Save the list of displayed columns and their 
relative order to the current folder.

Viewing Information on an Operation
You can view information on orders and operations via the Properties window or 
resource Tool Tips. 

To display the Properties window 
1. Select an order or operation from either pane.

2. Right-click and select Properties. If the Properties window is already open and you 
select another order or operation, you do not need to perform this step; the 
properties of your new selection replace the properties of your previous selection in
the existing Properties window.

The Properties window appears. 

Note: Most of the relevant properties are already available as folder
columns in the Orders view. This enables you to view these 
properties for all the orders at the same time instead of opening the 
properties window one order at a time.

The Property window displays a host of information about the selected operation. 
Choose tabs to access different types of information. 

When you double click on the Gantt chart bar on the right panel (or the labels on 
the left panel), a Property window appears with three tabs: resource, supply order, 
and end demand.

The properties for the Resource tab (only for the activity node) are: department/line,
resource name, org/instance, operation sequence, resource sequence, alternate 
number, firm type, start time, end time, assigned units, and total hours required.

The properties for the supply order tab (only for the supply node) are: job number, 
job type, item, quantity, firm flag, suggest due date, ship date, need by date, unit 
number, project, task, alternate BOM, alternate routing, and time fence.

The properties for the end demand tab (only for the supply node) are: demand date,
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demand satisfied date, pegged quantity, demand name, demand qty, demand type, 
demand priority, customer, customer site, and item

The resource tool tip for an operation is a subset of the Properties window; to see it, 
rest your cursor over the operation in the right panel. 

Specify Resources to Plot in the Lower Pane

To select resources to plot
• From the Resource view, select resources using the Find window.

• From the Orders view, select and order and then select Show Resources.

Specifying Time Buckets

To display a different time bucket for the right pane 
1. Right-click on any day. 

2. Choose from the following intervals: 

• Periods

• Weeks 

• Days

• Hours

• Thirty Minutes

• Fifteen Minutes

If the planning mode of the plan is Constrained (Without Detailed 
Scheduling):

• Gantt chart views are available only in the planning buckets (Day, 
Week, Period). The system does not allow the zoom level to be less than
a day (minutes and hours are disabled). You can to zoom from Week to 
Day and from Period to Week and Day. The entire planning horizon is 
displayed.

• In the Orders View the start of an order is set to the beginning of the 
planning bucket and the end of the order is set to the end of the 
planning bucket in which the order is completed.
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• In the Resources View the start of an activity is set to the beginning of 
the planning bucket and the end of the activity is set to the end of the 
planning bucket in which the activity is completed.

Rescheduling Operations
You can reschedule a job from the Resource Activities view by using the Reschedule 
window, or by dragging and dropping the bar in the right pane. You can also 
reschedule a job in the Orders view by editing the left pane.

To reschedule an operation using the Reschedule window 
1. In the left pane of the Gantt chart, right click on one of the nodes.

The related activity appears in the right pane.

2. [Right-click] on the bar in the right pane.

A list of tasks or options appears.

3. Select Reschedule.

4. Select a new start or end date for the activity. 

5. Click OK. 

The activity's new start or end date is reflected in the Gantt Chart. After moving an 
activity, you can firm it by the new start or end date, or by resource. 

To change the duration of an activity
1. Specify a new start or end date using the instructions above. 

2. Select the Resize check box.

3. Click OK. 

The activity's new duration is reflected in the Gantt Chart. After changing an 
activity's duration, you can firm it by the new start or end date, or by resource. 

To reschedule an activity graphically 
1. Select the activity you wish to reschedule.

2. Drag the activity to a new date or time. 

The activity's new start or end date is reflected in the Gantt Chart. 

After moving an activity, you can firm it by the new start or end date, or by 
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resource. 

To resize an activity graphically
1. Select the activity. 

2. Drag the right end of the activity bar to a desired end date. After resizing, the 
activity can be firmed.

Firming an Operation

To firm an operation
1. Place your cursor over the operation you wish to firm. 

2. Choose [right-click] > Firm/Unfirm Operation > [Firm option]. 

Resolving Overload of an Operation
There are three ways to resolve overload of an operation. You can: 

• Reschedule the operation to a time when sufficient resources are available.

• Select alternate resources for the operation. 

• Add extra capacity to complete the operation with your current resources.

To reschedule an operation
• Use the Reschedule window

• Drag and drop the operation in the Gantt Chart 

To load an alternate resources
1. Place your cursor over the operation you wish to offload. 

2. Choose [right-click] > Offload to Alternate Resource.

3. Choose an Alternate resource. 

A new resource is listed for the operation in the left pane. In the right pane, the 
operation's shading changes to reflect that it is updated. 

To add capacity
1. From the Resource or the Orders view, select an operation for which you wish add 

capacity. 
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2. Choose [right-click] > Resource Capacity.

The Resource Capacity window appears. 

3. Select a date for which you'd like to add capacity. 

4. Add capacity for a set duration for a particular shift. 

5. Click Apply. 

You can then run the online planner to see the results of adding capacity for this 
date. Your changes are also dynamically reflected in the Gantt Chart.

When any changes are made in the Gantt chart, including offloading, adding 
capacity, rescheduling, or increasing time duration for an activity, these changes do 
not take effect until the Online Planner is run.

Gantt Chart Icon Options
The following table shows the icon options for the Gantt chart and what happens when 
a particular option is selected.

Icon Option Gantt Chart Display

Peg Up and Down Displays upstream supplies and downstream 
supplies relative to the selected supply or 
demand.

Peg Up Displays all downstream supplies relative to 
the selected supply going all the way up to the
end demand.

Peg Down Displays all upstream supplies that relate to 
the selected supply or demand.

Back or Forward Select to navigate back and forth between 
prior results from pegging actions taken 
within the Orders view.

Show Pegging for Selected Displays pegging for the selected supply. 
Inbound and outbound material flow is 
displayed.

Show Pegging for All Displays all pegging relationships for 
displayed supply and demand.
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Icon Option Gantt Chart Display

Hide Pegging Turns off all pegging arrows that are 
displayed.

Show or Hide Intra Routing Displays the flow of material between 
operations within a routing.

Select All Selects all rows in the Orders view.

Note: This can be done only when the 
Orders view is displaying all supplies. For 
example, if the Orders view is displaying a 
full list of supplies only, the Select All 
option selects all of the supplies. However, 
if the Orders view is showing a demand 
and the supplies pegged to that demand, 
the Select All option does not select 
anything.

Collapse All Collapses all of the expanded options to the 
highest level.

Expand Selected Supplies to Operations All selected supplies are expanded to the 
operation level.

Expand Selected Supplies/Operations to 
Activities

All selected supplies are expanded to the 
resource activity level.

Show Critical Path Only Displays only critical activities.

Highlight Critical Path Displays all activities with critical activities 
highlighted.

Constrained Earliest Times Displays constrained earliest possible start 
and end times.

Unconstrained Earliest Times Displays unconstrained earliest possible start 
and end times.

Unconstrained Latest Times Displays unconstrained latest possible start 
and end times.
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Icon Option Gantt Chart Display

View Batches/Hide Batches Displays consolidated activities that are part 
of the same batch for a batchable resource, 
which is a resource with multiple activities 
that can be scheduled together as batches.

Show Charges Displays an activity split based on the number
of charges planned within the activity 
duration. For activities scheduled on 
chargeable resources, this option displays 
constituent charges of a single resource 
requirement. The start and end dates of each 
charge is shown as a thin white line within the
bar that represents the resource activity.

Hide Charges Removes the charges display from the bar 
graph.

Gantt Chart Pegging
Gantt Chart pegging is specific to the Orders view. For supplies that you specify, the 
Gantt chart pegging view links related end assembly orders, subassembly orders and 
purchased material orders together in a hierarchical display. For the entire hierarchy, 
the timing of all production operations and purchased material arrivals are displayed. 
Material arrivals are shown as milestones. The hierarchy may be flexibly collapsed 
(with collapsed operations and material arrivals appearing as rolled up bars, as is 
commonly seen in project plans) and expanded. This view provides a consolidated view
of all operation and material arrival dependencies for a particular end assembly order. 
You can drill down to any desired level and view further details.

To display Gantt Chart pegging
1. From the Planner's Workbench, select a plan.

2. Right click on the plan and select Supply and Demand, Supply and Demand.

The Supply/Demand window appears.

3. Select a demand.

4. Right click and select Gantt Chart.

The Gantt chart appears with the pegging information in the left pane. It displays 
the demand and all of the supplies pegged to that demand.

Alternatively, you can select a supply or a set of supplies and enter the Gantt chart. 
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The Gantt chart only displays these supplies. Then you can select one of the 
supplies and perform a pegging action, which results in the related supplies being 
displayed.

Gantt Chart Two Views
It is possible to pass information between two open views of the Gantt chart. For 
example, when viewing the Resource Activities view, you can add the Orders view 
along the horizontal plain.

To display two views
1. Navigate to the Gantt chart, Resource Activities view as an example.

2. Select a resource activity along the timeline for one of the resources displayed in the
view.

3. Click the Show Orders icon.

The Orders view is displayed below the Resource Activities view and is displays 
the order that you selected in the Resource Activities view..

Accessing Planner Workbench From Oracle Collaborative Planning
Suppliers can view specific information in the Planner Workbench by using the Planner 
Workbench tabbed region in Oracle Collaborative Planning. Based on whether you 
model the supplier as an organization or as a supplier for planning purposes, the 
information displayed to the supplier varies. 

If you model the supplier as an organization, the following information appears in their
Planner Workbench:

• Plans for which the supplier is modeled as an organization

• Supplier organization name

• Product families, categories, departments, lines, and transportation resources in the 
supplier organization

• Items and details such as components, where used, and approved suppliers within 
each product family

• Organization-specific supply and demand information

Your suppliers can use the Planner Workbench - Supplier Administrator responsibility 
to view the following left-pane nodes and related right-pane tabbed regions in the 
Planner Workbench: 
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Left Pane Nodes Right Pane Tabs

Organization Key Indicators, Actions

Category Key Indicators, Actions

Item Key Indicators, Horizontal Plan, Vertical Plan,
Actions,

Component Key Indicators, Horizontal Plan, Vertical Plan,
Actions,

The following table lists the right-click menu options available in Planner Workbench 
that your suppliers can use:

Function Name Menu Options

Exceptions Actions, Exception Details, Related 
Exceptions, Save Actions

Resources Resources, Resource Requirements, Resource 
Availability

Supplier Supplier Capacity, Supplier Flex Fences, 
Supplier Variability

Routings Routing Operations, Operation Networks

Key Indicators Key Indicators

Pegging Pegging, Critical Activities, End Pegged 
Supplies

Horizontal Plan Horizontal Plan

Vertical Plan Vertical Plan

Gantt Chart Gantt Chart

Supply Chain Bill Supply Chain Bill

Items Items



18-174    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Function Name Menu Options

Components Components

Where Used Where Used

Sourcing Sourcing

Destination Destination

Process Effectivity Process Effectivity

Co-products Co-products

Safety Stocks Safety Stocks

Substitutes Substitutes

Online Replan Start Online Planner, Stop Online Planner, 
Online Replan, Online Planner Status, Batch 
Replan, Launch New Plan, Copy Plan, Purge 
Plan

View Notifications Notifications

Launch Notifications Launch Notifications

Plan Options Plan Options

Release Select All for Release, Release

Collaborate Publish Order Forecast, Publish Supply 
Commits

Preferences Preferences

Undo Undo Summary, Add Bookmark

Plan Comparison Report Compare Plans

Supply/Demand Supply, Demand, Supply/Demand, On-hand

If you model the supplier as a supplier in the Planner Workbench, this information 
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appears in their Planner Workbench:

• Plans for which the supplier is modeled as a supplier

• Supplier name and supplier sites

• Categories and items associated with the supplier

• Supply and demand information specific to the supplier

Suppliers can use the Planner Workbench - Supplier User responsibility to view the 
following left-pane nodes and related right-pane tabbed regions in the Planner 
Workbench:

Nodes Tabs

Supplier Key Indicators, Actions

Category Key Indicators, Actions

Item Key Indicators, Horizontal Plan, Actions

The following table lists the right-click menu options available in Planner Workbench 
that your suppliers can use:

Function Name Menu Options

Items Items

Substitutes Substitutes

Resources Resources, Resource Requirements, Resource 
Availability

Supply Chain Bill Supply Chain Bill

Sourcing Sourcing

Destination Destination

Exceptions Actions, Exception Details, Related 
Exceptions, Save Actions
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Function Name Menu Options

Horizontal Plan Horizontal Plan

Vertical Plan Vertical Plan

Supply/Demand Supply, Demand, Supply/Demand, On-hand

Plan Comparison Report Compare Plans

Safety Stocks Safety Stocks

View Notifications Notifications

•

Colors Description

Dark Blue Required

Cyan Available

Magenta Overload

Pink Updated

Green Firmed

Pink with Green Border Updated/Firmed

Blue with Green Border Required/Firmed

Displaying Suppliers Modeled as Organizations
Oracle Advanced Supply Chain Planning provides you with the flexibility of modeling 
a supplier and its sites as an inventory organization. You can use this option if you want
to:

• Net through the supplier's supply chain bill in order to provide the supplier's 
supplier with advance visibility to their order forecast.



Planner Workbench    18-177

• Constrain your supply chain plan on the basis of a lower level material or resource 
constraint within the supplier.

In such cases, Oracle Advanced Supply Chain Planning plans the supplier's site like any
other internal inventory organization. When a planner views such an external 
organization in the Planner Workbench, it is distinguished as a supplier site as opposed 
to an internal organization through supplemental information.

Display of supplier site information provides you with advanced visibility to suppliers 
beyond your immediate suppliers by creating a multi-company supply chain plan. For 
example, if you source assemblies from a contract manufacturer with critical 
components being furnished by a tier 2 supplier, then you may want to create a 
multi-company plan. In such a plan, you can model your immediate suppliers as 
inventory organizations, and have the supply chain plan net through this organization 
in order to create demand for the tier 2 supplier. You can then publish the output of this
plan as forecasts for both your immediate and tier 2 suppliers.

You can create an external organization and associate it to the supplier site representing
the contract manufacturer in Oracle Inventory. Once the organization has been defined, 
you can create the reference setup information for planning purposes in this 
organization like items, bills of material, routings, resources, and operations.

For more details on setting up a supplier site as an inventory organization, see Oracle 
Inventory User's Guide.

To review plan information with suppliers modeled an organizations
1. Run a supply chain plan.

2. Navigate to Supply Chain Plan > Workbench to view plans by supplier 
organizations.

3. You can view the supplier icon and the supplier's company and site names in the 
Navigator window of Planner Workbench. The supplier sites that are modeled as 
organizations are graphically distinguished as external organizations in the 
Navigator window.

4. Highlight an organization, right-click, and select Supply/Demand.

5. The Supply/Demand window displays the Source Supplier and Source Supplier 
Sites in addition to the organization code for the modeled organization.
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19
Integrating with Planning and Manufacturing

Environments

This chapter covers the following topics:

• Overview of Integration with Planning and Manufacturing Environments

• Common Features in Hybrid Manufacturing Environments

• Oracle Project Manufacturing

• Oracle Flow Manufacturing

• Oracle Process Manufacturing

• Oracle Shop Floor Management

• Material Planning for Oracle Complex Maintenance Repair and Overhaul

• Integrating with Oracle Demantra Demand Management

• Integrating with Oracle Demantra Sales and Operations Planning

• Asset Intensive Planning

Overview of Integration with Planning and Manufacturing Environments
Oracle Advanced Supply Chain Planning integrates with:

• Mixed-mode manufacturing environments

• Other planning and manufacturing environments

Mixed-Mode Manufacturing Environments

Mixed-mode manufacturing lets you plan distribution and manufacturing operations 
for hybrid environments. You can plan for the full range of discrete, repetitive, process, 
project, and flow manufacturing environments. You can also plan to make to stock, 
make to order, assemble to order, and configure to order products simultaneously, 
using a single plan across all methods. This features enables you to use the most 
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efficient process to build each product.

Mixed-mode manufacturing is supported by the following combination of Oracle 
Applications: Oracle BOM (for discrete manufacturing), Oracle Flow Manufacturing, 
Oracle Project Manufacturing, and Oracle Process Manufacturing. These serve 
primarily to provide process plan (routing) data to the Oracle ASCP engine. They also 
provide the user interfaces with which users of the different manufacturing modes view
the output of the planning process.

Note: Repetitive manufacturing environments are supported in 
unconstrained planning, but not in constrained or optimized planning. 
For repetitive manufacturing environments that require constrained or 
optimized planning, it is recommended that you use flow schedules in 
Oracle Flow Manufacturing.

The planning engine adjusts the lot based job supply quantities displayed in the Planner
Workbench by the Reverse Cumulative Yield (RCY) figures. Since the job quantity in 
the execution system represents the quantity of the current operation of the job, the final
supply quantity in the planner workbench that represents the quantity coming out of 
the last operation of the routing is different. 

Other Planning and Manufacturing Environments

Other planning and manufacturing environments that integrate with Oracle Advanced 
Supply Chain Planning are::

• Oracle Complex Maintenance and Overhaul, see Material Planning for Oracle 
Complex Maintenance and Overhaul

• Oracle Strategic Network Optimization, see Integrating Strategic Network 
Optimization

• Oracle Production Scheduling, see Integrating Production Scheduling

• Oracle Demantra Demand Management, see Integrating with Oracle Demantra 
Demand Management

• Oracle Demantra Sales and Operations Planning, see Integrating with Oracle 
Demantra Sales and Operations Planning

Common Features in Hybrid Manufacturing Environments
Oracle ASCP includes full support for by-products, co-products, lot expirations, and 
formula effectivity dates. In some plan types, repetitive manufacturing features are 
supported. 
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Phantom Routings
Phantoms are non-stocked assemblies that let you group together material needed to 
produce a subassembly. Oracle ASCP explodes requirements through a phantom 
subassembly to the components as if the components were directly tied to the parent 
assembly. No planned orders are generated for phantom assemblies. Routings for 
phantom items are used to generate resource requirements. However, the planning 
engine does not support phantom routings for constrained plans.

Phantom Routings are included for all phantom items in an organization based on the 
settings of the Organization level parameter use phantom routings in Oracle Bills of 
Material. An additional parameter inherit phantom operation sequence set at the 
inventory organization level in Oracle Bills of Material determines whether components
of phantom items will retain their operation sequence or inherit them from the parent

.

Note: The combination of use phantom routings = Y and inherit 
phantom operation sequence = N is not supported. 

The following figure and table summarize the different behavior of a phantom item and
its components associated with settings of the two parameters, according to the 
example that follows.
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Bill of Material Structure for Assembly A

Use Phantom Routing Inherit Phantom Op Seq Behavior

Yes Yes Not supported

Yes No Not supported
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Use Phantom Routing Inherit Phantom Op Seq Behavior

No Yes Resource requirements 
generated for R1 and R2, but 
not R3 and R4. Due dates of 
Items E and F are calculated 
based on offset percentage of 
Op Seq 10.

No No Resource requirements 
generated for R1 and R2, but 
not R3 and R4. Due dates of 
Items E and F are calculated 
based on offset percentages of
Op Seq 30 and 40, 
respectively.

For more details, seeDefining Bills of Material Parameters, Oracle Bills of Material User's 
Guide and Phantoms, Oracle Bills of Material User's Guide.

Oracle Shopfloor Manufacturing (OSFM) does not use the phantom routing's operation 
sequence for the exploded phantom component requirements. The planning engine 
uses value No for organization parameter Inherit phantom op seq when it creates 
planned orders for Oracle Shopfloor Manufacturing (OSFM) lot based jobs.

Utilization Efficiency
Utilization and efficiency occur in capacity planning. Routings are used to generate 
capacity requirements for planned orders and suggested repetitive schedules by the 
planning engine. You can define utilization and efficiency on a department resource 
within Bills of Materials. For Flow Routings, the utilization and efficiency of individual 
resources used on a line in the Mixed Model Map definition are considered for 
determining the line rate. For repetitive schedules, it is assumed that the efficiency and 
utilization are factored into the user definition of line rate.

Utilization is a percentage. The range of values for utilization is 0.0 to 1.0. 

The range of values for efficiency is zero to infinity. The adjusted resource hours for 
each resource requirement planned on a department resource takes into account the 
utilization and efficiency of the resource. The adjusted resource hours of the resource 
requirement is calculated as follows:

Adjusted resource hours = resource required hours * utilization * efficiency.

(You can view utilization and efficiency in the Resources window in the Planner 
Workbench).

For more details, see Assigning Resources to a Department, Oracle Bills of Material User's
Guide
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Routing Effectivity
Routing Effectivity is incorporated into Capacity Planning with Oracle Planning 
Products.

Routings are used to generate capacity requirements for Planned Orders and Suggested 
Repetitive schedules by the planning engine. With the new functionality, resource 
requirements are generated using routings which are effective on the start date of the 
planned order or suggested repetitive schedule.

Each routing has an effective date and a disable date which indicates the date range for 
which the routing is effective. This is defined in Oracle Bills of Material. Routings are 
used to list the different resources which are required at each operation for an item.

For more details, see Creating a Routing, Oracle Bills of Material User's Guide

Simultaneous, Aggregate, and Alternate Resources
This flexfield can be used to enter data for planning and scheduling: Cost of using 
Alternate BOM / Routing, which is defined via a flexfield in the Bills of Material form.

The following cases can be used as a reference during implementation.

Example 1
An operation has three activities. The resource in each activity is individually replaced 
by an alternate resource.

Primar
y 
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rce 
Seq
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y 
Sched
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y 
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y 
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y 
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Group 
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ates 
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tute 
Group 
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Altern
ates 
Sched
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Altern
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Group

Altern
ates 
Resou
rce

Altern
ates 
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10 10 M1 Y 1 1 10 1 M1-1 Y

30 20 M2 Y 2 2 20 1 M2-1 Y

50 30 M3 Y 3 3 30 1 M3-1 Y

Example 2
An operation has three activities. The resource in each activity is replaced by more than 
one alternate resources.
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Primar
y 
Resou
rce 
Seq

Primar
y 
Sched
ule 
Seq

Primar
y 
Resou
rce

Primar
y 
Princi
pal

Primar
y 
Substi
tute 
Group 
Numb
er

Altern
ates 
Substi
tute 
Group 
Numb
er

Altern
ates 
Sched
ule 
Seq

Altern
ates 
Replac
ement 
Group

Altern
ates 
Resou
rce

Altern
ates 
Princi
pal

10 10 M1 Y 1 1 10 1 M1-1 Y

30 20 M2 Y 2 1 10 2 M1-2 Y

50 30 M3 Y 3 2 20 1 M2-1 Y

2 20 2 M2-2 Y

3 30 1 M3-1 Y

Example 3
An operation has three activities. Each activity has a principal and a simultaneous 
resource. Each pair of principal and simultaneous resource is replaced by an alternate 
pair of principal and simultaneous resource.
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10 10 M1 Y 1 1 10 1 M1-1 Y

20 10 L1 1 1 10 1 L1-1

30 20 M2 Y 2 2 20 1 M2-1 Y

40 20 L2 2 2 20 1 L2-1

50 30 M3 Y 3 3 30 1 M3-1 Y

60 30 L3 3 3 30 1 L3-1

Example 4
An operation has three activities. Each activity has a principal and a simultaneous 
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resource. Each pair of principal and simultaneous resource is replaced by alternate sets 
of resources. Some of these alternate sets have more resources than the primary sets 
they are replacing. Other alternate sets have fewer resources than the primary sets they 
are replacing.
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10 10 M1 Y 1 1 10 1 M1-1 Y

20 10 L1 1 1 10 1 L1-1

30 20 M2 Y 2 1 10 1 L1-2

40 20 L2 2 2 20 1 M2-1 Y

50 30 M3 Y 3 2 20 1 L2-1

60 30 L3 3 3 30 1 M3-1 Y

Example 5
An operation has three activities. Each activity has a principal and a simultaneous 
resource. When alternate resources are chosen for the first activity, alternate resources 
should also be chosen for the second and third activities. This synchronous selection of 
alternate resources is enabled by specifying the same substitute group number across all
three activities.
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30 20 M2 Y 1 1 20 1 M2-1 Y
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40 20 L2 1 1 20 1 L2-1

50 30 M3 Y 1 1 30 1 M3-1 Y

60 30 L3 1 1 30 1 L3-1

Example 6
This example illustrates examples of data setups that are inconsistent.

Primar
y 
Resou
rce 
Seq

Primar
y 
Sched
ule 
Seq

Primar
y 
Resou
rce

Primar
y 
Princi
pal

Primar
y 
Substi
tute 
Group 
Numb
er

Altern
ates 
Substi
tute 
Group 
Numb
er

Altern
ates 
Sched
ule 
Seq

Altern
ates 
Replac
ement 
Group

Altern
ates 
Resou
rce

Altern
ates 
Princi
pal

10 10 M1 Y 1 1 10 1 M1-1 Y

20 10 L1 1 1 20** 1 L1-1

30 20 M2 Y 2 2 20 1 M2-1 Y

40 20 L2 2 2 20 1 L2-1

50 30 M3 Y 3 3 30 1 M3-1 Y

60 30 L3 4* 3 30 1 L3-1

* Substitute group number cannot be different for two records that have the same 
schedule sequence numbers.

** A schedule sequence number within a replacement group under a given substitute 
group number cannot be different from one of the schedule sequence numbers of the 
primaries defined under that same schedule.
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Co-products
In some production environments, an item may turn into one or more parent items 
depending on factors such as process control, test results, and raw material quality. The 
parent items are called co-products.

Both Oracle Shop Floor Manufacturing (OSFM) and Oracle Process Manufacturing use 
co-products

Identifying Co-products

You identify co-products as a bill of material structure. In this diagram, assembles A, B, 
and C are co-products produced from raw material X. The percentage figures represent 
the expected mix of production of the co-products.
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Co-products

Co-products and Order Promising

Order promising considers co-product supplies for order promising as long as the 
demand is later than the co-product supply date. Using this product structure:

• On day 25, you have scheduled receipts for 10 item A, 6 item B, and 4 item C

• On day 10, you take a sales order against item B that is due on day 35. Order 
promising considers the scheduled receipt for quantity 6 as available to satisfy the 
sales order.

• On day 10, you take a sales order against item C that is due on day 20. Order 
promising does not consider the scheduled receipt for quantity 4 on day 25 as 
available to satisfy the sales order.

• On day 10, you take a sales order against item A for quantity 15 due on day 25. 



19-12    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Order promising considers the scheduled receipt for quantity 10 as available to 
satisfy the sales order; however, there is a shortage of quantity 5

• Capable-to-promise calculates that you need 10 item X to result in 5 item A 
(production of quantity 1 of item X results in production of quantity 0.5 of item A, 5 
/ 0.5 = 10)

• If there is enough item X available to result in 5 item A by day 25, order promising 
creates supply against item A for quantity 5 due on day 25, supply against item B 
for quantity 3 due on day 25, and supply against item C for quantity 2 due on day 
25.

Co-products and the Planning Process

The collection process collects co-product information.

The planning engine calculates supply for the co-product assemblies and demand and 
supply for the components based on the demand for any one of the co-product 
assemblies. It uses any component-level yield factors that you have specified when 
calculating component demand. 

It plans co-products on a daily basis and nets co-product supplies before creating 
planned orders to minimize inventory.

In Planner Workbench, you can:

• Identify co-products in the Navigator by a unique icon that differentiates them from
components

• Release planned orders for the assembly for which you realized demand

• Track the production for all the co-products by viewing supplies against the other 
co-products

To view a co-product relationship, navigate to the Items window, then press the 
Co-products button to view the related co-products and their planned percentages.

In the example, if you intend to produce 10 units of assembly A, the planning engine 
calculates demand for X as 20 units of X (10 units / 0.5 co-product percentage). The 
supply of 20 X plans for production of 10 units of supply for A, 6 units of supply (20 * 
0.3) for assembly B, and 4 units of supply (20* 0.2) for assembly C. 

The supply orders for the co-product assemblies are of types Planned order and 
Planned order co-product / by-product.

This table shows the supply/demand picture as a result of the demand against assembly
A for 10 units on Day 25
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Demand or Supply Day 10 Day 25 Day 35

Demand (A) 0 10 0

Supply (A) 0 10 (Planned order) 0

Demand (B) 0 0 0

Supply (B) 0 6 (Planned order 
co-product/by-produc
t)

0

Demand (C) 0 0 0

Supply (C) 0 4 (Planned order 
co-product/by-produc
t)

0

This table shows the supply/demand picture after you get demand against assembly B 
for 2 units on Day 35.

Demand or Supply Day 10 Day 25 Day 35

Demand (A) 0 10 0

Supply (A) 0 10 0

Demand (B) 0 0 2

Supply (B) 0 6 0

Demand (C) 0 0 0

Supply (C) 0 4 0

This table shows the supply/demand picture after you get demand against assembly C 
for 10 units on day 10. The planning engine does not move Planned order co-product / 
by-product supply either in or out to support other demands; it sets their due date on 
the same day as the planned order due date.
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Demand or Supply Day 10 Day 25 Day 35

Demand (A) 0 10 0

Supply (A) 25 0 0

Demand (B) 0 0 2

Supply (B) 15 6 0

Demand (C) 10 0 0

Supply (C) 10 4 0

If you release the planned order for assembly A, Planner Workbench creates a supply 
for quantity 20 to account for the production of assemblies A, B, and C from the 
material requirements of X for 20. The actual supply open for assembly A within the 
planning engine is 10.

The next time you run the plan, the planning engine uses supply of 10 units for 
assembly A and co-product / by-product supply for assembly B of 6 units and assembly 
C for 4 units. If you do not want to maintain the co-product / by-product supplies, clear 
the Co-products supply flag on the supply and the planning engine does not create 
co-product / by-product supplies.

Co-products and Safety Stock

You may have an operation that produces both a supply and a co-product supply. If the
planning engine pegs the supply to a safety stock, it marks the related co-product 
supply as low priority. This:

• Causes the pegging process to peg the co-product supply to low priority demands 
for the co-product

• Eliminates conflicting scheduling objectives on the operation

See Safety Stock, page 6-133.

Oracle Project Manufacturing
Oracle Project Manufacturing is designed to support companies that manufacture 
products for projects or contracts. It provides robust project tracking, billing, and 
budgeting. You can plan in a project or contract environment by segmenting all sources 
of supply and demand by project. This allows the planning process to identify 
components as shared or project specific, track existing inventories by project, and 
provide visibility to all supply and demand associated with the project. 
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Oracle Project Manufacturing also supports Seiban production. Seiban is a Japanese 
management practice. The word sei means production, and the word ban means 
number, thus implying a production number. A manufacturing plan is therefore 
managed by a Seiban number. All demand and supply for the manufacturing plan is 
associated with the Seiban number (via its project number). 

Oracle Project Manufacturing is also designed for engineer-to-order (ETO) environment
and a assemble-to-order environment. This enables a manufacturer to track supply and 
demand with a particular product, project, or customer. 

Oracle ASCP supports Oracle Project Manufacturing through Project Planning. With 
Project Planning you can:

• Include project or project-task or Seiban numbers in forecast, MPS, and MDS 
entries. 

• Load, copy or merge forecast, MPS, and MDS entries with project or project-task or 
Seiban numbers.

• Recognize and allocate supply according to project or project-task or Seiban 
numbers.

• Combine project or project-task and Seiban related supply and demand with 
common supply and demand in the same plan or schedule.

• Perform netting by planning groups, project or Seiban, and tasks

• Generate planned orders with project or Seiban, and task references

• Execute a plan in the Planner Workbench by planning group, project or project-task,
and Seiban.

• Perform net change simulation in a project environment.

• Generate planned orders with project or project-task or Seiban.

• Implement planning suggestions by planning group, project or project-tasks, or 
Seiban numbers.

Oracle Project Manufacturing is integrated with Oracle ASCP. Oracle ASCP supports 
constraint-based supply chain planning and optimization with online simulations for 
Engineer-to-Order (ETO) manufacturing typical in the Aerospace and Defense Industry.
It features the following:

Hard and Soft Pegging
The hard and soft pegging feature is fully supported by Oracle ASCP. An item's 
attribute can be set to any of the following pegging levels which are elaborated below:
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Soft Pegging
The planning process allocates supply at the project or project-task level (or Seiban) to 
demand at the project or project-task level (or Seiban) according to the reservation level 
set in the plan level options.

All reservations of supply to demand records is for a single item. Common, nonproject 
supply is used to satisfy project demand. For a soft pegged demand, excess project 
supply (or common supply) is always available for another project's demand.

No project references are made to planned orders issued to soft pegged items. 

(Choose the End Assembly/Soft Pegging option for both soft pegging and end assembly
pegging. End assembly pegging traces the end assembly to which the item is pegged at 
the top of the bill of material.)

Hard Pegging
In this option, the planning process allocates supply at the project or project task level 
(or Seiban) to demand at the project or project task level (or Seiban), according to the 
reservation level set in the plan level options. Excess common supply from one project 
can only be shared among projects in the same planning group, if reservation level is set
at planning group. 

Project references are attached to planned orders for hard pegged items.

(Choose the End Assembly/Hard Pegging option for both hard pegging and end 
assembly pegging).

Common Supply Netting
The new netting logic for Project Planning also takes into account excess common 
supply for project demand for hard pegged items. This netting logic is available only if 
the reservation level option for the plan is set to Planning Group. 

For the above, you can generate a graphical pegging display. If none is used for 
pegging, project material allocation, end assembly pegging, and graphics are disabled.

Supply Chain Project Planning with Hard Pegging
In situations where projects are executed across multiple organizations, Oracle ASCP 
provides you with the same useful features for managing demand and supply across 
multiple organizations in the supply chain.

It uses similar logic as Project Manufacturing planning to plan projects in multiple 
organizations and ensures that the project information is permeated to all organizations 
in the Supply Chain. Supply for a project belonging to multiple organizations can be 
netted against the demand for the same project in a single planning run.

Project Supply Chain Planning provides you with a visibility across the entire supply 
chain. You can use the same features to obtain project specific information from the 
Planner Workbench.
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Note: The project control level for all project manufacturing 
organizations must be the same for all organizations in the supply 
chain project planning scenario. 

Group Netting
The netting logic can include a group of projects. Excess supply in one project can be 
reserved against demand for another project belonging to the same planning group. For
this, set the reservation level to planning group. If reservation level is set to project then 
it is not group netting.

Borrow Payback
Two order types have been created in Project Planning to distinguish demand and 
supply resulting from a borrow/payback transaction in Project Manufacturing:

• Payback Demand

• Payback Supply

You can search for borrow/payback demand/supply using these order types. You can 
also see these order types on the Planner Workbench.

Planner Workbench
You can view payback demand created in the borrowing project and payback supply 
created in the lending project for an Item in the horizontal material plan and the 
Supply/Demand window in the Planner Workbench.

A scheduled payback transaction is considered as a new type of supply called payback 
supply for the lending project and a new type of demand called payback demand for 
the borrowing project. The scheduled payback date is used as the supply and demand 
date.

In the Preferences window, you can choose to display the payback demand and 
payback supply for the horizontal material plan.

The supply/demand picture can be viewed. No changes are allowed here, for example 
rescheduling or changing the quantity.

In the enterprise view, the payback supply is in a separate column. Payback demand is 
included in the other independent demand column. Payback supply is included in total 
supply. Payback demand is included in gross requirements. In addition, payback 
supply is included in current schedule receipts.

Pegging
You can view the borrow and payback relationships in the pegging window.

Please see the Oracle Project Manufacturing Implementation Manual for more information 
on Borrow/Payback in Project MRP.
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Default Project for Supplies Pegged to Excess
Oracle Advanced Supply Chain Planning allows you to manage planned supplies 
pegged to excess inventory when re-planning in a project manufacturing environment. 
You can specify a valid project as a default project for all supplies pegged to excess by 
using the MSC: Default Project for Supplies Pegged to Excess profile option.

Note: Oracle Advanced Supply Chain Planning assigns the default 
project for supplies pegged to excess only to hard pegged items.

To setup a default project
1. Define a project that is valid for all organizations that will be listed in the plan 

options. It will be used for assigning supplies that are pegged to excess. An existing 
project can also be used.

See the Oracle Projects Users Guide for more information on defining projects.

2. Set the value of the profile option MSC : Default Project for Supplies Pegged to 
Excess to the project code defined in step 1.

This profile can be setup at the Site, Application, Responsibility, or User Level

3. To setup at the User Level for the user that launches the plan, navigate to Edit > 
Preferences > Profiles

The Personal Profile Values form appears.

4. Specify a default project code for the profile option MSC: Default Project for 
Supplies Pegged to Excess.

Example
Consider an assembly item A with sub assembly item B, which uses component item C. 

The quantity per assembly for components B and C is 1.

An order quantity of 1 is placed for item A against project P1.

The planning system generates a planned order demand of 1 for item B. The order 
multiplier for item B has been set to 4. This results in a planned order of 4 for item B.

The planning system generates a planned order demand of 4 as well as a planned order 
of 4 for item C. The system splits the planned order based on the project codes:

1 - Planned order quantity of 1 pegged to project P1.

2 - Planned order quantity of 3 pegged to excess (no project code).

If the planned order for excess is released without a project code it will be rejected in 
purchasing (release fails, no purchase order will be created). 
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Scenario 1:
Project with demand = P1

Default project code = P2

Scenario 1

The planned orders are split into two parts:

• The planned order quantity of 1 is pegged to the project with demand, which is P1.

• The planned order quantity of 3 is pegged to excess with the default project code, 
which is P2.

Explanation:

• The total supply order is 4 based on the order modifier. The supply is split into two 
planned orders because of the fact that some part of the supply is pegged to the 
project demand and some part of the supply is pegged to excess. 

• In case of soft pegging, a planned order is not referenced to a project.

Scenario 2: 
Project with demand = P1

Default Project = P1
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Scenario 2

The planned orders are not split because the default project is the same as the project 
with demand.

Model/Unit Effectivity (Serial Effectivity)
Oracle ASCP supports Model/Unit Effectivity.

Items
Items can be set for effectivity control method. The full pegging attribute for the item 
must not be set to no pegging if the item is under model effectivity control. It must be 
set to soft pegging or hard pegging. 

Define MDS/MPS Entries by Unit Numbers
You can enter schedule entries by Model Unit Number. The unit number that you enter 
is validated against the master list of unit numbers that are eligible for that end item. If 
the item on the entry is a orderable subassembly, used in the bills of other end items, 
the entry can be associated with the unit numbers of its end item.

Unit Numbers in Sales Orders
You can load sales orders into a MDS, and have the unit number specified against the 
sales order.

Effectivity in the BOM
You can snapshot bills for items under unit effectivity in addition to those under date 
effectivity. The Engineering Changes Information snapshot as a part of the BOM can 
have the component effectivity specific to an end item unit number or a range of item 
unit numbers.

The snapshot tasks include end item unit number for different supply and demand 
entities used in the planner.

Generating Planned Orders
You can net all supply for a End Item Unit number to the demand for the end item. 
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Oracle ASCP generates planned orders with Unit Number specified on them. Demand 
for components can be created with model/unit number effectivity in addition to 
components with date effectivity. Oracle ASCP does not generate suggested repetitive 
schedules with Unit Number specified on them.

Planner Workbench
You can view the unit numbers of all items under unit number effectivity in the 
demand, supply, items, end assemblies. In the Find window you can specify the unit 
numbers while viewing items, supply/demand or exceptions. You can enter unit 
number information for new planned orders and MDS entries in the Planner 
Workbench. However, you cannot modify existing unit numbers tied to planned 
orders/MDS records from the Planner Workbench.

Pegging
You can view the unit number information in the pegging views.

WIP Mass Load / PO Requisitions Interface
When you implement Planned Orders in the Planner Workbench, you can pass on the 
unit number information to WIP and PO.

Flow Line Scheduling
You can view the unit numbers of all unscheduled orders under unit number effectivity
in the Line Scheduling Workbench Unscheduled Orders window (Oracle Flow 
Manufacturing Workbench). When you create new schedules based on an unscheduled 
order unit number effectivity, the resulting flow schedule contains the unit number 
reference. 

You can create new flow schedules under unit number effectivity and view the 
numbers for existing schedules in the Line Scheduling Workbench Detail window. You 
can create and update flow schedules under unit number effectivity using the API.

Project Specific Safety Stock
The planning engine plans safety stock within:

• Projects

• Planning groups

Use this feature if your business has supplies and demands segregated by ownership of 
inventory and if you operate in a projects/seiban or contracts environment.

The planning engine uses item attribute Reservation Level to determine netting and 
pegging behavior. If Reservation Level is:

• Project/Task: The planning engine follows non-project netting and pegging logic. 
See Safety Stock, page 6-133.
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• Higher than Project/Task: The planning engine meets safety stock levels of the 
combined requirements at that Reservation Level. For example, if Reservation Level
is Project, the planning engine sums the safety stock requirements from all of the 
tasks in each project and meets that safety stock level for the project.

You can see safety stock information with project/task references in the:

• Planner Workbench, Horizontal Plan window, Projects view; see Horizontal Plan, 
page 18-52: The safety stock numbers that display are for all of the projects in a 
period. For example, day 5 includes safety stock of 10 units for project P1 and 15 
units for project P2; the safety stock row in the horizontal plan shows 25 units for 
the item. 

• Pegging information; see Pegging Overview, page 18-83: For supplies, the pegging 
Properties window shows the project and task reference of the safety stock demand.

• Planner Workbench and Collections Workbench, Safety Stock window; see Safety 
Stock Window, page 18-127.

Non-MRP planned Safety Stock
When you specify safety stock levels by project in Oracle Inventory, specify the project 
along with the effective date and stock level. If the project control level is project-task, 
specify any task in the project; the planning engine does not plan safety stock by task 
number.

If a large portion of your safety stock demands relate to one project, specify the project 
as the value for the profile option MSC: Safety stock project. The project value defaults 
in each safety stock level entry but you can override it.

You should generally specify safety stock levels on workdays. If you specify a safety 
stock level on a non-workday, the planning engine compares the safety stock level on 
the non-workday and the previous workday and sets the safety stock level of the 
previous workday to the greater of the levels. For example:

• You specify safety stock level on a workday as 10. You specify safety stock level on 
the next day, a non-workday as 11. The planning engine sets the workday safety 
stock level to 11 and the non-workday safety stock level to 0.

• You specify safety stock level on a workday as 13. You specify safety stock level on 
the next day, a non-workday as 10. The planning engine sets the workday safety 
stock level to 13 and the non-workday safety stock level to 0.

• You specify safety stock level on a workday as 0. You specify safety stock level on 
the next day, a non-workday as 12. The planning engine sets the workday safety 
stock level to 12 and the non-workday safety stock level to 0.

Examples
This table shows safety stock calculations for item A7 with projects P1 and P2. Plan 
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reservations is set to the project level and hard pegging level is set to the project level. 
Item pegging attribute is set to hard pegging.

The safety stock requirements are:

• Item: A7, Project/Seiban: P1, Quantity: 50, Effective date: <blank>

• Item: A7, Project/Seiban: P1, Quantity: 150, Effective date: 1 November 

The on-hand balances are:

• P1: 10

• P2: 5

Schedule 
Entity

20 October 30 October 1 November 1 December

Demand 50 (P1) 40 (P2) 20 (P1) 10 (P2)

Safety stock 
demand

50 (P1) - 150 (P2) -

Scheduled 
receipts

25 (P2) 5 (P1) - -

Planned orders 85 (P1) 10 (P2) 20 (P1)

150 (P2)

10 (P2)

Projected 
available 
balance

50 (P1) 50 (P1) 50 (P1)

150 (P2)

50 (P1)

150 (P2)

This table shows safety stock calculations for item A7 with projects P1 and P2. Plan 
reservations is set to the planning group level and hard pegging level is set to the 
project level. Item pegging attribute is set to hard pegging. If you have supplies within a
bucket for projects belonging to same planning group, the allocation of supply to 
demand is completely random across projects.

The safety stock requirements are:

• Item: A7, Project/Seiban: P1, Quantity: 50, Effective date: <blank>

• Item: A7, Project/Seiban: P1, Quantity: 150, Effective date: 1 November 

The on-hand balances are:
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• P1: 10

• P2: 5

Schedule 
Entity

20 October 30 October 1 November 1 December

Demand 50 (P1) 40 (P2) 20 (P1) 10 (P2)

Safety stock 
demand

50 (P1) - 150 (P2) -

Scheduled 
receipts

25 (P2) 5 (P1) - -

Planned orders 55 (P1) 40 (P2) 20 (P1)

150 (P2)

10 (P2)

Projected 
available 
balance

50 (P1) 50 (P1) 50 (P1)

150 (P2)

50 (P1)

150 (P2)

This table shows safety stock calculations for item A7 with projects P1 and P2. Plan 
reservations is set to the project-task level and hard pegging level is set to the project 
level. Item pegging attribute is set to hard pegging. 

The safety stock requirements are:

• Item: A7, Project/Seiban: P1, Quantity: 50, Effective date: <blank>

• Item: A7, Project/Seiban: P1, Quantity: 150, Effective date: 1 November 

The on-hand balances are:

• P1, T1: 10

• P2, T2: 5

Schedule 
Entity

20 October 30 October 1 November 1 December

Demand 50 (P1,T2) 40 (P2,T1) 20 (P1,T2) 10 (P2, T1)
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Schedule 
Entity

20 October 30 October 1 November 1 December

Safety stock 
demand

50 (P1,T1) - 150 (P2,T2) -

Scheduled 
receipts

25 (P2,T1) 5 (P1,T1) - -

Planned orders 50 (P1,T2)

35 (P1,T1)

15 (P2,T1) 20 (P1,T2)

145 (P2,T2)

10 (P2,T1)

Projected 
available 
balance

50 (P1,T1) 50 (P1,T1) 50 (P1,T1)

150 (P2,T2)

50 (P1,T1)

150 (P2,T2)

This table shows safety stock calculations for item A7 with projects P1 and P2. Plan 
reservations is set to the project level and hard pegging level is set to the project level. 
Item pegging attribute is set to hard pegging.

The safety stock requirements are:

• Item: A7, Project/Seiban: P1, Quantity: 50, Effective date: <blank>

• Item: A7, Project/Seiban: P1, Quantity: 150, Effective date: 1 November 

The on-hand balances are:

• P1: 10

• P2: 5

Schedule 
Entity

20 October 30 October 1 November 1 December

Demand 50 (P1) 40 (P2) 20 (P1) 10 (P2)

Safety stock 
demand

50 (P1) - 150 (P2) -

Scheduled 
receipts

25 (P2) 5 (P1) - -
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Schedule 
Entity

20 October 30 October 1 November 1 December

Planned orders 85 10 170 10

Projected 
available 
balance

50 50 200 200

MRP planned Safety Stock
Specify the safety stock bucket days and the safety stock percent. The planning engine 
uses these parameters for the safety stock calculation for each project.

With planning group reservations, the planning engine uses the parameters for the 
safety stock calculation for the projects in each planning group. 

With both planning group reservation level and projects reservation level, the associates
each safety stock supply to the project and task of the last demand in the safety stock 
bucket days window. For example, safety stock bucket days is 3. When the planning 
engine is calculating safety stock for day 1, it includes the demands for days 1, 2, and 3 
in the calculation. Supply suggestions created to satisfy safety stock demand for day 1 
show the project and task identifiers of the last demand on day 3.

If you plan in either weekly or period buckets, specify a safety stock bucket days value 
that is long enough to reach to the end of week or period buckets since those demands 
are due at the end of the week or period.

Example
This table shows safety stock calculations for item A7 with projects P1 and P2. Plan 
reservations is set to the project level and hard pegging level is set to the project level. 
Item pegging attribute is set to hard pegging.

The safety stock parameters are:

• Safety stock bucket days: 4

• Safety stock percent: 10

The on-hand balances are:

• P1: 10

• P2: 5

The safety stock calculations for day 20 , project P1 is:

• Demands in the next four days (safety stock bucket days) for project P1: 70 (50 on 
day 20 + 20 on day 22)
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• Average daily safety stock demand: 18 (70 / 4 = 17.5) 

• Safety stock supply needed: 2 (18 * 0.1) = 1.8)

Schedule 
Entity

20 21 22 23 24 25

Demand 50 (P1) 40 (P2) 20 (P1) 10 (P2) 85 (P1)

10 (P2)

40 (P1)

100 (P2)

Scheduled 
receipts

25 (P2) 5 (P1) - - - -

Planned 
orders

37 (P1) 1 (P1)

12 (P2)

21 (P1) 11 (P2) 80 (P1)

10 (P2)

40 (P1)

100 (P2)

Projected 
available 
balance

2 (P1) 3 (P1)

2 (P2)

4 (P1)

2 (P2)

4 (P1)

3 (P2)

4 (P1)

3 (P2)

4 (P1)

3 (P2)

Workflow Based Project Exception Messages
Along with the other Exception Messages, Project Planning provides the following 
project related exception messages that can help monitor project material plans. Like 
other exception messages, these exception messages are also workflow enabled for 
better supply chain coordination. The Project Manager or Task Manager (if defined) are 
also be notified of these plan exceptions.

• Items with Excess inventory in a project-task: This exception message enlists all 
items with excess inventory in a project or project-task. This exception occurs when 
the projected on-hand quantity of the item in a project or project-task exceeds zero 
or safety stock by more than the value you entered in Excess Quantity in the 
exception set for the item.

• Items with Shortage in a project-task: This exception message highlights the items 
whose demand exceeds supply for that project or project-task. For items with a 
shortage in a project-task, an exception message is generated when the projected on 
hand quantity for an item in a project is negative or below the safety stock.

• Items allocated across project-task: This exception message indicates items where 
supply for one project or project-task is used to satisfy demand for another project 
or project-task.
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• Reschedule In

• Reschedule Out

• Cancellation

The planning engine always issues the reschedule and cancel exception messages but 
only issues the issues the excess, shortage, and cross-allocation exception messages 
when profile option MSC: Compute Project Exception is Yes.

Project Planning Implementation Steps
The steps to set up, run and view a plan in a project environment are as follows.

Oracle Project Manufacturing Setup
1. Define projects and tasks directly in Oracle Project Manufacturing, manually using 

Entry Project, or using the Project Manufacturing Seiban Number Wizard, or define 
Seiban numbers in Project Manufacturing using the Seiban Number Wizard. 

2. Define planning group Quick Code.

3. Associate a project/Seiban to a planning group (in the project parameters form)

Refer to the Oracle Project Manufacturing User's Guide for detailed setup instructions.

Oracle Inventory Setup
Define item pegging attributes. The following item pegging attributes can be used:

• Soft pegging, or End Assembly/Soft Pegging: In this case excess project or common 
supply is available to satisfy project demand of any project irrespective of plan 
options chosen. Planned orders do not carry project and task references.

• Hard Pegging, or End Assembly/Hard Pegging: In this case excess supply in one 
project can be used for demand of a different project in the same planning group if 
reservation is set to planning group. Excess common supply is also available for 
project demand only if the reservation level is planning group. Planned orders 
carry project and task references as defined by the hard pegging level plan option.

• None: Disables project material allocation. Also, planned orders do not carry any 
project or task reference irrespective of the hard pegging level plan option.

Refer to Oracle Inventory User's Guide for detailed setup instructions.

Oracle ASCP Setup
1. Define Plan Options. Either:
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• Go directly from the Navigator, Supply Chain Plan > Options

• Access the Plan Names form, select a plan, and click Plan Options.

2. Complete the following options in the Pegging window.

Option Description

Reservation Level This option determines the method of 
pre-allocation of project supply to project 
demand. You can choose to reserve based 
on:

• Planning Group

In this case the plan reserves 
project-specific supply at the planning 
group level. Excess supply in one 
project can be reserved against demand
for another project belonging to the 
same planning group. Excess common 
supply is also allocated to project 
demand.

• Project

In this case, project specific supply is 
used for demand specific to that project
only. This allows cross-allocation across
tasks within the same project.

• Task

This reserves supply for a project-task 
against demand for the same 
project-task only. No cross-allocation of
material belonging to the same project 
but different tasks is allowed.

• None

This is a nonproject plan.
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Option Description

Hard pegging level This option determines if the project or 
project-task references will be added to 
planned orders. This is applicable to hard 
pegged items only for which the pegging 
attribute must be hard pegging or End 
Assembly / Hard Pegging. For soft pegged 
items, no project references are associated. 
These work independent of the reservation 
level options.

3. Launch a plan.

Refer to Defining Plans, page 5-1 for more information on defining plan options and
launching plans.

The planning engine does not perform project planning in Constrained (Without 
Detailed Scheduling) planning mode.

When running targeted refresh for entity Trading partners, also collect entity 
Calendars. This ensures that the Oracle Project Manufacturing organizations are set 
up as organization type process so that the release process from Oracle Advanced 
Supply Chain Planning to Oracle Project Manufacturing succeeds.

Project Planning Logic
Refer to the Oracle Project Manufacturing Implementation Manual for Project planning 
logic. Netting Logic with examples of hard pegging with common supply netting and 
the pegging logic is explained here.

Note: Order modifiers are applied before project netting calculations. 

You cannot use end item substitution in project planning.

If you have demands without project references and you want their planned orders 
without project references, set all the items in their supply chains to use hard pegging.

Project Validation
Oracle Advanced Supply Chain Planning verifies project and task information with 
Oracle Project Manufacturing when it operates on planned orders and scheduled 
receipts during:

• Release

• Run online planner
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Verification Checks
When it finds project information in a planning entity, it verifies the following:

• Project manufacturing is enabled in the inventory organization.

• The project in the planning entity is enabled in the inventory organization and has 
its own effective date range.

• The project in the planning entity is chargeable.

• The transaction dates in the planning entity are within the project effective date 
range.

• Whether you control the inventory organization at the task level.

When it finds task information in a planning entity, it verifies that you control the 
inventory organization at the task level.

When you control the inventory organization at the task level, it verifies the following:

• The transaction has a task reference.

• The task in the planning entity is enabled in the inventory organization and has its 
own effective date range.

• The task in the planning entity is chargeable.

• The transaction dates in the planning entity are within the task effective date range.

Release Validation Situations
Oracle Advanced Supply Chain Planning performs the verification checks in the 
following cases during releases. It checks manual transactions in both Collections 
Workbench and Planner Workbench. If the project or project-task reference when you 
leave a transaction is the same as when you entered, there is no verification check:

• It encounters a project or project-task reference on a sales order.

• You change project or project-task reference on a master demand schedule entry in 
the source instance.

• It encounters a project reference for safety stock demand from profile option MSC: 
Safety Stock Project.

• You change project or project-task reference on a manual master demand schedule 
entry (Navigate to Supply/Demand window, change on Projects tabbed region).

• You change project or project-task reference on a supply, including the case where 
you firm the supply (Navigate to Supply/Demand window, change on Projects 
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tabbed region).

• You change project or project-task reference on a supply while releasing (Navigate 
to Supply/Demand window, Select Release, change on release Properties tabbed 
region).

• You use the select all for release (Navigate to Supply/Demand window, select Plan 
menu option, select Select All for Release)

• It encounters a project or project-task reference on a supply selected for 
auto-release.

Online Planner Validation Situations
Oracle Advanced Supply Chain Planning performs the verification checks in the 
following cases during online planner runs. It checks manual transactions in both 
Collections Workbench and Planner Workbench. If the project or project-task reference 
when you leave a transaction is the same as when you entered, there is no verification 
check:

• Project or project-task reference on a manual master demand schedule entry 
(Navigate to Supply/Demand window, change on Projects tabbed region).

• Project or project-task reference on a supply in either the Collection Workbench or 
in the Planner Workbench, including the case where you firm the supply (Navigate 
to Supply/Demand window, change on Projects tabbed region).

Oracle Advanced Supply Chain Planning does not perform the verification checks in 
the following cases during online planner runs. The release verification process 
performs them at that time:

• Project or project-task reference on a sales order.

• Change project or project-task reference on a master demand schedule entry in the 
source instance.

• Project reference for safety stock demand from the profile option MSC: Safety Stock 
Project.

Validation Errors
When the verification check process finds invalid conditions or data, it does the 
following:

• For many online operations on supplies and demands, the process displays an error
window and asks you to correct the data before it continues. This occurs for manual
master demand schedule entries, planned order and scheduled receipt entries in the
Supply/Demand window, and planned order and scheduled receipt entries in the 
Release Properties tabbed region.
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• For the select all for release and auto-release features, the process makes an entry in 
the Release Errors field. In select all for release, it does not select the row. In 
auto-release, it does not auto-release the supply.

If you receive errors, make sure that the following transaction items meet the criteria for
the verification checks:

• Org

• Project

• Task

• Implement Project

• Implement Task

• Suggested Due Date

• New Date

• Implement Date

Viewing the Plan
The plan can be viewed from the Planner Workbench. You can view planning 
information by project and implement manufacturing plans in the workbench by 
project. 

Use the Supply, Demand or Supply/Demand window of the Planner Workbench to 
view information about the plan's supply and demand. Planning Group, Project 
Number and/or Task Number may be used as the search criteria. 

You could also use customizable folders in the Supply, Demand or Supply/Demand 
screens to query planning information for a particular project or project-task.

The Horizontal Plan and Enterprise View windows enable you to view supply and 
demand information by Planning Group, Project, and Project-Task. You can also choose 
to see the planning status of all the material or only common material in these forms.

The Planner Workbench also generates Reschedule In, Reschedule Out and Cancel 
action messages for project supply. It follows the current Planning Time Fence and 
Acceptable Days Early logic to generate these messages.

Oracle Flow Manufacturing
Oracle Flow Manufacturing is a demand driven production system with balanced 
production lines and processes designed to produce a constantly changing mix of 
products at a steady rate. Flow manufacturing uses schedules for mixed model 
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production instead of work orders to drive production. The mixed model schedules are 
sequenced based on scheduling rules and material is replenished, or pulled through the 
sequence, using kanbans. 

This is in contrast to a traditional discrete environment where the Master Production 
Schedule and MRP are used to explode requirements and create planned orders that are
converted into purchase orders and work orders. There are some cases in which Oracle 
ASCP may be used effectively. For example - you have a seasonal business, and you use
Oracle ASCP to create planned orders during your slow period to build up inventory to
satisfy your peaks in demand. In these cases, planned orders may be converted into 
flow schedules.

When there is a hybrid of manufacturing methods, for example if a flow manufacturing 
system feeds to a discrete manufacturing plant, Oracle ASCP may be used effectively, 
because Oracle ASCP can consider a flow schedule as a supply. 

You can define operations and resources for flow routings. In:

• Unconstrained plans, the planning engine makes a resource requirement for the 
flow line and resource requirements for each resource in the routing.

• Constrained plans, the planning engine makes a resource requirement for the flow 
line but not for resource requirements

Supply Chain Synchronization
Oracle ASCP can improve supply-chain throughput and reduce inventories by 
improving synchronization of operations between facilities. In turn, Oracle Flow 
Manufacturing increases manufacturing plant throughput by dramatically decreasing 
manufacturing times and removing in-process and finished goods inventory.

Support for Flow Schedules 
If you specify line capacity, Oracle ASCP can constrain by that capacity to create plans. 
If demand is more than what can be manufactured, then Oracle ASCP creates a plan 
considering the constraints. These planned orders may be converted into flow 
schedules.

Note: You need to run the Push Plan Information concurrent program 
to see planned orders as valid inputs for flow schedules.

Oracle ASCP includes flow schedules to be considered as supplies.

The processes to define, implement, and maintain Oracle Flow Manufacturing are:

• Demand Management

• Line Design & Balancing
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• Line Scheduling & Sequencing

• Production Execution

• Product Families

• Release Flow Schedules

Planning plays an important part in the design phase of an Oracle Flow Manufacturing 
implementation.The derived demand of components is used to establish size 
requirements.

Generally the same forecast, MDS or MPS is used to design a mixed model production 
line and for Kanban planning. They are only used for planning purposes for line design 
and Kanban sizing. 

Oracle Advanced Supply Chain Planning uses the snapshot of inventory for on-hand 
quantity and safety stock.

External to the enterprise, the forecasts are communicated with suppliers so that they 
may, in turn, plan their operations. 

Demand Management
Oracle Flow Manufacturing forecast tools, Master Demand Schedules, and Master 
Production Schedules with Oracle ASCP are used for managing demand. Similar 
products are grouped into families to allow for planning at an aggregate level. The 
creation of forecasts, MDS/MPS are used for line design and Kanban planning. If you 
are not building directly to customer demand, Oracle Flow Manufacturing can create 
schedules from the planned orders generated by the above tools.

The following planning capabilities need to be set up: Forecasting & Master Demand 
Schedules. Oracle Flow Manufacturing uses the Demand Management tools provided 
in Oracle MPS/MRP or Oracle ASCP to plan production volumes.

Note: Demand Management, Oracle Flow Manufacturing Implementation 
Manual

Line Design and Balancing
Line Design includes grouping products into product families, defining the processes, 
and events required to produce each product, and re-grouping events into line 
operations to approximate TAKT time (German for target cycle time). The statement of 
demand established in Demand Management, whether it is from a forecast, MDS, or 
MPS, is critical to the line design function. The demand sets the upper limit of 
production capacity and becomes the basis for balancing procedures.

For more details, see:
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• Line Design and Balancing Procedures, Flow Manufacturing Line Balance, Oracle 
Fkow Manufacturing User's Guide

• Defining Flow Manufacturing Standard Processes, Oracle Flow Manufacturing User's 
Guide

• Defining Flow Manufacturing Standard Events, Oracle Flow Manufacturing User's 
Guide

• Defining Flow Manufacturing Standard Line Operations, Oracle Flow Manufacturing 
User's Guide

Product Families
Flow uses product families to plan at an aggregate level. Oracle ASCP supports product
family items. You can define different planning horizons for product families or item 
level. Resources can be planned at the product family level.

For more details, see Products and Parts Setup, Oracle Flow Manufacturing 
Implementation Guide and Assigning Product Family Members, Oraclel Bills of Material 
user's Guide.

Release Flow Schedules
The planning engine suggests flow schedules. You process them using sequence 
planning--an entirely different process than planned order release from Planner 
Workbench.

Sequence planning creates a flow that is timed to the minute and indicates which 
product follows which other product. You perform this in the Flow Manufacturing 
menu, Line Scheduling Workbench.

Theoretically correct flow manufacturers release sales orders rather than planned orders
because they make against sales demand rather then a forecast-driven plan. In Line 
Schedule Workbench, you can pool orders to be scheduled from either the sales orders 
or the planned orders allows you to select either sales orders or planned orders.

Line Scheduling Workbench does not recognize the difference between planned orders 
that satisfy sales orders, forecasts, or dependent demand. Watch out for double 
counting in this case. Line Scheduling Workbench does not recognize the difference 
between planned orders that satisfy sales orders, forecasts, or dependent demand. 
Watch out for double counting in this case.

You typically schedule and load lines for the next few days, depending on the total 
product cycle time. Use the planning process to plan and to provide supplier schedules 
for the long-term and you Line Schedule workbench to schedule and load lines in the 
short-term.

If you schedule using a pool of planned orders:
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• Use an MRP plan, not an MPS or an MPP plan

• Select Production

• After running the plan, push the planned orders to the transaction system

Oracle Process Manufacturing
The Oracle Process Manufacturing (OPM) user is fully integrated with Oracle ASCP 
and can plan based on plan objectives and use the materials and resources optimally. 
There is no need to execute OPM P/MRP.

Oracle ASCP provides an integrated plan for multiple modes of process manufacturing 
including batch, continuous, and packaging operations. It incorporates a formula-based,
process unique requirements including co-products, and scaling. 

The data used to plan materials and capacity exists in the OPM schema, and is used by 
the Oracle ASCP Planning Server. Oracle ASCP uses Production, Formula, Planning, 
and Sales data from OPM, as well as Inventory and Purchasing data from Oracle 
Applications. The user can run multiple plans and manage materials and resources. 
Once satisfied with the plan, it can be executed in the Production Module. 

License Capabilities
As of Oracle ASCP R12, ASCP unconstrained planning replaces OPM MRP. This table 
illustrates what you will received based on your upgrade path: 

Merged Organization Structure
The OPM structure merges with the Oracle Applications structure, as shown. 
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OPM and Oracle Applications Structures

OPM production batches and planning functions occur at the plant level. These are 
merged to production and planning data at the inventory organization level.

OPM demand is placed at the warehouse level and planning can occur at this level as 
well. These are merged to the inventory organization level.

OPM on-hand balances are stored at the warehouse or location level. Stock allocation 
and nettability takes place at the warehouse level. These are merged to the subinventory
level of Oracle Applications.

The above data and transactions can also occur at the location level in OPM. The 
corresponding level in Oracle Applications is the locator level, but Oracle ASCP plans at
the subinventory level. All OPM location data therefore must be merged into the 
warehouse and mapped at the subinventory level.

If you want to issue material to a batch from another inventory organization, use a 
transfer sourcing rule to move the material from the storing organization to the 
consuming organization.

Differences Between Production in OPM and Oracle Applications
In Oracle Applications, at the Inventory Organization level, site locations are used for 
vendors and customers, and departments are used to control resources. In OPM, the 
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resources are defined at the plant level. 

A work order (a WIP job, in Oracle Applications) is roughly equal to a production batch
in OPM. Both work orders and production batches consume resources. In Oracle 
Applications, a work order (created at the inventory organization level) can only draw 
from resources available in the inventory organization for which the work order was 
created. In OPM, a batch may only access resources for the plant. 

Plant warehouse effectivity in OPM allows a production batch to draw from materials 
available outside the plant (WIP Warehouse) in which the production batch was 
created. OPM also lets you specify the warehouses from which to pull inventory to 
complete a production batch. You can define multiple allocation parameters for an item.
This allows you to allocate inventory from multiple warehouses.

In Oracle ASCP, the ingredients for a batch must come from a single warehouse. OPM 
works around this issue by using the work-in-process warehouse or the resource 
warehouse, if available, as the single source of ingredient inventory when the batch has 
multiple sources or destinations. The work-in-process warehouse or the resource 
warehouse shows Oracle ASCP from where to allocate inventory.

Recommended OPM Organization Structure for Oracle ASCP
The following OPM organization structure is recommended in order for OPM data to 
smoothly merge with Oracle ASCP. Navigation paths are included:

• Each OPM production plant has only one associated warehouse called the Resource
Warehouse. Production is assumed to take place in that warehouse. (For more 
information, see Organizations Field Reference in Oracle Process Manufacturing 
System Administration User's Guide. The navigation path to the screen in the OPM 
application is OPM > System Administration > Organizations > Resource 
Warehouse Field.)

• There can be only one warehouse per plant. (For more information, see 
Organizations Field Reference in Oracle Process Manufacturing System Administration 
User's Guide. The navigation path to the screen in the OPM application is OPM > 
System Administration > Organizations > Resource Warehouse Field.)

• Multiple production plants can draw raw material inventory from common 
warehouses to meet their production demand. (For more information, see Setting 
Up Plant Warehouse Relationships in Oracle Process Manufacturing MPS/MRP and 
Forecasting User's Guide. The navigation path to the screen in the OPM application is
OPM > Planning > MPS > Setup > Plant Warehouse.)

• Multiple production plants can supply common warehouses (distribution center). 
(For more information, see Setting Up Plant Warehouse Relationships in Oracle 
Process Manufacturing MPS/MRP and Forecasting User's Guide. The navigation path 
to the screen in the OPM application is OPM > Planning > MPS > Setup > Plant 
Warehouse.)
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• Each OPM warehouse must have a corresponding inventory organization in Oracle 
Applications. (For more information, see Organizations Field Reference in Oracle 
Process Manufacturing System Administration User's Guide. The navigation path to the
screen in the OPM application is OPM > System Administration > Organizations > 
Resource Warehouse Field.)

• If multiple production plants use the same warehouse as their raw material 
inventory source, then the production for these plants should be planned together.

Merging Effectivities, Formulas, and Routings 
Oracle ASCP expects organization-specific formulas and routings.

Oracle ASCP includes the following OPM functionality:

• Effectivities

• Scaling

• One-level circular references

One-level circular references allow the definition of formulas that have a product or 
by-product listed as an ingredient in the same formula. For example, when making 
sourdough bread, you save a small portion of the dough to use as a starter for the next 
batch. Therefore, when defining a sourdough bread formula, the dough is a product, 
but it is also an ingredient. 

Creating a Resource Warehouse
In Oracle ASCP, capacity planning occurs at the inventory organization, department, or 
resource level. OPM needs to perform capacity planning at the plant level. To bridge 
this gap between OPM and Oracle ASCP, one warehouse is defined for each production
plant that requires capacity planning. These warehouses are called Resource 
Warehouses. Oracle ASCP recognizes Resource Warehouses as production facilities that
require capacity planning. 

To create a resource warehouse
Use the following navigation path in the OPM application:

1. OPM > Planning > MPS > Setup > Plant Warehouse. For more information, see 
Setting Up Plant Warehouse Relationships in Oracle Process Manufacturing 
MPS/MRP and Forecasting User's Guide.

2. OPM > System Administration > Organizations. For more information, see 
Organizations in Oracle Process Manufacturing System Administration User's Guide.
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Unit of Measure
You can define item units of measure in OPM that are four characters long, but the 
value will be truncated to three characters once the unit of measure is copied into 
Oracle Applications. You can automatically convert UOMs from OPM to Applications. 

This also applies for OPM organizations where OPM allows four characters and 
Applications allows three characters.

For additional information, seeEditing Units of Measure, Oracle Process Manufacturing 
System Administration User's Guide. The navigation path to the screen in the OPM 
application is OPM > System Administration > Units of Measure).

Setting Up and Using OPM Data
The OPM data that must be set up are:

• OPM organizations & warehouses

• OPM items, Unit of Measure, and conversions

• Effectivities, formulas and routings

• Resources

• MPS Schedules for Oracle ASCP

• Batches, FPOs, sales orders, forecasts, and on-hand inventory

For detailed instructions on setting up OPM data refer to the Oracle Process 
Manufacturing User's Guide. 

Besides the points stated in the previous section, some of the other areas which link to 
Oracle ASCP are described below.

OPM Organizations
If you plan to use the capacity planning function in Oracle ASCP, each OPM production
plant must own one resource warehouse.

Effectivity, Formulas, and Routings

Effectivity
OPM uses global effectivities by organization, as opposed to effectivities for a specific 
plant or resource warehouse. An organization's effectivities then apply to all plants and 
warehouses associated with that organization.

The following effectivity functions can be used with Oracle ASCP: min and max 
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quantities, start and end effective dates, formula and routing assignments, and 
preferences.

(For additional information, please refer to Editing Recipe Validity Rules in the Oracle 
Process Manufacturing New Product Development User's Guide. The navigation path 
to the screen in the OPM application is OPM > Development > Formula Management > 
Effectivities.)

Formulas
Oracle ASCP can accept one product per formula. If an OPM formula has multiple 
effectivities for a product or for co-products, a different formula is effectively viewed by
Oracle ASCP. Oracle ASCP expects one product per bill of material (in our case, a 
formula) and this causes the co-products and by-products to be reported as components
with negative quantities. Also, linear and fixed scaling is implementable.

(For additional information, please refer to Entering Formula Details in the Oracle 
Process Manufacturing New Product Development User's Guide. The navigation path 
to the screen in the OPM application is OPM > Development > Formula Management > 
Formulas.)

Routings
The routing/formula combination must be unique. The routing quantity uses the base 
UOM of the effectivities product. An OPM step is equivalent to an Operation. An OPM 
activity is equivalent to an Operation Resource Sequence. A routing resource is 
equivalent to an Operation Resource.

With OPM CRP, you have the option of using alternate resources. Resources are 
assigned a Plan Type indicating primary (1), auxiliary (2), or secondary (0) on the 
Operations form. In Oracle ASCP, only the primary and auxiliary resources are used. 
Secondary resources are ignored.

Oracle ASCP uses resource count and usage quantity information. You record resource 
count and usage quantity information in the Operations form. For example, if two 
identical blenders are used for mixing, enter 2 in the Count field. If the resource can mix
200 gallons per hour, enter 200 in the Process Quantity field and 1 in the Usage 
Quantity field.

Oracle ASCP enables you to use more than one resource at the same time during an 
operation, but you can not complete more than one operation in a routing at the same 
time. Oracle ASCP enables you to overlap an operation with another operation, but this 
restricts OPM's functionality of allowing concurrent operations and multiple dependent
operations. Concurrent operations are not allowed with Oracle ASCP. 

(For additional information, please refer to Understanding Routings in the Oracle 
Process Manufacturing New Product Development User's Guide. The navigation path 
to the screen in the OPM application is OPM > Development > Formula Management > 
Routings.)
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Complex Routings
In process manufacturing, production is often based on complex routings that consist of
simultaneous operations, multiple operations yielding multiple co-products, and 
multiple operations terminating with the production of main products. A complex 
routing has these characteristics:

• Multiple start operations

• Multiple end operations

• Parallel operations

• Different types of temporal dependencies between related operations.

• Ingredients consumed and products yielded by multiple operations.

Example: Complex Routing
An example of a complex routing is the tasks of baking a cake. The dry ingredients: 
flour and baking powder are sifted together. The moist ingredients: water, eggs, butter, 
and flavorings are mixed together. The output from both operations is added together 
gradually to make the batter. Both the dry and the moist operations should be 
performed during the same time frame, and then slowly added together. If the 
operation of sifting the dry ingredients waited until the completion of the moist 
operation, the dry ingredients might begin to cake together. And, if the moist operation 
waited for the completion of the dry to be sifted, the moist ingredients could begin to 
separate.

This diagram illustrates a complex routing with multiple starting operations, 
simultaneous operations, multiple ending operations, and multiple products:

When scheduling routing operations, the Oracle Advanced Supply Chain Planning 
scheduling process takes into account operation dependencies that are defined in Oracle
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Process Manufacturing. In forward scheduling phases, operations are scheduled based 
on their dependencies on preceding operations. In backward scheduling phases, 
operations are scheduled based on succeeding operations.

Operation dependency constraints are applied to the activities of upstream and 
downstream operations with two dependency types:

• Start-to-Start dependency type, which is applied to the first scheduled activity of 
the upstream operation and the first scheduled activity of the downstream 
operation.

• Finish-to-Start dependency type, which is applied to the last scheduled activity of 
the upstream operation and the first scheduled activity of the downstream 
operation.

Step dependencies are defined as:

• Finish-to-start with no offset, to indicate that a process step begins immediately 
after the completion of its preceding step. For example, a consecutive addition of 
ingredients is required without interruption.

• Finish-to-start with positive offset, to indicate that a process step begins at a 
specified period of time after the completion of its preceding step. For example, 
time is required to rest material before the addition of another ingredient.

• Finish-to-start with negative offset, to indicate that a process step begins at a 
specified period of time before the completion of its preceding step. For example, a 
production device needs to be activated before the addition of the next ingredient.

• Start-to-start with no offset, to indicate that a process step begins at the same time 
as the step it depends on. For example, there is a need for the simultaneous addition
of ingredients without interruption.

• start-to-start with positive offset, to indicate that a process step begins at a specified 
time after the start of its preceding step. This is similar to finish-to-start with 
negative offset, buy by specifying that the dependency is start-to-start, you can 
ensure the positive offset is maintained if the previous dependent step finishes 
early.

This diagram illustrates a finish-to-start dependency for operations 10 and 40 of the 
diagram above:
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Setting Up Complex Routings
The primary setup steps are:

1. Define complex routings, step dependencies, and time offsets.

2. Define inter-routing minimum time quantity (MTQ) and time offsets.

3. Define other data elements required for ASCP plans such as items, formulas, 
routings, recipes, validity rules, and sourcing rules.

To define complex routings
1. Select the Oracle Process Manufacturing responsibility.

2. Navigate to Process Engineer > Routings.

3. In the Process Routings Details window, select a routing step and click Step 
Dependencies.

4. In the Routing Step Dependencies window, specify these fields:

• Dependency Type: Finish-to-Start or Start-to-Start.

• Standard Delay. This value represents the minimum time offset between 
operations.

• Max Delay. this value represents the maximum time offset between operations.

• Transfer Percent. This value represents the percentage of material that flows 
from an upstream to each of its downstream operations.

• Apply Per Charge. Select this option to indicate that the operation step 
dependency and time offsets apply to charges in the operations.

To define inter-routing minimum transfer quantity and time offsets
1. Select the Oracle Process Manufacturing responsibility.
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2. Navigate to Process Engineer > Recipes.

3. From the Recipe Details window, select the Step/Material Association button.

4. On the Step/Material Association window, enter a value in the Minimum Transfer 
Quantity, Minimum Delay, and Maximum Delay fields.

• The minimum transfer quantity (MTQ) represents the operation at the 
downstream routing that consumes product A and produces product X. It can 
start after the production of MTQ of product A and the appropriate application 
of minimum and maximum time offsets.

• The Minimum and Maximum Delay fields represent the minimum and 
maximum time offsets between routings.

Processing Complex Routings
To process complex routings:

1. Run the ASCP plan.

2. Analyze the ASCP output.

• Verify that the start and end times of each operation within the complex routing
is as per the prescribed step dependencies.

• Verify the timing of inflows and outflows of material from the routing.

You can verify this information by using the Network Routing window or the 
Co-products window in the planner workbench.

3. Release planned orders to OPM.

4. Run OPM Batch.

ASCP released planned orders are converted to OPM batches:

• Automatically by setting the GMP: Auto Implement APS Suggestions profile option
to Yes in the Personal Profile Values window.

• Manually through the ASCP New Batch window.

To view step dependencies and time offsets
1. Select the Advanced Supply Chain Planner responsibility.

2. Navigate to Supply Chain Plan > Workbench.

3. Right-click on a plan and choose Items > Items from the menu.

4. In the Items window, select an item and click Routing Operations.
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5. In the Routing Operations window, click: Network Routing.

• Network Routing, which displays dependency types and offsets within the 
complex routing.

• Co-Product, which displays MTQ and time offsets for products yielding from 
the routing.

Contiguous Operations
In process manufacturing, the slack time between operations can be critical to the 
process. For example:

• , in an injection molding process, dry materials are grounded and then mixed in the 
proper proportion. In the next step they are mixed and heated with a liquid catalyst 
in a vat. When the material has reached the proper temperature, it has five minutes 
to be injected into molds. If the injection process is not finished in five minutes 
(maximum delay), the mixture starts to harden. In 15 minutes the mixture hardens 
to the point that the vat needs to be removed and cleaned with chisels. This can 
happen if the molding station is not available when the mixture is ready. This is the 
maximum delay or maximum time offset.

• In a process, the catalyst is mixed in with the inert materials and there needs to be at
least 15 minutes before the mixture can be passed to the next operation. This is the 
minimum delay or minimum time offset

• In many processes, the materials used (raw or intermediate) have specific shelf life 
and they need to be consumed before they are expired. This is specially a major 
issue for food manufacturers working with perishable materials

. These can become a costly problems if:

• Materials are wasted

• Machines are idle or have to be taken down for maintenance

• Customer orders are late

• Customer orders are lost

In order to support planning according to common practices of contiguous processing 
from raw materials to finished products, Oracle Advanced Supply Chain Planning can 
enforce minimum and maximum time offsets (slack time constraints) 

• Between operations within the same routing

• Across routings
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• Across operations in different routings across organizations

This enforcing action respects:

• Wait time constraints for material going from one operation to the next

• Minimum and maximum slack time allowed between operations

• Item shelf life constraints

Contiguous Processing Within a Routing

Within a routing, you model the time-offset constraint between the:

• Finish of the first operation and the start of the second operation

• Start of the first operation and the start of the second operation

Contiguous Processing Between Routings and Organizations

Across routings and across organizations, you model minimum and maximum time 
offsets between the last scheduled activity of the upstream operation (feeding routing) 
and the first scheduled activity of the downstream operation (consuming routing).

Minimum and Maximum Time Values

You can specify minimum and maximum time offsets between operations for each 
dependency type.

This table illustrates the minimum and maximum time values for the finish-to-start 
dependency type:

Finish-to-Start Dependency Type

Minimum and Maximum Time Values Description

0 The downstream operation begins 
immediately after the preceding operation 
ends. This time offset might be used if a 
consecutive addition of ingredients is required
without interruption.
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Minimum and Maximum Time Values Description

>0 The downstream operation begins within a 
specified period of time after the completion 
of its preceding step. If both minimum and 
maximum time values are positive, then the 
downstream starts after the minimum time 
value, and before the maximum time value.

This time offset might be used if the material 
must rest, but another ingredient needs to be 
added before it gets too hard.

<0 The downstream operation begins at the 
specified period of time before the completion 
of its preceding step.

Note: Offsets are between material 
scheduled activities of the upstream and 
downstream operations. For example, the 
upstream operation runtime activity and 
the downstream operation runtime 
activity.

This time offset might be used if a production 
device must be activated before the next 
ingredient is added. For example, the 
downstream runtime activity starts with an 
ingredient, and later in the process receives 
material from the upstream activity.

This table illustrates the minimum and maximum time values for the start-to-start 
dependency type:
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Start-to-Start Dependency Type

Minimum and Maximum Time Values Description

0 The downstream operation begins at the same 
time as the step it depends on. The first 
material scheduled activity of the downstream
operation will receive the material from the 
last material scheduled of the upstream 
operation at some point during its process. 

This time offset might be used if ingredients 
must be added at the same time without 
interruption.

>0 The downstream operation begins at a 
specified time after the start of the preceding 
step. If both minimum and maximum time 
values are positive, then the downstream 
operation starts after the minimum time value,
and before the maximum time value. 

Hard Link Constraints

If the upstream operation has a Minimum Transfer Quantity (MTQ) specified, the 
offsets are calculated from the point in time when the upstream operation has finished 
processing this transfer quantity. These are called hard link constraints.

Hard link constraints are applied to upstream and downstream operation activities with
the following criteria:

• The minimum transfer quantity specified at the upstream operation is applied 
between the last scheduled activity of the upstream operation and the first 
scheduled activity of the downstream operation.

• In case of supply split or a demand split, minimum transfer quantity and offsets is 
applied to supply segments of the last scheduled activity of the upstream operation 
and demand segments of the first scheduled activity of the downstream operation.

• All scheduled activities of the upstream operation are overlapped based on the 
minimum transfer quantity

• Any activity that is not scheduled is not overlapped with the preceding and 
following activities.

• Use profile option MSO: Overlap Activities by MTQ to prevent overlapping 
activities inside one operation.
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To track hard link between batches, use the Enforce Step Dependency flag. The Oracle 
Process Manufacturing planner can modify the Planned Start Date or Planned Quantity 
of Oracle Process Manufacturing batches without violating step dependency or hard 
link constraints. If this flag is not turned on, modifying batches can result in violating 
step dependency or hard link constraints. The Enforce Step Dependency flag can be set 
in the Oracle Process Manufacturing Routing Details window or Batch window. 

If there are no minimum and maximum time offsets, Oracle Advanced Supply Chain 
Planning uses the item shelf life at the upstream routing as the maximum time offset to 
model the hard link constraints. The minimum time offset is zero. All constraints 
mentioned in this section are valid with respect to these minimum and maximum time 
offset values. No hard link constraints are modeled if the shelf life is also Null.

The shelf life is used as the maximum time offset if profile option MSO: Use Item Shelf 
Life Days in Scheduling Buy or Make Orders is Yes. .For more information on setting 
the shelf life for an item, see MPS/MRP Planning Attribute Group, Oracle Inventory 
User's Guide

The planning engine calculates a minimum start date and time and a maximum start 
date and time for the downstream operations with hard links to completed upstream 
operations. These are based on the collected information of the completed upstream 
operations for a given supply

The collections process collects the:

• Actual Start Date/Time and Actual End Date/Time of the last value added activities 
of the completed upstream operations (material schedule flag for the activity is ON)
with hard links to downstream operations in WIP or Pending status (not 
completed). The completed operations always have values for the Actual Start 
Date/Time and Actual End Date/Time fields. 

• Dependency Type, Standard Delay, and Max Delay of the completed upstream 
operations with hard links to downstream operations.

Transfers

You can model the inter-organizations transfers as:

• Continuous transfer: The downstream process receives material in lot sizes of 1 
from the upstream process. The transfer starts on or after the completion of the 
minimum transfer quantity at the upstream process

• Non-continuous transfer: The downstream process receives material in discrete 
increments (typically more than 1 at a time) from the upstream process.

Setting Up Contiguous Operations

Set these profile options:

• MSO: Enable Hard Links Globally
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• MSC: Enforce Hard Links

• MSO: Use Item Shelf Life Days in Scheduling Buy or Make Orders

• MSO: Continuous transfer across organizations

• MSO: Upper Limit for Maximum Time Offset for Hard Links

• MSO: Transfer Quantity Threshold for Enforcing Hard Links

• MSO: Hard link scheduling window

• MSO: Maximum number of pulls/push for hard linked operations

• MSO: Hard link scheduling window expansion factor

• MSO: Overlap Activities by MTQ 

Define inter-routing material transfer quantity and time offsets. In the Step/Material 
Association window, specify:

• Minimum transfer quantity: The operation at the downstream routing can start 
after the production of the minimum transfer quantity at the upstream routing with
respect to minimum and maximum time offsets.

• Minimum and maximum time offsets: These represent the minimum and maximum
time offsets between routings on top of minimum transfer quantity.

For the modeling to take place, the planning engine must have access to this 
information from Oracle Process Manufacturing:

• Standard Delay (Intra routing minimum time offset)

• Max Delay (Intra routing maximum time offset)

• Minimum Time Offset (Inter routing)

• Maximum Time Offset (Inter routing)

• Dependency Type

• Minimum Transfer Quantity 

• Transfer Percent. This field represents the material transfer percentage from one 
operation to another. This field is in the Routing Step Dependencies form.

• Material quantity yielded from a step: This value is calculated based on the Step - 
Quantity field in the Step / Material Association form. The yield is subtracted from 
the step quantity and the transfer percentage is applied to the remainder. 
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Co-products and byproducts are not included in the material transferred from a 
step, and are not part of this calculation. 

• Actual Start Date/Time and Actual End Date/Time: Of the last value-added 
activities of the completed upstream operations (material schedule flag for the 
activity is selected) with hard links to downstream operations. These fields are in 
the Batch Steps form.

• Dependency Type, Standard Delay, and Max Delay: Of the completed upstream 
operations with hard links to downstream operations. These fields are in the 
Routing Step Dependencies form.

• Breakable: This field indicates whether an activity can be broken and scheduled at 
each side of a break. This field is in the Operation Details, Activities form.

Analyzing Contiguous Operations

View material transfer quantity and time offsets in Planner Workbench, Items, 
Co-Products window.

View and analyze time offsets by order in Planner Workbench Gantt Chart, Orders 
window

Note these exception messages:

• Item Exceptions exception group, Operation hard link violation: Navigate to the 
Supply/Demand and the Resource Requirements windows to identify causes and 
possible solutions

• Supply Problems for Late Sales Orders and Forecasts exception group, Requirement
causes resource overload: One of the causes for this exception is the Operation Hard
Link Constraint displayed in the Cause field in the Exception Details window. 
Rescheduling operations and/or adding capacity to resources can eliminate the 
resource overload problem.

• Item Exceptions Exception Group, End item supply shelf life violation: The 
planning engine issues this exception message if the remaining shelf life of a 
product will be smaller than the minimum remaining shelf life when it arrives at 
the customer site. 

Resources
When you complete the Resource Information form, you define a relationship between 
a plant and the resource. Because Oracle ASCP acknowledges the plant via the resource 
warehouse associated with the plant, Oracle ASCP views the resource as having a 
relationship with a resource warehouse instead of with a plant. Because a resource 
warehouse is mapped to a department in an inventory organization in Oracle 
Applications, the resource is essentially mapped to a department in an inventory 
organization via the plant resource form.
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You can use Oracle ASCP to develop capacity plans for your resources. The resource 
warehouse for the plant indicates to Oracle ASCP the need to perform capacity 
planning. The Oracle ASCP capacity planning function assumes that all resource 
capacity is measured in hours. The Assigned Quantity field (the navigation path to this 
screen in the OPM application is OPM > Planning > Capacity Planning > Setup > Plant 
Resources) indicates the number/quantity of the resource used in the specified plant for 
which you are defining production costs and usage availability. The number you enter 
depends on how broad a resource categorization you are defining. For example, if you 
defined the resource as Blender 1 (a specific machine) you would enter 1. If you use 
three blenders in the production line, and you defined the resource as Blenders (rather 
than defining each individual machine) enter 3.

The cost of using a resource for one unit of measure (for example, the cost of running a 
mixer for one hour) that you define in OPM Cost Management is also used by Oracle 
ASCP, but this cost must be recorded in the nominal cost value for the resource. Oracle 
ASCP assumes the unit of measure for all resources is an hour.

To set capacity planning, from the Navigator, choose Capacity Planning > Setup > 
Resources.

Scheduling Resource Charges
In process manufacturing , the resource used in an operation determines the capacity of 
the operation. When the resource capacity is less than the required amount, the resource
must run repeatedly with smaller amounts to complete the required batch. These 
iterations are called "charges". Oracle Advanced Supply Chain Planning can plan 
multiple charges to complete required batch quantities.

To determine the number of charges required for a batch, Oracle Advanced Supply 
Chain Planning divides the batch quantity by the maximum resource capacity and 
rounds up to the nearest integer. For example, if a resource has a maximum capacity of 
1000 gallons, and a batch requires 4500 gallons, the operation must run five times to 
complete the required amount (4500/1000=4.5; rounds up to 5).

Although the last charge for completing a batch might be for a smaller quantity than the
resource can handle, the amount of time that the operation runs is fixed. For example, if 
a mixer is only half full, it still requires the full operation time to complete the 
operation.

When a charge does not reach maximum capacity for an operation, Oracle Advanced 
Supply Chain Planning does not combine charges from different orders. A batch or 
work order that requires less than the maximum capacity of a resource is not processed 
with a charge for a different order.

Oracle Advanced Supply Chain Planning schedules charges as continuous processes; a 
single charge cannot split across manufacturing calendar breaks or gaps.
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Scheduling Resource Charges

Oracle Advanced Supply Chain Planning does not schedule gaps between charges for a 
batch unless this scheduling is necessary for filling a firm order. For example, if a batch 
requires 5 day-long charges on a resource and the resource is unavailable on Saturdays 
and Sundays, the system tries to schedule the charges on consecutive days without a 
break over the weekend. However, if the resource is unavailable for Monday and 
Tuesday in a week and the item is required to fill a firm order on the following 
Wednesday, Oracle Advanced Supply Chain Planning schedules the charges for 
Wednesday, Thursday, and Friday of Week 1 and Monday and Tuesday of Week 2.

Oracle Advanced Supply Chain Planning can recommend feeding material 
incrementally to charges. If an item base or chargeable activity feeds a chargeable 
activity, the planning engine splits the activity into as many segments as the number of 
consuming charges. This ensures that a charge can run as soon as sufficient material is 
available, rather than waiting for material for all charges in the activity. If the feeding 
activity is not proportionately scaled (scale type of fixed), it cannot feed charges 
incrementally.

Similarly, if a chargeable activity feeds an item base or chargeable resource activity, the 
planning engine splits the consuming activity into as many segments as the number of 
feeding charges. The consuming activity then can begin before all feeding activity 
charges are complete. If the consuming activity is not proportionally scaled, it cannot be
fed incrementally.

Oracle Advanced Supply Chain Planning can apply minimum and maximum time 
offsets between operations in a routing to the operation's charges.

When you release planned orders from Oracle Advanced Supply Chain Planning, 
Oracle Process Manufacturing imports the charge quantity and the start date and the 
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end date of charges as well as all operation resources. You cannot change any of this 
information. An OPM planner can execute a batch step as a whole and not its individual
charges. Users can view charge information in the Resource Charges window, which is 
accessible from the Tools > OPM Batch Steps form.

You can set up data required for scheduling charges in Oracle Process Manufacturing. 
You can then run collections to populate the data in Oracle Advanced Supply Chain 
Planning, and enable charges scheduling.

Setting Up Resource Charge Scheduling
To setup resource charge scheduling:

• Set up resources for scheduling charges.

• Specify chargeable activities.

• Enable charges scheduling.

Setting Up Resources for Scheduling Charges
In Oracle Process Manufacturing (OPM), for each resource for which you want to 
schedule charges, you must define the resource as chargeable and specify the maximum
capacity of the resource.

You can set up chargeable resources for all organizations or for a particular 
organization. If you define a chargeable resource for all organizations, the resource is 
chargeable in any organization where you create it. For example, if you define a 
chargeable resource called "Mixer" for all organizations and then create a "Mixer" 
resource in a particular organization, the organization-specific mixer is automatically 
defined as chargeable.

To set up a chargeable resource for all organizations
1. Select the Oracle Process Management responsibility.

2. Navigate to Process Engineer > Setup > Generic Resources.

3. In the Resources window, create or find a resource for which you want to schedule 
charges.

4. Select the Calculate Charges option.

5. Enter the maximum resource capacity in the Maximum field.

To set up a chargeable resource for a specific organization
1. Select the Oracle Process Management responsibility.

2. Navigate to Process Engineer > Setup > Plant Resources.

3. In the Resource Information window, create of find the resource for which you 
want to schedule charges.
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4. Select the Calculate Charges option.

5. Enter the maximum resource capacity in the Capacity Range field.

To specify chargeable activities
1. Select the Oracle Process Management responsibility.

2. Navigate to process Engineer > Process Operations.

3. In the Process Operation Details: Activities window, select an activity.

4. Click the Resources button.

5. In the Process Operation activity page, on the Scheduling Information tab, specify 
the Scale Type of By Charge for each chargeable resource.

To enable charges scheduling
To schedule resource charges in Oracle Advanced Supply Chain Planning, you must set
the MSO: Global Chargeable Flag to Yes. If this flag is set to No, charges are not 
scheduled and resource loads are not influenced by charges. The default value is No. 
For more information, see MSO Profile Options, page A-83

Viewing Resource Charge Information
In Oracle Advanced Supply Chain Planning, you can:

• View whether resources are chargeable. This information is specified in Oracle 
Process Manufacturing and collected into Oracle Advanced Supply Chain Planning.

• View charges for a resource activity.

• View planned activity charges in the Gantt chart. You can view charges for planned
orders and existing batches in the ASCP Gantt Chart Orders view and Resource - 
Activities view. For more information, see Interactive Scheduling using the Gantt 
Chart, page 18-159

• View exceptions related to charges. Oracle ASCP generates two new exceptions in 
the Material and resource capacity exception group with respect to chargeable 
resources.

• Resource charge was started with less than minimum capacity.

• Resource charge was started with more than maximum capacity. For more 
information about exception messages, see Supply Chain Planning Exception 
Messages, page 17-1

To view whether resources are chargeable
1. Select the Advanced Supply Chain Planner responsibility.



19-58    Oracle Advanced Supply Chain Planning Implementation and User's Guide

2. Navigate to Supply Chain Plan > Workbench.

3. In the Navigator, right-click a plan and choose Resources > Resources.

In the Resources window, the Chargeable option is selected for chargeable 
resources.

To view charges for a resource activity
You can view charges information for planned orders and existing batches in the 
Planner Workbench.

1. Select the Advanced Supply Chain Planning responsibility.

2. Navigate to Supply Chain Plan > Workbench.

3. In the Navigator, right-click a plan and choose Resources > Resources.

4. In the Resources window, click the Requirements button.

5. In the Resource Requirements window, click Charges.

The Charges window shows the planned charge dates and quantities.

MPS Schedule

Integrating MPS Schedule Parameters With Oracle ASCP
When you define your master production schedule (MPS) parameters, you indicate 
which plants are included in a schedule and select the criteria for including different 
sources of inventory supply and demand. The MPS schedule parameters serve the same
purpose in Oracle ASCP and are used to create the Oracle ASCP master demand 
schedule. The Oracle ASCP master demand schedule includes all plants linked to the 
MPS schedule in the MPS Schedule Parameters form detail (the navigation path to this 
screen in the OPM application is OPM > Planning > MPS > Setup > Scheduler).

For more information, see Defining an MPS Schedule in Oracle Process Manufacturing 
MPS/MRP and Forecasting User's Guide.

The MPS schedule must have a unique, five character name. The Oracle ASCP master 
demand schedule name consists of the MPS schedule name and the warehouse name. 
For example, a MPS schedule named SCHD1 for resource warehouse RSW1 would 
result in a master demand schedule named SCHD1/RSW1.

The Make to Stock field on the MPS Schedule Parameters form enables you to choose 
whether or not to include forecasts as a source of demand. The Make to Order field 
allows you to choose whether or not to include sales orders as a source of demand. The 
Plant Warehouses form defines the items and warehouses from which to pull the 
demand for each plant linked to the MPS schedule.



Integrating with Planning and Manufacturing Environments    19-59

Integrating Forecasts With Oracle ASCP
The setup steps necessary to use forecast consumption for Oracle ASCP are the same 
setup steps you must complete when using forecast consumption in OPM. 

To use forecast consumption
1. Create Forecast by using the following navigation path in the OPM application: 

OPM > Planning > Forecasting > Forecast. For more information, see Forecasting in 
Oracle Process Manufacturing MPS/MRP and Forecasting User's Guide.

2. Associate forecast with Schedule by using the following navigation path in the 
OPM application: OPM > Planning > Forecast > Schedule Association. For more 
information, see Forecast Schedule Association Field References in Oracle Process 
Manufacturing MPS/MRP and Forecasting User's Guide.

Forecast information created and linked to an MPS schedule in OPM is used by 
Oracle ASCP to create the master demand schedule. The forecasts used by the MPS 
schedule are specified on the Forecast Schedule Association form. A forecast can 
contain any number of items in various warehouses, but the schedule only uses 
those items that are valid to consume for a warehouse according to the Plant 
Warehouses form.

Note: Because one forecast can be used in multiple MPS schedules, 
be careful not to duplicate the demand for an item in a warehouse.

Integrating Production Orders With Oracle ASCP
Oracle ASCP views pending OPM production orders as a source of supply and 
demand. Oracle ASCP can only view pending OPM production orders (firm planned 
orders, pending batches, and work-in-process batches) for those items that have a 
item/warehouse/plant relationship defined on the Plant Warehouses form. 

You must turn on Production Operations Control (POC) for a plant and you must 
define a resource warehouse for a plant if you want to create capacity plans for the 
plant. Do this for the desired Organization on the OPM Organizations form. (For more 
information, see Organizations in Oracle Process Manufacturing System Administration 
User's Guide. The navigation path to the screen in the OPM application is OPM > System
Administration > Organizations).

If POC is turned on, Oracle ASCP collects the plant's routing and resource requirements
once a batch is created and the batch information is transferred to Oracle ASCP. If a 
plant does not have a resource warehouse, routing and resource data is not transferred 
to Oracle ASCP.

The ingredients for a batch must come from a single warehouse. OPM works around 
this issue by using the work-in-process warehouse or the resource warehouse, if 
available, as the single source of ingredient inventory when the batch has multiple 
sources or destinations. The work-in-process warehouse or the resource warehouse 
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shows Oracle ASCP from where to allocate inventory.

The quantity of a batch product is reported in the converted primary unit of measure of 
the item.

Firm planned orders are viewed by Oracle ASCP the same as batches, except the firm 
planned order routing and resource requirements are not considered. Routing and 
resource requirements are considered once a firm planned order is converted into a 
batch. 

Production rules (defined in OPM Inventory) are not required, but they do ensure that 
batches created meet fixed and variable lead-time requirements.

The process of creating production batches or firm planned orders from planning 
suggestions remains the same, regardless of whether or not the planning suggestions 
was created in Oracle ASCP or OPM. Any user can create production batches or firm 
planned orders from Oracle ASCP planning suggestions as long as the plant is listed in 
their security schema.

Integrating On-hand Inventory With Oracle ASCP
Oracle ASCP sees the on-hand inventory of item/warehouse combinations defined for 
the plant that is attached to the MPS schedule. If a lot has expired, Oracle ASCP does 
not consider the lot as available inventory. It also does not suggest that you use the 
available lot that is closer than the other lots to expiring. Oracle ASCP observes lot 
statuses and does not consider a lot for consumption unless the lot status identifies the 
lot as nettable.

Co-products
See Common Features in Hybrid Manufacturing Environments, page 19-2, Co-products 
section for basic co-product information. For more details, see the Oracle Process 
Manufacturing documentation.

Process manufacturing industry environments, the manufacturing focus is on:

• Formula

• Recipe

• Validity Rules

For example, ingredients 100 kilograms of grade 1 wheat and 40 liters of water combine 
to produce co-products 25 kilograms of A1 flour and 50 kilograms of A2 flour.
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Flour formula

The formula specifies the ingredients (components) that you use to make the product. 
The planning engine represents co-products produced with negative usages (similar to 
by-products). In the Formula By-Product Lines window, you can specify a scaling type 
(fixed or proportional).

The recipe specifies the process to make the product. You can specify alternate uses of 
the same formula by specifying it in multiple recipes that have different validity rules.

Validity rules associate with recipes and specify criteria such as:

• Start and end effectivity date ranges

• Minimum and maximum quantities

• Co-product to give preference to in ties

Item Quantity Day 1 Day 3

Flour A1 25 kg - -200

Flour A2 50 kg -100 -

Bran 10 kg - -

Pollard (fixed) 10 kg - -

Flour A1 - 50 (co-product) 150 (planned order)

Flour A2 - 100 (planned order) 300 (co-product)

Bran (by-product) - 20 (by-product) 60 (by-product)
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Item Quantity Day 1 Day 3

Pollard (by-product) - 10 (by-product) 10 (by-product

Demand for Wheat 100 kg -200 -600

Demand for Water 40 l -80 -240

Co-product items can have different units of measure.

The planning engine plans for the situation in which you produce the same product at 
multiple operations.

Consider these co-product issues when you select plan type. All plan types 
simultaneously plan all items to utilize co-product supplies created on the same day:

• Unconstrained plans use the process (formula, routing) with the highest priority 
and lowest preference that is effective for the date and quantity range

• Constrained plans with decision rules respect effective date and maximum quantity
ranges. They use the process with the highest priority and lowest preference that 
has adequate capacity.

• Optimized plans respect effective date and maximum quantity ranges. However, 
they select the best process (formula and recipe) that both respects capacity 
constraints and minimizes inventory and costs. You must specify costs for the 
alternate bill of material/routing pairs.

• While constrained plans with decision rules and optimized plans consider 
minimum quantity ranges, the results may not be minimized. The optimization 
process may select a process that violates the minimum quantity condition but that 
the planning engine later corrects. In this case, the results honor the process 
quantities but may not have chosen the best process. 

Co-products and Substitution Relationships

Co-products structures can be utilized with item substitution and component 
substitution functionality in constrained plans. This means that you may define that the 
co-product items have a substitute relationship. ASCP may use the substitute supplies 
on the same day that they are produced.

Supply Tolerances
Use supply tolerances to instruct the planning engine not to exactly match supply to 
demand at all times through the planning horizon.

You can apply supply tolerancing for an item either globally or at the item-organization
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level, depending on where you set the item attributes that control it.

The planning engine calculates supply tolerances for constrained and optimized plans

Supply Shortage Tolerance

The planning engine does not recommend more production if there is a supply that 
almost satisfies a demand. Use this tolerance if you typically accept shortages within a 
percentage of the demand quantity, for example, because of yield fluctuations.

If there is a supply whose quantity is higher that the tolerance percentage of the 
demand, the planning engine:

• Considers the demand fulfilled

• Recommends production of the short quantity at the end of the planning horizon

For example:

• You have an item that you make in lots of 20,000

• There is a demand for quantity 20,000

• The item has tolerance percentage of 93. Therefore, any supply for the same item 
that has quantity 18601 or greater is eligible to satisfy the demand [(20,000 * 0.93) + 
1]

• There is a supply for the item with quantity 19900

• The planning engine records that the supply of quantity 19,900 satisfies the demand
of quantity 10,000

• The planning engine creates a recommendation to produce quantity 20,000 to be 
due on the last day of the planning horizon and pegs it to excess.
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To instruct the planning engine to use supply shortage tolerance for an item, either

• Enter a percent value in profile option MSC: Demand Satisfied Percent Threshold 
for Pegging

• Enter a percent value for it in the Item Attributes Mass Maintenance form only as 
an item-organization attribute Shortage Tolerance Percent. 

If you want the planning engine to exclude planned orders from supply shortage 
tolerance and supply excess tolerance, set profile option MSC: Apply shortage and 
excess tolerance percentages to planned orders to No.

A value in this item attribute overrides the setting of profile option MSC: Demand 
Satisfied Percent Threshold for Pegging. You can control whether this tolerance applies 
to planned orders by setting a value for profile option MSC: Apply shortage and excess 
tolerance percentages to planned orders.

Supply Excess Tolerance

If there is a supply with quantity slightly larger than a demand, the planning engine 
pegs the entire supply quantity, including the excess quantity to the demand. It does 
not peg the excess to another demand. Use this tolerance if you typically accept 
overages within a percentage of the demand quantity, for example, because of yield 
fluctuations.

For example:

• You have an item that you make in lots of 20,000

• There is a demand for quantity 20,000
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• The item has tolerance percentage of 10. Therefore, any supply for the same item 
that has quantity 21,999 or less is eligible to satisfy the demand [20,000 + (20,000 * 
0.1) – 1]

• There is a work order for the item with quantity 20,075

• The planning engine records that the supply of quantity 20,075 satisfies the demand
of quantity 20,000

• It pegs the entire quantity of 20,075 to the demand for 20,000. It does not peg the 
excess supply quantity of 75 to any other demand. It recommends a planned order 
for the full quantity of the next demand of 20,000.

To instruct the planning engine to use supply excess tolerance for an item, either:

• Enter a percent value in profile option MSC: Minimum Supply/Demand Percent for 
Pegging.

• Enter values for it in the Item Attributes Mass Maintenance form as 
item-organization attribute Excess Tolerance Percent. 

If you want the planning engine to exclude planned orders from supply shortage 
tolerance and supply excess tolerance, set profile option MSC: Apply shortage and 
excess tolerance percentages to planned orders to No.

A value in this item attribute overrides the setting of profile option MSC: Minimum 
Supply/Demand Percent for Pegging. You can control whether this tolerance applies to 
planned orders by setting a value for profile option MSC: Apply shortage and excess 
tolerance percentages to planned orders.

Small Demands Delayed Fulfillment
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You indicate the typical production run size for an item by specifying a fixed order 
quantity. You indicate your tolerance for delaying small orders as a percentage of the 
fixed order quantity.

When the planning engine notices small demands for an item, it looks forward and 
attempts to find a demand for the same item that is closer to the typical production run 
size. It suggests that you satisfy all demands with one production run even though the 
smaller one will be late. Small demands are demands whose total quantities are lower 
than your tolerance for delaying small orders. 

Use this tolerance if you do not like to hold excess inventory to satisfy small orders and 
are willing to satisfy small orders late as needed. If you do not use this feature, the 
planning engine may recommend making a full production run quantity to satisfy the 
smaller, earlier orders. This results in your holding the remaining inventory for a larger,
later order.

For example:

• You have an item that you make in lots of 20,000

• You have an unsatisfied demand factor of 0.1. Therefore, supplies that have total 
quantities below 2000 may be subject to small demands delayed fulfillment [20,000 *
0.1]

• There is a demand on day 5 against that item for quantity 100

• There is a demand on day 25 against the same item for quantity 19,550

• The planning engine identifies the demand on day 5 for quantity 100 as subject to 
small demands delay fulfillment [100 < 2000]

• The planning engine identifies the demand on day 25 for quantity 19,550 as not 
subject to small demands delay fulfillment [19,550 > 2000]

• The planning engine recommends producing quantity 20,000 of the item due on 
day 25

• The demand on day 5 for quantity 100 should be satisfied late on day 10

• The demand on day 10 for quantity 19,550 should be satisfied on time on day 10

• The planning engine pegs the excess quantity of 450 on day 10 to excess
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To instruct the planning engine to use small demands delayed fulfillment, set profile 
option MSO: Delay fulfillment of small demands to Yes

Then either:

• Enter a quantity value in item attribute Fixed Lot Multiplier

• Enter factorUNSATISFIED_DEMAND_FACTOR through the MSC_SYSTEM_ITEMS 
table in the planning server (operational data store, plan_id = -1). This factor is 
any number between 0 and 1 and refers to a percentage of item attribute Fixed Lot 
Multiplier; the default value is NULL.

• Enter values for it in the Item Attributes Mass Maintenance form as 
item-organization attribute Unsatisfied Demand Factor 

To instruct the planning engine to use small demands delayed fulfillment for an item at 
the global level, set a value for profile option: MSO: Delay fulfillment of small demands.
You can also enter values for this in the Item Attributes Mass Maintenance form only as 
an item-organization attribute; use attribute Unsatisfied Demand Factor.

Pegging Examples

Study these examples to understand how to expect the pegging to appear when you are
using supply tolerances.

Example 1: Shortage and Excess Tolerance Percents

In this example:

• Shortage Tolerance Percent = 0.6

• Excess Tolerance Percent = 0.4
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For a demand quantity of 10000:

• Shortage Tolerance Quantity = 10000 * 0.6 / 100 = 60

• Excess Tolerance Quantity = 10000 * 0.4 / 100 = 40

The on-hand quantity 9980 is short by quantity 20 to satisfy the demand on day 2 for 
quantity 10,000.

The shortage is within the supply shortage tolerance [20 < 60].

The planning engine:

• Pegs the on-hand quantity 9800 to the demand on day 2 for quantity 10,000

• Places the shortage quantity 20 as a planned order at the end of the planning 
horizon on day 10

The discrete job due on day 3 for quantity 10,300 can satisfy the demand on day 4 for 
quantity 10,000 but is over by quantity 30.

The excess is within the supply excess tolerance [30 < 40].

The planning engine:

• Pegs the discrete job due on day 3 for its entire quantity 10,300 to the demand on 
day 4 for quantity 10,000

• Does not peg the excess quantity 30 to any other demand

The discrete job on day 2 for quantity 9000 is short by quantity 1000 to satisfy the 
demand on day 6 for quantity 10,000.

The shortage is outside the supply shortage tolerance [1000 > 60].

The planning engine:

• Pegs the discrete job on day 2 for quantity 9000 to the demand on day 6 for quantity
10,000

• To make up the shortage, recommends a planned order due on day 6 for quantity 
1000 

The discrete job on day 7 for quantity 11,000 can satisfy the demand on day 7 for 
quantity 10,000 but is over by quantity 1000.

The excess is outside the supply excess tolerance [1000 > 40].

The planning engine:

• Pegs the discrete job on day 7 for 10,000 of its quantity 11,000 to the demand on day 
7 for quantity 10,000

• Pegs the discrete job on day 7 for 1000 of its quantity 11,000 to the demand on day 8 
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for quantity 10,000

Example 2: Small Demands Delay Fulfillment

In this example:

• Fixed Days Supply = 40

• Fixed Lot Multiplier = 1,000,000

• Unsatisfied Demand Factor = 0.1

The first fixed days supply period includes the demands on September 1 for quantity 
2,500,000 and on October 1 for quantity 1,570,000. The total demand for this period is 
4,070,000 [2,500,000 + 1,570,000].

The planning engine calculates a planned order of 5,000,000 to:

• Completely satisfy the demand in the period

• Honor the fixed lot multiplier

However, the planning engine detects that this item is subject to small demands delay 
fulfillment. Recommending production of quantity 5,000,000 due on September 1 would
leave excess on-hand of quantity 70,000 from September 1 until November 1.

The unsatisfied demand factor against quantity 1,000,000 is 100,000 [1,000,000 * 0.1] This
quantity 70,000 is within the unsatisfied demand factor [70,000 < 100,000 or 70,000 / 
1,000,000 = 0.07 and 0.07 < 0.1].

The planning engine:

• Considers the quantity 70,000 as a small demand
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• Recommends a planned order due in September 1 for quantity 4,000,000

The demand due on September 1 should be completely satisfied on September 1.

The demand due on October 1 should be partially satisfied on September 1 with a 
shortage of quantity 70,000.

There is a cumulative unsatisfied demand of quantity 70,000 carried forward to period 
2.

The second fixed days supply period includes the demand on November 1 for quantity 
1,800,000 and the cumulative unsatisfied demand of quantity 70,000. The total demand 
for this period is 1,870,000.

The planning engine calculates a planned order of 2,000,000 to:

• Completely satisfy the demand in the period

• Honor the fixed lot multiplier

However, the planning engine detects that this item is subject to small demands delay 
fulfillment. Recommending production of quantity 2,000,000 due on September 1 would
leave excess on-hand of quantity 130,000 from November 1 until January 1.

The unsatisfied demand factor against quantity 1,000,000 is 100,000 [1,000,000 * 0.1] This
quantity 130,000 is outside the unsatisfied demand factor [130,000 > 100,000 or (70,000 + 
1,800,000) / 1,000,000 = 1.87 and 1.87 > 0.1].

The planning engine:

• Does not consider the quantity 130,000 as a small demand

• Recommends a planned order due in November 1 for quantity 2,000,000

The demand due on October 1 should be completely satisfied late on November 1.

The demand due on November 1 should be completely satisfied on November 1.

There is excess on-hand for quantity 130,000 on November 1 carried until the next 
period.
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Example 3: Combination of Shortage Tolerance Percent and Unsatisfied Demand 
Factor

In this example:

• Fixed Lot Multiplier = 1000

• Unsatisfied Demand Factor = 0.25

• Shortage Tolerance Percent = 10% = 0.1

• Profile option MSC: Apply shortage tolerance percent to planned orders = No

Day 1:

• Shortage = 3000 [Demand on day 1 – Supply available on day 1 = 20,000 – 17,000]

• Shortage tolerance quantity = 2000 [Demand on day 1 * Shortage Tolerance Percent 
= 20,000 * 0.1]

• The shortage is more than the shortage tolerance quantity [3000 > 2000]

• Consider the shortage not satisfied and create a planned order for quantity 3000 
due in day 1

Day 2:

• Shortage = 500 [Demand on day 2 – Supply available on day 2 = 20,500 – 20,000]

• Shortage tolerance quantity = 2050 [Demand on day 1 * Shortage Tolerance Percent 
= 20,500 * 0.1]

• The shortage is lower than the shortage tolerance quantity [500 < 2050]

• Consider the shortage satisfied and do not create a planned order
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Day 3:

• Shortage = 100 [Demand on day 3 – Supply available on day 3 = 100 – 0]

• Cumulative unsatisfied demand = 100 [Previous cumulative unsatisfied demand + 
Shortage on day 3 = 0 + 100]

• Unsatisfied demand quantity = 250 [Fixed lot multiplier * Unsatisfied demand 
factor = 1000 * 0.25]

• The cumulative unsatisfied demand is lower then the fixed lot multiplier [100 < 
1000]

• The cumulative unsatisfied demand is lower than the unsatisfied demand quantity 
[100 < 250]

• Consider the cumulative unsatisfied demand subject to small demands delay 
fulfillment and do not create a planned order 

Day 4:

• Shortage = 50 [Demand on day 4 – Supply available on day 4 = 50 – 0]

• Cumulative unsatisfied demand = 150 [Previous cumulative unsatisfied demand + 
Shortage on day 3 = 100 + 50]

• Unsatisfied demand quantity = 250 [Fixed lot multiplier * Unsatisfied demand 
factor = 1000 * 0.25]

• The cumulative unsatisfied demand is lower then the fixed lot multiplier [150 < 
1000]

• The cumulative unsatisfied demand is lower than the unsatisfied demand quantity 
[150 < 250]

• Consider the cumulative unsatisfied demand subject to small demands delay 
fulfillment and do not create a planned order 

Day 5:

• Shortage = 40 [Demand on day 5 – Supply available on day 5 = 40 – 0]

• Cumulative unsatisfied demand = 190 [Previous cumulative unsatisfied demand + 
Shortage on day 3 = 150 + 40]

• Unsatisfied demand quantity = 250 [Fixed lot multiplier * Unsatisfied demand 
factor = 1000 * 0.25]

• The cumulative unsatisfied demand is lower then the fixed lot multiplier [190 < 
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1000]

• The cumulative unsatisfied demand is lower than the unsatisfied demand quantity 
[190 < 250]

• Consider the cumulative unsatisfied demand subject to small demands delay 
fulfillment and do not create a planned order

Day 6:

• Shortage = 20,500 [Demand on day 6 – Supply available on day 6 = 20,500 – 0]

• Cumulative unsatisfied demand = 20,690 [Previous cumulative unsatisfied demand 
+ Shortage on day 3 = 190 + 20,500]

• Unsatisfied demand quantity = 250 [Fixed lot multiplier * Unsatisfied demand 
factor = 1000 * 0.25]

• The cumulative unsatisfied demand is higher than the unsatisfied demand quantity 
[20,690 > 250]

• Consider the cumulative unsatisfied demand not subject to small demands delay 
fulfillment and create a planned order for quantity 21,000 [Cumulative unsatisfied 
demand rounded to closest multiple of fixed lot multiplier = 20.690 rounded to 
closest multiple of 1000] due on day 6 There is a planned order excess of quantity 
310 available for future days 

Day 7:

• Shortage = -160 [Demand on day 7 – Supply available on day 7 = 150 – 310]

• Cumulative unsatisfied demand = -160 [Previous cumulative unsatisfied demand – 
Planned order excess + Shortage on day 7 = [-310 + 150]

• There is no cumulative unsatisfied demand so do not create a planned order

• There is a planned order excess of quantity 160 [310 - 150] available for future days

Day 8:

• Shortage = 40 [Demand on day 8 – Supply available on day 8 = 200 – 160]

• Cumulative unsatisfied demand = 40 [Previous cumulative unsatisfied demand – 
Planned order excess + Shortage on day 8 = [-160 + 200]

• Unsatisfied demand quantity = 250 [Fixed lot multiplier * Unsatisfied demand 
factor = 1000 * 0.25]

• The cumulative unsatisfied demand is lower then the fixed lot multiplier [40 < 1000]
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• The cumulative unsatisfied demand is lower than the unsatisfied demand quantity 
[40 < 250]

• Consider the cumulative unsatisfied demand subject to small demands delay 
fulfillment and do not create a planned order

Day 9:

• Shortage = 20,000 [Demand on day 9 – Supply available on day 9 = 20,000 – 0]

• Cumulative unsatisfied demand = 20,040 [Previous cumulative unsatisfied demand 
+ Shortage on day 3 = 40 + 20,000]

• Unsatisfied demand quantity = 250 [Fixed lot multiplier * Unsatisfied demand 
factor = 1000 * 0.25]

• The cumulative unsatisfied demand is higher than the unsatisfied demand quantity 
[20,040 > 250]

• Consider the cumulative unsatisfied demand not subject to small demands delay 
fulfillment and create a planned order for quantity 20,000 [Cumulative unsatisfied 
demand rounded to closest multiple of fixed lot multiplier = 20,040 rounded to 
closest multiple of 1000] due on day 6

• Of the planned order for quantity 20,000: Of the planned order for quantity 20,000:

• Quantity 40 satisfies the cumulative unsatisfied demand from day 8

• Quantity 19,660 [20,000 – 40] satisfies the shortage for day 9

• There is a now a cumulative unsatisfied demand of quantity 40 remaining against 
day 9

Day 10:

• Shortage = 200 [Demand on day 10 – Supply available on day 10 = 200 – 0]

• Cumulative unsatisfied demand = 240 [Previous cumulative unsatisfied demand – 
Planned order excess + Shortage on day 9 = [40 + 200]

• Unsatisfied demand quantity = 250 [Fixed lot multiplier * Unsatisfied demand 
factor = 1000 * 0.25]

• The cumulative unsatisfied demand is lower then the fixed lot multiplier [240 < 
1000]

• The cumulative unsatisfied demand is lower than the unsatisfied demand quantity 
[240 < 250]
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• Consider the cumulative unsatisfied demand subject to small demands delay 
fulfillment and do not create a planned order 

Day 11:

• Shortage = 20,200 [Demand on day 9 – Supply available on day 9 = 20,000 – 0]

• Cumulative unsatisfied demand = 20,440 [Previous cumulative unsatisfied demand 
+ Shortage on day 3 = 240 + 20,200]

• Unsatisfied demand quantity = 250 [Fixed lot multiplier * Unsatisfied demand 
factor = 1000 * 0.25]

• The cumulative unsatisfied demand is higher than the unsatisfied demand quantity 
[20,440 > 250]

• Consider the cumulative unsatisfied demand not subject to small demands delay 
fulfillment and create a planned order for quantity 20,000 [Cumulative unsatisfied 
demand rounded to closest multiple of fixed lot multiplier = 20,440 rounded to 
closest multiple of 1000] due on day 11

• Of the planned order for quantity 20,000:

• Quantity 40 satisfies the planned order shortage from day 9

• Quantity 200 satisfies the cumulative unsatisfied demand from day 10

• Quantity 19,760 [20,000 - 40 - 200] satisfies the shortage for day 11

• There is a now a cumulative unsatisfied demand of quantity 440 [20,200 – 19,760] 
remaining against day 11
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Example 4: Apply Shortage and Excess to Planned Orders

An item has two demands:

• Demand 1 quantity 10200

• Demand 2 quantity 10200

Fixed Order Quantity: 2000

MSC: Demand Satisfied Percent Threshold for Pegging: 98

Shortage Tolerance Quantity: 204 [10200 * (100 – 98) / 100]
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MSC: Minimum Supply/Demand Percent for Pegging: 0.0018

Excess Tolerance Quantity: 1836 [10200 * 0.0018]

Profile option MSC: Apply shortage and excess tolerance percentages to planned orders
is No:

• Create six planned orders each quantity 2000

• Ignore shortage tolerance quantity

• Use them to satisfy Demand 1

• Excess is 1800 [12000 - 10200]

• Apply excess to satisfy Demand 2

Profile option MSC: Apply shortage and excess tolerance percentages to planned orders
is Yes:

• Create six planned orders each quantity 2000 

• Use shortage tolerance quantity

• Use five of them to satisfy Demand 1. Demand 1 supply is 10000. The shortage 200 
is within the shortage tolerance quantity 204.

• Excess is 2000 [12000 - 10000]

• Apply excess to satisfy Demand 2

Preventing Early Builds
To prevent the planning engine from planning early builds, use profile option MSO: 
Allow early builds to consume existing supplies of phased-out components and 
sources.

Make Item Postprocessing Lead Time
Lead-time Item Attributes Definition

Postprocessing: For buy items, the time required to receive a buy or transfer item from 
the receiving dock to inventory. 

For make items, post-production activities that you don't model in the item routing, for 
example, quality control analysis and shipping preparation activities. Set it in the Item 
Attributes Mass Maintenance window, do not set it in the source using the Item 
Attributes window 

Setting Lead-times
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Set lead-time values for the planning engine to use in the following source system 
windows: 

• Source instance > Oracle Inventory > Organization items form > Item attributes > 
Lead-time tabbed region 

• Source instance > Oracle Purchasing > Approved Supplier List form

• Destination instance > Oracle Advanced Supply Chain Planning > Item Attributes 
Mass Maintenance

Lead-times and Order Dates

Dock date: For buy and transfer orders, the end of Processing and the beginning of 
Postprocessing; the date that the material should be on your receiving dock. 

For make orders, the date when you complete the operations and begin the 
post-processing activities (postprocessing lead time). 

Due date: For buy and transfer orders, the end of Postprocessing and for make orders, 
the end of Postprocessing; the date that the material should be in your inventory.

By-products and Coproducts

The supply of a by-product and a coproduct is ready for downstream consumption on 
the dock date.

By-products and coproducts cannot have post-processing lead times.

Oracle Shop Floor Management
Oracle Shop Floor Management is a module which bridges planning and execution 
systems. It provides the following capabilities:

Manage Complex shop floor lot transactions 

• Lot split and merge 

• Update of lot name, product, routing, quantity 

• Bonus lots creation 

Enable dynamic routings 

• Routing determined on the fly 

• Routing movements enforced based on legal next operations 

• Jumps allowed to any operation 

Provide end-to-end genealogy of your products 
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• Product tracking all the way back to raw material 

• Forward and backward genealogy surfing 

Model and track operation yield based cost for your products. 

• Operation level yields 

• Yielded cost of product 

• Cost variance at operations 

Enable integration of ERP with third-party MES systems. 

• Seamless integration with Oracle Applications 

Co-Product modeling 

• Modeling of co-products

Oracle ASCP integrates seamlessly with OSFM to provide the following capabilities:

Lot-Based Jobs
Lot-Based Jobs is an execution entity in Oracle OSFM designed to handle Lot-Based 
production. You can implement planned orders for items with Network Routings as 
Lot-Based Jobs. Follow the instructions specified in Implementing Planning 
Recommendation, page 18-151 to select and release planned orders from Planner 
Workbench. The release process checks the setting for network planning method in the 
Planning Parameters form at the time of release to see if it is Primary.

You can implement Reschedule In, Reschedule out, and Cancellation recommendations 
in addition to releasing the planned orders. Implementing recommendations uses a 
concurrent program called Import Lot Based Jobs at the source.

You may not be able to release planned orders as lot based jobs if you do not: 

• Select plan option Plan Capacity.

• Provide a WIP Accounting Class in the Oracle Work in Process parameters

• Provide Accounting Class in the Oracle Shopfloor Manufacturing (OSFM) 
parameters. You can also set Accounting Class in Oracle Advanced Supply Chain 
Planning Planner Workbench Preferences form, Others tab, Job Class field; 
however, this value applies to all instances 

• Set planning parameter OSFM Network Scheduling Method to Primary for the 
organization

You can pass job name, job start and completion dates, start quantity, BOM and Routing
designators, demand class, and WIP class, etc. For the quantity, the planning engine 
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uses the start quantity, all of the transactions against the job, and the reverse cumulative
yield at the current operation. The planning engine considers lot-based jobs as supplies.

You can pass the demand for the components of the assembly from Lot-Based Jobs, and 
calculate resource requirements. The planning engine considers efficiency and 
utilization in calculating resource requirements for intermediate operations.

You can see the results of the transactions on a Lot-Based Job; for example, Issues, 
Moves, Completions, etc. Oracle ASCP schedules the Lot-Based Jobs based on the 
availability of resources considering the current load of the shop floor. If you progress 
the job through move transactions at the source, the next time plan runs, Oracle ASCP 
schedule the rest of the operations in the network. 

The Firm Type field for the resource in the Oracle Advanced Supply Chain Planning 
Planner Workbench Resource Requirements window displays the Firm Type from 
Oracle Shopfloor Manufacturing (OSFM). The Oracle Advanced Supply Chain Planning
scheduling process does not override this flag. For example, if only the start date of a 
resource is firmed, the Oracle Advanced Supply Chain Planning scheduling process 
does not reschedule the start date but it may reschedule the end date. 

If you firm a resource of an Oracle Shopfloor Manufacturing (OSFM) job in the Oracle 
Advanced Supply Chain Planning Planner Workbench Resource Requirements window
and release it, the process transfers the Firm Type flag to the Oracle Shopfloor 
Manufacturing (OSFM) source.

Note: Lot-based Jobs are referred to as Discrete Jobs in the Planner's 
Work Bench

Coproducts
This feature is available with the integration of APS and Oracle Shop Floor 
Management (OSFM). 

In some production environments, an item may turn into one or more parent items 
depending on the process control, test results, raw material quality, etc. Such a 
relationship is defined by defining coproducts. OSFM allows you to specify multiple 
possibilities of assemblies (parents) that may be derived from a single part. 

You can set up coproducts using Oracle OSFM. To explain this with an example, 
consider the diagram below. A, B, and C are coproducts produced from raw material X. 
The figures in % are the expected mix of production of coproducts. 
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Coproducts

Co-products Support in Planning
See Common Features in Hybrid Manufacturing Environments, page 19-2, Co-products 
section for basic co-product information. For more details, see the Oracle Shop Floor 
Manufacturing (OSFM) documentation.

In the semiconductor, electronics and metals industries, the focus is the primary 
component that is processed to become individual products. For example, A Fast Wafer 
may become a Low Speed Chip, Medium Speed Chip, or High Speed Chip. 
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Wafer-chi: Primary bill of material

Use the Define Co-products form to specify co-products made from the primary 
component. Then, click Split Percentages and enter the percentage distribution for each 
co-product on the Define Time Phased Split Percentages form. You can specify 
effectivity date ranges for percentage distributions; the planning engine uses the 
percentage distributions effective on the plan launch date throughout the planning 
horizon.

You can build the same products from different components by using alternate bills of 
material/routing pairs during co-products setup. For example:

• Primary: Fast wafer component > Low Speed Chip 20%, Medium Speed Chip 30%, 
High Speed Chip 50%

• Alternate 1: Fast wafer component > Low Speed Chip 5%, Medium Speed Chip 
15%, High Speed Chip 80%

• Alternate 2: Medium wafer component > Low Speed Chip 30%, Medium Speed 
Chip 60%, High Speed Chip 10%

This diagram shows alternate bill of material 1. The process uses the same Fast Wafer as
the primary bill of material. However, the process is tuned to produce different 
percentages of co-products from those the primary bill of material.
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Wafer-chip: Alternate bill of material 1

This diagram shows alternate bill of material 2. The process uses a different wafer--Med
Wafer--from the one in the primary bill of material. It produces different percentages of 
co-products from those the primary bill of material.

Wafer-chip: Alternate bill of material 2

You can specify end-item substitutes for end item co-products and component 
substitutes for co-products used as components.

Co-product end item substitution
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Co-product component substitution

The issues that you consider when you select plan type apply to co-products also. All 
plan types simultaneously plan all items to utilize co-product supplies created on the 
same day:

• Unconstrained plans utilize the Primary bill of material and routing only for 
creating planned orders. However, the planning engine honors alternate bill of 
material/routing pairs on scheduled receipts.

• Constrained plans with decision rules select the primary bill of material/routing 
first. If capacity remains, they select each alternate bill of material/routing and use it
if it has capacity. Once the bill of material and routing selection is made then 
planning process is continued to minimize inventory.

• Optimized plans will select the best bill of material and routing that both respects 
capacity constraints and minimizes inventory and costs. You must specify costs for 
all alternate bill of material/routing pairs, all items, and all resources. 

The planning process does not consider the sequence of demands in an attempt to 
minimize supply. For example,

• High Speed Chip has demand due for quantity 100 on day 1

• Medium Speed Chip has demand due for quantity 60 on day 2

• Low Speed Chip has demand due for quantity 40 on day 3

The planning engine creates a planned order against High Speed Chip, the first 
demand, for quantity 100 and the co-product supplies to be made that day for quantity 
60 and quantity 40 fulfill the demands on day 2 and day 3.
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Item Percent/Quantit
y

Day 1 Day 2 Day 3

High Speed Chip 50% -100 - -

Medium Speed 
Chip

30% - -60 -

Low Speed Chip 20% - - -40

High Speed Chip - 100 (planned 
order)

- -

Medium Speed 
Chip

- 60 (co-product 
supply)

- -

Low Speed Chip - 40 (co-product 
supply)

- -

Demand for Fast 
Wafer

0.01 -1 - -

The planning engine can use alternate bill of material/routing pairs to resolve resource 
and material constraints. It may partially satisfy a later demand with a co-product 
produced from supply from an earlier demand, and then satisfy the remaining quantity 
with a later supply against that co-product. For example:

• Medium Speed Chip has demand due for quantity 60 on day 1

• High Speed Chip has demand due for quantity 100 on day 2

The planning engine creates a planned order against Medium Speed Chip, the first 
demand, for quantity 60 on day 1 using bill of material/routing pair ALT2. This 
production should create a co-product supply against High Speed Chip for quantity 10 
on day 1. The planning engine then creates a planned order against High Speed Chip 
for quantity 90 on day 2.

Item Percent/Quantit
y

Day 1 Day 2 Day 3

High Speed Chip 10% - -100 -



19-86    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Item Percent/Quantit
y

Day 1 Day 2 Day 3

Medium Speed 
Chip

60% -60 - -

Low Speed Chip 30% - - -40

High Speed Chip - 10 (co-product 
supply)

90 (planned 
order)

-

Medium Speed 
Chip

- 60 (planned 
order)

540 (co-product 
supply)

-

Low Speed Chip - 30 (co-product 
supply)

270 (planned 
order)

-

Demand for 
Medium Wafer

0.01 -1 -9 -

Requirement Integer Quantities
You can instruct the planning engine to round dependent demand quantities for 
components; see Requirement Integer Quantities in Items on page 1-1.

If you instruct the planning process to round all the items in a multiple co-product 
relationship either up or down, the results may show a difference between total supply 
quantity and total demand quantity among the items.

To avoid this, in Oracle Shop Floor Management (OFSM), specify one of the co-products
as the primary co-product. The planning engine increases the primary co-product 
requirements and decreases the other co-product requirements to balance the rounding.
It creates at least a quantity of 1 for each co-product 

This diagram shows a co-product bill of material.
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Co-product Bills of Material

All co-products are marked Enforce Integer Req either Up or Down.

The planning engine receives demand for 25 C933.

It calculates requirements for X as 42 [25 * 0.6 = 41.666, round to 42].

It calculates requirements for the co-products:

• C633: 2.49 [41.666 * 0.06]

• C800: 3.74 [41.666 * 0.09]

• C866: 10.41 [41.666 * 0.25]

• C933: 25

It rounds down requirements for the co-products:

• C633: 2

• C800: 3

• C866: 10

• C933: 25 

It calculates the difference between demand and supply as 2 less demand than supply 
[42 - (25 + 10 + 3 + 2)].

It increases the primary component by 2 to make the co-product requirements equal the
supply of 42:

• C633: 2

• C800: 3
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• C866: 12

• C933: 25 

If the demand is for the primary co-product, the planning engine rounds down all of the
other co-products and randomly selects one of them to increase to balance supply and 
demand. It does not increase the primary co-product.

Operation Yield 
If you can attribute significant amount of materials loss to a specific production process,
then identifying the process and managing the yield at an operation level is essential. 
Yields specified at operation sequence is often needed to calculate the amount of raw 
materials or sub assemblies and measure performance. 

Consider a production process as described in the diagram below. 

Production Process

In order to calculate raw materials needed at the start of each operation, cumulative 
yields, reverse cumulative yields, and net planning percentages need to be calculated. 
The diagram above shows you the calculations. Cumulative Yields are shown as CY, 
Reverse Cumulative Yields are shown as RCY, and Net Planning Percent is shown as 
NPP on the diagram. Net Planning Percent is the expected percentage of the flow of 
materials at a given node. Cumulative yield is the multiplication of yields in the 
forward direction. Reverse Cumulative Yield is the multiplication of yields in the 
reverse direction. Please refer to the diagram above for detailed calculations. 

You can specify the yields at operation sequence level in the Network Routings using 



Integrating with Planning and Manufacturing Environments    19-89

Oracle OSFM. The system can automatically calculate Cumulative Yields, Reverse 
Cumulative Yields, and Net Planning Percentages by using Calculate Cumulative Yield 
from the Tools menu on Network Routing form. 

If you use the Planned percent or Optimize methods, run Oracle Shop Floor 
Management (OSFM) concurrent process Calculate operation yields from the routings 
on the source. The planning engine calculates the reverse cumulative yield values for 
every order to account for time phased yields and needs Net Planning % from the 
source in the calculation.

Operation Yield Support in Order Promising
Oracle Global Order Promising considers operation yield when calculating component 
and resource requirements during capable-to-promise. The calculation is the same as in 
ASCP.

Operation Yield Support in Planning
If you need to calculate materials needed at operation sequence 10, you need to divide 
the order quantity by Reverse Cumulative Yield and multiply it by Net Planning 
Percent at Operation sequence 10. 

If you need item A at operation sequence 10, and you have an order quantity of 100, the 
component demand for A should be 100/.88*100%, which is 113.63. Oracle ASCP 
consumes resources at various operation sequences based on the inflated order quantity
which accounts for the operation yield. In our example, resources at operation sequence
10 are scheduled for a quantity of 113.63. 

If you decide to scrap or reject some of the items on a Lot-Based Job, you can apply 
yields for the rest of the pending operations. If you reject 20 units out of a total order of 
100 at Operation sequence 20 and assume that there were no losses at operation 
sequence 10, you can determine the component requirements based on a quantity of 80 
and the reverse cumulative yield at operation sequence 20.

If you have network routings where you have multiple nodes joining a single node, the 
cumulative yield calculation is based on the weighted average of the yields from the 
nodes that join to form a single node. 

Operation Yield and Discrete Jobs
The planning engine reduces component and resource requirements for future 
operations based on the operation yield defined in the discrete routing. The supply 
quantity for the job or planned order are also reduced based on the anticipated yield 
loss at future operations.

For accurate costing with operation yield, consider using Oracle Shop Floor 
Management.

Considering operation yield for existing discrete jobs improves the planning response 
time in recognizing the effect of actual yields on existing jobs. The operation yields 
defined in the routings are estimates. When the actual scrap transactions occur, the 
planning engine considers the current job quantity and the future planned yield loss to 
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determine the reduced supply quantity. This dynamic recalculation of the supply 
quantity allows Oracle Advanced Supply Chain Planning to calculate future planned 
order quantities more accurately.

It also improves the planning accuracy by estimating the effect of yield loss on:

• Supply quantity, which improves visibility to Oracle Global Order Promising and 
the planner of the effect of operation yield on existing jobs.

• Component requirements, which lowers inventory by more precise calculation of 
component requirements for later operations.

• Resource requirements, which improves the ability to implement constrained 
planning

If an item's routing has yield loss for any operation, the planning engine:

• Recalculates the component and resource requirements of a WIP job during data 
collection to reflect the current position of the WIP job (operation and 
inter-operation step) and the operation yield loss for the remaining operations.

• Calculates the supply quantity based on the current quantity and position of the job
and the reverse cumulative yield still to be considered at future operations. The 
planning engine does not calculate the WIP job supply quantity as MRP Net 
Quantity - Completed Quantity - Scrapped Quantity. 

If an item's routing does not include planned yield loss for any operation, then the 
component and resource requirements are collected and used by Oracle Advanced 
Supply Chain Planning.

Calculating Scheduled Quantity and Supply Quantity

The scheduled quantity at every operation is reduced by the estimated yield loss at the 
previous operation. Since, the component and resource requirements are calculated 
using the operation scheduled quantity, these are also reduced to the quantity expected 
at that operation.

The job's supply quantity is also reduced to account for operation yield at all planned 
operations.

For planned orders, the operation yield is taken into account by increasing the job start 
quantity and the scheduled quantity at each operation.

For discrete jobs,

Scheduled quantity = Sum (quantity at Queue, Run, and previous operation To Move) + 
(Scheduled quantity from previous operation x operation yield from previous 
operation)

Therefore, if a routing has operation yield, the planning engine calculates the scheduled
quantity instead of using the discrete job values.

This table shows scheduled quantity calculations for a discrete job example. You can see
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material requirement calculations for the same discrete job example in section 
Calculating Material Requirements and resource requirement calculations for the same 
discrete job example in section Calculating Resource Requirements. 

Operation 
Number

To 
(Q)ueue / 
(R)un / 
(M)ove

Quantity 
Completed

Quantity 
Scrapped

Operation 
Yield (%)

Reverse 
Cumulativ
e Yield (%)

Scheduled
Quantity

10 - 100 - 100 72.9 0

20 20 (M) 100 50 90 72.9 0

30 15 (R) 15 10 100 81 35

40 3 (Q), 2 (M) 2 - 90 81 38

50 - - - 100 90 36.2

60 - - - 90 90 36.2

70 - - - 100 100 32.58

Calculating Material Requirements

The material requirements is calculated as:

Quantity required = min ((scheduled quantity + quantity completed) * usage - quantity 
issued, 0)

During for material requirements calculations, users can manually issue materials to 
jobs using the Material Requirements window. Therefore, the quantity of components 
calculated for each operation takes quantity issued into account.

This table shows material requirement calculations for the discrete job example in 
section Calculating Scheduled Quantity and Supply Quantity. You can see resource 
requirement calculations for the same discrete job example in section Calculating 
Resource Requirements. In this table:

• The issue of component A at operation 10 is an over-issue caused by breakage 
(component yield)

• The issues of component B at operation 20 and component D at operation 40 are 
manual under issues. Similar under issues could occur in any component with type 
Assembly pull.

• The issue of component E at operation 60 has been performed in advance
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Operatio
n 
Number

Schedul
ed 
Quantity

Quantity 
Complet
ed

Compon
ent

Usage Quantity 
Issued

Quantity 
Required

Open 
Require
ment

10 0 100 A 1 120 100 
[0+100)*1]

0 
[Max(100
-120,0)]

20 0 100 B 1 0 100 
[0+100)*1]

100 
[100-0]

30 35 15 C 1 15 50 
[(35+15)*1
]

35 [50-15]

40 38 2 D 1 11 40 
[(38+2*1]

39 [40-1]

50 36.2 - - - - - -

60 36.2 - E 1 30 36.2 
[36.2*1]

6.2 
[36.2-30]

70 32.58 - - - - - -

Calculating Resource Requirements

The resource requirement calculation for item basis is

Resource requirements (operation) = max (((scheduled quantity (operation) + quantity 
completed) * usage - applied resource hours), 0)

The resource requirement calculation for lot basis is

Resource requirements (operation) = usage - applied resource hours

This table shows material requirement calculations for the discrete job example in 
section Calculating Scheduled Quantity and Supply Quantity. You can see material 
requirement calculations for the same discrete job example in section Calculating 
Material Requirements
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Operati
on 
Number

Schedu
led 
Quantit
y

Quantit
y 
Comple
ted

Resour
ce

Usage Basis Applies
Hours

Hours 
Require
d

Open 
Hours 
Require
d

10 0 100 R1 1 Item 100 100 0

20 0 100 R2 1 Lot 1 1 0

30 35 15 R2 1 Item 15 50 
[(35+15)
*1]

35 
[50-15]

40 38 2 R2 2 Lot 2 2 0

50 36.2 - R3 1 Item - 36.2 36.2

60 36.2 - R3 1 Item - 36.2 36.2

70 32.58 - R3 1 Item - 32.58 32.58

To use Operation Yield for Discrete Jobs

1. Navigate to BOM > Routing.

2. Enter yield for specific operations.

3. Navigate to Workbench > Items. 

4. Click the Routing Operations button.

5. View the operation yield for the routing.

6. Click the Resources button.

7. In the Resources window, click the Requirements button.

8. View the current quantity at each inter-operation step.

For more details on the information displayed in the Resource Requirements 
window, see Resource Requirements Window, page 18-134

The Resource Requirements window only displays operations that have scheduled 
resources where the resource schedule attribute is set to Yes. If the WIP job is in an 
operation with no scheduled resources, the job is scheduled correctly but you 
cannot view the quantity at the inter-operation step on the Resource Requirements 
window.
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Network Routings
Alternate ways of producing an item often demands flexible definition of Routings. 
Network Routings give you the flexibility of defining multiple manufacturing paths. 
Network Routings are defined using Oracle OSFM at the source. When you set up 
Network Routings, you can specify the estimated percentage of the orders that need to 
be processed on a specific path. This is called the planning percent. 

Network Routing Support in Planning
You can collect the Network Routings into the planning server using the APS Collection
program. You can snapshot the Network Routings and use them to calculate and 
schedule resource requirements for existing Lot-Based Jobs and planned orders when 
you run a plan. You can choose to schedule orders using Network Routings with the 
primary path:

To make your selection, navigate to form Setup and Use Parameters and set OSFM 
Network Scheduling Method to Primary

This diagram shows Network Routings.

Network Routing

Primary Path (default)

As the name suggests, you can schedule orders on primary path. In this case, Oracle 
ASCP calculates the Reverse cumulative yields and Net Planning Percent based on the 
Primary path. 

The following situations constitute an incomplete network routing and may affect plan 
results:

• You have a network routing, use a bottleneck resource group, and do not include at 
least one resource on the bottleneck resource group.

• You turn off scheduling for all resources at an operation and then instruct network 
routings to use this operation.
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The resource hours calculation is subject to profile option MSO: Floating Point Precision
for Usage in Routings. For example:

• The routing for an item uses a resource for 0.05 hours per piece or 3 minutes per 
piece - Efficiency and utilization are both 90% 

• A supply order for quantity 680 is scheduled on that resource

• The expected resource consumption is 34 hours [680 pieces * 0.05 hours per piece]

• MSO: Floating Point Precision for Usage in Routings is 100

• The planning engine calculates the resource requirement considering utilization 
and efficiency as 41.933333:

• Resource requirement for one piece: 3.70 minutes with precision factor 100 [3 / 
(0.9 * 0.9)]

• Resource requirement for 680 pieces: (3.70 * 680) / 60

• MSO: Floating Point Precision for Usage in Routings is 10,000 

• The planning engine calculates the resource requirement considering utilization 
and efficiency as 41.975266::

• Resource requirement for one piece: 3.7037 minutes with precision factor 10,000
[3 / (0.9 * 0.9)]

• Resource requirement for 680 pieces: (3.7037 * 680) / 60

• MSO: Floating Point Precision for Usage in Routings is 1,000,000 

• The planning engine calculates the resource requirement considering utilization 
and efficiency as 41.975300 :

• Resource requirement for one piece: 3.703703 minutes with precision factor 
1,000,000 [3 / (0.9 * 0.9)]

• Resource requirement for 680 pieces: (3.703703 * 680) / 60

Network Routing Support in Order Promising
Global Order Promising considers net planning percent (NPP) when it calculates 
resource and material requirements during capable-to-promise. In the diagram above, 
the resource and material requirement needed at node 30 is: Order Qty * RCY * 0.8 
(NPP) * Qty Per Assembly.
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Future Operation Details
The integration with planning provides an option of storing the future operation details
for a specific lot based job. The details for future operations can be updated for specific 
jobs in Oracle ShopFloor Manufacturing (OSFM). Oracle Advanced Supply Chain 
planning then utilizes the future operation details from the specific shop floor job 
during planning.

When you create a lot-based job, it receives its own copy of the network routing with 
the following details:

• All possible network flows. This data exists for future operations from the current 
operation. All routing information associated with the operation such as operation 
yield and planning percentage are stored in the job details.

• All possible alternate resources

• All possible substitute components

• The recommended network flow, resources, and components to be utilized

• The schedule date for the resources on the recommended path

You can update the recommended path for the specific job in Oracle ShopFloor 
Manufacturing (OSFM). It ensures that a complete recommended path exists for the lot 
based job. The planning engine interprets this as the primary path for the specific job 
and utilizes it for this job in the next planning cycle.

The planning engine releases scheduling details to Oracle ShopFloor Manufacturing 
(OSFM) for the primary path. This includes the recommended schedule dates, 
resources, and components. You can update the details to reflect decisions made for the 
specific job. For rescheduling existing jobs, the planning engine utilizes the updated 
information of the operation yield, recommended components, and recommended path.

Certain planning capabilities work with Oracle ShopFloor Manufacturing (OSFM) You 
can:

• Provide alternate resources for future operations of an existing job. This affects 
constrained plans only.

• Apply order modifiers to either the start quantity or the completion quantity for 
planned orders.

• Consider the current operation's resources as firm according to Firm Type of each 
resource (when profile option WSM: Create Job Level BOM and Routing Copies is 
Yes. If the job is in the inter-operation run step, the current operation is considered 
as Firm All (firm Start Date, End Date, Resource, and Assigned Units) . The 
planning process uses Firm Type in its scheduling for constrained plans only. For 
example, if the resource is Firm Start Date, the planning engine does not reschedule 
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the start date but the scheduling process may move the end date.

To set up future operation details
1. Navigate to Supply Chain Plan > Setup > Parameters.

2. Set the organization's planning method to primary path.

If you set the planning method to Planned percentage or Optimize, the planning 
engine schedules quantities on all possible paths. This may not be useful for 
detailed scheduling because the shop floor usually executes only one path.

3. Set the profile WSM: Create Job Level BOM and Routing Copies to Yes to control 
whether job details are stored on the shop floor job.

This profile option setting effects all shop floor organizations. You can select only 
one behavior for your business. For multiple source instances, you must use the 
same behavior for all shop floor organizations.

4. Ensure that the job's completion date is within the daily bucketed horizon.

5. Set the following profile options to suit your business requirements:

• MSC: Legacy Collections Using Lot Based Job Details

• MSC: Apply Order Modifier to Start Quantity

• MSC: Release WIP Dtls if Order Date different then BOM Revision Date

• MSC: Released Only By User

• MSC: Inflate WIP Resource Requirements

For more details on the above profiles, see MSC Profile Options, page A-13.

To use future operation details
In Oracle Advanced Supply Chain Planning, you can release details for planned orders 
and for reschedules. If the planning method is set to primary path and the job is 
scheduled to complete within the daily planning horizon, then the planning engine can 
release details to Oracle ShopFloor Management (OSFM).

1. Release discrete jobs and planned orders in Planner Workbench

You can update the order details for the planned orders using the Release 
Properties tab of the Supply/Demand window. If you change the quantity or date 
for a planned order, the order details do not reflect these decisions and are not 
released. The planning engine then releases the job header information only and 
Oracle ShopFloor Management (OSFM) explodes the bills of material and routing to
provide the details.
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If you firm the resource of a job in the Oracle Advanced Supply Chain Planning 
Planner Workbench Resource Requirements window, the release process transfers 
Firm Type to the Oracle Shopfloor Management (OSFM) job.

2. To view the operation details, navigate to OSFM > Lot Based Job.

3. Query the job.

4. Select Tools > Plan Details.

The Plan Details page appears.

5. To view and update the yield for a specific operation, click the Details icon at the 
end of the operation row.

6. To view and update a resource for a specific operation, drill down to operation 
details to view the primary and alternate resources.

7. Navigate to OSFM > View Resource Scheduling.

8. Define your Preferences to specify the resources that you want to view. The 
resources are displayed based on the amount of time they are utilized by existing 
jobs.

View supplies that are utilizing a resource and resource overloads.

9. Select the job in the Gantt chart, right-click, and select Choose Alternate Resources.

10. Select the supply, then right-click to select the alternate resource.

This updates the copy stored on the job that this resource is recommended. The 
planning engine then utilizes this as the primary resource in subsequent plans.

11. To view and update component requirements, select the Components subtab in the 
Plan Details > Operations page.

12. Query the job name.

13. Drill down to review component details.

14. Change the component requirements and select the substitute component to be 
used.

When you change the component requirement at an operation, the component yield
is updated to reflect your desired change.

You can also update the components required for the current operation using the 
Material Requirements form.

15. To update the recommended path, navigate to OSFM > Run Requests > Refresh 
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Open Jobs Copies.

This is interpreted as the primary path for this specific job. Oracle Advanced 
Supply Chain Planning utilizes the recommended path as the primary path for this 
job in the next planning cycle.

Oracle ShopFloor Management (OSFM) stores a copy of the bills of material and 
routing on the specific lot based job. If you make changes to the bills of material and
routing for existing jobs, you can update such jobs using the Refresh Open Jobs 
Copies concurrent process.

After data collection, the planning engine utilizes the job specific details that you 
have updated.

If the job is firmed, The planning engine will not change the resources. For non-firm
jobs, the planning engine may utilize alternate resources for future operations.

The planning engine uses the recommended resources from the lot based job. 

If the recommended path has changed, the planning engine may need to reschedule
all operations because the alternate path will not have any existing schedule dates 
to be firmed.

Material Planning for Oracle Complex Maintenance Repair and Overhaul
Oracle Advanced Supply Chain Planning is integrated with Oracle Complex 
Maintenance Repair and Overhaul for planning and scheduling material requirements 
that are associated with routine and non-routine maintenance requirements. Oracle 
Advanced Supply Chain Planning also takes into account integrated forecast of material
requirements from Oracle Demand Planning and safety stock demand from Oracle 
Inventory Optimization while planning for the material requirements that are linked to 
scheduled visits.

The planning engine collects all the inputs mentioned above and generates 
replenishment recommendations for moving or procuring material. These 
recommendations help you to plan materials well in advance to accommodate 
fluctuations in demand and supply for both planned (material requirements tied to 
routine maintenance) and unplanned (material requirements tied to non-routine 
maintenance) material requirements. You can also maintain optimum stock to meet 
specific service levels under the defined inventory budget constraints.

When a material requirement cannot be met, the planning engine generates an 
exception. Oracle Advanced Supply Chain Planning allows you to send back the 
recommended dates and the exceptions back to Oracle Complex Maintenance Repair 
and Overhaul.

To plan for Complex Maintenance Repair and Overhaul operations:
Oracle Advanced Supply Chain Planning allows you to perform the following material 
planning functions:



19-100    Oracle Advanced Supply Chain Planning Implementation and User's Guide

1. Navigate to Supply Chain Plan > Names to create or modify a supply chain plan.

2. Specify the following plan options in Plan Options > Organization tab: 

1. In the Global Demand Schedules region, select the names of either global or 
local (organization specific) demand planning scenarios that drive the plan.

2. In the Organization region, select the Include Sales Order check box to include 
the material requirements, which are associated with scheduled visits in 
Complex Maintenance Repair and Overhaul. These consume the total material 
requirements forecast from Oracle Demand Planning.

3. In the Demand Schedules region, specify the Inventory Optimization plan, 
which contains the safety stock targets prescribed by Oracle Inventory 
Optimization in response to the forecast and forecast variability output from 
Oracle Demand Planning.

3. Navigate to Collections > Oracle Systems > Standard Collection to run collections.

The Planning Data Collection window appears.

4. Select the Parameters field for the Planning Data Pull program. 

The Parameters window appears. 

5. Set up the following parameters to collect data from Oracle Complex Maintenance 
Repair and Overhaul:

1. Select the applicable Complex Maintenance Repair and Overhaul instance from 
the Instance list of values.

2. Select Yes from the Sales Orders list of values.

The planning engine collects data from the following sources of demand:

3. Material requirements associated with scheduled visits from Complex 
Maintenance Repair and Overhaul. 

4. Integrated forecast of material requirements from Oracle Demand Planning

5. Safety stock demand from Oracle Inventory Optimization

6. Navigate to Supply Chain Plan > Launch to run the plan.

7. Navigate to Supply Chain Plan > Workbench.

The Planner Workbench form appears.

8. Select a record, right-click and select Supply/Demand window to view the supplies 
pegged to the Complex Maintenance Repair and Overhaul demands.
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Oracle Advanced Supply Chain Planning displays the material requirement 
associated to a scheduled visit as a sales order. These sales orders are displayed as 
firm because the visit is already planned for in Oracle Complex Maintenance Repair
and Overhaul and associated to an organization.

The sales order number is displayed as:

<visit number>.<task number>.Complex MRO

For example, if a material requirement A has:

• Visit Number = 170

• Task Number = 2

The Order Number displayed for A in the Supply/Demand window = 
170.2.Complex MRO

9. Navigate to Planner Workbench > Exception Details window. Since, scheduled visit 
tasks are modeled as sales orders in Oracle Advanced Supply Chain Planning, you 
need to view the sales order reschedule recommendations to determine how the 
material, transportation, and calendar constraints, which are considered by the 
planning engine, affect the material availability and the scheduled dates of the visit 
tasks in Complex Maintenance Repair and Overhaul.

10. Release the sales order to update the material schedule dates in Complex 
Maintenance Repair and Overhaul.

To release recommendations to Complex Maintenance Repair and Overhaul
1. Navigate to User Preferences > Other tab and select the Include Sales Orders check 

box to release the material available date of each sales order back to the Complex 
Maintenance Repair and Overhaul as the schedule date of the material requirement 
in Complex Maintenance Repair and Overhaul.

2. Navigate to Planner Workbench > Supply/Demand window.

3. Select the Release check box for the planned order that you want to release.

4. Select Plan > Release menu option.

Oracle Advanced Supply Chain Planning sends back the material available date 
calculated for that sales order to Oracle Complex Maintenance Repair and Overhaul
as the new scheduled date for the appropriate visit task.

To view the updated schedule dates in Complex Maintenance Repair and Overhaul
1. Select the Oracle Complex Maintenance, Repair, and Overhaul responsibility.
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2. Navigate to Planning > Long Term Planning > Visits.

3. Select the appropriate visit for which you want to check the scheduled materials 
and dates and click the Plan Visit button.

The Schedule Visit page appears. 

4. Select Scheduled Materials from the left-hand menu.

The Scheduled Materials page appears.

You can view the scheduled dates and quantities in this page. The exception dates 
returned by Oracle Advanced Supply Chain Planning, i.e. the dates on which the 
material is required but are not available are also displayed.

For more details, see Oracle Complex Maintenance, Repair, and Overhaul User's Guide 
and Oracle Demand Planning Implementation and User's Guide.

Integrating with Oracle Demantra Demand Management
The key elements of the Oracle Demantra Demand Management integration with 
Oracle Advanced Supply Chain Planning are:

• Collection of: data from Oracle Advanced Supply Chain Planning for Oracle 
Demantra Demand Management. This is reference data that comes to Oracle 
Advanced Supply Chain Planning from the EBS source instance using the standard 
collections or from legacy systems using legacy collections:

• Hierarchy data

• Manufacturing and fiscal calendars

• Level values for hierarchies: Product category, product family, demand class

• Level values for locations: Zone, customer class, business group, legal entity, 
sales channel

• Collection of data from the EBS source instance into Oracle Demantra Demand 
Management

• Shipment and booking data (history series data)

• Return history

• Currencies and currency conversion rates

• Units of measure and unit of measure conversions

• Price lists
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• Movement of approved final forecasts, forecast accuracy MAPE, and demand 
priorities from Oracle Demantra Demand Management into Oracle Advanced 
Supply Chain Planning:

• Local forecast: Item, organization, week

• Global zone forecast: Item, zone, week

• Local forecast with demand class: Item, organization, week, demand class

• Global zone forecast with demand class: Item, zone, week, demand class

See Oracle Demantra Implementation Guide, Demantra Demand Management to EBS 
Integration.

Integrating with Oracle Demantra Sales and Operations Planning
The key elements of the Oracle Demantra Sales and Operations Planning (S&OP) 
integration with Oracle Advanced Supply Chain Planning are:

• A seeded Demantra export integration profile to expose the Consensus Fcst series to
Oracle Advanced Supply Chain Planning.

• The ability to define in Oracle Advanced Supply Chain Planning a list of plans that 
are visible to Oracle Demantra Sales and Operations Planning. An Oracle Demantra
workflow takes a list of these eligible plans.

• A workflow that imports the following streams from a single Oracle Advanced 
Supply Chain Planning plan: 

• Planned production

• Constrained shipment forecast

• Available supplier capacity

• Required supplier capacity

• Available standard (resource) capacity

• Required (resource) capacity

• Beginning on-hand

• Dependent demand

• Planned shipments
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• Safety stock

See Oracle Demantra Implementation Guide, Demantra Sales and Operations Planning to 
Advanced Supply Chain Planning Integration.

Asset Intensive Planning
You use asset intensive planning if you have a large supply chain responsible for asset 
lifecycle management.

You have both routine and non-routine asset maintenance visits. To drive material 
through the supply chain:

• Plan for the routine assembly maintenance visits based on operational history

• Forecast demand for non-routine assembly maintenance visits and components 
(both routine and non-routine) for the disassembly based on usage history

You disassemble assets and determine the components that do not need replacement 
and the components that need replacement

For the components that need replacement, you can:

• Repair them and replace them

• Use a replacement buy item

• Use a refurbished subassembly

For the components that need repair, you can repair them:

• Internally

• Externally

Asset Intensive Planning Integration with Oracle Enterprise Asset Management
The purpose of this functionality is to plan asset intensive maintenance.

Oracle Advanced Supply Chain Planning considers the preventative maintenance 
activities managed in Oracle Enterprise Asset Management and generates the supply 
chain plan for both rebuildable and consumable items. The Oracle Enterprise Asset 
Management Maintenance Scheduler considers factors to the maintenance effort that 
Oracle Advanced Supply Chain Planning does not consider, for example, usage, meter 
readings, and calendar days.

Process Overview

Rebuildable items (rebuildables) are assets that you install, remove, overhaul, and 
reinstall, for example, engines, control boxes, and computer boards. Other components 
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that you remove, discard, and replace are consumables.

Maintenance activities, for example, inspection, overhaul, lubrication, repair, servicing, 
and cleaning, are the templates of work orders. The activities have an activity structure
—the material requirements (maintenance bill of material) and operations and resource 
requirements (activity routing) that you need to perform the maintenance.

You associate activities with assets.

The preventative maintenance scheduler uses asset and rebuildable utilization meters 
and associated activities to forecast maintenance work orders (budget forecast 
template). The maintenance work orders forecast the material, resource, and budgetary 
requirements to maintain the assets for the budget horizon.

You can also create routine work orders and easy work orders manually. Oracle Quality
and Oracle Service create work orders as well.

When you release repair work orders:

• The material and labor associated with the activity becomes part of the work orders.

• They pass to Oracle Production Scheduling for execution.

Collections: Oracle Enterprise Asset Management Rebuildable Activity Structures
Assets have Asset Type of Rebuildable Inventory.

Rebuildable items have:

• Item attribute Inventory Item selected

• User Item Type of Asset Activity 

The activity is the type of maintenance activity you are performing.

• The collections process collects items from Oracle Enterprise Asset Management 
with asset-activity type.

• The planning process plans the asset items, and you specify the activities associated
with an asset in item attribute Rebuild Activity.

You define values for activities on the source in Oracle Enterprise Asset Management 
and in the destination in Oracle Advanced Supply Chain Planning. Oracle recommends 
the values be the same in both places. 

The activity structure from Oracle Enterprise Asset Management becomes the Oracle 
Advanced Supply Chain Planning repair structure.

Collections: Oracle Enterprise Asset Management Production Work Orders
The process uses net change collections.

The process collects into order types:
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• Maintenance Work Order

• Maintenance Work Order Demand

The work orders item in Oracle Enterprise Asset Management is the activity item. In 
Oracle Advanced Supply Chain Planning, the work order item becomes the related 
inventory item of:

• For assets, Asset Group

• For rebuildables, Rebuildable Item

The process collects work order with these statuses:

• Unreleased

• Released

• On Hold

• Pending Scheduling

• Draft

The process collects these Oracle Enterprise Asset Management work order attributes:

• Rebuild or Asset Activity: The maintenance activity being executed.

• Produces to Stock: Asset work orders do not make supply, rebuildable work orders 
make supply.

• Class Code: The expense accounts for the work.

• Maintenance Plan: The forecast name of the budget forecast that this work order 
belongs to

• Activity Type: The type of maintenance activity performed

• Priority

• Project: Project and task

Collections: Oracle Enterprise Asset Management Aggregate Budget Forecasted Work Orders
Oracle Enterprise Asset Management budget forecasted work orders occur:

• In forecast sets

• When the maintenance planner assigns preventative maintenance schedules to 
assets/activities and rebuildables/activities. From these come projected material, 
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resource and budget requirements. 

The process collects them in to the same order types and collects the same work order 
attributes as the Oracle Enterprise Asset Management production work orders. 

The collections process buckets these aggregate budgeted forecasted work orders into 
one work order per period, grouped by 

• Month

• Item

• Oaganization

• Maintenance Plan

• Asset Group

• Class Code

• Produce to Stock

You can control this collection with these parameters

• EAM Forecast: To collect them, select Yes

• Start Date

• End Date

Oracle recommends that you collect budgeted forecasted orders at least up to the Oracle
Advanced Supply Chain Planning planning horizon. 

ASCP collects aggregate forecasted work orders with these key attributes:

• Rebuild or Asset Activity

• Asset Group: The item

• Class Code: The expense accounts

• Priority

• Project

• Maintenance Plan: Forecast name

The collections process uses each order start date to assign the aggregate planned repair
order to a period.

The due date of the order is the last day of that period. 
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The material and resource requirements are on the first day of that period. They include
all of the components and resources on the detailed planned repair orders. 

These work orders are firm and cannot have substitute components. 

Make Resource Unavailable
The collections process determines shut down times of the production resources that 
correspond to the assets.

Asset and Production Resource Link

Equipment items are resources. You can link an asset to an equipment item.

You identify an equipment item by:

• In EAM, Asset Number,. You do not identify it by Equipment Item nor Serial 
Number

• In ASCP, Resource Code

Shutdown Type

When your asset is not available during maintenance, ASCP can make dummy work 
orders to use up the asset resource capacity. The duration is the shutdown specified on 
the rebuild activity / operation. 

The process decides to make a resource unavailable to production scheduling by 
looking at attribute Shutdown Type. 

If it is:

• Required, the resource is not available

• Not required, the resource is available

You can enter Shutdown Type against work orders and operations:

• If you enter Required for a work order, the process ignores operation Shutdown 
Type and makes all resources available or unavailable for the time of the work 
order

• If you enter Not Required for a work order, the process ignores work order 
Shutdown Type and makes each resource available or unavailable according to 
operation Shutdown Type for the time of its operation

If the asset is available during maintenance, set the value of work order Shutdown Type
to Not Required. If the asset can generally be available during maintenance except 
during certain operations, set the value of:

• Work order Shutdown Type to Not Required

• Operations Shutdown Type to Required
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Forecast work orders do not have operations, so you cannot mark operation-level 
shutdowns. 

The shutdown duration is from Scheduled Start Date to Scheduled Completion Date. If 
the work order has started, the resource unavailability starts on Actual Start Date.

The dummy maintenance work orders:

• Have work order numbers end with –R

• Are firm

• Have no components

• Can span the time of more than one EAM work order, for example, one for battery 
change and one for daily maintenance 

Maintenance Plans
Each Oracle Enterprise Asset Management work order has attribute Maintenance Plan 
with values:

• Production for the production work orders

• <forecast name> for the budget forecast work orders

• <simulation set name> for Oracle Complex Maintenance, Repair, and Overhaul 
simulation sets

Asset Intensive Planning Integration with Oracle Complex Maintenance, Repair, and 
Overhaul

This describes integration between Oracle Advanced Supply Chain Planning and Oracle
Complex Maintenance, Repair, and Overhaul.

Planning Scope
ASCP plans material and resource supply for complex assemblies (rotable items) and 
components (repairable items) associated with:

• Routine maintenance requirements

• Non-routine maintenance requirements

• Operational visits

ASCP recognizes the defectives in the supply chain and:

• Plans repair orders based on sourcing preferences
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• Maximizes the supply from repair

• Plans and executes the repair order by recommending adequate repair orders and 
defective move orders to move defective to repair site.

• Tracks the inventory and transactions across the extended supply chain

• Uses repair lead time or a repair bill of material/repair routing to plan for the 
auxiliary materials and resources you need to perform the repair

• Considers repair constraints like yield, repair lead-time and the various transfer and
processing lead-times

• Considers the return forecast as a future repair supply

ASCP creates:

• Planned complex assembly repair orders with suggested maintenance 
organizations

• Planned component work orders with suggested maintenance organizations

ASCP

• Plans to the visit and work order priorities set in cMRO

• Looks for alternate parts

• Uses simulation sets (simulated unit maintenance plan)

Setup
Source Setups

Define rebuildable items (asset group, asset type).

Define rebuild activities.

Define rebuildable item repair yields.

Define rebuildable item repair lead times.

Define repair activity bills of material.

Define repair activity routings.

Associate rebuildable items and rebuild activities (activity type).

See Oracle Complex Maintenance, Repair, and Overhaul User's Guide Supplement.

Destination Setup

Define repair activities.



Integrating with Planning and Manufacturing Environments    19-111

Define scrap rate.

Define repair at sourcing.

Define buy from (outside processing) sourcing.

Set profile option MSC: Enable Advanced Constraints value to Yes.

Set plan option, Constrain Mode value to Constrained (without detailed scheduling). 

Collections: Oracle Complex Maintenance, Repair, and Overhaul Work Orders
The collections process collects cMRO work orders associated with visits.

The collections process collects cMRO work orders with these types:

• Unreleased 

• Released

• On Hold

• Parts Hold 

• Pending QA Approval

• Pending Deferral Approval

• Pending Scheduling

• Import

The collections process collects into these ASCP order types:

• Supply: Maintenance Work Order

• Demand: Maintenance Work Order Demand

It collects cMRO Visit attributes:

• Visit: An asset and work orders to accomplish a set of maintenance tasks

• Produce To Stock: Work orders that produce supply

• Produce To Stock: Work orders that produce supply

• Operating Fleet: A group of assets used to define a fleet management program

• Maintenance Plan: Primary Plan, or the name of a simulation plan
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Collections: Oracle Complex Maintenance, Repair, and Overhaul UMP Aggregate Work Orders
The collections process collects and aggregates cMRO UMP requirements that the 
collections process brings into ASCP as work orders.

The collections process buckets these aggregate work orders into one work order per 
period, grouped by:

• Month

• Item

• Organization

• Maintenance Plan Primary

• Maintenance Requirement

• Operating Fleet

• Produce to Stock

The collections process uses order due dates to assign them to periods The due date of 
the aggregate orders is the last day of that period.

The material and resource requirements are due on the first day of that period. They 
include all of the components and resources on the detailed work orders. The UMP 
aggregate work orders do not have substitute components.

Do not release these work orders.

Use these collections parameters to control the collections process for them: cMRO 
Forecasts: Select Yes to collect them

• Start Date

• End Date

Asset Intensive Planning Strategy
This describes Oracle Advanced Supply Chain Planning processing.

Overview
The strategy of planning for supply of repair and rebuildable items is to:

• Issue the items for repair or rebuild

• Create supplies of the repaired and rebuilt items

The planning process, for EAM:
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• Collects rebuildable activity structures

• Collects production work orders

• Collects forecasted work orders

• Plans repair work orders for rebuildable items and purchase requisitions for 
consumable items.

The planning process, for cMRO:

• Collects work orders

• Considers collected cMRO work orders as firm, except for substitute items

• Balances supply and demand for the visit schedule and unit maintenance plans for 
items with attribute Produces to Stock set to Yes

• If there is not sufficient component material or resources to satisfy all maintenance 
work order demands on time, satisfies the higher priority work orders first and may
satisfy lower priority work order demands late. 

• If cMRO reserved items for a visit work order, applies the reservations to the 
planned maintenance work orders. 

• Releases planned repair work orders to cMRO

Release planned transfers of defective and usable items as internal requisitions / 
internal sales orders

Releases planned buy orders as purchase requisitions

In Oracle Advanced Supply Chain Planning, to select the work orders for the planning 
process to use, select them in plan option Maintenance Work Orders.

You perform asset intensive planning using a constrained plan. 

You cannot use batch plan and online replan. 

Usable vs Defective
The planning process uses items in:

• Usable subinventories as sources for good items

• Defective subinventories as sources of defective items to repair into usable items

Make at orders have demands for usable components.

Repair orders have demands for usable and defective components.

The planning engine decides whether material is usable or defective based on the 
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subinventory Default Locator Status.

Material that is in or is going to subinventories with these locators is defective: 

• Unserviceable

• Unserviceable: Not Available for Netting, ATP and Reservations

• MRB Review

• QC Hold

• Quarantine

You can mark Oracle Service Parts Planning Condition Type to Defective as well.

Sourcing Rules and Assignment Sets
Make different sourcing rules for defective items and usable items so that the defectives 
go to appropriate repair organizations and subinventories.

Repair at

Repair at sourcing rule indicates that you repair the item at the organization.

Assign the repair at sourcing rule to organizations where you perform repairs, either at 
instance-org level or item-instance-org level.

The assignment set Condition is the condition of the repairable at the end of the process.
Set it to Usable.

Transfer from

When you use transfer from sourcing rules to get material to a repairable facility, set its 
assignment set Condition to Defective. 

Removals Forecast
Any components of repair or maintenance work orders may be defective.

The planning process looks at all cMRO work orders that have a demand for a 
rebuildable item. When you installing the rebuildable item you remove a defective item 
for repair. The planning process uses these defective component requirements to create 
a removals forecast.

To mark a component as repairable, set destination item attribute Repair Module to 
EAM or CMRO. This tells the planning engine which application manages the item's 
maintenance.

It aggregates the information for each item as a removals forecast. To see this, select 
plan option Derive Returns Forecast from Work Orders.

The planning process groups the removal forecast by item, organization, and date.

Legacy Reverse Supply Chain Planning
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If you use legacy collections, you can collect a returns forecast (legacy reverse supply 
chain planning). It goes into order type Returns Forecast at the organization level. In 
plan options, organizations tab, specify the return forecast name. 

Order Types
These order types relate to asset intensive maintenance: 

• Planned Repair Work Order

• Maintenance Work Order

• Maintenance Work Order Demand

• Part Demand

• Planned Part Demand

• Returns Forecast

• External Repair Order

Scrap Rate and Repair Yield
Scrap rate (item organization item attribute) is the typical percentage of removals that 
are unrepairable defectives--repairable components that you scrap before putting them 
into subinventory 

The repairable returns = [Returns Forecast * (1 – Scrap Rate)] 

Repair yield (item attribute) is the typical percentage of repairable returns that you 
typically successfully repair. You can specify it in the source instance, the destination 
instance, or a simulation set.

The planning engine calculates the number of defectives you need to produce one unit 
of usable item [1 / repair yield]. It matches with the supply of defectives calculated 
using the returns forecast and the scrap rate (the repairable returns).

The quantity of the repairable component is [Work order quantity * (1 – Scrap Rate) * 
Repair Yield].

The repair yield applies to repairable components, not to consumable components--they
use the make component scrap and yield item attributes. 

The maximum number of usable parts that the repair process can create is Onhand + [(1 
– Scrap Rate) * Repairable Returns]] * Repair Yield

Planned Repair Orders
Repair orders are similar to make orders except:
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• Their sourcing is Repair at

• The defective items are components

• The usable item is the repaired assembly 

The repair structure does not have the defective component in it; the planning process 
creates it when it sees a Repair at sourcing rule.

If there is no repair structure, the planning process creates a repair work order without 
it.

It:

• Calculates the lead time from the routing. If there is no routing, it uses the value in 
item attribute Repair Lead Time. You can enter lead time in a simulation set as well.

• Plans the due date of components according to their offset percents. It loads the 
defective component to the first operation.

• Plans resources by their offset percents

• Plans for substitute components and alternate bills of material and routings

If you mark an asset as an outsourced assembly and a buy item, the planning engine 
plans a buy order against your manufacturing partner. 

If you transfer your defective parts to other organizations for repair, the planning 
process plans the transfers.

The planning engine considers maintenance orders as firm. It: 

• Does not recommend reschedule or cancel them

• Does recommend component substitutions

For each planned repair order, the planning engine looks at item attribute rebuild 
activity and uses its bill of material and routing to:

• Create component demand for defectives of the planned repair work order item

• Add consumable component demand from the repair bill of material

• Add the routing information from the repair routing

• Account for the repair yield

It combines planned repair orders for the same date into a single order. 

For duration, the planning engine uses the rebuild activity operation durations. If there 
are no operations, it uses item attribute Repair Lead Time.

The planning process uses item attribute Repair Lead Time--when there is no 
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routing--to determine when you need the defective component. You can set it in the 
destination instance at the organization level or in a simulation set. The simulation set 
overrides the destinations instance setting.

Aggregate Collected Work Orders
Aggregate collected work orders aggregate these production and forecast maintenance 
demands into monthly buckets:

• cMRO Visit Work Orders – Production

• cMRO Unit Maintenance Plan – Forecast

• eAM Production

• eAM Budget Forecast

You set plan option Maintenance Work Order Aggregation Horizon to Aggregate

Before the start of the aggregation horizon, the planning process does not further 
aggregate the collected work orders.

Within the aggregation horizon, the planning engine aggregates the collected forecasted
work orders and production work orders.

It aggregates cMRO forecasted and production work orders based on these attributes: 

• Month

• Item 

• Organization

• Maintenance Plan

• Maintenance Requirement

• Operating Fleet

• Produce to Stock

It aggregates EAM forecasted work orders based on these attributes:

• Month

• Item

• Organization

• Maintenance Plan
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• Asset Group

• Class Code

The planning process uses order due dates to assign the aggregate planned repair 
orders to periods.

The due date of the order is the last day of that period.

The material and resource requirements are on the first day of that period.

They include all of the components and resources on the detailed planned repair orders.

Internal/External Repair Decision
You can assign sourcing rules to model your internal/external repair business model.

When the planning process cannot meet repair demands on-time, it suggests outside 
processing (external repair) for them and creates a planned purchase requisition. You 
must set up outside processing. 

The planned repair order has no bill of material and routing. 

See Outside Processing. 

Project/Task Planning
The planning process links the maintenance work order to a project and task. 

Maintenance work orders that you assign to a project/task generate dependent 
demands assigned to the same project/task. The planning process pegs these dependent 
demands to supplies based on your choice of plan options Reservation Level and Hard 
Pegging Level. 

Buy orders that the process associate with the work order have the same project and 
task reference.

The project cost collector process passes these costs to the work order's project work in 
process accounts, rather than the accounts associated with the asset or organization.

If you use Seiban numbers, the Seiban number is a project number in ASCP. To instruct 
the planning engine to peg on hand lots, purchase orders, and work orders to specific 
demands based on the Seiban numbers, set Reservation Level to Project. 

Exception Messages
In context window Exception Details, you can see Part Condition.

These are the exception messages that the planning engine issues in asset intensive 
planing situations. See Understanding Exceptions, page 17-14:

1. Material and Resource Capacity Exception Group > Late replenishment to 
maintenance work order demand 
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2. Material and Resource Capacity Exception Group > Maintenance work order 
resource overload 

3. Substitutes and Alternates Used Exception Group > Work order uses substitute 
component 

4. Shortages and Excess Exception Group > Items with a shortage

5. Shortages and Excess Exception Group > Items with excess inventory

6. Shortages and Excess Exception Group > Items below safety stock

Planner Workbench
The context windows Supply, Demand, Supply/Demand and Onhand show these order
attributes for cMRO work orders and you can filter on them

• Visit

• Produce to Stock

• Maintenance Requirement

• Operating Fleet

• Maintenance Plan

The context windows Supply, Demand, Supply/Demand and Onhand show these order
attributes for EAM work orders and you can filter on them:

• Part Condition

• Produce To Stock

• Activity Type

• Activity Name

• Class Code

• Asset Group

• Maintenance Plan: Production for production work orders

The context windows Horizontal Plan and Vertical Plan show these order types:

• Planned Repair Work Order

• Maintenance Work Order
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• Maintenance Work Order Demand

• Part Demand

• Planned Part Demand

• Returns Forecast

• External Repair Order

You can select them in the Plan Preferences. 

The context window Horizontal Plan shows these calculations:

• Defective On-Hand

• Defectives In-Transit

• Projected Available Balance (Defective)

You can select them in the Plan Preferences. 

The context window Horizontal Resource Plan shows these order types: 

• Planned Repair Work Orders

• Maintenance Work Orders

You can select them in the Plan Preferences 

The pegging tree Properties window shows these order attributes: 

• Operating Fleet

• Maintenance Requirement

• Class Code 

• Asset Group

If you manually enter a planned repair work order, update these fields:

• Org

• Item

• Order Type

• New Date

• New Qty
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Recipe Information

Context windows Supply/Demand and Process Effectivity show Oracle Process 
Manufacturing recipe, formula, and routing information. Field:

• Alternate Bom displays recipe/version and formula/version, for example, 
RITUXAN/1, RXNFORMULA/1

• Alternate Routing displays recipe/version and formula/version, for example, 
RITUXAN/1, RXNROUTING/1

Planned Repair Order Release
You can release recommendations to cMRO, EAM, or Legacy. Specify which one in item
attribute Repair Module. You must specify a simulation set in plan options Item 
Simulation Set for the planning process to assign a repair module. 

When you release a repair work order for EAM:

• The material and labor associated with the activity becomes part of the work orders.

• They pass to Oracle Production Scheduling for execution.

When you release a planned repair work order for cMRO, the release process 
implements it as a planned repair work order with a suggested organization to perform 
the repair.

If you select Legacy, use Feed Work Order Supplies to feed back the legacy work in 
process supplies to ASCP. 

Resource Information Feedback
You can send resource availability information from ASCP to cMRO.

In plan options, aggregation tab, set Items to Item and Resource to Individual.

This process involves maintenance work orders, it does not involve forecasted work 
orders. 

To enable it automatically at order release, set plan launch option Publish Resource 
Capacity to CMRO.

To run it as needed, start concurrent process Load Net Resource Availability from 
Planning to CMRO. 

It sends resource availability from the plan name specified in the profile option MSC: 
Plan Name for CMRO to cMRO

cMRO uses this information and resource usage information from Oracle Work in 
Process to show available slots for scheduling new maintenance work orders. 
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Outside Processing
You can source for outside processing in these ways:

• Proportional sourcing: From internal and external repair sources, for example, 80% 
internal and 20% external

• Rank based sourcing: Internal is rank 1 and external is rank 2

• Combination repair and new buy: For example internal repair is rank 1, new buy is 
rank 2, and external repair is rank 3

Outside processing entities are:

• Sales Order: Demand for the defective item and its shipment from the maintenance 
organization to the outside processing supplier 

• Purchase Order: Purchase of the outside processing service. This does not apply to 
non-asset intensive planning.

• RMA: Supply of a usable (repaired) item and its return to the maintenance 
organization. The order type is External Repair Order. The planning process sees 
these as firm supply orders.

Do not use outside processing when, during a visit, you decide to send an item for 
outside processing. 

Oracle recommends that you model an outside processing department and resource in a
separate organization. You do not have to mark it as an external organization.

If you do, you can see the ASCP recommended planned external repair work orders 
separately from the ASCP recommended internal repair work orders in the cMRO 
Planning Workbench. The external repair order supplies and sales order demands also 
appear there.

In these Planner Workbench context windows, the RMA supply shows as order type 
External Repair Order:

• Supply, Demand, Supply/Demand

• Horizontal Plan

• Vertical Plan

• Enterprise Plan

Integrating Oracle Production Scheduling
Oracle Production Scheduling enhancements and updates support Production 
Scheduling integration with Oracle Enterprise Asset Management (eAM) and Oracle 
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Complex Maintenance Repair and Overhaul (cMRO). For more information, refer to 
Setting Schedule Options, page 20-20. 
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20
Integrating Production Scheduling

This chapter covers the following topics:

• Overview

• Running Production Scheduling with ASCP

• Running Production Scheduling in Standalone Mode Without ASCP

• Setting Profile Options for Production Scheduling

• Setting Resource Parameters for Production Scheduling

• Setting Up Batchable Resources

• Setting Forecast Priorities

• Using Replacement Groups as All-of-Sets

• Running Collections

• Creating a Schedule

• Setting Schedule Options

• Running a Schedule from the Workbench

• Submitting Model Generation

• Integrating to Production Scheduling

• Copying a Schedule Within Production Scheduling

• Publishing a Schedule

• Running Production Scheduling as a Service

• Feeding a Production Schedule Back into ASCP

Overview
Oracle Production Scheduling (PS) enables production schedulers to create detailed 
finite capacity and materially constrained optimized production schedules to drive 
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shop floor execution and material planning. Production Scheduling uses a 
constraint-based approach to automated scheduling. Unlike traditional automated 
scheduling tools that are limited to simple dispatch rules and have known bottlenecks, 
constraints in Production Scheduling can be assigned to every element - resources, 
operations, and due dates in a schedule. Through an advanced solver technology, 
feasible solutions can be found, if they exist, for virtually any floating constraints.

Production Scheduling can either interact only with the E-Business Suite, or 
additionally receive planned orders from Advanced Supply Chain Planning (ASCP) 
when generating detailed production schedules.

This chapter explains:

• The interaction between Production Scheduling, ASCP, and the E-Business Suite, 
and the data and process design considerations that enable a well integrated 
planning and scheduling process. 

• The configuration of the Oracle E-Business Suite to create production schedules. 

• The process of running schedules in Production Scheduling and publishing them 
back to the E-Business Suite

Production Scheduling can interact with the Oracle E-Business Suite independently, or 
in concert with ASCP. 

The graphic below shows the scope of Production Scheduling in comparison with 
ASCP.
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The objectives of ASCP and Production Scheduling are compared below:

ASCP Production Scheduling

Create New Supply Orders Schedule the supply orders that have already 
been created

Create a supply chain plan for a network of 
plants, warehouses, suppliers and customers 
in the supply chain

Create a production schedule for a single 
manufacturing facility

Plan a mid to long term horizon (for example, 
6 months to 1 year)

Schedule the short term horizon (for example, 
2 to 8 weeks)

Model aggregate level production constraints Model very detailed production constraints

Make decision on procurement - Create new 
purchase orders

Consider existing purchase orders as a source 
of supply. No new purchasing decisions taken

Running Production Scheduling with ASCP
When configured to run in concert with ASCP, Production Scheduling receives planned
orders from ASCP. Once Production Scheduling comes up with a detailed shopfloor 
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schedule, it communicates the schedule directly with the E-Business Suite and a portion
of this schedule is fed back into ASCP to constrain the subsequent run of the ASCP 
plan.

ASCP is a tactical and operational planning tool. It creates supply orders called planned
orders to meet demands that are present in the supply chain. In doing this it makes 
decisions based on:

• The size of the supply orders. Various order sizing rules can be used such as Fixed 
Order Quantities, Fixed Days of Supply, and Fixed Lot Multiples.

• The choice of alternates on the supply orders

• Alternate source facilities

• Alternate suppliers

• Alternate BOMs and Routings

• Substitute Components

• Alternate Resource
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• End Items Substitutes

The demands that Production Scheduling sees are:

• Inter-organizational transfer demands placed against the organization that is being 
scheduled by the downstream organizations in the supply chain including:

• Internal sales orders

• Planned order demands which are fed in from the ASCP plan to the production
schedule.

• Independent customer demands placed against the organization being scheduled 
including:

• Sales orders

• Forecasts

Both the sales orders and forecasts are fed in from the ASCP plan. The forecast 
quantities are reduced by the sales orders consumed in the ASCP plan.

In addition to the sales orders and forecasts from the ASCP plan, any new sales 
orders that have been collected into the planning server since the last run of the 
ASCP plan are also input into Production Scheduling provided these sales orders 
are due within the Demand Time Fence (a schedule option).

Note: Production Scheduling will not perform any forecast 
consumption for these new sales orders.

Business Process with ASCP:
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1. Run the ASCP plan. Within the planning time fence (PTF), ASCP does not create 
new orders. The existing work orders within the planning time fence are treated as 
firm in ASCP.

2. Release new orders from the ASCP plan using either a manual release process or an 
automated process. In the automated process, all work orders within the release 
time fence are released.

3. Run Production Scheduling. This process extracts the latest data from the 
E-Business Suite and ASCP:

• The work orders within the planning time fence. These work orders are not 
treated as firm in Production Scheduling unless they are manually firmed using
the Firm flag.

• The new work orders released from ASCP

• Planned orders from ASCP that exist within the scheduling horizon specified 
for the Production Scheduling schedule

4. Run various scenarios in Production Scheduling until the best schedule is achieved.

5. Approve and publish the preferred schedule to release any work order reschedules 
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and scheduled planned orders back to the execution system.

Running Production Scheduling in Standalone Mode Without ASCP
It is possible to run Production Scheduling without ASCP. When configured in 
standalone mode, Production Scheduling only schedules the work orders that it 
receives from Oracle ERP. Production Scheduling does not schedule any planned orders
because ASCP is not being used in the standalone Production Scheduling configuration.

The source of demands to Production Scheduling when running in standalone mode 
are:

• All external sales orders

• All internal sales orders

• Forecasts from a demand schedule

Production Scheduling does not perform any forecast consumption in this case. 
Forecasts are considered outside the demand time fence while sales orders are 
considered within the demand time fence.
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Note: If the total quantity of demand is greater than the total quantity 
of supply fed into Production Scheduling in the form of work orders, 
Production Scheduling will create new supplies. However it will not be 
possible to release these new supplies as new work orders into the 
execution system. 

The process for using Production Scheduling with the Oracle E-Business Suite in 
standalone mode is as follows:

1. A Production Scheduling schedule is run from the Oracle Workbench, extracting 
fresh ERP data from the E-Business Suite.

2. Within Production Scheduling, various scenarios are run until the best schedule is 
achieved.

3. The preferred schedule is approved and published back to the planning server, and 
work orders are released automatically to the E-Business Suite.

Setting Profile Options for Production Scheduling
To produce schedules based on the E-Business Suite data, you must configure the 
profile options to collect the correct information for the data snapshot. The following 
profile options must be set for Production Scheduling:

• MSC: PS - Snapshot Base Package

• MSC: PS - Snapshot Beginning Inventory Package

• MSC: PS - Snapshot Calendar Package

• MSC: PS - Snapshot Customer Package

• MSC: PS - Snapshot Distributor Package

• MSC: PS - Snapshot Enterprise Forecast Package

• MSC: PS - Snapshot Inventory Safety Targets Package

• MSC: PS - Snapshot Manufacturing Package

• MSC: PS - Snapshot Purchase Orders Package

• MSC: PS - Snapshot Sales Orders Package

• MSC: PS - Snapshot Supplier Package
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• MSC: PS - Snapshot Transfer Orders Package

• MSC: PS - Snapshot Work Orders Package

• MSC: PS Currency Symbol

• MSC: PS Resource Constraint Horizon

• MSC: PS Run Application Script

• MSC: PS Run Connector Script

• MSC: PS/SNO Alignment Date

• MSC: PS/SNO API Version

• MSC: PS/SNO Client Install Path

• MSC: PS/SNO Compress XML Package Files

• MSC: PS/SNO Data Store Path

• MSC: PS Enable CRO Scheduling profile

• MSC: PS Consistent Resource Assignment

• MSC: PS/SNO App Server URL

• MSC: PS Allow WO Purchased Item Offloading

See MSC Profile Options, page A-13 for more information about setting the Production 
Scheduling profile options.

Setting Resource Parameters for Production Scheduling
When integrating resource data, you must set up resources in Oracle EBS so that the 
data easily transfers to Production Scheduling. 

Using the Resource Parameters page, you can:

• Designate a resource as a crew, machine, or tool.

Note: When using OPM there is no distinction between machine 
and crew. All resources transfer a machines in Production 
Scheduling, unless you designate them as crew or tool on this form.

• Determine available spots for a batchable resource.
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• Determine Campaign Run Optimized properties.

• Determine offloading properties.

• Determine the inventory release interval for lot multiples.

To set resource parameters:
1. Using the Production Scheduler responsibility, select Setup.

2. Select Resource Parameters.

3. Complete these fields:

Field/Flag Description

Org Select the organization in which the 
resource is in.

Department Select the resource department.

Resource Select the resource.

Description The description is displayed from the 
resource table.

Type Select Crew, Machine, or Tool. This field 
transfers to the resource category in 
Production Scheduling.

Batchable Displays if the resource is batchable. 
Batchable resources are set up on the 
Resources page. See Setting Up Batchable 
Resources. 

This field transfers to the Batchable field on 
the Resource Properties window, Resource 
Capacity tab in Production Scheduling.

Available Spots Enter the available spots within the resource
if it is batchable.

This field transfers to the Maximum field 
within the Capacity Limits group box on the
Resource Properties window, Capacity tab 
in Production Scheduling.
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Field/Flag Description

CRO Select this check box if the resource is to be 
solved using Campaign Run Optimization. 
Only single capacity machines can be 
designated as campaign run optimized.

This check box transfers to the Use 
Campaign Run Optimization field on the 
Resource Properties window, Solver 
Options tab in Production Scheduling.

Min Cycle Time Enter the minimum amount of time 
required to cycle through demand for the 
items produced. This is the frequency at 
which items are typically manufactured. 
Minimum cycle time can be set to Shift, 
Days, or Weeks, and should match the 
manufacturing pattern. For example, if 
items are manufactured on a daily basis, 
minimum cycle time should be set to day. If 
items are not typically produced more than 
once a week, the minimum cycle time 
should be set to week. Production 
Scheduling uses the cycle time to collect and
aggregate demand when generating runs.

This value transfers to the Minimum Cycle 
Time field on the Resource Properties 
window, Solver Options tab in Production 
Scheduling.

Time Unit Select the time measurement that defines 
the Minimum Cycle Time value. 

This value transfers to the Minimum Cycle 
Time measurement field on the Resource 
Properties window, Solver Options tab in 
Production Scheduling.
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Field/Flag Description

Minimize Changeover Between Cycles Select this option to minimize the 
changeovers between cycles. Depending on 
what operations ran in the previous cycle, 
Production Scheduling will try to schedule 
operations without necessitating 
changeovers.

This value transfers to the Minimize 
Changeovers between cycles check box on 
the Resource Properties window, Solver 
Options tab in Production Scheduling.

Offload % Enter the percentage of capacity above 
which Production Scheduling offloads 
production to alternate resources in the set.

This value transfers to the Offload 
Threshold % field on the Resource 
Properties window, Solver Options tab in 
Production Scheduling.

Offload Window The defined time window before operations
must begin, expressed in days, which can be
used as the starting point for calculating 
resource utilization instead of the horizon 
start date. Using a global offload threshold 
window instead of the horizon start date 
allows you to evaluate resource utilization 
over a shorter period of time, which is 
closer to the time your operation must 
begin. This provides you with a more 
accurate picture of whether capacity is 
available to fulfill the operation on time. If 
resource utilization is greater than the 
offload threshold level, the operation can be
transferred to an alternate resource for 
fulfillment.

This value transfers to the Prebuild Target 
field on the Resource Properties window, 
Solver Options tab in Production 
Scheduling.
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Field/Flag Description

Time Unit Select the time unit that is associated with 
the Offload Window field. Valid values are: 
Minutes, Hours, Shifts, Days, or Weeks.

This value transfers to the Prebuild Target 
unit of measure field on the Resource 
Properties window, Solver Options tab in 
Production Scheduling.

Inventory Release Interval Enter lot multiples as a frequency in which 
inventory is released downstream. For 
example, you may want to specify that 
inventory on a machine should be released 
every four hours so that all yielded 
quantities are calculated based on four-hour
operation durations. This ensures the right 
level of plan detail is provided, while 
minimizing the amount of time to solve in 
Production Scheduling. The time based lot 
multiple can be specified for machines, 
crews, and tools.

This value transfers to the duration value 
field on the Link Properties window, 
Attributes tab in Production Scheduling.

The Inventory Release Interval or Time 
Based Lot Multiple is computed as: Usage x 
Efficiency x Time Based Lot Multiple.

Time Unit Select the time unit that is associated with 
the Inventory Release Interval field.

This value transfers to the duration unit of 
measure field on the Link Properties 
window, Attributes tab in Production 
Scheduling.

Setting Up Batchable Resources
A batchable resource can be described as a machine, oven, or kiln that processes many 
items simultaneously. Batchable resources must share one or more similar attribute 
such as temperature, color, or duration. Typically, these resources have several spots, 
such as locations or racks. When an item is placed within a batchable resource the item 
consumes one or more of these spots. 
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When defining a resource as Batchable, you must define a minimum and maximum 
spot capacity, and a pull forward window that allows the resource to be filled to its 
minimum spot capacity. If a minimum spot usage is required before setting up a 
machine to run a certain job type, the Production Scheduling solver may require to 
pull-forward subsequent operations to achieve the target minimum spot usage. 
However, it is important to note that target minimum spots are considered a soft 
constraint. This means that if no operations can be pulled forward to fulfill the target 
minimum usage (due to the pull forward window) or if there isn't enough demand in 
the model, the target can be violated and the user is presented with an alert.

To set up resources as batchable:
1. From the Manufacturing and Distribution responsibility, select Bills of Materials, 

Routings, Resources.

The Resources page appears.

2. Complete these fields:

Field/Flag Description

Resource Enter the name of the batchable resource.

Type Select Machine. Only machines can be 
batchable.

Basis Select Lot. The machine must be defined as 
lot-based to make it batchable.

Batchable Select to indicate the machine is batchable. 
This field is available for lot-based resources
only.

This value transfers to the Batchable radio 
button on the resource Properties window, 
Capacity tab in Production Scheduling.

Minimum Batch Capacity Enter the minimum batch capacity.

This value is used to calculate the lot 
multiple for the routing in Production 
Scheduling.
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Field/Flag Description

Maximum Batch Capacity Enter the maximum batch capacity.

This value is used to calculate the lot 
multiple for the routing in Production 
Scheduling.

Batch Capacity UOM Enter the batch capacity unit of measure.

This value is used to calculate the lot 
multiple for the routing in Production 
Scheduling.

Batching Window This value transfers to the Pull Forward 
Window value on the resource Properties 
window, Capacity tab in Production 
Scheduling.

UOM This value transfers to the Pull Forward 
Window UOM on the resource Properties 
window, Capacity tab in Production 
Scheduling.

3. Access the Resources page for the department.

4. Select the Owned tab.

5. Find the batchable resource row, and select the Schedule by Instance check box.

Tip: A batchable resource cannot be defined as a multi-capacity 
resource.

6. Access the Unit of Measure Conversions page.

7. Select the Inter-class tab.

8. Set up the Unit of Measure conversion between the batching capacity and the item 
UOM.

This must be completed before a batchable resource can be assigned to an 
operation. The UOM conversion factor is used for calculating the lot multiples for 
the routing in Production Scheduling. The lot multiple for a routing with a 
batchable resource is calculated as the capacity of the machine per spot. This takes 
precedence over other parameters such as charge quantity (OPM), MTQ, and so on.
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9. Access the Resource Parameters page.

10. Enter the Organization, Department, and Resource name.

The Type field populates with the machine type, which is Machine.

The Batchable check box is selected and a closed field. This value comes from the 
Resources setup page.

11. In the Available Spots field, enter the available spots within the resource. 

This field transfers to the Maximum field within the Capacity Limits group box on 
the Resource Properties window, Capacity tab in Production Scheduling.

To assign a batchable resource to an operation:
1. Access the Operation Resources page.

2. Select the Scheduling tab.

3. In the Resource field, enter the batchable resource name.

4. In the Setup Type field, select one of the options defined on the resource for the 
operation.

To assign the operation to the routing:
1. Access the Routings page.

2. On the Main tab, in the Referenced - Code field, enter the standard operation code 
for the operation.

Setting Forecast Priorities
The forecast priority is specified for each demand in Production Scheduling. In the 
event of resource conflicts, higher priority orders are expected to receive preferential 
treatment over other orders in the system.

Defining Forecast Priorities
Flexfields need to be set up to enter forecast priorities. Use the profile option: MSC: 
Forecast Priority Flexfield. This profile option indicates the flexfield that contains the 
priority.

Using Replacement Groups as All-of-Sets
Resource replacement groups in EBS are used to create All-of-Sets in Production 
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Scheduling.

Production Scheduling has four types of sets:

• Item sets.

• Resource sets.

• Operation sets.

• All-of-sets.

Items sets are specific to items where you can define and insert alternate items into 
operations. 

Resource sets enable you to substitute resources within an operation such as 
substituting machine 1 for machine 2, or crew 1 for crew 2. 

Operation sets enable you to substitute a production step within a routing. 

All-of-sets is a set type that means all resources in the set are used to run the operation. 
All-of-sets enable you to select groups of resources within an operation, such as running
an operation on line 1 and operator 1, or running the operation on line 2 and operator 2.
In this case, line 1 cannot be run by operator 2, and line 2 cannot be run by operator 1. 

Example of Setting up Replacement Groups in EBS
On the Operation Resources form, Scheduling tab, a primary resource group is defined 
and consists of M1 and C1. 

On the Operation Alternate Resources form, Scheduling tab, alternate resource 
replacement groups are defined where M2 and C2 have a replacement group value of 1,
and M1 and C2 have a replacement group value of 2. 

This implies that the operation can be run by one of the following resource groups:

• M1 and C1

• M2 and C2

• M1 and C2

To set up replacement groups in EBS:
1. Access the Operation Resources form.

2. Click the Scheduling tab.

3. In the Resource field, enter the primary resources for an operation.
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Tip: The primary fields that are used for All-of-sets are: Sequence 
and Resource.

4. Access the Operation Alternate Resources form.

5. Click the Scheduling tab.

6. In the Resource field, enter the alternate resources.

7. In the Replacement Group field, assign the same value to the alternate resource 
groups.

Example
For example, all resources that belong to alternate resource group 1, are assigned an
replacement group value of 1. All resources that belong to alternate resource group 
2, are assigned a replacement group value of 2.

Running Collections
The collections process for Production Scheduler is the same as the collections process 
for Oracle ASCP. There are no new data setups to be done for Production Scheduling if 
you have already performed these data setups for ASCP. 

See Supply Chain Modeling, page 6-1 for details on how to set up manufacturing model
related data in the Oracle E-Business Suite.

See Running Collections, page 4-1 for more details about the data collections process.

Production Scheduling can now collect cMRO work orders. To supplement this data, six
new tables have been added as this information is required to properly schedule cMRO 
work orders. This information is not available in standard collections and an API has 
been provided to augment the collected data. The tables are listed as follows:

1. Visits - Visit information including the start date, end date, and organization.

2. Work Order Attributes - Work order attribute information defining the work 
breakdown structure.

3. Work Order Milestones - The work order milestones for a given visit.

4. Work Order Operation Relation - Work order operation information including 
precedence constraints.

5. Work Order Breakdown - The work breakdown structure definition.

6. Work Order Task Hierarchy - Related work order information related work orders 
including precedence relationships.
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To import this data, the legacy collection framework has been leveraged. A spreadsheet 
template can be downloaded to facilitate the data upload and download procedure. 
This template enables an Add-In where you can import the sample flat file format, 
which can then be exported using the Add-In. Once this has been exported, it can be 
uploaded using an upload utility.

To upload flat files:

1. Access Collect Flat File Data - Self Service. The Oracle Collaborative Planning - 
Load Data Files page appears. 

2. Download the template, which will be in a self-extracting zip file executable, by 
selecting the Download link. A spreadsheet template is now available along with 
sample data files.

3. After populating the data and exporting, they can be uploaded using the Load Data
Files page.

Creating a Schedule
You can have multiple production schedules. You can either create a new schedule and 
go through all the steps to define it or you can base your schedule on an existing 
schedule, making changes where necessary.

To create a schedule:
1. Sign in using the Production Scheduler responsibility. 

2. Select the Names option.

The Organizations window appears.

3. Choose the schedule's organization.

The Production Schedule Name window displays all the current schedules 
associated with the organization you chose.

If you aren't basing your schedule on an existing schedule
1. Click the New button to add a new production schedule.

2. Enter the following details about the schedule:

Field/Flag Description

Name Define a schedule name.
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Field/Flag Description

Description Define the schedule description.

The new schedule now appears on the production schedule list.

Setting Schedule Options
Once the production schedule has been created, you can configure the model using the 
schedule options.

After signing in using the Production Scheduler responsibility, the Production Schedule
Options window can be accessed in two ways:

• From the Applications menu, choose the Names option. Choose an organization, a 
production schedule, and then click the Schedule Options button.

• From the Applications menu, choose the View Schedule Options. Choose an 
organization, a production schedule, and then click the Schedule Options button.

The Production Schedule Options window appears.

To set schedule options:
1. Enter schedule horizon, dates and times in the Horizon form. 

Production Schedule Options - Horizon 
Tab Fields

Description

Scheduling Horizon The number of days for which the schedule 
is to be created in Production Scheduling. 
Forecasts, sales orders, and work orders 
that fall before or after the scheduling 
horizon are not imported.

Release Horizon The number of days for which schedule 
results are sent back to the planning server 
and ERP source when the schedule is 
published from Production Scheduling. 
Only those work orders that start before the 
release horizon are exported.
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Production Schedule Options - Horizon 
Tab Fields

Description

Schedule Start Date Offset The number of days relative to the current 
system date that should be used as the 
horizon start date for extracting snapshot 
data from the E-Business Suite. For 
example, if today is January 24th and you 
want the schedule start to be January 23rd, 
set this to -1. This is useful if you are 
running the schedule based on older 
transactional data. 

Schedule Start Time The start time for the schedule, expressed in
hh24:mm format.

Schedule Start The schedule start date and time computed 
from the current system date, the schedule 
start date offset, and the schedule start time 
entered in the above fields.

Schedule End The schedule end date and time computed 
from the schedule start and schedule 
horizon information entered in the above 
fields.

2. Access and fill out fields on the Scope tab.

Production Schedule Options - Scope 
Tab Fields

Description

Include Past Due Sale Orders The number of days before the schedule 
start date that sales orders can be 
considered as valid demands within 
Production Scheduling.

ASCP Plan Reference Enter the ASCP plan from which 
Production Scheduling reads in dependent 
and independent demands as well as 
planned orders.

This applies to Discrete based jobs only. 
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Production Schedule Options - Scope 
Tab Fields

Description

Active Item Filter Select this option to pull only those items 
that are active within the given Production 
Scheduling horizon. The items are 
considered to be active if and only if they 
have either supply or demand within the 
horizon. This feature applies to all items 
coming from ASCP plan and from 
Category/Category Set. 

Schedule CMRO Work Orders Use to schedule cMRO work orders and 
import closed visit work orders.

Select this option to import cMRO schedule 
(Visit) information into Production 
Scheduling and have it account for this data
when generating schedules. Once this 
option is selected, you have the option of 
importing close Visit work orders.

Note: The ASCP Plan Reference field is 
no longer disabled for cMRO 
integrations. It is valid to run with an 
ASCP and cMRO orders in the same 
plan.

Import Closed Visit Work Order Select this option, available when Schedule 
CMRO Work Orders is selected, to import 
closed work orders for a Visit that is 
currently being scheduled. 

Note: This only applies to Visits that are 
open and imported into Production 
Scheduling. This option allows the 
scheduler to view the entire genealogy of
the visit. 

Consider EAM Schedule Use to consider Oracle Enterprise Asset 
Management (eAM) maintenance work 
orders. Select to import Oracle Enterprise 
Asset Management work orders. Not 
applicable to Oracle Process Manufacturing 
and Oracle Shop Floor Management.
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Production Schedule Options - Scope 
Tab Fields

Description

Include Past Due ___ Days The number of days to import past due 
Enterprise Asset Management work orders.

Demand Timefence The timefence to be used for sales orders 
and forecasts, expressed in number of days. 
The way sales orders and forecasts are 
handled depends on whether Production 
Scheduling works with ASCP, or connects 
directly to the E-Business Suite.

With an ASCP plan reference, only new 
sales orders collected since the last run of 
ASCP are considered within the demand 
time fence. These new sales orders will not 
consume forecasts. All other demands (sales
orders and forecasts) are as they exist in the 
referenced ASCP plan.

Without an ASCP plan reference, all 
forecasts are dropped within the demand 
timefence and only sales orders are 
considered. 
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Production Schedule Options - Scope 
Tab Fields

Description

Bottleneck Resource Group Select the bottleneck resource group for the 
organization.

A bottleneck resource group is a group of 
resources that represent the true constraints 
in the supply chain as pre-decided by the 
user. It is a way for the user to indicate that 
they do not want the planning or 
scheduling engine to consider the 
constraints on resources that do not belong 
to this group. The planning and scheduling 
engine is free to violate capacity constraints 
on the resources outside this group, which 
are often referred to as non bottleneck 
resources. 

A resource can belong to only one 
bottleneck resource group. The bottleneck 
resource group is specified in the 
Department Resources Form. The 
Production Scheduling integration sets the 
resources belonging to the bottleneck 
resource group as Relaxed = No. Resource 
that do not belong to this group should be 
set as Relaxed = Yes.
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Production Schedule Options - Scope 
Tab Fields

Description

Simulation Set Select the simulation set for the 
organization.

A Simulation set is a vehicle for making 
resource capacity changes against a 
prescribed baseline. The baseline is 
established by specifying valid shifts for the
resource in the Department, Resources, 
Shifts form. In this form, click on the 
Capacity Changes button to access the form 
where the baseline capacity of a resource 
can be modified. 

When modifying the picture of baseline 
capacity of a resource, the user should also 
specify the name of a valid simulation set 
that will hold those capacity changes. A 
simulation set name is a pre-defined 
designator defined in Bill of Material, Setup,
Simulation Sets. 

Simulation set example:

Resource R1 works on a Monday through 
Friday working calendar. On each working 
day it has two active shifts namely Shift 1, 
which is from 07:00 - 15:00, and Shift 2, 
which is from 16:00 - 23:00. 

If the user wants to create a scenario where 
they add a third shift in the month of 
January, they can do so in the form 
mentioned above, but when making the 
change they should specify the name of a 
simulation set such as, 
SIM_JAN_EXTRASHIFT. 

The same user might want to simulate 
another scenario, for example, the resource 
is taken down from maintenance between 
05-Jan-2006 and 15-Jan-2006. The user can 
do this as well using the above form and 
use another simulation set name to hold the 
change such as 
SIM_JAN_MAINTENANCE. 

After all of this information is collected over
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Production Schedule Options - Scope 
Tab Fields

Description

to the APS server, the user can run multiple 
plans, with each plan specifying different 
simulation set names to model various 
what-if scenarios.

Purchase Lead Time Offset Enter a value that determines the offset time
between the ASCP plan and the detailed 
production plan created by Production 
Scheduling. This value considers the 
amount of time needed to run MRP plans 
and Production Scheduling plans. The unit 
of measure for this value is days.

For example, if the Purchase Lead Time 
Offset is set to 1, the system will add one 
day to all purchase lead times in Production
Scheduling.

Include Past Due Demands Enter the number of days before the 
schedule start date that ALL demands (SO, 
TO out, Forecast, etc.) can be considered as 
valid within Production Scheduling.

Include Past Due Supplies Enter the number of days before the 
schedule start date that ALL supplies 
(Discrete/OPM/CMRO WO, PO, TO in, etc.) 
can be considered as valid within 
Production Scheduling. 

Demand Schedules Demand Planning forecast scenarios that 
are being brought into the schedule. This 
option is only available if you are not using 
an ASCP plan, and are running Production 
Scheduling in a standalone mode.

The demand schedules are used to read 
demand, such as a forecast. If an ASCP plan
is used, the demand comes from the ASCP 
plan and this field is not used. If there is no 
ASCP plan then you need to specify 
demand through a demand schedule.
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Production Schedule Options - Scope 
Tab Fields

Description

Category Set The category set to be used to filter the 
items for consideration.

This value transfers to an item group folder 
in the Model Workspace tree in Production 
Scheduling.

Category The categories from the category set to be 
included in the plan.

Description The description of the category is filled 
automatically.

3. Access and fill out the fields on the Schedule Parameters tab.

Production Schedule Options - Schedule
Parameters Tab Fields

Description

Cost Time Unit Select the unit of measure for the cost time 
displayed in Production Scheduling. Valid 
values are:

• Minutes

• Hour

• Shift

• Day

• Week

Fixed Time Fence Duration of the fixed time fence at the 
beginning of the calendar horizon. During 
this time, new operations are not scheduled 
by Production Scheduling. The fixed time 
fence applies to all resources.
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Production Schedule Options - Schedule
Parameters Tab Fields

Description

Decimal Precision The number of decimal places to be used 
when defining precision for all items in the 
model. For example, a value of two would 
produce two zeros after the decimal point. 
The default is 2.

Use Work Order Units of Effort Select this option if you want schedule work
orders by their individual "unit of effort" 
instead of strictly by demand. Selecting this 
option can shorten the makespan required 
to produce an item by breaking the routings
into multiple instances, enabling secondary 
operations to start earlier.

This option is not applicable for cMRO. This
is specific to manufacturing customers with 
incremental inventory release.

Adjacent Operations Preferred Select this option is you want to eliminate 
idle time when running multiple instances 
of an operation. Although this approach 
may increase the manufacturing makespan, 
it may improve the efficiency of the 
resources involved with the operation.

Enable Supply Tolerance Offset Select to indicate that supply tolerance 
offset should be used. If this option is 
selected, there will be no net new 
production recommendations generated at 
any level in the BOM (for example, only 
work order supply production will be 
scheduled). If there is insufficient work 
order supply, inventory will be 
automatically added to prevent levels from 
falling below zero (demand is permitted to 
be shorted). A Production Scheduling log 
message is generated to indicate what 
inventory quantity adjustments were made. 
Using this feature assumes work order 
supply is sufficient to meet demand.
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Production Schedule Options - Schedule
Parameters Tab Fields

Description

Enforce Horizon Start Select to move forward all operations 
running behind on various machines, 
without changing the sequence of the 
operations and consider upstream or 
downstream dependencies. There are a 
variety of different scenarios associated 
with this feature in regards to why 
operations may appear running in the past. 
For example, work order operations that 
have a Firm Start Date, Firm End Date, or 
Firm Date Range in the past, several work 
order operations that have an active status 
on the work order routing operation step 
that conflicts with another work order, and 
so on.

Note: When working with Visits, make 
sure "Pre-Build" is selected as the Build 
Strategy in Schedule Parameters tab.

Build Strategy Select the preferred demand build strategy. 
Valid values are: 

• Just-in-time (JIT) - Items normally 
produced as late as possible.

• Prebuild - Items normally produced as 
early as possible. 

JIT is the default.

Allow Resource Offloading on Workorders Select this option to allow Production 
Scheduling to offload work order 
production to alternate resources when 
above the specified offload threshold level. 

Ship Complete for Transfer Orders Select this option to ship all the items on a 
transfer order when all the line items have 
been produced. If left blank, shipment 
occurs after each line has been produced on 
the transfer order.
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4. Access and fill out the fields on the Display Parameters tab.

Production Schedule Options - Display 
Parameters Tab Fields

Description

Create Demand Folders Based On Specifies how the Production Scheduling 
Demand folders are structured. Valid values
are order class, demand priority, type, or 
customer.

Create Supply Folders Based On Specifies how the Production Scheduling 
Supplies folders are structured in the 
Supply and Demand Editor. Valid values 
are supplier or type.
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Production Schedule Options - Display 
Parameters Tab Fields

Description

Create Work Order Folders Based On Specifies how the Production Scheduling 
Work Order folders are structured. Valid 
values are Item, Routing or Work 
Breakdown Structure.

If the Schedule CMRO Work Orders option 
is selected on the Scope tab, then select 
Work Breakdown Structure from the Create 
Work Order Folders based On list.

When the Work Breakdown Structure 
option is selected from the Create Work 
Order Folders Based On list, the Workorder 
Display Options are enabled (the 
Workorder Display Options parameters 
should be based on the CMRO Work 
Breakdown Options in the lower section of 
the tab). It is important to note that the 
integration to cMRO needs to set these plan 
options dynamically, as these fields could 
have been renamed in the cMRO system 
(for example, the values in the right column 
need to be dynamic). The values will be set 
in the Work Breakdown Structure table 
from Parameters 1-9. When integration 
runs, these values are pulled from the 
cMRO system. 

Select the Workorder Breakdown Structure 
parameters to display in Production 
Scheduling and provide Custom Label if 
necessary. The Custom Label will appear 
with the Production Scheduling plan. If the 
fields change in cMRO, the plan options 
pick up the display name. Visit, Item and 
Item Serial Number cannot be renamed, and
Visit is always selected.

5. Access and fill out the fields on the Campaign Run Options tab if you want to run 
the Repetitive Manufacturing Optimization (RMO) algorithm in Production 
Scheduling. The RMO algorithm takes into consideration the various costs in the 
model, including inventory carrying, inventory stockout, changeover, and safety 
stock violation costs when creating an optimal production schedule. To facilitate the
efficient manipulation of these costs in the RMO algorithm to run various scenarios 
and simulations, you can use the scaling factors defined in this tab to help 
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understand and manipulate solve results. 

The Risk Adjusted Costs functionality in Production Scheduling enables you to 
quickly scale the relative costs of inventory carrying, inventory stockout, 
changeover and safety stock violation costs. The actual costs in the model do not 
change, but they are "scaled" in the Production Scheduling solver when it makes 
trade-off decisions to create a schedule. The cost factors default to a value of 1. You 
can quickly and easily change the relative importance of the specific cost by 
decreasing or increasing the factor value associated with the specific cost. The 
acceptable values for each of respective scale factors range from 0.01 to 100.

Production Schedule Options - 
Campaign Run Options Tab Fields

Description

Use Campaign Run Optimization Select this option to use Campaign Run 
Optimization in Production Scheduling. 

This value transfers to the Enable Campaign
Run Optimization check box on the Solver 
Options window, Campaign Run Options 
tab in Production Scheduling.

Work Week Start Day The start of the work week for the model 
using run optimization.

Work Day Start Time The start of the workday for the model 
using run optimization in a HH24:MM 
format.

Minimum Cycle Time The frequency at which items are typically 
manufactured. Minimum cycle time can be 
set to shift, days, or weeks, and should 
match the manufacturing pattern. For 
example, if items are manufactured on a 
daily basis, minimum cycle time should be 
set to day. If items are not typically 
produced more than once a week, the 
minimum cycle time should be set to week. 
Production Scheduling uses the cycle time 
to collect and aggregate demand when 
generating runs. Valid values are: 

• Shift

• Days

• Weeks
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Production Schedule Options - 
Campaign Run Options Tab Fields

Description

Ideal Operation Sequence Based On The changeover optimization criteria 
preferred for run optimized resources. Valid
values are:

• Cost - The cost of the changeover.

• Time - The duration between 
operations.

This value transfers to the Calculate Ideal 
Run Sequence field on the Solver Options 
window, Campaign Run Options tab in 
Production Scheduling.

Inventory Carrying Cost Scale Factor Enter the scaling factor you want applied by
Production Scheduling to reflect the relative
costs of carrying inventory. The cost scale 
factor is set to "1" by default. You can 
increase the relative importance of the 
carrying cost by increasing the scale factor.

Inventory Stockout Cost Scale Factor Enter the scaling factor you want applied by
Production Scheduling to stockout costs. 
The inventory stockout cost scale factor is 
set to "1" by default. You can increase the 
relative importance of the inventory 
stockout cost by increasing the scale factor.

Changeover Cost Scale Factor Enter the scaling factor you want applied by
Production Scheduling to changeover costs. 
The cost scale factor is set to "1" by default. 
You can increase the relative importance of 
the changeover cost by increasing the scale 
factor.

Safety Stock Violation Cost Scale Factor Enter the scaling factor you want applied by
Production Scheduling to safety stock 
violations. The cost scale factor is set to "1" 
by default. You can increase the relative 
importance of the safety stock violation cost 
by increasing the scale factor.
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Running a Schedule from the Workbench
Running a schedule starts Production Scheduling with the plan that was previously 
launched.

To run a schedule using the Workbench:
1. Sign in using the Production Scheduler responsibility. 

2. Choose Workbench from the Applications Menu.

3. Specify the schedule's organization.

This will take you to a form where all the defined schedules are displayed. The 
displayed columns are:

Field/Flag Description

Plan The schedule that you want to run or 
analyze. If no plans have been previously 
launched, No Search Conducted is 
displayed in this column.

Phase Specifies whether the schedule has been 
created in Production Scheduling. Valid 
values are:

• New - New schedules are those that 
have never been run by Production 
Scheduling. No schedules have been 
launched

• Completed - The schedule has been run
on Production Scheduling in the past, 
potentially resulting in a saved 
schedule.

Status The status message returned by the 
concurrent manager after last running this 
schedule.

Download The download link to the schedule.

If this is your first time launching the application, click Update Production 
Scheduling. A warning appears stating that an updated version of Production 
Scheduling will be installed. Click OK. An APS Integration software installation 
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status window appears.

4. Click on the schedule you want to run.

The Extract Planning Data window appears.

5. Choose the type of data extraction required to run your schedule.

Option Description

Launch Fresh Snapshot Collect the latest E-Business Suite data and 
ASCP planned orders for scheduling in 
Production Scheduling. If this is the first 
time you are running this schedule, this is 
the only option available to you.

Use Existing Snapshot in Server When E-Business Suite data has previously 
been collected to the planning server, this 
option creates the production schedule 
based on that data.

Use Existing Snapshot in Client Start Production Scheduling with the last 
model saved on the client computer.

6. Click OK.

A "waiting for concurrent request to complete" message appears. If it is the first 
time that you are running a schedule, the Production Scheduling client software is 
installed on your computer at this point. Finally, your schedule is displayed in 
Production Scheduling, ready for fine tuning.

See Oracle Production Scheduling Implementation Guide for more information about 
how to modify and solve schedules in Production Scheduling.

Submitting Model Generation
As an alternative to running a schedule from the Workbench, you can schedule a job, 
which creates the model, to run at a later time. This job stores the model on the server so
that a planner can access the model after it has been created. This feature eliminates the 
need for the connection between the server and the client to be active while the 
integration runs.

To submit model generation:
1. From the Production Scheduler responsibility, select Other.
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2. Select Request.

3. For a new request click the Submit a New Request button.

4. Select Single Request or Request Set.

5. Click OK.

6. In the Name field, enter MSCSCPPS for Production Scheduling.

The Parameters window appears.

7. Complete the fields on the Parameters window and click the OK button.

8. Click the Schedule button to determine when the job should run.

9. Select the job frequency and click the OK button.

10. Click the Submit button to schedule the job.

Integrating to Production Scheduling
When transmitting data from EBS to Production Scheduling the system automatically 
converts data based on certain values.

This section discusses:

• Generating folders in Production Scheduling.

• The resource calendar.

Generating Folders in Production Scheduling
In Production Scheduling, folders are used to create changeovers at a resource and 
operation group level, and view information filtered by group in schedule views such 
as the Resource Gantt or Item Gantt. User defined item and resource groups are 
imported into Production Scheduling from EBS. 

The resource group folder structure can be created three different ways from EBS:

• One resource group is created for each resource.

This group contains the resource and resource instances in case the resource is 
scheduled by instance. The naming convention is: <DEPARTMENT 
NAME>:<RESOURCE NAME>.

• One resource group is created for each department.

This group contains all of the resources assigned to a department.
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• One resource group is created for each user-defined resource group in EBS.

This group contains all the resources assigned to this group in EBS.

The item group folder structure is created for each category that the item is assigned to 
in the Schedule Options window, Scope tab. 

The operation group folder structure is created for each setup and resource 
combination. The group includes all the operations on a particular resource using a 
particular setup. The naming convention is <SETUP NAME>:<RESOURCE NAME>.

The Resource Calendar
The integration uses the resource calendar when populating the changeover calendar in 
Production Scheduling.

Copying a Schedule Within Production Scheduling
It is possible to create a copy of a schedule within Production Scheduling for simulation 
purposes. Production Scheduling maintains a mapping between the original schedule 
and the copied schedule. The name (and internal id) of the original schedule is used if 
you publish the simulated results back to the planning server. 

For example, you can define a schedule called "Production" (ID = 1111) and solve the 
schedule. Based on the results, you might decide to make a copy of the schedule in 
Production Scheduling and call it "Simulation" (ID = 1112), make some resource 
capacity changes, and run the schedule again. If satisfied with the results of the 
"Simulation" schedule, you can publish the results back to the planning server. When 
the results are published back, they get stored in the planning server under the ID= 
1111, corresponding to the ID of the original schedule "Production". The schedule called
"Simulation" only exists within the Production Scheduling application and is not visible 
in the planning server - it does not exist in the Schedule Names form.

See Oracle Production Scheduling Implementation Guide for more information about how 
to copy a schedule within Production Scheduling.

Publishing a Schedule
You can publish a schedule back to the planning server and to the Oracle Applications 
Manufacturing modules by using the Publish process.

Once the schedule has been solved, you can publish the results back to the E-Business 
Suite. Of all the scenarios you may have created while fine tuning your schedule, you 
must first approve your final schedule.

To publish a schedule:
1. In Production Scheduling, right-click on the schedule you want to approve for 
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publishing.

2. Click Approve.

The schedule name appears in bold in the Production Scheduling model workspace.

3. From the File menu, choose Publish. 

The Publish window appears.

4. From the publishing profile list, choose Release Schedule and click Publish.

The schedule including the sequenced planned orders, jobs, and scheduled resource
specific changeovers are published back to the planning server, and automatically 
released back to E-Business Suite.

Running Production Scheduling as a Service
Production Scheduling has been enhanced to be able to be called as a service. The solver
and application have been decoupled such that the import and solve process can 
optionally be run on the server - this includes Windows, Linux, Sun Solaris, HP-UX and
AIX platforms. The user interface continues to run on the planners Windows client.

This enables Production Scheduling users to have their models pre-solved on the server 
- saving time and improving efficiency. It also allows for batch solving of multiple plans
(Automation of the "what if" process).

The server-side functionality creates a deployable solved model which includes import 
and solver statistics in log files. The log files are all downloaded to the client desktop on
planner request. This enhancement also includes improved application status logging 
and filtering - including access to various event statuses and solver statistics log from 
within Production Scheduling for events which took place on the server.

To run Production Scheduling on the server as a service:
1. From the Responsibility form, select Production Scheduler.

2. From the Production Scheduler Navigator window, select the Launch menu option. 
The Launch PS Plan form and Parameters window appear.

3. From the Parameters window, enter the plan name or select a plan using the LOV 
button.

4. Select Yes from the Solve on Server field to solve the model on the server. Select No 
to download and review the unsolved model. 

5. Click OK to save the Parameters settings and close the Parameters window.

6. Click OK on the Launch PS Plan page to execute your plan.
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If you selected to run the plan on the server, the import and solver statistics are 
recorded in log files. The log files are all downloaded to the client desktop on planner 
request. This feature also provides application status logging and filtering - including 
access to various event statuses and solver statistics log from within Production 
Scheduling for events which took place on the server.

Feeding a Production Schedule Back into ASCP
Once the production schedule has been published back to the planning server, it can be 
used to constrain subsequent runs of ASCP plans. This is performed by specifying the 
name of the production schedule as input in the ASCP plan options.

Several Production Scheduling schedules, one per organization, can be specified in an 
ASCP plan. A firm horizon can be specified for each Production Scheduling schedule. 
The firm horizon defines the window in which planned orders are considered firm by 
ASCP. Production Scheduling releases selected work orders and planned orders to EBS 
and publishes the remaining in the scheduling horizon to the Planning Data Store. Only
planned orders that are unreleased from Production Scheduling are read into ASCP. 
The planned orders from Production Scheduling that fall in the firm horizon for that 
Production Scheduling schedule are imported and considered as firm in ASCP. Planned
orders that fall outside of the firm horizon are not imported into ASCP. 

ASCP reads all of the planned orders that are published by Production Scheduling from
the PDS that correspond to the Production Scheduling plan specified in the ASCP Plan 
Options page. ASCP reads the Production Scheduling published planned orders that 
fall within the firm horizon and marks them as firm with the new schedule start date. 
Any orders that fall outside of the firm horizon are not read by ASCP.

For each organization in the plan, you can specify the following on the Plan Options 
page, Organization tab:

Field/Flag Description

Firm Planned Orders From Production 
Schedule

Select this check box to indicate that the 
organization can receive data from Production
Scheduling to the schedule specified in the 
Schedule Name field.

Schedule Name Enter the schedule name. The schedule name 
that is entered should reference the ASCP plan
on the Schedule Options page, Scope tab.

Firm Horizon (days) The number of days for which the planned 
orders from the feeding production schedule 
are considered by the ASCP plan.
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For additional information on the Organization tab, see Defining Supply Chain Plans, 
Setting Plan Options, The Organization Tabbed Region.
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21
Integrating Strategic Network Optimization

This chapter covers the following topics:

• Overview

• Integration Architecture and Business Process

• Setting Profile Options for Strategic Network Optimization

• Running Collections

• Creating a New Plan Using the Workbench

• Setting Schedule Options

• Starting Strategic Network Optimization

• Running a Plan Using the Workbench

• Publishing a Plan

• Defining Assignment Sets in Strategic Network Optimization

• Modeling Demand at the Customer or Zone Level

• Mapping to Strategic Network Optimization

• Publishing a Constrained Forecast

• Submitting Model Generation

Overview
Oracle Strategic Network Optimization (SNO) is a tool that enables you to model and 
optimize your supply chain network, from obtaining raw materials through delivering 
end products. With strategic network optimization you can:

• Determine which material should be sourced from different suppliers.

• Determine what products to make in what plant.
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• Optimize your aggregate production plans including machine routings, the flow of 
materials, and use of critical resources.

• Optimize your distribution plans, including plant locations, warehouses, and 
transportation alternatives.

Strategic network optimization enables you to solve a wide range of production, 
distribution and planning problems. You can determine when and where to close or 
open facilities and production lines, and whether to manufacture in-house or outsource.
You can:

• Develop and evaluate "what if "scenarios.

• Plan for supply, demand, and capacity changes.

You can optimize plans by performing a variety of detailed analyses including expected
profit, new market, marketing promotions, materials and finished goods sourcing, and 
inventory builds.

Strategic Network Optimization is integrated with the Oracle E-Business Suite and 
leverages the APS component architecture to pull (or collect) data from the E-Business 
Suite.

Integration Architecture and Business Process
The Strategic Network Optimization and E-Business Suite provide out-of-the-box 
integration so that you can build base models in Strategic Network Optimization 
automatically. The integration passes data both ways.
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Inbound Integration
Strategic Network Optimization receives data from the following sources:

• ERP data such as items, organizations, bill of materials, routings, resources 
(machine and person), purchase orders, forecast, and on-hand inventory.

• Scenarios generated and published from Demand Planning (DP) if applicable.

• Inventory levels generated using an Inventory Optimization (IO) plan if applicable.

Outbound Integration
When using Strategic Network Optimization to perform sourcing or capital asset 
decisions that impact the supply chain network definition, sourcing rules used by 
Strategic Network Optimization can be published to APS so that ASCP and IO can use 
the assignment set definition for generating inventory or tactical plans.

Business Process
1. Run Strategic Network Optimization from the Workbench. This process extracts the
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latest data from the E-Business Suite, demand forecast scenarios from Demand 
Management, and time-phased safety stock levels from Inventory Optimization.

2. Run various scenarios in Strategic Network Optimization until the best plan is 
achieved.

3. Publish the assignment sets to the planning server in the form of sourcing rules so 
that:

• ASCP can generate a tactical plan to produce planned orders and 
recommendations to the E-Business Suite.

• Inventory Optimization can generate an inventory plan to support inventory 
policy decisions.

4. Run ASCP to produce planned orders and recommendations to the E-Business 
Suite. 

5. Release the ASCP planned orders and recommendations to the E-Business Suite.

EBS - Demantra Demand Management Integration
Oracle E-Business Suite integrates Oracle Demantra Demand Management to generate 
consensus forecasts and accuracy measures in a business scenario that implements 
Strategic Network Optimization. Oracle Demantra Demand Management collects 
booking history, price list, currency, calendars, users, and items from the E-Business 
Suite applications and generates the following functional outputs:

• Forecast and demand priority for Advanced Supply Chain Planning

• Forecast and forecast accuracy for Inventory Optimization

• Forecast for Strategic Network Optimization

To access the Demand Management Workbench, the E-Business Suite user requires any 
of the following responsibilities:

• Demand Administrator

• Demand Analyst 

For more information on the integration between Oracle Demantra Demand 
Management and the E-Business Suite, refer "EBS - Demantra Demand Management 
Integration" in Oracle Demantra Implementation Guide.
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Setting Profile Options for Strategic Network Optimization
To produce strategic network optimization plans based on the E-Business Suite data, 
you must configure the profile options to collect the correct information for the data 
snapshot. The following profile options must be set for Strategic Network Optimization:

• MSC: PS/SNO Alignment Date

• MSC: PS/SNO API Version

• MSC: PS/SNO Client Install Path

• MSC: PS/SNO Compress XML Package Files

• MSC: PS/SNO Data Store Path

• MSC: PS/SNO Debug Mode

• MSC: PS/SNO Use DB for Integration Data

• MSC: SNO - Snapshot Base Package

• MSC: SNO - Snapshot Beginning Inventory Package

• MSC: SNO - Snapshot Calendar Package

• MSC: SNO - Snapshot Customer Package

• MSC: SNO - Snapshot Demand Package

• MSC: SNO - Snapshot Distribution Package

• MSC: SNO - Snapshot Enterprise Forecast Package

• MSC: SNO - Snapshot Inventory Safety Targets Package

• MSC: SNO - Snapshot Manufacturing Package

• MSC: SNO - Snapshot Purchase Orders Package

• MSC: SNO - Snapshot Supplier Package

• MSC: SNO - Snapshot Transfer Orders Package

• MSC: SNO - Snapshot Work Orders Package

• MSC: SNO Connector Precision
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• MSC: SNO Currency Precision

• MSC: SNO Decimal Precision

• MSC: SNO Fixed Production Package

• MSC: SNO Optimization Type

• MSC: SNO Run Application Script

• MSC: SNO Run Connector Script

• MSC: SNO Sales Order Package

• MSC: SNO Transportation Capacity By

See MSC Profile Options, page A-13 for more information about setting the Strategic 
Network Optimization profile options.

Running Collections
The collections process for Strategic Network Optimization planner is the same as the 
collections process for Oracle ASCP. 

See Running Collections, page 4-1 for more details about the data collections process.

Creating a New Plan Using the Workbench
In order to create a Strategic Network Optimization plan, the first step is to create a 
name for the plan and specify the plan options. A Strategic Network Optimization plan 
name is created in the context of an organization.

To create a new plan using the Workbench:
1. Sign in using the Strategic Planner responsibility. 

2. From the Planner Workbench, choose the Strategic Network Planner responsibility.

3. Choose Names.

The Organizations form appears:
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4. Choose the plan's organization.

The SNO Schedule Definition form appears.
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If you aren't basing your plan on an existing plan
1. Click the New button to add a new plan.

2. Enter the following details about the plan:

Field/Flag Description

Name The name of the new Strategic Network 
Optimization plan.

Description A description of the plan.

The new plan now appears on the SNO Planner Definition list.

Setting Schedule Options
Once the plan has been created, you can configure the model using the schedule 
options.

After signing in using the Strategic Planner responsibility, the Strategic Planning 
Options window can be accessed in two ways:

• From the Applications menu, choose the Names option. Choose an organization, a 
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strategic plan, and then click the Schedule Options button.

• From the Applications menu, choose the View Schedule Options. Choose an 
organization, a strategic plan, and then click the Schedule Options button.

The Strategic Planning Options form appears.

To set schedule options:
1. Define the strategic plan on the Main tab where:

Field/Flag Description

Buckets Enter the number of buckets to be planned. 
You can choose between a "Week" or 
"Period" bucket type. Periods represent 
fiscal 445 periods.
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Field/Flag Description

Plan Start Date The current day. This day can be within a 
bucket, resulting in the first bucket being a 
partial bucket. The associated capacities, 
lead times, and transactional data are 
consistent with this date.

Plan End Date This date is calculated based on the Plan 
Start Date and the number and type of 
buckets to be planned.

Use for Sales and Operations Planning Specify whether or not the SNO plan should
be used for Sales and Operations Planning.

Scenario File Select this checkbox to upload a .imp or .zip
file from your local machine. To launch the 
SNO plan without considering the import 
file, de-select the check box.

Planned Resources Specify whether every resource within a 
routing is marked as capacity constrained, 
or just bottleneck resources.

Bottleneck Group If you have selected "Bottleneck Resources" 
in the Planned Resources field, specify the 
bottleneck group that you want to include 
in the plan.

Assignment Set (Input) The input assignment set used for sourcing 
considerations.

Assignment Set (Output) The assignment set to which the Strategic 
Network Optimization sourcing decisions 
are written if you choose to publish the 
sourcing rules from Strategic Network 
Optimization back to the E-Business Suite. 

Category Set The category set used to filter items for 
consideration.

Category Enter categories from the category set to be 
included in the plan.
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Field/Flag Description

Description The description of the category is filled 
automatically.

2. Click the Organizations tab.

Field/Flag Description

Add All Authorized Organizations Click this button to add all the 
organizations the Strategic Planner 
responsibility is authorized to access, as 
defined in the organizations security screen.
See Organization Security, page 12-65 for 
more information.

Org Select the organizations to be included in 
the model. 

Description The description of the selected 
organizations is automatically filled in.
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Field/Flag Description

Simulation Set The container for any capacity changes 
made to resources within the Oracle 
Manufacturing modules. When specified as 
input, the modified picture of resource 
capacity is considered by Strategic Network 
Optimization as input, rather than the 
baseline capacity.

Demand Schedules Select the MDS, MPS, Source Forecast, 
Demand Planning, or Inventory 
Optimization schedules to be brought into 
the plan. 

Select the Scenario which identifies the 
demand profile that the demand schedule 
maps to in Strategic Network Optimization. 
Valid values are:

• Baseline - maps to the primary Demand
or Safety profile

• Scenario1 - maps to Demand1 or Safety 
Stock1

• Scenario2 - maps to Demand2 or Safety 
Stock2

The description and type fields are filled in 
automatically.

Define Safety by Cover Click this checkbox to model safety stock by
periods of cover in a Strategic Network 
Optimization plan. 

In Strategic Network Optimization, safety stock can be expressed both in terms of 
quantity and periods of cover. Safety stock can be modeled in terms of time in 
Inventory Planner and passed to Strategic Network Optimization as a demand 
schedule. During integration, safety stock units of measure are converted from days
of supply to periods. In Strategic Network Optimization, values for Safety Cover 
are displayed in StorageCover nodes if the safety cover option is enabled.

Mapping to Scenarios
What-if scenarios can be modeled in Strategic Network Optimization and used to 
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support Supply Chain Risk Management. Each what-if scenario can be run with 
different demand and safety stock profiles and can be compared using key 
performance indicators. 

During integration, required data is mapped to Strategic Network Optimization. 
One primary and two alternate forecast and safety stock profiles can be mapped 
from E-Business Suite to Strategic Network Optimization to generate these what-if 
scenarios.

E-Business Suite Field Strategic Network Optimization Field

Baseline Imported into the following Demand node 
fields:

• Min

• Max

Scenario1 The Demand 1 field in the Demand nodes.

Scenario2 The Demand 2 field in the Demand node.

Starting Strategic Network Optimization
When the Launch menu item is selected in Strategic Planner:

1. Strategic Network Optimization is launched

2. Data is extracted from Collections

3. The model is built, and optionally solved, on the server

To start Strategic Network Optimization:
1. In Strategic Planner, choose Launch.

The Parameters form appears.
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2. In the Parameters form, enter the Plan Name

3. Set the Solve to Server field to Yes or No.

4. Click OK.

The Parameters form exits.

5. In the Launch form, click Submit.

The system creates a model.

6. In the Strategic Planner form, choose Workbench.

Running a Plan Using the Workbench
Running a plan starts Strategic Network Optimization with the previously launched 
plan.

To run a plan using the Workbench:
1. Sign in using the Strategic Planner responsibility. 

2. Choose Workbench from the Applications Menu.

The Strategic Plans form appears. The displayed columns represent:

Field/Flag Description

Plan The plan that you want to run or analyze. If 
no plans have been previously launched, 
No Search Conducted is displayed in this 
column.
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Field/Flag Description

Phase Specifies whether the plan has been created 
in Strategic Network Optimization. Valid 
values are:

• New - New plans are those that have 
never been run by Strategic Network 
Optimization. No plans have been 
launched.

• Completed - The plan has been run on 
Strategic Network Optimization in the 
past, potentially resulting in a saved 
plan.

Status The status message returned by the 
concurrent manager the last time the plan 
was run.

Download The download link to the plan.

If this is your first time launching the application, click Update Strategic Planner. A 
warning appears stating that an updated version of Strategic Planner will be 
installed. Click OK. An APS Integration software installation status window 
appears.

3. Click the plan that you want to run.

4. Click Download.

The model opens.

Publishing a Plan
Once a plan has been solved and reviewed, the sourcing rules can be published back to 
the planning server and used as input into ASCP. A sourcing rule is created for each 
item and is time phased over the horizon. The target assignment set is deleted and 
replaced with the new sourcing rules as follows:

1. All the existing assignment and sourcing rules belonging to the target assignment 
set are cleared.

2. An assignment for each receipt organization and item is created.
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3. A sourcing rule for each receipt organization and item is created.

4. An associated receipt organization record is created for each sourcing rule.

5. A source organization record is created for each lane and item for the receipt 
organization.

To publish a plan:
1. Sign in using the Strategic Planner responsibility. 

2. Select the Strategic Network Optimization plan you want to publish.

3. From the File menu, choose Publish.

The Publish dialog box appears.

4. From the Publish dialog box, choose Release Sourcing Rules.

5. Click OK.

The sourcing rules are published to the planning server, where they are used to 
create planned orders in ASCP, and inventory policy decisions in Inventory 
Optimization.

Defining Assignment Sets in Strategic Network Optimization
You can define assignment sets in Strategic Network Optimization by assigning 
sourcing rules. An assignment set represents a selection of organizations and/or items 
you want planned. 

• Bills of Distribution are not used to define assignment sets in Strategic Network 
Optimization.

• Strategic Network Optimization publishes at the item level only.

Lanes are created based on sourcing rule assignments and transportation lanes at the 
lowest level. Locations can be grouped into geographical zones and assignments 
defined at this zone level. Creating lanes to zones makes it easier to set up Strategic 
Network Optimization integration, especially if a large number of locations are 
modeled. 

See Setting Up the Supply Chain, page 6-2for more information about Assignment Sets.

Modeling Demand at the Customer or Zone Level
Demand can be imported into Strategic Network Optimization at the customer location 
level or at the aggregated zone level. In Strategic Network Optimization, demand exists 
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at whatever level the forecast is published.

• Zones are treated as customers in Strategic Network Optimization.

• Strategic Network Optimization models all demand for a customer or zone as 
global demand, even though the demand is attached to an organization.

The following are the hierarchy level combinations for publishing forecasts to model 
customer or zone demand:

Ship-From Hierarchy 
Level

Ship-To Location Zone None or All 
Geographies

Org Input as a local 
demand schedule but 
treated as global 
demand in Strategic 
Network 
Optimization.

Input as a local 
demand schedule but 
treated as global 
demand in Strategic 
Network 
Optimization.

Input as a local 
demand schedule and
treated as local 
demand at the 
organization level in 
Strategic Network 
Optimization.

All Orgs Input as a global 
demand schedule and
treated as global 
demand in Strategic 
Network 
Optimization.

Input as a global 
demand schedule and
treated as global 
demand in Strategic 
Network 
Optimization.

Not a valid scenario

When customers are modeled in Strategic Network Optimization, each ship-to location 
for the customer is modeled as a separate customer since shipping lanes are defined to 
locations. Assignment sets must be created by assigning sourcing rules for each of these 
customer locations in order for the demand to be imported into Strategic Network 
Optimization.

Note: Both customer locations and zones are treated as customers in 
Strategic Network Optimization. In case customers are modeled in 
Strategic Network Optimization, each ship-to location for the customer 
is modeled as a separate customer since shipping lanes are defined to 
locations. Assignment sets need to be created by assigning sourcing 
rules for each of these customer locations for the demand to be 
imported into Strategic Network Optimization.

When you set up zones in E-Business Suite, all locations in the regions assigned to the 
zone are included in the zone. The zone gets its latitude and longitude from the median 
location in Strategic Network Optimization's map view.

Sales orders are not netted against the forecast for the zones the ship-to locations reside 
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if zones are being modeled. Therefore, it is recommended that sales orders not be 
imported into Strategic Network Optimization if zones are being modeled. This can be 
done by setting the profile option, "MSC: SNO - Snapshot Sales Orders Package", to "No
". Since Strategic Network Optimization is a strategic planning product, running the 
model with only forecast should not adversely affect the solve results in a strategic time 
horizon.

To model customer demand in Strategic Network Optimization:
1. Publish the forecast using one of the following levels:

• Customer ship-to location

A customer ship-to location forecast can be set up in E-Business Suite by using 
the Customer and Ship Address fields in the forecast details. The forecast is 
published to Strategic Network Optimization as a demand schedule. A 
customer ship-to location forecast can also be set up by setting Geography to 
Ship To Location in Demand Planner and published to Strategic Network 
Optimization as a demand schedule.

• Zone

A zone level forecast can be set up in Demand Planner by specifying Zone as 
the output level in the geography dimension. Individual locations in the 
forecast are aggregated to the zone level and published to Strategic Network 
Optimization.

2. Set up shipping lanes from organizations to locations and zones in the 
Manufacturing and Distribution Manager. Use the following fields in the Transit 
Time form:

• Origin

• Destination

• Ship Method

3. Set up sourcing rules and assign them to customers and zones.

Assignment sets can be created in E-Business Suite or in the Strategic Planner 
responsibility.

4. Publish the forecast to the Strategic Network Optimization plan.

Sourcing recommendations are published at customer and site levels. One sourcing 
rule is created for each customer-site and item combination and assigned to the 
customer using Item-Instance-Organization assignment type.

5. Run the plan.
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In Strategic Network Optimization, a new Customer block node is created which 
contains one node for each customer location. The Ship-To location is included in the 
node names.

Mapping to Strategic Network Optimization
The section outlines various requirements for mapping data between E-Business Suite 
and Strategic Network Optimization.

Resource Replacement Groups
In E-Business Suite and Strategic Network Optimization, resource replacement groups 
can be set up with only certain combinations of simultaneous resources assigned to an 
operation. The following combinations are supported:

• Operator 1, Line 1

• Operator 2, Line 2

Note:  Other combinations, such as Operator 2, Line 1, will not work

For example, consider a All-of-Sets or resource replacement group where the primary 
resource group consists of GM-AS-M and GM-AS-C, and the alternate resource 
replacement group consists of GM-AS-MA and GM-AS-CA. This operation can only be 
run by either GM-AS-M and GM-AS-C or by GM-AS-MA and GM-AS-CA and not by 
any other combination of resources. When integrated with Strategic Network 
Optimization, one node is created for the primary resource group and the alternate 
resource replacement group.

Fixed Production
Integration facilitates planned production by aggregating work orders in Strategic 
Network Optimization. 

• Work order quantities are aggregated at the item-organization level in the Strategic 
Network Optimization period in which the work order is due. 

• Work order quantities are mapped to Strategic Network Optimization as a 
minimum constraint on production.

Note: The source of these work orders must be specified. Work orders 
are only imported from E-Business Suite and cannot be imported from 
ASCP.
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Supplier Capacities
In E-Business Suite, supplier capacities are set up for an item and supplier-site 
combination. This supplier capacity information is mapped to Strategic Network 
Optimization and aggregated into periods using a 7-day week calendar.

Date Effective Bill of Materials
Strategic Network Optimization supports Time Varying Bill of Materials. 

Publishing a Constrained Forecast
Strategic Network Optimization generates a constrained forecast which is a report of 
the demand satisfied at each organization, customer, or zone. This constrained forecast 
considers all supply chain constraints and is a result of cost or profit optimization. It can
be published to a demand schedule in ASCP and used to respect decisions made in 
Strategic Network Optimization.

The constrained forecast is published at the level where demand is imported; 
organization, customer ship-to location, or zone. It is published to the Planning Data 
Store as one or more Demand Planning scenarios, as follows:

Demand Plan Scenario published as: Input to ASCP as:

Organization level forecast Local demand schedule for each organization

Customer Ship-To Location level forecast Global demand schedule

Zone level forecast Global demand schedule

To publish a constrained forecast:
1. In Strategic Network Optimization, select File, then Publish.

The Publish form appears.

2. In the Publish form choose Release Constrained Forecast.

3. Complete the Profile Details fields.

4. Click the Publish button.
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Submitting Model Generation
As an alternative to running a schedule from the Workbench, you can schedule a job, 
which creates the model, to run at a later time. This job stores the model on the server so
that a planner can access the model after it has been created. This feature eliminates the 
need for the connection between the server and the client to be active while the 
integration runs.

To submit model generation:
1. From the Strategic Planner responsibility, select Other.

2. Select Request.

3. For a new request click the Submit a New Request button.

4. Select Single Request or Request Set.

5. Click OK.

6. In the Name field, enter MSCSCPSNO for Strategic Network Optimization.

The Parameters window appears.

7. Complete the fields on the Parameters window and click the OK button.

8. Click the Schedule button to determine when the job should run.

9. Select the job frequency and click the OK button.

10. Click the Submit button to schedule the job.
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22
Reports and Concurrent Processes

This chapter covers the following topics:

• Reports

• Concurrent Processes

Reports
Oracle Advanced Supply Chain Planning has the following reports:

• Audit Statements Report

• Plan Comparison Report

• Planning Detail Report

Audit Statements Report
The planning process involves collecting and using source data to drive planning. Data 
from source transaction instances need to be accurate and need to be set up properly in 
order for reliable planning output. Data from the source can be corrupt due to many 
reasons, including: bad transactions, missing transactions, human error, improper 
formats, conflicting and/or missing setups and profile options. 

The Audit Statements Report is a self-explanatory report that evaluates data setups for 
profile options that are incorrectly set, invalid package bodies and objects, invalid 
triggers, etc. It suggests remedies for the problems that are found. 

To run the Audit Statements Report
1. Sign in using the Advanced Supply Chain Planner responsibility.

2. Select Setup > Run Request. 

The Find Requests window appears.
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3. Select Submit a New Request. 

The Submit a New Request window appears.

4. Select Single Request, then click OK. 

The Submit Request window appears.

5. From the List of Values for the Name field, select Audit Statements Report. 

The Parameters window appears. 

6. Select Application.

Application Use for...

Global Order Promising Order promising related audit statements

Inventory Optimization Inventory optimization related audit 
statements

Advanced Supply Chain Planner Supply chain planning related audit 
statements

Demand Planning Demand planning related audit statements

7. Select Report.

Report Audits data setups related to ...

Audit Collections Setup Collections

Audit Planning Data The planning engine

Audit UI Data The user interface; for example, to check the
validity of materialized views and profile 
options that control the display of plan data

8. Select the plan for which you want to validate setup data.

9. Select the source instance for which you want to validate setup data.

10. Select Output Type.
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Output Type Select this if you...

Summary Report Do not want to look at details of the errors 
and warnings

Detail report - Errors Only Want audit details of the errors only

Detail Report - Errors and Warnings Want audit details of both the errors and 
warnings. Warnings are not fatal to the 
planning process, but could cause 
erroneous output

Detail Report - Complete Want the summary as well as errors and 
warnings in your audit report

11. Select OK.

The Parameters window disappears.

12. Select Submit in the Submit Request window.

To view the output of the Audit Statements Report
1. From the Navigator, select Other > Request. 

The Find Requests window appears.

2. Select Find. 

The Requests window appears.

3. Select the completed request for Audit Statements Report.

4. Select View Output to view the report.

Plan Comparison Report
The Plan Comparison Report compares two plans. To compare two plans:

• Specify criteria for comparison attributes (preference sets) and the comparison 
display (filtering criteria)

• Select the plans to compare and view the comparison: You can drill down from 
exception group comparison to exception type comparison to exception details 
comparison.
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Specifying Plan Comparison Criteria
The plan comparison criteria are:

• Preference set

• Filtering criteria

Preference Set
You use preference sets to specify comparison attributes, for example, the exception 
messages on which to compare. 

To specify a preference set
1. From the Plan Comparison screen, select either the Comparison Setting tab or 

choose the Create/Edit Preferences button.

The Preference Set Search page appears. You can:

• Select whether or not to display plan options comparison. 

• Delete the preference set

• Save the preference set and indicate it as the default

• Mark it private or public. Other users can access public preference sets.

2. To save the preference set, click Save.

3. To create a new preference set using the settings on the page, enter a new 
preference set name in Save Plan Comparison Preference Set As and click Save..

4. To discard changes to the preference set, click Cancel.

5. To edit another preference set, select the preference set name at the top of the page 
and click Go.

6. To display a plan comparison report using the preference criteria, click Display 
Report.

Filtering Criteria
You can select the filtering level for the attributes to be compared. For example, you 
could compare lateness at the item level and compare early replenishment at the 
product family level.

You can create and use filtering hierarchies and combinations of filtering hierarchies. 
Within each hierarchy, use:
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• Filtering to narrow the selection

• Combinations of filtering hierarchies to include more selections

The supported hierarchies are Item and Resource. 

Filtering functionality behaves similarly to the Find functionality in the Planner 
Workbench.

To select filtering criteria
1. Select the Comparison Settings tab.

2. Select the Filter Criteria tab.

The Filter Criteria page appears.

3. Select a field name.

4. Select a condition.

5. Select or enter the From and To.

6. To use these filter criteria for comparison, click Display Report.

7. To go the previous screen, click Cancel.

8. To delete all the data entered, click Clear.

9. To specify additional filter criteria, click Add Another Row.

Viewing Plan Comparison
You can access plan comparisons in several ways and display tabular and plan options 
information.

To access the Plan Comparison page from Planner Workbench
1. In Planner Workbench, select a plan name from the Navigator.

2. On the menu bar, select Plan.

3. Select Compare Plans.

The Plan Comparison page appears.

To access the Plan Comparison page from the Navigator
1. From the Navigator, navigate Reports > Plan Comparison Report > Plan 

Comparison.
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The Plan Comparison page appears.

To compare two plans
1. Check for View Requests and verify that concurrent process Compare Plan 

Exceptions has completed successfully.

2. Access the Plan Comparison page from the Planner Workbench or from the 
Navigator.

3. In the Exceptions tab, enter or select the plan names in Plan A and Plan B.

4. Enter or select the preference set.

To create or edit a preference set, click Create/Edit Preferences.

5. Click Go.

The comparison appears in the lower part of the page.

The page shows the exception count for the exception groups for the two plans 
according to the preference set.

You can select any exception group link and view the exception type plan 
comparison for that exception group. You can select any exception type link and 
view the exception details.

To drill down in the plan comparison
1. From the Exception Group Summary page, click a link in the Exception Group 

column.

The Exception Types Summary page appears.

This screen shows the exception count allocated to each exception type in the 
exception group.

2. From the Exception Types Summary page, click a link in the Exception Type 
column.

The exception details graph appears.

3. To view corresponding tabular data, click Exception Details.

The Exception Details page appears.

To view plan options
1. Select the Plan Options tab.

The Plan Options page appears.
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2. To view plan options information about the two plans, click the links at the bottom 
of the page (Main, Aggregation, Organization, Constraints, Optimization, Decision 
Rules).

Planning Detail Report
The Planning Detail Report has been enhanced for release 12. The enhanced Planning 
Detail Report uses XML Publisher for the output and is available to OPM and ASCP 
users. The Planning Detail Report that was available in previous releases is referred to 
as the Planning Detail Report (Discoverer) because it uses Oracle Discoverer for the 
output.

This section discusses both reports:

• Planning Detail Report, which is new with release 12.

• Planning Detail Report (Discoverer), which was available to ASCP users prior to 
release 12.

In previous releases, process manufacturing planners use these Oracle Process 
Manufacturing reports to view results of their plans:

• MRP Bucketed Material Report

• MRP Material Activity Report

• MRP Action Message Report

• MRP Error Message Report

In release 12, the source of this information has changed. Process manufacturing 
planners use the Oracle Advanced Supply chain Planning Detail Report to view the 
results of their plans.

In previous releases, process manufacturing planners use the Oracle Process 
Manufacturing OPM Reorder Point Report to view the results of reorder point 
planning. In release 12, the source of this information has changed. Process 
manufacturing planners use the Oracle Inventory Reorder Point Report to view the 
results of reorder point planning.

This diagram shows 11i Oracle Process Manufacturing Material Requirements Planning
reports and their R12 equivalents:
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Planning Detail Report
In previous releases, you could run the Oracle Advanced Supply Planning Detail 
Report against manufacturing plans. In release 12, the scope of data against which you 
can run the report has changed. You can run it against your manufacturing plans, your 
distribution plans, and your collected data. It shows material requirements planning 
information that you can use to understand the results of a plan.

This report is designed to increase planner productivity by using comprehensive and 
easy-to-analyze reports that summarize the plan at the desired level. It is also designed 
to improve communications between all parties involved in the planning and execution 
cycle.

The report may include the following sections: Horizontal Report, Vertical Report, 
Exception Report, and Action Report. These reports include details such as forecast, 
purchase order receipts, scheduled production, on-hand, available balance, expired lot, 
and safety stock.

To create the Planning Detail Report
1. Navigate using one of these navigation paths:

• ASCP navigation: Advanced Supply Chain Planning, Reports, Planning Detail 
Report.

• OPM navigation: OPM Process Planning, Planning, Reports, Planning Detail 
Report.

2. Two windows appear: the GMP_PDR window in the background, and the 
Parameters window in the foreground.

3. Complete the Parameters window using these fields:
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Parameter Description

Instance Select an instance.

Organization Select a plan owning organization.

Plan Name Select a plan or enter Collections to create 
the report based on the ODS data.

Plan Organizations Select all planned organizations or a single 
plan.

Day, Week, and Period Buckets Select the number of daily, weekly, and 
period buckets.

First, Second, and Third Sort Select a sort parameter: No Sort, 
Organization, Inventory Item, Category, 
Planner, Buyer, or ABC Class.

Exception types Select an exception type.

Planner, Buyer, Item From and To Select a range of planners, buyers, or items.

Category Set Name Select another category set. The default is 
the category set used for the plan.

Category From and To Select a range of categories.

ABC Class Name From and To Select a range of item ABC class.

Cutoff Date Select a cutoff date for the Vertical report.

Combined PDR Select Yes to print all four reports. If you 
select Yes, you will not be able to select 
individual reports.

Combined PDR Template Select the template name for the Combined 
report. There is one seeded template. Users 
can add additional templates as needed.

Combined PDR Template Locale Select the template locale for the Combined 
report. Such as en-US for English: United 
States.



22-10    Oracle Advanced Supply Chain Planning Implementation and User's Guide

Parameter Description

Horizontal PDR Select Yes to print the Horizontal report.

Horizontal PDR Template Select the template name for the Horizontal 
report.

Horizontal PDR Template Locale Select the template locale for the Horizontal 
report. Such as en-US for English: United 
States.

Vertical PDR Select Yes to print the Vertical report.

Vertical PDR Template Select the template name for the Vertical 
report.

Vertical PDR Template Locale Select the template locale for the Vertical 
report. Such as en-US for English: United 
States.

Exception PDR Select Yes to print the Exception report.

Exception PDR Template Select the template name for the Exception 
report.

Exception PDR Template Locale Select the template locale for the Exception 
report. Such as en-US for English: United 
States.

Action PDR Select Yes to print the Action report.

Action PDR Template Select the template name for the Action 
report.

Action PDR Template Locale Select the template locale for the Action 
report. Such as en-US for English: United 
States.

4. Click the OK button. The GMP_PDR window displays the Parameter selection 
string in the Parameter field.

5. On the GMP_PDR window, click the Submit button.

6. The Decision window appears asking if you want to submit another request. 
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Respond by clicking Yes or No.

7. The Planning Detail Report is available in XML Publisher. For more information 
about XML Publisher, see the Oracle XML Publisher User's Guide.

Planning Detail Report (Discoverer)
The Planning Detail Report (Discoverer) provides a simple and consolidated report that 
shows the output of the advanced supply chain planning process. The report gives 
detailed information to help you understand and analyze the supply chain planning 
results by presenting the data selectively and coherently. For a given Supply Chain 
Plan, the report includes the relevant details about items, resources, gross requirements,
scheduled receipts, planned orders, plan constraints, and exceptions in separate 
worksheets.

As of release 12, you must add this report to the ASCP responsibility to invoke it from a 
menu and print the worksheets selectively. You can select the plan, organizations, 
items, resources, projects, and many other parameters to filter the information to 
display in the report and you can change these parameters at any time.

The Planning Detail Report (Discoverer) contains six worksheets:

• Plan Details: Shows the details of the selected plan from form Plan Options.

• Item Details: Shows the details of the selected items.

• Resource Details: Shows the details of the selected resources

• Vertical Plan- shows the cumulative supply/demand picture (No buckets).

• Late Order Exceptions: Shows the details of late orders. Only the following 
exceptions are included in the Late Orders Exception Worksheet:

• Past Due Sales Order and Forecast

• Late supply pegged to sales order or forecast

• Late replenishments for sales order or forecast

• Replenishment after need date

• Past Due orders

• Other Exceptions: Shows the material and resource related exceptions that span the 
following exception groups:

• Material and resource capacity constraints

• Shortages and Excess 
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You can specify the details you need to see in the report. For example:

• You can choose not to see a particular worksheet, and you can control the display 
by selecting the sorting rule.

• A column can be removed from a worksheet, but if the new format (with the 
deleted column) is saved by any one user, other users would also not be able to 
view that column.

There are many Discoverer 4i features which enable you to flexibly manipulate the 
reports. For more details on using Discoverer, see Oracle Discoverer User's Guide.

To add the Planning Detail Report (Discoverer) to ASCP Responsibilities
To run the Planning Detail Report (Discoverer) you must add the report to ASCP 
responsibilities:

1. From Oracle Applications, select the Application Developer responsibility.

2. Navigate to Application > Menu, to open the Menu form.

3. Press F11 (view > query by example > enter) and enter MSC_TOP_4.0 in the Menu 
field.

4. Pres ctrl+F11 (view > query by example > run).

5. Place your cursor in the details block and press F11 (view > query by example > 
enter).

6. In the Function field, enter Planning Detailed Report - Discoverer.

7. Press ctrl+F11 (view > query by example > run), and change the prompt to Planing 
Detail Report (Discoverer).

8. Save your work, and change the responsibility to Advanced Supply Chain Planner.

To create the Planning Detail Report (Discoverer)
1. From the Advanced Supply Chain Responsibility, select Planning Detail Report 

(Discoverer). The Planning Detail window appears.

The following table describes each condition and defines the number of values that 
can be selected in the From and To fields for each condition. 

Condition Definition From To

All all the values for the 
parameter are 
selected

n/a n/a
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Condition Definition From To

Equals only one value is 
selected

single value n/a

Between a range of values is 
selected

single value single value

Among multiple values are 
selected

multiple values n/a

Is Not a value that is not 
required to be 
included in the 
report is selected

single value n/a

Outside a range of values is 
selected that are not 
required to be 
included in the 
report

single value single value

The information is filtered and displayed in the report on the basis of the values 
selected for the parameters. The following table is an example of the values that can
be selected for the different parameters.

Parameter Value

Plan Name Select a plan. 

Org Select multiple organizations for a multi-org
plan and for the owning organization. For 
single-org plan or when not working in the 
owning organization, only the current 
organization can be selected. 

Category Set The default is the category set used for the 
plan. You can select another category set. At
least one category set should be selected.

ABC Class Select a range of item ABC class 

Item Select a range of Items. 
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Parameter Value

Planner Select the name of a planner

Buyer Select the name of a buyer

Supplier Select one or more suppliers 

Planning Group Select the planning groups

Project Select the projects

Resource Group Select resource groups

Dept./Line Select the departments/lines

Resource Select a range of resources

2. Select the Go button. The Planning Detail Report (Discoverer) is launched in 
Discoverer 4i. The six worksheets, namely Plan Details, Item Details, Resource 
Details, Late Order Exceptions, and Other Exceptions can be accessed by selecting 
the respective tabs at the bottom of the report. If you rerun the report for a different 
plan, the Discoverer4i worksheets are already open. Click Refresh to see the new 
report.

3. Select the Item Details tab to open the Item Details worksheet.

4. To sort the data by Organization in Vertical Plan worksheet, select the Vertical Plan 
tab, then select Tools > Sort. The Sort Table appears. Use this table to change or add 
the sort parameter and condition.

5. To sort the data based on Organizations, select Add and select Organization in the 
Sort Table. 

6. To view the sorted Vertical Plan worksheet, select OK on the Sort Table Window. 
The sorted Vertical Plan worksheet appears.

Concurrent Processes
You can access concurrent processes from these locations in the Navigator:

• Collections menu
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• Setup menu

ATP 24x7 Switch Plans

Overview
In 24-by-7 available to promise, the inquiries are done on the current version of the plan
while the new plan run is in progress. Once the new plan is run, this synchronization is 
called internally during the ATP Post Plan Processing request and log messages in that 
request show the results of the synchronization process. Oracle may ask you to run this 
process independently as a debug step.

See also Oracle Global Order Promising Implementation and User's Guide.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select ATP 24x7 Switch Plans from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Plan Name: The plan against which you want to run the concurrent process.

ATP 24x7 Synchronization Process

Overview
Synchronization in 24-by-7 available to promise considers the sales orders received 
while the plan was being run and makes it a part of the new plan so that all demands 
are accurately reflected in the newest plan. Once the new plan is run, this concurrent 
process synchronizes the new plan. While this process typically runs automatically, 
Oracle may ask you to run this process independently.

See also Oracle Global Order Promising Implementation and User's Guide.

Prerequisites
An ATP plan
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Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select ATP 24x7 Synchronization Process from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Plan: The plan against which you want to run the concurrent process.

ATP Post Plan Processing

Overview
This concurrent process analyzes the plan output and summarizes the supply according
to an item's allocation rule. On completion of the run, you get availability picture is for 
order promising as the output. 

See also Oracle Global Order Promising Implementation and User's Guide.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select ATP Post Plan Processing from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Plan: The plan against which you want to run the concurrent process.
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Analyze Plan Partition

Overview
This concurrent process runs automatically at the end of the plan run and analyzes the 
plan partition after the plan is generated. It gathers the optimizer statistics and 
improves SQL performance for queries. 

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Analyze Plan Partition from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Plan Name: The plan against which you want to run the concurrent process.

Auto Release Planned Order

Overview
This concurrent process automatically releases planned orders:

• Generated during the run of a plan with Production selected

• With Order Date within item attribute Release Time Fence

Submission
The planning process automatically launches this concurrent process as needed. 

Completion
The concurrent process completes with warning if it cannot release a planned order for 
a buy item because the planner is not an active employee. It notes the issue in the log 
file with error Purchase requisition is not released because Planner is not an active 
employee.
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Build Collaborative Planning Calendar

Overview
This concurrent process builds a default calendar used in Oracle Collaborative Planning
application. Horizontal plans and exception calculations use this calendar. Oracle 
Collaborative Planning uses a hierarchy of calendars depending on the dates and order 
in question.

See also Oracle Collaborative Planning Implementation and User's Guide.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Build Collaborative Planning Calendar from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Calendar code: A valid calendar code existing in the planning system.

Calculate Resource Availability

Overview
For a planning instance, this concurrent process computes resource availability from a 
start date. This is typically used for quality assurance and regression testing where the 
source and planning destination dates may be different. 

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Calculate Resource Availability from the Reports list.
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The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Instance: The instance-organization against which you want to run the concurrent 
process.

Start Date: The date from which you want to calculate resource availability.

Collections Synonyms

Overview
This concurrent process drops and creates synonyms during the collections run.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Collections Synonyms from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
None

Collections Triggers

Overview
This concurrent process drops and creates triggers during the collections run.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.



22-20    Oracle Advanced Supply Chain Planning Implementation and User's Guide

The Submit Request window appears.

3. Select Collections Triggers from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
None

Collections Views

Overview
This concurrent process drops and creates views during the collections run.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Collections Views from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
None

Compare Plan Exceptions

Overview
This concurrent process performs the calculations that report Plan Comparison Report 
uses to compare two plans. 

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.
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2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Compare Plan Exceptions from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
From Plan: The original plan name.

To Plan: The copied plan name.

Continuous Collections

Overview
This concurrent process regularly and automatically synchronizes the data on the 
planning server to the current source data.

See also Running Collections.

Submission

Option 1
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Continuous Collections from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Option 2
1. In the Navigator, select Collections > Oracle Systems > Continuous Collection.

The Submit a New Request window appears.

The Parameters window appears.

2. Set the parameters and click Submit.
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Parameters
Instance: The instance-organization against which you want to run the concurrent 
process.

Collection Group: The collection group.

Number of Workers: The number of workers that the process should use.

Timeout (minutes): The time out in minutes after which the process will fail. 

Snapshot Threshold (%): Threshold that the collections engine should use to decide 
whether to do a net change or targeted collection. If the data volume change is above 
the specified percentage, the collections engine uses targeted collection.

Analyzing Staging Tables: Indicate whether to analyze staging tables and gather 
statistics for the staging table.

In the remaining program parameters, specify whether or not to collect each entity:

• Approved Supplier Lists (Supplier Capacities)

• BOM / Routings / Resources

• Bills of Resources

• Forecasts

• Items

• Key Performance Indicator Targets

• Master Demand Schedule (MDS)

• Master Prod. Schedule (MPS)

• On Hand

• Purchase Orders/Purchase Requisitions

• Sales Orders

• Supplier Responses

• Transportation Details

• User Supplies and Demands

• Work in Process (WIP)

• ATP Rules
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• Calendars

• Demand Class

• End Item Substitutions

• Key Performance Indicator Targets

• Planning Parameters

• Planners

• PO Receipts

• Projects/Tasks

• Reservations

• Resource Availability

• Safety Stock 

• Sourcing History

• Sourcing Rules

• Subinventories

• Suppliers/Customers/Orgs

• Unit Numbers

• Unit of Measure

• User Company Association

Create AHL Snapshots

Overview
This concurrent process drops and recreates AHL snapshots during the collection 
process. Typically, it runs as part of concurrent process Refresh Collection Snapshots 
when profile option MSC: Source set up required is Yes.

Submission
1. In the Navigator, select Setup > Run Requests.
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The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Create AHL Snapshots from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
None

Create APS Partitions

Overview
This concurrent process segregates data by plans and instances. Use it only if you want 
to have more than one partition. 

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Create APS Partitions from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Plan Partition count: The number of plan partitions to be created.

Instance Partition count: The number of instance partitions to be created. 

Create ATP Partitions

Overview
This concurrent process segregates data by plan with ATP partitions.

See also Oracle Global Order Promising Implementation and User's Guide.
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Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Create ATP Partitions from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Plan partition count: The number of plan partitions to be created.

Instance partition count: The number of instance partitions to be created.

Create BOM Snapshots

Overview
This concurrent process drops and recreates BOM snapshots during the collection 
process. Typically, it runs as part of concurrent process Refresh Collection Snapshots 
when profile option MSC: Source set up required is Yes.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Create BOM Snapshots from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
None
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Create Forecast Priority Flexfield

Overview
This concurrent process creates a new segment in the existing forecast descriptive 
flexfield in the source instance. The segment holds forecast priority information for each
forecast entry.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Create Forecast Priority Flexfields from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Forecast Priority: The segment of the flexfield that you want to designate for defining 
the forecast priority.

Create INV Snapshots

Overview
This concurrent process drops and recreates INV snapshots during the collection 
process. Typically, it runs as part of concurrent process Refresh Collection Snapshots 
when profile option MSC: Source set up required is Yes.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Create INV Snapshots from the Reports list.

The Parameters window appears.
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4. Set the parameters and click Submit.

Parameters
None

Create Instance-Org Supplier Association

Overview
This concurrent process designates a supplier as an external supplier organization and 
creates an association between the supplier and the instance-organization. The planning
engine nets and explodes though the supplier organization to issue buy planned orders.

See Modeling Cross-Instance Customers and Suppliers, page 11-5.

Use this process only when planning across instances. If the supplier and the 
organization are part of the same instance, use the supplier to organization association 
function when setting up inventory organizations . See Setting up Organization 
Parameters in Oracle Inventory User's Guide.

Prerequisites
Before running, collect the supplier and the instance-organization.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Create Instance-Org Supplier Association from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Instance Code: The instance in which you want to create the association.

Organization: The organization in which you want to create the association.

Modeled Supplier: The supplier to be associated with the specified instance.

Modeled Supplier Site: The supplier site to be associated with the specified instance.

Accept Demands From Unmet PO: This controls whether unmet quantity in the 
Purchase orders will be exploded though the supplier organizations to create demands 
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in the external supplier organization.

Create Inventory Planning Flexfields

Overview
This concurrent process creates new segment definitions in existing descriptive 
flexfields to hold data that may be required for inventory planning. It also populates 
profile values with the value corresponding to the descriptive flexfield attribute number
for each attribute created.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Create Inventory Planning Flexfields from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Service Level (Item): The service level value that you want to maintain for the items.

Service Level (Org): The service level value that you want to maintain for the 
organizations.

Service Level (Customer): The service level value that you want to maintain for the 
customers.

Create MRP Snapshots

Overview
This concurrent process drops and recreates MRP snapshots during the collection 
process. Typically, it runs as part of concurrent process Refresh Collection Snapshots 
when profile option MSC: Source set up required is Yes.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.
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2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Create MRP Snapshots from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
None

Create OE Snapshots

Overview
This concurrent process drops and recreates OE snapshots during the collection process.
Typically, it runs as part of concurrent process Refresh Collection Snapshots when 
profile option MSC: Source set up required is Yes.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Create OE Snapshots from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
None

Create PO Snapshots

Overview
This concurrent process drops and recreates PO snapshots during the collection process.
Typically, it runs as part of concurrent process Refresh Collection Snapshots when 
profile option MSC: Source set up required is Yes.
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Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Create PO Snapshots from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
None

Create Planning Flexfields

Overview
This concurrent process creates new segment definitions in existing descriptive 
flexfields to hold data that may be required for constrained and/or optimized planning. 
It also populates profile values with the value corresponding to the descriptive flexfield 
attribute number for each attribute (planning parameter) created.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Create Planning Flexfields from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Late Demands Penalty Attribute: The late demands penalty attribute.

Material Overcapacity Penalty (Item): The value that you want to maintain for the 
material capacity penalty cost at the item level.

Late Demands Penalty (Org): The value that you want to maintain for the late demands 
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penalty at the organization level.

Material Overcapacity Penalty (Org): The value that you want to maintain for the 
material overcapacity penalty at the organization level.

Resource Overcapacity Penalty (Org): The value that you want to maintain for the 
resource overcapacity penalty at the organization level.

Transportation Overcapacity Penalty (Org): The value that you want to maintain for the
transportation overcapacity penalty at the organization level.

Aggregate Resource (Resource): The value that you want to maintain for the aggregate 
resource at the resource level.

Resource Overcapacity Penalty (Resource): The value that you want to maintain for the 
resource overcapacity penalty at the resource level.

Material Overcapacity Penalty (Supplier): The value that you want to maintain for the 
material overcapacity penalty at the supplier level.

Substitute Items Priority: The value that you want to maintain for the substitute items 
priority.

Transportation Overcapacity Penalty (Ship Method): The value that you want to 
maintain for the transportation overcapacity penalty for the ship method.

BOM/Routing Cost: The value that you want to maintain for the Bill of Material (BOM) 
and Routing cost.

Late Forecasts Penalty: The value that you want to maintain for the late forecasts 
penalty.

Resource Group (Line): The value that you want to maintain for the resource group at 
the line level.

Demand Priority: The demand priority.

Create Resource Batch Planning Flexfields

Overview
For future use.

Create Setup and Run Flexfield

Overview
This concurrent process creates new segment definitions in existing descriptive 
flexfields to hold data that may be required for defining setup and run related 
information. 
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Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Create Setup and Run Flexfields from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Activity Group Id: The segment to be used for defining the activity group id.

Create WIP Snapshots

Overview
This concurrent process drops and recreates WIP snapshots during the collection 
process. Typically, it runs as part of concurrent process Refresh Collection Snapshots 
when profile option MSC: Source set up required is Yes.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Create WIP Snapshots from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
None
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Create WSH Snapshots

Overview
This concurrent process drops and recreates WSH snapshots during the collection 
process. Typically, it runs as part of concurrent process Refresh Collection Snaphots 
when profile option MSC: Source set up required is Yes.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Create WSH Snapshots from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
None

Create WSM Snapshots

Overview
This concurrent process drops and recreates WSM snapshots during the collection 
process. Typically, it runs as part of concurrent process Refresh Collection Snaphots 
when profile option MSC: Source set up required is Yes.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Create WSM Snapshots from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.
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Parameters
None

Create Zone Flexfields

Overview
This concurrent process creates new segment definitions in existing descriptive 
flexfields to hold data that may be required for planning and order promising. It also 
populates profile values with the value corresponding to the descriptive flexfield 
attribute number for each attribute (planning parameter) created.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Create Zone Flexfields from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Zone Usage: The segment to be used for defining the Zone usage.

Custom Exception Generator

Overview
This concurrent process creates user defined exceptions in Oracle Collaborative 
Planning

See also Oracle Collaborative Planning Implementation and User's Guide.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.
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3. Select Custom Exception Generator from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Exception Name: The name of the exception to be created.

Full Load: Select Yes to instruct the planning engine to calculate exceptions based on the
full set of data conditions. Select No to instruct the planning engine to calculate 
exceptions based on changed data from last run of the concurrent process.

Detail Scheduling Continuous Collection

Overview
For future use.

Detail Scheduling Data Pull

Overview
For future use.

Detail Scheduling ODS Load

Overview
For future use.

Download Profile Options Value

Overview
This concurrent process copies and captures the profile options value for each 
responsibility or user. It is typically used for debugging and regression testing. 

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.
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3. Select Download Profile Options Value from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Preference set name: The name for the preference set.

User Name: The user name whose profile options values will be downloaded.

Responsibility application: The application for which to download the profile values, 
for example, Inventory Planning, Collaborative Planning.

Responsibility name: The responsibility name for which the concurrent program will 
download the profile option values.

Schema Names: The Application Database schema names, for example, MSC, MSO.

File Name: The file name in which the profile values will be downloaded. 

Drop Collections Snapshot

Overview
This concurrent process drops the source snapshot definitions. Use it when there is an 
error or corruption in a particular snapshot or materialized view. The next collection 
recreates the snapshots. 

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Drop Collections Snapshot from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Snapshot Name: The name of the snapshot to drop.
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ERP Legacy Collections Request Set

Overview
This request set collects Oracle Applications data that is in flat file format and includes 
concurrent processes:

• Load Transaction Data

• Pre-Process Transaction Data

• Planning ODS Load

See also Running Collections.

Submission
1. In the Navigator, select Collections > Oracle Systems > Load Transaction Data using

Flat Files.

The Planning Data Collection window appears.

2. Set the parameters and click Submit.

Flat File Loader

Overview
This concurrent process loads legacy transaction data from flat files into the destination 
(planning) interface tables. Concurrent process Pre-Process Monitor validates the data 
from this load.

See also Running Collections.

Submission
The Legacy Collections request set automatically launches this concurrent process.

Parameters
File Path Separator: The file path separator. The value is unique to the operating system.

Control Files Directory: The complete path and name of the control file for loading the 
legacy data. 

Data Files Directory: The directory that contains the flat files.

Number of workers: The number of worker processes that you want to use to load the 
data.

In the remaining program parameters, specify the file name to be used to collect the 
entity. In case the data files directory is specified you just need to specify the file name. 
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Otherwise specify the complete path for each data file to load the particular entity being
selected for legacy load. 

• File Name: Demand Classes

• File Name: Bills of Material Headers

• File Name: Bills of Material Components

• File Name: Component Substitutes

• File Name: Items

• File Name: Routings

• File Name: Routing Operations

• File Name: Operation Resources

• File Name: Resource Groups

• File Name: Resources

• File Name: Resource Availability

• File Name: Resource Shifts

• File Name: Project Tasks

• File Name: Units of Measure

• File Name: Units of Measure Class Conversions

• File Name: Unit of Measure Conversions

• File Name: Category Sets

• File Name: Item Categories

• File Name: Item Sourcing

• File Name: Calendars

• File Name: Workday Patterns

• File Name: Shift Times

• File Name: Calendar Exceptions
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• File Name: Shift Exceptions

• File Name: Resource Requirements

• File Name: Item Suppliers

• File Name: Supplier Capacities

• File Name: Supplier Flex Fences

• File Name: Safety Stocks

• File Name: Trading Partners

• File Name: Trading Partner Sites

• File Name: Location Associations

• File Name: Sub Inventories

• File Name: Partner Contacts

• File Name: Shipping Methods

• File Name: Work Order Supplies

• File Name: Requisition Supplies

• File Name: On hand Supplies

• File Name: In transit Supplies

• File Name: Purchase Order Supplies

• File Name: Plan Order Designators

• File Name: Plan Order Supplies

• File Name: ASN Supplies

• File Name: Sales Order Demands

• File Name: Forecast Designators

• File Name: Forecast Demands

• File Name: Demand Schedule Designators
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• File Name: Demand Schedule Demands

• File Name: Work Order Component Demands

• File Name: Reservations

• File Name: Customer Items

• File Name: Item Substitutes

• File Name: Planners

• File Name: Operation Network

• File Name: Co-Products

• File Name: Job Operation Network

• File Name: Job Operation

• File Name: Job Requirement Ops

• File Name: Job Operation Resources

• File Name: Profiles

• File Name: Calendar Assignments

• File Name: Regions

• File Name: Zone Regions

• File Name: Region Locations

• File Name: Region Sites

Launch Supply Chain Planning Process Request Set

Overview
This concurrent request launches the concurrent request set that generates the plans. 
The request set includes:

• Memory-based snapshot and snapshot workers

• Memory-based planner and planner workers
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Prerequisites
• A plan name with plan options set.

• Enough system resources to avoid negative impacts on the online transaction 
processing.

Submission

Option 1
1. In the Navigator, select Supply Chain Plan > Launch.

The Submit a New Request window appears.

The Parameters window appears.

2. Set the parameters and click Submit.

Option 2
1. In the Navigator, select Supply Chain Plan > Names.

The Submit a New Request window appears.

The Parameters window appears.

2. Click Launch Plan.

3. Set the parameters and click Submit.

Parameters
Plan: The plan to launch.

Launch Snapshot: Specify whether to launch snapshot.

Launch Planner: Specify whether to launch the planner.

Anchor Date: The plan's Anchor date.

Enable 24x7 ATP: Specify whether to enable 24x7 order promising for this plan. 

Release reschedules: Specify whether to release reschedules in production plans. 

Snapshot Static Entities: Specify whether to snapshot static data, for example, suppliers 
and customers.

Launch Global Forecast Refresh: Automatically launches concurrent process Refresh 
Global Forecast Materialized Views.

Snapshot Source for Firm Planned Orders: Specify the source of firm planned orders 
into this plan:
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• <name of this plan>: The process uses firm planned orders from the Advanced 
Supply Chain Planning plan.. 

• <name of a Rapid Planning baseline or simulation plan>: The process uses firm 
planned orders from the Rapid Planning plan. See Simulating Plans in Oracle Rapid
Planning, Feeding Back from Rapid Planning.

Build Worksheet: Complete the worksheets you selected for the plan in Plan Options > 
tab Reporting.

Copy Plan Output to Simulation Plans: Automatically copy this plan to Rapid Planning 
as a baseline plan. Use Yes if you don't need to review the Advanced Supply Chain 
Planning plan before making it a Rapid Planning baseline plan

Legacy Collections Request Set

Overview
This request set collects legacy data that is in flat file format and includes concurrent 
processes:

• Flat File Loader

• Pre-process Monitor

• Planning ODS Load

See also Running Collections.

Submission
1. In the Navigator, select Collections > Legacy Systems > Collect Flat File Data.

The Planning Data Collection window appears.

2. Set the parameters and click Submit.

Load ATP Summary Based on Collected Data

Overview
Oracle Global Order Promising summarizes multiple supply and demand information 
in single-quantity buckets for each item / instance / organization / demand class. This 
concurrent process retrieves summary data for checking availability information. It 
improves available to promise performance because each inquiry does not need to 
compute availability from detailed supply and demand information.

See also Oracle Global Order Promising Implementation and User's Guide.
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Prerequisites
An ATP plan

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Load ATP Summary Based on Collected Data from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Instance: The instance-organization against which you want to run the concurrent 
process.

Load Method: Select the load method to use--complete, net change, or targeted.

Refresh Sales Orders: Select Yes to refresh sales orders in the summary.

Supplies/Demands: Select Yes to include supplies and demands in the summary.

Load ATP Summary Based on Planning Output

Overview
Oracle Global Order Promising summarizes multiple supply and demand information 
in single-quantity buckets for each item / instance / organization / demand class. 
Summary information changes as you get new orders and create new supplies through 
capable to promise. This concurrent process helps you determine and use incremental 
changes to the summary data by restricting the data summarization to be done on a 
specific plan. It may improve available to promise performance.

See also Oracle Global Order Promising Implementation and User's Guide.

Prerequisites
A completed supply chain plan.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.
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2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Load ATP Summary Based on Planning Output from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Plan_id: The plan ID.

Load Transaction Data

Overview
This concurrent process loads Oracle Applications transaction data from flat files into 
the destination (planning) interface tables. Concurrent process Pre-Process Transaction 
Data validates the data from this load.

See also Running Collections.

Submission
The ERP Legacy Collections request set automatically launches this concurrent process.

Parameters
Time Out Duration: The length of time in minuted that the process should wait in 
suspension before terminating. The default is 1440.

File Patch Separator: Separator used in file names of later parameters. The default is /.

Control Files Directory: The complete path and name of the control file for loading the 
legacy data. 

Data Files Directory: The directory that contains the flat files.

Total Number of Workers: The number of worker processes that you want to use to 
load the data.

In the remaining program parameters, specify the file name to be used to collect the 
entity. In case the data files directory is specified you just need to specify the file name. 
Otherwise specify the complete path for each data file to load the particular entity being
selected for legacy load. 

• File Name: Resource Requirements

• File Name: Supplier Capacities

• File Name: Supplier Flex Fences
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• File Name: Work Order Supplies

• File Name: Requisition Supplies

• File Name: On hand Supplies

• File Name: In transit Supplies

• File Name: Purchase Order Supplies

• File Name: Plan Order Designators

• File Name: Plan Order Supplies

• File Name: ASN Supplies

• File Name: Sales Order Demands

• File Name: Forecast Designators

• File Name: Forecast Demands

• File Name: Demand Schedule Designators

• File Name: Demand Schedule Demands

• File Name: Work Order Component Demands

MDS Data Collection

Overview
This concurrent process loads master demand schedule data from the source instance 
without affecting the rest of the collected data.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select MDS Data Collection from the Reports list.

The Parameters window appears.
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4. Set the parameters and click Submit.

Parameters
Instance: The instance-organization against which you want to run the concurrent 
process.

Planning Data Collection - Purge Staging Tables

Overview
This concurrent process deletes the data from the staging tables. Use it either before 
regenerating and launching a new data pull or after the collections data pull fails. 

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Planning Data Collection - Purge Staging Tables from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Instance: The instance-organization against which you want to run the concurrent 
process.

Validation: Specify whether the concurrent process needs to verify if a planning data 
collection is running.

Planning Data Collection Request Set

Overview
This request set performs data collection and includes concurrent processes:

• Planning Data Pull

• Planning ODS Load

See also Running Collections.



Reports and Concurrent Processes    22-47

Submission
1. In the Navigator, select Collections > Oracle Systems > Standard Collection.

The Planning Data Collection window appears.

2. Set the parameters and click Submit.

Planning Data Pull

Overview
This concurrent process pulls Oracle Applications data from the source (transaction) 
instance to the destination (planning) instance interface tables.

See also Running Collections.

Prerequisites
The refresh snapshot process should have completed successfully.

Submission

Option 1
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Planning Data Pull from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Option 2
The Planning Data Collection request set automatically launches this concurrent 
process.

Parameters
Instance: The instance-organization against which you want to run the concurrent 
process.

Collection Group: The collection group.

Number of Workers: The number of workers that the process should use.
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Timeout (minutes): The time out in minutes after which the process will fail. 

Purge Previously Collected Data: Indicate whether or not to purge previously collected 
data before pulling this data. 

Collection Method: The method of collection indicating whether to complete refresh or 
not. 

Analyzing Staging Tables: Indicate whether to analyze staging tables and gather 
statistics for the staging table.

In the remaining program parameters, specify whether or not to collect each entity:

• Approved Supplier Lists (Supplier Capacities)

• ATP Rules

• Bills of Materials / Routings / Resources

• Bills of Resources

• Calendars

• Demand Classes

• End Item Substitutions

• Forecasts

• Items

• Key Performance Indicator Targets

• Master Demand Schedules

• Master Production Schedules

• On Hand

• Planning Parameters

• Planners

• Projects/Tasks

• Purchase Orders/Purchase Requisitions

• Reservations

• Safety Stock
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• Safety Orders

• Sourcing History

• Sourcing Rules

• Subinventories

• Supplier Responses

• Suppliers/Customers/Orgs

• Transportation Details

• Unit Numbers

• Units of Measure

• User Company Association

• User Supplies and Demands

• Work In Process

Planning ODS Load

Overview
This concurrent process moves data from the destination (planning) instance interface 
tables to the destination (planning) instance planning tables.

See also Running Collections.

Prerequisites
Successful completion of planning data pull process. 

Submission

Option 1
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Planning ODS Load from the Reports list.
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The Parameters window appears.

4. Set the parameters and click Submit.

Option 2
The ERP Legacy Collections, Legacy Collections, and Planning Data Collections request 
sets automatically launch this concurrent process.

Parameters
Instance: The instance-organization against which you want to run the concurrent 
process.

Timeout (Minutes): Indicate timeout minutes beyond which the concurrent process will 
fail.

Number of Workers: The number of workers that the process should use.

Resource Availability: Indicate whether to compute resource availability.

Recalculate Sourcing History: Indicate whether to recalculate sourcing history.

Purge Sourcing History: Indicate whether to purge the sourcing history.

Pre-Process Monitor

Overview
This concurrent process preprocesses legacy transaction data in the destination 
(planning) instance interface tables and generates IDs. It validates data loaded using 
concurrent process Flat File Loader.

See Legacy Collection, page 4-23.

Prerequisites
Successful completion of the Flat File Loader process.

Submission
The Legacy Collections request set automatically launches this concurrent process.

Parameters
Instance: The instance against which you want to run the concurrent process.

Processing Batch Size: The processing Batch Size in terms of number of rows.

Total Number of Workers: The total number of workers to be used for validating the 
data. 

In the remaining program parameters specify whether to include certain types of data 
for validation. 
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• Process Calendars

• Process Demand Class

• Process Trading Partners

• Process category Sets

• Process Product Categories

• Process Units of Measure

• Process UOM Conversions

• Process Designators

• Process Projects and Tasks

• Process Items

• Process Suppliers

• Process Safety Stock

• Process Shipping Methods

• Process Sourcing Rules

• Process Bills of Materials

• Process Routings

• Process Resources

• Process Material Supplies

• Process Material Demands

• Process Reservations

• Process Resource Demands

• Process Customer Items

• Process Item Substitutes

• Process Planners
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• Process Profiles

• Process Calendar Assignments

Pre-Process Transaction Data

Overview
This concurrent process preprocesses Oracle Applications transaction data in the 
destination (planning) instance interface tables and generates IDs. It validates data 
loaded using concurrent process Load Transaction Data.

See also Running Collections.

Prerequisites
Successful completion of concurrent process Load Transaction Data.

Submission
The ERP Legacy Collections request set automatically launches this concurrent process.

Parameters
Instance: The instance in which you want to load the transaction data.

Plan: The plan against which you want to run the concurrent process.

Purge Collaborative Planning Historical Records

Overview
This concurrent process purges data collected into Oracle Collaborative Planning and 
saves it in a history table. Successive data collections increase the size of the table and 
may affect performance.

See also Oracle Collaborative Planning Implementation and User's Guide.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Purge Collaborative Planning Historical Records from the Reports list

The Parameters window appears.
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4. Set the parameters and click Submit.

Parameters
From Date: The first date from which to purge records.

To Date: The last date through which to purge records.

Order Type: A specific order type to purge.

Purge Designator

Overview
This concurrent process schedules the plan purge activity.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Purge Designator from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
None

Purge Interface Tables

Overview
This concurrent process purges Oracle Applications and legacy data from the 
destination (planning) interface tables. Use it before launching new collections when a 
previous data collection run failed or if you fine data corruption in the interface tables. 

See also Running Collections

Submission

Option 1
1. In the Navigator, select Collections > Oracle Systems > Purge Interface Tables.
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The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Purge Interface Tables from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Option 2
1. In the Navigator, select Collections > Legacy Systems > Purge Interface Tables.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Purge Interface Tables from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Instance code: The instance of the legacy source.

Delete Rejected Records Only: Specify wether to delete only the rejected records or all 
records.

Purge Legacy Data

Overview
This program deletes all the records that are collected from a legacy source. 

Submission
1. In the Navigator, select Collections > Legacy Systems > Purge Collected Data.

The Launch Purge Program for Collected data window appears.

The Parameters window appears.

2. Set the parameters and click Submit.
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Parameters
Instance: The instance of the legacy source.

Complete Refresh: Specify whether to perform complete refresh or not. 

Delete Records Up to Date: The date range up to which all the records will be deleted 
from the collected data. 

Delete Supplies: Specify whether to delete supply related entries from the collected 
data.

Delete Demands: Specify whether to delete demand related entries from the collected 
data.

Push Plan Information

Overview
This concurrent process deletes an entire plan on the source instance and then replaces 
it with a copy of the current plan from the destination instance.

Prerequisites
A plan that has been run successfully.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Push Plan Information from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Instance

Plan Type

Plan Name

Buy Orders Only: The default is No.

Demand: If you select Yes, the process purges and re-populates table 
mrp_gross_requirements with requirements from the plan. If you select No, the 
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process leaves the data in table mrp_gross_requirements. The default is Yes.

Organization Code: The list of values contains the planned organizations of the selected
plan.

Planner: The list of values contains the planners of the items planned in the selected 
plan.

Category: The list of values contains the categories in the default planning category set.

Item: You can select a specific item. If you leave this parameter blank, the process 
pushes information for all items planned in the selected plan.

Supplier: The list of values contains the suppliers in the plan assignment set. You can 
select a value for this parameter only if:

• Buy Orders Only is Yes

• Demand is No

Supplier Site: The list of values contains the supplier sites in the plan assignment set. 
You can select a value for this parameter only if:

• Supplier has a value

• Demand is No

Horizon Start Date: The earliest Suggested Due Date for which you want plan 
information pushed. If you leave this parameter blank, the process begins with the plan 
start date.

Horizon End Date: The latest Suggested Due Date for which you want plan information
pushed. The default is one year from today. If you leave this parameter blank, the 
process ends with the plan horizon.

Overwrite Behavior
If the fields Organization, Planner, Category, Item, Supplier, Supplier Site, Horizon 
Start Date, and Horizon End Date are all blank, the process:

• Deletes the plan information on the source instance

• Copies the plan information from the destination instance to the source instance

If the is a value in at least one of the fields Organization, Planner, Category, Item, 
Supplier, Supplier Site, Horizon Start Date, and Horizon End Date, the process:

• Deletes the plan information on the source instance that matches the criteria with 
values. The supplies and demands that do not match the criteria are not deleted.

• Copies the plan information from the destination instance to the source instance. 
The supplies and demands originally on the source instance that did not match the 
criteria stay as they were before the execution of the Push Plan Information process.
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If you perform rolling horizon pushes (plan start date to planning horizon) for 
consecutive runs of the same plan, leave Horizon Start Date blank. This eliminates the 
possibility duplicate orders pushed to the source instance.

To see the plan, navigate to responsibility Supply Chain Planner. You cannot see it in 
the MRP Names form.

The process does not release planned orders on the source. Also, it does not change:

• Planned order status from Released to None

• The row color to pink 

Example 1: Minimal Criteria
Settings:

• Buy Orders Only: No

• Demand: Yes

• Organization, Planner, Category, Item, Supplier, Supplier Site, Horizon Start Date, 
Horizon End Date: <blank>

The process:

• All supplies and demands from the selected plan in the source instance are deleted.

• All supplies and demands from the selected plan in the destination instance are 
copied to the source instance.

Example 2: Buy Orders Only
Settings: 

• Buy Orders Only: Yes

• Demand: Yes

• Organization, Planner, Category, Item, Supplier, Supplier Site, Horizon Start Date, 
Horizon End Date: <blank>

The process:

• All supplies and demands from the selected plan in the source instance are deleted.

• Buy orders from the selected plan in the destination instance are copied to the 
source instance.

Example 3: Multiple Criteria
Settings:



22-58    Oracle Advanced Supply Chain Planning Implementation and User's Guide

• Buy Orders Only: Yes

• Demand: No

• Planner: JSmith

• Horizon Start Date: 18-Feb-2004

• Horizon End Date: 30-Jun-2004

• Organization, Category, Item, Supplier, Supplier Site: <blank>

The process:

• All supplies and demands corresponding to the selected plan that satisfy ALL of the
following conditions are deleted from the source instance:

• Item planner = Jsmith

• Suggested Due Date >= 18-Feb-2004

• Suggested Due Date <= 30-Jun-2004

• All other supplies and demands in the source instance corresponding to the 
selected plan are left untouched.

• All supplies and demands from the selected plan in the destination instance that 
satisfy the conditions are copied to the source instance.

Inconsistent Data Warning
The concurrent process flags the risk of inconsistent plan data when it runs multiple 
times against the same plan name. If both of these conditions occur, the concurrent 
process completes the deletions and copies and issues a warning in its log file:

• The launch date/time of the plan being pushed is later than the launch date/time 
that was used in the last run of that plan name.

• The push process does not completely overwrite all data for the pushed plan in the 
source instance.

The warning text is "WARNING: Risk of inconsistent plan information. The Push Plan 
Information process has caused supply/demand data from multiple runs of plan <plan 
name> to be present on the source instance. Plan launch date/time at previous Push 
Plan Information run = <date 1>. Plan launch date/time at current Push Plan 
Information run = <date 2>."

The concurrent process does not identify which specific data came from which plan 
launch date/time.
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Example 1: Warning not issued
18-Feb: Run planning process for orgs ORG1, ORG2, and ORG3

18-Feb: Run Push Plan Information concurrent process for ORG1, ORG2, and ORG3

No warning issued

Data in source instance corresponds to:

• ORG1 data as of 18-Feb

• ORG2 data as of 18-Feb

• ORG3 data as of 18-Feb

19-Feb: Run planning process for orgs ORG1, ORG2, and ORG3

19-Feb: Run Push Plan Information concurrent process for ORG1, ORG2, and ORG3

No warning issued (because all source data overwritten)

Data in source instance corresponds to:

• ORG1 data as of 19-Feb

• ORG2 data as of 19-Feb

• ORG3 data as of 19-Feb

Example 2: Warning issued
18-Feb: Run planning process for orgs ORG1, ORG2, and ORG3

18-Feb: Run Push Plan Information concurrent process for ORG1, ORG2, and ORG3

No warning issued

Data in source instance corresponds to:

• ORG1 data as of 18-Feb

• ORG2 data as of 18-Feb

• ORG3 data as of 18-Feb

19-Feb: Run planning process for orgs ORG1, ORG2, and ORG3

19-Feb: Run Push Plan Information concurrent process for ORG1

Warning issued (because previous plan launch date = 18-Feb, current plan launch date =
19-Feb, and not all source data overwritten)

Data in source instance corresponds to:

• ORG1 data as of 19-Feb



22-60    Oracle Advanced Supply Chain Planning Implementation and User's Guide

• ORG2 data as of 18-Feb

• ORG3 data as of 18-Feb

20-Feb: Run Push Plan Information concurrent process for ORG2

No warning issued (because previous plan launch date = 19-Feb and current plan 
launch date = 19-Feb)

Data in source instance corresponds to:

• ORG1 data as of 19-Feb

• ORG2 data as of 19-Feb

• ORG3 data as of 18-Feb

Realign Operational Data Stores Dates

Overview
This concurrent process makes mass update of the dates for records present in the 
collected data. Use it for quality assurance and regression testing. 

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Realign Operational Data Stores Dates from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Instance: The instance-organization against which you want to run the concurrent 
process.

Time Factors (In Days): The time factor for shifting the dates forward. 
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Refresh Allocation Hierarchy Materialized View

Overview
This concurrent process determines the allocation rules to be used. Run it after making 
changes to allocation rules or assignments. 

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Refresh Allocation Hierarchy Materialized View from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
None

Refresh Collection Snapshots

Overview
This concurrent request refreshes the snapshot in the source. After the refresh, the 
snapshot reflects the most current master data.

If profile option MSC: Source set up required is Yes, this process runs the following 
concurrent processes:

• Create AHL Snapshots

• Create BOM Snapshots

• Create INV Snapshots

• Create MRP Snapshots

• Create OE Snapshots

• Create PO Snapshots

• Create WIP Snapshots
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• Create WSH Snapshots

• Create WSM Snapshots

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Refresh Collection Snapshots from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Refresh Mode: The refresh mode: Fast, Complete, or Automatic.

Snapshot Name: The snapshot that you want to refresh.

Threshold for Truncating Logs: The threshold for truncating the snapshot log file. 

Degree: The maximum degree of parallelism; the default is 0 which signifies Serial.

Refresh Global Forecast Materialized Views

Overview
This concurrent process converts the global forecast materialized views into populated 
tables for performance improvement.

Prerequisites
A data collection that changes the global forecasting information. For example, you can 
launch this process after: 

• Every collection

• Changing or creating plans

• Changing sourcing rules

• Changing assignment sets 
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Submission
The Launch Supply Chain Planning Process request set automatically launches this 
concurrent process if needed.

Parameters
Plan ID: If entered, the concurrent process runs for that plan only. If blank, the 
concurrent process runs for all plans with global forecasts.

Refresh KPI Summary Data
Obsolete; to display key performance indicators, select plan option Display Key 
Performance Indicators (Main tab).

Refresh Materialized Views

Overview
Oracle Global Order Promising chooses the plan that it uses for ATP purposes for all 
instance / item / organization / demand class combinations, this concurrent process 
improves that performance. It refreshes snapshot MSC_ATP_PLAN_SN.

See also Oracle Global Order Promising Implementation and User's Guide.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Refresh Materialized Views from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Materialized view name: Always enter MSC_ATP_PLAN_SN.

Release Sales Order Recommendations

Overview
This concurrent process posts sales order changes to the source instance. These changes 
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are recommended by the planning engine and released from Planner Workbench, for 
example, assignment of a shipping organization with global forecasting and 
replacement of line item from end item substitution. 

Prerequisites
Released sales order recommendations from Planner Workbench..

Submission
The Planner Workbench release process automatically launches this concurrent process.

Parameters
None.

Register Ask Oracle Planning Question
Not used.

Send XML Releases to Legacy Sources

Overview
This concurrent process pushes the release information via XML to a source legacy 
application. It is equivalent to the process that pushes release information to the Oracle 
Applications source instance.

See also Oracle Collaborative Planning Implementation and User's Guide.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Send XML Releases to Legacy Sources from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Instance code: The instance code of the legacy source.

Send Rescheduled Purchase Orders: Indicate whether to send rescheduled purchase 
orders.
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Send Rescheduled Work Orders: Indicate whether to send rescheduled work orders.

Send New Requisitions: Indicate whether to send new requisitions.

Send New Work Orders: Indicate whether to send new work orders.

Address of Destination System: Indicate whether the legacy source has an address or 
not.

Protocol (HTTP/SMTP/HTTP-OXTA): The message protocol to use to format the 
transactions.

User Name for Destination System: The user sign-on name at the legacy system.

Password for Destination System: The password for the user sign-on name at the legacy
system.

Supply Chain Event Manager

Overview
Trading partners and original equipment manufacturers post information such as 
supply, demand, and capacities into Oracle Collaborative Planning. This concurrent 
process identifies data conditions that may create imbalance in the supply chain and 
that you may need to manage.

See also Oracle Collaborative Planning Implementation and User's Guide.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select Supply Chain Event Manager from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
You can generate exceptions based on events for groups of events.

Late orders:

• Late replenishment to customer

• Late replenishment from supplier
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• Replenishment to customer is past due

• Replenishment from supplier is past due

Material shortage:

• Supply commit is less than customer order forecast

• Supplier supply commit is less than order forecast

• Short supply for customer purchase order

• Short supply from supplier for purchase order

• VMI item shortage at customer site, replenishment required

• VMI item shortage at your site

Response required:

• Response required for customer purchase order

• Supplier response required for purchase order

• Response required for supplier sales order

• Customer response required for sales order

Potential late orders:

• Potential late order due to upstream lateness

• Purchase order compresses lead time

• Customer purchase order compresses lead time

• Sales order requires lead time compression

Forecast mismatch:

• Customer sales forecast exceeds your sales forecast

• Customer sales forecast is less than your sales forecast

• Supplier sales forecast exceeds your sales forecast

• Supplier sales forecast is less than your sales forecast

Early orders:

• Early replenishment to customer
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• Early replenishment from supplier

Material excess:

• Supply commit exceeds customer order forecast

• Supplier supply commit exceeds order forecast

• Excess replenishment for customer purchase order

• Excess replenishment from supplier for purchase order

• VMI item excess at customer site

• VMI item excess at your site

Changed orders:

• Customer purchase order has been cancelled

• Customer purchase order has been rescheduled

• Customer purchase order has been rejected

Forecast accuracy:

• Customer sales forecast exceeds actual sales

• Sales forecast exceeds actual sales

• Customer order forecast exceeds actual orders

• Order forecast exceeds actual orders

Performance below target:

• Customer forecast error exceeds threshold

• Forecast error exceeds threshold

• Supplier has exceeded a stock-out threshold

• You have exceeded a stock-out threshold

• Supplier fill rate is below threshold

• Fill rate to customer is below threshold

• Supplier on-time delivery performance is below threshold
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• On-time delivery performance is below threshold

• Inventory turns for VMI item below threshold

• Customer inventory turns for VMI item below threshold

Custom exceptions scheduled with standard exceptions 

VMI Replenishment Engine

Overview
This concurrent process detects the need for and generates vendor-managed inventory 
replenishments. 

See also Oracle Collaborative Planning Implementation and User's Guide.

Submission
1. In the Navigator, select Setup > Run Requests.

The Submit a New Request window appears.

2. Select Single Request and click OK.

The Submit Request window appears.

3. Select VMI Replenishment Engine Concurrent Process from the Reports list.

The Parameters window appears.

4. Set the parameters and click Submit.

Parameters
Replenishments from Suppliers: Choose to generate vendor managed inventory 
replenishments managed by suppliers supplying to original equipment manufacturers.

Replenishment Time Fence Multiplier (> =1): For Replenishments from Suppliers, 
choose to increase the duration in which the vendor managed inventory engine 
evaluates supplies by a multiplier of the lead times.

Replenishments to Customers: Choose to generate vendor managed inventory 
replenishments managed by you for your customers.

Replenishment Time Fence Multiplier (> =1): For Replenishments to Customers, choose 
to increase the duration in which vendor managed inventory engine evaluates supplies 
by a multiplier of the lead times.
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A
Profile Options

This appendix covers the following topics:

• Special Considerations 

• INV Profile Options

• MRP and CRP Profile Options

• MSC Profile Options

• MSD Profile Options

• MSO Profile Options

• MSR Profile Options

Special Considerations 

Automatic Calculations
When the Default Value of a profile option states that it is automatically calculated, this 
means that the Planning Engine determines the default value of that particular profile 
option. These profile options are included in this appendix for information purposes 
only. If you must change these profile option values, do so only after consulting Oracle 
Development and Oracle Support.

Flexfield Attributes
Flexfield attribute profile options store the name of the flexfield column that contains 
the value in the corresponding table. For example, if the Aggregate Resource Name is 
stored in column ATTRIBUTE1, the profile option MSC: Aggregate Resource Name 
Flexfield Attribute will contain the value 1.

This setup is performed only during an Oracle Applications installation. Do not modify 
it unless absolutely necessary.
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Floating Point Precision
Certain quantities used by Oracle Advanced Supply Chain Planning have fractional 
values. For internal processing purposes these quantities must have integer values. To 
resolve this problem, floating-point precision profile options act as internal multipliers. 
When a fractional quantity is encountered it is multiplied by the appropriate 
floating-point precision profile option value, and the resulting integer is processed by 
the Planning Engine.

There are several floating-point precision profile options. This enables greater flexibility
in controlling the precision with which to consider each quantity. It also provides more 
flexibility to avoid numerical overflow on 32-bit platforms where the each equivalent 
integer processed by the Planning Engine cannot exceed 2.1 x 109. The floating-point 
precision profile options are: Floating Point Precision for Usages in Routing, Floating 
Point Precision, Floating Point Precision for Transportation Capacities (Weight and 
Volume), Floating Point Precision for Planning Bucket Efficiency.

INV Profile Options
The following table lists and defines the INV profile options in Oracle Advanced 
Planning.

Profile Option 
Name

Valid Values Default Value Description

INV: Capable to 
Promise

ATP/CTP 
Based on 
Planning 
Output, ATP 
Based on 
Collected Data

ATP Based on 
Collected Data

This is a site level profile. Valid 
values are:

• ATP/CTP Based on Planning 
Output: set the profile to this 
value if you want to use the 
Oracle Advanced Supply Chain 
Planning output for order 
promising.

• ATP Based on Collected Data: 
set the profile to this value if 
you want to use collected data 
for order promising.

INV: External ATP Not applicable Not applicable Only set up on source instance. Set 
this profile to Global ATP Server if 
Oracle Global Order Promising is 
deployed. This is a site level profile.
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MRP and CRP Profile Options
The following table lists and defines the MRP and CRP profile options available with 
Oracle Advanced Planning.

Profile Option 
Name

Valid Values Default Value Description

CRP: Spread 
discrete 
requirements

Yes/No No The planning engine usually sets 
resource requirement end dates in 
both production and 
manufacturing plans. However, if 
this profile option is Yes for a 
production plan, the planning 
engine does not set resource 
requirement end dates.

MRP: Activate OLP - - Not used by Oracle Advanced 
Planning. 

MRP: ATP 
Assignment Set

Text Null Indicates the assignment set name 
for use with Oracle Global Order 
Promising. When set to Null, 
Oracle Global Order Promising 
uses the assignment set from 
profile MSC: ATP Assignment Set 
from Oracle Advanced Planning 
Solution instance. Update this 
profile at site level on the source 
instance.

MRP: ATP Database
Link

Text Null Determines whether distributed 
Order Promising is used. 

MRP: Backlog 
Progress Timeout

- - Not used by Oracle Advanced 
Planning. 
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Profile Option 
Name

Valid Values Default Value Description

MRP: Calculate 
Excess Exceptions 
on Time Fence

Yes/No Yes Indicates whether excess 
exceptions are calculated at the 
time fence or up to the time fence. 
Valid values are:

- Yes: The planning engine issues 
exceptions only at the time fence 
date.

- No: The planning engine issues 
individual exceptions.

MRP: Calculate Plan
Performance

- - Not used by Oracle Advanced 
Planning. 

MRP: Calculate 
Supply Demand

Yes/No Yes Controls whether you calculate 
supply demand for an order 
promising check. Can update at 
site level. 

MRP: Category Set 
for Backlog Form

- - Not used by Oracle Advanced 
Planning.

MRP: Combine 
Sugg Rep Schedules

Yes/No Yes Combines repetitive schedules, if 
scheduled back-to-back for the 
same quantity. Used only by 
unconstrained plans.

MRP: Compute 
Sales Order 
Changes

- - Not used by Oracle Advanced 
Planning. 

MRP: Compute 
Standard 
Mandatory 
Components for 
ATO Models

Yes/No Yes Prevents mandatory component 
demands for ATO Models 
calculation during refresh snapshot
process when set to No. Omission 
of this process can increase 
performance. Must be set on the 
source instance.

MRP: Consume Fcst
Set Summary

- - Not used by Oracle Advanced 
Planning. 
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Profile Option 
Name

Valid Values Default Value Description

MRP: Consume 
Forecast

- - Not used by Oracle Advanced 
Planning. 

MRP: Consume 
MDS

- - Not used by Oracle Advanced 
Planning. 

MRP: Consume 
MPS

- - Not used by Oracle Advanced 
Planning. 

MRP: Create Time 
fence

Yes/No Yes Set to Yes to create a natural time 
fence based on firm work orders, 
purchase orders, flow schedules, 
and shipments. When set to No, 
the planning engine does not create
a time fence.

The planning engine honors the 
item attribute Planning Time Fence
regardless of the value of this 
profile option 

MRP: Cutoff Date 
Offset Months

Integer >= 0 6 Determines how many months of 
resource availability should be 
computed for resources and 
simulation sets. No resource 
availability is calculated beyond 
this horizon. For constrained plans 
beyond this horizon, resource 
capacity resource capacity is not 
available until the planning 
horizon.

MRP: Cutoff 
History Days

- - Not used by Oracle Advanced 
Planning. 

MRP: Debug Mode Yes/No No Enables debug messages within 
Oracle MRP when set to Yes. It 
captures details about runs of 
concurrent process WIP Mass 
Load. 

MRP: Default 
Criteria Set

- - Not used by Oracle Advanced 
Planning. 
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Profile Option 
Name

Valid Values Default Value Description

MRP: Default DRP 
Plan Name

- - Not used by Oracle Advanced 
Planning. 

MRP: Default 
Forecast Date

- - Not used by Oracle Advanced 
Planning. 

MRP: Default 
Forecast Name

- - Not used by Oracle Advanced 
Planning. 

MRP: Default Plan 
Name

- - Not used by Oracle Advanced 
Planning. 

MRP: Default 
Schedule Name

- - Not used by Oracle Advanced 
Planning. 

MRP: Default 
Sourcing 
Assignment Set

- - Not used by Oracle Advanced 
Planning. 

MRP: Demand Time
Fence Days

- - Not used by Oracle Advanced 
Planning. 

MRP: Enhanced 
Exception

- - Not used by Oracle Advanced 
Planning.

MRP: Environment 
variable to set path 
for MRP files

Text Null Specifies appropriate path for the 
MRP files. If this profile option is 
not used, files are written to 
$MRP_TOP/$APPLOUT.

MRP: Explode 
Demand Through 
Phantom 
Component

- -  
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Profile Option 
Name

Valid Values Default Value Description

MRP: Firm Internal 
Req Transferred to 
OE

Yes/No Yes This profile option specifies 
whether or not Oracle Advanced 
Supply Chain Planning should 
recommend reschedule messages 
for internal requisitions that have 
been linked to internal sales orders 
in Oracle Order Management. 
Valid values are:

- Yes: All internal requisitions 
transferred to Oracle Order 
Management are treated as firm 
supplies by Oracle Advanced 
Supply Chain Planning. 

- No: Oracle Advanced Supply 
Chain Planning may generate 
reschedule recommendations for 
these internal requisitions. 

Rescheduled recommendations 
cannot be released to purchasing 
for internal requisitions. To 
reschedule recommendations, 
cancel the internal requisition in 
the source instance and create a 
new requisition with the new date.

MRP: Firm Planned 
Order Time Fence

Yes/No Yes Set to Yes for firm planned orders 
to create a natural time fence. 
When set to No, the Planning 
Engine does not create a time fence
at a firm planned order. 

MRP: Firm 
Requisitions within 
time fence

- - Not used. Replaced by profile 
option MSO: Firm Requisitions 
within Time Fence.

MRP: Include Schd 
Rcpts in Use-up

Yes/No No If set to Yes it includes scheduled 
receipts when computing the 
engineering change order use-up 
date.
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Profile Option 
Name

Valid Values Default Value Description

MRP: Include 
Substitute 
Components

Yes/No No Indicates whether to include 
substitute components in Order 
Promising calculation. Can update 
at the site level.

MRP: Interface 
Table History Days

- - Not used by Oracle Advanced 
Planning. 

MRP: Maintain 
Original Schedule 
Version

- - Not used by Oracle Advanced 
Planning. 

MRP: MPS Relief 
Direction

- - Not used by Oracle Advanced 
Planning. 

MRP: Net All 
Purchase Orders 
Prior To 
Requisitions

Yes/No No Use this profile to specify whether 
or not the planning engine should 
net all existing supplies prior to 
netting purchase requisitions. The 
valid values are:

- Yes: Net purchase orders, then 
net purchase requisitions. This may
result in purchase requisitions with
schedule dates earlier than 
purchase orders being canceled or 
rescheduled out.

- No: Net purchase orders and 
purchase requisitions together.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.
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Profile Option 
Name

Valid Values Default Value Description

MRP: New 
Backward Planner 
Compatibility

Yes/No No Use tis profile option to instruct the
planning engine which sort of item 
to consider phantom items. Valid 
values are:

- Yes: Plan phantoms as standard 
items, create planned orders

- No: Plan phantoms as phantom 
items, do not create planned orders

See also profile option MSC: New 
Planner Backward Compatibility.

MRP: Old Sales 
Orders Cutoff Days

- - Not used by Oracle Advanced 
Planning. 

MRP: Perform 
Planning Manager 
Functions in Loads

- - Not used by Oracle Advanced 
Planning. 

MRP: Plan Revenue 
Discount Percent

Text Null Specifies the average discount 
percent applied to all items in a 
plan. This value is a key 
performance indicator used to 
calculate performance in a plan for 
Business Intelligence reports.

MRP: Plan Revenue 
Price List

Numeric Null Specifies the sales order price list 
applied to items in a plan. Used to 
calculate the plan margin key 
performance indicators for 
Business Intelligence reports.

MRP: Planner Batch 
Size

- - Not used by Oracle Advanced 
Planning.

MRP: Planner 
Workers

- - Not used by Oracle Advanced 
Planning. 

MRP: Planning 
Manager Batch Size

- - Not used by Oracle Advanced 
Planning. 
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Profile Option 
Name

Valid Values Default Value Description

MRP: Planning 
Manager Max 
Workers

- - Not used by Oracle Advanced 
Planning. 

MRP: Planning 
Manager Run First 
Time

- - Not used by Oracle Advanced 
Planning. 

MRP: Purchasing By
Revision

Yes/No Yes When set to Yes, creates purchase 
requisitions using the latest 
revision date on the item.

MRP: Purge Batch 
Size

Numeric 25000 Used by Oracle Advanced Supply 
Chain Planning collections and 
Snapshot. 

MRP: Repetitive 
Past Due Supply 
Days

- - Not used by Oracle Advanced 
Planning.
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Profile Option 
Name

Valid Values Default Value Description

MRP: Requisition 
Load Group Option

All on One, 
Buyer, 
Planner, 
Vendor, 
Category, 
Item, One 
Each

Null Indicates group by option used 
when loading requisitions using 
the Planner Workbench form. The 
planning engine uses the value of 
this profile option when there is no
value for window Plan Preferences 
> tab Other, field Req Group By.

Valid values are:

- All on One: Creates one purchase 
requisition for all recommended 
orders 

- Buyer: Creates one purchase 
requisition for each buyer; within 
each requisition, creates one line 
for each planned order

- Planner: Creates one purchase 
requisition for each planner; within
each requisition, creates one line 
for each planned order 

- Vendor: Creates one purchase 
requisition for each vendor; within 
each requisition, creates one line 
for each planned order 

- Category: Creates one purchase 
requisition for each item category; 
within each requisition, creates one
line for each planned order

- Item: Creates one purchase 
requisition for each item; within 
each requisition, creates one line 
for each planned order

- One each: Creates a purchase 
requisition for each planned order

MRP: Retain Dates 
Within Calendar 
Boundary

Yes/No No Determines whether to pull dates 
outside the calendar boundary into
calendar horizon.
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Profile Option 
Name

Valid Values Default Value Description

MRP: RHX Check 
Profile

- - Not used by Oracle Advanced 
Planning.

MRP: Round Source
Entries

- - Not used by Oracle Advanced 
Planning.

MRP: Snapshot 
Pause for Lock 
(Minutes)

- - Not used by Oracle Advanced 
Planning. 

MRP: Snapshot 
Workers

Integer >= 0 1 Determines number of workers 
launched by the snapshot monitor. 
When set to 0, the Snapshot runs as
a single- threaded process. 
Snapshot workers collect data on 
bills of material, work in process, 
on- hand quantities, purchasing, 
firm planned orders, routings, and 
work-in-process job resource 
requirements.

MRP: Sourcing Rule
Category Set

- - Not used by Oracle Advanced 
Planning. 

MRP: Time Fence 
Warning

- - Not used by Oracle Advanced 
Planning. 

MRP: Trace Mode Yes/No No Determines whether trace is 
enabled for all Oracle Advanced 
Supply Chain Planning processes.

MRP: Use Direct 
Load Option

Yes/No No Determines whether load worker 
can use the direct load option 
instead of conventional loads.
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Profile Option 
Name

Valid Values Default Value Description

MRP: Use Ship 
Arrived Flag

Yes/No No This profile is used when collecting
Intransit Supplies.

If Yes, then we check the 
wsh_new_deliveries.ultimate_drop
off_date to populate 
MRP_AP_INTRANSIT_SUPPLIES_
V.ARRIVED_FLAG. If Arrived, 
then we do not collect this supply. 

If No, Then we collect the intransit 
supply. NULL = No

MSC Profile Options
The following table lists and defines the MSC profile options available with Oracle 
Advanced Planning.

Profile Option 
Name

Valid Values Default Value Description

CP HZ View 
Default Query

Yes/No Yes Displays default results in the Oracle 
Collaborative Planning Horizontal 
View.

MSC: 64-bit 
Planner Platform

Yes/No No Set to Yes for the supported 64-bit 
platforms (HP-UX and Sun Solaris 2.8).

MSC: Action 
Allowed on ATP 
24x7 Plan While 
Running

Yes/No Yes This profile option controls whether 
you can access and make changes to 
the ATP plan while it is running in 
24x7 mode. The changes you make to 
the plan while it is running will not be 
reflected in the refreshed plan. 

If you set this profile option, consider 
setting MSC: ATP Synchronization 
Downtime (minutes).

This is a site level profile option. 
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Profile Option 
Name

Valid Values Default Value Description

MSC: Aggregate 
Resource Name 
Flexfield Attribute

Integer >= 0 Null Stores flexfield column name that 
contains its value in the corresponding 
table. See Flexfield Attributes, page A-1
for more information.

MSC: Allocated 
ATP Forward 
Consumption 
Method

Reduce 
future supply
from lowest 
priority and 
Reduce 
available 
supply from 
any priority

Reduce future 
supply from 
lowest priority

This profile controls the forward 
consumption method for allocated 
available to promise using the 
user-defined allocation percentage 
method. The values are:

- Reduce future supply from lowest 
priority: The shortage --after 
consuming its own allocated supply 
and available supply from a lower 
priority--is accounted for by using 
available future supply from the lowest
priority. If all the demand classes are at
the same priority, the shortage from a 
demand class consumes its own future 
supply. Use this if you prefer to delay 
some of the committed demand and 
hold the supply for higher priority 
demand classes.

- Reduce available supply from any 
priority: The shortage --after 
consuming its own allocated supply 
and available supply from lower 
priority--is accounted for by using 
available supply from higher priority 
demand classes. Therefore, committed 
demand must be accounted for before 
allowing more promises. 

This is a site level profile option. 

MSC: Allocation 
Assignment 
Category Set

Valid 
category set

Category 
specified in 
profile option 
MSC: Sourcing 
Category Set

The Assign Allocation Rule form and 
the Sourcing assignment form both use 
the MSC: Sourcing Category Set to 
determine the valid category set. Use 
this profile option if you want the 
allocation rule category set to be 
different from the sourcing 
assignments category set. 
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Profile Option 
Name

Valid Values Default Value Description

MSC: Allow 
Release of Planned
Orders from 
Demand Schedule 
Plan

Yes/No No This profile option provides increased 
flexibility for releasing planned orders 
and applies only to manual release. It is
not considered for auto-release. MPS 
and MPP planned orders cannot be 
auto-released from the MRP. The 
planning engine assumes that if the 
item is marked so that auto-release is 
allowed then auto-release has already 
occurred from the MPS or the MPP. 
Valid values are:

- Yes: You can release demand 
schedule MPP or MPP planned orders 
from the lower level plan

- No: You cannot release demand 
schedule MPP or MPP planned orders 
from the lower level plan

MSC: Allow 
Release of Planned
Orders from 
Demand Schedule 
Plan

Yes/No No Use this profile option to allow 
manually release master production 
plan and master production schedule 
planned orders from the material 
requirements planning plan, when the 
master production plan or master 
production schedule is a demand or 
supply schedule to the material 
requirements planning plan. Valid 
values are:

- Yes: Allow manual release

- No: Do not allow manual release

This profile only applies to manual 
release. It is not considered for 
auto-release; auto-release of planned 
orders of the release master production
plan and master production schedule 
planned orders occurred during their 
plan runs.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Anchor 
dates for 
calculating 
operation yields

Operation 
start date or 
Order start 
date

Operation start 
date

Use this profile option to instruct the 
planning engine on which effectivity 
date to use when it generates resource 
requirements of operations with yields.
This profile option applies to discrete 
jobs and Oracle ShopFloor 
Management (OSFM) routings with 
primary network scheduling method.

- Order start date: Use the order start 
date to check for operation effectivity 
and select yield value

- Operation start date: Use the 
operation start date to check for 
operation effectivity and select yield 
value.

The planning engine uses lead-time 
percent to calculate the operation start 
date; it assumes that the lead-time 
percent of an operation that is effective 
in the future is the same as the 
lead-time percent of the operation it 
replaces.

If an operation's effectivity ends within 
a time bucket, the planning engine 
assumes that its effectivity ends on the 
first day of the time bucket.

MSC: Anchor date 
for calculating 
remaining shelf 
life

Arrival 
Date/Ship 
Date

Arrival Date Use this profile option to instruct the 
planning engine which date to use as 
an anchor date for calculating the 
remaining shelf life. Valid values are:

- Arrival Date: Calculate the remaining 
shelf life from the arrival date at the 
customer site

- Ship Date: Calculate the remaining 
shelf life from the ship date.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Apply Lot 
Modifiers in 
Weekly/Period 
Buckets

Yes/No Null Determines whether order modifiers 
are considered when creating planned 
orders for weekly or period time 
buckets. A Yes value considers order 
modifiers in these calculations. A No 
value does not consider order 
modifiers in these calculations

MSC: Apply Order
Modifier To Start 
Quantity

Yes/No No Use this profile option to specify 
whether order modifiers are applied to 
start quantities for discrete or lot based 
jobs. This behavior only applies to 
routings that have operation yield. In 
this case the start quantity may be 
different from the expected supply 
quantity. Valid values are:

- Yes: The planning engine inflates the 
order start quantity by the routing 
operation yield and then applies order 
modifiers.

- No: The planning engine applies the 
order modifiers to the end quantity.

MSC: Apply 
Safety Stock 
Change interval to 
non MRP Planned 
Safety Stock

Yes/No No Use this profile option to specify the 
safety stock to which the smoothing 
within time interval applies: Valid 
values are:

- Yes: Smoothing applies to all types of 
safety stock

- No: Smoothing applies only to MRP 
planned safety stock
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Profile Option 
Name

Valid Values Default Value Description

MSC: Apply 
shortage and 
excess tolerance 
percentages to 
planned orders

Yes/No Yes Use this profile option to control the 
types of supplies to which the planning
engine applies Shortage Tolerance 
Percent and Excess Tolerance Percent. 
Valid values are:

- Yes: Apply them to all supply types

-No: Apply to them to all firm supply 
types except firm planned orders, for 
example, on-hand and scheduled 
receipts.

Using this option means that, in 
general, if the quantity of firm supplies 
used to satisfy a demand is lower than 
the Shortage Tolerance Percent of the 
item, the planning engine does not 
apply the tolerance to planned orders 
that it recommends. 

Whenever a demand is not fully 
satisfied, the planning engine sets the 
replenishment date to the end of the 
planning horizon.

MSC: ASCP 
Planning URL

<A url> Null Use this profile option to enable access 
to the web tools browser pages.

Set it at the site level.

Use format 
http://domain_name:port_numbe
r.

Use the domain name of your ASCP 
managed server and its port number.

MSC: ATP 
Allocation Method

User-Defined
Allocation 
Percentage, 
Demand 
Priority

Null Determines the allocation method used
by ATP. This is a site level profile. 
Valid values are:

• User-Defined Allocation 
Percentage

• Demand Priority
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Profile Option 
Name

Valid Values Default Value Description

MSC: ATP 
Assignment Set

Text Null Indicates name of the assignment set 
for Oracle Global Order Promising to 
use to identify all the possible shipping
organizations. Oracle Global Order 
Promising uses this assignment set if 
profile MRP: ATP Assignment Set is 
Null on the ERP instance. Users can 
update it the at site level in the 
Planning instance.

MSC: ATP 
Capacity 
Allocation

Yes/No No Set it to No. You should only set it to 
Yes under specific instruction from 
Oracle Applications development.

MSC: ATP Debug 
Mode

Debug Only, 
Debug and 
Database 
Trace, 
Database 
Trace Only, 
None

Null Determines whether to enable debug 
messages within Oracle Global Order 
Promising. You can update it at the 
user level. Valid values are: 

- Debug Only: ATP generates a log file 
for an ATP request. 

- Debug and Database Trace: ATP 
generates a log file and a database trace
file.

- Database Trace Only: ATP generates a
database trace file.

- None: ATP does not generate log file 
or database trace file.

MSC: ATP 
Enforces Lead 
Time for ATO 
Model

Yes/No Yes Use this profile option to specify how 
ATP considers lead-time. Valid values 
are:

- Yes: ATP always enforces lead-times 
for non-ATPable ATO models

- No: ATP does not enforce lead-times 
for non-ATPable ATO models
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Profile Option 
Name

Valid Values Default Value Description

MSC: ATP Infinite 
Time Fence Pad

Integer >=0 Null Oracle Global Order Promising adds 
the number of days specified in this 
profile option to the infinite time fence 
you specify in an ATP rule. It inflates 
the infinite time fence by that number 
of days.

Use this profile option when you want 
an infinite time fence date for an item 
to be based on the item manufacturing 
lead-times plus extra days.

This is a site level profile option. 

MSC: ATP 
Synchronization 
Downtime 
(minutes)

Integer > 0 Null You may need to set this profile option 
if you run available to promise in 24x7 
mode. When new sales orders come in 
while the synchronization process is 
running, the process can run for a long 
time if the order volume is high. 
Available to promise cannot switch to 
the new plan until the process finishes. 

Specify the ATP downtime in minutes. 
During the downtime, there are no new
sales orders for available to promise to 
process. The synchronization process 
can finish as soon as possible. There is a
trade-off between available to promise 
downtime and the time it takes to 
switch to the refreshed plan. 

This is a site level profile option. 



Profile Options    A-21

Profile Option 
Name

Valid Values Default Value Description

MSC: 
Automatically 
Recalculate 
Operation Time

Yes/No No If the value of this profile option is Yes,
the planning engine recalculates make 
order New Date (due date) if you both:

- Firm the order

- Update New Start Date

The calculation process uses: 

- Fixed and variable lead times

- Working days.

This applies only to unconstrained 
plans.

It has certain limitations.

MSC: 
Auto-Release 
Compression Days
Tolerance

Integer >= 0 Null Indicates the number of compression 
days allowed for the automatic release 
of planned orders.
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Profile Option 
Name

Valid Values Default Value Description

MSC: 
Auto-Release 
Compression Days
Tolerance

Null/List of 
Values

Null This profile option specifies the 
workday calendar that the planning 
engine uses to bucket the beginning 
and end of weeks and periods. 

Values are:

- Null: If you set this value, the 
planning engine uses the plan owning 
organization's calendar for bucketing 
weeks and periods. This is the 
organization that you launch the plan 
from.

- List of Values: You can select any 
calendar in the list of values for this 
profile option. This list of values 
includes all calendars that you defined 
on the source instance and collected.

The calendar that you associate with 
the profile option should be a 
seven-day calendar without any 
holidays. If not, some supplies may be 
adjusted to later weeks when two 
organizations have different calendars.

MSC:Avoid 
Re-sourcing Sales 
Orders

Yes/No Yes Use this profile option to instruct the 
planning engine whether to source 
sales orders. Valid values are:

- Yes: Do not source sales orders.

- No: Source sales orders. You can plan 
by arrival date, change ship methods, 
and change source orgganization if you
have set up the correct sourcing rules.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Buy Order 
Processing Lead 
Time Calendar

Supplier 
Capacity 
Calendar, 
Org 
Manufacturin
g Calendar

Supplier 
Capacity 
Calendar

Use this profile option to instruct the 
planning engine what calendar to use 
when it offsets processing lead-time for
buy orders. Valid values are:

- Supplier Capacity Calendar: The 
planning engine offsets processing 
lead-time for buy orders using the 
Approved Supplier List Supplier 
Capacity Calendar. The Approved 
Supplier List Supplier Capacity 
Calendar is the successor to the 
Approved Supplier List supplier 
delivery calendar.

- The planning engine offsets 
processing lead-time for buy orders 
using the organization manufacturing 
calendar

MSC: Cancel 
Outstanding Sales 
Order Quantities

Yes/No No Use this profile option to specify if 
distribution planning should cancel 
unfilled sales orders after the sales 
order latest acceptable date (Fill or 
Kill). The canceled quantity is 
displayed in the Expired Demand field 
of the Supply Demand window.

MSC: Category set
for CP Horizontal 
View

- - Indicates a category set that you want 
to query in the Oracle Collaborative 
Planning horizontal view. Using this 
profile option, you can restrict queries 
to specific categories based on your 
requirement.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Choice of 
Item for Which to 
Create Supplies in 
Substitute 
Relationship

Demanded 
Item, Highest
Level Item, 
Follow Item 
Attributes

Demanded 
Item 

Determines the item for which Oracle 
Global Order Promising and Oracle 
Advanced Supply Chain Planning 
creates planned supplies when item 
substitution relationships are specified.

When set to Follow Item Attribute and 
the item attribute Create Supply for all 
the substitute items in the substitution 
chain is No, no supplies are created. 

When you have a substitution chain A 
--> B --> C, and this profile option is set 
to Highest Level Item, it is expected 
that Oracle Advanced Planning creates 
supply for item C. Item C must be 
enabled in the organization where you 
are trying to create supply. If item C is 
not enabled in the organization, Oracle 
Advanced Planning creates supply for 
item B (the next highest level item in 
the substitution chain) and does not 
create supply for item C.

MSC: Circular 
Sourcing Surplus 
Inventory Basis

- - Not used.

MSC: Circular 
sourcing surplus 
days

- - Not used.

MSC: Class 
Hierarchy

Demand / 
Customer

Demand Indicates which allocation hierarchy to 
use. Users can update at the site level. 
Valid values are: 

- Demand Class: User-defined, 
single-level hierarchy.

- Customer Class: Three levels: 
customer class, customer, and site.
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Profile Option 
Name

Valid Values Default Value Description

MSC: 
Collaborative 
Planning Default 
Calendar

- - The horizontal view buckets supply 
and demand data into days, weeks and 
months (periods) according to the 
receiving calendar of the trading 
partner who receives material. This 
profile option indicates the default 
system calendar that Oracle 
Collaborative Planning uses when 
multiple customer sites are displayed 
together. 

MSC: Collect 
CMRO Work 
Order Demand

No Yes/No Specifies if Consumed Items are being 
imported to Production Scheduling. If 
no Work Order Consumed Items are 
being imported, set profile MSC: 
Collect CMRO Work Order Demand to 
Yes.

Used when performing collections. It is
not used in release 12.2 and higher. 

MSC: Collect Item,
Material and 
Resource Costs

Yes/No Yes This profile option indicates whether 
data collection should include cost 
information. Specifying No may 
improve data collections performance.

MSC: Collect 
Routing

Yes/No No Use this profile to instruct the targeted 
collections process how to collect bill of
material and routing data. Valid values
are:

- Yes: Collect bill of material and 
routing data

- No: Collect bill of material data but do
not collect routing data

This profile option is overridden by 
profile option INV: Capable To 
Promise is ATP/CTP based on Planning
Output.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Collection 
Window for 
Trading Partner 
Changes (Days)

Integer >= 0 Null Used by Oracle Advanced Supply 
Chain Planning collections. Specifies 
the number of days backwards that 
changes in customer names, customer 
sites, vendors, and vendor sites are 
collected. If null, then all changes are 
collected. Used when collections for the
trading partners entity is run in 
complete mode.

If you update or delete region ID in a 
record of tables wsh_regions, 
wsh_region_locations, or 
wsh_zone-regions, perform this 
process:

- Set this profile option to null or 0

- Run collections

- Reset this profile option to your usual 
non-zero value

MSC: Compute IB 
Aggregation 
during Collection

Yes/No/NUL
L

Yes/NULL Use this profile option to instruct the 
collections process whether to collect 
over the install base under contracts 
information (run concurrent process 
Compute Aggre Installbase under 
Contract). Valid values are:

• Yes: Run it if data pull parameter 
Install Base Under Contracts is 
Yes.

• No: Do not run it.

You can run the concurrent process 
before the collections run to reduce the 
collections run processing time.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Compute 
Project Exception

Yes/No Yes This profile option determines whether
to generate project specific exceptions 
when running a project based plan. 

- Yes: Enable the generation of project 
specific exceptions.

- No: Disable the generation of project 
specific exceptions. The default value is
Yes.

MSC: 
Configuration

Not 
applicable

Not applicable Used by Oracle Collaborative Planning.

MSC: Consume 
Forecast Inside 
Demand Time 
Fence

Yes/No No When set to No, demand time fence 
control is implemented prior to forecast
consumption. Forecast entries in the 
demand time fence are dropped as 
demand statements and not used for 
consumption. 

When set to Yes, forecast consumption 
occurs prior to enforcing demand time 
fence control. The forecast entries 
within the demand time fence are used 
for consumption but not as demand. 
After consumption, demand quantity 
for all the forecast entries within the 
demand time fence is zero.

If you are using forecast spreading:

- For a periodic forecast entry that falls 
in weekly planning buckets within the 
demand time fence, the forecast 
spreading process spreads the entries 
into daily entries.

- If the daily entry is within the 
demand time fence, the process ignores
the value that you set and uses the 
value Yes in processing. 

- If the daily entry is outside the 
demand time fence, the process ignores
this profile option and consumes 
against the entry.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Consume 
forecast with No 
demand class

Within Each 
Bucket, After 
Consuming 
Demand 
Class Specific
Forecast 

Within Each 
Bucket

This profile option instructs the 
forecast consumption process in about 
the order it should use to consume 
forecast entries when some of them 
have a demand class and others do not 
have a demand class. If you select:

• Within Each Bucket: The forecast 
consumption process starts by 
consuming forecast entries for the 
day on the sales order; it consumes
entries with matching demand 
class first, then entries with no 
demand class. Then, it consumes 
forecast entries within the 
backward and forward 
consumption days; for each day, it 
uses matching demand class first, 
then no demand class. 

• Within Each Bucket, After 
Consuming Demand Class Specific
Forecast: The forecast 
consumption process starts by 
consuming forecast entries for the 
day on the sales order with 
matching demand class only. 
Then, it consumes forecast entries 
within the backward and forward 
consumption days with matching 
demand class only. If there is a 
remaining sales order quantity, it 
repeats the process against forecast
entries with no demand class, first 
on the day on the sales order, then 
within the backward and forward 
consumption days. 

MSC: Cost of 
Using a BOM/ 
Routing Flexfield 
Attribute

- - Not used.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Cost Type Frozen,

Average,

Any 
user-defined 
cost type

Null Use this profile option on the source 
instance (execution system) to specify 
the cost type that collections should use
when collecting the item costs. 

You should perform a cost rollup for 
the specified cost type before collecting 
data.

If this profile option is null, collections 
uses the:

- Frozen cost type for standard costed 
organizations and

- Average cost type specified in 
organization setup for average costed 
organizations

MSC: CP Debug 
Level

Debug - Off, 
Debug - On, 
or Debug - 
High

Debug - High Controls the level of detail in the 
concurrent program log messages for 
Oracle Collaborative Planning.

Off: No debug messages generated

On: Short debug messages generated

High: Detailed debug messages 
generated.

MSC: Create 
resource 
requirements for 
all operations

Yes/No Yes If an operation has no resources with 
Schedule = Yes, when this profile 
option is set to:

• Yes: The planning engine creates a 
dummy resource requirement for 
the operation

• No: The planning engine does not 
create a dummy resource 
requirement for the operation; the 
operation does not have any 
resource requirements
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Profile Option 
Name

Valid Values Default Value Description

MSC: Currency 
Conversion Type

A currency 
conversion 
type

Corporate Use this profile option on the 
destination instance to specify currency
conversion type.

If you change the value, the next time 
you run collections, the collections 
process purges the data with the 
previous currency conversion type and 
replaces it with data with the new 
currency conversion type.

MSC: Daily 
Allocation to 
Maintain Safety 
Stock Level

Yes/No Yes Not used.

MSC: Day UOM Text Null Supports the unit of measure 
conversion required for Oracle 
Advanced Supply Chain Planning 
resource batching calculations. 
Batching Window is considered in 
days, but users can specify the batching
window in a unit of measure other than
days. The profile option establishes a 
standard for the Day unit of measure. 
Users must specify a unit of measure 
that represents the value Day using this
profile option. Users must also set up a 
unit of measure conversion between 
the unit of measure used for resources 
and the Day unit of measure specified 
here.

MSC: Default 
Project for 
Supplies Pegged 
to Excess

Project code Null Use this profile to manage planned 
supplies pegged to excess inventory 
when planning in a Project 
Manufacturing environment. Oracle 
Advanced Supply Chain Planning 
allows you to specify a project as a 
default project for all supplies pegged 
to excess. This may be setup at the Site, 
Application, Responsibility, or User 
Levels. The project must be assigned to 
all organizations that will be planned at
the defined level.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Default 
Time Stamp for 
Make Planned 
Order Release

00:00:00 and 
23:59:59

00:00:00 Use this profile option to specify the 
timestamp of an Oracle Work in 
Process and Oracle Shop Floor 
Manufacturing job recommended for 
release or reschedule by an 
unconstrained plan. Valid values are:

- 00:00:00: The planned order 
timestamps are set to 00:00:00.

- 23:59:59: The planned order 
timestamps are set to 23:59:59.

This does not apply to constrained and 
optimized plans.

MSC: Default 
Workbench Height

Specify the default workbench height. 
Can be defined at the site level.

MSC: Default 
Workbench Width

Specify the default workbench width. 
Can be defined at the site level.

MSC: Degree of 
Parallelism for 
Index Creation

Integer >= 0 0 Controls the use of parallel workers in 
data collections. Specifies how many 
parallel workers to use when creating 
indexes.

MSC: Demand 
Priority Flexfield 
Attribute

Integer >= 0 Null Stores the value of the attribute column
that controls the demand priority. See 
Flexfield Attributes, page A-1 for more 
information.

MSC: Demand 
Satisfied Percent 
Threshold for 
Pegging

Decimal 
percent

100.0 Set this profile option to instruct the 
planning engine to stop pegging 
supplies to a demand which is over 
satisfaction percentage. Oracle 
recommends setting the value greater 
than 99.9.

Even if you set this profile option 
below 100.0, the planning engine still 
satisfies 100% of the demand.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Display 
Order 
Rescheduling 
Supplies

Yes/No No This is a profile option is for use by 
Oracle. When set to Yes, Planner 
Workbench displays Order 
Rescheduling Supply and Order 
Rescheduling Demand inserted by 
available to promise when it 
unschedules a sales order for a 
configured item.

MSC: Display 
Warning Message 
When 
Rescheduling 
Recommendation 
Not Suggested by 
the Plan

Yes/No Yes This profile option specifies whether or
not the Planner Workbench should 
display a warning message when you 
release rescheduled orders that the 
planning engine has not recommended.

The values are:

- Yes: Use this value if you want the 
Planner Workbench to prompt you for 
confirmation when you release 
rescheduled orders that the planning 
engine does not recommend.

- No: Use this value if you do not want 
the Planner Workbench to display the 
message prompting to prompt you for 
confirmation when you release the 
rescheduled orders that the planning 
engine does not recommend.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Distribution 
Planning Ship 
Date

Ship full trips
early or ship 
latest 
(Target), Ship
full trips 
early or ship 
latest (SS), 
Latest 
possible ship 
date (Target), 
Latest 
possible ship 
date (SS)

Latest possible 
ship date (SS)

Use this profile option to schedule a 
trip for departure based on the earliest 
and latest possible ship dates of the 
trip. The values are:

- Ship full trips early or ship latest 
(Target): Utilized trips ship on the 
earliest possible ship date or in time to 
prevent inventory levels from 
dropping below target.

- Ship full trips early or ship latest (SS): 
Utilized trips ship on the earliest 
possible ship date or in time to prevent 
inventory levels from dropping below 
safety stock.

- Latest possible ship date (Target): 
Trips ship just in time to prevent 
inventory levels from dropping below 
target.

- Latest possible ship date (SS): Trips 
ship just in time to prevent inventory 
levels from dropping below safety 
stock.

MSC: DPP 
allocates to 
existing ISO's 
before other 
demands with the 
same priority

Yes/No Yes Use this profile option to specify how 
you want the DRP allocation process to
allocate to sales orders that:

- Are in the same allocation bucket

- Have the same demand priority

Valid values are:

- Yes: It allocates supply to internal 
sales orders first, then allocates supply 
to external sales orders.

- No: It allocates supply to all sales 
orders regardless of whether they are 
internal or external.
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Profile Option 
Name

Valid Values Default Value Description

MSC: DPP 
Discrete Job Cutoff
Window (Days)

Integer >=0 Null Use this profile option to control the 
number of days from plan start date 
that discrete jobs are considered. Valid 
values are:

- Null: All discrete jobs are considered 
by the distribution plan.

- 0: No discrete jobs are considered by 
the distribution plan.

- Integer >=0: All discrete jobs with 
completion dates from plan launch 
date + {integer value} are considered by
the distribution plan. New planned 
orders for discrete jobs can be created 
both inside and outside the job cutoff 
window.

MSC: DPP 
Multitasking 
Group ID's per 
Process

Integer 1 Use this profile option to specify how 
many group IDs an unconstrained 
demand and supply netting and 
allocation child process should process.
In this phase, a child process loads data
based on internal group IDs and will 
load all the org-items belonging to 
those group ID's. This option specifies 
the length of the list of group ID's.

This profile option does not control the 
Load Consolidation processes.

This profile option does not apply with 
operating system Microsoft Windows.

MSC: DPP 
Multitasking Max 
Concurrent 
Processes

Integer 10 Use this profile option to specify the 
maximum number of DPP processes 
that are allowed to run in parallel. For 
example, if your machine has 4 CPU's, 
you might choose to run a maximum of
one concurrent process on each CPU; in
this case, set the value to 4.

This profile option does not apply with 
operating system Microsoft Windows.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Enable 
Advanced 
Constraints

Yes/No No Use this profile option to control the 
values that display for plan option 
Constraints Mode (on the Constraints 
tab). Valid values for the profile option 
are:

- Yes: All values for plan option 
Constraints Mode display

- No: All values for plan option 
Constraints Mode display except 
Constrained (Without Detailed 
Scheduling) and Constrained (With 
Detailed Scheduling)

MSC: Enable 
Allocated ATP

Yes/No No Use this profile options to indicate 
whether allocated order promising is 
used. Users can update this profile at 
the site level.

MSC: Enable ATP 
for Phantom 
Components

Yes/No No If you set to Yes, Oracle Global Order 
Promising treats phantom items like 
standard items and net their supply 
and demand. 

If you set to No, Oracle Global Order 
Promising explodes phantom items to 
their components and performs 
availability check for the components 
only.

This is a site level profile option.

MSC: Enable ATP 
Summary Mode

Yes/No No Enables the summarization of supply / 
demand data for performance 
improvement. This is a site level 
profile. Valid values are:

- Yes: Enable ATP Summary Mode

- No: Disable ATP Summary Mode.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Enable ATP 
Workflow

Yes/No No Controls the generation of workflow 
notifications to send to the planner. 
This is a site level profile. Valid values 
are: 

Yes: Generate ATP Workflow 
Notifications

No: Do not generate ATP Workflow 
Notifications

MSC: Enable DPP 
Multitasking 
orders

Yes, No No Use this profile option to specify 
whether the planning engine should 
use high volume distribution planning.
You can set at the user and site levels. 
Valid values are:

- Yes: All DPP plans run by this user or 
at this site are run in high volume 
mode. This value does not apply with 
operating system Microsoft Windows.

- No: DPP plans run by this user or at 
this site are not run in high volume 
mode

MSC: Enable 
Enhanced 
Sourcing

Yes/No Yes Enables enhanced sourcing logic that 
considers historical allocations and 
allows the splitting of planned orders 
to achieve target sourcing percentages. 
Rank 2 buy sources are considered if 
supplier capacity is exhausted for rank 
1 sources.

This profile option duplicates the 
functionality of the decision rule Use 
Alternate Sources parameter for buy 
items but not for transfers from other 
organizations. When the decision rules 
are enabled, the planning engine does 
not consider this profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Enable 
Group Based 
Netting

Yes/No Yes Use this profile option to control 
whether the planning engine uses 
group based netting features. A value 
of Yes provides the most recent netting 
logic.

Oracle recommends that you set the 
value to Yes and use the latest netting 
features. This profile option is for 
backward compatibility.

MSC: ENFORCE 
CRITERIA 
REQUIREMENT 
BEFORE 
EXECUTING 
QUERY

Yes/No Yes Use this profile option to specify if a 
query requestor needs to specify 
criteria before executing a query:

- Yes: They do. This ensures that the 
query performs more efficiently.

MSC: Enforce 
Hard Links

Yes/No Yes This profile option specifies whether 
time offsets are hard constraints or soft 
constraints.

If Yes, the planning engine can violate 
resource and material capacities to 
satisfy minimum and maximum time 
offsets. If capacity is exceeded, 
exception messages start the cause as 
"Hard Link Constraint".

If No, the planning engine cannot 
violate resource and material capacities
to satisfy the minimum and maximum 
time offsets. In this case, the planning 
engine can violate hard links and 
generate a "Hard Link Violation" 
exception message.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Enhanced 
Project Netting

Yes/No No If the planning engine creates a 
planned order that pegs to multiple 
projects or tasks, the planning engine 
splits the planned order. Valid values 
are:

- Yes: If there is an excess, the planning 
engine includes its quantity in the 
planned order of one of the projects.

- No: If there is an excess, the planning 
engine creates a separate planned order
for it

MSC: Enable 
Enhanced 
Sourcing

-- -- Not used.

MSC: Excess and 
Safety Stock by 
Demand Class

Yes/No No This profile option controls the 
allocation of supply or demand that 
pegs to excess or safety stock in the 
case of allocated ATP using the 
demand-priority based method.

The valid values are:

- Yes: If such supply or demand has a 
demand class, and if the demand class 
exists on the allocation rule, allocate the
supply or demand to the demand class.
However, if the supply or demand 
does not have a demand class or if the 
demand class does not exist on the 
allocation rule, allocate the supply or 
demand to OTHER.

- No: Allocate such supply or demand 
to OTHER.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Explode in 
WIP when Details 
are not released

Yes.No/NUL
L

Yes/NULL Use this profile option to instruct the 
planning engine order whether to keep 
manually added operations and 
resources on work orders that it 
reschedules. Valid values are:

• Yes: Do not keep them. The 
planning engine removes the 
component requirements and 
operations and re-explodes the bill 
of material and routing to update 
them.

• Keep them. The planning engine 
removes the non-changed 
component requirements and 
operations and re-explodes the bill 
of material and routing to update 
them. 

The profile option applies to 
unconstrained plans.

MSC: Fast Refresh 
of Region Site Map

Yes/No/NUL
L

No/NULL Use this profile option to instruct 
concurrent process Refresh Collections 
Snapshot how to perform the supplier 
site to region mapping when there are 
changes to shipping regions. Valid 
values are:

• Yes: Re-map the affected supplier 
sites and those with no location 
defined

• No: Re-map all supplier sites

MSC: File Flush 
Limit

Integer > 0 20000 Use this profile option to control 
Planner concurrent process write to 
database, if the number of records 
exceed this value, the process uses 
SQL*Loader or array insert.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Firm 
Internal 
Requisition Time 
Fence

Yes/No Yes This profile option creates a natural 
time fence for an item if a firm internal 
requisition exists. The natural time 
fence is the date of the latest firm 
internal requisition.

The values are:

- Yes: Use this to create a natural time 
fence for a firm internal requisition.

- No: Use this if you do not want to 
create a natural time fence for a firm 
internal requisition.

MSC: Firm 
Intransit and PO 
in Receiving 
Supplies

Yes/No Yes This profile option applies to 
unconstrained plans only and instructs 
the planning engine whether it should 
consider intransit and purchase order 
in receiving supplies as firm or it 
should issue reschedule 
recommendations for them.

If you set the profile option to Yes, the 
planning engine considers intransit and
purchase order in receiving supplies as 
firm. If you set it to No, the planning 
engine generates reschedule 
recommendations for these types of 
supplies. Use this setting if you 
expedite shipments that are en route 
from a supplier to a receiving 
organization or if you want to expedite 
the movement of materials in receiving 
to the shop floor. For example, you 
might offload a package from a ship at 
a port and then fly the package to the 
receiving organization.

These recommendations are 
informational only and cannot be 
released from the Planner Workbench.

This is a user level profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Forecast 
Priority Flexfield 
Attribute

Integer >= 0 Null Stores the value of the attribute column
that will control the forecast priority. 
See Flexfield Attributes, page A-1 for 
more information.

MSC: Forecast 
Spreading 
Calendar

Organization 
Manufacturin
g Calendar, 
Organization 
Shipping 
Calendar

Organization 
Manufacturing 
Calendar

Use this profile option to specify the 
calendar that the forecast spreading 
process should use. Valid values are:

- Organization Manufacturing 
Calendar: Base forecast spreading on 
the organization manufacturing 
calendar.

- Organization Shipping Calendar: Base
forecast spreading on this hierarchy of 
organization shipping calendars—
carrier/organization calendar, 
organization shipping calendar. If 
neither of these calendars exists, 
forecast spreading uses the 
organization manufacturing calendar.

MSC: Future Days 
for Currency 
Conversion

Positive 
number

90 Use this profile option to instruct the 
collections process how many future 
days of currency conversion rates to 
collect, starting from today.

MSC: Generate 
Notifications for 
Transportation 
Updates

Yes/No Yes Use this profile option to specify 
whether the process that passes 
estimated arrival time updates from 
Oracle Transportation Management 
should create workflow notifications. 
Valid values are:

Yes: Create workflow notifications

No: Do not create workflow 
notifications
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Profile Option 
Name

Valid Values Default Value Description

MSC: High 
Volume Items

Yes/No No This snapshot profile controls plan 
weed out logic. Since snapshot on 
64-bit machines could run out of 
memory if the number of planned 
items is high. Valid values:

- Yes: Snapshot bypasses the weed out 
logic and directly inserts items from 
operational data store to planning data 
store. If item planning type is All 
Planned Items, the snapshot inserts all 
items into the planing data store. If the 
items have demand schedules only, 
snapshot only inserts the items in 
demands schedules into the planning 
data store.

- No: The snapshot uses weed out logic.

MSC: History 
Days for Currency 
Conversion

Positive 
number

180 Use this profile option to instruct the 
collections process how many past 
days of currency conversion rates to 
collect, starting from today.

MSC: Horizontal 
Plan Demand 
Bucketing 
Preference

Plan 
Recommende
d 
Date/Deman
d Due Date

Demand Due 
Date

This profile controls how Oracle Global
Order Promising treats demand due 
date when calculating availability. 
Valid values are:

- Plan Recommended Date, Oracle 
Global Order Promising treats the 
demand due as the date recommended 
by Oracle Advanced Supply Chain 
Planning.

- Demand Due Date, Oracle Global 
Order Promising treats the demand 
due as the Schedule Ship Date.

MSC: Horizontal 
Plan Extension 
Program

PackageNam
e.ProdecureN
ame format

<blank> Use this profile option when you are 
using a custom row in the Planner 
Workbench Horizontal Plan. Specify 
the name of the PL/SQL program unit 
with no parameters that specifies that 
information to display in the custom 
row.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Hour UOM Text HR Specifies unit of measure. Can be 
defined at the site level.

MSC: Ignore 
CMRO and EAM 
Work Orders for 
ASCP

Yes/No Yes Specifies if ASCP should ignore cMRO 
and EAM work orders. If the value is 
set to No then asset intensive planning 
features to account for EAM and cMRO
work orders are enabled. If set to Yes, 
then these features are disabled.

MSC: Include Firm
Planned Orders In 
Firm Allocation 
Window

Yes/No No For priority pegging, controls the point 
at which demands peg to firm planned 
orders. Valid values are:

- Yes: Firm planned orders are included
in the firm allocation window (along 
with scheduled receipts). They are 
eligible for pegging during the first 
phase of priority pegging.

- No: Firm planned orders are not 
included in the firm allocation window 
(along with scheduled receipts). They 
are eligible for pegging during the 
second phase priority pegging.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Include 
Safety Stocks in 
Priority based 
Pegging

Yes/No No Controls whether to exclude 
non-transient safety stock levels from 
the priority-based pegging logic. Valid 
values are:

• Yes: The planning engine does not 
give preference to non-transient 
safety stock levels in 
priority-based pegging. It pegs the 
demands and the safety stock 
levels, at the same time, to the 
supplies.

• No: The planning engine gives 
preference to non-transient safety 
stock levels in priority-based 
pegging. It first pegs them to 
non-firm planned orders. Then, it 
pegs the demands to the other 
supplies.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Inflate WIP 
Resource 
Requirements

Yes/No No Determines whether or not the 
planning engine should inflate the 
Work in Process resource requirements 
based on resource efficiency and 
utilization during collections from 
Oracle Work in Process.

The values are:

- Yes: Planning engine inflates the 
resource requirements for the firm, 
unfirm, and non-standard discrete jobs 
considering the resource efficiency and 
utilization.

- No: The planning engine does not 
consider resource efficiency and 
utilization to inflate the resource 
requirements for the collected discrete 
jobs.

Note that this profile option is used in 
conjunction with shop floor scheduling 
products such as Oracle Manufacturing
Scheduling. It is assumed that the 
discrete jobs are not released from the 
planning engine. If the jobs are 
rescheduled and released by the 
planning engine, the resource 
requirements are deflated. This could 
result in data inconsistency as the 
resource requirements are deflated on 
release whereas Oracle Manufacturing 
and Scheduling might have calculated 
resource requirements based on the 
inflated values.

The planning engine always sends the 
original resource requirements upon 
release. If the resource requirements 
are already inflated in the source from 
Oracle Manufacturing Scheduling, set 
this profile option to No to avoid 
double inflation of the resource 
requirements. Otherwise, set it to Yes 
so that the planning engine inflates the 
resource requirements.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Inventory 
Rebalancing 
Surplus Inventory 
Basis

Target, Safety
Stock

Safety Stock Use this option to specify whether 
inventory rebalancing considers target 
or safety stock inventory levels. Valid 
values are: 

- Target: Surplus inventory is defined 
as the quantity of projected available 
balance greater than target inventory 
level. Target inventory demands are 
considered by inventory rebalancing.

- Safety Stock: Surplus inventory is 
defined as the quantity of projected 
available balance greater than safety 
stock inventory level. Target inventory 
level demands are ignored by 
inventory rebalancing.

MSC: Launch 
Analyze Plan 
Partition

Yes/No Yes Launches the concurrent request 
Analyze Plan Partition. 

MSC: Launch 
Workflow-Enabled
Exception Message
Notifications

Yes/No Yes Determines if Oracle Collaborative 
Planning sends notification messages 
when it generates exceptions.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Legacy 
Collections Using 
Lot Based Job 
Details

Yes/No No Used with legacy data collections only. 
Valid values are:

• Yes: For Oracle ShopFloor 
Management (OSFM) lot based 
jobs, the planning engine uses the 
BOM and Routing details stored in
the job for scheduling future 
operations.

• No: The planning engine utilizes 
the BOM and Routing stored in the
BOM application for scheduling 
future operations of a lot based 
job. The job will be the reference 
for the current operation only. 
Only job header changes can be 
released from planning, not 
operation details.

To control the same behavior for 
collections from an Oracle E-Business 
Suite instance, Advanced Planning 
Suite uses Oracle ShopFloor 
Management (OSFM) profile option 
WSM: Create Job Level BOM and 
Routing Copies

MSC: Maximum 
Number of 
Planned Orders 
per Demand

Positive 
number

10000 The maximum number of planned 
orders that the planning engine can 
create to satisfy one demand.

MSC: Maximum 
Percentage 
variation in safety 
stock values

Null or 
positive 
number

Null The safety stock is not allowed to 
deviate by more than this value 
between two adjacent time intervals. 
Null allows any deviation.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Minimize 
Project Cross Peg 
within Window

Yes/No Yes Used in conjunction with profile option
MSC: Use attribute based netting in 
priority pegging. Valid values are:

- Yes: The planning engine tries to 
minimize cross pegging within the 
Supply/Demand window.

- No: The planning engine does not 
attend to the amount of cross pegging.

MSC: Minimum 
Percentage 
variation in safety 
stock values

Null or 
positive 
number

0 The safety stock is held constant across 
time intervals if the deviation is within 
this percentage. Zero ignores all 
deviations.

MSC: Minimum 
Supply/Demand 
Percent for 
Pegging

Decimal 
percent

0.0 Set this profile option to instruct the 
planning engine not to peg tiny 
supplies and large demands. It skips a 
supply if (Supply size / Demand size) x 
100 is less than the value of this profile 
option. Oracle recommends setting the 
value at 0.0001.

MSC: Minimize 
Workorder 
crossovers during 
reschedules

Yes/No No Controls pegging for work orders 
pegging to minimize crossovers during
rescheduling.

- Yes: The planning engine does not 
push the supply forward even if there 
is some excess. 

- No: The planning engine can peg 
work orders to safety stock supplies 
available. This may sometimes lead to 
work orders with later old schedule 
dates to be pegged to higher priority 
demands and work orders with earlier 
schedule dates may be pegged to lower
priority demands.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine only 
uses this profile option if its value is 
Yes.
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Profile Option 
Name

Valid Values Default Value Description

MSC: MPS 
Auto-Firm 
Planned Orders

Yes/No Yes This profile option specifies how the 
planning engine deals with master 
production schedule firm planned 
orders. You can use this profile option 
to specify whether or not the planning 
engine should treat all planned orders 
in the master production schedule as 
firm:

Valid values are:

- Yes: All planned orders in the master 
production schedule are automatically 
firmed and not rescheduled during a 
batch replan.

- No: Use the same behavior as 
distribution requirements plans and 
material requirements plans.

When a master production schedule is 
a demand schedule for another plan, 
the planning engine treats all planned 
orders in the demand schedule plan as 
firm. This is the same as treating 
planned orders in distribution 
requirements plans and material 
requirements plans that are demand 
schedules for other plans as firm.

This profile option applies only to 
master production schedule plans. You 
can set it at the site and user levels.

MSC: Net Change 
Temp Dir

Text Null Stores the location of image cache used 
in the Plan Comparison Report. 
Indicate the location in the following 
format: <directory>@<subdir> where 
<directory>

This must match the absolute path of 
the OA_MEDIA environment variable 
and <subdir> is the name of a 
subdirectory under the OA_MEDIA 
directory. The subdirectory must have 
write permissions for all.
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Profile Option 
Name

Valid Values Default Value Description

MSC: New 
Forecast Auto Plan

A valid plan 
name in 
Oracle 
Advanced 
Supply Chain
Planning

Null The plan launched in Oracle Advanced 
Supply Chain Planning when Oracle 
Collaborative Planning receives a 
supplier's forecast. Oracle recommends
that this plan be an unconstrained plan.

MSC: New 
Planner Backward 
Compatibility

Yes/No No Use tis profile option to instruct the 
planning engine which algorithm to 
use to plan phantom items. Valid 
values are:

- Yes: Use the old algorithm

- No: Use the new algorithm

See also profile option MRP: New 
Planner Backward Compatibility.

Oracle recommends that you use Yes, 
even though it is not the default value, 
unless you have a specific situation that
demands the new algorithim.

MSC: New Supply
Commit Auto Plan

A valid plan 
name in 
Oracle 
Advanced 
Supply Chain
Planning

Null The plan launched in Oracle Advanced 
Supply Chain Planning when Oracle 
Collaborative Planning receives a 
supplier's supply commits. Oracle 
recommends that this plan be a 
constrained plan.

MSC: 
Organization 
containing generic 
BOM for forecast 
explosion

Any collected
organization

Null Used by collections to identify and 
populate the bill of material validation 
organization.

MSC: Order Type 
for Consigned 
VMI

- - This indicates the order type that 
Oracle Collaborative Planning uses 
when creating a sales order for 
consigned VMI. This order type should
encompass billing and inventory 
reduction functions without any 
shipping being performed.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Operator 
Company Name

- - Used by Oracle Collaborative Planning.

MSC: OTM URL Null, <URL> Null Use this profile option to specify the 
URL of the Oracle Transportation 
Management instance that is providing 
the updates. This URL is used for 
drilling down in Oracle Transportation 
Management for more details about the
order that has been rescheduled.

MSC: Overwrite 
all Order Forecast 
records

Yes/No No Indicates whether or not the previous 
records regarding customer order 
forecasts need to be maintained. You 
can set this profile option to replace all 
previous forecasts with the latest 
forecast that the customer provides. 
The valid values are:

- Yes: Use this if you want to delete all 
previous order forecast records for an 
item, organization, customer, or 
customer site combination.

- No: Use this if you do not want to 
delete the previous forecasts.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Overwrite 
all supplier 
capacity records

Yes/No No Indicates whether or not the previous 
records regarding supplier capacity 
need to be maintained. You can set this 
profile option to replace all previous 
supplier capacity values with the latest 
supplier capacity to which the supplier 
commits. The valid values are:

- Yes: Use this if you want to delete all 
previous supplier capacity records for 
an item, organization, customer, or 
customer site combination. When the 
supplier provides a new commit 
statement for a specific horizon, the 
planning engine deletes all previous 
supplier capacity records for the 
horizon.

- No: Use this if you do not want to 
delete the previous supplier capacity 
records.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Pass List 
Price to OM in 
DRP Release

Yes/No No Use this profile option to specify how 
the distribution planning engine 
obtains internal sales order line list 
prices> Valid values are:

- Yes: During the creation of an internal
sales order line, the Oracle Order 
Management Application 
Programming Interface does not call 
the pricing engine to get the list price of
an item. Distribution planning passes 
the list price based on the item list 
price. If the list price is null, it passes 
the pass the standard cost. If the 
standard cost is null, it passes 0. In all 
cases, the internal sales order is created 
in a Booked status. This is the same 
process used when concurrent process 
Create Internal Orders creates internal 
sales orders from manual internal 
requisitions. 

No: During the creation of an internal 
sales order, the Oracle Order 
Management Application 
Programming Interface calls the pricing
engine to get the list price of an item. If 
the item is not an any price list, it 
creates the internal sales order in an 
Entered status. 

MSC: Performance
target for 
Inventory Turns 

Integer > 0 6 Use this profile option to set the KPI 
performance target for inventory turns.

MSC: Performance
target for Margin 
Percent 

Integer > 0 20 Use this profile option to set the KPI 
performance target for margn.

MSC: Performance
target for Ontime 
Delivery Percent 

Integer >0 100 Use this profile option to set the KPI 
performance target for ontime delivery.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Performance
target for Resource
Utilization Percent

Integer > 0 100 Use this profile option to set the KPI 
performance target for planned 
utilization.

MSC: Plan 
co-products

Yes/No Yes Indicate whether co-products are 
planned and whether supplies are 
created for the co-products. Can be 
defined at the site level. 

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine only 
uses this profile option if its value is 
Yes.

MSC: Plan for 
order at risk 
calculation

- - Indicates a plan that Oracle 
Collaborative Planning uses to derive 
the pegging information for each order 
that you upload.

MSC: Plan Name 
for CMRO

<A plan 
name>

Null In asset intensive planning, the plan 
that the planning engine uses when it 
sends resource availability information 
to Oracle Complex Maintenance, 
Repair, and Overhaul.

MSC: Planning 
Currency

- - Not used.

MSC: Planning 
Hub Currency 
Code

Currency 
code

<blank> Use this profile option on the 
destination instance to specify 
reporting currency. If you change the 
value, the next time you run 
collections, the collections process 
purges the data with the previous 
currency code and replaces it with data
with the new currency code. 

MSC: Priority for 
Substitute Items 
Flexfield Attribute

Integer >= 0 Null This profile option stores the name of 
the flexfield column that contains the 
value in the corresponding table. Set 
this profile option at the site level only 
See Flexfield Attributes, page A-1 for 
more information.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Priority of 
Alternate 
Resources for an 
Operation 
Flexfield Attribute

Integer >= 0 Null This profile option stores the name of 
the flexfield column that contains the 
value in the corresponding table. See 
Flexfield Attributes, page A-1 for more 
information.

MSC: Production 
Plan for 
Transportation 
Updates

Null, All 
Production 
Plans, 
<specific plan
name>

Null Use this profile option to indicate the 
production plans that receive estimated
arrival time updates from Oracle 
Transportation Management. Valid 
values are:

Null: Do not pass updates to any plan

All Production Plans: Pass updates to 
all plans with Production flag selected

<specific plan name>: Pass updates 
only to the plan that is specified

MSC: Project Task 
Collection 
Window Days

Null, Integer Null Controls which projects/tasks are 
collected after the collection engine 
deletes all of the previously collected 
records for the instance. Valid values:

- Null: Collects all of the records from 
the source.

- Integer: Collects all of the records 
from the source from projects whose 
end date is within the number of days 
in the past specified in the profile 
option value.

The collections process never collects 
tasks whose projects are completed. 

MSC: Provide 
Warning for Dates 
Entered on 
Non-work Days

Yes/No No - No: Use this value if you do not want 
the warning message to be displayed.

MSC: PS - 
Snapshot Base 
Package

Yes/No Yes Specifies whether the Base Package is 
used for creating a model in Production
Scheduling.
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Profile Option 
Name

Valid Values Default Value Description

MSC: PS - 
Snapshot 
Beginning 
Inventory Package

Yes/No Yes Specifies whether the Beginning 
Inventory Package is used for creating 
a model in Production Scheduling.

MSC: PS - 
Snapshot Calendar
Package

Yes/No Yes Specifies whether the Calendar 
Package is used for creating a model in 
Production Scheduling.

MSC: PS - 
Snapshot 
Customer Package

Yes/No Yes Specifies whether the Customer 
Package is used for creating a model in 
Production Scheduling.

MSC: PS - 
Snapshot 
Distribution 
Package

Yes/No Yes Specifies whether the Distribution 
Package is used for creating a model in 
Production Scheduling.

MSC: PS - 
Snapshot 
Enterprise 
Forecast Package

Yes/No Yes Specifies whether the Enterprise 
Forecast Package is used for creating a 
model in Production Scheduling.

MSC: PS - 
Snapshot 
Inventory Safety 
Targets Package

Yes/No Yes Specifies whether the Inventory Safety 
Targets Package is used for creating a 
model in Production Scheduling.

MSC: PS - 
Snapshot 
Manufacturing 
Package

Yes/No Yes Specifies whether the Manufacturing 
Package is used for creating a model in 
Production Scheduling.

MSC: PS - 
Snapshot Purchase
Orders Package

Yes/No Yes Specifies whether the Purchase Orders 
Package is used for creating a model in 
Production Scheduling.

MSC: PS - 
Snapshot Sales 
Orders Package

Yes/No Yes Specifies whether the Sales Orders 
Package is used for creating a model in 
Production Scheduling.
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Profile Option 
Name

Valid Values Default Value Description

MSC: PS - 
Snapshot Supplier 
Package

Yes/No Yes Specifies whether the Supplier Package
is used for creating a model in 
Production Scheduling.

MSC: PS - 
Snapshot Transfer 
Orders Package

Yes/No Yes Specifies whether the Transfer Orders 
Package is used for creating a model in 
Production Scheduling.

MSC: PS - 
Snapshot Work 
Orders Package

Yes/No Yes Specifies whether the Work Orders 
Package is used for creating a model in 
Production Scheduling.

MSC: PS Allow 
WO Purchased 
Item Offloading

Yes/No No Specifies item offloading control for 
purchased items. It allows alternate 
items on work orders consuming 
purchased items. This profile globally 
sets the work order allow offload flag 
to the appropriate value. The Bill of 
Material tab allows you to then set the 
Allow Offloading field to override the 
default as needed for those purchased 
items that have alternates. 

MSC: PS Currency
Symbol

text $ The currency symbol used by PS for 
measurement of costs and calculation 
of key performance indicators.

MSC: PS Resource 
Constraint 
Horizon

Any numeric 
value >= 0

30 (days) Sets a time window from the start of 
the scheduling horizon beyond which 
resource capacity will be relaxed. Value
specified in days. 

MSC: PS Run 
Application Script

text runPS.bat Specifies the name of the batch script 
that starts Production Scheduling.

MSC: PS Run 
Connector Script

text runPSConnecto
r.bat

Specifies the batch script that starts the 
Production Scheduling Connector.
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Profile Option 
Name

Valid Values Default Value Description

MSC: PS/SNO 
Alignment Date

Text 2000-01-01 
00:00:00

The alignment date is the date and time
that fixes the start of time periods in a 
model. The alignment date fixes all 
time period starts, including the Fiscal 
Month 445 period type, where it sets 
the start of 13-week 445 patterns. The 
alignment date format is yyyy-MM-dd 
HH:mm:ss.

MSC: PS/SNO API
Version

Text 3.2 The Supply Chain Planning XML 
format being used to generate SNO and
PS models. 

MSC: PS/SNO 
Client Install Path

Text c:\ The path where the Supply Chain 
Planning Production Scheduling (PS) 
or Strategic Network Optimization 
(SNO) is installed. PS and SNO are 
installed automatically the first time 
they are accessed by the E-Business 
Suite.

MSC: PS/SNO 
Compress Xml 
Package Files

Yes/No Yes Specifies whether data is transferred 
between the ASCP planning server, PS 
and/or SNO using a compressed file 
format also known as .gzip. The 
compressed XML format reduces the 
size of data files transferred, thereby 
minimizing the time involved in the 
creation of models.

MSC: PS/SNO 
Data Store Path

text Null The path to where the refreshed 
snapshot data from the E-Business 
Suite, or the published plans from PS 
or SNO, are temporarily stored before 
being transferred to the ASCP planning
server.

MSC: PS/SNO Past
Due Supplies 
Window

Integer 7 This value specifies the amount of time 
in the past to look for supply. Not 
applicable after 12.1.3.7 and removed 
from the ldt file. However, if this 
profile currently exists in your 
database, you will continue to see it but
it can ignored.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Purchase 
Order Dock Date 
Calculation 
Preference

Need By Date
and Promise 
Date

Promise Date This profile option specifies the 
purchase order line date that the 
planning engine uses as the material 
arrival (suggested dock) date:

- Promise Date: If the Promise Date is 
not available (an unacknowledged 
purchase order), the planning engine 
uses Need by Date.

- Need By Date

This is a site level profile option.

Use the same setting of this profile 
option for running both collections and
plans.

It does not affect supplier capacity, see 
profile option MSC: Supplier Capacity 
Consumption by Purchase Orders.

MSC: Purge 
Staging and Entity
Key Translation 
Tables

Yes/No No Controls both truncation of the staging 
table during data collection process 
and deletion of the link ID tables. 
When running data collections for 
multiple instances simultaneously, set 
to No to avoid data loss. Set to Yes to 
conserve disk space when running data
collections for single instances, or as 
separate processes for multiple 
instances. 

MSC: Refresh 
Snapshots 
Pending Timeout

Integer in 
minutes

10 Sets the time that the Planning Data 
Pull concurrent process waits for 
concurrent process Refresh Snapshots 
on the source before it times out. This 
time out only applies if concurrent 
process Refresh Snapshots is at status 
Pending/Inactive which occurs if 
another version of concurrent process 
Refresh Snapshots is running.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Release WIP 
Dtls if Order Date 
different then 
BOM Revision 
Date

Yes/No Yes If the value is Yes, then planning 
engine releases the WIP details even if 
the Suggested Start Date is different 
than BOM Revision Date. 

If the value is No, the planning engine 
does not release the WIP details if the 
new WIP Start Date is different than 
BOM Revision Date. Oracle Work in 
Process uses the details effective on the 
job start date.

MSC: Released 
Only By User

Yes/No No Use this profile option to specify 
whether to restrict implementation of 
planned orders and recommendations 
to the current user. Valid values are:

- Yes: Only implement planned orders 
and recommendations that this user 
marked

- No: Implement planned orders and 
recommendations that any user 
marked

MSC: Resource 
Group for a Line 
Flexfield Attribute

Integer >= 0 Null This profile option stores the name of 
the flexfield column that contains the 
value in the corresponding table. See 
Flexfield Attributes, page A-1 for more 
information.

MSC: Resource 
Type for an 
Operation 
Flexfield Attribute

- - Not used.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Respect 
Minimum 
Remaining Shelf 
Life Days

Yes/No No Use this profile option to instruct the 
planning engine how to plan supplies 
using minimum remaining shelf life 
days. Valid values are:

- Yes: Plan supplies taking into account 
the minimum remaining shelf life days.

- No: Plan supplies without enforcing 
minimum remaining shelf life days

The planning engine does not calculate 
safety stock if you set this profile to Yes
and you set item attributes for lot 
expiration.

MSC: Safety stock 
change interval 
(Days)

Integer > 0 1 Use this profile option to specify the 
time interval used for smoothing 
within the time interval functionality.

MSC: Safety Stock 
Project

Text Null Specifies the default project charged for
all safety stock demands. Oracle 
Advanced Supply Chain Planning 
assigns the project specified for all 
safety stock demands which originate 
from non-MRP planned safety stock. 
When safety stock requirements are 
specified in Oracle Inventory for 
specific projects, the profile option 
value is not honored. The list of values 
for this profile option is restricted to 
projects specified in Oracle Projects. 
This profile option is enabled at 
project/seiban level, not at the task 
level. 
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Profile Option 
Name

Valid Values Default Value Description

MSC: Sales Orders
Offset Days

Integer >= 0 Null Completed sales orders are collected 
within the offset duration. For example,
if Sales Orders Offset Days is set to 90, 
all the sales orders completed in the 
past 90 days are also collected. Can be 
defined at the site level. A Null value 
means all closed sales orders are 
collected.

Does not apply to complex 
maintenance repair and overhaul 
where the material scheduled for a visit
or task is collected as a sales order in 
Oracle Advanced Supply Chain 
Planning.

MSC: SCEM 
Engine Launch 
Events

None, Load, 
Publish, or 
All

All Launch the Supply Chain Event 
Manager when data is loaded, 
published, or both.

MSC: Self Service 
Loads Delimiter

-/, - Delimiter used to parse the data files 
loaded using self service loads, for 
example, the loading of spreadsheet 
forecast data to Oracle Demand 
Planning.

MSC: Scope of 
Analyze Plan 
Partition

All Partitions,
Plan Partition
Only 

Plan Partition 
Only 

This profile option specifies the 
partitions that concurrent process 
Analyze Plan Partitions should 
analyze.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Share Plan 
Partitions

- - The profile option is a work-around for
test/demo scenarios where you expect 
the creation of many plans by different 
testers and demonstrators. This profile 
option is not meant for production use 
by customers. When enabled the 
number of plan partitions parameter to 
the concurrent program mentioned 
becomes irrelevant; only one partition 
is created for a plan (you can enter 1). 
This profile option should only be 
changed by the system administrator. 

If the MSC: Share Plan Partitions 
profile is turned on, you must run the 
Create APS Partitions program 
afterwards so that it can create the 
partition that every plan shares. 

MSC: Shelf Life 
Override of Order 
Modifiers for 
Transfer Orders

Off/On Off Use this profile option to instruct the 
planning engine whether or not to 
maximize the number of demands 
satisfied with respect to minimum 
remaining shelf life. Valid values are:

- Off: Respect order modifiers for 
transfer orders. Schedule a supply 
pegged to multiple demands based on 
the most constraining demand with 
respect to minimum remaining shelf 
life. 

- On: Ignore order modifiers for 
transfer orders as needed both to 
maximize the number of demands 
satisfied with respect minimum 
remaining shelf life and to maximize 
the usage of supplies in advance of 
their expiry dates. 

MSC: 
Simultaneous 
Resource Sequence
Flexfield Attribute

Integer >= 0 Null This profile option stores the name of 
the flexfield column that contains the 
value in the corresponding table. This 
setup is only performed during 
application install.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Smoothing 
method to 
calculate Safety 
stock within 
Change interval

Minimum, 
Average, or 
Maximum

Average Specifies the mathematical construct 
used to calculate safety stock for a time 
interval using values within the time 
interval.

MSC: SNO - 
Snapshot Base 
Package

Yes/No Yes Specifies whether the Base Package is 
used for creating a model in Strategic 
Network Optimization.

MSC: SNO - 
Snapshot 
Beginning 
Inventory Package

Yes/No Yes Specifies whether the Beginning 
Inventory Package is used for creating 
a model in Strategic Network 
Optimization.

MSC: SNO - 
Snapshot Calendar
Package

Yes/No Yes Specifies whether the Calendar 
Package is used for creating a model in 
Strategic Network Optimization.

MSC: SNO - 
Snapshot 
Customer Package

Yes/No Yes Specifies whether the Customer 
Package is used for creating a model in 
Strategic Network Optimization.

MSC: SNO - 
Snapshot Demand 
Package

Yes/No Yes Specifies whether the Demand Package
is used for creating a model in Strategic
Network Optimization.

MSC: SNO - 
Snapshot 
Distribution 
Package

Yes/No Yes Specifies whether the Distribution 
Package is used for creating a model in 
Strategic Network Optimization.

MSC: SNO - 
Snapshot 
Enterprise 
Forecast Package

Yes/No Yes Specifies whether the Enterprise 
Forecast Package is used for creating a 
model in Strategic Network 
Optimization.

MSC: SNO - 
Snapshot 
Inventory Safety 
Targets Package

Yes/No Yes Specifies whether the Inventory Safety 
Targets Package is used for creating a 
model in Strategic Network 
Optimization.
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Profile Option 
Name

Valid Values Default Value Description

MSC: SNO - 
Snapshot 
Manufacturing 
Package

Yes/No Yes Specifies whether the Manufacturing 
Package is used for creating a model in 
Strategic Network Optimization.

MSC: SNO - 
Snapshot Purchase
Orders Package

Yes/No Yes Specifies whether the Purchase Orders 
Package is used for creating a model in 
Strategic Network Optimization.

MSC: SNO - 
Snapshot Sales 
Order Package

Yes/No Yes Specifies whether the Sales Order 
Package is used for creating a model in 
Strategic Network Optimization.

MSC: SNO - 
Snapshot Supplier 
Package

Yes/No Yes Specifies whether the Supplier Package
is used for creating a model in Strategic
Network Optimization.

MSC: SNO - 
Snapshot Transfer 
Orders Package

Yes/No Yes Specifies whether the Transfer Orders 
Package is used for creating a model in 
Strategic Network Optimization.

MSC: SNO - 
Snapshot Work 
Orders Package

Yes/No Yes Specifies whether the Work Orders 
Package is used for creating a model in 
Strategic Network Optimization.

MSC: SNO 
Connector 
Precision

Numeric 8 Specifies the precision value of the 
SNO connector.

MSC: SNO 
Currency 
Precision

Numeric 2 Specifies the number of decimal places 
used to display currency information in
the SNO Currency Table. For the most 
accurate calculations, a precision of 9 is 
recommended.
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Profile Option 
Name

Valid Values Default Value Description

MSC: SNO 
Decimal Precision

Numeric 2 Specifies the number of decimal places 
shown for data in properties windows. 
Within SNO, the number of decimal 
places is called the display precision. 
Changing the display precision does 
not change the actual data values saved
in a model. The display precision can 
affect results when you match data. For
example, if the display precision is 2, a 
Machine node Utilization field with a 
value of 133.333333 displays 133.33. If 
you try to match Machine nodes with a 
Utilization field value of 133.33, the 
Machine node in this example is not 
matched because its actual value is 
133.333333.

MSC: SNO 
Optimization Type

text Cost Specifies the optimization type to be 
used when solving the model. Valid 
values are:

- Cost: The item list price is not 
considered.

- Profit: The item list price is 
considered.

MSC: SNO Run 
Application Script

text runSNO.bat Specifies the name of the batch script 
that starts SNO.

MSC: SNO Run 
Connector Script

text runSNOConnec
tor.bat

Specifies the batch script that starts the 
SNO Connector.

MSC: SNO 
Transportation 
Capacity By

text Weight Specify the unit of measure that 
determines transportation capacity.

MSC: Source Setup
Required

- See Automatic 
Calculations, 
page A-1.

Internal profile used by the software 
during collections configuration. Do 
not manually update.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Sourcing 
History Start Date 
Offset (in months)

Integer >= 0 Null Offsets the starting date of sourcing 
history calculations and is used in 
conjunction with collections 
parameters Purge Sourcing History = 
Yes and Recalculate Sourcing History = 
Yes. These settings delete, then 
calculate Sourcing History from the 
Start date determined by the profile 
option value (in months). System 
performance can be degraded when 
there is a high value for this profile 
option and a high volume of source 
transaction data.

Valid values are: 

- Null: Collect all of it

- Positive integer: Collect that many 
number of months of it 

Set Planning Data Pull parameter 
Recalculate Sourcing History to Yes.

MSC: Sourcing 
Rule Category Set

Text Null Determines the category set used in 
Oracle Advanced Supply Chain 
Planning in the assignment set form. If 
this not set, the user cannot assign 
sourcing rules and bills of distribution 
at the Category- Instance-Organization 
and Category-Instance level.

MSC: Sourcing 
Variance 
Tolerance

Number 
between 0 
and 1

0.05 (5%) Used when Enforce Sourcing 
Constraints is enabled for a plan. This 
percentage value establishes a 
threshold for triggering exception 
messages if sourcing allocations are 
violated. Exceptions are generated if 
the difference between the 
user-specified sourcing allocation 
percentages and the plan-derived 
allocation percentages is greater than 
the Sourcing Variance Tolerance. The 
profile option is entered as a number 
and converted to a percentage. If the 
user enters 0.5 it becomes 50%.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Split 
Planned Order to 
perform safety 
stock pegging

No, Yes but 
do not violate
order 
modifier, or 
Yes

No Use this profile option to instruct the 
planning engine how to split a planned
order that pegs to customer demand 
when pulling it in to meet transient 
safety stock. Valid values are:

- No: Do not split planned orders

- Yes but do not violate order modifier: 
Split planned orders only if the split 
does not violate an order modifier

- Yes: Split planned orders

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine only 
uses this profile option if its value is 
No.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Split 
Planned Orders 
for Scheduling 
Flexibility

Yes/No Yes For constrained plan with decision 
rules and optimized plans, it 
determines whether the planning 
engine consolidates planned orders 
that were split during optimization 
processing prior to scheduling them. 
For unconstrained plans, set it to No. 

- Yes: Do not consolidate planned 
orders prior to scheduling.

The planning engine splits them into 
multiple planned orders whose 
quantities generally satisfy one 
planning time bucket's worth of 
capacity against the resources or 
suppliers used in the planned order. 
During scheduling, the planning 
engine has more flexibility to place 
smaller quantities into available time 
slots. You cannot specify the size of the 
durations and the planning engine 
does not guarantee that each planned 
order in the final plan output spans 
exactly one planning bucket.

- No: Consolidate orders when possible
prior to scheduling.

Use this value if you tend to have long 
production runs per routing that cross 
multiple planning buckets. The 
planning engine creates a single 
planned order.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
ignores this profile option and does not
consolidate planed orders prior to 
scheduling.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Supplier 
Capacity 
Accumulation 
(multiplier)

Numeric 
value > 0; 
may be larger
than 1

1 This profile option is a multiplier to 
ASL lead-time. The planning engine 
uses it to derive the date when capacity
accumulation begins for a supplier.

If profile option MSC: Purchase Order 
Dock Date Calculation Preference is 
Promise Date, Oracle suggests that you 
set this profile option to 0 so that 
suppliers accumulates capacity within 
their lead-time.

This is a site level profile option. 

MSC: Supplier 
Capacity 
Consumption by 
Purchase Orders

Yes, No 
Consumption
, 
Unacknowled
ged Purchase 
Orders Only, 
Purchase 
Orders 
outside Lead 
Time Only

No 
Consumption

This profile option specifies which 
purchase orders the planning engine 
uses to consume supplier capacity. 
Valid values are:

- Yes: All purchase orders consume 
supplier capacity

- No Consumption: No purchase orders
consume supplier capacity

- Unacknowledged Purchase Orders 
Only: Only purchase orders without a 
promise date consume supplier 
capacity

- Purchase Orders outside Lead Time 
Only: Only purchase orders with dock 
date outside of lead time consume 
supplier capacity

MSC: Suppress 
Exception for 
Selection of 
Alternates

Yes/No No Controls whether the planning engine 
generates exceptions related to 
alternate bills of material and routings. 
If the profile option is No, it does not 
generate those exceptions.

MSC: Temp Index 
Extent Size (Bytes)

- - Not used

MSC: Temp Table 
Extent Size (Bytes)

- - Not used
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Profile Option 
Name

Valid Values Default Value Description

MSC: 
Transportation 
Domain

Null, 
<domain 
name>

Null Use this profile option to specify the 
domain name that identifies the source 
instance integrated with Oracle 
Transportation Management. Enter the 
same value that is in profile option 
OTM: Domain Name.

MSC: Unit of 
Measure

- - Not used.

MSC: Update 
Requested 
Completion Date 
when Releasing 
Reschedules

n/a n/a n/a

MSC: Use attribute
based netting

Yes/No No Use this profile option to control 
netting in a project manufacturing 
environment. Valid values:

- Yes: Planning nets at the reservation 
level. It respects pegging level and 
creates planned orders based on hard 
pegging level. It does not respect order 
modifiers if the reservation level and 
hard pegging level are not the same. 
With this approach, you can enable 
priority pegging can be enabled.

- No: The planning engine uses 
customary netting in a project 
manufacturing environment.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Use Base 
Model during 
Forecast 
Consumption

Yes/No No Use this profile option to instruct the 
planning engine whether to consume 
configure to order forecasts with 
attention to the top-level models.

Valid values are:

- Yes: Consume configure to order 
forecasts for the same top-level model 
on the sales order line

- No: Consume configure to order 
forecasts without attention to their 
top-level models

Coordinate how you set this profile 
option with how you set profile option 
MSD: Publish CTO Forecast 
Percentages by Top-level Model.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Use FIFO 
Pegging

Yes/No No If this profile option is Yes, the 
planning engine uses FIFO pegging. 

For all demands and supplies, it 
proceeds item by item and pegs 
supplies to demands on a daily basis. 
Daily supplies and demands are not 
sorted. When supplies or demands on a
given date are used up, it picks from 
supplies or demands on the next date. 
The unpegged supplies are pegged to 
excess. 

If the plan option Peg Supplies by 
Demand Priority is selected, it 
performs a priority based allocation of 
firm supplies prior to performing the 
FIFO pegging of the non-firm supplies.

If profile option MSC: Use FIFO 
pegging is No, it uses either standard 
pegging or priority pegging logic. See 
profile options MSO: Demand Window
Size, MSO: Supply Window Size, MSO:
Firm Supply Allocation Window 
(Backward days), and MSO: Firm 
Supply Allocation Window (Forward 
days).

This is a user level profile option.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine does 
not use this profile option.

The planning engine performs safety 
stock smoothing only if this profile 
option is No.

MSC: Use Hash 
Key

- - This profile option is for use by Oracle
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Profile Option 
Name

Valid Values Default Value Description

MSC: Use 
Optimization 
Supply Due Dates 
for Pegging

Yes/No No Use this profile option to instruct the 
planning engine on the date fields to 
use when pegging. 

- Yes: Pegging uses the optimization 
recommended supply date for planned 
orders and scheduled receipts.

In FIFO pegging, the supply sequence 
is based on the optimization supply 
date. In priority pegging, the division 
of the supply window is based on 
optimization supply date. This setting 
has no effect on form supplies because 
optimization does not move the 
schedule date.

For independent demands, the 
optimization demand date is the 
schedule date. For dependent 
demands, the planning engine offsets 
optimization demand date from the 
optimization supply date of its 
assembly's supply

In co-product/by product 
environments, the planned 
order/scheduled receipt and its related 
by-product planned order/scheduled 
receipt have the correct optimization 
supply date for pegging. 

It reduces pegging discrepancies in 
which the main supply is pulled out 
and the by product supply remains at 
the original schedule date.

- No: Pegging behaves in the standard 
way.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine only 
uses this profile option if its value is 
Yes.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Use 
Shipping 
Receiving 
Calendars 

Yes/No Yes Controls the use of shipping, receiving, 
and carrier calendars. Values are:

- Yes: Use shipping, receiving, or, 
carrier calendar for 
planning/scheduling

- No: Use the organization 
manufacturing calendar while 
generating a plan. 

This profile option specifies:

- At the site level, whether the 
collection engine collects the calendars. 
If the calendars are collected, the 
planning engine uses them.

- At the user level, whether Planner 
Workbench displays the collected 
calendars. Even if the planning engine 
used the calendars, if the user level 
value is No, the Planner Workbench 
displays calendars as 24x7. This should 
be avoided.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine only 
uses this profile option if its value is 
Yes.

MSC: Vertical 
view default query

Not 
applicable

Not applicable Used by Oracle Collaborative Planning 
to display default results in the vertical 
view.

MSC: VMI Default
Query

Not 
applicable

Not applicable Used by Oracle Collaborative Planning 
to display default results on the VMI 
page.
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Profile Option 
Name

Valid Values Default Value Description

MSC: Wait Time to
Obtain Lock on 
Table/Partition for 
Snapshot Delete 
Worker (in sec)

Number >=0 60 seconds Time (in seconds) the Snapshot Delete 
Worker waits to obtain a lock on a 
table/partition before aborting. 
Releasing plans recommendations 
through Workbench and running 
Purge Plan can cause locks on the 
table/partition preventing the Snapshot
Delete Worker from obtaining a lock. If 
the timer expires, the program prints 
the following message in the log file: 
Unable to obtain a lock on table.

MSC: Write MBP 
Flat Files

Yes/No No Profile provide controls whether to 
flush the Planner concurrent process 
data files and setup data files during 
the plan run. If Yes, the process writes 
all the files to the 
$APPLCSF/out/data<planid> directory.

MSD Profile Options
The following table lists and defines the MSD profile options in Oracle Advanced 
Planning.

Profile Option 
Name

Valid Values Default Value Description

MSD: Calculate 
Planning 
Percentages

Planning 
Percentages

Forecast 
Explosion

Forecast 
Explosion

This profile option controls the 
behavior of the planning percentage 
calculations. For example, it controls 
whether the planning percentages 
can be calculated from the sales 
history of options. This profile can 
prevent expensive calculations when 
the user does not want to calculate 
planning percentages and just wants 
to use the existing planning 
percentages specified in the 
enterprise resource planning source 
to explode the forecast.
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Profile Option 
Name

Valid Values Default Value Description

MSD: Category Set 
Name

Category set 
names

Null This profile option is used to select 
one category set during the data 
collection process. If the user value is 
left blank, then all categories will be 
selected for data collection. Valid 
values are limited to valid category 
set names.

MSD: Client 
Debugging

- - This profile option is for use by 
Oracle. It allows you to enable 
debugging tools.

MSD: Code 
Workspace

- - This profile option is for use by 
Oracle.

MSD: Conversion 
Type

Conversion 
rates

Null This profile option determines what 
conversion rates are collected from 
the General Ledger rates table. Valid 
values are limited to valid conversion
rates.

MSD: Currency 
Code

Currency 
codes

Null This profile option designates the 
base currency used in Oracle Demand
Planning. All revenues are calculated 
and displayed in this base currency. 
Valid values are limited to the 
currency list of values.
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Profile Option 
Name

Valid Values Default Value Description

MSD: Customer 
Attribute

Descriptive 
flexfield 
column 
names

Null This is a source profile option used to
selectively bring the customer names 
into Oracle Demand Planning to 
improve the system performance. 
This profile holds the descriptive 
flexfield column name that is used to 
indicate if a customer in the 
Customers table will be used by 
Oracle Demand Planning. Only those 
customers in the Geography 
dimension that have this flexfield 
populated will be collected. 

This profile option value is one of the 
attribute columns of the 
RA_CUSTOMERS entity, which 
indicates whether or not the customer
will be used for demand planning 
purposes. In the customers table, you 
need to reflect this in a descriptive 
flexfield. All of the source views for 
the geography dimension that use the
RA_CUSTOMERS entity filter using 
this attribute column. If the profile 
option is not provided, then no 
filtering will occur. If the profile 
option is provided, then only the 
entities in the geography dimension 
that have the attribute in the 
RA_CUSTOMERS entity specified as 
Yes will be collected. To set up Key 
Customers, go to the Customer setup 
screen in Oracle Applications. Select 
the relevant customer and set an 
available flexfield column to Yes. For 
example, if you use attribute10, then 
you need to use this information in 
the MSD profile option setup also. 
Also, in the source instance, set up 
the following information for profile 
option value 
MSD_CUSTOMER_ATTRIBUTE: list 
of values from ATTRIBUTE1 to 
ATTRIBUTE15. 
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Profile Option 
Name

Valid Values Default Value Description

MSD: Default DP 
Scenario

Valid 
demand 
planning 
scenarios

Null This profile option specifies a 
demand scenario, which appears as a 
demand schedule in the Plan Options
window. 

You can select the demand scenario 
from the list of values.

When you publish the demand 
scenario specified in this option, the 
planning engine launches the 
unconstrained plan specified in the 
profile option MSC: New Forecast 
Auto Plan.

MSD: Master Org Master 
organizations

Null This profile option is used to select a 
master organization, if there are 
multiple master organizations. The 
item attributes pertaining to the 
selected master organization are used
by Oracle Demand Planning.

MSD: OLAP 
Directory Alias

- - Use this profile to specify the 
database directory alias used to store 
the log files created during the 
demand plan build process should be
stored. It is primarily for the technical
use of login and file-based operations.

This profile option can be set at the 
site level.
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Profile Option 
Name

Valid Values Default Value Description

MSD: One Step 
Collection

Yes/No No This profile option controls the 
number of steps in the data collection 
process. Valid values are:

Yes: indicating that the collection 
programs should take the data 
directly into the Fact Tables in a 
single step. 

No: allows for the default two step 
collection process. In the first step, 
the collection programs take the data 
in to the Staging Tables where the 
data can be consolidated and 
cleansed by the user, if required. In 
the second step, the pull concurrent 
programs carry the data over to the 
Fact Tables from the Staging Tables. 
Both set of tables exist on the 
Demand Planning Server.
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Profile Option 
Name

Valid Values Default Value Description

MSD: Publish CTO 
Forecast 
Percentages by 
Top-level Model

Yes/No No Use this profile option to instruct the 
Oracle Demantra Demand 
Management how to publish 
configure to order forecast 
percentages for options, option 
classes, and models that are in the bill
of materials for multiple top-level 
models. For example, Option Class M
is in the bills of material for both 
Model A and Model B.

Valid values are:

- Yes: Oracle Demantra Demand 
Management publishes planning 
percentages for option classes and 
options for each model bill of 
material that they are in. When the 
planning engine explodes forecasts, it
keeps the exploded information 
separated by top-level models.

- No: Oracle Demantra Demand 
Management publishes planning 
percentages for option classes and 
options aggregated over all the model
bills of material that they are in.

If you set it to Yes, you can see the 
source of each published planning 
percentage in Planner Workbench, 
Supply/Demand window in fields:

- Parent Model: The immediate 
parent of the option, option class, and
model in the forecast

-Top-level model: The top-level 
model of the option, option class, and
model in the forecast
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Profile Option 
Name

Valid Values Default Value Description

MSD: Two-Level 
Planning

Exclude 
family 
members 
with forecast 
control 
'None'/Collec
t all family 
members and
their sales 
histories

Exclude family 
members with 
forecast control 
'None'

Use this profile option to forecast 
demand at product family level on 
the basis of sales histories of member 
items. 

You can collect the sales histories of 
all the product family members 
regardless of their forecast control; 
set:

- Product family forecast control to 
Consume or Consume and derive

-Planning method for the product 
family and its members to Not 
planned

- This profile option to Collect all 
family members and their sales 
histories

You can collect the sales histories of 
all the Consume and Consume and 
derive product family members; set 
this profile option to Exclude family 
members with forecast control 'None'.

Use this profile option to forecast 
demand at the product family level 
on the basis of sales histories of 
member items. You can collect all the 
product family members and their 
sales histories regardless of the 
forecast control as long as the:

- Product family forecast control is 
Consume or Consume and Derive

- Planning method for the product 
family and its members is Not 
planned.

- Set this profile option to Collect all 
family members and their sales 
histories.

The default profile value is Exclude 
family members with forecast control 
'None' specifies that only Consume or
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Profile Option 
Name

Valid Values Default Value Description

Consume and Derive product family 
members are subject to collection.

MSO Profile Options
In general. MSO: profile options apply only to constrained and optimized plans. If an 
MSO: profile option applies to unconstrained plans, its description specifically mentions
it.

The following table lists and defines the MSO profile options available with Oracle 
Advanced Planning.

Profile Option 
Name

Valid Values Default Value Description

MSO: Activity 
Selection Window 
(Days)

any number 7 This profile option specifies the 
number of days over which the 
planning engine groups activities 
that are candidates for scheduling. 
The larger the number, the greater 
the chance of finding an activity 
that can be scheduled with another 
activity of the same setup type. 
Making this number too large 
might result in demand priorities 
not being fully respected while 
scheduling.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Additional 
Demand Slices for 
Shared Supply 
Rescheduling

Number >= -1 0 Controls the maximum number of 
slices to which supply can be 
rescheduled. Accepts values from 
-1 to maximum number of slices. 
Controls the maximum number of 
slices to which supply can be 
rescheduled. Supply is not 
rescheduled after this maximum 
even when demand will be 
delayed. Possible values include: -1:
Reschedule to last slice 0: Does not 
reschedule. 

For example, if a supply pegs to 
demand in slice 2, 3, 4, 5, and 6, and
the parameter value is 2, supply 
will reschedule if needed in slice 3 
and 4 (rescheduled 2 times, in slice 
3 and 4) and will not reschedule in 
slice 5 and 6.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Allow early 
builds to consume 
existing supplies of 
phased-out 
components and 
sources

Yes/No Yes With Oracle Process 
Manufacturing, use this profile 
option to specify whether the 
planning engine plans supplies 
earlier than their pegged demand 
due dates. You want to plan 
supplies early to make them before 
their bills of material become 
obsolete. Valid values are:

- Yes: It does

- No: It does not. It plans to make 
the item due on the demand due 
date and using the components that
are effective on the demand due 
date.

You can use this profile option in 
these planning modes:

- Constrained (Classic)

- Constrained (Without Detailed 
Scheduling)

- Constrained (With Detailed 
Scheduling) 
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Profile Option 
Name

Valid Values Default Value Description

MSO: Allow Partial 
Demand 
Completion

All End 
Demands, 
Sales Orders, 
or None

None Enables supply orders to 
individually schedule for partial 
satisfaction of a demand when 
demand is split across several 
supply orders. Valid values 
include: All End Demands: Enable 
Partial Demand Satisfaction for all 
independent demands (forecasts, 
sales orders, and MDS entries). 
Sales Orders: Enable Partial 
Demand Satisfaction for all Sales 
Order demand only. None: 
Schedules all supplies to coincide 
with completion date (latest supply
date) to meet demand.

This functionality can be enabled 
for all independent demands or 
only for Sales Orders.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
only uses this profile option if its 
value is All End Demands.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Allow 
Schedule Gaps for 
Shared Supplies

Yes/No No This profile option controls the 
scheduling of shared supplies 
(scheduled receipts, firm planned 
orders, and planned orders with 
multiple demands pegged to them).

- Yes: When scheduling shared 
supplies, the shared supply is 
moved to the right (moving the 
schedule date later) during the final
scheduling step (to coincide with 
the start time of downstream 
supplies) if it would make one of 
the pegged demands late or later. 
The shared supply schedule is 
always right justified if it does not 
make any pegged demands late or 
later. 

When a lower-level shared supply 
is scheduled for the highest priority
demand pegged to it, there may be 
a gap between the shared supply 
end date and the start date of the 
next downstream supply. By not 
right justifying it, it is more likely to
be on time for the lower priority 
demands in later demand slices 
which are also pegged to it. 

Before selecting Yes, consider the 
setting for MSO: Additional 
Demand Slices for Shared Supply 
Rescheduling. If this profile is not 0,
shared supplies may be 
rescheduled and this profile option 
does not need to be Yes. For 
example, Demand A with priority 
100 and Demand B with priority 
500 are in different slices. If the 
shared supply is late for Demand B,
it may still be rescheduled to be on 
time depending on available 
capacity and the number of 
additional demand slices in which 
it is scheduled.
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Profile Option 
Name

Valid Values Default Value Description

If MSO: Additional Demand Slices 
is 0 and this profile option is Yes, 
the planning engine does not right 
justify the shared supply due date; 
the shared supply might still be on 
time for demand B even though it is
not rescheduled in a later slice. 

- No: When scheduling shared 
supplies and moving them to the 
right (moving the schedule date 
later), the planning engine does not 
consider demands in other slices 
that are not yet unscheduled but 
pegged to this supply. This yields a 
schedule with fewer gaps but at the
expense of potentially more late 
demands.

This is a user level profile option. 

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.

MSO: Alternate 
Process Penalty

Number > 0 See Automatic 
Calculations, 
page A-1.

Specifies weight for alternate 
process objective in optimization. 
This value is specified as a number 
greater than 0, and is an internal 
value.

MSO: Alternate 
Resource Penalty

Number > 0 See Automatic 
Calculations, 
page A-1.

Specifies weight for alternate 
resource objective in optimization. 
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Profile Option 
Name

Valid Values Default Value Description

MSO: Alternate 
Resource Selection 
Method

Rank of 
Alternate

Setup Type 
Match

If Rank of Alternate, ASCP will 
prefer to load the primary resource 
if it is available even if it means 
incurring a setup that could have 
been avoided by going to the 
alternate.

If Setup Type Match, ASCP will 
prefer the alternate that is the best 
option from a setup minimization 
perspective. If all alternates are 
equal from a setup perspective, 
then ASCP chooses the alternate 
based on rank.

MSO: Alternate 
Source Penalty

Number > 0 See Automatic 
Calculations, 
page A-1.

Specifies weight for alternate 
source objective in optimization. 
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Profile Option 
Name

Valid Values Default Value Description

MSO: Avoid non 
working days for 
Buy/Transfer order 
dates

Yes/No No This profile option applies only 
when profile option MSO: Use Shift
definitions when scheduling 
lead-times is No. Valid vales are:

- Yes: The planning engine avoids 
placing the ship, dock, due dates of 
buy and transfer orders on 
non-workdays according to the 
appropriate calendar.

- No: The planning engine does not 
schedule buy and transfer orders 
with regard to the appropriate 
calendar.

This profile option does not govern 
the placement of order dates.

If profile option MSO: Use Shift 
definitions when scheduling 
lead-times is Yes, the planning 
engine assumes accurate shift 
timings.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
only uses this profile option if its 
value is Yes.

MSO: Barrier 
Optimizer 
Algorithm Choice

0, 1, 2, or 3 Null (interpreted
as 0)

This profile indicates which starting
point algorithm the planning 
engine when it uses the barrier 
algorithm to solve an optimization 
problem. It applies only when 
multiple threads are used in 
optimization.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Calculate 
Constraint 
Exceptions

Yes/No No Determines whether constraint 
exceptions are calculated for plans 
with Enforce Capacity Constraints 
selected.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Capacity 
Units Recalculation 
Threshold

Any value 
between 0 and
1

0 The planning engine schedules 
supplies in two phases:

- Backward schedule: From 
demand due date to see if demand 
can be met on time.

- Forward schedule: If the 
backward schedule results in a late 
demand, the forward schedule 
from the plan start date meet 
demands with minimum lateness.

At the end of the forward schedule 
phase, the planning engine adjusts 
the schedule to remove gaps 
between supplies (right 
justification). It may move a supply 
to occur at a time where there are 
more resource units available that 
there were in its previously 
scheduled time.

If this profile option is 1, the 
planning engine considers 
assigning more resource units to 
the supply. For example, this 
profile option is 0.5. The planning 
engine considers changing the 
number of resource units if the 
current capacity units value is less 
than 0.5 * Max assigned units on 
the routing for the item.

If this profile option is 0, the 
planning engine does not consider 
assigning more resource units. 

This is a user level profile option.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Check 
Redundant 
Constraints

0 and 1 See Automatic 
Calculations, 
page A-1.

Specifies location and removal of 
redundant constraints.

MSO: Choice of 
supply for 
substitution

All Supplies, 
Excess 
Supplies

All Supplies Determines which supplies are 
considered by the Planning Engine 
for substitution. Valid values are: 
All Supplies: Oracle Advanced 
Supply Chain Planning takes 
supplies belonging to substitute 
items even when there is demand 
for substitute items. Demand 
priorities drive the allocation. 
Excess supplies - Oracle Advanced 
Supply Chain Planning takes 
supplies belonging to substitute 
items only if it finds that the supply
from the substitute item is in 
excess. Oracle Advanced Planning 
performs regular netting logic 
within the Substitution Window 
and find that excess can be offered 
for substitution. The native demand
satisfaction has priority only within
the Substitution Window. After the 
Substitution Window demand 
priorities drive the substitution.

Oracle Order Promising does not 
honor this profile option. Oracle 
Order Promising always honors 
native demand satisfaction logic. 

MSO: Component 
offset logic for 
optimization 

2 n/a n/a
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Profile Option 
Name

Valid Values Default Value Description

MSO: Consume 
Firm Work Orders 
Based on Resource 
Hours

Yes/No No Use this profile to instruct the 
planning engine what data to use 
for resource load when it 
determines resource availability. 
Valid values are:

- Yes: The planning engine uses 
resource hours to determine the 
resource load. Use this value if you 
do not attend to work in process 
timestamps, your work in process 
times are not adjusted for 
efficiency, and you specify resource
hours.

- No: The planning engine uses 
timestamps to determine the 
resource load. Use this value if your
work in process times are adjusted 
for efficiency. If work in process is 
scheduled by the planning engine 
scheduling process, choose this 
value.

MSO: Continuous 
transfer across 
organizations

Yes/No No Allows you to model continuous or 
non-continuous transfers across 
organizations.

- Yes: Allows continuous transfers 
across organizations.

- No: Allows discrete, incremental 
or non-continuous transfers across 
organizations. 

This feature can also be set at the 
item/organization level using the 
Continuous Inter-Org Transfers 
item attribute. The value specified 
for the item attribute overrides the 
profile option setting.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Convergent 
Supplies 
Consumption 
Pattern for 
Inter-Org and 
Supplier Sourced 
orders

Series/ Parallel Parallel Allows you to fulfill a demand in 
series or in parallel from multiple 
supplies from suppliers and/or 
other organizations. Values are:

- Series - Demand is satisfied in 
series from multiple supplies.

- Parallel - This is the default value. 
Demand is satisfied in parallel from
multiple supplies.

For supplier sourced orders, use 
profile option MSO: Convergent 
Supplies Consumption Pattern for 
Inter-Org and Supplier Sourced 
Orders. 

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.

MSO: Convergent 
Supplies 
Consumption 
Pattern for 
Intra-Org Sourced 
orders

Series / 
Parallel

Parallel Allows you to satisfy a demand in 
series or in parallel from multiple 
supplies in the same organization. 
Values are:

- Series - Demand is satisfied in 
series from multiple supplies.

- Parallel - This is the default value. 
Demand is satisfied in parallel from
multiple supplies

If a component is fed by orders 
from multiple organizations, the 
value of profile option MSO: 
Convergent Supplies Consumption 
Pattern for Inter-Org and Supplier 
Sourced orders overrides the value 
of this profile option. 

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Cost Roll-up 
incremental factor

Null, positive 
number

Null This profile option controls the cost 
increments used by the internal cost
roll up in Oracle Advanced Supply 
Chain Planning. The cost 
calculation is: 

SUM across all components for the 
assembly [K * Cost of a component 
* (Usage of the component for the 
assembly + 0.01)]. 

K is the value that you set in this 
profile option. Oracle recommends 
a minimum value of 1. 

Valid values are:

- Null: Use the standard cost roll-up
logic 

Positive number: Use this factor in 
the cost roll-up logic of the 
planning engine optimization 
phase to calculate the assembly cost
based on the components costs

MSO: CPLEX Crash
Parameter

-1, 0, and 1 See Automatic 
Calculations, 
page A-1.

Determines how objective 
coefficients are used to select basis. 

MSO: CPLEX 
Refactor Rate

Integer >= 0 See Automatic 
Calculations, 
page A-1.

Specifies the value of the parameter
to control the refactor rate. 

MSO: CPLEX 
Scaling Factor

-1, 0, and 1 See Automatic 
Calculations, 
page A-1.

Contains the scaling factor in the 
Planning Engine.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Create 
Aggregate Supply 
for Unsatisfied 
Demands within 
Planning Time 
Fence

Yes/No No Use this profile option to instruct 
the planning engine whether to 
create one supply order to meet the 
demand within the planning time 
fence.

Valid values are:

- Yes: Create one supply order

- No: Create multiple supply orders

In both cases, the planning engine:

- Considers demand from the plan 
start date through and including 
the planning tine fence date

- Creates the orders on the planning
time fence date

MSO: Default 
Forecast Priority

Integer >= 0 100000 Contains default priority value for 
forecasts and is used by the 
Scheduling Engine to determine 
when to schedule the forecast. Can 
be defined at the site level. 
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Profile Option 
Name

Valid Values Default Value Description

MSO: Default 
Resource 
Sequencing 
Window (Days)

any number 7 After the planning engine select an 
unscheduled activity from the 
activity selection window specified 
by MSO: Activity Selection 
Window (Days), this profile option 
specifies the number of days from 
the pegged demand date over 
which the planning engine can look
for another activity of the same 
setup type to schedule the activity 
with and achieve a good sequence 
on the resource. This profile option 
number can be overridden by 
resource level settings made in the 
Departments: Resources screen in 
the source system.

The large this number, the longer 
the time spent by the resource on a 
setup type before changing over to 
the next setup type.

MSO: Default Sales 
Order Priority

Integer >= 0 10000 Contains default priority value for 
sales orders. Used by the 
Scheduling Engine to determine 
when to schedule a sales order. Can
be defined at the site level.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Default 
Timestamp for 
Forecasts

Beginning of 
Day or End of 
Day

End of Day This profile option determines the 
forecast timestamps that Oracle 
Advanced Supply Chain Planning 
uses to plan. It applies to forecast 
scenarios from Oracle Demand 
Planning, master demand schedule 
forecasts, and manual master 
demand schedule entries. The 
timestamp denotes the time by 
which supplies to meet the demand
must be available to be considered 
on time:

Values are:

- Beginning of Day: Supplies must 
be available at 00:00

- End of Day: Supplies must be 
available at 23:59

This profile option does not apply 
to sales orders.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Default 
Timestamp for 
Sales Orders

Beginning of 
Day, End of 
Day, or Retain
Sales Order 
Timestamps

End of Day This profile option determines the 
sales order line timestamps that 
Oracle Advanced Supply Chain 
Planning uses to plan. The 
timestamp denotes the time by 
which supplies to meet the demand
must be available to be considered 
on time:

Values are:

- Beginning of Day: Supplies must 
be available at 00:00.

- End of Day: Supplies must be 
available at 23:59.

- Retain Sales Order Timestamps: 
Supplies must be available at the 
timestamp on the sales order line. 
The sales order demand due 
timestamp does not affect forecast 
consumption because forecast 
consumption is done in daily 
buckets. 

This profile option does not apply 
to forecasts.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Default 
Timestamp Safety 
Stocks

Beginning of 
the Day or 
End of Day

Beginning of the 
Day

The planning engine uses this 
profile option value to determine 
when safety stock supplies are due. 
The timestamp value applies to the 
safety stock requirements from 
Oracle Inventory, Oracle Inventory 
Optimization, Oracle Material 
Requirements Planning, and Oracle
Advanced Supply Chain Planning.

The values are:

- Beginning of Day: Supplies must 
be available at 00:00. Set this option 
if you want to use timestamps that 
match safety stock requirements 
from Oracle Inventory 
Optimization. 

- End of Day: Supplies must be 
available at 23:59. Set this option if 
you want to use timestamps that 
match safety stock requirements 
from Oracle Inventory or Oracle 
Material Requirements Planning.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
only uses this profile option if its 
value is End of Day.

MSO: Delay 
fulfillment of small 
demands

Yes/No No Use this profile option to enable the
planning engine to delay fulfilling a
small demand until it has a later 
larger demand. If you select Yes, set
the item attribute Unsatified 
Demand Factor on each item whose
small demands you want delayed. 
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Profile Option 
Name

Valid Values Default Value Description

MSO: Demand Size 
Tolerance Before 
Splitting Planned 
Orders

Number >=0 Null Creates a threshold percentage that 
causes Planned Orders to split prior
to scheduling (if the remaining 
unallocated quantity of a planned 
order is greater than the remaining 
unallocated quantity of the pegged 
demand). Not used if order 
modifiers exist for an item and not 
used in a project planning 
environment. Valid values are 
positive decimal quantities (.5 is 
interpreted as 50%). 

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option

MSO: Demand 
Window Size

integer >=0 Null During priority pegging, demands 
are sorted based on the demand 
priority within the demand 
window. After these demands are 
fully pegged, Oracle Advanced 
Supply Chain Planning sorts all 
demands in the next window by 
priority. This is stated as the 
number of calendar days including 
non-workdays. With a value of 10, 
the first demand window is 
between the start date of the plan or
the first demand date +10 days. The
default (Null) is treated as 1 in the 
Planning Engine.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
uses this profile option as value 1 
day.



Profile Options    A-103

Profile Option 
Name

Valid Values Default Value Description

MSO: Disable 
Inference of Item 
Substitution 
Relationship

Yes/No/Null Null Use this profile option to instruct 
the planning engine whether to 
infer end item substitution 
relationships. Valid values are:

- Yes: Do not infer item substitution
relationships

- No/Null: Do infer item 
substitution relationships

MSO: Divergent 
Supply Feeding 
Pattern for 
Inter-Org and 
Supplier Sourced 
orders

Series With 
MTQ Only / 
Series

Series With MTQ
Only

Allows you to fulfill multiple 
downstream demands in parallel or
in series by a supply from another 
internal organization. Values are:

- Series With MTQ Only - This is 
the default value. A supply always 
feeds multiple demands in series 
when a corresponding MTQ has 
been specified.

- Series - Supply feeds multiple 
demands in series.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Divergent 
Supply Feeding 
Pattern for 
Intra-Org Sourced 
orders

Series With 
MTQ Only / 
Series

Series With MTQ
Only

Allows you to fulfill multiple 
downstream demands in parallel or
in series by a supply in the same 
organization. Values are:

- Series With MTQ Only - This is 
the default value. A supply always 
feeds multiple demands in series 
when a corresponding MTQ has 
been specified.

- Series - Supply feeds multiple 
demands in series. 

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.

MSO: Dual Simplex
Parameter

0, 1, 2, 3, and 4 See Automatic 
Calculations, 
page A-1.

Gradient parameter for dual 
simplex. 
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Profile Option 
Name

Valid Values Default Value Description

MSO: EDD 
Scheduling 
Window Control 

Any value 
between 0 and
1

0.5 This profile option is applicable to 
constrained plans with enforce 
demand due dates.

The planning engine calculates an 
actual scheduling window for each 
resource activity and supply. The 
actual window is defined by the 
dates:

- Latest Possible completion time 
(LPCT): Determined by the start 
time of downstream activities that 
have already been scheduled. 

- Earliest Allowable Completion 
Time (EACT): Calculated by the 
planning engine which accounts for
the unscheduled upstream 
activities and how much time those 
activities need.

If this profile option is the default 
value, the planning engine uses the 
calculated EACT.

If this profile option is lower than 
the default value, the planning 
engine uses an earlier EACT than 
the calculated EACT which gives 
the activity a larger scheduling 
window.

If this profile option is higher than 
the default value, the planning 
engine uses a later EACT than the 
calculated EACT which gives the 
activity a smaller scheduling 
window. 

This is a user level profile option.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Enable Cost 
Rollup for 
Optimization

Yes/No Null (interpreted
as No)

This profile specifies where the 
optimization engine looks for costs 
during cost-based optimization. 
Valid values are:

- No: Use user-provided costs from 
the source system

-Yes: Use costs from the internal 
cost rollup

MSO: Enable 
Decision Rules

Yes / No No The profile option enables User 
Defined Decision Rules. Yes: Use 
the user-defined decision rules. No:
User defined decision rules are not 
allowed. The Plan Options tab, 
Decision Rules, is disabled.

MSO: Enable Hard 
Links Globally

Yes/No No Use this profile option to specify 
whether the planning engine 
should globally enforce hard link 
constraints. Valid values are:

- Yes: Enforce hard link constraints

- No: Do not enforce hard link 
constraints

MSO: Enable 
Triangulation in 
Optimization

- - Reserved for future use.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Enforce 
Resource Sequence 
Contiguity

Yes / No Yes Controls contiguity constraints 
between resource activities within 
an operation. Valid values are:

- Yes: Resource activities within the 
same operation are scheduled 
contiguously in time. The end of 
the preceding activity exactly lines 
up with the start of the current 
activity and the end of the current 
activity exactly lines up with the 
start of the next (if there is MTQ 
specified, the activities may also 
overlap).

- No: The contiguity constraint is 
relaxed and in certain cases, the 
chances of obtaining feasible 
schedules improved.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.

MSO: Firm 
Operations/Orders 
Within Time Fence

Yes/No/Null No Indicates whether or not the 
planning engine should firm those 
operations and orders that are 
within the plannng time fence. The 
valid values are:

- Yes/Null: Firms operations and 
orders that are within the time 
fence.

- No: The planning engine does not 
reschedule the non-firm operations 
and orders that have dock dates 
within the time fence. 

This profile option also applies to 
unconstrained plans.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Firm 
Purchase Orders 
Within Time Fence

Yes/No/Null No Indicates whether or not the 
planning engine should firm those 
purchase orders that are within the 
planning time fence. The valid 
values are:

- Yes/Null: Firms purchase orders 
that are within the time fence.

- No: The planning engine 
reschedules and cancels the 
non-firm purchase orders that have 
dock dates within the time fence

This profile option also applies to 
unconstrained plans.

MSO: Firm 
Requisitions Orders
Within Time Fence

Yes/No/Null No Indicates whether or not the 
planning engine should firm those 
requisitions that are within the 
planning time fence. The valid 
values are:

- Yes/Null: Firms requisitions that 
are within the time fence.

- No: The planning engine does not 
reschedule the non-firm purchase 
requisitions that have dock dates 
within the time tence. The planning
engine reschedules and cancels 
recommendations within the time 
fence.

The planning engine uses the start 
date of the receiving organization 
as the reference for internal 
requisitions.

This profile option also applies to 
unconstrained plans.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Firm 
Requisitions Within
Time Fence

Yes/No No Use this profile option to tell the 
planning engine whether to 
consider internal requisitions at the 
receiving organization as firm. The 
requisitions that this profile option 
relates to are ones that have Start 
Date before or on Planning Time 
Fence Date.

Valid values are:

- Yes: It treats them as firm.

- No: It can recommend 
rescheduled and cancel.

MSO: Firm Supply 
Allocation Window 
(Backward days)

Integers >=0 1 The allocation of firm supplies to 
demands is based on demand 
priorities within the Firm Supply 
Allocation window. Set this 
window using system level profile 
options. This window is derived 
dynamically for each demand; it 
starts with the demand due date 
and goes backwards to the window
size.

This is stated as the number of 
calendar days including 
non-workdays.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Firm Supply 
Allocation Window 
(Forward days)

Integers >=0 Null The allocation of firm supplies to 
demands is based on demand 
priorities within the Firm Supply 
Allocation window. Set this 
window using system level profile 
options. This window is derived 
dynamically for each demand; it 
starts with the demand due date 
and moves forwards to the window
size. This pegs demands to firm 
supplies that are scheduled after 
the demand date. After searching 
backward, it searches forward by 
the number of days set by this 
profile option, pegging the supply 
with the nearest (earliest) schedule 
to the unallocated demand 
quantity. This can cause supplies to
be late for the demand due date.

This is stated as the number of 
calendar days including 
non-workdays.

To use this feature, set profile 
option MSO: Net All Firm Supplies 
Before Creating Planned Orders to 
Yes.

MSO: Firm Work 
Orders/ Operations 
Within Time Fence

Yes / No No Used for both constrained and 
unconstrained plans. When set to 
Yes, all operations of an order with 
start dates in the Planning Time 
Fence are treated as firm. Any 
operation with a start date outside 
of the Planning Time Fence is not 
considered firm and can be moved. 
When set to No, operations with 
start dates in the Planning Time 
Fence can be rescheduled out. 
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Profile Option 
Name

Valid Values Default Value Description

MSO: Floating 
Point Precision

Number > 0 100 Internal multiplier for order 
quantities. Can change the value 
depending on precision desired. 
Verify that the product of the 
floating point precision and the 
number does not exceed the 
maximum integer size handled by 
the machine.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.

MSO: Floating 
Point Precision for 
Planning Bucket 
Efficiency

Not applicable Not applicable This has been changed to MSO: 
HLS Granularity Precision.

MSO: Floating 
Point Precision for 
Transportation 
Capacities 
(Volume)

Number > 0 100 Internal multiplier for 
transportation lane capacities by 
volume, by day. Can change the 
value depending on precision 
desired. Verify that the product of 
the floating point precision and the 
number does not exceed the 
maximum integer size handled by 
the machine. See Floating Point 
Precision, page A-2 for more 
information.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Floating 
Point Precision for 
Transportation 
Capacities (Weight)

Number > 0 100 Internal multiplier for 
transportation lane capacities by 
weight, by day. Can change the 
value depending on precision 
desired. Verify that the product of 
the floating point precision and the 
number does not exceed the 
maximum integer size handled by 
the machine. See Floating Point 
Precision, page A-2 for more 
information.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.

MSO: Floating 
Point Precision for 
Usage in Routings

Number > 0 100 Internal multiplier for order 
quantities. Can change the value 
depending on precision desired. 
Verify that the product of the 
floating point precision and the 
number does not exceed the 
maximum integer size handled by 
the machine. See Floating Point 
Precision, page A-2 for more 
information.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option
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Profile Option 
Name

Valid Values Default Value Description

MSO: Generate 
Compression Days 
Exception

Yes/No Yes Use this profile option to control 
issuance of exception message 
Orders with compression days. 
Valid values:

- Yes: Issue the exception message

- No: Do not issue the exception 
message

The planning engine issues 
exception message Orders with 
insufficient lead-time when it 
schedules orders for less time than 
their assembly's lead-time. If the 
reason for that scheduling is that 
the planning engine would 
schedule the order in the past, it 
also issues exception message 
Orders with compression days.

To avoid seeing both these 
exceptions for the same order, 
select No for this profile option.

MSO: Generate 
Compression/Firmi
ng Exceptions for 
Orders in Progress

Yes/No Yes When set to No, the planning 
engine does not issue the following 
exception messages for firm orders 
whose start date is in the past (after
applying the lead time offset to the 
due date). The planning engine 
assumes that these orders are in 
progress and on time:

• Order with Insufficient Lead 
Time 

• Order is Firmed Early
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Profile Option 
Name

Valid Values Default Value Description

MSO: Generate 
Shared Supply 
Exceptions

Yes/No No The planning engine schedules 
demands in slices; each slice 
contains a set of demands in a time 
period. Sometimes, a supply is 
pegged to two demands (shared 
supply) that are each in different 
slices.

If these two slices are separated by 
more slices than the value of profile
option MSO: Additional Demand 
Slices for Shared Supply 
Rescheduling, the planning engine 
does not reschedule the shared 
supply in the earlier slice when it 
schedules the demand in the later 
slice. It is possible that the demand 
in the later slice is satisfied late 
because the planning engine did 
not reschedule in (earlier date) the 
supply in the earlier slice. 

If this profile option is Yes, the 
planning engine issues a Shared 
Supply Scheduled Late exception 
message when this occurs. If this 
profile option is No, the planning 
engine does not generate the 
exception message.

This is a user level profile option.

MSO: Global 
Batchable Flag

Yes/No No This profile option enables resource
batching functionality for order 
scheduling. Valid values are Yes 
(enable resource batching) and.No 
(do not enable resource batching).

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Global 
Chargeable Flag

Yes/No No This profile option controls 
whether Oracle Advanced Supply 
Chain Planning schedules resource 
charges. If Yes, the planning engine
schedules charges for chargeable 
resources. If No, chargeable 
resources are considered as item 
basis an no individual charges are 
scheduled. Material flows and 
resource loads are not influenced 
by charge quantities.

MSO: Global Time 
Limit

Number > 0 See Automatic 
Calculations, 
page A-1.

Parameter used to set global time 
limit for halting optimization. 

MSO: Hard link 
scheduling window

Integer 30 This profile option specifies the 
time window within which ASCP 
tries to schedule a set of operations 
linked together through hard links. 
If scheduling is unsuccessful, 
overloads are created.

This is a hidden profile option used
by development. This defines the 
scheduling window within which 
the system schedules the 
hard-linked operation set. 
Increasing the window gives room 
to schedule operations with hard 
links without overloading. Based 
on the number of operations per 
hard linked operation set, 
increasing this value can have a 
performance impact.

MSO: Hard link 
scheduling window
expansion factor

Integer 10 This hidden profile option used by 
development is used to limit the 
propagation for the hard linked 
operation set. Normally, we limit 
the propagation by a factor of (This 
profile option value * Minimum 
duration of hard linked operation 
set).
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Profile Option 
Name

Valid Values Default Value Description

MSO: Heuristic 
type

Look Ahead Look Ahead Determines which heuristic to use.

The look-ahead heuristic reserves 
time for lower priorities so the 
schedule begins with the tasks of 
higher priorities.

This is a site level profile option.

MSO: HLS flat files 
path

Text Null Specifies the directory to store the 
Planning Engine debugging data 
files.

MSO: Improved 
Lead Time 
Offsetting in 
Aggregated Buckets

- - Reserved for future use.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.

MSO: Include Past 
Due in Safety Stock

Yes/No Yes Use this profile option to instruct 
the planning engine whether to 
include past due demand in the 
safety stock calculation. Valid 
values are:

• Yes: Include it.

• No: Do not include it. If you 
have a lot of past due demand, 
use this value to avoid 
overstatement of typical safety 
stock level.

MSO: Internal 
Demand 
Aggregation Within
Optimization

Yes/No Null (interpreted
as No)

This profile specifies how the 
optimization engine should 
prioritize independent demands. 
Valid values are:

- Yes: Prioritize by date. This value 
improves optimization engine 
performance.

- No: Prioritize by demand priority
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Profile Option 
Name

Valid Values Default Value Description

MSO: Inventory 
Carrying Costs 
Percentage

A percentage 
between 0 and
100

Null Specifies inventory carrying costs 
percentage for all items in the plan. 
Can be defined at the site level. You
can update this value. The 
inventory carrying cost is a percent 
(if the user enters 10, the value is 
10%). 

MSO: Late 
Demands 
Exceptions 
Tolerance Minutes

Integer > 0 0 This profile option is used by 
constrained plans. Sets the value in 
minutes for a window during 
which the planning engine does not
issue exception messages for late 
demands. Use it particularly in 
cases where demands are only a 
few minutes or a few hours late.

The value that you enter is used 
based on a 24 hour, 7 day per week 
calendar. For example, enter 1440 
minutes (24 hours) for this profile 
option. A demand due at 15:00 on 
Tuesday does not cause late 
demand exception or diagnosis 
information as long as the supplies 
are complete by l5:00 on 
Wednesday.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Lead Time 
Control

Violate 
Minimum 
Processing 
Times to Meet 
Demand Due 
Date and Do 
Not Violate 
Minimum 
Processing 
Times

Violate 
Minimum 
Processing Times
to Meet Demand 
Due Date

This profile option is applicable to 
constrained plans. Valid values are:

- Violate Minimum Processing 
Times to Meet Demand Due Date: 
The planning engine meets the 
demand due date even if it 
compresses operations and 
supplies beyond their minimum 
durations (from item lead-times 
and routing usages).

- Do Not Violate Minimum 
Processing Times: The planning 
engine respects the minimum 
durations of operations and 
supplies (from item lead-times and 
routing usages) even if it satisfies 
demands late.

This is a user level profile option.

MSO: List Size for 
Pricing Candidates

Integer > 0 See Automatic 
Calculations, 
page A-1.

Parameter to set the list size for 
pricing candidates.

MSO: LP Constraint
Batch Size

- - Not used.

MSO: LP 
Markowitz 
Coefficient

Number 
between 
0.0001 and 
0.99999

See Automatic 
Calculations, 
page A-1.

Sets the Markowitz Coefficient. 

MSO: LP 
Optimization 
Algorithm

0: Primal 
simplex, 1: 
Dual simplex, 
2: Hybrid 
barrier primal,
3: Hybrid 
barrier dual

0 Determines which optimization 
algorithm is used. Can be defined 
at the site level. See Automatic 
Calculations, page A-1 for more 
information on the default value for
this profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Maximize 
Search of 
Availability 
Intervals

Yes / No Yes Enhances the capability of the 
scheduling engine to accurately 
identify pockets of available time 
where resource activities can be 
feasibly scheduled. Valid values 
are:

- Yes: Maintains a detailed picture 
of the Resource Profile while 
scheduling. Resource Profile refers 
to the time varying picture of 
requirements and availability. The 
maintenance of this detailed picture
causes the planning engine to miss 
fewer valid slots for scheduling 
activities than otherwise.

- No: Detailed Resource Profile is 
not maintained.

If you need to change the default 
value of this profile in your 
installation, it is recommended that 
you consult with Oracle 
Development before doing so.

You can set this option if you 
receive the Requirement causes 
resource overload exceptions in the 
Planner Workbench in Enforce 
Capacity Constraints Plans. For 
more details, see Exception 
Messages, page 17-1.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Maximum 
Activity Duration

Number > 0 See Automatic 
Calculations, 
page A-1.

Defines the Planning Engine 
maximum activity duration in days.
All requirements should be less in 
duration than this. If null, the 
planning horizon duration is used. 

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.

MSO: Maximum 
Allowable Days 
Late

Integer > 0 300 Limits the number of days by 
which a demand or unfirmed 
scheduled receipt can be moved out
when optimization is turned on. 
This value is used only to improve 
performance and reduce the size of 
the plan for the optimization 
component of the Planning Engine. 
Scheduling moves demands and 
unfirmed scheduled receipts out as 
long as necessary. Can be defined 
at the site level.

Note: Set this to a number as large 
as the typical planning horizon to 
avoid unusual results.

MSO: Maximum 
Allowable Days 
Late before Forecast
Expiration

Integer > 0 Null Oracle Advanced Supply Chain 
Planning uses this profile option 
when planning supplies for forecast
scenarios from Oracle Demand 
Planning, master demand schedule 
forecasts, and manual master 
demand schedule entries. When a 
forecast or master demand 
schedule entry cannot be 
completely satisfied within the 
allowable days late, the planning 
engine does not plan supplies for 
the quantity that is late by this 
many days.

The profile option does not apply to
sales orders.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Maximum 
Demands per 
Group

Integer > 0, 
smaller than 
the size of a 
slice

5 Determines the maximum number 
of demands that can be grouped 
together for scheduling. Within a 
group, the default heuristic can try 
different orders among the 
demands. Can be defined at the site
level.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.

MSO: Maximum 
Demands per 
Group for 
Advanced 
Sequencing

Any number 1 The profile option specifies the 
number of demands that are 
grouped together for scheduling. 
the larger this number, the greater 
the chances of obtaining good 
sequences on the resources. Making
this number too large might result 
in demand priorities not being fully
respected while scheduling.

MSO: Maximum 
Demands per Slice

Integer >= 0 100 Determines the number of 
demands in a slice. Enables the 
Scheduling Engine to resolve 
interactions of demands within a 
slice. Supplies shared between 
demands are scheduled better 
when the demands are in the same 
slice. However, slices that are too 
large slow down the Scheduling 
Engine use more memory. Can be 
defined at the site level.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Maximum 
Inventory Level % 
of Safety Stock

Between 0 and
100%

- Use this option to specify 
maximum inventory levels. If no 
other method of calculation is 
defined for an item-organization 
maximum inventory level, the 
levels are based on the specified 
percentage of the safety stock level.

MSO: Maximum 
Number of 
Prepones

Number > 0 10 Scalability factor for the Scheduling
Engine. The Scheduling Engine 
attempts to schedule the operations
in different orders to find a 
solution. Limits the number of 
times the Scheduling Engine 
attempts to schedule an operation. 
If there are many components for 
some items or many small supplies 
answering a demand, the number 
of orders is larger; reduce this 
parameter. Can be defined at the 
site level. See Automatic 
Calculations, page A-1 for more 
information.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.

MSO: Maximum 
Number of Pull for 
Operation

Integer > 0 8 When an operation cannot be 
scheduled on a certain day, the 
scheduling engine attempts to 
schedule it on an earlier date (for 
backward scheduling). This profile 
option controls how many days are 
tried in this manner. Many days 
result in lower performance. Can be
defined at the site level. See 
Automatic Calculations, page A-1 
for more information.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Maximum 
number of 
pulls/push for hard 
linked operations

-- -- This hidden profile option is not 
used.

MSO: Maximum 
Number of Pushes 
for Operation

-1 or Integer > 
0

-1 When you are running constrained 
plans with the Enforce Capacity 
Constraints plan option checked, 
this profile option controls the 
number of attempts made to 
schedule a resource activity 
feasibly. Valid values are:

-1: Continues the search for 
available capacity till the end of the 
planning horizon. 

Integer > 0: The number that you 
specify here determines the number
of attempts that the planning 
engine makes to schedule the 
activity. For example, if you set the 
profile option to 5, the planning 
engine makes 5 attempts to 
schedule the activity feasibly, and 
after that schedules the activity 
with an overload. The spot chosen 
to schedule the activity with 
overload is the initial spot that was 
tried.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Maximum 
Operations Per Slice

Integer > 0 3000 operations Determines the number of 
operations which can be scheduled 
in a slice. Limits the problem size in
a slice and can be a limiting factor 
in determining the number of 
demands that can be scheduled in a
slice.

Oracle recommends that you use a 
large value such as the default 
value.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.

MSO: Maximum 
Resource 
Over-capacity

Number > 0 5 Assigns resource slacks when it 
does not find the resource available
and it is forced to use slacks. The 
Scheduling Engine initiate the 
resource slack from 0 to maximum 
assigned units and will jump to this
number if no solution is possible. 
This limits the number of tries to 
assign the resource slack. Can be 
defined at the site level. See 
Automatic Calculations, page A-1 
for more information.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.

MSO: Maximum 
Simplex Iterations

Integer > 0 See Automatic 
Calculations, 
page A-1.

Parameter to set the maximum 
number of simplex iterations. 
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Profile Option 
Name

Valid Values Default Value Description

MSO: Minimize 
Supply Duration

Yes/No No Use this profile option to specify 
whether the planning engine 
should left-justify operations and 
post processing time..

The planning engine plans them to 
occur as close to the demand date 
as possible. They may have gaps 
between them because of resource 
constraints.

When the planning engine 
left-justifies them, it moves them 
earlier in time. It makes the start 
dates of the later ones the same as 
the end dates of the previous ones.

For example, the planning engine 
plans the operations for a supply 
that pegs to a demand date of day 
12. It plans:

- Operation 30 from days 10 to 12

- No operations for days 8 to 10

- Operation 20 from days 6 - 8

If you tell the planning engine to 
left-justify, it moves operation 30 
from days 10 - 12 to days 8 - 10.

Valid values are:

- Yes: Left justify

- No: Do not left justify
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Profile Option 
Name

Valid Values Default Value Description

MSO: Multiplier To 
Derive Supply 
Allocation Window

Number >= 0 Null You can set the Firm Supply 
Allocation window using the 
profile option MSC: Firm Supply 
Allocation Window or you can use 
the manufacturing lead-time and 
this profile option. If you specify 
any value for this profile option, the
information you enter for MSC: 
Firm Supply Allocation Window is 
ignored. If the product of this 
multiplier and cumulative 
manufacturing lead-time is a 
fractional quantity, the number is 
rounded up to the next integer. 



Profile Options    A-127

Profile Option 
Name

Valid Values Default Value Description

MSO: Net All Firm 
Supplies Before 
Creating Planned 
Order

No, 

All Supply 
Types,

Only for Work
Orders,

Only for 
Purchase and 
Transfer 
Supplies, 

All Supply 
Types 
Including 
By-product 
Supplies

No Nets all firmed supply available in 
any future period before creating 
new planned orders. The profile 
option treats firmed planned orders
the same as real supplies.

The values are:

- No: Does not net firm supplies 
before creating planned orders.

- All Supply Types: Net all firm 
supplies before creating planned 
orders. This includes work orders, 
purchase orders, transfer supplies 
and firm planned orders for these 
supplies. 

- Only for Work Orders: Net only 
firm discrete jobs before creating 
planned orders.

- Only for Purchase and Transfer 
Supplies: Net all firm purchased 
and transfer supplies before 
creating planned orders.

- All Supply Types Including 
by-product/co-product supplies: 
Nets all firm supplies (including 
by-product and co-product 
supplies) before creating planned 
orders. The planning engine does 
not reschedule by-product and 
co-product supplies, they follow 
the scheduling of the supply that 
generates them. This choice allows 
these supplies to be netted for 
earlier demands. This may cause 
late demands, but may reduce 
overall inventory.

MSO: Network 
routing cycle time 
coefficient

Not used Not used Not used
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Profile Option 
Name

Valid Values Default Value Description

MSO: Network 
routing fixed time 
window

Not used Not used Not used

MSO: Nfl Backward
Compression Pct

Not used Not used Not used

MSO: Nfl Forward 
Compression Pct

Not used Not used Not used

MSO: Number of 
Decomposition 
Groups in 
Optimization 

Integer > 0 NULL Before you change this, contact 
Oracle Support for a development 
recommendation.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Number of 
Demand Groups for
Optimization

Integer > 0 50 You can use this profile option only
for constrained plans that have 
decision rules enabled. In the case 
of cost-based optimization, the 
planning engine considers the 
demand lateness penalty cost 
instead of demand priorities.

Use this profile option to instruct 
the planning engine how to group 
demand into demand groups by 
priority ranges. For example, the 
demand priority values are from 1 
to 100 and you set this profile 
option to 5. The planning engine 
assigns demands to five demand 
groups. Each group includes a 
range of 20 priorities - 1 to 20, 21 to 
40, 41 to 60, 61 to 80, 81 to 100.

The planning engine searches for 
supplies that satisfy all demands 
having priorities in the same range. 
It satisfies demands in the higher 
priority range first. For multiple 
demands in the same priority 
range, the planning engine satisfies 
demands based on individual 
demand priorities.

Note that too many groups may 
affect performance.

MSO: Number of 
Threads for 
Optimization

Integer > 0 Null This profile option applies to 64-bit 
platforms only. Values greater than 
1 invoke running optimized plans 
in a multi-threaded mode. This 
enables various optimization 
problems to be solved in parallel so 
that run time may be reduced. 
However, multi-threading 
increases the CPU usage and 
memory consumption. You can 
control the load on CPU by 
specifying the number of threads 
that you want to run in parallel.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Optimization 
Advanced Start

0 and 1 Null (internally 
defaulted as a 
value of 1)

This profile option controls 
whether the planning engine 
should be set to use advanced start 
(profile option value 1). This means
that the optimization engine uses 
certain values from a previous run 
of the plan; it sees improved 
performance by reusing certain 
computations.

This is an optimization engine 
profile option and should not be 
changed under ordinary 
circumstances.

MSO: Optimization 
Daily Aggregation 
Buckets

Integer > 0 Null Specifies the Daily Aggregation 
Time Bucket to be used by the 
Planning Engine if the profile 
option MSO: Use Optimization 
Internal Time Aggregation is set to 
True.

MSO: Optimization 
Weekly 
Aggregation 
Buckets

Integer > 0 Null Specifies the Weekly Aggregation 
Time Bucket to be used by the 
Planning Engine if the profile 
option MSO: Use Optimization 
Internal Time Aggregation is set to 
True.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Order 
Modifier Maximum
Searching Depth

Integer 3 Use this profile option to specify 
the maximum number of lower 
levels in the supply chain that the 
planning engine searches for 
alternate sources, bills of material, 
components, and resources to 
resolve a shortage. The shortages 
often occur when the planning 
engine rounds down planed orders 
with respect to capacity constraints 
and order modifiers.

The planning engine searches this 
many levels down both in:

- The organization with the 
shortage

- Organizations that supply the 
short organization with the short 
item

Oracle suggests that:

The solution quality improves with 
higher numbers while the 
processing time worsens with 
higher numbers.

For each integer increase in the 
profile option, processing time 
worsens at a much higher rate than 
solution quality improves.

You consider the tradeoffs and tend
towards lover rather than higher 
numbers.

MSO: Overlap 
Activities by MTQ 

Yes/No No Use profile option MSO: Overlap 
Activities by MTQ to control 
overlapping activities inside one 
operation. Valid values are:

- Yes: Allow overlapping activities 
inside one operation.

- No: Prevent overlapping activities
inside one operation.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Peg 
By-product 
Supplies

Yes/No Yes Yes: Pegging is considered when 
scheduling operations with 
by-product supply. Scheduling of 
these operations respects demand 
for the by-product and demand for 
the main product. After scheduling 
these operations, the by-product 
supply date is updated to reflect 
the operation scheduled date. 

No: By-Product Supplies are not 
pegged to demands For 
constraint-based plans. Set this 
profile option to No with items that
are components on the supply 
chain bill of materials and that are 
by-product on a different level of 
the same supply chain bill of 
materials. Selecting No prevents the
planning engine from continuous 
looping between the component 
demand and the by-product 
supply.

MSO: Penalty Basis 
for Changeovers

Changeover 
Time

Changeover 
Penalty

Indicates whether the changeover 
time of the changeover penalty is to
be used as the criterion for 
calculation the ideal sequence.

If Changeover Time, ASCP uses the
relative changeover times between 
setup types as the criteria for 
deciding on the ideal sequence of 
setup types.

If Changeover Penalty, ASCP uses 
the relative changeover penalties 
between setup types as the criteria 
for deciding on the ideal sequence 
of setup types.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Penalty Cost 
Factor for 
Exceeding Item 
Material Capacity 
Flexfield Attribute

Integer >= 0 Null Stores the flexfield column name 
that contains the value in the 
corresponding table. Setup 
performed only during application 
install. See Flexfield Attributes, 
page A-1 for more information.

MSO: Penalty Cost 
Factor for 
Exceeding Material 
Capacity

Number >= 0 Null Defines a penalty cost factor for 
exceeding material capacity.

MSO: Penalty Cost 
Factor for 
Exceeding Material 
Capacity Flexfield 
Attribute

Number Automatically 
generated to 
denote flexfield 
segment holding 
the penalty factor

This profile option stores the item 
flexfield segment that holds the 
penalty cost factor for exceeding 
material capacity. The collections 
process Create Planning Flexfield 
concurrent program captures the 
segment when it first runs during 
installation.

MSO: Penalty Cost 
Factor for 
Exceeding Org 
Material Capacity 
Flexfield Attribute

Integer >= 0 Null Stores the flexfield column name 
that contains the value in the 
corresponding table. Setup 
performed only during application 
install. See Flexfield Attributes, 
page A-1 for more information.

MSO: Penalty Cost 
Factor for 
Exceeding Org 
Resource Capacity 
Flexfield Attribute

Integer >= 0 Null Stores the flexfield column name 
that contains the value in the 
corresponding table. Setup 
performed only during application 
install. See Flexfield Attributes, 
page A-1 for more information.

MSO: Penalty Cost 
Factor for 
Exceeding Org 
Transportation 
Capacity Flexfield 
Attribute

Integer >= 0 Null Stores the flexfield column name 
that contains the value in the 
corresponding table. Setup 
performed only during application 
install. See Flexfield Attributes, 
page A-1 for more information.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Penalty Cost 
Factor for 
Exceeding Resource
Capacity

0 and 1 Null (internally 
defaulted as a 
value of 1)

Denotes a factor for plan profit 
computations that is invoked only 
when the plan profit parameter for 
optimization has a value greater 
than 0. The penalty cost factor is 
multiplied by the resource cost to 
give the cost of overloading a 
particular resource. 

MSO: Penalty Cost 
Factor for 
Exceeding Resource
Capacity Flexfield 
Attribute

Integer >= 0 Null Stores the flexfield column name 
that contains the value in the 
corresponding table. Setup 
performed only during application 
install. See Flexfield Attributes, 
page A-1 for more information.

MSO: Penalty Cost 
Factor for 
Exceeding 
Transportation 
Capacity Flexfield 
Attribute

Integer >= 0 Null Stores the flexfield column name 
that contains the value in the 
corresponding table. Setup 
performed only during application 
install. See Flexfield Attributes, 
page A-1 for more information.

MSO: Penalty Cost 
Factor for Late 
Demands

Number > 0 None Defines a penalty cost factor 
common to all demands. The 
demands include sales orders, 
forecasts and safety stock. Can be 
defined at the site level.

MSO: Penalty Cost 
Factor for Late 
Forecasts Flexfield 
Attribute

Integer >= 0 Null Stores the flexfield column name 
that contains the value in the 
corresponding table. Setup 
performed only during application 
install. See Flexfield Attributes, 
page A-1 for more information.

MSO: Penalty Cost 
Factor for Late Item 
Demands Flexfield 
Attribute

Integer >= 0 Null Stores the flexfield column name 
that contains the value in the 
corresponding table. Setup 
performed only during application 
install. See Flexfield Attributes, 
page A-1 for more information.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Penalty Cost 
Factor for Late Org 
Demands Flexfield 
Attribute

Integer >= 0 Null Stores the flexfield column name 
that contains the value in the 
corresponding table. Setup 
performed only during application 
install. See Flexfield Attributes, 
page A-1 for more information.

MSO: Penalty Cost 
Factor for Late Sales
Orders Flexfield 
Attribute

Integer >= 0 Null Stores the flexfield column name 
that contains the value in the 
corresponding table. Setup 
performed only during application 
install. See Flexfield Attributes, 
page A-1 for more information.

MSO: Penalty 
Multiplier Outside 
Unconstrained 
Window

This profile option specifies an 
extra lateness penalty when 
scheduling later than the 
unconstrained latest possible 
completion time for a given 
activity.

MSO: Postpone Use
of Alternates to 
Latest Possible 
Time

Yes/No No Use this profile option to specify 
when the planning engine should 
plan alternate supplies. Valid 
values are

- Yes: Postpone planning them until
the last possible moment

- No: Plan them when you need to 
do so to create the best plan for the 
item

MSO: Preprocessing
Aggregator Fill

Integer > 0 See Automatic 
Calculations, 
page A-1.

Preprocessor aggregator fill. 

MSO: Preprocessing
Aggregator Limit

Integer > 0 See Automatic 
Calculations, 
page A-1.

Parameter to control preprocessing 
aggregator limit. 
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Profile Option 
Name

Valid Values Default Value Description

MSO: Preprocessing
Flag for LP Matrix

0,1 & 2 See Automatic 
Calculations, 
page A-1.

Use his profile option to control the
LPs where the planning engine 
triggers the pre-solve step. The 
pre-solve step helps identify 
redundant constraints and 
variables, so it helps reduce overall 
solve time. Enabling pre-solve 
solves some problems faster than 
solving from basis. The valid values
are: 

- 0: Turn off pre-solve for all LPs

- 1: Turn on pre-solve for some LPs

- 2: Turn on pre-solve for all LPs 
and turn off advanced start for all 
LPs

MSO: Preprocessor 
LP Compression

- - Not used.

MSO: Primal 
Simplex Parameter

-1, 0, 1, 2, 3, 
and 4

See Automatic 
Calculations, 
page A-1.

Gradient parameter for primal 
simplex algorithm. 

MSO: Primal/Dual 
Preprocessing 
Reduction

0, 1, 2, and 3 See Automatic 
Calculations, 
page A-1.

Used by optimization. 

MSO: Pull push 
base

Positive 
Integers

1 Each time the planning engine 
needs to search for a new spot to 
schedule it looks ahead by a certain 
time period that is dictated by the 
settings of the profile options MSO: 
Push Pull Base and MSO: Push Pull
Offset.

For more details, see Requirement 
causes resource overload exception,
page 17-29.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Pull push 
offset

Positive 
integer in 
mnutes

1440 Each time the planning engine 
needs to search for a new spot to 
schedule it looks ahead by a certain 
time period that is dictated by the 
settings of the profile options MSO: 
Push Pull Base and MSO: Push Pull
Offset.

For more details, seeRequirement 
causes resource overload exception,
page 17-29 .

MSO: Queue Time 
Factor

Number >= 0 None Increases item lead-time in 
optimization, so that lead-time 
values are close to those used in the
Scheduling Engine. Optimization 
lead-time is padded to include 
queue time.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Reschedule 
Jobs Out to Reduce 
Inventory Carrying 
Costs

Yes/No Yes This profile option involves right 
justifying standard and lot-based 
discrete jobs when rescheduling 
them out to line up with other 
supplies for the job. When there is a
constraint, the planning engine 
always moves the jobs based on the
constraint. When there are no 
constraints, you have the option to 
instruct the planning engine to 
right justify the jobs:

- Yes: The planning engine attempts
to schedule the job as late as 
possible for one or more demands.

- No: The planning engine does not 
reschedule or right justify the job 
beyond its old due date. If there is 
existing capacity earlier than the 
old due date of the job, the 
planning engine may recommend a
reschedule in. 

This profile option does not apply 
to other order types, for example, 
purchase orders and purchase 
requisitions.

MSO: Reschedule 
Shared Supply to 
Influence Batching

Yes/No No Determines whether the Planning 
Engine schedules shared supplies 
early to avoid item-based resource 
constraints prior to batch resources.
Valid values are Yes (considers 
whether scheduling shared 
supplies early will allow 
subsequent resource batching; this 
value improves the scheduled 
utilization of batch resources by 
considering earlier constraints) and 
No (schedules resource batching 
when supplies are available).
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Profile Option 
Name

Valid Values Default Value Description

MSO: Resource 
Adjustment Factor 
For Improved 
Offloading to 
Alternates

A number 
between and 
including 0 
and 1

Null (internally 
defaulted as a 
value of 1)

The factor that the planning engine 
uses to reduce the resource 
availability when making the 
sourcing decision. For example, if 
the factor is set to 0.8, the resource 
availability is reduced by 20% and 
the planning engine uses more of 
the alternate processes. Then, at the
time of scheduling, planning has 
more flexibility.

MSO: Resource 
Batching Strategy

Nearest Date/ 
Level 
Utilization

Nearest Date Selects order scheduling strategy 
used in resource batching. Valid 
values are Nearest Date (schedules 
orders to load resources nearest the 
due date of the order) and Level 
Utilization (schedules orders to 
level utilization of the resource).

MSO: Setup Pattern
Calculation 
Window (multiplier
of Resource 
Sequencing 
window

any number 1 A window is calculated by 
multiplying the Resource's 
Sequencing window value by the 
value in this profile.

The relative mix of various setup 
types that fall into this window is 
calculated and then applied to each 
resource sequencing window. 
When MSO: Use Sequencing 
Template is set to Yes, ASCP uses 
this calculated mix of setup types to
determine the desired spots.

MSO: Resource 
Group for the Line 
Flexfield Attribute

Integer >= 0 Null Stores the name of the flexfield 
column that contains the value in 
the corresponding table. This setup 
is only performed during 
application install. See Flexfield 
Attributes, page A-1 for more 
information.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Schedule 
Across Breaks

Yes/No Yes (can 
schedule across 
break)

Determines whether the scheduling
engine starts an activity before a 
break and ends it after the break. If 
set to No, verify that every activity 
has enough resource in one shift 
(otherwise the activities are moved 
to the end of the horizon). Can be 
defined at the site level.

MSO: Schedule PO 
in FIFO 

Yes n/a n/a

MSO: Schedule 
Simultaneous 
Resources Across 
Breaks

Yes/No Yes (can 
schedule across 
break)

This profile option behaves the 
same as profile option MSO: 
Schedule Across Breaks. However, 
it only applies to simultaneous 
resources.

MSO: schedule 
window width

Integers >=0 8 days Defines time window (days) that 
the scheduling engine looks for its 
primary resource. If the primary 
resource is not in this window, the 
scheduling engine moves to an 
alternate resource. Can be defined 
at the site level.

MSO: Scheduler 
Time Step

- - Reserved for future use.

MSO: SCO Dual 
Variables Tolerance

Numeric 0.000000001 Parameter used internally for 
optimization. Consult Oracle 
Development and Oracle Support 
before modifying this profile 
option.

MSO: SCO Reduced
Cost Tolerance

Numeric 0.000000001 Parameter used internally for 
optimization. Consult Oracle 
Development and Oracle Support 
before modifying this profile 
option.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Simplex 
Feasibility 
Tolerance

A number 
between e-9 
and e-4

See Automatic 
Calculations, 
page A-1.

Parameter to set the simplex 
feasibility tolerance. 

MSO: Simplex 
Optimality 
Tolerance

A number 
between e-9 
and e-4

See Automatic 
Calculations, 
page A-1.

Parameter to set the optimality 
tolerance for the simplex algorithm.

MSO: Simplex 
Perturbation 
Constant

A number 
greater than 
e-8

See Automatic 
Calculations, 
page A-1.

Parameter to set the simplex 
perturbation constant. 

MSO: Simplex 
Perturbation Limit

Integer > 0 See Automatic 
Calculations, 
page A-1.

Parameter for the simplex 
perturbation limit. 

MSO: Simplex 
Perturbation 
Parameter

0 and 1 See Automatic 
Calculations, 
page A-1.

Provides a perturbation constant 
for the Planning Engine. Sets the 
amount by which the Planning 
Engine perturbs the upper and 
lower bounds on the variables 
when a problem is perturbed.

Before you change this, contact 
Oracle Support for a development 
recommendation.

MSO: Simplex 
Presolve Limit

-1, 0, and 
integer > 0 

See Automatic 
Calculations, 
page A-1.

Parameter to set the limit on the 
number of pre-solves. 

MSO: Simplex 
Singularity Repair 
Limit

Integer > 0 See Automatic 
Calculations, 
page A-1.

Parameter to set the simplex 
singularity repair limit. 

MSO: Simultaneous
Resource Overlap 
Mode

- - Not used.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Slack Hours 
for Batch Resource

Integer Null This profile value is used by Oracle 
Advanced Supply Chain Planning 
to right justify the maximum end 
date for a scheduled batch resource.

The value specified is the amount 
of slack time (in hours) to delay 
scheduling the resource so that 
other supplies can be included in 
the same batch even though they 
cannot be scheduled as early as the 
original supply. This means that the
batch must wait for the constrained 
supply.

MSO: Solve Dual 
Problem

0 and 1 See Automatic 
Calculations, 
page A-1.

Controls whether the Planning 
Engine solves the dual problem or 
the primal problem. 

MSO: Sourcing 
Allocation Window

integer >= 1 7 Specifies the Allocation Percentages
Satisfaction Period. The constraints 
are enforced in a rolling horizon 
manner. Used with Enforce 
Sourcing Constraints enabled in 
specific plan options.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Split Planned 
Orders for 
Assigned Units

Yes / No Yes This profile option is used by 
Oracle Advanced Supply Chain 
Planning optimized plans only. It 
specifies if the planning engine 
should attempt to split planned 
orders such that they can be 
scheduled within a specific day.

The valid values are:

- Yes: Create more planned orders 
with quantities that can be 
scheduled by the resource units 
available within a given day.

- No: The planning engine 
generates larger planned orders 
that may require a resource 
duration spanning several days.

Note that the maximum number of 
resource units at the routing level 
will always be respected.

MSO: Spread 
Resource 
Consumption 
Within 
Optimization

Yes/No Null (interpreted
as No)

This profile specifies how the 
optimization engine should model 
resource consumption is modeled 
in optimization. Valid values are:

- Yes: Consume resources at the 
first operation. This value provides 
improved optimization engine 
performance.

- No: Consume resources at the 
operation to which they belong. 
This value provides improved 
optimization engine accuracy.

MSO: Substitute 
Item Penalty

Number > 0 None Defines an internal penalty weight 
for substitute item objective in 
supply chain optimization.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Supply 
Reschedule 
Window Size for 
Safety Stock 
Pegging

Integer > 0 Null This profile options provides an 
estimate of the number of days by 
which the supply and its associated
demand (dependent demand) 
moves due to constraints. You can 
use this profile option to specify the
number of days a specific supply 
can satisfy safety stock demand. 

MSO: Supply 
Window Size

Integer >= 0 Null During priority pegging, supplies 
are sorted based on supply type, 
then smallest quantity, then by 
schedule date. The highest priority 
demands from the first demand 
window will peg to the sorted 
supplies in the first window if 
possible. When the supplies from 
one window are all pegged, the 
demand will peg to the highest 
sorted supply in the next window 
until all demands are pegged. This 
is stated as the number of calendar 
days including non-workdays. Null
is treated as 1 in the Planning 
Engine.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
uses this profile option as value 1 
day.

MSO: Target 
Inventory Level % 
of Safety Stock

Between 0 and
100%

- Use this option to specify target 
inventory levels. If no other method
of calculation is defined for an 
item-organization target inventory 
level, the levels are based on the 
specified percentage of the safety 
stock level.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Transfer 
Quantity Threshold
for Enforcing Hard 
Links

Null, Number 
between and 
including 0 
and 1

0 Use this profile option to instruct 
the planning engine to ignore the 
hard link constraints if a transfer 
quantity is less than or equal to this 
percent threshold of the 
corresponding order quantity. 
Valid values are

- Number between 0 and 1: Ignores 
hard link constraints for transfer 
quantities less than or equal to this 
percent threshold

- Null: Respects all hard link 
constraints regardless of the size of 
the transfer quantities

MSO: Upper Limit 
for Maximum Time 
Offset for Hard 
Links

Integer 
(including 0), 
Null

Null Use this profile option to set an 
upper limit for the maximum time 
offset. If a maximum time offset is 
higher than this number, the 
planning engine uses this number 
instead of what you set. Valid 
values are: 

- Integer (including 0): Use this 
number

- Null: Use 10,000,000
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Profile Option 
Name

Valid Values Default Value Description

MSO: Use Breaks in
Calculation of 
Unconstrained 
Scheduling 
Windows

Yes/No Yes The planning engine calculates an 
unconstrained scheduling window 
for each resource activity and 
supply in a plan. The scheduling 
window is defined by the dates:

- Unconstrained Earliest Possible 
Start Time (UEPST)

- Unconstrained Earliest Possible 
Completion Time (UEPCT)

- Unconstrained Latest Possible 
Start Time (ULPST)

- Unconstrained Latest Possible 
Completion Time (ULPCT).

If this profile option is Yes, the 
planning engine does not set any of
these dates during a break even if 
the calculation places it there.

If this profile option is No, the 
planning engine does set any of 
these dates during a break if the 
calculation places it there.

This is a user level profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Use 
Collections Start 
Time

Yes

No,

Use Input 
Demand Plan 
Start Time or 
Collections 
Start Time,

Use Input 
Demand Plan 
Start Time or 
Plan Start 
Time

Yes Use this profile option to 
coordinate plan start date and 
collections start time. This affects 
how the plan calculates resource 
availability. Valid values are:

- No: Always use plan start time.

- Yes: Use collections start time.

- Use Input Demand Plan Start 
Time or Collections Start Time: If 
there is an input demand plan, the 
planning engine uses the Input 
Demand Plan Start Time. 
Otherwise, it uses the Collections 
Start Time.

- Use Input Demand Plan Start 
Time or Plan Start Time: The 
planning engine uses the Input 
Demand Plan Start Time. 
Otherwise, it uses the Plan Start 
Time.

MSO: Use 
Effectivity Date to 
Infer End Item 
Substitute Priority

Yes/No/Null Null Use this profile option to specify 
the method by which the planning 
engine selects end-item substitute 
items. Valid values are:

- Yes: Use effectivity date from the 
substitute list for the demanded 
item. The substitute item with the 
earliest effectivity date has the 
highest priority in the substitution 
chain.

- No/Null: Use substitution distance
from the demanded item. The 
substitute item with the least 
distance has the highest priority in 
the substitution chain.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Use Existing 
Supplies in 
Alternate 
BOM/Subs.

0, 1, 2, 3 0 Use this profile option to specify 
how the planning engine should 
use supplies of substitute 
components and supplies of 
components in alternate bills of 
material to satisfy demands. Valid 
values are:

- 0: Use supplies of both substitute 
components and supplies of 
components in alternate bills of 
material

- 1: Use supplies of substitute 
components; do not use supplies of 
components in alternate bills of 
material

- 2: Do not use supplies of either 
substitute components or supplies 
of components in alternate bills of 
material

- 3: Use supplies of components in 
alternate bills of material; do not 
use supplies of substitute 
components

MSO: Use Item 
Shelf Life Days in 
Scheduling Buy or 
Make Orders

Yes/No No Use this profile option to instruct 
the planning engine whether to use 
the item shelf life days as a backup 
maximum time offset between the 
operation that produces an item 
and the operation that consumes it. 
Valid values are:

- Yes: If the operation that produces
the item does not have a maximum 
time offset, use item shelf life days 
as the maximum time offset. 

No: Do not use item shelf life days 
as a backup maximum time offset.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Use of 
Assigned Units in 
Scheduling

Variable / 
Fixed at 
Routing Value

Variable Controls the number of resource 
units to be used when scheduling a 
resource activity. Valid values are:

- Variable: Permits a choice ranging
between a minimum of one unit 
and a maximum value equivalent 
to the assigned units specified on 
the routing for the item.

- Fixed at Routing Value: Forces the
scheduling engine to always choose
the number of assigned units 
specified in the routing when 
scheduling a resource activity. It is 
recommended that you choose this 
option when you do not need to 
use the flexibility of the Variable 
option.

Note: The assumption that the 
activity duration is less when 
more units are chosen is only 
valid for the basis type of Item 
specified in the Operation > 
Resources form.

MSO: Use 
Optimization and 
Decision Rules for 
Simulation 

Yes/No No For online planner sessions against 
constrained plans with decision 
rules or optimized plans, select:

• Yes: To rerun the optimization 
and decision rules-based 
decisions during the online 
planner session

• No: To retain the optimization 
and decision rules-based 
decisions from the initial 
planning run for the online 
planner session 
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Profile Option 
Name

Valid Values Default Value Description

MSO: Use Safety 
Lead Time

Yes/No No Use this profile option to instruct 
the planning engine how to plan 
material to be completed early as a 
safety buffer. Values are:

- Yes: Use safety lead-time 
planning. The value in item 
attribute Safety Stock Percent is the 
safety lead-time in days; for 
example, if safety lead-time is two 
days, enter 200. 

- No: Use non-transient / transient 
safety stock planning. The value in 
item attribute Safety Stock Percent 
is a percent of demand.

MSO: Use SCO 
Time Aggregation

True/False False Determines whether the Planning 
Engine should use different 
aggregate time buckets than 
specified in the aggregation settings
of the plan options. The Planning 
Engine use the values defined in 
the plan options. You can specify 
large values for daily and weekly 
buckets for Planning Engine 
output, but this increases Planning 
Engine calculation time. Valid 
values are: True: The Planning 
Engine uses aggregate time buckets
specified in MSO: Optimization 
Daily Aggregation Buckets and 
MSO: Optimization Weekly 
Aggregation Buckets. The period 
time bucket is derived. False: The 
Planning Engine uses the same 
aggregate time buckets as specified 
in the Aggregation tab of the Plan 
Options window.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Use 
Sequencing 
Template

Yes/No No This profile option specifies 
whether Oracle Advances Supply 
Chain Planning tries to schedule 
activities in accordance with a 
determined preferred sequence of 
activities.

If Yes, the planning engine 
determines a preferred sequence of 
activities on resources and tries to 
schedule activities in accordance 
with the sequence. This setting is 
recommended if the sequence 
dependent setup resource is the 
primary bottleneck.

If No, the sequence of activities is 
determined more dynamically 
when scheduling other activities. 
This setting is recommended if 
there are multiple bottleneck 
resources.

MSO: Use Shift 
Definitions When 
Scheduling Lead 
Times

Yes/No No Determines whether the planning 
engine needs to take into account 
shift times for calculating 
lead-times on shipping, receiving, 
and carrier calendars. Values are:

- Yes: Considers shift definitions for
calculating lead-times on calendars 
in case of constrained plans.

- No: Shift definitions are not 
considered when offsetting 
lead-times on calendars.

If the plan planning mode is 
Constrained (Without Detailed 
Scheduling), the planning engine 
does not use this profile option.
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Profile Option 
Name

Valid Values Default Value Description

MSO: Use up 
existing supply of 
primary 
components before 
substitute

Yes/No Yes Use this profile option to specify 
whether to use the supply of 
substitute components or the 
primary component first. Valid 
values are:

- Yes: Use the supply of the primary
component before using the supply
of the substitute components

- No: Use the supply of the 
substitute components before using
the supply of the primary 
component

MSR Profile Options
The following table lists and defines the MSR profile options in Oracle Advanced 
Planning.

Profile Option 
Name

Valid Values Default Value Description

MSR: Budget 
Category Set

Null or any 
category sets

Null Use this profile option to specify the 
categories that you can use when 
defining budgets in Oracle Inventory. 
Valid values are:

- Null: Define budgets with any category.

- Any category set: Define budgets only 
with categories that are in the category 
set.

MSR: 
Postponement 
Factor

Integers >= 0 10 Specifies maximum depth in the bill of 
materials and sourcing tree to which 
uncertainty must be postponed.
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Profile Option 
Name

Valid Values Default Value Description

MSR: Safety Stock 
Holding Strategy

Destination 
Organization
or Source 
Organization

Source 
Organization

Specifies where safety stock should be 
held when the carrying cost is the same 
for an item in the destination 
organization and a source organization. 
A 0 value causes the safety stock to be 
held at the destination organization. A 1 
value causes the safety stock to be held at
the source organization.

MSR: Probability 
Distribution Type

Cumulative 
Probabilities/
Probabilities

Probabilities Determines probability distribution type 
associated with forecast sets as input to 
Oracle Inventory Optimization. Valid 
Values are: Probabilities: Demand 
uncertainty is stated in terms of a 
(non-cumulative) probability 
distribution. Cumulative Probabilities: 
Demand uncertainty is stated in terms of 
a cumulative probability distribution.
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B
Flexfields

This appendix covers the following topics:

• Overview of ASCP Flexfields

• Applying Flexfields to Different Versions of Oracle RDBMS

Overview of ASCP Flexfields
The following flexfields are used to enter penalty cost data at the appropriate levels for 
independent demands, items, and resources.

Penalty Cost Factor for Late Demands (at the demand level)

Defined via a flexfield in the Forecast Items form (for forecasts) or in the Scheduling 
region of the Sales Orders form (for sales orders). This will be stored in the table 
OE_ORDER_LINES_ALL and MRP_FORECAST_DATES.

Penalty Cost Factor for Late Demands (at the item level)

Defined via a flexfield in the Items form. This will be stored in the table 
MTL_SYSTEM_ITEMS.

Penalty Cost Factor for Late Demands (at the org level)

Defined via a flexfield in the Organizations Parameters form. This will be stored in the 
table MTL_PARAMETERS.

Penalty Cost Factor for Exceeding Material Capacity (at the item/vendor level)

Defined via a flexfield in the Supplier-Item Attributes form (in the header region). It 
will be stored in PO_ASL_ATTRIBUTES.

Penalty Cost Factor for Exceeding Material Capacity (at the item level)

Defined via a flexfield in the Items form. It will be stored in MTL_SYSTEM_ITEMS.

Penalty Cost Factor for Exceeding Material Capacity (at the org level)

Defined via a flexfield in the Organizations Parameters form. This will be stored in the 
table MTL_PARAMETERS.
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Penalty Cost Factor for Exceeding Resource Capacity (at the resource level)

Defined via a flexfield in the Department Resources form. This will be stored in the 
table BOM_DEPARTMENT_RESOURCES.

Penalty Cost Factor for Exceeding Resource Capacity (at the org level)

Defined via a flexfield in the Organizations Parameters window. This will be stored in 
the table MTL_PARAMETERS.

Penalty Cost Factor for Exceeding Transportation Cap. (ship method level)

Defined via a flexfield in the Inter-location Transit Times form. It will be stored in 
MTL_INTERORG_SHIP_METHODS.

Penalty Cost Factor for Exceeding Transportation Capacity (at the org level)

Defined via a flexfield in the Organizations Parameters form. This will be stored in the 
table MTL_PARAMETERS.

Other APS flexfields are: 

Aggregate Resource for a Resource

This is defined via a flexfield in the Department Resources form. It is based on the 
existing flexfield Aggregate Resource Id. It is stored in the table 
BOM_DEPARTMENT_RESOURCES.

Priority for Substitute Items

This is defined in the Substitute Components form. This is stored in the table 
BOM_SUBSTITUTE_COMPONENTS.

Priority for MDS Entries

This is defined via a flexfield in the Master Demand Schedule Entries form. It is stored 
in the table MRP_SCHEDULE_DATES.

Service Level (at the item level)

This is defined via a flexfield in the Items form. It is stored in the table 
MTL_SYSTEM_ITEMS.

Service Level (at the org level)

This is defined via a flexfield in the Organization Parameters form. It is stored in the 
table MTL_PARAMETERS.

Service Level (at the customer level)

This is defined via a flexfield in the Customer Entries form. It is stored in the table 
RA_CUSTOMERS.

Applying Flexfields to Different Versions of Oracle RDBMS
Oracle ASCP and Oracle Global Order Promising checks to whether you have existing 
flexfield. If you do, it does not overwrite your existing settings. 



Flexfields    B-3

Transportation Capacity

Oracle ASCP and Oracle Global Order Promising provides fields in the Inter-Location 
Transit Time window for setting load weight and load volume.

Creating Demand Priority Flexfield Numbers Manually

To Create Demand Priority Flexfield Number Manually
1. From system administrator responsibility, navigate to Application > Flexfields > 

Descriptive > Segments.

2. Double-click Segments.

The Descriptive Flexfield Segments window appears.

3. For the Application field, click Find and select Oracle Master Scheduling/MRP 
MRP_SCHEDULE_DATES.

4. Click Segments.

The Segments Summary window appears.

5. Click New.

Fill in the fields as shown in the following table:

Field Enter

Name Demand Priority

Window Prompt Demand Priority

Column An attribute column (for example, attribute 
10)

Number 1

6. Click Value Set.

The Value Set window appears.

7. For Value Set Name, click Find.

The Find Value Sets window appears.

8. From list of values, select 7/Number.

9. Click OK.
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To create Profile
1. Changes responsibility to Application Developer. Select Profile.

2. Fill in the fields as shown in the following table:

Fields Enter

Name MRP_DMD_PRIORITY_FLEX_NUM

Application Select Oracle Master Scheduling/MRP from 
List of Values

User Profile Name Same as Name

Description MRP:demands flexfield attribute for 
demand priority

3. Save and close this window.

4. Switch responsibilities back to System Administrator.

5. Select Profile > System.

The Find System Profile Values screen appears.

6. In the Profile filed, find the Profile MRP_DMD_PRIORITY_FLEX_NUM from the 
List of Values.

7. Click Site.

8. Click Find.

The System Profile Values screen appears.

9. In the site column, enter the number 10 (or whatever number you chose for 
column).
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C
Control Files

This appendix covers the following topics:

• Setup Data Control Files

• Supply Control Files

• Demand Control Files

• User-Defined Keys

Setup Data Control Files
The following table shows the setup data control files.

Business Object Flat File Loader's File Name
Option

Control Files

Bill of Materials Bills of Material Headers MSC_ST_BOMS.ctl

Bill of Materials Bills of Material Components MSC_ST_BOM_COMPONEN
TS.ctl

Bill of Materials Component Substitutes MSC_ST_COMPONENT_SU
BSTITUTES.ctl

Items Items MSC_ST_SYSTEM_ITEMS.ctl

Routings Routings MSC_ST_ROUTINGS.ctl

Routings Routing Operations MSC_ST_ROUTING_OPERA
TIONS.ctl
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Business Object Flat File Loader's File Name
Option

Control Files

Routing Operation Resources MSC_ST_OPERATION_RESO
URCES.ctl

Resources Resources MSC_ST_DEPARTMENT_RE
SOURC.ctl ES

Resource Resource Availability MSC_ST_RESOURCE_CHAN
GES.ctl

Resource Resource Shifts MSC_ST_RESOURCE_SHIFT
S.ctl

Resource Resource Groups MSC_ST_RESOURCE_GROU
PS.ctl

Projects and tasks Project Tasks MSC_ST_PROJECT_TASKS.ct
l

Unit of Measure Units of Measure MSC_ST_UNITS_OF_MEASU
RE.ctl

Unit of Measure Units of Measure Class 
Conversions

MSC_ST_UOM_CLASS_CON
VERSIONS.ctl

Unit of Measure Units of Measure Conversions MSC_ST_UOM_CONVERSIO
NS.ctl

Item Categories Category Sets MSC_ST_CATEGORY_SETS.c
tl

Item Categories Item Categories MSC_ST_ITEM_CATEGORIE
S.ctl

Sourcing Rules Item Sourcing MSC_ST_ITEM_SOURCING.c
tl

Sourcing Rules Inter Org Shipment Method MSC_ST_INTERORG_SHIP_
METHODS.ctl

Calendars Calendars MSC_ST_CALENDARS.ctl
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Business Object Flat File Loader's File Name
Option

Control Files

Calendar Workday Patterns MSC_ST_WORKDAY_PATTE
RNS.ctl

Calendar Shift Times MSC_ST_SHIFT_TIMES.ctl

Calendar Calendar Exceptions MSC_ST_CALENDAR_EXCE
PTIONS.ctl

Calendar Shift Exceptions MSC_ST_SHIFT_EXCEPTIO
NS.ctl

Resource Demand Resource Requirements MSC_ST_RESOURCE_REQUI
REMENTS.ctl

Supplier Capacity Item Suppliers MSC_ST_ITEM_SUPPLIERS.c
tl

Supplier Capacity Supplier Capacities MSC_ST_SUPPLIER_CAPAC
ITIES.ctl

Supplier Capacity Supplier Flex Fences MSC_ST_SUPPLIER_FLEX_F
ENCES.ctl

Trading Partners Trading Partners MSC_ST_TRADING_PARTN
ERS.ctl

Trading Partners Trading Partner Sites MSC_ST_TRADING_PARTN
ER_SITES.ctl

Trading Partners Location Associations MSC_ST_LOCATION_ASSO
CIATIONS.ctl

Trading Partners Sub Inventories MSC_ST_SUB_INVENTORIE
S.ctl

Supply Chain People Partner Contacts MSC_ST_PARTNER_CONTA
CTS.ctl

Demand Class Demand Class MSC_ST_DEMAND_CLASSE
S.ctl
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Supply Control Files
The following table shows the control files for supplies.

Business Object Flat File Loader's File Name
Option

Control Files

Work Order Work Order Supplies MSC_ST_SUPPLIES_WO.ctl

Requisitions Requisition Supplies MSC_ST_SUPPLIES_REQ.ctl

On hand On-hand Supplies MSC_ST_SUPPLIES_ONHA
ND.ctl

Intransit Intransit Supplies MSC_ST_SUPPLIES_INTRA
NSIT.ctl

Purchase Order Purchase Order Supplies MSC_ST_SUPPLIES_PO.ctl

Supply forecast Plan Order Supplies MSC_ST_SUPPLIES_PLAN_
ORDERS.ctl

Supply forecast Plan Order Designators MSC_ST_DESIGNATORS_PL
AN_ORDERS.ctl

Demand Control Files
The following table shows demand control files.

Business Object Flat File Loader's File Name
Option

Control Files

Sales Orders Sales Order Demands MSC_ST_SALES_ORDERS.ctl

Demand Forecast Forecast Demands MSC_ST_DEMANDS_FOREC
AST.ctl

Demand Forecast Forecast Designators MSC_ST_DESIGNATORS_FO
RECAST.ctl
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Business Object Flat File Loader's File Name
Option

Control Files

Master Demand Schedule Demand Schedule Demands MSC_ST_DEMANDS_MDS.ct
l

Master Demand Schedule Demand Schedule 
Designators

MSC_ST_DESIGNATORS_M
DS.ctl

Work Order Component 
Demand

Work Order Component 
Demands

MSC_ST_DEMANDS_WORK
_ORDER.ctl

Safety Stocks Safety Stocks MSC_ST_SAFETY_STOCKS.c
tl

Reservations Reservations MSC_ST_RESERVATIONS.ctl

User-Defined Keys
COMPANY_NAME is required only if SCE is installed. For standalone APS, this is 
defaulted to -1.

The following table shows user-defined keys (UDK's) for various business objects.

Business Object Table User-Defined Key (UDK)

Item MSC_ST_SYSTEM_ITEMS SR_INSTANCE_CODE, 
ORGANIZATION_CODE, 
ITEM_NAME, 
COMPANY_NAME

BOM MSC_ST_BOMS SR_INSTANCE_CODE, 
ORGANIZATION_CODE, 
BOM_NAME (defaulted from
ASSEMBLY_NAME if Null),

ASSEMBLY_NAME,

ALTERNATE_BOM_DESIGN
ATOR (null allowed), 
COMPANY_NAME
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Business Object Table User-Defined Key (UDK)

BOM MSC_ST_BOM_COMPONEN
TS

SR_INSTANCE_CODE, 
ORGANIZATION_CODE, 
BOM_NAME (defaulted from
ASSEMBLY_NAME if Null), 

ASSEMBLY_NAME,

ALTERNATE_BOM_DESIGN
ATOR (can be null),

OPERATION_SEQ_CODE (if 
null or character would be 
defaulted to 1),

COMPONENT_NAME, 
EFFECTIVITY_DATE,

DISABLE_DATE (can be 
null), COMPANY_NAME

BOM MSC_ST_COMPONENT_SU
BSTITUTES

SR_INSTANCE_CODE, 
ORGANIZATION_CODE, 
BOM_NAME (defaulted from
ASSEMBLY_NAME if Null), 

ASSEMBLY_NAME,

ALTERNATE_BOM_DESIGN
ATOR (can be null), 
OPERATION_SEQ_CODE (if 
null or character would be 
defaulted to 1), 
COMPONENT_NAME, 
SUB_ITEM_NAME, 
COMPANY_NAME

Categories MSC_ST_CATEGORY_SETS SR_INSTANCE_CODE, 
CATEGORY_SET_NAME, 
COMPANY_NAME

Categories MSC_ST_ITEM_CATEGORIE
S

SR_INSTANCE_CODE, 

ORGANIZATION_CODE, 
CATEGORY_SET_NAME, 
CATEGORY_NAME, 
ITEM_NAME, 
COMPANY_NAME
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Business Object Table User-Defined Key (UDK)

UOM MSC_ST_UNITS_OF_MEASU
RE

UOM_CODE,

UNIT_OF_MEASURE (if null 
would be defaulted by 
UOM_CODE), 
COMPANY_NAME

UOM MSC_ST_UOM_CLASS_CON
VERSIONS

ITEM_NAME, 

FROM_UOM_CODE, 
FROM_UNIT_OF_MEASURE
(defaulted from 
FROM_UOM_CODE if null), 

TO_UOM_CODE, 
TO_UNIT_OF_MEASURE, 
(defaulted from 
TO_UOM_CODE if null) 

COMPANY_NAME

UOM MSC_ST_UOM_CONVERSIO
NS

ITEM_NAME, 

UOM_CODE, 
UNIT_OF_MEASURE 
(defaulted from UOM_CODE 
if null), COMPANY_NAME

Demand Class MSC_ST_DEMAND_CLASSE
S

SR_INSTANCE_CODE

DEMAND_CLASS, 
COMPANY_NAME,

Resources MSC_ST_DEPARTMENT_RE
SOURCES

SR_INSTANCE_CODE, 
ORGANIZATION_CODE, 
RESOURCE_CODE, 
DEPARTMENT_CODE, 
COMPANY_NAME

Resources MSC_ST_RESOURCE_SHIFT
S

SR_INSTANCE_CODE, 
ORGANIZATION_CODE, 
RESOURCE_CODE, 
DEPARTMENT_CODE, 
SHIFT_NAME, 
COMPANY_NAME
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Business Object Table User-Defined Key (UDK)

Resources MSC_ST_RESOURCE_CHAN
GES

SR_INSTANCE_CODE, 
ORGANIZATION_CODE, 
RESOURCE_CODE, 
DEPARTMENT_CODE, 
SHIFT_NUM, FROM_DATE, 
TO_DATE, FROM_TIME, 
TO_TIME, 
SIMULATION_SET, 
ACTION_TYPE, 
COMPANY_NAME

Resources MSC_ST_RESOURCE_GROU
PS

SR_INSTANCE_CODE, 

COMPANY_NAME, 

GROUP_CODE

Routings MSC_ST_ROUTINGS SR_INSTANCE_CODE,

ORGANIZATION_CODE,

ROUTING_NAME (defaulted
from ASSEMBLY_NAME if 
Null),

ASSEMBLY_NAME,

ALTERNATE_ROUTING_DE
SIGNATOR (can be null), 
COMPANY_NAME
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Business Object Table User-Defined Key (UDK)

Routings MSC_ST_ROUTING_OPERA
TIONS

SR_INSTANCE_CODE,

ORGANIZATION_CODE,

ROUTING_NAME (defaulted
from ASSEMBLY_NAME if 
Null),

ASSEMBLY_NAME, 
OPERATION_SEQ_CODE (if 
null or character would be 
defaulted to 1), 

ALTERNATE_ROUTING_DE
SIGNATOR (can be null), 
EFFECTIVITY_DATE,

DISABLE_DATE, 
COMPANY_NAME

Routings MSC_ST_OPERATION_RESO
URCES

SR_INSTANCE_CODE,

ORGANIZATION_CODE,

ROUTING_NAME (defaulted
from ASSEMBLY_NAME if 
Null),

ASSEMBLY_NAME, 
OPERATION_SEQ_CODE (if 
null or character would be 
defaulted to 1), 
RESOURCE_SEQ_CODE (if 
null or character would be 
defaulted to 1),

RESOURCE_CODE, 
ALTERNATE_ROUTING_DE
SIGNATOR (can be null), 
ALTERNATE_NUMBER (can 
be null), COMPANY_NAME

Calendar MSC_ST_CALENDARS SR_INSTANCE_CODE, 
CALENDAR_CODE, 
COMPANY_NAME
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Business Object Table User-Defined Key (UDK)

Calendar MSC_ST_CALENDAR_EXCE
PTIONS

SR_INSTANCE_CODE, 
CALENDAR_CODE, 
EXCEPTION_DATE, 
COMPANY_NAME

Calendar MSC_ST_WORKDAY_PATTE
RNS 

SR_INSTANCE_CODE, 
CALENDAR_CODE, 
SHIFT_NAME, 
COMPANY_NAME

Calendar MSC_ST_SHIFT_TIMES SR_INSTANCE_CODE, 
CALENDAR_CODE, 
SHIFT_NAME, FROM_TIME,
TO_TIME, 
COMPANY_NAME

Calendar MSC_ST_SHIFT_EXCEPTIO
NS 

SR_INSTANCE_CODE, 
CALENDAR_CODE, 

SHIFT_NAME, 
EXCEPTION_DATE, 
COMPANY_NAME

Material Supply (PO) MSC_ST_SUPPLIES SR_INSTANCE_CODE, 
ORDER_NUMBER, 
PURCH_LINE_NUM, 
ORDER_TYPE = 1(PO),8(PO 
Recv.), COMPANY_NAME

Material Supply (Req.) MSC_ST_SUPPLIES SR_INSTANCE_CODE, 
ORDER_NUMBER, 
PURCH_LINE_NUM, 
ORDER_TYPE = 2, 
COMPANY_NAME

Material Supply (WO- 
Discrete/ Flow)

MSC_ST_SUPPLIES SR_INSTANCE_CODE, 
ORDER_TYPE (3 - Discrete 
job, 7 - Non-standard job, 
27-Flow schedule), 
WIP_ENTITY_NAME, 
COMPANY_NAME
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Business Object Table User-Defined Key (UDK)

Material Supply (WO- By 
Products)

MSC_ST_SUPPLIES SR_INSTANCE_CODE, 
ORDER_TYPE (14 -Discrete 
job by-product, 15 
-Nonstandard job 
by-product), ITEM_NAME, 
WIP_ENTITY_NAME, 
ORDER_NUMBER, (if null 
defaulted by 
WIP_ENTITY_NAME if null),
OPERATION_SEQ_CODE (if 
null or character would be 
defaulted to 1), 
COMPANY_NAME

Material Supply (Plan Orders) MSC_ST_SUPPLIES SR_INSTANCE_CODE, 
ORDER_TYPE = 5 (Plan 
Orders), 

ORGANIZATION_CODE, 
SCHEDULE_DESIGNATOR, 
SCHEDULE_LINE_NUM (or 
order number), 
COMPANY_NAME

Material Supply (Plan Orders) MSC_ST_DESIGNATORS DESIGNATOR, 
ORGANIZATION_CODE, 
SR_INSTANCE_CODE, 
COMPANY_NAME

Material Supply (On Hand) MSC_ST_SUPPLIES SR_INSTANCE_CODE, 
ORDER_TYPE = 18, 
ITEM_NAME, 
ORGANIZATION_CODE, 
SUBINVENTORY_CODE 
(can be null), LOT_NUMBER 
(can be null), 
PROJECT_NUMBER (can be 
null), TASK_NUMBER (can 
be null), UNIT_NUMBER 
(can be null), 
COMPANY_NAME
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Business Object Table User-Defined Key (UDK)

Material Supply (Intransit) MSC_ST_SUPPLIES SR_INSTANCE_CODE, 
ORDER_NUMBER, 
PURCH_LINE_NUM, 
ORDER_TYPE = 11 (Intransit),
12 - (Intransit Receipt), 
COMPANY_NAME

Material Demand (Sales 
Orders)

MSC_ST_SALES_ORDERS SR_INSTANCE_CODE, 
SALES_ORDER_NUMBER, 
LINE_NUM, 
ORGANIZATION_CODE, 
COMPANY_NAME

Material Demand (WO- 
Discrete)

MSC_ST_DEMANDS WIP_ENTITY_NAME, 
ITEM_NAME, 
OPERATION_SEQ_CODE (if 
null or character would be 
defaulted to 1), 
SR_INSTANCE_CODE, 
ORIGINATION_TYPE = 2 
(Non Standard), 3 (Standard), 
ORGANIZATION_CODE, 
COMPANY_NAME

Material Demand (Master 
Demand Schedule)

MSC_ST_DEMANDS ITEM_NAME,

DEMAND_SCHEDULE_NA
ME,

SCHEDULE_LINE_NUM 
(Null allowed - in case of item
not being demanded on the 
same date more than once),

ORIGINATION_TYPE = 8 
(MDS),

ORGANIZATION_CODE

SR_INSTANCE_CODE

SCHEDULE_DATE, 
COMPANY_NAME
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Business Object Table User-Defined Key (UDK)

Material Demand (Master 
Demand Schedule)

MSC_ST_DESIGNATORS DESIGNATOR, 
ORGANIZATION_CODE, 
SR_INSTANCE_CODE, 
DESIGNATOR_TYPE =(1,2), 
COMPANY_NAME

Material Demand (Forecast) MSC_ST_DEMANDS ITEM_NAME,

FORECAST_DESIGNATOR,

SCHEDULE_LINE_NUM 
(Null allowed - in case of item
not being demanded on the 
same date more than once),

ORIGINATION_TYPE = 29 
(Forecast),

ORGANIZATION_CODE,

SR_INSTANCE_CODE,

SCHEDULE_DATE, 
COMPANY_NAME

Material Demand (Forecast) MSC_ST_DESIGNATORS DESIGNATOR, 
FORECAST_SET, 
ORGANIZATION_CODE, 
SR_INSTANCE_CODE, 
DESIGNATOR_TYPE =6, 
COMPANY_NAME

Safety Stocks MSC_ST_SAFETY_STOCKS SR_INSTANCE_CODE, 
COMPANY_NAME,

ORGANIZATION_CODE,

ITEM_NAME, 

PERIOD_START_DATE 
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Business Object Table User-Defined Key (UDK)

Reservations MSC_ST_RESERVATIONS SR_INSTANCE_CODE,

COMPANY_NAME,

SALES_ORDER_NUMBER,

LINE_NUM,

ORGANIZATION_CODE

Resource Demand MSC_ST_RESOURCE_REQUI
REMENTS

WIP_ENTITY_NAME, 
ITEM_NAME, 
OPERATION_SEQ_CODE (if 
null or character would be 
defaulted to 1), 
SR_INSTANCE_CODE, 
ORGANIZATION_CODE, 
DEPARTMENT_CODE, 
RESOURCE_CODE, 
COMPANY_NAME

Supplier Capacity MSC_ST_ITEM_SUPPLIERS SR_INSTANCE_CODE, 
ORGANIZATION_CODE, 
VENDOR_NAME, 
VENDOR_SITE_CODE, 
ITEM_NAME, 
COMPANY_NAME

Supplier Capacity MSC_ST_SUPPLIER_CAPAC
ITIES

SR_INSTANCE_CODE, 
ORGANIZATION_CODE, 
VENDOR_NAME, 
VENDOR_SITE_CODE, 
ITEM_NAME, FROM_DATE, 
COMPANY_NAME

Supplier Capacity MSC_ST_SUPPLIER_FLEX_F
ENCES

SR_INSTANCE_CODE, 
ORGANIZATION_CODE, 
VENDOR_NAME, 
VENDOR_SITE_CODE, 
ITEM_NAME, 
FENCE_DAYS, 
COMPANY_NAME
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Business Object Table User-Defined Key (UDK)

Trading Partners MSC_ST_TRADING_PARTN
ERS

SR_INSTANCE_CODE, 
PARTNER_NAME

PARTNER_TYPE (1 - 
supplier, 2 - customer), 
COMPANY_NAME

Trading Partners MSC_ST_TRADING_PARTN
ER_SITES

PARTNER_NAME, 
SR_INSTANCE_CODE, 
PARTNER_TYPE (1 - 
supplier, 2 - customer), 
TP_SITE_CODE, 
COMPANY_NAME

Trading Partners MSC_ST_LOCATION_ASSO
CIATIONS

PARTNER_NAME, 
SR_INSTANCE_CODE

PARTNER_TYPE

SR_TP_CODE

LOCATION_CODE, 

ORGANIZATION_CODE, 
COMPANY_NAME

Trading Partners MSC_ST_SUB_INVENTORIE
S

ORGANIZATION_CODE 
SR_INSTANCE_CODE

SUBINVENTORY_CODE, 
COMPANY_NAME

Trading Partners MSC_ST_PARTNER_CONTA
CTS

PARTNER_NAME, 
SR_INSTANCE_CODE, 
PARTNER_TYPE, 
TP_SITE_CODE, 
COMPANY_NAME, NAME

(A partner site can have only 
one contact) 

Organizations MSC_ST_TRADING_PARTN
ERS

ORGANIZATION_CODE,

SR_INSTANCE_CODE, 

PARTNER_TYPE (3 - 
organizations), 
COMPANY_NAME
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Business Object Table User-Defined Key (UDK)

Sourcing Rules MSC_ST_INTER_ORG_SHIP_
METHODS

SR_INSTANCE_CODE

FROM_ORGANIZATION_C
ODE,

TO_ORGANIZATION_COD
E, 

SHIP_METHOD, 
COMPANY_NAME,

Sourcing Rules MSC_ST_ITEM_SOURCING SR_INSTANCE_CODE, 
ITEM_NAME (null allowed), 
CATEGORY_NAME (null 
allowed), 
SOURCING_RULE_NAME 
(null allowed), 
ASSIGNMENT_NAME (null 
allowed), 
RECEIPT_ORGANIZATION_
CODE (null allowed if global 
sourcing), 
SOURCE_ORGANIZATION_
CODE, 
SOURCE_PARTNER_CODE 
(either one of source 
organization code or partner 
code can be null), 
SOURCE_PARTNER_SITE_C
ODE (null allowed), 
EFFECTIVE_DATE, 
COMPANY_NAME

Projects & Tasks MSC_ST_PROJECT_TASKS SR_INSTANCE_CODE, 
ORGANIZATION_CODE, 
PROJECT_NAME, 
TASK_NAME (can be null if 
only project information is to 
be provided), 
COMPANY_NAME
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Glossary

A

action message

Output of the planning process that identifies a type of action to be taken to correct a 
current or potential material, capacity, or transportation coverage problem.

aggregate resources

The summation of all requirements of multi-department resources across all 
departments that use them.

allocated ATP

The ability to allocate scarce supply (finished goods, key components or resources) to 
various demand channels. Whether you are performing ATP or CTP, the allocation is 
being considered for order promising.

alternate bill of material

An alternate list of component items you can use to produce an assembly. 

alternate resources 

Different resource or a group of different resources that can be used instead of the 
primary resource or group of resources in the job operation. Each resource, or group of 
resources, can form an alternate group. Alternative scheduling is when the primary 
group can be replaced by an alternate group in the job operation.

alternate routing

An alternate manufacturing process you can use to produce an assembly. 

alternate unit of measure

All other units of measure defined for an item, excluding the primary unit of measure.

API 

An Application Programming Interface (API) is a published interface to accomplish a 
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business or scientific function. An API defines a contract to its users by guaranteeing a 
published interface but hides its implementation details.

assemble-to-order (ATO)

An environment where you open a final assembly order to assemble items that 
customers order. Assemble-to-order is also an item attribute that you can apply to 
standard, model, and option class items. An item you make in response to a customer 
order.

assembly

An item that has a bill of material. You can purchase or manufacture an assembly item. 
Seeassemble-to-order, bill of material.

assignment hierarchy

You can assign sourcing rules and bills of distribution to a single item in an inventory 
organization, all items in an inventory organization, categories of items in an inventory 
organization, a site, and an organization. These assignments have an order of 
precedence relative to one another.

assignment set

A group of sourcing rules and/or bills of distribution and a description of the items 
and/or organizations whose replenishment they control. 

ATO

Seeassemble-to-order (ATO).

ATP

Seeavailable to promise (ATP).

availability

The quantity of the item is in stock (and not reserved) in the default location. 
Calculation is 'on-hand minus reserved.' 

available capacity

The amount of capacity available for a resource or production line.

available to promise (ATP)

The quantity of current on-hand stock, outstanding receipts and planned production 
which has not been committed through a reservation or placing demand. In Oracle 
Inventory, you define the types of supply and demand that should be included in your 
ATP calculation. Refers to the ability to promise availability based on a pre-defined 
statement of current and planned supply.
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available-to-promise rule

A set of Yes/No options for various entities that the user enters in Oracle Inventory. The
combination of the various entities are used to define what is considered supply and 
demand when calculating available to promise quantity.

B

basic ATP 

This term is used to describe the task of performing an ATP check against a given 
organization.

bill of distribution 

Specifies a multilevel replenishment network of warehouses, distribution centers, and 
manufacturing plants.

bill of material

A list of component items associated with a parent item and information about how 
each item relates to the parent item. Oracle Manufacturing supports standard, model, 
option class, and planning bills. The item information on a bill depends on the item type
and bill type. The most common type of bill is a standard bill of material. A standard 
bill of material lists the components associated with a product or subassembly. It 
specifies the required quantity for each component plus other information to control 
work in process, material planning, and other Oracle Manufacturing functions. Also 
known as product structures.

bill of resources

A list of each resource and/or production line required to build an assembly, model, or 
option.

bottleneck resource

A resource whose capacity is less than the demand placed upon it. For example, a 
bottleneck machine or work center exists where jobs are processed at a slower rate than 
they are demanded.

C

calculate ATP

An item attribute the planning process uses to decide when to calculate and print 
available to promise (ATP) for the item on the Planning Detail Report. The planning 
process calculates ATP as Planned production - committed demand.

calendar type

The period pattern used to define a manufacturing calendar.
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capable to deliver

A calculation that includes the transit lead time to meet your customers delivery needs 
Oracle Global Order Promising encompasses all these capabilities.

capable to promise

CTP (Capable to Promise) refers to the additional ability to determine the availability of 
component materials and resources to meet unplanned demands. 

component

A serviceable item that is a part or feature in another serviceable item. Your customers 
cannot report service requests against this type of serviceable item directly. You can 
reference components when you enter service requests against actual end item-type 
serviceable items, or products. For example, if you define three inventory items, A, B, 
and C, where A and B are products (end item-type serviceable items) but C is a 
component (non-end item-type serviceable item) of A, you can enter service requests 
against A and B directly, but not against C. When you enter a service request against 
product A, you can reference C because it is a component of A.

component demand

Demand passed down from a parent assembly to a component.

component item

An item associated with a parent item on a bill of material.

component yield

The percent of the amount of a component you want to issue to build an assembly that 
actually becomes part of that assembly. Or, the amount of a component you require to 
build plus the amount of the component you lose or waste while building an assembly. 
For example, a yield factor of 0.90 means that only 90% of the usage quantity of the 
component on a bill actually becomes part of the finished assembly. 

compression days

The number of days the planning process suggests you compress the order (in other 
words, reduce the time between the start date and the due date). 

D

discrete job

Discrete jobs are used to manufacture assemblies using specific materials and resources 
within a start and end date. (Also known as work order or assembly order).

E
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ECO

Seeengineering change order (ECO).

end item

Any item that can be ordered or sold. 

engineering change order (ECO)

A record of revisions to one or more items usually released by engineering.

F

firm planned order

An MRP-planned order that is firmed using the Planner Workbench. This enables the 
planner to firm portions of the material plan without creating discrete jobs or purchase 
requisitions. Unlike a firm order, a MRP firm planned order does not create a natural 
time fence for an item.

forecast

An estimate of future demand on inventory items. A forecast contains information on 
the original and current forecast quantities (before and after consumption), the 
confidence factor, and any specific customer information. You can assign any number of
inventory items to the forecast and use the same item in multiple forecasts. For each 
inventory item you specify any number of forecast entries.

H

highest level item

Item which sits on the top of the substitution chain. Usually this is the item, which is 
more functionally rich when compared to other items in the substitution chain.

I

independent demand

Demand for an item unrelated to the demand for other items.

item routing 

A sequence of manufacturing operations that you perform to manufacture an assembly.
A routing consists of an item, a series of operations, an operation sequence, and 
operation effective dates. Edits to an Item Routing do not automatically update a job 
routing.

J
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job routing 

A snapshot of an item routing that has been assigned to a job. The routing is current on 
the day the job was created. Edits to a job routing do not automatically revert to the 
item routing.

M

make order 

An order to manufacture an item. The following Oracle Applications entities are make 
orders: 

- Batches (Oracle Process Manufacturing) 

- Discrete jobs (Oracle Work in Process) 

- Flow schedules (Oracle Flow Manufacturing) 

- Jobs (Oracle Project Manufacturing) 

- Jobs (Oracle Shopfloor Management (OSFM))

master demand schedule

The anticipated ship schedule in terms of rates or discrete quantities, and dates. In 
ASCP, MDS is used as an input to the enterprise plan.

material and resource constrained plan

In this plan, you can generate a plan that respects material, resource, and transportation
constraints. However, no plan objectives are considered.

material constrained plan

In this plan, all material constraints that can be specified in the form of a supply 
schedule from manufacturing plants or by statements of vendor capacity from vendors 
are considered. When material availability is not a concern, resource availability 
constraints are used only to generate exceptions arising due to over utilization or 
under-utilization of resources.

multilevel supply chain ATP/CTP/CTD

This term is used to describe the task of performing a multilevel BOM availability check
including finished goods, components, resource, supplier capacity and transportation 
lead time. 

N

need by date

The need by date for the end item is the demand date. The need by dates for the 
dependent demands are calculated based on the lead-time offsets that are associated to 
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the Items and routings used. 

• For a constrained plan, the planning process uses planned orders and routings to 
derive the suggested due date. 

• For an unconstrained plan, , the suggested due date is the need by date. 

Therefore, any differences between the lead time offsets (need by date) and actual 
manufacturing time (suggested due date) created by the planning process, will show up
in the form of multiple exception messages.

O

ODS

Seeoperation data store (ODS).

operation data store (ODS) 

All the tables that are the destination for the collected data from transaction systems 
(both Oracle Applications and legacy systems). This acts as the input for the snapshot 
portion of the planning process. 

When we refer to ODS based ATP, we mean ATP based on collected data.

optimized plan

An optimized and executable plan based on plan objectives as well as material, 
resource, and transportation constraints.

original item 

An item for which you received demand.

overload

The condition where required capacity for a resource or production is greater than 
available capacity.

P

PDS

Seeplanning data store (PDS).

pegging

The capability to identify for a given item the sources of its gross requirements and/or 
allocations. Pegging can be thought of as active where-used information.

planned order

A suggested quantity, release date, and due date that satisfies net item requirements. 
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Planner Workbench

A form that you use to research exception messages and to act on recommendations 
generated by the planning process for a plan. You can implement planned orders as 
discrete jobs or purchase requisitions, maintain planned orders, reschedule scheduled 
receipts, and implement repetitive schedules. You can choose all suggestions from a 
plan or only those that meet a certain criteria.

planning data store (PDS) 

All the tables within Oracle Advanced Supply Chain Planning--the ODS and other 
output tables from planning. When we refer to PDS-based ATP, we mean ATP based on
planning output.

planning exception set

An item attribute the planning process uses to decide when to raise planning exceptions
for the item. 

planning horizon

The amount of time a schedule extends into the future.

planning time bucket

A time period into which the planning engine accumulates time-phased data and nets 
(performs the gross to net explosion on) that data as a unit. The planning engine plans 
in planning time buckets of minutes, hours, days, weeks, and periods (months). 

planning time fence

An item attribute used to determine a future point in time inside which there are certain
restrictions on the planning recommendations the planning process can make for the 
item. 

postprocessing lead time

The time required to receive a purchased item into inventory from the initial supplier 
receipt, such as the time required to deliver an order from the receiving dock to its final 
destination.

preprocessing lead time

The time required to place a purchase order or create a discrete job or repetitive 
schedule that you must add to purchasing or manufacturing lead time to determine 
total lead time. If you define this time for a repetitive item, the planning process ignores
it.

processing lead time

The time required to procure or manufacture an item. For manufactured assemblies, 
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processing lead time equals the manufacturing lead time. 

production activity control

The function of routing an dispatching the work to be accomplished through the 
production facility and of performing supplier control.

projected available balance

Quantity on hand projected into the future if scheduled receipts are rescheduled or 
cancelled, and new planned orders are created as per recommendations made by the 
planning process. Calculated by the planning process as current and planned supply 
(nettable quantity on hand + scheduled receipts + planned orders) minus demand (gross
requirements). Note that gross requirements for projected available includes derived 
demand from planned orders. Note also that the planning process uses suggested due 
dates rather than current due dates to pass down demand to lower level items. .

R

resource constrained plan

The planning engine considers all resource constraints such as available machine hours,
transportation capacity, as well as alternate resources. It considers alternate bill of 
materials only in an optimized plan. Material constraints are used only to generate 
exceptions arising due to lack of material availability.

routing

A sequence of manufacturing operations that you perform to manufacture an assembly.
A routing consists of an item, a series of operations, an operation sequence, and 
operation effective dates. 

S

safety stock

Quantity of stock planned to have in inventory to protect against fluctuations in 
demand and/or supply. 

scheduled receipt

A discrete job, repetitive schedule, non-standard job, purchase requisition, or purchase 
order. It is treated as part of available supply during the netting process. Schedule 
receipt dates and/or quantities are not altered automatically by the planning system.

seiban manufacturing

A manufacturing environment in which demand and supply are identified by seiban 
numbers that peg supply to demand. This numbering system is widely used in Japan 
and Korea.
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shipping

The function that performs tasks for the outgoing shipment of parts, components, and 
products. It includes packaging, marking, weighing and loading for shipment.

simultaneous resources

Two or more resources are scheduled to be working concurrently within a job 
operation. Each operation contains a scheduled sequence of activities and resources 
used in the operation. Simultaneity is implemented by having more than one resource 
used in an operation.

sourcing rule

Specifies how to replenish items in an organization, such as purchased items in plants. 

substitution chain

Several revisions of items with strict predecessor and successor relationships amongst 
them. In some cases various revisions are modeled as different items forming a 
substitution chain. 

suggested dock date

The date you expect to receive an order (to arrive on the receiving dock) as suggested 
by the planning process.

suggested due date

The date when scheduled receipts are expected to be received into inventory and 
become available for use as suggested by the planning process. See alsoneed by date

The need by date for the end item is the demand date. The need by dates for the 
dependent demands are calculated based on the lead-time offsets of the items and 
routings.. 

suggested start date

The date you or your suppliers expect to start to manufacture the order as suggested by 
the planning process.

supply chain

The processes from the initial raw materials to the ultimate consumption of the finished 
product linking across supplier-user companies. The functions inside and outside a 
company that enable the value chain.

supply chain ATP 

This term is used to describe the task of performing an ATP check against multiple 
sourcing organizations for a given customer request.
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supply chain management

The planning, organization, and controlling of supply chain activities.

supplier flexfences

Specifies capacity tolerance percentages that vary over time for each source. This allows
you to represent the ability of your supplier to flex capacity upwards based on the 
amount of advanced notice you provide.

T

time bucket

A unit of time used for defining and consuming forecasts. A bucket can be one day, one 
week, or one period.

U

unconstrained plan

The planning process assumes infinite material availability and resource capacity. 
Statements of material availability and resource capacity are used to generate 
exceptions. Demand priorities are included during the planning run to determine the 
appropriate pegging relationships between supply and demand.

underload

A condition where required capacity for a resource or production is less than available 
capacity.

W

workday calendar

A calendar that identifies available workdays for one or more organizations. The 
planning process plans and schedules activities based on an entity's available 
workdays.





Index-1

 
Index

A
accessing and executing planned orders, 18-151
accessing the Gantt Chart, 18-159
accessing the resource tool tip, 18-166
actions

saving, 7-6
undoing, 7-6
viewing, 7-6
viewing details, 7-6

Actions tab, 7-6
actual end date, 17-128
actual start date, 17-128
a day in the life of a planner, 3-3
adding capacity, 18-168
adjustable item field, 18-44
adjusted resource hours, 9-19
advanced forecast spreading, 5-100
Advanced Planning Suite, 1-1
aggregate resources, 19-6
aggregation levels, 5-137

choosing, 5-137
material, 5-141
product, 5-138
resource, 5-139
routing, 5-141
time, 5-137

aggregation tabbed region, 14-9
allocating demand based on historical demand, 
6-35
allocating demand to suppliers, 6-33
allocation

fair share, 16-18
alternate resources, 19-6

loading, 18-168
Analyze Plan Partition (concurrent process), 22-
17
append planned orders, 5-61
Application Instances window

setting up, 2-11
approved supplier list

delivery calendar, 6-88
processing lead-time, 6-88
viewing attributes in workbench, 6-88

APS information flows, 3-2
arrival time updates, 6-103
assemble to order, 10-10

example, 10-10
asset intensive planning, 19-104, 20-20

Oracle Complex Maintenance, Repair, and 
Overhaul, 19-109
Oracle Enterprise Asset Management, 19-104
planning strategy, 19-112

assignment sets
assignment hierarchy, 6-2
defining, 6-2

ATO
See assemble to order, 10-10

ATP
See available to promise, 11-8

ATP 24x7 Switch Plans (concurrent process), 22-
15
ATP 24x7 Synchronization Process (concurrent 
process), 22-15
atp post plan processing (concurrent process), 22-
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16
attaching a priority rule to a supply chain plan, 
5-68
Audit Statements report, 22-1

running, 22-1
viewing, 22-3

Auto Release Planned Order (concurrent 
process), 22-17
available to promise, 11-8

B
batchable resources

production scheduling, 20-13
batch plan

running, 7-4
batch replan, 9-63
batch resources, 6-158
Batch was started with less than minimum 
capacity exception message, 17-57
Batch was started with more than maximum 
capacity exception message, 17-60
bills of distribution

See BODs, 6-2
Bills of Materials, 9-3
BODs, 6-2

defining, 6-2
borrow payback, 19-17
bottleneck resource group

scheduling, 5-53
breadth-first search, 12-13
Build Collaborative Planning Calendar 
(concurrent process), 22-18
business flow

demand-to-make/demand-to-buy, 3-2
inquiry-to-order, 3-3

business flows, 3-1
by-products, 9-4

C
Calculate Cumulative Lead Time concurrent 
process, 6-79
Calculate Manufacturing Lead Time concurrent 
process, 6-79
Calculate Resource Availability (concurrent 
process), 22-18
calendar

carrier, 6-144
hierarchy, 6-144
receiving, 6-144
shift times, 6-148
shipping, 6-143
supplier capacity, 6-144

calendars
shipping receiving carrier supplier capacity, 6-
142

capacity
adding, 18-168

capacity changes, 9-17
capacity tolerance, 6-21
centralized planning, 4-8
chaining-multiple levels of substitution, 12-14
Changes recommended for sales orders, 17-23
checking status of an online planner session, 7-5
choosing plan classes

constraints, 5-31
enforce capacity constraints, 5-31
enforce demand due dates, 5-31
optimization, 5-31

collections, 4-1, 10-22, 11-2
and resource usage, 9-19
architecture, 4-6
configure to order, 10-22
continuous, 4-20
definitions, 4-3
legacy systems, 4-23
methods, 4-9
net change, 4-16
running, 3-5
standard, 4-10
strategy, 4-4

Collections Synonyms (concurrent process), 22-
19
collection strategy

data consolidation, 4-5
detect net change, 4-5
multi-process collection architecture, 4-5
projects/tasks and Seiban numbers, 4-6
pull architecture, 4-4

Collections Triggers (concurrent process), 22-19
Collections Views (concurrent process), 22-20
Collection Workbench, 4-4
combining objectives, 5-145
common planner tasks
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a day in the life of a planner, 3-3
Compare Plan Exceptions (concurrent process), 
22-20
comparing KPIs for multiple plans, 18-149
Components window, 18-139, 18-139
concurrent processes

Analyze Plan Partition, 22-17
ATP 24x7 Switch Plans, 22-15
ATP 24x7 Synchronization Process, 22-15
atp post plan processing, 22-16
Auto Release Planned Order, 22-17
Build Collaborative Planning Calendar, 22-18
Calculate Cumulative Lead Time, 6-79
Calculate Manufacturing Lead Time, 6-79
Calculate Resource Availability, 22-18
Collections Synonyms, 22-19
Collections Triggers, 22-19
Collections Views, 22-20
Compare Plan Exceptions, 22-20
Continuous Collections, 22-21
Create AHL Snapshots, 22-23
Create APS Partitions, 22-24
Create ATP Partitions, 22-24
Create BOM Snapshots, 22-25
Create Forecast Priority Flexfield, 22-26
Create Instance-Org Supplier Association, 22-
27
Create Inventory Planning Flexfields, 22-28
Create INV Snapshots, 22-26
Create MRP Snapshots, 22-28
Create OE Snapshots, 22-29
Create Planning Flexfields, 22-30
Create PO Snapshots, 22-29
Create Resource Batch Planning Flexfields, 22-
31
Create Setup and Run Flexfield, 22-31
Create WIP Snapshots, 22-32
Create WSH Snapshots, 22-33
Create WSM Snapshots, 22-33
Create Zone Flexfields, 22-34
Custom Exception Generator, 22-34
Detail Scheduling Continuous Collection, 22-
35
Detail Scheduling Data Pull, 22-35
Detail Scheduling ODS Load, 22-35
Download Profile Options Value, 22-35
Drop Collections Snapshot, 22-36

ERP Legacy Collections Request Set, 22-37
Flat File Loader, 22-37
Launch Supply Chain Planning Process 
Request Set, 22-40
Legacy Collections Request Set, 22-42
Load ATP Summary Based on Collected Data, 
22-42
Load ATP Summary Based on Planning 
Output, 22-43
Load Transaction Data, 22-44
MDS Data Collection, 22-45
Planning Data Collection - Purge Staging 
Tables, 22-46
Planning Data Collection Request Set, 22-46
Planning Data Pull, 22-47
Planning ODS Load, 22-49
Pre-Process Monitor, 22-50
Pre-Process Transaction Data, 22-52
Purge Collaborative Planning Historical 
Records, 22-52
Purge Designator, 22-53
Purge Interface Tables, 22-53
Purge Legacy Data, 22-54
Push Plan Information, 22-55
Realign Operational Data Stores Dates, 22-60
Refresh Allocation Hierarchy Materialized 
View, 22-61
Refresh Collection Snapshots, 22-61
Refresh Global Forecast Materialized Views, 
22-62
Refresh KPI Summary Data, 22-63
Refresh Materialized Views, 22-63
Register Ask Oracle Planning Question, 22-64
Release Sales Order Recommendations, 22-63
Rollup Cumulative Lead Time, 6-79
Send XML Releases to Legacy Sources, 22-64
Supply Chain Event Manager, 22-65
VMI Replenishment Engine, 22-68

configuration
hardware, 2-1

configurations
supported, 4-7
support for, 4-6

configure to order
collections, 10-22
forecast consunption, 10-21
forecast explosion, 10-9
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models, 10-4
order promising, 10-5
planning process, 10-23
sales orders, 10-4

conflict between choice to create supplies and 
enabling item in an organization, 12-18
conflicts related to enforce demand due dates 
plan, 12-18
constrained plans

look-ahead heuristic, 9-32
rules, 9-32
shift times, 9-34
user-defined alternate decision rules, 12-39

constrain new orders only, purchase order 
placed early scheme, 6-25
constrain new orders only scheme, 6-23
constraint

enforce purchasing lead-time, 9-30
constraint-based planning

overview, 9-1
constraint-based planning rules

look-ahead heuristic, 9-32
constraints

disabling, 9-27
enabling, 9-27
hard, 9-28
item lead time, 17-134
partial demand satisfaction, 9-39
phantom routings, 9-40
plan type differences, 9-28
rules, 9-32
shared supplies, 9-42
soft, 9-28
split planned orders, 9-41

constraints firm work orders, 9-42
constraint types, 9-2

demands, 9-2
items, 9-2, 9-3

BOMs, 9-3
by-products, 9-4
coproducts, 19-80
ECOs, 9-3
order modifiers, 9-5
product families, 9-5
substitute components, 9-4

lot-based jobs, 19-79
manufacturing resources, 9-2, 9-11

sourcing, 9-26
sourcing constraints, 9-2
suppliers, 9-2, 9-26
transportation resources, 9-2, 9-26

consumption
forecast, 5-85
forecast bucket, 5-93

continuous collections
running, 4-22

Continuous Collections (concurrent process), 22-
21
continuous data collection, 4-4
control files

demand, C-4
keys, C-5
setup data, C-1
supplies, C-4
supply, C-4
user-defined keys, C-5

controlling planned items, 5-153
co-products, 19-9

process manufacturing, 19-60
shop floor manufacturing, 19-81

Co-product window, 18-145
copying a horizontal plan, 18-58
copying a production schedule, 20-37
cost breakdown, 12-72
Create AHL Snapshots (concurrent process), 22-
23
Create APS Partitions (concurrent process), 22-24
Create ATP Partitions (concurrent process), 22-24
Create BOM Snapshots (concurrent process), 22-
25
Create Forecast Priority Flexfield (concurrent 
process), 22-26
Create Instance-Org Supplier Association 
(concurrent process), 22-27
Create Inventory Planning Flexfields (concurrent 
process), 22-28
Create INV Snapshots (concurrent process), 22-26
Create MRP Snapshots (concurrent process), 22-
28
Create OE Snapshots (concurrent process), 22-29
Create Planning Flexfields (concurrent process), 
22-30
Create PO Snapshots (concurrent process), 22-29
Create Resource Batch Planning Flexfields 
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(concurrent process), 22-31
Create Setup and Run Flexfield (concurrent 
process), 22-31
Create WIP Snapshots (concurrent process), 22-
32
Create WSH Snapshots (concurrent process), 22-
33
Create WSM Snapshots (concurrent process), 22-
33
Create Zone Flexfields (concurrent process), 22-
34
creating and launching a global supply chain 
plan, 5-4
creating a plan, 3-5
creating a production schedule, 20-19
creating demand priority flexfield numbers 
manually, B-3
creating profile, B-4
cross-instance

pegging, 11-13
cross-instance lead-times

create, 11-4
maintain, 11-4
view, 11-4

cross instance planning
collections, 11-10

cross-instance planning, 11-1
available to promise, 11-8
collections, 11-2
execution, 11-8
instances, 11-1
plan setup, 11-7
purchase orders, 11-13
sales orders, 11-13
supply chain modeling, 11-3

cross-instance sourcing relationships
define, 11-4

cross-instance supply chain modeling
customers, 11-5
intransit lead-time, 11-4
sourcing, 11-4
suppliers, 11-5

cumulative manufacturing lead-time, 6-78, 6-79
cumulative total lead-time, 6-78, 6-79
customer lists, 16-32
customer-specific substitution rules, 12-22
Custom Exception Generator (concurrent 

process), 22-34
custom rows, 18-57
cycle, planning, 3-3

D
daily load consolidation

distribution, 13-6
data collection

architecture, 4-6
collection strategy, 4-4
multiple source instances, 4-4
setting up, 4-10
simplified architecture, 4-9

data collection see Collections, 4-1
data consolidation, 4-5
days late, 6-99
decentralized planning, 4-7
decreasing demands, 5-149
decreasing items, 5-148
decreasing resources, 5-148
defining a priority rule, 5-67
defining bills of material for kitting, 13-3
defining demand priority rules, 13-5
defining graphs, 18-58, 18-58, 18-59
defining items as distribution planned, 13-2
defining plans, 5-1

choosing plan classes, 5-31
controlling aggregation levels, 5-137
global supply chain planning and subset 
planning, 5-7
setting plan options, 5-37

defining sourcing rules, 13-9
delays

demand satisfaction
item lead time constraints, 17-134

demand
pegging, 3-8

demand class, 5-86
demand control files, C-4
demand dates

days late, 6-99
request date, 6-97
suggested due date, 6-97
viewing in workbench, 6-96

demand due date
transfer calculation, 6-89
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demand management, 19-35
demand priority rules, 5-66
Demand quantity not satisfied exception 
message, 17-40
demands

decreasing, 5-149
Demand satisfied using end item substitution 
exception message, 17-101
demand sources, 3-4
demand to supply planning

automation
setup, 12-79

destination instance, 11-2
setup, 2-10

Destinations window, 18-119, 18-119
Assignment tabbed pane, 18-121
Effectivity Dates tabbed pane, 18-120
Sourcing tabbed pane, 18-120

Detail Scheduling Continuous Collection 
(concurrent process), 22-35
Detail Scheduling Data Pull (concurrent process),
22-35
Detail Scheduling ODS Load (concurrent 
process), 22-35
discrete jobs

firm, 9-42
planning time fence logic, 6-95
reschedule within time fence, 9-19
rescheduling

data consistency while rescheduling, 9-
21

resource usage, 9-19
scheduling, 6-126
scheduling in constrained - enforce capacity 
constraints plan, 6-129
scheduling in constrained - enforce demand 
due dates plan, 6-131
scheduling in unconstrained plan, 6-127
scheduling with firm operations and orders, 6-
132

displaying the Find window, 18-163
displaying the pegging tree, 18-111
displaying your plan horizontally, 18-124
displaying your plan vertically, 18-64
distribution

load consolidation
daily, 13-6

distribution planning
aggregation tabbed region, 14-9
customer lists, 16-32
daily allocation buckets, 14-9
defining bills of material for kitting, 13-3
defining items as distribution planned, 13-2
defining sourcing rules, 13-9
demand priority rules, 13-5
global forecasting, 15-1
high volume, 13-27
inventory rebalancing, 13-19
main tabbed region, 14-2
multiple inventory policies, 13-9
multi-processing, 13-27
organization selection lists, 15-47
organizations tabbed region, 14-16
overview, 1-3
plan options, 14-1
prerequisites, 13-2
set up overview, 13-1
ship method selection, 15-2
supply allocation rules, 13-25
trip consolidation days, 14-9
trip identifiers, 14-9
trip limits for ship methods by lane, 13-6

distribution plan options, 14-1
dock date, 6-78
Download Profile Options Value (concurrent 
process), 22-35
Drop Collections Snapshot (concurrent process), 
22-36
DRP

See distribution planning
due date, 6-78

E
earliest completion date, 17-126
earliest dates, 17-123
earliest order date, 17-124
earliest possible demand satisfied date, 17-127
early builds

preventing, 19-77
Early replenishment for forecast exception 
message, 17-21
Early replenishment for sales order exception 
message, 17-20
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ECC plans, 9-46
ECO

See engineering change orders, 9-56
ECOs, 9-3
EDD plans

See enforce demand due date plans, 9-46
effectivity, 19-40, 19-41
effectivity (time phasing), 12-21
effectivity in the BOM, 19-20
efficiency, 9-18
elongation factor, 9-38
enabling and disabling constraints, 9-27
end-item-level substitution

breadth-first search, 12-13
chaining-multiple levels of substitution, 12-14
conflict between choice to create supplies and 
enabling item in an organization, 12-18
conflicts related to enforce demand due dates 
plan, 12-18
customer-specific substitution rules, 12-22
effectivity (time phasing), 12-21
enforce sourcing splits and substitute supply 
across the supply chain, 12-14
examples illustrating substitution logic, 12-26
exception messages, 12-35
features, 12-15
general substitution examples, 12-31
optimization, 12-35
Oracle Global Order Promising, 12-39
overview, 12-1
partial order fulfillment, 12-20
preference for generating planned orders, 12-
16
process, 12-2
processing logic, 12-12
reciprocal-unidirectional and bidirectional 
substitution, 12-16
resolving conflict between item attributes and 
profile options, 12-17
search direction and transferring demands, 12-
32
search the supply chain for substitution, 12-12
simulate possible substitution, 12-24
substitution chain, 12-10
substitution logic, 12-12
substitution relationship, 12-2
transfer of demands on to substitute supplies, 

12-25
viewing substitution display, 12-10
window for substitution, 12-18
workflow for planning, 12-37

enforce capacity constraints plans, 9-46
enforce capacity constraints scenario, 5-150
enforce demand due date plans

scheduling, 9-46
enforce demand due dates scenario, 5-150, 5-150
Enforce Purchasing Lead-time constraint, 9-30
enforce sourcing splits, 6-45
enforce sourcing splits and substitute supply 
across the supply chain, 12-14
engineering change orders

use-up effectivity date, 9-56
enhanced exceptions, 17-117
ERP Legacy Collections Request Set (concurrent 
process), 22-37
examples illustrating substitution logic, 12-26
examples of how user-defined alternate decision 
rules are used, 12-46
exceeding resource capacity, 8-13
exception

change requests from suppliers, 12-79
early replenishment from supplier, 12-79
excess replenishment from supplier, 12-79
late replenishment from supplier, 12-79
short supply from supplier, 12-79

exception details
days late column, 17-11, 18-50

exception groups
item exceptions, 17-106
late sales orders and forecasts, 17-14
material and resource capacity, 17-45
projects/tasks, 17-103
recommendations, 17-115
reschedules, 17-77
shortages and excess, 17-72
substitutes and alternates used, 17-97
supply problems for late sales orders and 
forecasts, 17-24
transportation and distribution, 17-64
transportation management exceptions, 17-113

exception groups (collection of exception 
messages), 17-2
Exception groups (exception message filters), 17-
5
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exception message
demand satisfied using end item substitution, 
12-35

exception messages, 17-1
Batch was started with less than minimum 
capacity, 17-57
Batch was started with more than maximum 
capacity, 17-60
causes of late demands, 17-121
Changes recommended for sales orders, 17-23
comparing plans, 17-139, 22-3
constraint exceptions, 17-118
Demand quantity not satisfied, 17-40
Demand satisfied using end item substitution, 
17-101
details of each, 17-14
diagnosis, 17-117
Early replenishment for forecast, 17-21
Early replenishment for sales order, 17-20
end-item-level substitution, 12-35
exception groups, 17-2
filtering, 17-5
forecast expiration, 9-61
implementing, 17-139
Items allocated across projects/tasks, 17-105
Items below safety stock, 17-75
Items with a shortage, 17-73
Items with a shortage in a project/task, 17-104
Items with excess inventory, 17-76
Items with excess inventory in a project/task, 
17-105
Items with expired lot, 17-108
Items with negative starting on hand, 17-107
Items with no activity, 17-108
late demands, 17-121
Late replenishment for forecast, 17-19
Late replenishment for MPP/MPS demands, 
17-22
Late replenishment for sales order, 17-18
Late supply pegged to forecast, 17-40
Late supply pegged to sales order, 17-41
Material constraint, 17-47
online simulation, 17-138
operation hard link violation, 17-61
Order causes supplier capacity overload, 17-32
Order causes transportation volume capacity 
overload, 17-34

Order causes transportation weight capacity 
overload, 17-33
Order lead time constraint, 17-37
Order sourced from alternate facility, 17-100
Order sourced from alternate supplier, 17-101
Orders scheduled to next inventory point, 17-
87
Orders to be cancelled, 17-82
Orders to be rescheduled in, 17-84
Orders to be rescheduled out, 17-81
Orders with compression days, 17-85
Order with insufficient lead time, 17-35
Past due forecast, 17-17
Past due orders, 17-80
Past due sales orders, 17-17
Planned order uses alternate BOM/routing, 17-
98
Planned order uses alternate resources, 17-99
Planned order uses substitute components, 17-
99
Recommendations, 17-116
Requirement causes resource overload, 17-29
Requirement lead time constraint, 17-38
Requirement with insufficient lead time, 17-36
resolution, 17-117
resolution suggestions, 17-14
Resource constraint, 17-50, 17-89, 17-91, 17-92, 
17-94, 17-95
Resource overloaded, 17-52
Resource underloaded, 17-55
reviewing, 3-6
Sales order/forecast at risk, 17-15
Sales order/forecast at risk due to material 
shortage, 17-27, 17-28
simulation, 17-138
Supplier capacity overloaded, 17-54
Supplier split percentage violated, 17-109
Transportation resource's volume overloaded, 
17-70
Transportation resource's weight overloaded, 
17-68
Transportation resource constraint, 17-65, 17-
67
user-defined alternate decision rules, 12-65
viewing, 17-9, 17-117
workflow, 17-117

exceptions
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enforce capacity constraints related 
exceptions, 17-118
enhanced, 17-117
firming related exceptions, 17-119
late demands, 17-121

late replenishment for forecasts, 17-121
late replenishment for sales order, 17-121

lead-time related exceptions, 17-118
overload related exceptions, 17-118
See exception messages, 17-1
sorting, 17-10, 18-49

exceptions, resolving, 17-117
exceptions details

viewing, 17-11, 18-49
exception sets, 17-6

assigning, 17-7, 17-7
creating and updating, 17-7

excess demand
planned order to sales order

Accept Demands from Unmet PO flag, 
11-13

exporting plan results, 5-71
exporting to excel, 5-71
export to excel, 18-149

F
factors affecting objectives, 5-145
fair share allocation, 16-18
fictitious demand, 9-76
filtering

exception messages, 17-5
Find Requests, 4-23
Find window

displaying, 18-34, 18-163
firm discrete jobs, 9-42
firming an operation, 18-168
firming orders, 3-12
firm planned orders

creating and implementing, 18-151
firm work orders constraint, 9-42
fixed days supply, 9-6
fixed lead-time, 6-77, 6-79
fixed lot multiple, 9-6
fixed lot multiplier, 13-28
fixed order quantity, 9-6
flags

Operation Resource Schedule, 6-49
Flat File Loader (concurrent process), 22-37
flexfield attributes, A-1
flexfield numbers

creating manually, B-3
flexfields

applying to database, B-2
list, B-1
transportation capacity, B-3

flexible shift times, 9-34
elongation factor, 9-38

flexible tolerance fences, 6-21
flow line scheduling, 19-21
flow manufacturing

See Oracle Flow Manufacturing, 19-33
flow schedules, 19-34

planning time fence logic, 6-96
release, 19-36

forecast
explosion, 10-7
forecast expiration

forecast expiration with online and batch
replan, 9-63

forecast bucket consumption, 5-93
forecast consumption

configure to order, 10-21
viewing, 5-91

forecast consumption days, 5-86
forecast expiration, 5-93, 9-59

controlling late replenishments, 9-62
demand priority, 9-63
exception messages, 9-61
implementing, 9-61
setup, 9-59
viewing results, 9-60

forecast explosion
configure to order, 10-9
logic, 10-7

forecast priorities
setting, 20-16

forecasts, 5-74
bucket consumption, 5-93
consumption, 5-85
expiration, 9-59
overview, 5-74
past due, 5-74
spreading, 5-95
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Forecast Schedule Association form, 19-59
forecast spreading, 5-95

considerations, 5-98
setup, 5-96

form-based application, 4-36
formulas, 19-40, 19-41
fractional dependent demands, 9-9
fractional supply order quantities, 9-8

G
Gantt chart, 18-159

firming operations, 18-168
icon options, 18-169
operations, 18-167, 18-168, 18-168
order-centric view, 18-160
overload, 18-168
reschedule operations, 18-167
resolving overload, 18-168
resource-centric view, 18-161
right-click menu, 18-164
supplier capacity view, 18-162
time buckets, 18-166
view operations, 18-165
view resources, 18-166

Gantt Chart
accessing, 18-159
Find window, 18-163
user preferences, 18-162

Gantt chart pegging, 18-171
general substitution examples, 12-31
generating models

submitting, 20-35
generating models on the server, 21-21
generating planned orders, 19-20
global forecasting, 5-107

distribution planning, 15-1
examples, 5-119
global forecast consumption, 5-109
global forecast distribution, 5-115
global forecast explosion, 5-108
lower level pre-configuration consumption, 5-
114

global supply chain and subset plans
choosing between, 5-7

global supply chain plan, 5-7
creating and launching, 5-4

running, 5-3
global supply chain planning, 5-2

create plans, 5-4
decision points, 5-3, 5-7, 5-7
prerequisites, 5-3
single plan, 5-3, 5-7
subset planning, 5-7
subset plans, 5-6, 5-7

glossary, Glossary-1
graphs

changing number of periods, 18-59
choosing types of, 18-59
defining, 18-58
defining dynamically, 18-58, 18-59

group netting, 19-17

H
hard and soft constraints

setting, 9-28
hard pegging, 19-15

supply chain planning with, 19-16
hardware configuration, 2-1
heuristics, 9-32
high volume distribution planning, 13-27
historical demand

allocating demand according to, 6-35
horizontal plan

copy, 18-58
custom rows, 18-57
preferences

hide or show graph, 18-59
hide or show options for a row, 18-59
set column width and row height of data
cells, 18-59

save preferences, 18-59
save preferences for viewing, 18-59

hub and spoke planning, 5-9

I
implementing planning recommendations, 18-
151
implicit objectives, 5-144
increasing inventory turns, 12-76
increasing margin percentage, 12-76
increasing on-time delivery, 12-77
increasing planned utilization, 12-76
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instances, 11-1
integrating

production scheduling, 20-36
integration

demand management, 19-102
sales and operations planning, 19-103

interactive scheduling, 18-159
inventory carrying costs percentage, 8-13
inventory rebalancing, 13-19
inventory turns, 5-142, 12-70, 18-147
inventory value, 12-74
item definition, 9-3
item exceptions exception group, 17-106
item lead time constraints, 17-134
item planning information, 18-149
item relationship

cross-sell, 5-58
substitution, 5-58
up-sell, 5-58

items
decreasing, 5-148
planned order creation, 9-4

Items allocated across projects/tasks exception 
message, 17-105
Items below safety stock exception message, 17-
75
Items window, 18-114, 18-114

buttons, 18-118
description of fields, 18-114
right-click menu options, 18-119
viewing, 18-114

Items with a shortage exception message, 17-73
Items with a shortage in a project/task exception 
message, 17-104
Items with excess inventory exception message, 
17-76
Items with excess inventory in a project/task 
exception message, 17-105
Items with expired lot exception message, 17-108
Items with negative starting on hand exception 
message, 17-107
Items with no activity exception message, 17-108
item workflow, 3-7

J
jobs

lot-based, 19-79

K
key performance indicators

cost breakdown, 12-72
inventory turns, 12-70
inventory value, 12-74
making improvements, 12-76
margin, 12-72
margin percentage, 12-70
on-time delivery, 12-71
overview, 12-69
plan performance, 12-76
service level, 12-73
setup, 12-74
simulations, 7-8

key performance indicators see KPIs, 3-5
kitting, 13-3
KPIs

comparing multiple plans, 18-149
inventory turns, 18-147

calculation, 12-70
increasing, 12-76

margin percentage, 18-149
increasing, 12-76

on-time delivery, 18-148
increasing, 12-77

planned utilization, 18-148
calculation, 12-71
increasing, 12-76

reviewing, 3-5
reviewing item planning information, 18-149
viewing, 18-147, 18-147
viewing an enlarged version, 18-147

L
late demand

earliest possible completion time (EPCT), 17-
122
material constraints, 17-134
resource constraints, 17-134
viewing late demand information, 17-136

late demand penalty cost, 8-6
item level, 8-5
organization level, 8-5
plan level, 8-5
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late demands
latest possible start time (LPST), 17-121, 17-122

Late replenishment for forecast exception 
message, 17-19
Late Replenishment for MPP/MPS demands, 17-
22
Late replenishment for sales order exception 
message, 17-18
late sales orders and forecasts exception group, 
17-14
latest possible start time, 17-122
Late supply pegged to forecast exception 
message, 17-40
Late supply pegged to sales order exception 
message, 17-41
launching a plan, 3-5
Launch Supply Chain Planning Process Request 
Set (concurrent process), 22-40
lead time, 13-3

postprocessing, 19-77
lead-time, 6-77, 9-10

approved supplier list, 6-88
calculation examples, 6-104
concurrent processes, 6-79
cumulative manufacturing, 6-78, 6-79
cumulative total, 6-78, 6-79
dock date, 6-88
examples, 6-104
fixed, 6-77, 6-79
item attributes, 6-77
lead-time lot size, 6-78
manufactured item calculations, 6-86
manufactured supply component item 
calculation, 6-88
planned order demand due date, 6-84
postprocessing, 6-78
preprocessing, 6-77
processing, 6-78, 6-79, 6-88
purchased item calculations, 6-88
setting, 6-77
total, 6-82
transfer item calculations, 6-89
user-defined decision rules, 12-64
variable, 6-77, 6-79
viewing in workbench, 6-82

lead-time lot size, 6-78
lead times

safety, 6-79
legacy collection, 4-23

collect into ERP instance, 4-42
collect into legacy instance, 4-36
loading transaction data using flat files into 
ERP Instance, 4-41
non-Oracle ERP systems, 4-24
preprocessing, 4-32
process, 4-26
running, 4-35
setting up batch uploads, 4-27
setting up legacy instance, 4-35
transaction data, 4-25

Legacy Collections Request Set (concurrent 
process), 22-42
legacy system

data flow, 4-25
line design and balancing, 19-35
Load ATP Summary Based on Collected Data 
(concurrent process), 22-42
Load ATP Summary Based on Planning Output 
(concurrent process), 22-43
load consolidation

distribution
daily, 13-6

loading alternate resources, 18-168
Load Transaction Data (concurrent process), 22-
44
look-ahead heuristic, 9-32
look-ahead heuristic constraint, 9-32
lot-based job

future operation details, 19-96, 19-97
lot-based jobs, 19-79
lover level pre-configurations, 5-114

M
main tabbed region, 14-2
manufactured item lead-time calculations, 6-86
manufactured supply component item lead-time 
calculations, 6-88
manufacturing environments, 19-1
manufacturing resources

efficiency, 9-18
efficiency and utilization, 9-18
network routings, 19-94
operation yield, 19-88
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resource availability, 9-17
resources, 9-12

backward scheduling with fixed 
assigned units in scheduling, 9-14
backward scheduling with variable 
assigned units in scheduling, 9-13
forward scheduling with fixed assigned 
units in scheduling, 9-15

routings, 9-11
shifts, 9-16

capacity changes, 9-17
utilization, 9-18
workday calendar, 9-18

margin, 12-72
margin percentage, 5-142, 12-70, 18-149
master production schedule, 19-58
master scheduling, 5-22
material aggregation, 5-141
material aggregation levels

setting for a time horizon, 5-141
material and resource capacity exception group, 
17-45
Material constraint exception message, 17-47
material planning

cmro, 19-99
material scheduling method

manufactured supply component item 
calculation, 6-88

Material tabbed pane, 18-44
material workflow, 3-8
maximize inventory turns, 8-2
maximize on-time delivery, 8-2
maximize plan profit, 8-2
maximum allowable days late, 8-13
maximum inventory level, 13-9
maximum order quantity, 13-28
MDS Data Collection (concurrent process), 22-45
microsoft excel

exporting to, 5-71
minimum and maximum order quantity, 9-6
minimum transfer quantity, 6-49
min possible days late, 17-133
mixed mode manufacturing, 19-1, 19-2

common features, 19-2
efficiency, 19-5
Oracle Flow Manufacturing, 19-33
Oracle Project Manufacturing, 19-14

phantom routings, 19-3, 19-5
routing effectivity, 19-6
utilization, 19-5

model/unit effectivity
effectivity in the BOM, 19-20
flow line scheduling, 19-21
model unit number, 19-20
pegging, 19-21
Planner Workbench, 19-21
unit numbers in sales orders, 19-20
WIP mass/load PO requisitions interface, 19-
21

modeling demand at the customer or zone level, 
21-16
models

configure to order, 10-4
model unit number, 19-20, 19-21

generating planned orders, 19-20
modifying resources, 3-10
modifying supply and demand, 3-10
modify objectives, 3-9
modify supplier parameters, 3-11
MRP Planning Type item attribute, 5-28
multi-instance data collection, 11-10
multiple inventory policies, 13-9
multi-process collection architecture, 4-5
multiresource scheduling, 6-71

using, 6-71

N
need by date, 6-83, 6-100, 6-101

manufacturing calculation, 6-86
purchasing calculation, 6-88
transfer calculation, 6-89

nervousness, 5-150
net availability, 19-5
net change, 4-5
net change online replan, 3-11
net change planning, 3-11
net change replan, 7-3, 7-4
network routings, 19-94

primary path, 19-94
Network Routing window, 18-143

O
objective functions, 5-142
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choosing, 5-142
combining objectives, 5-145
computational burden, 5-148
factors affecting, 5-145
implicit objectives, 5-144
inventory turns, 5-142
margin percentage, 5-142
nervousness, 5-150
on-time delivery, 5-143
optimized plan data requirements, 5-149
optimized plan sourcing effects, 5-150
plan profit, 5-142

old dock date, 6-84, 6-102
old due date, 6-84, 6-102
on-hand quantities, 9-76
online planner, 7-3

batch mode planner, 7-3
online planner session

checking status, 7-5
stopping, 7-6

online replan, 9-63
running, 7-5

on-time delivery, 12-71, 18-148
on-time delivery objective, 5-143
operation, 18-167

firming, 18-168
rescheduling, 18-168

Operational Data Store (ODS), 4-3
Operational Data Store (ODS) Load, 4-2
operation hard link violation exception message, 
17-61
Operation Resource Schedule flag, 6-49
operations

firming, 18-168
overload, 18-168
rescheduling, 18-167
viewing, 18-165

operation yield, 19-88
optimization

comparing plans, 8-13
maximize inventory turns, 8-2
maximize on-time delivery, 8-2
maximize plan profit, 8-2
objectives, 3-9, 8-2

See also KPIs, 8-2
overview, 8-1
plan types, 3-9

See also plan classes, 5-33
optimization and end-item-level substitution, 12-
35
optimization effects

enforce capacity constraints scenario, 5-150
enforce demand due dates scenario, 5-150, 5-
150

optimization see also KPIs, 3-9
Optimization tab, 8-5
optimized plan

running, 3-9
optimized plans

user-defined alternate decision rules, 12-53
Oracle Advanced Planning and Scheduling

instance, 11-1
shop floor scheduling

efficiency and utilization, 9-18
Oracle Advanced Planning Suite, 1-1
Oracle Advanced Supply Chain Planning

capacity planning, 19-5
introduction, 1-1

Oracle Applications Data Store (ADS), 4-3
Oracle ASCP Flexfields, B-1
Oracle Collaborative Planning, 1-1, 12-79, 12-80, 
18-172
Oracle Complex Maintenance, Repair, and 
Overhaul

asset intensive planning, 19-109
Oracle Demand Planning, 1-1
Oracle Enterprise Asset Management

asset intensive planning, 19-104
Oracle Flow Manufacturing, 19-33, 19-34, 19-34, 
19-35

demand management, 19-35
product families, 19-36

Oracle Global Order Promising, 1-1, 12-39
Oracle iSupplier Portal

need by date, 12-78
promise date, 12-78

Oracle Manufacturing Scheduling, 1-1
resource usage, 9-19

Oracle Process Manufacturing, 19-37
contiguous operations, 19-47
effectivities, Oracle Process Manufacturing

formulas, 19-40, 19-41
master production schedule, 19-58
merged organization structure, 19-38
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OPM data for Oracle ASCP, 19-60
organizations, 19-41
organization structure, 19-37, 19-39
production details, 19-38
resources, 19-53
resource warehouse, 19-40
routings, 19-40, 19-41
set up, 19-41
unit of measure, 19-41

Oracle Production Scheduling, 1-1
Oracle Project Manufacturing, 19-14

assemble-to-order environment, 19-15
borrow payback, 19-17
default project, 19-18
engineer-to-order (ETO), 19-15
exception messages, 19-27
group netting, 19-17
hard pegging, 19-15, 19-16
implementation, 19-28
model/unit effectivity, 19-20
planning logic, 19-30
project planning, 19-16
safety stock, 19-21
Seiban production, 19-15
serial effectivity, 19-20
setup, 19-28
soft pegging, 19-15
supplies pegged to excess, 19-18
viewing plans, 19-33

Oracle Purchasing
dock date

need by date, 12-78
promise date, 12-78

Oracle Shop Floor Management, 19-78
coproducts

coproducts, 19-80
lot-based jobs, 19-79
network routings, 19-94
operation yield, 19-88

Oracle Strategic Network Optimization, 1-1
Oracle Workflow, 19-27

item workflow, 3-7
material workflow, 3-8
notifications, 3-7
project workflow, 3-8
rescheduling workflow, 3-8
sales order workflow, 3-8

Order causes supplier capacity overload 
exception message, 17-32
Order causes transportation volume capacity 
overload exception message, 17-34
Order causes transportation weight capacity 
overload exception message, 17-33
order date, 6-78
order dates

dock date, 6-78
due date, 6-78
order date, 6-78
start date, 6-78

Order lead time constraint exception message, 
17-37
order modifier item attribute

round order quantities, 9-8
order modifiers, 9-5, 13-28

fixed days supply, 9-6
fixed lot multiple, 9-6
fixed order quantity, 9-6
minimum and maximum order quantity, 9-6
rounding order quantities, 9-7

order promising
configure to order, 10-5

orders
firming, 3-12
releasing, 3-12

order size, 13-3
Order sourced from alternate facility exception 
message, 17-100
Order sourced from alternate supplier exception 
message, 17-101
Orders scheduled to next inventory point 
exception message, 17-87
Orders to be cancelled exception message, 17-82
Orders to be rescheduled in exception message, 
17-84
Orders to be rescheduled out exception message, 
17-81
Orders with compression days exception 
message, 17-85
Order with insufficient lead time exception 
message, 17-35
organizations, 19-37, 19-39
organization security, 12-65

example, 12-68
organization validation, 12-67
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plan names, 12-67
Plan Options form, 12-67
process, 12-66

organization selection lists, 15-47
organization specific collections, 4-44

single source to multiple destinations, 4-46
organizations tabbed region, 14-16
Organization window

setting up, 2-13
original need by date, 6-84
outbound ship method, 6-17
overwrite all, append planned orders, 5-61
overwrite none, append planned orders, 5-64
overwrite none, do not append planned orders, 
5-65
overwrite option

planning time fence, 6-91
overwrite options, 5-61
overwrite outside planning time fence, 5-62

P
page

Collaborative Planning Suite, 4-37
Oracle Collaborative Planning Suite

Load Data Files, 4-43
pages

web tools, 18-149
Parameters, 4-23
partial demand satisfaction constraint, 9-39
partial order fulfillment, 12-20
past due forecast

include in plan, 5-74
Past due forecast exception message, 17-17
Past due orders exception message, 17-80
Past due sales orders exception message, 17-17
pegging, 3-8, 5-69, 18-83, 19-15, 19-16, 19-17, 19-
21

cross-instance, 11-13
firm supply allocation window, 18-94
fractional demand quantities, 9-9
modes, 18-85
safety stock, 18-105
sizing demand and supply windows, 18-95
user-defined decision rules, 12-65
viewing pegging information, 18-111

Pegging

Gantt chart view, 18-171
pegging mode

FIFO, 18-100
priority, 18-91
priority and FIFO/priority comparison, 18-103
standard, 18-86

pegging tree, 18-111
displaying, 18-111

penalty costs, 8-13
exceeding material capacity, 8-12
exceeding resource capacity, 8-12
exceeding transportation capacity, 8-12
late demand, 8-12

penalty costs vs. penalty factors, 8-3
penalty factors

exceeding material capacity, 8-6, 8-6
exceeding resource capacity, 8-9, 8-9
late demand, 8-3
late demand penalty costs, 8-3
setting, 8-2
setting penalty factors for exceeding material 
capacity at the item level, 8-8
setting penalty factors for exceeding material 
capacity at the organization level, 8-8
setting penalty factors for exceeding material 
capacity at the plan level, 8-8
setting penalty factors for exceeding resource 
capacity at the organization level, 8-11
setting penalty factors for exceeding resource 
capacity at the plan level, 8-11
setting penalty factors for exceeding resource 
capacity at the resource level, 8-10
setting through plan options, 8-11
setting using profile options, 8-12
setting using the Optimization tab, 5-55

penalty factors for exceeding material capacity
profile option, 8-9

penalty factors for exceeding resource capacity
profile option, 8-11

phantom routings, 19-3, 19-5
phantom routings constraint, 9-40
PIP

see planned inventory points, 9-73
plan

viewing undo summary, 7-6
plan classes

choosing, 5-31
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constraints, 5-31
enforce capacity constraints, 5-31
enforce demand due dates, 5-31
material and resource constrained, 5-31, 5-32
material constrained, 5-31, 5-32
optimization, 5-31
optimized, 5-31, 5-33
resource constrained, 5-31, 5-32
unconstrained, 5-31, 5-32

plan comparisons
view, 22-5

plan constraints
earliest completion date, 17-126
earliest order date, 17-124
earliest possible demand satisfied date, 17-127
min possible days late, 17-133

plan dates
promise, 5-69
request, 5-69
schedule, 5-69

planing engine
and resource usage, 9-19

planned inventory point
using, 9-78

planned inventory points, 9-73
setup, 9-74

planned inventory points (PIP)
generate PIP orders exception, 9-77
job properties

Firm and Status, 9-77
planned items

controlling, 5-153
planned order creation, 9-4
planned orders

accessing and executing, 18-151
planning time fence logic, 6-94
split, 9-41
suggested dates, 9-37

Planned order uses alternate BOM/routing 
exception message, 17-98
Planned order uses alternate resources exception 
message, 17-99
Planned order uses substitute components 
exception message, 17-99
planned utilization, 18-148
planner workbench

adjusted resource hours, 9-19

overview, 18-1
resource efficiency, 9-19
resource hours, 9-19
resource utilization, 9-19
Select Worksheet (Export to Excel), 18-149
touchtime, 9-19

Planner Workbench, 18-44, 19-21
accessing from Oracle Collaborative Planning, 
18-172
BOM/Routing, 18-139
Component window, 18-139, 18-139
Co-product window, 18-145
cross-instance planned orders, 11-8
Destinations window, 18-119, 18-119

Assignment tabbed pane, 18-121
Effectivity Dates tabbed pane, 18-120
Sourcing tabbed pane, 18-120

drill down, 18-4
Exception Details window, 18-49, 18-49

navigate using buttons, 18-51
right-click menu options, 18-51

Exceptions icon, 18-5
Exception Summary window, 18-48
expand partial, 18-36
Expand Partial menu option, 18-36
Find window, 18-34

rolling dates search condition, 18-35
wildcard search condition, 18-35

firm planned orders, 18-151
Gantt Chart icon, 18-5
horizontal plan, 18-52

Copy Horizontal Plan menu option, 18-
58
description of fields, 18-53
exporting, 18-58

Horizontal Plan icons, 18-4
icons, 18-4
Icons, 18-4
Items icon, 18-5
Items window, 18-114, 18-114

buttons, 18-118
description of fields, 18-114
right-click menu options, 18-119
viewing, 18-114

key performance indicators, 12-76, 18-146
More icon, 18-5
multi-selecting nodes, 18-4
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Network Routing window, 18-143
Planning Detail report, 22-7
Process Effectivity window, 18-145
Properties window, 18-34
pull-down menus, 18-5
Queries Result window, 18-41
Queries tabbed pane, 18-36, 18-36

create query, 18-38
navigating, 18-36
Personal Queries node, 18-37
Public Queries node, 18-37
Query icons, 18-36
Query Result node, 18-37
view results, 18-40

Query icons, 18-4
recommendations, 18-151
releasing recommendations, 18-151
Resource Availability (Details) window, 18-
132

description of fields, 18-132
Resource Availability Summary window, 18-
131

buttons, 18-132
description of fields, 18-132

Resource Requirements window, 18-134, 18-
134
Resources window, 18-129

buttons, 18-131
right-click menu options, 18-131

right-click menu options, 18-5
Routing Operations window, 18-141
Safety Stock window, 18-127
Sources window, 18-121, 18-121

Assignment tabbed pane, 18-123
buttons, 18-124
Effectivity Dates tabbed pane, 18-123
Sourcing tabbed pane, 18-121

Substitution Chain window, 18-128
right-click menu options, 18-128

Supplier Administrator responsibility, 18-172
Supplier Capacity window, 18-124, 18-124

description of fields, 18-124
Supplier Capacity tabbed pane, 18-126
Supplier Flexfences tabbed pane, 18-126
viewing, 18-124

suppliers, 18-172
Supplier User responsibility, 18-175

Supplier Variability window, 18-126
Supply/Demand icon, 18-4
Supply/Demand region

right-click menu options, 18-82
Supply/Demand window, 18-64

Line tabbed pane, 18-80
Order tabbed pane, 18-66
Pegging icons, 18-112
Project tabbed pane, 18-81
Release Properties tabbed pane, 18-78
Sourcing tabbed pane, 18-80
viewing, 18-64

supply chain, 18-138
Supply Chain bill, 18-138
Tools menu, 18-5
using context windows

context synchronization, 18-48
vendor managed inventory supplies, 18-113
vertical plan, 18-64

display, 18-64
right-click menu options, 18-64

view by, 18-2
Actions, 18-3
Items, 18-3
Organizations, 18-3
Projects, 18-3
Resources, 18-3
Suppliers, 18-3

view horizontal plan, 18-52
view operations, 18-165
view payback demand, 19-17
view resources, 18-166
Where Used window, 18-144

planning
global forecasts, 5-114

planning business flows, 3-1
planning cycle, 3-3
Planning Data Collection - Purge Staging Tables 
(concurrent process), 22-46
Planning Data Collection Request Set (concurrent
process), 22-46
Planning Data Pull (concurrent process), 22-47
Planning Data Store (PDS), 4-3
Planning Detail report, 22-7
Planning Detail Report, 22-8
Planning Detail Report (Discoverer), 22-11
planning engine
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conditions when a non-firm open job is treated
as firm, 9-21

planning environments, 19-1
planning level, 17-134
planning modes, 5-33
Planning ODS Load (concurrent process), 22-49
planning process

configure to order, 10-23
planning recommendations

planning, 18-151
planning search logic for user-defined decision 
rules, 12-54
planning time fence, 6-91

calculation examples, 6-126
discrete jobs, 6-95
examples, 6-126
firm planned orders, 6-94
flow schedules, 6-96
logic for order types and supply types, 6-94
overwrite option, 6-91
planned orders, 6-94
planning time fence date, 6-91
planning time fence days, 6-91
profile options, 6-92
purchase orders, 6-94
purchase requisitions, 6-94
repetitive schedules, 6-95
setting, 6-91
viewing in workbench, 6-91

planning time fence constraints
constraints

planning time fence, 17-135
planning time fence date, 6-91

and plan type, 6-92
planning time fence days, 6-91
plan options

demand priority rules, 5-66
demand schedules, 5-57
forecast bucket consumption, 5-93
forecast consumption, 5-85
forecast spreading, 5-95
overwrite options, 5-61
pegging, 5-69
setting, 5-37
setting penalty factors, 8-11
viewing, 22-6

Plan Options

Optimization tab, 8-5
Plan Options form

Aggregation tabbed region, 5-44
Constraints tabbed region, 5-51
Decision Rules tabbed region, 5-55
Main tabbed region, 5-38
Optimization tabbed region, 5-54
Organizations tabbed region, 5-46
security, 12-67

Plan Options window
Reporting tabbed region, 5-56

plan profit objective, 5-142
plan results

exporting, 5-71
plans

automatic launch, 12-79
comparing, 17-139, 22-3
creating, 3-5
defining, 5-1
global supply chain, 5-2
launching, 3-5

plan type
and planning time fence date, 6-92

plan types, 3-9
choosing, 5-27
MRP Planning Type item attribute, 5-28
setting constraints, 9-28
unconstrained, 3-9

Plan Worksheets window, 5-71
postprocessing lead time

make item, 19-77
postprocessing lead-time, 6-78
preference for generating planned orders, 12-16
Preferences

gantt chart, 18-162
preprocessing lead-time, 6-77
Pre-Process Monitor (concurrent process), 22-50
Pre-Process Transaction Data (concurrent 
process), 22-52
prerequisites for distribution planning, 13-2
preventing early builds, 19-77
primary path

network routings, 19-94
priority rule

attaching, 5-68
defining, 5-67

Process Effectivity window, 18-145
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processing lead-time, 6-78, 6-79
process manufacturing

co-products, 19-60
supply tolerances, 19-62

procured models
supplier capacity, 10-25

product families, 9-5
product family, 19-36
production duration

manufacturing calculation, 6-87
purchasing calculation, 6-89

production schedules, 20-1
copying a schedule, 20-37
creating, 20-19
feeding back into ASCP, 20-39
publishing, 20-37
running as a service, 20-38
running from the Workbench, 20-34
running with ASCP, 20-3
running without ASCP, 20-7
setting schedule options, 20-20

production scheduling
integration, 19-122, 20-1

profile option
CRP: Spread discrete requirements, A-3
MSC: Allow Release of Planned Orders from 
Demand Schedule Plan, A-15
MSC: ATP Enforces Lead Time for ATO 
Models, A-19
MSC: PS - Snapshot Beginning Inventory, A-
55

profile options, 2-7, 2-7, 2-8, 2-10, 2-10, 2-10, 2-10, 
5-54, 5-144, 5-149, 5-150, 6-23, 6-45, 6-77, 6-91, 6-
92, 6-126, 8-3, 8-12, 8-12, 8-12, 12-17, 12-18, 12-18, 
20-8, 22-1, 22-1, 22-2, A-1

automatic calculations, A-1
CP HZ View Default Query, A-13
flexfield attributes, A-1
floating point precision, A-2
for strategic plans, 21-5
INV: Capable to Promise, 10-5, A-2
INV: External ATP, A-2
INV --> PROFILE OPTIONS, A-2
MRP

Explode Demand Through Phantom 
Component, A-6

MRP_NEW_PLANNER_BACK_COMPATABI

LITY, A-9
MRP: Activate OLP, A-3
MRP: ATP Assignment Set, A-3
MRP: ATP Database Link, 2-5, 2-10, A-3
MRP: Backlog Progress Timeout, A-3
MRP: Calculate Excess Exceptions on Time 
Fence, A-4
MRP: Calculate Plan Performance, A-4
MRP:Calculate Supply Demand, A-4
MRP: Category Set for Backlog Form, A-4
MRP: Combine Sugg Rep Schedules, A-4
MRP: Compute Sales Order Changes, A-4
MRP: Compute Standard Mandatory 
Components for ATO Models, A-4
MRP: Consume Fcst Set Summary, A-4
MRP: Consume Forecast, A-5
MRP: Consume MDS, A-5
MRP: Consume MPS, A-5
MRP: Create Time fence, A-5
MRP: Create Time Fence, 6-92, 6-93, 9-21
MRP: Cutoff Date Offset Months, A-5
MRP: Cutoff History Days, A-5
MRP: Debug Mode, A-5
MRP: Default Criteria Set, A-5
MRP: Default DRP Plan Name, A-6
MRP: Default Forecast Date, A-6
MRP: Default Forecast Name, A-6
MRP: Default Plan Name, A-6
MRP: Default Schedule Name, A-6
MRP: Default Sourcing Assignment, 10-4
MRP: Default Sourcing Assignment Set, A-6
MRP: Demand Time Fence Days, A-6
MRP: Enhanced Exception, A-6
MRP: Environment variable to set path for 
MRP files, A-6
MRP: Firm Internal Req Transferred to OE, 6-
92, 6-93, A-7
MRP: Firm Planned Order Time Fence, 6-92, 6-
93, 6-94, 9-21, A-7
MRP: Firm Requisitions within time fence, A-7
MRP: Include Schd Rcpts in Use-up, A-7
MRP: Include Substitute Components, A-8
MRP: Interface Table History Days, A-8
MRP: Maintain Original Schedule Version, A-
8
MRP: MPS Relief Direction, A-8
MRP: Net All Purchase Orders Prior To 
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Requisitions, A-8
MRP: Old Sales Orders Cutoff Days, A-9
MRP: Perform Planning Manager Functions in
Loads, A-9
MRP: Planner Batch Size, A-9
MRP: Planner Workers, A-9
MRP: Planning Manager Batch Size, A-9
MRP: Planning Manager Max Worker, A-10
MRP: Planning Manager Run First Time, A-10
MRP: Plan Revenue Discount Percent, A-9
MRP: Plan Revenue Price List, A-9
MRP: Purchasing By Revision, A-10
MRP: Purge Batch Size, A-10
MRP: Recommend action within Planning 
Time Fence, 6-94
MRP: Recommend Action within PTF, 6-92
MRP: Repetitive Past Due Supply Days, A-10
MRP: Requisition Load Group Option, A-11
MRP: Retain Dates Within Calendar 
Boundary, A-11
MRP: RHX Check Profile, A-12
MRP: Round Source Entries, A-12
MRP: Snapshot Pause for Lock (Minutes), A-
12
MRP: Snapshot Workers, A-12
MRP: Sourcing Rule Category Set, A-12
MRP: Time Fence Warning, A-12
MRP: Trace Mode, A-12
MRP: Use Direct Load Option, A-12
MRP: Use Ship Arrived Flag, A-13
MRP and CRP--> PROFILE OPTIONS, A-3
MSC: 64-bit Planner Platform, A-13
MSC: Action Allowed on ATP 24x7 Plan 
While Running, A-13
MSC: Aggregate Resource Name Flexfield 
Attribute, 2-8, A-14
MSC: Allocated ATP Forward Consumption 
Method, A-14
MSC: Allocation Assignment Category Set, A-
14
MSC: Allow Release of Planned Orders from 
Demand Schedule Plans, A-15
MSC: Anchor date for calculating remaining 
shelf life, A-16
MSC: Anchor dates for calculating operation 
yield, A-16
MSC: Apply Lot Modifiers in Weekly/Period 

Buckets, A-17
MSC: Apply Order Modifier To Start 
Quantity, A-17
MSC: Apply Safety Stock Change Interval to 
non MRP Planned Safety Stock, A-17
MSC: Apply shortage and excess tolerance 
percentages to planned orders, A-18
MSC: ASCP Planning URL, A-18
MSC: ATP Allocation Method, A-18
MSC: ATP Assignment Set, A-19
MSC: ATP Capacity Allocation, A-19
MSC: ATP Debug Mode, A-19
MSC: ATP Infinite Time Fence Pad, A-20
MSC: ATP Synchronization Downtime 
(minutes), A-20
MSC: Automatically Recalculate Operation 
Time, A-21
MSC: Auto-Release Compression Days 
Tolerance, A-21, A-21, A-
MSC: avoid re-sourcing sales orders, A-22
MSC: Buy Order Processing Lead Time 
Calendar, A-23
MSC: Cancel Outstanding Sales Order 
Quantities, A-23
MSC: Category set for CP Horizontal View, A-
23
MSC: Choice of item for which to create 
supplies in substitute relationship, 12-26
MSC: Choice of Item for Which to Create 
Supplies in Substitute Relationship, A-24
MSC: Choice of Items for which to Create 
Supplies in a Substitute Relationship, 12-17
MSC: Choice of Items for Which to Create 
Supplies in Substitute Relationship, 12-17
MSC: Circular sourcing surplus days, A-24
MSC: Circular Sourcing Surplus Inventory 
Basis, A-24
MSC: Class Hierarchy, A-24
MSC: Collaborative Planning Default 
Calendar, A-25
MSC: Collect CMRO Work Order Demand, A-
25
MSC: Collect Completed Jobs, 4-3
MSC: Collection Window for Trading Partner 
Changes (Days), A-26
MSC: Collect Item, Material and Resource 
Costs, A-25
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MSC: Collect Routing, A-25
MSC: Compute IB Aggregation during 
Collection, A-26
MSC: Compute Project Exception, A-27
MSC: Configuration, 12-81, A-27
MSC: Consume Forecast Inside Demand Time 
Fence, A-27
MSC: Consume forecast within demand time 
fence, 5-87, 5-89
MSC: Consume forecast with No demand 
class, A-28
MSC: Cost of Using a BOM/ Routing Flexfield 
Attribute, 2-9, A-28
MSC: Cost Type, A-29
MSC: CP Debug Level, A-29
MSC: Create resource requirements for all 
operations, A-29
MSC: Currency Conversion Type, 4-2, A-30
MSC: Daily Allocation to Maintain Safety 
Stock Level, A-30
MSC: Day UOM, A-30
MSC: Default Time Stamp for Make Planned 
Order Release, A-31
MSC: Default Workbench Height, A-31
MSC: Default Workbench Width, A-31
MSC: Degree of Parallelism for Index 
Creation, A-31
MSC: Demand Priority Flexfield Attribute, A-
31
MSC: Demand Satisfied Percent Threshold for 
Pegging, A-31
MSC: Display Order Scheduling Supplies, A-
32
MSC: Display Warning Message When 
Rescheduling Recommendation Not 
Suggested by the Plan, A-32
MSC: Distribution Planning Ship Date, A-33
MSC: DPP allocates to existing ISO's before 
other demands with the same priority (Days), 
A-33
MSC: DPP Discrete Job Cutoff Window 
(Days), 13-4, A-34
MSC: DPP Multitasking Group ID's per 
Process, A-34
MSC: DPP Multitasking Max Concurrent 
Processes, A-34
MSC: Enable Advanced Constraints, A-35

MSC: Enable Allocated ATP, A-35
MSC: Enable ATP for Phantom Components, 
A-35
MSC: Enable ATP Summary Mode, A-35
MSC: Enable ATP Workflow, A-36
MSC: Enable DPP Multitasking orders, A-36
MSC: Enable Enhanced Sourcing, A-36, A-38
MSC: Enable Group Based Netting, A-37
MSC: Enable User Defined Decision Rules, 9-
59
MSC: ENFORCE CRITERIA REQUIREMENT 
BEFORE EXECUTING QUERY, A-37
MSC: Enforce Hard Links, A-37
MSC: Enhanced Project Netting, A-38
MSC: Excess and Safety Stock by Demand 
Class, A-38
MSC: Explode in WIP when Details are not 
released, A-39
MSC: Fast Refresh of Region Site Map , A-39
MSC: File Flush Limit, A-39
MSC: Firm Internal Requisition Time Fence, 6-
92, 6-93, A-40
MSC: Firm Intransit and PO in Receiving 
Supplies, 6-93, A-40
MSC: Firm In-transit and PO in Receiving 
Supplies, 6-92
MSC: Forecast Priority Flexfield Attribute, A-
41
MSC: Forecast Spreading Calendar, 5-95, A-41
MSC: Future Days for Currency Conversion, 
4-2, A-41
MSC: Generate Notifications for 
Transportation Updates, A-41
MSC: High Volume Item, A-42
MSC: History Days for Currency Conversion, 
4-2, A-42
MSC: Horizontal Plan Demand Bucketing 
Preference, A-42
MSC: Horizontal Plan Extension Program, A-
42
MSC: Hour UOM, A-43
MSC: Ignore CMRO and EAM Work Orders 
for ASCP, A-43
MSC: Include Firm Planned Orders In Firm 
Allocation Window, A-43
MSC: Include Safety Stocks in Priority based 
Pegging, A-44
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MSC: Inflate WIP Resource Requirements, 9-
19, 9-20, 9-22, A-45
MSC: Inventory Rebalancing Surplus 
Inventory Basis, A-46
MSC: Launch Analyze Plan Partition, A-46
MSC: Launch Workflow-Enabled Exception 
Message Notifications, A-46
MSC: Legacy Collections Using Lot Based Job 
Details, A-47
MSC: Maximum Number of Planned Orders 
per Demand, A-47
MSC: Maximum Percentage variation in safety
stock values, 6-138, A-47
MSC: Minimize Project Cross Peg Within 
Window, A-48
MSC: Minimize Workorder crossovers during 
reschedules, A-48
MSC: Minimum Percentage variation in safety
stock values, 6-138, A-48
MSC: Minimum Supply/Demand Percent for 
Pegging, A-48
MSC: MPS Auto-Firm All Planned Orders, 6-
92, 6-93
MSC: MPS Auto-Firm Planned Orders, A-49
MSC: Multiplier to Derive Supply Allocation 
Window, 18-95
MSC: Net Change Temp Dir, A-49
MSC: New Forecast Auto Plan, 12-80, A-50
MSC: New Planner Backward Compatability, 
A-50
MSC: New Supply Commit Auto Plan, 12-81, 
12-81, A-50
MSC: Operator Company Name, A-51
MSC: Order Type for Consigned VMI, A-50
MSC: Organization containing generic BOM 
for forecast explosion, A-50
MSC: OTM URL, A-51
MSC: Overwrite all Order Forecast records, A-
51
MSC: Overwrite all supplier capacity records, 
A-52
MSC: Pass List Price to OM in DRP Release, A-
53
MSC: Plan co-products, A-54
MSC: Plan for order at risk calculation, A-54
MSC: Plan Name for CMRO, A-54
MSC: Planning Currency, A-54

MSC: Planning Hub Currency Code, 4-2, A-54
MSC: Priority for Substitute Items Flexfield 
Attribute, 2-9, A-54
MSC: Priority of Alternate Resources for an 
Operation Flexfield Attribute, A-55
MSC: Production Plan for Transportation 
Updates, A-55
MSC: Project Task Collection Window Days, 
A-55
MSC: Provide Warning for Dates Entered on 
Non-work Days, A-55
MSC: PS/SNO Alignment Date, A-58
MSC: PS/SNO API Version, A-58
MSC: PS/SNO Client Install Path, A-58
MSC: PS/SNO Compress Xml Package Files, 
A-58
MSC: PS/SNO Data Store Path, A-58
MSC: PS Allow WO Purchased Item 
Offloading, A-57
MSC: PS Currency Symbol, A-57
MSC: PS Resource Constraint Horizon, A-57
MSC: PS Run Application Script, A-57
MSC: PS Run Connector Script, A-57
MSC: PS - Snapshot Base Package, A-55
MSC: PS - Snapshot Calendar Package, A-56
MSC: PS - Snapshot Customer Package, A-56
MSC: PS - Snapshot Distribution Package, A-
56
MSC: PS - Snapshot Enterprise Forecast 
Package, A-56
MSC: PS - Snapshot Inventory Safety Targets 
Package, A-56
MSC: PS - Snapshot Manufacturing Package, 
A-56
MSC: PS - Snapshot Purchase Orders Package,
A-56
MSC: PS - Snapshot Sales Orders Package, A-
56
MSC: PS - Snapshot Supplier Package, A-57
MSC: PS - Snapshot Transfer Orders Package, 
A-57
MSC: PS - Snapshot Work Orders Package, A-
57
MSC: Purchase Order Dock Date Calculation 
Preference, 6-24, 6-25, 6-26, 12-78, 12-78, A-59
MSC: Purge Staging and Entity Key 
Translation Tables, A-59
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MSC: Released Only By User, A-60
MSC: Release WIP Dtls if Order Date different
then BOM Revision Date, 9-57, A-60
MSC: Resource Group for a Line Flexfield 
Attribute, 2-9, A-60
MSC: Resource Type for an Operation 
Flexfield Attribute, A-60
MSC: Respect Minimum Remaining Shelf Life 
Days, A-61
MSC: Safety stock change interval (Days), 6-
138, A-61
MSC: Safety stock project, 19-22
MSC: Safety Stock Project, 19-31, 19-32, A-61
MSC: Sales Orders Offset Days, 5-86, A-62, A-
62
MSC: SCEM Engine Launch Events, 12-80, A-
62
MSC: Scope of Analyze Plan Partition, A-62
MSC: Share Plan Partitions, A-63
MSC: Shelf Life Override of Order Modifiers 
for Transfer Orders, A-63
MSC: Simultaneous Resource Sequence 
Flexfield Attribute, A-63
MSC: Smoothing method to calculate Safety 
stock within Change interval, A-64
MSC: SNO Connector Precision, A-65
MSC: SNO Currency Precision, A-65
MSC: SNO Decimal Precision, A-66
MSC: SNO Optimization Type, A-66
MSC: SNO Run Application Script, A-66
MSC: SNO Run Connector Script, A-66
MSC: SNO - Snapshot Base Package, A-64
MSC: SNO - Snapshot Beginning Inventory 
Package, A-64
MSC: SNO - Snapshot Calendar Package, A-64
MSC: SNO - Snapshot Customer Package, A-
64
MSC: SNO - Snapshot Demand Package, A-64
MSC: SNO - Snapshot Distribution Package, 
A-64
MSC: SNO - Snapshot Enterprise Forecast 
Package, A-64
MSC: SNO - Snapshot Inventory Safety 
Targets Package, A-64
MSC: SNO - Snapshot Manufacturing 
Package, A-64
MSC: SNO - Snapshot Purchase Orders 

Package, A-65
MSC: SNO - Snapshot Sales orders Package, 
A-65
MSC: SNO - Snapshot Supplier Package, A-65
MSC: SNO - Snapshot Transfer Orders 
Package, A-65
MSC: SNO - Snapshot Work Orders Package, 
A-65
MSC: SNO Transportation Capacity By, A-66
MSC: Source Setup Required, A-66
MSC: Sourcing History Start Date Offset (in 
months, 4-14
MSC: Sourcing History Start Date Offset (in 
months), A-67
MSC: Sourcing Rule Category Set, A-67
MSC: Sourcing Variance Tolerance, 6-46, A-67
MSC: Split Planned Orders for Scheduling 
Flexibility, 9-42, A-69
MSC: Split Planned Order to perform safety 
stock pegging, A-68
MSC: Start Date Offset for Sourcing History 
(Months), 6-46
MSC: Supplier Capacity Accumulation 
(multiplier), 6-21, 6-22, 6-23, 6-24, 6-25, 6-26, 
A-70
MSC: Supplier Capacity Consumption by 
Purchase Orders, 6-23, A-70
MSC: Suppress Exception for Selection of 
Alternates, A-70
MSC: Temp Index Extent Size (Bytes), A-70
MSC: Temp Table Extent Size (Bytes), A-70
MSC: Transportation Domain, A-71
MSC: Unit of Measure, A-71
MSC: Update Requested Completion Date 
when Releasing Reschedules, A-71
MSC: Use attribute based netting, A-71
MSC: Use Base Model during Forecast 
Consumption, A-72
MSC: Use FIFO Pegging, 18-86, 18-88, 18-96, 
18-100, 18-101, 18-104, A-73
MSC: Use Hash Key, A-73
MSC: Use Optimization Supply Due Dates for 
Pegging, A-74
MSC: Vertical view default query, A-75
MSC: VMI Default Query, A-75
MSC: Wait Time to Obtain Lock on 
Table/Partition for Snapshot Delete Worker (in
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sec), A-76
MSC: Write MBP Flat Files, A-76
MSC --> PROFILE OPTIONS, A-13
MSD: Calculate Planning Percentages, A-76
MSD: Category Set Name, A-77
MSD: Client Debugging, A-77
MSD: Code Workspace, A-77
MSD: Conversion Type, A-77
MSD: Currency Code, A-77
MSD: Customer Attribute, A-78
MSD: Default DP Scenario, 12-79, 12-80, A-79
MSD: Master Org, A-79
MSD: OLAP Directory Alias, A-79
MSD: One Step Collection, A-80
MSD: Publish CTO Forecast Percentages by 
Top-level Model, A-81
MSD: Two-Level Planning, A-82
MSD --> PROFILE OPTIONS, A-76
MSO: Activity Selection Window (Days), A-83
MSO: Additional Demand Slices for Shared 
Supply Rescheduling, 9-45, 17-95, A-84
MSO: Allow early builds to consume existing 
supplies of phased-out components and 
sources, A-85
MSO: Allow Partial Demand Completion, 9-39
, 17-19, 17-20, A-86
MSO: Allow Schedule Gaps for Shared 
Supplies, A-87
MSO: Alternate Process Penalty, A-88
MSO: Alternate Resource Penalty, A-88
MSO: Alternate Resource Selection Method, 
A-89
MSO: Alternate Source Penalty, A-89
MSO: Avoid non working days for 
Buy/Transfer order dates, A-90
MSO: Barrier Optimizer Algorithm Choice, A-
90
MSO: Calculate Constraint Exceptions, 17-37, 
17-39, 17-65, 17-67, 17-119, A-91
MSO: Capacity Units Recalculation Threshold,
A-92
MSO: Check Redundant Constraints, A-93
MSO: Choice of supply for substitution, 12-26, 
A-93
MSO: Component offset logic for optimization
, A-93
MSO: Consume Firm Work Orders Based on 

Resource Hours, A-94
MSO: Continuous transfer across 
organizations, A-94
MSO: Convergent Supplies Consumption 
Pattern for Inter-Org and Supplier Sourced 
orders, A-95
MSO: Convergent Supplies Consumption 
Pattern for Intra-Org Sourced orders, A-95
MSO: Cost Roll-up incremental factor, A-96
MSO: CPLEX Crash Parameter, A-96
MSO: CPLEX Refactor Rate, A-96
MSO: CPLEX Scaling Factor, A-96
MSO: Create Aggregate Supply for 
Unsatisfied Demands within Planning Time 
Fence, A-97
MSO: Default Forecast Priority, A-97
MSO: Default Resource Sequencing Window 
(Days), A-98
MSO: Default Sales Order Priority, A-98
MSO: Default Timestamp for Forecasts, A-99
MSO: Default Timestamp for Sales Orders, A-
100
MSO: Default Timestamp Safety Stocks, 6-136, 
A-101
MSO: Delay fulfillment of small demands, A-
101
MSO: Delay Fulfillment of Small Demands, 6-
92
MSO: Demand Size Tolerance Before Splitting 
Planned Orders, A-102
MSO: Demands Size Tolerance PCT before 
Splitting Planned Orders, 9-41, 9-41, 9-42
MSO: Demands Size Tolerance PCT Before 
Splitting Planned Orders, 9-41
MSO: Demand Window Size, 18-86, 18-88, 18-
93, 18-93, 18-96, 18-105, A-102
MSO: Disable Inference of Item Substitution 
Relationship, A-103
MSO: Divergent Supply Feeding Pattern for 
Inter-Org and Supplier Sourced orders, A-103
MSO: Divergent Supply Feeding Pattern for 
Intra-Org Sourced orders, A-104
MSO: Dual Simplex Parameter, A-104
MSO: EDD Scheduling Window Control, 9-50,
9-55, A-105
MSO: Enable Cost Rollup for Optimization, A-
106
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MSO: Enable Decision Rules, 5-55, 9-32, 9-32, 
12-40, 12-41, 12-43, 12-43, 12-43, 12-43, 12-53, 
12-54, 12-64, A-106
MSO: Enable Hard Links Globally, A-106
MSO: Enable Triangulation in Optimization, 
A-106
MSO: Enforce Resource Sequence Contiguity, 
A-107
MSO: Firm Operations/Orders within the 
Planning Time Fence, 9-23
MSO: Firm Operations/Orders Within Time 
Fence, 6-92, 6-95, 6-95, 6-96, 6-132, 9-19, 9-21, 
A-107
MSO: Firm Orders/Operations within Time 
Fence, 6-94
MSO: Firm Purchase Orders Within Time 
Fence, 6-92, 6-95, A-108
MSO: Firm Requisitions Orders Within Time 
Fence, A-108
MSO: Firm Requisitions Within Time Fence, 6-
93, 6-95, A-109
MSO: Firm Supply Allocation Window 
(Backward days), 18-91, 18-92, 18-94, 18-95, 18-
96, 18-101, 18-105, 18-105, A-109
MSO: Firm Supply Allocation Window 
(Forward days), 18-92, 18-92, 18-94, 18-96, 18-
101, 18-105, A-110
MSO: Firm Work Orders/Operations Within 
Time Fence, A-110
MSO: Floating Point Precision, A-111
MSO:Floating Point Precision for Planning 
Bucket Efficiency, 9-36, 9-37
MSO: Floating Point Precision for Planning 
Bucket Efficiency, A-111
MSO: Floating Point Precision for 
Transportation Capacities (Volume), A-111
MSO: Floating Point Precision for 
Transportation Capacities (Weight), A-112
MSO: Floating Point Precision for Usage in 
Routings, A-112
MSO: Generate Compression/Firming 
Exceptions for Orders in Progress, A-113
MSO: Generate Compression Days Exception, 
A-113
MSO: Generate Shared Supply Exceptions, 17-
95, 17-120, A-114
MSO: Global Batchable Flag, A-114

MSO: Global Chargeable Flag, A-115
MSO: Global Time Limit, A-115
MSO: Hard link scheduling window, A-115
MSO: Hard link scheduling window 
expansion factor, A-115
MSO: Heuristic type, 9-33, A-116
MSO: HLS flat files path, A-116
MSO: Improved Lead Time Offsetting in 
Aggregated Buckets, A-116
MSO: Include Past Due in Safety Stock, A-116
MSO: Internal Demand Aggregattion Within 
Optimization, A-116
MSO: Inventory Carrying Costs Percentage, 
A-117
MSO: Late Demands Exceptions Tolerance 
Minutes, 9-61, A-117
MSO: Lead Time Control, 9-51, 9-52, 9-52, 17-
35, 17-36, 17-90, 17-93, A-118
MSO: List Size for Pricing Candidates, A-118
MSO: LP Constraint Batch Size, A-118
MSO: LP Markowitz Coefficient, A-118
MSO: LP Optimization Algorithm, A-118
MSO: Maximium Number of Prepones, A-122
MSO: Maximize Search of Availability 
Intervals, A-119
MSO: Maximum Activity Duration, A-120
MSO: Maximum Allowable Days Late, 9-59, 9-
61, 9-61, 9-62, 9-62, A-120
MSO: Maximum Allowable Days Late before 
Forecast Expiration, 9-59, 9-59, 9-60, 9-60, 9-61,
9-61, 9-62, 9-62, 9-62, 9-63, A-120
MSO: Maximum Demands per Group, A-121
MSO: Maximum Demands per Group for 
Advanced Sequencing, A-121
MSO: Maximum Demands per Slice, 9-33, 9-33
, A-121
MSO: Maximum Inventory Level % of Safety 
Stock, 6-93, A-122
MSO: Maximum Number of Pull for 
Operation, A-122
MSO: Maximum number of pulls/push for 
hard linked operations, A-123
MSO: Maximum Number of Pushes for 
Operation, A-123
MSO: Maximum Operations Per Slice, A-124
MSO: Maximum Resource Over-capacity, A-
124
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MSO: Maximum Simplex Iterations, A-124
MSO: Minimize Supply Duration, A-125
MSO: Multiplier to derive supply allocation 
window, 18-95, 18-95
MSO: Multiplier to Derive Supply Allocation 
Window, 18-94, 18-95
MSO: Multiplier To Derive Supply Allocation 
Window, 18-96, 18-101, 18-105, A-126
MSO: Net All Firm Supplies Before Creating 
Planned Order, A-127
MSO: Net All Firm Supplies Before Creating 
Planned Orders, 6-93, 6-94
MSO: Network routing cycle time coefficient, 
A-127
MSO: Network routing fixed time window, A-
128
MSO: NFL Backward Compression Pct, A-128
MSO: Nfl Forward Compression Pct, A-128
MSO: Number of Decomposition Groups in 
Optimization , A-128
MSO: Number of Demand Groups for 
Optimization, A-129
MSO: Number of Threads for Optimization, 
A-129
MSO: Optimization Advanced Start, A-130
MSO: Optimization Daily Aggregation 
Buckets, A-130
MSO: Optimization Weekly Aggregation 
Buckets, A-130
MSO: Order Modifier Maximum Searching 
Depth, A-131
MSO: Overlap Activities by MTQ , A-131
MSO: Peg By-product Supplies, A-132
MSO: Penalty Basis for Changeovers, A-132
MSO: Penalty Cost Factor for Exceeding Item 
Material Capacity Flexfield Attribute, 2-8, A-
133
MSO: Penalty Cost Factor for Exceeding 
Material Capacity, 8-9, A-133
MSO: Penalty cost factor for exceeding 
material capacity (Organization) flexfield, 2-8
MSO: Penalty Cost Factor for Exceeding 
Material Capacity Flexfield Attribute, A-133
MSO: Penalty Cost Factor for Exceeding 
Material Capacity Flexfield Attribute, 2-9
MSO: Penalty Cost Factor for Exceeding Org 
Material Capacity Flexfield Attribute, A-133

MSO: Penalty Cost Factor for Exceeding Org 
Resource Capacity Flexfield Attribute, A-133
MSO: Penalty Cost Factor for Exceeding Org 
Transportation Capacity Flexfield Attribute, 
A-133
MSO: Penalty Cost Factor for Exceeding 
Resource Capacity, 8-11, A-134
MSO: Penalty cost factor for exceeding 
resource capacity (Organization) flexfield, 2-8
MSO: Penalty cost factor for exceeding 
resource capacity (Resource) flexfield, 2-9
MSO: Penalty Cost Factor for Exceeding 
Resource Capacity Flexfield Attribute, A-134
MSO: Penalty cost factor for exceeding 
transportation capacity (Organization), 2-8
MSO: Penalty cost factor for exceeding 
transportation capacity flexfield attribute, 2-9
MSO: Penalty Cost Factor for Exceeding 
Transportation Capacity Flexfield Attribute, 
A-134
MSO: Penalty Cost Factor for Late Demands, 
8-6, A-134
MSO: Penalty cost factor for late demands 
(Organization) flexfield attribute, 2-8
MSO: Penalty cost factor for late forecasts, 2-9
MSO: Penalty Cost Factor for Late Forecasts 
Flexfield Attribute, A-134
MSO: Penalty Cost Factor for Late Item 
Demands Flexfield Attribute, 2-8, A-134
MSO: Penalty Cost Factor for Late Org 
Demands Flexfield Attribute, A-135
MSO: Penalty cost factor for late sales orders, 
2-9
MSO: Penalty Cost Factor for Late Sales 
Orders Flexfield Attribute, A-135
MSO: Penalty multiplier outside 
unconstrained window, A-135
MSO: Postpone Use of Alternates to Latest 
Possible Time, A-135
MSO: Preprocessing Aggregator Fill, A-135
MSO: Preprocessing Aggregator Limit, A-135
MSO: Preprocessing Flag for LP Matrix, A-136
MSO: Preprocessor LP Compression, A-136
MSO: Primal/Dual Preprocessing Reduction, 
A-136
MSO: Primal Simplex Parameter, A-136
MSO: Pull push base, A-136
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MSO: Pull push offset, A-137
MSO: Queue Time Factor, 9-62, 9-63, 12-64, A-
137
MSO: Reschedule Jobs Out to Reduce 
Carrying Inventory, A-138
MSO: Reschedule Shared Supply to Influence 
Batching, A-138
MSO: Resource Adjustment Factor For 
Improved Offloading to Alternates, 12-42, 12-
56, A-139
MSO: Resource Batching Strategy, A-139
MSO: Resource Group for the Line Flexfield 
Attribute, A-139
MSO: Schedule Across Breaks, A-140
MSO: Schedule PO in FIFO , A-140
MSO: Scheduler Time Step, A-140
MSO: Schedule Simultaneous Resources 
Across Breaks, A-140
MSO: schedule window width, A-140
MSO: SCO Dual Variables Tolerance, A-140
MSO: SCO Reduced Cost Tolerance, A-140
MSO: Setup Pattern Calculation Window, A-
139
MSO: Simplex Feasibility Tolerance, A-141
MSO: Simplex Optimality Tolerance, A-141
MSO: Simplex Perturbation Limit, A-141
MSO: Simplex Perturbation Parameter, A-141
MSO: Simplex Presolve Limit, A-141
MSO: Simplex Singularity Repair Limit, A-141
MSO: Simultaneous Resource Overlap, A-141
MSO: Slack Hours for Batch Resource, A-142
MSO: Solve Dual Problem, A-142
MSO: Sourcing Allocation Window, 6-46, A-
142
MSO: Split Planned Orders for Assigned 
Units, A-143
MSO: Spread Resource Consumption Within 
Optimization, A-143
MSO: Substitute Item Penalty, A-143
MSO: Supply Reschedule Window Size for 
Safety Stock Pegging, A-144
MSO: Supply Window Size, 18-86, 18-88, 18-93
, 18-94, 18-96, 18-105, A-144
MSO: Target Inventory Level % of Safety 
Stock, 6-93, A-144
MSO: Transfer Quantity Threshold for 
Enforcing Hard Links, A-145

MSO: Upper Limit for Maximum Time Offset 
for Hard Links, A-145
MSO: Use Breaks in Calculation of 
Unconstrained Scheduling Windows, 9-48, 9-
54, A-146
MSO: Use Collections Start Time, A-147
MSO: Use Effectivity Date to Infer End Item 
Substitute Priority, A-147
MSO: Use Existing Supplies in Alternate 
BOM/Subs., A-148
MSO: Use Item Shelf Life Days in Scheduling 
Buy or Make Orders, A-148
MSO: Use of Assigned Units in Scheduling, 9-
12, 9-13, 9-15, 9-15, A-149
MSO: Use Optimization and Decision Rules 
for Simulation , A-149
MSO: Use Safety Lead Time, A-150
MSO: Use SCO Time Aggregation, A-150
MSO: Use Sequencing Template, A-151
MSO: Use Shift Definitions When Scheduling 
Lead Times, A-151
MSO: Use up existing supply of primary 
components before substitute, A-152
MSO --> PROFILE OPTIONS, A-83
MSR: Budget Category Set, A-152
MSR: Postponement Factor, A-152
MSR: Probability Distribution Type, A-153
MSR: Safety Stock Holding Strategy, A-153
MSR --> PROFILE OPTIONS, A-152
profile optionsMSC: Auto-Release 
Compression Days Tolerance, A-22
special considerations, A-1

profile options 
MSC: Smoothing method to calculate Safety 
stock, 6-138

Project MRP
Oracle ASCP setup, 19-28
Oracle Inventory setup, 19-28
Oracle Project Manufacturing setup, 19-28

projects/tasks and Seiban numbers, 4-6
projects/tasks exception group, 17-103
project workflow, 3-8
publish a schedule to ASCP, 20-37
publishing a constrained forecast, 21-20
publishing a strategic plan, 21-15
publish plan results to Oracle Order 
Management, 18-154
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example, 18-158
pull architecture, 4-4
purchased item lead-time calculations, 6-88
purchase order

Oracle Purchasing, 12-78
supplier acknowledgement, 12-77

purchase orders
planning time fence logic, 6-94

purchase requisitions
planning time fence logic, 6-94

Purge Collaborative Planning Historical Records 
(concurrent process), 22-52
Purge Designator (concurrent process), 22-53
Purge Interface Tables (concurrent process), 22-
53
Purge Legacy Data (concurrent process), 22-54
Push Plan Information (concurrent process), 22-
55

R
rank and allocation

setting, 6-33
rapid planning, 1-8
Realign Operational Data Stores Dates 
(concurrent process), 22-60
receipts

scheduled, 6-151
reciprocal-unidirectional and bidirectional 
substitution, 12-16
recommendations exception group, 17-115
Recommendations exception message, 17-116
Refresh Allocation Hierarchy Materialized View 
(concurrent process), 22-61
Refresh Collection Snapshots (concurrent 
process), 22-61
Refresh Global Forecast Materialized Views 
(concurrent process), 22-62
Refresh KPI Summary Data (concurrent process),
22-63
Refresh Materialized Views (concurrent process),
22-63
Register Ask Oracle Planning Question 
(concurrent process), 22-64
related exceptions, 17-12

drill down, 18-50
related exceptions for the late replenishment

viewing, 18-50
release flow schedules, 19-36
releasing orders, 3-12
repetitive schedules

planning time fence logic, 6-95
replacement groups

all-of-sets, 20-16
reports, 22-1, 22-14

Planning Detail, 22-7
request date, 6-97
Requirement causes resource overload exception 
message, 17-29
requirement integer quantities, 9-8, 19-86
Requirement lead time constraint exception 
message, 17-38
requirements

integer quantities, 9-8, 19-86
Requirement with insufficient lead time 
exception message, 17-36
rescheduled purchase order

supplier acknowledgement, 12-77
reschedules exception group, 17-77
rescheduling an operation, 18-168
rescheduling discrete jobs

data consistency, 9-21
rescheduling non-firm open job, 9-21
rescheduling workflow, 3-8
resize windows, 18-44
resolving conflict between item attributes and 
profile options, 12-17
resolving exceptions, 17-117
resource actual usage, 9-18
resource aggregation, 5-140
resource aggregation levels

choosing, 5-139
setting for a time horizon, 5-140

Resource Availability (Details) window, 18-132
description of fields, 18-132

Resource Availability Summary window, 18-131
buttons, 18-132
description of fields, 18-132

resource breaks, 6-52
Resource constraint exception message, 17-50, 17-
89, 17-91, 17-92, 17-94, 17-95
resource efficiency, 9-18

planner workbench, 9-19
resource engine
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planning engine, 9-19
resource group

bottleneck, 5-53
resource hours, 9-19
Resource overloaded exception message, 17-52
resource parameters

production scheduling, 20-9
resource precedence constraints, 17-132
resource replacement groups, 21-19
Resource Requirements window, 18-134, 18-134
resources, 19-53

aggregate, 19-6
decreasing, 5-148
efficiency, 9-18
modifying, 3-10
selecting to plot, 18-166
simultaneous, 19-6
utilization, 9-18
viewing, 18-166

Resources
scheduling resource charges, 19-54

resource schedule
modeling, 6-49

Resources window, 18-129
buttons, 18-131
right-click menu options, 18-131

resource tool tip
accessing, 18-166

Resource underloaded exception message, 17-55
resource units

one-to-one basis
assigning, 6-74

resource usage, 9-19
and Oracle Manufacturing scheduling, 9-19
collections, 9-19
deflating, 9-19
discrete jobs, 9-19
inflating, 9-18, 9-19

resource utilization, 9-18
planner workbench, 9-19

resource warehouse, 19-40
review constrained forecast, 3-11
reviewing exception messages, 3-6
reviewing KPIs, 3-5
review workflow notifications, 3-7
Rollup Cumulative Lead Time concurrent 
process, 6-79

rounding order quantities, 9-7
round order quantities, 9-8
round order quantity, 13-28
routing

Operation Resource Schedule flag, 6-49
routing aggregation level

setting for a time horizon, 5-141
routing effectivity, 19-6
Routing Operations window, 18-141
routings, 9-11, 19-40, 19-41

alternate resources, 6-69
minimum transfer quantity, 6-49
multiple resources, 6-71
multiresource scheduling, 6-71
network, 19-94
setting up, 6-48
simultaneous resources, 6-69

rules
demand priority, 5-66

running a batch replan, 7-4
running a global supply chain plan, 5-3

prerequisites, 5-3
running an online replan, 7-5
running an optimized plan, 3-9
running an unconstrained plan, 3-9
running a production schedule, 20-34
running a production schedule with ASCP, 20-3
running a production schedule without ASCP, 
20-7
running a strategic plan, 21-14
Running production scheduling as a service, 20-
38
running the Audit Statements report, 22-1

S
safery stock

supply/demand window, 18-65
safety lead time, 6-79
safety stock, 6-133, 9-5, 13-9

constrained - enforce demand due dates plans,
9-56
co-products, 19-9
exception message, 17-72
horizontal plan, 18-63
inventory optimization, 6-135
levels, 6-135
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mean absolute deviation (MAD), 6-135
mrp planned, 6-135
non-mrp planned, 6-135
plan option, 5-54
project manufacturing, 19-21
safety stock window, 18-127
user-defined percentage, 6-135
user-defined quantity, 6-135

safety stock 
pegging, 18-105

safety stocks, 9-5
Safety Stock window, 18-127
Sales order/forecast at risk due to material 
shortage exception message, 17-28
Sales order/forecast at risk due to resource 
shortage exception message, 17-27
Sales order/forecast at risk exception message, 
17-15
sales orders

configure to order, 10-4
sales order workflow, 3-8
saving actions, 7-6
Schedule, 4-23
scheduled receipts, 6-151
scheduling

bottleneck resource group, 5-53
discrete jobs, 6-126
discrete jobs in constrained - enforce capacity 
constraints plan, 6-129
discrete jobs in constrained - enforce demand 
due dates plan, 6-131
discrete jobs in unconstrained plan, 6-127
discrete jobs with firm operations and orders, 
6-132

Scheduling Resource Charges
view resource charge information, 19-57

SCP names window, 5-4
search direction and transferring demands, 12-32
search the supply chain for substitution, 12-12
security, 12-65
Seiban numbers, 4-6
selecting resources to plot, 18-166
selection of alternates for OSFM, 12-50
Select Worksheet (Export to Excel) window, 18-
149
self-service application, 4-37
Send XML Releases to Legacy Sources 

(concurrent process), 22-64
sequence dependent setups, 9-64

discrete manufacturing, 9-64
planning, 9-70
process manufacturing, 9-69
viewing changeover times and preferred 
sequence, 9-72
viewing plan results, 9-73

sequence dependent steps, 9-21
serial numbers, 19-20
service level, 12-73
set schedule options

for strategic plans, 21-8
setting hard and soft constraints, 9-28
setting penalty factor for exceeding material 
capacity

hierarchy, 8-6
setting penalty factor for exceeding resource 
capacity

hierarchy, 8-9
setting penalty factor for late demand

hierarchy, 8-3
setting resource aggregation levels, 5-140
setting schedule options

for production schedules, 20-20
setting the material aggregation level for a time 
horizon, 5-141
setting the resource aggregation levels for a time 
horizon, 5-140
setting the routing aggregation level for a time 
horizon, 5-141
setting up

Application Instances window, 2-11
Organization window, 2-13

setting up distribution planning, 13-1
Setting up Routings

setting up resource charge scheduling, 19-56
set up

destination instance, 2-10
flowchart, 2-4
source instance, 2-5

setup data control files, C-1
setup for collection of transaction data, 4-25
shared supplies constraint, 9-42
shifts, 9-16

capacity changes, 9-17
shift time constraint, 9-34
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ship date, 6-103
ship method selection

distribution planning, 15-2
shop floor manufacturing

co-products, 19-81
shortages and excess exception group, 17-72
simulate possible substitution, 12-24
simulating plans in, 1-8
simulations, 1-8

changing, 7-6
comparison, 7-8
key performance indicators, 7-8
modes, 7-2
net change replan, 7-3, 7-4
overview, 7-1
reversing, 7-6
scenarios, 7-1
undo, 7-6

simulation scenarios
demands, 7-2
resource availability, 7-1
shutdown planning, 7-2
supplier capacity, 7-1
supplies, 7-2

simultaneous resources, 19-6
single-plan approach

advantages, 5-3
sorting exceptions, 17-10, 18-49
source instance, 11-1

setup, 2-5
sources of demand, 3-4
Sources window, 18-121, 18-121

Assignment tabbed pane, 18-123
buttons, 18-124
Effectivity Dates tabbed pane, 18-123
Sourcing tabbed pane, 18-121

sourcing constraints
tolerance fences, 9-27

sourcing percentages
splitting demand according to, 6-33

sourcing rules
defining, 6-2
supply chain, 6-2

split planned order
sizing and timing, 9-42

split planned orders constraint, 9-41
splitting demand according to sourcing 

percentages, 6-33
standard data collection, 4-3

running, 4-10
setting up, 4-15

start date, 6-78
stopping an online planner session, 7-6
Strategic Network Optimization

architecture, 21-2
business process, 21-2

strategic plans, 21-1
assignment sets, 21-16
create a new plan using the Workbench, 21-6
generating models on the server, 21-21
modeling demand at the customer or zone 
level, 21-16
publishing a constrained forecast, 21-20
publishing a plan, 21-15
resource replacement groups, 21-19
running a plan, 21-14
setting profile options, 21-5
setting schedule options, 21-8

subset planning
pitfalls, 5-7
scenarios, 5-6

subset plans
hub and spoke planning, 5-9

substitute components, 9-4
substitutes and alternates used exception group, 
17-97
Substitution Chain window, 18-128

right-click menu options, 18-128
substitution logic, 12-12
suggested dates

planned order, 9-37
suggested dock date, 6-83, 6-102

manufacturing calculation, 6-87
purchasing calculation, 6-88
transfer calculation, 6-89

suggested due date, 6-83, 6-97, 6-102
manufacturing calculation, 6-86
purchasing calculation, 6-88

suggested order date, 6-84, 6-101
manufacturing calculation, 6-87
purchasing calculation, 6-89
transfer calculation, 6-90

suggested ship date, 6-83
manufacturing calculation, 6-87
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purchasing calculation, 6-89
transfer calculation, 6-89

suggested start date, 6-83, 6-102
manufacturing calculation, 6-87
purchasing calculation, 6-89
transfer calculation, 6-90

supplier
supplier organization

external supplier organization, 11-14
supplier acknowledgement, 12-77
supplier capacity, 7-1

accumulation, 6-21
constraints, 6-20
procured models, 10-25
purchase order consumption, 6-23
setting, 6-20, 6-32
setting by time periods, 6-33

Supplier capacity overloaded exception message,
17-54
Supplier Capacity window, 18-124, 18-124

description of fields, 18-124
Supplier Capacity tabbed pane, 18-126
Supplier Flexfences tabbed pane, 18-126
viewing, 18-124

supplier collaboration, 12-80
automation

setup, 12-80
triggering launch of plan, 12-81

suppliers
modeled as organizations, 18-176

Supplier split percentage violated exception 
message, 17-109
Supplier Variability window, 18-126
supplies control files, C-4
supply

pegging, 3-8
supply allocation rules, 13-25
supply and demand

modifying, 3-10
supply chain

assignment sets, 6-2
sourcing rules, 6-2

supply chain bill
illustration, 10-11

Supply Chain Event Manager (concurrent 
process), 22-65
supply chain modeling, 6-1, 11-3

allocating demand to suppliers, 6-33, 6-35
Audit Statements report, 22-1
batch resources, 6-158
customers, 11-5
intransit lead-time, 11-4
lead-times, 6-76
planned inventory points, 9-73
planning server tasks, 6-162
planning time fence, 6-76
routings, 6-48
See also supply chain, 6-1
sourcing, 11-4
sourcing splits, 6-45
supplier capacity, 6-20
suppliers, 11-5
supply chain definition, 6-2

supply chain or where used information
viewing, 18-139

supply chain plan
attaching a priority rule, 5-68
copy a plan, 5-5
creating, 5-4

Supply Chain Plan Names form
security, 12-67

supply chain routing
planning level, 17-134

supply chain synchronization, 19-34
supply control files, C-4
supply dates

demand due date, 6-89
need by date, 6-83, 6-86, 6-88, 6-89, 6-100, 6-101
old dock date, 6-84, 6-102
old due date, 6-84, 6-102
original need by date, 6-84
production duration, 6-87, 6-89
ship date, 6-103
suggested dock date, 6-83, 6-87, 6-88, 6-89, 6-
102
suggested due date, 6-83, 6-86, 6-88, 6-102
suggested order date, 6-84, 6-87, 6-89, 6-90, 6-
101
suggested ship date, 6-83, 6-87, 6-89, 6-89
suggested start date, 6-83, 6-87, 6-89, 6-90, 6-
102
updated need by date, 6-100, 6-101
viewing in workbench, 6-84, 6-100

supply problems for late sales orders and 
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forecasts exception group, 17-24
supply tolerances, 19-62
supported configurations, 4-7

T
tabs

Action, 7-6
Optimization, 8-5

tailoring the user interface, 18-44
Planner Workbench, 18-44

customize columns, 18-44
display preferences, 18-44

target inventory level, 13-9
time aggregation levels

choosing, 5-137
tolerance fences

sourcing constraints, 9-27
tolerances

supply, 19-62
total lead-time, 6-82
touchtime, 9-19
transaction data collection, 4-25
transfer item lead-time calculations, 6-89
transfer of demands on to substitute supplies, 12-
25
transportation and distribution exception group, 
17-64
transportation capacity

flexfields, B-3
transportation management exceptions exception
group, 17-113
Transportation resource's volume overloaded 
exception message, 17-70
Transportation resource's weight overloaded 
exception message, 17-68
Transportation resource constraint exception 
message, 17-65, 17-67
trip limit constraints, 13-6
trip limits for ship methods by lane, 13-6

U
unconstrained plan

running, 3-9
See also plan types, 3-9

undoing your actions, 7-6
unit numbers in sales orders, 19-20

unit of measure, 19-41
updated need by date, 6-100, 6-101
user-defined alternate decision rules, 12-39

constrained plans, 12-39
examples of how user-defined alternate 
decision rules are used, 12-46
exception messages, 12-65
lead-times, 12-64
optimized plans, 12-53
pegging, 12-65
planning search logic, 12-54
search logic, 12-57
selection of alternates for OSFM, 12-50
simulations, 12-53

user-defined keys, C-5
use-up effectivity date, 9-56
using an existing plan as a demand schedule for 
new plan, 5-57
utilization, 9-18

V
variable lead-time, 6-77, 6-79
viewing actions, 7-6
viewing exception details, 17-11, 18-49
viewing exceptions

exceptions
expanding all actions, 18-49
viewing, 18-48

viewing pegging information, 18-111
viewing plan comparisons, 22-5
viewing related exceptions for the late 
replenishment, 18-50
viewing substitution display, 12-10
viewing supply chain or where used 
information, 18-139
viewing the Audit Statements report, 22-3
viewing undo summary for a plan, 7-6
VMI Replenishment Engine (concurrent process),
22-68

W
web tools pages, 18-149
Where Used window, 18-144
window

Load Transaction Data Parameters, 4-42
Planning Data Collections, 4-42



Index-35

Planning ODS Load Parameters, 4-43
Supplier Capacity, 18-124, 18-124

description of fields, 18-124
Supplier Capacity tabbed pane, 18-126
Supplier Flexfences tabbed pane, 18-126
viewing, 18-124

Supplier Variability, 18-126
window for substitution, 12-18
windows

Application Instances, 4-35
Collection Workbench, 4-15
Components, 18-139, 18-139
continuous collections, 4-23
Continuous Collections, 4-23

Requests, 4-23
co-product, 18-145
Data Pull Parameters, 4-10
Destinations, 18-119, 18-119

Assignment tabbed pane, 18-121
Effectivity tabbed pane, 18-120
Sourcing tabbed pane, 18-120

Exception Details, 18-49
Exception Summary, 18-48, 18-49
Find, 18-34
Flat File Loader Parameters, 4-36
Gantt: Right-click menu options, 18-165
Gantt Chart, 18-160
Horizontal Plan, 18-52
Item Forecast Entries, 8-4
Items, 18-114, 18-114

buttons, 18-118
description of fields, 18-114
right-click menu options, 18-119
viewing, 18-114

Key Performance Indicators (KPIs), 18-147
Key Performance Indicators (KPIs) trend 
chart, 18-147
MRP Forecast Dates, 8-4
Multiple Plans Comparison, 7-8
Network Routing, 18-143
ODS Load Parameters, 4-13
online planner status, 7-5
operation resources, 6-49
pegging information, 18-172
Planner Workbench, 18-2
Planning Data Collection, 4-10
Planning ODS Load Parameters, 4-37

Plan Worksteets, 5-71
Pre-Process Monitor Parameters, 4-36
Process Effectivity, 18-145
Properties, 18-34, 18-34
Purge Parameters, 4-38
Reschedule, 18-167
Resource Availability (Details), 18-132

description of fields, 18-132
updating resource availability, 18-133

Resource Availability Summary window, 18-
131

buttons, 18-132
description of fields, 18-132

resource capacity, 18-169
Resource Requirements, 18-134, 18-134
Resources, 18-129

buttons, 18-131
right-click menu options, 18-131

Resources, 6-159
Resource Tool Tip, 18-166
Routing Operations, 18-141
routings, 6-58
Safety Stock, 18-127
Schedule, 4-14
SCP Names, 5-4
Select Worksheet (Export to Excel), 18-149
Sources, 18-121, 18-121

Assignment tabbed pane, 18-123
button, 18-124
Effectivity Dates tabbed pane, 18-123
Sourcing tabbed pane, 18-121

sourcing rule, 6-45
Sourcing Rule, 11-5
Subinventory Netting, 5-57
Substitution Chain, 18-128

right-click menu options, 18-128
supplier, 6-33
Supply/Demand, 18-64
Supply/Demand for Unit Effective Items, 19-
21
Supply/Demand window, 18-65
system profile values, 6-45
System Profile Values, 8-6
Time Buckets, 18-167
two views, 18-172
Where Used, 18-144

WIP mass/load PO requisitions interface, 19-21
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work orders

firm, 9-42
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Planning Detail Report, 22-11
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